BigFix Inventory

User's Guide

Special notice
Before using this information and the product it supports, read the information in Notices.

Edition notice
This edition applies to version 10 of BigFix Inventory and to all subsequent releases and
modifications until otherwise indicated in new editions.

Contents
BigFix Documentation Homepage................................................................................
BigFix 10 Inventory Documentation.....................................................................................1
Overview................................................................................................................................. 3
What's new in this release............................................................................................ 3
Updates and patches for BigFix Inventory.................................................................80
Keeping BigFix Inventory up-to-date........................................................................ 508
Features and functions............................................................................................. 511
Preview features........................................................................................................ 512
Limitations..................................................................................................................513
Key concepts..............................................................................................................521
Scenarios.................................................................................................................... 599
Installing.............................................................................................................................611
Planning the installation........................................................................................... 611
Detailed System requirements................................................................................. 614
Software requirements.............................................................................................. 723
Hardware requirements.............................................................................................731
Port requirements......................................................................................................752
Firewall exceptions.................................................................................................... 753
Proxy exceptions........................................................................................................754
Installation accounts................................................................................................. 755
Coexistence scenarios.............................................................................................. 759
Installing on Windows............................................................................................... 767
Installing on Linux..................................................................................................... 799

Contents | v

Installation-related tasks...........................................................................................835
Configuring.........................................................................................................................842
Creating users and groups....................................................................................... 842
Setting up scans to discover software and hardware inventory............................ 855
Performing optional configuration......................................................................... 1014
Classifying the BigFix client used by multiple BigFix products............................ 1023
Upgrading.........................................................................................................................1024
Upgrading to BigFix Inventory v10......................................................................... 1024
Migrating from License Metric Tool.......................................................................1046
Managing the infrastructure...........................................................................................1047
Computer statuses.................................................................................................. 1047
Managing VM managers.........................................................................................1050
Administering the server.........................................................................................1168
Administering the database....................................................................................1208
Removing inactive computers................................................................................ 1225
Managing data sources.......................................................................................... 1227
Software inventory and license utilization.................................................................... 1235
Vendor-specific predefined reports........................................................................ 1236
Reported license metrics........................................................................................ 1241
Software classification............................................................................................1286
Software catalogs....................................................................................................1345
Reports..................................................................................................................... 1437
Enterprise applications inventory........................................................................... 1514
License metrics....................................................................................................... 1557
10.0.5 Contracts management..............................................................................1599

Contents | vi

10.0.7 Software discovery in containers.............................................................. 1651
10.0.8 Software data harvesting tool................................................................... 1653
Managing security threats..............................................................................................1654
Collecting file checksums.......................................................................................1654
Preview: Checking Common Vulnerabilities and Exposures (CVEs)....................1661
Tutorials........................................................................................................................... 1666
Tutorial: Reporting subcapacity usage per computer group................................ 1666
Tutorial: Managing software in the service provider environment....................... 1675
Tutorial: Bulk software classification using external tools...................................1689
Tutorial: Migrating software assignments between two BigFix servers.............. 1697
Security.............................................................................................................................1705
Flow of data.............................................................................................................1705
Security configuration scenarios............................................................................1709
Configuring database connection encryption....................................................... 1710
Configuring secure communication....................................................................... 1718
Assuring compliance with federal encryption standards..................................... 1729
Authenticating users with LDAP.............................................................................1734
Configuring and enabling single sign-on (SSO).....................................................1744
Configuring passwords and encryption mechanisms.......................................... 1778
Configuring user account lockout.......................................................................... 1791
Configuring VM Manager tool to accept trusted VM manager certificates.........1792
Relays....................................................................................................................... 1794
Troubleshooting and support.........................................................................................1796
Troubleshooting a problem.....................................................................................1796
Duplicate UUIDs problem........................................................................................1799

Contents | vii

Interrupting software scan.................................................................................... 1800
Troubleshooting software discovery......................................................................1801
Tuning performance........................................................................................................1941
Infrastructure............................................................................................................1941
Setting up scans and import.................................................................................. 1947
Additional tasks for improving performance.........................................................1955
Tuning performance in medium and large environments.................................... 1961
REST API considerations........................................................................................ 1973
Integrating with REST API.............................................................................................. 1982
REST API.................................................................................................................. 1982
Glossary........................................................................................................................... 2481
Index..........................................................................................................................

BigFix 10 Inventory Documentation
Welcome to BigFix Inventory documentation, where you can find information about how
to install and configure BigFix Inventory. The application provides you information about
your inventory and the license metrics. You can manage your software assets, gather
information about your hardware, and ensure license compliance of your enterprise using
BigFix Inventory.
BigFix Inventory provides new predefined vendor-specific report feature with a quick access
to discovered software assets and licensing information about different vendors. To learn
more about vendor-specific predefined reports, refer to Vendor-specific predefined reports.
From version 10.0.7, BigFix Inventory supports discovery of software in Docker container
images. From version 10.0.8, Software Data Harvesting Tool, an optional support is
introduced. The support is part of BigFix Inventory Catalog Enhancement Program. The tool
supports better software discovery for the endpoints. From version 10.0.9, new template
signature types are supported. Version 10.0.10 provides improved discovery for Mac
software in BigFix Inventory.
Important: This documentation applies to BigFix Inventory application updates 9.2.1
through 10.0.11. Supported BigFix platform versions 9.5 and 10.
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Overview
Become familiar with key concepts that are necessary to understand how BigFix Inventory
works and learn about features and functions that are introduced in every version of the
application.

What's new in this release
BigFix Inventory provides new features and enhancements that facilitate your work with the
application. Check out what is new.

Application update
• All Contracts panel changes
Starting from version 10.0.11, the column ‘Current measured values’ shows ‘n/a’ only
if a metric is not calculated by BigFix Inventory or if there are no products added to the
contract. In any other case, it shows a number.
• New recalculation button added to All Contracts panel
Added a new ‘Recalculate’ button to All Contracts, which is available when one or
more Contracts require recalculation under given scenarios. For more information,
refer to All contracts.
• New Product Metrics per Contract panel
The ‘Product Metrics per Group’ panel has been replaced with ‘Product Metrics per
Contract’ which can be accessed by clicking on corresponding Products on the All
Contracts report. The new panel shows current metric values per each product that
is assigned to a particular Contract. It is also enhanced by an additional column ‘Is
incomplete’ which reflects the status of recalculation. Product Metrics per Group
report is still available from main menu to allow for reporting of high-water mark
metrics with split per computer group.
• New Metric Microsoft SQL Server Physical Processor Cores
Added a new metric ‘Microsoft SQL Server Physical Processor Cores’ for the per core
physical licensing model. The new metric is calculated as per the current day and

follows the latest Microsoft SQL Server product terms. For more information, refer to
10.011 Managing Microsoft Processor Core licenses.
• All metrics changes
Starting from version 10.0.11, the All Metrics report does not display Metric Quantity
for the new metric ‘Microsoft SQL Server Physical Processor Cores’ and all the other
upcoming metrics that we will improve or migrate in the future. For such metrics, the
column Metric Quantity will display the notification ‘Calculated for Contract’.
• Extended discovery of Oracle Database
The improved reporting covers Oracle pluggable databases and additional licensable
options. For more information, refer to 10.0.11 Handling common situations with
extended oracle discovery.
• Software defined with template signatures is available in BigFix Inventory before
discovery
Software products, for which only template signatures are available, can be used in
Contracts, Software Classification, and Product & Metrics panels, even if they have not
been discovered on any computer
• Option to delete from database historical Computers and Software detections
The “maximum_data_lifetime” parameter is added in the Advanced Server Setting to
allow you remove from database computer and software detection records closed
earlier than the specified number of days.
• All template derived components are assigned to a single, generic product release
Components discovered with template signatures are by default bundled to one
product having ‘*’ for the release number instead of numbers which related to autodetected versions.
• Additional interim upgrade fixlet
Added fixlet for interim upgrade to version 10.0.10.0 of BigFix Inventory server
instances between version 10.0.2.0 (inclusive) and 10.0.3.0 (exclusive, the minimal
version eligible for direct upgrade to latest release).
• Improved static asset serving
Improved the performance through Cache-Control header.

• Enhancement of Oracle Java Detection
Enhanced discovery of existing Oracle Java signature for versions 7,8, 16 and 17 to
include non-standard installations.
• Support for modification of a software defined with a template signature
You can now modify the name and publisher of a software that is defined with a
template signature in software catalog is propagated to software discovered with the
template signature.
• Support for modification of a template signature
You can also modify the template signature in Software Catalog that is propagated to
software discovered with the template signature.
• Warning message while downloading Harvested Data for Harvester Tool
Added an improved and shortened warning message for better readability.
• Support for new platforms and systems
Added support for the following platforms and systems as managed devices:
◦ AIX 7.3 by using the BigFix client
◦ KDDI Cloud
◦ Red Hat Enterprise Linux 9 by using the BigFix client
◦ Ubuntu 22.04 on IBM z Systems by disconnected scanner
• Security fixes
◦ WebSphere Liberty updated to version 22.0.0.11
◦ Google Protocol Buffers upgraded to version 3.21.9
◦ Kubernetes Java Client API upgraded to version 16.0.2
◦ SnakeYAML upgraded to version 1.33 from 1.31
◦ Spring Boot upgraded to version 2.7.5
◦ Spring Framework upgraded to version 5.3.23

Application update
• Changes to Mac OS discovery
BigFix Inventory now provides improved automated catalog-less software discovery
on Mac OS devices. Vendor information is populated for both Package Data and
software inventory reports, for example, Software Classification. Catalog definitions
for MAC software include normalized Vendor information for key Vendors and one
Product definition compared to previous structure. Inventory reports include detailed
discovery of software classified as applications. Complete Package Data with
category classification is available with the option to promote selected components
to inventory as needed. With improved discovery, a bigger number of MAC software
offers usage information.
For more information, refer to Discovering Mac software in BigFix Inventory.
• IBM policy update for subcapacity reporting requirements for VPC license metric
Effective May 10, 2022, IBM requires all Virtual Processor Core (VPC) software
licenses that use subcapacity licensing to deploy IBM License Metric Tool or any other
tool approved by IBM like HCL BigFix Inventory. Manual capacity counting is no longer
permitted. Container Licensing terms are not included in this policy change.
For more information, refer to IBM subcapacity licensing page.
• Deleted old software signatures to optimize standard catalog processing
Improved catalog processing by removing old software signatures from BigFix
Inventory main catalog which results in better performance overall. Deleted signatures
refer to software and versions with very low probability of being active or deployed.
Deleted signatures are still available as custom catalog content for customers who
request specific titles and versions through the standard support channel.
• Additional information is provided in the audit snapshot
Files with license metric utilization that are a part of the audit snapshot include
information when the computer was first seen by the BigFix Inventory server. The
information is provided in the Computer First Seen column. For more information, see
Snapshot columns.

• Software Data Harvesting Tool
New fixlet added to clear data collected by Software Data Harvesting Tool.
• Leveraging data collected by BigFix analysis
From BigFix Inventory version 10.0.10, the amount of data transferred from endpoint
and server is reduced by limiting the data exchange to last upto 30 days. BigFix
Inventory combines incoming updates with existing data and because of server side
optimization, the already stored data is not processed again in the database. This
process of handling data collection leverages in reducing the load on the network and
BigFix Platform.
• Support for new platforms and systems
Added support for the following platforms and systems as managed devices:
◦ IBM Cloud LinuxONE VS
◦ NTT IaaS Powered by VMware
◦ IBM i 7.5
◦ Debian 11 x64
◦ Red Hat Enterprise Linux 9 by using the disconnected scanner
◦ Ubuntu 22.04 on x86 by using the disconnected scanner
◦ Azure VMware Solution with use of VM Manager Tool
◦ IBM z16
• End of support
IBM DB2 10.5 is no longer supported as a database for BigFix Inventory Server in line
with supported database list for BigFix platform. IBM withdrew support for DB2 10.5
in April 2020.
Microsoft Internet Explorer web browser is no longer supported.
Support is withdrawn for the following platforms and systems:
◦ VM Managers: Oracle VM Manager
◦ IBM i 7.1
◦ RHEL 5 on Power

• Added end of support data for additional vendors in software catalog
The end of support information in catalog is automatically populated for Adobe,
Oracle, Red Hat and VMware software. No change to end of support information for
IBM and Microsoft software. Upgrade BigFix Inventory server to version 10.0.10.0 to
see the changes.
◦ VMware - https://lifecycle.vmware.com/ /
◦ Adobe - https://helpx.adobe.com/in/support/programs/eol-matrix.html

Application update
• Template signature support for catalog management
The Catalog Customization panel has two new signature types, Package Template
signature and File Template signature. Using these signature types, you can create a
template signature that works for the current and future software releases matching
defined discovery template. For more information, see Template signature support.
• Improved data import time by removing deprecated features
Data import performance is improved by removing deprecated panels and related
import steps for Contracts (Deprecated), Contract Usage Data (Deprecated), Software
Installations (Deprecated), Inventory Exploration (Deprecated), Unrecognized Files.
The related sections in the document have been updated/removed.
Important: You must migrate the deprecated contacts to the equivalent before
upgrading the BigFix Inventory server to 10.0.9. Once the server is upgraded,
the deprecated features, such as deprecated contracts and saved reports
on deprecated panels, will be deleted and will not be retrievable. The custom
saved reports defined on removed panels must be redefined. At the end of
migration, a detailed report of the migration is displayed.
• Experimental cache implementation in BigFix Inventory Scanner
BigFix Inventory Scanner (CIT) includes a new type of cache for file system
information (file listing) that allows to clear query the cache. For more information,
see Use experimental CIT Scanner Cache3.

• Podman in addition to Docker as the runtime for executing scans of container
images
Image Scanning solution supports use of Podman (https://podman.io) in addition to
Docker (r) as the runtime for executing scans.
• Extension of REST APIs
The api/sam/v2/license_usage and computer_hardware association APIs have
been updated to include more information. For more information, see Retrieval of
license metric utilization (v2) and computer_hardware association.
• Added log rotation policy
Added log rotation policy to BigFix Inventory Cloud Adapter and BigFix Inventory
Scanner Service.
• New BigFix Inventory server metrics added
New metrics, Named User, Client Access License (CAL), Management License (ML)
have been added. The metrics are not assigned to any product by default. When
BigFix Inventory Server is upgraded, metrics are also added. If a custom metric with
the same code name is created, the custom metric is marked as non-custom and its
description is updated.
• Fixed PVU and VPC values for instances running in the warm standby mode
Fixed the PVU and VPC values for instances that run in warm standby mode to allow
the report show the correct metric utilization. For more information, see the IBM
document.
• New discovery for more software titles
Discovery capability updated for Oracle Financial Services Advanced Analytical
Applications Infrastructure, HCL Domino Server and HCL Domino Enterprise
Integrator, Microfocus Products (Sentinel Enterprise and Sentinel for Log
Management, eDirectory & Access Manager), Tripwire Enterprise Console and Tripwire
Axon Agent, and IBM Semeru products.
• Clean-up of Adobe CC suite

Discovery mechanism of Adobe CC products is improved. Definition source is
corrected to HCL for some products. Versions were removed from component names.
Old discovery records will be closed and new ones will be available.
• Patronus library updated to version 2.7.1
The custom number input component in BigFix Inventory is replaced with Patronus
number input component to stay updated and meet Patronus design standards.
• Support for migration of keystores from JCEKS to PKCS12 in VM Manager and SAP
tool for install/upgrade fixlet
If you upgrade from version lower than 10.0.8.0, the keystores are automatically
converted to the new format.
• Support for migration of keystores from JCEKS to PKCS12 in Cloud Adapter and
Scanner Service
If you upgrade from version lower than 10.0.8.0, the keystores must be migrated
manually using keystore migration tool. For details regarding the procedure, refer to
the containers documentation.
• Clear corrupt scanner installation fixlet enhancement
A fixlet is now available to detect corrupt scanner installation files and prevents the
catalog from updating with corrupt files.
• Support for new platforms and systems
Support is introduced for the following systems:
◦ Hyper-V on Windows Server 2022
◦ Ubuntu 18 and Ubuntu 20 on zSystems by using the disconnected scanner
◦ VMware Cloud on AWS - All equivalent to ESXi 7 or ESXi 6.7
For information about collecting data from this virtualization type, see
Virtualization types that require VM manager connections.
• Security fixes
◦ IBM Java Runtime updated to version 8.0.7.6 (CVE-2022-21299)
◦ IBM WebSphere Liberty updated to version 22.0.0.6 (CVE-2022-22475)
◦ IBM Java Semeru Runtime Open Edition (build 1.8.0_332-b09) for the BigFix
Inventory tools (CVE-2022-21299)

◦ Moment.js library updated to version 2.29.2 (CVE-2022-24785)
◦ Rack gem upgrade to 2.2.3.1 (CVE-2022-30122)
◦ Libraries updated in BigFix Inventory Cloud Adapter
• Software Components End of support dates
The end of support date updated for 24 Microsoft components and added for 34 more
components.

Application update
• Software Data Harvesting Tool
BigFix introduces an optional Software Data Harvesting Tool to improve software
discovery in catalogs.
• Improvements in Containers solution for software discovery
A dedicated plugin framework is available to communicate to Kubernetes APIs of
on-premise and public cloud containers to determine software usage of container
instances.
• REST API for assigning product to a FlexPoint offering or a Cloud Pak
You can use the api/sam/v2/software_instance REST API to assign products to
FlexPoint. For more information, see: Classifying software (v2).
• Enabling HTTP Access Logging for BigFix Inventory
A task enabling the server to log any incoming HTTP request. For more information,
see Enabling HTTP Access Logging for BigFix Inventory.
• Custom email address for sending feedback
You can provide use your preferred email address in the sending feedback option
instead of the default email address. See also, Provide feedback email.
• Custom message when SSO access is blocked
An option to provide custom message on the login page when an existing SSO user is
not yet added to BigFix Inventory. See also, SSO access blocked message.
• Fixlet to test CIT signatures on endpoints
Added fixlet to test custom CIT signatures on endpoints.

• Fixlet for detection and removal of broken scanner installations
Added fixlet to detect scanner installations on endpoints, where some scanner files
lost system read permissions or where files do not meet size criteria, then grants all
rights and performs unstallation
• End of support for BigFix Platform version 9.2.x
Effective April 30, 2022, HCL will end service for BigFix Platform version 9.2.x. Since
then, all updates to platform components will cease, including security patches. This
includes all BigFix Platform components including Root Server, Relay, Client, Console,
and Web Reports in version 9.2.x. All customers owning valid BigFix licenses and
current S&S are entitled, under the same part numbers, to BigFix Platform version
9.5.x and version 10.0.x.
Note: BigFix Inventory product versions 9.2.6 and above will still be supported,
when it runs on a supported BigFix Platform version (9.5.x or 10.0.x).
• Extended support for HP-UX
Even with the end of support for BigFix Platform 9.2.x on April 30, 2022, BigFix will
continue to support for HP-UX using BigFix Platform 9.2 Agent reporting to BigFix
Platform 9.5 or 10.0, connected to BigFix Inventory 10.x. BigFix Platform 9.2 HPUX Agent patches will be provided only to address PSIRT records or high severity
customer reported defects. For more information, see BigFix forum announcement.
Support for IBM subcapacity licensing for all versions of HP-UX is planned to be
removed at the end of 2022 as announced by IBM. For IBM Sub capacity license
related inquiries, write to subcap@us.ibm.com.
• Support for new platforms and systems
Support is introduced for the following systems:
◦ Fujitsu Cloud IaaS Instance - FJcloud-O
◦ AIX 7.3 - AIX 7.3 is supported only by disconnected scanner. The BES Agent and
CIT discovery support is not announced.
◦ Windows 11 Pro, Pro for Workstation and Enterprise edition
◦ Windows Server 2022 Standard and Datacenter edition

Note: Known defect - Disconnected Scanner does not set Operating
System key in computer.yml on Windows Server 2022. Before running
first scan go to work\computer.yml and set the key as, 'Operating
System: Windows Server 2022'.
• Security enhancements
Default certificate of the BigFix Inventory server and certificate of the VM Manager
Tool internal communication were updated with extended validity periods. Validity of
the old certificates were extended till 2031/2032.
◦ Log4J updated to version 2.17.1 (previously 2.15.0 in v10.0.7)
◦ Apache Xercer updated to version 2.12.2
◦ Apache httpclient updated to version 4.5.13
◦ ICU4J updated to version 69.1
◦ IBM Java Runtime updated to version 8.0.7.0 (CVE-2021-41035)
◦ IBM WebSphere Liberty updated to version 22.0.0.2 (PH42908 PH41986
PH42759 PH42435 PH42074 PH42762)
◦ JQuery-UI updated to version 1.13.0 (CVE-2021-41184, CVE-2021-41183,
CVE-2021-41182, CVE-2016-7103, CVE-2010-5312)
◦ React-scripts updated to version 5.0.0

Application update
• Software Discovery in containers
BigFix Inventory supports discovery of software in Docker container images. For more
information, refer to Software discovery in containers. Active container metric ID,
17346 added.
• Contract improvements
REST API to validate string customer fields.

◦ Custom field values of types: integer, float, boolean are accepted also without
quotation marks.
◦ Software which contains non-ASCII characters is accepted in contracts REST
API, as well as in the search field on UI.
◦ Contract fields like contract name in REST API can contain non-ASCII
characters.
◦ Error reporting for CSV import is improved for the cases when type ID, computer
group ID or purchase order quantity is empty, but it is expected to have a value.
◦ Error language in reporting of CSV import failure is improved. Language for
errors is used from user profile instead of header in request.
• Trace level setting in disconnected scanner
Run the setcfg.bat script in windows and setcfg.sh script on unix systems to help
screen with instruction and requests for new values to be set.
• Server installation no longer requiring ksh
Installation of the BigFix Inventory server no longer requires ksh which is not available
by default on newer versions of Linux.
• Support for new platforms and systems
Support is introduced for the following platforms and systems:
◦ Windows 11 on 64 bit for CIT scanner on BigFix Agent (10.0.4 or higher)
and Disconnected Scanner (10.0.7) client side (discovery, standard and
disconnected scans, and complete functional coverage).
Note: The support for Windows 11 excludes reporting Windows OS
11 as Software on Software Classification / Package Data where the
system is reported as Windows 10. The rest of the software discovery
works correctly. (Planned for next update).
◦ IBM Power 10 processor - supported only by using the disconnected scanner.
Operating systems running on Power 10 are not yet supported by the BigFix
client.
◦ NTT Enterprise Cloud Server

◦ Oracle Linux KVM managed by Oracle Linux Virtualization Manager 4.3 and later
◦ Debian 11 x86 by using the disconnected scanner
◦ Debian 11 x64 by using the disconnected scanner
◦ BIOS limits for Oracle Linux KVM managed by Oracle Linux Virtualization
Manager 4.3 and later
• Security enhancements
◦ Axios upgraded to version 0.21.4, CVE-2021-3749
◦ Checkbox to enable TLS1.2 was removed from Advanced Server settings. TLS
1.2 was already enabled by default from previous release.
◦ BigFix Inventory is shipped with TLS 1.2 with enabled cipher suites as included
in each Java / WebSphere version. It is possible to restrict the cipher suites
with an entry in customization.xml file, which is extending server.xml
definition. See also, Configuring Cipher suites.
◦ Log4j updated to version 2.15.0 in VM Manager Tool and SAP Tool CVE-2021-44228. BigFix Inventory is not affected by CVE-2021-45046.

Application update
• Importing contracts data from CSV files
BigFix Inventory now allows you to import contract data from CSV files through the
WebUI and REST API. See also, Importing contracts and API to import and export
contracts.
• Migrating contracts
Migrating deprecated contracts to new contracts is now possible. See also, Migrating
contracts.
• Convert purchase order from number to ELA and ELA to number
Contract management now allows you to convert purchase numbers to ELA and ELA
to purchase numbers.
• Set default product and metric for bundling assistant
You can set a default product and metric in the "Product and Metric' for bundling
assistant.
• Support for new platforms and systems

Support is introduced for the following platform and system:
◦ Fujitsu Cloud IaaS Instance
Support is added for BIOS limits on the following hypervisors that are installed on bare
metal:
◦ Hyper-V (all supported versions)
◦ Red Hat Virtualization (managed by Red Hat Virtualization Manager)
◦ Citrix Hypervisor 8.x
◦ VMware vSphere Hypervisor ESXi (all supported versions)
• End of support
Support is dropped for the following platforms:
◦ CentOS 6
◦ Debian 8
◦ VMware vSphere 6.0
◦ Internet Explorer 10

Application update
• Improved contracts management
The improved contracts management allows you to access and manage contracts
from one single report. The new contract supports any license metric and shows 'All
Metrics' data. See also, Contract management. The previous contract management
functionality is now deprecated.
• Updated predefined dashboard
The predefined dashboard now includes contracts with access to contracts of all
statuses. You can perform all actions selecting the contract type. The quick search on
the predefined dashboard allows you to search contracts with contract name.
• Custom metrics management on Products & Metrics panel
BigFix Inventory now allows you to add, modify, and delete metrics using the UI. For
more information, see Managing license metric through the UI.
• New Product Publisher Name column

The "Product Publisher Name" column on Software Classification panel indicates the
name of the publisher of a product that a software instance is assigned to.
• Combine package data with software instance data
Package data is now combined with software instance data to using a new Unified
Software API. For more information, see Unified software API.
• Notification about duplicate UUIDs
The To Do list shows notification about duplicate UUIDs (Universally Unique Identifier).
The list of computers with duplicate UUIDs is shown as a warning. For more
information, see Duplicate UUIDs problem.
• Disconnected scanner can be used to mark computers that run on public cloud
BigFix Inventory allows you to use disconnected scanner mark computers that run
on public cloud. For more information, see Identifying disconnected computers as
running on public clouds.
• Splitting of logs in VM Manager tool
To improve readability of logs, the communication with a hypervisor is captured in the
configuration file. For more information, see Log files.
• Catalog distributed in GZIP format instead of BZIP2
The downloaded software catalog from BigFix Inventory by endpoints is now available
in .gz (GZIP) format instead of .bz (BZIP2) format. The purpose is to discontinue the
use of BZIP2 compressor/format in BigFix Inventory. Next releases will include further
changes.
• Removal of use of zip/unzip binaries on Windows Endpoints
The multiarchive tool 7zip is used on Windows endpoints instead of zip/unzip
binaries. This change is applicable to the scanner update. The zip/unzip binaries are
still available for other areas.
• Suppressed package discovery
BigFix Inventory adds capability to suppress packages in the Package Data report and
Package Summary report to view the relevant packages only.
• Performance improvement

Improved processing of computers groups by restricting the default and maximum
limit of maxAggregationThreads and maxReaggregationThreads variables to control
the number of CPUs that are used.
• 'Component Detailed Version' column added in some of the predefined reports
The Software Installations, Current Installations, and Software: Discovered in the last
2 weeks predefined reports now show the Component Detailed Version column by
default.
• BigFix Inventory installation date available in audit snapshot
The “data_condition.txt” file of audit snapshot now shows the BigFix Inventory
installation date.
• Trace scanner setting change
Trace scanner settings now shows two options, Default and Verbose, where Default
represents the min and Verbose represents the max.
• Skip lock flag is Advance Server Settings
Skip lock flag is added to exclude the locked endpoints while downloading the
catalog.
• Security enhancements
◦ Rails upgraded to version 5.2.6 - CVE-2021-22880, CVE-2021-22904,
CVE-2021-22885
◦ Updated Ruby bundler - CVE-2019-3881, CVE-2020-36327
◦ IBM Java JRE upgraded to version 8.0.6.30
◦ IBM WebSphere Liberty upgraded to version 21.0.0.6
◦ Using POST parameters as GET parameters to enhance security.
◦ TLS 1 and TLS 1.1 are disabled and TLS 1.2 is supported - Install appropriate
service pack or content update for Microsoft SQL Server database. See also,
Software requirements.
◦ VMware ESXi minimum version requirement updated to VMware ESXi 6.0
Update 3. See also, Detailed System requirements.
• Support for new platforms and systems
◦ Debian 10 x86 (64 bit) by using the BigFix client
◦ Red Hat Enterprise Linux 8 on zSystems by using the BigFix client

◦ Red Hat Virtualization 4.4
◦ SLES 15 on zSystems by using the BigFix client
◦ Ubuntu 18 guest on Ubuntu KVM on Power using BigFix client and the
disconnected scanner
◦ NEC Cloud IaaS Instance
◦ MS SQL 2019
• End of support
◦ Support is withdrawn for Windows 2008 and 2008 R2.

Application update 10.0.4
• REST APIs for license metrics
BigFix Inventory now allows you to retrieve, create, change, and delete license metrics
using REST APIs. For more information, refer to 10.0.4 REST API for managing license
metrics.
• REST APIs to integrate multicluster licensing data in IBM License Service Reporter
You can use REST APIs to view licensing information about software that is needed
to integrate with other licensing tools in multicluster environments. For more
information, refer to Retrieval of license metric utilization (v2). The REST API provides
the same information as the IBM License Metric tool. The License Sender tool uses
the API to integrate multicluster licensing data in IBM License Service Reporter.
See also, Tracking license usage in multicluster environment with License Service
Reporter.
• Improvements in file facts import
Improved file fact import performance. The import.log shows status of file
imports. This helps in distinguishing between correct files, files with errors, files
encountering unpacking issues, and invalid files. The import progress shows
estimated time left to complete an import. The file path is recorded in the import log.
• Removal of the “Caused Detection” column and the “enable_caused_detection”
setting

The Caused Detection column is removed from the Package Data and Scanned File
Data reports. The enable_caused_detection parameter is also removed from the
advanced server setting. Saved reports that use this column are not automatically
migrated and you must manually re-create the reports. The Recognized column is
now the primary option to perform your tasks.
• Reporting information about the detailed version of applications discovered by
package-based signatures
Installed software components that are discovered by specific packages are reported
with a detailed component version which is the same as the package version. The
version information is shown in the Component Detailed Version column in the
Software Classification report and in component_detailed_version column in REST
API.
• Improvements in reporting information about detailed version and file size
The rules used to determine the version information to be shown when there are
multiple discoveries, have been updated. For details, refer to Component Detailed
Version. On the Details page of Software Classification panel, detailed versions of for
all such matched discovery means are displayed, together with the overall Component
Detailed Version for a given software component instance. The file size information
for matched file signatures is also displayed.
• Database connection encryption
With BigFix Inventory you can encrypt your database connection by using the
encryption that the database engine and JDBC driver support. For more information,
refer to Configuring database connection encryption.
• Regular database index rebuilding
Starting from the version 10.0.4, BigFix Inventory has a script that manages regular
database index rebuilding.
• Search software catalog by component name on the new dashboard
The new dashboard is extended with the functionality of catalog search by
component name. Catalog search widget is removed from the old dashboard. The
new quick search option and existing filters in reports provide equivalent functionality.

• Fixlet available to download PVU table
The 'Download PVU table' option now allows you to download the latest PVU table.
Download the file and then manually upload it to BigFix Inventory server. For BigFix
Inventory to be compliant with IBM Subcapacity, you must upgrade the server.
• Parameter added to show hidden values
A "show_hidden_values" parameter has been created and added in Advanced Server
Settings, which allows you to manage hidden parameters.
• Suppressed discovery of certain software products
Added new custom rules to suppress the discovery of software publishers, such as
Adobe Systems Incorporated and Microsoft Corporation, and Red Hat Enterprise Linux
software component. With the rules implemented, the reports for those vendors do
not appear under the Software Classification report.
• Automatically enabled performance logs
Performance logs are now automatically enabled. The logs can be disabled and
enabled back if required.
• Updated the EOS (End of Support) date for Microsoft software products
The EOS date of Microsoft products, such as Microsoft SQL Server, Microsoft Excel,
Windows OS, and Visual Studio has been updated. The EOS of non-IBM components
has also been updated.
• Security enhancements
◦ axios NPM package upgraded to version 0.21.1 - CVE-2020-28168
◦ IBM JRE is upgraded to version 8.0.6.25 due to critical CVE-2020-27221
◦ WebSphere Liberty updated to v.21.0.0.1
◦ rest-client updated to version 2.0.1
◦ formtastic updated to version 4.0.1
• Support for new platforms and systems
Support is introduced for the following platforms and systems:
◦ Oracle Enterprise Linux 8 on x86 by using the BigFix client
◦ Red Hat Enterprise Linux 8.1 and higher 8.x versions on Power by using the
BigFix client

◦ Red Hat Enterprise Linux 8 on zSystems by using the disconnected scanner
◦ Ubuntu 20.04 on x86 by using the BigFix client
◦ IBM Power Systems Virtual Servers on IBM Cloud
◦ Tencent Cloud Server Instance
• End of support
Starting from version 10.0.4, support is dropped for Windows 7.

Application update 10.0.3
• Notifications for failed data and catalog imports
The To Do list now shows notifications about failed data and catalog import. You
can also enable email notifications for failed imports. For more information, refer to
Notifications that are sent when imports of data and catalogs fail.
• Certification of License Activation Process for BigFix
BigFix Inventory now supports automatic component assignment for all active BigFix
products. For more information, refer to Assigning components to active BigFix
products <deprecated>.
• Improved user interface
Improved interface in the menus, dialogs, and reports
• Support for new platforms and systems
Support is introduced for the following platforms and systems:
◦ Alibaba Elastic Computer Service
◦ Red Hat 8.2 or a higher version for BigFix Inventory server. Check BigFix
Platform system requirement.
◦ Disconnected scanner on Red Had Enterprise Linux 8 on z Systems
• Security enhancements
To maintain security, the following selected components and libraries were updated:
◦ Rails upgraded to version 5.2.4.4
◦ Upgraded icu4j libraries to supported version

◦ WebSphere Application Server Liberty is upgraded to version 20.0.0.11
◦ Changed Websphere configuration to use TLS 1.2 by default for fresh
installation. For existing and upgraded BigFix Inventory installations, manual
configuration is required. For more information, refer to Enabling secure
communication.
◦ Addressed the security vulnerability of SSO login by implementing secure SSL
cookie. For more details, refer to the Knowledge Base article.

Application update 10.0.2
• New vendor-specific predefined reports
BigFix Inventory offers vendor-specific predefined reports that provide software
discovery and licensing information for specific software vendors like Adobe,
IBM, Microsoft, Oracle, SAP, VMware, and HCL. These reports help Software Asset
Managers manage software at their organization and get prepared for contract
negotiations and license audits. For more information, see Vendor-specific predefined
reports.
• New default dashboard
BigFix Inventory now shows the predefined vendor-specific reports on the default
dashboard to provide some out of the box data to the vendors.
• Installation path of all discovered software
Inventory reports now show the installation path of all discovered software (IBM and
non-IBM). If a product is installed in multiple paths, all paths are reported as separate
instances. Previously it was applicable only to IBM software.
• Software Classification details view
The details view now shows only matched detection. It does not show signatures that
does not match. It includes a link with complete list of signatures.
• Extended list of default exclusion list on Windows for scanner installation
For a newly installed scanner, the list of exclusions has been extended with directories
containing large files that are not related to the software discovery. For upgraded

scanner, to extend the list of exclusions with directories containing large files that are
not related to the software discovery, follow the procedure described in the KB article.
• IBM software catalog delivered only with application updates
Starting from 10.0.2, the IBM software catalog is a part of BigFix Inventory application
and BigFix Inventorydoes not support manual update of HCL catalog any longer.
However, manual catalog update continues to be supported for non-IBM vendors.
• Setting entitlements
BigFix Inventory now allows you to marks products as entitled through for products
and metrices. Setting entitlement works along with bundling assistant.
• Audit trail for user management operation
You can now enable a conditional user management parameter to allow the audit trail
report capture information, such as creation and deletion of users. It also shows any
modification in the user role and user computer group.
• Streaming of JSON responses for UI and API requests
Starting from 10.0.2, BigFix Inventory uses HTTP streaming in JSON responses.
With this improvement, pagination in the API is optional and all data can be fetched
with a single query. The applications integrated with BigFix Inventory and using
the pagination feature, should consider increasing the page size or dropping the
paging option for improved response time. For more information, see also REST API
considerations.
• Support for ISO 19770-2 delta/patch tags
Component Detailed Version now provides complete information about fix packs
through ISO 19770-2 patch/delta tags. Previously the tags used to get rejected on
both, endpoint side and server side. The functionality works with BigFix Inventory
server version 10.0.2 or higher and Initiate Software Scan fixlet version 10.0.2 or
higher.
• Support for new platforms and systems
Support is introduced for the following platforms and systems:
◦ SLES 15 SP1 on Power
◦ vSphere ESXi 7.0 and vSphere vCenter Server 7.0

◦ Disconnected scanner on Red Had Enterprise Linux 8.1 on Power
◦ Disconnected scanner on Ubuntu 20 x86
• Security enhancements
◦ IBM JRE is upgraded to version 8.0.6.15
◦ WebSphere Application Server Liberty is upgraded to version 20.0.0.5
◦ Several libraries for Ruby on Rails component are upgraded
◦ Upgraded jQuery to 3.5.1
◦ Obsolete and unused libraries removed from production
• End of support
◦ Starting from version 10.0.2, support is dropped for the following:
▪ IBM DB2 10.1 as database for BigFix Inventory server
▪ VM Manager tool version 32-bit
▪ IBM i 6.1

Application update 10.0.1
• Updated software catalog
New version of Catalog for enhanced software discovery. The catalog includes:
◦ IBM License Metric Tool Software Catalog version 9.2.19.0.
◦ capability to discover and collect evidence about usage of Oracle Java
Commercial Features: ‘Java Flight Recorder’ and ‘JRE Usage Tracking’. This
discovery is intended to help customers to check usage of Java Commercial
Features. The knowledge about usage of these features is needed for older
Oracle Java commercial licenses that are applicable for Oracle Java before
version 11.
◦ added discovery capability for 800+ software versions for number of titles
including Symantec, Hewlett-Packard, Oracle software
◦ 5 Ideas to discover or enhance discovery of specific software
• Package Data report is updated with data from Solaris IPS package manager
Support for Solaris IPS package manager is available for endpoints with BigFix client
installed.

• Configurable limit of custom software classification rules
More custom software classification rules can be defined now to automate
classification process. Provides ability to redefine limit on custom software
classification rules using Advanced Server Settings panel. Supports up to 100 custom
rules.
• Enhanced API for Scanned File data with additional properties for Windows
executables
Collection of additional properties for Windows executables is optional feature that
is disabled by default. This function is limited to 50 000 endpoints, has additional
storage requirements and impact on data import time. Rollout to endpoints requires
proper planning and verification before function is enabled.
• The Software Summary report becomes an integral part of BigFix Inventory
The Software Summary report provides an overview of software inventory in your
environment. Each row represents a set of software instances that are grouped by
the selected columns. The report was introduced as a preview feature and improved
over the past releases. It now becomes an integral part of BigFix Inventory. For more
information, see Available reports.
• User interface changes
User interface is updated in line with HCL brand for login window.
• Updated scanner
New version of Scanner for Windows to allow collection of additional properties for
Windows executables.
• IBM Virtualization Capacity reporting equivalent
BigFix Inventory 10.0.0.0 is equivalent to IBM License Metric Tool (ILMT) 9.2.18 for
IBM Virtualization Capacity reporting. For current status of IBM validated releases,
see BFI and HCL FAQ.pdf

• Enabler for reporting IBM Cloud Paks
BigFix Inventory reports information about utilization of license metrics by noncontainerized products that are installed as part of IBM Cloud Paks. For more
information, see: Licensing of non-containerized Cloud Pak programs.
• Inventory Exploration report becomes deprecated
Instead of the deprecated report, use the Software Summary report that provides
extended information about your software inventory. For more information, see
Available reports.
• Support for MS SQL 2016 Express and 2017 Express as a database for BigFix
Inventory
Express editions of MS SQL 2016 and 2017 are supported as a database for the
BigFix Inventory server. For specific requirements, see: Software requirements.
• Support for new platforms and systems
Support is introduced for the following platforms and systems:
◦ Citrix Hypervisor 8
◦ IBM i 7.4
◦ Oracle Compute Instance
• End of support for some operating systems and virtualization technologies
Support is dropped for the following operating systems and virtualization
technologies. If you are using any of them, upgrade to newer versions that are
supported by BigFix Inventory
◦ Operating systems
▪ Debian 7
▪ IBM i 5.1
▪ Oracle Solaris 10
▪ Red Hat Enterprise Linux 5 on x86
▪ Ubuntu 12
▪ Ubuntu 14
▪ Windows Vista

◦ Hypervisor and virtualization technologies
▪ Red Hat Virtualization 3.x
▪ VMware vSphere 5.x
▪ XenServer/ Citrix XenServer 6.x
• Security enhancements
To maintain security:
◦ IBM JavaJRE is updated to version: 8.0.6.5.
◦ WebSphere Application Server Liberty is upgraded to version 20.0.0.2.
◦ A number of libraries has been updated.

Application update 10.0.0
Detailed Component Version discovery for Oracle Java and Oracle

•
Weblogic

Starting from this release new mechanism is available for Patch level reporting.
Detailed Component Version discovery is supported by Extended Signature feature
and recent catalog content.
This functionality is available for:
◦ Oracle Java Runtime Environment
◦ Oracle Java JDK/SDK
◦ Oracle Weblogic
◦ Oracle Weblogic Enterprise Edition
◦ Oracle Weblogic Suite
•

Extension of the computer_hardware API association and related
computers report
◦ You can retrieve information about parent layer hostname.

•

IBM Virtualization Capacity reporting equivalent
◦ BigFix Inventory 10.0.0.0 is equivalent to IBM License Metric Tool (ILMT) 9.2.18
for IBM Virtualization Capacity reporting. For current status of IBM validated
releases, see BFI and HCL FAQ

•

User interface visual changes

◦ User interface visual changes in line with HCL brand.
•

Update of the end of support dates for IBM software
◦ Information about the end of support dates is refreshed for the IBM software
basing on the IBM Lifecycle data

•

Usability improvement to the user interface
To improve user experience, the following name changes are applied:
◦ Scan Health is renamed to Software Scan Health
◦ Missing Software Scan is renamed to Missing Scan
◦ IBM Capacity Data Completeness is renamed to Capacity Scan Health
◦ IBM Software Classification is renamed to Software Classification
◦ The Latest Software Scan column is renamed to Last Software Change

•

Support for DB2 11.5 as a database for BigFix Inventory server
DB2 11.5 is supported as a database for the BigFix Inventory server. For specific
requirements, see: Software requirements.

•

Security enhancements
To maintain security:
◦ IBM JavaJRE is updated to version: 8.0.6.0.
◦ WebSphere Application Server Liberty is upgraded to version 19.0.0.11.
◦ Several libraries for Ruby on Rails component are upgraded.

•

Support for new systems and hypervisors
The following new systems and hypervisors are supported:
◦ IBM z15
◦ AMD Epyc processor
◦ zCX (System Z Container Extensions)
◦ Nutanix on x86 with AHV

Application update 9.2.17
Support for new platforms and systems

•

The following platforms and systems are now supported:
◦ Hyper-V 2019
◦ Linux VMs on Nutanix AVH (IBM Power only)
◦ Red Hat Enterprise Linux 8 endpoints
◦ RHV 4.2 and 4.3 using new API available in RHV-M 4.x
• Important changes:
◦

Removal of the legacy IBM Software Classification panel
The IBM Software Classification was already deprecated and substituted
with Software Classification panel in application update 9.2.13. At this point,
the IBM Software Classification panel is entirely removed. The new Software
Classification panel allows simple software classification and ensures
better performance. It is fully customizable and allows you to create custom
classification rules.

◦

End of support for MS SQL 2008 and 2008 R2 database for BigFix
Inventory server
The support for MS SQL 2008 and 2008 R2 database for BigFix Inventory server
is discontinued. It is related to Microsoft officially ceasing the support in July
2019. For more information, see: Prepare now for end of support in 2019 and
2020 (Microsoft). To upgrade to BigFix Inventory 9.2.17, first migrate to newer
MS SQL version that is supported by BigFix Inventory. For the list, see: Software
requirements.

Application update 9.2.16
•

Drill down for better understanding of reported values on Software
Summary report extended to software usage statistics
You can additionally use drill down on Software Summary report to see the detailed
information about the software instances that contribute to software usage through

the related columns, for example, Used, Unused, Used in the Last Month and other
summary columns. For more information, see: Available reports.
Improved reporting of FlexPoints

•

◦ BigFix Inventory reports information about the highest license consumption of
FlexPoints over a specified reporting period for an entire FlexPoint bundle as
well as the contributing products.
◦ You can view the license metric utilization trends for the entire bundle, as well
as its components on the Metric Quantity History graph. The graph presents
information about the values calculated by the system and the values that are
declared by the user.
◦ Two new columns are now available on metric reports: Peak Date and Metric
Quantity. For more information, see: Report columns.
◦ The All IBM Metrics report shows only license consumption on a bundle level.
To see the detailed information about license consumption for the contributing
products, drill down by clicking the name of the bundle.
◦ Audit snapshot is extended with an additional file that outlines the usage
of FlexPoints in your environment. The flexpoints.csv file contains
information about the FlexPoint bundles and the underlying products.
For me information, see: IBM FlexPoints.
Setting metric quantity for license metrics that are not calculated by BigFix

•
Inventory

You can manually declare the metric quantity for selected license types for which
does not calculate license metric utilization out of the box. You can also use this
option to customize the metric quantity if needed. For more information, see: Setting
and removing the declared metric quantity.
•

Extension of the computer_hardware API association
You can retrieve information about additional hardware parameters, such as the serial
number, vendor, model, or type of the physical server. For more information, see:
computer_hardware association.

•

Custom rules for automatically suppressing components that meet
specified criteria

By specifying the relevant criteria, you can create the custom rule which automatically
suppresses the matching components in the future. For more information, see:
Creating and managing custom rules.
•

Extended support
◦ Support for new platforms and systems
▪ Certified support for the newest BigFix platform updates: 9.2.18 and
9.5.13
▪ Debian 9 x86 and x64
▪ SUSE Linux Enterprise Server 15 x86-64
▪ SMBIOS3 on Linux
▪ server on Windows 2019
▪ server on MS SQL 2017 version 14.0.3162.1 for fresh installations

•

Security enhancements
◦ Rails is upgraded to version 5.1.7 to maintain security.
◦ WebSphere Liberty Profile is upgraded to version 19.00.4 to maintain security.
◦ Update of the Xerces library to version 3.2.1 on AIX to keep the scanner secure
and reliable.

Application update 9.2.15.2
• Security enhancements
◦ WebSphere Liberty Profile is upgraded to version 19.00.4 to maintain security.

Application update 9.2.15
•

Preview feature: New Software Summary (Preview) report
The report provides an overview of software inventory in your environment. Each row
in the report represents a set of software instances that are grouped by the selected
columns. You can drill down the Software Summary report to view the details of the
instances in a group. The report also provides software usage statistics that contain
information about usage of the specific software based on the listed instances. You

can check how many instances of a product within the group are used and how many
are not. You can see an overview of software usage statistics from last month, last
quarter, and last year. You can also track the number of software instances within
the group for which software usage is monitored and for which it is not. For more
information, see: Available reports.
•

Extended reporting of usage statistics for Java
BigFix Inventory introduces a new and improved method of reporting usage for Java
Virtual Machine and Runtime Environments. Paths to Java processes that run on a
computer are matched with paths in which the software is discovered. Based on this
information, BigFix Inventory can determine exactly which Java instance was used.
It is possible to distinguish between usage of BigFix and Oracle Java installed on a
single computer. For more information, see: Monitoring and reporting software usage.
Software catalog in version 9.2.15 does not contain usage signatures for Java any
more. To report usage of Java, upgrade the BigFix Inventory server to version 9.2.15.

•

Extended support
◦ Support for new platforms
▪ Windows 2019
▪ Oracle SPARC-M8 processor
▪ Ubuntu 18.04 on x86
◦ Support for new virtualization technologies
▪ vCenter with external Platform Services Controllers (PSC) on different
computers
▪ Solaris Kernel zones on Oracle Solaris x86 and SPARC with nested
virtualization. For more information, see: Client installation on Oracle
Solaris

•

New Software Installations report that is based on the new data model
The new version of the Software Installations report is introduced. The old report is
deprecated and moved to the bottom of the Reports menu. It is planned to be entirely
removed in the future. The new report view is based on the new data model and
consistent with other reports. For more information, see: Available reports.

•

Extension of the To Do list

The To Do list is extended and additionally displays information about the outdated
scanning actions that need to be restarted. For more information, see: To Do list.
Documentation extended with new topics

•

Documentation is extended with new content, including the following help topics.
◦ Keeping BigFix Inventory up-to-date
◦ Software license optimization
◦ Tuning performance based on scalability guidelines
New look and feel of the user interface

•

The look and feel of the user interface is refreshed. The reports are now more vivid
with a new blue action bar, updated action icons and selected buttons.
Usability improvements on the management panels

•

Several improvements are introduced to simplify the navigation and usability of the
selected management panels, including Users, Saved Reports, Advanced Server
Settings and Contracts. You can use filters based on the available columns, and save
the custom view as a predefined view. You can also export these reports to a CSV or
PDF file.
Limitation: To filter the Contracts report by the All Computers computer group, use
its English name regardless of the interface language. The name of this group is not
translated.
Filtering reports by using matches exactly operator

•

You can filter reports and retrieve data from specified columns by using the matches
exactly operator. This operator is used to exactly match two values, including upper

and lowercase characters.
New naming convention for the exported reports

•

The names of report files that are exported, or received in a scheduled email follow a
new, more meaningful naming convention. Additionally, the email subject contains the
name of the predefined or custom report that is included.
Extended discovery of Oracle Databases certified for Oracle Database 18c:

•
18.3.

Discovery of new components from Citrix, Hewlett-Packard, Oracle and

•
other

The software catalog is extended to discover a number of new components from
Citrix, Hewlett-Packard, Oracle and other. To discover the components, ensure that
you upgrade BigFix Inventory to version 9.2.15.
Below is the list of the most important newly added components. To learn about their
exact versions, use the Software Catalog widget in BigFix Inventory to browse the
catalog content.
◦ Added discovery capability for Citrix products
▪ Citrix XenApp
▪ Citrix XenApp Reports
▪ Citrix XenDesktop
◦ Added discovery capability for Hewlett-Packard products
▪ HP Business Process Monitor
▪ HP Business Service Management
▪ HP Operations Agent
▪ HP Operations Manager
◦ Added discovery capability for Oracle products
▪ Oracle Clusterware
▪ Oracle Linux
▪ Oracle SOA Suite
•

Names of fixlets in the BigFix console contain information about version
Names of the fixlets are extended with the information about the currently available
version. By default, fixlet version is updated with each release of server. For more
information, see: Ensuring currency of scanner actions and fixlets.

•

Security enhancements
Rails is upgraded to version 5.0.7 to maintain security.

Application update 9.2.14
•

Reporting license usage for Adobe Creative Cloud products on Windows
reports utilization of the Registered User metric for Adobe Creative Cloud products.
The information is extracted during regular software scans directly from computers

where components of some Adobe Creative Cloud products are installed. Based
on the scan results, the Registered User metric is calculated and its utilization is
displayed on the All Metrics report. Detailed information about users is shown on the
Software Users report.
Thanks to this feature, you can track licenses of Adobe CC products in to analyze
trends, define thresholds and optimize costs by identifying users of unused instances.
For more information, see: Software Users report and Registered User.
•

Reporting license usage for BigFix Rational portfolio
Information about the usage of Floating User metric is now available on the All
Metrics report for BigFix Rational products. The calculations are available thanks
to integration with BigFix Rational License Key Server. The usage is provided by the
.slmtag files. For more information, see: Other IBM metrics.

•

Tagging software for more flexible categorization
You can now tag software components, or instances of the discovered software to
classify them. The tags might, for example, emphasize the ownership of a software
product, categorize it as a test or free of charge instance, or mark it as blacklisted or
approved. For more information, see: Adding and removing tags.

•

Preview feature: The new dashboard is extended with additional widgets
and quick search
The newest additions to the new BigFix Inventory dashboard include the summary
of the most important inventory data, recent changes, discovery gaps, and security
issues in one place. The dashboard is also extended with quick search that allows
you to easily find information related to file hashes, file names, vulnerabilities and
software inventory. For more information, see: Dashboard.

•

New predefined reports
New predefined reports are available under the Software Classification, Scanned File
Data and Computers reports. For more information, see: Available reports.

•
•

Reporting end of support dates for Microsoft products

The end of support dates are automatically populated for Microsoft software that
according to information provided on 20 November 2018 is announced to be out of
support between 30 November 2015 and 1 November 2021.
Best practices for configuring VM managers

•

Documentation provides best practices for configuring VM managers. For more
information, see: Best practices for configuring VM managers.
•

Top navigation bar extended with the

•

Changes in the Report menu

icon for providing feedback

The Software Catalog report is renamed to Products & Metrics. A link to Software
Components report is added under Reports in the main menu.
Users panel is expanded with the information about time and date of the

•
last login
•

Improvements on the VM Managers panel
Several improvements are introduced to simplify the navigation and usability of the
VM Managers panel. You can filter the report by any available column, and save the
custom view as a predefined view. You can also export the report to a CSV or PDF file.

•

Migrating software classification with REST API
The PUT operation on the /api/sam/v2/software_instances REST API allows you
to define, change, or migrate your current software classification. It can be used to
migrate your software assignments when moving clients between the instances
of BigFix server. For more information, see: Classifying software (v2) and Tutorial:
Migrating software assignments between two BigFix servers.

•

Retrieving information about the license utilization peak and the
contributing software instances through REST API in version 2
If you have custom tools or internal processes that use the software_instances
REST API, you can now achieve your goals by using the v2/license_usage and v2/
software_instances REST API. It is best to adjust the tools to use REST API in

version 2. For more information, see: Mapping functions of the software_instances
REST API.
•

Discovery of new components from Citrix, Oracle and SAP and other

The software catalog is extended to discover a number of new components from
Citrix, Oracle, SAP and other. To discover the components, ensure that you upgrade
BigFix Inventory to version 9.2.14.
Below is the list of the most important newly added components. To learn about their
exact versions, use the Software Catalog widget in BigFix Inventory to browse the
catalog content.
◦ Added discovery capability for Citrix products
▪ Citrix Diagnostic Facility
▪ Citrix PowerShell Snap-In
◦ Added discovery capability for Oracle products
▪ Oracle Discoverer
▪ Solaris
◦ Added discovery capability for SAP products
▪ SAP PowerBuilder
◦ Added discovery capability for Adobe CC 2019
◦ Improved usage reporting for Java products
•

Certification of Microsoft Edge browser
Microsoft Edge is certified as a supported browser for BigFix Inventory. For more
information, see: Software requirements.

•

Support for new virtualization technologies
◦ <deprecated> Oracle VM Server for x86 3.4.x
◦ Solaris Kernel zones on x86 without nested virtualization (not yet announced
as BigFix subcapacity eligible). For more information, see: Client installation on
Oracle Solaris.
◦ SLES 11 for PowerVM on Power9 in Power8 compatibility mode.
◦ SLES 12 for PowerVM on Power9 in native mode.
◦ SLES 15 on Power9 with disconnected scanner in P9 native mode.

•

Security enhancements
◦ To maintain security, Java is upgraded to the newest version: 8.0.5.25.
◦ WebSphere Application Server Liberty is upgraded to version 18.0.0.3.
◦ Update of the Xerces library to version 3.2.1 on Solaris Sparc and Solaris x86 to
keep the scanner secure and reliable.

•

Information about the session time out after a period of user inactivity
The session timeout specifies the period of user inactivity after which the session
ends, and the user is required to log in again. Before it happens, you are notified that
the session is about to end.

Application update 9.2.13
•

Utilization of the Registered User metric for Microsoft Office 365
reports utilization of the Registered User metric for Microsoft Office 365. The
information is extracted during regular software scans directly from computers where
components of Office 365 are installed. Based on the scan results, the Registered
User metric is calculated and its utilization is displayed on the All Metrics report.
Detailed information about users is shown on the Software Users report.
Thanks to this feature, you can track licenses for Office 365 in to analyze trends,
define thresholds and optimize costs by identifying users of unused instances. For
more information, see: Registered User.

•

Reporting additional IBM metrics based on the resource utilization data
that is delivered by .slmtag files
Additional IBM metrics that are based on the resource utilization data are displayed
on the All IBM Metrics and All Metrics reports. scans computers in your infrastructure
to find the software components that are reported with .slmtag files and then
aggregates their metric quantity. For more information, see: Reported license metrics.

•

Version currency of Internet browsers and other selected software that
changes frequently
BigFix Inventory automatically detects all versions of a number of software
components on Windows. These components include Internet browsers (Chrome,
Edge, Firefox, and Opera) as well as components such as Adobe Air, Adobe Flash
Player, Slack, and other. The components are detected by generic signatures
while their versions are automatically retrieved from files or packages that caused
detection. Such an approach allows for avoiding catalog gaps and ensures full
discovery currency.

Reporting utilization of FlexPoints

•

FlexPoint is a license metric unit that can be used to determine the cost of IBM
products that are purchased as part of FlexPoint bundles. Each product from a bundle
is licensed based on a different license metric but all metrics are converted into
FlexPoints. Products that are currently available as part of FlexPoint bundles are
products from the IBM Cloud and IBM Analytics brands. For more information, see:
IBM FlexPoints, and Classifying FlexPoint bundles.
Preview feature: Visibility of Common Vulnerabilities and Exposures

•
(CVEs)

◦ Information about CVEs is shown on the Software Classification report on which
CVEs are matched with software components through component detailed
versions.
◦ The details of CVEs are extended to include a link to a description of the CVE in
the National Vulnerability Database as well as the version of the CVSS, either 2.0
or 3.0.
◦ Information about CVEs can be filtered and sorted by the CVE name. The filter
shows the software that meets the specified criteria by searching through the
full list of CVEs of each reported software instance.
Thanks to the improvements in showing information about CVEs you can better
identify, monitor, and analyze potentially vulnerable software and at the same time
prevent potential threats.
•

New predefined reports available under Software Classification panel
The Software Classification report is extended with four predefined views:
◦ Out of Support Software that shows software installations for which support
already ended
◦ Software Approaching End of Support that shows software installations for
which support ends within the next three months
◦ Vulnerable Software that shows software installations for which at least one
CVE was matched
◦ Vulnerable Software - Recent that shows software installations that were
discovered within the last two weeks and for which at least one CVE was
matched

The views provide you with a quick overview of software that might pose security
threats in your environment.
•

Preview feature: Security dashboard and reporting
The new security dashboard shows a preview of security features in the form of
widgets. To view the dashboard, click Go to New Dashboard & Reporting on the
homepage. For more information, see: Dashboard.

•

New To Do list on the top navigation bar
The top navigation bar is extended with a To Do list that, at present, displays the
following information under the

icon:

◦ Failed imports of data
◦ Availability of a new version of the application
◦ The need to configure connections to virtualization hosts for some of the
computers
The relevant information is indicated with a number that is displayed on the icon. The
number is shown until you take action to address the displayed information. For more
information, see: To Do list.
•

Information about the shared processor pool
displays information about the identifier of the shared processor pool under the
Shared Pool ID column on the Hardware Inventory, Computers, Software Installations,
Oracle Databases and Software Classification reports.

•

REST API associations for quick analysis of security risks
The /api/sam/v2/software_instances REST API is extended with two associations:
◦ cve that allows to retrieve information about Common Vulnerabilities and
Exposures (CVEs) that were matched with a particular component through its
detailed version
◦ release_component_lifecycle that allows to retrieve information about when
a component reaches its end of support
The associations provide you with a method for retrieving information about software
that might pose security threats by using REST API.

•

Filtering reports and retrieving data through REST API request by using is
empty and is not empty operators

You can filter reports and retrieve data from specified columns by using the is empty
and is not empty operators.
•

Support for server on MS SQL 2016
server is now supported on MS SQL 2016 for fresh installations. If you used MS SQL
2016 with earlier versions of the product, see: Software requirements.

•

Discovery of new components from Citrix, Symantec, Oracle and other
The software catalog is extended to discover a number of new components from
Citrix, Symantec, Oracle and other. To discover the components, ensure that you
upgrade BigFix Inventory to version 9.2.13.
Below is the list of the newly added components. To learn about their exact versions,
use the Software Catalog widget in BigFix Inventory to browse the catalog content.
◦ Added discovery capability for Citrix products
▪ Citrix Edgesight
▪ Citrix Presentation Server
▪ Citrix XenDesktop
◦ Added discovery capability for Symantec products
▪ Veritas Cluster Enterprise Agents
▪ Veritas Cluster Server
▪ Veritas Cluster Server Bundled Agents
▪ Veritas Cluster Server Disk Reservation Modules and Utilities
◦ Added discovery capability for Oracle products
▪ Oracle Clusterware
▪ Oracle GoldenGate
▪ Sun Cluster HA for WebSphere MQ

•

List of software components with end of support dates is updated
The information about the end of support dates is refreshed for your BigFix software
components for which the dates were announced since the last update of the list. The
data is based on the information contained in BigFix Lifecycle in September.

•

Performance improvements
◦ The import of VM Manager data is optimized to decrease the processing time.

•

Security enhancements

◦ Java is upgraded to the newest version to maintain security.
◦ TLS 1.2 is enabled in BigFix Java by default.
◦ WebSphere Application Server Liberty is upgraded to version 18.0.0.2 to address
CVE-2018-1553.
◦ Update of the Xerces library to version 3.2.1 on Windows to keep the scanner
secure and reliable.
• Support for new virtualization technologies
◦ vSphere ESXi 6.7 and vSphere vCenter Server 6.7.
•

End of support for migration from License Metric Tool (LMT) and Tivoli®
Asset Discovery for Distributed (TAD4D) version 7.x
Starting from 1st October 2018, migration from License Metric Tool 7.x and Tivoli®
Asset Discovery for Distributed 7.x will no longer be supported. The support will not
be available regardless of the version of License Metric Tool 9.x or BigFix Inventory
9.x that you are using. For more information, see: End of support for migrating from
LMT and TAD4D version 7.x.

Application update 9.2.12
•

Reporting detailed hardware information
BigFix Inventory introduces a detailed hardware scan that allows you to retrieve
detailed hardware information related to memory, operating systems, storage,
processors, partitions, network adapters, SMBIOS data, IP addresses and logical
processor capacity data. You can use the collected information to report and monitor
hardware in your infrastructure. The new scan gives you a clear overview of your
physical assets. For more information, see: Detailed hardware scan.

•

Preventing security threats with information about Common Vulnerabilities
and Exposures (CVE) added to the software catalog
Common Vulnerabilities and Exposures (CVE) is a list of known security threats
that are assigned identification numbers. BigFix Inventory uses CVE that is provided
by the National Vulnerability Database to help you identify potential threats in your
environment. In this release, BigFix Inventory presents initial integration with National
Vulnerability Database as a preview feature. Thanks to the visibility of potentially

vulnerable software, it is possible to identify and prevent potential threats. For more
information, see: Preview: Checking Common Vulnerabilities and Exposures (CVEs).
•

Retrieving information about the discovered software component as
specified in the Common Platform Enumeration (CPE) dictionary
Common Platform Enumeration is a standardized naming scheme for software. This
information is available in REST API for integration scenarios. BigFix Inventory uses
the CPE dictionary to match CVEs and indicate known vulnerabilities in software
products. You can analyze and compare the CPEs based on the data feeds provided
by BigFix Inventory with other sources, such as CVEs that are available in the National
Vulnerability Database. For more information, see: component_cpe association.

•

Enhancements to reporting end of support dates
The end of support dates for selected BigFix software products and components
for which the information has been announced are now available on the Software
Classification panel. Additionally, a new Predefined End of Support column is available
on the Software Components report. The column indicates whether the end of
support date was provided by BigFix or was specified manually by a user.

•

Using Review Lite script for extended discovery of Oracle databases
Review Lite is a standard script used by the Oracle auditors to control the number of
Oracle licenses within a company. BigFix Inventory allows you to automatically run
this script on all computers in your environment. The results are interpreted by BigFix
Inventory which provides you with an overview of the report that you are required
to deliver to the auditors. For more information, see: Discovering usage of Oracle
Database features.

•

Automatic scanning of remote shared disks
Until now, remote shared disks could only be scanned with a manual procedure.
With the newest release of BigFix Inventory, you can optimize this process and set
up automatic scans. As a result, a single computer is designated to scan a specific
shared disk and discover the installed software. The data is then automatically
populated to all computers on which the same shared disk is mounted. For more
information, see:Discovering software on shared disks.

•

Collecting utilization data of SAP license metrics with License
Administration Workbench 2.0
Support for collecting SAP license metric utilization data is extended to License
Administration Workbench (LAW) 2.0. LAW 2.0 allows the creation and storage
of multiple consolidations. SAP Metric Data Collector uses these consolidations
to display the SAP utilization data in BigFix Inventory. For more information, see:
Collecting utilization of SAP license metrics.

•

Flexible license management by specifying the type of relation between a
component and a product as charged or not charged based on the specific license
agreement
BigFix Inventory allows you to specify the individual relation between a product and
a component as charged or not charged. For example, when the existing relation
between the component and the product is charged, but your license agreement
states that the component is not charged.

•

Refreshing scan data on a computer through the Support Page
When the software scan, capacity scan, or VM Manager Tool scan finishes
successfully on a particular computer but its results are not uploaded to the BigFix
server, you can force upload of the data. You can do it directly from BigFix Inventory
without the need of accessing the BigFix console and running a separate fixlet
for each type of scan. For more information, see: Troubleshooting problems with
computers.

•

Resuming a connection to the VM manager
You can resume a connection to a VM manager that is in the Invalid credentials suspended status by clicking the Resume button on the VM managers panel. For more
information, see: Understanding the VM Managers panel.

•

Information about full version of already discovered files
Scanned File Data report displays the full version of discovered files. After upgrade,
the data is imported to BigFix Inventory during a number of consecutive data imports
to avoid performance issues. Each consecutive import contains data from 10000
computers.

•

Extension of audit snapshot

Audit snapshot is extended with the following information.
◦ The PVU audit snapshot package is extended with an
audit_snapshot_summary.csv report. The report contains a summary of all
software products that were installed in your environment during the period for
which the snapshot is generated and which are charged. For more information,
see: Content of the audit snapshot.
◦ Charged column is added to the audit snapshot report. It indicates whether
the relation between the component and the product is charged based on the
license terms.
A new link to Learning Resources under Help

•

The list of quick links under Help

is updated with the link to Learning Resources

on the BigFix Security Learning Academy. The site consists of video tutorials for the
product.
•

Security enhancements
◦ Java upgrade which addresses the following CVEs: CVE-2018-2633,
CVE-2018-2618, CVE-2018-2603, CVE-2018-2602, CVE-2018-2579,
CVE-2018-1417, CVE-2018-2783, CVE-2018-2794.
◦ Update of the Xerces library to version 3.2.1 on Linux to keep the scanner secure
and reliable.

•

Support for new virtualization technologies
◦ Power VM on Power9 on AIX, IBM i and Linux.
◦ KVM on IBM Power8.
◦ Management of Citrix Xen through VM manager.

•

Deprecated content
The following reports and panels are deprecated with this application update:
◦ Usage Properties
◦ Package Properties
◦ UNIX Package Properties
◦ Current State Values

Application update 9.2.11
•

Improved license planning and prevention of security risk by setting up and
monitoring end of support dates for specific software
BigFix Inventory provides end of support dates for BigFix software components as
announced in BigFix Lifecycle. You can also specify the dates manually, both for
IBM and non-IBM components. You can use this information to easily define license
demand for the future. You can also use it for security purposes. For example, to
determine whether software installed on a computer that is under investigation is still
supported.

•

Utilization of the Virtual Processor Core (VPC) metric for BigFix products
BigFix Inventory measures utilization of the Virtual Processor Core (VPC) metric.
The metric is based on the number of virtual cores (vCPUs) that are available to the
product. VPC consumption is reported on the physical server level as well as across
servers similarly to other license metrics such as PVU. For more information, see: IBM
Virtual processor core (VPC).

•

Introduction of the Package Data Summary report
The Package Data report lists software packages that are discovered on the
computers in your infrastructure. You can find out what is the name of every package,
its version, vendor, description, and type. Every occurrence of the package is listed as
a separate row on the report.
This application update introduces the Package Data Summary report. The report
provides an aggregated view of the discovered packages with a number of times each
package appears in the infrastructure. This number is a hyperlink that brings you to
the detailed list of computers where the package is deployed.
From the Package Data Summary report, you can generate software signatures with
one click. You can also select multiple packages and create signatures in bulk. As a
result, the process of creating signatures from package data is simplified. You can
easily create software signatures for up to 20 components at once. Additionally, the
report provides information about which packages were already used as signatures

so you can focus only on the remaining ones. For more information, see: Available
reports and Creating signatures from package data.
Reporting information about the detailed version of Windows applications

•

Installed software components that are detected based on the presence of specific
files are reported with a detailed version which is the same as the file version. The
information is shown in the Component Detailed Version column on the Software
Classification report. The information can help you decide whether versions of
installed software components are covered by your entitlements and are in line
with the company policy. It can also be used for security purposes. For example,
to check whether the latest security patches are installed or whether versions with
vulnerabilities exist in the infrastructure.
Discovery of new components from Windows, Corel, Adobe, Symantec and

•
SAP

The software catalog is extended to discover a number of new components from
Windows, Corel, Adobe, Symantec and SAP. To discover the components, ensure that
you upgrade BigFix Inventory to version 9.2.11.
Below is the list of the newly added components. To learn about their exact versions,
use the Software Catalog widget in BigFix Inventory to browse the catalog content.
◦ Added discovery capability for Windows products
▪ Windows Defender
◦ Added discovery capability for Corel products
▪ CorelDraw Graphic Suite
◦ Added discovery capability for Adobe products
▪ Adobe Flash Player
▪ Adobe Lightroom CC
▪ Adobe Lightroom Classic
◦ Added discovery capability for Symantec products
▪ Altiris Deployment Solution Agent
▪ Altiris Patch Management Agent
▪ Symantec Encryption Desktop
▪ Veritas Enterprise Vault

◦ Added discovery capability for SAP products
▪ Sybase Central
Simplification of updating the software catalog

•

The process of updating the software catalog is simplified. You simply need to run the
Software Catalog Update task that downloads the software catalog, and automatically
uploads it to the BigFix Inventory server during the next import of data. Manual upload
of the software catalog through the BigFix Inventory user interface is no longer
needed. For more information, see: Manually updating software catalog.
Optimizing data imports thanks to enabling a new schema of the BigFix

•
database

The process of importing data from BigFix to BigFix Inventory is optimized thanks to
using an improved schema of the BigFix database. The improved schema is enabled
by default in fresh installations and during upgrades from earlier versions. The only
requirement is to have the BigFix server in version 9.5.5 or higher.
•

Preventing accumulation of unprocessed data in case of failing imports
When the imports of data are failing for a longer period of time, you can enable
skipping certain import steps. In such a case, the import continues even if
these steps fail. When the import finishes, it is marked as partial because only
data from successfully completed steps is processed. Enabling partial imports
allows for quicker system recovery after a problematic import and prevents
accumulation of unprocessed data. For more information, see the description of the
enable_partial_imports parameter in: Advanced server settings.

Application update 9.2.10
•

Reporting usage of products such as Microsoft Office at suite level
aggregated per computer
The Usage per Computer report shows product usage aggregated per computer so
that you can easily identify where the product is deployed and how frequently it is
used. Based on this information, you can decide whether you want to extend the
license for this product or not.

For product suites such as Microsoft Office, the usage is reported for the entire suite
rather than separately for Word, PowerPoint, Excel, and other components. By default,
the report is calculated regularly after every import, but you can also configure it to be
calculated on demand. For more information, see: Available reports.
•

Collecting and measuring utilization of SAP license metrics
This application update provides an end-to-end automation process for scheduling
generation and retrieval of SAP license utilization reports by leveraging the provided
ABAP plug-in. The process can now be handled entirely by the Administrator of BigFix
Inventory without the need to engage the SAP Administrator.
Once the SAP license utilization reports are processed by BigFix Inventory, the related
SAP license usage data is available on the Resource Utilization report. For more
information, see: Measuring and collecting utilization of SAP license metrics.

•

Adding products to the software catalog
You can easily add a custom product and the license metric that it uses to the
software catalog. You can then assign the relevant components to this product so
that your software classification is correct. For more information, see: Adding a new
product to software catalog.

•

Information about imported part numbers that influenced the initial
classification is visible on the Software Classification panel
Part numbers that are available on Passport Advantage represent products that
you purchased and license metrics that these products use. When you upload part
numbers to BigFix Inventory, they affect the default assignment of components.
Information about part numbers which caused that a component was assigned to a
particular product is displayed on the Software Classification panel. The information
gives you a better understanding of rationale behind the default classification that
was proposed.

•

REST API for advanced integration and data sharing
You can retrieve information about utilization of license metrics, query and set
thresholds of the utilization as well as query and set values of custom fields by using
the api/sam/v2/license_usage REST API. For more information, see: Retrieval of

license metric utilization (v2) and Setting license metric thresholds and custom field
values (v2).
You can also retrieve computer properties, including custom computer properties, by
using the computer_details association for the api/sam/v2/computers REST API.
For more information, see: computer_details association.
New computer status - Outdated VM Manager Data

•

When hardware inventory data is not retrieved from a VM manager for more than 30
days, default PVU counting is applied and higher utilization might be reported. To
allow the Infrastructure Administrator to troubleshoot problems with VM manager
connection before they affect the reports, the Outdated VM Manager Data status is
introduced. The status indicates that there are problems but license metric utilization
is not yet affected. For more information, see: Computer statuses.
Stand-alone scanner for monitoring isolated HP-UX computers

•

If some of your HP-UX computers cannot be managed from a central location due
to security reasons, you can discover software and hardware inventory by using
disconnected scans. Scan results are placed in files that can be later on used to
import the collected data to the BigFix Inventory server. For more information, see:
Discovering software and hardware with disconnected scanner on Windows and
UNIX.
•

Information about the number of partition cores
The number of partition cores that were assigned to a virtual machine when the peak
of the metric value occurred is shown in the Partition Cores column on the All Metrics
report and in the audit snapshot. You can use the information to better understand
how particular VMs contributed to license metric consumption. For more information,
see: Report columns.

•

Discovery of new components from HP, SAP, BMC and other
The software catalog is extended to discover a number of new components from
Oracle, SAP, and Red Hat. To discover the components, ensure that you upgrade
BigFix Inventory to version 9.2.10.
Below is the list of the newly added components. To learn about their exact versions,
use the Software Catalog widget in BigFix Inventory to browse the catalog content.

◦ Added discovery capability for HP products
▪ HP Application Lifecycle Management
▪ HP Business Process Monitor
▪ HP GlancePlus
▪ HP OpenView Internet Services
▪ HP OpenView Performance Agent
▪ HP-UX Image Viewer Subsystem
▪ HP-UX LAN Link Product
▪ Mercury Business Availability Center
▪ Mercury Interactive Quick Test Professional
◦ Added discovery capability for SAP products
▪ BusinessObjects Enterprise
▪ Crystal Reports .NET Server
▪ SAP BusinessObjects WebIntelligence
▪ SAP Crystal Reports
▪ SAP SQL Anywhere Network Database Server
▪ Sybase PowerDesigner
▪ Sybase Software Developer Kit
◦ Added discovery capability for BMC products
▪ BMC Atrium Orchestrator
▪ BMC Batch Impact Manager
▪ BMC BladeLogic RSCD Agent
▪ BMC Control-M Agent
▪ BMC Control-M CM For Advanced File Transfer
◦ Added discovery capability for CA products
▪ CA Erwin Data Modeler
▪ CA Application Management .NET Agent
▪ CA ARCserve Backup Diagnostic Utilities
▪ CA Clarity and Portfolio Management
▪ CA ControlMinder
▪ CA eHealth
▪ CA Erwin Data Modeler License Server

▪ CA Erwin Mart Server
▪ CA Plex
▪ CA Process Automation Orchestrator
▪ CA SiteMinder
▪ CA SiteMinder Web Agent
▪ CA Spectrum
▪ CA Unicenter CA-XCOM Data Transport
▪ CA Unicenter DSM Agent + Remote Control Plugin
▪ CA Unicenter NSM
▪ CA Unicenter Software Delivery
▪ CA Universal Job Management Agent
◦ Added discovery capability for Tibco products
▪ Tibco ActiveMatrix Adapter for Database
▪ Tibco ActiveMatrix BusinessWorks Service Engine
▪ TIBCO Designer
▪ Tibco Hawk
▪ TIBCO iProcess Workspace
▪ TIBCO Spotfire
▪ TIBCO Third-Party Core Libraries
◦ Added discovery capability for Veritas products
▪ NetBackup Bare Metal Restore
▪ NetBackup for Microsoft Exchange Server
▪ NetBackup for Microsoft SQL Server
▪ NetBackup for SAP
▪ NetBackup for Vmware
▪ NetBackup Remote Administration Console
▪ Symantec System Recovery
Optimizing the import of data

•

You can optimize the process of importing data from BigFix to BigFix Inventory. The
option is available for BigFix 9.5.5 and higher. To enable the feature, change the value
of the schema_next parameter to true. For more information, see: Advanced server
settings.

Serviceability improvements

•

To avoid a situation in which the import of data fails due to deadlocks of SQL queries,
the step during which the deadlock occurs is retried up to 5 times before the import
fails.
•

Support for Docker containers under Red Hat OpenShift
BigFix Inventory supports software discovery on Docker containers under the Red
Hat OpenShift container application platform. For more information, see: Discovery of
software in Docker containers.

Application update 9.2.9
•

Reporting of SAP license usage with integration of SAP License
Administration Workbench (SLAW) and SAP USMM
You can have reports of SAP license usage consolidated into BigFix Inventory by
integration with the SLAW and USMM tools. The measurements from all SAP systems
in the SAP landscape are transferred to the central SAP and combined into one SLAW
report. You can integrate the report into BigFix Inventory so that utilization of license
metrics for SAP products is shown on the Resource Utilization report. The capability
is available for all SAP products that can be measured by SAP SLAW and USMM tools.
For more information, see: Collecting utilization of SAP license metrics.

•

Discovery of Oracle Database extended to Solaris
Reporting of Oracle Databases is extended to Solaris 10 and 11 for all discoverable
versions. You can retrieve granular information about the edition (Standard or
Enterprise), options, Management Packs (including Oracle Real Application Cluster,
RAC), and user concurrent sessions of Oracle Databases that are deployed in your
environment. For more information, see: Extended discovery of Oracle Database.

•

Discovery of new components from Oracle, SAP, and Red Hat
The software catalog is extended to discover a number of new components from
Oracle, SAP, and Red Hat. To discover the components, ensure that you upgrade
BigFix Inventory to version 9.2.9.

Below is the list of the newly added components. To learn about their exact versions,
use the Software Catalog widget in BigFix Inventory to browse the catalog content.
◦ Added discovery capability for Oracle products
▪ Oracle Business Process Management Suite
▪ Oracle Database Gateway for APPC
▪ Oracle Database Gateway for Informix
▪ Oracle Database Gateway for Microsoft SQL Server
▪ Oracle Database Gateway for ODBC
▪ Oracle Database Gateway for Sybase
▪ Oracle Database Gateway for Teradata
▪ Oracle Database Gateway for WebSphere MQ
▪ Oracle JRockit
▪ Oracle Procedural Gateway for APPC
▪ Oracle Transparent Gateway for DRDA
▪ Oracle Transparent Gateway for Microsoft SQL Server
▪ Oracle Transparent Gateway for Sybase
▪ Oracle Transparent Gateway for Teradata
◦ Added discovery capability for SAP products
▪ SAP Crystal Server
▪ Sybase Adaptive Server Enterprise
▪ Sybase Enterprise Connect Data Access
▪ Sybase IQ Server
▪ Sybase Replication Server
◦ Added discovery capability for Veritas products
▪ Veritas NetBackup Client
▪ Veritas NetBackup Media Server
◦ Added discovery capability for CA Technologies products
▪ CA Unified Infrastructure Management
▪ CA Unified Infrastructure Management Snap
◦ Added discovery capability for Red Hat Technologies products

▪ Red Hat JBoss Data Grid
▪ Red Hat JBoss Enterprise Application Platform
▪ Red Hat Satellite Server
◦ Added discovery capability for AXWAY products
▪ Axway Transfer CFT
▪ Axway Transfer Interpel
◦ Added discovery capability for RES products
▪ RES ONE Automation Agent
▪ RES ONE Automation Console
▪ RES ONE Automation Dispatcher
Adding custom fields to license metric reports

•

You can extend information that is related to software products by adding custom
fields on the All Metrics report and its derivatives. The information can be of any type
and therefore can help you better identify ownership and purpose of the discovered
products as well as license management information such as purchase orders,
product owners or other. After the information is added, you can use it to create
filtering and grouping criteria such as contract name, placement, allocation, date,
or other. For more information, see: Adding custom information to license metric
reports.
•

Reporting information about the detailed version of software components
The installed software components that are detected with software identification
tags are reported with the detailed version, on condition that the tag collects this
information. The information is shown in the Component Detailed Version column. It
can help you decide whether versions of the installed software instances are covered
by your entitlements and are in line with the company policy. It can also be used for
security purposes, for example to check whether the latest patches are installed
for security purposes. For the components that are discovered with other detection
methods, the values in Component Detailed Version and Component Version columns
are duplicated.

•

Stand-alone scanner for monitoring isolated AIX computers
If some of your AIX computers cannot be managed from a central location due
to security reasons, you can discover software and hardware inventory by using

disconnected scans. Scan results are placed in files that can be later on used to
import the collected data to the BigFix Inventory server. For more information, see:
Discovering software and hardware with disconnected scanner on Windows and
UNIX.
•

Filtering the Package Data report to view the packages that can be used to
create new software signatures
Package Data report is extended with information about which of the packages that
are discovered in your infrastructure are already used as software signatures. Thus,
it is easier to identify which packages can be used to extend software discovery. To
narrow down the Package Data report to packages that can be used to create new
software signatures, filter the Package Data report by the Recognized and Caused
Detection columns.

•

Improved security of storing VM manager passwords
You can overwrite the default key that is used to encrypt VM manager passwords or
change the default password to the VM Manager Tool keystore. For more information,
see: Improving security of storing VM manager passwords.

•

Configuring LDAP server that uses load balancer to preserve server
certificates
If your LDAP server uses load balancer that dynamically changes the list of hosts, and
the connection between LDAP and the BigFix Inventory server is secure, set up the
BigFix Inventory server to preserve certificates of the LDAP server.

•

User interface improvements
The following user interface improvements are introduced:
◦ The look and feel of the application is improved to be more in line with other
BigFix applications.
◦ A panel that is used for configuring the collection of data that is displayed on
the Unrecognized Scan Data report is removed. Collection of the data is now
enabled by setting a parameter that is available on the Advanced Server Settings
panel.

•

Scanner improvements
The following scanner improvements are introduced:

◦ The scanner provides support for a wider range of national characters.
Character encoding in scan outputs and in scan configuration files is in the
UTF-8 format.
◦ 64-bit version of the scanner is available for AIX. The 32-bit version is removed.
•

Version of the application build visible in PDF reports
The PDF reports that are generated in BigFix Inventory contain detailed
information about the version of the application. The information can be helpful for
troubleshooting purposes.

•

Software catalog enhancements
The Software Catalog column is replaced with a set of columns that define the
organization that provides the definition of a component, product, publisher, release,
signature and version. For more information, see: Report columns.

•

Changes in PVU calculation on PowerKVM
Rules of counting subcapacity licenses on PowerKVM systems were clarified and
multithreading no longer impacts the number of reported cores. BigFix Inventory is
adjusted to the change and thus the number of PVUs that it reports is lower. For more
information, see: Subcapacity (Virtualization) License Counting Rules.
To ensure that the change in counting rules is reflected in BigFix Inventory, restart
the Run Capacity Scan on Virtualization Hosts fixlet and run the import of data. The
reported value might not change immediately, as the report shows the peak value.

Application update 9.2.8
•

Utilization of the Single and Dual Physical Processor metrics for Microsoft
Windows Server
BigFix Inventory measures utilization of the Single Physical Processor and Dual
Physical Processor metrics for Microsoft Windows Server. You can use the
information to calculate the license demand for this product. The feature is supported
for Windows Server 2008 R2 Datacenter, Windows Server 2012 Datacenter, and
Windows Server 2012 R2 Datacenter. For more information, see: Microsoft Single and
Dual Physical Processor.

Utilization of the Oracle Processor Core metric for Oracle Databases

•

Reporting of Oracle Databases is enhanced by processing the core factor and
measuring utilization of the Oracle Processor Core metric. You can use the
information to calculate the license demand for Oracle Databases without the need to
manually calculate core factors. The feature is supported for all discoverable versions
of Oracle Database (Enterprise Edition). For more information, see: Oracle Processor
Core.
•

Reporting software installed on shared disks based on software templates
To ensure completeness of software discovery, it is necessary to collect data from
shared disks. The solution that was available in the previous application updates
could be resource-consuming when shared disks were used extensively. The new
solution is based on creating software templates which allows for limiting the impact
of the shared disks scan on the performance of the infrastructure.
To report software that is installed on a shared disk, one of the computers on which
the disk is mounted is scanned to create a software template. Then, the template is
replicated within a computer group that contains other computers on which the same
disk is mounted. For more information, see: Discovery of software on shared disks
and Limiting scope of automated scan.

•

Collecting executable files based on application usage
To improve software discovery on Linux and Solaris systems, you can use files
associated with processes that have been run on the computers in your infrastructure,
regardless of their extension. These files, with supplementing information such
as path and size, are available on the Scanned File Data report and can be used to
create custom discovery and usage signatures for software components. For more
information, see: File system scan.
To use this feature, you require the BigFix server and client in version 9.5.5 or higher.
Collecting the files is enabled by default for new installations. If you are upgrading
from earlier versions, restart the Initiate Software Scan actions, and start them again
by using the new version of the fixlet. Ensure that you run the file system scan and
application usage statistics scan.

•

Version 2 of REST APIs for software and hardware inventory

New REST APIs for software inventory (api/sam/v2/software_instances) and
hardware inventory (api/sam/v2/computers) provide the following improvements:
◦ Historical information about uninstalled software and removed computers
◦ Complete information about software classification, including product to which
the component is assigned and its license metric as well as the status of
confirmation, exclusion, and suppression
◦ Associations that allow for retrieving additional hardware inventory information,
computer health or usage data with a single REST API call
◦ Improved security to ensure that a user who has access to a subset of
computers can retrieve data only from these computers
The APIs are planned to substitute the following existing APIs: software_inventory
and computer_systems. For more information, see: Retrieval of software inventory
(v2) and Retrieval of hardware inventory (v2).
•

Assigning a new license metric to an existing product
When your license terms define that a particular product uses a specific license
metric but such a relation is not available in the software catalog, you can assign any
of the license metrics available in BigFix Inventory to any of the products. It gives
you more flexibility to accommodate the assignment of license metrics to products
in accordance with your contract terms. For more information, see: Assigning an
additional metric to a product.

•

Configuration of user account lockout
To increase BigFix Inventory security, you can set conditions under which user
account is locked. You can set the maximum number of failed login attempts, the
period within which these attempts must occur for the account to be locked, and
the period for which the account is locked. By default, user account is locked for 5
minutes after the user attempts to log in to BigFix Inventory more than 10 times within
5 minutes. For more information, see: Configuring user account lockout.

•

Stand-alone scanner for monitoring isolated Solaris computers
If some of your Solaris computers cannot be managed from a central location due
to security reasons, you can discover software and hardware inventory by using
disconnected scans. Scan results are placed in files that can be later on used to

import the collected data to the BigFix Inventory server. For more information, see:
Discovering software and hardware with disconnected scanner on Windows and
UNIX.
Automatic decommissioning of computers that are inactive for a specified

•

period of time
When infrastructure management policy makes a process of deleting
decommissioned clients in BigFix difficult or impossible, you can enable automatic
decommissioning of inactive computers directly in BigFix Inventory. Inactive
computers are then decommissioned after a specified period of time, and are no
longer included in metric calculation. For more information, see: Automatically
decommissioning inactive computers.
Fixlet for collecting logs to troubleshoot problems with computers

•

If you are asked to provide data for troubleshooting problems with computers in
your infrastructure, you can run the Collect Logs from Endpoints fixlet, and provide
the generated output to BigFix Support. The output contains log files needed for
troubleshooting purposes. For more information, see: Troubleshooting problems with
computers.
Viewing all signatures that are defined for a component in the software

•
catalog

When a component that is installed in your infrastructure is not discovered, you can
check signatures that are defined for that component in the software catalog. You
can then use this information to troubleshoot software discovery. To find the list of
signatures, use the Software Catalog widget and search for the component. The list of
all signatures is displayed on the component details page. For more information, see:
Troubleshooting software discovery.
•

Improvements of the VM Manager tool
VM Manager tool is further enhanced to attempt to automatically fix common
problems with the VM manager connection parameters. For example, it tries using a
default port or a different URL suffix as well as changing the VM manager type. It also
tries to correct more than one mistake at a time.

•

Improved browsing of the software catalog content

Browsing the Software Catalog report is improved so that it is more intuitive and
consistent.
•

Serviceability improvements
To improve serviceability of the application, the following enhancements are
introduced:
◦ BigFix Inventory can reconnect to its database when the active connection was
reset or closed without the need of restarting the application server.
◦ Logging of the disconnected scanner on IBM i is improved.

•

Information about supported operating systems can be dynamically
generated through SPCR
Information about operating systems and hypervisors that are supported by
each component of BigFix Inventory including the server, the BigFix client, and
disconnected scans is moved to the Software Product Compatibility Reports
(SPCR). You can dynamically generate reports with information about specific
operating system or hypervisor, as well as selected components. To view predefined
reports generated per component and per operating system, see: Detailed System
requirements.

•

Support for new operating systems and public clouds
You can install the BigFix Inventory server on Windows Server 2016. You can also
identify computers as running on the Google Compute Engine public cloud. For more
information, see: Detailed System requirements.

•

Discovery of new components from Oracle, SAP, and Red Hat
The software catalog is extended to discover a number of new components from
Oracle, SAP, and Red Hat. To discover the components, ensure that you upgrade
BigFix Inventory to version 9.2.8.
Below is the list of the newly added components. To learn about their exact versions,
use the Software Catalog widget in BigFix Inventory to browse the catalog content.
◦ Added signatures for Oracle products
▪ Oracle Linux
▪ Oracle Data Integrator

▪ Oracle JDeveloper
▪ Oracle Service Bus
◦ Added signatures for SAP products
▪ SAP SQL Anywhere Personal Database Server
▪ SAP SQL Anywhere Network Database Server
▪ SAP SQL Anywhere High Availability Option
◦ Added signatures for Red Hat products
▪ Red Hat JBoss Fuse
▪ Red Hat JBoss Developer Studio
▪ Red Hat JBoss Enterprise Application Platform
▪ Red Hat JBoss Web Server
◦ Added signatures for TIBCO Rendezvous
◦ Added signatures for SUSE Linux Enterprise Server for SAP Applications

Application update 9.2.7
•

New Software Classification panel replaces the BigFix Software
Classification panel
The Software Classification panel introduces a new way of looking at software
inventory and relations between the discovered components and licensable products.
It provides a flat structure with software installations broken into single components,
which makes it easier to view software assets and manage relations between them.
The new panel provides functions such as reassigning, suppressing and sharing
components, excluding products as well as confirming software classifications. The
panel replaces the existing BigFix Software Classification panel. For more information,
see: Software Classification panel.

•

Creation of custom classification rules
When you are assigning a component, or excluding a product, you can create
a custom classification rule that will be applied when the same component or
product is discovered in the future. It allows for automating actions on analogical
components or products, and facilitates the process of software classification. For
more information, see: Creating and managing custom rules.

Utilization of the Physical Core and Virtual Core metrics for Microsoft SQL

•

Server with Software Assurance
BigFix Inventory measures utilization of the Physical Core and Virtual Core metrics
for Microsoft SQL Server. You can use this information to calculate the demand for
Microsoft SQL Server licenses. The feature is supported for Microsoft SQL Server
2012, 2014, and 2016 (Standard and Enterprise edition) with Software Assurance. For
more information, see: Microsoft Physical Core with SA and Microsoft Virtual Core
with SA.
•

Utilization of license metrics for VMware vCenter and vSphere
You can retrieve information about license metric utilization for VMware vCenter and
vSphere. You can use this information to calculate the demand for VMware licenses.
The data is collected by the VM Manager Tool and is displayed on the Resource
Utilization report. For more information, see: Measuring license metric utilization of
VMware products.

•

Discovery of SAP components
You can retrieve information about SAP components that are installed on Linux
and AIX computers in your infrastructure. The discovery is supported for all SAP
components that are based on SAP NetWeaver 7.x. For more information, see:
Discovering SAP components.

•

Utilization of the Install Instances metric for BigFix products
The All Metrics report is extended to include information about the utilization of the
Install Instances metric for BigFix products. You can see not only the current number
of installed product instances, but also how that number changed over time. You
can also set a threshold, to easily monitor when the number of installed instances
exceeds your expectations. For more information, see: License metric utilization, and
Reported license metrics.

•

Overview of license metrics that are used by BigFix products in your
infrastructure
The All Metrics report is extended to include not only products with license metrics for
which utilization is calculated, but also all other BigFix products in your infrastructure.
Even though metric utilization might not be calculated for these products, it gives

you an overview of all IBM metrics for which you should have licenses. For more
information, see: License metric utilization and Reported license metrics.
•

Discovery of software and hardware inventory with disconnected scans on
Windows and Linux
If there is no direct connection between some of the Windows or Linux computers
in you infrastructure and the BigFix server, you can discover software and hardware
inventory by using disconnected scans. Scripts that are provided in the disconnected
scanner package initiate software and capacity scans, and prepare scan results
that you later on upload to BigFix Inventory. For more information, see: Discovering
software and hardware with disconnected scanner on Windows and UNIX.

•

REST API for adding and changing VM managers
If you have a large number of VM managers to define, you can use REST API requests
to add and change VM managers in your infrastructure. For more information, see:
REST API for managing VM managers.

•

Adding custom part numbers to the catalog
Custom part numbers can be assigned to products with custom deals, or any other
software that is not included in the software catalog by default. Custom part numbers
that you add are matched against the part numbers that you obtain from Passport
Advantage to improve the accuracy of bundling assistance. You can check which
of your uploaded part numbers were matched against the catalog part numbers or
custom part numbers on the Software Catalog report. For more information, see: Part
numbers and Adding custom part numbers.

•

Extension of two bundling rules: bundling tags and part numbers
The bundling tags and part numbers rules are extended to increase the accuracy of
bundling assistance. The rules now use information contained in part numbers to
assign components not only to proper products but also to proper license metrics. For
more information, see: Bundling tags and Part numbers.

•

Two-phase matching of file signatures
When a file signature used for discovering a component on Windows had size and
version specified, the component was discovered only when both properties matched.
Applications that are frequently patched required separate signatures for every patch.

Currently, if a patch modifies only the size of the file signature, the signature will cause
software discovery.
Configuring security policy for user passwords

•

If your company has a security policy for user passwords, or you want to improve the
application security, you can configure BigFix Inventory to require that user passwords
fulfill specific requirements. By default, user passwords are required to be at least 8
characters long and contain one lowercase character, one uppercase character, and
one digit. For more information, see: Configuring security policy for user passwords.
Improvements of the VM Manager tool

•

VM Manager tool is enhanced to attempt to automatically fix the most common
problems with the VM manager connection parameters such as adding default URL
suffix, correcting the user name format, and testing the WinRM and PowerShell
protocols for Hyper-V VM managers. For information about disabling this
functionality, see: VM Manager Tool settings.
New look and feel of the user interface

•

Look and feel of the user interface is updated for improved experience. The possibility
of selecting all columns while configuring the report view is added.
Support for new operating systems and virtualization technologies

•

You can use Microsoft Hyper-V Server 2016, Xen Hypervisor, Oracle VM, RHEV-M 3.6
as well as VMware vCenter, and ESXi 6.5 as supported virtualization technologies on
selected operating systems. You can also install the BigFix client on AIX VIOS. For
more information, see: Detailed System requirements.
Discovery of new components from Microsoft, SAP, and Oracle

•

The software catalog is extended to discover a number of new components from
Microsoft, SAP, and Oracle. To discover the components, ensure that you upload the
software catalog published in March 2017, and upgrade BigFix Inventory to version
9.2.7.
Below is the list of the newly added components. To learn about their exact versions,
use the Software Catalog widget in BigFix Inventory to browse the catalog content.

◦ Components of Microsoft SQL Server
▪ Analysis Services
▪ Integration Services
▪ Master Data Services
▪ Reporting Services
◦ Components of SAP
▪ SAP Crystal Reports
▪ SAP Crustal Reports Viewer
◦ Components of Oracle
▪ Oracle Adapter
▪ Oracle B2B
▪ Oracle BPEL Process Manager
▪ Oracle Business Process Management Suite
▪ Oracle Business Rules
▪ Oracle Coherence
▪ Oracle Human Workflow
▪ Oracle Mediator
▪ Oracle SOA Suite
▪ Oracle Virtual Assembly Builder
▪ Oracle WebLogic Server Enterprise Edition
▪ Oracle WebLogic Suite
▪ Oracle WebLogic Server
▪ Service Architecture Leveraging Tuxedo
▪ Tuxedo Jolt
▪ Tuxedo Message Queue
▪ Tuxedo Server
▪ Tuxedo System and Application Monitor Plus
▪ MySQL Connector C
▪ MySQL Workbench
◦ TIBCO Enterprise Message Service

Application update 9.2.6
•

Preview Feature: Utilization of the physical core-based metric for
Microsoft SQL Server
BigFix Inventory measures utilization of the physical core-based licenses for
Microsoft SQL Server. You can use this information to calculate the demand for
Microsoft SQL Server licenses. The feature is supported for versions 2012, 2014, and
2016 (Standard and Enterprise edition). For more information, see: Microsoft Physical
Core with SA.

•

Preview Feature: Extension of the Software Classification panel
The Software Classification panel introduces a new way of looking at software
inventory and relations between the discovered components and licensable products.
It provides a flat structure with software installations broken into single components,
which makes it easier to view software assets and manage relations between them.
The preview panel is extended with the following functions:
◦ Selecting the license metric of a product to which you are assigning the
component
◦ Excluding a product or a component from license calculations, for example
when it is a trial version
◦ Viewing information about components that were installed during a specific
period and their assignment

•

Enhanced discovery of Microsoft Exchange editions
You can retrieve information about editions of Microsoft Exchange Servers that are
installed in your infrastructure and verify how many licenses are needed for each
edition. For more information, see: Discovering Microsoft Exchange edition.

•

Reporting high water mark of Oracle Database user sessions
BigFix Inventory retrieves the number of user sessions that are registered into the
Oracle Databases deployed in your environment, and provides their high water mark.
You can use this information to calculate the demand for the Oracle Named User
Plus license. For more information, see: Metering the number of Oracle Database
concurrent sessions.

•

Measuring application usage on Mac OS X

Information about application usage for software that is installed on Mac OS X is
available on the Software Installations report. You can use this information to verify
whether extension of license is needed for particular software instances based on
their frequency of use.
To enable collecting application usage on Mac OS X, stop actions created by the
Initiate Software Scan task that are currently running. Then, activate the Application
Usage Statistics analysis, and start the package data and application usage statistics
scans by using the updated task. For more information, see: Activating the analyses
and Initiating software scans.
•

Utilization of the Install Seats metric for products discovered by SWID tags
The All Metrics report is extended to include information about the utilization of the
Install Seats metric for non-IBM products that are discovered by SWID tags. You can
now see the number of installations of software that is discovered by SWID tags and
for which the software catalog does not define license details. For more information
about SWID tags, see: Support for ISO/IEC 19770-2. For more information about the
Install Seats metric and the All Metrics report, see: License metric utilization.

•

Upload of PVU table and software catalog during the upgrade
During the upgrade, new versions of the software catalog and PVU table are uploaded
to BigFix Inventory to ensure that the latest software is properly discovered and that
new processors are correctly matched. The versions that are uploaded are the newest
ones that were available during the release of the application update to which you are
upgrading. For more information, see: Upgrading to BigFix Inventory v10.

•

Reduced impact of scans due to the optimization of the scanner cache
folder on the endpoints
The scanner cache folder is used to store information about scanned files and
directories in your file system. By knowing the hierarchy of files, the scanner can
locate them quicker, which results in shorter scans. The amount of disk space that is
needed for the cache depends on the number of files that are being scanned.
Fresh installations of BigFix Inventory use the optimized cache which includes only
files that are relevant for the types of software scans that you are running. The
optimization results in a reduced size of the cache on the monitored computer.

Scanner cache settings are not changed during the upgrade. For more information,
see: Optimizing scanner cache configuration.
•

Searching the software catalog by part number
The Software Catalog report provides information about product part numbers and
associated license metrics. Thus, you can check which products your part numbers
represent and what license metrics they use. This information facilitates the process
of software classification. You can also verify whether a particular part number is
contained in the current software catalog, and thus influences bundling assistance.

•

Best practices for database backup
Documentation provides best practices for creating database backups. For more
information, see: Backing up and restoring the database.

•

Fixlet version visible in the BigFix client logs
The BigFix client log contains information about versions of fixlets that were run on
the specific computer. The information can be used for troubleshooting purposes, for
example to determine whether the action should be restarted because it was created
by an old version of the fixlet. For information about the location of client logs, see:
Component log files.

•

Additional options for migrating from License Metric Tool and Tivoli Asset
Discovery for Distributed 7.x
You can decide whether you want to migrate the following items that used to be
migrated by default:
◦ Software bundlings
◦ Software exclusions
◦ VM managers

•

Improved performance of generating CSV reports
Generation of CSV reports is now faster and consumes less resources.

•

Support for new operating systems and virtualization technologies
You can detect software that is installed on Windows Server 2016, Ubuntu 16 for
IBM Power Systems, and SUSE Linux 12 for IBM Power Systems on Little Endian

Architecture. You can use XenServer and Citrix XenServer as supported virtualization
technologies on selected operating systems. For more information, see: Detailed
System requirements.

Application update 9.2.5
•

Utilization of the Install metric for non-IBM products
Information about non-IBM products that use the Install metric is available on the All
Metrics report. You can see not only the current number of computers on which the
product is installed but also how that number changed over time. You can also set
a threshold, to easily monitor when the number of installed instances exceeds your
expectations. For more information, see: License metric utilization.

•

Preview Feature: Extension of the Software Classification panel
The Software Classification panel introduces a new way of looking at software
inventory and relations between the discovered components and licensable products.
It provides a flat structure with software installations broken into single components,
which makes it easier to view software assets and manage relations between them.
The preview panel is extended with the following functions:
◦ Selecting and assigning multiple components at once
◦ Confirming the assignment of components
◦ Classifying products from vendors other than BigFix

•

Bundling tags for improved software classification
Bundling tags facilitate the process of software classification allowing you to save
time and effort related to analyzing to which product a particular component belongs.
They contain information about the part number of a product to which the instance
of a component should be assigned. Thus, they increase accuracy of the automated
bundling. For more information, see: Bundling tags.

•

Software discovery on IBM i
You can discover software that is installed on the IBM i systems. The discovery
is based on a semi-automatic procedure that uses scripts to initiate software and
capacity scans. Because there is no direct connection between the IBM i systems
and the BigFix server, the scans that are initiated on these systems are called

disconnected scans. Although the scans run automatically, you must perform several
manual actions, such as installing the scanner, or uploading the results to BigFix
Inventory. For more information, see: Discovering software and hardware on IBM i.
Software discovery in Docker containers

•

Docker is a platform that allows for automating the deployment of applications inside
software containers. BigFix Inventory discovers software that is installed inside
Docker containers. It also measures license metric utilization of the discovered BigFix
products. For more information, see: Discovery of software in Docker containers.
Determining the usage of Virtual Processor Cores (VPC)

•

You can use BigFix Inventory to track the consumption of Virtual Processor Cores
(VPC). VPC is a unit of measure by which a program can be licensed. It can be
considered as a physical processor core, if the server is not partitioned for virtual
machines, or as a virtual core assigned to a virtual machine. For more information,
see: Determining the usage of Virtual Processor Cores (VPC).
Information about software scan duration

•

Information about the duration of the software scan is available in the Software Scan
Status analysis. You can use this information, for example, to review the scanner
timeout settings or verify whether optimization is needed to reduce the length of the
scan.
•

New VM manager status - Insufficient rights
The Insufficient rights status indicates that no data was collected from the VM
manager because the user that is defined for this VM manager does not have
sufficient rights.

•

Information about processor brand string
Information about the processor brand string is available on the Hardware Inventory
report. It contains a full specification of the processor including its brand, model, and
speed as read from the computer operating system. You can use this information to
apply vendor Core Factor values.

•

Forcing reupload of software scan results

When the import of software scan results fails, or when software is not reported
properly on the Software Installations report, you can use the Force Reupload of
Software Scan Results task to troubleshoot the problem.
Installing the scanner in an alternative path

•

You can choose whether you want to install the scanner in the default directory (on
the C: or opt drive) or the directory where the BigFix client is installed. This option
is useful, for example, when the security policy in your company does not allow for
installing software on the C: or opt drive. For more information, see: Installing the
scanner.
•

Support for new operating systems and virtualization technologies
You can detect software that is installed on Debian 8 for x86 and Ubuntu 16 for x86.
You can use z/KVM as a supported virtualization technology on SUSE Linux 12.

Application update 9.2.4
•

Setting metric thresholds for BigFix products
You can specify a metric threshold that is used to show how the metric consumption
that you would like to maintain relates to the actual consumption. You can then
schedule emails to be sent whenever metric consumption for any product exceeds the
threshold. For more information, see: Setting license metric threshold.

•

Sharing feedback
If you encounter problems with panels and reports or think that some of them
might be improved, you can quickly share your feedback by simply clicking the Send
Feedback button that is in the top-right corner of the user interface. Each panel has
a separate button that creates an email message with the panel name, version of the
application that you are using, and your comment. For more information about other
available communication channels, see: Give us feedback.

•

Preview features
Preview features allow you to work with the newly implemented functions and to
provide your feedback to influence their final form. These features are subject to
BigFix Support. For more information, see: Preview features.

•

Improvements for VM managers
The following improvements are introduced in the area of VM managers:
◦ Until now, the VM Managers panel listed only VM managers that are managed in
central mode. Now, it also lists those that are managed in the distributed mode.
Options such as editing, deleting, or testing connection are still applicable
only for the former. However, the read-only view of the latter gives you a clear
overview of all VM managers that are defined in your infrastructure. For more
information, see: Understanding the VM Managers panel.
◦ VMware vSphere Fault Tolerance allows for reducing virtual machine and
application downtime to zero. If a server failure occurs, a live shadow instance
of a virtual machine is created. The instance is up-to-date with the primary
virtual machine. BigFix Inventory can handle situations when shadow instances
of virtual machines are created and can properly calculate PVU utilization of
software that is installed on such machines.
◦ When VM managers in your infrastructure have status other than OK, and you
are not sure how to troubleshoot the problem, you can simply click the name
of the status. You will be redirected to a documentation page that provides the
most common reasons for each status and how to proceed.
◦ When the security policy in your company does not allow for transferring VM
manager credentials through the network, you can configure BigFix Inventory
so that the credentials are not transferred to the server. They are also not
displayed on the VM Managers panel when you edit the VM manager. For more
information, see: Advanced server settings.

•

API to retrieve cluster information
Information about the cluster to which a computer belongs is available on the
Hardware Inventory report. Now, the information can also be retrieved through REST
API. It can be then used, for example, to calculate license demand for Oracle or
Microsoft. For more information, see: Retrieval of clusters.

•

Support for BigFix database restoration
You can enable an import that retrieves all software scan data from the restored
BigFix database. Such an import is time-consuming and should be run only when
problems with incomplete data occur after the database is restored. When you enable

the option, the import runs once and returns to the normal operation mode. For more
information, see: Database problems.
•

Optimization of the scanner cache configuration
The scanner cache folder stores information about scanned files and directories
in your file system. By knowing the hierarchy of files, the scanner can locate them
quicker, which results in shorter scans. The amount of disk space that is needed
for the cache depends on the number of files that are being scanned. If the current
location of the cache folder cannot ensure sufficient disk space, you can optimize the
cache. Thanks to the optimization, the cache includes only files relevant for the types
of software scans that you are running. For more information, see: Optimizing scanner
cache configuration.

•

Discovery of software that is not in the current software catalog
When BigFix software is discovered with a software ID tag but is not in the current
catalog, a warning sign is displayed on the Software Catalog widget. It indicates that
a newer version of the catalog needs to be uploaded. For more information, see:
Support for ISO/IEC 19770-2.

•

Support for new operating systems and virtualization technologies
The BigFix client can be installed on Oracle Linux 7 and on Power Linux on the Little
Endian architecture. Support is added for PowerKVM virtualization technology.
Additionally, support for Multiple Shared Processor Pools is extended to Linux. For
more information, see: Detailed System requirements

Application update 9.2.3
•

Support for Unicode
Starting from V9.5, the BigFix Platform can gather data from BigFix clients that are
deployed in different geographical locations and thus use different code pages and
languages. The data is encoded into UTF-8 format, and reported back to the BigFix
server. As a result, regardless of the system and encoding that the clients use, the
data is correctly displayed both in BigFix and BigFix Inventory. For more information,
see: Unicode.

•

Collecting file MD5 and SHA256 checksums for security purposes

Checksums are long strings that describe the content of files and act as their
fingerprints. You can enable the calculation of checksums for files on your computers
to check their integrity and to ensure that they were not altered or tampered with. For
more information, see: Collecting file checksums.
•

Conditional report emails based on the number of rows in the report
You can configure reports to be emailed to specified recipients regularly or when a
specific number of rows is exceeded in the report. This option is useful for alerting
the recipients about changes to the key data or when the recipients do not work with
BigFix Inventory, yet must have access to the reports. For more information, see:
Scheduling report emails.

•

Controlling scan schedule directly from the BigFix Inventory user interface
The Scan Configurations panel is extended to allow for basic configuration of
software scans per computer groups directly from the BigFix Inventory user interface.
Use this method as an alternative to scheduling scans from the BigFix console.

•

Data visibility and license reporting per computer group limited to
authorized users
Improvements that are introduced in the area of data visibility and license reporting
per computer group include:
◦ Limitation of information that is displayed on the Audit Trail report to actions
performed only within the computer group to which the user who views the
report has access.
◦ Possibility of enabling and disabling subcapacity calculations per computer
group. For more information, see: Setting up computer groups.
◦ Reporting historical data for deleted computers within the scope of a computer
group.
◦ Introduction of permissions to upload part numbers and view contracts. For
more information, see: Roles.
The improvements give more flexibility and better management of data visibility in
situations where computers are divided into groups and each group is managed
by a different person. For example, in the service provider's environment or when
computers are divided into regions or business units.

Replacing Software Knowledge Base Toolkit with BigFix Inventory for

•

managing the software catalog content
You can use a tool that moves the custom catalog content from Software Knowledge
Base Toolkit to BigFix Inventory. Then, you can stop using Software Knowledge Base
Toolkit and start managing the catalog content entirely in BigFix Inventory. Managing
signatures in one application instead of two saves your time, facilitates the work, and
reduces maintenance costs.
Flexible date filtering

•

You can use time filters to display data starting from or ending at a particular date.
For example, you can view computers that were not seen within the last week or
contracts for which maintenance ends within a month. When you combine this feature
with conditional report emails, you get instant notifications about changes within your
environment including reports on which data fulfills specific time conditions.
Collecting host serial numbers

•

You can collect serial numbers of VM manager hosts and define the format in which
the information is displayed on the reports. For more information, see: Advanced
server settings.
Forcing capacity scan data uploads

•

When the import of capacity scan data fails, you can run a single capacity scan and
force the upload of its results to ensure that the data on reports is refreshed. For more
information, see: Initiating the capacity scan on all computers.
Changing advanced server settings from the application user interface

•

You can change advanced settings of the BigFix Inventory server, for example
settings related to the configuration of the central VM Manager tool, on the Advanced
Server Settings panel. Additionally, a number of new parameters is added. For more
information, see: Configuring advanced server settings.
Manually adjusting the PVU per core value from the BigFix Inventory user

•
interface

In earlier versions of BigFix Inventory, the PVU per core value was adjusted by using
a fixlet. Starting from this version, the fixlet is deprecated. The PVU value can be

changed on the Hardware Inventory panel instead. For more information, see:
Changing the PVU per core value.
Support for new operating systems and virtualization technologies

•

The BigFix client can be installed on Cent OS 6 and 7. Red Hat Enterprise Linux 7 and
SUSE Linux Enterprise Server 12 are supported on z/VM. Additionally, support for
RHEV-M 3.5 is provided. For more information, see: Detailed System requirements.

Application update 9.2.2
License reports per BigFix subcapacity region

•

BigFix subcapacity licensing rules define three regions. To properly calculate
subcapacity values for products that are installed in multiple regions, generate the
audit snapshot for each region. Then, for every product, sum up the subcapacity
values from all regions. The value that you obtain is the overall subcapacity usage
for the particular product. For more information, see: Virtualization Capacity License
Counting Rules, BigFix subcapacity regions and Tutorial: Reporting subcapacity usage
per computer group.
License reports per organizational business unit

•

You can manage software and view reports per organizational business unit. To do
this, divide the computers in your infrastructure into groups that represent these units.
Then, create dedicated users, each with access only to a particular computer group.
For more information, see: Organizational business units and Tutorial: Reporting
subcapacity usage per computer group.
License reports in the service provider environment

•

A service provider is a company that provides other organizations with access
to software installed on machines that are owned and maintained by the service
provider.

Available from 9.2.2. To properly calculate subcapacity values

in the service provider environment, divide the computers in your infrastructure into
groups that represent your customers. Then, manage software and generate audit
snapshots separately for each customer. For more information, see: Service providers
and Tutorial: Managing software in the service provider environment.
•

Creating extended signatures

Extended software signatures are based on data elements such as file names, registry
keys, or specific strings. They allow for discovering software that otherwise might not
be discovered with file or package signatures. You can now create extended software
signatures directly in BigFix Inventory without the necessity of installing Software
Knowledge Base Toolkit. For more information, see: Creating extended signatures.
•

Software Knowledge Base Toolkit is being sunset
Software Knowledge Base Toolkit was used by BigFix Inventory users to create
complex signatures, and was required at the time when BigFix Inventory could not
provide equal capabilities. Now, with the possibility of creating complex signatures
directly in BigFix Inventory, Software Knowledge Base Toolkit becomes deprecated
and will be discontinued.

•

Consolidated endpoint information
Hardware information, such as processor details, is available on the Computers,
Software Installations, and Oracle Databases reports. Combination of software and
hardware information on a single report facilitates the calculation of processor-based
and core-based licenses for non-IBM products.

•

Disabling the calculation of extended software aggregates
Software aggregates are pieces of data that are gathered during software scans.
They are processed during the successive data imports and later on displayed on the
Inventory Exploration report. You can disable the calculation of extended software
aggregates to reduce the length of data imports in very large environments where
multiple computer groups are defined. For more information, see: Disabling the
calculation of extended software aggregates.

•

Configuring location of the scanner cache folder
The scanner cache folder is used to store information about scanned files and
directories in your file system. By knowing the hierarchy of files, the scanner can
locate them quicker, which results in shorter scans. Change the location of the cache
folder if the default one cannot ensure sufficient disk space. For more information,
see: Optimizing scanner cache configuration.

•

Identifying VM manager duplicates

You can use the vmman_collecting_hostnames_enabled parameter to identify
duplicate UUIDs on VMware vSphere. When you set the parameter to true, host
names of virtual machines with duplicate UUIDs are written in the log file. For more
information, see: VM Manager Tool settings.
•

Defining time range of reports in relation to the current date
You can define the time range of reports in relation to the current date. Then, the
report provides you with data for a specific period, for instance the last 2 weeks.

•

REST API for retrieving raw scan results
You can retrieve raw scan results through REST API to improve the monitoring of your
environment by quickly discovering software that was installed or modified recently.
Shortened data imports cause that data about installed software reaches the server
more quickly. They also allow for increasing the number of imports that you run each
day. For more information, see: REST API for retrieving raw scan results.

•

Support for new platforms
The BigFix client can be installed on SUSE Linux Enterprise Server 12 (x86).
Additionally, support for Red Hat Enterprise Linux 7 on Power 8 is provided. For more
information, see: Detailed System requirements.

Related information
Software Use Analysis versions

Updates and patches for BigFix Inventory
This page provides information about application updates released for BigFix Inventory.
Release notes are also posted at BigFix Forum - Inventory (Release Announcements).

Table 1. Updates and patches
Update

Site version

Application
update 10.0.11
December, 2022
• In the "All Con

Target
customers

Comments
and upgrade
considerations

All cus

You must up

Release

ventory update

tomers

grade BigFix

notes

Inventory serv
er to 10.0.11 to
allow the new
capabilities

contracts updat

work for you.

ed for new met

Use Upgrade

rics

to the latest
version of Big

option added

Fix Inventory

per Contract

fixlet from Big

panel

Fix console to

• New recalcu

upgrade BigFix

lation button

Inventory serv

added to All

er.

Contracts
• New Metric Mi
crosoft SQL
Server Physical
Cores
• All template de
rived compo
nents assigned
to a single,
generic product
release

mation

157 BigFix In

tracts" panel,

• Product Metrics

More infor

Table 1. Updates and patches (continued)
Update
• Managing Mi
crosoft Proces
sor Core licens
es
• Improved tem
plate signatures
• Oracle features
discovery im
provements
• Improved han
dling of CDB/
PDB support for
Oracle pluggable
databases CDB/
PDB discovery
and reporting of
their licensable
options
• Improved dis
covery of sever
al licenses
• Improved error
handling and re
porting
• Security im
provements
• Defect fixes

Site version

Target
customers

Comments
and upgrade
considerations

More infor
mation

Table 1. Updates and patches (continued)
Update

Site version

Target
customers

Comments
and upgrade
considerations

More infor
mation

Certification for BFI
10.0.11 (LMT 9.2.29
equivalent) is pending.
Application
update 10.0.10.1
November, 2022
• Capability to dis
cover more than
460+ new soft
ware versions
• Added new tem
plate signatures
• Updated the
publisher name
from Microfocus
to Micro Focus
• Changed def
inition source
of selected Mi
crosoft compo
nents
• Defect fixes
Certification for BFI
10.0.10 (LMT 9.2.28

156

All cus

Release

tomers

notes

Table 1. Updates and patches (continued)
Update

Site version

Target
customers

Comments
and upgrade
considerations

More infor
mation

equivalent) is com
plete.
Release notes 155 BigFix In
ventory update
September, 2022
• Changes to Mac
OS discovery
• IBM policy up
date for subca
pacity reporting
requirements
for VPC license
metric
• Optimized stan
dard catalog
processing
• Additional infor
mation provid
ed in the audit
snapshot
• Improvement in
Software Data
Harvesting Tool
• Leveraging data
collected by Big
Fix analysis

All cus

You must up

Release

tomers

grade BigFix

notes

Inventory serv
er to 10.0.10 to
allow the new
capabilities
work for you.
Use Upgrade
to the latest
version of Big
Fix Inventory
fixlet from Big
Fix console to
upgrade BigFix
Inventory serv
er.

Table 1. Updates and patches (continued)
Update
• Support for new
platforms and
systems
• Defect fixes
• Improved dis
covery for sever
al software titles
• Technical equiv
alence to IBM
License Metric
Tool 9.2.28. The
new version is
under certifica
tion process by
IBM on the re
lease date. To
view the status
of IBM validated
releases refer to,
BigFix Inventory
FAQ.
Certification for BFI
10.0.10 (LMT 9.2.28
equivalent) is in
progress. To view the
status of IBM validated

Site version

Target
customers

Comments
and upgrade
considerations

More infor
mation

Table 1. Updates and patches (continued)
Update

Site version

Target
customers

Comments
and upgrade
considerations

More infor
mation

releases, refer to Big
Fix Inventory FAQ.
Application
update 10.0.9.1
August, 2022
• Capability to dis
cover more than
880 new soft
ware.
• Improved dis
covery for var
ious existing
softwares.
• Added Sentinel
One Endpoint
Protection Agent
for Unix & Win
dows platform.
• The Update
Software Cat
alog andRun
Software Data
Harvesting Tool
fixlets were up
dated.
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Table 1. Updates and patches (continued)
Update
• Updated MSI
Install loca
tion property of
package infor
mation to pre
fer regular paths
over system
paths.
• Changed def
inition source
information on
product, version,
release, compo
nent and signa
ture view to HCL
or IBM Internal
Development for
entries in Cata
log which uses
executable and
package infor
mation.
• Minimal permis
sions document
ed for BigFix
Cloud Adapter
Kubernetes.
• Defect fixes.

Site version

Target
customers

Comments
and upgrade
considerations

More infor
mation

Table 1. Updates and patches (continued)
Update

Site version

Target
customers

Comments
and upgrade
considerations

More infor
mation

Certification for BFI
10.0.9 (LMT 9.2.28
equivalent) is com
plete.
Application up 153 BigFix In
date 10.0.9
July, 2022
• Template sig

ventory update

All cus

You must up

Release

tomers

grade BigFix

notes

Inventory serv
er to 10.0.9 to
allow the new

nature to sup

capabilities

port catalog cus

work for you.

tomizations
• Improved data
import perfor
maed by remov
ing deprecat
ed features and
panels
• New predefined
license metrics
• Security up
grades
• Support for new
platforms and
systems
• Patronous up
date

Table 1. Updates and patches (continued)
Update

Site version

Target
customers

Comments
and upgrade
considerations

More infor
mation

• Conversion of
keystores
• Experimental
Cache 3 support
• BigFix Inventory
Scans and Big
Fix Client CPU
utilization
• Discovery im
provements
• Harvesting tool
improvements
• Containers sup
port imporve
ments
Certification for BFI
10.0.9 (LMT 9.2.28
equivalent) is pending.
Application
update 10.0.8.1
May, 2022
• Enterprise sig
nature content
integration for
more than 105
new software
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Table 1. Updates and patches (continued)
Update
• Updates in
cludes for pub
lishers, such as
Adobe, Canon
ical, Dell, Mi
crosoft, etc.
• SAP Crystal Re
ports for Enter
prise
• Definition
source changed
to HCL for Mi
crosoft Office,
SQL Server, and
MS Operating
systems
• Name of Veri
tas NetBackup
Server to Veri
tas NetBackup
Master Server
for all the exist
ing signatures
from GAM.
• New Discovery
of Microsoft Vi
sual Studio 2022

Site version

Target
customers

Comments
and upgrade
considerations

More infor
mation

Table 1. Updates and patches (continued)
Update

Site version

Target
customers

Comments
and upgrade
considerations

More infor
mation

• Signatures mod
ified for Quest
Web Parts for
SharePoint, Re
motely Any
where and Re
motely Any
where for IBM,
SaltStack Salt &
Salt Minion sig
natures, Mongo
DB, and Tripwire
Enterprise Agent
• Harvesting tool
improvements
• Defect fixes
Certification for BFI
10.0.8 (LMT 9.2.26
equivalent) is com
plete.
Application
update 10.0.8
March, 2022
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Inventory serv
er to 10.0.8 to

• Improvements

allow the new

in container sup

capabilities

port for software

work for you.

Table 1. Updates and patches (continued)
Update

Site version

Target
customers

Comments
and upgrade
considerations

discovery - new

To upgrade the

cluster technolo

BigFix Inven

gies verified for

tory server to

Kubernetes API

application up

compatibility.

date 10.0.8.0,

• Extended sup

run the 'Up

port for HP-UX

grade to the

managed ser

latest version

vices

of BigFix In

• Optional soft

ventory' fixlet

ware data har

from the Big

vesting tool for

Fix console.

better software
discovery
• Option to add
custom informa
tion in the ac
cess blocked er
ror for SSO user
• Option to
change the Pro
vide Feedback
email in the cus
tom email ad
dress
• Improved scan
ner cache opti
mization

More infor
mation

Table 1. Updates and patches (continued)
Update
• Keystore for
mat changed
from JCEKS to
PKCS12
• Added CVE
metadata to
Log4j update
fixlet
• Improved ser
viceability set
tings for bet
ter catalog cus
tomization
• Updated End-ofsupport for Big
Fix 9.2 and 9.5
components
• IEST API for as
signing a prod
uct to a Flex
Point or a Cloud
Pack offering
• Support for new
platforms and
systems
• Defect fixes

Site version

Target
customers

Comments
and upgrade
considerations

More infor
mation

Table 1. Updates and patches (continued)
Update

Site version

Target
customers

Comments
and upgrade
considerations

More infor
mation

Certification for BFI
10.0.8 (LMT 9.2.26
equivalent) is pending.
Application
update 10.0.7.1
February, 2022
• Detection of
Windows 11 af
ter running the
Initiate Software
Scan fixlet
• New template
signatures
added
• Discovery of 300
and more soft
ware versions
including Au
todesk Inc., Mi
crosoft, Oracle,
Red Hat
• Update the
Log4j library
in VM Manag
er Tool to ver
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Table 1. Updates and patches (continued)
Update

Site version

Target
customers

Comments
and upgrade
considerations

More infor
mation

sion 2.17.1 (10.0.7.0.1)
• Update VM Man
ager Tool to ver
sion (10.0.7.1)
• Unified naming
convention for
Java
• Defect fixes
Certification for BFI
10.0.7 (LMT 9.2.25
equivalent) is com
plete.
Application
update 10.0.7
December, 2021
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All cus

You must up

Release
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tomers

grade BigFix

notes

Inventory serv
er to 10.0.7 to

• Software discov
ery in containers
• Support for Win
dows 11 using
BigFix Client
• Improved con
tracts REST API.
• Trace level set
ting in discon
nected scanner

allow the new
capabilities
work for you.

Table 1. Updates and patches (continued)
Update

Site version

Target
customers

Comments
and upgrade
considerations

More infor
mation

to set new val
ues.
• ksh no longer
required for in
stalling BigFix
Inventory
• Capability to dis
cover 440+ soft
ware titles.
• Defect fixes.
Certification for BFI
10.0.7 (LMT 9.2.25
equivalent) is pending.
Application
update 10.0.6.1
November, 2021
• New discovery
capabilities for:
◦ Adobe
◦ BMC
◦ CA Tech
nologies
◦ Cisco Sys
tems Inc
◦ Citrix
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Table 1. Updates and patches (continued)
Update

Site version

Target
customers

Comments
and upgrade
considerations

More infor
mation

◦ Dell Com
puter Cor
poration
◦ HewlettPackard
◦ Intel
◦ Microsoft
◦ Oracle
◦ Red Hat
• Several defects
fixed and client
ideas imple
mented.
• This release in
cludes Software
Catalog version
10.0.6.1 with ca
pability to dis
cover more than
320 new soft
ware versions.
Application
update 10.0.6
September, 2021
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Release

ventory update

tomers

grade BigFix

notes

Inventory serv
er to 10.0.6 to
allow the new

Table 1. Updates and patches (continued)
Update
• API to create
and modify con
tracts
• Ability to import
contracts from
CSV file
• Ability to mi
grate deprecat
ed contracts
• Allows to con
vert purchase or
der from number
to ELA and vice
versa
• Set a default
products and
metric for
bundling assis
tant
• Discovery for
more than 435
new signa
tures, such as
Adobe, Auto
Desk Inc., Cit
rix, Microsoft ,
Oracle , SAP ,
SAS, SOLAR

Site version

Target
customers

Comments
and upgrade
considerations
capabilities
work for you.

More infor
mation

Table 1. Updates and patches (continued)
Update

Site version

Target
customers

Comments
and upgrade
considerations

More infor
mation

WINDS, Tableau
Software, and
VMware.
• ILMT core mod
ule update
• Security updates
• Defect fixes
Certification for BFI
10.0.6 (LMT 9.2.24
equivalent) is pending.
Application
update 10.0.5.1
August, 2021
• New discov
ery capabili
ty for Adobe,
Autodesk, Cit
rix, JetBrains,
McAfee, Mi
crosoft, Mongo
DB, Oracle, Veri
tas, VMware.
• Defect fixes and
client ideas im
plemented.
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Table 1. Updates and patches (continued)
Update

Site version

Target
customers

Comments
and upgrade
considerations

More infor
mation

• Capability to dis
cover more than
270 new soft
ware compo
nents.
Certification for BFI
10.0.5 (LMT 9.2.23
equivalent) is com
plete.
Application
update 10.0.5
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Inventory serv

July, 2021
• Improved con
tracts man
agement to de
fine contracts
through the new
All Contracts
report and ac
cess contracts
through the pre
defined report
dashboard
• Unified software
inventory view
supported by a

Note:

er to 10.0.5 to

Origi

allow the new

nal site

capabilities

version

work for you.

142 has
been re
freshed
to ad
dress
link is
sues.

Table 1. Updates and patches (continued)
Update
new API to com
bine software
instances and
package data
• Duplicate UUIDs
(Universally
Unique Identi
fier) shown in
the To Do list for
computers with
duplicate UUIDs
• Suppress Pack
age Data option
in the UI to sup
press data that
is not relevant
for reporting or
integration
• Support for
BigFix Plat
form Server
Based Comput
er Groups to en
able cloud spe
cific reporting
• Disconnected
scanner can be
used to mark

Site version

Target
customers

Comments
and upgrade
considerations

More infor
mation

Table 1. Updates and patches (continued)
Update
computers that
run on public
cloud
• Product publish
er name avail
able on Soft
ware Classifica
tion panel
• Catalog distrib
uted in GZIP for
mat instead of
BZIP2
• Added discov
ery capability for
350+ software
titles and pub
lishers, such as
Adobe, Citrix, Mi
crosoft, Solar
Winds, Syman
tec, VMware
• Security en
hancements
• Support for new
platform and
systems

Site version

Target
customers

Comments
and upgrade
considerations

More infor
mation

Table 1. Updates and patches (continued)
Update

Site version

Target
customers

Comments
and upgrade
considerations

More infor
mation

Certification for
BFI 10.0.5 (LMT
9.2.23 equiv
alent) is com
plete.
Application
update 10.0.4.1
May, 2021
• Added capabil
ity to discover
160 software
versions, that in
cludes:
◦ BMC
◦ CA Tech
nologies
◦ Citrix
◦ Oracle
◦ Red Hat
◦ Veritas
◦ VMware
• Implemented
customer ideas
• Defect fixes
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Table 1. Updates and patches (continued)
Update

Site version

Target
customers

Comments
and upgrade
considerations

More infor
mation

Certification for BFI
10.0.4 (LMT 9.2.22
equivalent) is now
complete.
Application
update 10.0.4
March, 2021
• REST APIs avail
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Inventory serv
er to 10.0.4 to
allow the new

able to retrieve,

capabilities

create, change,

work for you.

and delete li
cense metrics
• REST APIs to in
tegrate multi
cluster licens
ing data in IBM
License Service
Reporter
• Removal of the
“Caused Detec
tion” column
and the “en
able_caused_
detection” set
ting in Advanced
Server Parame

Table 1. Updates and patches (continued)
Update
ters. Recognized
column is now
the primary op
tion to perform
your tasks.
• Reporting infor
mation about
the detailed ver
sion of appli
cations discov
ered by pack
age-based sig
natures.
• Database con
nection encryp
tion
• Regular data
base index re
building
• Search software
catalog by com
ponent name on
the new dash
board
• Fixlet available
to download
PVU table

Site version

Target
customers

Comments
and upgrade
considerations

More infor
mation

Table 1. Updates and patches (continued)
Update
• Parameter
added to show
hidden values
• Improvements
in reporting in
formation about
detailed version
and file size
• Suppressed dis
covery of certain
software prod
ucts
• Automatically
enabled perfor
mance logs
• Security en
hancements
• Support for new
platforms and
systems
• Added capabil
ity to discover
350 software
versions.
Certification for BFI
10.0.4 (LMT 9.2.22
equivalent) is pending.

Site version

Target
customers

Comments
and upgrade
considerations

More infor
mation

Table 1. Updates and patches (continued)
Update

Site version

Application
update 10.0.3.1
February, 2021
• Updated soft
ware catalog to
discover:
◦ Adobe
◦ Apache
Software
Founda
tion
◦ BMC
◦ CA Tech
nologies
◦ Dell
◦ Docker
◦ EMC Cor
poration
◦ HewlettPackard
◦ Jet-Brains
◦ Microsoft
◦ Oracle
◦ Red Hat
◦ SAP

Target
customers

Comments
and upgrade
considerations

More infor
mation
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Table 1. Updates and patches (continued)
Update

Site version

Target
customers

Comments
and upgrade
considerations

More infor
mation

◦ TIBCO
◦ VMware
• Added 500+ new
signatures
• Defect fixes
Application
update 10.0.3
December, 2020
• Changes to sup
ported systems
and upgrade
paths - BigFix In
ventory version
10.0.3 supports
direct upgrade
from version
9.2.14 onwards.
For version be
low 9.2.14, you
need to upgrade
to BigFix Inven
tory 10.0.2 and
then upgrade to
the recent ver
sion.
• Improved user
interface - im
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Table 1. Updates and patches (continued)
Update
proved icons in
the menus, di
alogs, and re
ports
• Discovery of Red
Hat JBoss Enter
prise Application
Platform version
6.0-6.4.
• Notifications on
failed data and
catalog imports.
• Assigning com
ponents to ac
tive BigFix prod
ucts.
• Security en
hancements.
• Discovery im
provements

Site version

Target
customers

Comments
and upgrade
considerations

More infor
mation

Table 1. Updates and patches (continued)
Update

Site version

Target
customers

Comments
and upgrade
considerations

More infor
mation

◦ 221 new
signatures
added
◦ 14 new
manu
factures
added
• Support for new
systems and hy
pervisors.
Certification for BFI
10.0.3 (LMT 9.2.21
equivalent) is com
plete.
Content pack
10.0.2.1
November, 2020
• Updated Soft
ware Catalog to
discover:
◦ BMC soft
ware
◦ Oracle
software
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Table 1. Updates and patches (continued)
Update

Site version
◦ SAP soft
ware
◦ Tibco soft
ware
◦ Red Hat
software
◦ Open
source
Apache
software
◦ Oracle
Java Ad
vanced
Manage
ment Con
sole Agent
as part of
Oracle Ja
va auditing
function
◦ Microsoft
365 Apps
as part of
Microsoft
Office 365
product

Target
customers

Comments
and upgrade
considerations

More infor
mation

Table 1. Updates and patches (continued)
Update

Site version

Target
customers

Comments
and upgrade
considerations

More infor
mation

• Defect fixes
• Added 352 new
signatures
Application up 136 BigFix In
date 10.0.2
October, 2020
• Default dash

ventory update
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Inventory serv
er to 10.0.2 to
allow the new

board now

capabilities

shows ven

work for you.

dor-specific re
ports with an op
tion to switch
to the old dash
board.
• Inventory re
ports now
shows installa
tion path of all
discovered prod
ucts. If a prod
uct is installed
at multiple in
stances, it re
ports all paths
as separate in
stances.

Table 1. Updates and patches (continued)
Update
• The Software
Classification
details view
now shows only
matched detec
tions. The signa
ture shows a list
of all signatures.
• Extended exclu
sion list on Win
dows for scan
ner installation.
• Manual update
of IBM catalog
is no longer sup
ported by BigFix
Inventory.
• Settling entitle
ment feature al
lows to mark
products as enti
tled.
• User manage
ment parameter
allows to cap
ture any change
to the user and

Site version

Target
customers

Comments
and upgrade
considerations

More infor
mation

Table 1. Updates and patches (continued)
Update

Site version

Target
customers

Comments
and upgrade
considerations

More infor
mation

user permis
sions.
• Streamed JSON
responses to
improve API re
sponse time.
• Component De
tailed Version
provides com
plete informa
tion about the fix
packs.
• Security en
hancements.
• Support for new
systems and hy
pervisors.
• Certification for
BFI 10.0.2 (LMT
9.2.20 equiv
alent) is com
plete.
Application update
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August, 2020

Table 1. Updates and patches (continued)
Update

Site version

Target
customers

Comments
and upgrade
considerations

More infor
mation

• Added capabil
ity to discover
Docker engine
and Kubernetes
software
• Added discov
ery capability
for 100+ soft
ware versions
for software ti
tles, such as Or
acle, HewlettPackard,
McAfee, Mi
crosoft, Red
Hat, SAP, and
VMware
• Optional feature:
Scanner instal
lation for Big
Fix Inventory on
Windows.
Application
update 10.0.1
July, 2020
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Table 1. Updates and patches (continued)
Update
• Updated HCL
Catalog
• Package Da
ta report is up
dated with data
from Solaris IPS
package manag
er.
• Configurable
limit for custom
software classi
fication rules
• Enhanced API
for Scanned File
data with addi
tional properties
for Windows ex
ecutables
• Software Sum
mary report pro
vides extend
ed information
about your soft
ware inventory.
• Updated user in
terface
• Updated scan
ner

Site version

Target
customers

Comments
and upgrade
considerations

More infor
mation

Table 1. Updates and patches (continued)
Update

Site version

Target
customers

Comments
and upgrade
considerations

More infor
mation

• IBM Virtualiza
tion Capacity re
porting equiva
lent
Certification for
BFI 10.0.1 is
complete. For
current status of
IBM validated re
leases, see Pass
port Advantage.
• Enabler for re
porting IBM
Cloud Paks
• Inventory Explo
ration report is
deprecated.
Content pack 10.0.0.1 133 BigFix In

Release

May, 2020

notes

ventory catalog
update

• Updated HCL
Catalog
• Improved Mi
crosoft .NET
Framework ver
sion discovery

Table 1. Updates and patches (continued)
Update

Site version

Target
customers

Comments
and upgrade
considerations

More infor
mation

• Microsoft SQL
Server 2019 dis
covery
• Microsoft SQL
Server 2019 dis
covery
Application update
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March, 2020
• Detailed Compo

Inventory serv
er to v10 to up
grade data

nent Version dis

base to DB2

covery for Ora

11.5.

cle Java and Or
acle Weblogic
• Extension of the
computer hard
ware API associ
ation and related
Computers re
port
• Updated HCL
catalog to
10.0.0.0 that in
cludes IBM cata
log 9.2.18.0.

Table 1. Updates and patches (continued)
Update
• User interface vi
sual changes
• Update of the
end of support
dates for IBM
software
• Usability im
provement to
the user inter
face
• Security en
hancements
• Support for new
systems and hy
pervisors
Certification for
BFI v10 (LMT
9.2.18.0 equiva
lent) is complet
ed. For current
status of IBM
validated releas
es, see Passport
Advantage.

Site version

Target
customers

Comments
and upgrade
considerations

More infor
mation

Table 1. Updates and patches (continued)
Update

Site version

Target
customers

Application update
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9.2.17.0

ventory v9

tomers

February, 2020

Comments
and upgrade
considerations

More infor
mation
• En
hance
ments
• APAR

• Equivalence to

Fixes

IBM License

• Internal

Metric Tool

Defect

9.2.17. For cur

Fixes

rent status of

• Scan

IBM validated

ner

releases, see

changes

Passport Advan
tage.
• Software Cat
alog version
9.2.17 contain
ing:
◦ IBM Li
cense
Metric
Tool Soft
ware Cata
log version
9.2.17.0
◦ Added dis
covery ca
pability for

Table 1. Updates and patches (continued)
Update

Site version
Microsoft
Windows
2019
◦ Added dis
covery ca
pability
for com
ponents
of Adobe
Create
Cloud
2020
◦ Added dis
covery ca
pability
for 1300+
other soft
ware ver
sions

• Support for new
systems
◦ Hyper-V
2019
◦ Linux VMs
on Nutanix
AVH (IBM
Power on
ly)

Target
customers

Comments
and upgrade
considerations

More infor
mation

Table 1. Updates and patches (continued)
Update

Site version

Target
customers

Comments
and upgrade
considerations

More infor
mation

◦ RHEV 4.2
and 4.3
using new
API avail
able in
RHEV-M
4.x
Application update

129 BigFix In

All cus

9.2.16.2

ventory v9

tomers

hance
ments

December, 2019

• APAR

Updates include Soft

Fixes

ware Catalog version

• Internal

9.2.16.2 containing

Defect
Fixes

• IBM License

• Scan

Metric Tool Soft

ner

ware Catalog

changes

version 9.2.17.0
• Improved Oracle
Java Runtime
Environment dis
covery
Application update

128 BigFix In

All cus

9.2.16.1

ventory v9

tomers

October, 2019

• En

Table 1. Updates and patches (continued)
Update

Site version

Target
customers

• Enhanced soft
ware discovery
capability
• For more infor
mation please
refer to Catalog
Release Notes:
Catalog release
notes
• Scanner version
9.2.17.0000 im
provements
• Oracle Feature
Health Check
analysis is up
dated
• Support for new
platforms
◦ On the
endpoint
side: Red
Hat Enter
prise Linux
8.0
Application update

127 BigFix In

All cus

9.2.16

ventory v9

tomers

September, 2019

Comments
and upgrade
considerations

More infor
mation

Table 1. Updates and patches (continued)
Update
• Improved report
ing of IBM Flex
Points
• Setting metric
quantity for li
cense metrics
that are not cal
culated by Big
Fix Inventory
• You can manu
ally declare the
metric quantity
for selected li
cense types for
which BigFix In
ventory does not
calculate license
metric utilization
out of the box.
• Extension of the
computer_hard
ware API associ
ation
• You can retrieve
information
about addition
al hardware pa
rameters, such

Site version

Target
customers

Comments
and upgrade
considerations

More infor
mation

Table 1. Updates and patches (continued)
Update
as the serial
number, vendor,
model, or type
of the physical
server.
• Custom rules
for automati
cally suppress
ing components
that meet speci
fied criteria
• By specifying
the relevant cri
teria you can
create the cus
tom rule which
automatically
suppresses the
matching com
ponents in the
future.
• Support for Big
Fix Inventory
server on MS
SQL 2017
• MS SQL 2017 is
now supported
as a database

Site version

Target
customers

Comments
and upgrade
considerations

More infor
mation

Table 1. Updates and patches (continued)
Update

Site version

for BigFix Inven
tory for fresh in
stallations.
• Discovery
with the latest
9.2.15.3 soft
ware catalog
• The included
software cata
log is the latest
9.2.15.3.
• It includes IBM
License Metric
Tool Software
Catalog version
9.2.16.0.
• Security en
hancements
◦ On the
endpoint
side:
▪ Up
date
of
the
Xerces
li
brary

Target
customers

Comments
and upgrade
considerations

More infor
mation

Table 1. Updates and patches (continued)
Update

Site version
to
ver
sion
3.2.1
on
AIX
to
keep
the
scan
ner
se
cure
and
reli
able.

• Support for new
platforms
◦ On the
server
side:
▪ Win
dows
2019
◦ On the
endpoint
side:

Target
customers

Comments
and upgrade
considerations

More infor
mation

Table 1. Updates and patches (continued)
Update

Site version

Target
customers

▪ De
bian
9
x86
and
x64
▪ SUSE
Lin
ux
En
ter
prise
Serv
er 15
x86-64
▪ SM
BIOS3
on
Lin
ux
Application update

125 - BigFix In

All cus

9.2.15.2

ventory update

tomers

May, 2019

9.2.15.2

• 'Detecting mal
ware threats
based on

Comments
and upgrade
considerations

More infor
mation

Table 1. Updates and patches (continued)
Update

Site version

Target
customers

SHA-256 file
checksums' Pre
view Feature de
activation an
nouncement.
• End of the sup
port for MS
SQL 2008 and
2008 R2 data
base is planned
for September
2019.
Content pack 9.2.15.1 124 - BigFix In
April, 2019

ventory content

All cus
tomers

pack 9.2.15.1

• Discovery capa
bility for a num
ber of software
components
Application update

123 - BigFix In

All cus

9.2.15

ventory 9.2.14

tomers

March, 2019

update

• Preview feature:
New Software
Summary (Pre
view) report.

Comments
and upgrade
considerations

More infor
mation

Table 1. Updates and patches (continued)
Update
• Extended report
ing of usage sta
tistics for Java.
• Extended sup
port for new
platforms and
new virtualiza
tion technolo
gies.
• New Software
Installations
report that is
based on the
new data model.
• Extension of the
To Do list.
• Documentation
extended with
new topics.
• New look and
feel of the user
interface.
• Usability im
provements on
the manage
ment panels.
• Filtering reports
by using match

Site version

Target
customers

Comments
and upgrade
considerations

More infor
mation

Table 1. Updates and patches (continued)
Update
es exactly oper
ator.
• New naming
convention for
the exported re
ports.
• Extended dis
covery of Oracle
Databases cer
tified for Oracle
Database 18c:
18.3.
• Discovery of
new compo
nents from Cit
rix, HewlettPackard, Oracle
and other.
• Names of Big
Fix Inventory
fixlets in the Big
Fix console con
tain information
about version.
• Security en
hancements.

Site version

Target
customers

Comments
and upgrade
considerations

More infor
mation

Table 1. Updates and patches (continued)
Update

Site version

Content pack 9.2.14.1 122 - BigFix In
February, 2019

ventory content

Target
customers
All cus
tomers

pack 9.2.14.2

• Discovery capa
bility for a num
ber of software
components
Content pack 9.2.14.1 121 - BigFix In
January, 2019
• Discovery capa
bility for a num
ber of software
components
• Improved dis
covery of the Or
acle database
features with
the use of the
ReviewLite.sql
script and the
extension of the
Oracle Feature
Health Check
analysis with ad
ditional informa

ventory content
pack 9.2.14.1

All cus
tomers

Comments
and upgrade
considerations

More infor
mation

Table 1. Updates and patches (continued)
Update

Site version

Target
customers

tion for better
serviceability.
• Modification of
the file compres
sion utility used
by the fixlets.
Application update

120 - BigFix In

All cus

9.2.14

ventory 9.2.14

tomers

December, 2018

update

• Reporting li
cense usage for
Adobe Creative
Cloud products
on Windows.
• Reporting li
cense usage for
IBM Rational
portfolio.
• Tagging soft
ware for more
flexible catego
rization.
• Preview feature:
The new dash
board is extend
ed with addition

Comments
and upgrade
considerations

More infor
mation

Table 1. Updates and patches (continued)
Update
al widgets and
quick search.
• New predefined
reports.
• Preview fea
ture: Detect
ing malware
threats based
on SHA-256 file
checksums.
• Reporting end
of support dates
for Microsoft
products.
• Best practices
for configuring
VM managers.
• Top navigation
bar extended
with the icon for
providing feed
back.
• Changes in the
Report menu.
• Users panel is
expanded with
the information
about time and

Site version

Target
customers

Comments
and upgrade
considerations

More infor
mation

Table 1. Updates and patches (continued)
Update
date of the last
login.
• Improvements
on the VM Man
agers panel.
• Migrating soft
ware classifica
tion with REST
API.
• Retrieving infor
mation about
the license uti
lization peak
and the con
tributing soft
ware instances
through REST
API in version 2.
• Discovery of
new compo
nents from Cit
rix, Oracle, SAP
and other.
• Certification of
Microsoft Edge
browser.

Site version

Target
customers

Comments
and upgrade
considerations

More infor
mation

Table 1. Updates and patches (continued)
Update

Site version

Target
customers

• Support for new
virtualization
technologies.
• Security en
hancements.
• Information
about the ses
sion time out af
ter a period of
user inactivity
Content pack 9.2.13.2 119 - BigFix In
November, 2018
• Discovery capa
bility for a num
ber of software
components
• Software clas
sification capa
bility for new re
leases of IBM
software prod
ucts.
• Multiple updates
and additions
for non-IBM
software titles.

ventory content
pack 9.2.13.2

All cus
tomers

Comments
and upgrade
considerations

More infor
mation

Table 1. Updates and patches (continued)
Update

Site version

Target
customers

See the change
list for additional
details.
Content pack 9.2.13.1 118 - BigFix In
October, 2018

ventory content

All cus
tomers

pack 9.2.13.1

• Discovery capa
bility for a num
ber of software
components
Application update

117 - BigFix In

All cus

9.2.13

ventory 9.2.13

tomers

September, 2018

update

• Utilization of the
Registered User
metric for Mi
crosoft Office
365
• Reporting addi
tional IBM met
rics based on
the resource
utilization data
that is delivered
by .slmtag files

Comments
and upgrade
considerations

More infor
mation

Table 1. Updates and patches (continued)
Update
• Version curren
cy of Internet
browsers and
other selected
software that
changes fre
quently
• Reporting uti
lization of Flex
Points
• Preview fea
ture: Visibility of
Common Vulner
abilities and Ex
posures (CVEs)
• New predefined
reports available
under Software
Classification
panel
• Preview feature:
Security dash
board and re
porting
• New To Do list
on the top navi
gation bar

Site version

Target
customers

Comments
and upgrade
considerations

More infor
mation

Table 1. Updates and patches (continued)
Update
• Information
about the
shared proces
sor pool
• REST API as
sociations for
quick analysis of
security risks
• Filtering reports
and retrieving
data through
REST API re
quest by using is
empty and is not
empty operators
• Support for Big
Fix Inventory
server on MS
SQL 2016
• Discovery of
new compo
nents from Cit
rix, Symantec,
Oracle and other
• List of software
components
with end of sup

Site version

Target
customers

Comments
and upgrade
considerations

More infor
mation

Table 1. Updates and patches (continued)
Update

Site version

Target
customers

port dates is up
dated
• Performance im
provements
• Security en
hancements
Content pack 9.2.12.2 116 - BigFix In
August, 2018

ventory content
pack 9.2.12.2

• Discovery capa
bility for a num
ber of software
components
Content pack 9.2.12.1 115 - BigFix In
July, 2018

ventory content
pack 9.2.12.1

• Discovery capa
bility for a num
ber of software
components
Application update

114 - Fix for

Customers

9.2.12

APAR IJ07404

who scan

June, 2018

shared
disks

Comments
and upgrade
considerations

More infor
mation

Table 1. Updates and patches (continued)
Update
• Reporting de

Site version

Target
customers

113 - BigFix In

All cus

tailed hardware

ventory 9.2.12

tomers

information

update

• Preventing se
curity threats
with information
about Common
Vulnerabilities
and Exposures
(CVE) added to
the software
catalog
• Retrieving infor
mation about
the discovered
software com
ponent as spec
ified in the Com
mon Platform
Enumeration
(CPE) dictionary
• Enhancements
to reporting end
of support dates
• Using Review
Lite script for
extended dis

Comments
and upgrade
considerations

More infor
mation

Table 1. Updates and patches (continued)
Update
covery of Oracle
databases
• Automatic scan
ning of remote
shared disks
• Collecting uti
lization data
of SAP license
metrics with Li
cense Admin
istration Work
bench 2.0
• Flexible license
management
by specifying
the type of re
lation between
a component
and a product as
charged or not
charged based
on the specific
license agree
ment
• Refreshing scan
data on a com
puter through

Site version

Target
customers

Comments
and upgrade
considerations

More infor
mation

Table 1. Updates and patches (continued)
Update

Site version

the Support
Page
• Resuming a con
nection to the
VM manager
• Information
about full ver
sion of already
discovered files
• Extension of au
dit snapshot
• A new link to
Learning Re
sources under
Help
• Security en
hancements
• Support for Big
Fix Inventory
server on DB2
11
Content pack 9.2.11.3 112 - BigFix In
June, 2018

ventory content
pack 9.2.11.3

Target
customers

Comments
and upgrade
considerations

More infor
mation

Table 1. Updates and patches (continued)
Update

Site version

Target
customers

• Discovery capa
bility for a num
ber of software
components
Content pack 9.2.11.2 110 - BigFix In
April, 2018

ventory content
pack 9.2.11.2

• Discovery capa
bility for a num
ber of software
components
Application update

107, 108 - Big

Customers

9.2.11.1

Fix Inventory

with large

April, 2018

9.2.10.1 update

environ
ments with
more than

• Fix for APAR

3 millions

IJ05768

files used
for soft
ware de
tection.
Application update

106 - Refresh of

9.2.11

the DB2 license

March, 2018

terms
105 - BigFix In

All cus

ventory 9.2.11

tomers

Comments
and upgrade
considerations

More infor
mation

Table 1. Updates and patches (continued)
Update
• Improved li
cense planning
and prevention
of security risk
by setting up
and monitoring
end of support
dates for specif
ic software
• Utilization of the
Virtual Proces
sor Core (VPC)
metric for IBM
products
• Introduction of
the Package Da
ta Summary re
port
• Reporting infor
mation about
the detailed ver
sion of Windows
applications
• Discovery of
new compo
nents from Win
dows, Corel,

Site version
update + March
catalog update

Target
customers

Comments
and upgrade
considerations

More infor
mation

Table 1. Updates and patches (continued)
Update

Site version

Target
customers

Adobe, Syman
tec and SAP
• Simplification
of updating the
software cata
log
• Optimizing data
imports thanks
to enabling a
new schema of
the BigFix data
base
• Preventing accu
mulation of un
processed data
in case of failing
imports
Application update

104 - February

All cus

9.2.10.1

catalog update

tomers

January, 2018

103 - January

All cus

catalog update

tomers

102 - BigFix In

All cus

• Fix for APAR
IJ03008

ventory 9.2.10.1 tomers
update

Application update

99, 100 - BigFix

9.2.10

Inventory 9.2.10 tomers

All cus

Comments
and upgrade
considerations

More infor
mation

Table 1. Updates and patches (continued)
Update
December, 2017

Site version
update + De
cember catalog

• Reporting us
age of prod
ucts such as Mi
crosoft Office
at suite level ag
gregated per
computer
• Collecting and
measuring uti
lization of SAP
license metrics
• Adding products
to the software
catalog
• Information
about imported
part numbers
that influenced
the initial clas
sification is vis
ible on the Soft
ware Classifica
tion panel
• REST API for ad
vanced integra

update

Target
customers

Comments
and upgrade
considerations

More infor
mation

Table 1. Updates and patches (continued)
Update
tion and data
sharing
• New computer
status - Outdat
ed VM Manager
Data
• Stand-alone
scanner for
monitoring iso
lated HP-UX
computers
• Information
about the num
ber of partition
cores
• Discovery of
new compo
nents from HP,
SAP, BMC and
other
• Optimizing the
import of data
• Serviceability
improvements
• Support for
Docker contain
ers under Red
Hat OpenShift

Site version

Target
customers

Comments
and upgrade
considerations

More infor
mation

Table 1. Updates and patches (continued)
Update

Site version

Target
customers

Comments
and upgrade
considerations

Application update

98 - November

All cus

APARs deliv

9.2.9

catalog update

tomers

ered in the cat
alog update

October, 2017

• IJ00010

• Reporting of

• IJ00393

SAP license us

• IJ00821

age with integra
tion of SAP Li
cense Admin

97 - VM Man

All cus

VM Manager

istration Work

ager Tool up

tomers

Tool version

bench (SLAW)

dated to version

1.6.0.1 sup

and SAP USMM

1.6.0.1

ports RHEV-

• Discovery of Or

M version

acle Database

4.x. The sup

extended to So

port covers in

laris

stances that

• Discovery of

use HTTP Ba

new compo

sic Authenti

nents from Or

cation and ver

acle, SAP, and

sion 3 REST

Red Hat

API.

• Adding custom

RHEV-M 4.x

fields to license

uses differ

metric reports

ent URL than

• Reporting infor
mation about
the detailed ver

the earlier ver
sions.

More infor
mation

Table 1. Updates and patches (continued)
Update

Site version

sion of software 96 - October
components
catalog update
• Stand-alone
scanner for
monitoring iso
lated AIX com
puters
• Filtering the
Package Data
report to view
the packages
that can be used
to create new
software signa
tures
• Improved securi
ty of storing VM
manager pass
words
• Configuring
LDAP server that
uses load bal
ancer to pre
serve server cer
tificates
• User interface
improvements

Target
customers
All cus
tomers

95 - BigFix

All cus

Inventory

tomers

9.2.9 update +
September cata
log update

Comments
and upgrade
considerations

More infor
mation

Table 1. Updates and patches (continued)
Update

Site version

Target
customers

Comments
and upgrade
considerations

• Scanner im
provements
• Version of the
application build
visible in PDF re
ports
• Software cat
alog enhance
ments
Application update

94 - August cat

All cus

APARs deliv

9.2.8

alog update

tomers

ered in the cat
alog update

June, 2017

• IV98394

• Utilization of the

• IV99115

Single and Dual
Physical Proces 93 - July catalog All cus

APARs deliv

sor metrics for

ered in the cat

update

tomers

Microsoft Win

alog update

dows Server
• Utilization of the

• IV96696

Oracle Proces

• IV97087

sor Core metric

• IV97770

for Oracle Data
bases
• Reporting soft
ware installed
on shared disks

92 - Discon

Customers

nected scan

who use

ner package up discon
dated with the

nected
scans

More infor
mation

Table 1. Updates and patches (continued)
Update

Site version

based on soft

scanner version

ware templates

2.8.0.4001

• Collecting ex
ecutable files
based on appli
cation usage
• Version 2 of
REST APIs for
software and
hardware inven

Target
customers

considerations

All cus

If you installed

update to ad

tomers

the scanner

dress a problem

in version

with scanner

2.8.0.4000,

performance

upgrade it

and the soft

to version

ware scan

2.8.0.4001.
If you started
the software

• Assigning a new

scan by us

license metric to

ing the Initiate

an existing prod

Software Scan

uct

fixlet from site

• Configuration

number 90,

of user account

restart the

lockout

scan action by

• Stand-alone

using the fixlet

scanner for

from site num

monitoring iso

ber 91.

lated Solaris
• Automatic de

and upgrade

91 - Fixlet site

tory

computers

Comments

90 - Fixlet site

All cus

If you started

update to ad

tomers

the software

commissioning

dress a prob

scan by us

of computers

lem with initiat

ing the Initiate

that are inactive

ing the software

Software Scan

scan

fixlet from site

More infor
mation

Table 1. Updates and patches (continued)
Update

Site version

Target
customers

Comments
and upgrade
considerations

for a specified

number 89,

period of time

restart the

• Fixlet for collect

scan action by

ing logs to trou

using the fixlet

bleshoot prob

from site num

lems with com

ber 90.

puters
• Viewing all sig
natures that are
defined for a
component in
the software
catalog
• Improved brows
ing of the soft
ware catalog
content
• Serviceability
improvements
• Information
about supported
operating sys
tems can be dy
namically gen
erated through
SPCR
• Discovery of
new compo

89 - BigFix In

All cus

APARs deliv

ventory 9.2.8

tomers

ered in the cat

update + June

alog update:

catalog update
• IV95226

More infor
mation

Table 1. Updates and patches (continued)
Update

Site version

Target
customers

Comments
and upgrade
considerations

nents from Or
acle, SAP, and
Red Hat
Application update

88 - May cata

All cus

APARs deliv

9.2.7

log update

tomers

ered in the cat
alog update:

March, 2017

• IV95322

• New Software

• IV94805

Classification

• IV95235

panel replaces
the IBM Soft

87 - April cata

All cus

ware Classifica

log update

tomers

tion panel
• Creation of cus
tom classifica
tion rules
• Utilization of the
Physical Core
and Virtual Core
metrics for Mi
crosoft SQL
Server with Soft
ware Assurance
• Utilization of
license met
rics for VMware

86 - BigFix In

APARs deliv

ventory 9.2.7

ered in the cat

update + March

alog update:

catalog update
• IV80621
• IV81865
• IV81714
• IV80371
• IV81815
• IV93555
• IV93252

More infor
mation

Table 1. Updates and patches (continued)
Update
vCenter and
vSphere
• Discovery of
SAP compo
nents
• Utilization of the
Install Instances
metric for IBM
products
• Overview of li
cense metrics
that are used by
IBM products in
your infrastruc
ture
• Discovery of
software and
hardware inven
tory with discon
nected scans on
Windows and
Linux
• API for adding
and changing
VM managers
• Adding custom
part numbers to
the catalog

Site version

Target
customers

Comments
and upgrade
considerations

More infor
mation

Table 1. Updates and patches (continued)
Update

Site version

Target
customers

Comments
and upgrade
considerations

• Extension of two
bundling rules:
bundling tags
and part num
bers
• Two-phase
matching of file
signatures
• Configuring se
curity policy for
user passwords
• Improvements
of the VM Man
ager Tool
• Optimization of
migration
• New look and
feel of the user
interface
• Discovery of
new compo
nents from Mi
crosoft, SAP, and
Oracle
Application update

84, 85 - Febru

All cus

APARs deliv

9.2.6

ary catalog up

tomers

ered in the cat

December, 2016

date

alog update:

More infor
mation

Table 1. Updates and patches (continued)
Update

Site version

Target
customers

Comments
and upgrade
considerations

• Enhanced dis

• IV87656

covery of Mi

• IV92592

crosoft Ex
change editions
• Reporting high

83 - January

APARs deliv

catalog update

ered in the cat
alog update:

water mark of
Oracle Database

• IV91508

user sessions

• IV90557

• Measuring appli

• IV90764

cation usage on

• IV91182

Mac OS X
• Utilization of
the Install Seats
metric for prod
ucts discovered
by SWID tags
• Upload of PVU
table and soft
ware catalog
during the up
grade
• Reduced impact
of scans due to
the optimization
of the scanner
cache folder on
the endpoints

82 - BigFix In
ventory 9.2.6
update + De
cember catalog
update

More infor
mation

Table 1. Updates and patches (continued)
Update
• Searching the
software cata
log by part num
ber
• Best practices
for database
backup
• Fixlet version
visible in the Big
Fix client logs
• Improved perfor
mance of gen
erating CSV re
ports
• Additional op
tions for migrat
ing from License
Metric Tool and
Tivoli Asset Dis
covery for Dis
tributed 7.x
• PREVIEW FEA
TURE: Utilization
of the physical
core-based met
ric for Microsoft
SQL Server

Site version

Target
customers

Comments
and upgrade
considerations

More infor
mation

Table 1. Updates and patches (continued)
Update

Site version

Target
customers

• PREVIEW FEA
TURE: Extension
of the Software
Classification
panel
Application update

81 - November

All cus

9.2.5.1

catalog update

tomers

October, 2016

80 - October

All cus

catalog update

tomers

79 - BigFix In

All cus

ventory 9.2.5.1

tomers

• Fix for APARs
IV89617,
IV90167,
IV90129

update

Application update

78 - Fixlet site

All cus

9.2.5

update to ad

tomers

September, 2016

dress security
vulnerability in

• Utilization of the the compress
Install metric for ing utility used
non-IBM prod
ucts
• Software discov
ery on IBM i
• Software dis
covery in Docker
containers

by the scanner
77 - BigFix

All cus

Inventory

tomers

9.2.5 update +
September cata
log update

Comments
and upgrade
considerations

More infor
mation

Table 1. Updates and patches (continued)
Update
• Bundling tags
for improved
software classi
fication
• Determining the
usage of Virtual
Processor Cores
(VPC)
• Information
about software
scan duration
• New VM manag
er status - Insuf
ficient rights
• Information
about processor
brand string
• Forcing re-up
load of software
scan results
• Installing the
scanner in an al
ternative path
• PREVIEW FEA
TURE: Extension
of the Software
Classification
panel

Site version

Target
customers

Comments
and upgrade
considerations

More infor
mation

Table 1. Updates and patches (continued)
Update

Site version

Target
customers

Application update

76 - August cat

All cus

9.2.4

alog update

tomers

June, 2016

75 - July catalog All cus

• Setting metric
thresholds for
IBM products
• Sharing feed
back
• Improvements
for VM man
agers
• API to retrieve
cluster informa
tion
• Support for Big
Fix database
restoration
• Optimization
of the scanner
cache configura
tion
• Discovery of
software that is
not in the cur
rent software
catalog

update

tomers

74 - June cata

All cus

log update

tomers

72, 73 - BigFix

All cus

Inventory 9.2.4

tomers

update

Comments
and upgrade
considerations

More infor
mation

Table 1. Updates and patches (continued)
Update

Site version

Target
customers

Comments
and upgrade
considerations

• PREVIEW FEA
TURE: New Soft
ware Classifica
tion panel
Application update

71 - May 2016

All cus

9.2.3.1

catalog update

tomers

April, 2016

70 - April 2016

• Fix for APAR
IV83558 (Up
grade issue on
DB2)
• Performance im
provements

catalog update
69 - BigFix In

Customers Upgrade from

ventory 9.2.3.1

who have

update

not yet up er than 9.2.3:

version earli

graded to

Stop the ac

applica

tions created

tion up

by the Initiate

date 9.2.3. Software Scan
If you al
ready up
graded to
version
9.2.3, you
can install

and Upload
Software Scan
Results fixlets
and start them
again by using
the fixlets from

the update the updated
BigFix Invento
to improve
ry site.
the appli
cation per Upgrade from
formance.

version 9.2.3:

More infor
mation

Table 1. Updates and patches (continued)
Update

Site version

Target
customers

Comments
and upgrade
considerations
Stop the ac
tions created
by the Initiate
Software Scan
fixlet and start
them again by
using the fixlet
from the up
dated BigFix
Inventory site.

Application update

67, 68 - BigFix

All cus

Stop the ac

9.2.3

Inventory 9.2.3

tomers

tions created

March, 2016

update + March

by the Initiate

2016 catalog

Software Scan

update

and Upload

• Support for Uni
code
• Collecting

Software Scan
Results fixlets

file MD5 and

and start them

SHA256 check

again by using

sums for securi

the fixlets from

ty purposes

the updated

• Conditional

BigFix Invento

report emails

ry site.

based on the

If you do not

number of rows

restart these

in the report

actions, re
sults of the

More infor
mation

Table 1. Updates and patches (continued)
Update

Site version

Target
customers

Comments
and upgrade
considerations

• Controlling scan

delta file sys

schedule direct

tem scan are

ly from the Big

not generated

Fix Inventory

and the full file

user interface

system scan

• Data visibility

is always up

and license re

loaded to the

porting per com

BigFix server.

puter group lim
ited to autho
rized users
• Replacing Soft
ware Knowledge
Base Toolkit
with BigFix In
ventory for man
aging the soft
ware catalog
content
• Flexible date fil
tering
• Collecting host
serial numbers
• Forcing capaci
ty scan data up
loads
• Changing ad
vanced server

More infor
mation

Table 1. Updates and patches (continued)
Update

Site version

Target
customers

settings from
the application
user interface
• Manually adjust
ing the PVU per
core value from
the BigFix Inven
tory user inter
face
Application update

66 - February

All cus

9.2.2

catalog update

tomers

December, 2015

65 - January

• License reports
per IBM subca
pacity region

catalog update
64 - December
catalog update

• License reports

63 - BigFix In

per organiza

ventory 9.2.2

tional business

update

unit
• License reports
in the service
provider environ
ment
• Creating extend
ed signatures

Comments
and upgrade
considerations

More infor
mation

Table 1. Updates and patches (continued)
Update

Site version

Target
customers

• REST API for
retrieving raw
scan data
• Consolidated
endpoint infor
mation
• Disabling the
calculation of
extended soft
ware aggregates
• Configuring lo
cation of the
scanner cache
folder
• Identifying VM
manager dupli
cates
• Defining time
range of reports
in relation to the
current data
• Support for new
platforms
Application update

62 - November

All cus

9.2.1

catalog update

tomers

October, 2015

61 - October
catalog update

Comments
and upgrade
considerations

More infor
mation

Table 1. Updates and patches (continued)
Update

Site version

• Rebranding from 59 and 60 - Fix
IBM Endpoint
for incorrectly
Manager for

encoded Japan

Software Use

ese and Chinese

Analysis to IBM

translated files

BigFix Inventory

introduced dur

• Discovery of
software in
stalled on Mac
OS
• Extended dis
covery of Oracle
Database
• Monitoring uti
lization of li
cense metrics
other than PVU
and RVU MAPC

ing site propa
gation 58.
58 - Fix of rele
vance errors re
ported by BigFix
console for one
of troubleshoot
ing fixlet (in
ternal defect
143747)
57 - BigFix

• Single Sign-On

Inventory

• Coexistence

9.2.1 update +

of multiple in

September 2015

stances of Big

catalog

Fix Inventory on
one BigFix plat
form
• Identifying com
puters running
on public clouds

Target
customers

Comments
and upgrade
considerations

More infor
mation

Table 1. Updates and patches (continued)
Update

Site version

Target
customers

• Creating cus
tom signatures
based on nonstandard file
types
• Adding custom
bundling options
• Checking why a
Fixlet is not rele
vant
• Manually adjust
ing the PVU per
core value
• Importing delta
file system scan
Application update

55 and 56 - Au

All cus

9.2.0.2

gust 2015 cata

tomers

June 25, 2015

log

• Migrating cus
tomizations
from Software

53 and 54 - July
2015 catalog
52 - June 2015

Use Analysis 2.2 catalog
• Coexistence of
Software Use
Analysis and Li
cense Metric

50, 51 - SUA
9.2.0.2 update

Comments
and upgrade
considerations

More infor
mation

Table 1. Updates and patches (continued)
Update

Site version

Target
customers

Comments
and upgrade
considerations

Tool on one End
point Manager
server
• Collecting ca
pacity data di
rectly from KVM
hosts
• Hiding free soft
ware instances
from the IBM
Software Classi
fication panel
• PowerShell as
the communica
tion interface for
Hyper-V
Application update

48 - Fixed pre-

Customers Only fixlet for

9.2.0.1

fetch syntax er

with IEM

upgrading to

May 19, 2015

ror

enhanced

the newest

security

version of SUA

mode en

changed.

• Fixes for critical

abled and

APARs

SHA-256
downloads
required
47 - SUA 9.2.0.1 All cus

The update is

update

recommend

tomers

More infor
mation

Table 1. Updates and patches (continued)
Update

Site version

Target
customers

Comments
and upgrade
considerations
ed for all cus
tomers who
are using SUA
9.2

Application update

46 - April 2015

All cus

Coexistence

9.2

catalog

tomers

with Software

March 19, 2015

45 - April 2015

• Windows in
staller for the
Software Use
Analysis server

catalog; SwKBT
database re
freshed with
new catalog

working with MS 44 - Refreshed
SQL server data installers with
base
• Migration from

fix for APAR
IV70954

TAD4D 7.2.2 and 42, 43 - Re
7.5

moval of the

• Scan groups and ability to in
scan schedule

stall/upgrade

migration

because of

• Coexistence be
tween SUA 2.2
and 9.x

APAR IV70954
41 - SUA 9.2 GA

Use Analysis
2.2.

More infor
mation

Table 1. Updates and patches (continued)
Update

Site version

Target
customers

Comments
and upgrade
considerations

• Serviceability
improvements
for VM man
agers
What's new in this re
lease
Application update

40 - February

Customers The number

9.0.1.2

2015 catalog

migrating

December 19, 2014

39 - January

• Migration from
TAD4D 7.5
• Optimized vol

2015 catalog

from Tivoli sions that are
Asset Dis

scanned and

covery for

analyzed on

38 - SUA 9.0.1.2 Distributed the endpoints
refresh
7.5
is smaller,

ume of scanned 37 - VMMAN_

which reduces

file data

the load on the

• Information
about software
that is installed

Tool/1.0.0.6
36 - November
2014 catalog

Software Use
Analysis serv
er. To get ac

on UNIX shared

35 - SUA 9.0.1.2

curate results,

disks

update with

you must run a

• Scan health wid September 2014
catalog
get
What's new in this re
lease

of file exten

34 - November
2014 catalog fix

new software
scan shortly
after you have
applied this
patch.

More infor
mation

Table 1. Updates and patches (continued)
Update

Site version

Target
customers

Comments
and upgrade
considerations
The ability to
scan shared
disks on de
mand. This
can result
in multiple
clients scan
ning a shared
disk at the
same time,
which can low
er the perfor
mance of the
shared disk.
Moreover, soft
ware scans
and data im
ports can be
longer.

Application update

33 - November

9.0.1.1

2014 catalog

October 30, 2014

32 - Minor con

• Export of the en
tire software in

tent updates
31 - Minor con

ventory to a CSV tent updates
file

More infor
mation

Table 1. Updates and patches (continued)
Update
• Support for
Power Systems
on Linux (End
point Manager
client)

Site version

30 - Minor con
tent updates
29 - SUA 9.0.1.1
update

What's new in this re
lease
Application update

28 - CIT v

9.0.1

2.7.0.2043

August 17, 2014

27 - September

• Deployment
Health widget
• Integration with

2014 catalog
26 - July 2014
catalog

SmartCloud

25 - SUA 9.0.1

Control Desk

GA with June

(SCCD)

2014 catalog

• Managing the
software scan
from the web
user interface
• Customized re
port views
• REST API for
exporting and

Target
customers

Comments
and upgrade
considerations

More infor
mation

Table 1. Updates and patches (continued)
Update

Site version

importing cus
tomized report
views
• REST API for re
trieving comput
ers, software,
and license use
• Automatic ca
pacity configura
tion for Linux on
z/VM
• Support for the
ISO/IEC 19970-2
standard
• CPU pooling on
Linux for IBM
System z
• Shorter catalog
import time
What's new in this re
lease
Application update

24 - July 2014

9.0.0.2

catalog

June 2014

23 - Minor con

This update contains

tent updates

fixes for APARs.

Target
customers

Comments
and upgrade
considerations

More infor
mation

Table 1. Updates and patches (continued)
Update

Site version

What's new in this re

22 - SUA 9.0.0.2

lease

update

Application update

21 - April 2014

9.0.0.1

catalog

March 2014

20 - CIT version

• Native catalog
export and im
port

2.7.0.2039
19 - March 2014
catalog

• IBM software

18 - February

catalog ver

2014 catalog

sioned accord
ing to its release
date

17 - SUA 9.0.0.1
update

• Fixlet for diag
nosing the Com
mon Invento
ry Technology
scanner
• APARS and de
fects
What's new in this re
lease
Application update

16 - Minor con

9.0

tent updates

Target
customers

Comments
and upgrade
considerations

More infor
mation

Table 1. Updates and patches (continued)
Update
December 2013
• Subcapacity re
ports
• New and en

Site version

considerations

More infor
mation

14 - Minor con
tent updates

terface: dash

2.7.0.2000

• Audit log

and upgrade

tent updates

13 - CIT version

menu

customers

Comments

15 - Minor con

hanced user in
board and top

Target

12 - Minor con
tent updates
11 - Minor con

What's new in this re
lease

tent updates
10 - SUA 9.0 GA

Release notes
The release notes outline the features, updates and patches that are included in each
version of BigFix Inventory, including the latest application updates. The latest update is
cumulative and includes changes from previous releases.

Installing the update
To upgrade the BigFix Inventory server to the latest version, see Upgrading to BigFix
Inventory v10.

Application update 10.0.11
Table 2. Published site version
Name of component

Updated in

Version

the release

BigFix Inventory Content Site

157

Yes

BigFix Inventory Software Catalog

10.0.11.0

Yes

2638755

Yes

BigFix Inventory Server

10.0.11.0

Yes

BigFix Inventory Server: ILMT Core li

9.2.29.0

Yes

BigFix Inventory Server: ILMT Catalog

9.2.29.0

Yes

BigFix Inventory Scanner

9.2.29.1000 on Win

Yes

dows

Yes

(main version)
BigFix Inventory Software Catalog
(version on endpoint)

brary

9.2.29.0000 on other
platforms
BigFix Inventory Disconnected Scan

10.0.11.0

Yes

ner (incl. package for Containers)

9.2.29.0 on IBM I

Yes

BigFix Inventory VM Manager Tool

10.0.11.0

Yes

SAP Metric Data Collector

10.0.11.0

Yes

BigFix Inventory Image Scanner Script 10.0.11.0

Yes

BigFix Inventory Scanner Service

10.0.11.0

Yes

BigFix Inventory Cloud Adapter

10.0.11.0

Yes

Table 2. Published site version (continued)
Name of component
Software Data Harvesting Tool for

Updated in

Version

the release

1.1

No

1.0

No

BigFix Inventory
BigFix Inventory Keystore Migration
Tool
Allowed upgrade path
Starting from BigFix Inventory version 10.0.10.0, to ensure smooth upgrade
process, direct upgrade is supported from the last 8 server versions. The
minimal version for direct upgrade path increases with every release.
Depending on version number, one or more upgrade steps are necessary. The
minimal version for direct upgrade path is 10.0.3.0. For versions up to 10.0.1.0
(inclusive), upgrade first to 10.0.2.0 then upgrade to 10.0.10.0 using Upgrade
to interim version fixlets.
Tip: It is recommended to upgrade BigFix Inventory frequently to make
the new features and security fixes available. At least one upgrade per
year is important.
Changes to supported systems
Added support for the following platforms and systems as managed devices:
• AIX 7.3
• Red Hat Enterprise Linux 9
• Ubuntu 22.04
• KDDI Cloud for Linux
• Solaris 10

Note: Solaris 10 is supported by BigFix Inventory with the use of
BigFix Platform Agent 9.5 on both BigFix Platform 9.5 and 10.
IBM has discontinued Solaris 10 as IBM sub capacity eligible
platform.Use actions like “Initiate Software Scan” from this release as
it includes improved support for handling Solaris package manager
combinations.
For more information about supported systems, refer to Detailed System
requirements.
Changes to contracts management
This release offers additional enhancements for contracts management.
• A new Product Metrics per Contract report is available using the
dropdown option from Products column.
• A recalculation option is available in the All Contracts panel to quickly
recalculate metric value in case of changes in contract definition. For
contracts that require recalculation a special icon is added.
• Support for a new metric Microsoft SQL Server Physical Processor
Cores in line with the latest Microsoft product terms. The new metric
is calculated once contract is defined to give SAM full control for
what specific contract and group it is needed. Enabling license usage
calculation on computer group definition to calculate this metric is no
longer required. This new metric is managed through contract definition
and due to this reason its value is not presented in All metrics panel.
Note: The current metric value for this particular metric
is calculated based on recent data. In case of All metrics,
calculation is available by default for 90 days period (depending
on computer group definition). Newly supported metrics and
selected existing metrics will use this new mechanism in future
releases.

• Quick link to All Contracts is available from All Metrics originated
reports.
• Hands-on tutorial is available in product documentation under Contract
Management.
For the complete list of changes see What's new.
Note:
• The option for contract management with support of All Metrics
panel and its custom fields definition will be deprecated in the
future.
• IBM Flexpoint bundles, IBM Cloud Paks are not supported by
contracts management function.
• Product Metrics per Group report is still available from main
menu to allow for reporting of high-water mark metrics with split
per computer group.

Extended Oracle Database Features Discovery
Reporting covers Oracle pluggable databases and additional licensable
options including Tuning Pack, Oracle Database Lifecycle Management Pack,
Data Masking and Subsetting Pack.
Improved support for Oracle Database 11, old versions of UNIX devices
(Solaris & AIX) and extended list of return codes for troubleshooting.
Included Software Catalog
This release includes Software Catalog version 10.0.11.0 with capability to
discover 170+ new software versions including but not limited to the software
manufacturers, such as Adobe, Autodesk, Cisco, Citrix, McAfee, Microsoft, and
VMware.

For more information, refer to the Catalog Release Notes and Catalog Change
List.
Modified content
The version number of the fixlet is: 10.0.11.0
The following fixlets were updated and should be run to install the latest versions
of the specific components:
• Upgrade to the latest version of BigFix Inventory
• Update VM Manager Tool to version
• Update SAP Metric Data Collector
• Install VM Manager Tool
• Install SAP Metric Data Collector
• Install Additional VM Manager Tool
• Download the Disconnected Scanner Package for IBM I
• Download the Disconnected Scanner Package
• Download the BigFix Inventory Container Solution Packages
• Download BigFix Inventory
• Install or Upgrade Scanner in private mode on Windows
• Install or Upgrade Scanner
• Software Catalog Update (if BigFix Inventory is not upgraded)
• Download PVU table (if BigFix Inventory is not upgraded)
• Upgrade to the interim version 10.0.2.0 of BigFix Inventory (translation
correction)
• Upgrade to the interim version 10.0.10.0 of BigFix Inventory (adjusted
applicability to follow minimal version for direct upgrade to current
version)
The following fixlets were updated and require that actions created by their
previous versions are stopped and then started by using the updated fixlets.
Restarting actions is necessary to ensure that new features work properly:

• Run Capacity Scan and Upload Results
• Initiate Software Scan on Shared Disks
• Initiate Software Scan
• Upload Software Scan Results – no updates, but recommended to be
refreshed to match Initiate
The following fixlets were updated or added:
• Get Oracle Features
• Get Oracle Concurrent Sessions Number
• Identify Computers on Public Clouds
• Analyze the Relevance of a Fixlet or Task
• Force Reupload of Software Scan Results
Enhancements and important changes
For complete list of enhancements, refer to the What's new.
Defect fixes
For the list of known defects please refer to HCL Knowledge Base.
The following table lists BigFix Inventory Server APARs and other defects that
are fixed in this update.
Behavior after
ID

Symptoms

you install the

Available since

update
KB0101057

Update Schema

Migration script

runs for days

has been re-en

when environ

gineered to re

ment contains

duce duration to

macOS devices

minutes.

10.0.11.0

Behavior after
ID

Symptoms

you install the

Available since

update
BI-11517

All Metrics re

The issue is

ports shows on

fixed.

10.0.11.0

ly 500 records
instead of the
correct number
of the records
KB0101000

Arithmetic over

Import step

flow error in Da

“Processing of

ta Import log

bundling tags”

files on DB2

completes suc

10.0.11.0

cessfully.
Affected on
ly DB2 deploy
ments.
KB0101628

BFI Import fails

Import step “In

10.0.11.0

- sam.instance_ ventoryBuilder”
hash - SQL Arith completes suc
metic Overflow
on MS SQL

cessfully.
Affected only
MS SQL deploy
ments.

BI-13844

Empty publisher

HCL Inventory

on HCL Invento

report is regen

ry report

erated during
upgrade so that
the filter criteria
are fixed. Lim

10.0.11.

Behavior after
ID

Symptoms

you install the

Available since

update
itation: Any re
port subscrip
tions or default
report settings
related to this
report will be
deleted during
upgrade.
KB0100847

Package Sum

The issue is

mary report fail

fixed.

10.0.11.0

ing to calculate
The following table lists BigFix Inventory Scanner APARs and other defects
that are fixed in this update.
Behavior after you install

Available

the update

since

Data en

Data encrypted on share

10.0.11.0

crypted on

disk using Guardium/Vor

share disk

metric solution is recog

ID

Symptoms

KB0099621

using Guardi nized as shared drive
um/Vormet
ric solution
is recog
nized as lo
cal filesys
tem and, is
therefore,
scanned by

ID

Symptoms

Behavior after you install

Available

the update

since

default on
every end
point when
such volume
is mounted
and decrypt
ed. Scan of
the remote
disk multiple
times from
many end
points might
lead to un
necessary
overload of
such share
disk.
The following table lists BigFix Inventory tool APARs and other defects that
are fixed in this update. It includes VM Manager, SAP Data Collector, Image
Scanner, Scanner Service, and Cloud Adapter.

ID

Symptoms

BI-11147

Hyper-V

Behavior after you install

Available

the update

since

Hyper-V VMs with the

10.0.11.0

VMs with the same UUID and located on
same UUID

the same host are exclud

and located

ed from scan results and

on the same

the VM Manager status

host are not

ID

Symptoms

Behavior after you install

Available

the update

since

detected as

is set to “OK - duplicated

duplicates

UUIDs discarded”.

and only one
of them is re
turned by the
scan.
The following table lists BigFix Inventory Catalog APARs and other defects
that are fixed in this update.
Behavior after you install

Available

the update

since

ID

Symptoms

KB0101234

The software Snagit template signa
‘Snagit’ was

ture updated to improve

not being

discovery. Also deleted

discovered

the regular signatures of

due to incor

SnagIt to avoid double dis

10.0.11.0

rect package covery.
and file rules
Note: Old discov
ery records will
be closed, and
new ones will be
opened.
KB0101283

Lack of dis

Discovery is added for Red 10.0.11.0

covery for

Hat JBoss Enterprise Ap

Red Hat

plication Platform,6.4 to

JBoss Enter cover non-standard instal
prise Appli

lations

ID

Behavior after you install

Available

the update

since

Enhance

Changed the way of de

10.0.11.0

ment of Mi

tecting signature for Mi

crosoft SQL

crosoft SQL Server Man

Server Man

agement Studio and Cit

agement

rix XenDesktop and added

Studio and

new detection for Mi

Citrix Xen

crosoft SQL Server Man

Desktop de

agement Studio for version

tection

18.12

Symptoms
cation Plat
form

BI-13474

Note: Old discov
ery records will
be closed, and
new ones will be
opened.
KB0101314

Adobe Acro

Discovery now provides

bat compo

usage monitoring for

10.0.11.0

nents did not Adobe Acrobat compo
provide us

nents.

age monitor
ing.
KB0101687

False posi

To provide better discov

tive discov

ery moved the existing ‘CA

ery of Site

SiteMinder Web Agent’

Minder Web

v6.0, v12.0 and v12.5 GAM

Agent v6.0

10.0.11.0

ID

Symptoms

Behavior after you install

Available

the update

since

signature to server-side
signature
Note: Old discov
ery records will
be closed, and
new ones will be
opened.
The following table lists BigFix Inventory Fixlets APARs and other defects that
are fixed in this update.

ID

Symptoms

BI-14163

The prop

Behavior after you install

Available

the update

since

The issue is fixed.

10.0.11.0

Fixlets relevancy is cor

10.0.11.0

erty ‘Appli
cation Us
age by Path’
in ‘Applica
tion Usage
Statistics’
analysis is
not updated
on Windows
after running
the Software
Scan
KB0100567

Scan relat

ed fixlets not rectly evaluated.

ID

Symptoms

Behavior after you install

Available

the update

since

The issue is fixed.

10.0.11.0

relevant on
SunOS end
points with
no Image
Packaging
System (IPS)
KB0101246

Client set
ting _BESRelay_UploadManager_CleanupHours value

resetting af
ter executing
some fixlets
The following table lists user documentations APARs and other defects that
are fixed in this update.
Behavior after you install

Available

the update

since

ID

Symptoms

BI-13122

Integrate

Added a section to include 10.0.11.0

Contracts

the hands-on tutorial for

business

contract management.

document
into BFI of
ficial docu

Doc link: Contract Manage
ment

mentation
VM Manager Tool version and changes

The VM Manager Tool version that is used with this update is 10.0.11.0.
Scanner version and changes
The scanner version that is used with this update is 9.2.29.1000 for Windows
and 9.2.29.0000 for other platforms. The disconnected scanner version that is
used with this update is 10.0.11.0 and 9.2.29.0 for IBM I.

Application update 10.0.10.1
Table 3. Published site version
Name of component
BigFix Inventory Content

Version

Updated in the release

156

Yes

10.0.10.1

Yes

2638749

Yes

BigFix Inventory Server

10.0.10.0

No

BigFix Inventory Server:

9.2.28.0

No

9.2.28.0

No

9.2.28.1000 on Windows

No

9.2.28.0000 on other plat

No

Site
BigFix Inventory Software
Catalog (main version)
BigFix Inventory Software
Catalog (version on end
point)

ILMT Core library
BigFix Inventory Server:
ILMT Catalog
BigFix Inventory Scanner

forms
BigFix Inventory Discon

10.0.10.0

No

nected Scanner (includes

9.2.28.0 on IBM I

No

package for Containers)

Table 3. Published site version (continued)
Name of component
BigFix Inventory VM Man

Version

Updated in the release

10.0.10.0

No

SAP Metric Data Collector

10.0.10.0

No

BigFix Inventory Image

10.0.10.0

No

10.0.10.0

No

10.0.10.0

No

1.1

No

1.0

No

ager Tool

Scanner Script
BigFix Inventory Scanner
Service
BigFix Inventory Cloud
Adapter
Software Data Harvesting
Tool for BigFix Inventory
BigFix Inventory Keystore
Migration Tool
Included Software Catalog
The release includes Software Catalog version 10.0.10.1 with capability to
discover 460+ new software versions that includes Adobe, BMC Software,
Cisco Systems Inc., Citrix, Hewlett-Packard, Microsoft, RED HAT, SUSE, and
VMware using standard or template signatures. One template signature
covers 10+ software versions.
Added discovery for the following SAS software:
• SAS/GRAPH (Windows, Unix)
• SAS/ACCESS Interface to PC Files (Windows, Unix)
• SAS/ACCESS Interface to Hadoop (Unix)
New template signatures included in this release:

Refer to the below links to see the new added template signatures:
• Catalog Release Notes
• Catalog Change List
Modified content
The version number of the fixlet is 10.0.10.1.
The Update Software Catalog fixlet was updated and should be run to install
the latest versions of the specific components.
Enhancements and important changes
The following table lists enhancements and changes that are introduced in
this update:
Abstract

Description

Enhancement of Or Enhanced discovery of existing
acle Java Detection

Available since
10.0.10.1

Java signature for versions 7, 8,
9, 10, 12, 13, 14 and 15 to cover
non-standard installations.

Added discovery for Added discovery for SAS/AC
SAS/ACCESS Inter

CESS Interface to Hadoop ver

face to Hadoop

sion 9 for Linux platform.

Added discovery for Added discovery for SAS/AC
SAS/ACCESS Inter

CESS Interface to PC Files for

face to PC Files

version 9. Discovery is added for

10.0.10.1

10.0.10.1

Windows and UNIX platforms.
Added discovery for Added discovery for SAS/
SAS/GRAPH

GRAPH version 9. Discovery is
added for Windows and UNIX
platforms.

10.0.10.1

Abstract

Description

Available since

Deleted detection for SAS/
GRAPH for AIX platform.
Added discovery for Added discovery for Microsoft
Microsoft Project

Project 365 for Windows plat

365

form.

10.0.10.1

Added discovery for Added discovery for Adobe Cold 10.0.10.1
Adobe ColdFusion

Fusion for versions 2018.0 and
2021.0 for Windows and Unix
platform.

Microfocus publish Updated the publisher name
er name update

10.0.10.1

from Microfocus to Micro Focus.
Note: Previously dis
covered records will be
closed, and new ones
will be available.

Changed definition

For several Microsoft compo

source of selected

nents, the definition source has

Microsoft compo

been updated to HCL.

nents
• Microsoft SQL Server Man
agement Studio – 17.9,
18.0, 18.1, 18.2, 18.3, 18.5,
18.6, 18.9
• Microsoft Host Integration
Server - 2016.0
• Machine Learning Server –
9.2, 9.3, 9.4

10.0.10.1

Defect fixes
For the list of known defects please refer to HCL Knowledge Base.
The following table lists BigFix Inventory Catalog APARs and other defects
that are fixed in this update:
Behavior after
ID

Symptoms

you install the

Available since

update
KB0100409

KB0100717

NetBackup sig

Signatures

natures from

from one of the

two different

sources were

sources leading

deleted to avoid

to double dis

double discov

covery

ery.

Incorrect Vendor The publisher
for SUSE Linux

was changed to

Enterprise Serv

SUSE as SUSE is

10.0.10.1

10.0.10.1

er for SAP Appli no longer part of

KB0100631

cations

Micro Focus.

Wrong identifi

Oracle Java 11

cation of Oracle

Signatures were

Java software

improved for ac

component

curate discov
ery.

10.0.10.1

Application update 10.0.10
Table 4. Published site version
Name of component
BigFix Inventory Content

Version

Updated in the release

155

Yes

10.0.10.0

Yes

2638744

Yes

BigFix Inventory Server

10.0.10.0

Yes

BigFix Inventory Server:

9.2.28.0

Yes

9.2.28.0

Yes

9.2.28.1000 on Windows

Yes

9.2.28.0000 on other plat

Yes

Site
BigFix Inventory Software
Catalog (main version)
BigFix Inventory Software
Catalog (version on end
point)

ILMT Core library
BigFix Inventory Server:
ILMT Catalog
BigFix Inventory Scanner

forms
BigFix Inventory Discon

10.0.10.0

Yes

nected Scanner (include

9.2.28.0 on IBM I

Yes

10.0.10.0

Yes

SAP Metric Data Collector

10.0.10.0

Yes

BigFix Inventory Image

10.0.10.0

Yes

package for Containers)
BigFix Inventory VM Man
ager Tool

Scanner Script

Table 4. Published site version (continued)
Name of component
BigFix Inventory Scanner

Version

Updated in the release

10.0.10.0

Yes

10.0.10.0

Yes

Service
BigFix Inventory Cloud
Adapter
Allowed upgrade path
It is recommended to upgrade BigFix Inventory frequently to benefit from new
features and security fixes. Please plan at least one upgrade per year.
Starting from 10.0.10 release to ensure smooth upgrade process there will be
kept support for direct update from last 8 server releases. The minimal version
for direct upgrade path will be increased with every release.
There will be preserved every 8th release to allow upgrade from past releases
any time. Currently available release is 10.0.2. Release 10.0.10 is the next
planned version to be preserved.
Minimal version recommended for direct upgrade path:
For versions up to 10.0.1 (inclusive), upgrade first to 10.0.2 using already
available interim fixlet.
Version 10.0.2 is the oldest version supporting direct upgrade to 10.0.10.
Update to the next version of BigFix Inventory will require to be at least at
10.0.3 release or upgrade to the 10.0.10 first.
Q: I’m on version 10.0.5 and would like to install 10.0.10 release.
A: Upgrade directly to the 10.0.10 release.
Q: I’m on version 9.2.17 and would like to install 10.0.10 release.
A: Update first to the 10.0.2 and then to the 10.0.10 release.

Q: I’m on version 10.0.2, but plan to do the upgrade in January 2023 to the most
recent release.
A: It would be version 10.0.11. You will have to upgrade first to the 10.0.10 and
then to the 10.0.11, as 10.0.11 will support upgrade from version 10.0.3 or
higher.
Q: I’m on version 9.2.13 and would like to upgrade in April 2023 to the most
recent release.
A: At that time version 10.0.12 should be available. You will need to upgrade
first to the 10.0.2, then to the 10.0.10 and at the end to the 10.0.13.
Changes to supported systems
IBM DB2 10.5 is no longer supported as a database for BigFix Inventory Server
in line with supported database list for BigFix platform. IBM withdrew support
for DB2 10.5 in April 2020.
Microsoft Internet Explorer web browser is no longer supported.
Added support for the following platforms and systems as managed devices:
• IBM Cloud LinuxONE VS
• NTT IaaS Powered by VMware
• IBM i 7.5
• Debian 11 x64
• Red Hat Enterprise Linux 9 by using the disconnected scanner
• Ubuntu 22.04 on x86 by using the disconnected scanner
• Azure VMware Solution with use of VM Manager Tool
The following systems are withdrawn:
• VM Managers: Oracle VM Manager
• IBM i 7.1
• RHEL 5 on Power

For more information about supported systems, refer to Platform detailed
system requirements.
Extended upgrade time for environments with Mac OS
Due to rework of Mac OS package discovery, during the application upgrade
whole catalog and discoveries coming from Mac OS machines will be
removed. This removed data will be replaced by data from new software scan
during Data Import.
Due to removal process, application upgrade may take longer than usual when
there is Mac software and machines in the environment. Time, in minutes,
required for application upgrade can be estimated using following query:
select count(*) / 20 from sam.software_components c
join sam.publishers p on c.publisher_id = p.id
where p.name = 'Unclassified Mac Software'

Changes to software discovery on Mac OS devices
This release includes improved automated catalog-less software discovery
on Mac OS devices. Now Vendor information is populated for both Package
Data and software inventory reports, such as Software Classification. Catalog
definitions for MAC software include normalized Vendor information for
key Vendors and one Product definition compared to previous structure.
Inventory reports cover detailed discovery of software classified as
applications. Complete Package Data with category classification is available
with the option to promote selected components to inventory as needed.
With improved discovery, a bigger number of MAC software offers usage
information.
IBM Policy update for subcapacity reporting requirements for VPC license metric
Effective May 10, 2022, IBM requires all Virtual Processor Core (VPC) software
licenses that use subcapacity licensing to deploy IBM License Metric Tool or
any other tool approved by IBM like HCL BigFix Inventory. Manual capacity

counting is no longer permitted. Container Licensing terms are not included in
this policy change.
Details of the change are available and documented on the main IBM
subcapacity licensing page.
Changes to End of Support definitions in catalog
The end of support information in catalog is automatically populated for
Adobe, Oracle, Red Hat and VMware software. No change to End of support
information for IBM and Microsoft software. Upgrade BigFix Inventory server
to version 10.0.10.0 to see the changes.
Definition of End of Support dates for Software Components is part of
Software Catalog distributed with BigFix Inventory Server component. Only
upgrading the BigFix Inventory Server updates them.
Listing of state of End of Support dates for Software Components included in
BigFix Inventory Server update:

Publisher Name

Additional
Comment

Last Update

IBM

10.0.9

IBM i 7.1

10.0.9

RHEL 5 on Power

10.0.9

Updated in this
Release

• VM Man
agers: Oracle
VM Manager
• IBM i 7.1
• RHEL 5 on
Power
Deleted old software signatures to optimize standard catalog processing

This release includes improvement for catalog processing which is done by
removing old software signatures from BigFix Inventory main catalog which
results in better performance overall (Mentioned in BigFix Inventory Release
Notes for version 10.0.9.1). Deleted signatures refer to software and versions
with very low probability of being active or deployed.
Deleted signatures are still available as custom catalog content for customers
who request specific titles and versions through the standard support channel.
For list of deleted signatures see:
https://software.bigfix.com/download/tema/catalog/
BFI_signatures_deleted_10_0_10_0.pdf
Included Software Catalog
This release includes Software Catalog version 10.0.10.0 with capability to
discover 330+ new software versions including but not limited to the following
software manufacturers: Adobe, Autodesk, Cisco, Citrix, McAfee, Microsoft,
Samsung, VMware
New template signatures included in this release:
Template signature is a method of discovery where the version of a component
is detected automatically, and specific version added to the catalog on fly. Such
template signatures include all component versions. They are used when the
software is frequently updated and deployment method is not changed.
Publisher Name

Component Name

Platform

Red Hat

Red Hat Enterprise Linux

Linux

Apache Software Founda

Apache HTTP Server

Windows

CrowdStrike Falcon Sen

Linux

tion
CrowdStrike Inc.

sor
Siemens

Siemens PLM License

Windows &

Server

UNIX

For more information, refer to Catalog release notes and Catalog change list.
Modified content
The version number of the fixlet is: 10.0.10.0
The following fixlets were updated and should be run to install the latest
versions of the specific components:
• Upgrade to the latest version of BigFix Inventory
• Upgrade to the interim version 10.0.2 of BigFix Inventory if version older
than 10.0.2
• Software Catalog Update (if BFI not upgraded)
• Install or Upgrade Scanner
• Install or Upgrade Scanner in private mode on Windows
• Install SAP Metric Data Collector
• Update SAP Metric Data Collector
• Install VM Manager Tool
• Update VM Manager Tool
• Install Additional VM Manager Tool (OPTIONAL)
• Download the Disconnected Scanner Package for IBM I
• Download the Disconnected Scanner Package
• Download BigFix Inventory
• Download the BigFix Inventory Container Solution Packages
The following fixlets were updated and require that actions created by their
previous versions are stopped and then started by using the updated fixlets.
Restarting actions is necessary to ensure that new features work properly:
• Initiate Software Scan
• Upload Software Scan Results – no updates, but recommended to be
refreshed to match Initiate
• Run Capacity Scan and Upload Results

The following fixlets were updated or added:
• Clear Data Collected by Software Data Harvesting Tool
• Get Oracle Features
• Get Oracle Concurrent Sessions Number
• Identify Computers on Public Clouds
Enhancements and important changes
The following table lists enhancements and changes that are introduced in
this update.
Abstract
Mac OS discovery im

Added vendor informa 10.0.10.0

provements

tion, introduced pack
age categories to fil
ter-out non-applica
tions from Inventory,
improved usage detec
tion.
For list of all improve
ments see the doc
umentation section:
MAC OS discovery.

Normalized vendors

Vendors from detect

for Mac OS discovery

ed software are in line

10.0.10.0

with publishers from
software catalog.
End of support in

Added end of support

formation added for

dates to 64 Adobe

Adobe

products.

10.0.10.0

Abstract
End of Support infor

Added end of support

mation added for Ora

dates to 118 Oracle

cle

products.

End of Support infor

Added end of support

mation added for Red

dates to 15 Red Hat

Hat

products.

End of Support in

Added end of support

formation added for

dates to 41 VMware

VMware

products.

Catalog clean-up –

Deleted 14850 obso

deletion of obsolete

lete signatures from

signatures

more than 11400 re

10.0.10.0

10.0.10.0

10.0.10.0

10.0.10.0

leases to improve the
performance of Soft
ware Scan
For details refer
to:https://soft
ware.bigfix
.com/download/tema/
catalog/BFI_signa
tures_deleted_10_0_
10_0.pdf
Removal of unused

Added a possibility to

tags created for soft

automatically remove

ware components or

tags not assigned to

instances

any software compo
nent or instance (dur
ing data import). To
turn this feature on,

10.0.10.0

Abstract
switch on ‘delete_un
used_tags_automati
cally’ advanced serv
er setting (it is dis
abled by default). If
this clean-up action is
needed only once, then
disable this option af
ter the import.
Computer First Seen

Added the ‘Computer

column

First Seen' column to

10.0.10.0

license
metric utilization CSV
reports which are part
of the Audit Snapshot.
The column shows the
time when the com
puter was first detect
ed by BigFix Inventory
server.
Optimized data trans

The amount of soft

10.0.10.0

ferred for software us ware usage data
age monitoring

stored in BigFix data
base is optimized re
sulting in less data to
transfer and store.

New fixlet to clear col

Added a ‘Clear Data

lected harvester data

Collected by Software
Data Harvesting Tool’
fixlet which removes

10.0.10.0

Abstract
the data collected by
Software Data Har
vesting Tool from end
points and BigFix serv
er.
Updated component

Updated component

version for Oracle

version for Oracle

Database Client 19

Database Client from

10.0.10.0

19 to 19.3.
Enhancement of Ora

Enhanced discovery

cle Java Signatures

of existing Java signa

10.0.10.0

ture for version 8.0 to
account for non-stan
dard installations.
IBM Virtualization Ca

BigFix Inventory

pacity reporting equiv

10.0.10.0 is equivalent

alent

to IBM License Metric
Tool (ILMT) 9.2.28 for
IBM Virtualization Ca
pacity reporting.
The update covers
IBM sub-capacity cal
culation, IBM Catalog,
PVU and Scanner pari
ty.
For status of IBM vali
dated releases see fol
lowing BFI FAQ Docu
ment.

10.0.10.0

Abstract
Updated PVU table

Updated Processor

10.0.10.0

Value Unit table to ver
sion 06/07/2022.
Updated ‘Apple Com

Adjusted publisher

puter Corporation’

name.

10.0.10.0

publisher name to ‘Ap
ple’
Added discovery for

Added a new CIT sig

10.0.10.0

Red Hat Enterprise Lin nature for Red Hat En
ux

terprise Linux 9.

Added discovery for

Added a new CIT sig

Team Quest Analyzer

nature for Team Quest

10.0.10.0

Analyzer version 11 on
UNIX.
Added discovery for

Added template signa 10.0.10.0

CrowdStrike Falcon

ture for CrowdStrike

Sensor on Linux plat

Falcon Sensor on Lin

form

ux platform. Now,
Template signature ex
ists for both Windows
and Linux platform.
Existing regular signa
tures were deleted for
Windows platform.

Discovery improve

Added discovery by

ments for Adobe Cap

File Name and Pack

tivate

age Name.

10.0.10.0

Abstract
Changed definition
source to HCL.
Updated the compo
nent version for Adobe
Captivate from 2015
to 2015.0 and 2017 to
2017.0.
Removed discovery of

Removed the discov

10.0.10.0

Adobe Download Man ery of Adobe Down
ager

load Manager.

Removed discovery

Removed discovery

of Adobe Acrobat Dis

of Adobe Acrobat Dis

tiller

tiller since it cannot be

10.0.10.0

licensed, downloaded,
and/or installed as a
separate product.
Defect fixes
For the list of known defects please refer to HCL Knowledge Base.
The following table lists BigFix Inventory Server APARs and other defects that
are fixed in this update.
Behavior after
ID

Symptoms

you install the

Available since

updatee
KB0098499

Poor data im

Data Import per 10.0.10.0

port perfor

formance is cor

mance after en

rect.

abling Group
Aggregation

Behavior after
ID

Symptoms

you install the

Available since

updatee
in Computer
Groups Manage
ment.
KB0098905

Clusters API re

Clusters API re

turns outdated

turns only cur

10.0.10.0

data, also show rent data.
ing duplicat
ed entries from
old and new da
ta source (VM
Manager Tool).
KB0099323

Wrong database Correct data
is reported in

10.0.10.0

base is report

the log message ed in error mes
when connec

sage.

tion error oc
curs (always BFI
database).
KB0099152

Mismatch of

Dashboard

count in dash

fields show cor

board fields

rect numbers of

and number of

endpoints.

10.0.10.0

endpoints in re
ports.
BI-13117

Software from

Software from

macOS 11.5.1

macOS is report

or later does not ed properly.

10.0.10.0

Behavior after
ID

Symptoms

you install the

Available since

updatee
appear on Soft
ware Classifica
tion panel. It is
present only on
Package Data
panel.
BI-12646

No informa

Added addi

tion about used

tional log en

threads during

tries to Data Im

import for the

port log with

Capacity / VM

the actual num

Manager Data.

ber of threads

10.0.10.0

used during Da
ta Import of the
Capacity / VM
Manager Data
Import.
BI-13397

Input error mes

Input field error

sages in the Ed

messages are

it Contract dia

located below

log are located

the input fields.

10.0.10.0

on the right side
of the inputs.
BI-11848

Contract custom Decimal sepa
fields for deci

rator is aligned

mal number in

with a chosen

put will now be

language.

restricted either

10.0.10.0

Behavior after
ID

Symptoms

you install the

Available since

updatee
to comma or pe
riod as a deci
mal separator
depending on
the user’s lan
guage settings.
BI-11803

Details of delet

Link to details

ed signatures

panel is not

in Catalog Au

shown in case

dit not available

no details are

after a certain

available.

10.0.10.0

amount of time.
BI-12133

Grid row count

The count value

value is incor

is correct.

10.0.10.0

rect in the Ad
vanced Server
Settings pan
el after filtering
and sorting by
the Name col
umn.
BI-11837

Custom fields in Validation is
the Edit Contract added.
dialog are miss
ing length and
range validation.

10.0.10.0

The following table lists BigFix Inventory Scanner APARs and other defects
that are fixed in this update.
Behavior after
ID

Symptoms

you install the

Available since

update
The same ex

All exclude and

clude directo

include directo

ry ending with

ries are convert

a slash sign in

ed to a 'canon

cluded in both

ical' form. So

catalog (wscan

all the follow

sw) and file sys

ing 3 example

tem (wscanfs)

paths effective

scan configu

ly meaning the

rations cause

same:

physical scan of
the file system

• /abc

and cache recre

• /abc/*

ation when ws

• /abc/

canfs is run right
after wscansw.

/abc are con
verted to one
form:
After the
changes md5
hash of the scan
configuration is
the same and
as a result the
physical scan
of the file sys

10.0.10.0

Behavior after
ID

Symptoms

you install the

Available since

update
tem is not per
formed by ws
canfs. Instead
the data is read
from the cache,
which was creat
ed by wscansw
before.
The following table lists BigFix Inventory tools APARs and other defects that
are fixed in this update. It covers VM Manager, SAP Data Collector, Image
Scanner, Scanner Service, Cloud Adapter.
Behavior after
ID

Symptoms

you install the

Available since

update
KB0099902

Status ‘Invalid

VM Manager

Credentials’ re

Tool can authen

turning for VM

ticate with MD4

Manager Hy

algorithm to Hy

per-V configu

per-V hosts via

rations using

WinRM.

10.0.10.0

WinRM and au
thenticating with
MD4 algorithm.
The following table lists BigFix Inventory CatalogAPARs and other defects that
are fixed in this update.

Behavior after
ID

Symptoms

you install the

Available since

update
KB0100119

Autodesk Com

Autodesk Com

posite discov

posite signa

ered incorrectly.

tures are updat

10.0.10.0

ed to report the
correct version
and also avoid
false discovery.
KB0099763

Apache HTTP

Deleted existing

Server lost dis

signatures for

covery for 2.4

Windows plat

version.

form and added

10.0.10.0

template signa
ture for Apache
HTTP Server for
Windows plat
form. Now, tem
plate sign exists
for both Win
dows and Linux
platform.
KB0099831

Siemens PLM

Deleted exist

License Server

ing signature for

8.2 Version is in Siemens PLM
correctly discov License Server
ered.

and replaced it
with template
signature for
Windows and

10.0.10.0

Behavior after
ID

Symptoms

you install the

Available since

update
UNIX Platforms
for accurate dis
covery.
The following table lists BigFix Inventory FixletsAPARs and other defects that
are fixed in this update.
Behavior after
ID

Symptoms

you install the

Available since

update
The following table lists user documentation APARs and other defects that are
fixed in this update.
Behavior after
ID

Symptoms

you install the

Available since

update
KB0073035

Db2 temp ta

Documentation

blespace can

will contain ad

grow in an un

ditional section

controlled way

under “Tuning

on DB2 when

DB2 application

statement heap

database” de

is exhausted.

scribing how to
change state
ment heap set
ting in case of
issues with disk

10.0.10.0

Behavior after
ID

Symptoms

you install the

Available since

update
space used by
queries.
BI-13572

Internet Explor

References to

10.0.10.0

er is no longer

Internet Brows

supported as a

er has been re

browser by Big

moved from the

Fix server.

document.

VM Manager Tool version and changes
The VM Manager Tool version that is used with this update is 10.0.10.0.
Scanner version and changes
The scanner version that is used with this update is 9.2.28.1000 for Windows
and 9.2.28.0000 for other platforms. The disconnected scanner version that is
used with this update is 10.0.10.0 and 9.2.28.0 for IBM I.

Application update 10.0.9.1
Table 5. Published site version
Name of component
BigFix Inventory Content

Version

Updated in the release

154

Yes

10.0.9.1

Yes

2638735

Yes

Site
BigFix Inventory Software
Catalog (main version)
BigFix Inventory Software
Catalog (version on end
point)

Table 5. Published site version (continued)
Name of component

Version

Updated in the release

BigFix Inventory Server

10.0.9.0

No

Software Data Harvesting

1.1

No

9.2.27.0

No

9.2.27.0

No

9.2.27.1000 on Windows

No

9.2.27.0000 on other plat

No

Tool for BigFix Inventory
BigFix Inventory Server:
ILMT Core library
BigFix Inventory Server:
ILMT Catalog
BigFix Inventory Scanner

forms
BigFix Inventory Discon

10.0.9.0

No

nected Scanner including

9.2.27.0 on IBM I

No

10.0.9.0

No

SAP Metric Data Collector

10.0.9.0

No

BigFix Inventory Image

10.0.9.0

No

10.0.9.0

No

10.0.9.0

No

package for Containers
BigFix Inventory VM Man
ager Tool

Scanner Script
BigFix Inventory Scanner
Service
BigFix Inventory Cloud
Adapter
Included Software Catalog

This release includes Software Catalog version 10.0.9.1 and is capable to
discover more than 880 new software versions including but not limited to
software manufacturers, such as Adobe, Amazon.com, Citrix, Dell Computers,
General Electric, Hewlett-Packard, Intel, Kodak, Microsoft, Logitech Inc, Nvidia,
Red Hat, and Schneider Electric.
New template signatures included in this release:
Template signature is a method of discovery where the version of a
component is detected automatically, and a specific version is randomly
added to the catalog. Template signatures include all component
versions. They are used when the software is frequently updated and
deployment method is not changed. One template covers more than 10
software versions.
Publisher Name

Component Name

Platform

SentinelOne

SentinelOne Agent

WINDOWS, UNIX

Note: Changes made to the software component definition in catalog,
for example modification of component name, version, or publisher
may cause creation of new definition of the component and removal
of previous one. This leads to loss of Tagging, Classification and
custom end-of-support information.
In addition to the above, when discovery is based on a signature
evaluated on an endpoint, previous discovery results temporarily
disappear until the next software scan and related data import. A
new catalog must be propagated to the endpoints before the scan
execution.
Updated discovery mechanism for specific software with this behavior
includes specific notes (for details refer to the list of enhancements
and list of defects).

Planned improvement for catalog processing

Efficiency improvement is planned for the next release of BigFix Inventory
version 10.0.10. Old software signatures are planned to be removed from
BigFix Inventory main catalog which will result in better overall performance.
Deleted signatures refer to software and versions with very low probability of
being active or deployed. Deleted signatures will be still available as custom
catalog content for customers who request specific titles and versions
through the standard support channel. For list of signatures to be deleted,
check the link.
For more information, refer to the Catalog release notes and Catalog change
list.
Modified content
Fixlet version number: 10.0.9.1
Fixlet names: The Update Software Catalog fixlet was updated and should
be run to install the latest version of the catalog. The Run Software Data
Harvesting Tool fixlet was updated.
Enhancements and important changes
The following table lists enhancements and changes that are
introduced in this update.
Abstract

Description

Available since

Software Data

The MSI Install loca

10.0.9.1

Harvesting Fixlet:

tion property of pack

Changed content of

age information was

uninstall packages.

enhanced to prefer
regular paths over sys
tem paths.

Change of the defini

Definition source infor 10.0.9.1

tion source for catalog mation was changed
definitions which use

on product, version, re

Abstract

Description

executable and pack

lease, component and

age information.

signature view to HCL

Available since

or IBM Internal Devel
opment for those en
tries in Catalog which
uses executable and
package information.
This change is for im
proved serviceability
and does not impact
the discovery results.
SentinelOne Endpoint

Created a new tem

Protection Agent dis

plate signature for

covery

SentinelOne Endpoint

10.0.9.1

Protection Agent for
Unix & Windows plat
form.
Adoptium discovery

Added discovery for:
• Eclipse Temurin
JDK - Ver
sions:8.0, 11.0,
16.0, 17.0, and
18.0
• Eclipse Temurin
JRE - Versions:
8.0, 11.0, 17.0
and 18.0
• Windows and
Unix platform.

10.0.9.1

Abstract

Description

Available since

Red Hat Fuse discov

Added discovery for:

10.0.9.1

ery
• Red Hat Fuse
to include ver
sions 7.0, 7.1,
7.2, 7.3, 7.4, 7.5,
7.6, 7.7, 7.8, 7.9,
and 7.10.
• Windows and
Unix platform
Oracle Instant Client

Improved discovery for 10.0.9.1

discovery

Oracle Instant Client.
Discovery for missing
version was added for
Windows and UNIX
versions, 19.14, 19.3,
19.6, 19.8.
Added new package
signatures for Linux
versions 10.1, 10.2,
11.1, 11.2, 12.1, 12.2,
18.3, 18.4, 18.5,19.1,
19.12, 19.13, 19.14,
19.3, 19.5, 19.6, 19.8,
19.9, and 21.
Note:
• Discov
ery will
disap

Abstract

Description

Available since
pear un
til the
next
scan and
data im
port for
version
21. Cata
log prop
agation
to end
points is
required.

• Old dis
covery
records
will be
closed,
and new
ones
will be
opened
for ver
sion 21.

BFI Cloud Adapter:

In order to manage se 10.0.9.1

minimal Kubernetes

curity of BigFix Inven

permissions docu

tory Cloud Adapter de

mented

ployment refer to “Big
Fix Inventory 10. Soft

Abstract

Description

Available since

ware Discovery in Con
tainers” for minimal
permissions required.
Defect fixes
For the list of known defects please refer to HCL Knowledge Base.
The following table lists BigFix Inventory Catalog APARs and other defects
that are fixed in this update.
Behavior after
ID

Symptoms

you install the

Available since

update
KB0098806

Citrix XenDesk

Template signa

top, XenApp,

tures for Citrix

and StoreFront

XenDesktop, Xe

signatures

nApp and Store

cause false dis

Front are im

covery.

proved to not
detect other
modules. Reg
ular signatures
are removed
and replaced by
template cov
erage which al
so reports de
tailed version.
XenDesktop
Controller sig
natures are re

10.0.9.1

Behavior after
ID

Symptoms

you install the

Available since

update
moved as they
were often pro
viding false dis
covery, and Xen
Desktop signa
ture is providing
proper detection
for this compo
nent.
Note:
Old dis
covery
records
will be
closed,
and new
ones
will be
opened.
BI-11162

TIBCO Business The component
works version

name of TIBCO

6.3 was lead

Businessworks

ing to duplicated for version 6.3
software titles.

was corrected.
Note:

10.0.9.1

Behavior after
ID

Symptoms

you install the

Available since

update
• Dis
cov
ery
dis
ap
pears
un
til
the
next
scan
and
da
ta
im
port.
Cat
a
log
prop
a
ga
tion
to
end
points
is
re
quired.

Behavior after
ID

Symptoms

you install the

Available since

update
• Old
dis
cov
ery
records
will
be
closed,
and
new
ones
is
opened.

KB0099659

Microsoft Edge

Improved tem

template sig

plate signa

nature previ

tures show cor

ously based on

rect version. Al

Microsoft-

so, the compo

Edge.exe was

nent name is

reporting incor

updated to “Mi

rect version.

crosoft Edge”
from “Edge”.
Note:
Old dis
covery
records

10.0.9.1

Behavior after
ID

Symptoms

you install the

Available since

update
will be
closed,
and new
ones
will be
opened.
KB0099546

Oracle products, Discovery of the 10.0.9.1
such as Oracle

following Oracle

Adapter, Oracle

products were

Mediator were

corrected/added

incorrectly dis

to detect proper

covered.

version:
• Oracle
Adapter
• Oracle
BPEL
Process
Manager
• Oracle
Business
Process
Manage
ment Suite
• Oracle
Business
Rules

Behavior after
ID

Symptoms

you install the
update
• Oracle Hu
man Work
flow
• Oracle Me
diator
• Oracle
SOA Suite
Note:
Discov
ery for
Oracle
SOA
Suite
11.1 dis
appears
until
the next
scan
and data
import.
Catalog
propa
gation
to end
points is
required.

Available since

Behavior after
ID

Symptoms

you install the

Available since

update
KB0099462

UltraEdit signa

Duplicate signa

10.0.9.1

tures duplicated tures for Ultra
discovery

Edit were delet
ed for versions:
8.0,10.0,13.2,14.0,14.10,14.20,
and15.0.

Application update 10.0.9
Table 6. Published site version
Name of component
BigFix Inventory Content

Version

Updated in the release

153

Yes

10.0.9.0

Yes

2638729

Yes

BigFix Inventory Server

10.0.9.0

Yes

BigFix Inventory Server:

9.2.27.0

Yes

9.2.27.0

Yes

9.2.27.1000 on Windows

Yes

9.2.27.0000 on other plat

Yes

Site
BigFix Inventory Software
Catalog (main version)
BigFix Inventory Software
Catalog (version on end
point)

ILMT Core library
BigFix Inventory Server:
ILMT Catalog
BigFix Inventory Scanner

forms

Table 6. Published site version (continued)
Name of component
BigFix Inventory Discon

Version
10.0.9.0

Updated in the release
Yes

nected Scanner (incl. pack 9.2.27.0 on IBM I
age for Containers)

Yes

BigFix Inventory VM Man

10.0.9.0

Yes

SAP Metric Data Collector

10.0.9.0

Yes

BigFix Inventory Image

10.0.9.0

Yes

10.0.9.0

Yes

10.0.9.0

Yes

1.1

Yes

1.0

New

ager Tool

Scanner Script
BigFix Inventory Scanner
Service
BigFix Inventory Cloud
Adapter
Software Data Harvesting
Tool for BigFix Inventory
BigFix Inventory Keystore
Migration Tool
Allowed upgrade path
Minimal version recommended for direct upgrade path is 9.2.16.
For versions older than 9.2.16, first upgrade to version 10.0.2 using an already
available fixlet.
BigFix Inventory Scanner Service 10.0.8.0 (previous version) is not compatible
with BigFix Inventory Server 10.0.9 due to a change of success response code
from 200 to 204. BigFix Inventory Server 10.0.9.0 supports BigFix Inventory
Scanner Service version 10.0.9.0 only.

After upgrading BigFix Inventory server with FIPS function enabled
ensure that java.security files contain RSAPSS, RSASSA-PSS listed in
jdk.tls.disabledAlgorithms. For more information, see Configuring the

server to achieve FIPS compliance.
DB2 10.5 End of Support by BigFix Inventory starting from future release
BigFix Inventory v10.0.9.0 is the last release with support for DB2 10.5. Future
releases of BigFix Inventory will no longer support DB2 10.5.
IBM withdrew support for DB2 10.5 in April 2020. For more information, see:
Software lifecycle.
Microsoft Internet Explorer 11 support will be removed starting from future release
BigFix Inventory version 10.0.9.0 is the last release with support for Microsoft
Internet Explorer 11. Future releases of BigFix Inventory will no longer support
Microsoft Internet Explorer 11.
Microsoft withdrew support for Internet Explorer on certain versions
of Windows 10 on June 15, 2022. For more information, see, Microsoft
Announcement.
Changes to Software Discovery in Containers
This feature is licensed under Active Container SKU/unit of measure.
Image Scanning solution now supports use of Podman in addition to Docker
(r) as the runtime for executing scans. Image scanner was verified against
Podman versions: 1.9.x, 3.2.x.
Note: Podman version 2.0.x is not supported due to a known issue,
https://github.com/containers/podman/issues/7515.
BigFix Inventory Server 10.0.9.0 supports BigFix Inventory Scanner Service v
10.0.9.0 only due status code change for successful data upload.
Changes to UI Components in New Contracts

UI components were updated to the latest version to resolve a few usability
issues and limitations. With this change there is one new limitation: it's not
possible to type "-" in Number text fields of Edit/New Contract dialog in Firefox
web browser. Users can use mouse wheel or arrow keys to get negative
numbers.
Included software catalog
This release includes Software Catalog version 10.0.9.0 with capability to
discover 470+new software versions including but not limited to the following
software manufacturers: Adobe, AutoDesk, Cisco Systems, HCL, HewlettPackard, Microfocus, Microsoft, Oracle.
New template signatures included in this release cover 50+ new software
versions:
Template signature is a method of discovery where the version of a
component is detected automatically, and specific version added to the
catalog on fly. Such template signatures include all component versions.
They are used when the software is frequently updated and deployment
method is not changed. One template covers 10+ software versions.
Publisher Name
Tripwire, Inc.

Component
Name
Tripwire Axon

Platform

Release

WINDOWS, UNIX 10.0.9.0

Agent
Tripwire, Inc

Tripwire Enter

WINDOWS

10.0.9.0

prise Console
Microfocus

eDirectory

Microfocus

Access Manager UNIX

OpenSSL Project OpenSSL

WINDOWS, UNIX 10.0.9.0

UNIX

10.0.9.0
10.0.9.0

Note: Changes made to the software component definition in catalog
(for example, modification of component name, version, or publisher)

may cause creation of new definition of the component and removal
of previous one. This will lead to loss of Tagging, Bundling and custom
EOS dates.
When changes are made to a signature evaluated on an endpoint,
previous discovery results temporarily disappear until the next
software scan and related data import. (Catalog with changed
signatures has to be propagated to the endpoints).
Updated discovery mechanism for specific software with this behavior
includes specific notes (for details refer to the list of enhancements
and list of defects).
For more information, refer to the Catalog Release Notes and Catalog
Change List.

Modified content
The version number of the fixlet is: 10.0.9.0
The following fixlets were updated and should be run to install the latest
versions of the specific components:
• Upgrade to the latest version of BigFix Inventory
• Software Catalog Update (if BigFix Inventory is not upgraded)
• Install or Upgrade Scanner
• Install or Upgrade Scanner in private mode on Windows
• Install SAP Metric Data Collector
• Update SAP Metric Data Collector
• Install VM Manager Tool
• Update VM Manager Tool
• Install Additional VM Manager Tool (OPTIONAL)
• Download the Disconnected Scanner Package for IBM I
• Download the Disconnected Scanner Package
• Download BigFix Inventory
• Download the BigFix Inventory Container Solution Packages

The following fixlets were updated and require that actions created by their
previous versions are stopped and then started by using the updated fixlets.
Restarting actions is necessary to ensure that new features work properly:
• Initiate Software Scan
• Initiate Software Scan on Shared Disks
• Run Capacity Scans and Upload Results
• Get Oracle Features
• Get Oracle Concurrent Sessions Number
The following fixlets were updated or added:
• Configure Scan Cache
• Uninstall Scanner
• Test CIT Signature
• Clear Corrupted Scanner Installation
• Run Software Data Harvesting Tool
• Clear cache to force rescan Docker containers during next Software
Scan (this task refers to the old functionality, ISO tagged software scan
on Docker containers)
• Force Re-upload of Software Scan Results
• Upgrade to the interim version 10.0.2 of BigFix Inventory if version older
than 9.2.14 (no changes in 10.0.9)
• Update the Log4j library in VM Manager Tool to version 2.17.1 (no
changes in 10.0.9)
Enhancements and important changes
For a list of enhancements introduce in this release, see What's new.
Defect fixes
For the list of known defects please refer to HCL Knowledge Base.
The following table lists BigFix Inventory Server APARs and other defects that
are fixed in this update.

Behavior after
ID

Symptoms

you install the

Available since

update
BI-9838

Import fails af

Issue is fixed.

10.0.9.0

Generated er

Error messages

10.0.9.0

ror message on

displayed on UI

Server Settings

have been cor

panel contains

rected.

ter update from
9.2.16 when de
tected ISO tag
signature has
changed in soft
ware catalog. Er
ror in logs:Java::ComIbmDb2JccAm::SqlException: An
error occurred
in a triggered
SQL statement in trigger "SAM.SOFTWARE_COMPONENTS_TRIGG".

BI-10180

punctuation er
rors.
BI-9857

Catalog cus

An error mes

tomization al

sage is dis

lows to rename

played that the

a product to a

10.0.9.0

Behavior after
ID

Symptoms

you install the

Available since

update
name which is

product name is

already used by

already used.

the same pub
lisher.
KB0097450

There is a red ‘X’ There is a yellow 10.0.9.0
mark next to sig ‘!’ mark showing
nature discovery a potential scan
explanation for

issue with expla

positive past CIT nation on next

KB0097416

detection.

steps.

Warning in Iso

Improved han

tagRule step of

dling of ISO files

Data Import -

with empty pub

‘Could not save

lisher. Clear

ActiveModel’

messages are

10.0.9.0

displayed.
KB0072863

Incorrect inter

Complex tem

10.0.9.0

pretation of tem plate signatures
plate signatures

are correctly

by BigFix Inven

handled.

tory server may
lead to multiple
product discov
ery.
BI-10321

Drill down to

Reporting period 10.0.9.0

the Software

of the Software

Classification

Classification re

Behavior after
ID

Symptoms

you install the

Available since

update
is not adjusted

port is the same

to reporting pe

as in the All Met

riod for Install

rics and Prod

Seats metric in

uct Metrics per

All Metrics and

Group reports.

Product Metrics
per Group re
ports.
BI-9984

Mac OS signa

Usage informa

10.0.9.0

tures always dis tion is corrected.
play “Has Us
age” set to “Yes”
even if signature
couldn’t provide
such informa
tion
BI-10260

The Package

Fixed by listing

10.0.9.0

Summary report only the com
shows comput

puters which the

ers for which a

user has access

user has no per

to.

mission to ac
cess.
KB0098523

Contract report

Every Data Im

ing does not

port refresh of

take into ac

view sam.cur

count different

rent_metric_val

computer group

ues uses proper

10.0.9.0

Behavior after
ID

Symptoms

you install the

Available since

update
aggregation pe

aggregation pe

riods

riod for comput
er group.

BI-10875

Import from Big BigFix
Fix 9.5.4 fails

DataSource

when the BigFix

version is not

was not avail

cached in case

able during pre

of issue with ac

vious import

cessing data

10.0.9.0

source.
KB0098658

When BFI server BigFix Inventory
is being started

Server initializa

when its data

tion waits indef

10.0.9.0

base is not avail initely until data

BI-10655

able, BFI may

base is avail

not be available

able.

SLM tags for

SLM tags for

template com

template com

ponent can

ponent do not

cause failure of

cause import

InsertForNew

failure anymore.

10.0.9.0

SlmTags import
step
KB0095262

Cannot delete

Skipping dele

SSO configura

tion of <saml

tion

WebSso20> tag
no longer caus

10.0.9.0

Behavior after
ID

Symptoms

you install the

Available since

update
es an error when
deleting SAML
SSO configura
tion.
KB0098526

Unable to re

The issue is

move computer

fixed.

10.0.9.0

property even if
not used
BI-10997

1. Enabling de

• Enabling

bug logs for

debug

tema was en

logs for

abling debug

tema does

logs for import

not en

as well

able de

2. Only com

bug logs

mented
-DTEMA_LOG_
DEBUG parame
ter in jvm.op
tions was mak
ing debug logs
for tema dis
abled. Any other
value of the pa
rameter either
if it was 'false'
or anything else
was making

for import
anymore.
• DTEMA_
LOG_DE
BUG para
meter ac
cepts only
2 values ‘true’ and
‘false’. Any
other val
ue will be
rejected.

10.0.9.0

Behavior after
ID

Symptoms

you install the

Available since

update
debug logs for

Comment

tema enabled

ing the pa

3. Description of

rameter
works as a

a setting "Enable
debug level log
ging during data

false.
• Descrip
tion of

imports" in Ad

what "de

vanced Server

fault log

Settings wasn't

ging lev

describing what

el" means

"default logging

in imports

level" is

has been
added un
der the
setting.

KB0098382

Old scan file da

The issue is

ta not removed

fixed.

10.0.9.0

leading falsepositive discov
eries
KB0098905

Clusters API /

Data from delet 10.0.9.0

api/sam/clus

ed VM Man

ters returns both agers is not
deleted and in

shown. Added

active VM Man

ability to filter by

agers with no in and display VM
formation which Manager status.

Behavior after
ID

Symptoms

you install the

Available since

update
are active, creat
ing confusion.
KB0098416

Data import fail

Added a new

ing with mes

hidden/opt-in

sage "The up

feature for reg

date count value ular pruning of
is out of range."

historical da
ta. In advanced
server settings,
the maximum_
data_lifetime pa
rameter is set by
default to 0 (dis
abled).
With enabled
feature his
torical entries
closed before
defined num
ber of days are
removed com
pletely from the
BigFix Inventory.
This improves
the overall per
formance of fu
ture data im
ports.

10.0.9.0

Behavior after
ID

Symptoms

you install the

Available since

update
KB0098413

Modification of

The issue is

product’s de

fixed.

10.0.9.0

fault metric as
signment reverts
after import.
BI-8457

React-UI Pa

• Ctrl + A

tronus Defect

selection

Fixes

shortcut
works in
number in
puts in Ed
it Contract
dialog box.
• Date
Selector
allows to
translate
"Select
Month"
and
"Select
Year" la
bels.
• Date
Selector
– Correct
month
shown

10.0.9.0

Behavior after
ID

Symptoms

you install the

Available since

update
after se
lecting
a month
with less
days than
currently
selected
day of a
month.
BI-10871

Custom rules

Import now ap

are not applied

plies custom

in some cases

rules also for

10.0.9.0

discoveries
found in current
import, not on
ly previous suc
cessful import
process.
KB0098863

BFI Server In

Keystore for the

10.0.9.0

staller. Keystore Database cer
file "key_bfi_d

tificate is pre

b.jks" is not con served and con
verted during up verted when
grade

needed during
upgrade.

KB0098383

The upgrade to

All found SSLs

BFI 10.0.8.0 fails are processed
because of addi during the up

10.0.9.0

Behavior after
ID

Symptoms

you install the

Available since

update
tional SSL tags

grade of the BFI

in server.xml:

server.

Exception:Unex
pected number
of the <ssl> tags
in server.xml.
The following table lists BigFix Inventory Scanner APARs and other defects
that are fixed in this update:
Behavior after
ID

Symptoms

you install the

Available since

update
KB0093801

-

Missing UUID for Improved read
Solaris 11 VMs

ing SMBIOS data

on VMWARE

on this setup.

Using CIT 9.2.25 Introduced re
import of HW

gression. Physi

scan fails be

cal Hyper-V box

cause physical

es are correctly

Hyper-V boxes

recognized.

are treated as
VMs., Physical
Hyper-V boxes
are incorrectly
recognized as
VirtualMachine
Guest group is

10.0.9.0

10.0.9.0

Behavior after
ID

Symptoms

you install the

Available since

update
being included
in the HW scan
output.
The following table lists BigFix Inventory tools APARs and other defects that
are fixed in this update. It covers VM Manager, SAP Data Collector, Image
Scanner, Scanner Service, Cloud Adapter.
Behavior after
ID

Symptoms

you install the

Available since

update
BI-11155

VM Manager

When VM Man

Tool produces

ager Tool con

misleading logs

nects to a Hy
per-V instance,
logs on IN
FO level will
be more read
able, explaining
that different
protocols are
checked. Logs
on DEBUG level
will contain de
tails when a pro
tocol does not
work.

10.0.9.0

The following table lists BigFix Inventory Catalog APARs and other defects
that are fixed in this update:
Behavior after
ID

Symptoms

you install the

Available since

update
BI-10414

There were 3 du Duplicate pub
plicate Microfo

lishers were

cus publishers.

deleted and

(Micro Focus
Ltd., Micro Fo
cus (NetMan
age) and Micro
Focus Interna
tional Limited)

10.0.9.0

products as
signed to them
were moved to
correct Microfo
cus publishers.
Note:
Old dis
covery
records
will be
closed,
and new
ones
will be
opened.

KB0098728

The "LMTOOLS

“LMTOOLS Utili

Utility" compo

ty” is embedded

nent was wrong software it is not
ly discovered

detected. The

with Adobe as

discovery was

publisher.

removed.

10.0.9.0

Behavior after
ID

Symptoms

you install the

Available since

update
BI-11643

Oracle Database Version num

10.0.9.0

and Oracle Data bers were cor
base Client 18,

rected.

19 and 21 com
ponents had ver

Note:

sion number

Old dis

with “.0” added

covery

but shouldn’t be

records

cause they re

will be

port release in

closed,

the detailed ver

and new

sion.

records
will be
created.

KB0099114

Microsoft Visio

Enhanced capa

and Project ver

bility to discov

sions 2019 and

er the following

2021 had no us

9 components:

age capability
after change of

• Microsoft

the discovery

Project

mechanism.

Profes
sional
2019
• Microsoft
Project
Profes

10.0.9.0

Behavior after
ID

Symptoms

you install the
update
sional
2021
• Microsoft
Project
Standard
2019
• Microsoft
Project
Standard
2021
• Microsoft
Visio for
Microsoft
365
• Microsoft
Visio Pro
fessional
2019
• Microsoft
Visio Pro
fessional
2021
• Microsoft
Visio Stan
dard 2019
• Microsoft
Visio Stan
dard 2021

Available since

Behavior after
ID

Symptoms

you install the
update
• Microsoft
Visio for
Microsoft
365
Note:
Discov
ery will
disap
pear un
til the
next
scan
and data
import.
Catalog
propa
gation
to end
points is
required.

Note:
Old dis
covery
records
will be
closed,

Available since

Behavior after
ID

Symptoms

you install the

Available since

update
and new
ones
will be
opened.
The following table lists BigFix Inventory Fixlets APARs and other defects that
are fixed in this update:

ID

Symptoms

KB0098299

Get Oracle fea

Behavior after
the update

Available since

Issue is fixed.

10.0.9.0

Run Capacity

The issue is

10.0.9.0

Scan and Up

fixed. The set

load Results

ting capaci

fails with exit

tyNewFile is

code 0

assigned only

tures fixlet fail
ing to read ORA
CLE home and
SID
KB0098415

once.
KB0097418

Filtering of App

Applications

Usage from end with deleted exe
point is insuf

cutable files are

ficient. After

excluded from

deleting an exe

usage collec

cutable file of a

tion.

running applica

10.0.9.0

ID

Symptoms

Behavior after
the update

Available since

tion, the process
name in collect
ed usage data
has unwanted
“(deleted)” suf
fix.
BI-11130

Clear Scanner

Issue is fixed.

10.0.9.0

Initiate Software Issue is fixed.

10.0.9.0

Installation fixlet
was failing when
cit.ini was empty
or unreadable
KB0098714

Scan fails on
Sun OS v5.10
client due to fail
ing relevance
KB0098639

Issue with dock Created a new
er scan cache

fixlet: ‘Clear

cleaner fixlet:

cache to force

BigFix Inventory
Scanners do not
seem to cleanup after them
selves with re
gards to Dock
er container dis
coveries

rescan of Dock
er containers
during next Soft
ware Scan’.

10.0.9.0

Behavior after

ID

Symptoms

KB0099155

CPU spikes dur

Created

ing capacity

KB0099155

scan

about control

the update

Available since
10.0.9.0

ling CPU usage
by BigFix Client
and BigFix In
ventory scans.
Improved Client
Properties set
ting and en
forcing lower
process priority
on non-Windows
endpoints in Run
Capacity Scan
and Upload Re
sults fixlet.
The following table lists user documentation APARs and other defects that
are fixed in this update:
Behavior after

ID

Symptoms

KB0097891

Mistake in docs

Updated the

regarding key

command with

generation

“-aes256 2048”

the update

in the private
key.

Available since
10.0.9.0

ID

Symptoms

Behavior after
the update

Available since

Doc link: Creat
ing private keys
and certificates
KB0099289

No information

Removed the pa 10.0.9.0

about comput

rameter, com-

er_group_id filter puter_group_limitation in Re

id from the doc

trieval of hard

ument as this

ware inventory

is an internally

(v2)

used column.
Doc link:
• Retrieval
of hard
ware in
ventory
(v2)
• Retrieval
of soft
ware in
ventory
(v2)

KB0098857

Contract docu

Added precise

mentation incor information
rect and confus about CSV file
ing

encoding and
content require
ments in con

10.0.9.0

ID

Symptoms

Behavior after
the update

Available since

tracts import
page.
Doc link: Import
ing contracts us
ing CSV files
BigFix Inventory Server API changes
• Historical API /api/sam/software_instances is now based on new
software installations instead of the deprecated ones. The meaning
of columns deleted, ID, software_fact_id and underlying data model
is changed. It is recommended to use the new API api/sam/v2/
software_instances (no changes in it).

• Disconnected scanner upload API (/api/upload_scan REST API)
reports in case of success HTTP code 204 instead of 200.
• The api/sam/v2/license_usage is extended with information about
ratio that is applied to convert product license metrics to license metrics
of the FlexPoint bundle or Cloud Pak to which the product is assigned.
New columns available are; product_bundle_ratio_divider and
product_bundle_ratio_factor.

• The computer_hardware association is extended with information about
the hardware architecture. New column available: platform
• KB0098905: Clusters API /api/sam/clusters: data from deleted VM
Managers is not shown. Added ability to filter by and display VM
Manager status.
Removed Data Import steps
As part of “Removal of deprecated features and panels” the following Data
Import steps were removed:

• SAM::ContractFact.before_snapshot
• SAM::Contract
• SAM::SoftwareFact
• SAM::SoftwareFactHierarchy
• SAM::SoftwareFactHierarchyPivot
• SAM::ComputerGroupCatalogHierarchy
• SAM::ContractDimension
• SAM::ContractFact
• SAM::ComputerGroupDiscoverableRollup
• SAM::ComputerGroupCatalogHierarchyRollup
• SAM::ComputerGroupUnmatchedFile
After upgrade these steps no longer contributes to data import duration
resulting in shorter Data Import time. Sum of the execution time of the above
steps gives the import time improvement after upgrade.
VM Manager Tool version and changes
The VM Manager Tool version that is used with this update is 10.0.9.0.
Scanner version and changes
The scanner version that is used with this update is 9.2.27.1000 for Windows
and 9.2.27.0000 for other platforms. The disconnected scanner version that is
used with this update is 10.0.9.0 and 9.2.27.0 for IBM I.

Application update 10.0.8.1
Table 7. Published site version
Name of component
BigFix Inventory Content

Version

Updated in the release

152

Yes

10.0.8.1

Yes

Site
BigFix Inventory Software
Catalog (main version)

Table 7. Published site version (continued)
Name of component
BigFix Inventory Software

Version

Updated in the release

2638712

Yes

BigFix Inventory Server

10.0.8.0

No

BigFix Inventory Server:

9.2.26.0

No

9.2.26.0

No

9.2.25.1000 on Windows

No

Catalog (version on end
point)

ILMT Core library
BigFix Inventory Server:
ILMT Catalog
BigFix Inventory Scanner

9.2.25.0000 on other plat
forms
BigFix Inventory Discon

10.0.8.0

nected Scanner

9.2.26.0 on IBM I

BigFix Inventory VM Man

10.0.8.0

No

SAP Metric Data Collector

10.0.8.0

No

BigFix Inventory Image

10.0.8.0

No

10.0.8.0

No

10.0.8.0

No

No

ager Tool

Scanner Script
BigFix Inventory Scanner
Service
BigFix Inventory Cloud
Adapter
Included Software Catalog

This release includes Software Catalog version 10.0.8.1 with capability to
discover more than 100 new software versions, such as Adobe, Canonical, Dell
Computer Corporation, Microsoft, Red Hat, SAP, SAS, Tripwire Inc., Veritas, and
VMware.
Table 8. New template signatures included in this release:
Template signature is a method of discovery where the version of a
component is detected automatically and specific version is randomly
added to the catalog. The template signatures cover all component
versions. They are used when the software is frequently updated and
deployment method is unchanged.
Publisher Name

Component Name

Dell Computer

Quest Web Parts for

Corporation

SharePoint

Platform
Windows

HelpSystems LLC TeamQuest Manager

Windows

ImageMagick Stu ImageMagick

Windows

dio
Microsoft

Microsoft Visual Studio

Windows

Test Professional
Oracle

Oracle Insurance Compli

Windows

ance Tracker
Red Hat

Red Hat Satellite Capsule

Linux

Server
Red Hat

Red Hat Satellite Server

Linux

SAP

SAP Crystal Reports for

Windows

Enterprise
SAS

SAS IML Studio

Windows

Table 8. New template signatures included in this release:
Template signature is a method of discovery where the version of a
component is detected automatically and specific version is randomly
added to the catalog. The template signatures cover all component
versions. They are used when the software is frequently updated and
deployment method is unchanged.
(continued)
Publisher Name
SAS

Component Name
SAS Personal Login Man

Platform
Windows

ager
Tripwire, Inc.

Tripwire Enterprise Agent

Windows, Linux

VMware

Salt Master

Unix

VMware

Salt Minion

Unix

VMware

Salt SSH

Unix

VMware

VMware Tools

Windows, Linux

For more information, refer to Catalog release notes and Catalog change list.
Modified content
The version number of the fixlet is: 10.0.8.1.
The following fixlets were updated and should be run to install the latest
versions of the specific components:
• Update Software Catalog
The following fixlets were updated:
• Run Software Data Harvesting Tool
• Update VM Manager Tool
Enhancements and important changes

The following enhancements and changes are introduced in this update:

Abstract

Description

Clean-up of SAP Crys

Discovery is improved by replac

tal Reports for Enter

ing existing signatures for new tem

prise.

plate signature for SAP Crystal Re

Available
since
10.0.8.1

ports for Enterprise.
New discovery for Ver Added discovery for versions 9.0
itas NetBackup Client,

and 9.1.

Master Server, Media

The name of component Veritas

Server.

10.0.8.1

NetBackup Server has been updat
ed to Veritas NetBackup Master
Server for versions above 5.0.

New Discovery for Mi

Discovery based on file and pack

crosoft Visual Studio

age for 5 different editions:

10.0.8.1

2022.
• Microsoft Visual Studio 2022
Community Edition
• Microsoft Visual Studio 2022
Professional Edition
• Microsoft Visual Studio 2022
Enterprise Edition
• Microsoft Visual Studio 2022
Professional LTSC Edition
• Microsoft Visual Studio 2022
Enterprise LTSC Edition
Signature for

Deleted existing signature and cre

TeamQuest Manager.

ated a new template signature to
identify all versions.

10.0.8.1

Abstract

Description

Modify signatures for

Discovery is improved by replacing

Quest Web Parts for

existing signatures to new template

SharePoint.

signature for SAP Crystal Reports

Available
since
10.0.8.1

for Enterprise.
Modify signatures for

Removed detection for version 12.4 10.0.8.1

Remotely Anywhere

and by template signature. Added

and Remotely Any

new signature that reports the ver

where for IBM.

sion 12 and all its releases under
'Detailed Version'.

Modify signatures for

All existing discoveries of TRIP

Tripwire Enterprise

WIRE ENETRPRISE AGENT have

Agent.

been replaced with template signa

10.0.8.1

tures, one each for Windows and
Unix platforms.
Publisher name changed from
“Tripwire Inc.” to “Tripwire, Inc.”
Definition source

Definition source was corrected on

changed to HCL for

product, version, release, compo

Microsoft Office, SQL

nent and signature view to HCL or

Server, MS Operating

IBM Internal Development for the

systems.

following Microsoft products:
• Windows
• Windows Server
• Storage Server
• SQL Server
• Office

10.0.8.1

Abstract
Improved discovery

Description
Improved discovery for Pro and

Available
since
10.0.8.1

for Adobe Acrobat Pro Standard to distinguish 2 cate
and Standard. New

gories:

discovery for Adobe
Acrobat Reader.

• Classic (versions: 2015, 2017,
2020)
• Continuous (versions: 2015,
2017, 2018, 2019, 2020, 2021,
and 2022)
Added discovery for Reader for
both categories.

Improved discovery for Improved discovery for MongoDB
MongoDB Community

Community Server and MongoDB

Server and MongoDB

Enterprise Server.

10.0.8.1

Enterprise Server.
Software Data Har

Software Data Harvesting Tool us

10.0.8.1

vesting Tool: Improved es MSI data from package informa
collection of installa

tion to determine installation path

tion location
Software Data Har

The range of shortcuts collection

10.0.8.1

vesting Tool: Improved was increased in Software Data
collection of shortcuts Harvesting Tool.
Software Data Har

Collection of uninstall packages be 10.0.8.1

vesting Tool: Improved longing to 64 bits applications was
collection of 64 bits
application

improved.

Abstract

Description

Software Data Har

The storing of the username map

vesting Tool: Does not

ping file is configurable now. De

store username map

fault behavior being not creating

ping file on the end

the file.

Available
since
10.0.8.1

point.
Defect fixes
For the list of known defects please refer to HCL Knowledge Base.
The following table lists BigFix Inventory Catalog APARs and other defects
that are fixed in this update.

ID

BI-8989

Symptoms

Behavior after you
install the update

Ubuntu Server dis

Issue is fixed. Im

covery does not

proved discovery by

work properly.

adding detailed ver

Avail
able
since
10.0.8.1

sion of the software.
KB0097361

KB0097668

Lost discovery

Issue is fixed. Discov

for Oracle SOA in

ery supports bigger

some cases.

file sizes.

Discovery for

Discovery is improved. 10.0.8.1

ImageMagick was

Added template signa

based on exe

ture for this product.

cutable. Vendor
stopped updat
ing the version of
the file which was

10.0.8.1

ID

Symptoms

Behavior after you
install the update

Avail
able
since

causing false de
tection.
KB0097979

Discovery of Salt

Current discovery has

products (Salt and

been removed and re

10.0.8.1

Salt minion) report placed by a template
ed wrong version

for Salt Minion, Master

information due to

and SSH. The names

an incorrect pack

were not distinguish

age rule.

able previously. Up
dated publisher to
'VMware'.

KB0098000

Discovery for Trip

Deleted Tripwire Enter 10.0.8.1

wire Enterprise

prise signatures after

was based on ex

investigation. No prod

ecutable which

uct, name as Tripwire

exists in different

Enterprise existed.

product (Tripwire
Enterprise Agent)
KB0098232

Oracle Insurance

Faulty detection for

Compliance

Oracle Insurance

Tracker detection

Compliance Tracker

caused false-posi

has been changed to

tive discovery.

a new template signa

10.0.8.1

ture.
BI-10860

Wrong product

Windows, Windows

name for Windows, Server 2008, 2012,
2016 had compo

10.0.8.1

ID

Symptoms

Behavior after you
install the update

Windows Server

nent name previously

2008, 2012, 2016

changed, "Microsoft"

Avail
able
since

was removed from
component name,
but product name still
contained “Microsoft”.
Product names were
corrected.
KB0097998

False-positive

Faulty detection for

discovery of Mi

Microsoft Visual Stu

crosoft Visual Stu

dio Test Professional

dio Test Profes

was changed to a new

sional

template signature.

10.0.8.1

Note: Discov
ery may disap
pear until the
next scan and
data import.
KB0098554

Fixlet "Update VM

The incorrect hash

Manager Tool to

is fixed and the fixlet

version 10.0.8"

works correctly.

fails due to hash
mismatch.

10.0.8.1

Application update 10.0.8
Table 9. Published site version
Name of component
BigFix Inventory Content

Version

Updated in the release

151

Yes

10.0.8.0

Yes

2638693

Yes

BigFix Inventory Server

10.0.8.0

Yes

BigFix Inventory Server:

9.2.26.0

Yes

9.2.26.0

Yes

9.2.25.1000 on Windows

No

9.2.25.0000 on other plat

No

Site
BigFix Inventory Software
Catalog (main version)
BigFix Inventory Software
Catalog (version on end
point)

ILMT Core library
BigFix Inventory Server:
ILMT Catalog
BigFix Inventory Scanner

forms
BigFix Inventory Discon

10.0.8.0

Yes

nected Scanner

9.2.26.0 on IBM I

Yes

10.0.8.0

Yes

10.0.8.0

Yes

(incl. package for Contain
ers)
BigFix Inventory VM Man
ager Tool
SAP Metric Data Collector

Table 9. Published site version (continued)
Name of component
BigFix Inventory Image

Version

Updated in the release

10.0.8.0

Yes

10.0.8.0

Yes

10.0.8.0

Yes

Scanner Script
BigFix Inventory Scanner
Service
BigFix Inventory Cloud
Adapter
Changes to supported platforms
The end-of-support for the following platforms announced in BigFix Inventory
is related to IBM Subcapacity reporting capability:
• Windows 7 announced in BigFix Inventory v10.0.4.0
• Windows 2008 announced in BigFix Inventory v10.0.5.0
BigFix Platform still supports the above operating systems through 9.5 agents
and BigFix Inventory continues support for those operating systems for
Software Inventory and Hardware Inventory.
Vendor-specific licensing metrics might include restrictions on operating
system eligibility. For IBM Subcapacity eligible systems, refer to Sub-capacity
(Virtualization capacity) licensing (IBM site).
Effective, April 30, 2022, HCL will end services for BigFix Platform version
9.2.x. For more details, refer to https://forum.bigfix.com/t/bigfix-platform-9-2will-be-end-of-support-on-april-30th-2022/37948
Support for HP-UX
Despite the end-of-support of BigFix Platform 9.2 on April, 30th 2022, the
support for HP-UX managed will be extended using BigFix Platform 9.2 Agent
reporting to BigFix Platform 9.5 or 10.0 connected to BigFix Inventory 10.x.

BigFix Platform 9.2 HP-UX Agent patches will be provided only to address
PSIRT records or high severity customer reported defects.
For more information, refer to the announcement on the BigFix Forum:
BigFix v9.2 agent: support extension for HP-UX operating system - Release
Announcements / Platform (Release Announcements) - BigFix Forum.
Support for IBM Subcapacity Licensing purposes of all versions of HP-UX
is planned to be removed at the end of 2022 as announced by IBM. For IBM
Subcapacity License terms inquiries reach out to IBM at subcap@us.ibm.com.
Support for Microsoft Internet Explorer 11 Web Browser
Starting from BigFix Inventory v10.0.8.0 it is recommended to use Web
Browsers, such as Edge, Firefox, and Chrome instead of Microsoft Internet
Explorer 11 (IE11).
There are known issues related to IE11 and support for this browser will be
discontinued in the future:
• ES5 Syntax issues due to ES6 syntax usage
• [Improved Contracts Management] Edit Contract window is not
displayed on IE11
• BigFix Inventory UI not responsive on IE11 after number of actions
https://docs.microsoft.com/en-us/lifecycle/faq/internet-explorer-microsoftedge what-is-the-lifecycle-policy-for-internet-explorer[KB0093678] BigFix Inventory and BigFix Compliance using the same session cookie
https://support.hcltechsw.com/csm?
id=kb_article&sysparm_article=KB0093678
Collocation of the BigFix Inventory and BigFix Compliance on the same VM is
not supported.
If deployed on the same VM, when using a single, standard Web Browser
instance only one of the applications can be used. Once logged into one

application, if there is an open session with the other application, it would be
lost.
Workaround
Use the Private Mode in browser to access.
Deprecated Features prepared for removal in the next release
To continuously improve BigFix Inventory application and optimize import
process to eliminate unnecessary actions and deprecated features are
planned to be completely removed in the next application update version
10.0.9.0.
BigFix Inventory v10.0.8.0 is the last release with the option to activate and
use the following features.
Deprecated function

Replacement

Comments

Contracts (Deprecat

All Contracts

Complete replacement

Software Summary

Complete replacement

Software Installations

Software Installations

Complete replacement

(Deprecated) report

based on Software

ed) report
Contracts Usage Data
(Deprecated) report
Inventory Exploration
(Deprecated) report

Classification
Unrecognized Files re

N/A

port

Feature discontinued
as not used in busi
ness scenarios.

Changes to Software Discovery in Containers

BigFix Inventory Image Scanner can now scan optimized docker images which
do not satisfy requirements of BigFix Inventory Disconnected Scanner if the
host where Image Scanner is run meets specific requirements.
Since BigFix Inventory v10.0.7.0 dedicated plugin framework is available
to talk to Kubernetes APIs of on-premise and public cloud containers to
determine software usage of container instances.
Collection of container details is with the use of two Cloud Adapter
configurations:
• Kubernetes-based solutions that are compatible with standard
Kubernetes API v1.18 or newer (see note below for details).
• Generic Kubernetes API available in case own access method is
preferred.
Note: Examples of compatible solutions verified in test lab environment are
Vanilla (unmodified) Kubernetes v1.18, v1.21 and v1.23, Google Cloud v1.20,
RedHat OpenShift Container Platform v4.9.
For management of IBM software in Containers refer to IBM strategy and
solution FAQ. BigFix Inventory is certified for IBM Virtualization Capacity
License reporting on physical machines, virtual machines on premise and in
the cloud. For IBM Certified Containers the only approved licensing counting is
through IBM License Service. Feedback or questions regarding this capability
and strategy should be provided directly to IBM.
Currently the BigFix Inventory Software Discovery in Containers is limited
to software discovery only without license management capability but
provides visibility to a large set of vendor software in Kubernetes compatible
environments including RedHat OpenShift.
As BigFix Inventory feature matures over time, driven by customer feedback,
support for a wide variety of license management within containers will
be added, beyond IBM/RedHat container license management including

Microsoft, Adobe, SAP, HP, BMC, CA, Citrix, Corel, Symantec, TIBCO, VMware
and many others.
HCL looks forward to continuing partnership with IBM/RedHat to address their
container license management as a leading software vendor.
Optional Software Data Harvesting Tool for BigFix Inventory
This release introduces an optional tool called Software Data Harvesting Tool
for BigFix Inventory which is part of BigFix Inventory Catalog Enhancement
Program. The tool provides a better discovery of softwares installed at the
endpoints.
Please contact us through talk2sam@hcl.com if you would like to take part in
this program.
Included Software Catalog
This release includes Software Catalog version 10.0.8.0 with capability to
discover 400+ new software versions including but not limited to the following
software manufacturers: Adobe, AutoDesk, BMC Software, Cisco, HewlettPackard, JetBrains, Microfocus, Microsoft, Red Hat
New template signatures included in this release:
Template signature is a method of discovery where the version of a
component is detected automatically, and specific versions are randomly
added to the catalog. The template signatures includes all component
versions. They are used when the software is frequently updated and
deployment method is not changed.
Publisher name

Component name

Platform

Forcepoint

Forcepoint Endpoint

Windows

Hewlett-Packard

HP Business Service

Windows

Management
Adobe

Adobe Lightroom Clas Windows
sic

For more information, refer to the Catalog Release Notes and Catalog Change
List.
Modified content
The version number of the fixlet is 10.0.8.0.
The following fixlets were updated and should be run to install the latest
versions of the specific components:
• Upgrade to the latest version of BigFix Inventory
• Upgrade to the interim version 10.0.2 of BigFix Inventory if version older
than 9.2.14
• Software Catalog Update (if BFI not upgraded)
• Install or Upgrade Scanner
• Install or Upgrade Scanner in private mode on Windows
• Install SAP Metric Data Collector
• Update SAP Metric Data Collector
• Install VM Manager Tool
• Update VM Manager Tool
• Install Additional VM Manager Tool
• Download the Disconnected Scanner Package for IBM I
• Download the Disconnected Scanner Package
• Download BigFix Inventory
• Download the BigFix Inventory Container Solution Packages
The following fixlets were updated and require that actions created by their
previous versions are stopped and then started by using the updated fixlets.
Restarting actions is necessary to ensure that new features work properly:
• Initiate Software Scan
• Initiate Software Scan on Shared Disks
• Upload Software Scan Results – no updates, but recommended to be
refreshed to match Initiate

The following fixlets were updated or added:
• Configure Scan Cache
• Uninstall Scanner
• Test CIT signature
• Clear Scanner Installation
• Run Software Data Harvesting Tool
Enhancements and important changes
For a list of enhancements introduce in this release, see: What's New.
Defect fixes
Behavior after
ID

Symptoms

you install the

Available since

update
Server updates
KB0094309

Software Clas

Change the filter 10.0.8.0

sification report

"Publisher in set

with filters of

IBM" to "Publish
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er Name equal
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firmed equal

icant speed im

to No" taking

provement on

way too long to

report page with

process.

this specific fil
ter.

KB0094967

Inventory
Builder: Dictio
nariesBO: select
ing File Facts to
process to tem

Issue is fixed

10.0.8.0

Behavior after
ID

Symptoms

you install the

Available since

update
porary table on
MS SQL 2016
can have invalid
plan filling in
whole available
TempDB
KB0095233

Data Import fails Temporary bun
to complete

dle ids cleared

Custom Rule

if last import is

step

failed with the

10.0.8.0

info in the log
‘Bundle id table
truncated due
to last import
failed.’
KB0095723

Update VM Man The process of
ager Tool to Ver upgrade has
sion 10.0.7.0
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pre-fetch com
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update
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KB0095913

SLM Tag Import
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using Simple
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make sure the

tion error

error won't ap
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handling.
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Improved han

fails when ex
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ception got a nil
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message
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10.0.8.0

environment
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10.0.8.0
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latest version of
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executables for

correct file ver

Qualys Cloud

sion for the exe

Security Agent

cutables.

10.0.8.0

1.6 & 2.1
BI-9448

SnagIt 2.2 dis

Discovery now

covery did not

provides usage

provide usage

monitoring for

monitoring.

10.0.8.0

Behavior after
ID

Symptoms

you install the

Available since

update
versions 2.2 and
2.5.
BI-9741

Cleanup of For

Discovery is im

cepoint End

proved.

point

Four signatures

10.0.8.0

for Forcepoint
Endpoint are
deleted and re
placed by a tem
plate signature
for Windows
platform.
BI-9965

Microsoft Visio

Added detection 10.0.8.0

installed with

for Microsoft Vi

Microsoft 365

sio for Microsoft

was not detect

365.

ed correctly.
Fixlets
KB0092645

BigFix Invento

BigFix Inventory

ry Actions might actions include
be hanging on

the timeout set

Windows end

ting inside to de

points due to is

tect such situa

sues with Win

tions and then

dows Scripting

terminate such

Host.

handing scripts.

10.0.8.0

Behavior after
ID

Symptoms

you install the

Available since

update
BI-8919

Collect Logs

The issue has

from Endpoint

been fixed. The

fixlet fails on

Collect Logs

Windows ma

from Endpoint

chine with CIT

fixlet works

private installa

properly with

tion

CIT private in

10.0.8.0

stallation.
BI-8785

"Initiate Soft

The scan suc

10.0.8.0

ware Scan” fixlet ceeds.
occasionally
fails on MacOS.
User Documentation updates
KB0095270

Custom metric

Updated the

requirements

document with

too vaguely

information

specified

about conditions
required for the
metric to be dis
played on All
Metrics panel.
Doc link:

10.0.8.0

Behavior after
ID

Symptoms

you install the

Available since

update
• License
metric uti
lization
• Report
ed license
metrics
KB0096529

Supported man

Updated the

aged devices

document for

documentation

“Supported man

outdated

aged devices

10.0.8.0

documenta
tion outdated”.
Added Windows
7 as supported
version and up
dated the notes
to provide cor
rect information.
Doc link: Sup
ported managed
devices
BI-10142

Document dif

Added a new

ference between topic to include
BES Invento
ry and License
– Application
Information*

the article.
Doc link: Differ
ence between
Web Reports

analysis and Big and BigFix In

10.0.8.0

Behavior after
ID

Symptoms

you install the

Available since

update
Fix Inventory Re ventory software
ports.

discovery re
sults

BI-9266

Improved Soft

Software scan

10.0.8.0

ware Scan re

return codes

turn codes doc

(hcltechsw.com)

umentation to
cover statuses
shown on the
Software Scan
Status analy
sis and missing
Scanner error
codes
VM Manager Tool version and changes
The VM Manager Tool version that is used with this update is 10.0.8.0.
Scanner version and changes
The scanner version that is used with this update is 9.2.25.1000 for Windows
and 9.2.25.0000 for other platforms. The disconnected scanner version that is
used with this update is 10.0.8.0 and 9.2.26.0 for IBM I.

Application update 10.0.7.1
Table 10. Published site version
Name of component
BigFix Inventory Content
Site

Version
150

Updated in the release
Yes

Table 10. Published site version (continued)
Name of component
BigFix Inventory Software

Version

Updated in the release

10.0.7.1

No

2638678

Yes

BigFix Inventory Server

10.0.7.0

Yes

BigFix Inventory Server:

9.2.25.0

No

9.2.24.0

No

9.2.25.1000 (Windows)

Yes

Catalog (main version)
BigFix Inventory Software
Catalog (version on end
point)

ILMT Core library
BigFix Inventory Server:
ILMT Catalog
BigFix Inventory Scanner

9.2.25.0000 (other plat
forms)
BigFix Inventory Discon

10.0.7.0

nected Scanner

9.2.25.0 (for IBM I)

BigFix Inventory VM Man

10.0.7.0

Yes

10.0.7.0

Yes

Yes

ager Tool
SAP Metric Data Collector
Included Software Catalog
• This release includes Software Catalog version 10.0.7.1 with capability
to discover more than 300 new software versions.
Some of the new software versions that can be discovered are:
◦ AutoDesk Inc.
◦ Microsoft

◦ Oracle
◦ Red Hat
◦ SAP
◦ VMware
• Several defect fixes.
Table 11. New template signatures included in this release:
Template signature is a method of discovery where the version of a
component is detected automatically and specific version is randomly
added to the catalog. The template signatures cover all component
versions. They are used when the software is frequently updated and
deployment method is unchanged.
Publisher Name

Component Name

PostgreSQL Glob PostgreSQL

Platform
LINUX

al Development
Group
AccessData Cor

FTK Imager

WINDOWS

Broadcom

BacsTray Application

WINDOWS

CA Technologies

CA Application Managemen

WINDOWS

poration

t .NET Agent
CollabNet Inc

Collabnet Subversion

WINDOWS

Mobatek

MobaXterm

WINDOWS

NetSDK Software

S3 Browser

WINDOWS

NICE

NICE Storage Center

WINDOWS

PyScripter

PyScripter

WINDOWS

Table 11. New template signatures included in this release:
Template signature is a method of discovery where the version of a
component is detected automatically and specific version is randomly
added to the catalog. The template signatures cover all component
versions. They are used when the software is frequently updated and
deployment method is unchanged.
(continued)
Publisher Name

Component Name

Platform

SlikSVN

SlikSVN

WINDOWS

TortoiseCVS

TortoiseSVN

WINDOWS

Verint Systems

Logger Package

WINDOWS

VisualSVN Ltd.

VisualSVN Server

WINDOWS

WANdisco Inc.

SmartSVN

WINDOWS

Quest Software

Toad for IBM DB2

WINDOWS

Toad for MySQL

WINDOWS

Toad for SAP Solutions

WINDOWS

Toad Edge Preview

WINDOWS

Toad Data Point

WINDOWS

Toad for SQL Server

WINDOWS

Inc.

Inc.
Quest Software
Inc.
Quest Software
Inc.
Quest Software
Inc.
Quest Software
Inc.
Quest Software
Inc.

Table 11. New template signatures included in this release:
Template signature is a method of discovery where the version of a
component is detected automatically and specific version is randomly
added to the catalog. The template signatures cover all component
versions. They are used when the software is frequently updated and
deployment method is unchanged.
(continued)
Publisher Name
Trend Micro

Component Name
Trend Micro OfficeScan Agent

Platform
WINDOWS

version 13 and older
Trend Micro

Trend Micro Apex One Security

WINDOWS

Agent version 14 and newer
Trend Micro

Trend Micro Worry-Free Busi

WINDOWS

ness Security Agent
Trend Micro

Trend Micro Security Agent

WINDOWS

SAP

SAP Crystal Reports version 14

WINDOWS

and newer
Free Software

Gzip

LINUX

Foundation Inc.
For more information, refer to Catalog release notes and Catalog change list.
Modified content
The version number of the fixlet is 10.0.7.1.
The following fixlets were updated and should be run to install the latest
versions of the specific components:
• Update Software Catalog
• Initiate Software Scan
• Update VM Manager Tool

Enhancements and important changes
The following enhancements and changes are introduced in this update:

Abstract

Description

Windows 11 detection

Windows 11 is now detected after

and Operating Sys

updating the Initiate Software Scan

tem version reported

fixlet. Operating System detailed

Available
since
10.0.7.1

in Software Classifica version is also added for all of the
tion

Windows systems.
Note: It requires an update
of Initiate Software Scan
fixlet.

Discovery for Oracle

Discovery for version 14.1 (both

Weblogic Server, Or

Windows and Unix) is added.

10.0.7.1

acle Weblogic Serv
er Enterprise Edition,
Weblogic Suite
Improved discovery for Discovery for versions 12.1 and
Oracle Tuxedo Serv

12.2 for both Windows and Unix are

er, Oracle Tuxedo Jolt,

improved. The discovery now pro

Tuxedo System and

vides information about detailed

Application Monitor

version.

10.0.7.1

Plus (TSAM Plus), Ser
vices Architecture
Leveraging Tuxedo
(SALT)
Improved discovery for Discovery for versions 12.1 and
Oracle Database 12c

12.2 for both Windows and Unix are

10.0.7.1

Abstract

Description

Available
since

improved. The discovery now pro
vides information about detailed
version.
Improved discovery for Added discovery capability for
PostgreSQL

PostgreSQL on Linux platform.

Improvement of dis

Improved discovery for BMC Con

covery for BMC Con

trol-M Agent for Windows platform.

trol-M Agent

Versions include 6.0, 6.1, 6.3, 7.0,

10.0.7.1

10.0.7.1

8.0, 9.0 the discovery returns a de
tailed version now.
Discovery for Mi

Discovery for Microsoft Office 2021 10.0.7.1

crosoft Office 2021

added for Windows.

Improved discovery for Java Runtime Environment 7.0,
Oracle Java Runtime

10.0.7.1

JDK/SDK 7.0 and OpenJDK 7.0, 8.0

Environment, JDK/SDK return detailed version on Windows
and OpenJDK.

and Unix platforms.

Improved discovery

Discovery for releases 6.0-6.6 was

for Red Hat Jboss Da

improved to have better perfor

ta Grid 6.0 - 6.6 and

mance and to return the detailed

added new discovery

version. Discovery for releases

for Red Hat Data Grid

7.0-7.3 and 8.0-8.2 was added for

7.0-7.3, 8.0-8.2.

Windows and Unix platforms.

10.0.7.1

Improved naming con Changed naming for 3 Linux operat 10.0.7.1
vention of Linux OS

ing systems:

Abstract

Description
• Canonical Ubuntu Server →

Available
since

Ubuntu Server

• Fedora Project Fedora → Fe
dora

• Centos Linux → CentOS
Improved discovery for Improved discovery of TOAD on
TOAD

10.0.7.1

Windows platform with template
signatures:
• Toad for IBM DB2
• Toad for MySQL
• Toad for SAP Solutions
• Toad Edge Preview
• Toad Data Point
• Toad for SQL Server

Unified naming con

Java is merged into 2 components; 10.0.7.1

vention of Java

JDK/SDK and Java Runtime Envi
ronment:
• Java Developers Kit → JDK/
SDK

• Sun Java Development Kit →
JDK/SDK

• Java 2 Runtime Environment

Standard Edition → Java Run
time Environment

• Java 2 Platform Standard

Edition 5.0 Update x → Java
Runtime Environment

Abstract

Description

Available
since

Note: Detection can disap
pear, but it will appear once
again when customers
propagate a new catalog to
the endpoints. It will hap
pen because this type of
signature is validated on
the endpoint side.
Unified name conven

All components were moved to

10.0.7.1

tion of SAP Crystal Re SAP publisher, deleted multiple sig
ports

natures for one version and merged
into one signature.
Components that were modified:
• SAP Crystal Reports
• SAP Crystal Reports for En
terprise
• SAP Crystal Reports Server
• SAP Crystal Reports Viewer

Discovery for Zimbra

New discovery added to the catalog 10.0.7.1

Collaboration

for versions 8.8 and 9.0. Added sig
natures are for Linux platform.

Discovery for SAP

A new Windows template signature 10.0.7.1

Crystal Reports

was added for SAP Crystal Reports
which will assure discovery of ver
sions starting from 14.0 onwards.

Defect fixes

For the list of known defects please refer to HCL Knowledge Base.
The following table lists APARs and other defects that are fixed in this update.

ID

Symptoms

Behavior after you
install the update

Avail
able
since

Catalog updates
KB0094682

Discovery for Gzip

This defect has been

1.5, 1.6 returned

fixed.

10.0.7.1

faulty Install Path
to "gzip" when
"bash completion"
function was in
stalled on end
point.
BI-8765

The Microsoft Of

Deleted detection for

fice Language

both versions.

10.0.7.1

Pack 2016 and
2019 are faulty and
both are detecting
same version
BI-8550

Discovery for Vi

We replaced the old

sualSVN Server

discovery of Tor

caused false posi

toiseSVN, SlikSVN.

tives, after further

SmartSVN, VisualSVN

investigation the

Server, CollabNet Sub

issue could also

version with discov

happen in other

ery by a template sig

SVN/Subversion

nature. The new dis

products

covery fixes the falsepositive issue and pro

10.0.7.1

ID

Symptoms

Behavior after you
install the update

Avail
able
since

vides discovery for
previously missing
versions
KB0096090

Trend Micro Apex

Discovery was fixed

10.0.7.1

One Security Agent and improved by re
improperly discov

placing method of

ered

detection with tem
plate signatures for
Trend Micro OfficeS
can Agent, Trend Mi
cro Apex One Securi
ty Agent, Trend Micro
Worry-Free Business
Security Agent, Trend
Micro Security Agent.

KB0095764

Red Hat Cygwin

Discovery for ver

wrong version re

sion 2.9 was fixed (no

ported

longer discovers other
versions and reports
them as 2.9). Discov
ery for newer missing
versions was also pro
vided (3.0-3.3).
Note: Detec
tion can disap
pear, but it will
appear once

10.0.7.1

ID

Symptoms

Behavior after you
install the update

Avail
able
since

again when
customers
propagate a
new catalog to
the endpoints.
BI-8752

KB0095523

McAfee Agent dis

This defect has been

covery was faulty

fixed.

Microsoft

There was a dupli

OneDrive duplicat

cated discovery of

ed discovery

Microsoft OneDrive

10.0.7.1

10.0.7.1

(due to a template
signature on top of
non-template and
they both reported the
same version differ
ently, for ex, 19.42 and
19.423). Non-template
signatures were re
moved.
Documentation updates
BI-8978

Incorrect SQL data Updated the informa
base requirements tion about MS SQL
for BFI 9.2.16

2008 and 2008 R2
server edition in Big
Fix Inventory version
9.2.16 document.

10.0.7.1

ID

Behavior after you

Symptoms

install the update

Avail
able
since

Doc link: Software re
quirements
KB0094013

Lack of clear

Created a documenta 10.0.7.1

ly documented

tion page with step-by-

process for license step guidance for the
counting of BigFix
Inventory and relat
ed products

license counting.
Doc link: Using Big
Fix Inventory to calcu
late license for BigFix
products

Fixlet updates
KB0095723

Update VM Manag Updated the code so
er Tool to version

the fixlet no longer

(10.x) fixlet fails

fails.

10.0.7.1

Application update 10.0.7
Table 12. Published site version
Name of component
BigFix Inventory Content

Version

Updated in the release

148

Yes

10.0.7.0

Yes

2638667

Yes

Site
BigFix Inventory Software
Catalog (main version)
BigFix Inventory Software
Catalog (version on end
point)

Table 12. Published site version (continued)
Name of component

Version

Updated in the release

BigFix Inventory Server

10.0.7.0

Yes

BigFix Inventory Server:

9.2.25.0

Yes

9.2.25.0

Yes

9.2.25.1000 (Windows)

Yes

ILMT Core library
BigFix Inventory Server:
ILMT Catalog
BigFix Inventory Scanner

9.2.25.0000 (other plat
forms)
BigFix Inventory Discon

10.0.7.0

nected Scanner

9.2.25.0 (for IBM I)

BigFix Inventory VM Man

10.0.7.0

Yes

10.0.7.0

Yes

Yes

ager Tool
SAP Metric Data Collector
Allowed upgrade path
Minimal version recommended for direct upgrade path: 9.2.16
For version older than 9.2.16 upgrade first to 10.0.2 using already available
fixlet.
Software discovery in containers
BigFix Inventory, starting from version 10.0.7.0, supports the discovery of
software in Docker container images through standard discovery methods
including catalog signatures, template signatures, installation registry and ISO
SWID tags to cover traditional model of software deployment.
The application provides information about software running in containers, the
container instances with basic properties and their status. This information

allows you to determine the software deployment across container resources
that are allocated.
BigFix Inventory was instrumented to allow for a separate BigFix Inventory
server instance setup for software on image with container data collection
and reporting. The supported maximum number of images, in a separate
BigFix Inventory server instance, is equal to maximum number of supported
disconnected endpoints as in case of standard BigFix Inventory server
instance if configured in line with scalability guidelines.
A new plugin framework is available to talk to Kubernetes APIs of on-premise
and public cloud containers to determine software usage of container
instances.
Collection of container details is with use of two Cloud Adapter configurations
• Standard Kubernetes API for Kubernetes v1.18.0, Kubernetes v1.21.2
and Google Cloud v1.20.10.
• Generic Kubernetes API available in case own access method is
preferred.
Image Scan solution covers two integration scenarios
• Automated monitoring - available as a service to monitor and request
image scan only for images used in existing containers.
• Pipeline build process - to integrate with pipeline solution before image
is available for deployment.
This dedicated solution does not require any BigFix component to be added
into image neither installed in container.
Note: Software discovery in containers is covered by Active Container
license metric. For details refer to license information text (English
only) included in BigFix Inventory server package.

Included Software Catalog
This release includes Software Catalog version 10.0.7.0 with capability to
discover around 440+ new software versions.
As an enhancement we added a discovery capability of Check Point
SmartConsole on Windows platform for version - 80.40.
New template signatures included in this release:
Publisher Name

Component Name

Microsoft

Microsoft Visual Studio Code

Microsoft

Azure Data Studio

Microsoft

Microsoft Power BI Desktop

Adobe

Adobe Creative Cloud

Adobe

Adobe Genuine Software Integrity Service

Hewlett-Packard

HP Device Manager Configuration Center

For more information, refer to the Catalog Release Notes and Catalog Change List.
Modified content
The version number of the fixlet is: 10.0.7.0
The following fixlets were updated and should be run to install latest versions
of the specific components:
• Upgrade to the latest version of BigFix Inventory
• Upgrade to the interim version 10.0.2 of BigFix Inventory if version older
than 9.2.14
• Software Catalog Update (if BigFix Inventory is not upgraded)
• Install or Upgrade Scanner
• Install or Upgrade Scanner in private mode on Windows
• Install SAP Metric Data Collector
• Update SAP Metric Data Collector

• Install VM Manager Tool
• Update VM Manager Tool
• Install Additional VM Manager Tool (OPTIONAL)
• Download the Disconnected Scanner Package for IBM I
• Download the Disconnected Scanner Package
• Download BigFix Inventory
The following fixlet was added and should be used to obtain install media for
BigFix Inventory Container Solution:
• Download the BigFix Inventory Container Solution Packages
The following fixlets were updated and require that actions created by their
previous versions are stopped and then started by using the updated fixlets.
Restarting actions is necessary to ensure that new features work properly:
• Initiate Software Scan
• Upload Software Scan Results – no updates, but recommended to be
refreshed to match Initiate Software Scan version
Enhancements and important changes
For a list of enhancements introduce in this release, see: What's New.
Defect fixes and enhancements
For the list of known defects please refer to HCL Knowledge Base.
The following table lists APARs and other defects that are fixed in this update.
Behavior af
ID

Symptoms

ter you install

Available since

the update
Server updates
KB0093673

Unable to ac

All Contracts

cess Contracts

panel works cor

10.0.7.0

Behavior af
ID

Symptoms

ter you install

Available since

the update
after first data

rectly after the

import post BFI

first successful

10.0.5 upgrade

import after up
grade. BigFix In
ventory restart
after the import
may be required.

KB0093969

Contracts API

The issue af

and CSV import

fected BigFix In

return errors on

ventory which

DB2

in past was in

10.0.7.0

version before
10.0.0 and is
migrated to
10.0.6. In ver
sion 10.0.7, the
problem is fixed.
KB0093647

Too many filters Adding many fil 10.0.7.0
in new custom

ters in "Software

rule cause SQL

Classification"

error

cause error on
BFI 10.0.6 and
down versions.
The reason of
the error is DB
Column size ex
ceed for the re
lated column.

Behavior af
ID

Symptoms

ter you install

Available since

the update
After the imple
mentation, DBs
migrated and in
correct data was
removed with
migration and
maximized the
column size.
KB0094205

Unsuccessful

Mac OS 11 is

10.0.7.0

OS matching for recognized prop
Mac OS 11. Ap

erly, and pack

plication could

age data is dis

not identify Mac played.
OS 11 machines
as Mac OS, be
cause the op
erating system
is reported in a
different way.
This causes that
package data is
not reported for
such machine.
KB0094388

Hundreds of

The issue is

open connec

fixed.

tions to BigFix
database. BigFix
database may

There was pro
vided 10.0.6.0.1
hotfix.

10.0.7.0

Behavior af
ID

Symptoms

ter you install

Available since

the update
stop accept
ing new con
nections. BigFix
Inventory may
stop working
properly and be
able to run Data
Imports.
KB0093835

Software not

The issue is

displayed on

fixed.

10.0.7.0

Software Clas
sification de
spite signature
matching. This
can happen if a
custom metric
was assigned to
the product.
KB0092682

WAS Liberty

The issue is

PVU option

fixed. WAS Lib

found

erty SWID ISO
tags were re
moved from Big
Fix Inventory
Server 10.0.7.0
installation
package

10.0.7.0

Behavior af
ID

Symptoms

ter you install

Available since

the update
KB0095168

In some sce

The issue is

narios an im

fixed.

10.0.7.0

port process
is failing on
Unix package
facts step, due
to improper
parsing of long
strings with spe
cial characters,
which is break
ing the import
process
KB0094017

Unix packages

The issue is

on Ubuntu oper

fixed.

ating system are
empty if RPM
Package Manag
er is installed.
The sua_pack
age_data file in
the client's CIT
folder is emp
ty. There is no
proper discov
ery on the end
point where
RPM Package

10.0.7.0

Behavior af
ID

Symptoms

ter you install

Available since

the update
Manager is in
stalled; thus,
BigFix Inventory
does not report
installed soft
ware for Linux
Ubuntu clients.
KB0093628

During import,

The issue is

10.0.7.0

while processing fixed, and cor
file facts SQL

responding vali

query fails due

dation has been

to too big differ

added to catch

ence between 2

issue early and

dates

not stop import
process

KB0091998

Additional CIT

The issue is

Signatures in

fixed in ILMT

Endpoint Cat

9.2.25 adopted

alog that does

by BFI

not result in dis
covery of the
software: ILMT
core process
ing the ILMT
catalog creat
ed some addi
tional CIT rules
and then sig

10.0.7.0

Behavior af
ID

Symptoms

ter you install

Available since

the update
natures, which
were propagat
ed to the end
points. There
were matches,
but not resulting
in the software
discovery dur
ing the import
on BFI.
BI-7645

Cross-site Re

After the

quest Forgery

changes attack

vulnerability in

er will get “To

Login Form

ken has expired

10.0.7.0

or is invalid. Re
fresh page to lo
gin.” error and
login from cross
origin will be
blocked.
BI-6318

Inconsisten

"Connection

cy between UI

Test Status" for

and CSV/PDF

distributed VM

in "Connection

Managers will

Test Status" col always have
umn for distrib

"Not Applica

uted VM Man

ble" value in UI

agers:

10.0.7.0

Behavior af
ID

Symptoms

ter you install

Available since

the update
• UI - always and CSV/PDF re
"Not Ap

ports.

plicable"
value
• CSV/PDF
– ade
quate con
nection
test status
BI-7185

Contracts REST

Validation of

API validates

required string

required string

custom fields in

custom fields

PUT REST API is

10.0.7.0

introduced.
BI-7324

Contracts REST

Custom field val 10.0.7.0

API accepts

ues of types:

non-string cus

integer, float,

tom fields

boolean are
accepted also
without quota
tion marks.

BI-7365

Contracts REST

Software which

API and con

contains non-

tracts UI support ASCII characters
software hav

is accepted in

ing non-ASCII

contracts REST

characters in

API, as well as in
the search field

10.0.7.0

Behavior af
ID

Symptoms

ter you install

Available since

the update
names or pub

on UI. These is

lisher names

sues occurred
only in BigFix In
ventory using
SQL server data
base.

BI-7354

Contracts REST

Contract fields

API supports

like contract

non-ASCII char

name in REST

acters

API can contain

10.0.7.0

non-ASCII char
acters.
BI-7168

Improved er

Error reporting

ror reporting for

for CSV import

contracts CSV

is improved for

import

the cases when

10.0.7.0

type id, comput
er group id or
purchase order
quantity is emp
ty but it is ex
pected to have a
value.
BI-7207

Part of texts is

Contracts CSV

translated ac

import logic was

cording to Web

using language

browser's lang

header instead

setting instead

of user language

10.0.7.0

Behavior af
ID

Symptoms

ter you install

Available since

the update
of user profile

from profile.

lang setting

Which was lead
ing to mismatch
in language on
errors inside
modal window
and outside of it.

BI-7318

Windows 2019

On Windows

Exploit Protec

2019 Standard

tion feature can

the default set

break SAML

ting for Exploit

without exclu

Protection is

sions in place

"on". No BFI mal

for Java

functions were

10.0.7.0

observed when
launching the
application in
SSO mode when
switching Ex
ploit Protec
tion on and off,
restarting the
server, etc.
Scanner updates
IJ34778

VMware VMs

The problem

with Hyper-V

does not occur.

feature enabled
are treated as

10.0.7.0

Behavior af
ID

Symptoms

ter you install

Available since

the update
physical ma
chines.
199533

Due to Kernel

No Kernel Lock

Lockdown fea

down warnings

ture CIT gener

in dmesg out

ates a lot of Op

put.

10.0.7.0

erating System
warnings during
'/dev/mem' ac
cess.
199463

The existing

'--dumpsmbios'

'dumpsmbios'

switch allows to

method doesn't

dump the whole

allow to dump

smbios memory

'raw' smbios

area.

10.0.7.0

memory area. If
_SM_ & _DMI_
anchor-strings
are not discov
ered '--dumpsm
bios' switch
doesn't work at
all.
199380 /

On machines

SMBIOS data

IJ33747

with SeaBIOS

can be correct

(199413)

'_DMI_' anchor

ly collected by

string used to

CIT and returned

discover the

10.0.7.0

Behavior af
ID

Symptoms

ter you install

Available since

the update
SMBIOS Entry

in the hardware

Point is being

scan output.

stated twice.
The first entry
points to some
invalid memory
address.
199432

SQLite API have

'provider_

a problem with

cache3' can be

accessing its

used with UTF

own Database

character set.

10.0.7.0

file when path
contains some
character out
side of ASCII
character set.
199481

The existing

'Nested Virtual

'Nested Virtu

ization' check

alization' dis

has been re

covery method

moved.

is not reliable
and provide am
biguities. Fur
thermore, some
Nested Virtual
ization scenar
ios like running
VM inside the

10.0.7.0

Behavior af
ID

Symptoms

ter you install

Available since

the update
VM of the same
vendor are not
being discov
ered at all.
199338

SharedPoolCa

When local zone 10.0.7.0

(199110) /

pacityInCores

is assigned

IJ33481

and LparCapaci processor pool
tyInCores fields

(pset), then we

are reported as

cannot report

-1 on local zone

the totals of the

with pset as

LPAR capacity

signed.

as based on the
comment from
the code, we:
"invalidate be
cause we don't
know how many
packages the
system has be
side what's in
the pool". The
fix is to chang
ing the capaci
ty scan in such
a way that it re
ports the pool
resources as the
LPAR capacity
(so potentially

Behavior af
ID

Symptoms

ter you install

Available since

the update
ignoring the ad
ditional pack
ages not coming
from the pool
mentioned by
the comment).
199307 /

CIT wscanvpd

rpm command

RFE 199191

scanner hangs

execution is now

on a system

done with a 300

with a corrupted seconds (5 min
rpm registry due utes) timeout.
to hanging rpm

After the time

command.

out expires the
rpm process
is finished and
the CIT scanner
command exits.
Note:
wscan
vpd will
return
empty
results
on Linux
in such
case (if
rpm is
the only

10.0.7.0

Behavior af
ID

Symptoms

ter you install
the update
software
registry
scanned)
and will
exit with
no error
(return
code 0).
The cur
rent be
havior is
that ws
canvpd
does not
return
any error
in case
a given
provider
of soft
ware
registry
returns
empty
results.
Nevertheless
CIT logs will
contain the fol

Available since

Behavior af
ID

Symptoms

ter you install

Available since

the update
lowing error
messages (MIN
level):
Unable to exe
cute rpm com
mand, error
code=-1. No out
put has been re
turned.
Unable to pre
load packages
( err = -1 )
Unable to get
result from ex
pression Rpm
ProductList ( err
= -13111)
(Error -13111
is a RegPlugin
error meaning
REG_PLUGIN_ERROR_UNABLE_TO_GET_PROGRAM_LIST

199540

The timestamp

The timestamp

prefix of each

string is correct

cpuid log line

ly returned, and

10.0.7.0

Behavior af
ID

Symptoms

ter you install

Available since

the update
(from 'cpuid -d'

the proper value

command) con

is displayed in

tains garbage or the cpuid log.
incomplete time
stamp instead
of a full correct
timestamp. The
problem was re
turning a local
ly defined vari
ables, which
were lost on a
function exit.
Catalog updates
KB0094222

Wrong discov

Package infor

10.0.7.0

ery for SQL Serv mation is used
er Management

to determine

Studio.

version.
Discovery for all
existing releases
16.5 - 18.10 was
added.

KB0094717

Wrong informa

Package infor

tion about in

mation is used

stalled Visual

to determine

SVN instances

version.

10.0.7.0

Behavior af
ID

Symptoms

ter you install

Available since

the update
Discovery for all
existing releas
es 1.0 - 5.6 was
added.
KB0094947

False discov

Old way of dis

10.0.7.0

ery of HP Device covery got re
Manager 4.7

moved.
Template signa
ture was added
for HP Device
Manager Config
uration Center
instead.

KB0095067

SAP Open Client Old components 10.0.7.0
16.0 was detect for versions 15
ed as version 15 were replaced
by the new ones
which provide
better discovery
with the detailed
version returned.
Additionally, de
tection of ver
sion 16.0 was
added.

BI-8516

There was the

Java SE Devel

duplicated Java

opment Kit dis

10.0.7.0

Behavior af
ID

Symptoms

ter you install

Available since

the update
SE Development covery for ver
Kit discovery for sion 8 was re
version 8 (Ora

moved.

cle).
Document updates
KB0094774

No data (pre
viously Insuffi
cient rights) VM
status

Updated the

10.0.7

document for
“VM Manager
– No data sta
tus (previous
ly insufficient
rights). Docu
ment link: VM
manager status
es

BI-7532

Connection to

Added informa

BigFix database

tion about min

using TLS fails

imum fixpack

when MS SQL

level for MS SQL

Server does not

Server database

10.0.7

support TLS 1.2. having TLS 1.2
support.
KB0094774

No data (pre
viously Insuffi
cient rights) VM
status

Updated the
document for
“VM Manager
– No data sta
tus (previous

10.0.7

Behavior af
ID

Symptoms

ter you install

Available since

the update
ly insufficient
rights). Docu
ment link: VM
manager status
es
KB0093658

IBM i Discon

Updated the

nected scan

disconnected

ner package no

scanner topics

longer matches

to keep it up to

our documenta

date.

tion

Document link:

10.0.7

• Preparing
installa
tion files
for dis
connected
scans for
IBM i
• Installing
the scan
ner and
gathering
initial da
ta on IBM i
systems
BI-7532

Connection to

Added informa

BigFix database

tion about min

10.0.7.0

Behavior af
ID

Symptoms

ter you install

Available since

the update
using TLS fails

imum fixpack

when MS SQL

level for MS SQL

Server does not

Server database

support TLS 1.2. having TLS 1.2
support.
BI-6668

Rework of De

Dedicated pages 10.0.7.0

tailed System re have been cre
quirements sec

ated to list sys

tion

tems that are

Detailed System managed by
BigFix Invento
requirements
ry and require
ments for sys
tems to host
BigFix Inventory
Server.
Earlier, the infor
mation was on a
single page.
VM Manager Tool / SAP Tool
KB0095486

Log4j vulnera

Updated Log4j

bility in BigFix

to version

products

2.15.0 due to
CVE-2021-44228.

Security enhancements

10.0.7.0

To maintain security, the following selected components and libraries were
updated:
• Axios to version 0.21.4 - CVE-2021-3749
• Log4j to version 2.15.0 in VM Manager Tool and SAP Tool CVE-2021-44228. BigFix Inventory is not affected by CVE-2021-45046.
BigFix Inventory is shipped with TLS 1.2 with enabled algorithms as included
in each Java / WebSphere version. It is possible to restrict the algorithms
with an entry in customization.xml file, which is extending server.xml
definition.
Currently available algorithm list:
Algorithm considered as safe:
• TLS_DHE_RSA_WITH_AES_128_GCM_SHA256
• TLS_DHE_RSA_WITH_AES_256_GCM_SHA384
• TLS_ECDHE_RSA_WITH_AES_128_GCM_SHA256
• TLS_ECDHE_RSA_WITH_AES_256_GCM_SHA384
Algorithm considered as weak, but accepted by scanning tools:
• TLS_ECDHE_RSA_WITH_AES_128_CBC_SHA256
• TLS_ECDHE_RSA_WITH_AES_256_CBC_SHA384
• TLS_DHE_RSA_WITH_AES_128_CBC_SHA256
• TLS_DHE_RSA_WITH_AES_256_CBC_SHA256
Algorithm considered as weak but still included in standard setup:
• TLS_RSA_WITH_AES_128_CBC_SHA
• TLS_DHE_RSA_WITH_AES_128_CBC_SHA

• TLS_RSA_WITH_AES_256_CBC_SHA
• TLS_DHE_RSA_WITH_AES_256_CBC_SHA
• TLS_RSA_WITH_AES_128_CBC_SHA256
• TLS_RSA_WITH_AES_256_CBC_SHA256
• TLS_RSA_WITH_AES_128_GCM_SHA256
• TLS_RSA_WITH_AES_256_GCM_SHA384
• TLS_ECDHE_RSA_WITH_AES_128_CBC_SHA
• TLS_ECDHE_RSA_WITH_AES_256_CBC_SHA
Web Browsers used by users to connect to BigFix Inventory must support at
least one of shortlisted algorithm in case of adjusting this list further.
VM Manager Tool version and changes
The VM Manager Tool version that is used with this update is 10.0.7.0.
Scanner version and changes
The scanner version that is used with this update is 9.2.25.1000 for Windows
and 9.2.25.0000 for other platforms. The disconnected scanner version that is
used with this update is 10.0.7.0 and 9.2.25.0 for IBM I.

Application update 10.0.6.1
Table 13. Published site version
Name of component
BigFix Inventory Content

Version

Updated in the release

147

Yes

10.0.6.1

Yes

2638663

Yes

Site
BigFix Inventory Software
Catalog (main version)
BigFix Inventory Software
Catalog (version on end
point)

Table 13. Published site version (continued)
Name of component

Version

Updated in the release

BigFix Inventory Server

10.0.6.0

No

BigFix Inventory Server:

9.2.24.0

No

9.2.24.0

No

9.2.24.1000 (Windows)

No

ILMT Core library
BigFix Inventory Server:
ILMT Catalog
BigFix Inventory Scanner

9.2.24.0000 (other plat
forms)
BigFix Inventory Discon

10.0.6.0

nected Scanner

9.2.24.0 (for IBM I)

BigFix Inventory VM Man

10.0.6.0

No

10.0.6.0

No

No

ager Tool
SAP Metric Data Collector
Included Software Catalog
• New discovery capabilities for:
◦ Adobe
◦ BMC
◦ CA Technologies
◦ Cisco Systems Inc
◦ Citrix
◦ Dell Computer Corporation
◦ Hewlett-Packard
◦ Intel
◦ Microsoft

◦ Oracle
◦ Red Hat
• Several defects fixed.
• This release includes Software Catalog version 10.0.6.1 with capability
to discover more than 320 new software versions. For more information,
please refer to the Catalog Release Notes and the Catalog Change List.
Modified content
The version number of the fixlet is: 10.0.6.1
The following fixlets were updated and should be run to install latest
versions of the specific components:
• Update Software Catalog
Enhancements and important changes
The following table lists enhancements and changes that are introduced in
this update:
Abstract

Description

Oracle Database Client Discovery for version
on Linux

Available since
10.0.6.1

11.2, 12.1, 12.2, 18, 19,
21 on Linux platform
was made.

Red Hat Enterprise Ap Discovery for version
plication Platform ver

4.3 and 7.4 was made,

sion 4.3 and 7.4

older discovery got im
proved and returns a
detailed version.

10.0.6.1

Abstract

Description

New discovery for Ora Discovery for version

Available since
10.0.6.1

cle Database Client on 11.2, 12.1, 12.2, 18, 19,
Linux

21 on Linux platform.

New discovery for Red Discovery for version

10.0.6.1

Hat Enterprise Applica 4.3 and 7.4 was added,
tion Platform version

older discovery got im

4.3 and 7.4

proved and returns a
detailed version.

RED HAT High Avail

Discovery is now

ability Add-On vendor

based on the “Red Hat,

name change

Inc.” package.

New discovery for RED New signatures
HAT AMQ Streams

10.0.6.1

10.0.6.1

for RED HAT AMQ
Streams for 1.0 - 1.8
versions for LINUX
platform.

New discovery for Red New discovery for Red 10.0.6.1
Hat AMQ Interconnect Hat AMQ Interconnect
for Linux, versions: 1.5,
1.6, 1.7, 1.8, 1.9, 1.10.
Improvement of dis

Improvement of dis

covery for BMC Con

covery for BMC Con

trol-M Agent

trol-M Agent for ver

10.0.6.1

sions: 6.0, 6.1, 6.3, 7.0,
8.0, 9.0.
New discovery capa

New discovery based

bility for Adobe CC

on executables

2022

and packages for

10.0.6.1

Abstract

Description

Available since

Adobe CC 2022: Af
ter Effects, Animate,
Dreamweaver, Illustra
tor, InDesign, Photo
Shop, Premiere Pro
New discovery capa

New discovery capa

bility based on tem

bility based template

plate signatures for

signatures for Linux

10.0.6.1

Linux and Windows for and Windows
Vormetric 6
Defect fixes
For the list of known defects please refer to HCL Knowledge Base.
The following table lists APARs and other defects that are fixed in this update:
ID

Symptoms

Behavior after

Available since

you install the
update
BI-6247

Discovery for

Discovery now

Microsoft Vi

is based on the

sio Profession

registry key,

al and Stan

what prevent

dard 2019 were

lack of detec

based on pack

tion.

age. After the Vi
sio update pack
age name was
changed and
discovery didn't
work properly.

10.0.6.1

BI-6838

There were two

Now there is no

Sophos End

signature with

point Defense

the name of the

signatures in

Sophos End

the catalog that

point Defense

should be un

component.

10.0.6.1

der Sophos End
point compo
nent and not un
der Sophos End
point Defense.
BI-7293

Discovery of

Discovery is

SAS Data Inte

based on differ

gration Studio

ent file which

was based on

contains proper

checking if dis

version of SAS

10.0.6.1

tudio.exe file ex Data Integration
ists. Problem

Studio.

occurs when
new update is in
stalled and soft
ware manufac
ture is not up
dating installa
tion path.
KB0094183

TOAD for Ora

Discovery was

cle catalog mis

fixed by taking

matches caused version from
by template sig

the executable

nature taking

instead of the

version from

package. Al

10.0.6.1

the package in

so some com

stead of the exe ponents were
cutable

deleted to im
prove detection
provided by the
template com
ponent.

BI-7812

Detection of

Now discovery

the BMC Con

is based on in

trol-M Server 9.0 stalled-version
was based on

s.txt file which

the folder name

contains version

which can be

information.

changed and
lead to false
positives or lack
of detection.
BI-6415

Wrong platforms Platforms were
for two compo

10.0.6.1

corrected.

nents caused
warnings in the
logs.
BI-6247

Discovery for

Signatures were

Microsoft Vi

updated to use

sio Profession

Visio configura

al and Stan

tion data.

dard 2019 were
based on pack
age. After the Vi
sio update pack
age name was

10.0.6.1

changed and
discovery didn't
work properly.
BI-6838

There were two

Now there is no

Sophos End

signature with

point Defense

the name of the

signatures in

Sophos End

the catalog that

point Defence

should be un

component.

10.0.6.1

der Sophos End
point compo
nent and not un
der Sophos End
point Defense.
BI-7293

Discovery of

Discovery is

SAS Data Inte

based on differ

gration Studio

ent file which

was based on

contains proper

checking if dis

version of SAS

10.0.6.1

tudio.exe file ex Data Integration
ists. Problem

Studio.

occurs when
new update is in
stalled, and soft
ware manufac
ture is not up
dating installa
tion path.
KB0094183

TOAD for Ora

Discovery was

cle catalog mis

fixed by taking

matches caused version from

10.0.6.1

by template sig

the executable

nature taking

instead of the

version from

package. Al

the package in

so, some com

stead of the exe ponents were
cutable

deleted to im
prove detection
provided by the
template com
ponent.

BI-7812

Detection of

Now discovery

the BMC Con

is based on in

10.0.6.1

trol-M Server 9.0 stalled-version
was based on

s.txt file which

the folder name

contains version

which can be

information.

changed and
lead to false
positives or lack
of detection.
BI-6415

Too wide oper

Operating sys

ating system

tem designation

designation in

in signatures

two signatures

were corrected.

caused warn
ings in Com
mon Invento
ry Toolkit logs
on some BigFix
endpoints.

10.0.6.1

KB0094212

HP Insight Diag

HP Insight Diag

nostics Online

nostics Online

Edition for Win

Edition for Win

dows discovery

dows and HP In

was based on a

sight Diagnos

certain registry

tics discovery

key that was

was improved.

10.0.6.1

found in differ
ent software on
customer envi
ronment causing
false discovery

Application update 10.0.6
Table 14. Published site version
Name of component
BigFix Inventory Content

Version

Updated in the release

145

Yes

10.0.6.0

Yes

2638648

Yes

BigFix Inventory Server

10.0.6.0

Yes

BigFix Inventory Server:

9.2.24.0

Yes

9.2.24.0

Yes

Site
BigFix Inventory Software
Catalog (main version)
BigFix Inventory Software
Catalog (version on end
point)

ILMT Core library
BigFix Inventory Server:
ILMT Catalog

Table 14. Published site version (continued)
Name of component
BigFix Inventory Scanner

Version
9.2.24.1000 (Windows)

Updated in the release
Yes

9.2.24.0000 (other plat
forms)
BigFix Inventory Discon

10.0.6.0

nected Scanner

9.2.24.0 (for IBM I)

BigFix Inventory VM Man

10.0.6.0

Yes

10.0.6.0

Yes

Yes

ager Tool
SAP Metric Data Collector
Allowed upgrade path
Minimal version recommended for direct upgrade path: 9.2.16
For version older than 9.2.16 upgrade first to 10.0.2 through available fixlet.
Changes to contract management
We continue bringing better contract management experience to our clients.
In this release there are several improvements implemented as well as some
defects fixed. Including adding ability to create or update contract through
Rest API and through CSV file import. There is also a new feature allowing to
migrate old contracts to new improved contract management and support for
ELA (Enterprise License Agreement). The old contract management has been
disabled starting this release.
Changes to shared disks scan configuration
We continue bringing better contract management experience to our clients.
In this release there are several improvements implemented as well as some
defects fixed. Including adding ability to create or update contract through
Rest API and through CSV file import. There is also a new feature allowing to
migrate old contracts to new improved contract management and support for

ELA (Enterprise License Agreement). The old contract management has been
disabled starting this release.
Changes to shared disks scan configuration
A mechanism has been added to prevent the misuse of Initiate Software Scan
on Shared Disk using the Console.
BigFix Inventory since 9.2.12 version provides automation to manage the
status of computers and scans. It is recommended to use this capability
where Initiate Software Scan on Shared Disk is managed by BigFix Inventory.
Furthermore, ‘.snapshot’ directory has been added to the default exclusion list
for new installations. This directory is special directory on some share disks
that should be not scanned as contains time-based copies of the disk.
Included Software Catalog
This release includes Software Catalog version 10.0.6.0 with capability to
discover around 500 new software versions.
For more information, please refer to:
• Catalog Release Notes: Release Notes for BFI Catalog Content
• Catalog Change List: BFI_catalog_changelist_2021_09
Modified content
The version number of the fixlet is: 10.0.6.0
The following fixlets were updated and should be run to install latest versions
of the specific components:
• Upgrade to the latest version of BigFix Inventory
• Upgrade to the interim version 10.0.2 of BigFix Inventory if version older
than 9.2.14
• Software Catalog Update (if BFI not upgraded)
• Install or Upgrade Scanner
• Install or Upgrade Scanner in private mode on Windows

• Install SAP Metric Data Collector
• Update SAP Metric Data Collector
• Install VM Manager Tool
• Update VM Manager Tool
• Install Additional VM Manager Tool (OPTIONAL)
• Download the Disconnected Scanner Package for IBM I
• Download the Disconnected Scanner Package
• Download BigFix Inventory (10.0.6.0)
The following fixlets were updated and require that actions created by their
previous versions are stopped and then started by using the updated fixlets.
Restarting actions is necessary to ensure that new features work properly:
• Initiate Software Scan on Shared Disks
• Collect Detailed Hardware Information
• Get Microsoft Exchange Edition
• Initiate Collection of SAP Metric Data
• Initiate Software Scan
• Run Capacity Scan and Upload Results
• Upload Software Scan Results
• Get Oracle Concurrent Sessions Number
• Get Oracle Features
The following fixlets were added or updated but it does not require any
additional action:
• Identify Computers on Public Clouds
• Interrupt BigFix Inventory Software Scans
Enhancements and important changes
For a list of enhancements introduce in this release, see: What's New.
Defect fixes and enhancements
For the list of known defects please refer to HCL Knowledge Base.

The following table lists APARs and other defects that are fixed in this update.
Behavior af
ID

Symptoms

ter you install

Available since

the update
Server updates
KB0091385

There is no

The issue is

10.0.6.0

translation in the fixed.
Connection Test
Status column
when export
ing table from
Management ->
VM Managers to
CSV or PDF.
KB0092554

Upgrade to Big

The issue is

Fix Inventory

fixed. Moreover,

10.0.5 fails if

the case when

the "All Comput

license usage

ers" group has

calculations are

license usage

disabled after

10.0.6.0

calculations dis upgrade is also
abled

correctly han
dled.

KB0092588

Truststore lo

The issue

cation and

is caused

password pa

by disabled

rameters re

JavaScript, no-

quirements are

script error mes

wrongly dis

sage displayed.

played (in case

JavaScript must

10.0.6.0

Behavior af
ID

Symptoms

ter you install

Available since

the update
JavaScript dis

be enabled on

abled) in Inter

IE settings as a

net Explorer but

workaround of

not in Chrome

the defect.

on database cre
ation and config
uration phase.
KB0092812

Data Pruning -

Data Pruning

all records are

is split and

erased at once

committed in

instead of done

chunks.

10.0.6.0

in chunks.
This is causing
huge transaction
logs and long
execution time.
IJ31178

SLM tag files

Reporting was

might be report

corrected.

10.0.6.0

ed as correct
files by data im
port despite con
taining issues
preventing their
successful pro
cessing.
KB0092546

Some details of

Conditions on

Extended Hard

which REST API
endpoints da

10.0.6.0

Behavior af
ID

Symptoms

ter you install

Available since

the update
ware REST API

ta are prepared

are not working

were updat
ed. Now they
are looser and
are prepared in
proper place in
application ini
tialization.

KB0093047

False detection

Duplicated

on duplicated

UUIDs detection

UUID on AIX

is corrected af

10.0.6.0

ter the first im
port after up
grade.
BI-6875

Upgrade failing

There is possi

when MS SQL

ble to upgrade

database user

when current

have no privi

permission of

10.0.6.0

leged to manage database user is
MS SQL Agent

not allowing to

Jobs

create / update
MS SQL Agent
jobs.

BI-7106

EOS Import hit

There was con

predefined in

straint during

past dates re

EOS dates im

striction - 2001

port relative to
current date.

10.0.6.0

Behavior af
ID

Symptoms

ter you install

Available since

the update
is already 20

This leads to

years ago

rejecting EOS
more then
20 years ago
(WARN: End of
support date out
of scope: ).
Now the allow
dates are fixed
to range in years
from 1990 to
2100

BI-6283

In some time

The issue is

zones after se

fixed.

10.0.6.0

lecting a date in
New/Edit Con
tract dialog the
date changes
to one day be
fore the selected
date.
BI-6946

Cannot show a

The issue is

list of contracts

fixed.

in All Contracts
panel when any
contract is as
signed to a com
puter group

10.0.6.0

Behavior af
ID

Symptoms

ter you install

Available since

the update
which was creat
ed after last suc
cessful data im
port.
BI-6797

Cannot deter

The issue is

mine hierarchy

fixed. A hori

of deeply nest

zontal scroll bar

ed computer

appears when

groups in Add/

there is any long

Edit Contract di

or deeply nested

alog because

computer group

long and deeply

in the comput

nested comput

er group drop

er group names

down.

10.0.6.0

are trimmed.
BI-6790

Software pick

The issue is

er in Add/Edit

fixed. A horizon

Contract dialog

tal scroll bar ap

trims long soft

pears when a

ware names in

software name

the search re

exceeds width

sult list without

of the software

10.0.6.0

possibility to see search result
whole software

list.

name.
BI-6793

User cannot un

This issue is

set the metric

fixed. Now when

on edit contract

metric is already

10.0.6.0

Behavior af
ID

Symptoms

ter you install

Available since

the update
modal dialog.

chosen new op

The only option

tion is shown

is to set differ

in metric drop

ent one.

down, <not set>
which allows to
clear/unset met
ric selection.

BI-6794

Cannot set neg

This issue is

ative number in

fixed. User can

a custom field

type minus in

on edit contract

front of number

modal dialog.

on integer and

10.0.6.0

float custom
fields.
BI-5883

0 values in CSV

The issue is

and PDF Usage

fixed by display

10.0.6.0

per Computer re ing empty value
ports when there instead of 0.
is no usage
BI-6499

All Con

The issue has

10.0.6.0

tracts/Purchase fixed by activat
Orders - 'Delete'

ing JQuery ele

button doesn't

ments on React

get enabled as

state change

expected
BI-5903

Cannot assign

The issue is

a component in fixed.

10.0.6.0

Behavior af
ID

Symptoms

ter you install

Available since

the update
stance to a prod
uct via public
API
BI-6350

Re-import stuck

The issue is

for hours in

fixed

10.0.6.0

ILMT Core 'IB
MAggregation
Handler' in 'Pre
InventoryMove
DataStep'
BI-5905

BigFix Inven

Added Trou

tory: Create a

bleshooting

fixlet that would

fixlet

search for and
terminate all

10.0.6.0

114 Interrupt

BigFix Inventory
running scan ac Software Scans
tions
to interrupt
scans (back
ground parts)
BI-5906

Add warning

Protection

pop up to share

against uninten

drive scan fixlet

tional scanning

if possible

of all mounted

10.0.6.0

share disks
KB0092644

Multicloud sup

The issue is

port blocks the

fixed

10.0.6.0

Behavior af
ID

Symptoms

ter you install

Available since

the update
Central VM Man
ager capabilities
KB0093108

Installation fails

Achieved via Ja 10.0.6.0

at "Changing de va upgrade to
fault keystore

8.0.6.35

password"
Scanner updates
IJ32101

Some Intel

The problem

Hexa-core

does not occur.

10.0.6.0

CPUs, such
as i5-8600T,
i5-8500, and
i7-8850H are
assigned 100
PVUs, despite
all i3, i5, i7 CPUs
being worth 70
PVUs.
IJ31903

Not enough in

An appropri

formation is pro ate warning is
vided in case

added in the

when the scan

scanner and the

ner does not

server data im

have sufficient

port log.

rights to collect
all required hard
ware informa

10.0.6.0

Behavior af
ID

Symptoms

ter you install

Available since

the update
tion from the So
laris systems.
199195

The scanner dis The problem
covers only 4

10.0.6.0

does not occur.

cores per chip
on SPARC T5-2.
199011

Installation of

The problem

the disconnect

does not occur.

10.0.6.0

ed scanner fails
on Windows
with following
error.
Initial hard
ware scan
failed with error
-1073740940
Content updates
KB0093463

Software Cata

Software Cat

log Update fixlet alog Updates
breaks freshly

not longer con

upgraded BFI in duct additional
stance leading

cleanup actions,

to database cor only place the
ruption

new catalog.
Catalog updates

10.0.6.0

Behavior af
ID

Symptoms

ter you install

Available since

the update
KB0092760

The Citrix Store

Duplicated com 10.0.6.0

front 1811.0 sig ponents for Cit
nature inaccu

rix StoreFront

rately matches

with worse qual

to the configu

ity were delet

rationzipmanag ed. Components
er.exe file. There which provide
are duplicate

better discovery

components for

were left in the

the Citrix Store

Catalog.

Front.
KB0092323

The BEA Web

BEA WebLog

Logic Server

ic Server dis

discovery was

coveries (from

catching false

8.1 up to 10.0)

positives due to

were improved.

incorrect filter.

The filter doesn’t

10.0.6.0

use * anymore
but more exact
wording so only
the correct soft
ware gets dis
covered.
BI-6619

Discovery of Or

Oracle WebLog

acle WebLogic

ic Server discov

Server only de

eries (12.1.* and

tect standard in 12.2.*) were im
stallations

proved and they

10.0.6.0

Behavior af
ID

Symptoms

ter you install

Available since

the update
currently distin
guish between
different instal
lation media
BI-6329

Oracle WebLog

Discovery of the 10.0.6.0

ic Server Enter

Oracle WebLog

prise Edition dis ic Server Enter
coveries caused prise Edition for
an error in cus

versions 10.3,

tomer citlog.xml 12.1, 12.2 was
file

improved and
doesn’t cause
any errors in the
citlog.xml file.

BI-6693

Component

Platform for

for Magic ISO

the component

Maker 5.3. had

was set to “WIN

platform set to

DOWS”.

10.0.6.0

"ANY" instead
of "Windows"
which caused
warnings in the
logs.
KB0093614

Detection of

Now discov

the BMC Con

ery is based on

trol-M Agent 9.0

CONFIG.dat file

was based on

which contains

the folder name

10.0.6.0

Behavior af
ID

Symptoms

ter you install

Available since

the update
which can be

version informa

changed and

tion.

lead to false
positives or lack
of detection.
KB0093294

Discovery for

Fixed discovery

Oracle Data

capability of Or

10.0.6.0

base 19c doesn't acle Database
work correctly

18c , 19c and
21c to support
both software
with updates in
stalled and with
out them.

Document updates
BI-5922

Updated the

What's New

10.0.6.0

document about System Require
support for Hy
ments
per-V, Red Hat
Virtualization,
Citrix Hypervi
sor 8.x, VMware
vSphere Hyper
visor ESXi , and
Fujitsu.
BI-7050

Added a dupli
cate link Dupli

Duplicate UUID

10.0.6.0

Behavior af
ID

Symptoms

ter you install

Available since

the update
cate UUIDs prob
lem along with
the existing link,
Duplicate UUIDs
problem so that
users can ac
cess both, the
application and
their bookmark
(if they have
done so).
BI-6715

Added informa

Database index

tion about BFI

rebuilding

10.0.6.0

reindexing job
to be running
for version be
low 10.0.4. Al
so, added links
to configure and
start SQL Server
Agents for refer
ence.
BI-5977

Updated the

Discovering

document for:

software on
shared disks

• Add infor
mation for
analysis

10.0.6.0

Behavior af
ID

Symptoms

ter you install

Available since

the update
and warn
ings asso
ciated with
the task
when run
sub-opti
mally
• Config
ure NAS
shared
drives
through
exclusion
• Remind
the user
to send
in UTC or
otherwise
take into
account
the sys
tem clock
on the
endpoint
when
sending
actions
BI-7040

Removed an

Coexistence of

empty URL as

BigFix Invento

10.0.6.0

Behavior af
ID

Symptoms

ter you install

Available since

the update
the same was

ry and License

not required and Metric Tool in
was a repetition. the same infra
structure
KB0093153

Removed an

Coexistence of

empty URL as

BigFix Invento

the same was

ry and License

10.0.6.0

not required and Metric Tool in
was a repetition. the same infra
structure
KB0091963

Replaced the

Other IBM met

incorrect IBM

rics

10.0.6.0

link with the cor
rect one that in
cludes a list of
all products that
deliver .slmtag
files.
VM Manager Tool version and changes
The VM Manager Tool version that is used with this update is 10.0.6.0.
Scanner version and changes
The scanner version that is used with this update is 9.2.24.1000 for Windows
and 9.2.24.0000 for other platforms. The disconnected scanner version that is
used with this update is 10.0.6.0 and 9.2.24.0 for IBM I.

Application update 10.0.5.1
Table 15. Published site version
Name of component
BigFix Inventory Content

Version

Updated in the release

144

Yes

10.0.5.1

Yes

2638638

Yes

BigFix Inventory Server

10.0.5.0

No

BigFix Inventory Server:

9.2.23

No

9.2.23

No

9.2.23.1000 (Windows)

No

9.2.23.0000 (other plat

No

Site
BigFix Inventory Software
Catalog (main version)
BigFix Inventory Software
Catalog (version on end
point)

ILMT Core library
BigFix Inventory Server:
ILMT Catalog
BigFix Inventory Scanner

forms)
BigFix Inventory Discon

10.0.5.0

nected Scanner

9.2.23.0 (for IBM I)

BigFix Inventory VM Man

10.0.5.0

No

10.0.5.0

No

No

ager Tool
SAP Metric Data Collector
Included software catalog

• New discovery capability for:
◦ Adobe
◦ Autodesk
◦ Citrix
◦ JetBrains
◦ McAfee
◦ Microsoft
◦ MongoDB
◦ Oracle
◦ Veritas
◦ VMware
• Defect fixes and client ideas implemented.
• Software Catalog version 10.0.5.1 with capability to discover more than
270 new software components.
For more information, refer to:
Catalog Release Notes: https://software.bigfix.com/download/
tema/catalog/BFI_catalog_release_notes.pdf Catalog Change List:
https://software.bigfix.com/download/tema/catalog/changelist/
BFI_catalog_changelist_2021_08.pdf
Modified content
The version number of the fixlet is: 10.0.5.1
The following fixlets were updated and should be run to install latest
versions of the specific components:
• Update Software Catalog
• Initiate Software Scan
Enhancements and important changes
The following table lists enhancements and changes that are introduced in
this update:

Abstract

Description

Improved signature

Signatures for Oracle

discovery for Oracle

Database and Oracle

Database and Oracle

Database Client ver

Database Client ver

sions 18, 19 and 21

sions 18, 19 and 21

were improved and

Available since
10.0.5.1

the product patch lev
el will be available in
BigFix Inventory as De
tailed Version. Due to
this change, after im
porting software cata
log 10.0.5.1 the previ
ous discovery of these
products in versions
18 and above may dis
appear until a next
software scan is com
pleted on BigFix end
points
Improved discovery of

Added discovery for

Oracle Clusterware

releases 11.2, 12.1

10.0.5.1

and 19.0
Improved discovery for Signature for releases
Oracle Essebase

11.1 w changed and
signatures for versions
11.2, 19.3, 21.1, 21.2
were added for Win
dows and Linux plat
forms.

10.0.5.1

Abstract

Description

Improved discovery for Signatures for releas
Database Gateway for

es 11.1 and 12.1 were

Microsoft SQL Server

changed and addition

Available since
10.0.5.1

ally a signature for
12.2 was added.
Client ideas
The following client ideas were implemented:
ID
BFINV-I-148

Description
Expand and improve

Available since
10.0.5.1

Discovery Support for
MongoDB products:
MongoDB Community
Server, MongoDB En
terprise Server, Mon
goDB Compass, Mon
goDB Ops Manager,
MongoDB Kafka Con
nector, MongoDB BI
Connector
BI-5862

Added signatures for

10.0.5.1

versions 16.4 and 16.7
for Linux and Win
dows.
Defect fixes and enhancements
For the list of known defects please refer to HCL Knowledge Base.
The following table lists APARs and other defects that are fixed in this update.

Behavior af
ID

Symptoms

ter you install

Available since

the update
Catalog updates
KB0092040

PostgreSQL dis

Changed sig

covery capabil

nature compo

ity which uses

nents of discov

File Version dif

ery capability for

ferent from the

versions: 10.0,

component ver

10.1, 10.3, 10.4,

sion need to be

10.5, 10.6, 10.9,

changed to use

11.3, 12.1, 12.4

file size.

so they now use

10.0.5.1

file size which
solves this issue
KB0091156

NetBackup pub

NetBackup

lisher for ver

publisher was

sion 8.0 and

changed from

10.0.5.1

above should be “Symantec” to
changed to Veri “Veritas” for
tas.

components
with version 8
and above.

KB0087826

Discovered Ess

Signature for

base Server ver

version 11.3

sion does not

was deleted.

10.0.5.1

exist.
KB0091939

Signatures for

Apache Web

Apache Web

Server com

Server are de

ponent was

10.0.5.1

Behavior af
ID

Symptoms

ter you install

Available since

the update
livering false

merged to

discovery due

Apache HTTP

to duplicated

Server – one

signatures with

signature for

Apache HTTP

version 2.0 on

Server.

Windows was
moved, the rest
were deleted.

KB0091078

KB0091349

KB0092098

Lack of discov

Fixed signature

ery for Oracle

deliver correct

Database 18c

discovery.

Oracle Data

Fixed signature

base Client can

is using different

be installed in

file for version

a different fold

extraction deliv

er than existing

ering correct dis

signatures.

covery.

Oracle Database Signatures for
Gateway for

release 11.2

Microsoft SQL

were changed.

10.0.5.1

10.0.5.1

10.0.5.1

Server 11.2 re
ports wrong ver
sion
KB0092650

Installshield Iss Discovery ca
cript signature

pability was

v.11.5 should

fixed for version

be remapped

11.50 to show

10.0.5.1

Behavior af
ID

Symptoms

ter you install

Available since

the update
to InstallShield

InstallShield

Scripting Engine Software Corpo
v.11.50

ration publish
er instead Roxio
Inc.

BI-6584

Missing link to

Added the link to 10.0.5.1

IBM limitations

IBM limitations

concerning Big

at Limitations

Fix Inventory

section in BigFix
Inventory Docu
mentation
Link: Limitations

BI-6375

Incorrect SLM

Customers who

tag generated

use fixlet ‘Ini

for Adobe Muse

tiate Software

CC by Initiate

Scan’ in version

Software Scan

10.0.5.0 may ob

fixlet in version

serve incorrect

10.0.5.0

license calcula
tion for Adobe
Muse CC. In
such case up
date fixlet to ver
sion 10.0.5.1
or above is re
quired.

10.0.5.1

Application update 10.0.5
Table 16. Published site version
Name of component
BigFix Inventory Content

Version

Updated in the release

143

Yes

10.0.5.0

Yes

2638622

Yes

BigFix Inventory Server

10.0.5.0

Yes

BigFix Inventory Server:

9.2.23

Yes

9.2.23

Yes

Site
BigFix Inventory Software
Catalog (main version)
BigFix Inventory Software
Catalog (version on end
point)

ILMT Core library
BigFix Inventory Server:
ILMT Catalog
BigFix Inventory Scanner

9.2.23.1000 (Windows
9.2.23.0000 (other plat
forms)

BigFix Inventory Discon

10.0.5.0

nected Scanner

9.2.23.0 (for IBM I)

BigFix Inventory VM Man

10.0.5.0

Yes

10.0.5.0

Yes

Yes

ager Tool
SAP Metric Data Collector
Changes to TLS support

After upgrading to version 10.0.5, TLS 1 and TLS 1.1 are disabled and do not
work. Only TLS 1.2 is supported. Therefore, customers may notice connection
issues to database and hypervisors from VM Tool.
To mitigate problem on MS SQL, please install appropriate Software Pack /
Content Update for Microsoft SQL Server database (Software requirements).
To migrate problem on VMware ESXi upgrade to VMware ESXi 6.0 Update 3
(Detailed system requirements).
Changes to contract management
Contract can now be defined for product and any metric in new AllContracts
report. This report is available from Reports menu and from new Contracts
section in main dashboard. This upgrade includes the capability to define
contracts manually. API for integration and automation will be available
shortly.
Custom metrics management is available in both Products & Metrics and All
Contracts reports. New custom metrics can be added, modified, assigned to
products, used in new contracts definition, software bundling and as filtering
option. Product Metric per Group is new report with supporting data for
contracts but also offers more reporting capability. With new Product Metric
per Group report, it is now possible to see product metric calculation per
computer group in one view. For optimal performance in current version, this
report supports by default up to 20 computer groups Even if more computer
groups are defined, the additional reports are not listed.
All panels related to previous contract management functionality are marked
as deprecated and will be hidden by default in the future BigFix Inventory
release with option to enable them back.
For more information refer to user documentation.
Support for BigFix platform Server Based Computer Groups
BigFix 10.0.4 introduced Server Based Computer Groups which require
dedicated support. If BigFix Inventory import was already run with
previous version of BigFix Inventory (lower than 10.0.5) then there is a

need to resynchronize computer group definition, for details please see
documentation.
Included software catalog
This release includes Software Catalog version 10.0.5.0 with capability to
discover around 360 new software versions.
For more information, please refer to:
• Catalog Release Notes: https://software.bigfix.com/download/tema/
catalog/BFI_catalog_release_notes.pdf.
• Catalog Change List: https://software.bigfix.com/download/tema/
catalog/changelist/BFI_catalog_changelist_2021_07.pdf .
Modified content
The version number of the fixlets is 10.0.5.0.
The following fixlets were updated and will no longer use zip/unzip in order
to pack/unpack files, but 7zip on Windows:
• Scanner
◦ Install or upgrade scanner
◦ Install or upgrade scanner in private mode on Windows
◦ Initiate software scan
◦ Upload software scan results
◦ Force re-uploading of software scan results
◦ Run capacity scan and upload results
• VM Manager
◦ Install VM Manager tool
◦ Install additional VM Manager tool
◦ Update VM Manager tool to version
◦ Force VM Manager tool scan results upload
◦ Schedule VM Manager tool scan results upload
• Troubleshooting

◦ Collect logs from endpoints
◦ Edit Scanner Trace Settings
• BigFix Inventory update
◦ Upgrade to the latest version of BigFix Inventory
◦ Upgrade to the interim version 10.0.2.0 of BigFix Inventory if
version older than 9.2.14
◦ Download the Disconnected Scanner Package
◦ Download the Disconnected Scanner Package for IBM i
◦ Software Catalog Update
• Other
◦ Install SAP Metric Data Collector
◦ Update SAP Metric Data Collector
◦ Identify Computers on Public Clouds
◦ Get Oracle Concurrent Sessions Number
◦ Get Oracle Features
◦ Test CIT signature
Enhancements and important changes
For a list of enhancements introduce in this release, see: What's new
Defect fixes and enhancements
For the list of known defects please refer to HCL Knowledge Base.
The following table lists APARs and other defects that are fixed in this update.
Behavior
ID

Symptoms

after you

Avail

install the

able since

update
Server updates
KB0088181On Windows systems, when

This has

Scanner trace log level is set

been re

to MAX, wscansw.exe Catalog

solved and

10.0.5.0

Behavior
ID

Symptoms

after you

Avail

install the

able since

update
Based Scan step significant

duration or

ly increases it's duration also

CPU usage

causing high CPU usage.

do not oc
curoccur
any more
anymore.

KB0089750Shared Disk import fails with
ERROR: LMT ETL step failed,

The issue is 10.0.5.0
fixed.

Value is too long.
KB0089733BFI cannot connect to LDAP/
LDAPS.

The issue

10.0.5.0

is fixed. If
the problem
persists af
ter upgrade,
refer to doc
umentation

KB0089710Issue with the branches cause
that Oracle discovery based on

The issue is 10.0.5.0
fixed.

ISO is not reported.
KB0091200Schema update fails on drop

The issue

ping DBO.SAM_FILE_FACTS_

is fixed, and

SCD_SCAN_FILE_ID_INDEX

schema up
date works
properly.

10.0.5.0

Behavior
ID

Symptoms

after you

Avail

install the

able since

update
KB0091029OutOfMemory exception dur
ing File Facts import. Import is

The issue is 10.0.5.0
fixed.

hanging.
KB0090178Performance fix on Inventory

Optimized

Builder: Discovered Software

algorithm to

Details

overcome

10.0.5.0

bad execu
tion plans
on MS SQL
KB0089730BigFix Inventory 10.0.4.0
schema update is failing

Defect fixed 10.0.5.0
and the up
date is not
failing

KB0090975BigFix Inventory SQL temadb

Job defi

maintenance job is failing on

nition has

MS SQL with SQL_Latin1_Gen

been adjust

eral_CP1_CS_AS collation is set ed to work
on the MS SQL instance

on case sen
sitive envi
ronments.
Jobs has
been also
split into
two tasks:
Check the
BFI Import
and Reorga

10.0.5.0

Behavior
ID

Symptoms

after you

Avail

install the

able since

update
nize all in
dexes
KB0091207"Has Usage" values in the in the The issue

10.0.5.0

Usage per Computer panel were is fixed for
set incorrectly to "No" in some

new and up

cases. Moreover, CSV and PDF

dated sys

report files exported in the pan

tems.

el were missing usage details
for records with the "Has Us
age" value set to "No".
KB0091264BFI server upgrade issue

The fix is

from V.9.2.11 to v10.0.2 when

included

executing migration script

in BigFix

1526296744_jupiter_fix_prod_

Invento

inv_apar_ij06399.rb

ry 10.0.5,

10.0.5.0

however,
HCL support
should be
contacted to
get a hotfix
for BigFix In
ventory ver
sion 10.0.2.
KB0090734Import fails with duplicate

Adjusted

key error after upgrade to BFI

population

v10.0.4

of the dictio
nary, as well

10.0.5.0

Behavior
ID

Symptoms

after you

Avail

install the

able since

update
as trimming
the data af
ter gather
ing.
Server now
supports
versions
with the
trailing
spaces.
KB0090014Import fails with duplicate

Adjusted the 10.0.5.0

key error after upgrade to BFI

checksum

v10.0.4

calculation
for the ver
sion text.
The server
will now cal
culate prop
er check
sum for the
‘0.0’ version

KB0091465Outdated VM Manager Status

Incorrect

for non VM Manager managed

condition

endpoints

for highlight
ing results
as outdat
ed adjust

10.0.5.0

Behavior
ID

Symptoms

after you

Avail

install the

able since

update
ed to ex
clude phys
ical/bare
metal end
point.
KB0091337Solaris x86 Partition Cores not

Due to

updated after upgrading to

changes in

10.0.2

underlying

10.0.5.0

Solaris x86
processing,
information
shown on UI
was not up
dated.
Information
is updated
after first
data import.
PVU / RVU
MAPC cal
culation
was not af
fected.
KB0091089Delete false end of support date End of
for HCL products

supports
dates set
by IBM to

10.0.5.0

Behavior
ID

Symptoms

after you

Avail

install the

able since

update
2019-07-01
for HCL
products
were delet
ed since
support is
continued
by HCL now.
In BigFix
Inventory
lower than
v10.0.5 and
IBM License
Metric Tool
those dates
are still set.
For details
see Interpret
EOS dates.
BI-3828

BFI is starting for a long time

Database

(30 minutes or more), nothing

connec

shown on UI. Occurs when ap

tion han

plication is not able to connect

dling was

to database.

improved.
Proper mes
sages ap
pear when
connection

10.0.5.0

Behavior
ID

Symptoms

after you

Avail

install the

able since

update
to database
is lost. Reconnecting
was also im
proved.
BI-5125

During Install Path update step

This issue

of inventory builder (adding ISV

is fixed, and

paths) - instance and bundling

tags are up

tags updated improperly on

dated prop

shared instances, such as,

erly.

10.0.5.0

shared instances have tags
from original instances.
BI-5202

After adding a new metric to a

The issue is 10.0.5.0

product, Install Seats metric is

fixed.

removed from this product after When there
the next data import.
is first im
port after
BigFix In
ventory up
grade, miss
ing metrics
will be re
stored.
BI-4601

Registered Users metric ag

Perfor

gregation performance is very

mance of

slow.

Registered
Users and

10.0.5.0

Behavior
ID

Symptoms

after you

Avail

install the

able since

update
other met
rics aggre
gation is im
proved. Ag
gregation
calculation
uses now
all logical
CPUs by de
fault.
BI-4728

VMManager Upgrade was be

VMManag

having different in non-win

er action

10.0.5.0

dows when Copy folder was not for non-win
present

dows is now
in-line with
windows.

BI-5168

When Upgrade was triggered,

During

if there were no necessary per

upgrade,

missions for the re-indexing job checks were
then there was an error without

added to

sufficient information

validate
DB owner
and edition
of DB and
necessary
warnings/

10.0.5.0

Behavior
ID

Symptoms

after you

Avail

install the

able since

update
information
is displayed.
IJ30106

When a new connection to Or

The issue

acle VM Server is defined in Li

does not oc

cense Metric Tool, status of all

cur.

10.0.5.0

existing Hyper-V connections
changes to Invalid Credentials.
198690

An unexpected error might oc

The issue

cur when SSO is configured

does not oc

without properly configured

cur.

10.0.5.0

Webseal Reverse Proxy.
198541

When FIPS compliance is en

The issue is 10.0.5.0

abled and server is upgraded, it

fixed.

is not possible to log in to UI.
198507

The OutOfMemoryError excep

Max heap

10.0.5.0

tion is thrown by the application size has
server.

been in
creased for
default con
figuration.

198503

When the Docker scan is dis

Docker di

abled, the /var/lib/docker folder rectory is
is unnecessarily scanned.

excluded
from scan
when dock

10.0.5.0

Behavior
ID

Symptoms

after you

Avail

install the

able since

update
er scan is
disabled.
198769

When you run the vmman -re

The issue is 10.0.5.0

trievedebugdata command, the

fixed.

connection fails with the follow
ing status: Invalid Credentials
- Cannot complete login due to
an incorrect username or pass
word. The problem occurs if the
username or password that is
specified for the VM manager
contains the ampersand (&).
Content updates
KB0089469Run Capacity Scan on Virtual

Updated rel 10.0.5.0

ization Hosts is relevant even

evance to

for endpoint not being hypervi

check if sys

sor host

tem is capa
ble to be a
hypervisor:
module kvm
listed in /
proc/mod
ules
processor
got flag vmx
or svm in /

Behavior
ID

Symptoms

after you

Avail

install the

able since

update
proc/cpuin
fo. As a re
sult, fixlet
is no longer
applicable
for the end
point not
capable to
host.
KB0091295"Get Oracle Features" fixlet plac An option

10.0.5.0

ing the file lmt_bfi_get_script.sh to use tem
always in instance owner's fold porary fold
er

er instead
of Oracle in
stance own
er’s folder is
added.

KB0090976docker host's BESClient instal

The docker

lation is discovered in docker

host’s BES

containers when the host vol

Client instal

ume is visible on docker

lation is not

10.0.5.0

discovered
on docker
KB0087650Software Scan returns with er
ror code 1

Fixed and
the behavior
is no longer
observed

10.0.5.0

Behavior
ID

Symptoms

after you

Avail

install the

able since

update
KB0092316Fixlet "Upgrade to the latest

The issue

version of BigFix Inventory

does not oc

(10.0.5.0)" may fail during the

cur.

execution.
Catalog updates
KB0091403Signature for Sybase Adaptive

The signa

Server Enterprise v11.1 needs

ture was

to be deleted due to false dis

deleted.

10.0.5.0

covery with other products.
KB0091154NetBackup 3.0 signature is
falsely discovering other soft

The CIT op

10.0.5.0

erator was

ware due to wrong CIT operator changed.
The discov
ery is now
valid.
KB0091415Signatures for “Checkpoint

Two signa

SmartConsole” require deletion

tures with

of file version.

incorrect

Only file size should be
checked.

“1.0” version
were modi
fied – check
for the ver
sion was
deleted.

10.0.5.0

Behavior
ID

Symptoms

after you

Avail

install the

able since

update
KB0091284Signatures for “Microsoft .NET

Signatures

Core” v1.1 and v1.0 need to be

for “Mi

deleted.

crosoft .NET

Template signature with version
restriction needs to be updated
for version 1.x

10.0.5.0

Core” v1.1
and v1.0
were delet
ed.
Template
signature
with version
restriction
was updat
ed for ver
sion 1.x

KB0089612Signature for component IBM

The signa

Tivoli Enterprise Console 3.9

ture was

delivers false discovery.

deleted.

KB0089415File confix.xml is used as main

Two signa

discovery point causing exten

tures were

sive file read (long scan time

deleted.

10.0.5.0

10.0.5.0

and CPU utilization).
KB0091120Discovery for Oracle Cluster

Signature

ware reports wrong component for version
version.

10.2 was
fixed. Next

10.0.5.0

Behavior
ID

Symptoms

after you

Avail

install the

able since

update
catalog will
provide new
way of dis
covery for
this soft
ware.
BI-5659

Component name of “Install

Product “In

10.0.5.0

Shield” 11.0 and 11.5 should be stallShield
changed to “InstallShield Script Scripting En
ing Engine”.

gine” was
added.
Component
name was
changed for
the version
and two re
leases.

BI-5954

Signatures for the Adobe Acro

Signatures

bat Reader DC versions 2020,

for the

2021, 2022 are missing.

Adobe Acro
bat Reader
DC versions
2020, 2021,
2022 were
added.

Documentation updates

10.0.5.0

Behavior
ID

Symptoms

after you

Avail

install the

able since

update
KB0089517'Bundling assistant’ still not re

Corrected

ferred as ‘Automated bundling’

the phrase

across the document.

‘Bundling

10.0.5.0

assistant’
across the
document.
After chang
ing ‘Au
tomatic
Bundling’
feature
name to
‘Bundling
Assistant’
not all docu
mentations
pages were
updated.
Doc link:
BFI_10.0
document
KB0090889Document limitation on vulnera Improved
bilities found in BFI

documenta
tion about
elements
impacting
accuracy of

10.0.5.0

Behavior
ID

Symptoms

after you

Avail

install the

able since

update
CVE report
ing in BFI
Doc link:
Checking
common
vulnerabili
ties
KB0089359Issue with VM manager central
ID

Added a

10.0.5.0

note in the
VM Manag
er Installa
tion require
ment sec
tion about
the BES
RootServer.
Doc link:
VM Manag
er Tool in
stallation re
quirements

KB0092166BFI 10.0.3 import after upgrade

Updated the 10.0.5.0

from 10.0.1 taking over 500

document

hours

about per
formance
improve

Behavior
ID

Symptoms

after you

Avail

install the

able since

update
ment of
comput
ers that in
volves us
ing the max
Aggrega
tionThreads
and max
Reaggrega
tionThreads
variables to
control the
number of
CPUs being
used.
Doc link: Ad
vanced serv
er settings
BI-5023

Update the document for UUID,

Updated

Outdated VM Manager Data

the docu

status and correct the informa

ment with

tion about WinRM command

information

and Hyper_v URL.

about:

10.0.5.0

• Trou
bleshoot
ing No

Behavior
ID

Symptoms

after you

Avail

install the

able since

update
VM
Man
ager
data
status
• Cor
rect
ed the
syn
tax of
a Win
RM
com
mand.
• Up
dated
‘Iden
tifying
com
put
ers in
public
clouds’
sec
tion.
• Cor
rect
ed the

Behavior
ID

Symptoms

after you

Avail

install the

able since

update
‘de
fault
port’
used
in con
fig
uring
Win
RM.
Doc links:
• Li
cens
ing
rules
• Identi
fying
com
put
ers in
public
cloud
• Con
fig
uring
Win
RM

Behavior
ID

Symptoms

after you

Avail

install the

able since

update
• Adding
VM
man
agers
in cen
tral
mode
BI-5256

End Of Support Date is not cor

Added the

rect for various Microsoft Prod

informa

ucts

tion that the
End of Sup
port date for
Microsoft
Component
in Software
Compo
nent shows
the ‘extend
ed support
date’ and
not the ‘end
of support
date’. The
date can be
manually
updated.

10.0.5.0

Behavior
ID

Symptoms

after you

Avail

install the

able since

update
Doc link:
Changing
the EOS
BI-6025

Update software requirements

Updated

and SPCR details

‘security
enhance
ments’ in
the what’s
new, new re
quirements
in the soft
ware re
quirements
and sys
tem require
ments.
Doc links:
• What's
new
• Soft
ware
re
quire
ments
• Sys
tem

10.0.5.0

Behavior
ID

Symptoms

after you

Avail

install the

able since

update
re
quire
ments
VM Manager Tool version and changes
The VM Manager Tool version that is used with this update is 10050. Logs per
VM Manager are included in config files for better readability of logs.
Scanner version and changes
The scanner version that is used with this update is 9.2.23.1000 for Windows
and 9.2.23.0000 for other platforms. The disconnected scanner version that is
used with this update is 10.0.5.0 and 9.2.23.0 for IBM I.

Application update 10.0.4.1
Table 17. Published site version
Name of component
BigFix Inventory Content

Version

Updated in the release

140

Yes

10.0.4.1

Yes

2638593

Yes

10.0.4.0

Yes

Site
BigFix Inventory Software
Catalog (main version)
BigFix Inventory Software
Catalog (version on end
point)
BigFix Inventory Server

Table 17. Published site version (continued)
Name of component
BigFix Inventory Server:

Version

Updated in the release

9.2.22

Yes

9.2.22

Yes

9.2.22.1000 (Windows)

Yes

ILMT Core library
BigFix Inventory Server:
ILMT Catalog
BigFix Inventory Scanner

9.2.22.0000 (other plat
forms)
BigFix Inventory Discon

10.0.4.0

Yes

nected Scanner

9.2.22.0 (for IBM I)

BigFix Inventory VM Man

10.0.4.0

Yes

10.0.4.0

Yes

ager Tool
SAP Metric Data Collector
Included software catalog
• New discovery capabilities for:
◦ BMC
◦ CA Technologies
◦ Citrix
◦ Oracle
◦ Red Hat
◦ Veritas
◦ VMware
• Several defect fixes and customer Ideas
• This release includes Software Catalog version 10.0.4.1 with capability
to discover more than 160 software versions.
For more information, refer to:

• Catalog Release Notes: https://software.bigfix.com/download/tema/
catalog/BFI_catalog_release_notes.pdf
• Catalog Change List: https://software.bigfix.com/download/tema/
catalog/changelist/BFI_catalog_changelist_2021_05.pdf
Modified content
• The version included in the fixlet names is: 10.0.4.1
• The software catalog was updated and the catalog fixlet must be run to
install latest versions of the specific components.
Enhancements and important changes
Table 18. Enhancements
Abstract

Description

Available since

New Oracle Java 6 dis Added new signatures 10.0.4.1
covery

for Java 6 based on
package data for UNIX
and Windows plat
form.

Oracle SQL Developer

Implemented Oracle

10.0.4.1

4.1. missing discovery SQL Developer 4.1.
for Unix

signature for UNIX.

SolarWinds TFTP Serv Added new template
er signatures using

10.0.4.1

signature based on

too generic executable package.
name.
McAfee agent signa

Enhanced existing sig 10.0.4.1

tures missing discov

nature for UNIX dis

ery for Unix.

covery.

Defect fixes
For the list of known defects please refer to HCL Knowledge Base.
The following table lists APARs and other defects that are fixed in this update.
Table 19. Defect fixes
ID

Symptoms

Behavior after you

Avail

install the update

able since

Catalog updates
KB0089722

NetBackup from Sy

Change in discov

mantec and Veritas

ery no longer caus

10.0.4.1

signatures were creat es duplication and
ing duplicate discov

duplicate back

ery and double back

slashes in the in

slashes in the installa stallation path.
tion path.
KB0089553

Windows Defender

The existing signa

10.0.4.1

signatures were based tures are replaced
on the wrong exe

with a template sig

cutable name

nature using a cor
rect executable.

KB0089920

KB0089876

Robocopy & Robust

Robocopy signa

File Copy Utility are

tures were deleted

the same component

and product is dis

and separate signa

covered under Ro

tures for them cause

bust File Copy Utili

double discovery

ty.

Sun Calc and Win

Signatures that use 10.0.4.1

dows Calculator sig

generic file names

natures causing mis

were removed.

match

10.0.4.1

Table 19. Defect fixes (continued)
ID
KB0090200

Symptoms

Behavior after you

Avail

install the update

able since

Discovery for Oracle

Change in discov

JDK/SDK 14.0 is mis

ery for Oracle JDK/

matched with Adopt

SDK ensures prop

OpenJDK

er reporting of ven

10.0.4.1

dors and its com
ponents.
KB0090106

Collabnet Subversion

Discovery method

discovery was using

was updatd to file

file version and com

size discovery and

mon file name

the result no longer

10.0.4.1

mismatches with
other components.
KB0089924

SUN Java Support ver Signatures for Ja
sion 5.2 is delivering

va Support that

false discovery based

caused the false-

10.0.4.1

on installation files for positive discovery
IBM DB2 component

were deleted from
the catalog.

Implemented customer ideas
BFINV-I-181

AdoptOpenJDK-JRE 8 (Runtime-Only, no 10.0.4.1
JDK)

BFINV-I-182

AdoptOpenJDK-JRE 9 (Runtime-Only, no 10.0.4.1
JDK)

BFINV-I-183

AdoptOpenJDK-JRE 10 (Runtime-Only,
no JDK)

10.0.4.1

BFINV-I-184

AdoptOpenJDK-JRE 11 (Runtime-Only,

10.0.4.1

no JDK)
BFINV-I-185

AdoptOpenJDK-JRE 12 (Runtime-only,

10.0.4.1

no JDK)
BFINV-I-186

AdoptOpenJDK-JRE 13 (Runtime-Only,

10.0.4.1

no JDK)
BFINV-I-187

AdoptOpenJDK-JRE 14 (Runtime-Only,

10.0.4.1

no JDK)
BFINV-I-188

AdoptOpenJDK-JRE 15 (Runtime-Only,

10.0.4.1

no JDK)

Application update 10.0.4
Table 20. Published site version
Name of component
BigFix Inventory Content

Version

Updated in the release

140

Yes

10.0.4.0

Yes

2638578

Yes

BigFix Inventory Server

10.0.4.0

Yes

BigFix Inventory Server:

9.2.22

Yes

9.2.22

Yes

9.2.22.1000 (Windows)

Yes

Site
BigFix Inventory Software
Catalog (main version)
BigFix Inventory Software
Catalog (version on end
point)

ILMT Core library
BigFix Inventory Server:
ILMT Catalog
BigFix Inventory Scanner

Table 20. Published site version (continued)
Name of component

Version

Updated in the release

9.2.22.0000 (other plat
forms)
BigFix Inventory Discon

10.0.4.0

Yes

nected Scanner

9.2.22.0 (for IBM I)

BigFix Inventory VM Man

10.0.4.0

Yes

10.0.4.0

Yes

ager Tool
SAP Metric Data Collector
Included software catalog
This release includes Software Catalog version 10.0.4.0 containing:
• Added capability to discover 350 software versions.
• Defect fixes
For more information, please refer to:
• Catalog Release Notes: https://software.bigfix.com/download/tema/
catalog/BFI_catalog_release_notes.pdf
• Catalog Change List: https://software.bigfix.com/download/tema/
catalog/changelist/BFI_catalog_changelist_2021_03.pdf
Modified content
The version included in the fixlet names is: 10.0.4.0
The following fixlets were updated and should be run to install latest versions
of the specific components:
• Upgrade to the latest version of BigFix Inventory 10.x
• Software Catalog Update
• Install or Upgrade Scanner

• Install or Upgrade Scanner in private mode on Windows
• Update SAP Metric Data Collector
• Update VM Manager Tool
• Download the Disconnected Scanner Package for IBM I
• Download the Disconnected Scanner Package
The following fixlets were updated and require that actions created by their
previous versions are stopped and then started by using the updated fixlets.
Restarting actions is necessary to ensure that new features work properly:
• Run Capacity Scan and Upload Results (10.0.4.0)
• Initiate Software Scan (10.0.4.0)
• Get Oracle Features (10.0.4.0)
• Get Oracle Concurrent Sessions Number (10.0.4.0)
• Discover Remote Shared Disks (10.0.4.0)
The following fixlets were updated but it does not require any additional action:
• Uninstall Scanner (10.0.4.0)
• Download BigFix Inventory (10.0.40)
• Identify Computers on Public Clouds (10.0.4.0)
• Install Additional VM Manager Tool (OPTIONAL) (10.0.4.0)
• Update VM Manager Tool to version (10.0.4.0)
• Download BigFix Inventory (10.0.34/0)
Enhancements and important changes
For a list of enhancements introduce in this release, see: What's new
Defect fixes and enhancements
For the list of known defects please refer to HCL Knowledge Base.
The following table lists APARs and other defects that are fixed in this update.

Table 21. Defect fixes
Behavior af
ID

Symptoms

ter you install

Available since

the update
Server updates
KB0085297

CIT Upgrade

Install or Up

fails if Alternate

grade Scanner

location is used

fixlet can suc

and BesClient is

cessfully install

10.0.4.0

uninstalled/rein the scanner.
stalled
KB0085082

Data Import:

For the File

10.0.4.0

Getting the scan Facts scan re
results fails

sults operation

when file has

is repeated in

been changed

the new imple

since data im

mentation.

port and is re
quested to fetch
during import
KB0075700

BigFix Inven

There is provid

tory Data Im

ed improved im

ports suddenly

plementation of

increase in time

File Facts im

due to File Facts port significant
ETL step

ly improving the
duration of File
Fact import and
additional pro
tection mech

10.0.4.0

Table 21. Defect fixes (continued)
Behavior af
ID

Symptoms

ter you install

Available since

the update
anism against
overload.
KB0086966

Some AIX sys

The problem

10.0.4.0

tems might have does not occur.
a 'sed' command
that is not han
dling the re
quests to put
line endings. In
stead of a new
line, 'n' charac
ter is placed by
dropping '\' from
'\n', which is ex
pected to be in
terpreted as new
line.
As a result, it
creates invalid
output and it's
neither shown in
the BigFix Con
sole nor import
ed to the BigFix
Inventory.
KB0086020

Improved ac

Removed some

tions perfor

excessive index

10.0.4.0

Table 21. Defect fixes (continued)
Behavior af
ID

Symptoms

ter you install

Available since

the update
mance on file

es and added

scanned data re new indexes re
port

lated to Scanned
File Data.

KB0086349

Add support for

BFI supports

ISO SWID Tag in

software identi

2009 specifica

fication through

10.0.4.0

tion: NetBackup, files which are
Splunk, McAfee

complaint to

and more.

2009 specifica
tion.

KB0087604

Saved Reports

Saved Reports e- 10.0.4.0

do not Automati mail notification
cally Email when works properly.
SSO debug logs
are enabled.
KB0085584

File Facts scan

[Windows on

with issue in

ly] Status code

payload - End

5 is visible be

point side pre

cause of Initiate

vention.

software Scan in
‘Software Scan
status’ analysis
after finishing
the system file

10.0.4.0

Table 21. Defect fixes (continued)
Behavior af
ID

Symptoms

ter you install

Available since

the update
scan with empty
result.
KB0088612

Data Import

There is con

hangs on DB2

firmed DB2 bug

11.5

causing that

10.0.4.0

sporadically
query might
hang. BFI restart
resolves the is
sue. There is
recommend
ed to apply
IT35984 as soon
as would be re
leased by IBM
DB2.
KB0085086

Data Import: Us Files with not
ing the re-sync

matching com

option expose

puter id are dis

issue with get

carded and not

ting the file is

preserved in

no longer there - database avoid
file is tried to be

ing picking them

fetch every im

up again during

port

re-synchroniza
tion.

10.0.4.0

Table 21. Defect fixes (continued)
Behavior af
ID

Symptoms

ter you install

Available since

the update
BI-3899

Empty rows

For 'Recog

are displayed

nized' column,

when filtering

the problem

by 'Recognized',

has been fixed.

'Caused Detec

'Caused Detec

tion' columns

tion' column has

on Package Da

been completely

ta and Scanned

removed, as well

10.0.4.0

File Data reports as related ‘en
able_caused_de
tection’ setting.
Saved reports
which use this
column should
be re-created
manually.
BI-4654

Warning dialog

Stopping and

shows up when

restarting ap

stopping ap

plication using

plication using

Windows ser

Windows ser

vice does not

vice.

trigger any warn

10.0.4

ing popups.
BI-4513

For software_

Suppression

instances v2

works with

API, suppression NULL product
does not work

fields, confirma

10.0.4

Table 21. Defect fixes (continued)
Behavior af
ID

Symptoms

ter you install

Available since

the update
when JSON is

tion is always

submitted with

migrated.

NULL product
fields. Also con
firmation is not
always migrat
ed.
BI-3438

Re-sync option

Re-sync option

does not work

works properly.

10.0.4

for DB2 if com
patibility vec
tor is not set to
MYS.
IJ29172

Software Scan

The issue does

Status Analysis

not occur.

10.0.4

fails when BES
Client.exe and _
BESData folder
are on different
drives.
IJ29179

Part of the hosts The issue does
from the same
cluster may not
be processed
even though the
scan results are

not occur.

10.0.4

Table 21. Defect fixes (continued)
Behavior af
ID

Symptoms

ter you install

Available since

the update
correct (mostly
HYPER-V)
198123

Audit trail for

The issue does

setting and

not occur.

10.0.4

clearing entitle
ments does not
provide informa
tion about the
computer group
for which the op
eration was per
formed
198493

After upgrade

The issue does

on Windows

not occur.

tema.log shows
database errors.
tema]:.[ERROR]
Java::ComMicrosoftSqlserverJdbc::SQLServerException:
Cannot drop
the trigger
'sam.software_facts_-

10.0.4

Table 21. Defect fixes (continued)
Behavior af
ID

Symptoms

ter you install

Available since

the update
persistent_trigger_uuid_discoverable_guid', because
it does not
exist, or you
do not have
permission.:
drop trigger
sam.software_facts_persistent_trigger_uuid_discoverable_guid

Scanner updates
Memory alloca

When perform

tion statistics

ing file system

for 'Out of mem or software
ory' exceptions

scanning the
memory require
ments for the
scanner may
reach defined
limits. To veri
fy these limits,
additional logs
with memory al

10.0.4

Table 21. Defect fixes (continued)
Behavior af
ID

Symptoms

ter you install

Available since

the update
location statis
tics have been
added, exclu
sively for the AIX
platform.
Catalog updates
KB0087392

SolarWinds Net

Discovery

work Config

changed from

Generator 1.0

file version to

discovery too

file size.

10.0.4.0

generic.
KB0088629

VisualSVN Serv

Discovery

er signatures

changed from

10.0.4.0

mismatch due to file version to
different manu

file size.

factures compi
lations.
BI-268

Unified version

Version of old

ing of Microsoft

er Microsoft Vi

Visual Studio.

sual Studio com
ponents was
changed to meet
Microsoft ap
proach to com
ponent version.

10.0.4.0

Table 21. Defect fixes (continued)
Behavior af
ID

Symptoms

ter you install

Available since

the update
BI-4565

New template

All installed ver

discovery for

sions of the

McAfee Agent.

component are

10.0.4.0

being detected.
Document updates
BI-2480

Updated the

Bundling assis

phrase “Auto

tant

10.0.4

mated bundling”
with “Bundling
assistant.”
BI-4414

Updated the

Upgrading from

10.0.4

document about version 9
“upgrade paths
for versions
9.2.14, higher
and lower.”
BI-4901

Update the doc

VM Managers

ument with in

performance

formation about and stability
the suggested

recommenda

number of VMs

tion is to have

managed by VM less than 10 VM
Manager tool.

Manager Tool
connections
for a single VM
Manager Tool.

10.0.4

Table 21. Defect fixes (continued)
Behavior af
ID

Symptoms

ter you install

Available since

the update
Use distributed
VM Manager
Tools to manage
additional con
nections.
BI-4435

Update the doc

Server log file

10.0.4

ument with in
formation about
the DEBUG level
parameter.
VM Manager Tool version and changes
The VM Manager Tool version that is used with this update is 10.0.4.0.
Scanner version and changes
The scanner version that is used with this update is 9.2.22.1000 for Windows
and 9.2.22.0000 for other platforms. The disconnected scanner version that is
used with this update is 10.0.4.0 and 9.2.22.0 for IBM I

Application update 10.0.3.1
Table 22. Published site version
Name of component Version
BigFix Inventory Content

Updated in the release

139

Yes

10.0.3.1

Yes

Site
BigFix Inventory Software
Catalog (main version)

Table 22. Published site version (continued)
Name of component Version
BigFix Inventory Software

Updated in the release

2638573

Yes

BigFix Inventory Server

10.0.3.0

No

BigFix Inventory Server:

9.2.21

No

9.2.21

No

9.2.21.1000 (Windows)

No

Catalog (version on end
point)

ILMT Core library
BigFix Inventory Server:
ILMT Catalog
BigFix Inventory Scanner

9.2.21.0000 (other plat
forms)
BigFix Inventory Discon

10.0.3.0

No

nected Scanner

9.2.21.0 (for IBM I)

BigFix Inventory VM Man

10.0.3.0

No

10.0.3.0

No

ager Tool
SAP Metric Data Collector
Included software catalog
This release includes Software Catalog version 10.0.3.1 containing:
• New discovery capabilities
• Added 500+ new signatures
• Defect fixes
For more information, please refer to:

Catalog Release Notes: https://software.bigfix.com/download/tema/catalog/
BFI_catalog_release_notes.pdf
Catalog Change List: https://software.bigfix.com/download/tema/catalog/
changelist/BFI_catalog_changelist_2021_02.pdf
Modified content
• The version included in Fixlet name is: 10.0.3.0 with two exceptions.
• The following Fixlets are updated and should be run to install latest
versions of the specific components.
◦ Software Catalog Update – Fixlet version 10.0.3.1
◦ Initiate Software Scan – Fixlet version 10.0.3.1
Enhancements and important changes
The following table lists important changes that are introduced in this update:
Table 23. Enhancement and important changes
Abstract

Description

Avail
able since

Catalog updates
New Adobe Apps

Added Adobe Apps 2021 CC dis

2021 CC discovery

covery capability based on the exe

10.0.3.1

cutable and package data.
New .NET Core dis

Added discovery capability of .NET 10.0.3.1

covery

Core version 2.0 and newer.

New JRE and JDK/

Added discovery capability of JRE

SDK discovery

and JDK/SDK versions 14 and 15

10.0.3.1

on Windows and Linux platforms.
New Red Hat AMQ

Added discovery capability of AMQ 10.0.3.1

Broker discovery

Broker versions 7.0-7.8.

Table 23. Enhancement and important changes (continued)
Abstract

Avail

Description

able since

New JBoss Web

Added discovery capability of

10.0.3.1

Server discovery

JBoss Web Server versions 5.0-5.4.

New Apache Cas

Added discovery capability of

sandra discovery

Apache Cassandra versions 2.1-2.2

10.0.3.1

and versions 3.0-3.11.
Defect fixes and enhancements
For the list of known defects, refer to HCL Knowledge Base.
The following table lists APARs and other defects that are fixed in this update:
Table 24. Defect fixes
Behavior af
ID

Symptoms

ter you install

Available since

the update
Catalog updates
BI-3463

KB0084420

Google Chrome

After catalog up 10.0.3.1

signatures

load and import,

are incorrect

discovery will

ly discovering

appear immedi

Chromium.

ately.

Discovery that is After catalog up 10.0.3.1
supposed to dis load and import,
cover ActivePerl discovery will
discovers other

appear immedi

non-ActivePerl

ately.

installations.

Table 24. Defect fixes (continued)
Behavior af
ID

Symptoms

ter you install

Available since

the update
KB0085410

Discovery that is After catalog up 10.0.3.1
supposed to dis load and import,
cover Strawber

discovery will

ry Perl discovers appear immedi
other non-Straw ately.
berry Perl instal
lations.
KB0085953

Discovery Blend

After catalog up 10.0.3.1

for Visual Stu

load and import,

dio is delivering

discovery will

false discovery

appear immedi

of "Blend for Vi

ately.

sual Studio SDK
for .NET 4.5"
and "Blend for
Visual Studio Sil
verlight 5".
KB0086514

Discovery is

Created new dis 10.0.3.1

misidentifying

covery based

other installed

on the package

software as Ko

data for version

fax Capture due

9.0, 10.0, 10.1,

to common exe 10.2, 11.0 and
cutable name.

for 8.0 replaced
executable ver
sion with its
size.

Table 24. Defect fixes (continued)
Behavior af
ID

Symptoms

ter you install

Available since

the update
KB0086734

Discovery of

Discovery ca

Oracle Java

pability was re

Platform SE 11

moved.

10.0.3.1

which is in the
catalog conflicts
with other Ora
cle Java discov
ery capability.
Fixlet updates
KB0085584

File Facts scan

Added the fol

result might be

lowing preven

corrupted by

tion checks to

Scanner or post

the 'Initiate soft

processing in

ware scan' fixlet

some rare condi to handle cor
tions like:

rupted scan re
sults or post

• Disabled
Windows
Host
Script
(possibil
ity to exe
cute vbs
scripts) on

processing is
sues:
1) Pre-check if
script can be run
and stop the 'Ini
tiate Software
Scan' if fails.

Windows

2) avoid creation

endpoints

of the delta file if

10.0.3.1

Table 24. Defect fixes (continued)
Behavior af
ID

Symptoms

ter you install

Available since

the update
• Terminat
ed/emp

data are corrupt
ed

ty result
from Scan
ner itself

Application update 10.0.3.1
Table 25. Published site version
Name of component Version
BigFix Inventory Content

Updated in the release

139

Yes

10.0.3.1

Yes

2638573

Yes

BigFix Inventory Server

10.0.3.0

No

BigFix Inventory Server:

9.2.21

No

9.2.21

No

9.2.21.1000 (Windows)

No

Site
BigFix Inventory Software
Catalog (main version)
BigFix Inventory Software
Catalog (version on end
point)

ILMT Core library
BigFix Inventory Server:
ILMT Catalog
BigFix Inventory Scanner

Table 25. Published site version (continued)
Name of component Version

Updated in the release

9.2.21.0000 (other plat
forms)
BigFix Inventory Discon

10.0.3.0

No

nected Scanner

9.2.21.0 (for IBM I)

BigFix Inventory VM Man

10.0.3.0

No

10.0.3.0

No

ager Tool
SAP Metric Data Collector
Included software catalog
This release includes Software Catalog version 10.0.3.1 containing:
• New discovery capabilities
• Added 500+ new signatures
• Defect fixes
For more information, please refer to:
Catalog Release Notes: https://software.bigfix.com/download/tema/catalog/
BFI_catalog_release_notes.pdf
Catalog Change List: https://software.bigfix.com/download/tema/catalog/
changelist/BFI_catalog_changelist_2021_02.pdf
Modified content
• The version included in Fixlet name is: 10.0.3.0 with two exceptions.
• The following Fixlets are updated and should be run to install latest
versions of the specific components.
◦ Software Catalog Update – Fixlet version 10.0.3.1
◦ Initiate Software Scan – Fixlet version 10.0.3.1

Enhancements and important changes
The following table lists important changes that are introduced in this update:
Table 26. Enhancement and important changes
Abstract

Description

Avail
able since

Catalog updates
New Adobe Apps

Added Adobe Apps 2021 CC dis

2021 CC discovery

covery capability based on the exe

10.0.3.1

cutable and package data.
New .NET Core dis

Added discovery capability of .NET 10.0.3.1

covery

Core version 2.0 and newer.

New JRE and JDK/

Added discovery capability of JRE

SDK discovery

and JDK/SDK versions 14 and 15

10.0.3.1

on Windows and Linux platforms.
New Red Hat AMQ

Added discovery capability of AMQ 10.0.3.1

Broker discovery

Broker versions 7.0-7.8.

New JBoss Web

Added discovery capability of

Server discovery

JBoss Web Server versions 5.0-5.4.

New Apache Cas

Added discovery capability of

sandra discovery

Apache Cassandra versions 2.1-2.2

10.0.3.1

10.0.3.1

and versions 3.0-3.11.
Defect fixes and enhancements
For the list of known defects, refer to HCL Knowledge Base.
The following table lists APARs and other defects that are fixed in this update:

Table 27. Defect fixes
Behavior af
ID

Symptoms

ter you install

Available since

the update
Catalog updates
BI-3463

KB0084420

Google Chrome

After catalog up 10.0.3.1

signatures

load and import,

are incorrect

discovery will

ly discovering

appear immedi

Chromium.

ately.

Discovery that is After catalog up 10.0.3.1
supposed to dis load and import,
cover ActivePerl discovery will
discovers other

appear immedi

non-ActivePerl

ately.

installations.
KB0085410

Discovery that is After catalog up 10.0.3.1
supposed to dis load and import,
cover Strawber

discovery will

ry Perl discovers appear immedi
other non-Straw ately.
berry Perl instal
lations.
KB0085953

Discovery Blend

After catalog up 10.0.3.1

for Visual Stu

load and import,

dio is delivering

discovery will

false discovery

appear immedi

of "Blend for Vi

ately.

sual Studio SDK
for .NET 4.5"

Table 27. Defect fixes (continued)
Behavior af
ID

Symptoms

ter you install

Available since

the update
and "Blend for
Visual Studio Sil
verlight 5".
KB0086514

Discovery is

Created new dis 10.0.3.1

misidentifying

covery based

other installed

on the package

software as Ko

data for version

fax Capture due

9.0, 10.0, 10.1,

to common exe 10.2, 11.0 and
cutable name.

for 8.0 replaced
executable ver
sion with its
size.

KB0086734

Discovery of

Discovery ca

Oracle Java

pability was re

Platform SE 11

moved.

10.0.3.1

which is in the
catalog conflicts
with other Ora
cle Java discov
ery capability.
Fixlet updates
KB0085584

File Facts scan

Added the fol

result might be

lowing preven

corrupted by

tion checks to

Scanner or post

the 'Initiate soft

10.0.3.1

Table 27. Defect fixes (continued)
Behavior af
ID

Symptoms

ter you install

Available since

the update
processing in

ware scan' fixlet

some rare condi to handle cor
tions like:

rupted scan re
sults or post

• Disabled
Windows
Host
Script
(possibil
ity to exe
cute vbs
scripts) on

processing is
sues:
1) Pre-check if
script can be run
and stop the 'Ini
tiate Software
Scan' if fails.

Windows

2) avoid creation

endpoints

of the delta file if

• Terminat

data are corrupt

ed/emp

ed

ty result
from Scan
ner itself

Application update 10.0.3
Table 28. Published site version
Name of component

Version

Updated in the release

BigFix Inventory Content

138

Yes

Site

Table 28. Published site version (continued)
Name of component

Version

Updated in the release

BigFix Inventory Software

10.0.3.0

Yes

2638564

Yes

BigFix Inventory Server

10.0.3.0

Yes

BigFix Inventory Server:

9.2.21

Yes

9.2.21

Yes

9.2.21.1000 (Windows)

Yes

Catalog (main version)
BigFix Inventory Software
Catalog (version on end
point)

ILMT Core library
BigFix Inventory Server:
ILMT Catalog
BigFix Inventory Scanner

9.2.21.0000 (other plat
forms)
BigFix Inventory Discon

10.0.3.0

Yes

nected Scanner

9.2.21.0 (for IBM I)

BigFix Inventory VM Man

10.0.3.0

Yes

10.0.3.0

Yes

ager Tool
SAP Metric Data Collector

Changes to supported systems and upgrade paths
BigFix Inventory supports direct upgrade to the latest version. For versions
lower than 9.2.14, it is not possible to upgrade BigFix Inventory directly to the
latest version. To upgrade to the latest version, upgrade to version 10.0.2 first
using this fixlet, migrate the Database Schema and then use Upgrade to the
latest version of BigFix Inventory (10.0.4.0) to upgrade to the latest version.

For details on how to upgrade BigFix Inventory, refer to Upgrading to BigFix
Inventory v10
Changes to user interface
Improved icons in menus, reports, and dialog boxes.
Included software catalog
This release includes Software Catalog version 10.0.3.0 which includes:
• IBM License Metric Tool Software Catalog version 9.2.21.0
• Added discovery capability for 228 software versions including
discovering Red Hat JBoss Enterprise Application Platform
For more information, refer to
Catalog Release Notes: https://software.bigfix.com/download/tema/catalog/
BFI_catalog_release_notes.pdf
Catalog Change List: https://software.bigfix.com/download/tema/catalog/
changelist/BFI_catalog_changelist_2020_12.pdf
Modified content
The version included in the fixlet names is: 10.0.3.0
The following fixlets were updated and should be run to install latest versions
of the specific components:
• Upgrade to the latest version of BigFix Inventory 10.x
• Software Catalog Update
• Install or Upgrade Scanner
• Install or Upgrade Scanner in private mode on Windows
• Update SAP Metric Data Collector
• Update VM Manager Tool
• Download the Disconnected Scanner Package for IBM I
• Download the Disconnected Scanner Package

The following fixlets were updated and should be run to install newer versions
of the specific components. Restarting actions is necessary to ensure that
new features work properly:
• Run Capacity Scan and Upload Results (10.0.3.0)
• Initiate Software Scan (10.0.3.0)
• Get Oracle Features (10.0.3.0)
• Get Oracle Concurrent Sessions Number (10.0.3.0)
• Discover Remote Shared Disks (10.0.3.0)
The following fixlets were updated but it does not require any additional
action:
• Uninstall Scanner (10.0.3.0)
• Download BigFix Inventory (10.0.3.0)
• Identify Computers on Public Clouds (10.0.3.0)
• Install Additional VM Manager Tool (OPTIONAL) (10.0.3.0)
• Update VM Manager Tool to version (10.0.3.0)
• Download BigFix Inventory (10.0.3.0)
Enhancements and important changes
For a list of enhancements introduce in this release, see: What's new
Defect fixes
For the list of known defects please refer to HCL Knowledge Base.
The following table lists APARs and other defects that are fixed in this update:
Behavior after
ID

Symptoms

you install the
updates

Server updates

Available since

Behavior after
ID

Symptoms

you install the

Available since

updates
KB0082269

BigFix Inventory

Configuration

production.log

has been updat

file does not ro

ed and produc

tate

tion.log is no

10.0.3.0

longer produced
to avoid dupli
cated logging
KB0084887

While running

The problem

data imports af

does not occur.

10.0.3.0

ter upgrading to
BFI 10.0.2, there
is error in import
log as below:
Cannot insert
duplicate key
row in object
'sam.file_facts_scd' with

unique index
'sam_file_facts_scd_computer_id_full_path_sha1_valid_to_index'

KB0085129

New dashboard

The problem

config will not

does not occur.

10.0.3.0

Behavior after
ID

Symptoms

you install the

Available since

updates
show up af
ter upgrade to
10.0.2 in case
a saved report
was deleted be
fore upgrade
KB0085155

Data Import step The problem
UsageManag

10.0.3.0

does not occur.

er fails on Null
value insert into
non null column.
KB0084825

Metric Quantity

Metric Quanti

field is not dis

ty field is prop

playing proper

er value format

10.0.3.0

value formatting ting for given
for following lan languages
guages CS, DE,
ES, NL, pt-BR,SL,
HR, HU, RU, PL

• CS:100,000,99
=> 100
000,99
• DE,ES,N
L,pt-BR,SL:100,000.99
=>
100.000,99
• HR,HU,RU:100,000.99
=> 100
000,99

Behavior after
ID

Symptoms

you install the

Available since

updates
• PL:
• 100.000,99
=> 100
000,99
KB0085226

API request re

The problem

turns unexpect

does not occur.

ed character '\n'

The previous

for IP address

format (used be

es and discov

fore BFI v10.0.2)

ery paths. IP ad

is restored.

10.0.3.0

dress list is a
single text string
instead of a ta
ble.
KB0085446

Get Oracle Fea

The problem

tures fixlet in

does not occur.

10.0.3.0

some cases
does not detect
Advanced Com
pression feature
KB0085384

File Facts scan

The problem

with unicode

does not occur.

character in
payload is im
ported partial
ly when also
file checksums
are collected.

10.03.0

Behavior after
ID

Symptoms

you install the

Available since

updates
Furthermore,
there were kept
only records
processed.
The Import log
file shows the
following errors:
WARN: Excep
tion Encod
ing::Compati
bilityError while
processing da
ta in file itsit
search_0_1.xml
on computer
30. Message:
incompatible
character encod
ing: UTF-8 and
ASCII-8BIT
KB0085027

During instal

Typo is cor

lation of BFI

rected and de

10.0.2 on a

fault path is: "C:

clean system,

\Program Files

default instal

\BigFix Enter

lation directo

prise\BFI"

ry contains a ty
po: "C:\Program

10.0.3.0

Behavior after
ID

Symptoms

you install the

Available since

updates
Files\BigFix En
terprise\BFI",
where the word
"Enterprise" is
spelled "Enter
prise" (missing a
"r" letter). and re
sulting in an un
expected loca
tion after instal
lation.
KB0085442

Capacity scans

The problem

not uploading

does not occur.

10.0.3.0

leading to Out
dated or No VM
Manager status
BI-1207

Empty 'File path'

When file is

displayed on

placed in root

Scanned File

directory then

Data when file

Scanned File

is placed in the

Data report dis

10.0.3.0

root ( / ) directo plays path to

BI-1104

ry

this file correctly

When BESClient

Before files

id has changed

upload old,

and there are

scanned files

old, scanned

are removed

files with old

10.0.3.0

Behavior after
ID

Symptoms

you install the

Available since

updates
BESClient ids
these files are
causing warn
ing generation
during import
process
BI-2184

When BFI loses

Message has

connection to

been corrected

database serv

to display infor

10.0.3.0

er contract man mation that con

IJ25637

agement will

nection to data

display strange

base has been

message

lost

Installation of

The problem

the BigFix Inven does not occur.
tory server fails
because the
password for
the default Key
Store was not
set up correctly.
The following er
ror is written in
the logs.
com.ibm.li
cense.mgmt.in
stall.ia.actions

10.0.3.0

Behavior after
ID

Symptoms

you install the

Available since

updates
.EnableEncryp
tion.execute securityUtility
execution failed
with return code:
1, stdout: ,
stderr:
JVMJ9VM015W
Initialization er
ror for library
j9jit29(11):
cannot initialize
JIT
IJ25638

Multiple selec

The selection

tion for month

is now intuitive

ly and weekly

and information

schedule of ex

about the cur

porting reports

rent setting is

does not work

displayed.

10.0.3.0

correctly.
IJ26396

License usage is The problem
displayed on the does not occur.
All Metrics re
port for a prod
uct on a com
puter where no
component of

10.0.3.0

Behavior after
ID

Symptoms

you install the

Available since

updates
that product is
installed. It hap
pens on comput
ers where IBM
DB2 Advanced
Workgroup Serv
er Edition OEM
Limited Use
11.1 component
was previously
bundled to that
product (as a
charged assign
ment).
IJ26514

Import of data

The problem

fails after manu does not occur.
al modification
of the etl_set
tings.yml and
the following er
ror is written in
the tema.log file.
ERROR (De
fault Execu
tor-thread-3)
loadSystem
Properties

10.0.3.0

Behavior after
ID

Symptoms

you install the

Available since

updates
java.lang.Illegal
ArgumentExcep
tion: No enum
constant
com.ibm.li
cense.mgmt
.dao.system.Etl
Settings
IJ26522

Scheduling ca

The problem

10.0.3.0

pacity scan with does not occur.
a disconnected
scanner fails on
SUSE Linux En
terprise Server
11.
IJ26708

When more than The problem
one-dollar sign
($) is used for
any parameter
in the installa
tion response
file, the value is
incorrectly inter
preted. Installa
tion of the BigFix
Inventory serv
er might fail. If it
does not fail, the

does not occur.

10.0.3.0

Behavior after
ID

Symptoms

you install the

Available since

updates
value of the pa
rameter that is
used is not the
same as the one
that was pro
vided in the re
sponse file. It
might result in
unexpected be
havior.
IJ26973

In general, the

The problem

No Host Scan

does not occur.

Data status
means that the
VM is not con
sidered in PVU
calculations. To
correctly cal
culate PVU uti
lization on such
a VM, its host
must report to
BigFix Inven
tory. However,
HP-UX comput
ers with the No
Host Scan Data
status are con
tributing to cal

10.0.3.0

Behavior after
ID

Symptoms

you install the

Available since

updates
culation of PVU
based on default
PVU values.
197915

Some errors oc

The problem

curring during

does not occur.

10.0.3.0

schema update
are not properly
handled. Thus,
BigFix Inventory
upgrade may be
shown as suc
cessful in case it
failed.
197966

Disconnected

The problem

10.0.3.0

scanner can use does not occur.
up to 100% CPU
for a long period
of time on Win
dows 2008.
198084

In case a VM

The problem

Manager tool

does not occur.

configuration
file is invalid be
cause the pass
word is blank,
“vmman.bat
-reloadcon
fig” command

10.0.3.0

Behavior after
ID

Symptoms

you install the

Available since

updates
returns error
code 0 despite it
failed.
198085

“vmman.bat

The problem

10.0.3.0

-stop” command does not occur.
fails on timeout.
Documentation updates
BI-2346

Added informa

Managing data

tion about Low

sources-Lower

ering user per

ing user permis

missions for

sion

10.0.3.0

BigFix Platform
database ac
cess database.
BI-3050

Added more in

Advanced Server 10.0.3

formation about Parameters
the “resync_im
ports” in the Ad
vanced Server
Parameters sec
tion based on
the information
available on the
UI.
BI-3049

In the descrip

Advanced Server 10.0.3

tion of “resync_

Parameters

mode”, added

Behavior after
ID

Symptoms

you install the

Available since

updates
the information
about Catalog
Scan Only (2).
VM Manager tool version and changes
The VM Manager Tool version that is used with this update is 10.0.3.0.
Scanner version and changes
The scanner version that is used with this update is 9.2.21.1000 for Windows
and 9.2.21.0000 for other platforms. The disconnected scanner version that is
used with this update is 10.0.3.0.

Content pack 10.0.2.1
Table 29. Published site version
Name of component

Version

Updated in the release

BigFix Inventory Content

137

Yes

10.0.2.1

Yes

2638562

Yes

BigFix Inventory Server

10.0.2.0

No

BigFix Inventory Scanner

9.2.20.2000 (Windows)

No

Site
BigFix Inventory Software
Catalog (main version)
BigFix Inventory Software
Catalog (version on end
point)

9.2.20.1000 (Other plat
forms)

Table 29. Published site version (continued)
Name of component

Version

Updated in the release

BigFix Inventory Discon

10.0.2.0

No

nected Scanner

9.2.20.0 (for IBM I)

BigFix Inventory VM Man

10.0.2.0

No

10.0.2.0

No

ager Tool
SAP Metric Data Collector
Included software catalog
This release includes Software Catalog version 10.0.2.1 containing:
• Capability to discover products including the following:
◦ BMC software
◦ Oracle software
◦ SAP software
◦ Tibco software
◦ Red Hat software
◦ Open source Apache software
◦ Oracle Java Advanced Management Console Agent as part of
Oracle Java auditing function
◦ Microsoft 365 Apps as part of Microsoft Office 365 product
• Defects fixes
• Discovery capability for 290+ software versions
For more information, please refer to:
Catalog Release Notes: https://software.bigfix.com/download/tema/catalog/
BFI_catalog_release_notes.pdf
Modified content

• The version included in Fixlet name is: 10.0.2.1
• The 'Software Catalog Update' fixlet was updated and should be run to
install latest versions of the specific components.
Important changes
The following table lists important changes that are introduced in this update.
Table 30. Catalog release updates
Abstract

Description

Available since

Java Advanced Man

New signatures provid 10.0.2.1

agement Console

ing evidence for audit

Agent Evidence

ing use of Oracle Java
commercial features

Microsoft 365 Apps

Discovery enhance

10.0.2.1

ment for Microsoft
365 applications as
part of Microsoft Of
fice 365 product. Sup
ported editions are:
Enterprise, Business
and Home with dis
covery of their com
ponents: Excel, Word,
PowerPoint, Access,
Publisher, Outlook and
OneNote.
Defect fixes
For the list of known defects please refer to HCL Knowledge Base.
The following table lists APARs and other defects that are fixed in this update.

Table 31. Defect fixes
Behavior after
ID

Symptoms

you install the

Available since

update
KB0081696

SQR server for

Corrected signa 10.0.2.1

Sybase was in

ture by replac

correctly discov ing component
ered

version with
the .exe file size.

KB0080084

Microsoft

Template pack

ASP.NET Core

age signatures

not in the cata

were extend

log

ed to avoid dis

10.0.2.1

covering plug
ins with similar
package name.
KB0074700

Missing detailed Previously
version for Mi

added signa

crosoft System

tures due to dif

Center Configu

ferent Microsoft

ration Manager

versioning were

Client

not able to prop
erly discover
the product.
New signatures
check three dif
ferent possible
component ver
sion.

10.0.2.1

Table 31. Defect fixes (continued)
Behavior after
ID

Symptoms

you install the

Available since

update
Additionally,
there is new
package signa
ture to provide
discovery be
fore running CIT
scan.
KB0084446

Veritas Storage

Signature has

Foundation for

been deleted.

10.0.2.1

Windows was in
correctly discov
ered
BI-1832

Microsoft

New template

Idea: BFINV-

OneDrive is not

signature cre

being discov

ated which in

I-152

10.0.2.1

ered for some of cludes all Mi
its releases

crosoft OneDrive
releases.

BI-1819

Signature for

Signature delet

SPSS OEM Con

ed for this com

nect for ODBC

ponent.

5.0 1 1.0 is no
longer needed

10.0.2.1

Application update 10.0.2
Table 32. Published site version
Name of component

Version

Updated in the release

BigFix Inventory Content

136

Yes

10.0.2.0

Yes

2638555

Yes

BigFix Inventory Server

10.0.2.0

Yes

BigFix Inventory Server:

9.2.20

Yes

9.2.20

Yes

9.2.20.2000 (Windows)

Yes

Site
BigFix Inventory Software
Catalog (main version)
BigFix Inventory Software
Catalog (version on end
point)

ILMT Core library
BigFix Inventory Server:
ILMT Catalog
BigFix Inventory Scanner

9.2.20.1000 (other plat
forms)
BigFix Inventory Discon

10.0.2.0

Yes

nected Scanner

9.2.20.0 (for IBM I)

BigFix Inventory VM Man

10.0.2.0

Yes

10.0.2.0

Yes

ager Tool
SAP Metric Data Collector

Change to supported systems and upgrade paths

• IBM DB2 10.1 is no longer supported as a database for BigFix Inventory
Server in line with supported database list for BigFix platform
Change in delivery method for IBM Catalog Product Definitions
Starting with BigFix Inventory version 10.0.2.0, updates to licensing definitions
and bundling information for IBM products is available only with updates
to BigFix Inventory server code. Before this change, these updates were
packaged with updates to the BigFix Inventory software catalog. In order
to remain compliant with IBM licensing and bundling requirements, you
will need to stay current with the latest BigFix Inventory release and cannot
manage IBM changes through monthly catalog distribution. This change
was introduced to align with IBM announcement for version 9.2.20.0 of IBM
License Metric Tool. For more information please refer to this link BigFix
Forum.
Changes to user interface
• Default dashboard now shows vendor-specific reports with an option to
switch to the old dashboard.
• Vendor-specific predefined reports provide software discovery and
licensing information for specific software vendors, such as Microsoft,
Oracle, Adobe, IBM, HCL, SAP, and VMware.
• Installation path is now visible on inventory reports for all discovered
software (previously it was visible only for IBM software).
Includes software catalog
• Added 631 new signatures and 70 new software vendors
• Added discovery capability of Tableau Desktop and Tableau Server
• Several defects has been fixed
For more information please refer to:

◦ Catalog Release Notes: https://software.bigfix.com/download/
tema/catalog/BFI_catalog_release_notes.pdf
◦ Catalog Change List: https://software.bigfix.com/download/tema/
catalog/changelist/BFI_catalog_changelist_2020_09.pdf
Modified content
The version included in the fixlet names is: 10.0.2.0
The following fixlets were updated and should be run to install latest versions
of the specific components:
• Upgrade to the latest version of BigFix Inventory 10.x
• Software Catalog Update
• Install or Upgrade Scanner
• Install or Upgrade Scanner in private mode on Windows
• Update SAP Metric Data Collector
• Update VM Manager Tool
• Download the Disconnected Scanner Package for IBM I
• Download the Disconnected Scanner Package
The following fixlets were updated and should be run to install newer versions
of the specific components. Restarting actions is necessary to ensure that
new features work properly:
• Initiate Software Scan
• Initiate Software Scan on Shared Disks
• Upload Software Scan Results
• Run Capacity Scan and Upload Results
• Run Capacity Scan on Virtualization Hosts
• Collect Detailed Hardware Information
• Schedule VM Manager Tool Scan Results Upload
• Discover Remote Shared Disks

The following fixlets were updated but it does not require any additional
action:
• Configure File Checksum Collection
• Download BigFix Inventory
• Install Additional VM Manager Tool (OPTIONAL)
• Install SAP Metric Data Collector
• Install VM Manager Tool
• Configure Scanner Query Timeout
• Configure Scan Cache
• Collect Specific Registry from Windows Endpoints
• Change Scanner Cache Folder
• Edit Scanner Trace Settings
• Force VM Manager Tool Scan Results Upload
• Uninstall Scanner
• The following fixlet was added but it does not require any additional
action.
• Configure Collection of Additional Properties of Windows Executables
Enhancement and important changes
For a list of enhancements introduce in this release, see: What's new
Defect fixes
For the list of known defects please refer to HCL Knowledge Base.
The following table lists APARs and other defects that are fixed in this update:
Table 33. Defect fixes
Behavior after
ID

Symptoms

you install the
updates

Server updates

Available since

Table 33. Defect fixes (continued)
Behavior after
ID

Symptoms

you install the

Available since

updates
KB0080818

When script

No error mes

10.0.2.0

“setup-server-lin sages
ux-x86_64.sh”
is executed to
run BFI installer,
following er
ror message is
shown on RHEL
6:
./setup-serv
er-linux-x86_
64.sh[141]: [:
6Server: arith
metic syntax er
ror
KB0081683

Added informa

Preparing instal 10.0.2.0

tion in the docu

lation files for

ment about IBM

disconnected

i Catalog. Updat scans for IBM i
ed relevant sec
tions that IBM
i Disconnected
Scanner pack
age includes an
embedded Soft
ware Catalog
and the option

Table 33. Defect fixes (continued)
Behavior after
ID

Symptoms

you install the

Available since

updates
to update Soft
ware Catalog
has been dis
abled since BFI
version 9.2.17.
KB0079282

KB0080332

Changed doc

Configuring

umentation to

cryptographic

point to HCL

keystore pass

support instead

word and en

of IBM support

cryption

Updated docu

Maintaining the

mentation on

DB2 database

10.0.2.0

10.0.2.0

DB2 mainte
nance proce
dures
KB0081958

Added informa

• Setting up

tion in the docu

computer

mentation that

groups

creating more

10.0.2.0

• Tuning

than 20 comput

perfor

er groups may

mance

impact the per
formance.
KB0078838

BFI session

Session will re

timeout doesn't

spect value set
for time out.

10.0.2.0

Table 33. Defect fixes (continued)
Behavior after
ID

Symptoms

you install the
updates

work when SSO
is enabled.
After 20 minutes
of inactivity af
ter page is be
ing refresh, BFI
is redirected to
default identity
provider page
which is serving
new cookie. On
most panels it is
not causing any
problems, but
when customer
will apply any fil
ter to the panel
then Unexpected
Single Sign On
Error is appear
ing. In dev tools
SAML20Unso
licitedState is
visible during
wrong redirec
tion.

Available since

Table 33. Defect fixes (continued)
Behavior after
ID

Symptoms

you install the

Available since

updates
KB0078044

"Catalog Down

"Catalog Down

load" task over

load" task is rel

writes the new

evant only if the

catalog on end

existing end

points because

point catalog is

the relevance

older. The doc

clause inside

umentation has

checks if the

been updated

catalog version

with information

is different.

that changes in

10.0.2.0

the file exten
sion list should
be made after
contacting HCL
support.
KB0081727

Failed Imports

There has been

might cause

adjusted con

keeping re

dition used to

moved File

nominate facts

Facts, ISO Tags

for removal to

and Catalog

properly consid

Scan results

er all scan re

10.0.2.0

sults processed
in current import
KB0081307

Package Data

Removed pack

view shows re

age data is no

moved data in

longer displayed

10.0.2.0

Table 33. Defect fixes (continued)
Behavior after
ID

Symptoms

you install the

Available since

updates
context of the

when viewing

Computer

reports from
a computer or
computer group
context

KB0081394

Java usage will

Application us

be not report

age by path can

ed on selected

create a huge re

computer with

sult file and im

deactivated col

pact Platform

lection

Replication. The

10.0.2

output of the us
age scan has
been limited,
and the max
imal size of it
has been set to
1 MB to prevent
impact on BigFix
Platform.
IJ26396

Import of data

Import does not

fails during the

fail any more af

upload of the

ter the PVU table

PVU table and

upload.

the following er
ror is written in
the log. ERROR:

10.0.2.0

Table 33. Defect fixes (continued)
Behavior after
ID

Symptoms

you install the
updates

[ILMTCore]
(ImportThread)
doAction java.lang.ArithmeticException: divide
by zero at
com.ibm.ilmt.core.etl.core.actions.pvutable.
RefeshProcessorMeasuresForx86ManagedNodes.execute
(RefeshProcessorMeasuresForx86ManagedNodes.java:48)
at com.ibm.ilmt.core.etl.core.actions.VUTImportAction. doAction(VUTImportAction.java:78)

Available since

Table 33. Defect fixes (continued)
Behavior after
ID

Symptoms

you install the

Available since

updates
IJ25430

Security Identi

The issue does

ty Manager and

not occur.

10.0.2.0

Role Manage
ment Unlimit
ed User Option
are detected as
version 5.1 but
should be de
tected as ver
sion 6.0.
IJ25458

The Schedule

Scheduling of

VM Manager

VMManager

Tool Scan Re

Tool Scan Re

sults Upload

sults Upload

fixlet is not rele

fixlet is relevant

vant on Cent OS

on Cent OS end

10.0.2.0

due to relevance point.
restriction ac
cording to which
the fixlet should
be relevant on
Red Hat Linux
but not SUSE
Linux.
IJ25599

Computer that

The issue does

is identified

not occur.

as Oracle Pub

10.0.2.0

Table 33. Defect fixes (continued)
Behavior after
ID

Symptoms

you install the

Available since

updates
lic Cloud has
wrong value in
the Computer
Type column on
the Hardware In
ventory report.
IJ25697

When the num

The issue does

ber of partition

not occur.

cores exceeds
999 on the Hard
ware Inventory
report, the fol
lowing error is
displayed: Your
database is
offline/inaccessible or
your database
server credentials are
incorrect or
have expired.
Please contact the administrator
or refer to
tema.log for

10.0.2.0

Table 33. Defect fixes (continued)
Behavior after
ID

Symptoms

you install the

Available since

updates
more information.

197234

When the num

The issue does

ber of CPUs is

not occur.

10.0.2.0

increased on
an LPAR that is
monitored by
using a discon
nected scan
ner, the changed
number of CPUs
is not reflected
in BigFix Inven
tory.
BI-1255

BFI Data Import: Hotfix released
Improve "Dictio

10.0.2.0

for one cus

nariesBO: updat tomer includ
ed Version dic

ed in official re

tionary" process lease. Avoid in
ing time and sta efficient execu
bility by adding

tion plans es

index

pecially when
majority of File
Facts has been
changed.

BI-817

Long execution

There has been

of “Generate

rewritten the

10.0.2.0

Table 33. Defect fixes (continued)
Behavior after
ID

Symptoms

you install the

Available since

updates
Software Com

query with dedi

ponents” Data

cated implemen

Import step up

tation for MS

to 10h

SQL and DB2
databases to op
timize execution
time.
Scanner updates

197183

Software scan

The issue does

unnecessari

not occur.

10.0.2.0

ly follows sym
links for paths
defined in ex
cludeDirecto
ry/includeDirec
tory properties.
IJ24961

4 cores Ora

The issue does

cle Netra Sparc

not occur.

T4-1 is being
discovered as
8 cores. Num
ber of cores
mismatch has
caused a mis
leading hard

10.0.2.0

Table 33. Defect fixes (continued)
Behavior after
ID

Symptoms

you install the

Available since

updates
ware scan out
put.
IJ23404

It has been con

New experimen 10.0.2.0

firmed that in a

tal cache was

very rare case,

introduced. For

on some unusu

more informa

al UNIX OS se

tion, see: APAR

tups, under cir

IJ23404.

cumstances
that have not
yet been pre
cisely defined,
the mechanism
of caching the
scan data by the
software scan
ner fails. Due to
this error, the
scanner is loop
ing through the
cache data, and
as a result occu
pies one of the
threads avail
able on the ma
chine. The issue
is caused by the

Table 33. Defect fixes (continued)
Behavior after
ID

Symptoms

you install the

Available since

updates
incorrect pro
cessing of scan
ner cache data.
IJ23587

The capacity

The issue does

scan returns

onto occur.

10.0.2.0

the following er
ror: "Could not
load a transcod
ing service".
The problem is
caused by incor
rect settings of
the system's lo
cale.
197728

Subcapacity val The issue does
ues are incor

10.0.2.0

not occur.

rectly count
ed on Solaris
x86 with kernel
zones.
KB0080200

Scanner misin

The issue does

terprets SMBIOS not occur.
structure on Lin
ux. 'Componen
tID' section is
empty due to

10.0.2.0

Table 33. Defect fixes (continued)
Behavior after
ID

Symptoms

you install the

Available since

updates
cpuid compo
nent not being
able to read SM
BIOS data on
Linux
KB0081623

File facts/pack

BFI will keep the 10.0.2.0

age data are not raw data in the
being preserved

database for a

in database de

duration speci

spite setting

fied in raw_da

raw_data_-

ta_api_history_

api_histo-

keep_days para

ry_keep_days meter
value as more
than 0. raw_da
ta_api_history_
keep_days was
being overwrit
ten by pruning_days_to_keep
Content updates
KB0081663

Initiate Soft

Initiate Soft

ware Scan fixlet

ware Scan be

not applicable

comes relevant

10.0.2.0

Table 33. Defect fixes (continued)
Behavior after
ID

Symptoms

you install the

Available since

updates
on Solaris end

on all Solaris

points

endpoints
Catalog updates

KB0080543

10.0.2.0

Documenta
tion is updated
with information
about excluded
or suppressed
instances of li
censed com
puters not be
ing shown under
Contract data.
The advantage
of using Metrics
over Contracts
is added in the
document.

KB0081696

SoftArtisan Of

Change file ver

ficeWriter is be

sion, to file size

ing mismatched for all signa
with other prod

tures based on

ucts based on

‘licensemanag

the same file

er.exe’.

and file version

10.0.2.0

Table 33. Defect fixes (continued)
Behavior after
ID

Symptoms

you install the

Available since

updates
KB0081725

Tibco Ren

Change in signa 10.0.2.0

dezvous is being ture body to fil
detected twice

ter installation

on one software path by ‘bin/’

KB0081437

installation

and the end.

Tableau soft

Deletion of old,

ware is being

and creation

detected with

of new tem

wrong version

plate signatures,

reported

that differ be

10.0.2.0

tween Server
and Desktop ver
sion based on
package name.
KB0081777

Signature for

Deletion of old

Studio for Ac

file signature

tiveX is not sup

and replacing it

porting newer

with new pack

versions

age template

10.0.2.0

signature.
Security enhancements
To maintain security, the selected components and libraries were updated:
• Rails upgraded to version 5.2.4.3 - CVE-2019-5418, CVE-2019-5419,
CVE-2019-5420
• Nokogiri-1.6.8.1 patched to use newer Xerces 2.12.0

• jQuery upgraded to 3.5.1 - CVE-2020-11022, CVE-2020-11023
• Websphere WLP upgraded to 20.0.0.5 - CVE-2020-4329, CVE-2020-4303,
CVE-2020-4304
• Java upgraded to 8.0.6.15 - CVE-2020-2781, CVE-2020-2601,
CVE-2020-14621, CVE-2020-14581, CVE-2020-14579, CVE-2020-14578,
CVE-2020-14577, CVE-2020-2590
VM Manager Tool version and changes
• The VM Manager tool version that is used with this update is 10.0.2.0
and it includes fix for IJ24961. Please refer to the defect fixes table for
details.
• The 32-bit version of the VM Manager tool is no longer supported.
Scanner version and changes
The scanner version that is used with this update is 9.2.20.2000 for Windows
and 9.2.20.1000 for other platforms. The disconnected scanner version that is
used with this update is 10.0.2.0. As an exception, the disconnected scanner
version for IBM I is 9.2.20.0.
Support for new systems and hypervisors
The following new systems and hypervisors are supported starting this
release:
• SLES 15 SP1 on Power
• vSphere ESXi 7.0 and vSphere vCenter Server 7.0
• Disconnected scanner on Red Had Enterprise Linux 8.1 on Power
• Disconnected scanner on Ubuntu 20 x86
End of support
Starting from version 10.0.2, support is dropped for the following:

• IBM DB2 10.1 as database for BigFix Inventory server
• VM Manager tool version 32-bit
• IBM i 6.1

Application update 10.0.1.1
Table 34. Published site version
Name of the component

Version

BigFix Inventory Content Site

135

BigFix Inventory Software Catalog (main 10.0.1.1

Updated in this re
lease
Yes
Yes

version)
BigFix Inventory Software Catalog (ver

2638548

Yes

BigFix Inventory Server

10.0.1.0

No

BigFix Inventory Scanner

9.2.19.0000

No

sion on endpoint)

9.2.19.1000 (Win
dows)
BigFix Inventory Disconnected Scanner

10.0.1.0

No

9.2.19.0 (for IBM I)
BigFix Inventory VM Manager Tool

10.0.1.0

No

SAP Metric Data Collector

10.0.1.0

No

Included Software Catalog
This release includes Software Catalog version 10.0.1.1 containing:

• Added capability of discovering Docker engine and Kubernetes software
• Added discovery capability for 100+ software versions for number of
software titles including Oracle, Hewlett-Packard, McAfee, Microsoft,
Red Hat, SAP, and VMware
For more information please refer to:
Catalog Release Notes: https://software.bigfix.com/download/tema/
catalog/BFI_catalog_release_notes.pdf
Catalog Change List: https://software.bigfix.com/download/tema/
catalog/changelist/BFI_catalog_changelist_2020_08.pdf
Modified content
The version included in Fixlet is 10.0.1.1.
The following fixlets were updated and should be run to install newer versions
of the specific components:
• Software Catalog Update
• Initiate Software Scan
The following new fixlets were created to support install or upgrade scanner
for BigFix Inventory use only on Windows:
• Install or Upgrade Scanner in private mode on Windows
• Update Catalog Download fixlet templates on BFI server
The following fixlets were updated to support the scanner for BigFix Inventory
use only on Windows. After first use of fixlet ‘Install or Upgrade Scanner in
private mode on Windows’, it is required to stop all scheduled actions based
on the updated fixlets and schedule new actions based on them:
• Initiate Software Scan
• Configure Scanner Query Timeout
• Configure Scan Cache

• Install or Upgrade Scanner
• Uninstall Scanner
• Change Scanner Cache Folder
• Run Capacity Scan and Upload Results
• Edit Scanner Trace Settings
• Configure File Checksums Collection (MD5/SHA-256)
• Configure Collection of Additional Properties of Windows Executables
• Collect Detailed Hardware Information
Additionally, the following analyses were updated to support the scanner for
BigFix Inventory use only on Windows:
• Scanner Information
• Scanner Trace Settings
• File Checksums Collection Settings (MD5/SHA-256)
• Additional Properties of Windows Executables Collection Settings
Enhancements and important changes
The following table lists enhancements and changes that are introduced in
this update.
Abstract

Description

Available since

New capability: ‘Scan

This task installs or

10.0.1.1

ner installation for Big upgrades the scan
Fix Inventory use only

ner for BigFix Inven

on Windows’

tory use only to ver
sion 9.2.19.1000
(20/06/25) on Win
dows. Using this task
allows installing sepa
rate instance of scan
ner for BigFix Invento
ry. The separate HCL

Abstract

Description

Available since

CIT installation allows
coexistence with IBM
CIT where other IBM
products are IBM CIT
exploiters. The sepa
rate instance does not
impact the compati
bility and upgrades of
the IBM CIT caused by
other IBM exploiters.
The scanner includes
an optional feature to
collect a Windows ex
ecutable metadata in
formation.
When this scanner
is installed, the other
fixlet should be run as
well: ‘Update Catalog
Download fixlet
templates on BFI serv
er’ to allow automatic
catalog software prop
agation with new CIT
Scanner instance.
Document describing

HCL Acquired from

how to manage in Big

IBM software products

Fix Inventory license

that are developed by

for HCL software prod HCL and new versions
of them were released.

10.0.1.1

Abstract

Description

ucts that are licensed

Some of them are li

for IBM metrics

censed according to

Available since

IBM metrics. This doc
ument describes how
customers can man
age licenses for these
products in BigFix In
ventory and can be ob
tained from BigFix In
ventory support.
New discovery capa

Discovery of software

bility: Docker

for Linux:

10.0.1.1

• Docker Engine
Community Edi
tion
• Docker Engine
Enterprise Edi
tion
• Docker Engine
(enhanced dis
covery mecha
nism)
• Docker Engine
EnterpriseEdition
New discovery capa

Discovery of software

bility: Kubernetes

for Linux:

10.0.1.1

Abstract

Description

Available since

• Kubernetes
kubeadm
• Kubernetes
kubectl
• Kubernetes
kubelet
Catalog updates
Enhanced discovery

Discovering additional

capability: ASP.Net

versions for Microsoft

Core

ASP.NET Core. This

10.0.1.1

discovery mechanism
is based on ‘template
signature’, so version
is gathered automat
ically for all software
releases.
Defect fixes
For the list of known defects please refer to HCL Knowledge Base.
The following table lists APARs and other defects that are fixed in this update.
Behavior after
ID

Symptoms

you install the

Available since

update
KB0080737

Components

Correct process 10.0.1.1

discovered/re

ing on endpoint

ported in SUA

side to assure

package data

well- formed re

not imported

sult when Pack
age Data con

Behavior after
ID

Symptoms

you install the

Available since

update
due to parsing

tains new line

error

character in val
ue (Windows
Endpoint Only)

KB0080844

Initiate Software Corrected Ac
Scan Fails on

tion Script to

Windows sys

handle case

tems with Hy

when path is

per-V or Docker

not reported for

Desktop

process

10.0.1.1

Catalog updates
KB0075995

Some versions

Missing ver

of ‘CrowdStrike

sions will be dis

Falcon Sensor’

covered

10.0.1.1

were not discov
ered
KB0080366

VMware

VMWare

vSphere Update

vSphere Update

Manager indi

Manager will

cates incorrect

have versions

version in BFI

synchronized

software classi

with file version

fication

of the applica
tion main exe
cutable vmwareumds.exe.

10.0.1.1

Behavior after
ID

Symptoms

you install the

Available since

update
KB0078849

PowerShell 1.0

Problem oc

and 2.0 signa

curred with Win

ture being de

dows version

tected as sepa

7 and higher,

10.0.1.1

rated installation where Power
on newer sys

Shell 2.0 is still

tems

visible in registry
as separate in
stallation. Fixed
signature is not
being detected
when there is
newer version of
PowerShell vis
ible in registry
or package da
ta – PowerShell,
and vendor - Mi
crosoft Corpora
tion
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Table 35. Published site version
Name of the component

Version

BigFix Inventory Content Site
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Updated in this re
lease
Yes

Table 35. Published site version (continued)
Updated in this re

Name of the component

Version

BigFix Inventory Software Catalog (main

10.0.1.0

Yes

2638546

Yes

BigFix Inventory Server

10.0.1.0

Yes

BigFix Inventory Scanner

9.2.19.0000

No

9.2.19.1000 (Win

Yes

lease

version)
BigFix Inventory Software Catalog (ver
sion on endpoint)

dows)
BigFix Inventory Disconnected Scanner

10.0.1.0

Yes

9.2.19.0 (for IBM I)
BigFix Inventory VM Manager Tool

10.0.1.0

Yes

SAP Metric Data Collector

10.0.1.0

Yes

Included software catalog
This release includes Software Catalog version 10.0.1.0 that contains:
• IBM License Metric Tool Software Catalog version 9.2.19.0
• capability to discover and collect evidence about usage of Oracle Java
Commercial Features: ‘Java Flight Recorder’ and ‘JRE Usage Tracking’.
For more information please refer to:
• Catalog Release Notes
• Catalog Change List:
Modified content

The version included in fixlet’s name is 10.0.1.0.
The following fixlets were updated and should be run to install newer versions
of the specific components.
• BigFix Inventory upgrade to version 10.x
• Updated Software Catalog
• Upgraded Scanner
• Update SAP Metric Data Collector
• Update VM Manager Tool
• Download the Disconnected Scanner Package for IBM I
• Download the Disconnected Scanner Package
The following fixlets were updated and require that actions created by their
previous versions are stopped and then started by using the updated fixlets.
Restarting actions is necessary to ensure that new features work properly.
• Initiate Software Scan
• Initiate Software Scan on Shared Disks
• Upload Software Scan Results
• Run Capacity Scan and Upload Results
• Run Capacity Scan on Virtualization Hosts
• Get Oracle Concurrent Sessions Number
• Get Oracle Features
The following fixlets were updated but it does not require any additional
actions.
• Collect Detailed Hardware Information
• Configure File Checksum Collection
• Download BigFix Inventory
• Identify Computers on Public Clouds
• Install Additional VM Manager Tool (OPTIONAL)

• Install SAP Metric Data Collector
• Install VM Manager Tool
The following fixlet was added but it does not require any additional actions.
• Configure Collection of Additional Properties of Windows Executables
Enhancement and important changes
For a list of enhancements introduce in this release, see: What's New
Defect fixes
For the list of known defects please refer to HCL Knowledge Base.
The following table lists APARs and other defects that are fixed in this update:
Behavior af
ID

Symptoms

ter you install

Available since

the update
Server updates
KB0069306

Instructions for

Documentation

Discovering us

is corrected.

10.0.1.0

age of Oracle
Database fea
tures are incor
rect.
Reference to in
correct folder.
KB0074225

Missing plat

Check added to

form check

the Initiate Soft

when using

ware Scan fixlet

Docker scan.

for Docker scan

10.0.1.0

Behavior af
ID

Symptoms

ter you install

Available since

the update
support for Lin
ux only.
KB0079766

KB0080092
IJ22881

Package Sum

Package Sum

mary report cal

mary report cal

culation fails.

culated properly.

Catalog im

Catalog import

port fails during

is successful.

10.0.1.0

10.0.1.0

merge step with
IBM catalog.

KB0080339

Invalid
credential
s suspended

status on the
VM Manager
Panel.

Configuration to 10.0.1.0
be used in spe
cial cases when
communication
between vmtool
and hypervisor
hangs (Power
Shell integration
only) due to net
work issues. Set
vmm_max_subsequent_login_failures to 0

in vmmmainconf.properties

in order to avoid
hard timeout.

Behavior af
ID

Symptoms

ter you install

Available since

the update
KB0079609

On the VM Man

Additional logic

agers panel the

added to discard

following error

all root comput

occurs when

ers which are

DSA environ

not seen for over

ment is detect

a month, if multi

ed.

ple remain then
the one with

Before

VM Man Tool

you can

installed is se

configure

lected, in case

VM

there are more

managers,

the one with the

you must
install
and run
the BigFix
services,
including
Web
Reports,
on the
%{host}.
Ensure also
that the
BigFix
server
user that
is

lower id is se
lected.

10.0.1.0

Behavior af
ID

Symptoms

ter you install

Available since

the update
defined
for the
primary
data
source has
sufficient
rights.
For more
informatio
n, see the
product
documentat
ion.

All the VM Man
agers appear
distributed.
KB0079543

Degradation of

Improved re

response time

sponse time on

10.0.1.0

on API Software API Software In
Instances v2 on

stances v2.

long running en
vironments.
KB0079197

Get Oracle Fea

Scenario with

tures task failure username with
in case of user

>8 characters is

names with >8

addressed.

characters.

10.0.1.0

Behavior af
ID

Symptoms

ter you install

Available since

the update
KB0079191

Data import fails Data import is
with the follow

10.0.1.0

successful.

ing error:
SQL0433N
Value is
too long.
SQLSTATE=22
001

KB0078385

Run Capacity

Run Capacity

Scan fixlet fails

Scan is success

when there are

ful.

10.0.1.0

many scanfiles.
KB0078264

The old slm

When a com

tagsearch files

puter gets a

with old com

new computer

10.0.1.0

puter_id are kept ID the old slm
and uploaded to tagseach zip
the BigFix server files are deleted
upload sha1 di

on the endpoint.

rectory.
KB0075611

Scanner trigger

Protection

ing mounts of

mechanism was

shares.

added to Initiate
Software Scan
to prevent ex

10.0.1.0

Behavior af
ID

Symptoms

ter you install

Available since

the update
clusion without
wildcard.
KB0077322

Error in assign

Part number can 10.0.1.0

ing a part num

be assigned now

ber that has

to a different

been assigned

product.

in the past to a
deleted custom
product.
KB0076885

Software not

Software is dis

discovered

covered.

10.0.1.0

when signature
is added to an
existing product
created earlier
in Products and
Metrics.
IJ16175

The Initiate Soft The requirement 10.0.1.0
ware Scan fixlet

is removed.

requires the
pkgdb to work.

IJ21733

Creation of the

The problem

BigFix Invento

does not occur.

ry database fails
on Windows due
to compatibili
ty issues even

10.0.1.0

Behavior af
ID

Symptoms

ter you install
the update

though the data
base compati
bility level is cor
rect. The follow
ing error is dis
played.
The
database
must have
an SQL
Server
compatibil
ity
level of
least
110 (it's
currently
90).
If you have
migrated
this
database
from
an earlier
version
of SQL
Server,

Available since

Behavior af
ID

Symptoms

ter you install

Available since

the update
you must
update its
compatibil
ity
level
before
it can be
used.

IJ21747

BigFix Inven

The problem

tory does not

does not occur.

work and the fol
lowing error is
written in the
tema.log file.
com.ibm.ws
.webcontain
er.webapp I
SRVE0292I:
Servlet

Message
[tema]:.[FA
TAL]
ActionView
::Template:
:Error
(Unknown
error

10.0.1.0

Behavior af
ID

Symptoms

ter you install

Available since

the update
(SystemCal
lError)
- Unknown
Error (0)
/
var/opt/IBM
/LMT/ilmt/
wlp/usr/se
rvers/serve
r1/apps/tem
a.war/
WEB-INF/tmp
/cache/A02/
2C1/
views%2Fso
ftware_inst
alls_widget
_0_
true_0_en%2
F5887e2c04c
983629206d8
6835e34da4b
)
[…]

IJ21800

Update of

The problem

the database

does not occur.

schema fails

10.0.1.0

Behavior af
ID

Symptoms

ter you install
the update

due to invalid
handling of ex
isting indexes.
The following er
ror is visible in
the tema.log file.
createOutpu
tTable
com.ibm.db
2.jcc.am.Sq
lSyntaxErro
rException:
The name of
the object
to be
created is
identical
to the
existing
name
"AGGR.METR
IC_OTHER_GR
_1_IDX1"
of type
"INDEX".SQ
LCODE=-601
,

Available since

Behavior af
ID

Symptoms

ter you install

Available since

the update
SQLSTATE=42
710,
DRIVER=3.7
2.24

IJ22183

Documentation

Documentation

does not speci

is corrected.

10.0.1.0

fy that HOSTID
values on a lo
cal zone and its
parent global
zone must be
the same in or
der to match the
guest and host
system. Other
wise, BigFix In
ventory is un
able to proper
ly build virtual
ization struc
ture informa
tion and the "No
Host Scan Da
ta" status is dis
played for the
guest system.
IJ22221

A user cannot

The problem

generate the au does not occur.

10.0.1.0

Behavior af
ID

Symptoms

ter you install

Available since

the update
dit snapshot un
der the following
circumstances:
• The user is
not an Ad
ministrator
• The user is
assigned
a role that
allows for
generating
the audit
snapshot
• The user
does not
have a per
mission to
view the
Audit Trail
IJ22241

A disconnected

The problem

data source can does not occur.
not be created
on a computer
on which a cus
tom computer
property is de
fined.

10.0.1.0

Behavior af
ID

Symptoms

ter you install

Available since

the update
IJ22562

A KVM has the

The problem

"No Data" sta

does not occur.

10.0.1.0

tus despite it
was successful
ly scanned by
the Run Capaci
ty Scan on Virtu
alization Hosts
fixlet. The prob
lem occurs be
cause the output
of the virsh com
mand does not
show any guest
systems even
though they are
present and ac
tive.
IJ22782

Relevance 11 of

The problem

the Initiate Soft

does not occur.

ware Scan fixlet
returns the fol
lowing error on
Solaris.
Singular
expression
refers to

10.0.1.0

Behavior af
ID

Symptoms

ter you install

Available since

the update
nonexisten
t object

IJ23216

The VM Man

The error mes

10.0.1.0

agers panel can sage is im
not be displayed proved to indi
because Web

cate what is the

Reports are not

cause of the

running. Howev problem.
er, only a general
error message is
displayed.
IJ23221

When a software The problem
component was
discovered in
the past and lat
er on it was re
moved from the
software cata
log, the informa
tion about the
component be
comes inconsis
tent. The BigFix
Inventory data
base contains
correct infor
mation. How
ever, the Soft

does not occur.

10.0.1.0

Behavior af
ID

Symptoms

ter you install

Available since

the update
ware Classifica
tion and the PVU
Subcapacity re
ports provide in
correct informa
tion.
IJ23369

Documentation

Documentation

provides incor

is corrected.

10.0.1.0

rect descrip
tion of the catalog_dimensions

columns.
IJ22565

The "No VM

The problem

Manager Da

does not occur.

ta" status is dis
played for vir
tual machines
that are host
ed on VMWare
ESXi 6.7. The
problem oc
curs because
the UUID from
a local/guest
hardware scan
does not match
the value re
turned in vCen

10.0.1.0

Behavior af
ID

Symptoms

ter you install

Available since

the update
ter. The initial
three portions of
the UUID appear
to be mixed. As
a result, BigFix
Inventory cannot
match VMs and
calculate PVU
values.
BI-537

Signature de

Signature de

scription text

scription cor

misleading for

rected.

10.0.1.0

software that is
discovered with
package data.
BI-733

When BigFix

The problem

server is con

does not occur.

10.0.1.0

figured to use
backup server
(BigFix DSA sce
nario), all the VM
Managers ap
pear distributed
after BigFix In
ventory applica
tion upgrade.
BI-454

When trying to

The problem

access VM Man does not occur.

10.0.1.0

Behavior af
ID

Symptoms

ter you install

Available since

the update
agers manage
ment screen, if
a data source
isn't available it
throws the fol
lowing UI error:
We are sorry, but
something went
wrong.
BI-253

REST API filter

Filtering criteria

10.0.1.0

ing criteria of as work properly.
sociated tables
does not work.
BI-277

Collecting
utilizatio

The problem

10.0.1.0

does not occur.

n of SAP
license
metrics

not working
properly, error
in SAP tool log
"Persistent ID is
invalid".
BI-711

Too restrictive

Installation is

version check

successful.

prevent installa
tion on support

10.0.1.0

Behavior af
ID

Symptoms

ter you install

Available since

the update
ed editions of
DB2 v11.5
BI-529

All Metrics - fil

Filters work cor

ters work in

rectly.

10.0.1.0

correctly when
comma or + is
used in text filter
criteria.
BI-762

Catalog Search

Catalog search

on the dash

works properly.

10.0.1.0

board does not
work after rein
stalling BFI with
the same data
base.
BI-1164

Data import fails Data import is
with following
error:
One or more
values in
the INSERT
statement
,
UPDATE
statement,
or foreign

successful.

10.0.1.0

Behavior af
ID

Symptoms

ter you install
the update

key update
caused
by a DELETE
statement
are not
valid
because
the
primary
key,
unique
constraint
or unique
index
identified
by "2"
constrains
table
"SAM.VERSI
ONS" from
having
duplicate
values for
the index
key..
SQLCODE=-8
03,
SQLSTATE=2
3505,

Available since

Behavior af
ID

Symptoms

ter you install

Available since

the update
DRIVER=3.72
.24

196939

It is not possi

Documentation

ble to use the

is updated to

Airgap Tool

provide informa

in non-extrac

tion on how to

tion mode be

extract the in

cause informa

formation about

tion about the

the e-mail ad

e-mail address

dress and the

10.0.1.0

and license seri serial number.
al number that is For more infor
needed for this

mation, see: Up

procedure is not dating the con
available to the

tent of the fixlet

user.

site on Linux
and Updating
the content of
the fixlet site on
Windows.

196937

The /usr/lpp

The /usr/lpp

folder is incor

folder is re

rectly excluded

moved from the

from the soft

list of excluded

ware scan.

directories. Soft
ware that is in
stalled in this

10.0.1.0

Behavior af
ID

Symptoms

ter you install

Available since

the update
folder is correct
ly discovered.
196797

In very rare cas

The problem

es, the VM Man

does not occur.

10.0.1.0

agers panel
does not show
any existing VM
entries because
it treats the VM
Manager Tool as
deleted.
196971

Serial number

The -retrievede

of the hypervi

bugdata com

sor missing in

mand collects

10.0.1.0

retrievedebugda information
ta output.

about the seri
al number of the
hypervisor.

Catalog updates
KB0077313

BEA WebLogic

Invalid signature 10.0.1.0

Server v7 incor

is no longer in

rect discovery.

catalog to not
cause incorrect
discovery re
sults.

KB0076466

Invalid sig

Invalid sig

natures for

natures is no

10.0.1.0

Behavior af
ID

Symptoms

ter you install

Available since

the update
Microsoft

longer in cata

Project Server

log.

2016/2019.
KB0080084

Change com

New software

ponent name

name is visible

from 'Microsoft

in reports.

10.0.1.0

ASP .NET' to
'Microsoft
ASP .NET Core.
Security enhancements
To maintain security, few selected components and libraries were updated.
For more information, see the security enhancement updates under
Application updates 10.0.1.
VM Manager Tool version and changes
The version of the VM Manager Tool that is used with this application update
is 10.0.1.0.
Scanner version and changes
The version of the scanner that is used with this update is, 9.2.19.1000 for
Windows and 9.2.19.0000 for other platforms.
The version of the disconnected scanner that is used with this update is
10.0.1.0. As an exception, the version for disconnected scanner for IBM I is
9.2.19.0
Support for new systems and hypervisors
The following table lists new systems and hypervisors that are supported
starting this release:

Supported systems and hypervi
sors

Requirements

MS SQL 2016 Express

BigFix Inventory database

MS SQL 2017 Express

BigFix Inventory database

Citrix Hypervisor 8
IBM i 7.4

Disconnected scanner

Oracle Compute Instance
End of support for systems and hypervisors
Support is dropped for the following operating systems and virtualization
technologies
• Operating systems
◦ Debian 7
◦ IBM i 5.1
◦ Oracle Solaris 10
◦ Red Hat Enterprise Linux 5 on x86
◦ Ubuntu 12
◦ Ubuntu 14
◦ Windows Vista
• Hypervisor and virtualization technologies
◦ Red Hat Virtualization 3.x
◦ VMware vSphere 5.x
◦ XenServer/ Citrix XenServer 6.x

Previous application updates
For a full list of enhancements introduced in older versions of the product, see What's new
in this release.
APARS that were fixed in the previous updates

The following table lists the APARs and other defects that were fixed in the
previous updates:
Behavior af
ID

Symptoms

ter you install

Available since

the update
KB0078569

Incorrect dis

Discovery cor

10.0.0.1

covery of Oracle rected for ver
WebLogic v10.3
detailed version

sion 10.3
Detailed Com

Detailed Com

ponent Version

ponent Version

does not include

may include ad

extra characters

ditional char
acters in some
cases
KB0077224

Golden Gate 11

Discovery cor

and 12 on Linux

rected

10.0.0.1

not discovered
KB0077320

Microsoft Host

Discovery cor

10.0.0.1

Integration Serv rected
er 2016.0 not
discovered
KB0078545

Veritas Perl for

Discovery cor

VRTSvcs and

rected

VRTSPerl ver
sion discovery
issues

10.0.0.1

Behavior af
ID

Symptoms

ter you install

Available since

the update
KB0078543

Incorrect discov Discovery cor
ery of Audible

10.0.0.1

rected

Manager 5.1

IJ20095

IBM Cognos

To keep back

Analytic Serv

ward compatibil

er (IBM Cognos

ity of IBM cata

Analytic Serv

log import some

er for Non-Pro

part numbers

duction Environ that were asso
ment) changed

ciated with prod

name to IBM

uct IBM Cognos

Planning An

Analytic Server

alytics Local

will not be asso

TM1 Server (IBM ciated with prod
Planning Analyt uct IBM Plan
ics Local TM1

ning Analytics

Server for Non-

Local TM1 Serv

Production En

er. It might af

vironment). The

fect automated

part number that bundling capa
should discov

bility. To resolve

er the new prod the issue, use
uct is assigned

custom bundling

to the old prod

to assign com

uct in the soft

ponents to cor

ware catalog. As rect products.
a result, the old

10.0.0.1

Behavior af
ID

Symptoms

ter you install

Available since

the update
product is dis
covered.
IJ21789

IJ22354

KB0073588

IBM Tivoli Work IBM Tivoli Work 10.0.0.1
load Scheduler -

load Scheduler

Agent

- Agent 8.2 is

8.2 is not dis

properly

covered

discovered

Informix 4GL

Informix 4GL

7.51 is not dis

7.51 is discov

covered

ered

Reported lower

There is report

number of Serv

ed correct num

er Active Sock

ber of sockets

10.0.0.1

9.2.19

ets
KB0075037

Incorrect num

There is report

ber of cores de

ed correct num

tected for cer

ber of cores

9.2.19

tain Xeon E7
processors (re
gression in
9.2.17 and
9.2.18 Scanner)
Import of data
IJ21455

fails with the fol The problem
lowing error.
does not occur

9.2.19

Behavior af
ID

Symptoms

ter you install

Available since

the update
WARN:(ImportCapacity-Thread:0)
CapacityScanFileHandler::proces
sTask:: Some
error occurred
during importing the capacity scan from
file

./file_name.xml
for endpoint :
endpoint_id
196957

Capacity scan

fails to read SM ta is retrieved
BIOS data on

from DMI tables

UNIX due to

prior to other

memory access
error.
KB0076873

The SMBIOS da 9.2.19

methods.

Hyper-V VM

VM Managers

Managers go

behavior cor

"Invalid creden

rected and issue

tials - suspend

resolved.

ed" even though
the

10.0.0.0

Behavior af
ID

Symptoms

ter you install

Available since

the update
credentials work
fine.
KB0076850

Wrong format

Number format

for the Metric

for the Metric

10.0.0.0

Quantity column Quantity column
in All Metric Re
port

is in line with
other number
formats

KB0076241

App error while

Suppress op

trying to sup

tion for multiple

press multiple

rows working

rows of soft

properly and no

ware

10.0.0.0

error is dis
played.

KB0075708

Incorrect date

Date stamp col

time zones pro

lection corrected

10.0.0.0

duced by Collect for the Collect
Detailed Hard
ware Informa
tion fixlet
KB0075619

Import failing at

Detailed Hard
ware Informa
tion fixlet
Import runs suc 10.0.0.0

ETL step related cessfully for this
to UsageManag step and config
er - on Linux

uration

Behavior af
ID

Symptoms

ter you install

Available since

the update
KB0075451

Out of Memory

IBM WebSphere

issues may oc

Application

cur

Server Liberty

10.0.0.0

was upgraded
to higher version
and issue is
addressed
KB0074869

Large amount of Improved import 10.0.0.0
Registered User

time for large

metric causes

amount of Reg

slow data import istered
time
KB0074818

User metric

Duplicated en

Issue with dupli 10.0.0.0

tries when a

cated entries re

template signa

solved

ture is updated
KB0074707

Adobe Animate

Signature for

CC discovered

other compo

due to incorrect

nent was cor

10.0.0.0

signature defini rected to not
tion.

discover Adobe
Animate
CC

KB0074700

Microsoft Sys

Discovery

tem Center Con method correct
figuration Man

10.0.0.0

Behavior af
ID

Symptoms

ter you install

Available since

the update
ager 2012 is re

ed to exclude

ported using

client

scclient.exe
KB0074748

KB0074686

Incorrect MySQL Correct MySQL
Server version

Server version

detected

discovery

Old edition still

Old edition of

reported after

Microsoft SQL

Microsoft SQL

Server 2016 is

10.0.0.0

10.0.0.0

Server reinstalla not reported af
tion

ter it is replaced
with new
edition

KB0074643

BI-79

CIT installation

CIT installation

files permis

files have cor

sions issue

rect permissions

Error when send Scheduler work
ing email may

10.0.0.0

10.0.0.0

ing properly

crash
scheduler
BI-142

Icon for CIT sig

Updated icon

natures in Cata

in Catalog Cus

log Customiza

tomizations for

tions is mislead Extended
ing

Signature

10.0.0.0

Behavior af
ID

Symptoms

ter you install

Available since

the update
BI-174

Non admins

Non-admin user

cannot get Sup

with proper per

port Data de

mission has this

spite it is docu

option

mented in Doc
BI-386

10.0.0.0

available now

Supplemen

Incorrect data is 10.0.0.0

tary fix for to

properly handled

KB0073588
- change the
processors view
to handle
incorrect data
BI-456

Incorrect Logs

Logs are cor

during FileFact

rected

10.0.0.0

Import - all
the time
Processed 0% of
files
BI-367

BI-384

Remove bzip2

Install Scanner

from Install

fixlet does not

Scanner

include bzip2

Disconnected

Correct build

Scanner for IBMi version in Dis
fixlet description connected Scan
contains incor

ner for IBMi

rect build

fixlet description

10.0.0.0

10.0.0.0

Behavior af
ID

Symptoms

ter you install

Available since

the update
version
BI-60

Template signa

Correct template 10.0.0.0

tures based on

signatures are

package version generated
are incorrectly
generated when
package ver
sion is like '9.0
(6028)'
BI-27

Sybase Adap

Signature updat 10.0.0.0

tive Server Enter ed to assure cor
prise 15.7 - ex
rect discovery
isting signature
expect "SAP" in
name of prod
uct, whereas
name does not
contain it
BI-104

Wrong file name Signature updat 10.0.0.0
in the CIT signa ed to assure
ture for

correct discov

SQL Data Com

ery

pare component
BI-281

Disk2Vhd 2.1

Component Ver 10.0.0.0

should have ver sion is 2.01 De
sion 2.01

tailed Compo
nent Version

Behavior af
ID

Symptoms

ter you install

Available since

the update
stays in line with
file version
2.1.
IJ21245

After upgrad
ing to 9.2.17,

IJ21245

10.0.0.0

IJ21162

10.0.0.0

the server can
not be accessed
with the follow
ing message:
We are sorry, but
something
went wrong.
IJ21162

Incorrect end of
support date for
IBM
MQ 9.0.

IJ21140

The partition
cores report
ed on the Hard
ware Invento
ry report do not
match the CPU
Core Subcapac
ity Limit on the
IBM PVU Subca
pacity report for
machines

IJ21140

10.0.0.0

Behavior af
ID

Symptoms

ter you install

Available since

the update
on Amazon pub
lic cloud.
IJ21123

Schema update

IJ21123

10.0.0.0

IJ21002

10.0.0.0

IJ20158

10.0.0.0

fails with com
patibly
level check er
ror reported in
tema.log.
IJ21002

When importing
capacity scan
with the future
date, the import
of current scans
fails.

IJ20158

When config.s
so.debug is en
abled, a clear
text password
is shown in
team.log.

IJ19979

Import of data
fails with the fol IJ19979
lowing error: IN
FO: ETL from
Data Source
- SAM::Scan
File ERROR: Se

10.0.0.0

Behavior af
ID

Symptoms

ter you install

Available since

the update
quel::Check
ConstraintVio
lation: The UP
DATE statement
conflicted with
the CHECK con
straint
"ckt_samscan_
files_scd".
IJ19901

Central VM Man
ager Tool is in

IJ19901

10.0.0.0

correctly deter
mined when us
ing the BigFix
disaster recov
ery model with
the DSA
server as a
backup existing
in the environ
ment.
IJ21042

Software scan
based on pack
age data fails on
Solaris servers
due to missing
implementation

IJ21042

10.0.0.0

Behavior af
ID

Symptoms

ter you install

Available since

the update
of IPS repository
for
package data
collection.
IJ20419

Fixlets related

IJ20419

10.0.0.0

to VM managers
are not
relevant on De
bian OS.
IJ17980

The Run Capac
ity Scan and Up
load Results
(9.2.15.0) fixlet
shows the -1 exit
code. The fixlet
action script
shows the fol
lowing infor
mation:--- Com
pleted wait sh
-c "' {parame
ter "homefold
er" as string}/
runcit_tlm_h
w.sh' > '{parame
ter "logfilepath"
as string}' 2>&1"
Failed

10.0.0.0
IJ17980

Behavior af
ID

Symptoms

ter you install

Available since

the update
continue if {exit
code of action =
0}
IJ20761,

The vendor in

IJ20776

formation is not

IJ20761IJ20776 10.0.0.0

collected by the
capacity scan
because the
newer version of
BIOS is available
on the
physical server.
IJ20098

Capacity scan

IJ20098

10.0.0.0

Scanner up

Scanner up

10.0.0.0

grade on Win

grade success

dows 2019 fails

ful

does not collect
information
about BIOS.
196556

with the fol
lowing mes
sage: Can't ex
ecute com
mand '"C:\Pro
gram Files\tivoli
\cit\bin\ws
cancfg.exe" -en

Behavior af
ID

Symptoms

ter you install

Available since

the update
able all', result
was: 0 Exec '"C:
\Program Files
\tivoli\cit\bin
\wscancfg.exe"
-enable all' re
turned -1 *** Er
ror: could not
restart CIT. In
stallation failed,
rolling back
Done.
196412

The capping val Capping values

10.0.0.0

ues of CPU pool, corrected
LPAR group and
tenant resource
group are not
converted or are
incorrect.
196379

The discon
nected scanner
scans the paths
defined as
$DOCKER_
EXCLUDED_
PATHS.

Paths corrected

10.0.0.0

Behavior af
ID

Symptoms

ter you install

Available since

the update
196332

Using the dis

No scan failure

10.0.0.0

connected scan in the described
ner on a ma

scenario

chine with lo
cale suffix set to
@euro causes
the scan failure
with a 255 error
and the fol
lowing mes
sage:COULD
NOT LOAD A
TRANSCODING
SERVICE
196207

The warning

Warning mes

10.0.0.0

that is displayed sage corrected
during import
is not clear:
WARN: Can't find
component :
<SAM::Compo
nentLifecycleEn
try:0x43f7
cf2>
KB0074925

When BigFix In

Consistent date

ventory agents

format for last

complete scans,

9.2.17

Behavior af
ID

Symptoms

ter you install

Available since

the update
last scan at

scan attempt

tempt date is

date.

showing incon
sistently some
times with dd/
mm/yy format
and sometimes
with mm/dd/yy
format.
KB0074586

"Publisher

"Publisher

9.2.17

Name" and "Ven Name" and "Ven
dor" fieldsare

dor" fields cor

wrongly popu

rectly populated

lated on non-

on non-English

English UI with

UI

the equivalent
of "&lt;no data>"
in the given lan
guage when try
ing to create
signature from
Package data.
KB0074358

User not able to

Authorization

delete saved re

in place to not

ports using BFI

allow to delete

console but able saved reports
to delete them

9.2.17

Behavior af
ID

Symptoms

ter you install

Available since

the update

KB0075033

using developer

from developer

tools

tools

Incorrect discov Corrected dis
ery of Python

9.2.17

covery of Python

versions 2.x, 3.2, software
and 3.4.
KB0074191

Data Import fails Data import is
when BigFix In

9.2.17

successful.

ventory and Big
Fix are using dif
ferent database
type
KB0074063

CSV and PDF re Total Runs num 9.2.17
ports for Soft

ber exported in

ware Installa

to reports

tions (Deprecat
ed) panel do not
show Total Runs
number for us
age data
KB0073902

Data Import fails Additional erro
when two scan

neous files are

results exists for discarded. Only
a given comput

file assigned to

er

given computer
is

9.2.17

Behavior af
ID

Symptoms

ter you install

Available since

the update
imported.
KB0073349

Bundling status

Data import is

widget causes

successful

9.2.17

Data Import to
fail
KB0073035

Unable to down Successful
load PVU Audit

download of

snapshot

PVU Audit snap

9.2.17

shot
KB0072803

Column reorder

Column selec

is not updat

tion and reorder

ed when col

preserved for

9.2.17

umn selection is scheduled
changed
KB0073085

reports

Missing data

Re-aggregation

due to a reag

requests are

gregation issue

correctly set in

9.2.17

identified
scenarios
KB0072802

Import errors -

Software Users

Cannot insert

are imported

duplicate key

properly

9.2.17

row for Software
Users
KB0074680

Adobe Photo

Correct Adobe

Shop applica

PhotoShop ap

9.2.17

Behavior af
ID

Symptoms

ter you install

Available since

the update
tions usage sta

plications usage

tistics are not

statistics

accurate on Mac on MAC OS
OS
IJ19251

The Initiate Soft The Initiate Soft 9.2.17
ware Scan fixlet

ware Scan fixlet

should verify the is updated.
OS platform as
Docker scan is
supported only
on Linux.
IJ18134

When a docker

The issue does

image does not

not occur

have any
.SWIDTAG sig
nature file in
side, the follow
ing error mes
sage is returned:
cp: cannot stat
'/var/opt/BES
Client/LMT/CIT/
docker/ima ges/
z987654321y0/
*': No such file
or
directory

9.2.17

Behavior af
ID

Symptoms

ter you install

Available since

the update
IJ17594

PVU table spec

PVU table is up

ifies 120 PVUs

dated

9.2.17

for the IBM z14
LR1 (3907)
Rockhopper 1
processor. How
ever, the
value should be
100 PIUs
IJ17219

Run Capacity

Run Capacity

Scan on Virtu

Scan on Virtual

alization Hosts

ization Hosts on

fails with the

KVM

Exit Code 1 on
KVM hosts.
BI-23

Cannot create

9.2.17

hosts runs suc
cessfully
Issue resolved

9.2.17

Issue with for

Formatter cor

9.2.17

matter

rected to handle

SAMproces

nil values

disconnected
datasource Something went
wrong
BI-17

sors_by_com
puter_type_fo

Behavior af
ID

Symptoms

ter you install

Available since

the update
rmatter: han
dling nil values
BI-58

Modify schwrap No false spy
per.vbs in dis

9.2.17

ware detection

connected scan for schwrap
ner to avoid

per.vbs

false spyware
detection
BI-111

Windows in

Issue resolved

9.2.17

'NaN.undefined'

<no data> pre

9.2.17

instead of <no

sented properly

staller: installer
hangs when try
ing to stop BI
server.
BI-18

data> in Average in Average Runs
Runs per Day
BI-217

per Day

BFI upgrade fails Invalid entry in
due to database software catalog
schema update
issue caused by
invalid entry in
software catalog

does not impact
upgrade

9.2.17

Keeping BigFix Inventory up-to-date
BigFix Inventory updates and content packs are released periodically. Ensure that you
upgrade the BigFix Inventory server with each release to take advantage of the new features
and apply the application patches.

Periodical updates
Release of a BigFix Inventory application update
BigFix Inventory update is released periodically, typically at the end of each
calendar quarter. The update contains a variety of new and improved features
as well as the application patches. BigFix Inventory version increments with
each release, and is independent of the version of the BigFix platform.
Release of a content pack
Apart from application updates, a content pack is released usually at the end
of each month. A content pack provides new discovery capability for a number
of software components, and might contain modifications to fixlets. Content
pack does not upgrade the BigFix Inventory server.

How to turn on automatic notifications about application updates and content
packs
To keep current with BigFix Inventory and receive notifications about application updates,
subscribe to Announcements for BES Administrators. After you subscribe, you will receive email notifications related to the announcements.

Information about the latest releases and content packs
• For a list of features added in a particular application updates, see: What's new.
• For a list and description of every release and content pack as well as the list of
patches, see Updates and patches for BigFix Inventory and Release notes.

Currency of components

Keeping up-to-date
It is important to upgrade server with each release. You do not need to upgrade the
remaining infrastructure components, such as the BigFix server or clients that frequently. is
compatible with any supported version of BigFix. Upgrading the server resolves the majority
of known defects and allows you to take advantage of the newly developed and improved
features.

Versioning of the components
Versions of and the BigFixplatform are independent and they differ.
Starting from application update 9.2.15, the version of the application update
and versions of the internal tools of , such as, the scanner, SAP Metric Data Collector and
VM Manager tool are unified. In this update the version of each component is 9.2.15. In the
future, the version of each component will change to the version of the application update
only when this component will change.

Updating components
To make sure that your architecture is up-to-date, analyze the list of actions according to
their priority.
1. Upgrade to the newest version of
2. Stop your active actions, and then restart them using the newest versions of fixlets.
3. Upgrade the internal tools, such as, the scanner, SAP Metric Data Collector and VM
Manager tool. For more information, see: Installing the scanner and Updating VM
Manager Tool.
4. Optional: Upgrade the BigFix platform components. This step is optional and mainly
depends on your business needs and requirements. Upgrading the platform might
be related to the security measures as each update might bring a number of security
enhancements. From perspective, upgrading BigFix is usually not required for to
work properly. The majority of the features are independent and work with older
versions of the platform.

Ensuring currency of scanner actions and fixlets
Make sure that the scanner actions that are running on your endpoints are updated after
each application release. The fixlet names contain the information about version to help
you easily determine which actions are activated with the outdated fixlets and should be
restarted after the application update.

Versioning of fixlets
Starting from application update 9.2.15, names of all fixlets include their version
in brackets, for example; Initiate Software Scan (9.2.15.0).
The fixlet version is updated with each release of the product, regardless of whether the
definition of the fixlet changed. However, the versions of the internal tools, such as the
scanner, SAP Metric Data Collector and VM Manager tool are updated only when these tools
change. Therefore, it might occur that the version of the installation or upgrade fixlet and the
version of the tool that it deploys differ.

Best practices
Limit modifications of the fixlet names
Do not modify the entire name of the fixlet, but rather add a meaningful prefix
or suffix to it. Keep the version in the fixlet name, so that it is reflected in the
name of the initiated action. Thanks to this, you can easily distinguish the
actions that are initiated with different version of the fixlet.
Ensure currency of your scanner actions
Your actions are not automatically updated upon installing a new application
release. Whenever new version of fixlets are available, restart your current
actions. To check what actions to restart, compare the names of the active
actions with the names of the relevant fixlets. If the versions that are included
in these names are different, restart the actions.
To restart the single scanning action, perform the following steps.
1. Go to the BigFix console, and select Actions in the navigation tree.
2. Right-click the chosen action, and select Stop Action.

3. Go to Sites > External Sites > BigFix Inventory v10.
4. Choose Fixlets and Tasks, select the fixlet that you want to restart and
click Take Action. Make sure that the fixlet parameters are the same as
those set in the previously stopped action.
Note: server is compatible with the actions that were initiated with
the previous versions of the server. However, only by ensuring the
currency of your scanner action and fixlets you take advantage of new
features and improvements that are implemented in the new release.
Plan ahead
Plan ahead and be ready to restart your current actions every time a new
release of is installed. The plan should be aligned with your business needs
and should not prevent you from upgrading the server.

Features and functions
BigFix Inventory provides useful features for managing physical and virtualized
environments. It discovers the software that is installed in your infrastructure, helps you to
analyze the consumption data, and allows you to generate reports.

Hardware
BigFix Inventory shows detailed information about hardware that are integrated with 3rd
party applications.

Software discovery and identification
BigFix Inventory scans your infrastructure to determine the software that is installed on the
monitored computers.

Extending software discovery with custom signatures
BigFix Inventory allows to create a custom signatures. Creating custom signatures allow
you to manage software that are not discovered or are missing form the installation registry.

For more information, see Exporting and importing custom signatures. BigFix Inventory
includes a catalog of software products along with a set of rules called signatures. The
signatures are matched against the results of the scan to build a complete overview of
software that is installed in your infrastructure.

Software usage monitoring
BigFix Inventory leverages the capabilities of BigFix Platform to show a statistical data
about software usage.

IBM license usage reporting and compliance
BigFix Inventory, a replacement of IBM License Metric Tool, is an IBM certified application
for IBM sub-capacity.
BigFix Inventory provides the information that is needed to ensure compliance with
Processor Value Units (PVU), and Resource Value Units (RVU MAPC) audit reports licensing
terms.
BigFix Inventory calculates the maximum core capacity of the server that is available to
the installed IBM software. The application also determines the number of processor value
units (PVU) or processor-core entitlements that are required. If you deploy a supported
virtualization technology, the tool provides processor core capacity information for the
whole virtualized environment.
You can generate IBM permitted audit snapshot for IBM PVU and IBM RVU MAPC in your
infrastructure.

Enterprise software discovery and license usage reporting
BigFix Inventory has capabilities to discover selected enterprise software and calculate its
license usage.

Preview features
BigFix Inventory provides a set of preview features that give you a chance to take a sneak
peek at what we are currently developing and researching. Whether it is a small function or

an extended report, you can check how it works and tell us about your ideas. The previews
can change with each release, which means that you can still influence their final form.

Disclaimer
The preview features are subject to change and can be modified and improved based on
the customer needs and feedback. Some previews might gradually subside or be entirely
removed from the product.

Providing your feedback
Your feedback is crucial for the development team and your comments and suggestions
are very much appreciated. Test the new features and let us know what you think and what
can be improved. Use the following communication channels to provide your feedback at
talk2sam@hcl.com.

Limitations
Review the list of BigFix Inventory limitations. For information on IBM limitations, refer to
IBM limitations.

Installation and configuration
• Support for Distributed Server Architecture (DSA) is limited to one backup server
Distributed Server Architecture (DSA) allows for setting up multiple BigFix servers
that can replicate data between each other. BigFix Inventory does not support failover
but BigFix Inventory can work with BigFix Inventory configured in DSA mode. It is
recommended to configure BigFix Inventory server with primary BigFix Inventory
server. If the configured BigFix Platform server fails, BigFix Inventory server imports
continues to fail. It is recommended to restore BigFix Inventory and discontinue using
BigFix Inventory as a primary server. If you need to switch to BigFix Inventory server as
primary server, you need to reconfigure existing data source with BigFix Inventory and
then resynchronize datasources through resynchronize_datasources_once parameter
in Advanced Server Settings."
• Microsoft™ SQL Server used as the BigFix database cannot be case sensitive

Only case insensitive Microsoft™ SQL Server database is supported.
• Changing the host name of the BigFix server is not supported
The host name of the BigFix server cannot be changed because it is recorded in the
license certificate during the installation. To change the host name of BigFix, reinstall
the application.
• Creating clones of virtual machines that are running is not supported
Cloning virtual machines that are running might produce unexpected results in BigFix
Inventory.
• Language of the installer depends on the system locale
To run the BigFix Inventory installer in a language other than English, system locale
must be set to that language.
• Permissions that are defined for the Administrator role cannot be changed
The Administrator role is assigned all available permissions. It prevents from creating
separate Administrator roles, for example one responsible for data, the other for
users.

Using BigFix Inventory
• The scanner does not scan paths that contain certain whitespace characters and
other special characters
The scanner does not scan file paths that contain the following whitespace
characters:
◦ Carriage return (CR, character code 13)
◦ Line feed (LF, character code 10)
◦ Whitespace characters whose decimal codes are in the following ranges: 0- 8,
11-12, 14-31
It also does not scan shared disks whose mount point paths contain an asterisk (*) or
a question mark (?). To avoid a situation in which software is not discovered, ensure
that files paths in your infrastructure do not contain the unsupported characters.
• Software installed in the /Libraries directory on Mac OS X is not discovered
Only software that is installed in the /Applications directory is discovered.

• Information about Mac OS X computers is not presented on the IBM Capacity Data
Completeness widget
Computers running on Mac OS X are not included in the computer count on the IBM
Capacity Data Completeness widget. It happens because the types of scans that
produce results displayed on this widget are not run on Mac OS X. However, these
computers are included in the computer count on the Scan Health widget. It causes
that the overall number of computers displayed on each widget is different.
• Calculating utilization of the Managed PVU metric requires an additional
configuration of BigFix Inventory
Managed PVU metric is based on the number of processor cores available on
computers that are managed by an application, for example by BigFix Spectrum
Protect for Virtual Environments. Calculating utilization of the Managed PVU metric is
not available out of the box. To calculate its utilization, place an appropriate isotag
file on the computers that are managed by the particular application.
• Creating contracts and catalog customizations for IBM products is limited
IBM provides catalog content that allows for discovering practically all IBM products.
Due to internal reasons, entries for some products are duplicated in this catalog. Thus,
it is not possible to modify the correct entry and creating contracts for IBM products
might not work correctly. Moreover, BigFix Inventory supports contracts only for
installation-based licenses which are not applicable to the majority of IBM products.
Creating contracts for IBM products and customizing BigFix products in the software
catalog is discouraged.
Note: This limitation is applicable to the old contracts that were created
before BigFix Inventory version 10.0.5.
The new contracts are shown only for first 20 computer groups. The
contracts for any computer group that is beyond 20 is excluded from the report.
Computer groups are selected as per the order they were created (computer ID).
It excludes the computer groups that have metrics disabled. However, you can
select the computer groups using the 'new_contracts_max_computer_groups' and

'new_contracts_selected_computer_groups' hidden parameters from the Advanced
Server settings.
• Signatures with the same GUID and different rules might be overwritten
When you import a signature that has the same GUID as a signature that already
exists in BigFix Inventory and the new signature has a different number of rules than
the existing one, the signatures are not merged. Instead, the new signature overwrites
the existing one. The problem does not occur when the imported signature has a
different or no GUID.
• Software is detected twice if a custom catalog entry is the same as an entry in the
BigFix catalog or an entry generated from an isotag file
If you create a custom catalog entry which has the same publisher name, software
name, and version as an entry in the BigFix catalog or an entry generated from an
isotag file, both the custom and original entry is visible as detected.
• slmtag files with overlapping entries are not supported
Start time of one entry in an slmtag file cannot overlap with the previously reported
period. It should start at the end time of the previous entry or later.
• Adding excluded directories fails on Solaris when the number of characters in the
task exceeds 1000
When you use the Add Excluded Directories task and the specified list of directories is
longer than 1000 characters, the task fails on Solaris.
• Specific start time cannot be set for actions by using REST API
BigFix REST API requires that the start time for an action is specified as an offset
from the time on the BigFix server. The solution is prone to network latency problems.
It might cause that the action starts at time different from the intended one.

Reports
• Custom rule to suppress the discovery of software components of publishers from
SWID tags
With improvements for ISO SWID tags processing in versions 10.0.2
and 10.0.4, BigFix Inventory is capable to read information from most ISO SWID tags

released by vendors. This includes the ability to recover from issues within the tag
itself.
Reporting of software through ISO SWID tags is not normalized and the reports are
shown as usual. Currently, the following ISO SWID tags were indentified that results in
duplicate discovery of existing software catalog entries with below names:
◦ with the published defined as: Adobe Systems Incorporated
◦ with the published defined as: Microsoft Corporation
◦ with the component name of: Red Hat Enterprise Linux
Starting from version 10.0.4, predefined custom rules have been created to
suppress the duplicate discovery of software which have been already discovered
once.

With version 10.0.9, the issue of not marking already discovered

software have been addressed. In future releases, there might be added capability to
reject ISO SWID tags overlapping with catalog content.
• Reports show the current PVU per core value instead of the value that occurred
during the license peak time
IBM PVU Subcapacity and All Metrics reports as well as the audit snapshot show
the current PVU per core value instead of the value that occurred during the license
peak time. It does not affect the calculation of PVU subcapacity and full capacity.
To display the value that occurred during the license peak on the reports, change
the start date of the report to a more recent date. Try changing the date until you
find the date when the PVU per core value changed. It allows you to have consistent
information displayed on the reports.
• Data on the Software Installations report is inconsistent with data on other reports
Information on the Software Installations report regarding software installed on
shared disks or components installed multiple times on the same computer is
inconsistent with information on other reports. The inconsistency occurs also when a
column on a report links to a filtered view of the Software Installations report such as
in case of the Installed Software column on the Computers report. It happens because
the Software Installations report is based on the old data model that does not take
shared disks and multiple component instances into account.

Starting from application update 9.2.15, the old Software Installations report
is deprecated and substituted with a new report view. It is based on a new data model
and consistent with other reports. The limitation no longer applies.
• Scheduling multiple report e-mails requires ensuring an appropriate interval
between each report e-mail
When you schedule multiple reports to be sent to your email, you must ensure that
they are not being sent at the same time. The reason is that each report is managed in
a different session that starts when the report is being sent, and ends when the action
is completed. Each closed session, however, terminates also other sessions, in this
case the delivery of other reports. Therefore, the schedule must be different for each
report. The sufficient interval is about 5-10 minutes. You can specify it while setting
the start time.
• Audit Trail limitations
Audit Trail report cannot be filtered by the Details column and does not contain
information about uploads and imports of part numbers. What is more, audit trail
does not contain information about software classification when either component,
product or both are non-IBM.
• Non-IBM software discovered both on a local system and a shared disk is shown
only as installed locally
When non-IBM software is installed on a local system and on a shared disk, it is
shown only as installed locally on the Software Classification panel.
• Filtering computers based on their IP addresses does not work under certain
conditions
When you filter your computers based on their IP addresses and specify the relation
as ends with, no computers are displayed even if some computers match the criteria.
To work around this issue, you can choose other relations, such as contains or
begins with. This limitation concerns all reports.

• Filtering by installation path does not work under certain conditions
When the installation path is specified as report filtering criteria, and contains -1,
for example: C:\My_App -1, the filter returns inaccurate results. The filter returns

not only the content of the specified directory, but also all non-IBM products that are
installed on the computer.
• Filtering causes that the content of the window is scrolled up
When you filter a report by using the in set filter, the content of the entire window is
scrolled up to the top. You have to scroll down to add another filter.
• Incorrect number of rows can be displayed on reports that are saved as PDF files
The number of rows that is displayed in the upper right corner of a PDF file can
differ from the number of rows that is displayed on the user interface. This problem
was only encountered with Mounted Shared Disks column in the Computers report
because it contains multi-line entries.
• Time values are provided in different time zones on the user interface and in PDF or
CSV reports
On some reports, time values are expressed in the local time zone when the report is
viewed on the user interface but in the UTC time when the report is exported to a PDF
or CSV file. What is more, the format of the date and time is hardcoded in PDF reports.
• Signature definitions are not available on the Catalog Audit report for custom
signatures that were deleted
When you delete a custom signature from the software catalog, definition of this
signature is not available on the Catalog Audit report. The definition section is empty.
• Package Data limitations
The version format on Package Data report may differ for disconnected software
scan results when compared to regular scan results. For regular scan, the dash (-) is
replaced with period (.).
For example, the version shows as follows:
◦ Disconnected scanner reports: 1.8.3.1-11.el7
◦ Regular scanner reports: 1.8.3.1.11.el7
On Solaris platform, inconsistencies in Package Data report version may happen
because of collecting data from various package managers. Disconnected scanner
does not support IPS package manager.

• Non-English characters are incorrectly displayed on the Package Data report for IBM
i systems
If the name of a package that is discovered on an IBM i system contains non-English
characters, the characters are incorrectly displayed on the Package Data report.
• Sorting by name does not work on the predefined reports.

Security
• SP800-131a compliance cannot be enabled with Microsoft™ SQL Server
If the SP800-131a cryptographic standard is enabled in strict mode in BigFix Inventory
and the enhanced security mode is configured on the BigFix and MS SQL servers,
connection between the BigFix Inventory server and the SQL Server cannot be
established.
• The pvk format of the encrypted private key is not supported
You can use an encrypted private key in the openSSL or pkcs8 formats.
• Key pair generated for BigFix Inventory can be used for Web Reports only if the
private key is not password-protected

Other
• Custom page URL does not work on Microsoft Edge
The Custom Rule URL, accessed throughout Management > Custom Rules > Rule
Details page may not work on Microsoft Edge because of the browser's limitation in
handling the length of URL.
• The To Do List displays the names of outdated scanning actions always in English.
• Catalog search does not work during the import of data - This is applicable to
versions lower than 10.0.4.
• Fixlet for distributing scanner catalogs to the endpoints is not translated
The Catalog Download (Version: version) fixlet is a custom fixlet that is not delivered
with the BigFix Inventory fixlet site. Thus, it is not translated.
• Process IDs are not present in audit snapshots

• Eastern Arabic numerals are not supported

Key concepts
There are several concepts that will help you to understand how BigFix Inventory works and
how to use it effectively.

Dashboard
The dashboard provides with a quick access to information about deployments, scans,
computers, and software assets in your infrastructure.
Note: To provide feedback about the dashboard, write to talk2sam@hcl.com.

Dashboard and reports
Starting from 10.0.2.0, BigFix Inventory default dashboard displays vendor-specific
predefined reports summary of the selected inventory reports and a preview of the security
features. The reports are grouped in a specific order. For more information on vendorspecific predefined reports, refer to Vendor-specific predefined reports.
To view the old dashboard, click Go to the previous version. You can set the previous or
new dashboard as your default dashboard when required. To do so, click the user icon and
select Set as homepage.

The reports are grouped to help you find all your related reports together. For more
information about the reports, refer to Available reports.
Use the search option to search your preferred reports. You can search with file name, file
hash, CVE name, and software component. To search your preferred files, use File Name
or File Hash. Enter the software component name to discover the software. To search data
about vulnerable software, use CVE name. The default search filter is set to Discovered
Software.
The quick search on the top right corner allows you to search contracts with
contract name.

Previous dashboard
If you use BigFix Inventory 9.2.12 or earlier, your dashboard contains the following widgets:
• Deployment Health
• Software Health Scan

• Capacity Health Scan
• Inventory Exploration
• Inventory Data
• Software Catalog
• IBM PVU Subcapacity
• IBM Software Classification

Deployment Health
Deployment Health widget shows whether BigFix clients that are installed in your
infrastructure are connecting to the BigFix server. It also reports the most common issues
that occur when clients are operating such as, problems with disk space or missing scanner
prerequisites.
Tip: Read the Deployment Health, Scan Health, and IBM Capacity Data
Completeness widgets from left to right and fix issues in the same order.

Elements of the widget
The total number of computers to which the user has access. The number
is determined by the computer group to which the user is assigned.
The total number of computers includes Mac computers. However,
information about deployment health is not collected from these systems.
Thus, they are not included in the counts for particular statuses.
Links to the report with results narrowed down to computers with the
particular status.
The number of computers with a particular status.
Link to information about actions that you can take to resolve the reported
problems.

Software Scan Health
The Software Scan Health widget shows the health of scans that are running in your
infrastructure. When software scans are not working correctly, the installed software might
not be discovered.
Important: The Software Scan Status analysis must be activated for the widget to
show valid data. If the analysis is not activated, all computers are reported with the
Failed Scan, Missing Software Scan, and Outdated Catalog statuses.

Elements of the widget
The total number of computers to which the user has access. The number
is determined by the computer group to which the user is assigned.
The total number of computers includes Mac computers. However,
only information about the status of the package data scan is collected from
these systems. Therefore, Mac computers are included in the count for the
Failed Scan status. They are not included in the counts for the remaining
statuses.
Links to the report with results narrowed down to computers with the
particular status.
The number of computers with a particular status.
Link to information about scan problems.
Link to information about activating analyses required to collect data that
is displayed on the widget.

Capacity Scan Health
The Capacity Scan Health widget shows whether capacity data is correctly gathered from
the computers in your infrastructure. The lack of capacity data might impact calculation of
PVU consumption.

Elements of the widget
The total number of computers to which the user has access. The number
is determined by the computer group to which the user is assigned.
The total number of computers includes Mac computers. However,
information about capacity data is not collected from these systems. Thus,
they are not included in the counts for particular statuses.
Links to the report with results narrowed down to computers with the
particular status. For more information about each status, see: Computer
statuses.
The number of computers with a particular status.
A link to the VM Managers panel.

A link to information about the flow of capacity data between virtual
machines, VM Manager tool, and the BigFix Inventory server.

Inventory Exploration
The Inventory Exploration widget shows top five publishers with the largest number of
defined contracts. The publishers are ordered according to the number of computers on
which their software is installed, regardless of the number of contracts.

Elements of the widget
The number of products from a particular publisher.
A link to the Software Summary report.
A link to the All Contracts panel. Contracts management

Inventory Data
The widget shows a summary of the installed BigFix software as well as computers, and
computer groups in your infrastructure.

Elements of the widget
A link to the Software Installations report.
A link to the Computer Groups report.
A link to the Computers report.

Software Catalog
The widget shows information about the content and version of the current software

catalog.
Elements of the widget
Links to lists of publishers, software products, versions, releases,
components, and signatures that are available in the current catalog.
Name of the catalog provider.
Version of the software catalog. If a warning sign appears, it indicates
that the software that is not the current catalog is discovered. To view a list
of such products, filter the Software Classification report by Product name,
is empty. For more information, see: Catalog Problems: The <not set> value

appears under the Product Name on Software Classification panel.
Date and time when the report was last edited.
Link to the report with information when software reaches end of
support.

IBM PVU Subcapacity
The widget shows products with the highest PVU consumption rate. It shows how many
PVUs a product consumes but does not relate this information to your license entitlements.
By default, the maximum of five products is displayed.
The accuracy of the displayed data depends on when the scan data was imported, whether
the PVU table is up-to-date, and whether software assignment was modified. If any of these
factors was changed, an appropriate message is displayed on the widget.
If the widget shows No data, the data is not available. It might occur when scan data
was not uploaded, the upload of the data has not finished yet, or inventory scans do not
work properly. The message is not displayed if the data from at least one BigFix client is
successfully updated.

Elements of the widget
The PVU consumption rate for a product.
A link to the entire IBM PVU Subcapacity report.
The current version of the PVU table.

A link to the website on which you can check whether a new version of the
PVU table is available.
A link to the Metric Table Upload panel on which you can upload a new
version of the PVU table.

IBM Software Classification
The widget shows the number of completed and pending classifications of the software
that is installed in your infrastructure.
The accuracy of the displayed data depends on when the scan data was imported and
whether the part numbers file is up-to-date. If any of these factors was changed, an
appropriate message is displayed on the widget.
If the widget shows No data, the data is not available. It might occur when scan data was
not uploaded, the upload of the data has not finished yet, or inventory scans do not work
properly. The message is no longer displayed if scan data from at least one BigFix client is
successfully updated.

Elements of the widget

A link to the Software Classification panel with results narrowed down to
software installations with complete classification.
A link to the Software Classification panel with results narrowed down
to software installations that are still pending classification completion. Go
through these items and either confirm their default assignment or reassign
them to different products so that all installations in your infrastructure are
confirmed.
A link to the Software Classification panel.
The date when the last part numbers file was imported.
A link to the Part Numbers Upload panel on which you can upload the part
numbers file.

To Do list
Available from 9.2.13. The To Do list provides you with information about items
that might require your action including failed imports of data, availability of a new version
of BigFix Inventory or the need to configure a connection to VM managers.

To Do items
The number of To Do items is indicated by the number that is displayed on the To Do icon
. It is shown until the appropriate action is undertaken, which can be done if you are
an Administrator or have the required permissions. Otherwise, you are advised to contact
the BigFix Inventory Administrator to undertake the action for you. To update the To Do List,
refresh the BigFix Inventory user interface.
Table 36. Information that is displayed on the To Do list
Type of information
Duplicate UUID issue

Details
States that there are computers with duplicate
UUIDs (universally unique identifier). The list of

Table 36. Information that is displayed on the To Do list (continued)
Type of information

Details
computers with duplicate UUIDS is shown in the
import log.
For information on troubleshooting, refer to Dupli
cate UUIDs problem.

Failed data and catalog import

Shows the date and time when the data import has
failed along with the date and time of the last suc
cessful import.

Failed catalog import

Shows the date and time when the catalog import
has failed along with the date and time of the last
successful import. For more information, refer to
Notifications that are sent when imports of data
and catalogs fail.

Failed IBM catalog im
port

Shows the date and time when the IBM catalog im
port has failed along with the date and time of the
last successful catalog import.

Availability of a new version of

Provides information about the new version of the

BigFix Inventory

BigFix Inventory server that is available as well as
the version that you are currently running.

The need to configure connec

Provides information about the need of configur

tions to virtualization hosts

ing connections to VM managers to avoid over
counting subcapacity licenses. For more informa
tion about the impact of not configuring connec
tions to VM managers, see: Managing VM man
agers.

Outdated scanning ac
tions

Provides information about the scanning actions
that are running and which were started using the
older versions of the Initiate Software Scan and

Table 36. Information that is displayed on the To Do list (continued)
Type of information

Details
Upload Software Scan Results fixlets. To address
this issue, restart these action in the BigFix Inven
tory v10 fixlet site. For more information, see: En
suring currency of scanner actions and fixlets.
Note: The To Do List displays the names of
outdated scanning actions always in Eng
lish.

Changing the scope of the To Do list
If you are an Administrator, you can change which information is shown on the To Do list.
Currently, you can disable displaying information about the need of configuring connections
to VM managers. To disable the information, go to Management > Advanced Server
Settings, and change the value of the todo_display_vm_managers_need parameter to false.

Extract, Transform, Load (ETL)
The Extract, Transform, Load (ETL) is a process in the database usage that combines
three database functions that transfer data from one database to another. The first stage,
Extract, involves reading and extracting data from various source systems. The second
stage, Transform, converts the data from its original format into the format that meets
the requirements of the target database. The last stage, Load, saves the new data into the
target database, thus finishing the process of transferring the data.
In BigFix Inventory, the Extract stage involves extracting data from the BigFix server. The
data includes information about the infrastructure, installed agents, and detected software.
ETL also checks whether a new software catalog is available, gathers information about
the software scan and files that are present on the endpoints, and collects data from VM
managers.

The extracted data is then transformed to a single format that can be loaded to the BigFix
Inventory database. This stage also involves matching scan data with the software catalog,
calculating processor value units (PVUs), processing the capacity scan, and converting
information that is contained in the XML files. After the data is extracted and transformed,
it is loaded into the database and can be used by BigFix Inventory.The hardest load on the
BigFix Inventory server occurs during ETL when the following actions are performed:
• A large number of small files is retrieved from the BigFix server (Extract).
• Many small and medium files that contain information about installed software
packages and process usage data are parsed (Transform).
• The database is populated with the parsed data (Load).
At the same time, BigFix Inventory prunes large volumes of old data that exceeds its data
retention period.
Performance of the ETL process depends on the number of scan files, usage analyses, and
package analyses that are processed during a single import. The main bottleneck is storage
performance because many small files must be read, processed, and written to the BigFix
Inventory database in a short time. By properly scheduling scans and distributing them
over the computers in your infrastructure, you can reduce the length of the ETL process and
improve its performance.
An important factor that influences the duration of the ETL process is the amount of
updates on the file system since the last scan. Such operations as security updates or
significant system upgrades can cause ETL to run longer, because it has to process
information about all modified files. For example, regular updates released by Microsoft on
Tuesdays would significantly lengthen the Wednesday import in environments with many
Windows platforms.

Software and hardware discovery
BigFix Inventory discovers hardware and software in your IT infrastructure.
With BigFix Inventory you can accomplish the following goals by using software and
hardware discovery:
• Manage software inventory
• Monitor license consumption

• Achieve basic license compliance
• Create an inventory of hardware in the enterprise

Infrastructure analysis
The first step, before you start discovering software and hardware, is to obtain the baseline
of computers that exists in your environment. Estimate the total number of computers
and organize them into computer groups in the BigFix console to avoid overloading the
infrastructure.

Discovery of software and hardware
Collect information about your software, license compliance and hardware inventory. It is
commonly achieved by activating the capacity and software scans in the BigFix console. For
more information, see: Setting up scans to discover software and hardware inventory.
Discovery

Description

Software in

Software inventory is analyzed by the scanner that searches for dif

ventory

ferent types of information to determine whether the software is in
stalled or to measure its usage. You should set up the appropriate
software scans during the initial configuration of BigFix Inventory.
For more information, see: Types of software scans.
Thanks to BigFix Inventory you can understand and manage your
software inventory, especially through the following practices:
• Discovering IBM and non-IBM software to view and classify
your software inventory on the Software Classification panel.
• Measuring utilization of license metrics that are used within
your organization. You can view the details on the All Metrics
report that shows utilization of the assigned license metric by
all instances of a particular product. However, it is limited to a
subset of license metrics. For more information, see:License
metric utilization.
• Estimating resource utilization of products that deliver .slm
tags. The Resource Utilization report shows utilization of all li

Discovery

Description
cense metrics that can be used by a particular product. How
ever, the data is not aggregated and requires further process
ing. For more information, see: Raw utilization of license met
rics.
• Measuring current application usage by monitoring the infor
mation about packages and files that exist on the computers
in your environment. You can view the usage statistics on the
Inventory Exploration and Usage per Computer report.
• Discovering software that is installed on Mac OS. To discov
er software that is installed on Mac OS, run the package da
ta scan on Mac computers. Other types of software scans are
not needed. On the reports, the publisher of these products is
generic and called Unclassified Mac Software because the in
formation about the publisher is not available directly. In this
case, the publisher should be considered as unknown and no
manual action is required to set it.

Hardware infor Thanks to BigFix Inventory you can collect information about the
mation and ca

processors and the processor capacity that is assigned to each

pacity data

computer in your infrastructure.
Capacity scan
Capacity scan collects data about the physical proces
sor, system type (physical or virtual), guest operating
system, and logical partitions. It must be activated
on every computer, virtualization host and virtual ma
chine. For more information, see: Initiating the capacity
scan on all computers.
Capacity scan on virtualization hosts
To collect capacity data on Xen and KVM hosts, you
need to activate an additional fixlet: Run Capacity Scan

Discovery

Description
on Virtualization Hosts. For more information, see: Col
lecting capacity data from virtualization hosts for Xen
and KVM.
Capacity scan on virtual machines
To collect capacity data on VMware, Hyper-V, KVM
RHV-M, and Citrix Hypervisor (formerly XenServer), you
must add relevant VM managers in BigFix Inventory.
For more information, see: Adding VM managers for
VMware, Hyper-V, KVM with RHV-M, Citrix Hypervisor
and Nutanix.
The hardware information and capacity data are displayed on the
Hardware Inventory report.
Detailed Hardware Scan
To collect information about memory, operating
systems, storage, processors, partitions, network
adapters, SMBIOS data, IP addresses and logical
processor capacity data, you need to activate the Col
lect Detailed Hardware Information fixlet. For more in
formation, see: Detailed hardware scan.
Starting from application update 9.2.12, thanks to BigFix Inventory
you can collect detailed information about hardware in your infra
structure. You can retrieve this data with REST API. For more infor
mation, see: REST API for retrieving detailed hardware information
(v2).

Related information
Installing the scanner
Initiating software scans
Uploading software scan results

Fixlets, tasks, and analyses
Fixlets and tasks are central to BigFix platform. BigFix Inventory, as a part of this platform,
uses them to perform required actions on selected computers. Fixlets and tasks define
these actions and specify the criteria that make them relevant. Usually, an action is
deployed with a simple click.

Overview
Fixlets, tasks, and analyses are available on the dedicated BigFix Inventory v10 site that can
be accessed through the BigFix console.

For more information, see: Sites in the BigFix documentation.

Relevance
You can run a fixlet or task only on the computers for which it is relevant. Relevance
indicates which computers meet the relevance conditions that are listed for each fixlet
or task on the Details tab. The Applicable Computer Count column shows the number
of computers that apply. Relevance is determined per computer, and is continuously reevaluated by BigFix. It helps you understand the sequence of actions. In some cases, it
might be required to run one fixlet or task, to enable action defined by another. Relevance of
the deployment fixlets indicates that a new component version is available, and you should
run it to ensure that the latest code level is used. For more information, see: Fixlets and
tasks in the BigFix documentation.
Note: If you need to run a task on a computer that is not relevant, see: Checking why
a fixlet or task is not relevant.

Analyses
Analyses provide an overview of the most important information about the computers in the
environment, the installed scanner version, or status of the last software scan. You can use
these details to monitor health and understand if all necessary actions were successfully
completed. For more information, see: Analyses in the BigFix documentation.

Initial configuration
The required configuration fixlets and tasks ensure that BigFix Inventory works properly.
If you selected Enable default scan schedule for this data source during initial
configuration, the scans are configured automatically. Otherwise, you must configure the
scans manually. For more information, see: Manual scan configuration.

List of fixlets and tasks
The list and description of fixlets and tasks available in the BigFix console on the BigFix
Inventory v10 site.

Required configuration fixlets and tasks
There are four basic fixlets and tasks that are required to configure BigFix Inventory to
collect all necessary data from the computers in your environment.
Table 37. Required configuration fixlets and tasks
Name
Upgrade to

Category

Description

Deployment Use this fixlet to upgrade BigFix Inventory to the inter

the interim version

im version 10.0.2 and then upgrade to the latest ver

10.0.2 of BigFix In

sion. This is applicable for BigFix Inventory version

ventory if version

lower than 9.2.14.

older than 9.2.14

For more information, refer to Upgrading to BigFix In
ventory v10.

Upgrade to

Deployment Use this fixlet to directly upgrade BigFix Inventory to

the latest version

the latest version. This is applicable for BigFix Inven

of BigFix Inventory

tory versions 9.2.14 or higher.

(10.0.4.0)
Note: For BigFix Inventory to be compliant
with IBM Subcapacity, you must upgrade the
server.
For more information, refer to Upgrading to BigFix In
ventory v10.
Download

Deployment This task provides a link to the latest PVU table.

PVU table

Download the file and then manually upload it to the
BigFix Inventory server. For more information, refer to
download instructions.

Install or Upgrade
Scanner

Scanner

BigFix Inventory requires a dedicated scanner to be
installed on each endpoint. This task installs the
scanner or upgrades it to the latest version on the

Table 37. Required configuration fixlets and tasks (continued)
Name

Category

Description
specified endpoints. For more information, see: In
stalling the scanner.
Analysis: Scanner Information

Run Capacity Scan

Scanner

and Upload Results

After you install the scanner, you need to schedule
capacity scans on all endpoints to ensure that the da
ta in BigFix Inventory is complete. By default, the ca
pacity scan is set to run every 30 minutes and usual
ly takes a few seconds. The frequency is required by
the IBM pricing for subcapacity reporting. This task
runs the capacity scan to retrieve data from the spec
ified endpoints. If the action is completed, the results
were gathered and uploaded. For more information,
see: Initiating the capacity scan on all computers.

Initiate Software
Scan

Scanner

Use this fixlet to configure software scan that ana
lyzes the file system and registry, and discovers the
installed software. The scan can take from few min
utes to few hours depending on the number of files in
your file system. You can specify the exact date and
time of the scan, not to affect other business applica
tions running on the system. Additionally, you can set
a CPU threshold for the scan to minimize its impact,
however, that will make the scan last longer.
Select all the listed scan types. If the task is not rele
vant for some endpoints, log in to the BigFix Inventory
and run the initial import to ensure that the catalog is
propagated to all endpoints. This task is not relevant
on endpoints where the scanner is not installed. For
more information, see: Initiating software scans.

Table 37. Required configuration fixlets and tasks (continued)
Name

Category

Description
Analysis: Software Scan Status

Upload Software

Scanner

Scan Results

This task uploads inventory data that is collected by
the software scans from the specified endpoints to
the BigFix server. Each endpoint should be targeted
only once. For more information, see: Uploading soft
ware scan results.

Troubleshooting fixlets
There are several fixlets and tasks that can help you troubleshoot the most common issues
and questions related to the application.
Table 38. Troubleshooting fixlets
Name

Category

Description

Analyze the Rele

Trou

vance of a Fixlet or

bleshooting vance conditions of a particular fixlet or task are not

Task

This task creates an analysis that checks which rele
met. Check the results of the analysis to learn why a
fixlet or task is not relevant on a particular endpoint.
The analysis is created in the Master Action site. For
more information, see: Checking why a fixlet or task
is not relevant.

Force Reupload of

Trou

Software Scan Re

bleshooting gathered by the software inventory and the file sys

sults

This task forces reupload of inventory data that was
tem scans. The data is reuploaded to BigFix once
and no schedule is set. The data is then transferred
to BigFix Inventory during the import. The import in
cludes results of the full file system scan, not the
delta scan. It might affect the length of the import.

Table 38. Troubleshooting fixlets (continued)
Name
Gather En
vironment Informa

Category
Trou

Description
This task retrieves information about BigFix Inventory

bleshooting and BigFix environment for troubleshooting purpos

tion

es. The task is relevant only for the Linux operating
system.

Other fixlets
The remaining fixlets and task can help you manage, configure, troubleshoot, deploy and
migrate the product and its components, and manage VM Managers.
Table 39. Other fixlets
Name
Install or Upgrade

Category
Scanner

Description
BigFix Inventory requires a dedicated scanner to be

Scanner in private

installed on each endpoint. This task installs the

mode on windows

scanner or upgrades it to the latest version on the
specified endpoints in a private mode. It installs CIT
binaries in <BES Client>\LMT\CIT\scanner directory,
but without registering the instance in CIT global files
(no cit.ini or other global CIT configuration files).In
case when there is a global CIT with SUA exploiter al
ready installed, the SUA exploiter will be uninstalled
from the global CIT and upgraded to the private ver
sion.

Add Excluded Direc

Scan Man

This task is used to add entries to the list of directo

tories

agement

ries that are excluded from scanning. After you spec
ify the directories, run the task against the chosen
endpoints. The directories are then sent to the scan
ner that omits them during the software scan. For

Table 39. Other fixlets (continued)
Name

Category

Description
more information, see: Excluding additional directo
ries.

Add Targeting Ex

Configura

This task prevents software and capacity scans that

ception to Temporar tion

are scheduled on the endpoint from running without

ily Disable Scans

the need of modifying the entire scan schedule. You
can use it to temporarily disable scans on a computer
that undergoes maintenance, patching, or some oth
er resource-consuming action that could be disturbed
by the software or capacity scan.

Change Scanner

Scanner

Cache Folder

This task allows you to select a new cache folder to
store the scanned cache data. The task cannot be
performed when a scan is in progress.
If the task is relevant, the scanner is installed in all
applicable endpoints. The task is not applicable to
endpoints which have HCL scanner installed in pri
vate mode.
For more information, see: Optimizing scanner cache
configuration.

Collect De Scanner

This task runs a detailed hardware scan on the spec

tailed Hardware In

ified endpoints. It collects information related to

formation

memory, operating systems, storage, processors, par
titions, network adapters, SMBIOS data, IP address
es and logical partition capacity data. The solution is
supported on Windows, Linux x86 and AIX. The task
can be run also on other operating systems but the
returned results might not be accurate. For more in
formation, see: Detailed hardware scan.

Table 39. Other fixlets (continued)
Name

Category

Description
Analysis: Detailed Hardware Information

Collect Logs
from Endpoints

Trou

The task collects BigFix client logs, scanner logs,

bleshooting scan configuration logs, VM manager configuration
files, and files generated during scans. Run this task
when you are requested by BigFix Support to collect
log files for troubleshooting purposes.

Configure
Collection of Addi

Scan Man

This task allows you to enable the collection of addi

agement

tional properties of Windows executables by running

tional Properties of

a fixlet that changes the configuration of the software

Windows Executa

scan for BigFix Inventory. For more information, see:

bles

Enabling collection of additional properties of Win
dows executables.

Configure File

Scan Man

This task enables the collection of file checksums

Checksums Collec

agement

and is intended for advanced security scenarios on

tion (MD5/SHA-256)

ly. The MD5 and SHA-256 checksums are calculat
ed during the file system scan, and are created for
each file that is discovered by the software scan. For
more information and requirements, see: Collecting
file checksums.

Configure Scan
Cache

Scanner

This task allows for configuring the file system scan
cache. By default, the cache is enabled and is cleared
after every scan. The cache is shared by different
scan types. Disabling the cache will significantly im
pact scan performance, and it is not recommended,
unless absolutely necessary. The task is relevant on
ly on computers where the scanner is installed. For
more information, see: Optimizing scanner cache
configuration.

Table 39. Other fixlets (continued)
Name
Configure Scanner

Category
Scanner

Query Timeout

Description
This task allows you to set the maximum time in
which the software scan process should finish. As
the software scan involves scanning as well as ad
ditional evaluation, the overall software scan time
might exceed the value provided.

Create Ca
pacity Configuration

Configura

This task creates a file that contains the manually-en

tion

tered capacity values. If this task is relevant, it means

for Linux on z Sys

that no capacity configuration exists on this endpoint

tems

yet and the manual configuration is required. If this
fixlet is not relevant on a computer, you do not have
to perform any manual actions to calculate the ca
pacity values. For more information, see: Creating ca
pacity configuration for Linux on z Systems.
Delete Ca

Configura

This task deletes the file that contains the manual

tion

ly-entered capacity values.

Disable Application

Configura

This task disables the collection of application usage

Usage Statistics

tion

statistics on endpoints. For more information, see:

pacity Configuration
for Linux on z Sys
tems

Disabling the collection of software usage.

Disable

Configura

Collecting executable files based on application us

tion

age is automatically enabled when you have the Big

Collecting Exe

Fix client and server in version 9.5.5 or higher, use

cutable Files Based

Linux or Solaris system, and have the Application Us

on Application Us

age Statistics analysis activated. This task disables

age

collection of executable files that are based on the
list of processes on endpoints. If you run this task,

Table 39. Other fixlets (continued)
Name

Category

Description
the files associated with these processes are not dis
played on the Scanned File Data report.

Discover Remote

Scan Man

This task identifies shared disks that exist in your en

Shared Disks

agement

vironment. For more information, see: Discovering
software on shared disks and Limiting scope of auto
mated scan.
Analysis: Shared Disk Information

Download BigFix In

Deployment This task downloads the newest BigFix Inventory

ventory

server installer to the specified endpoint.

Download the Dis

Deployment This task provides a link to the latest disconnected

connected Scanner

scanner package. The package contains installation

Package (version)

and configuration files, and the scripts that are re
quired for software and capacity discovery on Win
dows and Linux computers. This solution can only be
used if the BigFix client cannot be installed due to le
gal, business, or technical reasons. For more infor
mation, see: Discovering software and hardware with
disconnected scanner on Windows and UNIX.

Download

Deployment This task provides a link to the latest disconnected

the Disconnected

scanner package for IBM i. The package contains in

Scanner Package for

stallation and configuration files, and the scripts that

IBM i (version)

are required for software and capacity discovery on
IBM i systems. For more information, see: Discover
ing software and hardware on IBM i.

Edit Ca
pacity Configuration

Configura

This task edits the file that contains the manually-en

tion

tered capacity values. If this task is relevant, it means

Table 39. Other fixlets (continued)
Name

Category

Description

for Linux on z Sys

that the capacity configuration already exists on this

tems

endpoint.

Edit Scanner Trace

Trou

This task allows you to set debug traces for the scan

Settings

bleshooting ner. If this task is relevant, it means that the scanner
is installed on an endpoint. For more information, see:
Changing scanner trace settings.
Configuring This task enables collection of executable files that
Enable Col

are based on the list of processes on endpoints.

lecting Executable

If you run this task, the files associated with these

Files Based on Appli

processes will be displayed on the Scanned File Da

cation Usage

ta report. Use this task if you previously disabled the
feature using the Disable Collecting Executable Files
Based on Application Usage fixlet.

Force VM Manager

Trou

Tool Scan Results

bleshooting by VM Manager Tool or by the Run Capacity Scan on

Upload

This task forces the upload of capacity data collected
Virtualization Hosts task. The data is uploaded to Big
Fix and can be transferred to BigFix Inventory by run
ning a data import. The data is uploaded only once
and no schedule is set. For more information, see:
Forcing the upload of collected data.

Get Microsoft Ex

Scanner

change Edition

This task allows you to retrieve information about the
editions of Microsoft Exchange servers that are in
stalled on the computers in your infrastructure. For
more information, see: Discovering Microsoft Ex
change edition.

Get Oracle Concur

Scanner

This task allows you to retrieve information about the

rent Sessions Num

high water mark value of concurrent sessions for Or

ber

acle Databases that are installed on the computers

Table 39. Other fixlets (continued)
Name

Category

Description
in your infrastructure. For more information, see: Me
tering the number of Oracle Database concurrent ses
sions.

Get Oracle Features

Scanner

This task allows you to retrieve information about the
editions and features of Oracle Databases that are in
stalled on the computers in your infrastructure. For
more information, see: Extended discovery of Oracle
Database.

Get SAP Compo

SAP Sys

This task allows you to retrieve information about the

nents

tems

SAP components that are installed on the computers
in your infrastructure. For more information, see: Dis
covering SAP components.

Identify Computers

Configura

This task marks targeted endpoints as computers

on Public Clouds

tion

that are running on a public cloud. It allows the spe
cific license model for the PVU count without hyper
visor access. For more information and a list of sup
ported public clouds, see: Identifying computers on
public clouds.

Initiate
Collection of SAP

SAP Sys

This task runs the SAP Metric Data Collector. The tool

tems

collects license metric utilization data from a single

Metric Data

SAP landscape. For more information, see: Collecting
utilization of SAP license metrics.

Initiate Soft

Scanner

This task runs the catalog-based scan, file system

ware Scan on Shared

scan, and software identification tags scan to discov

Disks

er software that is installed on shared disks. Scan re
sults are used to create software templates that rep
resent the discovered software. The templates are
later on shared between all computers on which the

Table 39. Other fixlets (continued)
Name

Category

Description
disks are mounted to ensure that the software is re
ported on these computers. For more information,
see: Discovering software on shared disks and Limit
ing scope of automated scan.
Analysis: Status of Shared Disks Software Scan

Install Additional VM VM Man

This task installs an additional VM Manager Tool

Manager Tool ver

in the specified version on any computer. The tool

agers

sion number (OP

should only be used to manage VM managers that

TIONAL)

are in separated networks and cannot be reached by
the BigFix server. For more information, see: Manag
ing VM managers.

Install SAP

SAP Sys

This task installs the SAP Metric Data Collector in the

tems

specified version on a selected computer. The tool

Metric Data Collector

collects license metric utilization data from a single
SAP landscape. For more information, see: Collecting
utilization of SAP license metrics.

Install VM Manager

VM Man

This task installs VM Manager Tool in the specified

Tool version number

agers

version on the BigFix server. Use this task if automat
ic installation failed. For more information, see: (Op
tional) Installing VM Manager Tool.

Refresh Re-Sub
scribed Endpoints

Scanner

This fixlet detects endpoints that were re-subscribed
from a different fixlet site and is used for the coexis
tence of License Metric Tool and BigFix Inventory. For
such endpoints, it forces the upload of capacity data,
and refreshes properties to ensure that they are relat
ed to the relevant fixlet site. An endpoint is refreshed
after each re-subscription. The initial subscription is
set after running the software scan.

Table 39. Other fixlets (continued)
Name

Category

Description

Remove Capacity

VM Man

This task applies to the KVM and Xen hosts only. It

Scan Data from Vir

agers

removes the data that was generated on virtualiza

tualization Hosts

tion hosts during the capacity scan. For more infor
mation, see: Collecting capacity data from virtualiza
tion hosts for Xen and KVM.

Remove Excluded Di Scan Man

This task is used to remove entries from the list of

rectories

directories that are excluded from scanning. After

agement

you specify the directories, run the task against the
chosen endpoints. The directories are then sent to
the scanner that includes them back in the software
scan. For more information, see: Including the exclud
ed directories back in scans.
Remove Targeting

Configura

This task resumes software and capacity scans that

Exception to Resume tion

were temporarily disabled by using the Add Targeting

Scans

Exception to Temporarily Stop Scans task.

Run Capacity Scan

VM Man

This task applies to the KVM and Xen hosts only. It

on Virtualization

agers

runs a capacity scan on virtualization hosts to re

Hosts

trieve capacity data from all virtual machines that are
managed by the specified host. Schedule the scan on
every host that manages virtual machines which have
the BigFix client installed. For more information, see:
Collecting capacity data from virtualization hosts for
Xen and KVM.

Schedule VM Man

VM Man

This task schedules regular uploads of capacity data

ager Tool Scan Re

agers

collected by VM Manager Tool or by the Run Capac

sults Upload

ity Scan on Virtualization Hosts task. The data is up
loaded to BigFix and can be transferred to BigFix In

Table 39. Other fixlets (continued)
Name

Category

Description
ventory by running a data import. For more informa
tion, see: Changing the upload schedule.

Set DSD
Mode

Configura

This task sets the DSD mode on Solaris endpoints.

tion

If the Solaris system is in the DSD domain, set this
mode so that the PVU data is correctly calculated.
For more information, see: Setting the DSD mode on
Solaris.

Software Catalog
Update (version)

Deployment

Starting from application update 9.2.11, the
catalog update process is automatized. This task au
tomatically downloads the software catalog, and up
loads it to the BigFix Inventory server during the next
import of data. No further action is required.
For versions before 9.2.11, this task downloads the
latest software catalog to the computer where the
BigFix Inventory server is installed. After the file is
downloaded, you must upload it to the BigFix Invento
ry server. For more information, see: Manually updat
ing software catalog.
Warning: Since catalog version 10.0.2, Soft
ware Catalog Update fixlet updates only nonIBM part of the catalog. The same applies
to the manual catalog upload. To get the lat
est supported IBM catalog part you must
upgrade BigFix Inventory. It is in line with
IBM ILMT 9.2.20, https://www.ibm.com/sup
port/pages/node/6223460.

Table 39. Other fixlets (continued)
Name

Category

Description
However, the definition of the software cat
alog does not change for other vendors, and
the manual updates continue to be support
ed.

Uninstall

SAP Sys

This task uninstalls the SAP Metric Data Collector

SAP Metric Data Col tems

from the selected computer. It also removes folders

lector

that the tool uses as well as deletes settings of the
BigFix client specific to the tool.

Uninstall Scanner

Scanner

This task uninstalls the scanner and the correspond
ing configuration files from the specified endpoints.

Uninstall VM Manag VM Man

This task uninstalls the VM Manager Tool from the

er Tool

specified endpoints. It also deletes the client settings

agers

and folders used by the VM Manager Tool. For more
information, see: Uninstalling VM Manager tool.
Unset DSD
Mode

Configura

This task unsets the DSD mode on Solaris endpoints.

tion

For more information,see: Setting the DSD mode on
Solaris.

Update

SAP Sys

SAP Metric Data Col tems

This task updates the SAP Metric Data Collector to
the latest version.

lector
Update VM Manager

VM Man

This task updates VM Manager Tool to the speci

Tool to version ver

agers

fied version. For more information, see: Updating VM

sion number

Manager Tool.

Upgrade to the latest Deployment This fixlet upgrades BigFix Inventory to the latest ver
version of BigFix In
ventory10

sion. It also uploads the latest software catalog and

Table 39. Other fixlets (continued)
Name

Category

Description
PVU table to the BigFix Inventory server. For more in
formation, see: Upgrading to BigFix Inventory v10.

WARNING: End

Trou

Some of your endpoints are subscribed to both the

points Subscribed to bleshooting IBM License Reporting (ILMT) v9 and the BigFix In
Multiple Sites

ventory v10 fixlet site, which will lead to issues with
software discovery that are not supported. An end
point can report to only one application at a given mo
ment. Remove the endpoints from one of the sites.

Clear cache

Deployment Use this fixlet to force rescanning of docker contain

to force rescan

ers during the next Initiate Software Scan. You need

Docker containers

to clear cache of already scanned images. This task

during next Software

refers to the ISO tagged software scan on Docker

Scan

containers. This fixlet is related to Discovery of soft
ware in Docker containers.

High-water mark
Utilization of license metrics can fluctuate depending on the location and configuration of
virtual machines in the physical environment. High-water mark is the peak in the utilization
of a license metric by a product during the reporting period. It represents the number of
metric units that are needed to license a product during that period.
The following examples are based on sample utilization of PVUs by DB2 Enterprise Server
Edition during a four-week period.

Example 1: High-water mark for a single server with one virtual machine
In this example, DB2 is installed on a single virtual machine. Configuration of this machine
changes over time so the number of processor cores that are available to DB2 varies every
week. DB2 consumes the following number of PVUs.

• 800 PVUs in the first week
• 400 PVUs in the second week
• 1200 PVUs in the third week
• 800 PVUs in the fourth week
High-water mark for DB2 in this four-week period occurs in the third week and equals 1200
PVUs.

Example 2: High-water mark for a single server with four virtual machines
and no CPU overcommitment
In this example, a server has four virtual machines whose configuration changes over time.
The machines do not share any processor cores, and no capping is needed. The server-level
utilization of PVU is the sum of PVUs used by DB2 on each virtual machine.
Peak value from a single virtual machine is 1200 PVUs and occurs in the third week.
However, DB2 is installed on all virtual machines so values from all virtual machines must
be added to calculate the high-water mark. High-water mark for DB2 in this four-week period
occurs in the second week and equals 1500 PVUs.

Example 3: High-water mark in the entire infrastructure
In this example, there are three servers with many virtual machines. The infrastructure-level
PVU utilization is the sum PVUs used by DB2 on each server and utilization on each server
is the sum of PVUs used by DB2 on each virtual machine that exists on that server.
High-water mark for DB2 in this four-week period occurs in the first week and equals 4800
PVUs.

Related information
IBM Processor value unit (PVU)
IBM Resource value unit (RVU MAPC)

Main background application tasks
The main goal of BigFix Inventory is to generate PVU, and RVU audit reports based on the
collected data. All calculations are done in accordance with PVU, and RVU license pricing
rules that are described in the official subcapacity licensing documents.

Aggregation
Aggregation is the main calculation task in BigFix Inventory. The aggregation process is a
scheduled background task that is run on a daily basis at a particular hour. By default it is

performed when the server time is midnight. The task calculates the PVU, and RVU values
based on the data that is collected from the agents during software and capacity scans.

Reaggregation
If the initial software bundles are correct after software discovery and rebundling is
unnecessary, aggregation is the only calculation process that is required on the side of the
BigFix Inventory server and the data that was once calculated is always correct. However,
this is rarely the case. You must always modify some parts of the initial bundles that are
proposed by BigFix Inventory. You must always confirm which bundles are correct for
complex products. A complex product is a product that can be bundled with more than one
software offering. After rebundling is complete, the PVU and RVU values that were already
calculated must be refreshed. Reaggregation tasks were designed to recalculate or refresh
PVU and RVU values that were already calculated. Manual actions that might trigger the
data reaggregation include:
• Rebundling a software instance from one product to another
• Confirming the default bundle
• Including software instance in PVU, or RVU calculations
• Excluding software instance from PVU, or RVU calculations
• Sharing an instance
These five actions are very basic operations that the application users perform frequently to
adjust the bundling data. In addition to manual actions, refresh of the calculated data can
also be triggered by bundling assistance.

Aggregation versus reaggregation
The aggregation process was designed to calculate the data from many agents for all
products over a short time. In contrast, reaggregation process was designed to perform
quick recalculation of PVU, and RVU values for a selected subset of products that were
already aggregated. Aggregation of all products from all agents is much quicker (even
hundreds of times) than reaggregation of the same amount of data. However, when you
must recalculate the PVU and RVU values of only one product, reaggregation should be

quicker than aggregation, which cannot recalculate the reporting value of only one product,
but must reaggregate it for all discovered products simultaneously.

Inventory builder
Inventory builder is another background task that is executed periodically. During this
time, the software inventory is built based on the data from the agent software scans. In
other words, this task transforms a list of discovered software components to a list of the
discovered software products. In most cases, the initial software bundling of detected
components performed by the inventory builder has a very low level of confidence.

Bundling assistance
Similarly to aggregation, bundling assistance is a periodic background task. It is strictly
related to the inventory builder task - when the execution of inventory builder ends, bundling
assistance starts.
When the bundling assistance task runs, it determines the best bundle connections to
all unconfirmed product instances. If the newly calculated bundles have a higher level of
confidence than the current product bundles, bundling assistant rebundles those product
instances to the new product with the best match. In the vast majority of cases, subsequent
bundling assistant runs calculate the same level of confidence for most or even for all
of the unconfirmed product instances. However, from time to time, especially in large
environments with a large percentage of unconfirmed instances where it can actually
happen frequently, the newly calculated confidence level can turn out to be higher then the
old one. In this case, the software instance is rebundled. The most common reasons why
automatic bundling is able to rebundle some old unconfirmed product instances are:
• Import of a new set of part numbers
• Import of a new software catalog

• After manual rebundling or manual confirmation of one product instance, other
unconfirmed product instances can be better bundled by using partition or
infrastructure collocation rules
• Detection of a new simple software component (a component that can be assigned to
only one product) by agents might also change the calculations for other unconfirmed
instances due to partition or infrastructure collocation bundling assistance rules.
However, bundling assistance does not replace the manual work that must be done
to confirm or rebundle all unconfirmed product instances. The confidence level that is
calculated by bundling assistant is supposed to facilitate manual bundling by providing the
best potential bundling options for all unconfirmed product instances.

Extract, Transform, Load (ETL)
In general, Extract, Transform, Load (ETL) is the process in database usage that combines
three database functions that aim at transferring data from one database and placing it into
another. The first stage, Extract, involves reading and extracting data from various source
systems. The second one, Transform, converts the data from its original form into the form
that meets the requirements of the target database. The last stage, Load, saves the new
data into the target database, thus finishing the process of transferring the data.
In BigFix Inventory, the Extract stage involves extracting data from the BigFix server. Such
data includes information about the infrastructure, installed agents and detected software.
ETL also checks if the new software catalog is available, gathers information about the
software scan and files that are present on the endpoints, and collects data from the VM
managers.
The extracted data is then transformed to a single format that can be loaded to the BigFix
Inventory database. This stage also involves matching scan data with the software catalog,
calculating processor value units (PVU), processing the capacity scan, and converting
information that is contained in the XML files.
After the data is extracted and transformed, it is loaded to the database and can be used by
BigFix Inventory.

Related information
Bundling Assistant

Products, components, and bundles
BigFix Inventory discovers software components, and bundles them to products basing on
the data contained in the software catalog. Get familiar with these notions to understand
the capabilities and performance of BigFix Inventory.
Software catalog
A software catalog is a collection of the definitions of software products, their
relations and data (signatures) that are used to detect software as installed or
used in an IT environment.
An initial software catalog is included in the tool. You must update it regularly.
HCL delivers and maintains the Software Catalog that includes a set of IBM
and non-IBM product definitions and signatures.
The following diagram represents the catalog definition for the product
Product X. It shows how the various catalog definitions are related and how
they provide a structure that supports identification of the software.

The catalog also contains information indicating what license metric each
product uses and how the license quantity is calculated.
The software catalog is a knowledge database that contains information about:
Software product (Offering)
A software product is a logical unit of software packaging and sharing that
has a managed development and maintenance lifecycle and customer visible
attributes. It can be a collection of components, software products whose
licensing can be dependent on the licensing of the offering as a whole.
Component
A component is a unit of software that can be detected as installed or running
on computer systems independently of other software items. It can be a
part of a software product, and might be separately identified, but is not
individually licensed.
Signature
A signature is a unique set of data that is used to discover a given release
of the software component. It is used to identify a distributed software
release as installed or running on a computer system. There are two types of
signatures:
• Inventory recognition signatures detect if a product or component
release is installed on the system.
• Usage monitoring signatures detect if a product or component release is
running on the system.
A signature can be a file, registry entry, or another identifier, that acts as a
fingerprint for identifying software products. The catalog can be augmented
with information about custom or proprietary software products in your IT
environment.
Hierarchy

A hierarchy is a structure that represents software versions, releases, and
variations.
Bundle
A bundle is set of products that are offered under a single entitlement or
license with no dedicated components. In the catalog, a bundle is modeled
as a software product with setup relationships to all of the software products
that it consists of.
When a file system is scanned, components are discovered by matching the
relevant information against signatures that are defined in the catalog. Basing
on the match, the most suitable product is selected for each component. You
can change the default bundling on the Software Classification panel.

IBM Software licensing rules on public clouds
IBM software that is installed on computers that run on public clouds is licensed
according to the IBM BYOSL policy. To ensure that license metric utilization is properly
calculated for such software, computers must be identified as running on public clouds.
For more information, see: IBM Eligible Public Cloud BYOSL policy.

Supported public clouds
Public clouds that are currently supported by BigFix Inventory include:
• Amazon EC2
• IBM SoftLayer
• Microsoft Azure
•

Google Compute Engine

•

Oracle Compute Instance

•

Alibaba Elastic Compute Service

•

IBM Power Virtual Server

•

Tencent Cloud Server Instance

•

NEC Cloud IaaS Instance

•

Fujitsu Cloud IaaS Instance

◦

FJcloud-V

◦

FJcloud-O

•

NTT Enterprise Cloud Server

•

KDDI Cloud

See also:
• Identifying computers on public clouds
• Identifying disconnected computers as running on public clouds

Limitations
BigFix Inventory does not support public cloud VMs that are identified by duplicated serial
numbers. The serial number is usually the UUID of the virtual machine that is assigned by
the VM manager of the particular public cloud.

Licensing of non-containerized Cloud Pak programs
Available from 10.0.1 IBM Cloud Paks deliver IBM enterprise software and open
source components in open and secure solutions that are easily consumable and can run
anywhere. BigFix Inventory collects information about the utilization of license metrics by
non-containerized products that are installed as part of IBM Cloud Paks.

Conversion options
For each product that is a part of a Cloud Pak, a separate conversion option is specified in
the License Information document. For example, if you install IBM MQ Advanced as part
of the Cloud Pak for Integration, the conversion option is 2 VPCs /1 VPC. It means that
when IBM MQ Advanced uses 200 VPCs, 100 VPCs contribute to the utilization of VPCs by
the entire Cloud Pak. For more information about conversion options, search the License
Information documents.

Classifying non-containerized products as belonging to IBM Cloud Paks
Classification of non-containerized products to IBM Cloud Paks is a two-step process. First,
you classify components that are discovered by BigFix Inventory to products with proper

license metrics. Then, you assign products to IBM Cloud Paks. For more information and
detailed instructions, see: Assigning products to Cloud Paks.

Reading metric utilization
Information about IBM Cloud Paks
You can view information about IBM Cloud Paks on the IBM Flex Points and IBM Cloud
Paks report. The report lists IBM Cloud Paks based on the decisions that you make during
software classification. The Metric Quantity column represents utilization of license metric
units by non-containerized products that are assigned to the Cloud Pak.

Information about non-containerized products that are a part of Cloud Paks
To view the detailed report with non-containerized products that are assigned to the IBM
Cloud Pak, go to the IBM Flex Points and IBM Cloud Paks report, and click the name of
the Cloud Pak in the Product Name column. The detailed report provides the following
information:
• License metric that the product is assigned
• Number of license metric units that the product uses
• Date when utilization of the license metric by the product was the highest during the
reporting period
• Number of license metric units that the product contributes to the license metric
utilization of the Cloud Pak

Information about IBM Cloud Paks in the audit snapshot
When you generate the audit snapshot, information about IBM Cloud Paks is contained in
the cloud_paks.csv file. The file contains the following information:

• IBM Cloud Paks and their license metric utilization
• Products that are installed as part of IBM Cloud Paks and the number of license
metric units that they contribute to metric utilization of the IBM Cloud Pak
Table 40. A fragment of the cloud_paks.csv file
Flex
Row

Pub

No.

lisher

Prod
uct
Name

Point

Metric

or

Metric

Cloud

Quan
tity

Pak

Bundle
Peak

Metric

Date

Contri
bution

Bundle
1

IBM

IBM

None

Virtual 3

Cloud

Proces

Pak for

sor

Inte

Core

Im

Recal

ported

cula

Part

tion

Num

Need

bers

ed

27-02-20

No

27-02-203

No

gration
2

IBM

IBM

IBM

Virtual 10

MQ

Cloud

Proces

Pak for sor
Inte

Core

gration

Example
The following scenario describes how utilization of license metrics is calculated for Cloud
Paks under different circumstances. The calculations are based on sample values and
should be treated as examples.
Three products from Cloud Pak for Multicloud Management are installed:
• IBM Cloud Automation Manager
• IBM Tivoli Monitoring for Linux on System z
• IBM SmartCloud Application Performance Management Standard

The following table shows an example of how utilization of license metrics by noncontainerized products is calculated by BigFix Inventory.
Table 41. Example of contribution of license metrics by non-containerized products to
Cloud Pak for Multicloud Management
Summary for complex table
Product

IBM Cloud Au

License metric

License met

Conver

ric quantity

sion option

License met
ric quantity af
ter conversion

MVS

100

25 MVS/1 MVS 4

IBM Tivoli Mon MVS

100

8 MVS/1 MVS

tomation Man
ager

itoring for Linux

12.5 rounded
up to 13

on System z
IBM Smart

MVS

50

2 MVS/1 MVS

25

Cloud Appli
cation Perfor
mance Man
agement Stan
dard
Total

42

Configuration parameters of the disconnected scanner
(disconnected scenario)
You can edit the configuration files to customize the disconnected scanner behavior and the
scans. For example, you can schedule scans and specify directories to exclude from scans.
Important: Do not change parameters that are not described.

setup_config.ini
The file contains general parameters for scheduling software and capacity scans.
Table 42. Parameters in the setup_config.ini file.
Parameter

Default value

DOCKER_SCAN_

FALSE

ENABLED

Possible values

Description

• TRUE

Enables discovery

• FALSE

of software that is
installed in Dock
er containers. For
more information
on how License
Metric Tool reports
software that is in
stalled in Docker
containers, see: Dis
covering software
in Docker contain
ers.

HW_S
CAN_SCHEDULE_
ENABLED

TRUE

• TRUE

Enables scheduling

• FALSE

capacity scans in
cron.
By default, the
capacity scan is
scheduled to run
every 30 minutes.
The frequency can
not be modified.
When you set the
value of this para
meter to FALSE,
a single capacity

Table 42. Parameters in the setup_config.ini file. (continued)
Parameter

Default value

Possible values

Description
scan is run but no
schedule is set.

PACKAGE_OUT

.\output

Directory name

PUT_DIR

Defines the directo
ry in which scan re
sults are stored. By
default, the .\output
directory is created
in the installation di
rectory of the dis
connected scanner.

PUBLIC_
CLOUD_TYPE

The field is empty
by default

KDDI

•

Virtual Server
• IBM Power
Virtual Server

Specifies the type
of a public cloud on
which the comput
er is running. It al

• IBM SoftLayer lows proper count
ing of the number
• Microsoft
Azure

of Processor Value

• Amazon EC2

Units (PVUs) per vir

• Google Com

tual core.

pute Engine
• Oracle Com
pute Instance

Note: En
sure the

• Alibaba Elas

name of the

tic Compute

public cloud

Service

is enclosed

• Tencent

in quotation

Cloud Server
Instance

marks.

Table 42. Parameters in the setup_config.ini file. (continued)
Parameter

Default value

Possible values

Description

• NEC Cloud
IaaS Instance
•

Fujit
su Cloud IaaS
Instance
Note:
For
appli
cation
up
dates
and
,
Fu
jitsu
Cloud
IaaS
In
stance
indi
cates
FJ
cloud-V.
Start
ing
from
appli

Table 42. Parameters in the setup_config.ini file. (continued)
Parameter

Default value

Possible values

Description

cation
up
date
,
it indi
cates
both
FJ
cloud-V
and
FJ
cloud-O.
SW_SCAN_SCHED
ULE_ENABLED

FALSE

• TRUE

Enables software

• FALSE

scans scheduling in
crontab. If you set
SW_SCAN_SCHED
ULE_ENABLED to
TRUE, the first soft
ware scan is initiat
ed after you install
the scanner. Subse
quent scans will run
on that time with
the frequency you
choose (defined
by SW_SCAN_FRE
QUENCY)

Table 42. Parameters in the setup_config.ini file. (continued)
Parameter

Default value

SW_SCAN_FRE

WEEKLY

QUENCY

Possible values

Description

• DAILY

Defines the fre

• WEEKLY

quency of software
scans, either daily
or weekly.

isotag_config.xml and slmtag_config.xml
The isotag_config.xml file contains parameters for tuning the software identification
tags scan. The slmtag_config.xml contains parameters for tuning the resource
utilization scan. For more information about these scans, see: Types of software scans.
Table 43. Parameters in the isotag_config.xml and slmtag_config.xml files
Parameter

Default value

AssumeAutoFS

remote

Possible values
• local
Recognizes
disks mount
ed by autofs

Description
Specifies how the
scan recognizes
disks that were
mounted by the

as local disks. automatic mount
ing service (aut
• remote
Recognizes
disks mount
ed by autofs
as remote
disks.
• other
Recognizes
disks mount
ed by autofs

ofs).

The

parameter is not
available .

Table 43. Parameters in the isotag_config.xml and slmtag_config.xml files
(continued)
Parameter

Default value

Possible values

Description

as disks of
other types,
for example:
DVD.
ExcludeDirectory

For the list of direc

Directory name

Specifies directo

tories that are ex

ries that are exclud

cluded by default,

ed from software

see: Excluding di

scans. For more

rectories from being

information, see:

scanned.

Excluding direc
tories from soft
ware scans by dis
connected scanner
(disconnected sce
nario).

ExcludeGuestDirec true

• true

Specifies whether

tories

• false

catalogs that be
long to zones
or WPARs are
scanned. When the
value of the para
meter is set to true,
the catalogs are not
scanned.

IncludeDirectory

$local::*

[media_type::]dri

Specifies directories

ve:pathWhere:

to be included in

media_type

the software scan.
The para

Table 43. Parameters in the isotag_config.xml and slmtag_config.xml files
(continued)
Parameter

Default value

Possible values

Description

Spec

meter is not avail

ifies

able.

the
media
type.
Pos
sible
val
ues:
• $lo
cal
In
cludes
lo
cal
disks.
• $re
mote
In
cludes
re
mote
disks.
• $oth
er
In
cludes

Table 43. Parameters in the isotag_config.xml and slmtag_config.xml files
(continued)
Parameter

Default value

Possible values
oth
er
disk
types,
for
ex
am
ple:
DVD.
This
op
tion
is
sup
port
ed
on
ly
on
Win
dows.
• $all
In
cludes
all
disks
that
are

Description

Table 43. Parameters in the isotag_config.xml and slmtag_config.xml files
(continued)
Parameter

Default value

Possible values
list
ed
above.
If the
medi
a_type
vari
able
is not
spec
ified,
the
$local
value
is as
sumed.
drive
Spec
ifies
drives
to be
includ
ed.
You
can in
dicate
one or

Description

Table 43. Parameters in the isotag_config.xml and slmtag_config.xml files
(continued)
Parameter

Default value

Possible values
more
drives
or you
can
use
the
$local,
$re
mote,
$oth
er, and
$all
val
ues.
In the
latter
case,
all dri
ves of
a par
ticular
type
are in
cluded
in the
scan.
This
vari
able

Description

Table 43. Parameters in the isotag_config.xml and slmtag_config.xml files
(continued)
Parameter

Default value

Possible values
is op
tion
al on
UNIX.
path
Spec
ifies
the
path
to be
includ
ed.
The
fol
lowing
wild
cards
are
sup
port
ed: as
terisks
(*) and
ques
tion
mark
(?).

Description

Table 43. Parameters in the isotag_config.xml and slmtag_config.xml files
(continued)
Parameter

Default value

Possible values

Description

Timeout

43200

Any positive number Specifies the num
ber of seconds after
which a query times
out.

schedule_scans.sh
Replace the default user profile name QSECOFR with your preferred profile name to use it to
run capacity scans. The user profile must meet the following requirements:
• Class set to *USER
• Special authority set to *NONE
You can use the same user profile that is used to install the scanner and run the software
scan. Set up the special authority to *ALLOBJ.

sw_config.xml
The file contains parameters for tuning the catalog-based scan. For more information about
this scan, see: Types of software scans.
Table 44. Parameters in the sw_config.xml file.
Parameter

Default value

assumeAutoFS

remote

Possible values
• local
Recognizes
disks mount
ed by autofs

Description
Specifies how the
scan recognizes
disks that were
mounted by the au

as local disks. tomatic mounting
service (autofs).
• remote

The para

Table 44. Parameters in the sw_config.xml file. (continued)
Parameter

Default value

Possible values

Description

Recognizes

meter is not avail

disks mount

able .

ed by autofs
as remote
disks.
• other
Recognizes
disks mount
ed by autofs
as disks of
other types,
for example:
DVD.
excludeDirectory

For the list of direc

Directory name

Specifies directo

tories that are ex

ries that are exclud

cluded by default,

ed from software

see: Excluding di

scans. For more

rectories from be

information, see:

ing scanned (BigFix

Excluding direc

scenario).

tories from soft
ware scans by dis
connected scanner
(disconnected sce
nario).

excludeGuestDirec true

• true

Specifies whether

tories

• false

catalogs that be
long to zones
or WPARs are

Table 44. Parameters in the sw_config.xml file. (continued)
Parameter

Default value

Possible values

Description
scanned. When the
value of the para
meter is set to true,
the catalogs are not
scanned.

includeDirectory

$local::*

[media_type::]dri

Specifies directo

ve:pathWhere:

ries to be includ

media_type
Spec

ed in the software
scan.

The

parameter is not

ifies

available .

the
media
type.
Pos
sible
val
ues:
• $lo
cal
In
cludes
lo
cal
disks.
• $re
mote

Table 44. Parameters in the sw_config.xml file. (continued)
Parameter

Default value

Possible values
In
cludes
re
mote
disks.
• $oth
er
In
cludes
oth
er
disk
types,
for
ex
am
ple:
DVD.
This
op
tion
is
sup
port
ed
on
ly
on

Description

Table 44. Parameters in the sw_config.xml file. (continued)
Parameter

Default value

Possible values
Win
dows.
• $all
In
cludes
all
disks
that
are
list
ed
above.
If the
medi
a_type
vari
able
is not
spec
ified,
the
$local
value
is as
sumed.
drive
Spec
ifies

Description

Table 44. Parameters in the sw_config.xml file. (continued)
Parameter

Default value

Possible values
drives
to be
includ
ed.
You
can in
dicate
one or
more
drives
or you
can
use
the
$local,
$re
mote,
$oth
er, and
$all
val
ues.
In the
latter
case,
all dri
ves of
a par
ticular
type

Description

Table 44. Parameters in the sw_config.xml file. (continued)
Parameter

Default value

Possible values
are in
cluded
in the
scan.
This
vari
able
is op
tion
al on
UNIX.
path
Spec
ifies
the
path
to be
includ
ed.
The
fol
lowing
wild
cards
are
sup
port
ed: as
terisks

Description

Table 44. Parameters in the sw_config.xml file. (continued)
Parameter

Default value

Possible values

Description

(*),
ques
tion
mark
(?).
maxQueryTime

43200

Any positive num

Specifies the num

ber

ber of seconds after
which a query times
out.

Configuration files that should not be modified
Do not modify any parameters in the following configuration files. Otherwise, the
disconnected scanner might stop working.
• tlm_hw_config.xml
• vpd_config

Discovery of software in Docker containers
Available from 9.2.5. Docker is a platform that allows for automating the
deployment of applications inside software containers. BigFix Inventory discovers software
that is installed inside Docker containers. It also measures license metric utilization of the
discovered products.

Discovering software
BigFix Inventory discovers software that is installed in Docker containers on condition that:
• Only one Docker engine is deployed on the host computer.
• The Docker container is deployed on one of the following platforms:

◦ Red Hat Enterprise Linux 7 for x86
◦ Red Hat Enterprise Linux 7 for IBM System z (64-bit)
◦ SUSE Linux 12 for x86
• The Docker container is running.
• The BigFix client is installed on the host computer.
• Scans and uploads of their results are enabled on the host computer.
• Software that is installed in the Docker container delivers software ID tags.
• To ensure proper discovery of software on Docker containers, the content of a Docker
container cannot change throughout its lifecycle.
Starting from application update 9.2.10, BigFix Inventory additionally supports
software discovery on Docker containers under the Red Hat® OpenShift container
application platform.

Viewing software
Software that is installed in Docker containers can be viewed on the Software Installations
report. It is presented under the host computer. To learn why the software was discovered,
click Details.

The details include, among other, information about:
Container on which the software was detected.
Software ID tag that caused the detection.

Additional configuration
In some Docker environments, you might need to perform additional steps to specify a nondefault installation path, or to exclude directories from scanning. For more information, see:
Configuring scans on Docker containers.

Measuring license metric utilization
Apart from discovering software that is installed in Docker containers, BigFix Inventory also
reports license metric utilization of the discovered products. When the Docker is deployed
on a physical host, license metric utilization is calculated on the level of the host. When it is
deployed on a virtual machine, utilization is calculated on the level of the virtual machine.
For more details, see the following scenarios.
Important: Docker is not a subcapacity eligible virtualization but it can be used in
combination with a subcapacity eligible virtualization. The scenarios show how
utilization of PVU and RVU MAPC is calculated. Utilization of other reported metrics
is calculated in an analogical way.
Scenario 1: Docker deployed on a physical server
When the Docker engine is deployed directly on a physical server, PVU and RVU MAPC
utilization is measured on the level of the host computer.
Example: Three containers are deployed on a physical server that has four Intel Xeon 3400
processors, each with six cores. It gives 24 cores in total. IBM MQ is installed in two out of
three containers. BigFix Inventory counts PVU and RVU MAPC utilization on the level of the
host computer.

In this case, IBM MQ has access to 24 cores. According to the PVU table, when the server
has four sockets, this processor model is assigned 100 PVUs per core. Thus, PVU utilization
for IBM MQ equals 2400 PVUs. The value would be the same if another instance of IBM MQ
was installed in the third container.
Scenario 2: Docker deployed on a virtual machine
When the Docker engine is deployed on a virtual machine, PVU and RVU MAPC utilization is
counted as the highest number of PVUs that are available for the virtual machine.
Example: Two virtual machines are installed on a physical server that has four Intel Xeon
3400 processors, each with six cores. It gives 24 cores in total. Each virtual machine is
assigned eight cores and has two containers deployed. IBM MQ is installed:
• In one container on the first virtual machine
• In two containers on the second virtual machine

In this case, IBM MQ that is installed on each of the virtual machines has access to eight
cores. In total, it has access to 16 cores out of 24 cores that are available on the physical
computer. According to the PVU table, when the server has four sockets, this processor
model is assigned 100 PVUs per core. Thus, PVU utilization for IBM MQ equals 1600 PVUs.
If the Docker engine was deployed directly on the physical server, IBM MQ would have
access to 24 cores and its PVU utilization would equal 2400 PVUs.

Disabling software discovery
By default, BigFix Inventory scans all Docker containers that are deployed on computers
where the BigFix client is installed. If you do not want to scan the containers, but still want
to monitor the host computer, you can disable scanning of Docker containers. For more
information, see: Disabling scans on Docker containers.

Logs
To troubleshoot problems with discovery of software that is installed in Docker containers,
see the docker_scan.log log. The log is stored in the BigFix client installation directory.
By default, it is:
var/opt/BesClient/LMT/CIT/docker_scan.log
C:\Program Files (x86)\BigFix Enterprise\BESClient\LMT
\CIT\docker_scan.log

Fixlet to force rescan Docker containers during next Software Scan
The fixlet, "Clear cache to force rescan Docker containers during next Software Scan" forces
rescanning of docker containers during the next Initiate Software Scan. This is achieved by
clearing cache of already scanned images. This task refers to the ISO tagged software scan
on Docker containers.

Support for ISO/IEC 19770-2
ISO/IEC 19770-2 is an international standard for creating software identification (SWID)
tags. The tags are XML files that are used for discovering and identifying software. They
are delivered with software products and contain unique product-related information such
as its name, edition, version, whether it is a part of a bundle and more. SWID tags facilitate
software discovery and the overall process of software asset management.
Component Detailed Version now provides complete information about fix packs
through ISO 19770-2 patch/delta tags. Previously the tags used to get rejected on both,
endpoint side and server side. The functionality works with BigFix Inventory server version
10.0.2 or higher and Initiate Software Scan fixlet version 10.0.2 or higher.

Supported schemas
BigFix Inventory supports SWID tags in the 19770-2:2014-CD1 and 19770-2:2015 schemas.
BigFix Inventory supports ISO 19770-2 SWID tags. Initial support for provided for the
19770-2:2014-CD1 and 19770-2:2015 schemas and only primary tags.With version 10.0.2
there has been added support for delta/patch tags.Starting from version 10.0.4 there has
been added support for 19770-2:2008 schema as well improved recovering information
from not well formed ISO tags, including tags without changed tagID/tagVersion but
updated release information.

BigFix
When BigFix is discovered with an SWID tag that is not contained in the current catalog,
a warning sign is displayed on the Software Catalog widget. If you want to see what
components were detected, perform the following steps:
1. In the top navigation bar, click Reports > Software Installations.
2. Hover over Configure, and click Configure View. Select the Component Definition
Source check box to display the column, and add the following filter: Component
Definition Source, equal to, SWID IBM Tags Without License Info. Then, click

Submit.
To be able to bundle such components, upload the latest software catalog.
Tip:

You can create a custom bundling definition on the Software

Classificationpanel.

Limitations
• Bundling assistance might not be available for IBM components that are discovered
with the SWID tag. To assign such a component to a product, upload the latest
software catalog to BigFix Inventory. If the catalog contains the relation, automatic
bundling is done. You have to either confirm the suggested relation or, if the relation is
not correct, reassign the component to a different product.

Related information
Bundling tags

Discovering Mac software in BigFix Inventory
With BigFix Inventory version 10.0.10, software discovery is extended on Mac endpoints
or computers. The discovery is based on catalog-less mechanism and catalog entries are
created automatically based on discovery results and algorithm/logic for Mac discovery.
Mac application packages have well-defined naming convention and versioning, but vendor
of an application is not normalized. BigFix Inventory includes an algorithm to determine and
normalize the names of software vendors for Mac software packages. This feature replaces
the previous method of software discovery. All catalog definitions including signatures
created by “Automatic Signature creation for installed software on Mac Computers” and
dependent discovery are removed during upgrade.
To be able to use new Mac software discovery:
• Update “Initiate Software Scan” action to version 10.0.10
• Update “BigFix Inventory Server” to version 10.0.10

Before upgrading
As Mac OS package discovery is improved, current catalog and software discovered for
Mac OS machines are removed during the application upgrade. The data is replaced with
data imported during new software scan. As the data is removed, application upgrade may
take longer than usual if there are Mac software and machines in the environment.
The time required for upgrade is estimated by the following query:
select count(*) / 20 from sam.software_components c
join sam.publishers p on c.publisher_id = p.id
where p.name = 'Unclassified Mac Software'

Note: Stop old actions and start new actions using updated version of “Initiate
Software Scan” fixlet. The result of this fixlet produces package data for Mac OS
machines in a format that is accepted by BigFix Inventory 10.0.10.0. Data from old
format is still shown on Package Data panel, but no longer on software inventory
reports, like Software Classification.

New features
The new features are listed below:
Vendor name
The new package scan for Mac OS provides information about the package
vendor. Additionally, during data import, vendor names are normalized to avoid
duplicate vendor names. For example, “HCL America” is normalized to “HCL”
and “International Business Machines” to “IBM”, etc.
Extended usage data
The new package scan for Mac OS includes improvements for usage
signatures generation. As a result, number of software components with the
ability to report usage is higher than in previous implementation.
Package categories
To further improve the Mac software reporting, a “category” of the package
has been introduced. In current implementation each package on Mac
is classified as “Application” or “Other”. Only the entries categorized
as “Application” are promoted to Catalog and reported under Software
Classification.
It is also possible to promote entries classified as “Other” by manually creating
the signature from the Package Data view. It is recommended to adjust
signature to include any patch for given software and normalize Publisher and
Software Name.
New catalog hierarchy

Components discovered on Mac machines are bundled to one product
having release number ‘*’ instead of numbers depending on package version.
The change is also applicable to 'product_release' column in api/sam/v2/
software_instances REST API. It does not affect license calculations.

Component version is limited to two numbers, for example, 1.2 where the
whole version string is present in Component Detailed Version column.

Unicode
Available from 9.2.3. Starting from V9.5, BigFix Platform has the capability to
gather data from BigFix clients deployed with different code pages and languages, encode
the data into UTF-8 format, and report it back to the BigFix server. As a result, regardless of
the system and encoding that your clients use, the data is correctly displayed both in BigFix
and in BigFix Inventory. This capability is useful when your environment has clients with
different code pages and data that contains non-ASCII characters.
This capability has the following main assumptions:
• The data is correctly displayed only if the characters belong to the code page of
a particular client. Your clients can use various code pages and all of them are
supported by BigFix, but from the perspective of a single client, all outgoing data must
be consistent with the code page of this client. For example, if you install software
whose name contains the ê character (which is specific to Windows 1252 code page)
on a client that uses the Windows 1250 code page, this character will not be correctly
displayed in BigFix Inventory, because it does not belong to the code page of the
client.
• Encoding into UTF-8 format is supported only for the bottom-up data flow, that is, for
the data that flows from the BigFix clients to the BigFix server. The top-down data flow
does not support this encoding, which means that all actions sent towards the clients,
for example through Fixlets, cannot contain non-ASCII characters. The top-down data
flow always uses the code page of the BigFix server.

Prerequisites
• BigFix server 9.5 or higher
• BigFix agent 9.5 or higher
• BigFix Inventory 9.2.3 or higher

Limitations
• Results of the package data scan
All results of the package data scan, that is, packages and data retrieved from the
registry, are omitted if they contain characters that do not belong to the code page of
the client on which they are installed. Such results are filtered out on the client side
and are not uploaded to BigFix. Other types of the software scan are not affected.
• Names of all items created in the BigFix interface
All items created in the BigFix interface, such as custom sites, Fixlets and analyses,
computer groups, and so on, will not be correctly displayed if they contain characters
that do not belong to the code page of the BigFix server. All these items are a part of
the top-down data flow, which does not support encoding into UTF-8 format.
• BigFix Inventory Fixlets that has user-specified paths
Avoid using non-ASCII characters while specifying paths in BigFix Inventory Fixlets,
because such paths might not be accepted. The affected Fixlets are: Add Excluded
Directories, Remove Excluded Directories, and Change Scanner Cache Folder.
• VM managers credentials
Avoid using non-ASCII characters in user names that are used to log in to VM
managers, because the VM Manager Tool that connects to those VM managers does
not support encoding into UTF-8 format.
• Subscription e-mails
Avoid using non-ASCII characters in email addresses, which are used as the recipients
of scheduled reports.

Related information
Unicode in BigFix

Time handling
From version 10.0.6, contract values are calculated in UTC (Coordinated Universal Time)
time zone. Before version 10.0.6, BigFix Inventory used to calculate contract values in server
OS's time zone for All Contract reports and in local time for edit contracts.
Dates are shown in local time zone if no time zone is mentioned for a component. Dates are
shown in UTC if the same is mentioned during the creation. For example, when creating a
new contract, BigFix Inventory indicates that the considered time zone is UTC.
Example: All Metrics panel
In UTC In UTC, daylight saving does not impact the start and end time. In UTC, any
computation for the date considers the start time as 00:00:00 UTC and end time as
23:59:59 UTC.
Example: Data Imports
A data import is scheduled in Central European Time (CET) for October, 14th
2021 at 03:00 PM (15:00). In UTC, the import is scheduled for 1:00 PM (13:00).
This means that after switch to Winter time on October 31, 3:00 AM, data
import will be still triggered at 1:00 PM (13:00) UTC, which mean that the
import will happen at 2:00 PM (14:00) CET instead of 03:00 PM (15:00).
Example: Saved Reports
In Asia-Pacific time zone, at the start of the day, reports show data from
'previous day' and in Americas, at the end of the day, reports show data from
'next day'. To avoid this discrepancy, API calls are made based on the UTC
time zone. When you select to view a report, the API converts the report in
UTC and the report is shown in UTC.

Scenarios
To understand the business goals that you can achieve with BigFix Inventory, familiarize
yourself with the main user scenarios. Each scenario presents a real-life example of using
the application and lists personas who are typically involved in achieving a business goal.

Service providers
Available from 9.2.2. To properly calculate subcapacity values in the service
provider environment, divide the computers in your infrastructure into groups that represent
your customers. Then, manage software and generate audit snapshots separately for each
customer.
A service provider is a company that provides other organizations with access to software
installed on machines that are owned and maintained by the service provider. There are
three typical scenarios that are used in the service provider environment.

Scenario 1: Software that is installed on one virtual machine is used by one
customer
In this scenario, all products that are installed on one virtual machine are used by one
customer. To properly calculate PVU values for each customer, perform the following steps:
1. Configure VM managers that control virtual machines in your environment.
Tip: If each customer should be allowed to view information about all VM
managers in the infrastructure, use basic VM management (central). If each
customer should be allowed to only view information about VM managers
that control the virtual machines that he uses, use advanced VM management
(distributed).
2. If you grant your customers access to the BigFix console to allow them to run scans
and perform other actions on computers, create a site, a computer group, and
an operator that is dedicated to each customer. Then, provide the customer with
credentials for the dedicated operator. This way, you ensure that each customer has
access only to computers on which the software that he uses is installed.

3. Create computer groups that represent your customers in BigFix Inventory. Ensure
that each group contains only machines with software that is used by one customer.
Avoid creating computer groups that overlap as it might distort the obtained results.
4. Bundle software and generate reports per customer:
• If you give customers access to BigFix Inventory or when each customer
account is managed by a separate person, create dedicated BigFix Inventory
users, each with access to one computer group. Then, provide each customer
with credentials for the user dedicated to their company. Each customer can
manage software and generate reports for the software that they use.
Restriction: To ensure that each user has access to information
only about computers that he uses, do not assign the user with the
Administrator role. By default, this role has access to the All Computers
group. Thus, a user who is assigned this role can view information about
all computers in the infrastructure.
• If you manage customer software, generate a separate audit snapshot for each
computer group. Then, provide each customer with their report.
For detailed instructions, see: Tutorial: Managing software in the service provider
environment.

Scenario 2: Some of the software that is installed on a virtual machine is
used by the service provider
In this scenario, some of the software products that are installed on a virtual machine are
used by the service provider, not the customer. To ensure that the customer is not charged
for these products, perform the following steps for each computer group:
1. Open the All Metrics report and filter out the product that is not used by the customer.
2. Set the report as the default view for the computer group to which your user is
assigned.
3. Generate the audit snapshot. It will not contain the software that is not used by the
customer.

Restriction: All instances of the product that you filter out must be used by the
service provider.
For detailed instructions, see: Tutorial: Managing software in the service provider
environment.

Scenario 3: Software that is installed on one virtual machine is used by many
customers
In this scenario, multiple customers access software that is installed on one virtual
machine. This scenario is not supported in BigFix Inventory.

Data visibility
Some of the items in BigFix Inventory are visible globally to all users. Other items are
visible only for the user who has access to a particular computer group. If you grant your
customers access to BigFix Inventory, review which items are visible globally and which are
visible per computer group.
Table 45. Data visibility
The table consists of three columns and 17 rows.

Item

Visible

Visible per

globally to

comput

all users

er group

Data retention period

Yes

Email server

Yes

LDAP server

Yes

PVU table

Yes

Retrieved computer properties

Yes

Software catalog

Yes

Table 45. Data visibility
The table consists of three columns and 17 rows.
(continued)

Item
VM managers (in the basic VM management scenario)

Visible

Visible per

globally to

comput

all users

er group

Yes

Audit trail

Yes

Bundling

Yes

Computer groups

Yes

Contracts

Yes

Part numbers

Yes

Reports

Yes

Software exclusions

Yes

VM managers (in the advanced VM management scenario)

Yes

Unrecognized files

Yes

BigFix subcapacity regions
Available from 9.2.2. BigFix subcapacity licensing rules define three regions.
To properly calculate subcapacity values for products that are installed in multiple
regions, generate the audit snapshot for each region. Then, for every product, sum up the
subcapacity values from all regions. The value that you obtain is the overall subcapacity
usage for the particular product.

BigFix subcapacity regions
Regions that are defined by BigFix subcapacity licensing rules include:

• Region 1: North America and South America
• Region 2: Europe and Africa
• Region 3: Asia and Australia
For more information, see: Virtualization Capacity License Counting Rules.

Steps to calculate subcapacity values
To properly calculate subcapacity values in an environment that spans over multiple BigFix
subcapacity regions, perform the following steps:
1. Divide the computers in your infrastructure into groups that reflect BigFix subcapacity
regions. Ensure that each group contains only computers that are located in one
region. Do not create computer groups that overlap as it might distort the obtained
results.
2. Optional: If software in each region is managed by a different person, create
dedicated BigFix Inventory users, each with access only to computers in one region.
3. Import part numbers for each computer group and bundle software within each
region.
4. Generate audit snapshots for each region. Ensure that the snapshots cover the same
or approximately the same period.
5. For every product, sum up the subcapacity values from all regions. The value that you
obtain is the overall subcapacity usage for the particular product.
Important: If you generate the audit snapshot for the All Computers group,
the PVU usage might differ from the value that you obtain by summing up
PVU values from snapshots generated for each region. PVU usage for the All
Computers group is measured at the time when the sum of PVU values from
all regions is the highest. However, this value might not reflect the highest
PVU usage in each region. To comply with the subcapacity licensing rules,
you must know what is the highest PVU usage in each region, and then sum
up these values to obtain the overall PVU usage for a product. To better
understand the logic, see the example below.

For detailed instructions, see: Tutorial: Reporting subcapacity usage per computer group.

Example
A large international company has offices in Australia, Europe, and North America. To fulfill
the subcapacity licensing requirements, computers in this company are divided into three
groups. The computer group hierarchy looks as follows.
• All Computers
◦ Region 1: North America
◦ Region 2: Europe
◦ Region 3: Australia
Product A is installed on computers in all regions. To obtain information about the highest
PVU usage in each region, the Software Asset Manager generates the audit snapshot for
each region. Figure 1: The highest PVU usage for Product A in each region. is a visualization
of PVU usage for Product A. The highest PVU usage for each region is marked in blue.
Figure 1. The highest PVU usage for Product A in each region.

According to the generated snapshots, the highest PVU values are:

• 140 PVUs in Region 1
• 200 PVUs in Region 2
• 140 PVUs in Region 3
To obtain the overall PVU usage for Product A, the Software Asset Manager sums up the
highest PVU values from each region.
140 + 200 + 140 = 480 PVUs
The total PVU usage for Product A is 480 PVUs. If the Software Asset Manager generated
a single audit snapshot for the All Computers group, the reported PVU usage would be
340 PVUs. Figure 2: The highest PVU usage for Product A in the All Computers group. is a
visualization of PVU usage for Product A calculated on the level of the All Computers group.
The highest PVU usage is marked in blue.
Figure 2. The highest PVU usage for Product A in the All Computers group.

The correct PVU value for Product A is the value obtained by summing up the PVU values
from three regions, namely 480 PVUs.

Possible setup of the BigFix infrastructure
To facilitate infrastructure management and the creation of computer groups, you can set
up the BigFix infrastructure in one of the following ways.
Important: These setups are provided as examples only. You can set up the BigFix
infrastructure in any way that suits your needs.
One BigFix server with three relays
In this case, one BigFix server monitors all computers in your infrastructure. You set
up three relays, each dedicated to handling the traffic from computers in one BigFix
subcapacity region. Then, in the BigFix console, you create computer groups that reflect the
BigFix subcapacity regions. You can later on use these groups to easily create computer
groups in BigFix Inventory.
Note: Computer groups created in the BigFix console are used to manage
the infrastructure, and run Fixlets against selected computers. They are not
automatically copied to BigFix Inventory. However, they can be used as the basis for
creating computer groups that define the scope of reports in BigFix Inventory.

Three BigFix servers
In this case, you set up an infrastructure with three BigFix servers. Each server is dedicated
to one BigFix subcapacity region and collects data only from the computers in that region.
Data from all BigFix servers is imported to one instance of BigFix Inventory in which you
create three computer groups. Each computer group reflects one BigFix server.

Organizational business units
Available from 9.2.2. To manage software and view reports per organizational
business unit, divide the computers in your infrastructure into groups that represent these
units. Then, create dedicated users, each with access to a particular computer group.
To manage software per organization business unit, perform the following steps:
1. Divide the computers in your infrastructure into groups that reflect the departments.
Ensure that each group contains only computers from one department. Do not create
computer groups that overlap as it might distort the obtained results.
2. If software in each department is managed by a different person, create dedicated
BigFix Inventory users, each with access to computers in one department.
3. Import part numbers for each computer group and bundle software within each
department.

For detailed instructions, see: Tutorial: Reporting subcapacity usage per computer group.

Example
A company that is located in the United States has three departments: Finance, HR, and IT.
Because employees in each department use software that is typical for their position, the
Software Asset Manager wants to manage the software for each department separately. To
do this, he asked the IT Architect to create three computer groups in BigFix Inventory, each
containing computers from only one business unit. The computer group hierarchy looks as
follows.
• All Computers
◦ Computer Group 1: Finance Department
◦ Computer Group 2: HR Department
◦ Computer Group 3: IT Department
The Software Asset Manager can now import part numbers that are dedicated for each
computer group and manage the software within each department separately. He can also
generate separate subcapacity reports to get an overview of PVU consumption for BigFix
software within each department. However, to create the audit snapshot with the PVU
consumption within the entire company he must generate the audit snapshot for the All
Computers group.

Give us feedback
The BigFix Inventory development team is open to any kind of feedback that can help
improve our application and better tailor it to your needs. You can leave your comments or
ask questions through several channels.
Forum
Use for: quick problem solving
If you are not necessarily looking to give us feedback, but rather need a quick
solution to your problem, visit our forum and check whether we already helped
in a similar situation. If you cannot find a solution, describe the problem and

get help from other experienced users or our team, which constantly monitors
the submitted posts. This is not an official, but a very quick way to get support.
• Go to Inventory forum
Service Request (PMR)
Use for: defects and problems, official support channel
Service Requests, or PMRs, are an official way of communicating with
our support teams. Day and night, in Americas, Europe, or Asia, there is
always someone who will find a solution to your problem, regardless of how
complicated it may seem.
• Open a Service Request
RFE
Use for: ideas for enhancements and new functions
RFE, or Request for Enhancement, is a way to submit an idea for a new
function in BigFix Inventory.
• Submit an idea

Installing
Learn about the requirements and available installation scenarios to ensure that the
deployment of BigFix Inventory goes smoothly in your environment.

Planning the installation
Before you start the installation, review information about hardware and software
requirements and other considerations to ensure that the installation completes
successfully.

BigFix Inventory infrastructure
A complete deployment of BigFix Inventory consists of the BigFix Inventory server and
its database, the BigFix server and its database, and a BigFix console. Additionally, a
BigFix client must be installed on every computer from which you want to collect software
inventory data. Depending on the environment size, you can install all components on a
single computer, or distribute them among multiple computers.
Figure 3. BigFix Inventory infrastructure

BigFix Inventory server
The BigFix Inventory server provides a reporting interface for the inventory
data that is collected from the computers managed by BigFix. To process the
data in real time and to ensure reporting accuracy, the BigFix Inventory server
should run all the time. Users access the application server through a web
user interface.
BigFix server
The BigFix server forms the heart of the BigFix infrastructure. It coordinates
the flow of data to and from individual computers. The server stores the
results of capacity scans for up to five days, and thus should not be stopped
for a longer period. It also stores the results of the last successful software
scan from each computer. If new software scans are run more than once
during server maintenance, not all of them are processed after the restart.
BigFix console

The BigFix console provides a system-wide view of all computers in the
infrastructure and their configuration. It is used to target computers with
specific actions such as installing the scanner or scheduling software and
capacity scans.
Web Reports
Web Reports is a high-level web application that allows for visualizing data
collected from the BigFix infrastructure. It is required by BigFix Inventory to
connect with the VM Manager Tool that collects data from the VM managers
in your infrastructure.
BigFix clients
BigFix client is common for all products that are based on the BigFix platform
and should be installed on every computer, including backup and recovery
machines, to ensure audit readiness. It provides information about computer
properties, and is used to perform tasks such as installing the scanner on
the computers. The BigFix client runs on all operating systems supported by
BigFix Inventory, except for IBM i that uses disconnected scans instead of the
client.
Apart from the BigFix client, a scanner should also be installed on every
monitored computer. The scanner is an independent component that is used
by BigFix Inventory to collect information about the hardware, as well as the
software that is installed on the computers in your infrastructure.
Databases
BigFix server and BigFix Inventory server require their separate database
instances. Depending on the size of your environment, these can be two
database instances running on a single database engine, or two separate
database engines. The data is extracted from the BigFix server database and
imported to the BigFix Inventory database during the Extract, Transform, and
Load (ETL) import process.

Detailed System requirements
The tables in this section provide detailed information about the system requirements for
BigFix Inventory 10.
List of system requirements for previous versions of BigFix Inventory:
• 9.2.16
• 9.2.15
• 9.2.14
• 9.2.13
• 9.2.12
• 9.2.11
• 9.2.10
Operating systems
Hypervisors
Prerequisites

Supported managed devices
The tables in this section provide detailed information about supported managed devices
for BigFix Inventory 10.
Important: Software vendors might restrict eligible paltform for their software
licensing and change the eligability in future for reasons, such as end of support
of given technology. To stay compliant with vendor rules, refer to the vendor
documentation about current platform eligability for a given licensing metric. For
IBM Subcapacity eligible systems, check Sub-capacity (Virtualization capacity)
licensing page.
Navigation
Operating systems: AIX HP IBM i Linux Solaris Windows

Hypervisors: AIX HP IBM i Linux Solaris Windows
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Table 46. AIX
Operating
system
AIX 6.1

Hardware
POWER System -

Bitness

Supported
BigFix Agent

Disconnected Scanner

Operating system minimum

Notes

64-Exploit

Yes

Yes

TL4

(1)

64-Exploit

Yes

Yes

Varies

(1)

64-Exploit

Yes

Yes

Base

(1)

64-Exploit

No

Yes

Base

(1)

Big Endian
AIX 7.1

POWER System Big Endian

AIX 7.2

POWER System Big Endian

AIX 7.3

POWER System Big Endian

AIX notes:
1. Supported Virtualization Technologies
• PowerVM®
◦ LPAR
◦ DLPAR
◦ Single Shared Processor Pool
◦ Micro-Partitioning®
◦ Multiple Shared Processor Pools
◦ Shared Dedicated Processor
◦ Mobility (Live Partition Mobility)
◦ System WPARs (Both regulated and un-regulated, also RSET bound)
◦ WPAR mobility (Live Application Mobility)
• IBM zEnterprise® BladeCenter Extension (zBX)
• Processor Core Deconfiguration
• Power Enterprise Pools (Supported for all IBM Power Systems that support this
technology)
• Both regulated and un-regulated, also RSET bound
Note: Ensure that on AIX the xlC.rte library version 13.1.0.0 or higher is
installed on the target computer.

Table 47. HP
Oper
ating
system
HP-UX
11i v3
HP-UX
11i v3

Supported
Hard
ware

Bitness

Big

Discon

Fix

nected

Agent Scanner
IA64

32, 64-Ex

Operating
system

Notes

minimum

Yes

Yes

Base

Yes

Yes

Yes

Base

Yes

ploit
PA-RISC 32, 64-Ex
ploit

Prod

End

uct

of

mini

sup

mum

port

Notes:
1. Effective April 30, 2022, HCL will end service for BigFix Platform version 9.2.x. Even
with the end of support for BigFix Platform 9.2.x, BigFix will continue to support
for HP-UX using BigFix Platform 9.2 Agent reporting to BigFix Platform 9.5 or 10.0,
connected to BigFix Inventory 10.x. BigFix Platform 9.2 HP-UX Agent patches will be
provided only to address PSIRT records or high severity customer reported defects.
For more information, see BigFix forum annoucement.
Table 48. IBM i
Supported
Oper
ating

Hardware

system

Bit

BigFix

ness

Agent

Dis

Oper

con

ating

nect system Notes
mini
ed
Scan

mum

ner
IBM i 7.1

POWER Sys 32

No

Yes

tem - Big

Base

(1)

(1)

Endian
IBM i 7.2

POWER Sys 32

No

Yes

tem - Big

Base

(1)

(1)

Endian
IBM i 7.3

POWER Sys 32

No

Yes

tem - Big

Base

(1)

(1)

Endian
IBM i 7.4

POWER Sys 32
tem - Big
Endian

No

yes

Base

No

Prod

End

uct

of

mini

sup

mum

port

Table 48. IBM i (continued)
Supported
Oper
ating

Hardware

system

Bit

BigFix

ness

Agent

Dis

Oper

con

ating

nect system Notes
mini
ed
Scan

mum

Prod

End

uct

of

mini

sup

mum

port

ner
IBM i 7.5

POWER Sys 32

No

Yes

Base

No

tem - Big
Endian
IBM i notes:
1. Supported Virtualization Technologies PowerVM
• LPAR
• DLPAR
• Single Shared Processor Pool
• Micro-Partitioning
• Multiple Shared Processor Pools
• Shared Dedicated Processor
• Mobility (Live Partition Mobility)
Table 49. Linux
Supported

Oper
ating

Operating

Hard

system

ware

Bitness

Discon
BigFix Agent nected

sys
tem

Prod End
uct
of
Notes
mini sup

Scanner mini
mum
CentOS 7

x86-64 64-Exploit

Yes

No

Base

mum port

No

Table 49. Linux (continued)
Supported

Oper
ating

Operating

Hard

system

ware

Bitness

Discon
BigFix Agent nected

sys
tem

Prod End
uct
of
Notes
mini sup

Scanner mini
mum
CentOS 8

x86-64 64-Tolerate

Yes

Yes

Base

mum port

(2)

(2)
Debian 9.8 x86-64 64-Exploit,

Yes

No

Base

No

64-Tolerate

Yes

No

Base

No

64-Tolerate

Yes

Yes

Base

No

64-Tolerate

Yes

Yes

Base

No

Yes

No

Base

No

Yes

No

Base

No

Yes

Yes

Base

(2)

64-Tolerate
Debian 10

x86
and
x64

Debian 11

x86
and
x64

Debian 11

x86
and
x64

Oracle En x86-64 32, 64-Ex
terprise

ploit

Linux 6
Oracle En x86-64 64-Exploit
terprise
Linux 7
Oracle En x86-64 64-Exploit
terprise
Linux 8

(2)

Table 49. Linux (continued)
Supported

Oper
ating

Operating

Hard

system

ware

Bitness

Discon
BigFix Agent nected

sys
tem

Prod End
uct
of
Notes
mini sup

Scanner mini
mum
Red Hat

POW

64-Exploit

Yes

No

Enterprise ER

Base

mum port

(2)

10.0.1

(2)

10.0.1

(2)

10.0.1

(2)

Linux

Sys

(RHEL) 5

tem -

Advanced

Big En

Platform

dian

Red Hat

IBM z

64-Exploit,

Enter

Sys

64-Tolerate

prise Lin

tems

Yes

Yes

Base
(2)

ux (RHEL)
5 Server
Red Hat

POW

Enter

ER

prise Lin

Sys

ux (RHEL)

tem -

5 Server

Big En

64-Exploit

Yes

No

Base
(2)

dian
Red Hat

IBM z

64-Exploit,

Enter

Sys

64-Tolerate

prise Lin

tems

ux (RHEL)
Server 6

Yes

Yes

Base
(2)

(2)

Table 49. Linux (continued)
Supported

Oper
ating

Operating

Hard

system

ware

Bitness

Discon
BigFix Agent nected

sys
tem

Prod End
uct
of
Notes
mini sup

Scanner mini
mum
Red Hat

IBM z

64-Exploit,

Enter

Sys

64-Tolerate

prise Lin

tems

Yes

Yes

Base

mum port

(2)

(2)

ux (RHEL)
Server 7
Red Hat

POW

Enter

ER

prise Lin

Sys

ux (RHEL)

tem -

6 Server

Big En

64-Tolerate

Yes

Yes

Base

(2)

(2)

dian
Red Hat

POW

64-Exploit,

Enter

ER

64-Tolerate

prise Lin

Sys

ux (RHEL)

tem -

7 Server

Big En

Yes

Yes

Base

(2)

(2)

dian
Red Hat

POW

64-Exploit,

Enter

ER

64-Tolerate

prise Lin

Sys

ux (RHEL)

tem -

Server 7

Little
Endian

Yes

Yes

7.1

Yes

Table 49. Linux (continued)
Supported

Oper
ating

Operating

Hard

system

ware

Bitness

Discon
BigFix Agent nected

sys
tem

Prod End
uct
of
Notes
mini sup

Scanner mini
mum
Red Hat

POW

Enter

ER

prise Lin

Sys

ux (RHEL)

tem -

Server 6

Big En

64-Exploit

Yes

Yes

Base

mum port

(2)

(2)

dian
Red Hat

x86-64 64-Exploit,

Enter

Yes

Yes

64-Tolerate

Base

(2)

(2)

prise Lin
ux (RHEL)
Server 6
Red Hat

x86-64 64-Exploit,

Enter

Yes

Yes

64-Tolerate

Base

(2)

(2)

prise Lin
ux (RHEL)
Server 7
Red Hat

POW

64-Exploit,

Enter

ER

64-Tolerate

prise Lin

Sys

ux (RHEL)

tem -

Server 8.1

Little
Endian

Yes

Yes

Base

(3)

Table 49. Linux (continued)
Supported

Oper
ating

Operating

Hard

system

ware

Bitness

Discon
BigFix Agent nected

sys
tem

Prod End
uct
of
Notes
mini sup

Scanner mini
mum
Red Hat

IBM z

Enter

Sys

prise Lin

tems

64-Tolerate

mum port

No

Yes

Base

(3)

Yes

Yes

Base

(1)

ux (RHEL)
8
Red Hat

x86-64 64-Tolerate

Enter

(1) (2) (2)

prise Lin

(3)

ux (RHEL)
8
Red Hat

x86-64 64-Tolerate

Yes

Yes

Enter

Base

(2)

(2)

prise Lin
ux (RHEL)
9
SUSE Lin

IBM z

ux Enter

Sys

64-Exploit

Yes

No

Base

No

64-Exploit

Yes

No

Base

No

prise Serv tems
er (SLES)
11
SUSE Lin

IBM z

ux Enter

Sys

prise Serv tems

Table 49. Linux (continued)
Supported

Oper
ating

Operating

Hard

system

ware

Bitness

Discon
BigFix Agent nected

sys
tem

Prod End
uct
of
Notes
mini sup

Scanner mini
mum

mum port

er (SLES)
12
SUSE Lin

IBM z

ux Enter

Sys

64-Tolerate

Yes

Yes

Base

No

64-Exploit

Yes

No

Base

No

Yes

Yes

SP3,

No

prise Serv tems
er (SLES)
15
SUSE Lin

POW

ux Enter

ER

prise Serv Sys
er (SLES)

tem -

11

Big En
dian

SUSE Lin

POW

64-Exploit,

ux Enter

ER

64-Tolerate

SP4,

prise Serv Sys
er (SLES)

tem -

12

Little

SP5

Endian
SUSE Lin

POW

ux Enter

ER

prise Serv Sys
tem -

64-Tolerate

No

Yes

Base,
SP1

No

10.0.2

Table 49. Linux (continued)
Supported

Oper
ating

Operating

Hard

system

ware

Bitness

Discon
BigFix Agent nected

sys
tem

Prod End
uct
of
Notes
mini sup

Scanner mini
mum

mum port

er (SLES)

Little

15

Endian

SUSE Lin

x86-32 32

Yes

No

Base

No

x86-64 64-Exploit

Yes

No

Base

No

x86-64 64-Exploit

Yes

No

Base

No

x86-64 64-Exploit

Yes

No

Base

No

ux Enter
prise Serv
er (SLES)
11
SUSE Lin
ux Enter
priseServ
er (SLES)
11
SUSE Lin
ux Enter
prise Serv
er (SLES)
12
SUSE Lin
ux Enter
prise Serv
er (SLES)
15

Table 49. Linux (continued)
Supported

Oper
ating

Operating

Hard

system

ware

Bitness

Discon
BigFix Agent nected

sys
tem

Prod End
uct
of
Notes
mini sup

Scanner mini
mum
SUSE Lin

zSys

ux Enter

tems

mum port

64-Exploit

Yes

No

Base

No

64-Exploit

Yes

No

Base

No

x86-32 32

Yes

No

Base

No

x86-64 64-Exploit

Yes

No

Base

No

KVM

64-Exploit

Yes

No

Base

No

Ubuntu

POW

64-Exploit,

Yes

Yes

Base

No

18.04 LTS

ER

64-Tolerate

prise Serv
er (SLES)
15
Ubuntu

POW

16.04 LTS

ER
Sys
tem Little
Endien

Ubuntu
16.04 LTS
Ubuntu
16.04 LTS
Ubuntu
16.04 LTS

Sys
tem -

Table 49. Linux (continued)
Supported

Oper
ating

Operating

Hard

system

ware

Bitness

Discon
BigFix Agent nected

sys
tem

Prod End
uct
of
Notes
mini sup

Scanner mini
mum

mum port

Little
Endian
Ubuntu

x86-64 64-Tolerate

Yes

No

Base

No

Ubuntu

IBM z

No

Yes

Base

No

18.04 LTS

Sys

x86-64 64-Tolerate

Yes

No

Base

No

Ubuntu

IBM z

64-Tolerate

No

Yes

Base

No

20.04 LTS

Sys

x86-64 64-Tolerate

No

Yes

Base

No

Ubuntu

IBM z

No

Yes

Base

No

22.04 LTS

Sys

18.04 LTS
64-Tolerate

tems
Ubuntu
20.04 LTS

tems
Ubuntu
22.04 LTS

tems
Linux Notes:

64-Tolerate

10.0.2

1. Ensure that on Red Hat Enterprise Linux 8.0 libstdc++.so.6 library is installed on the
target computer.
2. Ensure that the libstdc++.so.6 library is installed on the target computer.
3. To verify the requirement about Red Hat 8, refer to BigFix Platform system
requirement report.
Table 50. Solaris
Supported
Oper
ating
system

Hard

Bit

ware

ness

BigFix Agent

Dis

Oper

con

ating

nect

system

ed

mini

Scan

mum

Prod
uct
mini

End
Notes

mum

SPARC

32

Yes

Yes

Base

10
Solaris
10
Solaris

64-Tol Yes

Yes

Base

erate
SPARC

32

Yes

Yes

Base

tory
Ac
tions

x86-32

32

Yes

Yes

Base

x86-64

64-Tol Yes

Yes

Base

11
Solaris

Inven
10.0.11

11
Solaris

Use
BigFix

x86-64

11
Solaris Notes:

erate

sup
port

ner
Solaris

of

1. Solaris 10 is no longer IBM subcapacity eligible platform
2. Solaris 10 is supported with use of BigFix Platform Agent 9.5
3. Use the BigFix Inventory 10.0.11 actions like "Initate Software Scan" as they contain
improved relevances for handling Solaris package managers
Table 51. Windows
Supported
Dis
Oper
ating
system

Hard

Bit

ware

ness

BigFix
Agent

con

Operating

nect

system

ed

minimum

Scan

Prod
uct
mini

End
Notes

mum

x86-64

64-Ex

Yes

Yes

Base

No

Yes

Yes

Base

No

Yes

Yes

Base

No

64-Tol Yes

Yes

Base

(5)

Yes

Base, An

No

dows 11

ploit,

Pro

64-Tol
erate

Win

x86-64

64-Ex

dows 11

ploit,

Pro for

64-Tol

Work

erate

station
Win

x86-64

64-Ex

dows 11

ploit,

Enter

64-Tol

prise

erate

Win

x86-64

dows 11
Win
dows 10

erate
x86-32

32

Yes

niversary

sup
port

ner
Win

of

Table 51. Windows (continued)
Supported
Dis
Oper
ating
system

Hard

Bit

ware

ness

con

Operating

BigFix

nect

system

Agent

ed

minimum

Scan

Prod
uct
mini

End
Notes

mum

Update,

prise

Creator Up
date, Fall
Creator Up
date, April
2018 Up
date, 1809,
1903, 1909
Base, An
niversary
Update,
Creator Up
date, Fall
Creator Up
date, April
2018 Up
date, 1809,
1903, 1909

Win

x86-64,

dows 10 64-Ex
Enter
prise

ploit,

64-Tol Yes
erate

Yes

Base, An
niversary
Update,
Creator Up
date, Fall

sup
port

ner
Enter

of

(2)

Table 51. Windows (continued)
Supported
Dis
Oper
ating
system

Hard

Bit

ware

ness

con

Operating

BigFix

nect

system

Agent

ed

minimum

Scan

Prod
uct
mini

End
Notes

mum

Creator Up
date, April
2018 Up
date, 1809,
1903, 1909
Base (2),
Anniversary
Update (2),
Creator Up
date (2),
Fall Creator
Update (2),
April 2018
Update (2),
1809 (2),
1903 (2),
1909 (2)
x86-32

32

Yes

Yes

Base, An

dows 10

niversary

Pro

Update,
Creator Up
date, Fall
Creator Up

sup
port

ner

Win

of

No

Table 51. Windows (continued)
Supported
Dis
Oper
ating
system

Hard

Bit

ware

ness

con

Operating

BigFix

nect

system

Agent

ed

minimum

Scan

Prod
uct
mini

End
Notes

mum

date, April
2018 Up
date, 1809,
1903, 1909
Base, An
niversary
Update,
Creator Up
date, Fall
Creator Up
date, April
2018 Up
date, 1809,
1903, 1909
x86-64

64-Ex

Yes

Yes

Base, An

dows 10

ploit,

niversary

Pro

64-Tol

Update,

erate

Creator Up
date, Fall
Creator Up
date, April
2018 Up

sup
port

ner

Win

of

(2)

Table 51. Windows (continued)
Supported
Dis
Oper
ating
system

Hard

Bit

ware

ness

con

Operating

BigFix

nect

system

Agent

ed

minimum

Scan

Prod
uct
mini

End
Notes

mum

date, 1809,
1903, 1909
Base (2),
Anniversary
Update (2),
Creator Up
date (2),
Fall Creator
Update (2),
April 2018
Update (2),
1809 (2),
1903 (2),
1909 (2)
x86-64

dows 8

64-Tol Yes

No

Base

No

No

Base

No

erate

Enter
prise
Win
dows 8
Profes
sional

x86-32

32

Yes

sup
port

ner

Win

of

Table 51. Windows (continued)
Supported
Dis
Oper
ating
system

Hard

Bit

ware

ness

con

Operating

BigFix

nect

system

Agent

ed

minimum

Scan

Prod
uct
mini

End
Notes

mum

x86-64

dows 8

64-Tol Yes

No

Base

No

erate

Profes
sional
Win

x86-32

32

Yes

No

Base

No

x86-64

64-Tol Yes

No

Base

No

Yes

Base

(1)

dows
8 Stan
dard
Win
dows

erate

8 Stan
dard
Win

x86-6464- 64-Tol Yes

dows

Exploit,

erate

Base

Server
2019
Data
center
Edition
Win

x86-6464- 64-Tol Yes

dows

Exploit,

Server

erate

Yes

Base
Base

sup
port

ner
Win

of

(1)

Table 51. Windows (continued)
Supported
Dis
Oper
ating
system

Hard

Bit

ware

ness

con

Operating

BigFix

nect

system

Agent

ed

minimum

Scan

Prod
uct
mini

End
Notes

mum

2019
Essen
tials Edi
tion
x86-64

64-Ex

dows

ploit,

Server

64-Tol

2019

erate

Yes

Yes

Base

(1)

Base

Stan
dard
Edition
Win

x86-32

32

Yes

Yes

dows
Server

Base (3),

(2)

SP2 (3)

(3)

Base (2)(3),

2008

SP2 (2)(3)

Data
center
Edition
Win

x86-64

64-Ex

Yes

Yes

Base (3),

(1)

dows

ploit,

Service

(2)

Server

64-Tol

Pack 1 (3)

(3)

2008 R2

erate

sup
port

ner

Win

of

Table 51. Windows (continued)
Supported
Dis
Oper
ating
system

Hard

Bit

ware

ness

con

Operating

BigFix

nect

system

Agent

ed

minimum

Scan

Prod
uct
mini

End
Notes

mum

Base (2)

center

(3), Service

Edition

Pack 1 (2)
(3)

Win

x86-32

32

Yes

Yes

Base (3),

(3)

SP2 (3)

dows
Server

Base (3),

2008

SP2 (3)

Enter
prise
Edition
Win

x86-64

64-Ex

Yes

Yes

Base (3),

(2)
(3)

dows

ploit,

SP2 (3)

Server

64-Tol

Base (2)(3),

erate

SP2 (2)(3)

2008
Enter
prise
Edition
Win

x86-64

64-Ex

Yes

Yes

Base (3),

(2)
(3)

dows

ploit,

Service

Server

64-Tol

Pack 1 (3)

2008

erate

sup
port

ner
Data

of

Table 51. Windows (continued)
Supported
Dis
Oper
ating
system

Hard

Bit

ware

ness

con

Operating

BigFix

nect

system

Agent

ed

minimum

Scan

Prod
uct
mini

End
Notes

mum

Base (2)

terprise

(3), Service

Edition

Pack 1 (2)
(3)

Win

x86-32

32

Yes

Yes

dows

Base (3),

(3)

SP2 (3)

Server
2008
Stan
dard
Edition
Win

x86-64

64-Ex

dows

ploit,

Server

64-Tol

2008

Yes

Yes

Base (2)(3),

(2)

SP2 (2)(3)

(3)

Base (3),

(1)

erate

Stan
dard
Edition
Win

x86-64

64-Ex

Yes

Yes

dows

ploit,

Service

(2)

Server

64-Tol

Pack 1 (3)

(3)

2008 R2

erate

sup
port

ner
R2 En

of

Table 51. Windows (continued)
Supported
Dis
Oper
ating
system

Hard

Bit

ware

ness

con

Operating

BigFix

nect

system

Agent

ed

minimum

Scan

Prod
uct
mini

End
Notes

mum

Base (2)

dard

(3), Service

Edition

Pack 1 (2)
(3)

Win

x86-64

64-Ex

dows

ploit,

Server

64-Tol

2012

Yes

Yes

Base
Base (2)

(1)
(2)

erate

Data
center
Edition
Win

x86-64

64-Ex

dows

ploit,

Server

64-Tol

2012 R2

Yes

Yes

Base

(1)

Base (2)

erate

Data
center
Edition
Win
dows
Server
2012

x86-64

64-Ex
ploit,

Yes

Yes

Base
Base (2)

sup
port

ner
Stan

of

(1)

Table 51. Windows (continued)
Supported
Dis
Oper
ating
system

Hard

Bit

ware

ness

con

Operating

BigFix

nect

system

Agent

ed

minimum

Scan

Prod
uct
mini

End
Notes

mum

64-Tol

tials Edi

erate

tion
Win

x86-64

64-Ex

dows

ploit,

Server

64-Tol

2012 R2

Yes

No

Base

(1)

Yes

Yes

Base

(1)

erate

Essen
tials Edi
tion
Win

x86-64

64-Ex

dows

ploit,

Server

64-Tol

2012

Base (2)

erate

Stan
dard
Edition
Win

x86-64

64-Ex

dows

ploit,

Server

64-Tol

2012 R2
Stan

erate

Yes

Yes

Base
Base (2)

sup
port

ner
Essen

of

(1)

Table 51. Windows (continued)
Supported
Dis
Oper
ating
system

Hard

Bit

ware

ness

con

Operating

BigFix

nect

system

Agent

ed

minimum

Scan

Prod
uct
mini

End
Notes

mum

dard
Edition
x86-64

64-Ex

dows

ploit,

Server

64-Tol

2016

Yes

No

Base

(1)

Yes

No

Base

(1)

Yes

No

Base

(1)

erate

Data
center
Edition
Win

x86-64

64-Ex

dows

ploit,

Server

64-Tol

2016

erate

Essen
tials Edi
tion
Win

x86-64

64-Ex

dows

ploit,

Server

64-Tol

2016
Stan

erate

sup
port

ner

Win

of

Table 51. Windows (continued)
Supported
Dis
Oper
ating
system

Hard

Bit

ware

ness

con

Operating

BigFix

nect

system

Agent

ed

minimum

Scan

Prod
uct
mini

End
Notes

mum

dard
Edition
64-Ex

Win

ploit,

dows

64-Tol

Server

erate

Yes

Yes

Base

(2)

Yes

Yes

Base

(2)

Yes

Yes

Base

(1)

2022
Stan
dard
Edition
x86-64

64-Ex

Win

ploit,

dows

64-Tol

Server

erate

2022
Stan
dard
Evalua
tion
x86-64
Win

64-Ex
ploit,

sup
port

ner

x86-64

of

(2)

Table 51. Windows (continued)
Supported
Dis
Oper
ating
system

Hard

Bit

ware

ness

con

Operating

BigFix

nect

system

Agent

ed

minimum

Scan

Prod
uct
mini

End
Notes

mum

of
sup
port

ner
dows

64-Tol

Server

erate

2022
Data
center
x86-64

64-Ex

Win

ploit,

dows

64-Tol

Server

erate

Yes

Yes

Base

(1)
(2)

2022
Data
center
Evalua
tion
Windows Notes:
1. Installation with Server Core or Nano Server is not supported.
2. If you use a 64-bit system, always run the disconnected scanner scripts in the 64-bit
command prompt.
3. This operating system is no longer in service. Please refer to IBM's policy on
unsupported operating systems:https://www.ibm.com/support/customercare/sas/f/
handbook/policies.html unsupported

4. The support for Windows 7 is limited.
• The support for older Windows versions is provided on BigFix Platform 10 with
BigFix 9.5 Agents BigFix Platform 9.5 system requirements.
• Licensing metrics for vendors might include restrictions on supported OS for
eligibility to use the metric. For IBM Subcapacity eligible systems check Subcapacity (Virtualization capacity) licensing (IBM site).
5. In BigFix Inventory version 10.0.7, we are announcing support for Windows 11 on 64
bit. It is possible to run the scans and capture the software discovery on Windows 11.
• Windows 11 does not have updated version. Internally in Windows Registry it
is represented as version 10 and there is only possible to distinguish it by Build
Number 22000 or higher
• Computer Property: Operating System - BigFix Client must be in version 10.0.4
or higher, otherwise system reports as Windows 10.
• Software Classification and Package Data: System in BigFix Inventory version
10.0.7 is reported as Windows 10. The rest of the software discovery works
correctly.
• Detailed Hardware Scan: Operating System - major_version and minor_version is
still 10.0.
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Table 52. AIX
Supported
Hypervisor

BigFix Agent

Discon

Any support

Operating sys

nected

ed version

tem minimum

Notes

Scanner
IBM PowerVM Hyper

Yes

Yes

(2)

AIX 6.1 POWER System -

visor (LPAR, DPAR, Mi

Big Endian

cro-Partition) any sup

AIX 7.1 POWER System -

ported version

(2)

Big Endian
AIX 7.2 POWER System Big Endian

IBM PowerVM VIOS

Yes

Yes

(1)

AIX 6.1 POWER System -

(1)

Big Endian

any version

AIX 7.1 POWER System Big Endian
AIX 7.2 POWER System Big Endian
Live Application Mobil Yes
ity (LAM) for Workload

Yes

AIX 6.1

AIX 6.1 POWER System Big Endian

No
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Table 52. AIX (continued)
Supported
Hypervisor

BigFix Agent

Discon

Any support

Operating sys

nected

ed version

tem minimum

Notes

Scanner
Partition (WPAR) AIX

AIX 7.1 POWER System -

6.1

Big Endian
AIX 7.2 POWER System Big Endian

Live Application Mobil Yes

Yes

AIX 7.1

AIX 6.1 POWER System -

ity (LAM) for Workload

Big Endian

Partition (WPAR) AIX

AIX 7.1 POWER System -

7.1

Big Endian
AIX 7.2 POWER System Big Endian

No

Notes applying to hypervisors on AIX operating systems:
1. Supported Virtual I/O Server (VIOS) version 2.2.3 or higher. Before you start
installation of the the BigFix client, run oem_setup_env command to place the user
into the OEM software installation and setup environment.
2. In rare cases when machine is live migrated using Live Partition Mobility technology
BFI may wrongly calculate PVU values (high watermarks). This is known limitation
that will be mitigated in future releases.
Table 53. HP
Supported
Discon
Hypervisor

BigFix Agent

nected
Scan

Any support Operating system
ed version

minimum

any version

HP-UX 11i v3 IA64

(1)

HP-UX 11i v3 PA-

Notes

ner
HP-UX Virtu
al Partitions

Yes

Yes

(vPars) any
version

(1), (2)

RISC

Notes applying to hypervisors on HP operating systems:
1. HP-UX Virtual Partitions v6.0 (vPars v6.0) and later on HP Integrity Server Blade is not
supported.
2. Effective April 30, 2022, HCL will end service for BigFix Platform version 9.2.x. Even
with the end of support for BigFix Platform 9.2.x, BigFix will continue to support
for HP-UX using BigFix Platform 9.2 Agent reporting to BigFix Platform 9.5 or 10.0,
connected to BigFix Inventory 10.x. BigFix Platform 9.2 HP-UX Agent patches will be
provided only to address PSIRT records or high severity customer reported defects.
For more information, see BigFix forum annoucement.

Table 54. IBM i
Supported
Dis
Hypervisor

con
BigFix Agent nected
Scan

Any sup
ported ver
sion

Prod
Operating sys
tem minimum

Notes

uct
mini
mum

ner
IBM Power Yes
VM Hyper
visor (LPAR,

Yes

(1)
(1)

DPAR, Mi
cro-Parti
tion) any
supported
version

IBM i 7.1 POW

(1)

10.0.2

ER System - Big

only

Endian

for IBM

IBM i 7.2 POW
ER System - Big
Endian
IBM i 7.3 POW
ER System - Big
Endian

i 7.4
POW
ER Sys
tem Big En
dian

IBM i 7.4 POW
ER System - Big
Endian
Notes applying to hypervisors on IBM i operating systems
1. In rare cases when machine is live migrated using Live Partition Mobility technology
BFI may wrongly calculate PVU values (high watermarks). This is known limitation
that will be mitigated in future releases.

Table 55. Linux
Supported
Dis
Hypervisor

conect
BigFix Agent

ed
Scan

Oper
Any sup
ported
version

Prod

ating
system Notes
mini

Citrix Hypervisor 8.0 Yes

Yes

8.0

View

No

Citrix Hypervisor 8.1 Yes

Yes

8.1

View

No

Citrix Hypervisor 8.2 Yes

Yes

8.2

View

No

Citrix XenServer 7

Yes

Yes

7 (1)

View

(1)

IBM PowerKVM any

Yes

Yes

any ver

View

No

View

(5)

supported version
IBM PowerVM Hy

sion
Yes

Yes

pervisor (LPAR,

any ver
sion (5)

DPAR, Micro-Parti
tion) any supported
version
IBM z/VM Hypervi

Yes

Yes

6.4

View

No

Yes

Yes

11

View

No

Yes

Yes

12

View

No

sor 6.4
KVM in SUSE Lin
ux Enterprise Server
(SLES) 11
KVM in SUSE Lin
ux Enterprise Server
(SLES) 12

mini
mum

mum

ner

uct

Table 55. Linux (continued)
Supported
Dis
Hypervisor

conect
BigFix Agent

ed
Scan

Oper
Any sup
ported
version

system Notes
mini

Yes

Yes

12

View

No

Yes

Yes

16.04

View

No

ux Enterprise Server
(SLES) 15
KVM on Ubuntu
16.04 LTS
Microsoft Hyper-V

LTS
Yes

Yes

2008 R2

View

No

Yes

Yes

2012

View

No

Yes

Yes

2012 R2

View

No

Yes

Yes

2016

View

No

Yes

Yes

2019

View

No

Yes

Yes

2022

View

No

Yes

Yes

5.10 (4)

View

(4) (6)

Server 2008 R2
Microsoft Hyper-V
Server 2012
Microsoft Hyper-V
Server 2012 R2
Microsoft Hyper-V
Server 2016
Microsoft Hyper-V
Server 2019
Hyper-V on Win
dows Server 2022
Nutanix Acropolis
5.10

uct
mini
mum

mum

ner
KVM in SUSE Lin

Prod

ating

Table 55. Linux (continued)
Supported
Dis
Hypervisor

conect
BigFix Agent

ed
Scan

Oper
Any sup
ported
version

system Notes
mini

Yes

Yes

(2)

View

(2)

Yes

Yes

6.0

View

No

Yes

Yes

7.0

View

No

Yes

Yes

4.0

View

No

Yes

Yes

4.1

View

No

Yes

Yes

4.2

View

No

Yes

Yes

4.3

View

No

for SPARC All Ver
sions
Red Hat KVM as
delivered with Red
Hat Enterprise Linux
(RHEL) and its RHEV
equivalent 6.0
Red Hat KVM as
delivered with Red
Hat Enterprise Linux
(RHEL) and its RHEV
equivalent 7.0
Red Hat Virtualiza
tion 4.0
Red Hat Virtualiza
tion 4.1
Red Hat Virtualiza
tion 4.2
Red Hat Virtualiza
tion 4.3

uct
mini
mum

mum

ner
Oracle VM Server

Prod

ating

Table 55. Linux (continued)
Supported
Dis
Hypervisor

conect
BigFix Agent

ed
Scan

Oper
Any sup
ported
version

system Notes
mini

uct
mini
mum

mum

ner
Red Hat Virtualiza

Prod

ating

Yes

Yes

4.4

View

No

VMware ESXi 6.5

Yes

Yes

6.5 (6)

View

(6)

VMware ESXi 6.7

Yes

Yes

6.7

View

(6)

VMware ESXi 7.0

Yes

Yes

7.0

View

No

Xen 4.4

Yes

Yes

4.4.(3)

View

(3)

Xen 4.5

Yes

Yes

4.5 (3)

View

(3)

Xen 4.6

Yes

Yes

4.6 (3)

View

(3)

z/VM 6.1

Yes

Yes

6.1

View

No

z/VM 6.2

Yes

Yes

6.2

View

No

z/VM 6.3

Yes

Yes

6.3

View

No

10.0.5

tion 4.4

10.0.2

Notes applying to hypervisors on Linux operating systems:
1. Hardware-assisted Virtualization (HVM) and Paravirtualization (PV) are supported.
2. Oracle VM Server for SPARC (formerly Logical Domains also called LDOMs) 2.0, 2.1,
2.2, 3.0, 3.1, 3.2, 3.3, 3.4
3. To collect capacity data, use the Run Capacity Scan on Virtualization Hosts task. For
more information, see: Collecting capacity data directly from virtualization hosts.

4. Support for Linux guests on AHV 5.11+ on IBM Power CS appliances, managed
by Nutanix PRISM. Support for Linux and Windows guests on AHV 5.11+ on x86
appliances, managed by Nutanix PRISM.
5. In rare cases when machine is live migrated using Live Partition Mobility technology
BFI may wrongly calculate PVU values (high watermarks). This is known limitation
that will be mitigated in future releases.
6. Single Server, Cluster, Mobility (VMware Vmotion)
Table 56. Solaris
Supported
Dis
con
Hypervisor

BigFix Agent

nect
ed
Scan

Sup

Support

ported ed guest
ver

operating

sion

system

11

Solaris 11

Prod
Notes

Yes

Yes

ux Enterprise Server

SPARC

(SLES) 11

Solaris 11

No

x86-64
Oracle VM Server

Yes

Yes

(2)

Solaris 11

for SPARC All Ver

SPARC

sions

Solaris 11

(2)

x86-64
Red Hat KVM as

Yes

Yes

6.0

Solaris 11

delivered with Red

SPARC

Hat Enterprise Linux

Solaris 11

(RHEL) 6.0

x86-64

mini
mum

ner
KVM in SUSE Lin

uct

No

Table 56. Solaris (continued)
Supported
Dis
con
Hypervisor

BigFix Agent

nect
ed
Scan

Sup

Support

ported ed guest
ver

operating

sion

system

6.0

Solaris 11

Prod
Notes

Yes

Yes

delivered with Red

SPARC

Hat Enterprise Lin

Solaris 11

ux (RHEL) and its

Red Hat KVM as

No

x86-64

RHEV equivalent 6.0
Yes

Yes

7.0

Solaris 11

delivered with Red

SPARC

Hat Enterprise Lin

Solaris 11

ux (RHEL) and its

Sun Solaris 10 Glob Yes

No

x86-64

RHEV equivalent 7.0
Yes

10

Solaris 11

al/Local Zones

SPARC

(SPARC) 10

Solaris 11

No

x86-64
Sun Solaris 10 Glob Yes

Yes

10

Solaris 11

al/Local Zones

SPARC

(x86-64) 10

Solaris 11

No

x86-64
Sun Solaris 11 Glob Yes
al/Local Zones
(SPARC) 11

Yes

11 (1)

Solaris 11
SPARC

mini
mum

ner
Red Hat KVM as

uct

(1)

Table 56. Solaris (continued)
Supported
Dis
con
Hypervisor

BigFix Agent

nect
ed
Scan

Sup

Support

ported ed guest
ver

operating

sion

system

11 (1)

Solaris 11

Prod
Notes

Yes

al/Local Zones

(1)

x86-64

(x86-64) 11
VMware ESXi 6.5

Yes

Yes

6.5 (4) Solaris 11

(4)

SPARC
Solaris 11
x86-64
Solaris 11
x86-64
VMware ESXi 6.7

Yes

Yes

6.7

Solaris 11

(4)

x86-64
VMware ESXi 7.0

Yes

Yes

7.0

Solaris 11

(4)

x86-64
VMware ESXi 7.1

Yes

Yes

7.0

Solaris 11

(4)

x86-64
Xen 4.4

Yes

Yes

4.4

Solaris 11
SPARC
Solaris 11
x86-64

mini
mum

ner
Sun Solaris 11 Glob Yes

uct

(3)

Table 56. Solaris (continued)
Supported
Dis
con
Hypervisor

BigFix Agent

nect
ed
Scan

Sup

Support

ported ed guest
ver

operating

sion

system

4.5

Solaris 11

Prod
Notes

uct
mini
mum

ner
Xen 4.5

Yes

Yes

(3)

SPARC
Solaris 11
x86-64
Xen 4.6

Yes

Yes

4.6

Solaris 11

(3)

SPARC
Solaris 11
x86-64
Notes applying to hypervisors on Solaris operating systems:
1. Oracle Solaris Kernel Zone, also called a solaris-kz branded zone is not supported
2. Oracle VM Server for SPARC (formerly Logical Domains also called LDOMs) 2.0, 2.1,
2.2, 3.0, 3.1, 3.2, 3.3, 3.4
3. To collect capacity data, use the Run Capacity Scan on Virtualization Hosts task. For
more information, see: Collecting capacity data directly from virtualization hosts.
4. Single Server, Cluster, Mobility (VMware Vmotion)

Table 57. Windows
Supported
Dis
Hypervisor

con
BigFix Agent

nected
Scan

Support
ed ver
sion

Support
ed guest
operating

Prod
Notes

system

Yes

Yes

8.0

View

No

Yes

Yes

8.1

View

No

Yes

Yes

8.2

View

No

Citrix XenServer 7 Yes

Yes

7

View

(1)

Microsoft Hy

Yes

Yes

2016

View

No

Yes

Yes

2019

View

No

Yes

Yes

2022

View

No

Nutanix Acropolis Yes

Yes

5.10 (1)

View

(2)

Yes

Yes

4.0

View

No

Yes

Yes

4.1

View

No

8.0
Citrix Hypervisor
8.1
Citrix Hypervisor
8.2

per-V Server 2016
Microsoft Hy
per-V Server 2019
Hyper-V on Win
dows Server 2022

5.10
Red Hat Virtual
ization 4.0
Red Hat Virtual
ization 4.1

mini
mum

ner
Citrix Hypervisor

uct

Table 57. Windows (continued)
Supported
Dis
Hypervisor

con
BigFix Agent

nected
Scan

Support
ed ver
sion

Support
ed guest
operating

Prod
Notes

system

uct
mini
mum

ner
Red Hat Virtual

Yes

Yes

4.2

View

No

Yes

Yes

4.3

View

No

VMware ESXi 6.5

Yes

Yes

6.5 (3)

View

(3)

VMware ESXi 6.7

Yes

Yes

6.7

View

No

VMware ESXi 7.0

Yes

Yes

7.0

View

No

ization 4.2
Red Hat Virtual
ization 4.3

Notes applying to hypervisors on Windows operating systems
1. Hardware-assisted Virtualization (HVM) and Paravirtualization (PV) are supported.
2. Support for:
a. Linux guests on AHV 5.11+ on IBM Power CS appliances, managed by Nutanix
PRISM.
b. Linux and Windows guests on AHV 5.11+ on x86 appliances, managed by
Nutanix PRISM.
3. Single Server, Cluster, Mobility (VMware Vmotion)

Supported software for BigFix Inventory Server
The tables in this section provide detailed information about the system prerequisites for
BigFix Inventory 10.
Operating systems: Linux Windows

Prerequisites: Asset Management Databases Runtime Environment Web Browsers
Table 58. Linux
Operating
Operating system

Hardware

Bitness

system

Product

Notes

minimum

minimum
Red Hat Enterprise

x86-64

Linux (RHEL) Server

64-Exploit, 64-

6.3

(2)

Base (2)

(2)

Tolerate

6
Red Hat Enterprise

x86-64

Linux (RHEL) Server

64-Exploit, 64Tolerate

7
Red Hat Enterprise

x86-64

64-Tolerate

8.2

10.0.3

Linux (RHEL) Server
8.2
Table 59. Windows

Operating system

Windows Server

Hard
ware

x86-64

Bitness

64-Ex
ploit,64-Tol

Edition

erate
x86-64

64-Ex

2019 Essentials

ploit,64-Tol

Edition

erate

Windows Server

x86-64

system

Notes

minimum

2019 Datacenter

Windows Server

Prod

Operating

64-Ex

2019 Standard Edi

ploit,64-Tol

tion

erate

uct

End of

mini

support

mum

Base (1)

(1)

Base (1)

(1)

Base (1)

(1)

Table 59. Windows (continued)

Operating system

Windows Server

Hard

Bitness

ware

x86-64

Prod

Operating
system

Notes

minimum

uct

End of

mini

support

mum

64-Ex

Base (1)

(1) (2)

Not sup

2008 R2 Datacen

ploit,64-Tol

(3), Ser

(3)

ported

ter Edition

erate

vice Pack

(2) (3)

Not sup

1 (1)(3)
Windows Server

x86-64

64-Ex

Base (1)

2008 R2 Enterprise

ploit,64-Tol

(3), Ser

Edition

erate

vice Pack

ported

1 (1)(3)
Windows Server

x86-32

32

2008 Standard Edi

Base (3),

(3)

SP2 (3)

Not sup
ported

tion
Windows Server

x86-64

64-Exploit,

Base (3),

64-Tolerate

SP2 (3)

64-Ex

Base (1)

(1) (2)

Not sup

2008 R2 Standard

ploit,64-Tol

(3), Ser

(3)

ported

Edition

erate

vice Pack

2008 Standard Edi

(2) (3)

Not sup
ported

tion
Windows Server

x86-64

1 (1)(3)
Windows Server

x86-64

64-Ex

2012 Datacenter

ploit,64-Tol

Edition

erate

Windows Server
2012 R2 Datacen
ter Edition

x86-64

64-Exploit,
64-Tolerate

Base (1)

(1) (2)

Base (1)

(1)

Table 59. Windows (continued)

Operating system

Windows Server

Hard
ware

x86-64

Bitness

64-Ex
ploit,64-Tol

Edition

erate
x86-64

64-Ex

2012 R2 Essen

ploit,64-Tol

tials Edition

erate

Windows Server

x86-64

2012 Standard Edi

system

Notes

minimum

2012 Essentials

Windows Server

Prod

Operating

64-Exploit,

uct

End of

mini

support

mum

Base (1)

(1)

Base (1)

(1)

Base (1)

(1)

Base (1)

(1)

Base (1)

(1)

Base (1)

(1)

Base (1)

(1)

64-Tolerate

tion
Windows Server

x86-64

2012 R2 Standard

64-Exploit,
64-Tolerate

Edition
Windows Server

x86-64

2016 Datacenter

64-Exploit,
64-Tolerate

Edition
Windows Server

x86-64

2016 Essentials

64-Exploit,
64-Tolerate

Edition
Windows Server
2016 Standard Edi

x86-64

64-Exploit,
64-Tolerate

tion
1. BigFix Inventory works with Windows 2019 Exploit Protection feature turned on
including configurations with SSO enabled.

Table 60. Asset Management
Prereq
Prerequisite

Version

uisite

Available

mini

for version

mum
BigFix Plat
form

Operating
system re
strictions

End of
support

10.0.0

10.0.0

10.0.0

No

9.5

9.5

9.5

No

9.2.6 and future 9.2.6

9.2.6, 9.2.7,

No

(1)

fix packs

9.2.8, 9.2.9,

No

(1)

9.2.10, 9.2.11,
9.2.12, 9.2.14,
9.2.16, 9.2.17,
10.0.0
Endpoint

9.2.0 and future 9.2.0

9.2.0, 9.2.1.0,

Manager

fix packs

9.2.2.0,

Platform

9.2.3.0,
9.2.5.0

1. Support for BigFix Platform 9.2 ends on April 30th, 2022. For more information, see
BigFix forum announcement.

Table 61. Database
Oper
Pre
requi
site

Ver
sion

Pre

ating

requi

sys

site

tem

mini

re

mum

stric

Only
sup
port
ed on

Avail

Future

able

ver

for

Prod

Fu

sions, ture fix Notes

ver

re

sion

leases

packs

11.5.0.0 11.5.0.0 Yes

View

Ad

11.5.0.0

(1)

(1)

vanced
Edition
VPC
Option
DB2

11.5.0.0 11.5.0.0 Yes

Stan

View

11.5.0.0

(1)

(1)

dard
Edition
VPC
Option
Mi

2012

2012

No

crosoft and fu
SQL

ture fix

Server

packs

Enter
prise
Edition

2014

2012

No

Yes

(3)

No

Yes

(2)

No

Yes

(2)

(3)

2014

No

and fu

2014
(2)

ture fix
packs
2016
and fu

2016

No

2016

mini
mum

tions
DB2

uct

Table 61. Database (continued)
Oper
Pre
requi
site

Ver
sion

Pre

ating

requi

sys

site

tem

mini

re

mum

stric

Only
sup
port
ed on

Avail

Future

able

ver

for

Prod

Fu

sions, ture fix Notes

ver

re

sion

leases

packs

ture fix
packs
View

2017

Yes

(5)

2012

No

No

Yes

(4)

2014

No

No

Yes

(6)

2016

No

No

Yes

(2)

2017

No

No

Yes

(5)

and fu
ture fix
packs
Mi

2012

crosoft and fu
SQL

ture fix

Serv

packs

er Ex
press

2014
and fu
ture fix
packs
2016
and fu
ture fix
packs
2017
and fu
ture fix
packs

mini
mum

tions

2017

uct

Table 61. Database (continued)
Oper
Pre
requi
site

Ver
sion

Pre

ating

requi

sys

site

tem

mini

re

mum

stric

Only
sup
port
ed on

Avail

Future

able

ver

for

Prod

Fu

sions, ture fix Notes

ver

re

sion

leases

packs

uct
mini
mum

tions
Mi

2012

2012

No

No

Yes

(3)

2014

No

No

Yes

(2)

2016

No

No

Yes

(2)

2017

Yes

View

No

Yes

(5)

2019

Yes

View

No

Yes

(5)

crosoft and fu
SQL

ture fix

Server

packs

Stan
dard
Edition

2014
and fu
ture fix
packs
2016
and fu
ture fix
packs
2017
and fu
ture fix
packs

Mi

2019 -

crosoft All edi
SQL

tions

Server

- Stan
dard,
Enter

10.0.5

Table 61. Database (continued)
Oper
Pre
requi
site

Ver
sion

Pre

ating

requi

sys

site

tem

mini

re

mum

stric

Only
sup
port
ed on

Avail

Future

able

ver

for

Fu

sions, ture fix Notes

ver

re

sion

leases

packs

Prod
uct
mini
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1. To use DB2 as a database, BigFix Inventory server must be installed on Linux. Use a
DB2 instance with default settings. Other required database settings are configured by
BigFix Inventory server installer. Restriction: If you specify non-default DB2 settings,
BigFix Inventory server might not work properly.
2. To use SQL Server as a database, BigFix Inventory server must be installed on
Windows. Ensure that snapshot isolation is enabled in the SQL Server. For information
about the requirements, see the Microsoft SQL Server documentation. The support for
AlwaysOn solution has not been tested.
3. To use SQL Server as a database, BigFix Inventory server must be installed on
Windows. Ensure that snapshot isolation is enabled in the SQL Server. For information
about the requirements, see the Microsoft SQL Server documentation. The support for
AlwaysOn solution has not been tested. Important: If you use SQL Server 2012, install
cumulative update 5 for SQL Server 2012 SP2 to prevent possible corruption of the
database.
4. To use SQL Server as a database, BigFix Inventory server must be installed on
Windows. Ensure that snapshot isolation is enabled in the SQL Server. For information
about the requirements, see the Microsoft SQL Server documentation. The support
for AlwaysOn solution has not been tested. Important: If you use SQL Server 2012,
install cumulative update 5 for SQL Server 2012 SP2 to prevent possible corruption

of the database. Express Editions are supported only for environments with up to 500
endpoints, because they limit the disk space available to each database instance. For
the same reason, BigFix must be dedicated to BigFix Inventory server and contain only
the BigFix Inventory server fixlet site. Other applications and their fixlet sites would
increase the required disk space resulting in problems with the database.
5. To use SQL Server as a database, BigFix Inventory server must be installed on
Windows. Ensure that snapshot isolation is enabled in the SQL Server. For information
about the requirements, see the Microsoft SQL Server documentation. The support
for AlwaysOn solution has not been tested.Cumulative Update Package 15 (or later)
for SQL Server 2017 - KB4498951 must be installed. To use SQL Server as a database,
BigFix Inventory server must be installed on Windows.
6. To use SQL Server as a database, BigFix Inventory server must be installed on
Windows. Ensure that snapshot isolation is enabled in the SQL Server. For information
about the requirements, see the Microsoft SQL Server documentation. The support
for AlwaysOn solution has not been tested. Express Editions are supported only for
environments with up to 500 endpoints, because they limit the disk space available
to each database instance. For the same reason, BigFix must be dedicated to
BigFix Inventory server and contain only the BigFix Inventory server fixlet site. Other
applications and their fixlet sites would increase the required disk space resulting in
problems with the database.
Table 62. Runtime Environment
Prerequisite

Version

Windows

5.8 and

Script Host

future fix

Prerequisite
minimum
5.8
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Fu
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Versions,

ture Fix

system re

Releases

Packs

strictions

No

Yes

packs
Runtime Environment notes
1. Windows Script Host must be enabled on Windows endpoints.

View

Notes

(1)

Table 63. Web Browsers
Prereq
Prereq

Version

uisite

uisite
mini
mum

Google

35 and future

Chrome

versions, re

Future
Versions,
Releases

Future
Fix Packs

Operating
system re

Notes

strictions

35

Yes

Yes

No

No

13

Yes

Yes

No

No

17.0

Yes

Yes

No

(1)

leases and fix
packs
Microsoft

13 and future

Edge

versions, re
leases and fix
packs

Mozilla

17.0 and fu

Firefox ESR ture versions,
releases and
fix packs
Web Browser notes:
1. Starting from 10.0.3 TLS 1.2 is used by default. It is not recommended to use older,
less secure protocols.

System requirement terms
Below table provides terms and descriptions for BigFix Inventory system requirements.
Bitness

Compatibility of the product with the bit version support that is
provided by an operating system. Different parts of a product
might run on the same operating system but support different
application bitness. For example, one part of the product might

run only in 32-bit mode, whereas another might support 64-bit
tolerate mode.
31: The product or part of the product runs as a 31-bit applica
tion in a 31-bit operating environment.
32: The product or part of the product runs as a 32-bit applica
tion in a 32-bit operating environment.
64-tolerate: The product or part of the product runs as a 32-bit
application in a 64-bit operating environment.
64-exploit: The product or part of the product runs natively as a
64-bit application in a 64-bit operating environment.
Deployment unit and Deployment structure identifies pieces of a product that can be
component

independently deployed onto one or more machines in a distrib
uted infrastructure.
• The top level of the deployment structure consists of one
or more deployment units. There are four possible deploy
ment units that a product might support: Desktop, Server,
Agent or client, Mobile.
• Deployment units may be further divided into deployable
components
Desktop deployment unit: Part of the deployment structure in
tended for use by a single user, typically installed on the user
desktops. Examples of desktop deployment units include devel
opment tools, administrative tools, stand-alone business appli
cations.
Server deployment unit: Part of the deployment structure that
can provide services to multiple clients, providing the server
in a client-server architecture. Examples of server deployment
units include application servers, management servers, data
base servers and server-based business applications.

Agent or client deployment unit: Part of the deployment struc
ture that allows remote connection between software. Exam
ples of agent of client deployment units include agents in man
agement system that are installed in the same tier as the man
aged resources, a remote application, or database clients that
are installed with the software accessing the remote services.
Mobile deployment unit: Part of the deployment structure in
tended for use by a single user, typically installed on a mobile
device. An example of a mobile deployment unit is a mobile ap
plication.
Product minimum

The minimum maintenance level that is required for the product
to run on the operating system, on an hypervisor, or work with a
prerequisite product or supported software.

End of support

The maintenance level of the product when end of support has
been announced for the operating system, an hypervisor, or
work with a prerequisite product or supported software.

Operating system

The minimum operating system maintenance level that is re

minimum

quired to run on the product.

SPCR Related topic
Prerequisites
Table 64. Prerequisites - Runtime Environment - Windows Script Host 5.8 and Future
Fix Packs
Component
Agent or client
• BigFix Agent
• Disconnect
ed scanner

Supported operating systems
• Windows 10 Enterprise x86-64
• Windows 10 Anniversary Update Enterprise x86-64
• Windows 10 Creators Update Enterprise x86-64
• Windows 10 Fall Creators Update Enterprise x86-64
• Windows 10 April 2018 Update Enterprise x86-64

Table 64. Prerequisites - Runtime Environment - Windows Script Host 5.8 and Future
Fix Packs (continued)
Component

Supported operating systems
• Windows 10 1809 Enterprise x86-64
• Windows 10 1903 Enterprise x86-64
• Windows 10 1909 Enterprise x86-64
• Windows 10 Pro x86-64
• Windows 10 Anniversary Update Pro x86-64
• Windows 10 Creators Update Pro x86-64
• Windows 10 Fall Creators Update Pro x86-64
• Windows 10 April 2018 Update Pro x86-64
• Windows 10 1809 Pro x86-64
• Windows 10 1903 Pro x86-64
• Windows 10 1909 Pro x86-64
• Windows 7 Enterprise x86-64
• Windows 7 Service Pack 1 Enterprise x86-64
• Windows 7 Professional x86-64
• Windows 7 Service Pack 1 Professional x86-64
• Windows 8 Enterprise x86-64
• Windows 8 Professional x86-64
• Windows 8 Standard x86-64
• Windows Server 2019 Datacenter Edition x86-64
• Windows Server 2019 Essentials Edition x86-64
• Windows Server 2019 Standard Edition x86-64
• Windows Server 2008 Datacenter Edition x86-64
• Windows Server 2008 SP2 Datacenter Edition x86-64
• Windows Server 2008 R2 Datacenter Edition x86-64
• Windows Server 2008 R2 Service Pack 1 Datacenter Edi
tion x86-64
• Windows Server 2008 Enterprise Edition x86-64
• Windows Server 2008 SP2 Enterprise Edition x86-64
• Windows Server 2008 R2 Enterprise Edition x86-64

Table 64. Prerequisites - Runtime Environment - Windows Script Host 5.8 and Future
Fix Packs (continued)
Component

Supported operating systems
• Windows Server 2008 R2 Service Pack 1 Enterprise Edition
x86-64
• Windows Server 2008 Standard Edition x86-64
• Windows Server 2008 SP2 Standard Edition x86-64
• Windows Server 2008 R2 Standard Edition x86-64
• Windows Server 2008 R2 Service Pack 1 Standard
• Edition x86-64
• Windows Server 2012 Datacenter Edition x86-64
• Windows Server 2012 R2 Datacenter Edition x86-64
• Windows Server 2012 Essentials Edition x86-64
• Windows Server 2012 R2 Essentials Edition x86-64
• Windows Server 2012 Standard Edition x86-64
• Windows Server 2012 R2 Standard Edition x86-64
• Windows Server 2016 Datacenter Edition x86-64
• Windows Server 2016 Essentials Edition x86-64
• Windows Server 2016 Standard Edition x86-64

Table 65. Prerequisites - Database - DB2 Advanced Enterprise Server Edition 10.5
Component
Server
• BigFix Inven
tory Server

Supported operating systems
• Red Hat Enterprise Linux (RHEL) Server 6.3 x86-64
• Red Hat Enterprise Linux (RHEL) Server 7 x86-64

Table 66. Prerequisites - Database - DB2 Advanced Workgroup Server Edition 10.5
Component
Server
• BigFix Invento

Supported operating systems
• Red Hat Enterprise Linux (RHEL) Server 6.3 x86-64
• Red Hat Enterprise Linux (RHEL) Server 7 x86-64

ry Server
Table 67. Prerequisites - Database - DB2 Enterprise Server Edition 10.5
Component
Server
• BigFix Invento

Supported operating systems
• Red Hat Enterprise Linux (RHEL) Server 6.3 x86-64
• Red Hat Enterprise Linux (RHEL) Server 7 x86-64

ry Server
Table 68. Prerequisites - Database - DB2 Workgroup Server Edition 10.5
Component
Server
• BigFix Inventory

Supported operating systems
• Red Hat Enterprise Linux (RHEL) Server 6.3 x86-64
• Red Hat Enterprise Linux (RHEL) Server 7 x86-64

Server
Table 69. Prerequisites - Database - Db2 Advanced Edition VPC Option 11.5.0.0
Component
Server
• BigFix Inventory
Server

Supported operating systems
• Red Hat Enterprise Linux (RHEL) Server 7 x86-64

Table 70. Prerequisites - Database - DB2 Standard Edition VPC Option 11.5.0.0
Component
Server

Supported operating systems
• Red Hat Enterprise Linux (RHEL) Server 7 x86-64

• BigFix Inventory
Server
Table 71. Prerequisites - Database - Microsoft SQL Server Enterprise Edition 2017 and
Future Fix Packs
Component
Server
• BigFix Inventory
Server

Supported operating systems
• Windows Server 2019 Datacenter Edition x86-64
• Windows Server 2019 Essentials Edition x86-64
• Windows Server 2019 Standard Edition x86-64
• Windows Server 2012 Datacenter Edition x86-64
• Windows Server 2012 R2 Datacenter Edition x86-64
• Windows Server 2012 Essentials Edition x86-64
• Windows Server 2012 R2 Essentials Edition x86-64
• Windows Server 2012 Standard Edition x86-64
• Windows Server 2012 R2 Standard Edition x86-64
• Windows Server 2016 Datacenter Edition x86-64
• Windows Server 2016 Essentials Edition x86-64
• Windows Server 2016 Standard Edition x86-64

Table 72. Prerequisites - Database - Microsoft SQL Server Standard Edition 2017 and
Future Fix Packs
Component
Server
• BigFix Inventory
Server

Supported operating systems
• Windows Server 2019 Datacenter Edition x86-64
• Windows Server 2019 Essentials Edition x86-64
• Windows Server 2019 Standard Edition x86-64

Table 72. Prerequisites - Database - Microsoft SQL Server Standard Edition 2017 and
Future Fix Packs (continued)
Component

Supported operating systems
• Windows Server 2012 Datacenter Edition x86-64
• Windows Server 2012 R2 Datacenter Edition x86-64
• Windows Server 2012 Essentials Edition x86-64
• Windows Server 2012 R2 Essentials Edition x86-64
• Windows Server 2012 Standard Edition x86-64
• Windows Server 2012 R2 Standard Edition x86-64
• Windows Server 2016 Datacenter Edition x86-64
• Windows Server 2016 Essentials Edition x86-64
• Windows Server 2016 Standard Edition x86-64

Hypervisor
Table 73. Hypervisors - Citrix Hypervisor 8.0
Component
Agent or client
• BigFix Agent
• Disconnected
scanner

Supported operating systems
• CentOS 7 x86-64
• Debian 9.8 x86-64
• Oracle Enterprise Linux 6 x86-64
• Oracle Enterprise Linux 7 x86-64
• Red Hat Enterprise Linux (RHEL) Server 6 x86-32
• Red Hat Enterprise Linux (RHEL) Server 6 x86-64
• Red Hat Enterprise Linux (RHEL) Server 7 x86-64
• SUSE Linux Enterprise Server (SLES) 12 x86-64
• SUSE Linux Enterprise Server (SLES) 15 x86-64
• Ubuntu 16.04 LTS x86-32
• Ubuntu 16.04 LTS x86-64
• Ubuntu 18.04 LTS x86-64

Table 74. Hypervisors - Citrix Hypervisor 8.1
Component
Agent or client
• BigFix Agent
• Disconnected
scanner

Supported operating systems
• CentOS 7 x86-64
• CentOS 8 x86-64
• Debian 9.8 x86-64
• Debian 10 x86-64
• Oracle Enterprise Linux 7 x86-64
• Oracle Enterprise Linux 8 x86-64
• Red Hat Enterprise Linux (RHEL) 8 x86-64
• Red Hat Enterprise Linux (RHEL) Server 7 x86-64
• SUSE Linux Enterprise Server (SLES) 12 x86-64
• SUSE Linux Enterprise Server (SLES) 15 x86-64
• Ubuntu 16.04 LTS x86-32
• Ubuntu 16.04 LTS x86-64
• Ubuntu 18.04 LTS x86-64
•

Ubuntu 20.04 LTS x86-64

Table 75. Hypervisors - Citrix Hypervisor 7
Component
Agent or client
• BigFix Agent
• Disconnected
scanner

Supported operating systems
• CentOS 7 x86-64
• Debian 9.8 x86-64
• Oracle Enterprise Linux 6 x86-64
• Oracle Enterprise Linux 7 x86-64
• Red Hat Enterprise Linux (RHEL) Server 6 x86-32
• Red Hat Enterprise Linux (RHEL) Server 6 x86-64
• Red Hat Enterprise Linux (RHEL) Server 7 x86-64
• SUSE Linux Enterprise Server (SLES) 11 x86-32
• SUSE Linux Enterprise Server (SLES) 11 x86-64
• SUSE Linux Enterprise Server (SLES) 12 x86-64
• Ubuntu 16.04 LTS x86-32
• Ubuntu 16.04 LTS x86-64

Table 76. Hypervisor - IBM PowerKVM any supported version
Component
Agent or client

Supported operating systems
• Red Hat Enterprise Linux (RHEL) Server 6 POWER Sys
tem - Big Endian

• BigFix Agent
• Disconnected
scanner

• Red Hat Enterprise Linux (RHEL) Server 7 POWER Sys
tem - Big Endian
• Red Hat Enterprise Linux (RHEL) Server 7.1 POWER
System - Little Endian
• SUSE Linux Enterprise Server (SLES) 11 POWER Sys
tem - Big Endian
• SUSE Linux Enterprise Server (SLES) 12 POWER Sys
tem - Little Endian
• Ubuntu 16.04 LTS POWER System - Little Endian

Table 77. Hypervisor - IBM PowerVM Hypervisor (LPAR, DPAR, Micro-Partition) any
supported version
Component
Agent or client

Supported operating systems
• Red Hat Enterprise Linux (RHEL) 5 Server POWER Sys
tem - Big Endian

• BigFix Agent
• Disconnected
scanner

• Red Hat Enterprise Linux (RHEL) Server 6 POWER Sys
tem - Big Endian
• Red Hat Enterprise Linux (RHEL) Server 7 POWER Sys
tem - Big Endian
• Red Hat Enterprise Linux (RHEL) Server 7.1 POWER
System - Little Endian
• SUSE Linux Enterprise Server (SLES) 11 POWER Sys
tem - Big Endian
• SUSE Linux Enterprise Server (SLES) 12 POWER Sys
tem - Little Endian
• Ubuntu 16.04 LTS POWER System - Little Endian

Table 78. Hypervisor - IBM z/VM Hypervisor 6.4
Component
Agent or client

Supported operating systems
• Red Hat Enterprise Linux (RHEL) 5 Server IBM z
Systems

• BigFix Agent
• Disconnected scan
ner

• Red Hat Enterprise Linux (RHEL) Server 6 IBM z
Systems
• Red Hat Enterprise Linux (RHEL) Server 7 IBM z
Systems
• SUSE Linux Enterprise Server (SLES) 11 IBM z
Systems
• SUSE Linux Enterprise Server (SLES) 12 IBM z
Systems

Table 79. Hypervisor - KVM in SUSE Linux Enterprise Server (SLES) 11
Component
Agent or client
• BigFix Agent
• Disconnected
scanner

Supported operating systems
• CentOS 7 x86-64
• Oracle Enterprise Linux 6 x86-64
• Oracle Enterprise Linux 7 x86-64
• Red Hat Enterprise Linux (RHEL) 5 Server IBM z Sys
tems
• Red Hat Enterprise Linux (RHEL) 5 Server POWER Sys
tem - Big Endian
• Red Hat Enterprise Linux (RHEL) Server 6 IBM z Sys
tems
• Red Hat Enterprise Linux (RHEL) Server 7 IBM z Sys
tems
• Red Hat Enterprise Linux (RHEL) Server 6 POWER Sys
tem - Big Endian
• Red Hat Enterprise Linux (RHEL) Server 7 POWER Sys
tem - Big Endian

Table 79. Hypervisor - KVM in SUSE Linux Enterprise Server (SLES) 11 (continued)
Component

Supported operating systems
• Red Hat Enterprise Linux (RHEL) Server 7.1 POWER Sys
tem - Little Endian
• Red Hat Enterprise Linux (RHEL) Server 7.5 POWER Sys
tem - Little Endian
• Red Hat Enterprise Linux (RHEL) Server 6 x86-32
• Red Hat Enterprise Linux (RHEL) Server 6 x86-64
• Red Hat Enterprise Linux (RHEL) Server 6.3 x86-64
• Red Hat Enterprise Linux (RHEL) Server 7 x86-64
• SUSE Linux Enterprise Server (SLES) 11 IBM z Systems
• SUSE Linux Enterprise Server (SLES) 12 IBM z Systems
• SUSE Linux Enterprise Server (SLES) 12 SP1 IBM z Sys
tems
• SUSE Linux Enterprise Server (SLES) 11 POWER System
- Big Endian
• SUSE Linux Enterprise Server (SLES) 12 POWER System
- Little Endian
• SUSE Linux Enterprise Server (SLES) 12 SP3 POWER
System - Little Endian
• SUSE Linux Enterprise Server (SLES) 11 x86-64
• SUSE Linux Enterprise Server (SLES) 12 x86-64
• Ubuntu 16.04 LTS POWER System - Little Endian
• Ubuntu 16.04 LTS x86-32
• Ubuntu 16.04 LTS x86-64

Table 80. Hypervisor - KVM in SUSE Linux Enterprise Server (SLES) 12
Component
Agent or client

Supported operating systems
• Red Hat Enterprise Linux (RHEL) 5 Advanced Platform POW
ER System - Big Endian

• BigFix
Agent
• Discon
nected
scanner

• Red Hat Enterprise Linux (RHEL) Server 6 POWER System Big Endian
• Red Hat Enterprise Linux (RHEL) Server 6 IBM z Systems
• Red Hat Enterprise Linux (RHEL) Server 6 x86-32
• Red Hat Enterprise Linux (RHEL) Server 6 x86-64
• SUSE Linux Enterprise Server (SLES) 11 POWER System Big Endian
• SUSE Linux Enterprise Server (SLES) 11 IBM z Systems
• SUSE Linux Enterprise Server (SLES) 11 x86-32
• SUSE Linux Enterprise Server (SLES) 11 x86-64
• Red Hat Enterprise Linux (RHEL) 5 Server POWER System Big Endian
• Red Hat Enterprise Linux (RHEL) 5 Server IBM z Systems
• SUSE Linux Enterprise Server (SLES) 12 POWER System - Lit
tle Endian
• SUSE Linux Enterprise Server (SLES) 12 x86-64
• Red Hat Enterprise Linux (RHEL) Server 7 POWER System Big Endian
• Red Hat Enterprise Linux (RHEL) Server 7 x86-64
• SUSE Linux Enterprise Server (SLES) 12 IBM z Systems
• Red Hat Enterprise Linux (RHEL) Server 7 IBM z Systems
• CentOS 7 x86-64
• Oracle Enterprise Linux 6 x86-64
• Oracle Enterprise Linux 7 x86-64
• Ubuntu 16.04 LTS x86-64
• Ubuntu 16.04 LTS POWER System - Little Endian
• Ubuntu 16.04 LTS x86-32

Table 80. Hypervisor - KVM in SUSE Linux Enterprise Server (SLES) 12 (continued)
Component

Supported operating systems
• Red Hat Enterprise Linux (RHEL) Server 7 POWER System Little Endian
• Ubuntu 18.04 LTS x86-64
• SUSE Linux Enterprise Server (SLES) 15 x86-64
• CentOS 8 x86-64
• Oracle Enterprise Linux 8 x86-64
• SUSE Linux Enterprise Server (SLES) 15 IBM z Systems
• Debian 10 x86-64
• SUSE Linux Enterprise Server (SLES) 15 POWER System - Lit
tle Endian
• Debian 10 x86-32
• Red Hat Enterprise Linux (RHEL) 8 x86-64
• Debian 9.8 x86-64

Table 81. Hypervisors - KVM on Ubuntu 16.04 LTS
Component
Agent or client

Supported operating systems
• Red Hat Enterprise Linux (RHEL) 5 Advanced Platform POW
ER System - Big Endian

• BigFix
Agent
• Disconnect
ed scanner

• Red Hat Enterprise Linux (RHEL) Server 6 POWER System Big Endian
• Red Hat Enterprise Linux (RHEL) Server 6 IBM z Systems
• Red Hat Enterprise Linux (RHEL) Server 6 x86-32
• Red Hat Enterprise Linux (RHEL) Server 6 x86-64
• SUSE Linux Enterprise Server (SLES) 11 POWER System Big Endian
• SUSE Linux Enterprise Server (SLES) 11 IBM z Systems
• SUSE Linux Enterprise Server (SLES) 11 x86-32
• SUSE Linux Enterprise Server (SLES) 11 x86-64

Table 81. Hypervisors - KVM on Ubuntu 16.04 LTS (continued)
Component

Supported operating systems
• Red Hat Enterprise Linux (RHEL) 5 Server POWER System Big Endian
• Red Hat Enterprise Linux (RHEL) 5 Server IBM z Systems
• SUSE Linux Enterprise Server (SLES) 12 POWER System Little Endian
• SUSE Linux Enterprise Server (SLES) 12 x86-64
• Red Hat Enterprise Linux (RHEL) Server 7 POWER System Big Endian
• Red Hat Enterprise Linux (RHEL) Server 7 x86-64
• SUSE Linux Enterprise Server (SLES) 12 IBM z Systems
• Red Hat Enterprise Linux (RHEL) Server 7 IBM z Systems
• CentOS 7 x86-64
• Oracle Enterprise Linux 6 x86-64
• Oracle Enterprise Linux 7 x86-64
• Ubuntu 16.04 LTS x86-64
• Ubuntu 16.04 LTS POWER System - Little Endian
• Ubuntu 16.04 LTS x86-32
• Red Hat Enterprise Linux (RHEL) Server 7 POWER System Little Endian
• Ubuntu 18.04 LTS x86-64
• Ubuntu 18.04 on zSystems by using the disconnected scan
ner
• Ubuntu 20.04 on zSystems by using the disconnected scan
ner
• SUSE Linux Enterprise Server (SLES) 15 x86-64
• CentOS 8 x86-64
• Oracle Enterprise Linux 8 x86-64
• SUSE Linux Enterprise Server (SLES) 15 IBM z Systems
• Debian 10 x86-64

Table 81. Hypervisors - KVM on Ubuntu 16.04 LTS (continued)
Component

Supported operating systems
• SUSE Linux Enterprise Server (SLES) 15 POWER System Little Endian
• Debian 10 x86-32
• Red Hat Enterprise Linux (RHEL) 8 x86-64
• Debian 9.8 x86-64

Table 82. Hypervisors - Microsoft Hyper-V Server 2008 R2
Components
Agent or client

Supported operating systems
• Red Hat Enterprise Linux (RHEL) 5 Advanced Platform
POWER System - Big Endian

• BigFix Agent
• Disconnected
scanner

• Red Hat Enterprise Linux (RHEL) Server 6 POWER Sys
tem - Big Endian
• Red Hat Enterprise Linux (RHEL) Server 6 IBM z Systems
• Red Hat Enterprise Linux (RHEL) Server 6 x86-32
• Red Hat Enterprise Linux (RHEL) Server 6 x86-64
• SUSE Linux Enterprise Server (SLES) 11 POWER System
- Big Endian
• SUSE Linux Enterprise Server (SLES) 11 IBM z Systems
• SUSE Linux Enterprise Server (SLES) 11 x86-32
• SUSE Linux Enterprise Server (SLES) 11 x86-64
• Red Hat Enterprise Linux (RHEL) 5 Server POWER Sys
tem - Big Endian
• Red Hat Enterprise Linux (RHEL) 5 Server IBM z Systems
• SUSE Linux Enterprise Server (SLES) 12 POWER System
- Little Endian
• SUSE Linux Enterprise Server (SLES) 12 x86-64
• Red Hat Enterprise Linux (RHEL) Server 7 POWER Sys
tem - Big Endian
• Red Hat Enterprise Linux (RHEL) Server 7 x86-64

Table 82. Hypervisors - Microsoft Hyper-V Server 2008 R2 (continued)
Components

Supported operating systems
• SUSE Linux Enterprise Server (SLES) 12 IBM z Systems
• Red Hat Enterprise Linux (RHEL) Server 7 IBM z Systems
• CentOS 7 x86-64
• Oracle Enterprise Linux 6 x86-64
• Oracle Enterprise Linux 7 x86-64
• Ubuntu 16.04 LTS x86-64
• Ubuntu 16.04 LTS POWER System - Little Endian
• Ubuntu 16.04 LTS x86-32
• Red Hat Enterprise Linux (RHEL) Server 7 POWER Sys
tem - Little Endian
• Ubuntu 18.04 LTS x86-64
• SUSE Linux Enterprise Server (SLES) 15 x86-64
• CentOS 8 x86-64
• Oracle Enterprise Linux 8 x86-64
• SUSE Linux Enterprise Server (SLES) 15 IBM z Systems
• Debian 10 x86-64
• SUSE Linux Enterprise Server (SLES) 15 POWER System
- Little Endian
• Debian 10 x86-32
• Red Hat Enterprise Linux (RHEL) 8 x86-64
• Debian 9.8 x86-64

Table 83. Hypervisors - Microsoft Hyper-V Server 2012
Component
Agent or client

Supported operating systems
• Red Hat Enterprise Linux (RHEL) 5 Advanced Platform
POWER System - Big Endian

• BigFix Agent
• Disconnected
scanner

• Red Hat Enterprise Linux (RHEL) Server 6 POWER Sys
tem - Big Endian
• Red Hat Enterprise Linux (RHEL) Server 6 IBM z Systems

Table 83. Hypervisors - Microsoft Hyper-V Server 2012 (continued)
Component

Supported operating systems
• Red Hat Enterprise Linux (RHEL) Server 6 x86-32
• Red Hat Enterprise Linux (RHEL) Server 6 x86-64
• SUSE Linux Enterprise Server (SLES) 11 POWER System Big Endian
• SUSE Linux Enterprise Server (SLES) 11 IBM z Systems
• SUSE Linux Enterprise Server (SLES) 11 x86-32
• SUSE Linux Enterprise Server (SLES) 11 x86-64
• Red Hat Enterprise Linux (RHEL) 5 Server POWER Sys
tem - Big Endian
• Red Hat Enterprise Linux (RHEL) 5 Server IBM z Systems
• SUSE Linux Enterprise Server (SLES) 12 POWER System Little Endian
• SUSE Linux Enterprise Server (SLES) 12 x86-64
• Red Hat Enterprise Linux (RHEL) Server 7 POWER Sys
tem - Big Endian
• Red Hat Enterprise Linux (RHEL) Server 7 x86-64
• SUSE Linux Enterprise Server (SLES) 12 IBM z Systems
• Red Hat Enterprise Linux (RHEL) Server 7 IBM z Systems
• CentOS 7 x86-64
• Oracle Enterprise Linux 6 x86-64
• Oracle Enterprise Linux 7 x86-64
• Ubuntu 16.04 LTS x86-64
• Ubuntu 16.04 LTS POWER System - Little Endian
• Ubuntu 16.04 LTS x86-32
• Red Hat Enterprise Linux (RHEL) Server 7 POWER Sys
tem - Little Endian
• Ubuntu 18.04 LTS x86-64
• SUSE Linux Enterprise Server (SLES) 15 x86-64
• CentOS 8 x86-64
• Oracle Enterprise Linux 8 x86-64

Table 83. Hypervisors - Microsoft Hyper-V Server 2012 (continued)
Component

Supported operating systems
• SUSE Linux Enterprise Server (SLES) 15 IBM z Systems
• Debian 10 x86-64
• SUSE Linux Enterprise Server (SLES) 15 POWER System Little Endian
• Debian 10 x86-32
• Red Hat Enterprise Linux (RHEL) 8 x86-64
• Debian 9.8 x86-64

Table 84. Hypervisors - Microsoft Hyper-V Server 2012 R2
Component
Agent or client

Supported operating systems
• Red Hat Enterprise Linux (RHEL) 5 Advanced Platform
POWER System - Big Endian

• BigFix Agent
• Disconnected
scanner

• Red Hat Enterprise Linux (RHEL) Server 6 POWER Sys
tem - Big Endian
• Red Hat Enterprise Linux (RHEL) Server 6 IBM z Sys
tems
• Red Hat Enterprise Linux (RHEL) Server 6 x86-32
• Red Hat Enterprise Linux (RHEL) Server 6 x86-64
• SUSE Linux Enterprise Server (SLES) 11 POWER Sys
tem - Big Endian
• SUSE Linux Enterprise Server (SLES) 11 IBM z Sys
tems
• SUSE Linux Enterprise Server (SLES) 11 x86-32
• SUSE Linux Enterprise Server (SLES) 11 x86-64
• Red Hat Enterprise Linux (RHEL) 5 Server POWER Sys
tem - Big Endian
• Red Hat Enterprise Linux (RHEL) 5 Server IBM z Sys
tems

Table 84. Hypervisors - Microsoft Hyper-V Server 2012 R2 (continued)
Component

Supported operating systems
• SUSE Linux Enterprise Server (SLES) 12 POWER Sys
tem - Little Endian
• SUSE Linux Enterprise Server (SLES) 12 x86-64
• Red Hat Enterprise Linux (RHEL) Server 7 POWER Sys
tem - Big Endian
• Red Hat Enterprise Linux (RHEL) Server 7 x86-64
• SUSE Linux Enterprise Server (SLES) 12 IBM z Sys
tems
• Red Hat Enterprise Linux (RHEL) Server 7 IBM z Sys
tems
• CentOS 7 x86-64
• Oracle Enterprise Linux 6 x86-64
• Oracle Enterprise Linux 7 x86-64
• Ubuntu 16.04 LTS x86-64
• Ubuntu 16.04 LTS POWER System - Little Endian
• Ubuntu 16.04 LTS x86-32
• Red Hat Enterprise Linux (RHEL) Server 7 POWER Sys
tem - Little Endian
• Ubuntu 18.04 LTS x86-64
• SUSE Linux Enterprise Server (SLES) 15 x86-64
• CentOS 8 x86-64
• Oracle Enterprise Linux 8 x86-64
• SUSE Linux Enterprise Server (SLES) 15 IBM z Sys
tems
• Debian 10 x86-64
• SUSE Linux Enterprise Server (SLES) 15 POWER Sys
tem - Little Endian
• Debian 10 x86-32
• Red Hat Enterprise Linux (RHEL) 8 x86-64
• Debian 9.8 x86-64

Table 85. Hypervisors - Microsoft Hyper-V Server 2016
Component
Agent or client
• BigFix
Agent
• Discon
nected
scanner

Supported operating systems
• CentOS 7 x86-64
• CentOS 8 x86-64
• Debian 10 x86-32
• Debian 9.8 x86-64
• Debian 10 x86-64
• Oracle Enterprise Linux 6 x86-64
• Oracle Enterprise Linux 7 x86-64
• Oracle Enterprise Linux 8 x86-64
• Red Hat Enterprise Linux (RHEL) 8 x86-64
• Red Hat Enterprise Linux (RHEL) 5 Advanced Platform POW
ER System - Big Endian
• Red Hat Enterprise Linux (RHEL) Server 6 x86-32
• Red Hat Enterprise Linux (RHEL) Server 6 x86-64
• Red Hat Enterprise Linux (RHEL) Server 6.3 x86-64
• Red Hat Enterprise Linux (RHEL) Server 7 x86-64
• SUSE Linux Enterprise Server (SLES) 11 x86-32
• SUSE Linux Enterprise Server (SLES) 11 x86-64
• SUSE Linux Enterprise Server (SLES) 12 x86-64
• SUSE Linux Enterprise Server (SLES) 15 x86-64
• Ubuntu 16.04 LTS x86-32
• Ubuntu 16.04 LTS x86-64
• Ubuntu 18.04 LTS x86-64

Table 86. Hypervisors - Microsoft Hyper-V Server 2019
Component
Agent or client

Supported operating systems
• CentOS 7 x86-64
• CentOS 8 x86-64
• Debian 10 x86-32

Table 86. Hypervisors - Microsoft Hyper-V Server 2019 (continued)
Component

Supported operating systems

• BigFix

• Debian 9.8 x86-64

Agent

• Debian 10 x86-64

• Disconnect

• Oracle Enterprise Linux 6 x86-64

ed scanner

• Oracle Enterprise Linux 7 x86-64
• Oracle Enterprise Linux 8 x86-64
• Red Hat Enterprise Linux (RHEL) 8 x86-64
• Red Hat Enterprise Linux (RHEL) 5 Advanced Platform POW
ER System - Big Endian
• Red Hat Enterprise Linux (RHEL) Server 6 x86-32
• Red Hat Enterprise Linux (RHEL) Server 6 x86-64
• Red Hat Enterprise Linux (RHEL) Server 6.3 x86-64
• Red Hat Enterprise Linux (RHEL) Server 7 x86-64
• SUSE Linux Enterprise Server (SLES) 11 x86-32
• SUSE Linux Enterprise Server (SLES) 11 x86-64
• SUSE Linux Enterprise Server (SLES) 12 x86-64
• SUSE Linux Enterprise Server (SLES) 15 x86-64
• Ubuntu 16.04 LTS x86-32
• Ubuntu 16.04 LTS x86-64
• Ubuntu 18.04 LTS x86-64

Table 87. Hypervisors - Nutanix Acropolis 5.10
Component
Agent or client

Supported operating systems
• Red Hat Enterprise Linux (RHEL) Server 7.1 POWER Sys
tem - Little Endian

• BigFix Agent
• Disconnected
scanner

• Red Hat Enterprise Linux (RHEL) Server 7 x86-64
• Ubuntu 16.04 LTS POWER System - Little Endian

Table 88. Hypervisors - Oracle VM Server for SPARC All Versions
Component
Agent or client
• BigFix Agent
• Disconnect
ed scanner

Supported operating systems
• CentOS 7 x86-64
• Debian 9.8 x86-64
• Oracle Enterprise Linux 6 x86-64
• Oracle Enterprise Linux 7 x86-64
• Red Hat Enterprise Linux (RHEL) 5 Server IBM z Systems
• Red Hat Enterprise Linux (RHEL) 5 Server POWER System Big Endian
• Red Hat Enterprise Linux (RHEL) Server 6 IBM z Systems
• Red Hat Enterprise Linux (RHEL) Server 7 IBM z Systems
• Red Hat Enterprise Linux (RHEL) Server 6 POWER System Big Endian
• Red Hat Enterprise Linux (RHEL) Server 7 POWER System Big Endian
• Red Hat Enterprise Linux (RHEL) Server 7.1 POWER System
- Little Endian
• Red Hat Enterprise Linux (RHEL) Server 7.5 POWER System
- Little Endian
• Red Hat Enterprise Linux (RHEL) Server 6 x86-32
• Red Hat Enterprise Linux (RHEL) Server 6 x86-64
• Red Hat Enterprise Linux (RHEL) Server 6.3 x86-64
• Red Hat Enterprise Linux (RHEL) Server 7 x86-64
• SUSE Linux Enterprise Server (SLES) 11 IBM z Systems
• SUSE Linux Enterprise Server (SLES) 12 IBM z Systems
• SUSE Linux Enterprise Server (SLES) 12 SP1 IBM z Sys
tems
• SUSE Linux Enterprise Server (SLES) 11 POWER System Big Endian
• SUSE Linux Enterprise Server (SLES) 12 POWER System Little Endian

Table 88. Hypervisors - Oracle VM Server for SPARC All Versions (continued)
Component

Supported operating systems
• SUSE Linux Enterprise Server (SLES) 12 SP3 POWER Sys
tem - Little Endian
• SUSE Linux Enterprise Server (SLES) 11 x86-32
• SUSE Linux Enterprise Server (SLES) 11 x86-64
• SUSE Linux Enterprise Server (SLES) 12 x86-64
• Ubuntu 16.04 LTS POWER System - Little Endian
• Ubuntu 16.04 LTS x86-32
• Ubuntu 16.04 LTS x86-64

Table 89. Hypervisors - Red Hat KVM as delivered with Red Hat Enterprise Linux
(RHEL) and its RHEV equivalent 7.0
Component
Agent or client
• BigFix
Agent
• Disconnect
ed scanner
• CentOS 7
x86-64

Supported operating systems
• Oracle Enterprise Linux 6 x86-64
• Oracle Enterprise Linux 7 x86-64
• Red Hat Enterprise Linux (RHEL) 5 Server IBM z Systems
• Red Hat Enterprise Linux (RHEL) 5 Server POWER System Big Endian
• Red Hat Enterprise Linux (RHEL) Server 6 IBM z Systems
• Red Hat Enterprise Linux (RHEL) Server 7 IBM z Systems
• Red Hat Enterprise Linux (RHEL) Server 6 POWER System Big Endian
• Red Hat Enterprise Linux (RHEL) Server 7 POWER System Big Endian
• Red Hat Enterprise Linux (RHEL) Server 7.1 POWER System
- Little Endian
• Red Hat Enterprise Linux (RHEL) Server 7.5 POWER System
- Little Endian
• Red Hat Enterprise Linux (RHEL) Server 6 x86-32
• Red Hat Enterprise Linux (RHEL) Server 6 x86-64

Table 89. Hypervisors - Red Hat KVM as delivered with Red Hat Enterprise Linux
(RHEL) and its RHEV equivalent 7.0 (continued)
Component

Supported operating systems
• Red Hat Enterprise Linux (RHEL) Server 6.3 x86-64
• Red Hat Enterprise Linux (RHEL) Server 7 x86-64
• SUSE Linux Enterprise Server (SLES) 11 IBM z Systems
• SUSE Linux Enterprise Server (SLES) 12 IBM z Systems
• SUSE Linux Enterprise Server (SLES) 12 SP1 IBM z Systems
• SUSE Linux Enterprise Server (SLES) 11 POWER System Big Endian
• SUSE Linux Enterprise Server (SLES) 12 POWER System Little Endian
• SUSE Linux Enterprise Server (SLES) 12 SP3 POWER Sys
tem - Little Endian
• SUSE Linux Enterprise Server (SLES) 11 x86-32
• SUSE Linux Enterprise Server (SLES) 11 x86-64
• SUSE Linux Enterprise Server (SLES) 12 x86-64
• Ubuntu 16.04 LTS POWER System - Little Endian
• Ubuntu 16.04 LTS x86-32
• Ubuntu 16.04 LTS x86-64

Table 90. Hypervisors - Red Hat KVM as delivered with Red Hat Enterprise Linux
(RHEL) and its RHEV equivalent 7.0
Component
Agent or client

Supported operating systems
• Red Hat Enterprise Linux (RHEL) 5 Advanced Platform POW
ER System - Big Endian

• BigFix
Agent
• Discon
nected
scanner

• Red Hat Enterprise Linux (RHEL) Server 6 POWER System Big Endian
• Red Hat Enterprise Linux (RHEL) Server 6 IBM z Systems
• Red Hat Enterprise Linux (RHEL) Server 6 x86-32
• Red Hat Enterprise Linux (RHEL) Server 6 x86-64

Table 90. Hypervisors - Red Hat KVM as delivered with Red Hat Enterprise Linux
(RHEL) and its RHEV equivalent 7.0 (continued)
Component

Supported operating systems
• SUSE Linux Enterprise Server (SLES) 11 POWER System - Big
Endian
• SUSE Linux Enterprise Server (SLES) 11 IBM z Systems
• SUSE Linux Enterprise Server (SLES) 11 x86-32
• SUSE Linux Enterprise Server (SLES) 11 x86-64
• Red Hat Enterprise Linux (RHEL) 5 Server POWER System Big Endian
• Red Hat Enterprise Linux (RHEL) 5 Server IBM z Systems
• SUSE Linux Enterprise Server (SLES) 12 POWER System - Lit
tle Endian
• SUSE Linux Enterprise Server (SLES) 12 x86-64
• Red Hat Enterprise Linux (RHEL) Server 7 POWER System Big Endian
• Red Hat Enterprise Linux (RHEL) Server 7 x86-64
• SUSE Linux Enterprise Server (SLES) 12 IBM z Systems
• Red Hat Enterprise Linux (RHEL) Server 7 IBM z Systems
• CentOS 7 x86-64
• Oracle Enterprise Linux 6 x86-64
• Oracle Enterprise Linux 7 x86-64
• Ubuntu 16.04 LTS x86-64
• Ubuntu 16.04 LTS POWER System - Little Endian
• Ubuntu 16.04 LTS x86-32
• Red Hat Enterprise Linux (RHEL) Server 7 POWER System Little Endian
• Ubuntu 18.04 LTS x86-64
• SUSE Linux Enterprise Server (SLES) 15 x86-64
• CentOS 8 x86-64
• Oracle Enterprise Linux 8 x86-64
• SUSE Linux Enterprise Server (SLES) 15 IBM z Systems

Table 90. Hypervisors - Red Hat KVM as delivered with Red Hat Enterprise Linux
(RHEL) and its RHEV equivalent 7.0 (continued)
Component

Supported operating systems
• Debian 10 x86-64
• SUSE Linux Enterprise Server (SLES) 15 POWER System - Lit
tle Endian
• Debian 10 x86-32
• Red Hat Enterprise Linux (RHEL) 8 x86-64
• Debian 9.8 x86-64

Table 91. Hypervisors - Red Hat Virtualization 4.0
Component
Agent or client

Supported operating systems
• Red Hat Enterprise Linux (RHEL) 5 Advanced Platform
POWER System - Big Endian

• BigFix
Agent
• Disconnect
ed scanner

• Red Hat Enterprise Linux (RHEL) Server 6 POWER System Big Endian
• Red Hat Enterprise Linux (RHEL) Server 6 IBM z Systems
• Red Hat Enterprise Linux (RHEL) Server 6 x86-32
• Red Hat Enterprise Linux (RHEL) Server 6 x86-64
• SUSE Linux Enterprise Server (SLES) 11 POWER System Big Endian
• SUSE Linux Enterprise Server (SLES) 11 IBM z Systems
• SUSE Linux Enterprise Server (SLES) 11 x86-32
• SUSE Linux Enterprise Server (SLES) 11 x86-64
• Red Hat Enterprise Linux (RHEL) 5 Server POWER System Big Endian
• Red Hat Enterprise Linux (RHEL) 5 Server IBM z Systems
• SUSE Linux Enterprise Server (SLES) 12 POWER System Little Endian
• SUSE Linux Enterprise Server (SLES) 12 x86-64

Table 91. Hypervisors - Red Hat Virtualization 4.0 (continued)
Component

Supported operating systems
• Red Hat Enterprise Linux (RHEL) Server 7 POWER System Big Endian
• Red Hat Enterprise Linux (RHEL) Server 7 x86-64
• SUSE Linux Enterprise Server (SLES) 12 IBM z Systems
• Red Hat Enterprise Linux (RHEL) Server 7 IBM z Systems
• CentOS 7 x86-64
• Oracle Enterprise Linux 6 x86-64
• Oracle Enterprise Linux 7 x86-64
• Ubuntu 16.04 LTS x86-64
• Ubuntu 16.04 LTS POWER System - Little Endian
• Ubuntu 16.04 LTS x86-32
• Red Hat Enterprise Linux (RHEL) Server 7 POWER System Little Endian
• Ubuntu 18.04 LTS x86-64
• SUSE Linux Enterprise Server (SLES) 15 x86-64
• CentOS 8 x86-64
• Oracle Enterprise Linux 8 x86-64
• SUSE Linux Enterprise Server (SLES) 15 IBM z Systems
• Debian 10 x86-64
• SUSE Linux Enterprise Server (SLES) 15 POWER System Little Endian
• Debian 10 x86-32
• Red Hat Enterprise Linux (RHEL) 8 x86-64
• Debian 9.8 x86-64

Table 92. Hypervisors - Red Hat Virtualization 4.1
Component
Agent or client

Supported operating systems
• Red Hat Enterprise Linux (RHEL) 5 Advanced Platform POW
ER System - Big Endian

• BigFix
Agent
• Disconnect
ed scanner

• Red Hat Enterprise Linux (RHEL) Server 6 POWER System Big Endian
• Red Hat Enterprise Linux (RHEL) Server 6 IBM z Systems
• Red Hat Enterprise Linux (RHEL) Server 6 x86-32
• Red Hat Enterprise Linux (RHEL) Server 6 x86-64
• SUSE Linux Enterprise Server (SLES) 11 POWER System Big Endian
• SUSE Linux Enterprise Server (SLES) 11 IBM z Systems
• SUSE Linux Enterprise Server (SLES) 11 x86-64
• Red Hat Enterprise Linux (RHEL) 5 Server POWER System Big Endian
• Red Hat Enterprise Linux (RHEL) 5 Server IBM z Systems
• SUSE Linux Enterprise Server (SLES) 12 POWER System Little Endian
• SUSE Linux Enterprise Server (SLES) 12 x86-64
• Red Hat Enterprise Linux (RHEL) Server 7 POWER System Big Endian
• Red Hat Enterprise Linux (RHEL) Server 7 x86-64
• SUSE Linux Enterprise Server (SLES) 12 IBM z Systems
• Red Hat Enterprise Linux (RHEL) Server 7 IBM z Systems
• CentOS 7 x86-64
• Oracle Enterprise Linux 6 x86-64
• Oracle Enterprise Linux 7 x86-64
• Ubuntu 16.04 LTS x86-64
• Ubuntu 16.04 LTS POWER System - Little Endian
• Ubuntu 16.04 LTS x86-32
• Red Hat Enterprise Linux (RHEL) Server 7 POWER System Little Endian

Table 92. Hypervisors - Red Hat Virtualization 4.1 (continued)
Component

Supported operating systems
• Ubuntu 18.04 LTS x86-64
• SUSE Linux Enterprise Server (SLES) 15 x86-64
• CentOS 8 x86-64
• Oracle Enterprise Linux 8 x86-64
• SUSE Linux Enterprise Server (SLES) 15 IBM z Systems
• Debian 10 x86-64
• SUSE Linux Enterprise Server (SLES) 15 POWER System Little Endian
• Debian 10 x86-32
• Red Hat Enterprise Linux (RHEL) 8 x86-64
• Debian 9.8 x86-64

Table 93. Hypervisors - Red Hat Virtualization 4.2
Component
Agent or client

Supported operating systems
• Red Hat Enterprise Linux (RHEL) 5 Advanced Platform
POWER System - Big Endian

• BigFix Agent
• Disconnect
ed scanner

• Red Hat Enterprise Linux (RHEL) Server 6 POWER System Big Endian
• Red Hat Enterprise Linux (RHEL) Server 6 IBM z Systems
• Red Hat Enterprise Linux (RHEL) Server 6 x86-32
• Red Hat Enterprise Linux (RHEL) Server 6 x86-64
• SUSE Linux Enterprise Server (SLES) 11 POWER System Big Endian
• SUSE Linux Enterprise Server (SLES) 11 IBM z Systems
• SUSE Linux Enterprise Server (SLES) 11 x86-32
• SUSE Linux Enterprise Server (SLES) 11 x86-64
• Red Hat Enterprise Linux (RHEL) 5 Server POWER System Big Endian
• Red Hat Enterprise Linux (RHEL) 5 Server IBM z Systems

Table 93. Hypervisors - Red Hat Virtualization 4.2 (continued)
Component

Supported operating systems
• SUSE Linux Enterprise Server (SLES) 12 POWER System Little Endian
• SUSE Linux Enterprise Server (SLES) 12 x86-64
• Red Hat Enterprise Linux (RHEL) Server 7 POWER System Big Endian
• Red Hat Enterprise Linux (RHEL) Server 7 x86-64
• SUSE Linux Enterprise Server (SLES) 12 IBM z Systems
• Red Hat Enterprise Linux (RHEL) Server 7 IBM z Systems
• CentOS 7 x86-64
• Oracle Enterprise Linux 6 x86-64
• Oracle Enterprise Linux 7 x86-64
• Ubuntu 16.04 LTS x86-64
• Ubuntu 16.04 LTS POWER System - Little Endian
• Ubuntu 16.04 LTS x86-32
• Red Hat Enterprise Linux (RHEL) Server 7 POWER System Little Endian
• Ubuntu 18.04 LTS x86-64
• SUSE Linux Enterprise Server (SLES) 15 x86-64
• CentOS 8 x86-64
• Oracle Enterprise Linux 8 x86-64
• SUSE Linux Enterprise Server (SLES) 15 IBM z Systems
• Debian 10 x86-64

Table 94. Hypervisors - Red Hat Virtualization 4.3
Supported operating systems
Agent or client

• Red Hat Enterprise Linux (RHEL) 5 Advanced Platform
POWER System - Big Endian

• BigFix Agent
• Disconnected
scanner

• Red Hat Enterprise Linux (RHEL) Server 6 POWER Sys
tem - Big Endian
• Red Hat Enterprise Linux (RHEL) Server 6 IBM z Systems
• Red Hat Enterprise Linux (RHEL) Server 6 x86-32
• Red Hat Enterprise Linux (RHEL) Server 6 x86-64
• SUSE Linux Enterprise Server (SLES) 11 POWER System Big Endian
• SUSE Linux Enterprise Server (SLES) 11 IBM z Systems
• SUSE Linux Enterprise Server (SLES) 11 x86-32
• SUSE Linux Enterprise Server (SLES) 11 x86-64
• Red Hat Enterprise Linux (RHEL) 5 Server POWER Sys
tem - Big Endian
• Red Hat Enterprise Linux (RHEL) 5 Server IBM z Systems
• SUSE Linux Enterprise Server (SLES) 12 POWER System Little Endian
• SUSE Linux Enterprise Server (SLES) 12 x86-64
• Red Hat Enterprise Linux (RHEL) Server 7 POWER Sys
tem - Big Endian
• Red Hat Enterprise Linux (RHEL) Server 7 x86-64
• SUSE Linux Enterprise Server (SLES) 12 IBM z Systems
• Red Hat Enterprise Linux (RHEL) Server 7 IBM z Systems
• CentOS 7 x86-64
• Oracle Enterprise Linux 6 x86-64
• Oracle Enterprise Linux 7 x86-64
• Ubuntu 16.04 LTS x86-64
• Ubuntu 16.04 LTS POWER System - Little Endian
• Ubuntu 16.04 LTS x86-32

Table 94. Hypervisors - Red Hat Virtualization 4.3 (continued)
Supported operating systems
• Red Hat Enterprise Linux (RHEL) Server 7 POWER Sys
tem - Little Endian
• Ubuntu 18.04 LTS x86-64
• SUSE Linux Enterprise Server (SLES) 15 x86-64
• CentOS 8 x86-64
• Oracle Enterprise Linux 8 x86-64
• SUSE Linux Enterprise Server (SLES) 15 IBM z Systems
• Debian 10 x86-64
• SUSE Linux Enterprise Server (SLES) 15 POWER System Little Endian
• Debian 10 x86-32
• Red Hat Enterprise Linux (RHEL) 8 x86-64
• Debian 9.8 x86-64
Table 95. Hypervisors - VMware ESXi 6.5
Component
Agent or client
• BigFix
Agent
• Disconnect
ed scanner

Supported operating systems
• CentOS 7 x86-64
• CentOS 8 x86-64
• Debian 10 x86-32
• Debian 9.8 x86-64
• Debian 10 x86-64
• Oracle Enterprise Linux 6 x86-64
• Oracle Enterprise Linux 7 x86-64
• Oracle Enterprise Linux 8 x86-64
• Red Hat Enterprise Linux (RHEL) 8 x86-64
• Red Hat Enterprise Linux (RHEL) 5 Advanced Platform
POWER System - Big Endian
• Red Hat Enterprise Linux (RHEL) Server 6 x86-32
• Red Hat Enterprise Linux (RHEL) Server 6 x86-64

Table 95. Hypervisors - VMware ESXi 6.5 (continued)
Component

Supported operating systems
• Red Hat Enterprise Linux (RHEL) Server 6.3 x86-64
• Red Hat Enterprise Linux (RHEL) Server 7 x86-64
• SUSE Linux Enterprise Server (SLES) 11 x86-32
• SUSE Linux Enterprise Server (SLES) 11 x86-64
• SUSE Linux Enterprise Server (SLES) 12 x86-64
• SUSE Linux Enterprise Server (SLES) 15 x86-64
• Ubuntu 16.04 LTS x86-32
• Ubuntu 16.04 LTS x86-64
• Ubuntu 18.04 LTS x86-64

Table 96. Hypervisors - VMware ESXi 6.7
Component
Agent or client
• BigFix Agent
• Disconnected scanner

Supported operating systems
• CentOS 7 x86-64
• CentOS 8 x86-64
• Debian 10 x86-32
• Debian 10 x86-64
• Debian 9.8 x86-64
• Oracle Enterprise Linux 7 x86-64
• Oracle Enterprise Linux 8 x86-64
• Red Hat Enterprise Linux (RHEL) 8 x86-64
• Red Hat Enterprise Linux (RHEL) Server 6
x86-32
• Red Hat Enterprise Linux (RHEL) Server 6
x86-64
• Red Hat Enterprise Linux (RHEL) Server 7
x86-64
• SUSE Linux Enterprise Server (SLES) 11
x86-32

Table 96. Hypervisors - VMware ESXi 6.7 (continued)
Component

Supported operating systems
• SUSE Linux Enterprise Server (SLES) 11
x86-64
• SUSE Linux Enterprise Server (SLES) 12
x86-64
• SUSE Linux Enterprise Server (SLES) 15
x86-64
• Ubuntu 16.04 LTS x86-32
• Ubuntu 16.04 LTS x86-64
• Ubuntu 18.04 LTS x86-64
• Ubuntu 20.04 LTS x86-64

Table 97. Hypervisors - VMware ESXi 7.0
Component
Agent or client
• BigFix Agent
• Disconnected scanner

Supported operating systems
• CentOS 7 x86-64
• CentOS 8 x86-64
• Debian 10 x86-32
• Debian 9.8 x86-64
• Debian 10 x86-64
• Oracle Enterprise Linux 6 x86-64
• Oracle Enterprise Linux 7 x86-64
• Oracle Enterprise Linux 8 x86-64
• Red Hat Enterprise Linux (RHEL) 8 x86-64
• Red Hat Enterprise Linux (RHEL) Server 6
x86-32
• Red Hat Enterprise Linux (RHEL) Server 6
x86-64
• Red Hat Enterprise Linux (RHEL) Server 6.3
x86-64

Table 97. Hypervisors - VMware ESXi 7.0 (continued)
Component

Supported operating systems
• Red Hat Enterprise Linux (RHEL) Server 7
x86-64
• SUSE Linux Enterprise Server (SLES) 11
x86-32
• SUSE Linux Enterprise Server (SLES) 11
x86-64
• SUSE Linux Enterprise Server (SLES) 12
x86-64
• SUSE Linux Enterprise Server (SLES) 15
x86-64
• Ubuntu 16.04 LTS x86-32
• Ubuntu 16.04 LTS x86-64
• Ubuntu 18.04 LTS x86-64
• Ubuntu 20.04 LTS x86-64

Table 98. Hypervisors - VMware ESXi 6.7
Component
Agent or client

Supported operating systems
• Red Hat Enterprise Linux (RHEL) 5 Advanced Platform
POWER System - Big Endian

• BigFix Agent
• Disconnect
ed scanner

• Red Hat Enterprise Linux (RHEL) Server 6 POWER System Big Endian
• Red Hat Enterprise Linux (RHEL) Server 6 IBM z Systems
• Red Hat Enterprise Linux (RHEL) Server 6 x86-32
• Red Hat Enterprise Linux (RHEL) Server 6 x86-64
• SUSE Linux Enterprise Server (SLES) 11 POWER System Big Endian
• SUSE Linux Enterprise Server (SLES) 11 IBM z Systems
• SUSE Linux Enterprise Server (SLES) 11 x86-32
• SUSE Linux Enterprise Server (SLES) 11 x86-64

Table 98. Hypervisors - VMware ESXi 6.7 (continued)
Component

Supported operating systems
• Red Hat Enterprise Linux (RHEL) 5 Server POWER System Big Endian
• Red Hat Enterprise Linux (RHEL) 5 Server IBM z Systems
• SUSE Linux Enterprise Server (SLES) 12 POWER System Little Endian
• SUSE Linux Enterprise Server (SLES) 12 x86-64
• Red Hat Enterprise Linux (RHEL) Server 7 POWER System Big Endian
• Red Hat Enterprise Linux (RHEL) Server 7 x86-64
• SUSE Linux Enterprise Server (SLES) 12 IBM z Systems
• Red Hat Enterprise Linux (RHEL) Server 7 IBM z Systems
• CentOS 7 x86-64
• Oracle Enterprise Linux 6 x86-64
• Oracle Enterprise Linux 7 x86-64
• Ubuntu 16.04 LTS x86-64
• Ubuntu 16.04 LTS POWER System - Little Endian
• Ubuntu 16.04 LTS x86-32
• Red Hat Enterprise Linux (RHEL) Server 7 POWER System Little Endian
• Ubuntu 18.04 LTS x86-64
• SUSE Linux Enterprise Server (SLES) 15 x86-64
• CentOS 8 x86-64
• Oracle Enterprise Linux 8 x86-64
• SUSE Linux Enterprise Server (SLES) 15 IBM z Systems
• Debian 10 x86-64
• SUSE Linux Enterprise Server (SLES) 15 POWER System Little Endian
• Debian 10 x86-32
• Red Hat Enterprise Linux (RHEL) 8 x86-64
• Debian 9.8 x86-64

Table 99. Hypervisors - Xen 4.4
Component
Agent or client
• BigFix Agent
• Disconnected
scanner

Supported operating systems
• CentOS 7 x86-64
• Oracle Enterprise Linux 6 x86-64
• Oracle Enterprise Linux 7 x86-64
• Red Hat Enterprise Linux (RHEL) 5 Server IBM z Systems
• Red Hat Enterprise Linux (RHEL) 5 Server POWER System
- Big Endian
• Red Hat Enterprise Linux (RHEL) Server 6 IBM z Systems
• Red Hat Enterprise Linux (RHEL) Server 7 IBM z Systems
• Red Hat Enterprise Linux (RHEL) Server 6 POWER System
- Big Endian
• Red Hat Enterprise Linux (RHEL) Server 7 POWER System
- Big Endian
• Red Hat Enterprise Linux (RHEL) Server 7.1 POWER Sys
tem - Little Endian
• Red Hat Enterprise Linux (RHEL) Server 7.5 POWER Sys
tem - Little Endian
• Red Hat Enterprise Linux (RHEL) Server 6 x86-32
• Red Hat Enterprise Linux (RHEL) Server 6 x86-64
• Red Hat Enterprise Linux (RHEL) Server 6.3 x86-64
• Red Hat Enterprise Linux (RHEL) Server 7 x86-64
• SUSE Linux Enterprise Server (SLES) 11 IBM z Systems
• SUSE Linux Enterprise Server (SLES) 12 IBM z Systems
• SUSE Linux Enterprise Server (SLES) 12 SP1 IBM z Sys
tems
• SUSE Linux Enterprise Server (SLES) 11 POWER System Big Endian
• SUSE Linux Enterprise Server (SLES) 12 POWER System Little Endian
• SUSE Linux Enterprise Server (SLES) 12 SP3 POWER Sys
tem - Little Endian

Table 99. Hypervisors - Xen 4.4 (continued)
Component

Supported operating systems
• SUSE Linux Enterprise Server (SLES) 11 x86-32
• SUSE Linux Enterprise Server (SLES) 11 x86-64
• SUSE Linux Enterprise Server (SLES) 12 x86-64
• Ubuntu 16.04 LTS POWER System - Little Endian
• Ubuntu 16.04 LTS x86-32
• Ubuntu 16.04 LTS x86-64

Table 100. Hypervisors - Xen 4.5
Component
Agent or client
• BigFix Agent
• Disconnected
scanner

Supported operating systems
• CentOS 7 x86-64
• Oracle Enterprise Linux 6 x86-64
• Oracle Enterprise Linux 7 x86-64
• Red Hat Enterprise Linux (RHEL) 5 Server IBM z Sys
tems
• Red Hat Enterprise Linux (RHEL) 5 Server POWER Sys
tem - Big Endian
• Red Hat Enterprise Linux (RHEL) Server 6 IBM z Sys
tems
• Red Hat Enterprise Linux (RHEL) Server 7 IBM z Sys
tems
• Red Hat Enterprise Linux (RHEL) Server 6 POWER Sys
tem - Big Endian
• Red Hat Enterprise Linux (RHEL) Server 7 POWER Sys
tem - Big Endian
• Red Hat Enterprise Linux (RHEL) Server 7.1 POWER
System - Little Endian
• Red Hat Enterprise Linux (RHEL) Server 7.5 POWER
System - Little Endian
• Red Hat Enterprise Linux (RHEL) Server 6 x86-32

Table 100. Hypervisors - Xen 4.5 (continued)
Component

Supported operating systems
• Red Hat Enterprise Linux (RHEL) Server 6 x86-64
• Red Hat Enterprise Linux (RHEL) Server 6.3 x86-64
• Red Hat Enterprise Linux (RHEL) Server 7 x86-64
• SUSE Linux Enterprise Server (SLES) 11 IBM z Systems
• SUSE Linux Enterprise Server (SLES) 12 IBM z Systems
• SUSE Linux Enterprise Server (SLES) 12 SP1 IBM z Sys
tems
• SUSE Linux Enterprise Server (SLES) 11 POWER System
- Big Endian
• SUSE Linux Enterprise Server (SLES) 12 POWER System
- Little Endian
• SUSE Linux Enterprise Server (SLES) 12 SP3 POWER
System - Little Endian
• SUSE Linux Enterprise Server (SLES) 11 x86-32
• SUSE Linux Enterprise Server (SLES) 11 x86-64
• SUSE Linux Enterprise Server (SLES) 12 x86-64
• Ubuntu 16.04 LTS POWER System - Little Endian
• Ubuntu 16.04 LTS x86-32
• Ubuntu 16.04 LTS x86-64

Table 101. Hypervisors -Xen 4.6
Component
Agent or client
• BigFix Agent
• Disconnect
ed scanner

Supported operating systems
• CentOS 7 x86-64
• Debian 9.8 x86-64
• Oracle Enterprise Linux 6 x86-64
• Enterprise Linux 7 x86-64
• Red Hat Enterprise Linux (RHEL) 8 x86-64
• Red Hat Enterprise Linux (RHEL) 5 Advanced Platform
POWER System - Big Endian

Table 101. Hypervisors -Xen 4.6 (continued)
Component

Supported operating systems
• Red Hat Enterprise Linux (RHEL) 5 Server IBM z Systems
• Red Hat Enterprise Linux (RHEL) 5 Server POWER System Big Endian
• Red Hat Enterprise Linux (RHEL) Server 6 IBM z Systems
• Red Hat Enterprise Linux (RHEL) Server 7 IBM z Systems
• Red Hat Enterprise Linux (RHEL) Server 6 POWER System Big Endian
• Red Hat Enterprise Linux (RHEL) Server 7 POWER System Big Endian
• Red Hat Enterprise Linux (RHEL) Server 7.1 POWER Sys
tem - Little Endian
• Red Hat Enterprise Linux (RHEL) Server 7.5 POWER Sys
tem - Little Endian
• Red Hat Enterprise Linux (RHEL) Server 6 x86-32
• Red Hat Enterprise Linux (RHEL) Server 6 x86-64
• Red Hat Enterprise Linux (RHEL) Server 6.3 x86-64
• Red Hat Enterprise Linux (RHEL) Server 7 x86-64
• SUSE Linux Enterprise Server (SLES) 11 IBM z Systems
• SUSE Linux Enterprise Server (SLES) 12 IBM z Systems
• SUSE Linux Enterprise Server (SLES) 12 SP1 IBM z Sys
tems
• SUSE Linux Enterprise Server (SLES) 15 IBM z Systems
• SUSE Linux Enterprise Server (SLES) 11 POWER System Big Endian
• SUSE Linux Enterprise Server (SLES) 12 POWER System Little Endian
• SUSE Linux Enterprise Server (SLES) 12 SP3 POWER Sys
tem - Little Endian
• SUSE Linux Enterprise Server (SLES) 15 POWER System Little Endian

Table 101. Hypervisors -Xen 4.6 (continued)
Component

Supported operating systems
• SUSE Linux Enterprise Server (SLES) 11 x86-64
• SUSE Linux Enterprise Server (SLES) 12 x86-64
• SUSE Linux Enterprise Server (SLES) 15 x86-64
• Ubuntu 16.04 LTS POWER System - Little Endian
• Ubuntu 16.04 LTS x86-32
• Ubuntu 16.04 LTS x86-64
• Ubuntu 18.04 LTS x86-64

Table 102. Hypervisors - z/VM 6.1
Component
Agent or client
• BigFix Agent
• Disconnected
scanner

Supported operating systems
• Red Hat Enterprise Linux (RHEL) 5 Server IBM z Systems
• Red Hat Enterprise Linux (RHEL) Server 6 IBM z Systems
• Red Hat Enterprise Linux (RHEL) Server 7 IBM z Systems
• SUSE Linux Enterprise Server (SLES) 11 IBM z Systems

Table 103. Hypervisors - z/VM 6.2
Component
Agent or client

Supported operating systems
• Red Hat Enterprise Linux (RHEL) 5 Server IBM z Sys
tems

• BigFix Agent
• Disconnected
scanner

• Red Hat Enterprise Linux (RHEL) Server 6 IBM z Sys
tems
• Red Hat Enterprise Linux (RHEL) Server 7 IBM z Sys
tems
• SUSE Linux Enterprise Server (SLES) 11 IBM z Sys
tems
• SUSE Linux Enterprise Server (SLES) 12 IBM z Sys
tems

Table 104. Hypervisors - z/VM 6.3
Component
Agent or client

Supported operating systems
• Red Hat Enterprise Linux (RHEL) 5 Server IBM z Sys
tems

• BigFix Agent
• Disconnected
scanner

• Red Hat Enterprise Linux (RHEL) Server 6 IBM z Sys
tems
• Red Hat Enterprise Linux (RHEL) Server 7 IBM z Sys
tems
• SUSE Linux Enterprise Server (SLES) 11 IBM z Sys
tems
• SUSE Linux Enterprise Server (SLES) 12 IBM z Sys
tems

Table 105. Hypervisors - Windows - Citrix Hypervisor 8.0
Component
Agent or client
• BigFix Agent
• Disconnected scan
ner

Supported operating systems
• Windows 10 Enterprise x86-64
• Windows 10 Pro x86-64
• Windows 7 Enterprise x86-64
• Windows 7 Professional x86-64
• Windows 8 Enterprise x86-64
• Windows 8 Professional x86-64
• Windows 8 Standard x86-64
• Windows Server 2019 Datacenter Edition x86-64
• Windows Server 2019 Essentials Edition x86-64
• Windows Server 2019 Standard Edition x86-64
• Windows Server 2008 Datacenter Edition x86-64
• Windows Server 2008 R2 Datacenter Edition x86-64
• Windows Server 2008 Enterprise Edition x86-64
• Windows Server 2008 R2 Enterprise Edition x86-64
• Windows Server 2008 Standard Edition x86-32
• Windows Server 2008 Standard Edition x86-64

Table 105. Hypervisors - Windows - Citrix Hypervisor 8.0 (continued)
Component

Supported operating systems
• Windows Server 2008 R2 Standard Edition x86-64
• Windows Server 2012 Datacenter Edition x86-64
• Windows Server 2012 R2 Datacenter Edition x86-64
• Windows Server 2012 Essentials Edition x86-64
• Windows Server 2012 R2 Essentials Edition x86-64
• Windows Server 2012 Standard Edition x86-64
• Windows Server 2012 R2 Standard Edition x86-64
• Windows Server 2016 Datacenter Edition x86-64
• Windows Server 2016 Essentials Edition x86-64
• Windows Server 2016 Standard Edition x86-64

Table 106. Hypervisors - Windows - Citrix Hypervisor 8.1
Component
Agent or client
• BigFix Agent
• Disconnected scan
ner

Supported operating systems
• Windows 10 Enterprise x86-64
• Windows 10 Pro x86-64
• Windows 7 Enterprise x86-64
• Windows 7 Professional x86-64
• Windows 8 Enterprise x86-64
• Windows 8 Professional x86-32
• Windows 8 Professional x86-64
• Windows 8 Standard x86-64
• Windows Server 2019 Datacenter Edition x86-64
• Windows Server 2019 Essentials Edition x86-64
• Windows Server 2019 Standard Edition x86-64
• Windows Server 2008 Datacenter Edition x86-64
• Windows Server 2008 R2 Datacenter Edition x86-64
• Windows Server 2008 Enterprise Edition x86-64
• Windows Server 2008 R2 Enterprise Edition x86-64
• Windows Server 2008 Standard Edition x86-64

Table 106. Hypervisors - Windows - Citrix Hypervisor 8.1 (continued)
Component

Supported operating systems
• Windows Server 2008 R2 Standard Edition x86-64
• Windows Server 2012 Datacenter Edition x86-64
• Windows Server 2012 R2 Datacenter Edition x86-64
• Windows Server 2012 Essentials Edition x86-64
• Windows Server 2012 R2 Essentials Edition x86-64
• Windows Server 2012 Standard Edition x86-64
• Windows Server 2012 R2 Standard Edition x86-64
• Windows Server 2016 Datacenter Edition x86-64
• Windows Server 2016 Essentials Edition x86-64
• Windows Server 2016 Standard Edition x86-64

Table 107. Hypervisors - Windows - Citrix Hypervisor 7
Component
Agent or client
• BigFix Agent
• Disconnected scan
ner

Supported operating systems
• Windows 10 Enterprise x86-64
• Windows 10 Pro x86-64
• Windows 7 Enterprise x86-64
• Windows 7 Professional x86-64
• Windows 8 Enterprise x86-64
• Windows 8 Professional x86-64
• Windows 8 Standard x86-64
• Windows Server 2008 Datacenter Edition x86-64
• Windows Server 2008 R2 Datacenter Edition x86-64
• Windows Server 2008 Enterprise Edition x86-64
• Windows Server 2008 R2 Enterprise Edition x86-64
• Windows Server 2008 Standard Edition x86-64
• Windows Server 2008 R2 Standard Edition x86-64
• Windows Server 2012 Datacenter Edition x86-64
• Windows Server 2012 R2 Datacenter Edition x86-64
• Windows Server 2012 Essentials Edition x86-64

Table 107. Hypervisors - Windows - Citrix Hypervisor 7 (continued)
Component

Supported operating systems
• Windows Server 2012 R2 Essentials Edition x86-64
• Windows Server 2012 Standard Edition x86-64
• Windows Server 2012 R2 Standard Edition x86-64
• Windows Server 2016 Datacenter Edition x86-64
• Windows Server 2016 Standard Edition x86-64

Table 108. Hypervisors - Windows - Microsoft Hyper-V Server 2016
Component
Agent or client
• BigFix Agent
• Disconnected scan
ner

Supported operating systems
• Windows Server 2008 Standard Edition x86-64
• Windows Server 2008 Datacenter Edition x86-64
• Windows Server 2008 Enterprise Edition x86-64
• Windows 7 Professional x86-64
• Windows 7 Enterprise x86-64
• Windows Server 2008 R2 Datacenter Edition
x86-64
• Windows Server 2008 R2 Enterprise Edition x86-64
• Windows Server 2008 R2 Standard Edition x86-64
• Windows 8 Enterprise x86-64
• Windows 8 Standard x86-64
• Windows 8 Professional x86-64
• Windows Server 2012 Datacenter Edition x86-64
• Windows Server 2012 Standard Edition x86-64
• Windows Server 2012 Essentials Edition x86-64
• Windows Server 2012 R2 Datacenter Edition
x86-64
• Windows Server 2012 R2 Essentials Edition x86-64
• Windows Server 2012 R2 Standard Edition x86-64
• Windows 10 Pro x86-64
• Windows 10 Enterprise x86-64

Table 108. Hypervisors - Windows - Microsoft Hyper-V Server 2016 (continued)
Component

Supported operating systems
• Windows Server 2016 Datacenter Edition x86-64
• Windows Server 2016 Standard Edition x86-64
• Windows Server 2016 Essentials Edition x86-64
• Windows Server 2019 Datacenter Edition x86-64
• Windows Server 2019 Essentials Edition x86-64
• Windows Server 2019 Standard Edition x86-64

Table 109. Hypervisors - Windows - Microsoft Hyper-V Server 2019
Component
Agent or client
• BigFix Agent
• Disconnected scan
ner

Supported operating systems
• Windows 10 Enterprise x86-64
• Windows 10 Pro x86-64
• Windows 7 Enterprise x86-64
• Windows 7 Professional x86-64
• Windows 8 Enterprise x86-64
• Windows 8 Professional x86-32
• Windows 8 Professional x86-64
• Windows 8 Standard x86-32
• Windows 8 Standard x86-64
• Windows Server 2019 Datacenter Edition x86-64
• Windows Server 2019 Essentials Edition x86-64
• Windows Server 2019 Standard Edition x86-64
• Windows Server 2008 Datacenter Edition x86-32
• Windows Server 2008 Datacenter Edition x86-64
• Windows Server 2008 R2 Datacenter Edition
x86-64
• Windows Server 2008 Enterprise Edition x86-32
• Windows Server 2008 Enterprise Edition x86-64
• Windows Server 2008 R2 Enterprise Edition x86-64
• Windows Server 2008 Standard Edition x86-32

Table 109. Hypervisors - Windows - Microsoft Hyper-V Server 2019 (continued)
Component

Supported operating systems
• Windows Server 2008 Standard Edition x86-64
• Windows Server 2008 R2 Standard Edition x86-64
• Windows Server 2012 Datacenter Edition x86-64
• Windows Server 2012 R2 Datacenter Edition
x86-64
• Windows Server 2012 Essentials Edition x86-64
• Windows Server 2012 R2 Essentials Edition x86-64
• Windows Server 2012 Standard Edition x86-64
• Windows Server 2012 R2 Standard Edition x86-64
• Windows Server 2016 Datacenter Edition x86-64
• Windows Server 2016 Essentials Edition x86-64
• Windows Server 2016 Standard Edition x86-64

Table 110. Hypervisors - Windows - Nutanix Acropolis 5.10
Component
Agent or client
• BigFix Agent
• Disconnected scan
ner

Supported operating systems
• Windows Server 2019 Datacenter Edition x86-64
• Windows Server 2019 Essentials Edition x86-64
• Windows Server 2019 Standard Edition x86-64
• Windows Server 2016 Datacenter Edition x86-64
• Windows Server 2016 Essentials Edition x86-64
• Windows Server 2016 Standard Edition x86-64

Table 111. Hypervisors - Windows - Red Hat Virtualization 4.0
Component
Agent or client
• BigFix Agent
• Disconnected scan
ner

Supported operating systems
• Windows Server 2008 Standard Edition x86-64
• Windows Server 2008 Datacenter Edition x86-64
• Windows Server 2008 Enterprise Edition x86-64
• Windows 7 Professional x86-64

Table 111. Hypervisors - Windows - Red Hat Virtualization 4.0 (continued)
Component

Supported operating systems
• Windows 7 Enterprise x86-64
• Windows Server 2008 R2 Datacenter Edition
x86-64
• Windows Server 2008 R2 Enterprise Edition x86-64
• Windows Server 2008 R2 Standard Edition x86-64
• Windows 8 Enterprise x86-64
• Windows 8 Standard x86-64
• Windows 8 Professional x86-64
• Windows Server 2012 Datacenter Edition x86-64
• Windows Server 2012 Standard Edition x86-64
• Windows Server 2012 Essentials Edition x86-64
• Windows Server 2012 R2 Datacenter Edition
x86-64
• Windows Server 2012 R2 Essentials Edition
x86-64
• Windows Server 2012 R2 Standard Edition x86-64
• Windows 10 Pro x86-64
• Windows 10 Enterprise x86-64
• Windows Server 2016 Datacenter Edition x86-64
• Windows Server 2016 Standard Edition x86-64
• Windows Server 2016 Essentials Edition x86-64
• Windows Server 2019 Datacenter Edition x86-64
• Windows Server 2019 Essentials Edition x86-64
• Windows Server 2019 Standard Edition x86-64

Table 112. Hypervisors - Windows - Red Hat Virtualization 4.1
Component
Agent or client

Supported operating systems
• Windows Server 2008 Standard Edition x86-64
• Windows Server 2008 Datacenter Edition x86-64

Table 112. Hypervisors - Windows - Red Hat Virtualization 4.1 (continued)
Component

Supported operating systems

• BigFix Agent

• Windows Server 2008 Enterprise Edition x86-64

• Disconnected scanner

• Windows 7 Professional x86-64
• Windows 7 Enterprise x86-64
• Windows Server 2008 R2 Datacenter Edition
x86-64
• Windows Server 2008 R2 Enterprise Edition
x86-64
• Windows Server 2008 R2 Standard Edition x86-64
• Windows 8 Enterprise x86-64
• Windows 8 Standard x86-64
• Windows 8 Professional x86-64
• Windows Server 2012 Datacenter Edition x86-64
• Windows Server 2012 Standard Edition x86-64
• Windows Server 2012 Essentials Edition x86-64
• Windows Server 2012 R2 Datacenter Edition
x86-64
• Windows Server 2012 R2 Essentials Edition
x86-64
• Windows Server 2012 R2 Standard Edition x86-64
• Windows 10 Pro x86-64
• Windows 10 Enterprise x86-64
• Windows Server 2016 Datacenter Edition x86-64
• Windows Server 2016 Standard Edition x86-64
• Windows Server 2016 Essentials Edition x86-64
• Windows Server 2019 Datacenter Edition x86-64
• Windows Server 2019 Essentials Edition x86-64
• Windows Server 2019 Standard Edition x86-64

Table 113. Hypervisors - Windows - Red Hat Virtualization 4.2
Component
Agent or client
• BigFix Agent
• Disconnected scanner

Supported operating systems
• Windows Server 2008 Standard Edition x86-64
• Windows Server 2008 Datacenter Edition x86-64
• Windows Server 2008 Enterprise Edition x86-64
• Windows 7 Professional x86-64
• Windows 7 Enterprise x86-64
• Windows Server 2008 R2 Datacenter Edition
x86-64
• Windows Server 2008 R2 Enterprise Edition
x86-64
• Windows Server 2008 R2 Standard Edition
x86-64
• Windows 8 Enterprise x86-64
• Windows 8 Standard x86-64
• Windows 8 Professional x86-64
• Windows Server 2012 Datacenter Edition x86-64
• Windows Server 2012 Standard Edition x86-64
• Windows Server 2012 Essentials Edition x86-64
• Windows Server 2012 R2 Datacenter Edition
x86-64
• Windows Server 2012 R2 Essentials Edition
x86-64
• Windows Server 2012 R2 Standard Edition
x86-64
• Windows 10 Pro x86-64
• Windows 10 Enterprise x86-64
• Windows Server 2016 Datacenter Edition x86-64
• Windows Server 2016 Standard Edition x86-64
• Windows Server 2016 Essentials Edition x86-64
• Windows Server 2019 Datacenter Edition x86-64

Table 113. Hypervisors - Windows - Red Hat Virtualization 4.2 (continued)
Component

Supported operating systems
• Windows Server 2019 Essentials Edition x86-64
• Windows Server 2019 Standard Edition x86-64

Table 114. Hypervisors - Windows - Red Hat Virtualization 4.3
Component
Agent or client
• BigFix Agent
• Disconnected scanner

Supported operating systems
• Windows Server 2008 Datacenter Edition x86-32
• Windows Server 2008 Standard Edition x86-64
• Windows Server 2008 Datacenter Edition x86-64
• Windows Server 2008 Enterprise Edition x86-64
• Windows 7 Professional x86-64
• Windows 7 Enterprise x86-64
• Windows Server 2008 R2 Datacenter Edition
x86-64
• Windows Server 2008 R2 Enterprise Edition
x86-64
• Windows Server 2008 R2 Standard Edition
x86-64
• Windows 8 Enterprise x86-64
• Windows 8 Standard x86-64
• Windows 8 Professional x86-64
• Windows 8 Professional x86-32
• Windows 8 Enterprise x86-32
• Windows 8 Standard x86-32
• Windows Server 2012 Datacenter Edition x86-64
• Windows Server 2012 Standard Edition x86-64
• Windows Server 2012 Essentials Edition x86-64
• Windows Server 2012 R2 Datacenter Edition
x86-64

Table 114. Hypervisors - Windows - Red Hat Virtualization 4.3 (continued)
Component

Supported operating systems
• Windows Server 2012 R2 Essentials Edition
x86-64
• Windows Server 2012 R2 Standard Edition
x86-64
• Windows 10 Pro x86-64
• Windows 10 Enterprise x86-64
• Windows Server 2016 Datacenter Edition x86-64
• Windows Server 2016 Standard Edition x86-64
• Windows Server 2016 Essentials Edition x86-64
• Windows Server 2019 Datacenter Edition x86-64
• Windows Server 2019 Essentials Edition x86-64
• Windows Server 2019 Standard Edition x86-64

Table 115. Hypervisors - Windows - VMware ESXi 6.5
Component
Agent or client
• BigFix Agent
• Disconnected scanner

Supported operating systems
• Windows 10 Enterprise x86-64
• Windows 10 Pro x86-64
• Windows 7 Enterprise x86-64
• Windows 7 Professional x86-64
• Windows 8 Enterprise x86-64
• Windows 8 Professional x86-64
• Windows 8 Standard x86-64
• Windows Server 2019 Datacenter Edition x86-64
• Windows Server 2019 Essentials Edition x86-64
• Windows Server 2019 Standard Edition x86-64
• Windows Server 2008 Datacenter Edition x86-64
• Windows Server 2008 R2 Datacenter Edition
x86-64
• Windows Server 2008 Enterprise Edition x86-64

Table 115. Hypervisors - Windows - VMware ESXi 6.5 (continued)
Component

Supported operating systems
• Windows Server 2008 R2 Enterprise Edition
x86-64
• Windows Server 2008 Standard Edition x86-64
• Windows Server 2008 R2 Standard Edition
x86-64
• Windows Server 2012 Datacenter Edition x86-64
• Windows Server 2012 R2 Datacenter Edition
x86-64
• Windows Server 2012 Essentials Edition x86-64
• Windows Server 2012 R2 Essentials Edition
x86-64
• Windows Server 2012 Standard Edition x86-64
• Windows Server 2012 R2 Standard Edition
x86-64
• Windows Server 2016 Datacenter Edition x86-64
• Windows Server 2016 Standard Edition x86-64

Table 116. Windows - Hyper-V on Windows Server 2022
Component
Agent or client
• BigFix Agent
• Disconnected scanner

Supported operating systems
• Windows 10 Enterprise x86-32
• Windows 10 Enterprise x86-64
• Windows 10 Pro x86-32
• Windows 10 Pro x86-64
• Windows 11 Enterprise x86-64
• Windows 11 Pro x86-64
• Windows 8 Enterprise x86-32
• Windows 8 Enterprise x86-64
• Windows 8 Professional x86-32
• Windows 8 Professional x86-64

Table 116. Windows - Hyper-V on Windows Server 2022 (continued)
Component

Supported operating systems
• Windows 8 Standard x86-32
• Windows 8 Standard x86-64
• Windows 8.1 Enterprise x86-32
• Windows 8.1 Enterprise x86-64
• Windows 8.1 Professional x86-32
• Windows 8.1 Professional x86-64
• Windows 8.1 Standard x86-32
• Windows 8.1 Standard x86-64
• Windows Server 2012 Datacenter
Edition x86-64
• Windows Server 2012 Essentials
Edition x86-64
• Windows Server 2012 R2 Datacen
ter Edition x86-64
• Windows Server 2012 R2 Essentials
Edition x86-64
• Windows Server 2012 R2 Standard
Edition x86-64
• Windows Server 2012 Standard Edi
tion x86-64
• Windows Server 2016 Datacenter
Edition x86-64
• Windows Server 2016 Essentials
Edition x86-64
• Windows Server 2016 Standard Edi
tion x86-64
• Windows Server 2019 Datacenter
Edition x86-64
• Windows Server 2019 Essentials
Edition x86-64

Table 116. Windows - Hyper-V on Windows Server 2022 (continued)
Component

Supported operating systems
• Windows Server 2019 Standard Edi
tion x86-64
• Windows Server 2022 Datacenter
Edition x86-64
• Windows Server 2022 Standard Edi
tion x86-64

Table 117. Linux - Hyper-V on Windows Server 2022
Component
Agent or client
• BigFix Agent
• Disconnected scanner

Supported operating systems
• CentOS 7 x86-64
• CentOS 8 x86-64
• Red Hat Enterprise Linux (RHEL) 8
x86-64
• Red Hat Enterprise Linux (RHEL)
Server 6 x86-64
• Red Hat Enterprise Linux (RHEL)
Server 7 x86-64

Software requirements
Ensure that all prerequisite software is installed on the computers in your infrastructure.

Server requirements
For information about operating systems on which BigFix, DB2® and SQL Server are
supported, see: Detailed System requirements.
To learn about BigFix Platform system requirements, refer to BigFix 10 - Detailed System
Requirements.

Table 118. Requirements for the BigFix Inventory server
Version
BigFix

Description
• 10.0

For information about the requirements, see:

• 9.5

• BigFix 10.0 product documentation

Note: Support for Big
Fix Platform 9.2 ends
on April 30th, 2022. For
more information, see
BigFix forum annouce
ment.

• BigFix 9.5 product documentation
Important: 10.0.5 BigFix Inven
tory communicates only using
TLS 1.2. When using TLS en
cryption for BigFix Platform MS
SQL database, please ensure
that MS SQL database is on ap
propriate fixpack level that sup
ports TLS 1.2. Otherwise data
imports in BigFix Inventory will
not work. For details on MS SQL
minimum fixpack levels sup
porting TLS 1.2, refer to TLS 1.2
support article.

DB2®

•

DB2 11.5

Operating system requirements

(The fixpack level should

To use DB2 as a database, Big

be in line with BigFix re

Fix Inventory must be installed

quirements.)

on Linux™.
DB2 version
Note: DB2 11.5 For the
list of databases sup
ported by the BigFix plat
form, see: BigFix Plat

Table 118. Requirements for the BigFix Inventory server (continued)
Version

Description
form 9.5: Detailed Sys
tem Requirements and
BigFix Platform 10: De
tailed System Require
ments.
DB2® requirements
For information about the data
base requirements, see, DB2®
11.5 product documentation.
DB2® edition
DB2® Workgroup Server Edition
is sufficient to work with BigFix
Inventory regardless of the num
ber of endpoints. You can use
DB2® Enterprise Server Edition,
or Advanced Enterprise Serv
er Edition to have access to ad
vanced features of DB2®.
DB2 upgrade considerations
Below are some of the DB2 up
grade considerations:
• You can upgrade the DB2
to version 11.5 using the
same machine as well us
ing a new machine.

Table 118. Requirements for the BigFix Inventory server (continued)
Version

Description
◦ If you consider up
grading DB2 us
ing the same ma
chine, make sure
that RHEL operating
system is on version
7.6 or higher, or 8.1
or higher. Refer to
DB2 upgrade on Lin
ux for more informa
tion.
◦ If you consider using
a new machine, you
can move the BigFix
Inventory database
to the new machine
and upgrade DB2.
To know more about
it, refer to Moving
the BigFix Inventory
database.
• DB2 upgrade is multistep
process. Refer to the IBM
DB2 documentation for
details.
• Upgrading the database
needs sufficient disk
space.
DB2 settings

Table 118. Requirements for the BigFix Inventory server (continued)
Version

Description
• Use a DB2 instance with
default settings. Other re
quired database settings
are configured by BigFix
Inventory installer.
Restriction: If you spec
ify non-default DB2 set
tings, BigFix Inventory
might not work properly.
Download DB2® software
For more information, see:
Downloading and installing
DB2®.
Support for DB2 11.5 GA
Refer to the support article to
know about how support works
for DB2 11.5 GA.

SQL

• 2016 Express SP2

Server

• 2012 SP2 CU 10 , SP3 CU 3 ventory must be installed on Windows™.
• 2012 Express® SP2 CU 10,
SP3 CU 3
• 2014 CU 12, SP1 CU 5
• 2014 Express® CU 12, SP1
CU 5
•

2016

To use SQL Server as a database, BigFix In

SQL Server settings
Ensure that snapshot isolation
is enabled in the SQL Server. For
information about the require
ments, see the Microsoft™ SQL
Server documentation.

Table 118. Requirements for the BigFix Inventory server (continued)
Version

Description
•

2016 Express SP2
or higher

tion has not been tested.
2017 version

•

14.0.3162.1 or higher
•

2017 Express
CU15 or higher

•

The support for AlwaysOn solu

2019

Permissions and roles
For more information about per
missions and roles of MS SQL
Server user, see: Installation ac
counts.

Note: SP = Service Pack,
CU = Content Update
• X11R7.x

The X server is required if you want to install

X serv

or uninstall the BigFix Inventory server in in

er

teractive mode on Red Hat Enterprise Linux™.
It is also required if you want to complete the
server configuration by using a browser that is
available on the computer where the BigFix In
ventory server is installed.
Restriction: XMing X Server for Win
dows™ is not supported.

Other software requirements
Table 119. Other software requirements for BigFix Inventory
Required soft
ware
Web Reports

Required versions

Comments
A component of the Big
Fix platform that is re

Table 119. Other software requirements for BigFix Inventory (continued)
Required soft
ware

Required versions

Comments
quired by BigFix Invento
ry to configure VM man
agers. Web Reports can
be installed during the
installation of BigFix,
and must reside on the
same server.

Browser

Firefox 17 Extended Support Release

Requirements

(ESR) or higher ESR editions
• JavaScript™ must
Note: To use TLS 1.2, check
whether your version of the
browser supports it and whether
it is enabled. Otherwise, use TLS
1.0 for secure communication
with SSL.
Chrome 35 or higher

be enabled in the
browser.
• Minimal support
ed screen resolu
tion is 1360x768
pixels.
• Recommended
screen resolution
is 1920x1080 pix

Restriction: You can experience
problems with checking the de
tailed information about the met

els.
Proxies

ric quantity on the Metric Quantity

Proxies are supported

History and Maximal Trend Value

and depend on the serv

History graphs on License Metrics

er configuration. With

reports. Once you hover over the

the default configura

graph, the information about met

tion, use SSL proxies. If

ric quantity might not be properly

you disabled SSL on the

Table 119. Other software requirements for BigFix Inventory (continued)
Required soft
ware

Required versions

Comments

displayed, or might not appear at

server, then use HTTP

all.

proxies. In big environ
ments, the connections
Microsoft Edge

might time out with
time-consuming opera

Restriction:
• Reports cannot be export
ed to PDF when multiple
columns are selected. Ex
port the data to CSV file in
stead.
• In reports where IP Address
column is enabled, the IP
address is a link that is acti
vated by an external plug-in,
such as Skype. To remove
the link, disable the plug-in.
• You can experience prob
lems with checking the de
tailed information about
the metric quantity on the
Metric Quantity History and
Maximal Trend Value Histo
ry graphs on License Met
rics reports. Once you hov
er over the graph, the infor
mation about metric quanti

tions (downloading ex
tensive reports). In such
a case, increase the
timeout limit for com
munication between the
proxy and BigFix Inven
tory.

Table 119. Other software requirements for BigFix Inventory (continued)
Required soft
ware

Required versions

Comments

ty might not be properly dis
played, or might not appear
at all.

Bash
National lan

To display PDF reports

guage pack for

in a native language,

PDF reader

a language pack that
displays the native lan
guage fonts might be re
quired.

Red Hat packages
The following packages are required if you install the components on Red Hat Enterprise
Linux™.
Table 120. Red Hat packages that are required for the installation
Component

Required packages

BigFix Inventory server

• bash

DB2®

• libstdc++.so.6.0.8
• Red Hat binutils

Hardware requirements
During setup, match your optimum deployment size to your hardware specifications. Use
the recommendations as a general guidance.

Hardware requirements for the server on Windows
Ensure that the computer on which you are installing BigFix Inventory meets the minimal
CPU, and memory requirements for the server and database elements.

Virtualized environment
The ETL (extract, transform, and load) import heavily uses the database resources. BigFix
Inventory and SQL Server can be installed on a virtualized environment. However, for
large deployments that consist of more than 50.000 computers, it is recommended that
dedicated hardware is used.
In a virtual environment for medium size deployments that consist of 10.000 - 50.000
computers, it is recommended that dedicated resources are considered for processor,
memory, and virtual disk allocation. The virtual disk that is allocated for the VM should be
dedicated RAID storage, with dedicated IO bandwidth for that VM.
Use SQL Server that is dedicated for BigFix Inventory and is not shared with BigFix or
other applications. Fine-tuning based on the above mentioned recommendations might be
required.

Processor and RAM
The values provided for BigFix were calculated with the assumption that the BigFix
server, its database and Web Reports server are installed on a single server and that the
BigFix server is dedicated to BigFix Inventory. If you share the BigFix server between
other applications, refer to the BigFix documentation for information about hardware
requirements: BigFix requirements.
The values provided for BigFix Inventory were calculated for the maximum of five
concurrent application users.

Table 121. Processor and RAM requirements for BigFix Inventory
This table consists of four columns, one header row, and four body rows. The second
column is further divided into two sub-columns.
Environ
ment size
Small envi

Topology
1 server

ronment

Reports server

8 GB

cores

(3GB)

2-3 GHz, 4

16 GB

Medium envi 2/3

BigFix, its database, and Web Re

servers** ports server

5 000 - 50 000

BigFix Inventory and SQL Server

endpoints*
Large envi

2/3

ronment

servers** ports server

50 000 - 150

BigFix, its database, and Web Re

BigFix Inventory and SQL Server

000 end

cores
2-3 GHz, 4

12 - 24 GB

cores

(6GB)

2-3 GHz, 4 -

16 - 32 GB

Very large en 2/3

150 000 end
points*

BigFix, its database, and Web Re

servers** ports server
BigFix Inventory and SQL Server

Xmx

16 cores
2-3 GHz, 8 -

32 - 64 GB

16 cores

(8GB)

2-3 GHz, 16

32 - 64 GB

points*

More than

Xmx

er

endpoints

vironment

Memory

2-3 GHz, 4

• BigFix Inventory, and SQL Serv

Up to 5 000

ronment

• BigFix, its database, and Web

Processor

Xmx

cores
2-3 GHz, 8 -

64 - 96

16 cores

GB***
Xmx

(8GB)

* For environments with more than 35 000 endpoints, scan groups are required. For
more information, see Tuning performance.
** A distributed environment, where BigFix Inventory is separated from the database,
is advisable.
*** SQL Server must be throttled to 3/4 RAM capacity.
xmx The default settings for the Java heap size is not sufficient for medium and large
environments. If your environment consists of more than 5000 endpoints, increase the
memory available to Java client processes by increasing the Java heap size.
Procedure
1. Go to the <INSTALL_DIR>/wlp/usr/servers/server1/ directory and edit the
jvm.options file.
2. Set the maximum Java heap size (Xmx) as suggested in table above.
3. Restart BigFix Inventory server.

Disk space
The following tables show disk space requirements for each component.
Important: The BigFix client is also installed on the computers where the
components are installed. Ensure that the computers have enough space for the
client. For more information, see: Hardware requirements for the client.

Table 122. Disk space requirements for BigFix Inventory installed on Windows
This table consists of four columns, one header row, and three body rows. The second
and third body rows are divided in to three rows from the second column.
Space re
Default Directory

quired

Comments

C:\Program Files 500 MB

Compressed installer that is downloaded to the se

(x86)\BigFix En-

lected endpoint from BigFix. It can be deleted after

terprise\BES In-

extracting.

Table 122. Disk space requirements for BigFix Inventory installed on Windows
This table consists of four columns, one header row, and three body rows. The second
and third body rows are divided in to three rows from the second column.
(continued)
Space re
Default Directory

quired

Comments

stallers\BFI_in- 500 MB
staller

Extracted installer.

C:\Program Files 3 GB

installation directory. The amount includes space

\BigFix Enter-

required for future upgrades.

prise\BFI
%TEMP%

350 MB

Temporary files used during the installation.

%USERPROFILE%

1 MB

The home directory of the user running the installa
tion.

SQL Server for BigFix Inventory
Table 123. Disk space requirements for SQL Server for BigFix Inventory
Space re
Default Directory

quired

C:\Program Files 1 GB

Comments
Database installation directory.

\Microsoft SQL
Server
C:\Program Files See Com Database server instance.
\Microsoft

ments

The amount of disk space that is required for the

SQL Serv-

database server depends on the number of com

er\MSSQL11.MSSQLSERV-

puters in your environment and the average size

ER\MSSQL\DATA

of scan files and analyses. It can be calculated ac
cording to the following formula*:

Table 123. Disk space requirements for SQL Server for BigFix Inventory (continued)
Space re
Default Directory

quired

Comments
• <The number of computers> x 1 MB + 6 GB of
initial disk space
For example:
10 000 computers
10 000 x 1 MB + 6 GB = 16 GB
100 000 computers
100 000 x 1 MB + 6 GB = 106 GB

C:\Program Files See Com Database transaction logs.
\Microsoft

ments

During the data import (ETL process), BigFix Inven

SQL Serv-

tory requires some additional free disk space for

er\MSSQL11.MSSQLSERV-

database server transaction logs. The amount of

ER\MSSQL\DATA

disk space that is required can be significant be
cause transaction logs store two sets of data:
• Data that is used for recovery if the ETL fails
• Data that is used to create new ETL results
The amount of disk space that is necessary for the
transaction logs depends on the number of com
puters in your environment as well as the number
of computers in a single scan group from which
data is processed during the import.
To lower the amount of disk space that is neces
sary for transactions logs, distribute the scans
over time so they are processed during several da
ta imports instead of one.

Table 123. Disk space requirements for SQL Server for BigFix Inventory (continued)
Space re
Default Directory

quired

Comments
The size of transaction logs can be calculated ac
cording to the following formula*:
• <The number of computers> x 1.2 MB + <the
number of computers in the biggest scan
group> x 1.2 MB + 17 GB of initial disk space
For example:
10 000 computers and 10 000 scan results
10 000 x 1.2 MB + 10 000 x 1.2 MB +
17 GB = 41 GB
100 000 computers and 15 000 scan results
100 000 x 1.2 MB + 15 000 x 1.2 MB
+ 17 GB = 155 GB

C:\Program Files See Com tempdb database that is used to store and manage
\Microsoft

ments

temporary objects.

SQL Serv-

The size of tempdb can be calculated according to

er\MSSQL11.MSSQLSERV-

the following formula*:

ER\MSSQL\DATA
• <The number of computers> x 0.5 MB
For example:
15 000 computers
15 000 x 0.5 MB = 7.5 GB
*The disk space requirements are calculated based on the average number of files that are
discovered in your environment. The values that are provided in the formula assume that
the average number of the discovered files is 800 per computer, which is represented by

1 and 1.2 MB. If, according to your estimates, the number of files is higher, increase this
value adequately. If you already installed BigFix Inventory, you can use the Scanned File
Data and Computers reports for your calculations. Note, that the required initial disk space
(15 or 17 GB) is constant. The number of discovered files not only affects the size of the
database,but also the server runtime memory requirements. For more information, see:
Tuning performance in medium and large environments.
* The formulas apply to typical environments that are configured to run weekly software
scans, daily data imports, and whose endpoints have about 60 software installations each.
The results also depend on the amount of data returned by the scans, which means that in
some environments the required amount of disk space might be smaller or bigger. In case
of irregular data imports or accumulated scans, the required disk space increases.
Note: The retention period in this typical environment is set to the last 7 days. For
more information about tuning this parameter, see: Shortening the retention period
gradually to avoid problems with growing database size.
BigFix
Table 124. Disk space requirements for BigFix installed on Windows
This table consists of four columns, one header row, and three body rows. The second
and third body rows are divided in to three rows from the second column.
Space re
Default Directory

quired

C:\Program Files 1.8 GB

Comments
BigFix installation directory.

\BigFix Enterprise\BES Server
C:\Program Files Around 2

BigFix cache. It stores files that are downloaded by

(x86)\BigFix En- GB

some of the fixlets before they are distributed to

terprise\BES

the selected endpoints. For example, the BigFix In

Server\www-

ventory installer.

Table 124. Disk space requirements for BigFix installed on Windows
This table consists of four columns, one header row, and three body rows. The second
and third body rows are divided in to three rows from the second column.
(continued)
Space re
Default Directory

quired

Comments

rootbes\bfmir-

The required space might increase if you run some

ror\down-

of the fixlets multiple times. For example, each

loads\sha1

time you run the Upgrade to the latest version of
BigFix Inventory 9.x, a new installer is downloaded
to the cache. Thus, the required space increases.
To check whether a fixlet downloads any files and
what their size is, log in to the BigFix console, and
check the value in the Download Size column for
the particular fixlet. Then, ensure that enough disk
space is available in the BigFix cache.

C:\Program Files 90 MB

BigFix console.

\BigFix Enterprise\BES Console
SQL Server for BigFix
For information about hardware requirements for the SQL Server that is used as the BigFix
database, see the Database requirements.
Apart from the disk space that is described in the guide, ensure additional disk space for
transaction logs on the computer where the BigFix database is installed. To calculate the
required disk space, check how many objects exist in all fixlet sites that you have enabled
in the BigFix console. An object is every computer group, analysis, fixlet, and task that exist
in the console, including the ones that are not relevant. Every 1000 objects requires 1GB

of free disk space. For example, if you have 500 fixlets and tasks, 300 analyses, and 20
computer groups, you have 820 objects in total. Thus, 1 GB of disk space is required.

Reference
Tuning performance

Hardware requirements for the server on Linux
Ensure that the computer on which you are installing the BigFix Inventory meets the minimal
CPU, and memory requirements for the server and database elements.

Virtualized environment
The ETL (extract, transform, and load) import heavily uses the DB2 database resources.
BigFix Inventory and DB2 server can be installed on a virtualized environment. However,
for large deployments that consist of 50 000 - 100 000 computers, it is recommended that
dedicated hardware is used.
In a virtual environment for medium size deployments that consist of 10 000 - 50 000
computers, it is recommended that dedicated resources are considered for processor,
memory, and virtual disk allocation. The virtual disk that is allocated for the VM should be
dedicated RAID storage, with dedicated IO bandwidth for that VM.
Use DB2 server that is dedicated for BigFix Inventory and is not shared with BigFix or
other applications. Fine-tuning based on the above mentioned recommendations might be
required.

Processor and RAM
The values provided for BigFix were calculated with the assumption that the BigFix
server, its database and Web Reports server are installed on a single server and that the
BigFix server is dedicated to BigFix Inventory. If you share the BigFix server between
other applications, refer to the BigFix documentation for information about hardware
requirements: BigFix requirements.

The values provided for BigFix Inventory were calculated for the maximum of five
concurrent application users.
Table 125. Processor and RAM requirements for BigFix Inventory
The table consists of four columns and four body rows. The second column is further
divided into two sub-columns.
Environ
ment size
Small envi

Topology
1 server BigFix, its database, and Web Reports

ronment

Processor

Memory

2-3 GHz, 4

8 GB

server, BigFix Inventory and DB2

cores

(3GB)

BigFix, its database, and Web Reports

2-3 GHz, 4

16 GB

Xmx

Up to 5 000
endpoints
Medium envi 2/3
ronment

servers** server

5 000 - 50

BigFix Inventory and DB2

000 end

cores
2-3 GHz, 4

12 - 24

cores

GB

points*

Xmx

(6GB)

Large envi

2/3

ronment

servers** server

50 000 - 150

BigFix, its database, and Web Reports

BigFix Inventory and DB2

000 end

2-3 GHz, 4 - 16 16 - 32
cores

2-3 GHz, 8 - 16 32 - 64
cores

points*

Xmx

2/3

environment

servers** server

150 000 end
points*

GB
(8GB)

Very large

More than

GB

BigFix, its database, and Web Reports

BigFix Inventory and DB2

2-3 GHz, 16

32 - 64

cores

GB

2-3 GHz, 8 - 16 64 - 96
cores

GB***
Xmx

(8GB)

* For environments with more than 35 000 endpoints, scan groups are required. For
more information, see Tuning performance.
** A distributed environment, where BigFix Inventory is separated from the database,
is advisable.
xmx The default settings for the Java heap size is not sufficient for medium and large
environments. If your environment consists of more than 5000 endpoints, increase the
memory available to Java client processes by increasing the Java heap size.
Procedure
1. Go to the <INSTALL_DIR>/wlp/usr/servers/server1/ directory and edit the
jvm.options file.
2. Set the maximum Java heap size (Xmx) as suggested in table above.
3. Restart BigFix Inventory server.

Disk space
The following tables show disk space requirements for each component.
Important: The BigFix client is also installed on the computers where the
components are installed. Ensure that the computers have enough space for the
client. For more information, see: Hardware requirements for the client.
BigFix Inventory
Table 126. Disk space requirements for BigFix Inventory installed on Linux
The table consists of three columns and five body rows. The first body row is further divided
into two rows.
Space
re
Default Directory

quired

Comments

user_direc-

500

Compressed installer that is downloaded to the selected

tory/BFI_in-

MB

endpoint from BigFix. The compressed installer can be

staller

deleted after it is extracted.

Table 126. Disk space requirements for BigFix Inventory installed on Linux
The table consists of three columns and five body rows. The first body row is further divided
into two rows.
(continued)
Space
re
Default Directory

quired
500

Comments
Extracted installation files.

MB
/opt/BFI

3 GB

BigFix Inventory installation directory. The amount includes
space required for future upgrades.

/tmp

350

Temporary files used during the installation.

MB
Important: The installer must be able to run exe
cutable files in this directory.
$HOME

1 MB

Home directory of the user running the installation.

/etc

1 MB

Directory that stores scripts that start the server.

/var

10 kB

Directory that stores the installation registry.

DB2 for BigFix Inventory
Table 127. Disk space requirements for DB2 for BigFix Inventory
The table consists of three columns and four body rows.
Space
re
Default Directory
/opt/IBM/db2

quired

Comments

1.5 GB DB2 installation directory.

Table 127. Disk space requirements for DB2 for BigFix Inventory
The table consists of three columns and four body rows.
(continued)
Space
re
Default Directory

quired

Comments

/var/db2

10 kB

Directory that stores DB2 global registry.

/home/db2inst1

See

Database server instance.

Com

The amount of disk space that is required for the database

ments server depends on the number of computers in your environ
ment and the average size of scan files and analysis. It can
be calculated according to the following formula*:
• <The number of computers> x 1 MB + 15 GB of initial
disk space
For example:
10 000 computers
10 000 x 1 MB + 15 GB = 25 GB
100 000 computers
100 000 x 1 MB + 15 GB = 115 GB
/home/db2in-

See

Database server transaction logs.

st1/db2inst1/

Com

During the data import (ETL process), BigFix Inventory re

ments quires some additional free disk space for database server
transaction logs. The amount of disk space that is required
can be significant because transaction logs store two sets
of data:
• Data that is used for recovery if the ETL fails
• Data that is used to create new ETL results

Table 127. Disk space requirements for DB2 for BigFix Inventory
The table consists of three columns and four body rows.
(continued)
Space
re
Default Directory

quired

Comments
The amount of disk space that is necessary for the transac
tion logs depends on the number of computers in your en
vironment as well as the number of computers in a single
scan group from which data is processed during the import.
To lower the amount of disk space that is necessary for
transactions logs, distribute the scans over time so they are
processed during several data imports instead of one.
The size of transaction logs can be calculated according to
the following formula*:
• <The number of computers> x 1.2 MB + <the number
of computers in the biggest scan group> x 1.2 MB + 17
GB of initial disk space
For example:
10 000 computers and 10 000 scan results
10 000 x 1.2 MB + 10 000 x 1.2 MB + 17 GB =
41 GB
100 000 computers and 15 000 scan results
100 000 x 1.2 MB + 15 000 x 1.2 MB + 17 GB =
155 GB

*The disk space requirements are calculated based on the average number of files that are
discovered in your environment. The values that are provided in the formula assume that

the average number of the discovered files is 800 per computer, which is represented by 1
and 1.2 MB. If, according to your estimates, the number of files is higher, increase this value
adequately. If you already installed , you can use the Scanned File Data and Computers
reports for your calculations. Note, that the required initial disk space (15 or 17 GB) is
constant. The number of discovered files not only affects the size of the database,but also
the server runtime memory requirements. For more information, see: Tuning performance in
medium and large environments.
* The formulas apply to typical environments that are configured to run weekly software
scans, daily data imports, and whose endpoints have about 60 software installations each.
The results also depend on the amount of data returned by the scans, which means that in
some environments the required amount of disk space might be smaller or bigger. In case
of irregular data imports or accumulated scans, the required disk space increases.
Note: The retention period in this typical environment is set to the last 7 days. For
more information about tuning this parameter, see: Shortening the retention period
gradually to avoid problems with growing database size.
BigFix
Table 128. Disk space requirements for BigFix installed on Linux
The table consists of three columns and five body rows.
Space
re
Default Directory

quired

Comments

/var/opt/BESIn- 90 MB Directory with console and client installers.
stallers
/var/opt/
BESServer

2 GB

BigFix installation directory.

Table 128. Disk space requirements for BigFix installed on Linux
The table consists of three columns and five body rows.
(continued)
Space
re
Default Directory

quired

Comments

/var/opt/

Around BigFix cache. It stores files that are downloaded by some

BESServer/www-

2 GB

of the fixlets before they are distributed to the selected end

rootbes/bfmir-

points. For example, the BigFix Inventory installer.

ror/down-

The required space might increase if you run some of the

loads/sha1/

fixlets multiple times. For example, each time you run the
Upgrade to the latest version of BigFix Inventory 9.x, a new
installer is downloaded to the cache. Thus, the required
space increases.
To check whether a fixlet downloads any files and what their
size is, log in to the BigFix console, and check the value in
the Download Size column for the particular fixlet. Then, en
sure that enough disk space is available in the BigFix cache.

/var/opt/BESWe- 300
bReportsServer

MB

/opt/BESWebRe-

500

portsServer

MB

/opt/BESServer

100

Web Reports installation directory.

Directory with the Web Reports server binaries.

Directory with server binaries.

MB
/var/log

1 MB

C:\Program

90 MB BigFix console installation directory. The console must be

Files\BigFix
Enterprise\BES
Console

Directory with log files.

installed on Windows.

For disk speed, see: Storage performance requirements.
DB2 for BigFix
For information about hardware requirements for DB2 that is used as the BigFix database,
see the Database requirements.
Apart from the disk space that is described in the guide, ensure additional disk space for
transaction logs on the computer where the BigFix database is installed. To calculate the
required disk space, check how many objects exist in all fixlet sites that you have enabled
in the BigFix console. An object is every computer group, analysis, fixlet, and task that exist
in the console, including the ones that are not relevant. Every 1000 objects requires 1GB
of free disk space. For example, if you have 500 fixlets and tasks, 300 analyses, and 20
computer groups, you have 820 objects in total. Thus, 1 GB of disk space is required.

Reference
Tuning performance

Hardware requirements for the client
Review important information about hardware requirements for the BigFix client and the
software and capacity scans that are embedded in it.

Processor and RAM
An BigFix client alone can consume up to 2% of the processing power of one processor
core on an endpoint. However, the client is complemented with software and capacity scans
that collect necessary software and hardware information from your endpoints. Although
the capacity scan reports very low CPU usage, the software scan can consume substantial
CPU resources while a scan is in progress. To decrease the impact of a software scan on
production system, it can be scheduled to run on the weekends or in the evenings. You can
also run the software scan with the CPU threshold option that limits the consumption of
your CPU resources.

Table 129. CPU and RAM usage for BigFix clients
This table consists of four columns, one header row, and three body rows.
Component
BigFix client

CPU
<2%

RAM

Comments

< 20

For more information, see:

MB

https://support.hcltechsw
.com/csm?id=bigfix_support.

Software scan

Up to 100 %

< 80

The software scan runs on de

You can limit the

MB

mand, and can be monitored by
checking the following process

usage by running

es: wscansw, wscanfs.

the scan with the
CPU threshold at
tribute.
Capacity scan

<1%

< 20

The capacity scan runs every

MB

30 minutes, and can be moni
tored by checking the following
process: wscanhw.

Disk space
Ensure that endpoints have enough disk space before you start installing the BigFix clients.
Important: The following disk space requirements do not include the size of files
that are downloaded to the endpoint by some of the fixlets. For example, the fixlet
Download BigFix Inventory, downloads the application installer to the specified
endpoint. Thus, more space is required on the targeted endpoint.
To check whether a fixlet downloads any files to the targeted endpoint, log in to the
BigFix console, and check the value in the Download Size column for the particular
fixlet. Then, ensure that enough disk space is available on the endpoint.

Table 130. Disk space requirements for clients installed on UNIX
Operating

Space re

system
UNIX

Directory

quired

Comments

/opt/BESClient

80 MB

Client installation directory.

/var/opt/BESClient

250 MB

Client data directory. This di
rectory contains all scan re
sults.

200 MB

The additional space is re
quired if the VM Manager
Tool is installed on the end
point.

/opt/tivoli/cit

50 MB

Scanner installation directo
ry.

/opt/tivoli/cit/

100 MB on

Scanner cache files.

cache_data

average

The required disk space de
pends on the number of files,
directories, and subdirec
tories to be scanned. It can
be estimated by multiply
ing the number of files to be
scanned by 60 bytes.

/etc/cit

< 1 MB

Scanner configuration files.

/tmp

100 MB on

Scanner temporary files.

average

The required disk space de
pends on the scanner options
that are used (for example,
sorting) as well as the num
ber of files, directories, and
subdirectories to be scanned.

Table 130. Disk space requirements for clients installed on UNIX (continued)
Operating

Space re

system

Directory

quired

Comments
It can be estimated by multi
plying the number of files to
be scanned by 100 bytes.

/usr/ibm/tivoli/com-

10 MB

Scanner log files.

mon/CIT
Table 131. Disk space requirements for clients installed on Windows
Operating
system
Windows

Space re
Directory
C:\Program Files

quired
150 MB

Comments
Client installation and data

(x86)\BigFix Enter-

directory. This directory con

prise\BES Client

tains all scan results.
300 MB

The additional space is re
quired if the VM Manager
Tool is installed on the end
point.

C:\Program Files

20 MB

Scanner installation directory.

50 MB on

Scanner cache files.

\tivoli\cit
C:\Program Files

\tivoli\cit\cache_data average

The required disk space de
pends on the number of files,
directories, and subdirecto
ries to be scanned. It can be
estimated by multiplying the
number of files to be scanned
by 60 bytes.

Table 131. Disk space requirements for clients installed on Windows (continued)
Operating
system

Space re
Directory

quired

Comments

%WINDIR%

< 1 MB

%TMP% or %TEMP%

100 MB on Scanner temporary files.
average

Scanner configuration files.

The required disk space de
pends on the scanner options
that are used (for example,
sorting) as well as the num
ber of files, directories, and
subdirectories to be scanned.
It can be estimated by multi
plying the number of files to
be scanned by 100 bytes.

C:\Program Files

10 MB

Scanner log files.

\tivoli\ibm\tivoli
\common\CIT\logs

Port requirements
When planning the infrastructure, ensure that port numbers used by BigFix Inventory, BigFix,
and the database are free to enable communication between those components.
The following is the list of default ports used by the BigFix Inventory infrastructure. You can
change them during the installation of each component:

Table 132. Default ports used by the BigFix Inventory infrastructure
This table consists of three columns, one header rows, and three body rows. The first
and third body rows are divided in to two rows from the second column.
Port
Type
BigFix In

number
9081

ventory

Description
The web browser connects to the server (HTTPS) to display
the user interface.
The BigFix server uses this port to connect to the BigFix In
ventory server.

DB2®

50000

The server connects to DB2®.

SQL Server

1433

The server connects to SQL Server.

BigFix

52311

BigFix clients and console connect to the server.
The BigFix Inventory server uses this port to connect to the
BigFix server.

For more information about port numbers and interactions between components of the
BigFix Inventory infrastructure, see: Flow of data.
Make sure that relevant web addresses are accessible from the computer where the BigFix
server is installed. For more information, see: Firewall exceptions.

Firewall exceptions
Some of the fixlets require that the BigFix server connects to the Internet and downloads
necessary files and updates. To ensure that they can be downloaded, relevant web
addresses must be accessible from the computer where the server is installed. Add those
addresses as firewall exceptions and ensure that they are accessible to the proxy server if
you are using it.
Ensure that the following web addresses are accessible from the computer where the BigFix
server is installed

• esync.bigfix.com
• gatherer.bigfix.com
• software.bigfix.com
• support.bigfix.com
• sync.bigfix.com
The HTTP port 80 must be open for communication.
BigFix Inventory occasionally offers you a customer feedback survey. This quick
survey allows you to rate the product and provide valuable feedback that can help us
improve our services. To be able to participate in the survey, allow the connection to the
following web page from your browser: https://survey.medallia.eu/.

Proxy exceptions
If the BigFix server uses a proxy for Internet connection to access fixlet sites or prefetch
downloads, the BigFix Inventory server must be added to an exception list to ensure that the
catalog propagation works properly.
In an environment with a proxy, propagation of the catalog might fail because the BigFix
server connects to the proxy to download the catalog file instead of connecting to the
server directly. To ensure that the problem does not occur, add the following entries to the
proxy exception list in the BigFix server configuration:
• IP address of the server
• FQDN host name of the server
Additionally if the BigFix server is installed on the same computer as server, add the
following entries to the proxy exception list:
localhost, 127.0.0.1

For more information, see: Setting a proxy connection on the server.

Installation accounts
You can install all the infrastructure components as the administrative user. You can also
install some components as a non-administrative user but some limitations apply.
Table 133. Installation accounts for the components of the BigFix Inventory
infrastructure on Windows
Account

Account Permissions and Roles

OS Account to install and run BigFix User with administrative privileges with the log
Inventory server

on as a service permission.
If you want to use the Windows authentication
mode and your database server is remote, en
sure that the user that accesses the database
is a domain user. This user needs to have the
dbcreator or sysadmin rights in MS SQL data
base.

OS Account to install and run SQL

User with administrative privileges

Server database
SQL Server database user for BigFix User account that either:
Inventory database
1. the system admin
2. has permissions listed below and user
mapping to access the BigFix Inventory
database. Important: this requires manual
creatation of database during installation.
User has the default language set to "Eng
lish" (not a variety of English).
The permissions required for non system admin
are:

Table 133. Installation accounts for the components of the BigFix Inventory
infrastructure on Windows (continued)
Account

Account Permissions and Roles
• user role: public
• permission: select
• execute, mapping: BigFix Inventory data
base, Master, MSDB
•

has "SQLAgentUserRole" for msdb database to manage SQL Server agent
jobs. Without access, the user cannot
manage the BigFix Inventory index main
tenace job. Instead to the index mainte
nance job being created/updated, warning
appears in the tema.log log file.

SQL Server database user for BigFix Database user has have following permissions
Inventory to access SQL Server Big on BFEnterprise database: CREATE FUNCTION,
Fix Platform BFEnterprise database CREATE SCHEMA, CREATE TABLE, CREATE VIEW,
EXECUTE, SELECT

User has the default language set to "Eng
lish" (not a variety of English).
Once BigFix Inventory is installed or updated
and the first data import is complete, MS SQL
users with lower permissions can access BigFix
Platform database. Before any BigFix Invento
ry update, the data source must be reconfigured
to allow the database user, db_owner access to
BigFix Platform database. If you do not reconfig
ure the data source, the next data import might
fail.

Table 133. Installation accounts for the components of the BigFix Inventory
infrastructure on Windows (continued)
Account

Account Permissions and Roles
Following are the required minimal permission
for a user on BigFix Platform database to run
regular import:
DEFAULT_DATABASE=[BFEnterprise]
DEFAULT_LANGUAGE=[us_english]
Server Role: public

Permissions:
CONNECT TO ANY DATABASE
CONNECT SQL

BFEnterprise database permissions
Roles: public, db_datareader
Permissions:
EXECUTE

GRANT EXEC TO <user>

SQL Server database user for BigFix User has the default language set to "Eng
Inventory to access SQL Server Big lish" (not a variety of English).SELECT
Fix Platform Web Reports database
(BESReporting)

Table 134. Installation accounts for the components of the BigFix Inventory
infrastructure on Linux
Account Permis
Account
OS Account to in

sions and Roles
root or non-root user

Limitations
Server that is installed by a non-

stall and run BigFix

root user is not registered as

Inventory server

a system service. It also can
not be upgraded with a fixlet. It
must be upgraded in interactive
or silent mode.

OS Account to in

root or non-root user

For information about limita

stall and run DB2®

tions that apply when you install

database

DB2® as a non-root user, see
the following links.
• Non-root installation
overview DB2® 11.5 doc
umentation

DB2 database user To allow the application instal
for BigFix Invento

lation and opearation user with

ry database

authorities: DBADM, DATAAC
CESS, and ACCESSCTRL is re
quired.
There is recommended to cre
ate a dedicated database user
for BigFix Inventory with about
authorities.
The user got assigned roles and
permissions for created BigFix

Table 134. Installation accounts for the components of the BigFix Inventory
infrastructure on Linux (continued)
Account Permis
Account

sions and Roles

Limitations

Inventory Database during data
base creation.
DB2 database user DBAUTHDATAACCESS
for BigFix Invento
ry to access DB2
BigFix Platform
database (BFENT)
DB2 database user DATAACCESS
for BigFix Invento
ry to access DB2
BigFix Platform
Web Reports data
base (BESREPOR)

Coexistence scenarios
This topic describes supported scenarios for the coexistence of BigFix Inventory and
License Metric Tool.

Coexistence of BigFix Inventory and License Metric Tool in the
same infrastructure
License Metric Tool and BigFix Inventory can coexist within the same infrastructure. They
can be connected to the same BigFix server but monitor different sets of computers. You
can then use BigFix Inventory to discover non-IBM software and measure its license metric
utilization on selected computers, and use License Metric Tool to monitor computers
on which only IBM software is installed. Thanks to connecting both applications to a

common BigFix server, you can manage them by using one console. It makes monitoring
the environment much easier.
Although License Metric Tool and BigFix Inventory are connected to a common BigFix
server, they work as separate applications and must be installed on separate computers.
Each application manages a separate set of computers that can report to only one
application at a given moment. The applications also use different fixlet sites and dedicated
sets of fixlets for installation and configuration. Apart from the common BigFix server, all
other aspects, such as software and capacity scans or the software catalog, are specific to
each application.

Limitations
• Separate installation
BigFix Inventory and License Metric Tool must be installed on separate computers.
• VM managers
You can add VM managers through the user interface only for the application that has
the BigFix server subscribed to its fixlet site. It happens because VM managers added
through the user interface must be managed by the VM Manager tool that is installed
on the BigFix server. For the other application, use advanced VM management. For
more information, see: Advanced VM management (distributed).
If you collect VM manager data directly from virtualization hosts by using the Run
Capacity Scan on Virtualization Hosts fixlet, the coexistence is possible only if all
endpoints from this host report to the same application. For more information about
the fixlet, see: Collecting capacity data from virtualization hosts for Xen and KVM.
• Many re-subscriptions
You might encounter problems with the missing software catalog or scan results
if you often re-subscribe endpoints between the two applications. These problems
occur only if you re-subscribe endpoints more than once. For example, if you resubscribe an endpoint from BigFix Inventory to License Metric Tool, and then
subscribe it back to BigFix Inventory

Adding a second BigFix Inventory server
Available from 9.2.1. Multiple instances of BigFix Inventory can coexist within
the same infrastructure. They can be connected to the same BigFix server but monitor
different computers that are grouped according to specific criteria. It allows for reporting
utilization of license metrics for subsets of computers, managing parts of the environment
by separate teams, or distributing the workload by importing data from a smaller number of
computers.
Important: You can fulfill the same scenarios by dividing computers into groups in
a single instance of BigFix Inventory. It is the recommended approach. For more
information, see: Tutorial: Reporting subcapacity usage per computer group.
To add another instance of BigFix Inventory, install another BigFix Inventory server and
connect it to the same BigFix platform. Ensure that both instances of BigFix Inventory use
the same fixlet site. From the BigFix perspective, the separation of servers is not visible. The
servers use the same fixlet site, computers, and tasks that are used to scan the environment
and discover software. The separation occurs during the import of data from BigFix to
BigFix Inventory servers.
To import data from different sets of computers, divide the computers into groups by giving
them unique computer settings. Then, create an analysis that retrieves the values of these
settings. Finally, modify the data import so that each BigFix Inventory server imports data
only from computers that have a particular setting, and omits the remaining ones. As a
result, each BigFix Inventory server manages a separate group of computers.
Note: Consider the following limitation only if you initially installed BigFix Inventory
version 9.2.3 or earlier, regardless of whether you upgraded to a newer version
since:
The coexisting servers must use the same database software, either SQL Server or
DB2, and have the same software catalog uploaded. It is required because you will
later disable the catalog delivery in one of the servers, so that a common catalog is
always delivered to all computers. Different signatures in catalogs for SQL Server

and DB2 would cause problems in software discovery. For more information, see
Additional considerations.

Complete the following procedures to enable the coexistence.

Dividing computers between servers
Available since 9.2.1. Divide your computers between two servers by specifying
unique computer settings. Based on these settings, the servers choose specific computers
to import the data from. As a result, each of your servers manages a separate group of
computers. Plan the division, and then mark your computers as either BFI1 or BFI2.
This procedure shows only one way of dividing your computers between two servers. You
can specify also other settings, or use relevance expressions to divide the computers
according to their operating systems, computer groups, or any custom criteria. For more
information about creating properties and analyses that are required to retrieve them, see
Creating retrieved properties and Creating analyses.
1. Log in to the BigFix console.
2. Add new computer settings to your computers. Based on these settings, your
computers are divided between two instances of BigFix Inventory.
a. In the navigation tree, click Computers.
b. Select a group of computers that you want to add to one of the servers.
c. Right-click these computers, and then click Edit Computer Settings.
d. Select the Custom Setting check box, and enter the following values:
Setting Name: Instance
Setting Value: BFI1 or BFI2

The value, BFI1 or BFI2, depends on the instance that you want to add a specific
computer to. Specify BFI1 for a group of computers, and BFI2 for another group.
e. Click OK to save the setting. Repeat the preceding steps until all your computers
have a value BFI1 or BFI2 specified.
3. Create a custom analysis to retrieve the specified settings from your computers.
a. To create an analysis, click Tools > Create New Analysis.
b. Specify the name as Instance Assignment.
c. Click the Properties tab, and then click Add Property.
d. Specify the name of the property as Instance.
e. In the relevance field, enter the following string:
value of setting "Instance" of client|""

This relevance expression returns the value of the setting Instance that you
added to your computers. It can return either BFI1 or BFI2.
f. Click OK to save the analysis. The analysis is added to your Master Action Site.
4. Verify that the analysis is returning correct values.
a. Click Sites > Master Action Site.
b. Select your custom Instance Assignment analysis.
c. Click the Results tab. The analysis shows a property called Instance, which
returns either BFI1 or BFI2. If you did not set this property for some computers,
the value is empty.
You divided your computers based on specific computer settings. You can now modify the
data import settings in both instances of BigFix Inventory to specify whether the servers
should import data about either BFI1 or BFI2 computers.

Modifying servers to include specific computers
Available from 9.2.1. Modify the data import settings so that each of your servers
imports the data only from a specific group of computers. The servers choose only those
computers that meet the specified criteria, for example, that are marked with a value BFI1,
but not BFI2. Other computers are omitted during the import.
The main element that decides which computers report to which server is the custom
analysis that you created to retrieve some information about your computers, in this case
specific values like BFI1 or BFI2. The server checks the analysis results to verify values that
are attached to your computers. If a computer has a value that meets the server criteria,
then data from this computer is imported. Otherwise, the computer is discarded.
1. Go to installation_directory/wlp/usr/servers/server1/config.
2. Edit the etl_settings.yml file and specify the following properties and values:
scoped_etl_enabled: 1
Specifies whether a scoped data import should be enabled. If set to 0,
data from all computers is imported.
scoped_etl_site_name: ActionSite
Specifies the name of the Fixlet site that contains your custom analysis.
ActionSite stands for Master Action Site.
scoped_etl_site_is_custom: false
Specifies whether the Fixlet site is a custom site.
scoped_etl_analysis_name: Instance Assignment
Specifies the name of your custom analysis.
scoped_etl_analysis_property_id: 1
Specifies the ID of the analysis property Instance. If you added just one
property, it has the ID of 1. However, you can check it by exporting the
analysis to a bes file and opening it in a text editor.
scoped_etl_based_on: MATCH

Specifies conditions of a scoped data import. In this case, you can enter
any value that is different from the default SITE_URL_FOR_SITE_NAME.
The default value would import data from all computers in a Fixlet site.
scoped_etl_resultstext_match: BFI1%
Specifies the value based on which the server selects its computers.
Specify BFI1 for one server, and BFI2 for another. A value returned by
the analysis might include a space or a new line at the end. Enter a
percent sign (%) after the value to include such occurrences instead of
discarding a computer.
scoped_etl_overwrite_on_migration: false
Specifies whether to overwrite these settings with default ones after an
upgrade or migration.
3. Restart the server.
4. Run a data import.
You modified the servers to import data only from specific computers. You can open the
Computers report to verify that only chosen computers are shown.
Review additional considerations and apply them to your environment to avoid problems
with coexistence.

Additional considerations
To ensure that no problems occur while working with coexisting servers, review the
following considerations and apply them to your environment.

Software catalogs
To ensure that software on your computers is discovered based on the same software
signatures, upload the same software catalogs to both servers. You can then disable the
catalog delivery on one of them to avoid overwriting. The remaining server will deliver
the catalog to all computers, regardless of the server that they report to, because the
computers are in the same Fixlet site.

To disable the catalog delivery, run the following query on the database:
UPDATE DBO.SYSTEM_GLOBALS SET VALUE = '--- false
' WHERE NAME='catalog_download_actions_enabled';

Note: Consider the following limitation only if you initially installed BigFix Inventory
version 9.2.3 or earlier, regardless of whether you upgraded to a newer version
since:
Use the same database software for both servers, either DB2 or SQL Server.
Signatures are different between these two types, and one software catalog might
cause problems with discovery.

VM managers
You can use the user interface to add VM managers only for one of the servers, namely the
one that has the BigFix server assigned to it. This is because VM managers added in the
user interface must be managed by the VM Manager Tool that is installed on the BigFix
server. For the other server, you can use advanced VM management, in which you install
additional tools on any computer.

Changing assignments
If you want to change a computer assignment, for example from BFI1 to BFI2, ensure that
you edit the existing setting instead of creating a new one. To edit the setting, complete the
following steps:
1. In the BigFix console, click Computers.
2. Right-click a single computer, and then click Edit Computer Settings.
3. Select the Instance setting, click Edit, and specify a new value.

Missing scan results
Missing scan results might occur after changing the assignments of your computers. Such
a change is not always detected by the server, which as a result does not upload the scan
results. To correct this issue, you must reinstall the scanner and rerun the scans. After you

do this, the old scan results are deleted, and the new ones are collected and uploaded. To
reinstall the scanner, complete the following steps:
1. In the BigFix console, stop all actions that are running on the problematic endpoints.
2. Open the Fixlet site.
3. From Fixlets and Tasks, select Uninstall Scanner, and click Take Action.
4. Select all problematic computers, and click OK. Wait until the action is complete.
5. Reinstall the scanner and rerun the scans. For more information, see: Setting up
scans.

Installing on Windows
A complete deployment of BigFix Inventory on Windows requires the installation of three
components: the BigFix platform, the BigFix Inventory server, and an MS SQL database.
Additionally, a BigFix client must be installed on every computer from which you want to
collect software inventory data. You can install all components from scratch or add the
BigFix Inventory server to the existing BigFix infrastructure. Depending on the environment
size, you can install all components on a single computer, or distribute them among multiple
computers.
Figure 4. BigFix Inventory infrastructure

Step-by-step installation guide for Windows
Use the step-by-step installation guide to ensure that you complete all steps necessary to
successfully install BigFix Inventory on Windows.
Table 135. Step-by-step guide for installing and configuring BigFix Inventory
Stage
1.

Installation step
Plan the installation to ensure that the computer on which you want to install BigFix Inventory fulfills the fol
lowing requirements:
• Runs on a Detailed System requirements
• Fulfills the minimum hardware requirements
• Has sufficient disk space
• Has the required software installed

2

Install the BigFix platform

Table 135. Step-by-step guide for installing and configuring BigFix Inventory (continued)
Stage

Installation step
• Create the license authorization file
• Download the BigFix installer
• Install the BigFix server, console and the first client
• Install the BigFix client on every computer from which you want to collect software inventory data

Tip: You can install the clients at this point or proceed with the installation of BigFix Invento
ry and install the clients later on.
3

Install BigFix Inventory
• Install MS SQL Server
• Enable the BigFix Inventory fixlet site
• Install the BigFix Inventory server
• Perform initial configuration
• Verify the current application and catalog version

4

Create users and groups to give users access to BigFix Inventory and to define computers for which they
can see data.
• Set up users
• Set up computer groups

5

Set up scans to discover software and hardware inventory in your infrastructure.

Important: The steps are not required if you enabled the default scan configuration during the instal
lation.

• Optional: Distribute scans for improved performance
• Activate the required analyses
• Install the scanner
• Initiate software scans
• Schedule uploads of software scan results
• Collect capacity data

Installing the BigFix platform on Windows
The BigFix platform is the core of the BigFix Inventory infrastructure. It consists of a server
that coordinates the flow of data to and from the monitored computers, an administrative
console, and clients that collect data from the computers in your infrastructure. Before you
can install BigFix Inventory, install all components of the BigFix platform.
REFERENCE
BigFix Inventory infrastructure
Software requirements
Hardware requirements for the server on Linux

Creating the license authorization file
After you order BigFix Inventory from Passport Advantage, you receive a welcome email
with information how to access the BigFix License Key Center. Go to the Key Center and
create the license authorization file that contains deployment and licensing information. The
file is needed during the installation of the BigFix platform.
1. Go to the License Key Center.
2. Enter your email address and the password that you received in the welcome email.

3. For each product that you purchased, specify the allocated client quantity. If you leave
0, you cannot install the particular product.
4. To generate the license authorization file, click Create Serial Number.
5. To download the file, click Download.
The LicenseAuthorization.BESLicenseAuthorization file is downloaded to your
computer. The file is needed during the installation of the BigFix platform.
Download the BigFix installer.

Downloading the BigFix installer for Windows
To obtain the BigFix installer for Windows, go to the BigFix download center and download
the Installation Generator.
1. Go to http://support.bigfix.com/bes/release/, and choose the latest version of the
BigFix platform.
2. Download the Installation Generator.

3. To save the installer, click Save File.
Move the installer to the computer on which you want to install the BigFix platform and start
the installation.

Installing BigFix on Windows
To install the BigFix platform on Windows, run the installation wizard that will guide you
through the installation of the BigFix server, console, and the first BigFix client.
The BigFix platform installed on Windows requires MS SQL Server as a database. Ensure
that you have MS SQL Server installed and running before you start the installation of BigFix.
For information about supported versions of MS SQL Server, see: Software requirements.
Restriction:
The BigFix installer allows for the installation of an evaluation version of MS SQL
Server. However, such version expires after 180 days and should not be used in a
production environment.

The following procedure shows the most common installation scenario for Windows.
If it does not fit your environment, you need more information about each step, or other
installation tasks, see: Installing on Windows systems in the BigFix documentation.
1. Request a license certificate.
a. To start the installation, run the BigFix-BES-version.exe file.
b. When prompted, choose the Production installation.

c. After you read and accept the license agreement, select I want to install with an
BigFix license authorization file.
d. Specify the location of the license authorization file, and click Next.
e. Enter the DNS name or IP address of the computer on which you want to install
the BigFix platform, and click Next.
f. Create a public/private key pair that will be used to authorize all users of the
BigFix console. Enter the password and choose the key size, then click Create.

g. Save the created files in a secure folder, and click OK.
Attention: If you lose the private key file, a new license certificate needs
to be created, which requires a new installation.
h. Submit the request to BigFix to obtain the license certificate.

• If the computer can access the Internet, select the first option, and click
Request. The request is submitted automatically.
• If the computer cannot access the Internet, select the second option. The
request.BESLicenseRequest file is generated, and saved to a chosen
folder. Copy the file to a computer with Internet access. Go to BES License
Request Handler, and submit the request file. In return, the license.crt
file is saved to your computer. Copy the file back to the computer where
you are installing BigFix. Return to the installation, and click Import to
import the certificate. Then click Create.
2. Enter the parameters of the masthead file that contains configuration and license
information. Then, click OK.
Tip: Default settings are suitable for most deployments. For detailed
information about the parameters, see: Requesting a license certificate and
creating the masthead.

3. Choose the destination folder for the installers of the BigFix components, and click
Next. After the component installers are deployed, click Finish.
The Installation Guide is launched to lead you through the installation of BigFix
components: server, console, and client.
4. Install the BigFix server.
a. In the Installation Guide, click Install Server, and click Install or Upgrade the
Server on this computer.
b. Follow instructions in the installation wizard. When prompted, specify the
location of the license.pvk file, and enter the password that you specified in
step 1.f. Click OK to continue.
c. Create an account that you want to use to log in to the BigFix console, and click
OK.
d. To complete the installation, click Finish.
5. Install the BigFix console.
a. In the Installation Guide, click Install Console, and click Install or Upgrade the
Console on this computer.
b. Follow instructions in the installation wizard.
c. To complete the installation, click Finish.
Tip: You can log in to the console with the user that you created in step
4.c.
6. Install the BigFix client on the computer on which you installed the BigFix server.
a. In the Installation Guide, click Install Clients, and click Install or Upgrade the
Client on this computer.
b. Follow instructions in the installation wizard.
c. To complete the installation, click Finish.
7. If you want to install the BigFix Inventory server on a different computer, install the
BigFix client on that computer.

You can proceed with the installation of the BigFix client on every computer from which you
want to collect software inventory data or with the installation of the BigFix Inventory server.
You can perform these tasks in any order.

Installing the BigFix clients
Install the BigFix client on every computer in your network that you want to monitor,
including the backup and recovery machines.

Installation methods
Methods for installing the clients vary depending on the operating system. Even if you install
the BigFix server on Linux™, you might need to install some of the clients on Windows™ if
your network consists of such computers. For more information, see:
• Installing clients on Windows™ computers
• Installing clients on Linux™ and UNIX™ computers
If you are not sure which installation method to choose, install the client manually.

Additional installation requirements
• If you are using HP Integrity VM, install the client on the virtual machines and their
host operating systems.
• If you are using Solaris Containers/Zones or Logical Domains (LDOM), install the
client in the global zone on the control domain and in other global zones. For more
information, see: Client installation on Oracle Solaris.

Installation packages
The BigFix installation image available on the Passport Advantage® contains client
installers. You can also download client installation packages from the BigFix® support
web page.

Important: Not all of the operating systems for which installation packages are
provided as part of the BigFix installation image are supported by BigFix Inventory.
For more information, see: Detailed System requirements.

Client vs scanner
The BigFix client is common for all BigFix products that are based on the BigFix platform,
and is used to perform various tasks on the endpoints. It provides information about a set
of computer properties like its host name or the IP address. It is also used to install the
scanner on the computers, and enables scanner management through fixlets.
The scanner is an independent component that is used by BigFix Inventory. It collects
information about the hardware, as well as the software that is installed on the computers
in your infrastructure. The data is sent to the BigFix server. You can then import it to the
BigFix Inventory server.
Apart from installing the BigFix client, install also the scanner on every computer that you
want to monitor to ensure that all necessary data is collected. For more information, see:
Setting up scans to discover software and hardware inventory.

Installing BigFix Inventory on Windows
Before you start the installation of BigFix Inventory on Windows, ensure that an MS SQL
Server is installed in your infrastructure. Then, enable a dedicated fixlet site in the BigFix
console and download the BigFix Inventory installer. Next, run the installation in interactive
or silent mode.
REFERENCE
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Installing MS SQL Server for BigFix Inventory on Windows
BigFix Inventory that is installed on Windows requires MS SQL Server as a database.
However, the software is not delivered as part of BigFix Inventory. Ensure that you install MS
SQL Server before you proceed with the installation of the BigFix Inventory server.
The database can be installed on the same computer as the BigFix Inventory server or
on a separate one. You can also reuse the MS SQL Server that you installed for the BigFix
platform.
For detailed installation instructions, see: Installing SQL Server.

Enabling the fixlet site
A fixlet site is a collection of fixlets, tasks, and analyses that are related to a particular
BigFix application. To get access to the content that is specific to BigFix Inventory, enable
the application fixlet site. The procedure differs depending on whether the computer where
the BigFix server is installed has the Internet access or not.

Enabling the fixlet site on Windows with Internet access
If the BigFix server can access the Internet, enable the BigFix Inventory site from the BigFix
console. Then, subscribe computers that you want to monitor to this site so that its content
becomes applicable on these computers.
1. Log in to the BigFix console.
2. In the bottom-left corner of the console, click BigFix Management.

3. In the left navigation panel, click License Overview.

4. In the pane on the right, locate the entry called Inventory, and accept the license
agreement.
5. From the list of available sites, enable the BigFix Inventory v10 site.
The content of the site is downloaded to the BigFix server.
Tip: If there is no site called Inventory, select the site called IBM Endpoint
Manager for Software Use Analysis v9.
6. Subscribe all computers that you want to monitor to the fixlet site so that its content
becomes applicable to these computers.
a. In the bottom-left corner of the console, click All Content.
b. In the left navigation panel, expand Sites > External Sites, and open the BigFix
Inventory v10 site.
c. In the pane on the right, open the Computer Subscriptions tab, select computers
that you want to monitor. If you want to monitor the entire infrastructure, select
All Computers. Otherwise, specify appropriate filtering criteria.

Tip: If the option is not active, click Gather to download the content of
the fixlet site.

d. Click Save Changes.
You enabled the BigFix Inventory site and subscribed computers that you want to monitor to
this site.
Download the BigFix Inventory installer to a selected computer and start the installation.

Enabling the fixlet site on Windows without Internet access
If the BigFix server cannot access the Internet, use the Airgap tool to enable the fixlet
site. When the site is enabled and the content loaded, use the BES Download Cacher to
download and cache the files on the BigFix server.
1. Create a request file to obtain the list of fixlet sites to which you are entitled.
a. Go to the BigFix server installation directory, by default C:\Program
Files (x86)\BigFix Enterprise\BES Server, and run the
BESAirgapTool.exe file. When prompted, save the files to a dedicated folder,
for example Airgap.

b. Copy the created files to a computer with Internet access, and run the
BESAirgapTool.exe file on that computer. This action exchanges the request
file for a response file.
c. Copy the AirgapResponse file back to the computer where the BigFix server is
installed, and place it in the Airgap folder. Run BESAirgapTool.exe to load
the response to the BigFix server.
2. Enable the BigFix Inventory site.
a. Log in to the BigFix console.
b. In the bottom-left corner of the console, click BigFix Management.

c. In the left navigation panel, click License Overview.

d. In the pane on the right, locate the entry called BigFix Inventory, and accept the
license agreement.
e. From the list of available sites, enable the BigFix Inventory v10 site.
Tip: If there is no site called Inventory, select the site called IBM
Endpoint Manager for Software Use Analysis v9.
3. To create a request file to load the content into the site, repeat step 1.
4. Subscribe all computers that you want to monitor to the BigFix Inventory fixlet site so
that its content becomes applicable to these computers.
a. Log in to the BigFix console.
b. In the left navigation panel, click Sites > External Sites > BigFix Inventory v10.
c. In the pane on the right, open the Computer Subscriptions tab, and select
computers that you want to monitor. If you want to monitor the entire
infrastructure, select All Computers. Otherwise, specify appropriate filtering
criteria. Click Save Changes.
The License Reporting.efxmBigFix Inventory.efxm file is created on
the server.
5. Cache the content of the fixlet site on the BigFix server.
a. On the computer where the BigFix server is installed, go to: install_dir\BES
Server\wwwrootbes\bfsites. Copy the BigFix Inventory.efxm file
to a Windows computer with Internet access, and place it in the C:\BigFix
directory.
b. In the C:\BigFix directory create a folder called downloads.
c. Run the BES Download Cacher with the following command:
BESDownloadCacher.exe -m "C:\BigFix\BigFix Inventory.efxm"
-x C:\BigFix\downloads

The BES Download Cacher downloads approximately 1 GB of required files.
d. Optional: The default cache size is enough if you use only the BigFix Inventory
v10 fixlet site. However, if you plan to run fixlets from other sites, such as BES
Support, increase the cache size so that the BigFix server does not try to delete
any files.
i. Log in to the BigFix console.
ii. In the left navigation bar, click Computers and right-click the computer on
which the BigFix server is installed. Then, click Edit Computer Settings.
iii. Increase the value of the _BESGather_Download_CacheLimitMB setting. If
the setting is not on the list, add it and specify the value in MB.
Tip: The size depends on each fixlet site, however you might need
to increase it to at least a couple of gigabytes.
e. Copy the contents of the downloads folder from the computer with Internet
access to the following directory on the computer where the BigFix server is
installed:
install_dir\BES Server\wwwrootbes\bfmirror\downloads\sha1

You enabled the BigFix Inventory fixlet site and loaded its content.
Download the BigFix Inventory installer to a selected computer and start the installation.

Installing the server on Windows
After you enable the fixlet site, download the BigFix Inventory installer, and proceed with the
installation. You can install the server in interactive or silent mode.

Installing the server on Windows in interactive mode
To install the BigFix Inventory server on Windows, download the application installer to
a selected computer and run the setup-server-windows-x86_64.bat script. Then,
follow instructions in the installation wizard.

• Ensure that the BigFix client is installed on the computer on which you want to install
the BigFix Inventory server.
• Log in as user with administrative privileges and run the installer with the Run as
Administrator option.
• Disable or reduce the User Account Control in Windows to avoid warnings during the
installation.
1. Download the BigFix Inventory installer.
a. Log in to the BigFix console.
b. In the navigation panel, click Sites > External Sites > BigFix Inventory v10 >
Fixlets and Tasks.
c. In the upper right pane, select Download BigFix Inventory, and click Take Action.
d. Select the computer to which you want to download the installer, and click OK.
Wait until the status of the action is Completed. The installer is downloaded to
the BES Installers\BFI_installer directory on the selected computer.
By default, the directory is in the following location: C:\Program Files
(x86)\BigFix Enterprise\BES Installers\BFI_installer.
Tip: If the computer is not available, ensure that it has the BigFix client
installed and is subscribed to the BigFix Inventory fixlet site.
2. Log in to the computer where you downloaded the installer as a user with
administrative privileges.
3. Go to the directory where the installer was downloaded, and extract the installation
files.
4. To start the installation, run the setup-server-windows-x86_64.bat file.
Run the installer with the Run as Administrator option.
Tip: If you encounter a slow installation, check the following items:

• Check the performance and speed of the hard disk.
• Check whether the antivirus is scanning each file separately as it might
slow down packaging. If this is the case, turn off the antivirus. If the
antivirus cannot be turned off, expect the installation to be slower.
5. Select the language of the installation, and click OK. The installation wizard starts, and
the welcome panel opens. Click Next.
If you cannot choose your language in the installation wizard, set the system locale to
a chosen language. For more information, see Troubleshooting.
6. Read and accept the license agreement, and click Next.
7. Follow instructions in the installation wizard and provide the required parameters.
8. On the last panel, specify the user account that you want to be used for running the
application service.
• If you choose Local System account, the service runs under the NT AUTHORITY
\SYSTEM user, which has all required rights.

• If you choose Other account, specify a user with the log on as a service right
and administrative privileges. The User Account Control in Windows must be
reduced or disabled, because it might block the service from starting. The user
must be entered as domain\username, machine\username, or .\username if it is
a local account.

Important: To use Windows authentication to access the database, the
service owner chosen on this panel must be available both to BigFix Inventory
and the relevant database server for which you use this authentication.
For local databases, you can use the Local System account. For remote
databases, specify a domain user that is shared between the two servers.
9. When the installation is complete, click Done to exit the wizard.
Tip: If you encountered problems during the installation, analyze the log file
that is in the following directory: %USERPROFILE%/BFI9.2.16.
The BigFix Inventory server is installed and the initial configuration opens in the browser. If
you do not have a browser installed or want to complete the configuration from a different
computer, go to: https://host_name:port, where host_name and port are the values that
you specified during the installation.
Complete the initial configuration.

TASK
Resuming a stopped or failed interactive installation
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Installing the server on Windows in silent mode
To install the BigFix Inventory server on Windows, download the application installer to
a selected computer, edit parameters in the install_response.txt file, and run the
installation command.
• Ensure that the BigFix client is installed on the computer on which you want to install
the BigFix Inventory server.
• Log in as user with administrative privileges and run the installer with the Run as
Administrator option.
• Disable or reduce the User Account Control in Windows to avoid warnings during the
installation.
1. Download the BigFix Inventory installer.
a. Log in to the BigFix console.
b. In the navigation panel, click Sites > External Sites > BigFix Inventory v10 >
Fixlets and Tasks.
c. In the upper right pane, select Download BigFix Inventory, and click Take Action.
d. Select the computer to which you want to download the installer, and click OK.
Wait until the status of the action is Completed. The installer is downloaded to
the BES Installers\BFI_installer directory on the selected computer.

By default, the directory is in the following location: C:\Program Files
(x86)\BigFix Enterprise\BES Installers\BFI_installer.
Tip: If the computer is not available, ensure that it has the BigFix client
installed and is subscribed to the BigFix Inventory fixlet site.
2. Log in to the computer where you downloaded the installer as a user with
administrative privileges.
3. Go to the directory where the installer was downloaded, and extract the installation
files.
4. Read the license agreement in the BES Installers\BFI_installer\licenses
\LA_language.txt file.
5. Edit the install_response.txt response file and adjust it to your installation.
Ensure that the RSP_LICENSE_ACCEPTED parameter is set to true. If you do not
accept the license, the installation fails. For more information about installation
parameters, see: Server installation response file.
6. Start the command line and change to the directory with installation files. To start the
installation, run the following command.
setup-server-windows-x86_64.bat -f response_file_path -i silent

Where response_file_path is the absolute path to the response file that you are using.
For example:
setup-server-windows-x86_64.bat -f "C:\Program Files (x86)\BigFix
Enterprise\BES Installers\BFI_installer\install_response.txt" -i
silent

Tip: Use the -h option to view help information about using the script, for
example: setup-server-windows-x86_64.bat -h.

Tip: If you encounter a slow installation, check the following items:

• Check the performance and speed of the hard disk.
• Check whether the antivirus is scanning each file separately as it might
slow down packaging. If this is the case, turn off the antivirus. If the
antivirus cannot be turned off, expect the installation to be slower.
Access the BigFix Inventory user interface to complete the initial configuration. To access
the user interface, go to: https://host_name:port, where host_name and port are the
values that you specified during the installation.

TASK
Resuming a stopped or failed interactive installation
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Server installation response file
The install_response file specifies input parameters that are used during the
installation of the BigFix Inventory server in silent mode.
Table 136. Response file parameters
Parameter key name

Description

RSP_LICENSE_ACCEPT Accepts the license agreement.
ED

Default
false

The installation fails if you do not
change the value of the parameter
to true.

RSP_DISABLE_PRE

Disables prerequisite checking

false (warnings are

REQ_WARNINGS

warnings.

enabled)

Table 136. Response file parameters (continued)
Parameter key name

Description

Default

If the server does not have enough
memory or processor cores, the
silent installation fails. You can
change this behavior by setting the
value of this parameter to true. The
installation can complete even if
the requirements are not fulfilled,
however insufficient resources
might impact performance.
RSP_TLM_ROOT

Specifies the installation location.

C:\Pro-

Specify an empty directory in which gram Files
\BigFix Enteryou want to install the server. If the
prise\BFI
directory does not exist, it is creat
ed.
RSP_TLM_HTTPS_PORT Specifies the port that is used by

/opt/BFI
9081

the server.
If you do not specify the port num
ber, a default value is used. If the
selected port is already used by a
different application, the installa
tion fails.
RSP_DISABLE_

Disables communication warnings.

COMMUNICATION_

If any of the ports that you speci

WARNINGS

fied in the RSP_TLM_HTTPS_PORT
is locked by another application,
silent installation fails. To specify
a port that is temporarily used but
will be available later, set the RSP_

false

Table 136. Response file parameters (continued)
Parameter key name

Description

Default

DISABLE_COMMUNICATION_
WARNINGS parameter to true.
RSP_USER_AC Specifies the user account for run
COUNT

ning the application service.
The User Account Control in Win
dows must be reduced or disabled.
Otherwise, it might block the ser
vice from starting.
If you leave the value current, the
service runs under the NT AUTHORITY\SYSTEM user, which has all re

quired rights. If you specify a differ
ent user, ensure that the following
requirements are met:
• The user has the log on as a
service right and administra
tive privileges.
• The user is entered as
domain\username, machine\username, or .\username if it is a local account

Important: To use Windows
authentication to access
the database, the service
owner chosen here must
be available both to BigFix
Inventory and the relevant

current

Table 136. Response file parameters (continued)
Parameter key name

Description

Default

database server for which
you use this authentication.
For local databases, you
can use current, but for re
mote ones it must be a do
main user that is shared be
tween the two servers.
RSP_USER_AC Specifies the password of the user
COUNT_PWD

account for running the application
service.

Performing initial configuration on Windows
During the initial configuration, you create a BigFix Inventory database and the application
administrator. You also set up a connection to the BigFix server and database. As an option,
you can configure a connection to the Web Reports database to give the Web Reports users
access to BigFix Inventory.
• Ensure that you have SQL Server database user for BigFix Inventory database as
defined on Installation accounts page.
Creation of the BigFix Inventory database
• To create a new database during initial configuration in BigFix Inventory, the user must
have the sysadmin role in MS SQL Server.
◦ If you chose local system account as the service owner during the installation,
provide the sysadmin role to the NT AUTHORITY\SYSTEM user in MS SQL server.
• Alternatievly manually create an MS SQL before the configuration. Make sure that:

◦ the database is empty
◦ use the SQL_Latin1_General_CP1_CS_AS collation. You must have the db_owner
role in MS SQL Server to perform this action.
◦ Snapshot isolation is allowed in the database. To allow snapshot isolation,
use ALTER DATABASE DatabaseName and SET ALLOW_SNAPSHOT_ISOLATION ON
queries.
Other considerations
• If you want to use Windows authentication to connect to the databases, the following
requirements must be fulfilled:
◦ BigFix and BigFix Inventory must be installed on Windows.
◦ To use a local user for authentication, BigFix and BigFix Inventory must be
installed on the same instance of Windows. The applications can run on
different hosts if the user is a domain user.
◦ The owner of the BigFix Inventory service must also be able to access this
database.
1. Create the BigFix Inventory database.
a. Enter the host name of the database server.
If you want to configure a named database instance or specify a non-default
port, provide the host name in the following format:
• hostname\instance_name, for example localhost\MyInstance
• hostname:port_number, for example localhost:1444
b. Enter the name of the application database.
c. Select the authentication mode.

• Select Windows Authentication, to authenticate with a Windows user
that you specified as the service owner during the installation of BigFix
Inventory.
Restriction: If the MS SQL Server is installed on the same
computer as BigFix Inventory, enter the database host name
without its domain name (FQDN) or use localhost instead. The
host name can be specified as NC1985110 or localhost, but not
as NC1985110.domain.com or 198.50.100.
• Select SQL Server Authentication to authenticate with an MS SQL Server
user. This authentication mode must be enabled in MS SQL Server. For
more information, see: Enabling the SQL Server Authentication mode.
d. To create the database instance, click Create.
2. Create the administrator of BigFix Inventory.
Tip: Avoid using admin, administrator, root or a similar name for the
administrative account. Such an account might be prone to hacker attacks
and locked out if an attacker exceeds the specified number of failed login
attempts. For more information, about the account lockout, see: Configuring
user account lockout.

3. Optional: To automatically enable scans that collect data from the computers in your
infrastructure, select Enable default scan schedule for this data source.
If you enable the default scan schedule, actions that are needed to collect data from
the computers in your infrastructure are automatically started on the BigFix server.
This option is advised for environments with up to a few thousand computers. For
larger environments, finish the installation, divide the computers into groups, and then
manually set up scan schedule for each group to avoid performance issues. For more
information about the default and manual scan schedule, see: Setting up scans to
discover software and hardware inventory.
4. Configure the connection to the BigFix database. The database stores information
about the computers, and data that was discovered on these computers. Specify the
host, port, database name, and credentials of the user that can access the BigFix
database.

5. Configure the connection to the BigFix server. The host name or IP address, and the
API port number are automatically retrieved from the database. Specify only the
administrative user that you created during the installation of BigFix.

Note: If you do not want to provide the Master Operator, you can create a
dedicated BigFix user that fulfills the following requirements:
• Is assigned the BigFix Inventory v10 site
• Is assigned computers that you are going to monitor, and the computer
where the BigFix server is installed
• Has the following permissions: Can use REST API, Can use Console,
Custom Content, Can Create Actions
The option is supported starting from BigFix 9.5.
6. Optional: If the BigFix and BigFix Inventory servers are in separated networks, the
automatic address lookup might return incorrect address. To disable the lookup,
select Disable automatic address lookup, and specify the address manually. Then,
configure additional environment variables on the BigFix Inventory server. For more
information, see Configuring servers in separate networks.
7. Optional: Configure the connection to the Web Reports database. Specify the
database type, host name, database name, and credentials of the Web Reports
database user.
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8. To create connections to the databases, click Create.
When the connections are created and configured, a new page opens and a message
about the data import is displayed.
9. Optional: If your environment consists of more than 50 000 endpoints, complete
steps to enhance the application performance before you run the import.
10. To run the initial import, click Import Now.
The import might take a few hours, depending on your hardware capacity.
If you enabled the default scan schedule, the collected data might not be displayed in BigFix
Inventory after the initial import. Some time is required to finish scans that were initiated
during the installation, and to upload scan results to the server. If the reports in BigFix
Inventory do not contain any data, wait about an hour until the scans are completed. Then,
start another import.
If you did not enable the default scan schedule, manually configure scans to collect data
that is later on displayed on the reports. For more information, see Setting up scans to
discover software and hardware inventory.
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Uninstalling on Windows
To remove BigFix Inventory from your infrastructure, stop the application-specific actions
and analyses that are running on the computers and uninstall the scanner. Then, remove
the VM Manager tool. Finally, uninstall the BigFix Inventory server. You can also remove the
related database.

Uninstalling the server on Windows in interactive mode
To uninstall the BigFix Inventory server on Windows, run the uninstall.bat file. Then,
follow instructions in the installation wizard. The wizard does not uninstall the MS SQL
Server nor the BigFix server. These components need to be removed separately.
1. Log in to the computer where the BigFix Inventory server is installed as the same user
who performed the installation.
2. Go to the C:\Program Files\BigFix Enterprise\BFI\Uninstall
directory and run the uninstall.bat file. Start the uninstallation with the Run as
administrator option.
3. Follow instructions in the uninstallation wizard. When the uninstallation finishes, click
Done.
The BigFix Inventory server is uninstalled but the database, user logins, and passwords are
preserved. To remove them, delete the BigFix Inventory database. You can also remove the
BigFix server.
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Uninstalling the server on Windows in silent mode
To uninstall the BigFix Inventory server on Windows, edit parameters in the
uninstall_response.txt file, and run the uninstallation command. The command

does not uninstall the MS SQL Server nor the BigFix server. These components need to be
removed separately.
1. Log in to the computer where the BigFix Inventory server is installed as the same user
who performed the installation.
2. Go to the directory with the uninstallation response file, open the
uninstall_response.txt file, and edit the uninstallation parameters. By default,
the directory is C:\Program Files\BFI Enterprise\BFI\Uninstall.
3. Start the command line and run the following command.
uninstall.bat -f C:\Program Files\BFI
Enterprise\BFI\Uninstall\uninstall_response.txt -i silent

The BigFix Inventory server is uninstalled but the database, user logins, and passwords are
preserved. To remove them, delete the BigFix Inventory database. You can also remove the
BigFix server.
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Installing on Linux
A complete deployment of BigFix Inventory on Linux requires the installation of three
components: the BigFix platform, the BigFix Inventory server, and DB2 database.
Additionally, a BigFix client must be installed on every computer from which you want to
collect software inventory data. Depending on the environment size, you can install all
components on a single computer, or distribute them among multiple computers.
Figure 5. BigFix Inventory infrastructure

Step-by-step installation guide for Linux
Use the step-by-step installation guide to ensure that you complete all steps necessary to
successfully install BigFix Inventory on Linux.
Table 137. Step-by-step guide for installing and configuring BigFix Inventory
Stage
1.

Installation step
Plan the installation to ensure that the computer on which you want to install BigFix Inventory fulfills the fol
lowing requirements:
• Runs on a Detailed System requirements
• Fulfills the minimum hardware requirements
• Has sufficient disk space
• Has the required software installed

2

Install the BigFix platform

Table 137. Step-by-step guide for installing and configuring BigFix Inventory (continued)
Stage

Installation step
• Create the license authorization file
• Download the BigFix installer
• Install the BigFix server, console and the first client
• Install the BigFix client on every computer from which you want to collect software inventory data

Tip: You can install the clients at this point or proceed with the installation of BigFix Invento
ry and install the clients later on.
3

Install BigFix Inventory
• Install DB2
• Enable the BigFix Inventory fixlet site
• Install the BigFix Inventory server
• Perform initial configuration
• Verify the current application and catalog version

4

Create users and groups to give users access to BigFix Inventory and to define computers for which they
can see data.
• Set up users
• Set up computer groups

5

Set up scans to discover software and hardware inventory in your infrastructure.

Important: The steps are not required if you enabled the default scan configuration during the instal
lation.

• Optional: Distribute scans for improved performance
• Activate the required analysis
• Install the scanner
• Initiate software scans
• Schedule uploads of software scan results
• Collect capacity data

Installing the BigFix platform on Linux
The BigFix platform is the core of the BigFix Inventory infrastructure. It consists of a server
that coordinates the flow of data to and from the monitored computers, an administrative
console, and clients that collect data from the computers in your infrastructure. Before you
can install BigFix Inventory, install all components of the BigFix platform.
Important: Even if you set up entire environment on Linux, you need a Windows
computer on which you can install the BigFix console.
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Creating the license authorization file
After you order BigFix Inventory from Passport Advantage, you receive a welcome email
with information how to access the BigFix License Key Center. Go to the Key Center and
create the license authorization file that contains deployment and licensing information. The
file is needed during the installation of the BigFix platform.
1. Go to the License Key Center.
2. Enter your email address and the password that you received in the welcome email.

3. For each product that you purchased, specify the allocated client quantity. If you leave
0, you cannot install the particular product.
4. To generate the license authorization file, click Create Serial Number.
5. To download the file, click Download.
The LicenseAuthorization.BESLicenseAuthorization file is downloaded to your
computer. The file is needed during the installation of the BigFix platform.
Download the BigFix installer. For more information, see: Downloading the BigFix installer
for Linux.

Downloading the BigFix installer for Linux
To obtain the BigFix installer for Linux, log in to Passport Advantage and download the
required packages. If you are planning to install the BigFix platform and DB2 on a single
computer, download the package that contains installers for both applications. If you
are planning to install the components on separate computers, download the installers
separately.

1. Log in to Passport Advantage.
2. On the Navigation help tab, click Software download & media access.
3. In the lower part of the page, click BigFix Inventory.
4. In the window that opens, select your preferred operating system and language for the
installation packages.
5. In the lower part of the page, select Required, and click Download.
6. In the window that opens, select the download location, the preferred download
method, select I agree to the terms and conditions, and click Download Now.
7. On the page that opens, click the displayed links to download the BigFix packages.
Image

Description

BigFix_Pltfrm_Install_V95_L-

BigFix Platform Installer V9.5 for Linux

nx_DB2.tgz

and DB2 Multilingual

DB2_10.5.0.5_limited_Lnx_-

IBM DB2 Server V10.5.0.5 for Linux on

x86-64.tar.gz

AMD64 and Intel EM64T systems (x64)
Multilingual

For information about part numbers of the installation packages, see: BigFix 9.5.0 Download Information.
Move the installer to the computer on which you want to install the BigFix platform and start
the installation.

Installing BigFix on Linux
To install the BigFix platform on Linux, run the install.sh script and go through the
installation of the BigFix server, DB2 database, and the first BigFix client. Then, install the
BigFix console on a Windows computer.
The BigFix platform installed on Linux requires DB2 as a database. You can use an existing
instance of DB2 or install it together with BigFix.

The following procedure shows the most common installation scenario for Linux. If it does
not fit your environment, you need more information about each step, or other installation
tasks, see: Installing on Linux systems in the BigFix documentation.
1. Go to the directory with the installation package, and extract the installation files.
tar xvf installation_package

2. From the extracted directory, go to ServerInstaller_n.n.nnn.n-rhe6.x86_64,
and run the installation script.
./install.sh

3. To choose the production installation, enter 2.
Select the type of installation
[1] Evaluation: Request a free evaluation license from BigFix.
This license allows you to install a fully functional copy of the
BigFix on up to 1000 clients, for a period of 30 days.
[2] Production: Install using a production license or an authorization
1for a production license.
Choose one of the options above or press Enter to accept the default
value: [1]

4. To accept the license agreement, enter 1.
5. To install all BigFix components, enter 1.
Select the BigFix features you want to install:
[1]

All Components (server, client, and WebReports)

[2]

Server and client Only

[3]

WebReports Only

Choose one of the options above or press <Enter> to accept the default
value: [1]

6. To create a single or master database, enter 1.
Select the database replication:
[1]

Single or master database

[2]

Replicated database

Choose one of the options above or press <Enter> to accept the default
value: [1]

7. To use a local instance of DB2, enter 1.
Select the database:
[1]

Use a local database

[2]

Use a remote database

Choose one of the options above or press <Enter> to accept the default
value: [1]

8. Specify the installation location for BigFix.
Choose the server's root folder:
Specify the location for the server's root folder or
press <Enter> to accept the default value: /var/opt/BESServer

9. Specify the installation location for Web Reports.
Choose the WebReports server's root folder:
Specify the location for the WebReports server's root folder or
press <Enter> to accept the default
value: /var/opt/BESWebReportsServer

10. Enter the port number for Web Reports.
Since version 9.5.2, freshly installed Web Reports
is automatically configured to use HTTPS.
Choose the WebReports server's port number:
Specify the port number or press <Enter> to accept the default value:
8083

11. The installer checks if DB2 is installed on the server. To install it automatically from
the files that are bundled with BigFix, enter 1.
DB2 installation check
The installer does not detect if DB2 is installed on the system.
Specify which option corresponds to your installation:

[1]

DB2 is not installed, install it.

[2]

DB2 is installed, use the installed instance.

[3]

Exit from the installation.

Choose one of the options above or press <Enter> to accept the default
value: [1

12. Default settings containing DB2 users and installation path are listed. To accept them
and proceed with the installation, enter 1.
DB2 installation
DB2 will be installed using the following settings:
DB2 instance owner: db2inst1
DB2 fenced user: db2fenc1
DB2 administration server user: dasusr1
DB2 communication port: 50000
DB2 installation directory: /opt/ibm/db2/V10.5
If you want to use different value for these settings specify them
in the installation response file. Refer to the product documentation
for further details.
[1]

Proceed to install DB2.

[2]

Exit from the installation.

Choose one of the options above or press <Enter> to accept the default
value: [1]

13. Specify a password for the DB2 administrative users.
DB2 administrative user password:
Specify the password for the DB2 administrative users:

14. Enter the user name and password for the initial administrative user of BigFix or press
Enter to use the default IEMAdmin. This user is required to log in to the BigFix console.
15. To run the installation using a license authorization file, enter 1.
Choose the type of setup that best suits your needs:
[1]

I want to install with a BES license authorization file.

[2]

I want to install with a production license that I already have.

[3]

I want to install with an existing masthead.

Choose one of the options above or press <Enter> to accept the default
value: [1]

16. If you are not using a proxy, enter 2.
Proxy usage
[1]

Use the proxy to access the internet

[2]

Do not use the proxy

Choose one of the options above or press <Enter> to accept the default
value: [2]

17. Specify the location of your license authorization file.
License authorization location
Enter the location of the license authorization file that
you received from BigFix or press <Enter> to accept the default
value:
./license/LicenseAuthorization.BESLicenseAuthorization

18. Specify the DNS name or IP address of the server on which you are performing the
installation, or press Enter to accept the default value.
19. Specify the site admin private key password.
20. Specify the key size to encrypt the credentials.
Key size level
Provide the key size that you want to use:
[1]

'Min' level (2048 bits)

[2]

'Max' level (4096 bits)

Choose one of the options above or press <Enter> to accept the default
value: [2]

21. Specify the License folder in which the license file is to be generated and saved.
Choose the license folder:
Specify a folder for your private key (license.pvk), the license
certificate (license.crt),

and the site masthead (masthead.afxm) or press <Enter> to accept the
default value: ./license

22. Submit the request to BigFix to obtain the license certificate:
• If your server can access the internet, enter 1. The request will be submitted
automatically.
• If your server cannot access the Internet, enter 2, and submit the request
manually:
a. The request.BESLicenseRequest is generated and saved to a folder
with your license files. Copy this request to a computer with internet
access.
b. On the computer with internet access, go to BES License Request Handler
and submit the request file.
c. The license.crt file is saved to your computer. Copy it back to the
BigFix server.
d. Return to the installation and enter 1 to import the certificate and continue
with the installation.
23. Specify the value of the deployment encoding (FXF encoding) that will be used for the
content.
24. To accept the default masthead values, enter 1.
Advanced masthead parameters
The masthead will be created using the following defaults:
Server port number: 52311
Use of FIPS 140-2 compliant cryptography: Disabled
Gather interval: One Day
Initial action lock: Unlocked
Action lock controller: Console
Action lock exemptions: Disabled
Unicode filenames in archives: Enabled
The above default values are suitable for most of BigFix deployments.
[1]

Use default values

[2]

Use custom values

Choose one of the options above or press <Enter> to accept the default
value: [1]

25. To run Web Reports as a root, enter 1.
Use root user for WebReports
If you specify true, WebReports service will run with root privileges.
[1]

True

[2]

False

Choose one of the options above or press <Enter> to accept the default
value: [2]

26. When the installation is complete, install the BigFix console.
Important: The BigFix console is supported only on Windows.
a. Go to /var/opt/BESInstallers.
b. Copy the Console folder to a Windows computer.
c. On the Windows computer, run the setup.exe script, and follow instructions in
the installation wizard.
27. If you want to install the BigFix Inventory server on a different computer, install the
BigFix client on that computer.
You can proceed with the installation of the BigFix client on every computer from which you
want to collect software inventory data or with the installation of the BigFix Inventory server.
You can perform these tasks in any order.

Installing the BigFix clients
Install the BigFix client on every computer in your network that you want to monitor,
including the backup and recovery machines.

Installation methods
Methods for installing the clients vary depending on the operating system. Even if you install
the BigFix server on Linux™, you might need to install some of the clients on Windows™ if
your network consists of such computers. For more information, see:

• Installing clients on Windows™ computers
• Installing clients on Linux™ and UNIX™ computers
If you are not sure which installation method to choose, install the client manually.

Additional installation requirements
• If you are using HP Integrity VM, install the client on the virtual machines and their
host operating systems.
• If you are using Solaris Containers/Zones or Logical Domains (LDOM), install the
client in the global zone on the control domain and in other global zones. For more
information, see: Client installation on Oracle Solaris.

Installation packages
The BigFix installation image available on the Passport Advantage® contains client
installers. You can also download client installation packages from the BigFix® support
web page.
Important: Not all of the operating systems for which installation packages are
provided as part of the BigFix installation image are supported by BigFix Inventory.
For more information, see: Detailed System requirements.

Client vs scanner
The BigFix client is common for all BigFix products that are based on the BigFix platform,
and is used to perform various tasks on the endpoints. It provides information about a set
of computer properties like its host name or the IP address. It is also used to install the
scanner on the computers, and enables scanner management through fixlets.
The scanner is an independent component that is used by BigFix Inventory. It collects
information about the hardware, as well as the software that is installed on the computers
in your infrastructure. The data is sent to the BigFix server. You can then import it to the
BigFix Inventory server.

Apart from installing the BigFix client, install also the scanner on every computer that you
want to monitor to ensure that all necessary data is collected. For more information, see:
Setting up scans to discover software and hardware inventory.

Installing BigFix Inventory on Linux
Before you start the installation of BigFix Inventory on Linux, ensure that DB2 is installed in
your infrastructure. Then, enable a dedicated fixlet site in the BigFix console and download
the BigFix Inventory installer. Next, run the installation in interactive or silent mode.
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Installing DB2 for BigFix Inventory on Linux
BigFix Inventory that is installed on Linux requires DB2 database. You can install the
database on the same computer as the BigFix Inventory server or on a separate one.
You can also reuse the instance of DB2 that you installed for the BigFix platform. DB2
installation package is delivered together with BigFix Inventory.
The following scenario shows how to install DB2 that is delivered with BigFix Inventory.
If it does not fit your environment, you need more information about each step or other
installation options, see the documentation for DB2 11.5.
1. Go to the directory with the installation package, and extract the installation files.
tar xvf installation_package

2. From the extracted directory, run the installation script.
./db2setup

3. In the navigation bar of the DB2 Setup Launchpad, click Install a Product.

4. Scroll down, and click Install New under DB2 Workgroup Server Edition.
5. Read and accept the license agreement. Click Next.
6. Select the installation type, and click Next.
7. Select Install DB2 Server Edition on this computer and save my settings in a
response file, and click Next.
8. Specify the installation directory, and click Next.
9. Create a user for the DB2 Administration Server, and click Next.
10. Select Create a DB2 instance, and click Next.
11. Select Single partition instance, and click Next.
12. Create the DB2 instance owner. This user will be needed when you specify connection
details between BigFix and BigFix Inventory. Then, click Next.
13. Create the fenced user, and click Next.
14. Set up the DB2 server to send notifications or select the second check box to omit this
step. Then, click Next.
15. Review the settings, and click Finish. The installation is started.
16. When the installation is complete, add a license file to extend your license.
a. From the directory with extracted installation files, go to /db2/license.
b. Copy the db2wse_o.lic file to the home directory of the DB2 instance owner,
by default /home/db2inst1.
c. Open the terminal and switch the user to the DB2 instance owner.
su - db2inst1

d. Add the license file to your installation.
db2licm -a db2wse_o.lic

The installation of DB2 is complete. The default location is /opt/ibm/db2.

Enabling the fixlet site
A fixlet site is a collection of fixlets, tasks, and analyses that are related to a particular
BigFix application. To get access to the content that is specific to BigFix Inventory, enable
the application fixlet site. The procedure differs depending on whether the computer where
the BigFix server is installed has the Internet access or not.

Enabling the fixlet site with Internet access
If the BigFix server can access the Internet, enable the BigFix Inventory site from the BigFix
console. Then, subscribe computers that you want to monitor to this site so that its content
becomes applicable on these computers.
1. Log in to the BigFix console.
2. In the bottom-left corner of the console, click BigFix Management.

3. In the left navigation panel, click License Overview.

4. In the pane on the right, locate the entry called Inventory, and accept the license
agreement.
5. From the list of available sites, enable the BigFix Inventory v10 site.
The content of the site is downloaded to the BigFix server.
Tip: If there is no site called Inventory, select the site called IBM Endpoint
Manager for Software Use Analysis v9.
6. Subscribe all computers that you want to monitor to the fixlet site so that its content
becomes applicable to these computers.
a. In the bottom-left corner of the console, click All Content.
b. In the left navigation panel, expand Sites > External Sites, and open the BigFix
Inventory v10 site.
c. In the pane on the right, open the Computer Subscriptions tab, select computers
that you want to monitor. If you want to monitor the entire infrastructure, select
All Computers. Otherwise, specify appropriate filtering criteria.

Tip: If the option is not active, click Gather to download the content of
the fixlet site.

d. Click Save Changes.
You enabled the BigFix Inventory site and subscribed computers that you want to monitor to
this site.
Download the BigFix Inventory installer to a selected computer and start the installation.

Enabling the fixlet site without Internet access
If the BigFix server cannot access the Internet, use the Airgap tool to enable the fixlet
site. When the site is enabled and the content loaded, use the BES Download Cacher to
download and cache the files on the BigFix server.
To complete the following procedure, you need two computers:
• Linux computer on which the BigFix server is installed
• Windows computer with Internet access

1. Log in to a Windows computer with Internet access and download the Airgap tool. The
tool is available on the BigFix Enterprise Suite Download Center page.
Important: Ensure that the version of the Airgap tool that you download
corresponds with the version of your BigFix server.
2. Create a request file to obtain the list of fixlet sites to which you are entitled.
a. Log in to the Linux computer where the BigFix server is installed.
b. Go to the BigFix server installation directory, by default /opt/BESServer/bin,
and run the following command to start the Airgap tool.
./Airgap.sh -remotedir /directory

Where directory is the directory in which the airgap.tar file is created.
c. Extract the airgap.tar file.
tar xvf airgap.tar

d. Copy the extracted AirgapRequest.xml file to the Windows computer, and
place it in the folder that contains the downloaded BESAirgapTool.exe file.
e. On the Windows computer, run the BESAirgapTool.exe file. This action
exchanges the request file for a response file.
f. Copy the AirgapResponse file to the Linux computer, and place it in the /
opt/BESServer/bin directory.
g. Run the Airgap tool again on the Linux computer.
./Airgap.sh -run

3. Enable the BigFix Inventory site.
a. Log in to the BigFix console.
b. In the bottom-left corner of the console, click BigFix Management.

c. In the left navigation panel, click License Overview.

d. In the pane on the right, locate the entry called Inventory, and accept the license
agreement.
e. From the list of available sites, enable the BigFix Inventory v10 site.
Tip: If there is no site called Inventory, select the site called IBM
Endpoint Manager for Software Use Analysis v9.
4. To create a request file to load the content into the site, repeat step 2.
5. Subscribe all computers that you want to monitor to the BigFix Inventory fixlet site so
that its content becomes applicable to these computers.

a. Log in to the BigFix console.
b. In the left navigation panel, click Sites > External Sites > BigFix Inventory v10.
c. In the pane on the right, open the Computer Subscriptions tab, and select
computers that you want to monitor. If you want to monitor the entire
infrastructure, select All Computers. Otherwise, specify appropriate filtering
criteria. Click Save Changes.
The BigFix Inventory.efxm file is created on the server.
6. Cache the content of the fixlet site on the BigFix server.
a. On the computer where the BigFix server is installed, go to the install_dir/
BESServer/wwwrootbes/bfsites directory. Copy the BigFix
Inventory.efxm file to a Windows computer with Internet access, and place
it in the C:\BigFix directory.
b. In the C:\BigFix directory create a folder called downloads.
c. Run the BES Download Cacher with the following command:
BESDownloadCacher.exe -m "C:\BigFix\BigFix Inventory.efxm
-x C:\BigFix\downloads

The BES Download Cacher downloads approximately 1 GB of required files.
d. Optional: The default cache size is enough if you use only the BigFix Inventory
fixlet site. However, if you plan to run fixlets from other sites, such as BES
Support, increase the cache size so that the BigFix server does not try to delete
any files.
i. Log in to the BigFix console.
ii. In the left navigation panel, click Computers and right-click the computer
on which the BigFix server is installed. Then, click Edit Computer Settings.

iii. Increase the value of the _BESGather_Download_CacheLimitMB setting. If
the setting is not on the list, add it and specify the value in MB.
Tip: The size depends on each fixlet site, however you might need
to increase it to at least a couple of gigabytes.
e. Copy the contents of the downloads folder from the computer with Internet
access to the following directory on the computer where the BigFix server is
installed:
install_dir/BESServer/wwwrootbes/bfmirror/downloads/sha1

You enabled the BigFix Inventory fixlet site and loaded its content.
Download the BigFix Inventory installer to a selected computer and start the installation.

Installing the server on Linux
After you enable the fixlet site, download the BigFix Inventory installer, and proceed with the
installation. You can install the server in interactive or silent mode.

Installing the server on Linux in interactive mode
To install the BigFix Inventory server on Linux, download the application installer to a
selected computer and run the setup-server-linux-x86_64.sh script. Then, follow
instructions in the installation wizard.
• Ensure that the BigFix client is installed on the computer on which you want to install
the BigFix Inventory server.
• Ensure that the computer meets the following requirements:
◦ A graphical user interface is available
◦ X server is configured
◦ DISPLAY variable is set properly

• Start the installation as root. Otherwise, the server is not registered as a system
service.
• The use of sudo is not supported.
1. Download the BigFix Inventory installer.
a. Log in to the BigFix console.
b. In the navigation bar, click Sites > External Sites > BigFix Inventory v10 > Fixlets
and Tasks.
c. In the upper right pane, select Download BigFix Inventory, and click Take Action.
d. Select a computer to which you want to download the installer, and click OK.
The installer is downloaded to the /user/BFI_installer directory on the
selected computer. By default: /root/BFI_installer.
2. Log in as root to the computer where you downloaded the installer.
3. Go to the directory where the installer was downloaded, and extract the installation
files.
tar xvf BFI-server-version-timestamp-linux-x86_64.tar.gz

4. To start the installation, run the setup-server-linux-x86_64.sh script.
Tip: If the installation is slow, check the following items:
• Check the performance and speed of the hard disk.
• Check whether the antivirus is scanning each file separately as it might
slow down packaging. If this is the case, turn off the antivirus. If the
antivirus cannot be turned off, expect the installation to be slower.
5. Select the language of the installation, and click OK. The installation wizard starts, and
the welcome panel opens. Click Next.
If you cannot choose your language in the installation wizard, set the system locale to
a chosen language. For more information, see: Troubleshooting.
6. Read and accept the license agreement, and click Next.
7. Follow instructions in the wizard and provide the required installation parameters.

8. When the installation is complete, click Done to exit the wizard.
Tip: If you encounter problems during the installation, analyze the log file that
is in the $HOME\BFI9.2.16 directory.
The BigFix Inventory server is installed and the initial configuration opens in the browser. If
you do not have a browser installed or want to complete the configuration from a different
computer, go to: https://host_name:port, where host_name and port are the values that
you specified during the installation.
Complete the initial configuration.

TASK
Resuming a stopped or failed interactive installation
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Installing the server on Linux in silent mode
To install the BigFix Inventory server on Linux, download the application installer to a
selected computer, edit parameters in the install_response.txt file, and run the
installation command.
• Ensure that the BigFix client is installed on the computer on which you want to install
the BigFix Inventory server.
• Start the installation as root to register the server as a system service and to be able
to upgrade it later with a fixlet. Otherwise you can start the installation as non-root
user.
• The use of sudo is not supported.

1. Download the BigFix Inventory installer.
a. Log in to the BigFix console.
b. In the navigation bar, click Sites > External Sites > BigFix Inventory v10 > Fixlets
and Tasks.
c. In the upper right pane, select Download BigFix Inventory, and click Take Action.
d. Select a computer to which you want to download the installer, and click OK.
The installer is downloaded to the /user/BFI_installer directory on the
selected computer. By default: /root/BFI_installer.
2. Log in as root to the computer where you downloaded the installer.
3. Go to the directory where the installer was downloaded, and extract the installation
files.
tar xvf installation_package

4. Read the license agreement in the /user/BFI_installer/licenses/
LA_language.txt file.
5. Edit the install_response.txt response file and adjust it to your installation.
Ensure that the RSP_LICENSE_ACCEPTED parameter is set to true. If you do not
accept the license, the installation fails. For more information about installation
parameters, see: Server installation response file.
6. Change to the directory with installation files. To start the installation, run the
following command.
setup-server-linux-x86_64.sh -f response_file_path -i silent

Where response_file_path is the absolute path to the response file that you are using.
For example:
setup-server-linux-x86_64.sh
-f /root/BFI_installer/install_response.txt -i silent

Tip: Use the -h option to view help information about using the script, for
example: setup-server-linux-x86_64.sh -h.

Tip: If the installation is slow, check the following items:
• Check the performance and speed of the hard disk.
• Check whether the antivirus is scanning each file separately as it might
slow down packaging. If this is the case, turn off the antivirus. If the
antivirus cannot be turned off, expect the installation to be slower.
Access the BigFix Inventory user interface to complete the initial configuration. To access
the user interface, go to: https://host_name:port, where host_name and port are the
values that you specified during the installation.
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Server installation response file
The install_response file specifies input parameters that are used during the
installation of the BigFix Inventory server in silent mode.
Table 138. Response file parameters
Parameter key name

Description

RSP_LICENSE_ACCEPT Accepts the license agreement.
ED

Default
false

Table 138. Response file parameters (continued)
Parameter key name

Description

Default

The installation fails if you do not
change the value of the parameter
to true.
RSP_DISABLE_PRE

Disables prerequisite checking

false (warnings are

REQ_WARNINGS

warnings.

enabled)

If the server does not have enough
memory or processor cores, the
silent installation fails. You can
change this behavior by setting the
value of this parameter to true. The
installation can complete even if
the requirements are not fulfilled,
however insufficient resources
might impact performance.
RSP_TLM_ROOT

Specifies the installation location.

C:\Pro-

Specify an empty directory in which gram Files
\BigFix Enteryou want to install the server. If the
prise\BFI
directory does not exist, it is creat
ed.
RSP_TLM_HTTPS_PORT Specifies the port that is used by
the server.
If you do not specify the port num
ber, a default value is used. If the
selected port is already used by a
different application, the installa
tion fails.

/opt/BFI
9081

Table 138. Response file parameters (continued)
Parameter key name

Description

RSP_DISABLE_

Disables communication warnings.

COMMUNICATION_

If any of the ports that you speci

WARNINGS

Default
false

fied in the RSP_TLM_HTTPS_PORT
is locked by another application,
silent installation fails. To specify
a port that is temporarily used but
will be available later, set the RSP_
DISABLE_COMMUNICATION_
WARNINGS parameter to true.

RSP_USER_AC Specifies the user account for run
COUNT

ning the application service.
The User Account Control in Win
dows must be reduced or disabled.
Otherwise, it might block the ser
vice from starting.
If you leave the value current, the
service runs under the NT AUTHORITY\SYSTEM user, which has all re

quired rights. If you specify a differ
ent user, ensure that the following
requirements are met:

current

Table 138. Response file parameters (continued)
Parameter key name

Description

Default

• The user has the log on as a
service right and administra
tive privileges.
• The user is entered as
domain\username, machine\username, or .\username if it is a local account

Important: To use Windows
authentication to access
the database, the service
owner chosen here must
be available both to BigFix
Inventory and the relevant
database server for which
you use this authentication.
For local databases, you
can use current, but for re
mote ones it must be a do
main user that is shared be
tween the two servers.
RSP_USER_AC Specifies the password of the user
COUNT_PWD

account for running the application
service.

Performing initial configuration on Linux
During the initial configuration, you create a BigFix Inventory database and the application
administrator. You also set up a connection to the BigFix server and database. Optionally,

you can configure a connection to the Web Reports database to give the Web Reports users
access to BigFix Inventory.
• To reuse DB2 that you installed for BigFix with BigFix Inventory, increase the number
of active databases to at least 3. To increase the number, log in as the DB2 instance
owner, and run the following command. Then, restart the database server.
db2 update dbm cfg using NUMDB number_of_active_databases

1. Create the BigFix Inventory database.
• If the DB2 server is installed on the same computer as the BigFix Inventory
server, perform the following steps.
a. Select The application and the database are on the same computer. The
host name, port number, and the default name of the database are filled in
automatically. If you want to specify a different name of the database, you
can choose any name that meets the DB2 naming requirements.
b. Provide credentials of the operating systems user that will be used for
connecting to the database. The user can be an instance owner.
Tip: Create a dedicated user for connecting to DB2. The user
receives access required by BigFix Inventory automatically by
the application script. It is not recommended to configure the
authorities manually. To allow the application work, authorities,
such as DBADM, DATAACCESS, and ACCESSCTRL are required.
c. To create the database, click Create.
• If the DB2 server is installed on a different computer than the BigFix Inventory
server, perform the following steps.
a. Clear The application and the database are on the same computer check
box.
b. Provide the host name and port number of the computer where the DB2
server is installed, and specify the name for the application database. You
can use the default name or choose any name that meets the DB2 naming
requirements.

c. Provide credentials of the operating systems user that will be used for
connecting to the database. The user can be an instance owner.
Tip: Create a dedicated user for connecting to DB2. The user
receives access required by BigFix Inventory automatically by
the application script. It is not recommended to configure the
authorities manually. To allow the application work, authorities,
such as DBADM, DATAACCESS, and ACCESSCTRL are required.
d. To download a script that is used for creating the database, click
Download Script.
e. Move the script to the computer where the DB2 server is installed and run
it. The script creates a database that can be accessed by the user that you
specified in substep c.
Important: The user who runs the script must have the SYSADM
authority. You can use the DB2 instance owner.
f. When the database is created, return to the computer on which you are
configuring BigFix Inventory, and click Create.
2. Create the administrator of BigFix Inventory.
Tip: Avoid using admin, administrator, root or a similar name for the
administrative account. Such an account might be prone to hacker attacks
and locked out if an attacker exceeds the specified number of failed login
attempts. For more information, about the account lockout, see: Configuring
user account lockout.

3. Optional: To automatically enable scans that collect data from the computers in your
infrastructure, select Enable default scan schedule for this data source.
If you enable the default scan schedule, actions that are needed to collect data from
the computers in your infrastructure are automatically started on the BigFix server.
This option is advised for environments with up to a few thousand computers. For
larger environments, finish the installation, divide the computers into groups, and then
manually set up scan schedule for each group to avoid performance issues. For more
information about the default and manual scan schedule, see: Setting up scans to
discover software and hardware inventory.
4. Configure the connection to the BigFix database. The database stores information
about the computers and data that was discovered on these computers. Specify the
host, port, database name, and credentials of the user that can access the BigFix
database.

5. Configure the connection to the BigFix server. The host name or IP address, and the
API port number are automatically retrieved from the database. Specify only the
administrative user that you created during the installation of BigFix.

Note: If you do not want to provide the Master Operator, you can create a
dedicated BigFix user that fulfills the following requirements:

• Is assigned the BigFix Inventory v10 site
• Is assigned computers that you are going to monitor, and the computer
where the BigFix server is installed
• Has the following permissions: Can use REST API, Can use Console,
Custom Content, Can Create Actions
The option is supported starting from BigFix 9.5.
6. Optional: If the BigFix and BigFix Inventory servers are in separated networks, the
automatic address lookup might return incorrect address. To disable the lookup,
select Disable automatic address lookup, and specify the address manually. Then,
configure additional environment variables on the BigFix Inventory server. For more
information, see: Configuring servers in separate networks.
7. Optional: Configure the connection to the Web Reports database. Specify the
database type, host name, database name, and credentials of the Web Reports
database user.

8. To create connections to the databases, click Create.

When the connections are created and configured, a new page opens and a message
about the data import is displayed.
9. Optional: If your environment consists of more than 50 000 endpoints, complete
steps to enhance the application performance before you run the import.
10. To run the initial import, click Import Now.
The import might take a few hours, depending on your hardware capacity.
If you enabled the default scan schedule, the collected data might not be displayed in BigFix
Inventory after the initial import. Some time is required to finish scans that were initiated
during the installation, and to upload scan results to the server. If the reports in BigFix
Inventory do not contain any data, wait about an hour until the scans are completed. Then,
start another import.
If you did not enable the default scan schedule, manually configure scans to collect data
that is later on displayed on the reports.
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Uninstalling on Linux
To remove BigFix Inventory from your infrastructure, stop the application-specific actions
and analyses that are running on the computers and uninstall the scanner. Then, remove
the VM Manager tool. Finally, uninstall the BigFix Inventory server. You can also remove the
related database.

Uninstalling the server on Linux in interactive mode
To uninstall the BigFix Inventory server on Linux, run the uninstall.sh script file. Then,
follow instructions in the installation wizard. The wizard does not uninstall DB2 nor the
BigFix server. These components need to be removed separately.
1. Log in to the computer where the BigFix Inventory server is installed as root.
2. Go to the /opt/BFI/Uninstall directory, and run the uninstall.sh script.

3. Follow instructions in the uninstallation wizard. When the uninstallation finishes, click
Done.
The BigFix Inventory server is uninstalled but the database, user logins, and passwords are
preserved. To remove them, log in as the DB2 instance owner on the computer where the
database is installed, and run the following command.
db2 deactivate db database_name
db2 drop db database_name

Where database_name is the name of the BigFix Inventory database, by default TEMADB. You
can also remove the BigFix server.
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Uninstalling the server on Linux in silent mode
To uninstall the BigFix Inventory server on Linux, edit parameters in the
uninstall_response.txt file, and run the uninstallation command. The command does
not uninstall DB2 nor the BigFix server. These components need to be removed separately.
1. Log in to the computer where the BigFix Inventory server is installed as root.
2. Go to the /opt/BFI/Uninstall directory, open the uninstall_response.txt
file, and edit the uninstallation parameters.
3. Start the command line and run the following command.
uninstall.sh -f /opt/BFI/Uninstall/uninstall_response.txt -i silent

The BigFix Inventory server is uninstalled but the database, user logins, and passwords are
preserved. To remove them, log in as the DB2 instance owner on the computer where the
database is installed, and run the following command.

db2 deactivate db database_name
db2 drop db database_name

Where database_name is the name of the BigFix Inventory database, by default TEMADB. You
can also remove the BigFix server.
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Installation-related tasks
If you encounter problems during the installation, you can check details related to the
problem, fix it, and then resume the installation. If the BigFix and BigFix Inventory servers
are in separated networks, you can disable the automatic address lookup to avoid problems
with initial configuration. Learn how to check the current application and catalog version to
make sure that your installation and initial configuration were successful.

Resuming a stopped or failed interactive installation
You can rerun the interactive installation during the pre-installation and installation stages.
You can also use a built-in function to diagnose problems during the installation of the
BigFix Inventory server.
There are different ways to rerun the installation and the solution depends on the phase
during which the problem occurred. If an error occurs during the pre-installation phase, you
can restart the installation and no additional actions are required. If you encounter an error
during the installation phase, you have two options:
• You can remove the installation directory before you restart the installation
• You can use a built-in function to diagnose and fix the problem

Some configuration steps in the installation depend on other steps. If one of them fails,
the execution of the dependent step is also held. If an error occurs, the installation wizard
continues running steps that do not depend on the failed one. You can see the list of
prerequisites for any step in the step properties dialog. To open the dialog, double-click the
step, or right-click it and select Details.
You can continue the installation and fix the problem at the end of the installation. You
can also end the installation and resolve the problem later, at a convenient time. It is not
necessary to specify any special options. It is enough to run the installation wizard again.
It detects that the previous configuration attempt failed or was interrupted and starts
automatically in resume mode.
If you exited the installation wizard, run it again. It automatically starts the configuration.
1. If you encounter a problem, double-click the line that contains the step name, or rightclick it and select Details. The line is indicated by a red icon.

2. Review the most important information that is displayed in the top. If a dedicate log
file exists, its location is shown.

3. Review the information that is shown on the Standard Output tab or, if applicable, on
the Dedicated Log tab to determine the cause of the problem.
Important: To reduce the performance load on the computer, the function that
captures the dedicated log file runs with the lowest possible priority. Thus,
the Dedicated Log tab does not always present the most recent and detailed
information. What is more, the end of the log file might not be shown. If a
failure occurs, check either the dedicated log whose location can be found in
the step description, or the msg_server.log file.
4. Fix the problem.
5. On the installation panel, right-click the line that shows the problem, then click Set >
Ready (rerun the step).
The installer completes the step and the remaining dependent steps. If you run the
failed step outside the installation wizard, mark the step as completed successfully.

Note: If you cannot diagnose the problem and rerun the step manually,
uninstall the product and try to install it again.
6. Click Next. The Post-installation Summary opens with information about installed
components.

Configuring servers in separate networks
When the BigFix and BigFix Inventory servers are installed in separate networks, automatic
lookup of their IP addresses might not work correctly. It might happen, for example in
networks that use network address translation (NAT). To ensure that IP addresses of
the servers are correct and the communication between them works, change the default
settings, and manually enter the IP addresses or domain names of the servers.
By default, the address of the BigFix server is automatically retrieved from the database.
In case of separate networks, the address might contain a local address of the server that
cannot be recognized outside of its network. After you specify the IP address of the BigFix
server, you also need to specify the correct address of the BigFix Inventory server to allow
the BigFix server to access the software catalog.
1. During the initial configuration of BigFix Inventory, while specifying the connection
details of the BigFix server, select Disable automatic address lookup, and enter the
host name of the BigFix server. The address is always created based on the provided
host name and port number.
Note: To access this panel after the installation, log in to BigFix Inventory, and
click Management > Data Sources.

Tip: To check whether the BigFix host is correct, access the following
URL from the BigFix Inventory network: http://hostname:port/
UploadReplication. Expected message: Error: no query parameters
specified.

2. On the computer where the BigFix Inventory server is installed, add an environment
variable with new addresses that will be used by the BigFix server to access the
software catalog.
a. Go to one of the following directories, and create the server.env file.
•

install_dir/wlp/usr/servers/server1

•

install_dir\wlp\usr\servers\server1

b. Add the following variable to the file:

SERVER_URL_CATALOG=https://IP_address:port
IP address of the BigFix Inventory server that the BigFix server
uses to obtain the software catalog and deliver it to the clients.
This catalog is then used during the catalog-based software scan.
3. Restart the BigFix Inventory server.

Verifying the current version of and the software catalog
Check the current version of and the software catalog to make sure that the installation
was successful.
1. Log in to .
2. Check the current version of the server.
a. Hover over the Help icon

, and click About.

b. Check the version number in the About window.

3. Check the version of the software catalog.

a. Go to Management > Catalog Upload.
b. Check the version of the catalog under Catalog Version Information and make
sure it is the latest available.

Configuring
After you install BigFix Inventory, configure the application. Create accounts for the users
who need access to the application and set up scans to collect software and hardware
inventory data from your environment.

Creating users and groups
Each user who has access to BigFix Inventory must be assigned a role and a computer
group. The role defines which reports and panels the user can view. The computer group
narrows down the scope of these reports and panels to computers that meet certain
criteria.

Setting up roles
A role is a collection of permissions that correlates to a list of privileges. Each user
is assigned a role according to the privileges the user needs to efficiently operate the
application. BigFix Inventory comes with a set of predefined roles. However, you can also
create custom roles according to your needs.
You must be an Administrator to perform this task.
The Administrator role is set by default and cannot be modified.
1. In the top navigation bar, click Management > Roles.
2. To add a role, click New.
3. Specify the name and permissions that you want the new role to have, and click
Create.
You created a custom user role. You can now create users and assign them suitable roles.

Task
Setting up users

Roles
You can create a set of roles in BigFix Inventory and assign each of them with different
permissions. Then, you can assign those roles to particular users, thus making them
responsible for different actions. By setting up correct roles, you can easily establish which
user has access to particular functions in BigFix Inventory. The roles can be assigned by the
Administrator.

Pre-configured roles
BigFix Inventory has six preconfigured roles: Administrators, Auditors, Catalog Managers,
Contract Managers, Software Asset Managers, and Infrastructure Administrators. Each
of these roles has a different set of permissions that allow the users to perform various
actions. The Administrator can edit or delete those roles, or create new ones and assign
them permissions of your choice. The following table lists the preconfigured roles and their
permissions.
Table 139. Roles preconfigured in BigFix Inventory and their permissions
The table consists of seven columns and 24 rows.
Infras
Admin
Permission
Display Preview

istrator

Catalog
Auditor

Contract

Software

tructure

Asset

Admin

Manager Manager Manager

istrator

Yes

Panels
Edit Server Configu

Yes

ration
Manage Catalogs

Yes

Manage Computer

Yes

Groups

Yes
Yes

Table 139. Roles preconfigured in BigFix Inventory and their permissions
The table consists of seven columns and 24 rows.
(continued)
Infras
Admin
Permission
Manage Computer

istrator

Catalog
Auditor

Contract

Software

tructure

Asset

Admin

Manager Manager Manager

istrator

Yes

Properties
Manage Contracts

Yes

Manage Data

Yes

Yes

Sources
Manage Directory

Yes

Servers
Manage Hardware

Yes

Inventory
Manage Imports

Yes

Manage Licenses

Yes

Manage Package

Yes

Yes
Yes

Yes

Yes
Yes

Properties
Manage Part Num

Yes

Yes

Yes

Yes

bers Uploads
Manage Roles

Yes

Manage Scan Con

Yes

Yes

figurations
Manage Software
Classification

Yes

Yes

Table 139. Roles preconfigured in BigFix Inventory and their permissions
The table consists of seven columns and 24 rows.
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Infras
Admin
Permission

istrator

Manage Support Da

Yes

Catalog
Auditor

Contract

Software

tructure

Asset

Admin

Manager Manager Manager

istrator

ta
Manage Uploads

Yes

Manage Usage

Yes

Yes

Yes

Yes
Yes

Properties
Manage User Provi

Yes

sioning
Manage Users

Yes

Manage VM Man

Yes

Yes

agers and Servers
View Audit Trail

Yes

Yes

Yes

View Catalog Audit

Yes

Yes

View Contracts

Yes

Yes

View Endpoints

Yes

Yes

View Hardware In

Yes

Yes

Yes

Yes

Yes

Yes

View Raw Data

Yes

Yes

Yes

Yes

View Shared Disks

Yes

Yes

Yes

Yes

Yes

Yes

Yes
Yes

Yes

Yes

Yes

Yes

Yes

Yes

ventory
View License Met
rics
Yes

Table 139. Roles preconfigured in BigFix Inventory and their permissions
The table consists of seven columns and 24 rows.
(continued)
Infras
Admin

Catalog

Permission

istrator

Auditor

View Software Cata

Yes

Yes

Yes

Yes

Contract

Software

tructure

Asset

Admin

Manager Manager Manager
Yes

Yes

istrator

Yes

log and Signatures
View User Details

Yes

Permissions
The following list describes permissions that are available in BigFix Inventory. Find out
about each of them so that you can tailor the roles to your needs.
Important: Some of the permissions are specific only for the Administrator and
cannot be assigned to other users. These permissions include:
• Display Preview Panels
• Edit Server Configuration
• Manage Computer Properties
• Manage Data Sources
• Manage Directory Servers
• Manage Roles
• Manage Support Data
• Manage User Provisioning
• Manage Users

Table 140. Permissions
Permission

Comments

Display Preview Panels

The user can enable preview features.

Edit Server Configura

The user can change settings of the BigFix Inventory server.

tion
Manage Cata The user can edit catalog servers, update the catalog as
logs

well as create, edit, and delete the content of the custom
software catalog.
The user can edit the end of support date for soft
ware components.
The user can add and remove tags on the select
ed reports.

Manage Computer

The user can create, edit, and delete computer groups.

Groups
Manage Computer Prop The user can specify additional computer properties that
erties

are to be gathered from the computers in the infrastructure.

Manage Contracts

[The user can create, edit, and delete contracts.
The user can set or edit the license threshold to
be notified about excessive license consumption.
The user can add, edit, and delete custom fields.]
-

This permission is deprecated since Big-

Fix Inventory version 10.0.5.

The user can manage new contracts and manage li
cense metrics.
Manage Data Sources

The user can add, edit, and delete BigFix servers that are
used as data sources by BigFix Inventory.

Table 140. Permissions (continued)
Permission

Comments

Manage Directory

The user can add, edit, and delete directory servers that are

Servers

used for authentication of BigFix Inventory users.

Manage Hardware In

The user can change the Oracle core factor or the PVU per

ventory (previously:

core value that is assigned to a processor.

Manage PVU per Core)
Manage Imports

The user can schedule imports of data, and run them manu
ally.

Manage Li
censes

The user can add custom part numbers and new products
to the software catalog, and assign additional license met
rics to products.

Manage Package Prop

The user can create, edit, and delete application properties

erties

that are used to recognize software in your infrastructure.
Manage Part

The user can manage uploads of the part numbers file.

Numbers Uploads
Manage Roles

The user can add, edit, and delete roles that are available in
BigFix Inventory.

Manage Scan Configura The user can schedule software scans.
tions
Manage Software Clas

The user can reassign software instances between differ

sification

ent products, include or exclude them in pricing calcula
tions, and share them between more than one product.
Manage Sup

The user can access the Computer Support Data panel.

port Data
Manage Uploads

The user can manage uploads of the software catalog, and
metric tables.

Table 140. Permissions (continued)
Permission

Comments

Manage Usage Proper

The user can create, edit, and delete application properties

ties

that gather information about the use of software in your in
frastructure.

Manage User Provision

The user can integrate users from a directory server with

ing

BigFix Inventory.

Manage Users

The user can add, edit, and delete users that exist in BigFix
Inventory.

Manage VM Managers

The user can create, edit, and delete VM managers.

and Servers
View Audit Trail

The user can view the Audit Trail report that contains the
history of all actions performed by users.

View Catalog Audit

The user can view information about changes to the cus
tom software catalog.

View Contracts

The user can view contract usage data. - This
permission is deprecated since BigFix Inventory
version 10.0.5

The user can view new contracts.
View Endpoints

The user can view information about the installed software
as well as scan, registry, and raw data from endpoints.

View Hardware Invento

The user can view the details of the processors that are

ry

used by the software.

View License Metrics

The user can view the list of all software products that are
contained in the PVU License Usage reports, the license
type and usage for each product, the history of license con
sumption over the specified time period, and the top license
consuming products.

Table 140. Permissions (continued)
Permission

Comments
The user can view values that are specified in
custom fields.

View Raw Data

The user can view:
• Metering Data report that contains information about
the use of the software items
• Unrecognized Files report that shows a ranking of the
most frequently encountered files
• Scanned File Data report that provides information
about all files that are detected by the software inven
tory tool scanner
• Package Data report that contains information about
all installed packages

View Shared

The user can view information about shared disks that are

Disks

used in the infrastructure.

View Software Catalog

The user can view the software catalog and signatures.

and Signatures
View User De
tails

The user can view information about current software users
and their details for the software that is installed on the
computers in the infrastructure.

Setting up users
Create users to give access to BigFix Inventory. Assign each user with a role to determine
permissions that the user has, and with a computer group to determine the computers to
which the user has access.
You must be an Administrator to perform this task.

If your company has a security policy for passwords and account management, the
password authorization mechanism that is available in BigFix Inventory should be used only
for the initial setup.
Starting from application update 9.2.7, you can configure BigFix Inventory to
ensure that user passwords fulfill a number of requirements. For more information, see:
Configuring security policy for user passwords. If you are using an earlier version of the
application, or your password policy cannot be met by configuring the available password
requirements, use LDAP or single sign-on. For more information, see: Authenticating users
with LDAP or Configuring and enabling single sign-on (SSO).
1. In the top navigation bar, click Management > Users.
2. To add a user, click New.
3. Specify the name of the user and the role that you want to assign to that user.
4. Select the computer group to which the user is to have access and the authentication
method. Then, click Create.

Task
Setting up roles

Setting up computer groups
Computer groups can be used to narrow down the scope of reports to computers that meet
certain criteria or to share software discovered on one computer among all computers in
the group, for example when a shared disk is mounted on multiple computers.
You must have the Manage Computer Groups permission to create a reporting computer
group. You must be an Administrator to create a software template group.
Note: Creating more than 20 computer groups may impact the data import
performance.

Computer groups can be created in the BigFix console or in BigFix Inventory. The groups are
not automatically copied between the applications. However, groups created in the BigFix
console can be recreated in BigFix Inventory as described in step 4 below.
Groups created in the BigFix console are used to manage the infrastructure, assign
computers to fixlet sites, and run fixlets against selected computers. Groups created in
BigFix Inventory have two types:
• Reporting: This type is used to narrow down the scope of reports to computers that
meet certain criteria. Such a group can have subgroups and can be assigned to users.
It can be also used to assign contracts as well as upload part numbers to a subset of
computers.
• Software template: This type is used only to share software discovered on one
computer among all computers in the group.
The following procedure describes how to create a computer group in BigFix Inventory. For
information about creating computer groups in the BigFix console, see: Computer groups.
1. In the top navigation bar, click Management > Computer Groups
2. To create computer group, click New.
3. Provide the name and description of the computer group.
4. Specify filters according to which computers are assigned to the group, and click
Create.
You can also create a group that is based on a computer group in the BigFix console.
Choose Data Source Groups, in set, and select the computer group that you want to
recreate.
To view all the groups that are available in the BigFix console, ensure that you run a
successful import of data.
Restriction: The size of data returned by the specified filter cannot exceed 1
MB.
BigFix Platform 10.0.4 allows you to create server based computer
groups. For more information, see Creating Server Based Computer Groups.

Tip: Upgrade BigFix Inventory before you create server based
computer groups. If you create a server based group in BigFix
Platform before installing BigFix Inventory 10.0.5 or higher, you
might need to enforce full synchronization of DataSource Group
membership information. Execute the below query to reset the
sequence in the BigFix Inventory database:
• MS SQL
update dbo.datasource_sequences
set last_sequence=0x0 where
class_name='DatasourceGroupFixletResult'

• DB2
update dbo.datasource_sequences set
last_sequence=cast('0' as BLOB) where
class_name='DatasourceGroupFixletResult'

Next import will extend duration of this step.

5.

Choose the type of the computer group.
• Choose Reporting to create a group used for limiting the scope of computers
visible on reports.
a. Specify whether you want to calculate usage of license metrics for this
computer group. If you are not interested in this information, you can
disable these calculations to improve import performance,especially in
larger environments.
◦

For version 10.0.0 and higher, select Enable license
usage calculations to calculate usage of all license metrics that are
supported by .

◦

For versions 9.2.5 to 9.2.17, select license metrics for
which you want to calculate utilization in this computer group.

b.

Specify the number of days for which the data is to be
calculated. This number defines the default period for which the data that
is show on the All IBM Metrics report is calculated and up-to-date.
For example, when you set the value to 30 days, and then display a report
for the last 90 days, the report shows the following data:
◦ If you display the report for a newly created computer group, the
report shows values for the last 30 days and is empty for the rest of
the period.
◦ If you display the report for an existing group, the values might be
outdated.
In both cases, recalculate the data.

c. Optional:

To configure scans for this computer group, select

Create scan configuration. Choose the scan frequency, requested start
date, and types of software scans that you want to run on the computers
in this group.
The option is available only if the definition of the group uses the Data
Source Groups filter as the only condition based on which computers are
assigned to this group. For more information about configuring scans
from the BigFix Inventory user interface, see: Changing scan configuration
from the BigFix Inventory user interface.
• Choose Software Template to create a group used for sharing software
discovered on one computer among all computers in the group. Such a group
can be used for example to ensure that software discovered on a shared disk is
reported on all computers on which the disk is mounted. Then, select software
templates that you want to share between computers in this group.

6. To save the computer group, click Create.
7. To make the computer group available in BigFix Inventory, wait for the scheduled
import or run it manually.
After you create a computer group, and run the import, you can view reports narrowed down
to the computers that belong to this group. To do this, go to Reports > Computer Groups,
and select a computer group. Then, from the upper left corner, select the report that you
want to view for this computer group.

Setting up scans to discover software and hardware
inventory
The scanner is an independent, well-defined component that is used by BigFix Inventory. It
is installed and managed through the BigFix client, and it enables the software and capacity
scans. Software and capacity scans collect data that is later on displayed on the BigFix
Inventory reports. For environments with up to a few thousand computers, you can enable
the default scan configuration. In this case, the analyses are activated and software and
capacity scans as well as uploads of their results are scheduled automatically on the
computers that are subscribed to the BigFix Inventory site. For larger environments, it is
advisable to divide the computers into groups and manually configure a separate scan
schedule for each group to avoid performance issues.

Frequency of scans and uploads of data
By default, software and capacity scans are scheduled with a frequency that meets auditing
requirements. If you want to change the default frequency, ensure that the new setup fulfills
the minimal requirements and all considerations.

Frequency of scans
Table 141. Frequency of scans
Type of

Default

Minimal

the scan

frequency

frequency

Capacity

Every 30

Every 30

In case of subcapacity reporting, it is necessary

scan

minutes

minutes

to capture configuration of vCPU to count the

Comments

maximum capacity of processor cores for each
program concurrently. To ensure that dynamic
changes of the vCPU configuration are captured,
the capacity scan must run every 30 minutes.
You can change the frequency of the scan only if
you use BigFix Inventory for purposes other than
subcapacity reporting.
For information about scheduling the scan, see:
Initiating the capacity scan on all computers.
Software

Once per

Once per

You can adjust the frequency of the software

scan

week

month

scan to the dynamics with which software inven
tory changes in your environment. For informa
tion about scheduling the scan, see: Initiating
software scans.

Scan of

Every 30

Every 30

In case of subcapacity reporting, it is necessary

VM man

minutes

minutes

to capture mobility of VMs. To ensure that it is

agers

captured, data from VM managers must be col
lected every 30 minutes. You can change the fre
quency of collecting data only if you use BigFix
Inventory for purposes other than subcapacity
reporting.

Table 141. Frequency of scans (continued)
Type of

Default

Minimal

the scan

frequency

frequency

Comments
For information about scheduling the scan, see:
Adding VM managers for VMware, Hyper-V, KVM
with RHV-M, Citrix Hypervisor and Nutanix.

Shared

Once per

Once per

For information about scheduling the scan, see:

disks scan week

month

Discovering software on shared disks.

Discon

Every 30

Every 30

In case of subcapacity reporting, it is necessary

nected

minutes

minutes

to capture configuration of vCPU to count the

capacity

maximum capacity of processor cores for each

scan

program concurrently. To ensure that dynamic
changes of the vCPU configuration are captured,
the capacity scan must run every 30 minutes.
You can change the frequency of the scan only if
you use BigFix Inventory for purposes other than
subcapacity reporting.
The scan is triggered and scheduled automati
cally after you install the disconnected scanner.
For more information, see:
• IBM i: Installing the scanner and gathering
initial data on IBM i systems
• Other platforms: Installing the scanner
and gathering initial data

Discon

On de

Once per

You can adjust the frequency of the software

nected

mand

month

scan to the dynamics with which software inven

software

tory changes in your environment.

scan

For information about scheduling the scan, see:

Table 141. Frequency of scans (continued)
Type of

Default

Minimal

the scan

frequency

frequency

Comments
• IBM i: Running software scans and gather
ing scan results on IBM i systems
• Other platforms: Running software scans
and gathering scan results

Detailed

On de

This type of the scan is not required for audit

hardware

mand

ing purposes. Running this scan once per week
or less frequently is sufficient to collect detailed

scan

hardware inventory.
For information about scheduling the scan, see:
Detailed hardware scan.

Frequency of uploading scan results
Upload of data from the scanned computer to the BigFix server occurs according to a
frequency that is specific to the type of the scan. The data is then uploaded from the BigFix
sever to the BigFix Inventory server during the import. In case of the disconnected scans,
the data is uploaded directly to the BigFix Inventory server. It is not stored on the BigFix
server.
Table 142. Frequency of uploading scan results
Summary for complex table
Type of up

Default fre

loaded results

quency

Capacity scan

Comments

When results

Upload of capacity scan results is scheduled

change in com

automatically when you schedule the capacity

parison to the re

scan.

Table 142. Frequency of uploading scan results
Summary for complex table
(continued)
Type of up

Default fre

loaded results

quency

Comments

sults of the previ
ous scan.
Software scan

When results

For information about scheduling the upload,

change in com

see: Uploading software scan results.

parison to the re
sults of the previ
ous scan.
VM managers da Every 12 hours

Upload of results from VM managers is sched

ta

uled automatically when you configure connec
tion to VM managers.

Disconnected ca On demand

Results of disconnected capacity and software

pacity scan

scans are imported directly to the BigFix Inven

Disconnected

On demand

software scan

tory server. They should be imported immedi
ately after new results of the software scan are
available.
For more information, see:
• IBM i: Importing scan results from IBM i
systems to BigFix Inventory
• Other platforms: Importing scan results
to BigFix Inventory

Detailed hard
ware scan

Once per day

Results of the deep hardware scan are gath
ered daily by the Detailed Hardware Informa
tion analysis.

Table 142. Frequency of uploading scan results
Summary for complex table
(continued)
Type of up

Default fre

loaded results

quency

Comments
For more information, see: Detailed hardware
scan.

Default scan configuration
Default scan configuration is advised for environments with up to a few thousand
computers. It ensures that the required analyses are activated and software and capacity
scans as well as uploads of their results are scheduled automatically. These actions are
necessary to collect data from the computers in your infrastructure and to display it on
the BigFix Inventory reports. You can enable the default scan configuration during the
configuration of BigFix Inventory connections to the databases or when adding another data
source.

What happens automatically
When you enable default scan configuration, the following actions are automatically
activated and scheduled on each computer that is subscribed to the BigFix Inventory site.
The same configuration is also automatically applied to all computers that are subscribed
to the BigFix Inventory site at a later time.
• The following analyses are activated:
◦ Application Usage Statistics
◦ Capacity Configuration for Linux on z Systems
◦ Installed UNIX Packages
◦ Installed Windows Applications
◦ Scanner Information
◦ Software Scan Status
◦ VM Manager Information
• The scanner is installed.

• All types of software scans and uploads of their results are scheduled.
• Capacity scans and uploads of their results are scheduled.
Additionally, when you enable the default scan configuration for the second and successive
data sources that you add, the software catalog is distributed to the computers on condition
that it was successfully uploaded and imported for the first data source.

What to do next
• After you enable the configuration, run the import of data. The data that is collected
from the computers in your infrastructure should be displayed on the BigFix Inventory
reports. However, the newly set-up environment needs time to finish the scans and to
upload their results to the server. If the reports do not contain any data after the first
import, wait about an hour until the scans are completed. Then, run another import.
To change the default scan configuration, use the Scan Configurations panel.
Alternatively, you can change the scan configuration through the BigFix console by
using the Initiate Software Scan fixlet.
• Add VM managers that are an important and mandatory addition to the capacity scan.
These are the hosts that manage your virtual machines. BigFix Inventory can already
evaluate the virtual capacity of your environment, but needs extra data about the
physical one to accurately calculate your subcapacity consumption. This data can be
collected only from VM managers.

Changing scan configuration from the BigFix Inventory user
interface
Available from 9.2.3. The Scan Configurations panel allows for basic scan
management directly from the BigFix Inventory user interface. Use the panel if you enabled
the default scan configuration or as an alternative to scheduling scans from the BigFix
console.
The panel is used for configuring the time, frequency, and types of software scans that are
run on the endpoints. If you enabled the default scan configuration, all prerequisites are
fulfilled and you can manage scans without any further setup. In other cases, ensure that

the required analyses are activated, the scanner is installed on the endpoints, uploads of
software scan results are scheduled, and capacity scans and uploads of their results are
scheduled. You must complete these actions manually from the BigFix console before you
can schedule scans from the BigFix Inventory user interface. For more information, see:
Manual scan configuration.
After the prerequisites mentioned above are fulfilled, divide the computers in your
infrastructure into groups in the BigFix console. Then, based on these groups, create
computer groups for which you want to schedule software scans in BigFix Inventory. A
computer group that you create in BigFix Inventory must fulfill the following conditions to
allow for scheduling scans through the Scan Configurations panel:
• It has the All Computers group as its parent. It is not a subgroup of another computer
group.
• Definition of this group uses a single Data Source Groups filter as the only condition
based on which computers are assigned to this group. Data source groups represent
computer groups that were earlier created in the BigFix console.

You must be an Administrator or an Infrastructure Administrator to perform this task.
When you create scan configuration for a computer group in the BigFix Inventory user
interface, the Initiate® Software Scan action is created and sent to the BigFix server. Each
time you change scan configuration on the Scan Configurations panel, the related action is
updated on the BigFix server. When you delete the scan configuration, the related action is
by default removed from the BigFix server.
If you configure scans on the Scan Configurations panel and then change scan
configuration in the BigFix console, information about the change is not reflected on the
BigFix Inventory user interface. To avoid duplicated scans or unexpected scan behavior,
avoid configuring scans in both places and choose your preferred method instead.

1. Create computer groups and enable scans for these groups.
2. To edit scan configuration, click Management > Scan Configurations, and select the
computer group for which you want to change the scan settings.
Note: Each row represents the schedule and status of the software scan for
a particular computer group. The row All computers from Data source name
represents all computers that report to one BigFix server. The row is created
automatically. You can edit or disable the scan schedule for this group.

3. Choose the scan frequency and requested start date.
Due to any network latency, the time when the scan actually starts might be several
minutes different from the requested start time. The requested start date represents
the time and date when the action is started in accordance to the time zone of the
BigFix server.
4. Choose the types of software scan to run.
For more information about each type of software scan, see: Types of software scans.
If the computer group for which you are configuring scans consists entirely of
computers that run on Mac OS, run only the package data scan on these computers
as other types of software scans are not applicable to Mac OS. If the group consists
of computers that run on Mac OS and computers that run on other operating systems,
select all types of scans that you want to run. Only the package data scan is run on
the Mac OS computers. The remaining types of scans are skipped as not applicable.

5. To save the changes, click Save and Start Scans. Then, click OK to confirm that you
want to restart the scan action that is running on the BigFix server.
Important: When you change a single scan configuration, all scans that were
configured from the BigFix Inventory user interface are restarted on the BigFix
server.
Scan configuration for a computer group can have one of the following statuses:

• Active - The Initiate® Software Scan action was started on the BigFix server. The
software scan runs according to the schedule defined on the Scan Configurations
panel.
• Stopped - The Initiate® Software Scan action was stopped on the BigFix server. The
software scan is not running. You can re-enable the scan on the Scan Configurations
panel or configure the scan from the BigFix console.
• Server unavailable - The scan schedule cannot be displayed and set because the
BigFix server or the Web Reports server is not responding. Follow the troubleshooting
steps to resolve the issue.
If you want to disable software scans for a particular computer group, open the scan
configuration for this group and clear the Enabled check box.

Manual scan configuration
Manual scan configuration is advised for environments with more than a few thousand
computers. It requires that analyses are activated and software and capacity scans as well
as uploads of their results are scheduled manually after the installation. These actions are
necessary to collect data from the computers in your infrastructure and display in on the
BigFix Inventory reports. Flexibility of the manual scan configuration allows for avoiding
performance issues that might occur when you scan too many computers at the same time.
To manually configure scans, perform the following tasks:
1. Optional: Divide the computers into groups in the BigFix console.
In large environments, it is advisable to divide the computers into groups in the BigFix
console and configure a separate scan schedule for each group. For a summary of
good practices related to scan distribution, see: Distribution of scans for improved
performance. For more detailed information, see the Tuning performance.
2. Set up scans to discover software and hardware discovery.
a. Activate the analyses.
b. Install the scanner.
c. Initiate software scans.

d. Upload software scan results.
e. Collect capacity data.
After you successfully schedule software and capacity scans, run the import of data. When
the data is displayed on the BigFix Inventory reports, you can further customize the scans.
For example, you can exclude directories from software scans or scan remote shared file
systems. For more information, see: Advanced scan configuration.

Distribution of scans for improved performance
Performance of importing data from the BigFix server to depends on the number of scan
files, usage analyses, and package analyses that are processed during a single import. By
properly scheduling scans and distributing them over the computers in your infrastructure,
you can reduce the length of the data import.
Use the following guidelines to improve the performance of the data import:
Divide computers into groups
• After you install , do not run the scans on all computers in your
infrastructure. Divide the computers into groups in the BigFix console
and start by gathering the default properties from a single computer
group. For more information about creating computer groups in the
BigFix console, see: Computer groups.
• Consider creating computer groups that are based on stability. In a
stable environment, scans can be run less frequently than once a week.
Schedule scans to run at different time
• Schedule scans to run on different days for different computer groups.
• Avoid a situation in which multiple groups are scanned at the same
day or the following day. It might cause that scans and data imports
interfere.
• Reduce the frequency of scans. In most cases, it is sufficient to scan
the infrastructure once a week, which is the default frequency. In large

environments, you can disable the option to automatically run scans and
initiate them only when necessary. The minimum scan frequency is once
per month.
Limit the amount of gathered data
• In the initial deployment phase, or if you do not need the information,
disable the collection of software usage. For more information, see:
Disabling the collection of software usage.
• Try to limit the number of computer properties that are gathered during
scans.
For more information about distributing scans and other actions that you can undertake to
improve the application performance, see: Tuning performance.

Activating the analyses
An analysis is a collection of property expressions that is used to view and summarize
properties of computers in your infrastructure. Some of the analyses are required to
discover installed software and must be activated all the time. Other analyses are used only
in specific scenarios or for troubleshooting purposes and can be activated according to
your needs.
If you enabled the default scan configuration, the required analyses are activated
automatically and this configuration is not required.
1. Log in to the BigFix console.
2. In the navigation tree, click Sites > External Sites > BigFix Inventory v10 > Analyses.
3. To activate an analysis, right-click it, and click Activate.
To ensure that the installed software is properly detected, activate the following
analyses on all computers in your infrastructure:

• Installed UNIX Packages
• Installed Windows Applications
• Software Scan Status
To measure software usage, activate also the Application Usage Statistics analysis.
Install the scanner on the computers on which you want to detect the software.

Installing the scanner
The scanner collects hardware information as well as information about files and packages
that exist on the computers in your infrastructure. Install the scanner on every computer
on which you want to detect software. If you enabled the default scan configuration , the
scanner is installed automatically and this configuration is not required.
Before you install the scanner, note the following considerations.
• Ensure that the BigFix client is installed and running on the computers on which
you want to detect software and that the computers are subscribed to the BigFix
Inventory v10 site.
• To install the scanner on a WPAR, you must install it on the LPAR first.
•

Ensure that on AIX the xlC.rte library version 13.1.0.0 or higher is
installed on the target computer.

•
◦ For scanner versions 9.2.17 and 10.0.0, ensure that libnsl.so.1 on Red Hat
Enterprise Linux 8.0 is installed on the target computer.
◦ For scanner versions 2.8.0.3000 and below, ensure that libstdc++.so.5 is
installed on 32-bit Linux x86 computers.
•

Ensure that the libstdc++.so.6 library is installed on the target computer.

•

Software discovery on Mac OS X does not require installing the scanner nor
scheduling regular uploads of scan results. To enable the discovery, it is enough to run
the package data scan.

The scanner can be used by multiple IBM applications. By default, the scanner that is
delivered with BigFix Inventory is installed in the single user mode. It means that if it is used

by other applications, it must be run by root (UNIX) or SYSTEM (Windows). If any of the
applications requires that the scanner is run by a different user, install it in the regular mode.
For more information, see: CIT deployed by LMT/BFI 9 by other IBM products.
1. Log in to the BigFix console.
2. In the navigation bar, click Sites > External Sites > BigFix Inventory v10 > Fixlets and
Tasks.
3. In the upper right pane, select Install or Upgrade Scanner.
4.

Select the installation directory. You can choose the default directory, or
an alternative one. In the latter case, the scanner is installed in the same path as the
BigFix client.
Note: The setting applies only to new installations, you cannot change the
path if you are upgrading the existing scanner.

5. Click Take Action.
6. Select the computers on which you want to install the scanner, and click OK.

Tip: To ensure that the action is applied on all computers that are added in the
future, select Dynamically target by property.
You installed the scanner on the computers in your infrastructure. To view information
about the installed scanner, for example its version, activate the Scanner Information
analysis, and open the Results tab.
After you install the scanner, schedule software scans.

Installing or Upgrading the scanner in a private mode
Private scanner installation mode allows to install BFI private CIT instance that does not
share any resources with global CIT installation made by other CIT exploiters.
The task installs CIT binaries in <BES Client>\LMT\CIT\scanner directory, but without
registering the instance in CIT global files (no cit.ini or other global CIT configuration files).
In case when there is a global CIT with SUA exploiter already installed, the SUA exploiter will
be uninstalled from the global CIT and upgraded to the private version.
The following custom CIT settings will be moved to the private mode:
• CIT trace log level
• maximum size of trace files
• maximum number of trace files

Note: The 'custom cache location' CIT setting is not moved to private mode.
Settings, such as ‘list of the excluded directories’, that are available at<BES Client>\LMT\CIT
directory remain unchanged while moving to the private mode.
The installation requires at least 70 MB of free disk space on the drive where BigFix client is
installed. The private installation mode is available currently for Windows platform only.
To check the version of the scanner that is currently installed on the endpoints, activate the
analysis: Scanner Information. The scanner that is installed in the private mode would have
exploiter 'BFI Private'.
NOTE: Automatic catalog propagation will not work automatically with the scanner installed
in the private mode up to BFI version 10.0.2.0.
To make it working you have to update the Catalog Download fixlet templates in the BFI
server using 'Update Catalog Download fixlet templates on BFI server' fixlet.

Initiating software scans
During the software scans, the scanner collects information about files with particular
extensions, package data, and software identification tags to evaluate whether particular
software is installed on the computers in your infrastructure. It also gathers information
about the running processes to measure software usage. By default, software scans are
scheduled to run regularly but you can specify the exact days and times of the scans, or
modify their start and end dates.
Backups of software directories that are stored on the endpoints might be reported as
separate software instances. It might result in false discoveries and incorrect license
consumption. To avoid this problem, either exclude the backups from scanning or compress
them with a data compressor.
The scanner does not scan the following elements:

• Archived files such as ZIP or RAR files
• Paths that contain certain whitespace characters and other special characters. To
avoid a situation in which software is not discovered, ensure that file paths in your
infrastructure do not contain the unsupported characters. For more information, see:
Limitations.
If you enabled the default scan configuration, software scans are initiated by default and
this configuration is not required.
Software scan is resource-consuming, and its duration depends on the number of files
in the file system. To minimize the impact of the scan, schedule the software scan for
the period that is least critical for your environment, for example, at night or during the
weekend. Software scan needs to be run with frequency that is adjusted to the dynamics of
the environment, but typically few times per each reporting period. For information about
default and minimal scan frequency, see: Frequency of scans and uploads of data.
Additionally, to minimize the impact of the scan, you can set up a CPU threshold for the
scan, and optimize the cache configuration. For more information, see: Optimizing scanner
cache configuration.
1. Log in to the BigFix console.
2. In the navigation tree, click Sites > External Sites > BigFix Inventory v10 > Fixlets and
Tasks.
3. Select Initiate Software Scan.
If the task is not applicable, see: Scan problems.
4. To ensure complete software discovery, select all types of scans under the Software
Discovery section.

Different types of scans search for different types of information to determine
whether the software is installed or to measure its usage. Generally, all types of
scans should be run regularly. However, you can choose to run different types of
scans at different times or distribute the scan schedule over the computers in your
environment to improve the performance of the import. For more information, see:
Types of software scans.
To discover software that is installed on Mac OS X, run the package data
scan on Mac computers. To measure application usage, activate the Application
Usage Statistics analysis and run the application usage statistics scan. Other types of
software scan are not necessary and are ignored on Mac OS X.
5. To see license metric utilization on reports, select the relevant options under the
Additional Scan Capabilities section.

Note: The resource utilization scan collects information contained in
.slmtag files. The license metric quantity for these products is based on
the .slmtag data and is reported on All Metrics and All IBM Metrics panels
. To ensure that the reported data is accurate and current, it is recommended
to schedule the resource utilization scan to run daily. If you prefer to run the
remaining scans at different times, run the Initiate Software Scan fixlet for
resource utilization scan separately.
6. Optional: To enable scanning of shared disks in basic mode, select Scan remote
shared disks. The basic mode is advised for environments where a single shared disk
is mounted on a single computer or a few computers. However, this mode is only one
of the available solutions. Before selecting this option, see: Discovering software on
shared disks.
7. Optional: To limit the amount of processor resources that the scanner consumes,
select Initiate the software scan with CPU threshold. Specify the consumption limit
that is in the range 5 - 100.
The higher value you specify, the higher is the consumption limit. For example, if you
specify 75, scanner processes use the average of 75% of the processing power of the
target computer.

Important: Setting the threshold does not guarantee that the CPU
consumption is always below the specified value. It fluctuates around that
value, sometimes exceeding it and sometimes dropping below it. Temporary
peaks are expected.
The setting does not apply to Mac OS X because the scanner is not installed
on these computers.

8. To start the scan, click Take Action.
9. Select the computers on which you want to initiate the scans.
Only local drives are scanned on the selected computers. For information about
scanning shared disks, see: Discovering software on shared disks.
Tip: To ensure that the action is applied on all computers that are added in the
future, select Dynamically target by property.
10. Optional: By default, the scans are scheduled to run weekly. If you want to specify
the dates and frequency of the scans, open the Execution tab. Specify the details, and
click OK.
For information about default and minimal scan frequency, see: Frequency of scans
and uploads of data.
Schedule uploads of software scans results to the BigFix server.

Types of software scans
The scanner can search for different types of information to determine whether the
software is installed or to measure its usage. Generally, all types of scans should be run

regularly. However, you can choose to run different types of scans at different times or
distribute the scan schedule over the computers in your environment to improve the
performance of the import process.

Software discovery
Catalog-based scan
In this type of scan, the BigFix server creates scanner catalogs that are sent
to the endpoints. Based on those catalogs, the scanner discovers exact
matches and sends its findings to the server. Scanner catalogs do not include
signatures that can be found based on the list of file extensions nor entries
that are irrelevant for a particular operating system.
File system scan
In this type of scan, the scanner uses a list of file extensions to check whether
any files with those extensions exist on the endpoints. Then, it returns the
findings to the BigFix server where the discovered files are compared with
the software catalog. If a particular file matches an entry in the catalog, the
software is discovered.
Collecting executable files based on application usage
Starting from application update 9.2.8, the file
system scan additionally reports files that are based on processes that have
been run on the computers in your infrastructure, regardless of their extension.
To view these files, you need to meet the following criteria:
• The BigFix server and client are in version 9.5.5 or higher.
• The operating system is Linux or Solaris.
• Application Usage Statistics analysis is activated.
The reported files, with supplementing information such as path and size, are
available on the Scanned File Data report and can be used to create custom
discovery and use signatures for software components. If the process has

been active at least once since the feature was turned on and the associated
file exists on the computer, this file is displayed on the report.
This feature is enabled by default. To stop collecting information about the
files, run the Disable Collecting Executable Files Based on Application Usage
fixlet. In case you need to reactivate this feature, run the Enable Collecting
Executable Files Based on Application Usage fixlet.
Note: Checksums collection (MD5 and SHA-256) for these files is not
supported.
Outputs of the file system scan
The scan generates two outputs: full file system scan and delta file system
scan. The former contains information about all files that were discovered on
the endpoint. The latter contains information only about files that changed
between the last two full file system scans. Both outputs are generated during
every scan and uploaded to the BigFix server. However, only one of them is
imported to BigFix Inventory.
Delta file system scan is imported to BigFix Inventory in the first place to
improve the import performance. Full file system scan is imported instead of
the delta scan in the following cases:
• The file system scan is run on the endpoint for the first time
• The BigFix client was reinstalled on the endpoint
• The delta file system scan is larger than one third of the full file system
scan
• The endpoint does not meet the prerequisites for generating the delta
scan. If any of the prerequisites are not met on an endpoint, check the
BES_Client\LMT\CIT\delta.log file for more details.
◦

sed, diff, wc, tar, gzip, expr

◦

VBScript interpreter

Package data scan

In this type of scan, the scanner searches the system registry to gather
information about Windows™ and UNIX™ packages that are installed on the
endpoints. Then, it returns the findings to the server where the discovered
packages are compared with the software catalog. If a particular package
matches an entry in the catalog, the software is discovered.
Software identification tags scan
In this type of scan, the scanner searches for software identification tags
that are delivered with software products. Then, it returns the findings to the
BigFix server where the tags are processed. Based on the information that
they contain, the software is discovered.

Additional scan capabilities
Application usage statistics
In this type of scan, the scanner gathers information about processes that
are running on the endpoints. Then, it returns the findings to the BigFix server
where the data is translated into usage statistics.
The usage data is first collected when the BigFix client is installed on an
endpoint, and an application usage statistics is enabled. The statistics are
displayed on the Metering Data report. When the processes are matched
against usage signatures from the software catalog, or custom usage
signatures, the statistics are available on the Software Classification panel.
Starting from application update 9.2.11, BigFix Inventory additionally
collects application usage data in a new format.
Remember: By default, the usage scan is scheduled to run weekly to
avoid performance issues. If you want to collect software usage on a
daily basis, run the usage scan daily.
Resource utilization scan
In this type of scan, the scanner searches for software license metric tags
that contain information about types of licenses that can be used by a product

and their usage. The scanner returns its findings to the BigFix server where
the tags are processed. Based on the information that they contain, the
maximum usage of license metrics over the last 30 days and its trend value
are calculated. For more information, see: Raw utilization of license metrics.
Tip: The scan collects information about license metrics that are
reported by products which implemented the ISO/IEC 19770-4:2017
standard. Because the volume of the collected data might be large, do
not run this scan if you do not want to monitor these metrics.
User information
In this type of scan, the scanner collects information about users of the
specific software products that help calculate the usage of some licensebased products. The results are shown on the All Metrics and Software Users
reports. For more information, see: Available reports.

Uploading software scan results
When the software scan finishes, its results must be uploaded from the computers in your
infrastructure to the BigFix server. To ensure that software inventory data is up-to-date,
software scans and uploads of their results should run on a similar schedule.
If you enabled the default scan configuration, uploads of software scan results are
scheduled automatically and this configuration is not required.
1. Log in to the BigFix console.
2. In the navigation bar, click Sites > External Sites > BigFix Inventory v10 > Fixlets and
Tasks.
3. In the upper right pane, select Upload Software Scan Results, and then in the lower
pane, click Take Action.
Note: The size of a single compressed scan result cannot exceed 1 MB.

4. Select computers from which you want to upload software scan results.
Tip: To ensure that the action is applied on all computers that are added in the
future, select Dynamically target by property.

5. Optional: By default, software scan results are uploaded to the BigFix server whenever
they are available on the target computer. If you want to specify the dates and
frequency of the uploads, open the Execution tab. Specify the details, and click OK.

Schedule capacity scans and uploads of their results.

Collecting the hardware information and capacity data
The hardware information and capacity data concern information about your processors,
and the processor capacity that is assigned to each computer. You can review the
information on the Hardware Inventory report. The hardware and capacity data is essential
to calculate processor-based metrics, for example PVU.
Concept
Discovering software in Docker containers

Initiating the capacity scan on all computers
The capacity scan is the essential part of collecting capacity data and should run on all
computers, including Oracle Logical Domains. The scan runs every 30 minutes, and collects
data about the physical processor, system type (physical or virtual), guest operating system,
and logical partitions.
•

You must have tar and gzip installed on each target computer.

• For KVM x86 hosts that are not controlled by RHV-M and PowerKVM hosts, do not use
the Run Capacity Scan and Upload Results task to collect the capacity data. Instead,
use the Run Capacity Scan on Virtualization Hosts task. For more information, see:
Collecting capacity data from virtualization hosts for Xen and KVM.
The scan runs every 30 minutes. However, it runs very quickly and has minimal impact on
the processor usage. Moreover, scan results are uploaded to the BigFix server only if they
changed since the last scan. It ensures that no unnecessary network traffic is generated.
Restriction: In case of subcapacity reporting, it is necessary to capture
configuration of vCPU to count the maximum capacity of processor cores for each
program concurrently. To ensure that dynamic changes of the vCPU configuration
are captured, the capacity scan must run every 30 minutes. You can change the
frequency of the scan only if you use BigFix Inventory for purposes other than
subcapacity reporting.
1. Log in to the BigFix console.
2. In the navigation tree, click Sites > External Sites > BigFix Inventory v10 > Fixlets and
Tasks, and select Run Capacity Scan and Upload Results.
3. In the lower pane, click Take Action, and choose Click here to schedule regular
capacity scans and uploads of results.
Important: Single capacity scan runs only once. Results of this scan are
uploaded to the BigFix server regardless of whether they differ from the
results of the previous scan. Use this option only when you need to force the

upload of scan results, for example when the import of scan results failed.
Otherwise, run the regular capacity scan.

4. Open the Target tab, and select computers that you want to scan.
Tip: To ensure that the action is applied on all computers that are added in the
future, select Dynamically target by property.

When the scan completes successfully, scan results are automatically uploaded to the
BigFix server.

Client installation on Oracle Solaris
To ensure that the capacity data is properly collected from computers that are running on
the Oracle Solaris virtualization, install the BigFix client on all required operating systems,
zones and domains. Then, set up capacity scans on each endpoint.

Installation order
Install the BigFix client in the following order:
1. Global zone in the Control Domain (if it exists)
2. Global zones
3. Local zones and Kernel zones
You might change the order and install the BigFix client on the computers in the local zone
first. As a result, these computers have the No Host Scan Data status until you install the
BigFix client on the computers in the global zone.

Requirements
The HOSTID values on a local zone and its parent global zone must be the same to
match the guest and host system. Otherwise, BigFix Inventory is unable to properly build
information about the virtualization structure. As a result, guest operating systems have the
No Host Scan Data status.

Examples
The following examples of possible installation scenarios describe in what order you might
install the BigFix client on computers in the global and local zones.
Scenario

Applicable for
Solaris

SPARC

x86
To discover an application that is in
stalled on operating system 2 (local

Yes

Yes

zone), install the client in the following
order:
1. Operating system 1 (global
zone)
2. Operating system 2 (local zone)

To discover an application

Yes

Yes

that is installed on operating system
3 (local zone), install the client in the
following order:
1. Operating system 1 (global
zone)
2. Operating system 2 (global zone
in the Kernel Zone)
3. Operating system 3 (local zone
in the Kernel Zone)
To discover an application that is in
stalled on operating system 4 (local
zone on a Logical Domain that is not
the Control Domain), install the client
in the following order:
1. Operating system 1 (global zone
in the Control Domain)
2. Operating system 3 (global zone
of operating system 4 in the
Logical Domain)
3. Operating system 4

Yes

To discover an application that is in

Yes

stalled on operating system 2, install
the client in the following order:
1. Operating system 1 (global zone
in the Control Domain)
2. Operating system 2

To discover an application

Yes

that is installed on operating system 5
(local zone in the Kernel Zone), install
the client in the following order:
1. Operating system 1 (global zone
in the Control Domain)
2. Operating system 3 (global zone
of operating system 4 in the
Logical Domain)
3. Operating system 4 (global zone
of operating system 5 in the
Kernel Zone)
4. Operating system 5

Adding VM managers for VMware, Hyper-V, KVM with RHV-M,
Citrix Hypervisor and Nutanix
After you configure the capacity scan, BigFix Inventory can evaluate capacity of virtual
machines in your environment. However, to accurately calculate subcapacity consumption,
it also needs data about physical hosts on which these VMs are running. The data can be
collected only from VM managers. To ensure that the data is available to BigFix Inventory,
configure connections to VM managers in your infrastructure.

•

You must have the Manage VM Managers and Servers permission to perform this
task.

• The computer where the main instance of the VM Manager tool is installed must
belong to the computer group to which you are assigned. Otherwise, the option to add
VM managers is disabled.
• If the panel is blocked and displays a warning, see: Troubleshooting: Enabling the VM
Managers panel.
VM Manager Tool, starting from update 1.5.0.0, is enhanced to attempt to
automatically fix the most common problems with the VM manager connection parameters.
This feature is disabled by default. To enable this feature, go to Management > Advanced
Server Settings and change the setting of vmman_fix_parameters_enabled parameter to
true. While fixing connection problems the VM Manager Tool can connect using the HTTP

protocol when the defined HTTPS connection is not available. This setting is enabled by
default. To disable switching protocol from HTTPS to HTTP, go to Management > Advanced
Server Settings and change the setting of vmman_http_connection_allowed parameter to
false. For more information, see: Advanced server settings.

1. In the top navigation bar, click Management > VM Managers.
2. To add a VM manager, click New.
3. Select the virtualization type and provide the required details.
• To add Microsoft Hyper-V:
a. Select one of the available communication interfaces: PowerShell or
WinRM. For more information about these interfaces, see: Microsoft
Hyper-V.
Important: WinRM is the preferred communication interface.
Before you add the VM Manager, configure WinRM on the HyperV host. For more information, see: Configuring WinRM on Hyper-V
hosts.
b. Provide the URL of the VM manager in the following format: https:///
ovirt-engine/api to https://{manager-host}/ovirt-engine/api.

c. To share credentials with other hosts in the same cluster, select Share
credentials with other hosts in the same cluster.
d. Provide the Administrator account credentials. Define the user
as user_name\domain or user_name@domain. For example: test
\cluster.com or test@cluster.com.

• To add KVM with RHV-M:
a. Provide the URL of the VM manager in the following format: https://
<RHV-M_IP_address>/ovirt-engine/api.

b. Provide the account credentials. Define the user as user_name@domain,
for example: test@cluster.com.
•

To add Nutanix:
a. Provide the URL of the VM manager in the following format: https://
<NUTANIX_PRISM_IP_ADDRESS>:9440/PrismGateway/services/rest/
v2.0.

b. Provide the account credentials.
•

To add Oracle VM:
a. Provide the URL of the VM manger in the following format:
b. https:///ovirt-engine/api to https://{manager-host}/ovirtengine/api

c. Provide the account credentials.
• To add VMware ESX, ESXi or vCenter:
a. Provide the URL of the VM manager in the following format:
◦ https://<vCenter_IP_address>/sdk/vimService.wsdl
b. Provide the account credentials. Define the user as domain\user_name, for
example: cluster.com\test.
•

To add Citrix Hypervisor (formerly XenServer):
a. Provide the URL of the VM manager in the following format: https://
Citrix_hypervisor.

b. Provide the account credentials.
The following example shows a configured connection to VMware ESX, ESXi or
vCenter.

Note: "KVM RHV-M" VM Manager type has been renamed to "KVM RHV-M
or Oracle Linux Virtualization". This change is only on the UI. As Oracle VM
is approaching end of life, instead of the new version, Oracle moves to KVM
and introduces Oracle Linux Virtualization Manager as manager. Oracle Linux
Virtualization Manager works with previous versions of BigFix Inventory which
supports KVM RHV-M.
4. Click Create. Connection to the VM manager is created and its status is Pending.
5. Select the VM manager, and click Test Connection.
The test might take a few minutes. Refresh the panel. If the VM manager connection
is properly configured, the connection test status changes to Successful.
You have created a VM manager. Its status remains Pending until the data is collected from
the VM manager, uploaded to the BigFix server, and transferred to BigFix Inventory during
the import of data.
The upload of data collected from VM managers is triggered shortly after you modify any
VM manager, for example create a new connection or change the existing one. If you do not
make any modifications, the data is uploaded according to the schedule, which is every 12
hours by default. For more information, Capacity data flow.
Note: BigFix Inventory can count the cluster cores properly only if the data comes
from a single VM manager connection for the whole cluster. This option is visible on
Management > VM Managers panel.

• For VMware, the data should come from vCenter where VMs in the same
cluster must belong to a single vCenter, otherwise the cluster core results will
not be correct.
• For Hyper-V, the data should come from a single host within a cluster when
Share credentials with other hosts in the same cluster option is

enabled.
Cluster Cores are assigned based on the node layer and not the machines.
Physical machines that host Hyper-V, share the same node layer as VMs they
host. These machines have the same cluster name. As a result, Hardware
Inventory report shows the same Cluster Name for Hyper-V hosts and the
hosted VMs.

Collecting capacity data from virtualization hosts for Xen and KVM
For Citrix, Xen and KVM, connection to the VM manager does not have to be defined
in BigFix Inventory to collect capacity data. The data can be collected directly from
virtualization hosts by using the Run Capacity Scan on Virtualization Hosts task.
This method is applicable on the following virtualizations:
•

Xen Hypervisor

•

Citrix Hypervisor (formerly XenServer)
Important:

Starting from application update 9.2.12, it is

recommended to collect data from Citrix Hypervisor (formerly XenServer) by
configuring connections to VM managers. For more information, see:Adding
VM managers in central mode.
• PowerKVM
• KVM x86
Tip: If your KVM x86 hosts are controlled by RHV-M, you can configure the
RHV-M as a VM manager in BigFix Inventory. It allows for collecting capacity

data from all controlled hosts without the need of using the Run Capacity
Scan on Virtualization Hosts task on each of them. For more information, see:
Adding VM managers in central mode.
For information about supported versions of these virtualizations, see: Detailed System
requirements.
Ensure that virtualization hosts from which you want to collect capacity data meet the
following prerequisites.
KVM hosts
Ensure that the following prerequisites are met on the KVM hosts:
• The host runs on Linux x86 or Linux on Power
• Bash shell is available
• libvirt-client library is installed (virsh command is available)
• libxml2 library is installed (xmllint command is available)
Xen hosts
Ensure that the following prerequisites are met on the Xen hosts:
• The host runs on Linux x86
• Bash shell is available
• xl command is available
• libxml2 library is installed (xmllint command is available)
1. Log in to the BigFix console.
2. In the navigation tree, click Sites > External Sites > BigFix Inventory v10 > Fixlets and
Tasks.
3. In the upper right pane, select Run Capacity Scan on Virtualization Hosts.
4. Optional: To collect information about host names of virtualization hosts, select
Collect host names of virtualization hosts.
This option affects the format of information about virtualization hosts that is
displayed in the Server ID column on the reports. If you select this option, the column

contains information about the vendor, type and host name of the host as specified
in the managedServerTagTemplate parameter. If you do not select this option,
the column contains the serial number of the host instead of its name. For more
information about the managedServerTagTemplate parameter, see: Advanced server
settings.
5. To start the scan, click Take Action.
Important: If you run this task on the host, you no longer need to run the Run
Capacity Scan and Upload Results task on that host.
6. From the list of applicable computers, select the supported hosts.
Important: The list is filtered out to the computers that meet the prerequisites.
However, not all of them are virtualization hosts.
7. Optional: By default, the capacity scan is scheduled to run every 30 minutes.
However, in an environment with many KVM or Xen hosts, consider lowering the
frequency of the scan. To specify the frequency of the scan, open the Execution tab,
specify the details, and click OK.
For environments with multiple hosts, run the scan once per one to six hours.
Restriction: You can change the frequenIBMer you obtain the acceptance of
the BigFix Compliance Team.
8. Schedule the upload of scan results to the BigFix server.
a. In the upper right pane, select Schedule VM Manager Tool Scan Results Upload,
specify the frequency, and click Take Action.
b. Select the hosts from which you collected the capacity data, and click OK.
Tip: To check the status of the capacity scan on the endpoints, activate the
analysis Status of Capacity Scan on Virtualization Hosts. If the status is other
than OK, check the return code to learn what is the cause of the problem and
how to solve it. For more information, see: Return codes of capacity scans on
virtualization hosts.

9. Wait for the scheduled import or run it manually to transfer the data to BigFix
Inventory.
Note: When you run fixlet 'Run Capacity Scan on Virtualization Hosts', the
discovered hosts, such as KVM, Xen, and Citrix are displayed on Management
> VM Managers panel in BigFix Inventory UI.

Related reference
Return codes of capacity scans on virtualization hosts

Removing capacity scan data from the host
During the capacity scan, some files and folders are generated on the virtualization host. If
you no longer collect capacity data from a particular host, remove the files and folders that
were created by the capacity scan.
1. Stop the actions that were created by the Run Capacity Scan on Virtualization Hosts
task on the specified endpoints. Otherwise, the scan continues running and the files
are recreated.
a. In the navigation tree of the BigFix console, click Sites > External Sites > BigFix
Inventory v10 > Actions.
b. Select the actions, and in the lower pane, click Stop.
2. In the navigation tree, go to Fixlets and Tasks.
3. In the upper right pane, select Remove Capacity Scan Data from Virtualization Hosts,
and click Take Action.
4. Select the computers from which you want to remove the data that was generated
during the capacity scan, and click OK.

Identifying computers on public clouds
For all computers that run on public clouds, you must additionally identify them as
such. This is required to apply the correct PVU rates, which might differ between the public

clouds. It is enough to run a Fixlet against these computers and specify the type of the
public cloud.
For information about licensing rules that apply on public clouds, the list of supported public
clouds, and existing limitations, see IBM Software licensing rules on public clouds.
Procedure
1. In the navigation tree of the BigFix console, click Sites > External Sites > BigFix
Inventory v10 > Fixlets and Tasks.
2. In the upper right pane, select Identify Computers on Public Clouds.
3. Choose the type of the public cloud and click Take Action.
Note: If you incorrectly identified a computer as running on a public cloud,
choose Remove existing identification.
4. Select all computers that run on this type of cloud and click OK.
Tip: To check which computers are identified as running on public clouds,
activate the Identified Public Cloud Computers analysis and open the Results
tab.
A computer that runs on a public cloud is assigned the number of PVUs that is specified in
the IBM Eligible Public Cloud BYOSL policy. Information about the assigned number of PVUs
is displayed on the Computers report after the next capacity scan and import of data. PVU
consumption for the software that is installed on such a computer is properly calculated.

Identifying disconnected computers as running on public clouds
If a computer on which you use the disconnected scanner runs on a public cloud,
identify it as public to ensure that PVU consumption is properly calculated for the software
that is installed on that computer.
For information about licensing rules that apply on public clouds, the list of supported public
clouds, and existing limitations, see: IBM Software licensing rules on public clouds.

Procedure
1. Log in to the computer that runs on the public cloud.
2. Go to the directory in which the disconnected scanner is installed, and open the
setup_config.ini file.
3. Set the value of the PUBLIC_CLOUD_TYPE parameter. For the list of available values,
refer to the config file.
Note: Ensure the name of the public cloud is enclosed in quotation marks.
A computer that runs on a public cloud is assigned the number of PVUs that is specified in
the IBM Eligible Public Cloud BYOSL policy. Information about the assigned number of PVUs
is displayed on the Computers report after the next capacity scan and import of data. PVU
consumption for the software that is installed on such a computer is properly calculated.

Advanced scan configuration
After you successfully schedule software and capacity scans and the scan data is displayed
on the BigFix Inventory reports, you can further customize the scans. For example, you can
exclude directories from software scans or scan remote shared file systems.

Detailed hardware scan
Available from 9.2.12. Detailed hardware scan collects hardware information
related to memory, operating systems, storage, processors, partitions, network adapters,
SMBIOS data, IP addresses and logical partition capacity data. The solution is supported
on Windows, Linux x86 ad AIX. It can be run also on other operating systems but the results
might not be accurate.
In BigFix Inventory, there are two types of hardware scans: capacity scan and detailed
hardware scan.
• Capacity scan collects the main information about the type and the capacity of
processors in your infrastructure. BigFix Inventory uses this data to calculate software
license usage for metrics that are based on processor capacity, such as PVU. BigFix

Inventory displays the selected hardware attributes of scanned processors on the
Hardware Inventory and Software Classification panels. You can also use API to
retrieve the capacity details.
• Detailed hardware scan collects additional information about your hardware. The scan
uses the same scanner technology as capacity scan. However, detailed hardware
scan has a much broader spectrum and retrieves more hardware attributes. These
details are not required to report license metrics. They can be used to monitor your
hardware inventory or manage your assets. You can only retrieve the results of the
detailed hardware scan through API.
For more information, see: Software and hardware discovery.

Collecting detailed hardware scan information
Available from 9.2.12.

You can collect the detailed hardware

information by running the Collect Detailed Hardware Information task in the BigFix console.
To retrieve the data use the relevant REST API.
Limitations
• Detailed hardware scan cannot be collected if you use the disconnected scan.
• The output of the detailed hardware scan cannot exceed 100 KB. This limit should be
enough for most endpoints. However, if it is exceeded, the results will not be imported
to BigFix Inventory server. Information about exceeding the limit of 100 KB is returned
by the Detailed Hardware Information analysis.
Considerations
• If a piece of information is not applicable to your system, or cannot be retrieved, the
detailed hardware scan returns no value, or the value equals "-1".
• In case of virtual systems, such as, VMware, Hyper-V or KVM guests, the scanner
might not be able to retrieve the accurate value of some physical machine attributes.
The physical system information is emulated by the hypervisor and the scanner

cannot access the host system properties directly. The level of similarity between
the virtual devices and the actual hardware depends on the virtualization technology
used.
1. Log in to the BigFix console.
2. In the navigation tree, click Sites > External Sites > BigFix Inventory v10 > Fixlets and
Tasks.
3. Select Collect Detailed Hardware Information, and then in the lower pane, click Take
Action.
4. Select computers from which you want to collect the detailed hardware information.
5. Optional: By default, the scan repeats every week. However, you can customize the
frequency of the scan according to your needs. Select Execution tab and modify the
Reapply this action section.
6. Click OK.
7. To populate the scan results to BigFix, activate the Detailed Hardware Information
analysis.
8. Wait for the scheduled import, or run it manually.
9. To retrieve the detailed hardware information, use the relevant REST API call. For more
information, see: REST API for retrieving detailed hardware information (v2).
The API call returns the detailed hardware information about the computers in your
environment.
You can check the status and the date of the last scan in Detailed Hardware Information
analysis.

Discovering software on shared disks
BigFix Inventory allows you to scan the shared disk on designed endpoint and use the
information across all of endpoints. The solution is fully-automated.
To discover software that is installed on shared disks, identify disks that exist in your
infrastructure. Then, choose the method of scanning these disks that best suits your
environment.

Software that is discovered on shared disks is reported on every computer on which the
shared disk is mounted. It causes that license metric utilization that is calculated for the
discovered software increases. When the software is reported on every computer on which
the shared disk is mounted, it continues contributing to license metric utilization for the
entire reporting period even if the shared disk is unmounted.

Requirements
• Scanning shared disks might increase the number of scanned files per computer in
your environment and it might affect the hardware requirements of your system. For
more information, see: Hardware requirements.
• Discovery of shared disks is supported on Linux, AIX, Solaris, and HP-UX. It is not
supported on Windows.
• Types of discovered shared disks include UNIX Network File System (NFS) and
Windows Common Internet File System (CIFS).
• Types of software scans that are run on shared disks include catalog-based scan, file
system scan, and software identification tags scan.
• If you have systems with multiple interfaces, ensure that you configure them correctly.
For more information, see: Configuring servers in separate networks.
Warning:
1. BigFix Inventory scan is designed to scan only mounted drives and not invoke
automounting of the shares. This is achieved by listing the mounts at the
beginning and then scanning only designed and mounted.
• Scan for designed share disk does not further check against the specific
directories on the scanned shared. It assume that all the structure is
local and can be accessed.
•

Form version 10.0.6, the */.snapshot/* directory is excluded
by default for the newly set up endpoints. The snapshot directory is an
example of directory that is not listed as a shared directory but gets
triggered to mount as sub-shared.

The exclude_path.txt file include the exclusion rules. The exclusion
list does not allow to scan directories matching */.snapshot/*. The
*/.snapshot/* exclusion rule is not added when exclude_path.txt
exists. You can change the rules on server side as required.
Run the 1_Install_Scanner.bes fixlet to include the
exclude_path.txt file. For newly set-up endpoints,
if the exclude_path.txt file is not present, the
1_Install_Scanner.bes fixlet creates the same. For scanner
initialization or upgrade, the existing exclude_path.txt file is used
and the exclusion rule is not overwritten.
• Check if the exclusion list includes */.snapshot/* directory on nonWindows endpoints. It is recommend to add the */.snapshot/* directory
on non-Windows endpoints when you apply share disk scan.
2. There is an option to automate the scan, see also Optimized mode Automatic scanning of remote shared disks. Use this process to limit the
scope of the scan and decide the endpoints that you want to scan. Scans
access file systems and incorrect manual configuration might lead to
overloading share disk if targeted incorrectly. It is recommneded to use it
when you are familiar with the process.

Set up shared disk scan
A prerequisite for the shared disk scan is to collect information about available and
mounted share disks. See Step 1: Discovering remote shared disks.
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Step 1: Discovering remote shared disks
To discover shared disks that are used in your infrastructure, run the Discover Remote
Shared Disks task. Then, activate an analysis that gathers the retrieved information. After
an import, the information is shown on the Shared Disks report. You can also retrieve it by
using the api/sam/v2/shared_disks REST API.

1. Log in to the BigFix console.
2. Discover remote shared disks in your environment.
a. In the navigation tree, click Sites > External Sites > BigFix Inventory v10 >
Fixlets and Tasks.
b. In the upper right pane, select Discover Remote Shared Disks, and then in the
lower pane, click Take Action.
c. Select computers on which you want to discover shared disks, and click OK.
Tip: Select all applicable computers to ensure that all shared disks are
discovered.
3. Gather information about the discovered shared disks.
a. In the navigation tree, click Analyses.
b. Right-click Shared Disk Information, and click Activate.
4. Wait for the scheduled import or run it manually.
Information about shared disks is shown on the Shared Disks report. You can also retrieve it
by using REST API. For more information, see: Retrieval of shared disks (v2).
To view information about software that is installed on the discovered shared disks, scan
the disks. Choose scanning method that best fits your use of shared disks. Refer to the
table, Methods of scanning remote shared disks.

Step 2a: Optimized mode - Automatic scanning of remote shared
disks
Available from 9.2.12. To discover software that is installed on shared disks
in your infrastructure, enable automatic scanning of shared disks. As a result, a single
computer is designated to scan a specific shared disk and discover the installed software.
The data is then automatically populated to all computers on which the same shared disk is
mounted. Use this mode when a single shared disk is mounted on many computers.

• This method of scanning is advised for environments with a heavy use of shared
disks in which a single shared disk is mounted on many computers. For information,
see: Discovering software on shared disks.
• This method is not supported in environments in which multiple instances of BigFix
Inventory use a single BigFix server as the data source.
•

You must be an Administrator to perform this task.

• Ensure that the parameter enable_automatic_task_deployment is set to true on the
Advanced Server Settings panel. It is the default setting.
1. Discover shared disks that exist in your infrastructure.
2. Enable optimized scan of shared disks.
a. Log in to BigFix Inventory and go to Management > Advanced Server Settings.
b. Change the value of the autoscan_shared_disks_enable parameter to true.
Note: If you disable this parameter, and then want to enable it back, you
need to wait at least one day. Alternatively, you can log in to the BigFix
console and remove the LMT_Autoscan_Shared_Disks property from all
computers on which you ran the scan of shared disks.
3. Wait for the scheduled import or run it manually.
During the import, a single computer is designated to scan a specific shared disk.
An action that is called Optimized Shared Disks Scan Update Resources List is
created on the BigFix server. Each action represents designation of a single computer.
Additionally, the software scan is triggered on every designated computer.
Important: Because these actions are triggered during the first import after
you enable the scanning, it might take a couple of consecutive imports to
discover software that is installed on shared disks.
To see software that was discovered on shared disks, go to Reports > Software
Classification. Hover over Configure, and click Configure View. Then, and add the following
filter: From Software Template, equal to, yes.

When you click the link in the Details column, you can see on which shared disk the
software is installed.

Advanced options
Manually Scanning Individual Disk
To discover software that is installed on shared disks in your infrastructure, run the software
scan with the Scan remote shared disks option enabled.
• This method of scanning is advised for environments in which a single shared disk is
mounted on one or only few computers. For information, see: Discovering software on
shared disks.
• If more computers are configured to scan a shared disk, performance of the
disk might decrease drastically and the scanning might take a long time. It is
recommended to schedule the clients to scan the shared disk at different times, for
example to spread the scanning across many days of the week.
• If the shared disks to be scanned are large, scan timeout problems might occur.
The difference is that automatic mode scans all shared disks that exist in your
environment. If you want to scan only selected shared disks, use manual scanning.
For more information, see: Discovering software on shared disks. If you already set
up manual scanning (this method), you can switch to automatic scanning. For more
information, see: Switching to automatic scanning of shared disks.
1. Discover shared disks that exist in your infrastructure.
2. Exclude unsupported file systems from scanning.
a. In the navigation tree, click Analyses.
b. Click Shared Disk Information, and open the Results tab to recognize file
systems that must be excluded from scanning.
c. In the navigation tree, click Fixlets and Tasks and select Add Excluded
Directories. Specify directories or mount points of unsupported file systems,
and click Take Action. For more information, see: Adding excluded directories.

Tip: A mount point is a directory that is at the top of the file system
hierarchy. You can verify whether a directory is a mount point by
checking the output of the mount or mountpoint commands.
d. Select computers on which you want to exclude the unsupported file systems
and click OK.
3. Stop the current software scans.
a. In the navigation tree, click Actions.
b. In the upper right pane, select the Initiate Software Scan action.
c. In the lower pane, click Stop.
4. Initiate software scans with the option to scan remote shared disks selected. To
effectively setup the scan you can create a manual group for computers and use this
option.
Important: Automounted remote disks will be scanned only if they are
mounted during the scan.
Information about shared disks and the installed software is available on the following
reports:
• Computers report (when you access it from the widget on the homepage) contains
information about the type of file system, shared disk IP address, and mount point
• Scanned File Data report contains information about the file path
• Software Classification report contains information about the installation path
Information about scanned files and directories in your file system is stored in
the scanner cache folder. By knowing the hierarchy of files, the scanner can locate them
quicker, which results in shorter scans. The amount of disk space that is needed for the
cache depends on the number of files that are being scanned. If the current location of
the cache folder cannot ensure sufficient disk space, you can change the location of the
cache folder or optimize the cache. For more information, see: Optimizing scanner cache
configuration.

Switching to automatic scanning of shared disks
To switch from manual scanning of shared disks to automatic scanning, set up the
automatic scans. Then, wait for automatic scans to finish successfully to ensure data
consistency. Finally, remove computer groups that were created to report software that is
discovered on the shared disks.
1. Enable automatic scanning of shared disks.
To ensure data consistency, wait for the results of the automatic scanning. To check
the status of the scan, go to Reports > Shared Disks, and check the value in the
Automatic Scan Status column. The value should be OK for every shared disk that was
scanned by using the manual method.
2. In BigFix Inventory, remove computer groups that were created to report software that
is discovered on shared disks.
a. Go to Management > Computer Groups.
b. Select the computer group that you want to remove, and click Delete.
c. To confirm the removal, click Delete.
3. Optional: In the BigFix console, remove computer groups that contain computers on
which a particular shared disk is mounted.
a. In the navigation tree, go to Computer Groups.
b. Right-click the computer group that you want to remove, and click Remove.
c. To confirm the deletion, click OK.

Limiting scope of automated scan
Available from 9.2.8. To discover software that is installed on shared disks in your
infrastructure, create computer groups that contain only computers on which the same disk
is mounted. Then, scan one of the computers in that group to create a software template.
Finally, share the template between all computers on which the disk is mounted.

• This method of scanning is advised for environments with a heavy use of shared
disks in which a single shared disk is mounted on many computers.
Important:

Starting from application updated 9.2.12, this method

can be automated. Using the automated scanning is recommended as it
is easier to set up and maintain. The difference is that automatic mode
scans all shared disks that exist in your environment. If you want to scan
only selected shared disks, use manual scanning. For more information, see:
Discovering software on shared disks. If you already set up manual scanning,
you can switch to automatic scanning. For more information, see: Switching
to automatic scanning of shared disks.
•

You must be an Administrator to perform this task.

The choice of the scanned computer depends on whether some of the computer groups
are overlapping and whether computers that access the same shared disk run on various
operating systems.
Scenario 1: Each computer has access to one shared disk
There are two shared disks, each mounted on six computers. To properly
report the discovered software, create two computer groups in BigFix
Inventory:
• Computer Group 1 that contains computers on which Shared Disk 1 is
mounted
• Computer Group 2 that contains computers on which Shared Disk 2 is
mounted
From each group, select one computer to be scanned. Scan results from
the designated computer are propagated to the remaining computers in the
computer group. Thus, software that is installed on Shared Disk 1 is reported
on all computers in Computer Group 1 without the need to scan all computers
in that group. The same happens for computers in Computer Group 2.

Scenario 2: Some computers have access to two shared disks
There are two shared disks. Shared Disk 1 is mounted on nine computers.
Shared Disk 2 is mounted on six computers. To properly report the discovered
software, create two computer groups in BigFix Inventory:
• Computer Group 1 that contains computers on which Shared Disk 1 is
mounted
• Computer Group 2 that contains computers on which Shared Disk 2 is
mounted
Three of the computers belong to both computer groups because they have
both disks mounted. Select one of these computers to be scanned. This way,
only one computer is scanned to discover software that is installed on both
shared disks. Scan results from the designated computer are propagated to
the rest of computers in both groups. Computers on which only one disk is
mounted show software from that disk only. Computers on which both disks
are mounted show software from both disks.

Scenario 3: Computers have access to one shared disk but run on different operating
systems
There is one shared disk that is mounted on nine computers. Three of the
computers run on Linux, three on AIX, and three on Solaris. To properly report
the discovered software, create one computer group in BigFix Inventory. From
this group, designate three computers to be scanned, one for every operating
system.
It is necessary because the software catalog that is propagated to each
computer monitored by BigFix Inventory contains software signatures specific
to the operating system on which that computer runs. Thus, scan results from
the shared disk must be matched against software catalog for every operating
system. Scan results from each designated computer are propagated to the
rest of computers that run on the same operating system.

1. Discover shared disks that exist in your infrastructure.
2. Create a list of unique access points of the discovered shared disks. The information
is needed to group computers on which the same shared disk is mounted.
a. In the navigation tree, click Analyses.
b. In the upper-right pane, right-click Shared Disks Information, and click Activate.
c. Open the Results tab. The Computer Name column lists computers on
which shared disks are mounted. The Remote Shared Disks column provides
information about the type of the mounted shared disk, the access point, and
the path under which the disk is mounted on a particular computer.

d. Create a list of unique access points.

• If every computer has only one disk mounted, right-click the results of
the analysis, and click Copy Text. Then, paste the list to a text editor, and
edit the file so that it contains only information about access points. For
example:
192.0.2.21:/file_server/shared

• If a computer has multiple disks mounted, double-click the computer, and
scroll down to the Shared Disk Information section.

Copy the text, paste it to a text editor, and edit the file so that it contains
only information about access points. For example:
192.0.2.21:/file_server/shared
192.0.2.22:/file_server/shared
192.0.2.23:/file_server/shared

3. Create a BigFix computer group that contains computers on which a particular shared
disk is mounted. The group is used to easily designate one computer that can be
scanned to create a software template.
a. To make grouping computers easier, create a computer property based on the
information about the access point of the mounted shared disk.
i. In the top navigation, click Tools > Manage Properties.
ii. From the list of available properties, select Remote Shared Disks, and
click Make Custom Copy. Then, click OK.
b. Create a computer group that contains all computers on which the shared disk
is mounted.

i. In the top navigation, click Tools > Create New Automatic Computer
Group.
ii. Specify the name of the computer group. For example, Shared Disk 1.
iii. Specify the following conditions: Remote Shared Disks, contains,
<IP:shared_disk>.

If a shared disk is mounted based on the IP address on some of the
computers and based on the host name on other computers, BigFix
Inventory does not unify addresses of access points. Thus, add the
following condition to the definition of the computer group: Remote
Shared Disks, contains, <host_name:shared_disk>. Alternatively, create

two separate computer groups: one in which the access point based on
the IP address and the other in which it is based on the host name.

If the same shared disk is mounted on computers that run on different
types of operating systems, create a computer group per each type.
To create such a group, add the following condition to the definition
of the computer group: OS, contains, <operating_system>, where
<operating_system> can have the following values:
• linux
• aix
• hp-ux
• sunos

For more information, see scenario 3 in Discovering software on shared
disks.

4. From the computer group, choose one computer to be scanned. Information about
software discovered on the shared disk that is mounted on this computer is used as a
software template.
a. In the navigation tree, click Fixlets and Tasks.
b. In the upper right pane, select Initiate Software Scan on Shared Disks.
c. Optional: If the computer has multiple shared disks mounted and you want to
scan only some of them, specify URLs of the access points that you want to
scan. Otherwise, all mounted shared disks are scanned.
You can enter each URL from a separate line or separate the URLs with a
semicolon (;).
Tip: Ensure that the URLs are exactly the same as the URLs returned by
the Shared Disks Information analysis.

d. Optional: To limit the amount of processor resources that the scan consumes,
select Initiate the software scan with CPU threshold. Specify the consumption
limit that is in the range 5 - 100. The higher value you specify, the higher is the
consumption limit.
For example, if you specify 75, scanner processes use the average of 75% of the
processing power of the target computer.
Important: Setting the threshold does not guarantee that the CPU
consumption is always below the specified value. It fluctuates around
that value, sometimes exceeding it and sometimes dropping below it.
Temporary peaks are expected.
e. To start the scan, click Take Action. Then, expand Applicable Computers >
By Group, and select the group that you created in step 3. From the list of
computers that belong to this group, select one computer to be scanned, and
click OK.
Tip: If one of the computers has many shared disks mounted, scan this
computer. This way, only one computer is scanned to discover software
that is installed on multiple shared disks. For more information, see
scenario 2 in Discovering software on shared disks.
f. To see the status of the scan, activate the Status of Shared Disks Software
Scan analysis, and open the Results tab.
If any of the columns shows <multiple results>, it means that multiple shared
disks are mounted on the scanned computer. To see the status of the scan for
each shared disk, hover over the results in the column specific to the type of the
scan. The number next to the status corresponds to the number of the shared
disk in the Scanned Disks column. You can also double-click the computer, and
scroll down to the Status of Shared Disks Software Scan section.

After the scan finishes, a software template is created.
5. If you have not previously scheduled upload of scan results from the scanned
computer, schedule it now. Ensure that the upload is scheduled only once per
computer.
a. In the navigation tree, click Fixlets and Tasks.
b. In the upper right pane, select Upload Software Scan Results, and click Take
Action.
c. Select the computer that is scanned to create the software template, and click
OK.
6. To make the software templates available in BigFix Inventory, wait for the scheduled
import or run it manually.
7. Create a computer group in BigFix Inventory. The group is used to report software that
is discovered on the shared disk on all computers that belong to this computer group.
a. Log in to BigFix Inventory, and click Management > Computer Groups.
b. To create a computer group, click New.
c. Provide the name and description of the computer group.
Tip: To make it easier to correlate computer groups that are created in
the BigFix console and in BigFix Inventory, use the same name in both
cases.
d. Specify filters according to which computers are assigned to the group, and
click Create. To create a group that is based on a computer group from the
BigFix console, choose Data Source Groups, in set, and select the group that
you created in step 3.

e. In the Type section, select Software Template.
f. Select the software template that you want to share among all computers that
belong to this group. Then, click Create.

Important: Ensure that you assign a software template to a group in
which all computers have the shared disk mounted. Otherwise, software
discovered on the shared disk is reported on computers that do not in
fact have access to that software.
To see software that was discovered on shared disks, go to Reports > Software
Classification. Hover over Configure, and click Configure View. Then, and add the following
filter: From Software Template, equal to, yes.
When you click the link in the Details column, you can see on which shared disk the
software is installed.

Changing the computer scanned to discover software on shared
disks
Available from 9.2.8. If you designated a computer to be scanned to create a
software template for shared disks, and you want to designate a different computer, start by
scanning the new computer. After the computer is scanned, and scan results are uploaded
to BigFix Inventory, stop the scan on the computer that you initially designated. Thanks to
this approach, you ensure continuity of software discovery on shared disks.

1. Select the computer that you want to scan to create the new software template.
a. Log in to the BigFix console.
b. In the navigation tree, click Sites > External Sites > BigFix Inventory v10 >
Fixlets and Tasks.
c. In the upper right pane, select Initiate Software Scan on Shared Disks, and click
Take Action.
d. Select the new computer that you want to scan, and click OK.
Tip: If you have the computers grouped, expand Applicable Computers
> By Group, and select a group. Then, from the list of computers that
belong to this group, select one computer to be scanned.
2. After the scan finishes, wait for the scheduled import of data or run it manually.
3. Select the new software template for the computer group that uses the template
created from the initially designated computer.
a. Log in to BigFix Inventory, and go to Management > Computer Groups.
b. Open the computer group that used the old software template.
c. Select the new software template that you want to share among all computers
that belong to this group. Then, click Create.
4. Stop the shared disks scan that is running on the computer that you initially
designated.
a. Log in to the BigFix console.
b. In the navigation tree, click Actions.
c. Look for the action called Initiate Software Scan on Shared Disks that is running
on the computer that you want to stop scanning.
d. Right-click the action, and click Stop Action. Then, click OK to confirm.

Discovering software in Docker containers
Available from 9.2.5. Docker is a platform that allows for automating the
deployment of applications inside software containers. BigFix Inventory discovers software

that is installed inside Docker containers. It also measures license metric utilization of the
discovered BigFix products.

Requirements
BigFix Inventory discovers software that is installed in Docker containers on condition that:
• Only one Docker engine is deployed on the host computer.
• The Docker container is deployed on one of the following platforms:
◦ Red Hat Enterprise Linux 7 for x86
◦ Red Hat Enterprise Linux 7 for BigFix 64-bit)
◦ SUSE Linux 12 for x86
• The Docker container is running.
• The BigFix client is installed on the host computer.
• Scans and uploads of their results are enabled on the host computer.
• Software that is installed in the Docker container delivers software ID tags.
• To ensure proper discovery of software on Docker containers, the content of a Docker
container cannot change throughout its lifecycle.
Starting from application update 9.2.10, BigFix Inventory additionally supports
software discovery on Docker containers under the Red Hat® OpenShift container
application platform.

Viewing software
Software that is installed in Docker containers can be viewed on the Software Installations
report. It is presented under the host computer. To learn why the software was discovered,
click Details.

The details include, among other, information about:
Container on which the software was detected.
Software ID tag that caused the detection.

Measuring license metric utilization
Apart from discovering software that is installed in Docker containers, BigFix Inventory also
reports license metric utilization of the discovered BigFix products. When the Docker is
deployed on a physical host, license metric utilization is calculated on the level of the host.
When it is deployed on a virtual machine, utilization is calculated on the level of the virtual
machine. For more details, see the following scenarios.
Important: Docker is not a subcapacity eligible virtualization but it can be used in
combination with a subcapacity eligible virtualization. The scenarios show how
utilization of PVU and RVU MAPC is calculated. Utilization of other reported metrics
is calculated in an analogical way.
Scenario 1: Docker deployed on a physical server
When the Docker engine is deployed directly on a physical server, PVU and RVU MAPC
utilization is measured on the level of the host computer.
Example: Three containers are deployed on a physical server that has four Intel Xeon 3400
processors, each with six cores. It gives 24 cores in total. IBM MQ is installed in two out of

three containers. BigFix Inventory counts PVU and RVU MAPC utilization on the level of the
host computer.

In this case, IBM MQ has access to 24 cores. According to the PVU table, when the server
has four sockets, this processor model is assigned 100 PVUs per core. Thus, PVU utilization
for IBM MQ equals 2400 PVUs. The value would be the same if another instance of IBM MQ
was installed in the third container.
Scenario 2: Docker deployed on a virtual machine
When the Docker engine is deployed on a virtual machine, PVU and RVU MAPC utilization is
counted as the highest number of PVUs that are available for the virtual machine.
Example: Two virtual machines are installed on a physical server that has four Intel Xeon
3400 processors, each with six cores. It gives 24 cores in total. Each virtual machine is
assigned eight cores and has two containers deployed. IBM MQ is installed:
• In one container on the first virtual machine
• In two containers on the second virtual machine

In this case, IBM MQ that is installed on each of the virtual machines has access to eight
cores. In total, it has access to 16 cores out of 24 cores that are available on the physical
computer. According to the PVU table, when the server has four sockets, this processor
model is assigned 100 PVUs per core. Thus, PVU utilization for IBM MQ equals 1600 PVUs.
If the Docker engine was deployed directly on the physical server, IBM MQ would have
access to 24 cores and its PVU utilization would equal 2400 PVUs.

Logs
To troubleshoot problems with discovery of software that is installed in Docker containers,
see the docker_scan.log log. The log is stored in the BigFix client installation directory.
By default, it is:
var/opt/BesClient/LMT/CIT/docker_scan.log
C:\Program Files (x86)\BigFix Enterprise\BESClient\LMT
\CIT\docker_scan.log

Concept
Collecting the hardware information and capacity data

Configuring scans on Docker containers
Available from 9.2.5. In some Docker environments, you might need to perform
additional steps to specify a non-default installation path, or to exclude directories from
scanning.
Note: To check whether the Docker is installed in the default installation path, run
the following command.
$ docker version

If the result of the command is a Docker version, the Docker is installed in the
default installation path. Any other outcome indicates that the Docker is installed in
a non-default path.
Specifying a non-default installation path for Docker
If Docker is installed in a non-default path, add this path as a setting of the
BigFix client, so that the software can be successfully discovered.
1. Log in to the BigFix console, and click Computer Management >
Computers.
2. Right-click on the computer that has the Docker installed, and click Edit
Computer Settings.
3. Add a computer setting. Specify the name as DOCKER_EXEC, and provide
an absolute path as the value, for example /usr/bin/docker.
Specifying additional command options
By default, the scan runs the Docker command without any options. If you
want to use additional options provided by Docker, for example -H (daemon
socket to connect to), add these options as a new setting of the BigFix client.
Enter all options in one setting.

1. Log in to the BigFix console, and click Computer Management >
Computers.
2. Right-click on the computer that has the Docker installed, and click Edit
Computer Settings.
3. Add a computer setting. Specify the name as DOCKER_OPTS, and
provide options as the value, for example -H unix:///var/run/
docker.sock.
Excluding directories from scans
The default Docker file system directory /var/lib/docker is excluded from
scanning.
If you change the Docker file system directory to a custom directory, you
need to manually exclude it from scanning because it might cause duplicated
discoveries. For more information, see: Excluding directories.

Disabling scans on Docker containers
Available from 9.2.5. By default, BigFix Inventory scans all Docker containers
that are deployed on computers where the BigFix client is installed. If you do not want to
scan the containers but still want to monitor the host computer, change the value of the
DOCKER_SCAN parameter on the host computer.
You can disable software discovery on all containers that are deployed on a host computer.
You cannot disable it on a subset of containers only.
1. Log in to the BigFix console, and click Computers.
2. Select the host computer on which Docker containers are deployed, and click Edit
Settings.
3. Click Add. Specify DOCKER_SCAN as the setting name, and false as the setting value.
Then, click OK.

Docker containers are no longer scanned. Scan results remain in the <BES Client>/LMT/
CIT/docker/containers directory on the host computer but the directory itself is added
to the list of excluded directories. Thus, the results are not transferred to BigFix Inventory.
Important: The Docker file system directory /var/lib/docker might contain
copies of software ID tags. When the Docker scan is enabled, the directory is
excluded from scanning to avoid duplicated software discovery. When you disable
the Docker scan, the directory is included back into regular scans.
If you want to re-enable the scans of Docker containers, change the value of the
DOCKER_SCAN parameter to true.

Excluding directories from being scanned
Excluding some directories from scanning is useful if the directories are large and contain
no information that is important to the software inventory. By excluding them, you can
speed up the scanning process. Some directories are excluded from software scans by
default. They must remain excluded to ensure accuracy of data. You can add or remove
other directories from the list by using tasks in the BigFix console. You can also manually
add them to the scanner files on particular endpoints.
Tip:

Check how long the software scan lasts on each computer. If the

scan is very long, it might indicate that some of the directories on this computer can
be excluded from scanning. For example, because they contain software installation
images or other file repositories not related to IBM software.

To check the scan length, activate the Software Scan Status analysis, and see the
Total Time column.

Directories that are excluded by default
By default, the following directories are excluded from software scans. Ensure that you do
not remove them from the list. It might lead to untested and unsupported results in BigFix
Inventory.
AIX
/proc
*/tmp
*/eznim
*/unicore/lib/*
*/perl/lib/*
*/perl5/*
/usr/src/kernels/*

Note: Starting from scanner version 2.8.0.5000, the /usr/lpp
directory is no longer excluded from software scans. It might cause
that more software components are discovered by BigFix Inventory.
Solaris
/proc
*/tmp
*/eznim
*/unicore/lib/*
*/perl/lib/*
*/perl5/*
/usr/src/kernels/*
/var/spool/pkg

UNIX

/proc
*/tmp
*/eznim
*/unicore/lib/*
*/perl/lib/*
*/perl5/*
/usr/src/kernels/*

Windows
?:/System Volume Information
?:/$Recycle.Bin
?:/RECYCLER
?:/$WINDOWS.~BT/
?:/Windows/servicing/
%CSIDL_WINDOWS%/System32
%CSIDL_WINDOWS%/SysWOW64
%CSIDL_WINDOWS%/winsxs
%CSIDL_WINDOWS%/ServicePackFiles
%CSIDL_WINDOWS%/installer
%CSIDL_WINDOWS%/$NtUninstall
%CSIDL_WINDOWS%/$NtServicePackUninstall*$
%CSIDL_WINDOWS%/$hf_mig$
%CSIDL_WINDOWS%/servicing
*/Windows.old/
*/tmp
*/temp
*/cache/out-of-date
*/Temporary Internet Files
?:/ProgramData/Docker/windowsfilter/
?:/ProgramData/Package Cache
%CSIDL_WINDOWS%/SoftwareDistribution

Retrieving the list of directories that are excluded from being
scanned
To retrieve the list of all directories that are currently excluded from scanning, activate a
relevant analysis in the BigFix console.
1. Log in to the BigFix console.
2. In the navigation tree, click Sites > External Sites > BigFix Inventory v10, and then
click Analyses.

3. Select the Excluded Directories analysis, right-click on it, and then click Activate. The
analysis is activated and starts retrieving the list of directories.
4. To view the excluded directories, click the Results tab. Directories are divided
according to endpoints. You can view the directories in three ways:
• All directories printed on separate lines are listed in the Excluded Directories
column. If an entry says <multiple results>, hover over it to view the
complete list.
• All directories printed on one line and separated with a semicolon (;) are listed in
the Excluded Directories (semicolon separated) column.
• You can also double-click on <multiple results> to view the summary. All
directories are listed in the Excluded Directories entry.

You retrieved the list of all directories that are excluded from scanning. Whenever you
add or remove a directory from the list, you can use this analysis to verify if the operation
succeeded.

Excluding additional directories
You can exclude additional directories from being scanned by specifying them in the task
and then running this task against the chosen endpoints. Excluding directories that do
not contain any information relevant for software inventory can significantly speed up the
scanning process.
Use ASCII characters to specify the names of directories that you want to exclude from
scanning.
Some directories are excluded from being scanned by default. Ensure that you do not
remove them from the list. It might lead to untested and unsupported results in BigFix
Inventory. For the full list, see: Directories that are excluded by default
Using asterisks (*) and question marks (?) to specify the additional directories that
should be excluded
You can use the asterisk (*) and question mark (?) wildcards to specify which
directories to exclude from scanning. Remember about the following rules:

• Asterisks (*) and question marks (?) should be used according to their
regular rules of usage while specifying excluded directories. An asterisk
(*) might represent no characters, or a few consecutive characters. A
question mark (?) represents a single character.
• The number of asterisks (*) and question marks (?) in a single path is
not limited.
• Asterisks (*) and question marks (?) are the only wildcards that are
supported. Other expressions, such as [a]* or [a-z] are not supported,
and should not be used to specify the excluded directories.
Examples of properly specified directories.
Example 1. ?:/System Volume Information
The System Volume Information directory located on any partition
is excluded. For example, c:/System Volume Information and d:/
System Volume Information.
Example 2. */backup*
Any directory on a file system that begins with backup is excluded. For
example, /tmp/backup and /home/user1/backup20170101.
Example 3.
/tmp
/tmp/
/tmp/*
The /tmp directory is excluded.
Note: It is important to place the wildcards in the right position. The
following path patters specify different directories.
/tmp/*
Only the /tmp directory is excluded.

/tmp*
The /tmp directory, as well as any directory starting
with the tmp string are excluded. For example, /tmp1, /
tmp123, and /tmpABC.
*/tmp
Any /tmp directory on file system is excluded. For
example, /tmp, /var/tmp, and /home/user/test/
tmp.

Example 4. *per*lib6*all
Any directory path that contains the per string which is followed by a string
that contains lib6 and ends with all. For example, /usr/opt/perl5/
lib64/5.10.1/aix-thread-multi-64all and /usr/opt/perl5/
lib64/site_perl/5.10.1/aix-thread-multi-64all.
However, according to the rules, this example does not cover the following
path: /usr/opt/perl5/lib64/5.10.1/aix-thread-multi-64all2 as
it does not end with the all.
1. Log in to the BigFix console.
2. In the navigation tree, click Sites > External Sites > BigFix Inventory v10, and then
click Fixlets and Tasks.
3. Select the Add Excluded Directories task.
4. Specify which directories are to be excluded from scanning. If you specify a particular
directory, it is excluded along with all its sub-directories.
in the directory path.

Use only slashes (/)

5. Click Take Action and select endpoints for which you want to apply the changes.
You added new entries to the list of directories that are excluded from scanning.

Including the excluded directories back in scans
You can include a directory back in the software scan by specifying it in a task, and running
this the task against the chosen endpoints.
Some directories are excluded from being scanned by default. Ensure that you do not
remove them from the list. It might lead to untested and unsupported results in BigFix
Inventory. For the full list, see: Directories that are excluded by default.
1. Log in to the BigFix console.
2. In the navigation tree, click Sites > External Sites > BigFix Inventory v10, and then
click Fixlets and Tasks.
3. Select the Remove Excluded Directories task.
4. Specify which directories are to be removed from the list of excluded directories.

5. Click Take Action and select endpoints for which you want to apply the changes.
You removed the entries from the list of directories that are excluded from scanning. Those
directories are now scanned during the software scan.

Manually excluding directories
After you install the scanner, you can specify which directories are to be excluded from
scanning during the raw scan of the file system.
Important: Use ASCII characters to specify the names of directories that you want
to exclude from scanning.
You specify those directories by adding paths to the exclude_path.txt file that is in the
<BES Client>LMT/CIT directory. Each path must be added on a separate line. For more
information about modifying the file, see: Excluding additional directories
The file already contains some entries depending on the operating system. You can remove
the content of the file which means that no paths are excluded from the scan. However,
if you delete the whole file, it will be recreated with the default content before the next
software scan.
Unless you exclude specific paths, all the following drives are included in the scan:
All local drives and other drives, such as floppy disk, CD-ROM, and DVD.

•

Note: Remote drives are not scanned.
•

All local drives.

Specify paths according to the following syntax:
drive:path

Important: When you specify a path delimiter, you must use a forward slash (/)
instead of a backslash (\). For example, C:/Program Files.
drive
Specifies the drive. Asterisks (*) and question marks (?) are supported. This
variable is optional on UNIX.
path
Specifies the path. Asterisks (*) and question marks (?) are supported. This
variable also supports the following CSIDL values on Windows:
%CSIDL_WINDOWS%
%CSIDL_PROGRAM_FILES%
%CSIDL_COMMON_DESKTOPDIRECTORY%
%CSIDL_COMMON_STARTMENU%
%CSIDL_COMMON_STARTMENU%
%CSIDL_COMMON_STARTUP%
%CSIDL_COMMON_PROGRAMS%
Important: The above CSIDL values already have a drive specified. If
you use them, omit the drive variable.
You can refer to the following examples when specifying your paths.
• Excludes the System Volume Information folder on any local drive:
?:/System Volume Information

• Excludes the System32 folder on the local drive that is specified in the CSIDL value:
%CSIDL_WINDOWS%/System32

Discovering software and hardware with disconnected scanner on
Windows and UNIX
Available from 9.2.7. You can discover software and hardware inventory by using
disconnected scans that do not require direct connection between the scanned computers
and the BigFix server. Scripts that are provided in the disconnected scanner package initiate
software and capacity scans, and prepare scan results that you later on upload to BigFix
Inventory.

Disclaimer
Restriction: If you use the disconnected scanner for IBM Virtualization Capacity,
also referred to as subcapacity licensing, you must comply with the following rules:
• You must obtain the approval from IBM Compliance to use disconnected
scans. To request for such an approval, contact your IBM Sales
Representative who will instruct you on how to contact IBM Compliance.
• Disconnected scans can be applied when the BigFix client cannot be installed
due to technical, legal, business,or security reasons, or in case of other valid
justification.
• The disconnected scanner for IBM Virtual Capacity can be deployed only to
supported and eligible operating systems.
The BigFix client is not available for IBM iSeries, and thus it is the
only method of software and hardware discovery on these systems. Unlike on
other operating systems, approval from IBM Compliance is not required to use
disconnected scans on IBM i. For more information, see: Discovering software and
hardware on IBM i.
Disconnected scans should be used with caution, especially when you use BigFix Inventory
for subcapacity reporting. They require much more user control and manual maintenance
including scanner and catalog updates, periodic transfer of data, and manual health checks
to assure report correctness. The maintenance is customer responsibility because it is not
automated as in case of the BigFix client.

Disconnected scanner package
To collect the software and hardware inventory data, you need an endpoint package that
consists of:
• Scanner
• Configuration files
• Scripts to run the scans and prepare the scan result package
The scripts initiate software and capacity scans, gather scan results, and adjust them to the
format that is compatible with BigFix Inventory. If the scripts are not appropriate for your
environment, you can edit and customize them, or create new scripts that better fit your
needs.

Scalability
You can collect data from up to 25000 disconnected endpoints on condition that the
computer where the BigFix Inventory server is installed meets hardware requirements for
very large environments. For more information about the requirements, see: Hardware
requirements for the server on Linux and Hardware requirements for the server on Windows.
Additionally, to ensure good performance of importing the scan results, complete the
following configuration.
• Run the software scan on weekly basis.
• Distribute the import of result packages over the week so that a subset of packages
is imported every day. For example, import 5000 packages every day from Monday to
Friday.
• Set up automatic removal of scan results from the disconnected data source directory
after the results are successfully imported to BigFix Inventory. To automatically
remove the packages, go to Management > Advanced Server Settings and set the
value of the delete_successfully_imported_scans parameter, to true.
• Configure the transaction logs size and increase the Java heap size. For more
information, see: Tuning performance in medium and large environments.
•

Change the ulimit -n value to 4096.

Scan frequency
For information about default and minimal scan frequency as well as recommended
frequency of importing scan results, see: Frequency of scans and uploads of data.

Multiple environments
When you have multiple environments, for example test and production, ensure that the
following requirements are met:
• Every computer reports only one of the environments.
• Results of the disconnected scan from one environment are not uploaded to BigFix
Inventory that monitors the other environment.

Limitations
• Resource utilization, and metering data are not supported. For more information, see:
Raw utilization of license metrics.
• Scanning remote shared file systems is not supported.
• Detailed hardware scan cannot be collected if you use the disconnected scan.
• The disconnected scanner always collects full scans, not delta scans.
• The directories that are excluded from software scans by default cannot be used as
installation directories. To view the full list, see: List of excluded directories.
The Package Data report does not provide any information in the

•

Description column.
• The information provided in the Operating System column might be slightly different
for the computers that are scanned by the disconnected scan, and the computers
scanned by a regular scan.
• The disconnected scan does not include additional computer properties that are
defined by the user. To collect these details, you need to define additional entries in
the computer.yml file.

Concept
Discovering software and hardware on IBM i

Disconnected scanner requirements
Available from 9.2.7. The list of disk space requirements, and the supported
operating systems compatible with the disconnected scanner.
Table 144. Disconnected scanner requirements
Operat
ing system
Windows

Supported versions

Required disk space

For information about supported

40 MB + disk space for the scan

versions, see: BigFix 9.5 - System ner cache
Requirements and choose BigFix

Linux

Inventory 9.5 application update
9.2.16.
Solaris

24 MB + disk space for the scan
ner cache
80 MB + disk space for the scan
ner cache.

AIX

80 MB + disk space for the scan
ner cache.

HPUX

48 MB + disk space for the scan
ner cache.

Adding a new data source for disconnected scans
Available from 9.2.7. All scan results are imported to BigFix Inventory from a
directory dedicated to disconnected scans. Add this directory as a data source to allow
BigFix Inventory to check its content and import all packages that are stored within. The
packages are imported during each data import.
All scan results must be manually transferred from all endpoints into the new directory that
works as a data source. You can automate this process by using NFS, or by other means
that better suit your environment.

1. On the computer where BigFix Inventory server is installed, create a directory with
read and write access, for example:
•

/disconnected

•

C:\disconnected

2. Log in to BigFix Inventory, and in the top navigation bar click Management > Data
Sources.
3. Click New, and specify the following values:
a. Specify the name of this data source.
b. Specify the Database Type as Disconnected.
c. Specify the location of the directory that you created.
Note: The path is not validated. Ensure that you provide a correct one.

4. Download the catalog for the appropriate platform. It is needed for software
discovery. You will copy it to your systems together with the scanner, and the
configuration files.
5. Click Create.
Prepare installation files for disconnected scans.

Preparing installation files for disconnected scans
Available from 9.2.7. After you add the disconnected data source, prepare the
installation package and distribute it to the disconnected systems. The package should
contain the scanner, software catalog and the configuration files that are used to initiate
scans. You can download the catalog from the BigFix Inventory server.
Prepare the installation files for disconnected scans in a few easy steps. First, obtain the
disconnected scanner package and include the software catalog in it. If needed, configure
the scans by making modifications in the setup_config.ini file, and performing the
optional optimization. Then, upload the disconnected scanner packages to endpoints.
1. To obtain the disconnected scanner package, follow one of the listed paths.
• Go to the BigFix console and run Download the Disconnected Scanner Package
(version) fixlet to download the disconnected scanner package.
• The name of the disconnected scanner package follows the specific naming
convention: BFI-DisconnectedScanner-<platform>-<version><timestamp>.
2. Download the software catalog.
a. Log in to BigFix Inventory, and go to Management > Data Sources.
b. Select your disconnected data source.
c. Download the catalog for the appropriate platform.
3. Prepare the content of the disconnected scanner directory.
a. Unpack the disconnected scanner package on the computer from which you
intend to transfer the scanner to your endpoints.
b. Open the config directory in the unpacked package.
c. Place the catalog file CIT_catalog_PLATFORM.xml in the config directory.

4. Optional Perform optional configuration and optimization of the scanner.
You can configure the disconnected scan settings mainly by editing the
setup_config.ini file that is located in the config directory of the unpacked
package. If you upgrade the disconnected scanner, the setup_config.ini file is
overwritten and you must configure the scheduled scans and output directory again.
To schedule regular software or hardware scans, edit the

a.

setup_config.ini file that is located in the config directory of the
unpacked package.
• For scheduling regular software scans configure the following
parameters.
◦ SW_SCAN_SCHEDULE_ENABLED parameter enables regular
software scans on the endpoint. To schedule regular software
scans, set the parameter to TRUE.
◦ SW_SCAN_FREQUENCY parameter allows you to configure the
frequency of software scans. Set the parameter to WEEKLY or
DAILY. The first software scan is initiated after you install the
scanner. For more information, see: Installing the scanner and
gathering initial data. Subsequent scans will run on that time with
the frequency you choose.
•

The capacity scan runs regularly. However,
if you want to collect the capacity data only once, set the
HW_SCAN_SCHEDULE_ENABLED parameter to FALSE.

For more advanced configuration, you can edit the settings of cron on Unix, or
Task Scheduler on Windows.
b.

To configure the output directory for the disconnected scanner, edit
the PACKAGE_OUTPUT_DIR parameter in the setup_config.ini file that is
located in the config directory of the unpacked package.
• PACKAGE_OUTPUT_DIR parameter allows you to configure the path
where the scan results are stored. Provide a relative or absolute path. A
base of the relative path is the installation directory of the disconnected
scanner. The default path is ./output.

c. If any further modifications are required, customize the configuration files
before distributing them to endpoints in your environment. Then, you do not
need to configure each endpoint individually. You can change the default
configuration; for example, limit the processor utilization, or specify the
directories that need to be excluded from being scanned. For more information,
see: Troubleshooting the discovery by disconnected scanner.
Note:

The fs_config.xml file contains the list of collected

file extensions under the FileMask parameter. If it is required, you can
narrow down this list by removing the unwanted extensions from the
file. For other supported systems, the list of extensions is configured
automatically based on the software catalog.
5. Upload the whole content of the disconnected scanner package to the endpoints. Do
not change file names.
Note: After you install the scanner on endpoints, the scanner installation path
cannot be changed. The installation path is a location where you upload the
installation files. To change the installation path, back up the configuration
files, scan results and logs. Then, uninstall the scanner, move the files to a
different directory, and then install the scanner in a new location.

Restriction:
The installation path should not contain any white space
characters.
The installation path should be short, and should not contain any
special characters or spaces.
The name of the directory where the installation files are copied
cannot contain any special or national characters. Spaces are allowed. The
entire path cannot exceed the total of 99 characters.

Install the scanner and gather initial data.

Installing the scanner and gathering initial data
Available from 9.2.7. After you copied the installation files and the software
catalog to the endpoints, start the installation and the initial scans.
• To perform this task, you must have the appropriate privileges.
◦

root

◦

administrative privileges with elevation

• If you use License Metric Tool or Tivoli® Asset Discovery for Distributed 7.x,
remember that the installation of the disconnected scanner stops the 7.x agent. You
need to restart the 7.x agent after the setup.
1. Go to the directory where you copied the installation files.
2. Run the setup file.
•

setup.sh

•

setup.bat

It automatically performs the following steps:
• Installs the scanner
• Runs the initial capacity scan, and creates the computer.yml file.
The initial capacity scan is needed to collect data about your system, and to
create the computer.yml file that will identify this system. The file is added
to each package with scan results and it helps to catalog and correctly display
them in the user interface. It contains information about the operating system,
such as host name, and a unique computer ID.
Note:

For older versions of Red Hat Linux on s390 mainframe,

it can be required to manually provide machine type, processor type,
shared pool capacity, and system active processors. The script will ask
you to specify these parameters if the scanner cannot collect these
details automatically.

For Solaris systems that run on SPARC, it is required to specify
if the system is in Dynamic System Domains.
• Schedules regular capacity scans.
The capacity scan is scheduled to run every 30 minutes to gather current
results for virtualized environments where the capacity can dynamically change
depending on the allocated resources.
If you want to collect the scan data only once, run the setup
file with the -noschedule option.
Note:

The -noschedule option is not applicable on Linux

systems. You can configure the HW_SCAN_SCHEDULE_ENABLED
parameter to run a one-time capacity scan. For more information, see
Preparing installation files for disconnected scans.
The scanner is set up now, and ready to run the software scan and gather results. During
installation, the endpoint_id.txt file was created in the config directory. The file
contains the host name, and the time stamp of the first setup. The combination of these
two elements becomes an endpoint identifier that can be modified by the user if needed. In
case of scanner upgrade, or re-installation, the existing endpoint identifier from the file will
be used.
Run the software scan and gather scan results.

Running software scans and gathering scan results
Available from 9.2.7. The script that is responsible for the software scan collects
the results of the catalog-based, package data, and ISO tags scan as well as retrieves
results of the capacity scan and the computer.yml file. All these results are combined
and compressed into a common .zip or tag.gz package that can be imported to BigFix
Inventory.

• Make sure that you have the appropriate privileges to perform this task.
◦

root

◦

administrative privileges with elevation

• Each time you update the software catalog in BigFix Inventory, run an import of data
or wait for the scheduled import. Next download the newest version of software
catalog to an endpoint to run the software scan on it. For more information, see:
Downloading the software catalog.
• The scan takes around 30 minutes. The exact time depends on the computer load, file
system size, and the CPU threshold if you set it.
• For information about default and minimal scan frequency, see: Frequency of scans
and uploads of data.
• By default, no limit is set on the processor usage during the scan. To limit processor
usage, set the CPU threshold. For more information, see: Optimizing the processor
utilization.
1. Go to the directory, where you uploaded the disconnected scan package.
2. Run the following script to initiate the scan.
•

run_sw_and_pack.sh

•

run_sw_and_pack.bat

A compressed package with scan results was created in the output directory. It contains
capacity scan results since the date when the last package was generated. The
uncompressed scan results are deleted from their original location to ensure that they are
not included in any future packages.
Import the package to BigFix Inventory. After it is successfully imported, delete it from the
endpoint to save disk space.

Importing scan results to BigFix Inventory
Available from 9.2.7. To import new scan results to BigFix Inventory, copy the
package to the disconnected scans directory that you added as a data source.

• For information about recommended frequency of importing scan results, see:
Frequency of scans and uploads of data.
• If you upload a package with older results, the current ones are overwritten.
• Discovered software is reported with the import time, not the package time stamp.
• Import only one package per endpoint. Otherwise, capacity results might be skipped.
• Processed packages are not removed from your disconnected scans directory. The
ones already imported are skipped.
1. Go to the directory where you uploaded the disconnected scan package. Ensure that a
result package was created in the output directory after the software scan.
The package name uses the <UTC_DATE>-<hostname>.<extension> pattern. It
contains the following files:
•

capacity.tar.gz, catalog_scan.xml, computer.yml,
isotag_scan.tar.gz, package_scan.xml, source.tar.gz,
file_scan.xml

•

capacity.zip, catalog_scan.xml, computer.yml,
isotag_scan.zip, package_scan.xml, source.zip, file_scan.xml

2. Copy the package into the disconnected scans directory that you added as a data
source in BigFix Inventory.
3. Wait for the scheduled import or run it manually.
During the data import, BigFix Inventory checks the directory that you added as a data
source and imports scan packages that meet the requirements. Scan results are processed
and displayed on the reports in the user interface.
Files from processed packages are saved in the installation_directory/wlp/usr/
servers/server1/tmp/datasources/Datasource_ID directory.
The processed packages are stored in the directory specified in the data source
configuration. The packages are not automatically removed. It is recommended to create
the audit snapshot once a quarter. Then, back up the packages in a different directory, and
remove them from the directory specified in the data source configuration.

Disconnected scanner maintenance and troubleshooting
Available from 9.2.7. You can use the maintenance and troubleshooting tasks to
monitor the scan progress, optimize the processor usage during the scan, understand and
fix the most common issues, or learn more about the log files.

Updating the scanner and the scripts
Available from 9.2.7. Both the scanner and the scripts are updated on a regular
basis to introduce improvements and new functions. To update the scanner, once again
download all the required files, and copy them into the directory where the previous version
is already located.
1. Log in to the BigFix console.
2. In the navigation bar, click Sites > External Sites > BigFix Inventory v10 > Fixlets and
Tasks.
3. In the upper right pane, select Download the Disconnected Scanner Package
(version).
4. To run the task, click Take Action. Choose the disconnected scanner package for the
appropriate platform from the drop-down menu.
5. Optional: If you made any changes to the software scan configuration files
sw_config.xml, fs_config.xml, or isotag_config.xml, make sure that you
back up the files before you extract the package. These files are overwritten.
6. Extract the contents to the disconnected scanner directory.
7. Optional: If you recently updated the software catalog in BigFix Inventory, update it
also on the system with the disconnected scanner.
a. To download the software catalog for disconnected scanner, log in to
BigFix Inventory and navigate to Management > Data Source. Choose the
disconnected data source, and download the catalog for the appropriate
platform.
b. Place the catalog in the config directory of the disconnected scanner package
that you downloaded through fixlet.

Note: The catalog is available for download after uploading the main software
catalog and running a data import.
8. Optional: If you made any changes to the software scan configuration files:
sw_config.xml, fs_config.xml or isotag_config.xml, modify the new file
versions to reflect the changes. Look at the back up files that you created in step 5,
and rewrite the changes to modify the new files. Do not copy the old back up files as
they might differ between the versions.
9. Run the setup file.
•

setup.sh

•

setup.bat

Decommissioning computers with disconnected scanners
Available from 9.2.7. When you decommission a computer that is no longer in
use, you can mark it as decommissioned on the Computers report, so that it is not displayed
in BigFix Inventory.
You must have the Manage Computer groups permissions to use this API.
1. In the top navigation bar, click Reports > Computers.
2. Click the computer name.
3. Click Decomission computer.

After you decommission the computer, this computer does not show up on the current
reports. You can still manage the software on the Software Classification panel, but it is
marked as uninstalled. The software is still displayed on the All Metrics report.

Uninstalling the disconnected scanner
Available from 9.2.7. If you no longer need the disconnected scanner to scan the
computer, you can uninstall it from any endpoint.
1. Open the directory where the disconnected scanner is installed.
2. Create a back up of endpoint_id.txt file that is located in config directory. This
file will be required to install disconnected scanner on the endpoint again in the future.
3. Run the following script.
•

./uninstall.sh

•

uninstall.bat

4. Remove the whole directory where the disconnected scanner was installed.
The scanner is successfully uninstalled, the data is no longer collected and all software and
hardware scans stop.

Understanding the Deployment Health and Software Scan Health
Available from 9.2.7. Deployment Health and Software Scan Health contain
information about your clients and the scans that were initiated. You can view this
information on the Deployment Health, and Software Scan Health widgets on the
dashboard, or on the Computers report. Deployment Health excludes all the disconnected
datasource endpoints. To properly understand values that are displayed for systems
scanned with disconnected scans, see the explanation of particular columns on the
Computers report.

Table 145. Explanation of Deployment Health and Software Scan Health information
for systems with disconnected scans
Column Name
Has Outdated

Description
Always shows No.

Version
Has Low Disk

Always shows No.

Space
Is Out of Sync

Always shows No.

Has Missing

Always shows No.

Prerequisites
Agent Version Taken from the Agent Version property in the computer.yml file.
Catalog Scan

Shows Yes if the imported package contains the catalog_s-

Successful

can.xml file.

Software Tags Shows Yes if the imported package contains the isotag_scan pack
Scan Success age.
ful
File System

Shows Yes if the imported package contains the file_scan.xml

Scan Success file.
ful
Package Scan Shows Yes if the imported package contains the package_sSuccessful

can.xml file.

Catalog Ver

Taken from the Catalog Version property in the computer.yml file.

sion
Endpoint

Taken from the Catalog Version property in the computer.yml file.

Scanner Cata

It displays only the second part of the whole catalog version, for ex

log Version

ample 1250110.1.

Table 145. Explanation of Deployment Health and Software Scan Health information
for systems with disconnected scans
(continued)
Column Name
Last Scan At

Description
Taken from the timestamp used in the final package name.

tempt
Scanning

Always shows No.

Shared Disks
Mounted

Always shows ''.

Shared Disks

Troubleshooting the discovery by disconnected scanner
Available from 9.2.7. The troubleshooting section lists the most common
issues you might encounter while discovering software and hardware inventory with
the disconnected scanner. The main objective of troubleshooting is to determine why
something does not work as expected and explain how to resolve the problem.

Log files
Scanner log files are in the following directory:
Installation directory/logs
Installation directory\logs

Optimizing the processor utilization
By default, processor utilization is not limited during the scan. You can optimize it by setting
up the CPU threshold. Setting the threshold might lengthen the time of the scan.
Note: Setting the threshold does not guarantee that the CPU consumption is always
below the specified value. It fluctuates around that value, sometimes exceeding

it and sometimes dropping below it. Temporary peaks are expected. Setting the
threshold might lengthen the time of the scan.
1. Edit the configuration file or files that you downloaded with the scanner:
sw_config.xml, fs_config.xml, isotag_config.xml.
2. Add new cpuThreshold attributes in the appropriate file.
• For FSScanner add a corresponding parameter in the following files:
sw_config.xml, fs_config.xml, isotag_config.xml
• For Signatures add a corresponding parameter in the sw_config.xml file.
For example:
• sw_config.xml
<CIT>
<XSE version="1.0">
<Plugins>
<Plugin name="FSScanner">
(...)
<Attribute name="cpuThreshold" value="20:2:150:850"/>
<Attribute name="maxQueryTime" value="43200"/>
<Attribute name="interruptOnTimeout" value="true"/>
<Attribute name="assumeAutoFS" value="remote"/>
(...)
</Plugin>
</Plugins>
<Signatures>
<Attribute name="cpuThreshold" value="20:2:150:850"/>
(...)
</Signatures>
</XSE>
</CIT>
</IBM>

• fs_config.xml or isotag_config.xml

<IBM>
<CIT>
<FSScan version="1.0">
(...)
<Provider value="provider_cache"/>
<AssumeAutoFS value="remote"/>
<CpuThreshold value="20:2:150:850"/>
</FSScan>
</CIT>
</IBM>

3. Specify one of the following values:
Desired
utiliza
tion

Value

5%

10:2:50:950

10%

20:2:100:900

15%

20:2:150:850

20%

30:2:200:800

25%

30:2:250:750

50%

50:2:300:500

4. Save the file.

Excluding directories from being scanned
You can exclude directories from being scanned. To do this, edit all configurations files:
sw_config.xml, fs_config.xml, isotag_config.xml, and specify the directories as
values of the excludeDirectory attributes.

• To exclude the /tmp directory:
◦ in sw_config.xml: <Attribute name="excludeDirectory" value="/tmp/"/>
◦ in fs_config.xml and isotag_config.xml: <ExcludeDirectory value="/
tmp/">

• To exclude all directories named tmp, for example /tmp and /dir/tmp:
◦ in sw_config.xml: <Attribute name="excludeDirectory" value="*/tmp/"/
>

◦ in fs_config.xml and isotag_config.xml: <ExcludeDirectory
value="*/tmp/">

Common problems
The package is being skipped during the import despite meeting the requirements
Such a problem might occur if you are importing more than one package from
an endpoint. BigFix Inventory always imports the latest package and omits all
previous ones. The following message about skipping the package is related
to irrelevant packages and can be ignored:
2015-11-05 09:35:22 WARN: Skipping file: package_scan.xml from:
201510101200-2inarow.zip.
The data was already processed.
2015-11-05 09:35:22 INFO: Skipping file: package_scan.xml.
Unsupported file in: 201510101200-2inarow.zip.

The detected software is duplicated in BigFix Inventory after reinstalling disconnected
scanner
If you uninstall the disconnected scanner and remove its directory from a
computer, and then reinstall the disconnected scanner, the endpoint ID of
this computer is changed. As a result, the software inventory is duplicated
in BigFix Inventory. To avoid duplication after you reinstall the disconnected
scanner, perform the following actions.

1. Go to config directory, and substitute the endpoint_id.txt file with
the backup file you created before uninstallation. For more information,
see: Uninstalling the disconnected scanner. Changing the endpoint ID
allows you to keep the historical data, and collect the new data for this
endpoint.
2. Check the DNS and IP address of the endpoint.
3. Log in to BigFix Inventory.
4. Navigate to Reports > Computers.
5. To identify the duplicated computer, add the following columns to the
report DNS Name, IP Address and Computer First Seen.
6. Compare the two computers with the same DNS Name and IP Address,
and find the one that was first seen more recently.
7. Decommission this computer. For more information, see:
Decommissioning computers with disconnected scanners.
8. Wait for the scheduled import or run it manually.
The host name of an endpoint provided by the disconnected scanner is different than
expected
The host name that is provided by the disconnected scanner and a regular
scanner can be different. The regular scanner uses the host name that is
provided by BigFix, while the disconnected scanner checks the host name
by running the hostname command, or, if not available, through the scanner
check.
Installation of the scanner and the capacity scan are slow on AIX
It happens when the host name cannot be resolved. To solve the problem, add
the host name to DNS or to the /etc/hosts file. The default configuration of
the name resolver on AIX first looks for the host name in the DNS then in the
/etc/hosts file. If you add the host name to the hosts file, you might also
need to make changes in the /etc/netsvc.conf file and restart the system.

Monitoring the import log
When you import a package with scan results to BigFix Inventory, the import log
(Management > Data Imports) displays information and warning messages related to
your package. If the package or its content does not meet the requirements, it might be
skipped during the import, and the scan results will not be displayed in BigFix Inventory.
While monitoring the import log, you can expect the following messages:
info: Processing scan package: package from: directory.
info: Invalid file name. The scan package must match the pattern
YYYYMMDDHHMM-*.zip. Skipping package: package.
info: Invalid Catalog Version property in the computer.yml file: version.
The property must match the pattern <Number>.<Number>. The catalog might
be reported as outdated.
warn: The disconnected scans location does not exist: directory.
warn: Invalid file name. The scan date must be later than year 2000.
Skipping package: package.
warn: Skipping corrupted scan package: package. The following error
occurred: error.
warn: Missing computer.yml file. Skipping package: package.
warn: Missing property: property in the computer.yml file. Skipping
package: package.
warn: Invalid computer.yml file. Skipping package: package. The following
error occurred: error.
warn: The value of the endpointID property in the computer.yml file is
longer than 512 characters. Skipping package: package.
warn: The value of the endpointID property in the computer.yml file is
empty. Skipping package: package.
warn: Missing property: endpointID in the computer.yml file. Skipping
package: package.
warn: Importing older scan package from: date for computer: computer_id.
This computer already has data from: date.
warn: The file is larger than 2097150 bytes. Skipping file: scan_file from:
package for computer: computer_id.

warn: The following error occurred when processing the package_scan.xml
file: error.
warn: The insertion of the operating_system package data into the database
failed on record content. The following error occurred: error.

Scheduling imports of data
BigFix clients report data to the BigFix server that stores the data in its file system or
database. BigFix Inventory server connects to the BigFix server and its database, downloads
the stored data, and processes it. This process is called an import or Extract, Transform,
Load (ETL). By default, the import runs once a day at midnight. You can schedule it for a
period that is most suitable for your environment considering its size and specification.
You must have the Manage Imports permission to perform this task.
The import of data is an Extract, Transform, Load (ETL) process.
• During the Extract stage, data is extracted from the BigFix server. It includes
information about the infrastructure, installed clients, and detected software. ETL also
checks whether a new software catalog is available, gathers information about the
software scan and files that are present on the computers. It also collects data from
VM managers.
• During the Transform stage, the extracted data is transformed to a single format that
can be loaded to the BigFix Inventory database. This stage also involves matching
scan data with the software catalog, calculating processor value units (PVUs),
processing the capacity scan, and converting information that is contained in the XML
files.
• During the Load stage, the data that was extracted and transformed is loaded into the
BigFix Inventory database and can be used by BigFix Inventory.
1. In the navigation bar, click Management > Data Imports.
2. To schedule regular imports, select Enabled, specify the number of daily imports and
their hours, and click Save.

Information about data imports and their status is displayed in the import history.

Note: An error may appear during data import. Wait for few seconds or refresh the
page to allow the application to get back to its previous state.
We're sorry, the application is not accessible. (503)
An import is finalizing. Refresh the page to see the new data.

If you want to quickly discover recent changes to software inventory without having to wait
for the complete data import, you can schedule imports of raw data. Such imports are much
quicker but the imported data is not visible in the user interface. It can be retrieved only by
using REST API. For more information, see: Importing raw scan data.
If the imports of data are failing, you can enable partial imports. For more
information, see: Enabling partial imports.

Importing raw scan data
Available from 9.2.2. You can schedule an import of raw scan data. Such an
import is much quicker, because it only imports raw scan results, and omits successive
steps, such as aggregation and license calculations. The imported raw data, however, is
not updated in the user interface, and can only be retrieved by using REST API. This type of
import is used to quickly discover recent changes to software inventory without having to
wait for the complete data import.
• The Raw Data Only import does not replace the complete data import, which must be
run regularly to process and aggregate the data.
• The Raw Data Only import can be run only as a scheduled import. When you click
Import Now, you always run a complete data import.
• To run the Raw Data Only import only once, use REST API. For more information, see:
Running data imports.
1. To enable this feature, go to https://hostname:port/management/feature,
and select Enable the Raw Data Only import mode.
2. In the navigation bar, click Management > Data Imports.
3. To schedule regular imports, select Enabled, and specify the number of daily imports
and their hours.

4. Select Raw Data Only next to each import that you want to use for importing raw scan
results.

5. Click Save.
Information about completed data imports is displayed in the import history. Each entry has
an icon that indicates the type of the import, either Complete or Raw Data Only.

When the Raw Data Only import finishes, retrieve the imported raw data by using REST API.
For more information, see REST API for retrieving raw scan results.

Enabling partial imports
Available from 9.2.11. If the imports of data are failing, you can enable partial
imports. Such imports process all steps and continue even if steps that are not crucial for
the operation of BigFix Inventory fail. These imports allow for avoiding accumulation of
scan data during the period when you troubleshoot the problem.
1. In the navigation bar, go to Management > Advanced Server Settings.
2. Change the value of the enable_partial_imports parameter to true.

Information about data imports and their status is displayed in the import history. Partial
imports are indicated by a warning sign.

Partial imports might fail if any of the steps that are crucial for the operation of BigFix
Inventory is disrupted, for example, if the database connection does not work. The imports
that fail are displayed in red in the import history.
After the problem is solved, and imports complete successfully, disable partial imports.

Notifications that are sent when imports of data and catalogs fail
BigFix Inventory sends notifications about failed data and catalog imports in the To Do
List. It also sends you email notifications for failed imports if you chose to receive email
notifications.

To Do List
The To Do List shows notifications about the following events:
•

Failed import of data shows the date and time when the data import failed
and the date and time of the last successful import.

•

Failed catalog import shows the date and time when the catalog import failed
and the date and time of the last successful import.

•

Failed IBM catalog import shows the date and time when the IBM catalog
import failed and the date and time of the last successful catalog import.

The date and time show the start time of the import (the time when the import was
initiated). The time shown the in the To Do List is the user's local time. The notification also
provides a link so that you can analyze the issue.

The To Do List does not show notifications for incomplete and interrupted imports. It also
does not show notification about imports that are successfully generated but shows errors
in the error log.
The To Do List notification is shown in the following format:

Email notifications
You can enable email notifications if you chose to receive such notifications. If you enable
email notifications, the user receives emails for failed events, such as failed data import,
failed catalog import, and failed IBM catalog import. The date and time included in the
email is in UTC. The email notification option is disabled by default. Failed import email
notification settings are available to all users who have access to data imports.

Note: You must have Manage Data Import permission to set up email notification.
For information about how to configure a SMTP server or Mail Setting, refer to
Configuring the server to send mail notifications.
To set email notification, perform these steps:
1. Click Management > Data Imports.
2. Select Send failed data and catalog import notifications checkbox.
3. In the Email field, enter an email address.
4. In the Language field, select a language.
5. Click Save to save the configuration.

The user receives email notifications in the following format:

Note:
If you do not receive email notifications for failed imports, check the import log and
mail_error.log. The To Do list might not show notifications, but an email is sent
to the user in some cases, as follows:
• The initial import failure
• When only the HCL charge units import fails, but other parts of HCL catalog
import succeeded

Creating capacity configuration for Linux on z Systems
To properly calculate subcapacity values for products that are installed on Linux on z
Systems, create capacity configuration for such computers. First, run a fixlet that creates a
file with manually entered capacity values and places it on the target computer. Then, run
regular software and capacity scans to discover the installed software and calculate its
license metric utilization.
Note: Automatic capacity configuration is supported on Linux on z/KVM and on
System z10 starting from model E64 (type 2097) mainframes with z/VM 6.3 and
later that supports the Store Hypervisor Information (STHYI) instruction. If the
automatic capacity configuration is supported, you do not have to perform any
manual actions to calculate the capacity values.
The Create Capacity Configuration for Linux on z Systems fixlet is relevant on all
computers where manual configuration is required. It is not relevant on computers where
automatic capacity configuration is supported. If the fixlet is not relevant, you do not have to
perform any manual actions to calculate the capacity values.
1. Log in to the BigFix console.
2. In the navigation tree, click Sites > External Sites > BigFix Inventory v10 > Fixlets and
Tasks.

3. Select Create Capacity Configuration for Linux on z Systems and specify the
following values:
• Machine Type
• Processor Type
• Shared Pool Capacity
• System Active Processors
4. To run the task, click Take Action.
5. Select computers for which you want to create the capacity configuration, and click
OK.
The fixlet is relevant only on computers on which creating the manual configuration is
required.
You created capacity configuration that will be used to calculate subcapacity values. If you
want to edit or delete the capacity configuration, use the Edit Capacity Configuration for
Linux on z Systems or Delete Capacity Configuration for Linux on z Systems task.
To discover software that installed on the computers and calculate its license metric
utilization, schedule regular software and capacity scans. For more information, see:
Initiating software scans, and Initiating the capacity scan on all computers.

Setting the DSD mode on Solaris
If a computer runs the Solaris operating system and is in the DSD domain, set the DSD
mode to ensure that metric utilization is correctly calculated for software that is installed
on this computer. If you do not set the DSD mode, Solaris machines in DSD might not be
properly identified and metric utilization might be underestimated.
1. Log in to the BigFix console.
2. In the navigation tree, click Sites > External Sites > BigFix Inventory v10 > Fixlets and
Tasks.
3. Select Set DSD Mode and then in the lower pane, click Take Action.
4. Select computers for which you want to set the DSD mode, and click OK.
5. Optional: If you want to remove the DSD mode, use the Unset DSD Mode task.

Advanced Scanner Configuration Option
BigFix Inventory supports following configuration options for Scanner:
• Configuring Scan Cache
• Changing Scanner Cache Folder
• Configuring Scanner Query Timeout
The options are available as dedicated fixlets in BigFix Inventory site. To access the options,
navigate to Sites > External Sites > BigFix Inventory v10 > Fixlets and Tasks. You do not
need to change the settings. The product is pre-configured with optimal settings.

Configuring Scan Cache
This task allows you to configure file system scan cache. By default, the cache is enabled
and is cleared after every scan. The cache is shared by different scan types. Disabling the
cache impacts scan performance. The task is applicable only on computers where the
scanner is installed.
To resolve issues with disk space, change the location of the cache folder to Fixlet Change
Scanner Cache folder. To check the current scanner cache settings, activate the Scanner
Information analysis.

Available configuration options
File system cache settings:
There are two options available:
1. Invalidate cache after 24 hours – cache is preserved after scan and can be used with
next BigFix Inventory scan within 24 hours
2. Empty cache after every scan – cache is removed at the end of the scan

Use experimental CIT Scanner Cache3
From version 10.0.8, Cache 3, a new mechanism for caching information has been
introduced. CIT Scanner Cache3 is optimized for lower CPU and memory footprint

compared to default Cache2. It is recommended to use Cache3 on computers that
experience scanning problems.
Cache 3 features:
• Cache optimization is supported on Windows, Linux and AIX.
• Use CIT Scanner Cache3 if supported.
• Cache3 is not yet supported on shared disk. Cache2 is used for remote disk scan.
• Cache3 does not support the CPU threshold setting through Initiate Software Scan
fixlet. The threshold is not considered and the scane uses 1 core without self-limiting
it’s use.
• Status of Cache3 enablement can be checked through Scanner Information Analysis:
Property: Cache Optimization: adjusted to report ENABLED when Cache3 in use and
property Cache3 State: ENABLED / DISABLED. Enabled when cache3 is activated and
CIT Scanner in version 9.2.26.0000 or higher.
Cache 3 limitations:
Functionalities not yet supported:
1. Wildcard values, such as (*) (?) for “includeDirectory” are not supported.
2. $local, $remote and $all media types are not supported and are not considered. These
parameters are considered as local.
3. Short Windows filenames are not supported.
4. UTF-8 encoding in filenames are not supported.
5. Timeout setting is not supported.
6. File checksums and attributes other than file size are not cached.
7. Cache is not rebuilt when a scan configuration changes. For example, when the
catalog or a list of exclude directories or extensionToCache values changes. Perform
cache reset using wscanfs -reset for the cache to be rebuilt after subsequent scan.

Changes
The option to 'disable cache' is discontinued.
The option to 'optimize the scanner cache' is discontinued.

To set the scanner optimization, either upgrade the scanner using fixlet provided in BigFix
Inventory version 10.0.8 or manually change the Computer Setting CIT_Scan_Provider
toprovider_cache2.
Optimize the scanner cache
Cache 2 was introduced in BigFix Inventory Scanner and from version

the option

also optimizes remote shared file systems.
Important: Starting from application update 9.2.6, new installations have the
optimization enabled. Scanner cache settings is not changed until version 10.0.8.

Storage of configuration of Cache
Handling of cache is controlled per endpoint using computer settings:
• CIT_Empty_Cache_After_Scan - when set to true then cache is removed at the end of
scan. Otherwise is kept.
• CIT_Scan_Provider – overrides default in action for type of cache to be used.
Recommended value: provider_cache2
To enable cache optimization without upgrading the Scanner on a particular computer,
perform these steps:
1. Log in to BigFix Console.
2. Navigate toComputer Management > Computers and select the computer.
3. Check the value of the CIT_Scan_Provider parameter. If the value isprovider_cache,
the optimization is not enabled.
1. If it isprovider_cache2 orprovider_cache3 [10.0.8 CIT Scanner 9.2.26] the
optimization is enabled.
When you enable the scan optimization (cache2), the cache that is created during the
software scan includes only files that are relevant for the types of software scans that you
are running. The size of the cache is reduced.

Changing Scanner Cache Folder
The scanner cache folder is used to store information about scanned files and
directories in your file system. The scanner locates the cache folder using the file hierarchy
which results in quick scans. The amount of disk space that is needed for the cache
depends on the number of files that are being scanned. If the current cache folder does not
have sufficient disk space, you can change the location of the cache folder or optimize the
cache.
Change the default location of the scanner cache folder.
1. Log in to the BigFix console.
2. Navigate to, click Sites > External Sites > BigFix Inventory v10 > Fixlets and Tasks.
3. Select Change Scanner Cache Folder.
4. Provide an absolute path to the new cache folder, or restore the default folder,
scanner_install_dir/cache_data.
5. Click Take Action.
6. Select computers on which you want to change the scanner cache folder.
7. Click OK.
After you change the cache folder or restore the default, all current cache is removed.
A new cache is created after you run the software scan. To check the current cache
folder, see the results of the Scanner Information analysis.

Configuring Scanner Query Timeout
This task changes the default timeout for queries run by scanner used in the Initiate
Software Scan task.
If scanner query timeout issue occurs, increase the default timeout value (43200 seconds 12 hours). Timeout problems are indicated by the return code 29 that is logged in the result
page of the Software Scan Status analysis. The problem occurs on a slow computer or
when a low CPU threshold is set.
The change in settings does not limit total scan duration. It limit the execution time of one
query, for example, evaluation of one signature in Catalog-based scan and complete file
system scan.

Scan timeout is defined in seconds.

Optimizing scanner cache configuration
The scanner cache folder is used to store information about scanned files and directories
in your file system. By knowing the hierarchy of files, the scanner can locate them quicker,
which results in shorter scans. The amount of disk space that is needed for the cache
depends on the number of files that are being scanned. If the current location of the cache
folder cannot ensure sufficient disk space, you can change the location of the cache folder
or optimize the cache.
•

Change the default location of the scanner cache folder.
1. Log in to the BigFix console.
2. In the navigation tree, click Sites > External Sites > BigFix Inventory v10 >
Fixlets and Tasks.
3. Select Change Scanner Cache Folder.
4. Enter an absolute path to the new cache folder, or restore the default
scanner_install_dir/cache_data folder.
5. Click Take Action, and select computers on which you want to change the
scanner cache folder. Then, click OK.
After you change the cache folder or restore the default one, all current cache is
removed. The new cache is created after you run the software scan. To check
the current cache folder, see the results of the Scanner Information analysis.

•

Optimize the scanner cache. This option is recommended for
infrastructures with a large number of files that need to be scanned. Optimization of
the cache allows for reducing its size and shortening the time of the scan.
The option also optimizes remote shared file systems.
Important: Starting from application update 9.2.6, fresh installations have the
optimization enabled. However, scanner cache settings are not changed if you

are upgrading. To check whether scan optimization is enabled on a particular
computer, in the BigFix console go to Computer Management > Computers,
and select the computer. Then, check the value of the CIT_Scan_Provider
parameter. If the value is provider_cache, the optimization is not enabled. If it
is provider_cache2, the optimization is enabled.
1. Log in to the BigFix console.
2. In the navigation tree, click Sites > External Sites > BigFix Inventory v10 >
Fixlets and Tasks.
3. Select Configure Scan Cache.
4. To reduce the amount of disk space that is used by the cache, select Enable
cache optimization.
5. Click Take Action, and select computers on which you want to enable the
optimization. Then, click OK.
When you enable the scan optimization, the cache that is created during the
software scan includes only files that are relevant for the types of software
scans that you are running. The size of the cache is reduced.

Updating scanner catalogs
Scanner catalogs are used to discover software on the endpoints. They are automatically
created and distributed to the endpoints after every import that contains the BigFix software
catalog. If the automatic distribution fails, endpoints on which the catalogs were not
updated have the Outdated Catalog status on the Scan Health widget. You must manually
update scanner catalogs on these endpoints.

• Before you update the scanner catalogs manually, try to determine why the automatic
update failed. For more information, see Server operation problems.
• Ensure that the BigFix Inventory server is visible to your BigFix server.
• If Secure Socket Layer (SSL) is enabled in BigFix Inventory, all updates are also
downloaded through SSL. The BigFix server must recognize SSL certificates of BigFix
Inventory as valid.
1. Log in to BigFix Inventory.
2. Import the software catalog.
3. In the top navigation bar, click Management > Catalog Upload.
4. To download the fixlet file to your computer, click the question mark sign. Then,
click Catalog Download Fixlet. Choose the location where you want to save the
catalog_download.bes file, and click Save.
5. Copy the file to the computer where the BigFix console is installed.
6. Log in to the BigFix console.
7. To import the fixlet, click File > Import.
8. Open the directory where you store the catalog_download.bes file, select the file,
and click Open. The file is imported.
9. In the left pane, click Sites > Master Action Site > Fixlets and Tasks. A list of available
fixlets opens in the upper right pane.
10. To run the fixlet on the endpoints, select Catalog Download (Version: version), and
click Take Action.
11. Select the computers on which you want to run the fixlet, and click OK.

You imported the scanner catalogs to the endpoints in your infrastructure. To gather
inventory data from the endpoint, you must now initiate software scans.

Deprecated: Setting up additional analysis properties
Analysis properties are used to recognize software and gather information about its usage.
Analysis properties are set by default in BigFix Inventory. You can also set up your own
properties that you want to use to gather information from the endpoints.
Starting from application update 9.2.12, adding usage properties becomes
deprecated.
You must have the Manage Usage and Package Properties permission to perform this
task.
1. In the top navigation, click Management > Usage Properties.
2. To add an application usage property, click New.
3. Specify the name of the property. From the list of available properties, choose the
data source property that you want to use to discover software that is installed in your
infrastructure, its use or other properties, and click Create.

Disabling the collection of software usage
Information about software usage is collected if you enabled the default scan configuration
or manually activated the Application Usage Statistics analysis and ran the relevant scan.

If you are in the initial deployment phase, or if you do not need information about software
usage, you can disable the collection of this information to improve BigFix Inventory
performance and shorten the import time.
1. Log in to the BigFix console.
2. In the navigation tree, click Sites > External Sites > BigFix Inventory v10 > Fixlets and
Tasks.
3. In the upper right pane, select Disable Application Usage Statistics, and then in the
lower pane, click Take Action.
4. Select computers from which you no longer want to collect information about
software usage, and click OK.

Discovering software and hardware on IBM i
Available from 9.2.5. You can discover software and hardware inventory on IBM
i systems by using disconnected scans that do not require direct connection between the
scanned computers and BigFix server. Scripts that are provided in the disconnected scanner
package initiate software and capacity scans, and prepare scan results that you later on
upload to BigFix Inventory.
Important: Because BigFix client is not available for IBM i, the disconnected scanner
is the only method of software and hardware discovery on IBM i systems. Unlike
on other operating systems, approval from IBM Compliance is not required to use
disconnected scans on IBM i.
Disconnect Scanner for IBM i is provided by IBM and HCL redistributes the same with
BigFix Inventory. The IBM i Disconnected Scanner includes an embedded IBM i Catalog. So,
the option to update catalog using BigFix Inventory generated catalog for IBM i has been
disabled since version 9.2.17.
You must periodically update the IBM i Disconnected Catalog to update any currency
change. You can also use newer IBM i Disconnected Scanner package with older BigFix
Inventory versions

Ignore any notification about outdated catalog for IBM i endpoint in BigFix Inventory version
below 10.0.2. BFI Server automatically ignores the notification since BFI Server version
10.0.2.

Disconnected scanner package
To collect the software and hardware inventory data, you need an endpoint package that
consists of:
• Scanner
• Configuration files
• Scripts to run the scans and prepare the scan result package
The scripts initiate software and capacity scans, gather scan results, and adjust them to
the format that is compatible with BigFix Inventory. If the scripts are not appropriate for
your environment, you can edit and customize them, or create new scripts that better fit
your needs. You can also use a manual procedure. However, it is not recommended for
inexperienced users.

Scalability
You can collect data from up to 25000 disconnected endpoints on condition that the
computer where the BigFix Inventory server is installed meets hardware requirements for
very large environments. For more information about the requirements, see: Hardware
requirements for the server on Linux and Hardware requirements for the server on Windows.
Additionally, to ensure good performance of importing the scan results, complete the
following configuration.
• Run the software scan on weekly basis.
• Distribute the import of result packages over the week so that a subset of packages
is imported every day. For example, import 5000 packages every day from Monday to
Friday.
• Set up automatic removal of scan results from the disconnected data source directory
after the results are successfully imported to BigFix Inventory. To automatically

remove the packages, go to Management > Advanced Server Settings and set the
value of the delete_successfully_imported_scans parameter, to true.
• Configure the transaction logs size and increase the Java heap size. For more
information, see: Tuning performance in medium and large environments.

Scan frequency
The disconnected scanner triggers the software and capacity scan. Each of these scans
consists of a set of scripts and binaries that use up to 5 jobs. Thus, if you use the same
queue, make sure that the job limit is set to 10 or more.
For information about default and minimal scan frequency as well as recommended
frequency of importing scan results, see: Frequency of scans and uploads of data.
The disconnected scanner triggers the following scans:
• Capacity scan - The scan runs via the BFI_HW jobs that are scheduled during the
installation as QSECOFR user on its default queue. The capacity scan runs every 30
minutes.
• Software scan - You can schedule the software scan to run according to your
preference and use any specified queue. The recommended scan frequency is once a
month.
A software scan scheduled / run on demand by end user using user/queue specified by end
user. Recommended to be executed once a month.

Multiple environments
When you have multiple environments, for example test and production, ensure that the
following requirements are met:
• Every computer reports only one of the environments.
• Results of the disconnected scan from one environment are not uploaded to BigFix
Inventory that monitors the other environment.

Limitations
• Resource utilization, and metering data are not supported. For more information, see:
Raw utilization of license metrics.
• Scanning remote shared file systems is not supported.
• Detailed hardware scan cannot be collected if you use the disconnected scan.
• The disconnected scanner always collects full scans, not delta scans.
• The disconnected scan does not include additional computer properties that are
defined by the user. To collect these details, you need to define additional entries in
the computer.yml file.

Concept
Discovering software and hardware with disconnected scanner on Windows
and UNIX

Disconnected scanner requirements for IBM i
The list of disk space requirements, the supported IBM i version compatible with
the disconnected scanner and other relevant requirements.

Supported operating systems, versions and required disk space
Table 146. Disconnected scanner requirements for IBM i systems
Operat
ing system
IBM i

Supported versions
For information about supported

Required disk space in
the installation directory
Scanner installation directories:

versions, see: and BigFix Detailed
System requirements.

• /etc/cit - at least 20
MB. Also, provide disk
space for the scanner
cache.
• /cit

Table 146. Disconnected scanner requirements for IBM i systems (continued)
Operat
ing system

Required disk space in

Supported versions

the installation directory
◦ 50 MB for the script
and installation me
dia
◦ 50 MB for capacity
scan results for 90
days
• /qsys.lib/qtivcit.lib/ - 200 MB

Win
dows

40 MB + disk space for the scan
ner cache

Red
Hat Linux

24 MB + disk space for the scan
ner cache

Solaris

80 MB + disk space for the scan
ner cache

AIX

80 MB + disk space for the scan
ner cache

HPUX

48 MB + disk space for the scan
ner cache

Other requirements
Ensure that IBM i computers meet the following criteria.
• The disconnected scanner consumes up to 10 jobs. Ensure that the job limit is
sufficient.The jar tool is available on the computer. To check whether the tool is
available, type jar in the QSH.
• The QSH touch command provided by IBM is available (/QOpenSys/pkgs/bin/touch).
The use of touch commands provided by other sources is not supported.

• JAVA_HOME variable is set on the computer and exported to your process.
1. To set the JAVA_HOME variable, run one of the following commands from the
IBM i Main Menu.
◦ To add the variable to your current interactive job, run the following
command.
ADDENVVAR ENVVAR(JAVA_HOME)
VALUE('/QOpenSys/QIBM/ProdData/JavaVM/jdk80/64bit')

◦ To set the variable at the system level, run the following command.
ADDENVVAR ENVVAR(JAVA_HOME)
VALUE('/QOpenSys/QIBM/ProdData/JavaVM/jdk80/64bit')
LEVEL(*SYS)

2. Export the JAVA_HOME variable to your process
◦ To open a QSH session, run the STRQSH command.
◦ To export the variable to your process, run the following command.
export -s
JAVA_HOME=/QOpenSys/QIBM/ProdData/JavaVM/jdk80/64bit

Adding a new data source for disconnected scans
Available from 9.2.5. All scan results are imported to BigFix Inventory from a
directory dedicated to disconnected scans. You must add this directory as a data source to
allow BigFix Inventory to check its content and import all packages that are stored within.
The packages are imported during each data import.
All scan results must be manually transferred from all IBM i systems into the new directory
that works as a data source. You can automate this process by using NFS, or by other
means that better suit your environment.

1. On the computer where BigFix Inventory server is installed, create a directory with
read and write access, for example: /disconnected.
2. Log in to BigFix Inventory, and in the top navigation bar click Management > Data
Sources.
3. Click New, and specify the following values:
a. Specify the name of this data source.
b. Specify the Database Type as Disconnected.
c. Specify the location of the directory that you created.
Note: The path is not validated. Ensure that you provide a correct one.

4. Click Create.
Prepare installation files for disconnected scans.

Preparing installation files for disconnected scans for IBM i
Available from 9.2.5. After you add the data source, prepare the installation
package and distribute it to IBM i endpoints. The package should contain the disconnected
scanner and configuration files used to initiate the scans. These files are downloaded from
the BigFix console.
IBM i Disconnected Scanner is provided by IBM and HCL redistributes it with BigFix
Inventory. The package includes an embedded Software Catalog. So, the option to update
Software Catalog using BigFix Inventory generated catalog for IBM i has been disabled
since BFI version 9.2.17.
You must periodically update the IBM i Disconnected Catalog to update any currency
change. You can also use newer IBM i Disconnected Scanner package with older BigFix
Inventory versions.
Ignore any notification about outdated catalog for IBM i endpoint in BigFix Inventory version
below 10.0.2. BFI Server automatically ignores the notification since BFI Server version
10.0.2.0
Starting from application update 9.2.16, each disconnected scanner package
includes the software catalog. You no longer need to separately download the software
catalog and place it in the disconnected scanner directory on IBM i computers.
1. Download the disconnected scanner.
a. Log in to the BigFix console.
b. In the navigation bar, click Sites > External Sites > BigFix Inventory v10 >
Fixlets and Tasks.
c. In the upper right pane, select Download the Disconnected Scanner Package for
IBMi (version).
d. To run the task, click Take Action.

The file is downloaded.
For versions before 9.2.16 file would be named: LMTDisconnectedScanner-ibm_i-<version>-<timestamp>.zip
2. Optional: To customize the disconnected scanner, edit configuration files.
Configuration files include:
• schedule_scans.sh - Modify the file and replace the default user profile
name QSECOFR with the name of the profile that will be used to run hardware
scans. The minimal requirements for the user profile are the class set to *USER
and the special authority set to *NONE. You can use the same user profile that
is used to install the scanner and run the software scan. Then, set up the special
authority to *ALLOBJ.
• sw_config.xml - The file contains a number of extra settings, such as
the processor utilization and directories excluded from scanning. For more
information, see: Troubleshooting the discovery on IBM i.
3. Upload the disconnected scanner package to IBM i computers. Place the files in /cit
directory
a. Extract the LMT-DisconnectedScanner-ibm_i-<version><timestamp>.zip file to the /cit directory
Install the scanner and gather initial data.

Installing the scanner and gathering initial data on IBM i systems
Available from 9.2.5. After you distribute the disconnected scanner package to
the computers in your infrastructure, install the scanner and run the initial scans.
• You must have the *ALLOBJ authority to perform this task.
• The jar tool must be available on the endpoint. To check whether the tool is available,
type jar in the QSH.
• Set the JAVA_HOME variable on the computer on which you want to install the
scanner and export it to your process.

1. To set the variable, run one of the following commands from the IBM i Main
Menu.
◦ To add the variable to your current interactive job, run the following
command:
ADDENVVAR ENVVAR(JAVA_HOME)
VALUE('/QOpenSys/QIBM/ProdData/JavaVM/jdk80/64bit’)

◦ To set the variable at the system level, run the following command:
ADDENVVAR ENVVAR(JAVA_HOME)
VALUE('/QOpenSys/QIBM/ProdData/JavaVM/jdk80/64bit')
LEVEL(*SYS)

2. Export the JAVA_HOME variable to your process.
a. Open a Qshell session by using the STRQSH command.
b. Export the variable to your process by using the following command.
export -s
JAVA_HOME=/QOpenSys/QIBM/ProdData/JavaVM/jdk80/64bit

1. Open the QSH and go to the /cit directory where you copied the disconnected
scanner package
2. Run the setup_all.sh file.
It automatically performs the following steps:
• Installs the scanner.
• Runs the initial capacity scan, and creates the computer.yml file.
The initial capacity scan is needed to collect data about your IBM i system, and
to create the computer.yml file that will identify this system. The file is added
to each package with scan results and it helps to catalog and correctly display
them in the user interface. It contains information about the operating system,
such as host name, and a unique computer ID.

• Schedules regular capacity scans.
The capacity scan is scheduled to run every 30 minutes to gather current
results for virtualized environments where the capacity can dynamically change
depending on the allocated resources.
Note: After you install the scanner, its installation path cannot be changed.
The installation path is a location where you upload the installation files. To
change the installation path, back up the configuration files, scan results and
logs. Then, uninstall the scanner, move the files to a different directory, and
then install the scanner in the new location.
3. Go to the /cit or /cit/config directory, and verify that the created
computer.yml file contains the correct data. For more information about the
contents of this file and instructions about how to change them, see: Creating the
computer.yml file.
The scanner is set up now, and ready to run the software scan and gather results.
Run the software scan and gather scan results.

Running software scans and gathering scan results on IBM i
systems
Available from 9.2.5. The script that is responsible for the software scan collects
the results of the catalog-based, package data, and software ID tags scan as well as
retrieves results of the capacity scan and the computer.yml file. All these results are
combined and compressed into a common ZIP package that can be imported to BigFix
Inventory.
•

To perform this task, you must have *ALLOBJ authority.

• Each time you update the software catalog in BigFix Inventory, run an import of data
or wait for the scheduled import. Next download the newest version of software
catalog to an endpoint to run the software scan on it. For more information, see:
Preparing the disconnected scanner package..

• The scan takes around 30 minutes. The exact time depends on the computer load, file
system size, and the CPU threshold if you set it.
• For information about default and minimal scan frequency, see: Frequency of scans
and uploads of data.
• By default, no limit is set on the processor usage during the scan. To limit processor
usage, set the CPU threshold. For more information, see: Optimizing the processor
utilization.
1. Go to the directory where you uploaded the disconnected scanner package.
2. To initiate the software scan, and pack software and capacity scan results, run the
following script:
SBMJOB JOB(BFI_PKG) CMD(QSH CMD('/cit/run_sw_and_pack.sh'))

•

Starting from application update 10.0.2, which includes IBM i disconnected scanner
package 9.2.20, you can run the software scan and pack scan results independently.
• To run the software scan without generating the package with scan result, run
the following command:
SBMJOB JOB(BFI_PKG) CMD(QSH CMD('/cit/automation/

◦

run_sw.sh'))
• To pack scan results, run the following command:
SBMJOB JOB(BFI_PKG) CMD(QSH CMD('/cit/automation/

◦

pack_results.sh'))
The script packs results of the software scan and capacity scan generated since
the last time the package with scan results was created. If no new scan results are
available, the outcome is as follows.
The script returns error code 5.

•
3.

To monitor the progress of the scan, check the run_sw_and_pack_std.log file
that is created during the scan in the directory where you installed the disconnected
scanner, or monitor the scanner logs. For more information, see: Monitoring the scan
progress

A compressed package with scan results is created in the package output directory. The
default directory are:

•

/cit

Names of results packages use the following naming convention.
•

<YYYYMMDDHHMM>-<endpoint_ID>.zip
Important: Do not change names of results packages. Otherwise, they will not be
imported to BigFix Inventory.

Import the package to BigFix Inventory. After it is successfully imported, delete it from the
endpoint to save disk space.

Importing scan results from IBM i systems to BigFix Inventory
Available from 9.2.5. To import new scan results to BigFix Inventory, copy the
package to the disconnected scans directory that you added as a data source.
• For information about recommended frequency of importing scan results, see:
Frequency of scans and uploads of data.
• If you upload a package with older results, the current ones are overwritten.
• Discovered software is reported with the import time, not the package time stamp.
• Import only one package per endpoint. Otherwise, capacity results might be skipped.
• Processed packages are not removed from your disconnected scans directory. The
ones already imported are skipped.
1. Go to the package output directory. The default directory is /cit. Verify that a ZIP
package was created after running the software scan.
The package name is based on the following pattern:
<YYYYMMDDHHMM>-<endpoint_ID>.zip, for example
201510191213-6552CFF-5.zip. It contains the following files:
capacity.zip
catalog_scan.xml
computer.yml

isotag_scan.zip
package_scan.xml
source.zip

2. Copy the ZIP package into the disconnected scans directory that you added as a data
source in BigFix Inventory.
3. To save disk space, remove the ZIP package from the IBM i endpoint.
4. Repeat steps 1, 2 and 3 for all the IBM i endpoints in your infrastructure.
5. Wait for the scheduled import or run it manually.
6. Optional: If you want to save disk space on the computer where BigFix
Inventory is installed, go to Advanced Server Setting panel and enable the
delete_successfully_imported_scans parameter. For more information, see: Advanced
server settings.
During the data import, BigFix Inventory checks the directory that you added as a data
source and imports scan packages that meet the requirements. Scan results are processed
and displayed on the reports in the user interface.
Files from processed packages are saved in the installation_directory/wlp/usr/
servers/server1/tmp/datasources/Datasource_ID directory.
The processed packages are stored in the directory specified in the data source
configuration. The packages are not automatically removed. It is recommended to create
the audit snapshot once a quarter. Then, back up the packages in a different directory, and
remove them from the directory specified in the data source configuration.

Disconnected scanner maintenance and troubleshooting
Available from 9.2.5. You can use the maintenance and troubleshooting
tasks related to the disconnected scanner to monitor the scan progress, optimize the
processor usage during the scan, understand and fix the most common issues, or learn
more about the log files.

Updating the scanner and the scripts on IBM i systems
Available from 9.2.5. Both the scanner and the scripts are updated on a regular
basis to introduce improvements and new functions. To update the scanner, once again
download all the required files, and copy them into the /cit directory in IFS on your IBM i
system, or other directory where the previous version is already located.
1. Log in to the BigFix console.
2. In the navigation bar, click Sites > External Sites > BigFix Inventory v10 > Fixlets and
Tasks.
3. In the upper right pane, select Download the Disconnected Scanner Package for IBMi
(version).
4. To run the task, click Take Action.
5. Optional: If you made any changes to the scan configuration file
configure_scan.sh, or the software scan configuration file sw_config.xml
make sure that you back up the files before you extract the package. Otherwise, the
files are overwritten.
6. Extract the contents to the disconnected scanner directory.
7. Optional: If you recently updated the software catalog in BigFix Inventory, update it
also on the system with the disconnected scanner.
a. To download the software catalog for disconnected scanner, log in to BigFix
Inventory and go to Management > Data Source. Choose the disconnected data
source, and download the catalog for IBM i.
b. Place the catalog in the config directory of the disconnected scanner package
that you downloaded through fixlet.
Note: The catalog is available for download after uploading the main software
catalog and running a data import.
8. Optional: If you made any changes to the scan configuration file
configure_scan.sh, or the software scan configuration file sw_config.xml,
modify the new file versions to reflect the changes. Look at the back up files that you

created in step 5, and rewrite the changes to modify the new files. Do not copy the old
back up files as they might differ between the versions.
9. Run the update.sh script.

Decommissioning computers with disconnected scanners
Available from 9.2.5. When you decommission a computer that is no longer in
use, you can mark it as decommissioned on the Computers report, so that it is not displayed
in BigFix Inventory.
You must have the Manage Computer groups permissions to use this API.
1. In the top navigation bar, click Reports > Computers.
2. Click the computer name.
3. Click Decomission computer.

After you decommission the computer, this computer does not show up on the current
reports. You can still manage the software on the Software Classification panel, but it is
marked as uninstalled. The software is still displayed on the All Metrics report.

Uninstalling the disconnected scanner from IBM i systems
If you no longer need the disconnected scanner to scan the IBM i system, you can
uninstall it from any endpoint.

1. Open the directory where the disconnected scanner is installed.
2.

Create a backup of the endpoint_id.txt file that is located in
the config directory. This file will be required if you want to install the disconnected
scanner on the same computer in the future.

3. To uninstall the scanner, run the following script. The script uninstalls the scanner and
cancels the scan schedule. It does not remove scanner files.
a.

uninstall.sh

b.

uninstall.bat

4. Remove the directory where the disconnected scanner was installed.
The scanner is successfully uninstalled, and the data is no longer collected. Software and
capacity scans no longer run.

Understanding the Deployment Health and Software Scan Health
for IBM i systems
Available from 9.2.5. Deployment Health and Software Scan Health contain
information about your clients and the scans that were initiated. You can view this
information on the Deployment Health, and Software Scan Health widgets on the
dashboard, or on the Computers report. Deployment Health excludes all the disconnected
datasource endpoints. To properly understand values that are displayed for IBM i systems,
see the explanation of particular columns on the Computers report.
Table 147. Explanation of Deployment Health and Software Scan Health information
for IBM i systems
Column Name
Has Outdated

Description
Always shows No.

Version
Has Low Disk

Always shows No.

Space
Is Out of Sync

Always shows No.

Table 147. Explanation of Deployment Health and Software Scan Health information
for IBM i systems
(continued)
Column Name
Has Missing

Description
Always shows No.

Prerequisites
Agent Version Taken from the Agent Version property in the computer.yml file.
Catalog Scan

Shows Yes if the imported package contains the catalog_s-

Successful

can.xml file.

Software Tags Shows Yes if the imported package contains the isotag_scan pack
Scan Success age.
ful
File System

Always shows Yes. IBM i endpoints do not run file system scan.

Scan Success
ful
Package Scan Shows Yes if the imported package contains the package_sSuccessful

can.xml file.

Catalog Ver

Taken from the Catalog Version property in the computer.yml file.

sion
Endpoint

Taken from the Catalog Version property in the computer.yml file.

Scanner Cata

It displays only the second part of the whole catalog version, for ex

log Version

ample 1250110.1.

Last Scan At

Taken from the timestamp used in the final package name.

tempt
Scanning

Always shows No.

Shared Disks
Mounted
Shared Disks

Always shows ''.

Using NFS to automate the transfer of scan results
Available from 9.2.5. You can use NFS to automate the transfer of scan results
from your IBM i systems to the BigFix Inventory server. The results will be stored in a shared
directory and imported by BigFix Inventory without any additional actions.
You can use NFS in several configurations:
• BigFix Inventory acts as an NFS server
• Each IBM i acts as an NFS server
• You use a separate NFS server
In this procedure, BigFix Inventory installed on Linux acts as an NFS server and shares a
directory with an IBM i system that acts as an NFS client. The scan results saved into the
shared directory on IBM i system are readily available to BigFix Inventory. The scenario can
be adopted to be used in the Windows environment.
1. Configure the BigFix Inventory server to allow transfer by using NFS.
a. Install the nfs-utils package.
b. Configure the firewall to allow the NFS-related traffic from IBM i systems.
c. Create a directory for the disconnected scans results, and change its ownership
and rights.
mkdir /disconnected
chown nfsnobody:nfsnobody /disconnected
chmod 755 /disconnected

d. Add this directory as a data source.
e. Edit /etc/exports, and add the directory to the list of shared directories. The
following example shows a single IP address of an IBM i system, but you can
specify a range of addresses.
/disconnected

172.16.0.31(rw,sync)

f. Refresh the NFS configuration.
exportfs -a

2. On the IBM i system, create an output directory for scan results and mount the shared
directory from the BigFix Inventory server.
This step connects these directories. Whenever you save files into /bfi_server,
they will also be available in the /disconnected directory on the BigFix Inventory
server.
MKDIR '/bfi_server'
ADDMFS TYPE(*NFS) MFS('IP_address_of_BFI_server:/disconnected')
MNTOVRDIR('/bfi_server') OPTIONS(*DFT)

3. Open the default /cit directory, or other directory where you store the disconnected
scan scripts, and modify the following property in the configure_scan.sh script to
save all scan results into the new output directory.
PACKAGE_OUTPUT_DIR="/bfi_server"

4. Run the software scan to collect new scan results. When the scan is complete, the
package with scan results can be imported to BigFix Inventory by running a data
import.

Monitoring the scan progress
Available from 9.2.5. In case of any problems with the software scan, you can
check whether the scan was started or completed, and view some extra information about
the scanned directories.

Log files
The run_hw.sh and run_sw_and_pack.sh commands are the_console.sh wrappers , and
they redirect the script output into the run_hw_std.log and run_sw_and_pack_std.log
files. The default size limit of a single log file is 1024 bytes. The limit can be changed
in the configure_scan.sh file. To change the size limit provide a new LIMIT value. If
during the next scan the log files exceed the size limit, the existing files are renamed to

run_hw_std.log.1 and run_sw_and_pack_std.log.1. However, only up to two such files

can exist per command. Therefore, if run_hw_std.log.1 and run_sw_and_pack_std.log.1
already exist, the oldest log files are removed.

Checking the scanner version
To monitor the scan progress, you must have the scanner in version 2.8.0.0001, or higher.
To check the current version, open the /etc/cit/cit.ini file.
CIT_Version = 2.8.0.0001

Checking the initiated scans
Information about the started and completed scans is written in the /etc/cit/logs/
traceCIT.log file.
16/07/04 15:18:36 E [main.C] seMain:

308 IMPORTANT: ---START--- Software

scan started. CIT Version = '2.8.0.0001'
16/07/04 15:20:14 E [cache.C] 2800 IMPORTANT: File system access on
'/' (drive: '/:', type: 2, fs: 'os400fs')
16/07/04 15:22:02 E [cache.C] 2835 IMPORTANT: (OK) File system access on
'/' (drive: '/:', type: 2, fs: 'os400fs')
16/07/04 15:22:02 E [cache.C] 2800 IMPORTANT: File system access on
'/QSYS.LIB' (drive: '/QSYS.LIB:', type: 2, fs: 'qsysfs')
16/07/04 15:25:24 E [cache.C] 2835 IMPORTANT: (OK) File system access on
'/QSYS.LIB' (drive: '/QSYS.LIB:', type: 2, fs: 'qsysfs')
...
16/07/04 15:41:31 E [main.C] seMain:

483 IMPORTANT: ---STOP--- Software

scan finished with return code=0

Checking the scanned directories
You can check which directories are currently being scanned in the /etc/cit/logs/
traceCIT_scanned_dirs.log file.

2016-07-04T15:20:14 '/'
2016-07-04T15:20:14 '/iso'
2016-07-04T15:20:14 '/maestro'
...
2016-07-04T15:25:23 '/QSYS.LIB/QAUTOMON.LIB'

If the scan is taking too long to complete or hangs on a particular directory, you can stop it
by aborting the job that is running the scan. Then, exclude the directory from scanning, and
repeat the scan.

Troubleshooting the discovery on IBM i
Available from 9.2.5. The troubleshooting section lists the most common
issues you might encounter while discovering software and hardware inventory with
the disconnected scanner. The main objective of troubleshooting is to determine why
something does not work as expected and explain how to resolve the problem.

Log files
Scanner log files are in the following directories:
• /Installation directory/logs/*.
• /etc/cit/logs/*
The default installation directory is /cit.

Transferring files from IBM i systems
The internal file structure of IBM i systems displayed when connecting over FTP is very
complex. However, you can use one of the following commands to make it more UNIX-like.
Issue one of these commands after connecting over FTP:
cd /
site NAMEFMT 1

Tip: For more information, see Using the FTP Subcommand: NAMEFMT.

Next, set the appropriate mode for transferring your files, either binary or text. Use the binary
mode for transferring scan results, and text mode to obtain the scanner log files.

Optimizing the processor utilization
By default, processor utilization is not limited during the scan. You can optimize it by setting
up the CPU threshold.
Note: Setting the threshold does not guarantee that the CPU consumption is always
below the specified value. It fluctuates around that value, sometimes exceeding
it and sometimes dropping below it. Temporary peaks are expected. Setting the
threshold might lengthen the time of the scan.
1. Edit the sw_config.xml file that you downloaded with the scanner.
2. Add two new cpuThreshold attributes, one for FSScanner and another for Signatures.
For example:
<BigFix>
<CIT>
<XSE version="1.0">
<Plugins>
<Plugin name="FSScanner">
<Attribute name="cpuThreshold" value="20:2:150:850"/>
(...)
<Attribute name="interruptOnTimeout" value="true"/>
</Plugin>
</Plugins>
<Signatures>
<Attribute name="cpuThreshold" value="20:2:150:850"/>
</Signatures>
</XSE>
</CIT>
</IBM>

3. Specify one of the following values:

Desired
utiliza
tion

Value

5%

10:2:50:950

10%

20:2:100:900

15%

20:2:150:850

20%

30:2:200:800

25%

30:2:250:750

50%

50:2:300:500

4. Save the file.

Excluding directories from being scanned
You can exclude directories from being scanned during the catalog-based and ISO tags
scan. To do this, edit the sw_config.xml file. Specify the directories as values of the
excludeDirectory attributes.
• To exclude the /tmp directory:
<Attribute name="excludeDirectory" value="/tmp/"/>

• To exclude all directories named tmp, for example /tmp and /dir/tmp:
<Attribute name="excludeDirectory" value="*/tmp/"/>

Providing failing packages to BigFix Support
Import of a package is failing
If you see the following errors in the import log, provide the whole scan
package.
2015-11-06 08:31:07 INFO: Processing scan package: 2015110412009.128.0.223.zip from: /disconnected/.

2015-11-06 08:31:08 INFO: ETL from FileSystem - SAM::Disconnecte
dScan
(0x00000000563C63FF - 0x00000000563C6514): Failed
2015-11-06 08:31:08 ERROR: Sequel::UniqueConstraintViolation:
Java::ComIbmDb2JccAm::SqlIntegrityConstraintViolationException:
One or more values in the INSERT statement,
UPDATE statement, or foreign key update caused by a DELETE state
ment are not valid because the primary key,
unique constraint or unique index identified by "1" constrains t
able "DBO.RAW_DATASOURCE_FILES" from having
duplicate values for the index key.. SQLCODE=-803, SQLSTATE=2350
5, DRIVER=3.64.104

Import of a single file is failing
The import of a single file from the scan package is failing if the import log
contains the following message:
2015-11-06 10:48:07 WARN: An error occurred parsing XML file 2 i
n file isotagsearch_0_375.zip.
Install path value was not found.

Such a file must be provided with its long path. To determine the path,
complete the following steps:
1. Go to the BigFix Inventory installation directory.
2. Search for the failing file:
find -name "isotagsearch_0_375.zip"

Command output that must be provided to Support:
./wlp/usr/servers/server1/tmp/datasources/2/UploadManager/s
ha1/75/375/isotagsearch_0_375.zip

Common problems
The package is being skipped during the import despite meeting the requirements
Such a problem might occur if you are importing more than one package from
an endpoint. BigFix Inventory always imports the latest package and omits all
previous ones. The following message about skipping the package is related
to irrelevant packages and can be ignored:
2015-11-05 09:35:22 WARN: Skipping file: package_scan.xml from:
201510101200-2inarow.zip.
The data was already processed.
2015-11-05 09:35:22 INFO: Skipping file: package_scan.xml.
Unsupported file in: 201510101200-2inarow.zip.

The import might fail if you use the same results of the capacity scan in different
packages
This problem might occur if you reuse the capacity scan results for testing
purposes. If more than one endpoint has the same scan results, the import
fails and the following message is displayed:
ERROR:

(ImportCapacity-Thread:3) doInsert com.ibm.db2.jcc.am.Sq

lIntegrityConstraintViolationException:
One or more values in the INSERT statement, UPDATE statement, or
foreign key update caused
by a DELETE statement are not valid because the primary key, uni
que constraint or unique
index identified by "1" constrains table "ADM.LAST_IMPORTED_SCAN
" from having duplicate values
for the index key.. SQLCODE=-803, SQLSTATE=23505, DRIVER=3.64.10
4

Ensure that you run the capacity scan for each of your endpoints and use
appropriate results.
The software or ISO tags scan fails and no results are created

Run the following command in QSH, and then repeat the scan.
export QIBM_MULTI_THREADED=Y

The software is discovered and bundled, but there are no PVU calculations
The problem might be caused by an incorrect epoch, which points to the
date in the future. The epoch is included in file names of the capacity scan
results, for example tlm_hw_201603021330_1456969683.xml. Open the
capacity.zip archive, and check whether the epochs are correct. You
will have to convert the epoch into a normal date. On Linux, you can do it by
running the date -d @epoch command.
The host name of an endpoint provided by the disconnected scanner is different than
expected
The host name that is provided by the disconnected scanner and a regular
scanner can be different. The regular scanner uses the host name that is
provided by BigFix, while the disconnected scanner checks the host name
by running the hostname command, or, if not available, through the scanner
check.
Opening a support case
If none of the above solutions work for you, open a support case and provide
the following files to BigFix Support:
• package with scan results
◦ /Installation directory/run_hw_std.log
◦ /Installation directory/run_sw_and_pack_std.log
• /Installation directory/warning*.xml file
• scanner logs from /etc/cit/logs
• the console output of a failed step in the debug mode, if possible. The
example below generates the /cit/failure.log file with the output:
export QIBM_MULTI_THREADED=Y
/qsys.lib/qtivcit.lib/wscansw.pgm -s -c /cit/sw_config.xml
-i /cit/CIT_catalog_I5OS.xml

-o /cit/catalog_scan_man.xml -e /cit/warning_man.xml -debug
>/cit/failure.log 2>&1

Monitoring the import log
When you import a package with scan results to BigFix Inventory, the import log
(Management > Data Imports) displays information and warning messages related to
your package. If the package or its content does not meet the requirements, it might be
skipped during the import, and the scan results will not be displayed in BigFix Inventory.
While monitoring the import log, you can expect the following messages:
info: Processing scan package: package from: directory.
info: Invalid file name. The scan package must match the pattern
YYYYMMDDHHMM-*.zip. Skipping package: package.
info: Invalid Catalog Version property in the computer.yml file: version.
The property must match the pattern <Number>.<Number>. The catalog might
be reported as outdated.
warn: The disconnected scans location does not exist: directory.
warn: Invalid file name. The scan date must be later than year 2000.
Skipping package: package.
warn: Skipping corrupted scan package: package. The following error
occurred: error.
warn: Missing computer.yml file. Skipping package: package.
warn: Missing property: property in the computer.yml file. Skipping
package: package.
warn: Invalid computer.yml file. Skipping package: package. The following
error occurred: error.
warn: The value of the endpointID property in the computer.yml file is
longer than 512 characters. Skipping package: package.
warn: The value of the endpointID property in the computer.yml file is
empty. Skipping package: package.
warn: Missing property: endpointID in the computer.yml file. Skipping
package: package.

warn: Importing older scan package from: date for computer: computer_id.
This computer already has data from: date.
warn: The file is larger than 2097150 bytes. Skipping file: scan_file
from: package for computer: computer_id.
warn: The following error occurred when processing the package_scan.xml
file: error.
warn: The insertion of the operating_system package data into the database
failed on record content. The following error occurred: error.

(Optional) Manually installing the scanner and running the scans
on IBM i systems
Available from 9.2.5. scripts that automate the scans are not appropriate for
your environment, and you need to customize the execution of scans without changing
the required scan frequency, refer to this appendix. The appendix describes how to run
each scan, how to collect the results, and finally how to create the final package that
can be uploaded to BigFix Inventory manually. The automated scripts, however, remain a
recommended way of discovering on IBM i systems.

(Optional) Manually installing the scanner
Available from 9.2.5. If the automated scripts are not appropriate for your
environment, you can manually install the scanner. You will also need to run the initial
capacity scan, create the computer.yml file, and schedule regular capacity scans. These
tasks are optional and can be completed with the automated scripts.

Installing the scanner
Available from 9.2.5. Install the scanner on each of your IBM i systems to be able
to initiate the software and capacity scans.
Note: This task is optional, because it can be completed by an automated script.
Use it only for advanced scenarios.

Install the scanner by running the following commands from QSH:
cd /cit
./install_scanner.sh

Running the initial capacity scan
Available from 9.2.5. The initial capacity scan is needed only to gather detailed
information about the scanned IBM i system. You will use this information to create the
computer.yml file that describes your IBM i system, and is required for each import
of new scan results. All subsequent capacity scans will be initiated from a script that
schedules them to run automatically every 30 minutes.
Note: This task is optional, because it can be completed by an automated script.
Use it only for advanced scenarios.
Go to /cit, and run the run_hw.sh script.
The results were saved in /cit/output/hw_scan_all/last.xml. You can now create
the computer.yml file.

Creating the computer.yml file
Available from 9.2.5. The computer.yml file contains information about the
scanned IBM i system, and is used to catalog scan results and correctly display them in the
user interface. Each package with scan results must contain this file, but you can reuse the
file as long as it is unique for each IBM i system.
Note: This task is optional, because it can be completed by an automated script.
Use it only for advanced scenarios.

1. Go to /cit, or /cit/config, and edit the computer.yml.sample file. The file
contains the following values:
endpointID: 6552CFF:5
Agent Version: IBM_doc_v.1.0
Catalog Version: 1250110.0
Operating System: IBM i V7R1M0 PowerPC 64
DNS Name: NC198511
Computer Name: NC198511
IP Address: 198.51.100.0

2. Take the values from the results of the capacity scan that are in the /cit/output/
hw_scan_all/last.xml file. The table provides some details on how to retrieve
them.
At
tribute

Description

Value

end

Mandatory.

point

Unique ID of the computer. It

<HWSerial>6552CFF</HWSerial>

must contain the hardware se

<LparID>5</LparID>

ID

In capacity results:

rial number and LPAR ID in the
<HWSerial>:<LparID> format, for
example 6552CFF:5.
Agent

Optional.

Ver

You can use this attribute to

sion

provide information that lets
you differentiate between scan
results. For example, if you
used the manual procedure to
gather them, you can call it IBM_doc_v.1.0, or choose other

-

At
tribute

Description

Value

names for automated process
es.
Cat

Optional.

To view these versions, in BigFix In

alog

Versions of the software cat

ventory go to Management > Catalog

Ver
sion

alog and its custom content,

Upload.

separated with a dot (.), for ex
ample 1250110.0.

Oper

Mandatory.

ating

Operating system of the com

<OSName>IBM i</OSName>

puter. It must start with IBM i,

<OSVersion>V7R1M0</OSVersion>

but you can add more informa

<OSArch>PowerPC</OSArch>

tion, and have it displayed in the

<OSKernelMode>64</OSKernelMode

user interface.

>

Sys
tem

Com

Mandatory.

puter

Name of the computer, used

Name

In capacity results:

In capacity results:
<Hostname>NC046189</Hostname>

for identification. It can be an IP
address, or any name or ID that
lets you recognize the comput
er.

DNS

Optional.

Name

Domain name, used for identi

-

fication. It can be the same as
Computer Name.
IP Ad Optional.
dress

IP address of the computer,
used for identification. For mul

In capacity results:

At
tribute

Description
tiple IPs, place each address
on a new line that starts with a
space.

Value
<Address
IsKey="1">9.156.46.189</Addre
ss>

Syntax for multiple IPs:
IP Address: 198.51.100.0
198.51.100.1
198.51.100.2

3. Save the file as computer.yml in the same directory.

Scheduling regular capacity scans
Available from 9.2.5. The capacity scan must be initiated every 30 minutes to
gather current results for virtualized environments, in which capacity can dynamically
change depending on allocated resources. After you run the script, the scan will be run with
such a frequency automatically. The results do not have to be imported to BigFix Inventory
with such a high frequency. You can import only those that are already available, and include
the rest in the next imported package.
Note: This task is optional, because it can be completed by an automated script.
Use it only for advanced scenarios.
Go to /cit, and run the schedule_scans.sh script.
After you run the script, the capacity scan will be initiated every 30 minutes, each time
creating two output directories:
hw_scan_all
All capacity scan files and their signatures. They are required for audit
purposes to prove that the capacity scan was initiated every 30 minutes.
hw_scan_unique

Unique capacity scan files that contain only changes to the capacity.
Additionally, 48 instances of the BFI-HW job that run the run_hw.sh script are created.
Since the capacity scan must be run every 30 minutes, two jobs are created for each hour.
All capacity results will be automatically copied from their directories and included in the
common package with all scan results after you run the software scan.

(Optional) Manually running the scans and preparing the results
Available from 9.2.5. After you install the scanner, you use the QSH to initiate the
software and capacity scans. Each type of scan creates a different output that must be
copied to the final package that is imported to BigFix Inventory.
Before you start the scans, create two directories that will make it easier to manage the
scan results.
/scans
In this directory, you will store all scan results that you want to include in a
single import to BigFix Inventory. After you copy the results to this directory,
you must compress and rename it, so that it has the right format. Such a final
package is then imported to BigFix Inventory.
/source
In this directory, you will store signatures of all scan results that you copied to
the /scans directory. In the case of the ISO tags scan, also the original output
file. These files are required for audit purposes to ensure that scan results
were not altered.
All details regarding the final package are described later in this document.

Running the capacity scan
Available from 9.2.5. In the capacity scan, the scanner reports the system type
and details about the physical processor. If applicable, it also collects information about the
guest operating system and logical partitions. This data is required to calculate the PVU and
RVU MAPC consumption.

Note: This task is optional, because it can be completed by an automated script.
Use it only for advanced scenarios.
The capacity scan must be run every 30 minutes to collect current results.
1. In QSH, run the following command to initiate the capacity scan:
/qsys.lib/qtivcit.lib/wscanhw.pgm -nolock

-s -c tlm_hw_config.xml

-o tlm_hw_<DATE>_<SECONDS>.xml

Where:
-s
Creates a signature for the output file. The signature must be stored for
audit purposes.
-c tlm_hw_config.xml
Path to the tlm_hw_config.xml configuration file that you
downloaded with CIT.
-o tlm_hw_<DATE>_<SECONDS>.xml
The output file.
DATE - Date in the YYYMMDDHHMM format, for example
201511101248.
SECONDS - Number of seconds that passed since January 1st 1970, for
example 1447177713.
Tip: You can retrieve the date and the number of seconds by
running the date +%Y%m%d%H%M-%s command on Linux.
2. Compress the output file into a capacity.zip package. The package can contain
more than one output file.
3. Copy the capacity.zip package to the common /scans directory, in which you
store all scan results.

Running the catalog-based scan
Available from 9.2.5. In the catalog-based scan, the scanner creates scanner
catalogs that are based on the catalog that you attach while initiating the scan. Based on
these catalogs, the scanner discovers exact software matches.
Note: This task is optional, because it can be completed by an automated script.
Use it only for advanced scenarios.
1. Download the software catalog for IBM i systems from your BigFix Inventory server:
https://hostname:port/sam/catalogs/CIT_catalog_I5OS.xml.bz2. The
catalog is available after uploading the main software catalog and running a data
import. Next, extract it and upload to a directory in IFS on your IBM i system.
2. In QSH, run the following command to reset cache:
/qsys.lib/qtivcit.lib/wscanfs.pgm -reset

3. Run the following command to initiate the catalog-based scan:
/qsys.lib/qtivcit.lib/wscansw.pgm -s -c sw_config.xml
-i CIT_catalog_I5OS.xml -o catalog_scan.xml

Where:
-s
Creates a signature for the output file. The signature must be stored for
audit purposes.
-c sw_config.xml
Path to the sw_config.xml configuration file that you downloaded
with the scanner.
-i CIT_catalog_I5OS.xml
Path to the software catalog for IBM i systems.
-o catalog_scan.xml
The output file.

4. Copy the output catalog_scan.xml file to the /scans directory, in which you store
all scan results.
5. Copy the corresponding signature to the /source directory.

Running the ISO tags scan
Available from 9.2.5. In software identification tags scan, the scanner searches
for ISO tags that are delivered with software products. After you upload the final package
with scan results to BigFix Inventory, the tags are processed. Based on the information that
they contain, the software is discovered.
Note: This task is optional, because it can be completed by an automated script.
Use it only for advanced scenarios.
The ISO tags scan requires the software catalog for ISO tags. You can find it in the
downloaded ibm_i_cit_and_configs.zip package.
1. In QSH, run the following command to initiate the ISO tag scan:
/qsys.lib/qtivcit.lib/wscansw.pgm -s -c sw_config.xml
-i i5_iso_catalog.xml -o iso_scan.xml

Where:
-s
Creates a signature for the output file. The signature must be stored for
audit purposes.
-c sw_config.xml
Path to the sw_config.xml configuration file that you downloaded
with CIT.
-i i5_iso_catalog.xml
Path to the ISO software catalog for IBM i systems.
-o iso_scan.xml

The output file. It contains paths to all scanned ISO tags.
2. The scan creates the iso_scan.xml output file. Back up this file, because you will
need to store the original output and its signature for audit purposes.
3. The iso_scan.xml output file lists all scanned ISO tags. You must now gather and
copy these tags to a separate directory and create a text file that lists all of them.
Create such a directory, for example /isotag_scan, and then complete the following
steps:
a. Open the iso_scan.xml file. Each entry in this file contains a path to the
scanned ISO tag file, for example:
<MatchedSignature guid="ISO-TAGS">
<Variable name="INSTALL_PATH"
value="/
iso-swid/IBM_Capital_Regulatory_Reporting_Add-on-License-4.9.0.sw
idtag"/>
<Variable name="IS_INSTALLED" value="true"/>
</MatchedSignature>

b. Copy each path to a new file called list.txt. Place each path on a separate
line, for example:
/
iso-swid/IBM_Capital_Regulatory_Reporting_Add-on-License-4.9.0.sw
idtag
/
iso-swid/1986-03.com.ibm_IBM_BigFix_Inventory_Server-9.2.1.swidta
g

c. Copy each of the scanned ISO tags to the isotag_scan directory. Rename
the files so that they contain numeric values according to their order in the
list.txt file.
For example, if the /iso-swid/
IBM_Capital_Regulatory_Reporting_Add-on-

License-4.9.0.swidtag file is written on the first line in the list.txt file,
rename this ISO tag to 1.
The following image shows sample ISO tag files and their paths in the
list.txt file.

4. Compress the isotag_scan directory into a [zip|tar.gz|tgz] package, and
copy it to the /scans directory, in which you store all scan results.
Warning: The list.txt file must be the first file in the archive. You can
achieve it by compressing only this file, and then adding the rest of files to the
archive.
5. Copy the backup iso_scan.xml file and its signature to the /source directory.

Running the package data scan
Available from 9.2.5. In the package data scan, the scanner searches the system
registry to gather information about packages that are installed on your endpoints. After you
upload the final package with scan results to BigFix Inventory, the discovered packages are
compared with the software catalog resulting in software discoveries.
Note: This task is optional, because it can be completed by an automated script.
Use it only for advanced scenarios.
1. In QSH, run the following command to initiate the package data scan:
/qsys.lib/qtivcit.lib/wscanvpd.pgm -s -o package_scan.xml
-c vpd_config.xml

Where:

-s
Creates a signature for the output file. The signature must be stored for
audit purposes.
-o package_scan.xml
The output file.
-c vpd_config.xml
Path to the configuration file that you downloaded with the scanner.
2. Copy the output package_scan.xml file to the /scans directory, in which you store
all scan results.
3. Copy the corresponding signature to the /source directory.

Creating the final package
Available from 9.2.5. Gather all scan results and compress them into a ZIP
package that can be imported to BigFix Inventory.
Note: This task is optional, because it can be completed by an automated script.
Use it only for advanced scenarios.
BigFix Inventory does not import single scan results, but rather a whole package that
has the right file name and format. The package must contain the following files:
computer.yml, catalog_scan.xml, capacity.zip, isotag_scan.[zip|tar.gz|
tgz], package_scan.xml and source.zip. It must be copied to your disconnected
scans directory that you added as a data source.
Considerations
• If you upload a package with older results, the current ones are overwritten.
• Discovered software is reported with the import time, not the package timestamp.
• Import only one package per endpoint. Otherwise, capacity results might be skipped.
• Processed packages are not removed from your disconnected scans directory. The
ones already imported are skipped.

1. Compress the /source directory, in which you store signatures, into the
source.zip package, and copy it to the /scans directory.
2. In the /scans directory, create a computer.yml file, and fill it in like in the following
example:
endpointID: 6552CFF-5
Agent Version: IBM_doc_v.1.0
Catalog Version: 1250110.0
Operating System: IBM i V7R1M0 PowerPC 64
DNS Name: NC198511
Computer Name: NC198511
IP Address: 198.51.100.0

Where:
endpointID - (mandatory) Unique ID of your computer. It must contain the
hardware serial number and LPAR ID in the <HWSerial>-<LparID> format, for
example 6552CFF-5. You can retrieve these values from the results of the
capacity scan.
Agent Version - (optional) You can use this parameter to describe a way that
you used to create the final package. For example, if you used the manual
procedure, you can call it IBM_doc_v.1.0, or choose other names for automated
processes. This information can be used for troubleshooting failing imports.
Catalog Version - (optional) Versions of the software catalog and its custom
content, separated with a dot (.), for example 1250110.0. You can view the
versions in BigFix Inventory by going to Management > Catalog Upload.
Operating System - (mandatory) Operating system of your computer. It must
start with IBM i, but you can add more information, and have it displayed in
the user interface. You can retrieve information about the name, version, and
architecture from the results of the capacity scan.
DNS Name - (optional) Domain name, used for identification. It can be the same
as Computer Name.
Computer Name - (mandatory) Name of your computer, used for identification.
IP Address - (optional) IP address of your computer, used for identification.

3. Compress the /scans directory into a ZIP package, and rename it to
<UTC_DATE>-<endpointID>.zip, for example 201510191213-6552CFF-5.zip,
where:
UTC_DATE - Date of scan in Coordinated Universal Time (UTC). It must have the
following format: YYYYMMDDHHMM. The file name must start with this timestamp
to ensure correct ordering.
endpointID - The same endpoint ID that you used in the computer.yml file. It is
required to distinguish between various packages and computers.
4. Copy the ZIP package into your disconnected scans directory that you added as a
data source in BigFix Inventory. The package is imported to BigFix Inventory after you
run a data import.
5. Run a data import.
During the data import, BigFix Inventory checks the directory that you added as a data
source and imports all scan packages that meet the requirements. Scan results are
processed and displayed on reports in the user interface.
Files from processed packages are saved in installation_directory/wlp/usr/
servers/server1/tmp/datasources/Datasource_ID.

(Optional) Clear corrupted scanner installation
This topic describes the 'Clear Scanner Installation' fixlet and the process to uninstall a
scanner.
The 'Clear Corrupted Scanner Installation' fixlet is relevant for endpoints where corrupted
scanner installation is detected. See fixlet description in the console for more information
about relevance. The corrupted installation can impact in missing files, incorrect file
permissions, incorrect file content or file size. These factors may affect the updating,
uninstalling the scanner, updating catalog, or performing some actions on the endpoint.
Using this fixlet grants file permissions to system users and allows them to uninstall the
scanner. If location of the scanner is unknown, due to missing or corrupted cit.ini file,
the fixlet will check common installation folders and follow with uninstallation.

After the task is complete, you can use ‘Install Scanner’ fixlet to install scanner on this
endpoint.
1. Log in to the BigFix console.
2. Go to Sites > External Sites > BigFix Inventory v10 > Fixlets and Tasks.
3. Select Clear Scanner Installation.
4. To start the scan, click Take Action.
5. Select the computers on which you want to uninstall the scanner.
The scanner is uninstalled.

Performing optional configuration
You can perform optional configuration tasks to further customize the application.

Enabling HTTP Access Logging for BigFix Inventory
This task enables the server to log any incoming HTTP request. The task is limited when
generic data on HTTP level, such as the remote IP, remote host, time, URL, method, status
code, and response size are available.
To enable the access login, perform these steps:
1. Edit the <BFI Install dir>\wlp\usr\servers
\server1\customization.xml and add following configuration:
<server>
<httpEndpoint id='tema'>
<accessLogging

filepath="${server.output.dir}/logs/http_defaultEndpoint_access.log"
logFormat='%a %h %t "%r" URL: %U R-Meth: %m Q:
%q Status Code: %s Response Size: %b User: %{BFI-user-hash}o :
%{_DSS_session}C'/>

</httpEndpoint>
</server>

2. Restart BigFix Inventory Server
In <BFI Install dir>\wlp\usr\servers\server1\logs\,
http_defaultEndpoint_access.log file is created. The file includes the logs for all

HTTP calls made towards the application. By default, there are 2 logs each 20 MB.
There is no option to set the location, number of files and the files size.
For more options of configuration, refer to the below topics:
• HTTP access logging
• HTTP Access Logging (httpAccessLogging)
• HTTP transport channel custom properties

Data retention periods
Table 148. Data retention periods
Period for
Type of data
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Changing the default period
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of the file system scan,

value of the raw_data_api_history_keep_

package data scan, and

days parameter on the Advanced Server
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Table 148. Data retention periods (continued)
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The period cannot be changed.

Configuring data retention period for raw utilization data
By default, raw data about utilization of license metrics is stored in the BigFix Inventory
database for 90 days. You can change the period depending on the period for which you
want to generate reports of raw utilization data.
Retention period is set by default in fresh installations of BigFix Inventory. If you upgraded
from Software Use Analysis, your original settings were preserved.
Raw utilization data is related to license metrics that are reported by products, which
implemented the ISO/IEC 19770-4:2017 standard. By default, retention period for raw
utilization data is set to 90 days. After that period, the data is removed from the BigFix
Inventory database. Software items for which raw license utilization is not reported for a
period longer than the specified one are no longer displayed on the Resource Utilization
report.
1. In the top navigation bar, click Management > Server Settings.
2. Specify the period after which you want the data to be removed from the database. If
you want to disable the data retention period, clear the check box. Then, click Save.

The data that is older than the retention period is removed from the database during every
import.
If the retention period was not configured or you shortened it considerably, removal
of the large amounts of data might lengthen the first import after the change. During
the consecutive imports, smaller amounts of data are removed and should not have
considerable impact on the import time on condition that the import runs regularly.

Setting up computer properties
You can specify computer properties that are to be gathered from the computers in your
infrastructure. You can then use those properties to filter data on the Computers report and
to assign computers to computer groups.
You must be an Administrator to perform this task.
You cannot set up additional computer properties for IBM i computers.
1. To view the properties that are specified for the computers in your infrastructure, click
Management > Computer Properties.
2. To add a property, click New.
3. In the Create Computer Property pane, specify the name of the property to be
displayed in BigFix Inventory. Select the property from the Data Source Property list
and click Create.
Tip: When you start typing in the property name, a list of possible values is
displayed. It contains all properties whose names contain the letters that
you entered in the specified order, regardless of whether the letters occur

immediately one after another. For example, if you type path, the list might
contain properties such as Patches Applied - Solaris, because letters p, a,
t, h occur in this order in the property name.

To have the computer property displayed, wait for the next scheduled import or run it
manually. Each computer property requires that a relevant analysis is activated. After the
import finishes, check the import log for warning messages that indicate that an analysis
related to a particular property is not activated. For example:
WARN: Analysis 'Software Scan Status', bound to Computer Property
'Status of catalog-based scan', is not activated and will not be imported.

If you find such a warning, activate the required analysis to have the computer property
displayed.

Deprecated: Package and usage properties
In addition to computer properties, BigFix Inventory also uses package properties, UNIX
package properties, and usage properties to retrieve data about your software and its
usage. The data is originally gathered by analyses, and the properties are links between
these analyses and BigFix Inventory. All properties are configured by default and do not
require any action from you.
Starting from application update 9.2.12, editing package and usage properties
becomes deprecated.

Package properties
Package properties retrieve data about software that is installed on the Windows operating
systems. The data is gathered by the Installed Windows Applications analysis that retrieves
the list of your software from the Windows Registry. The raw data collected by the analysis
can also be viewed in the BigFix console by checking the analysis results.
To view the property in BigFix Inventory, go to the following URL:
https://<bfi_host>:<port>/management/sam/package_properties, and

select the property. The property must be linked to the relevant Fixlet site that contains the
analysis, otherwise the results will not be collected.

Data retrieved from the analysis is displayed on the Package Data report. To access it, click
Reports > Package Data.

UNIX package properties
UNIX package properties retrieve data about software that is installed on the UNIX
operating systems. The data is gathered by the UNIX Installed Packages analysis that
retrieves the list of your software from the package management system. The raw data
collected by the analysis can also be viewed in the BigFix console by checking the analysis
results.
To view the property in BigFix Inventory, go to the following URL:
https://<bfi_host>:<port>/management/sam/unix_package_properties, and
select the property. The property must be linked to the relevant Fixlet site that contains the
analysis, otherwise the results will not be collected.

Data retrieved from the analysis is displayed on the Package Data report. To access it, click
Reports > Package Data.

Usage properties
Usage properties retrieve data about the use of your software. The data is gathered by the
Application Usage Statistics analysis.
To view the property in BigFix Inventory, go to the following URL:
https://<bfi_host>:<port>/management/sam/app_usage_properties, and
select the property. The property must be linked to the relevant Fixlet site that contains the
analysis, otherwise the results will not be collected.

Data retrieved from the analysis is displayed on the Metering Data report. To access it, click
Reports > Metering Data.

Setting the homepage
If you use a particular report or panel frequently, you can set it as BigFix Inventory
homepage.
• To set a new homepage:
1. Open the report or panel that you want to set as the homepage.
2. Hover over the User icon

, and click Set as homepage.

• To return to the default homepage:
1. Hover over the User icon

, and click Profile.

2. Under the Homepage field, click Clear.

Deprecated: Disabling subcapacity calculations
Subcapacity licenses are based on the number of processor value units (PVU) or resource
value units (RVU) that can be used by the product not the number of all processor cores
that are available on the physical server. Such a licensing scheme allows for reducing the
cost of licenses for products that are eligible for PVU or RVU subcapacity. If no subcapacity

products are installed in your environment, you can disable subcapacity calculations to
improve the performance of the import.
Important:

Starting from application update 9.2.5, the option to entirely

disable subcapacity calculations is no longer available. You can disable PVU and
RVU MAPC calculations, both full capacity and subcapacity, per computer group.
For more information, see: Setting up computer groups.
To disable subcapacity calculations, go to https://hostname:port/management/
feature and clear the Subcapacity checkbox. Then, click Save.
Tip: You might restart the BigFix Inventory server to ensure that subcapacity
calculations are disabled.
After you disable subcapacity calculations, subcapacity data is not uploaded to BigFix
Inventory server during the import. Performance of the import is improved. Fixlets and
tasks that are related to subcapacity configuration and VM managers remain available
and relevant in the BigFix console. However, you do not have to run them. Additionally, the
following elements of the BigFix Inventory user interface are hidden:
• Widgets:
◦ IBM Capacity Data Completeness
◦ IBM PVU Subcapacity
◦ BigFix Software Classification
• Management panels:
◦ BigFix Software Classifications
◦ VM Managers
◦ Metric Table Upload
◦ Part Numbers Upload
• Reports:
◦ IBM PVU Subcapacity
◦ All Metrics

◦ Audit Trail
◦ Hardware Inventory
The following permissions are removed from the user roles:
• Manage Software Classification
• Manage VM Managers and Servers
• View Audit Trail
• View Hardware Inventory
• View License Metrics

Classifying the BigFix client used by multiple BigFix
products
Note: Refer to Using BigFix Inventory to calculate license for BigFix products for a
complete step-by-step guidance on license counting process.

Upgrading
A new version of is released periodically, typically at the end of each calendar quarter.
Upgrade to the new version regularly to take full advantage of new features and application
fixes.

Upgrading to BigFix Inventory v10
BigFix Inventory is currently offered in single maintenance stream. Upgrading to the
entire environment includes upgrading the BigFix Inventory server, VM Manager tool, the
scanner, and the database. For best results, update the server regularly to benefit from new
capabilities and defect fixes. Once you finish the upgrade, you must restart all ongoing
actions to enable the fixlets.
Ensure that no files or directories in the BigFix Inventory installation directory are open in an
external program. For example, ensure that no log files are open in a text editor. Also, ensure
that no PDF reports are being generated during the server upgrade. Otherwise, the upgrade
might fail with error code 41.
For information about space requirements, see: Hardware requirements for the server on
Windows or Hardware requirements for the server on Linux.
Important: For best results, especially for big environments, first run the fixlet in
a test environment before you upgrade to check the component compatibility. To
do so, back up your production database, restore it on the test server, and then
upgrade. If the upgrade succeeds, upgrade the production server.

Note: You cannot upgrade between different operating systems.
For versions 9.2.14 or higher, you can directly upgrade to the latest version.
To upgrade to the latest version:
1. Create a backup of the server. See Backing up the server.
2. Upgrade the fixlet site. See Updating the fixlet site.

3. Upgrade BigFix Inventory using fixlet: Upgrade to the latest version of
BigFix Inventory.
4. Migrate the database schema. See Updating the server database
schema
5. Upgrade all BigFix Inventory components, such as BigFix Inventory
server, the database, VM Manager tool, scanner and actions. See
Upgrading the server in interactive mode, Upgrading the server in
silent mode, Updating the server database schema, and Upgrading the
scanner, tools and actions.
6. In case schema migration fails, restore the server. See Restoring the
server after a failed upgrade.
Result: The BigFix Inventory server is upgraded to the latest version.
Note: Run data import post upgrading the server.
For version lower than 9.2.14, it is not possible to upgrade directly to the latest
version. To upgrade to the latest version, use the fixlet to upgrade to the interim
version 10.0.2, migrate the database schema and then upgrade to the latest version.
To upgrade to the version 10.0.2:
1. Create a backup of the server. See Backing up the server.
2. Upgrade the fixlet site. See Updating the fixlet site.
3. Upgrade BigFix Inventory using fixlet: Upgrade to the interim version
10.0.2 of BigFix Inventory if version older than 9.2.14.
4. Migrate the database schema. See Updating the server database
schema
5. In case schema migration fails, restore the server. See Restoring the
server after a failed upgrade.

Result: The BigFix Inventory server is upgraded to interim version 10.0.2.
To upgrade the server to the latest version, perform the steps mentioned
above under the 'upgrade to the latest version' section.
Note: Run data import post upgrading the server.

Upgrade considerations
New features and improvements may impact the existing capabilities. You need to take
some additional steps or expect temporary longer duration of some processing.
Refer to the upgrade consideration when you upgrade from a specific version.
Table 149. Upgrade considerations
Version from which you are
upgrading
Earlier than 10.0.2

Considerations
The first data import after the upgrade takes longer,
because the data includes the installation path of
non-IBM software for existing records. This import is
a one-time operation, and the next import takes the
usual time to finish.
Information about the of scanned files is re-import
ed to show more details. The data is displayed on the
"Scanned File Data" report in the "File Version" col
umn.

Earlier than 9.2.11

The data is re-imported during a number of consecu
tive imports to avoid performance issues. Each con
secutive import contains data from 10000 comput
ers. The number of imports during which the data is
re-imported is specified in the resync_imports para
meter that is available by clicking Management > Ad
vanced Server Settings.

Table 149. Upgrade considerations (continued)
Version from which you are
upgrading
Earlier than 9.2.1

Considerations
If you had computer groups defined, subcapacity cal
culations are disabled for those groups after the up
grade. As a result, some of the panels and reports
are not available to users who are assigned to those
computer groups. To re-enable subcapacity calcula
tions, click Management > Computer Groups, open
a computer group, and select PVU, RVU MAPC, and
VPC. Then, click Save. For more information, see:
Setting up computer groups.

Updating the fixlet site
The content of the BigFix Inventory fixlet site can be periodically modified. New fixlets,
tasks, and analyses can be added. The existing ones can be changed or might become
obsolete due to functionality changes. If the BigFix server is installed on a computer with
the Internet access, the BigFix Inventory fixlet site is updated automatically whenever
the updates are available. However, if the server is installed on a computer without the
Internet access, you must update the fixlet site manually. Start by checking whether the
fixlet site that you are currently using is up-to-date. If a newer version of the fixlet site exists,
download the site content by using the Airgap tool. Then, cache the files on the BigFix
server by using the BES Download Cacher.
Note: The procedures in this section describe the extraction mode for upgrading the
fixlet site. However, you can use non-extraction mode as an alternative. To explore
the Airgap tool capabilities, see: Using the Airgap tool.

Checking the version of the fixlet site
Compare the current version of the fixlet site with the latest version that was published. If a
newer version is available, updated the content of your fixlet site.
1. To check what is the latest version of the fixlet site, open the http://sync.bigfix.com/
cgi-bin/bfgather/ibmforsua site, and look for the Version line.
2. To check what is the current version of the fixlet site that you are using, open the
BigFix console and click the name of the fixlet site. The version of the site is displayed
on the Details tab.
If a newer version of the fixlet site is available, update the content of your fixlet site.

Updating the content of the fixlet site on Windows
If the BigFix server is installed on a Windows computer without the Internet access, use the
Airgap tool to download the content of the fixlet site to a computer with the Internet access.
Then, move the files to the Windows computer on which the BigFix server is installed. You
can update the site content in extraction or non-extraction mode. The non-extraction mode
is simpler but the procedure is available from BigFix 9.5.5. For earlier versions, use the
extraction mode.

Updating site content in non-extraction mode
The following procedure describes the simplest path. For all available options, see: Using
the Airgap tool in the non-extraction mode in the BigFix documentation.
You need a Windows computer with the Internet access.
1. Obtain the serial number of your BigFix server and the e-mail address that is
specified in the BigFix license. To obtain this information, go to the following URL:
https://<ip_address>:<port_number>/masthead/masthead.afxm.
Where:
<ip_address>
IP address of the BigFix server.

<port_number>
Port that is used by the BigFix server. By default, it is 52311.
The information is listed in the following lines.
From: <mail_address>
X-Fixlet-Site-Serial-Number: <serial_number>

2. On a computer with the Internet access, gather site contents and create the Airgap
response file.
a. Go to the Airgap tool website and download the Airgap tool. Then, extract the
files.
b. Open the command line, go to the directory where you extracted the Airgap tool,
and run the following command.
BESAirgapTool.exe -serial <serial_number> -email
<mail_address> -createSiteList <site_list_file_name>

Where:
<serial_number>
Serial number of your BigFix server.
<mail_address>
E-mail address that is specified in the BigFix license.
<site_list_file_name>
Name of the file to which you want to write the sites for your
BigFix license.
c. Open the <site_list_file_name> file and check whether the flag A is specified next
to the IBM License Reporting site. The flag indicates that contents of the IBM
License Reporting site is gathered and necessary files are downloaded. If a
different flag is specified, change it to A.

N::BES
Support::http://sync.bigfix.com/cgi-bin/bfgather/bessupport
A::IBM License
Reporting::http://sync.bigfix.com/cgi-bin/bfgather/ibmlicenserep
orting

d. Open the command line, go to the directory where you extracted the Airgap tool,
and run the following command.
BESAirgapTool.exe -site <site_list_file_name> -download
-cache <cache_name>

Where:
<site_list_file_name>
Name of the file that contains the list of sites for your BigFix
license.
<cache_name>
Path to the folder where you want to store the downloaded files.
As a result, files are downloaded to the <cache_name> folder, and the
AirgapResponse file is created.
3. Copy the AirgapResponse, and the <cache_name> folder to the Linux computer
where the BigFix server is installed.
Place the files in the following locations.
• Place the AirgapResponse file in the folder with the BESAirgapTool.exe
script.
• Place the content of the <cache_name> folder in the BigFix server cache folder.
By default, the cache folder is: %PROGRAM FILES%\BigFix Enterprise
\BES Server\wwwrootbes\bfmirror\downloads\sha1.

4. Open the command line, go to the directory where you placed the files and run the
following command to import the content of the fixlet site to your BigFix server.
BESAirgapTool.exe

Updating site content in extraction mode
The following procedure describes the simplest path. For all available options, see: Using
the Airgap tool in the extraction mode in the BigFix documentation.
You need a Windows computer with the Internet access.
1. Open the directory where the BigFix server is installed and run the
BESAirgapTool.exe file. When prompted, save the file to a new folder, for example
Airgap. An airgap request file is created.
2. Copy all the created files to a Windows computer with the Internet access.
3. On the Windows computer with the Internet access, run the BESAirgapTool.exe.
The airgap request file is changed into a response file.
4. Copy the AirgapResponse file to the BigFix server and place it in the directory that
you created in step 1.
5. Run BESAirgapTool.exe. The airgap response is loaded to the BigFix server.
Cache the files and move them to the BigFix server.

Updating the content of the fixlet site on Linux
If the BigFix server is installed on a Linux computer without the Internet access, use the
Airgap tool to download the content of the fixlet site to a computer with the Internet access.
Then, move the files to the Linux computer on which the BigFix server is installed. You can
update the site content in extraction or non-extraction mode. The non-extraction mode
is simpler but the procedure is available from BigFix 9.5.5. For earlier versions, use the
extraction mode.

Updating site content in non-extraction mode
The following procedure describes the simplest path. For all available options, see: Using
the Airgap tool in the non-extraction mode in the BigFix documentation.
You need a Windows or Linux computer with the Internet access.
1. Obtain the serial number of your BigFix server and the e-mail address that is
specified in the BigFix license. To obtain this information, go to the following URL:
https://<ip_address>:<port_number>/masthead/masthead.afxm.
Where:
<ip_address>
IP address of the BigFix server.
<port_number>
Port that is used by the BigFix server. By default, it is 52311.
The information is listed in the following lines.
From: <mail_address>
X-Fixlet-Site-Serial-Number: <serial_number>

2. On a computer with the Internet access, gather site contents and create the Airgap
response file. You can perform these steps on Windows or Linux, regardless of the
operating system on which the BigFix server is installed.
•

To gather site contents and create the Airgap response file on a
Windows computer with the Internet access, perform the following steps.
a. Go to the Airgap tool website and download the Airgap tool. Then, extract
the files.
b. Open the command line, go to the directory where you extracted the
Airgap tool, and run the following command.
BESAirgapTool.exe -serial <serial_number> -email
<mail_address> -createSiteList <site_list_file_name>

Where:

<serial_number>
Serial number of your BigFix server.
<mail_address>
E-mail address that is specified in the BigFix license.
<site_list_file_name>
Name of the file to which you want to write the sites for your
BigFix license.
c. Open the <site_list_file_name> file and check whether the flag A is
specified next to the IBM License Reporting site. The flag indicates that
contents of the IBM License Reporting site is gathered and necessary files
are downloaded. If a different flag is specified, change it to A.
N::BES
Support::http://sync.bigfix.com/cgi-bin/bfgather/bessupport
A::IBM License
Reporting::http://sync.bigfix.com/cgi-bin/bfgather/ibmlicen
sereporting

d. Open the command line, go to the directory where you extracted the
Airgap tool, and run the following command.
BESAirgapTool.exe -site <site_list_file_name> -download
-cache <cache_name>

Where:
<site_list_file_name>
Name of the file that contains the list of sites for your BigFix
license.
<cache_name>

Path to the folder where you want to store the downloaded
files.
As a result, files are downloaded to the <cache_name> folder, and the
AirgapResponse file is created.
•

To gather site contents and create the Airgap response file on a Linux
computer with the Internet access, perform the following steps.
a. Go to the computer where the BigFix server is installed, open the terminal,
and run the following command.
# cd /opt/BESServer/bin
# ./Airgap.sh -remotedir <folder_name>

Where: <folder_name> is the folder that you will copy to the Linux
computer with the Internet access.
b. Move the <folder_name> folder to the Linux computer with the Internet
access.
c. In the <folder_name> folder, locate the airgap.tar compressed file, and
decompress it.
d. From the decompressed folder, delete the AirgapRequest.xml file.
e. Open the terminal, go to the directory where you extracted the Airgap tool,
and run the following command.
./Airgap.sh -serial <serial_number> -email
<mail_address> -createSiteList <site_list_file_name>

Where:
<serial_number>
Serial number of your BigFix server.
<mail_address>
E-mail address that you specified in the BigFix license.
<site_list_file_name>

Name of the file to which you want to write the sites for your
BigFix license.
f. Open the <site_list_file_name> file and check whether the flag A is
specified next to the IBM License Reporting site. The flag indicates that
contents of the IBM License Reporting site is gathered and necessary files
are downloaded. If a different flag is specified, change it to A.
N::BES
Support::http://sync.bigfix.com/cgi-bin/bfgather/bessupport
A::IBM License
Reporting::http://sync.bigfix.com/cgi-bin/bfgather/ibmlicen
sereporting

g. Open the terminal, go to the directory where you extracted the Airgap tool,
and run the following command.
./Airgap.sh -site <site_list_file_name> -download
-cache <cache_name>

Where:
<site_list_file_name>
Name of the file that contains the list of sites for your BigFix
license.
<cache_name>
Path to the folder where you want to store the downloaded
files.
As a result, files are downloaded to the <cache_name> folder, and the
AirgapResponse file is created.
3. Copy the AirgapResponse, and the <cache_name> folder to the Linux computer
where the BigFix server is installed.
Place the files in the following locations.

• Place the AirgapResponse file in the folder with the Airgap.sh script.
• Place the content of the <cache_name> folder in the BigFix server cache
folder. By default, the cache folder is: /var/opt/BESServer/wwwrootbes/
bfmirror/downloads/sha1.
4. Open the terminal, go to the directory where you placed the files and run the following
command to import the content of the fixlet site to your BigFix server.
./Airgap.sh -run

Updating site content in extraction mode
The following procedure describes the simplest path. For all available options, see: Using
the Airgap tool in the extraction mode in the BigFix documentation.
You need a Windows computer with the Internet access.
1. Download the Airgap tool to the Windows computer with the Internet access. The tool
is available on the BigFix Enterprise Suite Download Center page.
2. Open the command line and run the following command.
• For BigFix version 9.5.5 and higher
cd /opt/BESServer/bin
./Airgap.sh -remotedir <directory>

Where:
<directory>
Directory where the airgap.tar file is going to be created.
• For BigFix versions up to 9.5.4
cd /opt/BESServer/bin
./Airgap.sh -run

The airgap.tar file is created in the current directory.
3. To extract the Airgap request file from the airgap.tar file, run the following
command.

tar xvf airgap.tar

4. Copy the extracted AirgapRequest.xml file to the Windows computer and place it
in the folder that contains the downloaded BESAirgapTool.exe file.
5. On the Windows computer, run the BESAirgapTool.exe. The Airgap request file is
changed into the Airgap response file.
6. Copy the AirgapResponse file to the Linux computer where the BigFix server is
installed and place it in the /opt/BESServer/bin directory.
7. Run the Airgap tool again to upload the AirgapResponse file to BigFix.
cd /opt/BESServer/bin
./Airgap.sh -run

Wait a few minutes for the BigFix console to refresh.
Cache the files and move them to the BigFix server.

Caching the files
Typically, fixlets and tasks download files that they require from the Internet. In separated
networks, the required files must first be cached on a Windows computer with the Internet
access and then moved to the BigFix server.
You need a Windows computer with the Internet access.
You need to complete these steps only if you updated the site content in extraction mode. If
you updated the site content in non-extraction mode, the steps are not required.
1. Optional: The default size of the BigFix server cache is enough if you use only the
BigFix Inventory v10 fixlet site. If you plan to run fixlets from other sites, such as BES
Support, increase the cache size so that the BigFix server does not try to delete any
files. To increase the cache size, perform the following steps.

a. Log in to the BigFix console.
b. In the navigation tree, click Computers and right-click the computer on which
the BigFix server is installed. Then, click Edit Computer Settings.
c. Increase the value of the _BESGather_Download_CacheLimitMB setting. If the
setting is not on the list, add it and specify the value in MB.
The size depends on each fixlet site. You might need to increase it to at least a
couple of gigabytes.
2. Copy the BigFix Inventory.efxm file from the BigFix server to the Windows
computer with the Internet access.
a. Log in to the computer where the BigFix server is installed and go to the
install_dir\BES Server\wwwrootbes\bfsites directory.
b. Copy the BigFix Inventory.efxm file and move it to the computer with the
Internet access. Place the file in the C:\BigFix directory.
3. Use the BES Download Cacher to download the required files.
a. Download the BES Download Cacher to the computer with the Internet access.
The tool is available on the BigFix Enterprise Suite Download Center page.
b. On the computer with the Internet access, go to the C:\BigFix directory, and
create a folder that is called downloads.
Tip: Do not clean the contents of this folder. Next time, when you run
the Download Cacher only the files that were changed since the last d
will be updated. The process will last shorter than if you downloaded the
entire content every time.
c. Run the BES Download Cacher.
BESDownloadCacher.exe -m "C:\BigFix\BigFix Inventory.efxm"
-x C:\BigFix\downloads

4. Copy the contents of the downloads folder from the computer with the Internet
access to the following directory on the BigFix server.
install_dir\BES Server\wwwrootbes\bfmirror\downloads\sha1

The cached files are automatically delivered to the BigFix relays and clients every time you
run a fixlet that requires those files. Use both the Airgap tool and the BES Download Cacher
periodically to ensure that the content of your fixlet site is always up-to-date.
When you run a fixlet, an action is created to indicate the status of its execution. If an action
started by a fixlet is running and a newer version of the fixlet is delivered, stop the current
action. Then, run the new version of the fixlet. To do this, perform the following steps.
1. Log in to the BigFix console and go to Actions.
2. Look for actions started by fixlets that were updated, right-click each action, and click
Stop Action.
3. Run the updated version of the fixlets.

Backing up the server
Before you start the upgrade, back up the database, installation registry, and the server files
to be able to restore the server if the upgrade fails.
1. Stop the BigFix Inventory server.
2. Back up the database.
Back up the DB2 database.
Back up the SQL Server database.
3. Back up the installation registry.
/var/.com.zerog.registry.xml
This file is hidden. To view it, run the ls -la command.
If you installed the server as a non-root user, the registry is in
$HOME/.com.zerog.registry.xml.
C:\Program Files\Zero G Registry\.com.zerog.registry.xml

This file is hidden. To view it, change the Folder Options in Control Panel to display
hidden files, or type the complete path in the address bar of any open window.
4. Back up the installation directory. The default paths are:
For BigFix Inventory 10.x
/opt/BFI
C:\Program Files\BigFix Enterprise\BFI
For BigFix Inventory 9.x
/opt/ibm/BFI
C:\Program Files\ibm\BFI
5. If you did not start the BigFix Inventory server during the database backup, start the
server now.
You completed all steps that are required to restore the server after a failed upgrade. You
can proceed to upgrading the server.

Upgrading the server in interactive mode
To upgrade the server in interactive mode, start the installation of a newer version of BigFix
Inventory on the same computer. In interactive mode, you upgrade the server through a
wizard.
To see the automated procedure for upgrading the server to the newest version, see:
Upgrading to BigFix Inventory v10.
Create a back up of the database, installation registry, and the server files to be able to
restore the server if the upgrade fails.
1. Download the latest installer and extract it.
a. Log in to the BigFix console and go to Sites > External Sites > BigFix Inventory
v10 > Fixlets and Tasks.
b. Select Download BigFix Inventory, and click Take Action.
c. Select the computer on which the BigFix Inventory server is installed, and click
OK. When the download completes, extract the installer.

2. Run one of the installation files:
setup-server-linux-x86_64.sh
setup-server-windows-x86_64.bat
3. Follow the steps in the wizard.
4. When the upgrade is complete, click Done.
Tip: If the upgrade fails, check the upgrade logs. For more information, see:
Server installation and upgrade logs.
Continue with the upgrade of the remaining components

Related reference
Server installation and upgrade logs
Installation and upgrade problems
Related information
Restoring the server after a failed upgrade

Upgrading the server in silent mode
To upgrade the server in silent mode, start the installation of a newer version of BigFix
Inventory on the same computer. Silent installation runs in the background.
To see the automated procedure for upgrading the server to the newest version, see:
Upgrading to BigFix Inventory v10.
Create a back up of the database, installation registry, and the server files to be able to
restore the server if the upgrade fails.

1. Download the latest installer and extract it.
a. Log in to the BigFix console and go to Sites > External Sites > BigFix Inventory
v10 > Fixlets and Tasks.
b. Select Download BigFix Inventory, and click Take Action.
c. Select the computer on which the BigFix Inventory server is installed, and click
OK. When the download completes, extract the installer.
2. Read the license agreement in the license.txt file. The file is in the license/
LA_language directory.
3. Edit the upgrade_response.txt file.
4. In the response file, set the RSP_LICENSE_ACCEPTED parameter to true.
5. To start the upgrade, run one of the following commands:
./setup-server-linux-x86_64.sh -i silent -f /
response_file_path/upgrade_response.txt
setup-server-windows-x86_64.bat -i silent -f
response_file_path\upgrade_response.txt
For response_file_path, enter the absolute path to the response file. For example:
setup-server-windows-x86_64.bat -i silent -f
C:\images\SUA\upgrade_response.txt

Tip: If the upgrade fails, check the upgrade logs. For more information, see:
Server installation and upgrade logs.
Continue with the upgrade of the remaining components

Related reference
Server installation and upgrade logs
Installation and upgrade problems

Related information
Restoring the server after a failed upgrade

Updating the server database schema
BigFix Inventory server database schema gets updated when upgrading from one version to
another.
MS SQL only
1. Database user configured for BigFix Inventory must be the owner of database. A nonowner cannot perform the database update. Following error message appears if a non
database-owner tries to update the database:
*'User ''%{user_name}'' is not the owner of specified database.
Current database owner is ''%{owner}''.
As Database Administator use the following query to fix database
ownership: ALTER AUTHORIZATION ON DATABASE::
%{db_name} TO "%{user_name}".'*

2. MS SQL database has a MS SQL agent created BigFix Inventory database index
maintenance. Index maintenance is not supported for MS SQL express edition. The
following message appears for MS SQL express edition:
MS SQL Express Edition is detected.
There will be not created BFI Index Maintenance Job as this edition
does not support SQL Server Agent.

3. The user must have a system admin or has the access of "SQLAgentUserRole" for
msdb database to manage SQL Server agent jobs. Without access, the user cannot
manage the BigFix Inventory index maintenace job. Instead to the index maintenance
job being created/updated, the following warning appears in the tema.log log file.

"<strong>WARNING - </strong> The database user % {user_name}

Database upgrade is not blocked but the index maintenance job is not created. The
tema.log file includes the failure as a warning for migration scripts running during the

job creation attempt.
Follow the below steps to update the database schema:
1. After you upgrade the server, go to BigFix Inventory and click on Schema Update to
complete the upgrade.
For the MS SQL database, the user who is configured in this database must have the
db_owner role assigned. Log in to BigFix Inventory, and click Update Schema.

Important: The time taken to complete the upgrade depends on the size of the
environment. It may vary from 2 minutes to 2 hours.
2. To ensure that all changes are processed, run an import. In BigFix Inventory, click
Management > Data Imports, and click Import Now.
Important: The time taken by the first import may take longer as it includes
the new software catalog as well as might conduct additional computation do
prepare existing data for new version.

Upgrading the scanner, tools and actions
Upgrade BigFix Inventory scanner, tools, and actions as part of server upgrade process.
1. Upgrade the VM Manager tool to the latest version.
a. In the BigFix console, go to Fixlets and Tasks.
b. Select Update VM Manager Tool to version number, and click Take Action.
c. Select the computer on which the VM Manager Tool is installed, and click OK.
2. Update the BigFix Inventory scanner on an operating system that is supported.
New Scanner releases contains security fixes, fixes of problems that appear in your
environment, or new features that you want to use, upgrade the scanner to the latest

version. For information about changes introduced in each version of the scanner, see
the Release notes.
To update the scanner, perform the following steps:
a. In the BigFix console, go to Fixlets and Tasks.
b. Select Install or Update Scanner, and click Take Action.
c. Select all relevant computers, and click OK.
3. It is recommended to restart actions like Initiate Software Scan and Upload Software
Scan Results to benefit from improvements and new features. For other fixlets and list
of updated actions, refer to Release notes. You can also check Source Release Date
to see updated action.
To restart the actions, perform the following steps:
a. In the BigFix console, go to Actions.
b. Look for actions started by the fixlets that were updated, right-click each action,
and click Stop Action.
c. Run the updated version of the fixlets.

Restoring the server after a failed upgrade
After a failed upgrade, you can restore the server to its original state by restoring the
database, installation registry, and the server files from backups.
If you did not back up the installation directory and the registry, you can install the new
server and restore only the database. You can keep the data that is already in your database
and avoid running the initial import.
1. Stop the server.
2. Restore the database from a backup.
Restore the DB2 database.
Restore the SQL Server database.
3. Replace the installation registry with the backup registry. Copy the
.com.zerog.registry.xml backup file to one of the following directories:
/var/

C:\Program Files\Zero G Registry\
If you installed the server as a non-root user, copy the backup file to $HOME/.
4. Replace the installation directory with the backup directory.
5. Start the server.

Migrating from License Metric Tool
It is possible to migrate from IBM License Metric Tool to HCL BigFix Inventory. Please
contact support for additional instructions providing your current IBM License Metric Tool
version and database details. Migration process is manual and it is recommended to get
assistance from HCL services.

Managing the infrastructure
After you complete the initial configuration of , learn how to manage components of its
infrastructure: VM managers, server, database, and data sources.

Computer statuses
Computer statuses provide information about the condition of the computers that are
monitored by BigFix Inventory. To properly discover the installed software and measure its
license metric utilization, ensure that computers in your environment work correctly.

OK
There are no problems with the computer. No actions are required.

No Scan Data
Results of the capacity scan are missing. To solve the problem, schedule the capacity
scan, and upload its results. For more information, see: Initiating the capacity scan on all
computers.

No Host Scan Data
The BigFix client is not installed on the host operating system. Depending on the
virtualization technology, perform the following actions:
• For HP Integrity VM, install the BigFix client on the host computer and wait until it
uploads the capacity scan results or upload them manually. For more information,
see: Initiating the capacity scan on all computers.
• For Solaris Container/Zones or Logical Domains (LDOM), install the BigFix client in the
following zones:
◦ Global zone on the control domain
◦ Global zones of all local zones in which software is installed
Wait until the client uploads the capacity scan results or upload them manually. For
more information, see: Client installation on Oracle Solaris.
• For other virtualization technologies, refer to Virtualization Capacity License Counting
Rules for more information.

Outdated VM Manager Data
Connection to the VM manager is configured, but hardware inventory data that was
retrieved from the computer is older than 3 days. License metric utilization is not affected
yet. If you do not resolve the issue within 30 days, the computer status changes to No VM
Manager Data and default IBM PVU counting is applied to the computer. As a result, license
metric utilization that is reported can be higher. For more information, see: Default PVU
counting on x86 processors.
Note: The period after which hardware inventory data is considered outdated is
configured by the vmManagerDetachmentNotificationPeriod parameter. The period
after which the computer status changes to No VM Manager Data is configured by
the vmManagerDetachmentPeriod. For more information, see: Advanced server
settings.
To solve the problem, perform the following actions:
• Ensure that the VM manager is connected.
• Ensure that all parameters of the VM manager connection are correctly configured.
Important: When you troubleshoot the VM manager connection, ensure that
the following conditions are fulfilled:
◦ You have sufficient rights to collect information about the complete
virtualization topology including virtual machines, hosts, clusters, and
relations among them.
◦ The UUIDs of virtual machines and hosts are valid and in scope of the
particular virtualization technology.
◦ Information about the number of processors, total number of cores, and
processor description is available.
• If the problem persists on KVM although the VM manager connection is correctly
configured, go to Reports > Hardware Inventory, and check the value in the Server ID
column. If the value has the TLM_VM_UUID_of_the_VM format, check whether the UUID
is correctly set on the virtual machine. If two or more virtual machines have the same

UUID, manually set unique UUIDs for these machines. Note that virtual machines can
operate on different hosts.
• Ensure that each cluster in your infrastructure has a unique name. In the VMware
environment, it is not possible to create two clusters with the same name in the same
data center. However, vCenter can manage several data centers at the same time. As
a result, one vCenter can control clusters that have the same name but are in different
data centers. If multiple clusters share a name, rename them to keep each name
unique.
• Ensure that the value of the vmManagerDetachmentPeriod parameter is higher
than the frequency with which data is retrieved from VM managers. The interval
between consecutive retrievals of data is set by the vmm_polling_time_interval
parameter and is 30 minutes by default. If the idle time after which a computer that is
managed by a VM manager is considered detached is lower, change the value of the
vmManagerDetachmentPeriod parameter.

No VM Manager Data
Hardware inventory data that was retrieved from the computer is older than a specific
period or has never been retrieved. Default PVU counting is applied to the computer. As a
result, reported license metric utilization can be higher than actual. For more information,
see: Default PVU counting on x86 processors.
Impact of the peak of metric utilization on the reports depends on why the status appeared.
The status can appear in the following situations:
• The VM manager is not specified for the computer and hardware inventory data has
never been retrieved. If you configure the VM manager within a specific period, the
peak of metric utilization is ignored and does not influence the reports. The period is:
◦ 1 day for version up to 9.2.9.
◦ 30 days for version 9.2.10 and higher. The period can be configured by the
vmManagerDetachmentPeriod parameter.
• The VM manager is specified for the computer but the retrieved hardware
inventory data is older than a specific period. The period can be configured by the
vmManagerDetachmentPeriod parameter and is by default:

◦ 7 days for version up to 9.2.9
◦ 30 days for version 9.2.10 and higher
The peak of metric utilization is not removed from the reports that are generated for
the period when the computer had the No VM Manager Data status even after you
resolve the issue.
To solve the problem, perform the same actions as in case of the Outdated VM Manager
Data status.

Managing VM managers
VM managers are pieces of software that create, manage, and monitor virtual machines.
You configure connections to VM managers so that BigFix Inventory can gather data that is
required to calculate utilization of license metrics in virtual environments.

Collecting information from VM managers
Resources that are available to virtual machines are dynamically allocated based on current
needs. When a virtual machine is not performing processor-intensive tasks, processor cores
that are allocated to that machine are assigned to other virtual machines that need them
to handle their workload. Because of these dynamics, BigFix Inventory cannot scan virtual
machines to collect information about processor type and the number of available cores.
To collect this information, BigFix Inventory needs access to VM managers, which control
resources that are available to virtual machines. With such access, BigFix Inventory can
check the number of cores on the physical computer that hosts the virtual machines and
see the allocation and usage of these resources.
You must define connections to VM managers for the following x86 virtualization types:
• VMware vSphere
• Microsoft Hyper-V
• Kernel-based Virtual Machine except for the hosts that are not controlled by RHV-M
and the PowerKVM hosts that deliever capacity data with the Run Capacity Scan on
Virtualization Hosts fixlet.
• <deprecated> Oracle VM Server for x86

Lack of information from VM managers
You should configure connections to VM managers within 24 hours, after you run the first
successful hardware scan on new virtual machines. Otherwise BigFix Inventory is not able
to retrieve information about the virtualization hierarchy and physical processors. Thus, it is
not able to properly calculate subcapacity values. In such a case, BigFix Inventory applies
default PVU counting on virtual machines which causes that PVU utilization might be overcounted. For more information, see: Default PVU counting on x86 processors.
IBM accepts audit reports that contain PVU values calculated based on the default PVU
counting instead of considering the client to be ineligible for subcapacity or liable for full
capacity.
When you configure connections to VM managers later on, the reported PVU values are
lower than or equal to the values that were reported when the connections were missing.
However, peaks that resulted from missing connections remain on the reports that are
generated for the period when the peaks occurred.

VM Manager tool
To collect data from VM managers, BigFix Inventory uses the VM Manager tool. The tool
connects to VM managers and gathers data about their capacity, focusing on processors,
their type, and usage. The data is then imported to BigFix Inventory and utilization of license
metrics is calculated. In order to avoid any performance issues it is recommended to keep
the number of VM Manager Tool connections below 10 for a single VM Manager Tool.

Approaches to manage VM managers in BigFix Inventory
You can choose between two approaches to manage VM managers: basic (central - below
10 managed VM Manager Tool connections) or advanced (distributed - above 10 managed
VM Manager Tool connections). You can also combine these two approaches. The choice
depends on the specifics of your environment.

Default PVU counting on x86 processors
To properly calculate PVU subcapacity, BigFix Inventory requires information about the
number of processor cores that are available to virtual machines and on the physical

computers that host these machines. If the information is not available, license metric
utilization cannot be properly calculated and reported results might be over-counted for x86
processors.
When hypervisor data is not available, reported results might be over-counted due to the
following reasons.
• The applied PVU rate might be higher than the actual rate
PVU rate that is applied to a processor depends on the model and type of the
processor as well as the number of processors that can be installed on a physical
host (the number of sockets). When hypervisor data is not available, BigFix Inventory
cannot properly identify the PVU rate for a processor. It applies the PVU rate for the
configuration with the highest number of sockets that is possible for the particular
processor.
Important:

Starting from application update 9.2.11, BigFix Inventory

always applies 120 PVUs per core when the PVU rate for a processor cannot
be properly identified. In earlier versions of BigFix Inventory, the number of
applied PVUs was specified in the PVU table.
• The number of processor cores that are taken into account might be higher than the
actual number of available cores
If CPU is over-committed to virtual machines and the total virtual capacity exceeds
the physical capacity, virtual capacity must be capped to physical capacity according
to the pricing rules. When hypervisor data is not available, BigFix Inventory cannot
limit virtualization capacity to physical capacity.
IBM accepts audit reports that contain PVU values calculated based on the default PVU
counting instead of considering the client to be ineligible for subcapacity or liable for full
capacity.
For more information about the results of applying default PVU counting, see: Scenario:
Capacity in virtual environments with no VM managers defined.

Tip: If the hypervisor data is missing from a virtual machine and default PVU
counting is applied, ID of the server on which the machine runs begins with TLM_VM.

Supported virtualization types
BigFix Inventory requires that connections to VM managers are defined for the following
virtualization types: Kernel-based Virtual Machine, Microsoft Hyper-V, VMware vSphere, and
Xen.
Table 150. Supported virtualization types and versions
Virtualization Type

Comments

Kernel-based Virtual Managed by
Machine

RHV-M

Versions

• BigFix Invento
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versions, go to De

HTTP Basic Au

tailed System re

thentication and

quirements and

version 3 REST

click Supported Hy

API.

pervisors.

• You must use VM
Manager tool in
version 1.6.0.1 or
higher.
• Starting from VM
Manager tool up
date 9.2.17, Big
Fix Inventory sup
ports instances
that use version
4 API and Oauth2
Authentication.

Table 150. Supported virtualization types and versions (continued)
Virtualization Type

Comments
Not managed

Versions

• Capacity data

by RHV-M

from x86 KVM
hosts that are
not controlled by
RHV-M is collect
ed directly from
the host by using
the Run Capaci
ty Scan on Virtu
alization Hosts
fixlet. For more
information, see:
Collecting capaci
ty data from virtu
alization hosts for
Xen and KVM

Nutanix
AVH

Managed by Nu
tanix Prism

•

Support
for Linux guests
on AHV 5.11+ on
IBM Power CS ap
pliances, man
aged by Nutanix
PRISM. BigFix In
ventory supports
PRISM API ver
sion 2. AIX guest
is not currently
supported.

Table 150. Supported virtualization types and versions (continued)
Virtualization Type

Comments

Versions
Support

•

for Linux and Win
dows guests on
AHV 5.11+ on x86
appliances, man
aged by Nutanix
PRISM
Microsoft Hyper-V

• If you are going to
use WinRM com
munication in
terface, config
ure WinRM on all
hosts. For more
information, see:
Configuring Win
RM.

Azure
VMware Solution

• Azure VMware
is supported as
an on-premise
VMware infra
structure instal
lation. To collect
data, you must
configure con
nection to the
VMware SDK
API that is spe
cific to your in
stance of the

Table 150. Supported virtualization types and versions (continued)
Virtualization Type

Comments
Azure VMware on
the VM Managers
panel.

VMware
Cloud on AWS

• VMware Cloud on
AWS is support
ed the same way
as an on-prem
VMware infra
structure installa
tion.
• To collect data,
configure connec
tion to the vCen
ter Server that is
specific to your
instance of the
VMware Cloud on
AWS (not to the
AWS portal) on
the VM Managers
panel.
• If the VM Manag
er Tool is installed
on a virtual ma
chine on VMware
Cloud on the AWS
infrastructure,
ensure that you

Versions

Table 150. Supported virtualization types and versions (continued)
Virtualization Type

Comments

Versions

complete the fol
lowing steps.
◦ Enable com
munication
between the
VM where
the VM
Manager
Tool is in
stalled and
the vCen
ter Server
by using the
TCP port
443. To al
low for this
communi
cation, con
figure the
Manage
ment Gate
way fire
wall. In the
default con
figuration,
such com
munication
is denied.
◦ If the vCen
ter Server

Table 150. Supported virtualization types and versions (continued)
Virtualization Type

Comments

Versions
URL points
to an ex
ternal IP,
modify the
hosts file
on the VM
where the
VM Man
ager Tool
is installed
and add an
entry that
points to
the private
address of
the vCenter
Server.

VMware vSphere

ESXi

• You must have
at least read-only
rights to all VMs.
For more informa
tion, see: Verify
ing permissions.

vCenter

• You must have
at least read-only
rights to all VMs.
For more informa
tion, see: Verify
ing permissions.

Table 150. Supported virtualization types and versions (continued)
Virtualization Type

Comments

Versions

• BigFix Inventory
supports config
uration with one
single sign-on do
main, one single
sign-on site, and
vCenter Server
with Platform Ser
vices Controller
on the same ma
chine (Embedded
Deployment Mod
el).
• BigFix Inventory
supports vCen
ter Server instal
lation on a Win
dows computer
and as a vCenter
Server Appliance.
•

BigFix
Inventory sup
ports the configu
ration with exter
nal Platform Ser
vices Controller
(PSC) with one
PSC on a different
machine. In case
of a complex envi

Table 150. Supported virtualization types and versions (continued)
Virtualization Type

Comments

Versions

ronment with mul
tiple PSCs, con
tact HCL Support.
Citrix Hypervisor (formerly
XenServer)

• XenServer Tools
must be installed
on all VMs.

VMware vSphere
VMware vSphere is one of the virtualization technologies supported by BigFix Inventory.

Purpose
This solution consists of two products: a VMware ESX (or ESXi) hypervisor and a VMware
vCenter server. Both of these components provide the API that can be used to extract
information concerning virtual machines in your infrastructure. The section below shows
the differences between these two varieties.

ESX or ESXi
It is an operating system that hosts virtual machines. It is enough to connect to a specific
ESX if you do not use any software deployed in a clustered environment. However, if an ESX
is controlled by a vCenter, it is recommended to connect a given VM manager to it via the
vCenter. This is because BigFix Inventory needs data from every ESX box (every box that
hosts a virtual machine where the CIT scanner is installed). If you choose a connection via
ESX, you have to define all the ESX boxes separately in the VM Managers panel. If you have
a vCenter deployed, you can manage all the ESX boxes via this server (it saves time and
decreases the network load).
Note: Changing the Universally Unique Identifier (UUID) on ESX virtual machines
may lead to overcharging because when the identifier is changed, BigFix Inventory
recognizes it as a brand new virtual machine.

Supported versions:
For a full list of supported versions, see: Supported virtualization types.

vCenter
It is used for managing computer systems on which virtual machines are installed. You have
to use it if your software is installed in a clustered environment. Instead of connecting to
each ESX box separately, you connect to all ESX boxes via a vCenter, whose main role is to
retrieve data from them. Therefore, it is beneficial to you to connect to ESX boxes through a
vCenter even if you do not have a clustered environment because in this way you can reduce
the network traffic.
Supported versions:
For a full list of supported versions, see: Supported virtualization types.

The default URL for ESX or ESXi, and vCenter
The default URL that is to be used (it may vary in your environment if the administrator of
the ESX box, or vCenter has changed the configuration of the API, for example, if the HTTP
protocol is used instead of the HTTPS one):
• For ESX or ESXi: https://ESX_IP_address/sdk/vimService.wsdl
• For vCenter: https://vCenter_IP_address/sdk/vimService.wsdl
Make sure that the vSphere Web Services SDK is set up and verify if the given URL is
valid. Paste the URL into the Web browser and make sure that if it can be accessed. If not,
check the setup of the URL in vCenter settings. To do this, go to vCenter Server Settings
> Advanced Settings and see the setting of VirtualCenter.VimApiUrl. If the URL cannot be
reached, consult your VMware administrator.

Supported topologies
BigFix Inventory supports configuration with one single sign-on domain, one single sign-on
site, and vCenter Server with Platform Services Controller on the same machine (Embedded
Deployment Model). To set up other topologies, including external Platform Services or
multiple single sign-on sites, you must connect to each ESX box separately.

Verifying permissions for VMware communication
Users must have sufficient privileges to collect all the data from the VM managers for
VMware. The user must have at least read-only rights to all VMs on which the agents are
running.
You verify whether users have sufficient privileges in the VMware Infrastructure Client. The
user must have the correct access privileges for VMs on which the endpoints are running,
and for the hosts of the VMs. If a user has insufficient privileges, agents return a No VM
Manager Data status.
This procedure describes how to enable read-only rights for all elements in a virtual
topology. Read-access is required only to the VMs on which the endpoints are running and
to hosts of these VMs. However, the easiest way to set access permissions is to configure
read-only access for all elements in a virtual topology.
1. To extend the privileges for the user, log in to VMware Infrastructure Client with a user
that has administrator rights.
2. Right-click on the left bar and choose Hosts and Clusters.
3. Go to Permissions tab, right-click anywhere in the section, and then click Add
Permission.
4. In the Assign Permissions panel, click Add, choose the user, and then click OK.
5. Choose Read-Only as an Assigned Role.
6. Select the Propagate to Child Objects check box, and click OK.

Microsoft™ Hyper-V
Microsoft™ Hyper-V is one of the virtualization technologies that are supported by BigFix
Inventory. It is the successor of Microsoft™ Virtual Server.

Purpose
To retrieve information about the measures and virtualization structure of virtual machines,
define the Hyper-V hypervisors as VM managers on the BigFix Inventory server. They are
able to expose required data via the WS-MAN protocol.

In the case of clusters, two approaches exist:
1. Define all Hyper-V servers that are a part of the cluster in the VM Managers panel. If
any servers are missing, they are in the Incomplete definition status.
2. If all members of the cluster have at least one common set of credentials that has
privileges to access the WS-MAN interface (for example, the domain user), define one
computer system from the cluster as a VM manager. Then, select the option to share
credentials. The BigFix Inventory server uses the credentials to connect to the HyperV that you defined in the user interface. Then, it extracts addresses of the remaining
cluster members and connects to them by using the same credentials.

Communication interface
You can choose to use PowerShell or WinRM as the communication interface for Hyper-V.
For both communication interfaces, make sure that you provide the user name in one of the
following formats:
• user_name@domain, for example: test@cluster.com
• user_name\domain, for example: test\cluster.com
Starting from application update 9.2.16, you can also provide the administrator
user name in one of the following formats:

• domain@user_name, for example: cluster.com@test
• domain\user_name, for example: cluster.com\test
Note: Make sure that you upgrade the VM Manager Tool to version 9.2.16, not only
the server.
If the target server is not in a domain, specify its host name as the domain. For example:
• test\hostname or test@hostname
hostname\test or hostname@test

•
PowerShell

PowerShell is a framework for managing the automation and configuration
of tasks and can use the RPC protocol. In order for BigFix Inventory to use
PowerShell for retrieving the information from VM managers, the VM Manager
Tool must be installed on a Windows™ computer. The computer must also
meet the following requirements:
• Microsoft™ RPC communication with Microsoft™ Hyper-V must be
allowed by Windows firewall
• ICMP Echo Reply must be allowed by Windows firewall
• Microsoft™ PowerShell 2.0 or higher must be installed
• Microsoft™.NET Framework 3.5 or higher must be installed
Important: If you are using .NET Framework 4.0 or higher, use
PowerShell version 3.0 or higher.
The use of PowerShell depends on the operating system of your BigFix server,
because the main VM Manager Tool is installed along with the server:

You configure a Hyper-V VM manager in the BigFix Inventory UI
and choose PowerShell as the communication interface.
You use advanced VM management to install additional VM
Manager Tool on any Windows computer, and then specify a Hyper-V
VM manager in a configuration file. Such a VM manager is not visible in
the UI, but is managed through the VM Manager Tool command line. For
more information, see Advanced VM management.

WinRM
Windows Remote Management (WinRM) is the Microsoft implementation
of the WS-Management protocol. It uses Simple Object Access Protocol
(SOAP) over HTTP and HTTPS. In order for BigFix Inventory to use WinRM for
retrieving the information from VM managers:
• You must configure Windows™ Remote Management Service (WinRM)
for all members of the Microsoft™ Hyper-V cluster. For more information,
see: Configuring WinRM on Hyper-V hosts.
• The default URL that is to be used is "https://<HYPERV_IP_address>:<port>/wsman", where <port> is the port of the listener
that was created for the WinRM service. The default value for the HTTP
listeners is 5985 and for HTTPS listeners is 5986 (WinRM 2.0). To verify
all the defined WinRM listeners, use the winrm enumerate winrm/
config/listener command.

WinRM communication interface uses NTLM authentication in order to
access data on virtual machines. As a result, in VM Manager Tool logs
you can notice the following messages:

2022-01-01 00:00:00 : (vmmconf_xxxx.properties)
com.ibm.license.mgmt.vmmanager.hyperv.net.HttpConnector::in
itializeNTLM::Response Code is: 401

The response code 401 is expected to be returned as part of NTLM
protocol client-server message exchange. For information about NTLM
protocol, see the tech community article.

Supported versions
For a full list of supported versions, see: Supported virtualization types.

Configuring WinRM on Hyper-V hosts
Configure Windows™ Remote Management to allow the BigFix Inventory server to gather
data about virtualization topology of virtual machines installed in your infrastructure.
• To retrieve the data that is required to properly calculate PVU, you must be logged in
as a local administrator on the Hyper-V host. It is necessary because the Windows
Management Instrumentation call that accesses MsCluster namespace requires an
administrative account.
• Hardcoded and select-only statements are run over WinRM. The obtained data is
stored in a database schema. BigFix Inventory does not modify the Hyper-V settings
and does not affect it any other way.
The WinRM service is an implementation of WS-Management specification that enables
cooperation between hardware and operating systems that come from different vendors.
The BigFix Inventory server connects to this service defined as a VM manager and collects
data regarding virtualization hierarchy. Therefore, you must perform the following procedure
on each Hyper-V host in your infrastructure, including those that are part of a cluster, to
ensure the WinRM service is running and configured to enable communication with the
server.

1. Defining HTTP and HTTPS listeners. By default, communication with the WinRM
service is disabled because there are no listeners defined. To check whether there
are any listeners that are currently defined, type the following command: winrm
enumerate winrm/config/listener. If there is no output returned, there are no

listeners defined.
a. To define a default HTTP listener, type:
winrm quickconfig

The command starts the WinRM service and sets it to start automatically with
the system start. It also creates an HTTP listener on the default port (accepting
requests from any IP), it defines Internet Connection Firewall exceptions for the
service, and it opens the HTTP port. Depending on the version of the WinRM
service, the default HTTP port might be 80 or 5985. For more information, see
Installation and Configuration for Windows™ Remote Management.
b. To define a listener for secure connection (HTTPS), you must have a valid
certificate on the Hyper-V host with a CN that matches the host name that
you are using to connect to Hyper-V. You must also create a listener with
the CertificateThumbprint of that certificate. For more information, see the
Microsoft documentation: http://support.microsoft.com/kb/2019527.. You
might be able to create a self-signed certificate for testing purposes, however,
you should consult your certificate administrator.
Note: If an appropriate certificate was not found on the machine, the
above command will not work and the following output will be returned
“The certificate must have a CN matching the host name, be appropriate
for Server Authentication, and not be expired, revoked, or self-signed.”
If there is a need to use a self-signed certificate, you can manually
generate it and create the listener by starting the following command:
winrm create
winrm/config/listener?Address=*+Transport=HTTPS

@{Hostname=”<the name of your
server>”;CertificateThumbprint=”<certificate
thumbprint>”}

In this case you have to configure the firewall settings manually.
2. Enabling WinRM Negotiate authentication scheme. The WinRM service offers
several authentication schemes to be used to authenticate the client side. The BigFix
Inventory server uses Negotiate authentication scheme, which is enabled by default.
a. To check the current setting of this property, type:
winrm get winrm/config/service/auth

b. To set the required value of this property, enter:
winrm set winrm/config/service/auth @{Negotiate="true"}

3. Setting WinRM AllowUnencrypted property. The server requires the property to be set
to "true".
a. To check the current settings, type:
winrm get winrm/config/service

b. To set the required value of this property, type:
winrm set winrm/config/service @{AllowUnencrypted="true"}

Note: Setting this value to "true" does not mean that the sensitive data,
such as user names or passwords, will be passed in an unencrypted
form over the network. Only the content of the SOAP messages will
be sent as a plain text. If this cannot be accepted because of security
reasons, define the HTTPS listener and use the secured transport
(HTTPS) while defining a VM manager in the BigFix Inventory server so
that the TLS protocol will be used to encrypt all the network traffic.

4. Verifying the listener. After you define the HTTP or HTTPS listener, verify that you can
remotely connect to the Hyper-V server.
a. On the Hyper-V server, determine the port on which the Windows Remote
Management client for the HTTP or HTTPS transport listens. Type the following
command in the Windows command line:
winrm enumerate winrm/config/listener

• If the port number is listed in the Port line, the listener was properly
created.
• If you receive an error or there is no information for the transport, the
listener was not created properly. Go back to step one, and define the
listener again.
b. To verify the listener, type:
winrm enumerate winrm/config/listener /r:<transport>://
<Hyper-V_server_name>:<port>/wsman /u:<user_id> /p:<password> /
a:Negotiate

Where
<transport>
Is either HTTP or HTTPS.
<Hyper-V_server_name>
Is the host name of the Hyper-V server. If you are using HTTPS, the
host name must match the CN in the certificate.
<port>
Is the port number that you obtained in the previous step.
<user_id>
Is the user ID that is used to connect to the Hyper-V server.
<password>

Is the password that is used to connect to the Hyper-V server.
For example:
winrm enumerate winrm/config/listener /r:https://
myhyperv.ibm.com:5986/wsman /u:administrator /p:abc /a:Negotiate

5. Verifying whether the Virtual System Management service is running. To verify that
the service that provides Hyper-V management is running, go to Administrator Tools
> Services on the Hyper-V server. Look for the service called Hyper-V Virtual Machine
Management
• If the service exists, but is not running, start the service.
• If the service does not exist, the Hyper-V host was not configured properly.
6. Verifying the MsCluster resource. If the server is clustered, verify that you can access
the MsCluster namespace. On the Hyper-V server, type the following command into
the Windows command line:
winrm enumerate wmi/root/MsCluster/*
-dialect:"http://schemas.microsoft.com/wbem/wsman/1/WQL"
-filter:"SELECT PrivateProperties, Type FROM MsCluster_Resource WHERE
Type='Network Name' AND Flags='1'"

If this command fails, refer to Microsoft documentation about WMI for MsCluster.
7. Verifying remote connectivity and the server certificate. To verify remote connectivity
and the server certificate, type the following command into the Windows command
line:
Restriction: Enter the following command on the Windows command line of
the BigFix Inventory server. If the server is not installed on a computer that
runs on a Windows operating system, use a computer that is not the Hyper-V
host and runs on Windows 2008 or higher.

winrm set winrm/config/client @{TrustedHosts="<Hyper-V_server_name>"}
winrm get winrm/config/client /r:<transport>://

<Hyper-V_server_name>:<port>/wsman /u:<user_id> /p:<password> /
a:Negotiate

Where
<transport>
Is either HTTP or HTTPS.
<Hyper-V_server_name>
Is the host name of the Hyper-V server. If you are using HTTPS, the host
name must match the CN in the certificate.
<port>
Is the port number on which the Windows Remote Management client
for the HTTP or HTTPS transport listens.
<user_id>
Is the user ID that is used to connect to the Hyper-V server.
<password>
Is the password that is used to connect to the Hyper-V server.
For example:
winrm set winrm/config/client @{TrustedHosts="myhyperv.ibm.com"}
winrm get winrm/config/client /r:https://
myhyperv.ibm.com:5986/wsman /u:administrator /p:abc /a:Negotiate

The following error is often returned when a self-signed certificate is used is:
WSManFault
Message = The server certificate on the destination computer
(myhyperv.ibm.com:5986)
has the following errors: The SSL certificate is signed by an unknown
certificate authority.

If you receive this error, export the self-signed certificate from the Hyper-V host,
and import it on the BigFix Inventory host. For other errors, refer to Microsoft
documentation for the returned error code.
Tip: For more information about Hyper-V configuration, see the following
document: Hyper-V connection fails CODVM0005E.

Troubleshooting Hyper-V connection issues
Troubleshoot, and understand the connection issues between Microsoft Hyper- V and BigFix
Inventory. Analyze the listed solutions to resolve connection problems.

Glossary
The connection between BigFix Inventory and Hyper-V is established through the Windows
Management Instrumentation (WMI) queries. These queries use either PowerShell over
the DCE-RPC mechanism, or WinRM that uses SOAP, or XML over HTTP protocol. The
BigFix Inventory client communicates with the Hyper-V host through the VM Manager
interface, VM Manager Tool. The following list describes the basic components of the
virtual environment:
Server
The Hyper-V host where the WinRM service is located.
Client
BigFix Inventory host that can be either a Windows or Unix computer.
The client authentication on both Windows and Unix systems uses the same authentication
sequence: NTLM, NTLMV2, or HTTP Basic. The Windows domain members undergo
Kerberos network authentication when you use PowerShell as the communication interface.

Troubleshooting multiple Hyper-V VM Manager Connections
When there are many Hyper-V VM Manager connections that are configured with WinRM
interface, VM Manager tool might not be able to correctly establish the connections
simultaneously in multiple threads. In this case, you must set the vmm_thread_pool_size

parameter to 1 to lower the number of connection threads. Additionally consider adding
more VM Manager Tools to distribute the load between them.

Manual Hyper-V troubleshooting
If the hyperv_precheck.wsf script was not able to diagnose the Hyper-V issues with
satisfactory results, proceed with the manual troubleshooting.
1. Verify whether the WinRm service is running. Run the following command in
command prompt.
sc query WinRM

The query results should include the following information.
SERVICE_NAME: WinRM
STATE

: 4

RUNNING

Note: The Windows User Account Control (UAC) can affect user access to
the WinRM service. If you use the Negotiate authentication scheme, only the
Administrator account can access the service. To allow all accounts to access
the service, set the following registry value.
HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Po
licies\System\
LocalAccountTokenFilterPolicy to '1'

2. Verify the WinRM configuration properties by using command prompt.
a. Run the following commands on the Hyper-V server:
• winrm get winrm/config/service
• winrm enumerate winrm/config/listener
b. Run the following commands on the client:

• winrm get winrm/config/client
Note: If Hyper-V and BigFix Inventory are installed on the same host, you
can use a single command to retrieve the required information: winrm
get winrm/config.

3. Set up a simple test case by changing some of the WinRM settings.
a. On the BigFix Inventory server, add an asterisk to the Trustedhosts list.
winrm set winrm/config/client @{TrustedHosts="*"}
TrustedHosts="*" forces the client to abandon authentication of the remote

end. However, the remote end still requires the client authentication. Typically,
TrustedHost is set on the client to the Hyper-V server name.

b. Allow basic authentication and unencrypted traffic on a Hyper-V server.
winrm set winrm/config/service/auth @{Basic="true"}
winrm set winrm/config/service @{AllowUnencrypted="true"}
Basic="true" enables HTTP Basic authentication through user and password in

clear text. AllowUnencrypted= true allows the transfer of the unencrypted data
through HTTP between the server and the client.
c. Check the WinRM configuration setup.
'winrm get winrm/config/client':
Client:
NetworkDelayms = 5000
URLPrefix = wsman
AllowUnencrypted = true
Auth
Basic = true
Digest = true
Kerberos = true
Negotiate = true
Certificate = true

CredSSP = false
DefaultPorts
HTTP = 5985
HTTPS = 5986
TrustedHosts = *

'winrm get winrm/config/service' on the Hyper-V server:
Service:
RootSDDL =
O:NSG:BAD:P(A;;GA;;;BA)(A;;GA;;;S-1-5-21-3273298017-2363932476
-3643925056-1633)S:P(AU;FA;GA;;;WD)(AU;SA;GWGX;;;WD)
MaxConcurrentOperations = 4294967295
MaxConcurrentOperationsPerUser = 15
EnumerationTimeoutms = 600000
MaxConnections = 15
MaxPacketRetrievalTimeSeconds = 120
AllowUnencrypted = true
Auth
Basic = true
Kerberos = true
Negotiate = true
Certificate = true
CredSSP = false
CbtHardeningLevel = Relaxed
DefaultPorts
HTTP = 5985
HTTPS = 5986
IPv4Filter = *
IPv6Filter = *
EnableCompatibilityHttpListener = true
EnableCompatibilityHttpsListener = true
CertificateThumbprint

If the previous change to Basic = true resolved the authentication issue,
apparently the client and the server are not able to negotiate the authentication
protocol. The Basic authentication scheme is not recommended, unless WinRM
is set up with HTTPS. It might cause security exposure by sending a user name,
a password and the message body in clear text. Microsoft uses three protocols
during the Negotiate scheme: Kerberos, NTLMV2, and NTLM. Usually, the client
and the server choose the best authentication mechanisms they agree upon.
BigFix Inventory does not allow the Kerberos protocol. To check whether the
client and the server allow the NTLMV2 or NTLM protocol, use the following
registry query.
reg query
HKEY_LOCAL_MACHINE\System\CurrentControlSet\control\LSA\MSV1_0

The following parameters under this registry key control the authentication
schema behavior:
• NtlmMinClientSec
• NtlmMinServerSec
The parameters can be modified through the appropriate Group Policy:
Computer Configuration > Windows Settings > Local Policies > Security
Options:LAN Manager authentication level
4. To manually identify the appropriate authentication mechanism for WinRM service on
the remote host, use the following commands:
• Run the command from Windows PowerShell.
Test-WSMan -ComputerName http://<Hyper-V_server_name>:<port>
-Auth <authentification_scheme> -Cred <user_id>

Where:
<Hyper-V_server_name>
Is the host name of the Hyper-V server. If you are using HTTPS, the
host name must match the CN in the certificate.
<port>

Is the port number on which the Windows Remote Management
client for the HTTP or HTTPS transport listens.
<authentification_scheme>
Is the authentication scheme: Basic or Negotiate
<user_id>
Is the user ID to Windows PowerShell.
• Run the command from the command prompt.
winrm identify -r:http://<Hyper-V_server_name>:<port>
-auth <authentification_scheme> -u:<user_id> -p:<password>

Where:
•

<Hyper-V_server_name>
Is the host name of the Hyper-V server. If you are using HTTPS, the
host name must match the CN in the certificate.
<port>
Is the port number on which the Windows Remote Management
client for the HTTP or HTTPS transport listens.
<authentification_scheme>
Is the authentication scheme: Basic or Negotiate.
<user_id>
Is the user ID to WinRM.
<password>
Is the password to WinRM.

Event tracing
If BigFix Inventory cannot connect to the Hyper-V host, use the custom Windows Event
Tracing. When the settings of the Client and the server are conflicting, the Security event log
generates the following error message: Unknown user name or bad password. You cannot

determine that the actual issue is the unsupported authentication protocols. The Windows
event tracing obtains the diagnostic data about the WMI and WinRM queries.
1. To start Event Tracing on the Hyper-V server, use the following commands:
• logman.exe start winrmtrace -p Microsoft-Windows-Winrm -o
winrmtrace.etl -ets

• logman.exe start wmitrace -p Microsoft-Windows-WMI-Activity -o
wmitrace.etl -ets

2. Run the VM Manager connection test.
•

vmman.bat -testconnection

•

vmman.sh -testconnection

The formatted WinRM Event Trace Log file, winrmtrace.etl, contains the information
about the user authentication issue.
<Task>User authentication </Task>
<Message>Sending HTTP 401 response to the client and disconnect the
connection after
sending the response</Message>

Additionally, the file consists of the SOAP, or XML queries that are sent from the Client and
provide essential data that is useful during troubleshooting the Hyper-V problems.

Troubleshooting Hyper-V connection status with Wireshark
Note:

To analyze the network traffic stream on Unix with no GUI

environment, use tcpdump. To dump all the traffic to the external file use tcpdump
-vvv -XX -w tcpdump.out. The tcpdump.out file can be viewed with Wireshark.

Successful connection test between BigFix Inventory and Hyper-V with PowerShell
interface.
Parameters:

•

vmman.bat -testconnection

•

vmman.sh -testconnection

vmm_communication_interface=POWERSHELL

PowerShell uses the NTLM authentication protocol.

It does not connect to the WinRM ports: 5985 and 80, but it uses a DCE-RPC
mechanism to connect to the Endpoint Mapper service via port 135.
1. Select the RemoteCreateInstance response entry.
2. To check whether the authentication finished successfully, expand
the parameters, and check the value of HResult. If authentication was
success, HResult is marked as S_OK.
PowerShell v2 by default uses NTLMv1 for negotiation. To update NTLM, use
the following registry setting:
HKEY_LOCAL_MACHINE\System\CurrentControlSet\Control\LSA\LMCompat
ibilityLevel

For more information, see: How to enable NTLM 2 authentication.
Unsuccessful connection test between BigFix Inventory and Hyper-V with NTLM
interface.
Parameters:
•

vmm_communication_interface=NTLM

•

vmm_url=http://.../wsman

• The default port:
80

The connection test failed, and the config_file.log file contains the
following error messages:
(...)com.ibm.license.mgmt.vmmanager.hyperv.net.HttpConnector::se
nd::
An error occurred while trying to send request to http://.../wsm
an

(...)com.ibm.license.mgmt.vmmanager.hyperv.net.HttpConnector::se
nd:java.net.
ConnectException: Connection refused: connect

While the errors from the trace.log and config_file.log files do not
provide enough details, the Wireshark capture proves that the issue is related
to TCP. Use the following command to check for listener on port 80.
winrm enumerate winrm/config/listener

If no listeners are detected, run the following command to set up listeners.
winrm set winrm/config/service @{EnableCompatibilityHttpListener
="true"}

Note: The setup of listeners on port 80 can collide with the other
HHTP services on this computer. To avoid the issues, specify a
dedicated WinRM port, such as 5985 or 5986, on the vmm_url
connection string.
Unsuccessful connection test between BigFix Inventory and Hyper-V with NTLM
interface. HTTP Error 401.

1. The connection test failed, and the config_file.log contains the
following error messages.
(...)com.ibm.license.mgmt.vmmanager.hyperv.net.HttpConnecto
r::retrieve::
Response Code is: 401

(...)com.ibm.license.mgmt.vmmanager.hyperv.net.HttpConnecto
r::retrieve::
The following response code was returned while connecting t
o VM Manager
http://.../wsman: responseCode = 401

The following Wireshark capture lists the NTLM negotiation.

The first four rows show the successful NTLM negotiation. The fourth
row ends the so-called four-way NTLM handshake. The last line detects
HTTP Error 401: Unauthorized, and expands into the following HTTP

response.
The WWW-Authenticate: Negotiate response indicates that the server
is ready to use the NTLM, NTLMV2, or HTTP Basic authentication
scheme. However, the server already successfully responded to the
negotiation sequence. Ensure that the WinRM AllowUnencrypted = true.
Note: VM Managers do not provide the HTTP body encryption.
WinRM accepts only the HTTP body that is encrypted with
Negotiate, or Kerberos protocol.
2. The Wireshark capture shows the unsuccessful NTLM negotiation
handshake.

The four-way NTLM handshake ends with a 401 error. The most
common reason behind this error is the lack of sufficient access rights.
To check whether the accounts assigned to the Administrators group
are allowed to access WinRM, configure the following Windows registry
entry.
HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersio
n\Policies\
System\LocalAccountTokenFilterPolicy

Unsuccessful connection test between BigFix Inventory and Hyper-V caused by the
bug related to vmm_login domain prefix interpretation.
When you add a VM Manager to BigFix Inventory, make sure that you provide
the administrator user name in one of the following formats:
• user_name@domain, for example: test@cluster.com
• user_name\domain, for example: test\cluster.com
Starting from application update 9.2.16, you can also provide the
administrator user name in one of the following formats:
• domain@user_name, for example: cluster.com@test
• domain\user_name, for example: cluster.com\test
Note: Make sure that you upgrade the VM Manager Tool to version
9.2.16, not only the server.
If you do not follow this pattern, and provide the user name in the incorrect
format, an error is generated during the VM Manager authentication.

When the error occurs, the user name is assigned to the incorrect field.

Kernel-based Virtual Machine
Kernel-based Virtual Machine is one of the virtualization technologies supported by BigFix
Inventory.

Purpose
®.

Kernel-based Virtual Machine (KVM) is a full virtualization solution for Linux

In the KVM

architecture, each guest (virtual machine) is implemented as a regular Linux process.
After you install KVM, you can run multiple guests, with each of them running a different
operating system image. Each of these virtual machines has private, virtualized hardware,
which includes memory, storage, graphics adapter, and a network card. This allows KVM to
benefit from all the features of the Linux kernel.

Collecting capacity data
Capacity data is collected from virtual machines that are managed by KVM hosts in two
ways:
• Capacity data from x86 KVM hosts that are controlled by RHV-M is collected by the
VM Manager Tool.
• Capacity data from x86 KVM hosts that are not controlled by RHV-M and from
PowerKVM hosts is collected directly from the host by using the Run Capacity Scan
on Virtualization Hosts fixlet. For more information, see: Collecting capacity data
directly from KVM hosts.

Red Hat Virtualization Manager (RHV-M)
Red Hat Virtualization (RHV, previously known as Red Hat Enterprise Virtualization) is
an enterprise virtualization product based on the KVM hypervisor. RHV-M is a service
running on a Red Hat Enterprise Linux server that provides interfaces for controlling the
virtualization platform. It manages provisioning, connection protocols, user sessions logins
and logoffs, virtual desktop pools, virtual machine images, and the high availability and
clustering systems. RHV-M provides the REST API that is used by BigFix Inventory to collect
information about the whole infrastructure that is managed by RHV-M.
The default URL that is to be used:
https://<RHV-M_IP_address>/ovirt-engine/api

Supported versions:
For a full list of supported versions, see: Supported virtualization types.

Nutanix
Available from 9.2.17. Nutanix is one of the virtualization technologies supported by BigFix
Inventory.

Purpose
Nutanix solutions are built on the hyperconverged infrastructure (HCI) technology. Nutanix
Acropolis is a foundation of Nutanix Enterprise Cloud platform that provides built-in
virtualization, storage services, networking and cross-hypervisor application mobility.
Nutanix supports all of the leading hypervisors, including virtualization solutions from
VMware, Microsoft, Citrix, and the native Nutanix hypervisor, AHV (Acropolis Hypervisor)
which is a native virtualization solution that supports IBM Power and x86 based hosts
depending on version.

Prism
Nutanix Prism is a management pane that provides unified interface for Nutanix clusters. It
is used to monitor and manage entities across Nutanix clusters through a web console. It
allows to run a mixed environment, or easily switch hypervisors to meet changing needs.
The default URL is:
https://<NUTANIX_PRISM_IP_ADDRESS>:9440/PrismGateway/services/rest/v2.0

Supported versions
Nutanix Acropolis 5.10
•

BigFix Inventory supports PRISM API version 2. Support for Linux guests on
AHV 5.11+ on IBM Power CS appliances.

•

Support for Linux and Windows guests on AHV 5.11+ on x86 appliances.

Supported technologies:
For a full list of supported versions, see: Supported virtualization types.

<deprecated> Oracle VM Server for x86
Available from 9.2.14.Oracle VM Server for x86 is one of the virtualization
technologies supported by BigFix Inventory.
Notice: Support for Oracle VM Server for x86 is discontinued by the vendor and
Oracle VM Server for x86 is no longer considered as subcap eligble by IBM. For
more information, see Oracle lifetime support policy and IBM schedule of removing
items from the list of subcapacity eligible technologies.

Purpose
Oracle VM Server for x86 is a full virtualization solution that manages the Oracle VM
environment. BigFix Inventory supports the Oracle VM Servers for x86 which are managed
by Oracle VM Managers. BigFix Inventory connects to Oracle VM Manager and collects
the software and capacity data. The solution does not support the direct connection to the
Oracle VM Server for x86.
Important: The Oracle VM Manager to which BigFix Inventory connects can manage
both Oracle VM Servers for x86 and SPARC. However, this solution does not retrieve
the data from SPARC Servers. Oracle VM Server for SPARC is supported by BigFix
Inventory on different terms. For more information, see: Client installation on Oracle
Solaris.

Oracle VM Manager
Oracle VM Manager provides interfaces for controlling the virtualization platform. It
manages provisioning, connection protocols, user sessions logins and logoffs, virtual
desktop pools, virtual machine images, and the high availability and clustering systems.
Oracle VM Manager provides the REST API that is used by BigFix Inventory to collect
information about the infrastructure that is managed by Oracle VM Manager.
The default URL that is to be used:
https://<OVM-Manager_IP_address>:7002/ovm/core/wsapi/rest

Supported versions:
For a full list of supported versions, see: Supported virtualization types.

Flow of capacity data from VM managers
To understand how capacity data is gathered in virtual environments, see what data flows
between virtual machines, VM Manager tool, and the BigFix Inventory server, and how
frequently it is transferred.
The following diagram shows the flow of data between virtual machines, VM Manager
tool, and the BigFix Inventory server in case of centralized VM management where the VM
Manager tool is installed on the same computer as the BigFix server.

It might happen that the VM Managers panel does not display up-to-date information about
your virtual systems. The delay might be caused by the fact that the data about your virtual
environment and the configuration data goes through many infrastructure elements and
depends on various scheduled tasks. As a result, the time that is needed for the complete
virtualization data to reach BigFix Inventory and be displayed in the interface might last up
to two days depending on your specific configurations.

Table 151. Frequency of steps of collecting capacity data
Num
ber
1.

Step

Frequency

Comments

Changes in configuration of the After every
VM Manager tool and VM man change of con
ager connections are sent to

figuration

the endpoints.
2.

VM manager data is collected

Every 30 min

from VM managers by the VM

utes

Manager tool.

Restriction: In case of
subcapacity reporting, it
is necessary to capture
mobility of VMs. To en
sure that it is captured,
data from VM man
agers must be collect
ed every 30 minutes.
You can change the fre
quency of collecting da
ta only if you use BigFix
Inventory for purposes
other than subcapacity
reporting.

3.

VM manager data is uploaded

Every 12 hours

from the VM Manager tool to
the BigFix server.
4.

The current infrastructure da
ta from the clients and the VM
Manager tool is imported from
the BigFix server to the BigFix
Inventory server.

Every 24 hours

Basic VM management (central)
Use basic VM management if the BigFix server can connect to VM managers in your
infrastructure. It is the default method of configuring connections to VM managers through
the BigFix Inventory user interface.
Data about the capacity of VM managers is needed to calculate consumption of license
metrics in the virtual environment. In basic VM management, the data is collected by the
main instance of the VM Manager tool that is by default installed on the BigFix server. You
must only ensure that it can connect to your VM managers. If some of your VM managers
are in separated networks with no connection from the BigFix server, manage these VM
managers through advanced VM management. For more information, see: Advanced VM
management (distributed).

Understanding the VM Managers panel
Before you start adding VM Managers, see the details of the VM Managers panel to
understand the available options and columns.
To open the VM Managers panel, click Management > VM Managers. Starting from
application update 9.2.4, the panel lists not only VM managers that are managed in the
central mode, but also those from the distributed mode. However, options such as editing,
deleting, or testing connection are applicable only for VM managers that are managed in
the central mode. For information how to perform these tasks for VM managers that are
managed in the distributed mode, see: Advanced VM management (distributed).
The number of VM managers that are shown on the panel depends on your computer
group assignment. You can see only VM managers from which data is collected by the VM
Manager tool that belongs to the computer group to which you are assigned.

New
Click this button to add a VM manager. Use this option to add VM managers
to which the BigFix server can connect. If the VM manager is in a separated
network to which the BigFix server cannot connect, create the VM manager
configuration file. For more information, see: Advanced VM management
(distributed).
Important: The button is disabled when the computer where the main
instance of the VM Manager tool is installed does not belong to the
computer group to which you are assigned.
Delete
Click this button to delete the selected VM manager. The option is applicable
only to VM managers that are managed in the central mode. If the selected
VM manager is managed in the distributed mode, the button is disabled. To
delete such a VM manager, remove its configuration file from the computer
that is listed in the Computer ID of VM Manager Tool column.
Important: When you delete a configuration file of a VM manager
that is managed in the distributed mode, the VM manager is removed
from the BigFix Inventory user interface after the maximum visibility

period is exceeded. The period is set by the maxVMManagerVisibility
parameter and is set to 90 days by default.
Test Connection
Click this button to test the connection to the selected VM manager. The
option is applicable only to VM managers that are managed in the central
mode. If the selected VM manager is managed in the distributed mode,
the button is disabled. The status of the connection test is shown in the
Connection Test Status column.
Resume
Click this button to resume a connection to a VM manager that is in the Invalid
credentials - suspended status. When the number of failed login attempts is
exceeded, connection to the VM manager is suspended to prevent the account
from locking. After you correct the underlying issue, you can resume the
connection.
More information
A link to a documentation topic that describes how to manage VM managers.
Operation Status
The status of the VM manager that reflects its condition. The status changes
when connection or configuration problems occur. For more information, see:
VM manager statuses.
Connection Test Status
The status of the connection test. The initial value is Not Tested and it
changes to Testing, Successful, or Failed after you click Test Connection.
The latter two statuses are always followed by a time stamp. For more
information, see: Connection test statuses.

The option is applicable only to VM managers that are managed in the central
mode. If the selected VM manager is managed in the distributed mode, the
connection status is Not Applicable.
Type
Type of the VM manager.
URL
Web address of the VM manager. Each virtualization type uses a different
address format. The template is always provided when you add VM managers.
For more information, see: Supported virtualization types.
Data Import Time
Date and time when the capacity data was imported from the BigFix server to
BigFix Inventory.
Data Collection Time
Date and time when the capacity data was collected from the VM manager
by VM Manager tool. The time that is shown in this column might differ from
the time in the Data Import Time column because the collected data might
still need to be uploaded to the BigFix server and then imported to BigFix
Inventory.
Computer ID of VM Manager tool
Identifier of the computer on which the VM Manager tool that collects data
from the particular VM manager is installed. Click the link to display the details
of the computer, for example its IP address. You can use the information to
learn which computer to access to change the configuration file of the VM
Manager tool in the distributed mode.
Deployment Type
Indicates whether the VM manager is deployed in the central or distributed
mode. If the deployment type is central, you can edit the VM manager on the
BigFix Inventory user interface.

If the deployment type is distributed, you can view information about the VM
manager on the BigFix Inventory user interface, but you cannot edit nor delete
it. To change the settings of such a VM manager, edit its configuration file. The
file is on the computer that is listed in the Computer ID of VM Manager tool
column. For more information, see: VM manager configuration parameters.
Deprecated: User Name
In earlier versions, this columns shows the user name that is used to connect
to the VM manager.

Adding VM managers in central mode
Configure connections to VM managers in your infrastructure to ensure that the VM
Manager tool can gather data that is needed to calculate consumption of license metrics
in your virtual environment. To configure a connection to VM managers through the BigFix
Inventory user interface, open the VM Managers panel, and specify details of VM managers,
such as the web address, virtualization type, and credentials.
•

You must have the Manage VM Managers and Servers permission to perform this
task.

• The computer where the main instance of the VM Manager tool is installed must
belong to the computer group to which you are assigned. Otherwise, the option to add
VM managers is disabled.
• If the panel is blocked and displays a warning, see: Troubleshooting: Enabling the VM
Managers panel.
VM Manager Tool, starting from update 1.5.0.0, is enhanced to attempt to
automatically fix the most common problems with the VM manager connection parameters.
This feature is disabled by default. To enable this feature, go to Management > Advanced
Server Settings and change the setting of vmman_fix_parameters_enabled parameter to
true. While fixing connection problems the VM Manager Tool can connect using the HTTP

protocol when the defined HTTPS connection is not available. This setting is enabled by
default. To disable switching protocol from HTTPS to HTTP, go to Management > Advanced

Server Settings and change the setting of vmman_http_connection_allowed parameter to
false. For more information, see: Advanced server settings.

1. In the top navigation bar, click Management > VM Managers.
2. To add a VM manager, click New.
3. Select the virtualization type and provide the required details.
• To add Microsoft Hyper-V:
a. Select one of the available communication interfaces: PowerShell or
WinRM. For more information about these interfaces, see: Microsoft
Hyper-V.
Important: WinRM is the preferred communication interface.
Before you add the VM Manager, configure WinRM on the HyperV host. For more information, see: Configuring WinRM on Hyper-V
hosts.
b. Provide the URL of the VM manager in the following format: https:///
ovirt-engine/api to https://{manager-host}/ovirt-engine/api.

c. To share credentials with other hosts in the same cluster, select Share
credentials with other hosts in the same cluster.
d. Provide the Administrator account credentials. Define the user
as user_name\domain or user_name@domain. For example: test
\cluster.com or test@cluster.com.

• To add KVM with RHV-M:
a. Provide the URL of the VM manager in the following format: https://
<RHV-M_IP_address>/ovirt-engine/api.

b. Provide the account credentials. Define the user as user_name@domain,
for example: test@cluster.com.
•

To add Nutanix:
a. Provide the URL of the VM manager in the following format: https://
<NUTANIX_PRISM_IP_ADDRESS>:9440/PrismGateway/services/rest/
v2.0.

b. Provide the account credentials.

To add Oracle VM:

•

a. Provide the URL of the VM manger in the following format:
b. https:///ovirt-engine/api to https://{manager-host}/ovirtengine/api

c. Provide the account credentials.
• To add VMware ESX, ESXi or vCenter:
a. Provide the URL of the VM manager in the following format:
◦ https://<vCenter_IP_address>/sdk/vimService.wsdl
b. Provide the account credentials. Define the user as domain\user_name, for
example: cluster.com\test.
To add Citrix Hypervisor (formerly XenServer):

•

a. Provide the URL of the VM manager in the following format: https://
Citrix_hypervisor.

b. Provide the account credentials.
The following example shows a configured connection to VMware ESX, ESXi or
vCenter.

Note: "KVM RHV-M" VM Manager type has been renamed to "KVM RHV-M
or Oracle Linux Virtualization". This change is only on the UI. As Oracle VM
is approaching end of life, instead of the new version, Oracle moves to KVM
and introduces Oracle Linux Virtualization Manager as manager. Oracle Linux
Virtualization Manager works with previous versions of BigFix Inventory which
supports KVM RHV-M.
4. Click Create. Connection to the VM manager is created and its status is Pending.

5. Select the VM manager, and click Test Connection.
The test might take a few minutes. Refresh the panel. If the VM manager connection
is properly configured, the connection test status changes to Successful.
You have created a VM manager. Its status remains Pending until the data is collected from
the VM manager, uploaded to the BigFix server, and transferred to BigFix Inventory during
the import of data.
The upload of data collected from VM managers is triggered shortly after you modify any
VM manager, for example create a new connection or change the existing one. If you do not
make any modifications, the data is uploaded according to the schedule, which is every 12
hours by default. For more information, Capacity data flow.
Note: BigFix Inventory can count the cluster cores properly only if the data comes
from a single VM manager connection for the whole cluster. This option is visible on
Management > VM Managers panel.
• For VMware, the data should come from vCenter where VMs in the same
cluster must belong to a single vCenter, otherwise the cluster core results will
not be correct.
• For Hyper-V, the data should come from a single host within a cluster when
Share credentials with other hosts in the same cluster option is

enabled.
Cluster Cores are assigned based on the node layer and not the machines.
Physical machines that host Hyper-V, share the same node layer as VMs they
host. These machines have the same cluster name. As a result, Hardware
Inventory report shows the same Cluster Name for Hyper-V hosts and the
hosted VMs.

VM manager statuses
After you add a VM manager, see the explanation of its status to ensure that the VM
manager works properly.

VM manager statuses
The statuses apply to VM managers that are managed both in central and distributed mode.
Outdated VM Manager Data or No VM Manager Data
If the scan result file was imported without errors, but some computers still
have the Outdated VM Manager Data or No VM Manager Data status, perform
the following steps.
Action
• To determine the cause of the problem, check whether the VM Manager
tool collects valid and complete results. For more information, see:
Troubleshooting Outdated VM Manager Data.
Connection failed
Connection to the VM manager failed and the data was not retrieved.
Action:
• To determine the cause of the problem, open the VM Manager tool log
files that are in the BES Client\LMT\VMMAN\logs directory, and look
for the following exception.
VM Manager is not able to communicate with ESX 4.x due to:
javax.net.ssl.SSLHandshakeException: java.security.cert.Cer
tificateException: Certificates does not conform to algorit
hm constraints

For more information,see: RQMCopyUtility error: SSL_TLS SSLContext
not available. Certificate does not conform to algorithm constraints.
Note: ESX 4 is no longer supported by VMWare. For more
information, see: End of Availability and End of Support Life for
ESX 4.x and VMware Management Assistant.
• In order to debug log in process modify the following file.

◦

BES Client/LMT/VMMAN/vmman.sh

◦

BES Client\LMT\VMMAN\vmman.bat

Update the Properties Definitions section by adding the debug dump
option to VMM_PROPERTIES_DEFS parameter. Insert the following line:
◦

VMM_PROPERTIES_DEFS="Dcom.sun.xml.internal.ws.transport.http.client.HttpTransportPipe.dump=true
-Dhttps.protocols=TLSv1.2,TLSv1.1,TLSv1
-Dcom.ibm.jsse2.disableSSLv3=false
-Dcom.ibm.tools.attach.enable=no

◦

SET VMM_PROPERTIES_DEFS=%VMM_PROPERTIES_DEFS%

-Dcom.sun.xml.internal.ws.transport.http.client.HttpTransportPipe.dump=true

Run the following VMMAN tool command:
◦

vmman.sh -testconnection > vmman.out 2>&1

◦

vmman.bat -testconnection > vmman.out 2>&1

Verify the command output by checking credentials and VM manager
response.
Data partially collected
Data was collected only from some of the hosts.
Action:
• If the problem occurs on Hyper-V, it indicates that some of the host in
the cluster have connectivity issues. To identify the problematic hosts,
open the VM Manager tool log files that are in the BES Client\LMT
\VMMAN\logs directory and search for the following entries:
◦ Processing of the host: <HOST_UUID> ip:
<HOST_IP_ADDRESS> from hyper-v cluster was skipped
because of invalid connection status (<STATUS>).

◦ A communication error occurred when processing one of
the Hyper-V hosts in the cluster. Host name: <HOSTNAME>.
Skip and continue.

Fix connectivity issues for the identified hosts. If the problem persists,
contact HCL support.
• If the problem occurs on Citrix Hypervisor (formerly XenServer),
it indicates that XenTools are not installed on some of the virtual
machines. To identify the problematic virtual machines, open the VM
Manager tool log files that are in the BES Client\LMT\VMMAN\logs
directory and search for the following entries:
◦ It was not possible to retrieve the number of cores
assigned to XEN VM with UUID: <VM_UUID>. Most likely the
XenServer Tools are not installed on this particular VM.
Skipping VM and continue.

Install XenTools on the identified virtual machines.
Duplicated address
The address of the VM manager is duplicated. The first VM manager with this
address remains active and the status is displayed for the remaining ones.
Action: Delete duplicated VM managers to ensure that data is gathered only
once. The duplicated addresses might occur only within a particular VM
manager type.
Hard timeout - suspended
Connection to the VM manager failed and no further attempts are made. The
status indicates that either the provided URL or configuration is incorrect, or
that there are problems with the network.
Action: Check the connection between VM managers and the VM Manager
tool. Also, correct the URL and the credentials, and save the changes.
Ensure that thevmm_communication_locked property is set to false in the
corresponding vmmconf_*.properties file.
Inactive

Data from the VM manager was not retrieved for a period longer than the
maximum VM manager inactivity. The status indicates that either the provided
URL or configuration is incorrect.
Action: Correct the URL and the credentials, and save the changes.
Invalid credentials - attempting
Connection to the VM manager failed because the credentials are incorrect
or the password expired. More attempts are made until the limit of failed
login attempts is exceeded. Then, the status changes to Invalid credentials suspended to prevent the account from locking.
Action: Edit the VM manager and correct the credentials.
Invalid credentials - suspended
Connection to the VM manager is suspended because of the below reasons:
1. The number of failed login attempts was exceeded. The status is used
to prevent the account from locking if invalid credentials were provided.
Action:
• Ensure that the VM manager credentials are correct. Then, click
Resume.
• Go to vmmconf_*.properties file and make sure that the
vmm_communication_locked parameter is set to false.

• By default, VM Manager tool is installed on the same computer
as the BigFix server. Check the connection between VM Manager
tool and VM manager. Make sure that the firewall, proxy and NAT
settings are correct.
2. Windows™ Remote Management (WinRM) not configured properly with
BigFix Inventory to gather data about installed machines.
Action: The user must have administrative access to the WinRM
framework to get data from Hyper-V managed hosts. For more
information, refer to Configuring WinRM on Hyper-V hosts.
No data (previously Insufficient rights)

No data was collected from the VM manager. The most common reason is
that there is no data or that the user that is defined for this VM manager does
not have sufficient rights.
Action: If you run the Run Capacity Scan on Virtualization Hosts fixlet, ensure
that the virtualization hosts from which you want to collect capacity data have
at least one virtual machine that is correctly defined and running.
Make sure that the user has read access to these virtual machines that are
managed by this VM manager and their host.
OK
Data is collected from the VM manager and processed according to the
schedule. No issues were detected.
OK - duplicated UUIDs discarded
Each virtual machine must have a unique UUID. When a UUID identifies more
than one VM, the duplicate VMs are discarded from the results. The problem
is most often caused by one of the following reasons:
• For VMware:
◦ Virtual machines were deployed from catalog templates in vCloud
Director. By default, such machines are assigned the same BIOS
UUID. For more information, see: BIOS UUIDs in vCloud Director
are not unique when virtual machines are deployed from catalog
templates.
◦ Virtual machines were cloned without changing their UUIDs. For
more information, see: Changing or keeping a UUID for a moved
virtual machine.
• For Hyper-V:
◦ Virtual machines were deployed by importing an exported Hyper-V
guest that already exists, without changing the BIOS UUID.
◦ Virtual machines were deployed using a template.

Action: Open the VM Manager tool log files that are in the BES Client\LMT
\VMMAN\logs directory and identify discarded virtual machines. Then, refer
to the documentation for your virtualization type to learn how to assign unique
UUIDs to each virtual machine. For information about VMWare, see: Editing a
virtual machine with a duplicate UUID.bios.
After the duplicates are corrected, the VM manager status changes to OK.
Pending
The status is applicable only to VM managers that are managed in the central
mode. It is displayed after a VM manager is created or after its definition
is modified. It indicates that changes are still being propagated to the VM
Manager tool. The status changes to OK when the following steps are
completed:
1. VM Manager tool gathers data from VM managers.
2. The data is uploaded to the BigFix server.
3. The data is transferred to BigFix Inventory with a data import.
If a problem occurs during any of these steps, the status changes to indicate
the problem.
Action: Wait until the VM Manager tool completes the steps that are required
to upload the data. For more information about each step, see: Capacity data
flow.
If the status of the VM manager remains Pending for a longer period of time, it
might indicate that the Schedule VM Manager Tool Scan Results Upload task
was not scheduled or was stopped. To check whether it is the case, perform
the following steps.
1. Log in to the BigFix console, and go to Actions.
2. Look for the Schedule VM Manager Tool Scan Results Upload action and
check its status.

3. If the action does not exist, or its status is Stopped or Expired, start the
action.
a. Go to Sites > External Sites > BigFix Inventory v10 > Fixlets and
Tasks.
b. In the upper right pane, select Schedule VM Manager Tool Scan
Results Upload, and click Take Action.
c. Select the computer on which the BigFix server is installed, and
click OK.
After you schedule the action, wait for the collected data to be uploaded to
the BigFix server and then imported to BigFix Inventory. The status of the VM
manager should change to OK after the import.
Unknown problem
The problem does not fall into any other category. Check the VM Manager tool
log to determine the cause.
Action: If you are not able to determine the cause of the problem from the VM
Manager tool log, contact HCL Support.

Connection test statuses
The following statuses are displayed in the Connection Test Status column after you select
a VM manager and click Test Connection. The statuses are applicable only to VM managers
that are managed in central mode. If the VM manager is managed in the distributed mode,
the connection test status is Not Applicable.
Not Tested
The connection test was never started. Select a VM manager and click Test
Connection.
Testing
The connection is being tested. It might take a few minutes until the status
changes. Refresh the panel.
Successful

The connection to a VM manager was established. The VM manager is
configured correctly.
Failed
The connection to a VM manager could not be established. Check the VM
Manager tool log files that are in the BES Client\LMT\VMMAN\logs to
determine the cause.

Troubleshooting the Outdated VM Manager Data and No VM
Manager Data statuses
Understand why the VM Manager data cannot be retrieved by BigFix Inventory and then
troubleshoot the issues. Apply the listed solutions for computers that have the Outdated VM
Manager Data or No VM Manager Data status.

Background
Basic virtual environment is configured with one central VM Manager Tool that is installed
on one of the following:
• same computer as the BigFix Inventory server in case of new installations of BigFix
Inventory application update 10.0.4 and higher.
• same computer as the BigFix server in case of application update 10.0.3 and lower, or
environments that were upgraded to application update 10.0.4 or higher.
You can use a more complex environment, with many instances of VM Manager Tool. Each
tool must be connected with all hypervisors that is configured for this VM Manager. Results
from each hypervisor must reach BigFix Inventory.

Reasons behind the data retrieval failure
VM Manager data cannot be retrieved by BigFix Inventory due to one of the following
reasons:
• The hypervisor connection is not defined.
• VM Manager Tool cannot connect to the hypervisor to collect the data.

• VM Manager Tool does not generate results, or does not properly communicate them
to BigFix Inventory.
• VM Manager Tool collects invalid or incomplete results.

Before you begin troubleshooting
Collect the following information:
• The number of VM Manager Tools that are installed in your environment.
• The number of hypervisors to be connected.
• Valid credentials with sufficient rights to log in to hypervisors.
Starting from application update 9.2.12, you do not need to go to the computer
where VM Manager tool is installed, to get the data that are needed for troubleshooting
purposes. When cannot retrieve VM manager data from a computer, go to the Computer
Support Data panel and download the logs from the related computer to investigate the
issue. For more information about how to download the log package, see: Collecting logs
for troubleshooting purposes.

Troubleshooting
Identify if the computer runs on a public cloud and then additionally identify it as
runing on a public cloud
For detailed information, refer to Identifying computers on public clouds.
Check whether all VM Managers are defined in BigFix Inventory
1. Log in to BigFix Inventory.
2. Go to Management > VM Managers, and check whether all the VM
Manager connections are defined. If not, see: Adding VM Managers in
central mode or Adding VM Managers in distributed mode.
Note: Make sure that the VM Manager URL is in the correct
format. The format differs between technologies, and versions.

Check whether the status of all VM Manager connections shows as OK
If any of the VM Manager connections is in status other than

OK, refer to:

VM manager statuses.
Check whether VM Manager Tool is properly configured.
1. The VM Manager Tool is installed at:
BESClient/LMT/VMMAN
C:\Program Files (x86)\BigFix Enterprise\BES
Client\LMT\VMMAN
a. To ensure that the tool was installed successfully, log in to the
BigFix console.
b. In the navigation panel, click Actions and select Install VM
Manager Tool.
c. Open to the Computers tab, and check whether the status is set to
Completed. If the installation failed, check which line of the action
script caused the failure. Double-click the listed computer, and
analyze the View Action Info to find the relevant line. If you cannot
find the Install VM Manager Tool action, see: Troubleshooting:
Enabling the VM Managers panel.
2. Run the following command and check whether the VM Manager Tool is
working:
BESClient/LMT/VMMAN/vmman.sh -run
BESClient\LMT\VMMAN\vmman.bat -run
3. Test the connection to VM Managers by running the following
command.
BESClient/LMT/VMMAN/vmman.sh -testconnection
BESClient\LMT\VMMAN\vmman.bat -testconnection
4. Check the statuses of the VM Managers by running the following
command.

BESClient/LMT/VMMAN/vmman.sh -status
BESClient\LMT\VMMAN\vmman.bat -status
For more information, see: Running VM Manager tool and VM Manager
tool command-line options.
In case of the central and distributed VM Manager Tool, check whether VM Manager
Tool results are generated and properly communicated to the BigFix Inventory server
1. Check whether the files with scan results are packed for upload.
a. Go to Computer Support Data panel and collect the logs from
the computer that you need to investigate. For more information
about how to download the log package, see: Collecting logs for
troubleshooting purposes.
b. Go to the following directory.
•

\sha1_files
\logcollector_0_computer_id_logCollectorAgent.tar
\computer_id_logCollectorAgent\var\opt
\BESClient\LMT\VMMAN\computer_id

•

\sha1_files
\logcollector_0_computer_id_logCollectorAgent
\Program Files (x86)\BigFix Enterprise\BES
Client\LMT\VMMAN\computer_id_vmman.zip

2. If the result files are not packed for upload, check whether the upload is
scheduled.
a. Log in to the BigFix console.
b. Click Actions in the navigation tree, and select Schedule VM
Manager Tool Scan Results Upload.
c. Check the details and make sure that the state is marked as Open.
If not, see: Uploading collected data.

d. If the action failed, check which line of the action script caused
failure. Go to the Computer tab, double-click the listed computer,
and analyze the View Action Info to find the relevant line. You can
also try forcing the upload of collected data.
3. Check whether the scan results exist in the BES server sha1 directory in
the log package that you downloaded from the affected computer.
•

/sha1/
vmman_scan_*_computer_id_*_vmman.tar.gz

•

\sha1\vmman_scan_*_computer_id_*_vmman.zip

If the Schedule VM Manager Tool Scan Results Upload action was
completed successfully, but the files are still not uploaded, go to the
log package that was downloaded from this computer and in the sha1
directory check the Index.txt file. If the file contains the following
error MaxArchiveSize: Exceeded, see: Configuring VM manager for
subcapacity reporting.
Note:

Starting from application update

9.2.14, you can check whether the value of
_BESClient_ArchiveManager_MaxArchiveSize parameter is
exceeded on the Computer Support Data panel. For more
information, see: Checking whether the maximum archive size is
exceeded.
4. Check whether file with scan results is available in the BigFix
database, go to the log package that was downloaded from Computer
Support Data panel and check whether the BIGFIX_Uploads and
BIGFIX_uploads_availability files contain the data. If you cannot
find the results, restart the FillDB service on the BigFix server.
Run the following command: /etc/init.d/

•

besfilldb restart.
Find the FillDB service on the list of services, and restart

•
it.

It takes several minutes for the database to update after the restart.

• If the issue occurs more than once, upgrade the BigFix server. For
more information, see: Software/Hardware data may not appear in
the ILMT/BFI UI after successful ETL import because of the BigFix
FillDB APAR IV83671.
5. Check whether you can find the result data in DatasourceFile in the
log package that was collected from this computer.
• If the result file exists in the BigFix database, but it is not found in
DatasourceFile file, contact the IBM® support.
6. Check whether you can find the results in adm.last_imported_scan
file in the log package from this computer.
• If the results data exists in all databases (listed in point 5 and 6),
but cannot be found in adm.last_imported_scan file, it means
that the import of data fails.
◦ Check the BigFix Inventory import logs, which are located in
the following directory and troubleshoot the issue.
Installation_directory/wlp/usr/servers/
server1/logs/imports
You can find also the last import log attached to the log
package from this computer.
Check whether the VM Manager Tool collects valid and complete results.
Continue with this solution if the result file was imported without errors, and at
least one of your VM Manager connection shows Outdated VM Manager Data
or No VM Manager Data status, perform the following steps:
1. Collect UUIDs of the affected computers.
a. To troubleshoot for Outdated VM Manager Data status, perform
the following steps.
i. Log in to BigFix Inventory, Computer Support Data panel,
and collect logs from the affected computer.
ii. Open a file that matches the following pattern and has the
highest timestamp.

/sha1_files/
cit_capacity_*_<computer_ID>_tlm_hw.tar.gz/
<computer_ID>_tlm_hw.tar/
tlm_hw_<date_time>_<timestamp>.xml
\sha1_files
\cit_capacity_*_<computer_ID>_tlm_hw.zip
\tlm_hw_<date_time>_<timestamp>.xml
iii. Get the UUID of the computer.
<?xml version="1.0" encoding="UTF-8"?>
<Hardware>
(...)
<ComponentID version="1">
<Manufacturer>VMware, Inc.</Manufactu
rer>
<Product>VMware Virtual Platform</Pro
duct>
<Version>None</Version>
<SerialNumber>VMware-12 34 56 78 12 3
4 12 34-12 34 12 34 56 78 90 12</SerialNumber>
<Type></Type>
<UUID>12345678-1234-1234-1234-1234567
89012</UUID>
</ComponentID>
(...)
<VirtualMachineGuest version="1">
<UUID>VMware-12 34 56 78 12 34 12 3412 34 12 34 56 78 90 12</UUID>
<HypervisorType>VMware</HypervisorTyp
e>
</VirtualMachineGuest>

(...)
</Hardware>

iv. Remove any prefixes or spaces in the obtained UUID.
Ensure that the UUID conforms to the following pattern:
xxxxxxxx-xxxx-xxxx-xxxx-xxxxxxxxxxxx. For example,
12345678-1234-1234-1234-123456789012.
b. To troubleshoot for No VM Manager Data status, perform the
following steps:
i. Log in to BigFix Inventory.
ii. Log in to BigFix Inventory, and view the Capacity Scan Health
widget. It shows the number of endpoints with the No VM
Manager Data status.
iii. Click the No VM Manager Data to see the list of computers
with no VM Manager data on the Hardware Inventory report.

iv. Export the report to CSV file to view the information about
the server ID.
v. Open the CSV file and choose one of the obtained UUIDs.
Remove the TLM_VM_ prefix from the UUID.
2. Obtain files with VM Manager Tool scan results.
a. Go to the VM Manager Tool installation directory and run the
following command:
/sha1_files/
logcollector_*_<computer_id>_logCollectorAgent.tar.gz/
<computer_id>_logCollectorAgent.tar/
var/opt/BESClient/LMT/VMMAN/
debugData.zip

\sha1_files

\logcollector_*_<computer_id>_logCollectorAgent.zip

\Program Files (x86)\BigFix Enterprise\BES Client
\LMT\VMMAN\debugData.zip
b. Go to the debugData.zip file generated in the VM Manager Tool
installation directory.
3. Check whether the UUID that you obtained in step 1 exists in the file
with scan results that is located in the upload subdirectory of the
debugData.zip package.
The UUID you obtained in step 1 can differ from the UUID that is returned
by the VM Manager Tool. Both values consist of 32 identical characters.
However, the first 16 characters are arranged in different order. Only the
final 16 characters are the same. For example, the value in the Server
ID column can be TLM_VM_12345678-1234-1234-1234-123456789012,
but the value that is retrieved by the VM Manager Tool is
78563412-3412-3412-1234-123456789012.

This issue was fixed in application update 9.2.3. To solve the problem,
upgrade BigFix Inventory to the latest version. After the upgrade,
upload the new capacity data to produce new scan results. To do that,
run a single capacity scan and force upload of its results. For more
information, see: Initiating the capacity scan on all computers. The
capacity data is updated in up to two days, when the capacity scans and
the VM manager data are imported.
4. If the UUID of the affected computer does not exist in the scan results
files, check the following possible causes:
a. The UUID is duplicate.
i. To verify whether the UUID is duplicated, search all
trace.log and config_file.log files for the following
information.
Duplicates of UUIDs are found on VM Manager,
URL: https://srvvcspr01/sdk/vimService.wsdl.
Discarded UUIDs for guests: 4227e866-7121-d731-23
5a-343077d7ee93.

The trace.log and config_file.log files are stored in the
following location:
/sha1_files/
logcollector_*_<computer_id>_logCollectorAgent.tar.gz/
<computer_id>_logCollectorAgent.tar/var/opt/
BESClient/LMT/VMMAN/logs
\sha1_files
\logcollector_*_<computer_id>_logCollectorAgent.zip
\Program Files (x86)\BigFix Enterprise\BES
Client\LMT\VMMAN\logs
Note:

To improve readability of logs, the

config file in config directory is used to record all
communication with a hypervisor. Each config
file has a separate log and a separate name, such
as <config_name.log>. For example, config file,
vmmconf_8762375104473669393.properties has a

log file named vmmconf_8762375104473669393.log.
To avoid the confusion with log file names, only
one log file is created per config file. Also, for every
hypervisor, the config file has one log file.
ii. If some UUIDs are duplicated, go to the virtual machine that
has the duplicated UUID, and change it so that it becomes
unique.
b. The user who is connecting with the VM manager on VMware
does not have a permission to collect data about the virtual
machine. Check the VM manager settings, and permissions.
For more information, see: Verifying permissions for VMware
communication.
c. The VM manager is not valid for the virtual machine.

5. If the UUID of the affected computer exists in the scan results file, but
the computer still has the Outdated VM Manager Data or No VM Manager
Data status, perform the following steps.
a. Check whether debug data is collected for the affected computer.
• For local or disconnected VM Manager Tool, go to the VM
Manager Tool installation directory and run the following
command:
◦

./vmman.sh -retrievedebugdata

◦

vmman.bat -retrievedebugdata

Then, go to the debugData.zip file generated in the VM
Manager Tool installation directory.
• For central or distributed VM Manager Tool, open the log
package, and go to the debugData.zip file that is stored in
the following location.
/sha1_files/

◦

logcollector_*_<computer_id>_logCollectorAgent.tar.gz/
<computer_id>_logCollectorAgent.tar/var/opt/
BESClient/LMT/VMMAN/debugData.zip
\sha1_files

◦

\logcollector_*_<computer_id>_logCollectorAgent.zip
\Program Files (x86)\BigFix Enterprise\BES Client
\LMT\VMMAN\debugData.zip
b. Go to the debug/<VM_manager_connection_ID> subdirectory
of the debugData.zip file.
c. Check whether the login.xml file is correct, and error-free. The
login.xml file can contain the authentication error but the VM

manager connection test was successful, the user login, or
password probably contains one of the following characters: $ or
\.
<faultcode>ServerFaultCode</faultcode>
<faultstring>Cannot complete login due to an incorrect
user name

or password.</faultstring>
<detail>
<InvaildLoginFault xmlns="urn:vim25" xsi:type="Invalid
Login"/>

To solve the problem, upgrade the VM Manager Tool to the latest
version. For more information, see: Checking the VM Manager tool
version and Updating VM Manager Tool.
Note: After you upgrade the VM Manager Tool, download
fresh log package and check the debug data.
d. Open the retrieveProperties.xml file. The file contains
information about all virtual machines, including VMs with
duplicated UUIDs, and the <HostCpuPackage> data. If the
<HostCpuPackage> tag is not in the file, the user that connects

to the VM manager is underprivileged. Ensure that the user has
sufficient permissions. For more information, see: Verifying
permissions for VMware communication and How to set the
correct permissions for LMT - VMware communication.

Troubleshooting: Enabling the VM Managers panel
If the VM Managers panel is disabled and you cannot add VM managers, complete
additional steps to enable the panel. This issue often occurs if your BigFix server does not
have Web Reports configured, or if the automatic installation of the VM Manager Tool failed.
It can also occur when the BigFix user that is used to connect to the BigFix console does
not have sufficient rights.
The issue can be recognized by a disabled panel and a message similar to the following
example:
Before you can configure VM managers, you must install and run the BigFix
services,
including Web Reports. For more information, see the product documentation.

Required permissions
Before you perform the following steps, ensure that the BigFix user that is used to connect
to the BigFix console is a Master Operator. If you do not want to use the Master Operator,
you can create a dedicated user that fulfills the following requirements:
• Is assigned the BigFix Inventory v10 site
• Is assigned computers that you are going to monitor, and the computer where the
BigFix server is installed
• Has the following permissions: Can use REST API, Can use Console, Custom Content,
Can Create Actions
The option is supported starting from BigFix 9.5.

Installing Web Reports
The Web Reports component is typically installed together with the BigFix server. You might
have chosen, however, to omit this component during the installation. To install it, complete
one of the following steps depending on the operating system of the computer, where BigFix
is installed.
• For Windows systems, see Installing Web Reports.
• For Linux systems, start the installation of BigFix. Choose the Production installation
and when prompted for the installation of components, choose Web Reports only.
Select the BigFix Features you want to install:
[1]

All Components (Server, Client, and WebReports)

[2]

Server and Client Only

[3]

WebReports Only

Choose one of the options above or press <Enter>
default: [1]

You installed Web Reports on the BigFix server.
Install VM Manager Tool.

to accept the

(Optional) Installing VM Manager Tool
If the automatic installation of VM Manager Tool failed, you can install it manually on the
BigFix server.
• Review software requirements and other considerations
• Install an BigFix client on the target computer.
• Install and start Web Reports on the BigFix server.
1. Log in to the BigFix console.
2. In the navigation tree, click Sites > External Sites > BigFix Inventory v10 > Fixlets and
Tasks.
3. Select Install VM Manager Tool version number, and then click Take Action.
4. Select the BigFix server as target computer and click OK.
Schedule the upload of collected data.

(Optional) Uploading collected data
The uploading of collected data is scheduled automatically. You can use this procedure if
the automatic installation of VM Manager Tool failed.
1. Log in to BigFix console.
2. In the navigation tree, click Sites > External Sites > BigFix Inventory v10 > Fixlets and
Tasks.
3. Select Schedule VM Manager Tool Scan Results Upload.

4. In Description, enter the upload frequency in hours.

5. Select the BigFix server as the target computer and click OK.

Note: All options in the Execution tab are disabled. The frequency can be
specified only in the Description field.
You scheduled to upload capacity data from VM Manager Tool to BigFix. The data is
transferred to BigFix Inventory with each data import. If no modifications are made to VM
managers, the data is uploaded according to the schedule. If you modify a VM manager, the
upload is triggered shortly afterwards.
Add VM managers in the user interface.

Advanced configuration of basic VM management
When you use the basic VM management, you can perform advanced configuration on the
Advanced Server Settings panel. However, it is not usually needed.

The basic VM management does not usually require reconfiguring. However, you can
change the configuration parameters on the Advanced Server Settings panel. For more
information, see: Advanced server settings. Any customization can significantly impact the
server and its performance. Thus, ensure that every configuration is carefully considered
and needed.

Advanced VM management (distributed)
Use advanced VM management if the BigFix server cannot connect to some of the VM
managers because they are in separated networks. This approach requires that you install
an additional VM Manager Tool, and configure VM managers through the command line.
You can use advanced VM management as an extension of the basic configuration.
VM managers to which the BigFix server can connect can still be managed in the BigFix
Inventory user interface. Additional VM Manager Tool would manage only VM managers
for which such a connection cannot be established. You can connect to such VM managers
by creating configuration files and managing the connections in the VM Manager tool
command line.
Although VM managers are managed through the command line, their capacity data is
uploaded to BigFix Inventory and updated on reports in the same way as for the basic
configuration. In contradiction to the main VM Manager tool, additional instances can be
installed on any computer that can connect to separated VM managers, and you can deploy
as many of them as you need. VM managers configured in the command line are visible on
the VM Managers panel in the BigFix Inventory user interface. However, their configuration
cannot be changed through that panel. It can be change only through the VM manager
configuration files.
The advanced VM management also gives you the following benefits:
• Balancing the network traffic by distributing it between multiple VM Manager Tools
• Collecting capacity data only for selected virtual machines (UUID-based filtering)

Deployment scenarios
Before you proceed to advanced VM management, review the available scenarios for which
you can use the additional instance of VM Manager Tool. The main purpose is to transfer
the capacity data from VM managers that are in separated networks, but you can also
balance the network traffic, or filter your virtual machines based on their UUIDs.

Scenario 1: A VM manager is in a separated network and cannot connect to
BigFix
Without a direct connection to BigFix, data about capacity of VM Managers cannot be
collected, which conflicts with license compliance. If you have a separated network in
your environment, you can use VM Manager tool that serves as a connector between VM
Managers and the server. The tool can be installed on any computer that can connect to VM
Managers. It gathers data about their capacity and then uploads it to the server.
The following image shows two separated networks, each represented by a different VM
Manager tool.

Scenario 2: You want to balance the network traffic coming from multiple VM
Managers
You can balance the network traffic by distributing it between multiple VM Manager Tools.
Successful load balancing optimizes resource use, maximizes throughput, minimizes
response time, and avoids overload.
The following image shows two VM Manager Tools connected to the BigFix server. Each of
them is responsible for gathering capacity data from different VM Managers.

Scenario 3: UUID-based virtual machine filtering
The purpose of filtering based on universally unique identifier (UUID) is to select only those
virtual machines whose capacity and topology data is to be included in a final report. The
VM manager has the function of matching UUIDs of selected guests. To stay compliant, all
the necessary virtual machines units must be included in the report. When you enable UUIDbased filtering all of the non-selected guests, empty hosts and clusters are removed.

Installing additional VM Manager tool
To connect to VM managers that are in separated networks, you must first install additional
VM Manager Tool. You can install it on any computer that can connect to the separated
networks.
• Review software requirements and other considerations
• Install an BigFix client on the target computer.
1. Log in to the BigFix console.
2. In the navigation tree, click Sites > External Sites > BigFix Inventory v10 > Fixlets and
Tasks.
3. Select Install Additional VM Manager Tool (OPTIONAL) version number and click
Take Action.
4. Select the target computer and click OK. The target computer must be able to connect
to separated VM managers.
You installed additional instance of VM Manager Tool. You can use its command-line
interface to manage VM managers that are in separated networks.
Schedule the upload of collected data.

Related information
Uploading collected data

Uploading collected data
After you install additional VM Manager Tool, schedule the regular uploads of collected
data. This action is required so that the capacity data that is collected by VM Manager Tool
is uploaded to the BigFix server.
1. Log in to the BigFix console.
2. In the navigation tree, click Sites > External Sites > BigFix Inventory v10 > Fixlets and
Tasks.
3. Select Schedule VM Manager Tool Scan Results Upload.

4. In Description, enter the upload frequency in hours.

5. Click Take Action.
6. Select the target computer and click OK. The computer must have VM Manager Tool
installed.

Note: All options in the Execution tab are disabled. The frequency can be
specified only in the Description field.
You scheduled the upload of capacity data from VM Manager Tool to BigFix. The data is
transferred to BigFix Inventory with each data import. If no modifications are made to VM
managers, the data is uploaded according to the schedule. If you modify a VM manager, the
upload is triggered shortly afterwards.
Configure VM managers.

Adding VM managers in distributed mode
In advanced VM management, you add VM managers by creating configuration files, where
you specify web address, type, and credentials that are required to access a VM manager.
Each VM manager uses a separate configuration file.
VM managers for which configuration files are created are displayed in the BigFix Inventory
user interface. However, they can be managed only in the VM Manager tool command-line
interface.
VM Manager Tool, starting from update 1.5.0.0, is enhanced to attempt
to automatically fix the most common problems with the VM manager connection
parameters. This feature is disabled by default. To enable this feature, go to the BES
Client\LMT\VMMAN\config directory, open the vmmmainconf.properties file
and change the setting of the vmm_fix_parameters_enabled parameter to true. While

fixing connection problems the VM Manager Tool can connect using the HTTP protocol
when the defined HTTPS connection is not available. This setting is enabled by default.
To disable switching protocol from HTTPS to HTTP, go to the BES Client\LMT\VMMAN
\config directory, open the vmmmainconf.properties file and change the setting of
the vmm_http_connection_allowed parameter to false. For more information, see: VM
Manager Tool settings.
1. Go to the BES Client\BFI\VMMAN\config directory.
2. Copy the vmmconf_template.properties file and rename it to
vmmconf_name.properties. This file now represents a new VM manager.
Attention: Each time you create a VM manager configuration file, use the
vmmconf_template.properties file as a template. Do not copy and edit
configuration files that you previously created for a different VM manager.
After you load the configuration file for the first time, an ID is generated for
a VM manager. Each ID must be unique. When you copy and edit an existing
configuration file, the ID is duplicated.
3. Edit the file and specify the following parameters:
vmm_url
Specify the web address of the VM manager. You can specify either a
full URL or only the host name or IP address.
For example, vmm_url=http://192.0.2.0/wsman.
Important: The default URL differs depending on the
virtualization type.
• vCenter
◦ https://<vCenter_IP_address>/sdk/
vimService.wsdl

• RHV-M
◦ https://<RHV-M_IP_address>/ovirt-engine/api
• Hyper-V
◦ https://<Hyper-V_IP_address>/wsman

Citrix Hypervisor (formerly XenServer)

•

◦ https://<Citrix-hypervisor>
•
•

Nutanix
◦ https://<NUTANIX_PRISM_IP_ADDRESS>:9440/
PrismGateway/services/rest/v2.0

vmm_type
Specify the type of the VM manager. The possible values are
VMWARE_V_SPHERE, MICROSOFT_HYPER_V, KVM_RHV_M, XEN_MANAGER,
ORACLE_VM or NUTANIX.

For example, vmm_type=MICROSOFT_HYPER_V.
vmm_login
Specify the user name that is used to access the VM manager.
For example, vmm_login=administrator\cluster.com.
Important: VM managers use different definitions of users:
• For Microsoft Hyper-V, you must use the Administrator
account. The user is defined as user_name\domain or
user_name@domain. For example: test\cluster.com or
test@cluster.com.

• For VMware, the user is defined as domain\user_name, for
example: cluster.com\test.
• For RHV-M, the user is defined as user_name@domain, for
example: test@cluster.com.
•

For Citrix Hypervisor (formerly XenServer), the
user is defined as user_name, for example root.

•

For Oracle VM Server for x86, the user is defined
as user_name, for example: test.

•

For Nutanix, the user is defined as user_name,
for example: test.

vmm_password
Specify the password that is used to access the VM manager. The
password is encrypted and saved when you load the configuration files.
For more information about optional parameters, see Configuration parameters.
4. Save the configuration file. To establish the connection, you must run the VM Manager
Tool and load the configuration file.
Run the VM Manager Tool.

Running VM Manager tool
After creating configuration files for your VM managers, you must run the VM Manager tool
to load the configuration, test connections, and check the status of VM managers.
For a complete list of commands that can be used in VM Manager tool, see VM Manager
Tool command-line options.
1. Open the command-line interface and go to BES Client\LMT\VMMAN.
2. Optional: VM Manager Tool is started automatically after installation, however you
can use the following commands to start it, if needed.
./vmman.sh -run
vmman.bat -run
3. Load the new or updated configuration files to update the connection parameters in
VM Manager Tool. During this step, the passwords provided in the files are encrypted.
You must repeat this step after modifying or creating a configuration file.
./vmman.sh -reloadconfig
vmman.bat -reloadconfig
4. Test connections to VM managers.
./vmman.sh -testconnection
vmman.bat -testconnection

5. Check the status of VM managers.
./vmman.sh -status
vmman.bat -status
Tip: For more information about the available statuses, see VM manager
statuses.

If the VM managers report the OK status, they are working properly, and the capacity
data is being collected. The upload of collected data is triggered shortly after making any
modifications to VM managers, such as adding a new connection or changing the existing
one. If no modifications are made, the data is uploaded according to the schedule. For more
information, see Capacity data flow.
Starting from application update 9.2.4, VM managers from the distributed mode
are also visible in the user interface after the data about them is imported to the BigFix
Inventory server. However, they can be modified only through configuration files.

Additional configuration
Additional configuration tasks are intended to give you more control over VM Manager
Tool. You can use them to customize the VM Manager Tool, or to enable filtering of virtual
machines based on their UUIDs. All of these tasks are optional.

VM manager configuration parameters
In advanced VM management, connection to each VM manager is created based on
the information provided in the configuration files. Apart from specifying mandatory
parameters, such as web address, virtualization type, user name, and password, you can
also use additional ones to disable VM managers, set the number of login attempts, or allow
Hyper-V to share credentials with hosts in the same cluster.
Important: The following settings cannot be changed for the main instance of VM
Manager Tool that is installed on the BigFix server. Any changes are overwritten
during the next action performed on VM managers. To configure VM managers on
the main instance of VM Manager Tool, see: Adding VM managers in central mode.

Table 152. VM manager configuration parameters
The table describes global configuration parameters. For each parameter, there are 2 levels. The first level consists
of four columns and provides the unit as well as the default, minimum, and maximum values of the parameter. The
second level is common for all four columns and provides a description of the parameter.
Unit

Minimum

Maximum

Description

Parameter
vmm_url

Default

Web address
(URL)
Specifies the web address of the VM manager. You can provide ei
ther a full URL, a partial URL, or only a host name or IP address. In
the second case, the full address of the VM manager is built based

Table 152. VM manager configuration parameters
The table describes global configuration parameters. For each parameter, there are 2 levels. The first level consists
of four columns and provides the unit as well as the default, minimum, and maximum values of the parameter. The
second level is common for all four columns and provides a description of the parameter.
(continued)
Unit

Default

Minimum

Maximum

Description

Parameter

on the selected type of the VM manager and protocol (if speci
fied). HTTPS protocol is used by default.
If you specify only the addresses, the defaults are used:
• https://virtualcenter/sdk for VMWARE_V_SPHERE
• https://hyper-v/wsman for MICROSOFT_HYPER_V
• https://rhv-m:8443/api for KVM_RHV_M
https://Citrix-hypervisor for XEN_-

•
MANAGER

•

https://ovm-m:7002/ovm/core/wsapi/rest for ORACLE_VM

If you do not specify the complete URL but only a protocol, or a
port, or a context path, the URL is built based on the following
defaults:
• VMWARE_V_SPHERE - default protocol https, port 443 (for
https) or 80 (for http), context path - sdk
• KVM_RHV_M - default protocol https, port 8443 (for https)
or 8080 (for http), context path - api
• MICROSOFT_HYPER_V - default protocol https, port 443
(for https) or 80 (for http), context path - wsman

Table 152. VM manager configuration parameters
The table describes global configuration parameters. For each parameter, there are 2 levels. The first level consists
of four columns and provides the unit as well as the default, minimum, and maximum values of the parameter. The
second level is common for all four columns and provides a description of the parameter.
(continued)
Unit

Default

Minimum

Maximum

Description

Parameter

XEN_MANAGER - default protocol https, port

•

443 (for https) or 80 (for http), context path - <empty>
ORACLE_VM - default protocol https, port

•

7002 (for https) or 80 (for http), context path - /ovm/
core/wsapi/rest

If the URL contains the name of a VM manager, the name is re
solved to an IP address. However, the full URL, including a port
number, is used by the server to identify the VM manager.
Each VM manager must have a different web address, that is, only
one entry is allowed for a particular URL. If two or more configura
tion files duplicate the URL address, only the first file is treated as
valid. The remaining files are ignored.
vmm_type

Characters
Specifies the type of VM manager. The possible values are:
• VMWARE_V_SPHERE
• MICROSOFT_HYPER_V
• KVM_RHV_M

vmm_communication_interface

•

XEN_MANAGER

•

ORACLE_VM

Characters

POWERSHELL

Specifies the communication interface that is used for commu
nication with Microsoft™ Hyper-V. This option is supported only

Table 152. VM manager configuration parameters
The table describes global configuration parameters. For each parameter, there are 2 levels. The first level consists
of four columns and provides the unit as well as the default, minimum, and maximum values of the parameter. The
second level is common for all four columns and provides a description of the parameter.
(continued)
Unit

Default

Minimum

Maximum

Description

Parameter

when the VM Manager Tool is installed on Windows. On Linux, the
value of this parameter is ignored and the NTLM communication
is always used. The possible values are:
• NTLM
• POWERSHELL
vmm_login

Characters
Specifies the user name that is used to access the VM manager.

Important: For Microsoft™ Hyper-V, you must use the Ad
ministrator account.
vmm_password

Characters
Specifies the password that is used to access the VM manager.
A password that is entered in plain text is immediately encrypted
and saved while the configuration files are loaded.

Important: For Microsoft™ Hyper-V, you must use the Ad
ministrator account.
vmm_communication_locked

True/false

False

Indicates whether the connection to the VM manager is locked.
The possible values are:
true

Table 152. VM manager configuration parameters
The table describes global configuration parameters. For each parameter, there are 2 levels. The first level consists
of four columns and provides the unit as well as the default, minimum, and maximum values of the parameter. The
second level is common for all four columns and provides a description of the parameter.
(continued)
Unit

Default

Minimum

Maximum

Description

Parameter

Disables the connection to the VM manager but
keeps the configuration file. If the number of failed
logging attempts that is specified in the vmm_max_
subsequent_login_failures parameter is exceeded,
the value of the vmm_communication_locked para
meter is automatically set to true.
false
Unlocks communication with the VM manager and
resets the count of the subsequent failed logging at
tempts.
vmm_get_cluster_info_with_shared_creden
tials

True/false

False

Indicates whether the same credentials can be used to connect to
every host in the same cluster. You can use this parameter only for
Microsoft™ Hyper-V. The possible values are:
true
Uses the same credentials to get information about
all other hosts in the same cluster.
false
Set when credentials for every host in the cluster are
different. Each host in the same Hyper-V cluster re
quires a separate configuration file.

VM Manager tool command-line options
Apart from basic commands that allow you to create connections to VM managers and
check their status, you can use additional commands to run or remove VM Manager Tool,
encrypt passwords, or collect debug information for troubleshooting purposes.
The following table provides a list of command-line options that you can use when you run
the VM Manager tool. If you run the application without specifying any options, the help
screen is displayed by default.
Option

Description

Example

-addcertificate

Adds a certificate to the keystore. Use this

-alias unique_-

option when the VM Manager tool is set not

alias -file vm_-

to trust SSL certificates from all defined VM root/Downloads/VMwaredefaultcertifi-

manager_certifi-

managers (vmman_trust_all_vm_manager

cate

s_certificates parameter is set to false).

./vmman.sh -addcertificate -alias cert_to_vmm1 -file /

cate.crt
vmman.bat -addcertificate
-alias cert_to_vmm1 -file C:\Users
\Administrator\Downloads\VMwaredefaultcertificate.crt

Changes the default password to the VM

./vmman.sh -changepass-

-changepassword

Manager tool keystore. For more informa

word -file /var/opt/BESClient/LMT/

-file file_path

tion, see: Improving security of storing VM

VMMAN/config/keystore_password.txt

manager passwords.

vmman.bat -changepassword
-file "C:\Program Files (x86)\BigFix Enterprise\BES Client\LMT\config\keystore_password.txt"

-convertkeystore

Converts the keystore format from JCEKS to
PKCS12. Use this option if you manually up
graded the VM Manager Tool from a version

Notice: Ap
plicable

earlier than 10.0.8.

./vmman.sh -convertkeystore
vmman.bat -convertkeystore

Option

Description

Example

till version
10.0.8.
Displays the help screen. It is the default op

-help

tion when no other option is specified.
Installs VM Manager tool as a system ser

-install

./vmman.sh -install

vice.

vmman.bat -install

Important: You must have the ad
ministrative or root privileges to use
this option.
The installation logs are
in the directory: BES Client\LMT
\VMMAN\logs\install.

-passwd password-

Encrypts a password for the VM manager

String -config

from a configuration file that is specified in

Password -config ./config/vmmconf_-

file_path

the config parameter.

1.properties

./vmman.sh -passwd new-

vmman.bat -passwd newPassword -config config\vmmconf_1.properties
-regen- Overwrites the default key that is used to
erateencryption-

encrypt passwords to VM managers. Run

key

the command to increase security of storing
the passwords. For more information, see:

./vmman.sh -regenerateencryptionkey
vmman.bat -regenerateencryptionkey

Improving security of storing VM manager
passwords.
-reloadconfig

Reloads all configuration files and updates
the parameters in the memory of VM Man

./vmman.sh -reloadconfig
vmman.bat -reloadconfig

Option

Description

Example

ager tool. You can use this option only if VM
Manager tool runs as a system service.

Tip: Use this option each time a new
VM manager connection is defined
to load the newly created configura
tion.

-remove

Removes VM Manager tool from the service

./vmman.sh -remove

registry.

vmman.bat -remove

Important: You must have the ad
ministrative or root privileges to use
this option.
The removal logs are
in the directory: BES Client\LMT
\VMMAN\logs\install.

-retrievedebugda-

Collects debug information from all defined

ta

VM managers and stores it in the debugDa- data

./vmman.sh -retrievedebug-

ta.zip file that is in the main the VM Man
ager tool directory. The collected informa

vmman.bat -retrievedebugdata

tion includes:
• Configuration files
• Log files
• Network communication log files
• Data collected from VM managers
• Status of all VM managers
-run

Starts the VM Manager tool in service mode.
In this mode, data is collected for all defined
VM managers repeatedly at the interval that

./vmman.sh -run
vmman.bat -run

Option

Description

Example

is set in the vmm_polling_time_interval pa
rameter. To use this option, you must install
VM Manager tool as a system service.

Important:

You must

have the administrative privileges to
use this option.

-runonce [ -con-

Collects data from all defined VM managers

fig file_path ]

once and exits the VM Manager tool. To col fig ./config/vmmconf_1.properties

./vmman.sh -runonce -con-

lect data from a particular VM manager, use
the -config file_path option, where file_

vmman.bat -runonce -config
config\vmmconf_1.properties

path is a full or relative path to the configu
ration file of the VM manager that you want
to collect data from.
-status [ -config

Displays the operation status for all VM

file_path ]

managers. If the file path is specified, the

./vmman.sh -status -config ./config/vmmconf_1.properties

operation status for the particular VM man
ager is displayed.

vmman.bat -status -config
config\vmmconf_1.properties

To see the information about all the opera
tion statuses, refer to the topic VM Manager
tool statuses.
-stop

Stops VM Manager tool that was started as

./vmman.sh -stop

a system service.

vmman.bat -stop

-testconnection

Tests connections to all defined VM man

[ -config file_-

agers. To collect data from a particular VM

-config ./config/vmmconf_1.proper-

path ]

manager, use the -config file_path op

ties

tion, where file_path is a full or relative path
to the configuration file of the VM manager
that you want to collect data from.

./vmman.sh -testconnection

vmman.bat -testconnection
-config config\vmmconf_1.properties

VM Manager Tool settings
You can configure settings of VM Manager Tool by editing the
vmmmainconf.properties file that is stored in the BES Client\LMT\VMMAN\config
directory.
Important: The following settings cannot be changed for the main instance of VM
Manager Tool that is installed on the BigFix server. Any changes are overwritten
during the next action performed on VM managers. To configure VM managers on
the main instance of VM Manager Tool, see: Adding VM managers in central mode.

Table 153. Global configuration parameters
Parameter
check_vm_managers_uniqueness
Distinguishes unique VM managers from du

Unit
Boolean (true/

Default
True

false)

plicates.
uuid_filtering_enabled
Enables UUID filtering.

Boolean (true/

False

false)

vmm_collecting_hostnames_en Boolean (true/

False

false)

abled
Specifies whether host names should be col
lected and saved in the log files. Available for
VMware.
You can enable this parameter to solve prob
lems with duplicated UUIDs. In the case of
found duplicates, the host names are written
in the log files.
vmm_collecting_host_serials_
enabled

Boolean (true/
false)

False

Minimum

Maximum

Table 153. Global configuration parameters (continued)
Parameter

Unit

Default

Minimum

Maximum

Specifies whether serial numbers of VM
manager hosts are collected for VM man
agers from which data is collected by the VM
Manager tool. Available for Hyper-V, VMware
5.0 and higher, and Oracle VM Server for x86.
To display information about serial numbers
in the Server ID column on the reports, adjust
the Server ID template that is specified by
the managedServerTagTemplate parameter.
For more information, see: Advanced server
settings.
vmm_connection_timeout

Seconds

90

10

3600 (1 hour)

Minutes

720

0

10080

Boolean (true/

False

Specifies the time after which the connection
with a VM manager is ended.
vmm_data_transfer_period
Determines how often the scan data is trans
ferred to the agent to be uploaded to the
server if subsequent scans have the same
results.
vmm_fix_parameters_enabled
Attempts to fix the most common problems
with VM manager connection parameters,
such as adding default URL suffix, correcting
the user name format, and testing the Win
RM and PowerShell protocols for Hyper-V
VM managers.

false)

Table 153. Global configuration parameters (continued)
Parameter
vmm_http_connection_allowed
Allows the VM manager to connect by using

Unit
Boolean (true/

Default

Minimum

Maximum

True

false)

the HTTP protocol when the defined HTTPS
connection is not available.
vmm_keystore_password_do_
not_change_it
Contains the encrypted password to the VM
Manager tool keystore. The parameter is
specified only if you changed the default
password by using the regeneratekeystorepassword command. For more infor

mation, see: Improving security of storing
VM manager passwords.

Important: Do not change the value
of this parameter.
vmm_max_subsequent_login_failures
Specifies the maximum number of failed lo
gin attempts in to the VM manager. The de
fault value of vmm_max_subsequent_lo
gin_failures should be set as 0 to avoid con
nection timeout. This scenario is applicable
when using PowerShell framework. When
the value is set as 0, the VM manager tool at
tempts connecting to the VM manager for
unlimited times (irrespective of the frame
work used).

Number

3

0

100

Table 153. Global configuration parameters (continued)
Parameter

Unit

Default

Minimum

Maximum

The value when set to 3, the VM Manager
tools attempts for 3 times and then it stops
attempting. To resolve this, try the following
options:
• change the username and/or pass
word
• change the hypervisor address
• restart VM manager tool
• edit configuration in the file
The status of VM Manager changes as per
the value you set. For example, when the val
ue is set as 3, the status changes to 'Invalid
credentials - suspended' and when the value
is set as 0, the status changes to 'Invalid cre
dentials - attempting'. For more information
on statuses, refer to VM manager statuses.
vmm_polling_time_interval
Specifies the interval between the consecu
tive retrievals of data from VM managers.

Restriction: In case of subcapacity
reporting, it is necessary to capture
mobility of VMs. To ensure that it is
captured, data from VM managers
must be collected every 30 minutes.
You can change the frequency of col
lecting data only if you use BigFix In

Minutes

30

30

10080 (1
week)

Table 153. Global configuration parameters (continued)
Parameter

Unit

Default

Minimum

Maximum

ventory for purposes other than sub
capacity reporting.
vmm_rmi_protocol

String

TLSv1.2

Number

25001

Bytes

10240

10240

1048576

Number

10

1

100

Specifies the protocol that is used for inter
nal communication through the port that is
specified in the vmm_rmi_ssl_port parame
ter when you run the reloadconfig or stop
commands.
Possible values are:
• SSL
• SSLv3
• TLSv1
• TLSv1.1
• TLSv1.2
vmm_rmi_ssl_port
Specifies the port that is used for internal
communication when you run the reloadcon
fig or stop commands.
vmm_slm_tags_file_size_limit
The maximum size of each .slmtag file that
is used to collect VMware license metric uti
lization.
vmm_slm_tags_files_per_soft
ware

Table 153. Global configuration parameters (continued)
Parameter

Unit

Default

Minimum

Maximum

The maximum number of .slmtag files that
are stored on the computer for each license
key under VMware instance.
vmm_slm_tags_enabled
Enables collection of license metric utiliza

Boolean (true/

False

false)

tion for VMware VM managers. If set to true,
.slmtag files are created locally and col
lected by the resource utilization scan.
vmm_thread_pool_size

Number

10

Boolean (true/

True

Specifies the number of threads in thread
pool that is used for connections to VM man
agers.
vmm_transfer_credentials_to_

false)

server
Specifies whether VM manager credentials
are transferred to the server. The option is
enabled by default. If you disable the option,
the credentials are not transferred and thus
they are not displayed on the VM Managers
panel when you edit the VM manager.
vmm_trust_all_vm_managers_
certificates
Specifies whether SSL certificates from all
defined VM managers are trusted. If the op
tion is disabled, certificates that are trust
ed must be placed in the truststore on the
computer where the VM Manager Tool is in

Boolean (true/
false)

True

1

50

Table 153. Global configuration parameters (continued)
Parameter

Unit

Default

Minimum

Maximum

stalled. For more information, see: Configur
ing VM Manager tool to accept trusted VM
manager certificates.

UUID-based virtual machine filtering
The purpose of filtering based on universally unique identifier (UUID) is to collect the
capacity data only for chosen virtual machines. The remaining ones are omitted and not
updated in BigFix Inventory.

Enabling UUID-based virtual machine filtering
The uuid_filtering_enabled parameter is set by default to false. You must set it to
true before you can select virtual machines to be included in a final report.
Note: To change this parameter for basic (central) VM management, log in to
BigFix Inventory, go to Management > Advanced Server Settings, and change the
vmman_uuid_filtering_enabled value to true.
1. Go to the computer where you installed an additional instance of VM Manager Tool.
2. Go to BES Client\LMT\VMMAN\config.
3. Open the vmmmainconf.properties file.
4. Set the uuid_filtering_enabled property to true.
You enabled filtering of virtual machines based on their UUIDs. If you want to later reverse
the changes, set the property to false.

Selecting virtual machines for UUID-based filtering
You can select virtual machines for whom the capacity data is to be collected by putting
their UUIDs in the vmmfilterconf.properties file.

1. Obtain the list of virtual machines UUIDs by running the select distinct uuid from
ADM.VIRTUAL_VM_UUID SQL query. For more information, see Obtaining the list of

virtual machine UUIDs.
2. In the BES Client\LMT\VMMAN\config directory, open the
vmmfilterconf.properties file.
3. Add the UUIDs of chosen virtual machines
During filter matching, the VM manager removes any white space characters and
hyphens (-). All letters are also converted to uppercase.
All of these entries are valid:
• 5030a6eb-485a-35b5-0fa0-a8bc4a459c9d
• 564da050-7b20-8754-b578-e8437da8653e
• 564D1E0d4C0CE65B8A54203D7E032D2B
Run the following command to load the list of UUIDs that you configured:
•

./vmman.sh -reloadconfig

•

vmman.bat -reloadconfig

Obtaining the list of virtual machine UUIDs
You can use the list of virtual machine UUIDs that are currently connected to the BigFix
Inventory server to select those for whom the capacity data is to be collected.
You can find all of the virtual machine UUIDs that are currently connected to the BigFix
Inventory server in the ADM.VIRTUAL_VM_UUID table in the TEMADB database. You can
extract the complete list of UUIDs and then remove the chosen UUIDs to omit certain virtual
machines.
The following procedure explains how to retrieve the list of UUIDs from the DB2 database. If
you are using MS SQL, use a method of retrieving information from database tables that is
suitable for this database.

1. Log in to the database server as db2inst1 or other user with DBADM rights.
2. To obtain the list of virtual machines UUIDs, enter the following commands in the
system command-line interface:
db2 connect to TEMADB
db2 "select distinct uuid from ADM.VIRTUAL_VM_UUID" >uuids.txt

Note: TEMADB is the default database name. If you are unsure whether it
applies to your database, see: Checking the database name.
The list is now stored in the uuids.txt file.
Remove the unnecessary UUIDs from the uuids.txt file and copy the remaining UUIDs to
the vmmfilterconf.properties file.

Collecting capacity data from virtualization hosts for Xen and
KVM
For Citrix, Xen and KVM, connection to the VM manager does not have to be defined
in BigFix Inventory to collect capacity data. The data can be collected directly from
virtualization hosts by using the Run Capacity Scan on Virtualization Hosts task.
This method is applicable on the following virtualizations:
•

Xen Hypervisor

•

Citrix Hypervisor (formerly XenServer)
Important:

Starting from application update 9.2.12, it is

recommended to collect data from Citrix Hypervisor (formerly XenServer) by
configuring connections to VM managers. For more information, see:Adding
VM managers in central mode.
• PowerKVM
• KVM x86

Tip: If your KVM x86 hosts are controlled by RHV-M, you can configure the
RHV-M as a VM manager in BigFix Inventory. It allows for collecting capacity
data from all controlled hosts without the need of using the Run Capacity
Scan on Virtualization Hosts task on each of them. For more information, see:
Adding VM managers in central mode.
For information about supported versions of these virtualizations, see: Detailed System
requirements.
Ensure that virtualization hosts from which you want to collect capacity data meet the
following prerequisites.
KVM hosts
Ensure that the following prerequisites are met on the KVM hosts:
• The host runs on Linux x86 or Linux on Power
• Bash shell is available
• libvirt-client library is installed (virsh command is available)
• libxml2 library is installed (xmllint command is available)
Xen hosts
Ensure that the following prerequisites are met on the Xen hosts:
• The host runs on Linux x86
• Bash shell is available
• xl command is available
• libxml2 library is installed (xmllint command is available)
1. Log in to the BigFix console.
2. In the navigation tree, click Sites > External Sites > BigFix Inventory v10 > Fixlets and
Tasks.
3. In the upper right pane, select Run Capacity Scan on Virtualization Hosts.

4. Optional: To collect information about host names of virtualization hosts, select
Collect host names of virtualization hosts.
This option affects the format of information about virtualization hosts that is
displayed in the Server ID column on the reports. If you select this option, the column
contains information about the vendor, type and host name of the host as specified
in the managedServerTagTemplate parameter. If you do not select this option,
the column contains the serial number of the host instead of its name. For more
information about the managedServerTagTemplate parameter, see: Advanced server
settings.
5. To start the scan, click Take Action.
Important: If you run this task on the host, you no longer need to run the Run
Capacity Scan and Upload Results task on that host.
6. From the list of applicable computers, select the supported hosts.
Important: The list is filtered out to the computers that meet the prerequisites.
However, not all of them are virtualization hosts.
7. Optional: By default, the capacity scan is scheduled to run every 30 minutes.
However, in an environment with many KVM or Xen hosts, consider lowering the
frequency of the scan. To specify the frequency of the scan, open the Execution tab,
specify the details, and click OK.
For environments with multiple hosts, run the scan once per one to six hours.
Restriction: You can change the frequenIBMer you obtain the acceptance of
the BigFix Compliance Team.
8. Schedule the upload of scan results to the BigFix server.
a. In the upper right pane, select Schedule VM Manager Tool Scan Results Upload,
specify the frequency, and click Take Action.
b. Select the hosts from which you collected the capacity data, and click OK.

Tip: To check the status of the capacity scan on the endpoints, activate the
analysis Status of Capacity Scan on Virtualization Hosts. If the status is other
than OK, check the return code to learn what is the cause of the problem and
how to solve it. For more information, see: Return codes of capacity scans on
virtualization hosts.
9. Wait for the scheduled import or run it manually to transfer the data to BigFix
Inventory.
Note: When you run fixlet 'Run Capacity Scan on Virtualization Hosts', the
discovered hosts, such as KVM, Xen, and Citrix are displayed on Management
> VM Managers panel in BigFix Inventory UI.

Related reference
Return codes of capacity scans on virtualization hosts

Removing capacity scan data from the host
During the capacity scan, some files and folders are generated on the virtualization host. If
you no longer collect capacity data from a particular host, remove the files and folders that
were created by the capacity scan.
1. Stop the actions that were created by the Run Capacity Scan on Virtualization Hosts
task on the specified endpoints. Otherwise, the scan continues running and the files
are recreated.
a. In the navigation tree of the BigFix console, click Sites > External Sites > BigFix
Inventory v10 > Actions.
b. Select the actions, and in the lower pane, click Stop.
2. In the navigation tree, go to Fixlets and Tasks.

3. In the upper right pane, select Remove Capacity Scan Data from Virtualization Hosts,
and click Take Action.
4. Select the computers from which you want to remove the data that was generated
during the capacity scan, and click OK.

Maintenance tasks
You can perform additional maintenance and troubleshooting tasks on VM Manager Tool.
These tasks are not limited to a specific approach to VM management, but can be applied
to any instance of VM Manager Tool.

VM Manager tool installation requirements
The computer on which you install the VM Manager tool must meet all software and
hardware requirements.
Important: Central VM Manager tool must be installed on a BESRootServer.
By default BigFix Inventory assumes one BESRootServer per datasource. In
case of Distributed Server Architecture (DSA) with multiple BESRootServers per
datasource the VM Manager tool must be installed on the BESRootServer with
the lowest ID, even if the root server is not the primary root server of the datasource.

Supported operating systems
The VM Manager tool can be installed on any 64-bit version of Windows or Linux that
is supported by the BigFix client or the disconnected scanner. For the list of supported
operating systems, see: Detailed System requirements.

Software prerequisites
The following libraries must be available on the computer:
• unzip in any version
• glibc library version 2.7 or higher

Required free disk space
The VM Manager tool requires 300 MB of disk space.

Log files
You can gather the log files to determine the problems that are related to the VM Manager
tool. You can also change the log settings.
VM Manager tool log files are stored at:
• Trace log files: BES Client\LMT\VMMAN\logs
• Installation log files: BES Client\LMT\VMMAN\logs\install
You can also gather the complete set of logs by running the -retrievedebugdata command in
VM Manager tool.

Log settings
You can change the log settings by editing the following files:
• log4j.properties for application update 10.0.2 and lower
• log4j2.xml for application update 10.0.3 and higher
The following parameters are the most useful:
For versions below 10.0.3
log4j.appender.mylogger.maxFileSize specifies the maximum size of a log file
Default value = 1000 KB
log4j.appender.mylogger.MaxBackupIndex specifies the maximum number of
log files
Default value = 10
log4j.rootLogger specifies the logging level
Default value = INFO. You can change it to DEBUG to enable debug logging.

For versions 10.0.3 and 10.0.4
SizeBasedTriggeringPolicy specifies the maximum size of a log file
Default value = 1 MB
DefaultRolloverStrategy specifies the maximum number of log files
Default value = 10
Root level specifies the logging level
Default value = INFO. You can change it to DEBUG to enable debug logging.
For versions 10.0.5 and higher
SizeBasedTriggeringPolicy specifies the maximum size of a log file
Default value = 1 MB
DefaultRolloverStrategy specifies the maximum number of log files
Default value = 2 (numer of files for the main trace.log and for every
hypervisor log)
Root level specifies the logging level
Default value = INFO. You can change it to DEBUG to enable debug logging.

Changing the upload schedule
Capacity data collected by VM Manager Tool is uploaded to the BigFix server every 12
hours. You can change this schedule by removing the default schedule and creating a new
one.
1. Stop and remove the default schedule.
a. In the navigation tree of the BigFix console, click Actions.
b. Locate the action Schedule VM Manager Tool Scan Results Upload.
c. Right-click the action and select Stop Action. The schedule is stopped.
d. Again, right-click the action and select Delete Action. The schedule is removed.
2. Create a new schedule.

a. In the navigation tree, click Sites > External Sites > BigFix Inventory v10 >
Fixlets and Tasks.
b. Select Schedule VM Manager Tool Scan Results Upload.
c. In Description, enter the new frequency in hours.

d. Click Take Action.
e. Select the target computer that has VM Manager Tool installed and click OK.
The action is started under new schedule.

Note: All options in the Execution tab are disabled. The frequency can
be specified only in the Description field.
You set up the new schedule. The data collected by VM Manager Tool is now uploaded to
BigFix with the frequency that you specified.

Forcing the upload of collected data
You can force the collected data to be immediately uploaded to the BigFix server. The data
is uploaded once and no schedule is set.
1. Log in to BigFix console.
2. In the navigation tree, click Sites > External Sites > BigFix Inventory v10 > Fixlets and
Tasks.
3. Select Force VM Manager Tool Scan Results Upload, and then click Take Action.

4. Select the target computer and click OK.
You uploaded the collected data to the BigFix server.
Run a data import in BigFix Inventory to update the data in the user interface.

Checking the VM Manager tool version
Activate the VM Manager Information analysis to retrieve data about the installed version of
VM Manager tool. You can use the analysis to quickly confirm the successful installation of
the tool.
The VM Manager Information analysis returns information for two properties,
VMMAN_Tool_Version, which specifies the installed version of the VM Manager tool, and
Build_Version, which shows the details of the build.

1. Log in to the BigFix console.
2. In the navigation bar, click Sites > External Sites > BigFix Inventory v10 > Analyses.
3. Select VM Manager Information and click Activate.

4. After you activate the analysis, open the Results tab. The information about the
version and the build is available next to the name of the applicable computer.

Updating VM Manager Tool
You can update VM Manager Tool to the newest version.
The Update VM Manager Tool to version version number task can be activated only if there
are any older versions of VM Manager Tool.
1. Log in to BigFix console.
2. In the navigation tree, click Sites > External Sites > BigFix Inventory v10 > Fixlets and
Tasks.

3. Select Update VM Manager Tool to version version number and click Take Action.
4. Select the target computer and click OK.
You updated VM Manager Tool to the newest version.

Uninstalling VM Manager tool
Follow the procedure to uninstall the VM Manager tool from the endpoints and to delete all
the related settings and folders. Uninstallation of the VM Manager tool is also required if
you want to reinstall the tool.
1. Log in to the BigFix console.
2. In the navigation tree, click Sites > External > BigFix Inventory v10 > Fixlets and
Tasks.
3. Select Uninstall VM Manager Tool and click Take Action.

4. Select the target computer and click OK.

You uninstalled VM Manager Tool.

Backing up and restoring theVM Manager tool
To avoid losing configuration of VM manager connections due to corruption of VM Manager
tool files, back up the /LMT/VMMAN/config/ and /LMT/VMMAN/keydb/ directories. If
the VM Manager tool files are corrupted, reinstall the VM Manager tool and restore the two
directories from the backup location.

1. Back up the VM Manager tool and copy the following directories to a backup location:
• Config: <client_install_dir>/LMT/VMMAN/config/
• Keydb: <client_install_dir>/LMT/VMMAN/keydb/
2. Reinstall the VM Manager tool and copy the backed-up directories to the VM Manager
tool installation directory.
a. Log in to the BigFix console.
b. In the navigation tree, click Sites > External Sites > BigFix Inventory v10 >
Fixlets and Tasks.

c. To uninstall the existing VM Manager tool, select Uninstall VM Manager Tool,
and click Take Action. Then, select the computer on which the VM Manager tool
is installed, and click OK.
d. To install a new VM Manager tool, select Install VM Manager Tool version
number, and click Take Action. Then, select the computer on which you want to
install the VM Manager tool, and click OK.
3. Restore the /LMT/VMMAN/config/ and /LMT/VMMAN/keydb/ directories from the
backup location.

Best practices for configuring VM managers
Apply the best practices when configuring VM managers to ensure that your infrastructure
works efficiently.

Optimal configuration strategies
Follow the optimal configuration strategies to collect all data from your VM managers.

Pooling interval
Pooling interval is a period during which VM Manager tool is allowed to connect to all
configured VM managers, and collect and upload the data from these VM managers. If
pooling interval is exceeded, the VM Manager tool times out and the next data collection
cycle is delayed. If you want to count and report subcapacity, it is necessary to capture
mobility of virtual machines. Therefore, data from VM managers must be collected every 30
minutes or more frequently. You can change the frequency of data collection only if you use
for purposes other than subcapacity reporting. To specify the pooling interval, set the value
of the vmm_polling_time_interval parameter on the Advanced Server Settings panel or in
the configuration file for VM Manager. For more information, see: Advanced server settings
and VM Manager Tool settings.

Number of virtual machines
The number of virtual machines that reside on VM managers directly relates to the
amount of data that needs to be gathered. If you configure multiple connections
from one VM Manager tool to VM managers that host vast number of virtual
machines, problems might occur. If it takes too long to collect data from all configured

connections, VM Manager tool times out as it exceeds the pooling interval time.
_BESClient_ArchiveManager_MaxArchiveSize parameter limits the total size of files that
are uploaded to the server. The limit might be exceeded by data that is collected from all
configured connections and as a result, the data is not uploaded. For more information
about the _BESClient_ArchiveManager_MaxArchiveSize parameter, see: Configuring VM
manager for subcapacity reporting

VM managers and network performance
Performance of VM Manager tool depends on the network typology of your environment
as well as the hardware specifications and the load of hypervisors. If network connection
is slow or the hypervisors take long time to respond and provide the requested data,
performance of VM Manager tool can be significantly impacted.

Configuring VM manager for subcapacity reporting
If you use for subcapacity reporting purposes, perform additional configuration tasks to
balance the workload of your VM Manager tool.
Make sure that you define enough VM Manager tool connections. Every VM Manager tool
should handle the workload and complete its tasks within the time that is determined by the
pooling interval.
1. Set the value of _BESClient_ArchiveManager_MaxArchiveSize to at least 50 MB on
the endpoint where the VM Manager tool is installed. In this way, you eliminate the risk
of reaching the maximum size of files that can be uploaded to the BigFix server during
the configuration.
a. Log in to the BigFix console.
b. In the left navigation panel and, select Computers. Right-click the name of the
appropriate computer, and click Edit Computer Settings.
c. Edit the value of the _BESClient_ArchiveManager_MaxArchiveSize parameter to
increase the maximum archive size.
Note:

Starting from application update 9.2.14, you can

check on the Computer Support Data panel whether the value of

_BESClient_ArchiveManager_MaxArchiveSize is exceeded. For more
information, see: Troubleshooting problems with computers.
2. Set the value of pooling interval to 30 minutes or less. It is a mandatory setting if you
use to count subcapacity.
• For the central VM Manager tool, go to Management > Advanced Server
Settings and set the value of vmm_polling_time_intervalparameter.
• For distributed VM Manager tool, go to the following directory and
set the value of the vmm_polling_time_interval parameter in the
vmmmainconf.properties file.
◦

BESClient/LMT/VMMAN/config/

◦

BESClient\LMT\VMMAN\config

3. To check whether you defined enough VM Manager tool connections, perform the
following steps.
a. Stop the VM Manager tool service.
i. Go to the following directory
•

BESClient/LMT/VMMAN

•

BESClient\LMT\VMMAN

ii. Run the following command.
./vmman -stop

b. Define the VM manager connection. For more information, see: Adding VM
managers for VMware, Hyper-V, KVM with RHV-M, Citrix Hypervisor and Nutanix.
c. Clear the following directory
•

BESClient/LMT/VMMAN/logs

•

BESClient\LMT\VMMAN\logs

d. Check whether all connections are correctly defined and gather the data. Go to
the following directory and run the command: ./vmman -runonce.
e. To make sure that the results of the command ./vmman -runonce are correct,
check whether you see the following message for every defined connection.

CODSV0001I: [ vmmconf_<number>.properties ] Data was successfully
retrieved
from the VM manager at https://<URL>

f. Go to the following directory.
•

BESClient/LMT/VMMAN/logs

•

BESClient\LMT\VMMAN\logs

Check the trace.log file to see how long it took to complete the ./vmman
-runonce command.

g. Note the time between log messages, for example:
2018-07-25 11:35:38 : (main)
com.ibm.license.mgmt.datacollector.Runner:
:initialiseLogger::Logger initialised successfully.
…
2018-07-25 11:37:49 : (main)
com.ibm.license.mgmt.datacollector.Runner::runCollector
(Configuration)::Finished 'run once' command.

• If the time between log messages stays under 20 minutes, it means that
you defined enough VM Manager tool connections and that every VM
Manager tool completes its tasks within the acceptable time. You can
define more connections if needed.
• If the time between log messages goes above 20 minutes, distribute
connections to another VM Manager tool so that every VM Manager tool
completes its tasks within that time.
◦ To limit the amount of data collected by a single connection, set
users with limited access to a subset of computers and split the
load between multiple VM Manager tool connections.

Tip: Even though the pooling interval is 30 minutes, keep the time
between log messages under 20 minutes. You need to leave some
breathing room for VM migrations, higher network traffic or higher
hypervisor workload periods.
h. Run the ./vmman -run command to start the VM Manager tool service.
i. Check the size of the data set that was collected from this VM Manager tool and
whether it exceeds the _BESClient_ArchiveManager_MaxArchiveSize value.
4. After you complete the configuration of VM Manager tool connections, results are
stored in the following directory. To sent the results to the BigFix server, run the
Schedule VM Manager Tool Scan Results Upload task.
•

BESClient/LMT/VMMAN/upload

•

BESClient\LMT\VMMAN\upload

You can run Force VM Manager Tool Scan Results Upload to upload the result files to
the BigFix server faster.
5. When the task completes, the result file or files are stored in the following
directory. Result files names follow the specific naming convention:
1323215_<number>_vmman.tar.gz.

•

BESClient/LMT/VMMAN/

•

BESClient\LMT\VMMAN\

• Your VM manager configuration is complete. If at any point your previously configured
VM Manager tool stops collecting data, go to the following directory.
◦

BESClient/LMT/VMMAN/logs

◦

BESClient\LMT\VMMAN\logs

Check if the log file contains the following message.
"[WARNING] Data collection from some defined vm managers did not
finish within defined

pooling interval 30. Please consider increasing the
vmm_polling_time_interval setting
in vmmmainconf.properties file or divide your vm manager connections
to more VM Manager Tools.

If that happens, you need to configure new VM Manager tool and split the workload.
• You can check whether _BESClient_ArchiveManager_MaxArchiveSize is exceeded by
checking the Software Scan Status analysis. The Is archive size exceeded? column
provides the information for computers with VM Manager tool installed.

Administering the server
Perform administering tasks on your server to configure advanced settings, or restart its
services.

Starting the server
You can start the BigFix Inventory server by running the srvstart.bat or srvstart.sh
script.

Starting the server on Linux
To start the server, run the srvstart.sh script.
Only the user who installed BigFix Inventory or has root privileges can perform this task.
1. Optional: Check if your DB2® instance is running.
a. Log on to the computer where DB2® is installed. You must be a DB2® instance
owner.
b. Type db2start at the command line.
2. Go to the BigFix Inventory installation directory.
3. Open the cli directory.
4. Run srvstart.sh.

Starting the server on Windows
To start the server, run the srvstart.bat script.
1. Optional: Check if your SQL Server instance is running.
a. Log on to the computer where the SQL Server® is installed. You must have
administrative privileges or be an SQL Server service owner.
b. Start the SQL Server instance. For more information, see: Start, Stop, Pause,
Resume, Restart SQL Server Services.
2. Go to the BigFix Inventory installation directory.
3. Open the cli directory.
4. Run srvstart.bat.

Stopping the server
You can stop the BigFix Inventory server by running the srvstop.bat or srvstop.sh script.

Stopping the server on Linux
To stop the server, run the srvstop.sh script.
Only the user who installed BigFix Inventory or has root privileges can perform this task.
1. Go to the BigFix Inventory installation directory.
2. Open the cli directory.
3. Run srvstop.sh.
4. Optional: After stopping the server, check if the DB2® instance is stopped:
a. Log on to the computer where DB2® is installed. You must be a DB2® instance
owner.
b. Type db2stop at the command line. The DB2® instance stops.

Stopping the server on Windows
To stop the server, run the srvstop.bat file.

1. Go to the BigFix Inventory installation directory.
2. Open the cli directory.
3. Run srvstop.bat.

Customizing the login page
You can enter a custom message that will appear on the login page to differentiate between
multiple instances of BigFix Inventory, or to provide extra information related to this
instance. The custom message is commonly used to notify other users about specific
conditions related to the instance, such as important configuration changes.
1. Log in to BigFix Inventory, and go to Management > Session Settings.
2. In the Custom Message on Login Page field, enter your message. After you click Save,
the message will be displayed on the login page for all users of BigFix Inventory.

Setting session timeout
The session timeout specifies the period of user inactivity after which the session ends, and
the user is required to log in again. Before it happens, you are notified that the session is
about to end.

1. In BigFix Inventory, click Management > Session Settings.
2. Enter the timeout value in seconds. By default, it is set to 3600 seconds.
3. Click Save.

SSO access blocked message
You can enter a custom message that will appear on the login page when an existing SSO
user is not yet added to BigFix Inventory. The custom message can include internal point of
contacts that the user must contact to get the SSO access enabled.
1. Log in to BigFix Inventory.
2. Go to Management > Session Settings.
3. In the Custom Message on SSO Access Blocked Page field, enter your message.
4. Click Save. The message is saved and will appear when SSO access is blocked

Configuring advanced server settings
Available from 9.2.3. You can change advanced settings of the BigFix Inventory
server, for example settings related to the configuration of the central VM Manager tool, on
the Advanced Server Settings panel.

You must be an Administrator to perform this task.
Important: Configuration of advanced server settings is intended for users with
in-depth knowledge of BigFix Inventory. If you are not sure about the impact of a
particular parameter on your environment, do not change the parameter.
The following procedure describes how to change advanced server settings on the user
interface. This option is available starting from version 9.2.3. For earlier versions, you
can change the settings by using REST API calls. For more information, see: REST API for
changing advanced server settings.
1. To open the panel, go to Management > Advanced Server Settings. If the panel is
not available in the menu, go to the following URL: https://hostname:port/
management/sam/control_values.
2. Click a parameter that you want to change and provide its new value.
For more information about each parameter, see: Advanced server settings.
Restriction: You cannot change advanced server settings when the import is
in progress.
3. To save the changes, click Save.

Advanced server settings
Available from 9.2.3. Review to the list of parameters that you can use to
configure the BigFix Inventory server. You can change the parameters on the Advanced
Server Settings panel or through REST API.
To open the panel, go to Management > Advanced Server Settings. If the panel is not
available in the menu, go to the following URL: https://hostname:port/management/
sam/control_values. For information how to change the settings through REST API,
see: Configuring advanced server settings.

Table 154. Server settings
Name & Parameter

Type

Default

Minimum

Maximum

Description
Integer

0 (dis

0

3650

abled)
• Name: Maximum Historical
Data Lifetime
• Parameter: maximum_data_
lifetime

This parameter control the period of time for which
you can retain the historical data about detected
computers and software. The default value is un
limited (value set to 0). When the range is set be
tween 1-3650, the deleted records are retained for
defined number of days before they are permanent
ly deleted. Data deletion is done during Data Im
port. The amount of data that can be deleted is lim
ited to 10,000 computers and an additional 50,000
software instances per data import to distribute the
deletion of the larger sets over several imports.
Using the parameter permanently deletes the data.
Boolean

• Name: Delete unused tags au
tomatically
• Parameter: delete_unused_
tags_automatically

False

When the value is set to true, the parameter auto
matically deletes all unused saved tags from the
database during data import. Once the parameter is
enabled, the inactive tags do not appear when you
try to add or delete a tag from an instance or a com
ponent.
Enum

Delete 'add
& delete
shared

Table 154. Server settings (continued)
Name & Parameter

Type

Maximum

disk' ac

stopping in BigFix
actions

Minimum

Description

• Name: Delete action after
• Parameter: delete_stopped_

Default

tions (1)
Control the behavior of handling issued actions after
stopping them by BigFix Inventory.
Possible values:
• Keep stopped actions (0)
• Delete add & delete shared disk actions (1) –
current default
• Delete all (2)
String

talk2sam@h
cl.com

• Name: Provide feedback
email
• Parameter: provide_feed
back_email
Notice:

This parame

ter has been removed.

Allows you to provide your preferred email address
in the sending feedback option. The email address
should be within internal point of contact.
Boolean

False

Allows you to enable and disable the deprecated re
ports. When you set the value to true:
• it shows Contract Management reports, such

• Name: Deprecated Contracts
Management enabled
• Parameter: deprecated_con
tracts_mgmt_enabled

as Software Installations, Software Explo
ration, Contracts Usage Data and Manage
ment Contracts.
• it enables related import steps and calcula
tions.
• ETL steps are executed.

Table 154. Server settings (continued)
Name & Parameter

Type

Default

Minimum

Maximum

Description
The parameter is disabled by default. You need to
run data import after you change the value to true.
Integer

• Name: new_contracts_max_
computer_groups
• Parameter: new_contracts_
max_computer_groups

20

0

1000000

Defines maximum number of Computer Groups that
can be used for new contracts management. Groups
are selected according to their creation time (using
the ID), in ascending order, unless 'new_contracts_
selected_computer_groups' parameter is defined.
Run data import after this value is changed.
Note: This parameter is hidden by default.
String

• Name: new_contracts_select
ed_computer_groups
• Parameter: new_contracts_s
elected_computer_groups

Allows you to manually select which Computer
Groups for new contracts management. It should be
a comma separated list of computer group IDs.
Run Data Import after this value is changed.
Note: This parameter is hidden by default.
Boolean

• Name: Catalog distribution use the Skip Lock flag
• Parameter: catalog_down
load_task_skip_lock

False

Enable the flag to skip locked endpoints in Catalog
download fixlet. Helps is excluding locked endopints
when automatically pushing the catalog. When the
value is set to false, catalog download includes the
locked endpoints. When activated, 'Skipped Locked
Constraint' is added to the Catalog download fixlet.

Table 154. Server settings (continued)
Name & Parameter

Type

Default

Minimum

Maximum

Description
The flag applies to actions that are executed in auto
mated way.
Boolean

• Name: Allow end user to mod
ify hidden parameters
• Parameter: show_hidden_val

False

Enable the parameter to allow end users view all hid
den parameters and allow them to perform required
actions.

ues
Boolean
• Name: Enable audit trail for
user management
• Parameter: user_mgmt_au
dit_trail_enabled

Enable the parameter to allow the audit trail to cap
ture information, such as creation and deletion of
users. It also captures any modification to the user
role and user computer group.
Number

• Name: Maximum number of
custom rules
• Parameter: customRuleLimit

False

10

0

100

Specifies the maximum number of custom rules
that can be created to automate the process of soft
ware classification. Increasing the number of cus
tom rules can prolong the duration of data import.
Boolean

True

(true/false)
• Name: Account lockout: en
able account lockout
• Parameter: user_lockout_en

Specifies whether exceeding the specified number
of failed login attempts locks the user account.

abled
Minutes

5

1

60

Table 154. Server settings (continued)
Name & Parameter
• Name: Account lockout: lock
out period
• Parameter: user_lockout_

Type

Default

Minimum

Maximum

Description
Specifies the period for which a user cannot log in to
the application after exceeding the maximal number
of failed login attempts.

length
Minutes
• Name: Account lockout: login
attempts period
• Parameter: user_retry_time_
period

imal number of failed login at

1

60

Specifies the period during which the user can try to
log in to the application. When the maximal number
of failed login attempts is exceeded within this peri
od, the account is locked.
Integer

• Name: Account lockout: max

5

10

2

128

Specifies the maximum number of failed login at
tempts after which the user account is locked.

tempts
• Parameter: user_max_login_
retries
Boolean
• Name: Automatically decom
mission inactive computers
• Parameter: decommission_i
nactive_computers

False

Enables the option to automatically remove inactive
computers from BigFix Inventory after the period de
fined in the max_data_visibility_for_inactive_com
puters parameter. This option is disabled by default.
Boolean

False

Enables the option to automatically remove the scan
results after they are successfully imported from the

Table 154. Server settings (continued)
Name & Parameter
• Name: Automatically delete

Type

Default

Minimum

Maximum

Description
disconnected data source. After you set this option

the scan results after the suc

to true, automatic removal is applied after each sub

cessful import from the dis

sequent import of data. You can manually remove

connected data source

any remaining files, such as older scan results or

• Parameter: delete_success
fully_imported_scans

files that are skipped. The option is useful especially
when you handle many scan results packages. The
removal does not affect the report data and the scan
results are included in the reports.

• Name: CSV report separator
• Parameter: csvReport
Separator
• Name: Calculate metric con

Character

Comma (,)

Specifies the character that is used as a value sepa
rator during the creation of CSV files.
Boolean

True

sumption for incomplete com (true/false)
puters
• Parameter: calculateLicense
UsageForIncompleteComput
ers

Specifies how PVU consumption on x86 virtual ma
chines that have incomplete data is counted. If set
to true, PVU consumption is counted based on the
number of PVUs on the host. In this case, the report
ed PVU consumption might be higher than the real
value, but configuration of VM managers is not re
quired. If set to false, the reported PVU consumption
is 0, and VM managers must be configured.
Boolean
(true/false)

True

Table 154. Server settings (continued)
Name & Parameter
• Name: Calculating usage per
computer

Type

Default

Minimum

Maximum

Description
Specifies when the values that are displayed on the
Usage per Computer report are calculated. By de

• Parameter: calculate_dur

fault, usage per computer is calculated during every

ing_import/product_usage

import. If you change the setting to false, the usage

Previously: on_demand_

is calculated on demand. To update the report on

sam/product_usage

demand, open it and click Calculate.
After you change the value of the parameter, restart
the BigFix Inventory server for the change to take ef
fect.
Minutes

0

0

10080 (1
week)

• Name: Catalog distribution
waiting time
• Parameter: catalog_down
load_task_stagger_interval

Specifies the maximum time for which the distribu
tion of the software catalog to the endpoints is post
poned to reduce network traffic.
The distribution of the catalog to each endpoint is
postponed for a random amount of time that is with
in the specified waiting time. For example, if you set
the waiting time to 1 week, the first computer can
download the catalog after an hour since the import
of the catalog, the second computer after a day, and
the third computer after a week. The amount of time
is randomly chosen by each computer.
Boolean
(true/false)

False

Table 154. Server settings (continued)
Name & Parameter
• Name: Collect VMware li
cense metric utilization
• Parameter: vmman_slm_

Type

Default

Minimum

Maximum

Description
Enables collection of VMware license metric utiliza
tion. The option is disabled by default. The setting
applies only to the central VM.

tags_enabled
Days
• Name: Computer approaching
detachment from VM manag
er
• Parameter: vmManagerDe
tachmentNotificationPeriod
• Name: Computer detachment
from VM manager
• Parameter:
◦

vmManagerDe
tachmentPeriod

◦ Previously: computer
VmManagerDetach
mentPeriod

3

1

90

Specifies the maximum idle time after which data
from the VM manager is considered to be outdated.
After that time, the computer status changes to Out
dated VM Manager Data. The value should be lower
than the value of the vmManagerDetachmentPeriod
parameter.
Days

1

90

30
Previously:
7
Specifies the maximum idle time after which a guest
computer or a host computer is considered to be de
tached from the VM manager. After that time, the
computer status changes to No VM Manager Data.
The data that is sent by an agent is not augmented
by the data that is retrieved from the VM manager.
Starting from application updated 9.2.8, if
the host is a part of a cluster, it is also disconnected
from that cluster.

Table 154. Server settings (continued)
Name & Parameter

Type

Default

Minimum

Maximum

Description
The value of this parameter should be greater than
the value of the vmManagerDetachmentNotifica
tionPeriod parameter.
Boolean

True

(true/false)
• Name: Deploy tasks automati
cally
• Parameter: enable_automat
ic_task_deployment

Specifies whether tasks initiated by the BigFix Inven
tory server are automatically deployed to the BigFix
server. The tasks include:
• Import of the new software catalog to the Big
Fix server.
• Configuration of scan frequency and schedule
on the Scan Configurations panel.
• Automatic configuration of the fixlet site on
the BigFix server that is added as a new data
source.
• Installation and configuration of the main
VM Manager tool on the BigFix server that is
added as a new data source.
The option is enabled by default which is the recom
mended setting.
Warning: If you disable the automatic de
ployment of tasks, you need to perform a
number of manual tasks to ensure that the
data needed by BigFix Inventory is collected

Table 154. Server settings (continued)
Name & Parameter

Type

Default

Minimum

Maximum

Description
and that proper values are displayed on the
reports.
Boolean

False

(true/false)
• Name: Display data from par
tial imports

Important: Use this parameter only when

• Parameter: allow_partial_da

you are requested by HCL Support.

ta_view
Enables displaying data from the last import regard
less of whether the import was successful or par
tial. It might cause inconsistency or lack of results
on some reports. By default, the parameter is dis
abled and only data from successful imports is dis
played. To enable this parameter, first enable the en
able partial imports parameter.
Boolean

True

(true/false)
• Name: Download software
catalog automatically
• Parameter: enable_automat
ic_catalog_download

Specifies whether the new software catalog is auto
matically distributed to the endpoints. If you disable
this option, you must distribute the catalog manual
ly. For more information, see: Updating scanner cat
alogs.
Boolean
(true/false)

False

Table 154. Server settings (continued)
Name & Parameter

Type

Default

Minimum

Maximum

Description

• Name: Enable debug level log Specifies whether import logs contain debug level
ging during data imports
information. When the parameter is set to false, the
• Parameter: debug_logging_

default logging level is used.

for_imports
Removed since

Boolean

False

(true/false)
• Name: Enable information
about files and packages that
cause software detection
• Parameter: enable_caused_
detection_data

Enables the data that specifies whether a file or a
package contained enough information to cause de
tection of the related software. After enabling the
data, you can display the Cause Detection column
on the Scanned File Data and Package Data reports.
This option is disabled by default.
Note: The enable_caused_detection_da
ta parameter is removed since BigFix In
ventory version 10.0.4. You must re-create
your saved reports in case you had used the
Caused Detection column.
Boolean

False

(true/false)
• Name: Enable partial imports
of data
• Parameter: enable_partial_
imports

Enables skipping certain steps during the import of
data. The import continues even if these steps fail.
When the import finishes, it is marked as partial be
cause only data from successfully completed steps
is processed.

Table 154. Server settings (continued)
Name & Parameter

Type

Default

Minimum

Maximum

Description
Boolean

False

(true/false)
• Name: Enabled schema next
feature
• Parameter: schema_next

Optimizes the process of importing data from Big
Fix. The option is available for BigFix 9.5.5 and high
er. If you upgraded the BigFix server from earlier ver
sions, run at least one import of data before you en
able the optimization to ensure data consistency.

• Name: Location of temporary
application files
• Parameter: tempPathForGen
eratedFiles

Path

Period (.)

Specifies the path to the folder where temporary ap
plication files, such as the CSV reports during gener
ation, are stored. The default value indicates that the
files are created in the following location:
•

install_dir/wlp/usr/
servers/server1

•

install_dir\wlp\usr\servers
\server1

Path

../../../../
cve_data

• Name: Location of CVE files
upload
• Parameter: tempPathForCVE
Files

Specifies the path to the folder where temporary
CVE files should be stored for an upload. The default
value indicates that the files are stored in the cve_data folder that is in the installation directory of the
BigFix Inventory server.

Table 154. Server settings (continued)
Name & Parameter
• Name: Maximum VM manag
er inactivity
• Parameter: maxVMManagerI
nactivity

Type

Default

Minimum

Maximum

Description
Days

3

1

90

Specifies the maximum time after which a VM man
ager is considered inactive if the server receives no
new data from this VM manager. After that time, the
status of the VM manager changes to Inactive.
Days

• Name: Maximum VM manag
er visibility
• Parameter: maxVMManager

90

1

2147483647

Specifies the number of days after which a VM man
ager is removed from the VM Managers panel if no
data is collected from that VM manager.

Visibility
Number
• Name: Maximum number of
VMware .slmtag files
• Parameter: vmman_slm_

10

1

10

The maximum number of .slmtag files that are
stored on the computer for each license key under
VMware instance.

tags_files_per_software
Number
• Name: Maximum number of
aggregation threads
• Parameter: maxAggregation
Threads

2

1

64

Specifies the maximum number of threads that can
be run during the aggregation. If you increase their
number, performance of aggregation improves.
However, memory usage and database locking in
crease. You should provide two processor cores on
the database server for each thread.
Aggregation algorithm now uses use all log
ical CPUs by default parameter. This number can

Table 154. Server settings (continued)
Name & Parameter

Type

Default

Minimum

Maximum

Description
be controlled using maxAggregationThreads. The
default value of maxAggregationThreads has now
changed to 64 (max). Number of threads can not be
higher than number of logical CPUs on the system,
regardless of the setting.
MS SQL must have the VIEW SERVER STATE per
mission enabled. BigFix Inventory uses MS SQL to
access temadb. Without this permission, the aggre
gation runs single threaded and does not not apply
the maxAeaggregationThreads parameter.

• Name: Maximum number of
import threads
• Parameter: numberOfImport
Threads

Number

0

0

32

Specifies the maximum number of threads that are
used to process capacity scan data and VM manag
er scan data during the import of data from the Big
Fix server.
If the database user configured for BigFix Inventory
can not execute the below queries:
DB2
SELECT min(value) FROM
SYSIBMADM.ENV_SYS_RESOURCES
where upper(name) in
('CPU_TOTAL', 'CPU_ONLINE',
'CPU_CONFIGURED')

MS SQL

Table 154. Server settings (continued)
Name & Parameter

Type

Default

Minimum

Maximum

Description
SELECT cpu_count FROM
sys.dm_os_sys_info

• There is an warning message in tema.log.
Starting from version 10.0.10 there is

•

information in the Data Import logs about the
actual value.
• Number of thread is set to 1.
When the configuration is set to 0, number of
threads is automatically counted as double of cores
reported by above queries, but not more than 32.
Tip: In environments with over 10000 end
points that are running on high-performance
machines, it can be beneficial to increase
the number of threads to speed up the im
port.
• Name: Maximum number of
processed license metric files
• Parameter: maximumNum
berOfLicenseUseMetricFiles
ToProcessPerImport

Number

-1

-1

2147483647

Specifies the maximum number of license metric
tag files that can be processed during an import.
The oldest unprocessed files are processed in the
first place. Then, the specified number of newer files
is consecutively processed with every import. The
value -1 indicates that all files are processed in a sin
gle import.

Table 154. Server settings (continued)
Name & Parameter

Type

reaggregation threads
• Parameter: maxReaggrega
tionThreads

Minimum

Maximum

Description
Number

• Name: Maximum number of

Default

4

1

64

Specifies the maximum number of threads that can
be run during reaggregation. If you increase their
number, performance of reaggregation improves.
However, memory usage and database locking in
crease. You should provide two processor cores on
the database server for each thread.
Reaggregation algorithm now uses use all
logical CPUs by default parameter. This number can
be controlled using maxReaggregationThreads. The
default value of maxReaggregationThreads has now
changed to 64. Number of threads can not be higher
than number of logical CPUs on the system, regard
less of the setting.
MS SQL must have the VIEW SERVER STATE per
mission enabled. BigFix Inventory uses MS SQL to
access temadb. Without this permission, the aggre
gation runs single threaded and does not not apply
the maxReaggregationThreads parameter.
Number

• Name: Maximum number of
rows exported to PDF
• Parameter: pdfReportRow
Limit

100 000

0

2147483647

Specifies the maximum number of rows that can be
exported to a PDF file. If the number of rows in the
report is larger than the specified limit, appropriate
information is provided in the generated PDF file.
Number

100 000

0

2147483647

Table 154. Server settings (continued)
Name & Parameter
• Name: Maximum number of

Type

Default

Minimum

Maximum

Description
Specifies the maximum number of rows to be re

rows in REST API for raw scan trieved in a single request when using REST API for
results
retrieving raw scan results. This parameter applies
• Parameter: raw_data_api_de

only if the REST API limit parameter, which always

fault_limit

takes precedence, is omitted in the request. The de

(removed since BigFix Inven

fault value is 100 000. 0 indicates that all rows are

tory version 10.0.2)

retrieved.

Number
• Name: Maximum number of
rows to select on the Software
Classification report

250000

0

500000

Specifies the maximum number of rows that can be
selected at once on the Software Classification re
port.

• Parameter: selectAllLimit
Bytes
• Name: Maximum size of
VMware .slmtag files

10240

10240

1048676

The maximum size of each .slmtag file that is
used to collect VMware license metric utilization.

• Parameter: vmman_slm_
tags_file_size_limit
Days
• Name: Maximum visibility of
data for inactive computers
• Parameter: max_data_visibili
ty_for_inactive_computers

90

1

1000

Specifies the number of days after which the da
ta from the inactive computer no longer influences
metric calculation and is not visible in BigFix Inven
tory. To enable this feature change the decommis
sion_inactive_computers parameter to true.
Days

90

0

180

Table 154. Server settings (continued)
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• Name: Number of days to

Type

Default

Minimum

Maximum

Description
Specifies the number of days for which data from

count Microsoft Windows

a VM contributes to metric calculation of Microsoft

Server metrics after VM mi

Windows Server after the VM is moved to a differ

gration

ent host. Run an import after you change the value

• Parameter: historical_peri

of this parameter to recalculate the data.

od_for_microsoft_metrics
Days
• Name: Number of days to
keep the removed raw scan
results
• Parameter: raw_data_api_his
tory_keep_days

7

-1

30

Specifies the number of days after which historical
raw scan data is removed from the database. The
data was used to discover software but cannot be
used for this purpose again. It is not displayed on
any reports. It can only be retrieved by using REST
API. The data is no longer needed and can be safely
removed from the database without any impact on
the reports.
Set the value of the parameter to 0 to remove the da
ta after every successful import. You can set it to -1
to never remove the data. However, such a setting is
not recommended as it can generate lots of unnec
essary data that impacts application performance.
Days

0

-1

2147483647

Specifies the number of days after which internal da
ta that is used by the application is removed from

Table 154. Server settings (continued)
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• Name: (Currently not used)

Type

Default

Minimum

Maximum

Description
the database. The data is not displayed on any re

Number of days to keep inter

ports and can be safely removed from the database.

nal application data

Set the value of the parameter to 0 to remove the da

• Parameter: pruning_days_to_
keep

ta after every successful import. You can set it to -1
to never remove the data. However, such a setting is
not recommended as it can generate lots of unnec
essary data that impacts application performance.
Boolean

True

(true/false)
• Name: Optimize migration
from 7.x for large environ
ments

Specifies whether the migration from version 7.x to
9.x is optimized for large environments.

• Parameter: new_migration_
mode_enabled
Integer
• Name: Optimized shared
disks scan: CPU threshold
• Parameter: autoscan_
shared_disks_cpu_threshold

0

0

100

Limits the amount of processor resources that the
scanner consumes during the optimized scan of
shared disks. By default, the option is set to 0 which
means that the limit is disabled.
Boolean

False

(true/false)
• Name: Optimized shared
disks scan: enable
• Parameter: autoscan_
shared_disks_enable

Enables optimized scan of shared disks. When the
option is enabled, scanning of shared disks is au
tomated. As a result, the following actions are per
formed automatically:

Table 154. Server settings (continued)
Name & Parameter

Type

Default

Minimum

Maximum

Description
• Computers are designated to scan shared
disks that exist in your infrastructure
• Software scans are scheduled on the desig
nated computers
• New computers are designated if problems
occur with scanning the initially designated
computers
The option is disabled by default. For more informa
tion, see: Discovering software on shared disks.
Days

• Name: Optimized shared
disks scan: maximum inactivi
ty time
• Parameter: max_inactivity_
of_designated_shared_disk_

14

1

365

Specifies the maximum time after which a computer
that is designated to scan a shared disk and which
already provided scan results is considered inac
tive. After that time, a new computer is automatical
ly designated to scan the shared disk.

scanner
Days
• Name: Optimized shared
disks scan: maximum waiting
time
• Parameter: max_waiting_for_
share_disk_scan_for_new_

7

1

90

Specifies the maximum time to wait for the first re
sults of the shared disk scan performed by a newly
designated computer. If no results are collected for
this period, a new computer is automatically desig
nated to scan the shared disk.

designated_endpoint
Days

7

1

30

Table 154. Server settings (continued)
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• Name: Optimized shared
disks scan: scan interval

Type

Default

Minimum

Maximum

Description
Specifies the frequency of the optimized software
scan on shared disks.

• Parameter: autoscan_
shared_disks_scan_interval_
days
Boolean

False

(true/false)
• Name: Preserve Initiate Soft
ware Scan actions on the Big
Fix server
• Parameter: scanConfig_pre
serve_InitiateScanAction

Specifies whether Initiate Software Scan actions
that are created on the BigFix server are preserved
when the scan configuration is deleted on the Scan
Configurations panel. If you set the value of this pa
rameter to true, the actions are stopped but are not
removed from the BigFix server.
Boolean(true/ False
false)

• Name: Remove information
about current software users
during next import
• Parameter: remove_user_in
formation

Specifies whether information about current soft
ware users is removed during the next import. His
torical aggregation data for Registered User met
ric will also be removed from the All Metrics report.
This option is disabled by default.
Boolean

False

(true/false)
Enables an import that retrieves all software scan
data from the restored BigFix database. Such an im
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• Name: Re-synchronize data

Type

Default

Minimum

Maximum

Description
port is time-consuming and should be run only when

sources after database

problems with incomplete data occur after the data

restoration

base is restored. When you enable the option, the

• Parameter: resynchronize_
datasources_once

import runs once and returns to the normal opera
tion mode.
Integer

• Name: Re-synchronize Scan
Data
• Parameter: resync_imports

0

0

60

Defines the number of consecutive imports during
which scan data is re-synchronized. By default, the
option is set to 0 which means that resync_import is
disabled, and scan data is not re-synchronized. It is
recommended to re-synchronize the data during 7 to
14 imports to optimize the load on the BigFix serv
er. To define the scope of the re-synchronized data,
change the value of the resync_mode parameter.
Resynchronization is needed if you want to display
detailed file version for software components that
were discovered before you upgraded BigFix Inven
tory to version 9.2.11.
Note: This parameter is not used for regu
lar tasks and actions. It is used only to im
port changes when there is a new feature or
patch available. With subsequent <resync_
imports> import, the scanned data is resyn
chronised as per the scope defined in re
sync_mode. During the process, each import
1/<resync_imports> of the compute is ex

Table 154. Server settings (continued)
Name & Parameter

Type

Default

Minimum

Maximum

Description
tended with regular updates coming from
the endpoint itself.
Set the DB2 compatibility vector to MYS to allow the
re-sync functionality work properly.
• Use db2set | grep 'DB2_COMPATIBILITY_VEC
TOR' command to check if the value is correct
ly set. The command should return DB2_COM
PATIBILITY_VECOTR=MYS.
• If the value is not correctly set, use db2set
DB2_COMPATIBILITY_VECTOR=MYS com
mand to set the value.
Enum

• Name: Re-synchronize Scan
Data Mode
• Parameter: resync_mode

File Scan

All Scans Catalog Scan

Only (0)

(1)

Only (2)

Defines the scope of scan data that is re-synchro
nized.
Possible values:
• File Scan Only (0) - Only results of the file sys
tem scan are resynchronized.
• All Scans (1) - Results of the file system scan,
catalog-based scan, and software identifica
tion tags scan are re-synchronized.
• Catalog Scan Only (2) - Results of the CIT
scans are re-synchronized.

Table 154. Server settings (continued)
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Notice:

This parame

ter has been removed.

Type

Default

Minimum

Maximum

Description
Enum

Never (0)

Specifies how often unrecognized scan data is cal
culated. The data allows for determining the most
effective ways of improving signature coverage, but
slows down imports, particularly in larger deploy

• Name: Recompute unrecog
nized scan data aggregates

ments. The aggregated data is visible on the Unrec
ognized Files report.

• Parameter: recompute_unrec Possible values:
ognized_scan_data
• Never (0) - Scan data aggregates are not cal
culated.
• Next Import Only (1) - Scan data aggregates
are calculated only during the next import.
Then, the value of the parameter changes to
Never (0).
• Every Import (2) - Scan data aggregates are
calculated during every import.
• Name:Reporting Missing Scan Days
status

30

1

365

Specifies the number of days from the last software

Previously: Software scan in

scan after which the computer is reported on the

terval

Software Scan Health widget as missing software

• Parameter: scanHealthLastS scan.
canAttempt
• Name: Scan files import wait
ing time
• Parameter: scanFilesDown
loadImportTimeout

Seconds

10

1

600

Table 154. Server settings (continued)
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Type

Default

Minimum

Maximum

Description
Specifies the maximum number of seconds to wait
for a file with scan results to be read from the BigFix
server during import.
String

%VENDOR
%TYPE

• Name: Server ID template for
managed hosts
• Parameter: managedServer
TagTemplate

%HOSTNAME

Specifies the format of information about VM man
ager hosts that is displayed in the Server ID column
on the reports. The parameter affects hosts from
which data is collected by the VM Manager tool or
by the Run Capacity Scan on Virtualization Hosts
fixlet.
By default, the column contains information about
the vendor, type and host name of the VM manag
er host. For example: IBM NC123456.IBM.COM. You
can choose any combination of the following char
acteristics of a VM manager host to be displayed on
the reports:
• Host name (REST API value: %HOSTNAME)
Important: To display this information
for hosts from which data is collected
by the Run Capacity Scan on Virtual
ization Hosts fixlet, you must first en
able the collection of host names. To
do this, select the Collect host names
of virtualization hosts check box in
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Type

Default

Minimum

Maximum

Description
the fixlet. Otherwise, a serial number is
displayed instead of the host name for
such VM manager hosts.
• Identifier (REST API value: %ID)
• Model (REST API value: %MODEL)
• Serial number (REST API value: %SERIAL_NUMBER)

Important: To display this information
for hosts from which data is collected
by the VM Manager tool, you must first
enable the collection of serial num
bers. To do this, set the value of the
vmman_collecting_host_serials_en
abled parameter to true.
• Type (REST API value: %TYPE)
• Vendor (REST API value: %VENDOR)
Note: Information is displayed in the new
format after the next import.
To change the format of information through REST
API, list the characteristics of the VM manager host
that you want to display in the value parameter. The
value must be URL-encoded. For example:
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Type

Default

Minimum

Maximum

Description
PUT
http://localhost:9081/api/sam/configs?tok
en=
7adc3efb175e2bc0f4484bdd2efca54a8fa&name=m
anagedServer
TagTemplate&value=%25VENDOR%20%25TYPE%20%2
5SERIAL_NUMBER

String

%VENDOR
%TYPE

• Name: Server ID template for

%SERIAL_-

unmanaged hosts
• Parameter: standalone
ServerTagTemplate

NUMBER

Specifies the format of information about the host
that is displayed in the Server ID column on the re
ports. The parameter affects hosts that are not af
fected by the managedServerTagTemplate parame
ter.
By default, the column contains information about
the vendor, type and serial number of the host. For
example: IBM Corp. 7946 99B7166. You can choose
any combination of the following characteristics of a
host to be displayed on the reports:
• Identifier (REST API value: %ID)
• Model (REST API value: %MODEL)
• Serial number (REST API value: %SERIAL_NUMBER)

Table 154. Server settings (continued)
Name & Parameter

Type

Default

Minimum

Maximum

Description
• Type (REST API value: %TYPE)
• Vendor (REST API value: %VENDOR)
Note: Information is displayed in the new
format after the next import.
To change the format of information via REST API,
list the characteristics of the host that you want to
display in the value parameter. The value must be
URL-encoded. For example:
PUT http://localhost:9081/api/sam/configs?
token=7adc3efb175e2bc0f4484bdd2efca54a8fa
&name=standaloneServerTagTemplate&value
=%25VENDOR%20%25MODEL%20%25SERIAL_NUMBER

MB
• Name: Size limit of Scan File
to process
• Parameter: scanFileSizeLimit

20

0

100

Specifies the maximum size of the scan file that can
be processed by BigFix Inventory. Files that exceed
the limit are rejected. When you set the parameter
to 0, the limit is disabled and all files are process re
gardless of their size.

• Name: Sort bundling options
alphabetically
• Parameter: blockUiBundling
Computations

Boolean

False

(true/false)
Specifies whether bundling options that are dis
played when you reassign a software component
are sorted by confidence or alphabetically. By de
fault, the options are sorted by confidence. If you set

Table 154. Server settings (continued)
Name & Parameter

Type

Default

Minimum

Maximum

Description
the value of the parameter to true, the options are
sorted alphabetically and thus are displayed more
quickly on the user interface.
Boolean

False

(true/false)
• Name: Split SQL query for in
serting software facts
• Parameter: split_ms_merge

Important: Use this parameter only when
you are requested by HCL Support.
Splits the SQL query that is used for inserting soft
ware facts into multiple queries to reduce usage of
TEMPDB in a large-scale environment. Splitting the
query lengthens the import. The parameter is applic
able only on Windows.

• Name: Store hardware data
for VM manager nodes
• Parameter: storeHwDataFor
AllVMManagerNodes

Boolean

False

(true/false)
Specifies whether information about nodes and
clusters that is retrieved from VM managers is
stored in the database, regardless of whether an
agent is running on any virtual machine on such
nodes or clusters.
Boolean

True

(true/false)
• Name: The default value of
the Automatically confirm the
affected components check

Specifies the default value of the Automatically con
firm the affected components check box on the
Software Classification. If the parameter is set to

Table 154. Server settings (continued)
Name & Parameter

Type

Default

Minimum

Maximum

Description

box on the Software Classifi

true, the check box is selected by default and com

cation panel

ponents affected by an action are confirmed. Other

• Parameter: automaticConfirm wise, affected component are not confirmed.
Boolean

True

(true/false)
• Name: To Do: Show that VM
manager connection is miss
ing
• Parameter: todo_display_
vm_managers_need

Specifies whether the To Do List shows information
about missing connections to VM managers. By de
fault, the parameter is set to true which means that
the item is displayed.
Integer

• Name: User password: maxi
mal number of characters
• Parameter: user_password_

0

0

1024

Specifies the maximum length of the user pass
word. By default, the parameter is set to 0 which
means that the requirement is disabled.

max_length
Number
• Name: User password: maxi
mal number of the same char
acters in a row
• Parameter: user_password_

0

0

32

Specifies the maximum number of the same charac
ters that can be used in a row in the user password.
By default, the parameter is set to 0 which means
that the requirement is disabled.

max_of_identical_character
s_in_row
Number

8

0

128

Specifies the minimum length of the user password.
Set the value to 0 to disable the requirement.

Table 154. Server settings (continued)
Name & Parameter

Type

Default

Minimum

Maximum

Description

• Name: User password: mini
mal number of characters
• Parameter: user_password_
min_length
Regular Ex

^(?=.*[a-

pression

z])(?

• Name: User password: regular

=.*[A-Z])

expression

(?=.*\d).

• Parameter: user_password_
regular_expression

+$

Specifies the regular expression that must be
matched by the user password. By default, the pass
word must contain at least one uppercase character,
one lowercase character, and one digit. Set the value
to an empty string to disable this requirement.
String

• Name: User password: re
quired special characters
• Parameter: user_password_
special_characters

0

Specifies the list of special characters from which at
least one must be used in the user password. By de
fault, no special characters are required.
Note: Provide the characters one after an
other without any separators. For example:
?!&%. If you add a space, it is also treated as

a special character.
Boolean
(true/false)

True

Table 154. Server settings (continued)
Name & Parameter
• Name: Validate VM manager
data
• Parameter: validateVMMan

Type

Default

Minimum

Maximum

Description
Specifies whether the XML schema of files with VM
manager data is validated by the BigFix Inventory
server.

agersData

Settings of the main VM Manager tool
The following parameters can be configured from the server only if you are using
basic VM management. If you are using advanced VM management, you must edit the
vmmmainconf.properties configuration file to change the parameters. For more
information about changing the settings of an additional VM Manager tool, see: VM
Manager Tool settings.
Table 155. Settings of the main VM Manager tool
Name & Parameter

Type

Default

Minimum

Maximum

Description
Boolean

True

(true/
• Name: Allow VM manager HTTP false)
connection fallback
Allows the VM manager to connect by using the
• Parameter: vmman_http_con
HTTP protocol when the defined HTTPS connec
nection_allowed
tion is not available.
Boolean

False

(true/
• Name: Attempt to fix VM man
ager connection parameters
• Parameter: vmman_fix_parame
ters_enabled

false)
Attempts to fix the most common problems with
VM manager connection parameters, such as

Table 155. Settings of the main VM Manager tool (continued)
Name & Parameter

Type

Default

Minimum

Maximum

Description
adding default URL suffix, correcting the user
name format, and testing the WinRM and Power
Shell protocols for Hyper-V VM managers.

• Name: Check VM managers for
uniqueness
• Parameter: vmman_check_u
niqueness_enabled

Boolean

False

(true/
false)
Specifies whether unique VM managers are distin
guished from duplicates.
Boolean

False

(true/
• Name: Collect serial numbers of false)
VM manager hosts
Specifies whether serial numbers of VM manager
• Parameter: vmman_collecting_
hosts are collected for VM managers from which
host_serials_enabled
data is collected by the VM Manager tool. Avail
able for Hyper-V and VMware 5.0 and higher.
To display information about serial numbers in the
Server ID column on the reports, adjust the Serv
er ID template that is specified by the managed
ServerTagTemplate parameter.
Boolean

False

(true/
• Name: Collect virtual machines
host names
• Parameter: vmman_collecting_
hostnames_enabled

false)
Specifies whether host names of virtual machines
are collected by the VM Manager tool and saved
in its log files. Available for VMware only.

Table 155. Settings of the main VM Manager tool (continued)
Name & Parameter

Type

Default

Minimum

Maximum

Description
You can enable this parameter to solve problems
with duplicated UUIDs. If duplicates are found, the
host names are written in the log files.

• Name: Filter VM manager UUIDs Boolean
• Parameter: vmman_uuid_filter
ing_enabled

False

(true/
false)
Enables UUID filtering of VM managers. For more
information, see: UUID-based virtual machine fil
tering.

• Name: Maximum number of
subsequent login failures
• Parameter: vmman_max_subse
quent_login_failures

Number

3

0

100

Specifies the maximum number of failed attempts
of logging in to the VM manager.
Boolean

True

(true/
• Name: Transfer VM manager
credentials
• Parameter: vmman_transfer_
credentials_to_server

false)
Specifies whether VM manager credentials are
transferred to the server. The option is enabled by
default. If you disable the option, the credentials
are not transferred and thus they are not displayed
on the VM Managers panel when you edit the VM
manager.
Boolean
(true/
false)

True

Table 155. Settings of the main VM Manager tool (continued)
Name & Parameter
• Name: Trust SSL certificates

Type

Default

Minimum

Maximum

Description
Specifies whether SSL certificates from all de

from all defined VM managers

fined VM managers are trusted. If the option is

• Parameter: vmman_trust_all_

disabled, certificates that are trusted must be

vm_managers_certificates

placed in the truststore on the computer where
the VM Manager Tool is installed. For more infor
mation, see: Configuring VM Manager tool to ac
cept trusted VM manager certificates.

• Name: VM manager connection

Seconds

90

10

timeout
• Parameter: vmman_connec
tion_time_out
• Name: VM manager data trans

hour)
Specifies the time after which the connection with
a VM manager is ended.
Minutes

720

30

fer period
• Parameter: vmman_transfer_
period

3600 (1

10080 (1
week)

Determines how often scan data is transferred to
the agent to be uploaded to the server if subse
quent scans have the same results.

• Name: VM manager pooling in

Minutes

30

30

terval
• Parameter: vmman_pooling_
time_interval

10080 (1
week)

Specifies the interval between the consecutive re
trievals of data from VM managers.
Restriction: In case of subcapacity re
porting, it is necessary to capture mobility
of VMs. To ensure that it is captured, da
ta from VM managers must be collected
every 30 minutes. You can change the fre

Table 155. Settings of the main VM Manager tool (continued)
Name & Parameter

Type

Default

Minimum

Maximum

Description
quency of collecting data only if you use
BigFix Inventory for purposes other than
subcapacity reporting.

• Name: VM manager thread pool
size
• Parameter: vmman_thread_
pool_size

Number

10

1

50

Specifies the number of threads in the thread pool
that is used for connections to VM managers.

Administering the database
Perform administering tasks on your database to keep it in good condition, protect your
data, or configure additional settings.

Backing up and restoring the database
Perform regular backups of the data that is stored in the database, and restore it when
needed to prevent data loss.
To maintain data consistency during data recovery, it is recommended to perform backup
at least once per week. When you plan regular backups, you must consider the dynamics
of your environment, for example, infrastructure changes and software installations.
It is a good practice to back up the database before you update the software catalog,
upgrade the server, or introduce significant changes to the middleware or the operating
system. The number of backups that you keep depends on the storage space available.
It is recommended to ensure that the backup that you store allows the restoration of your
environment to the last functional state. Thus, if you introduce several consecutive changes
in the application, the database, or the operating system, ensure that you perform backup
after each of those change.

Consider the start time and duration of the import when you plan the backup schedule to
avoid performance impact on the data import.

Backing up the DB2® database
You should back up the database on a regular basis to protect your data. Each backup is the
copy of the entire database that can be restored in the case of corruption or malfunction.
• Users
To perform the backup, log in as the database instance owner.
• Space requirements
Ensure that enough storage space is available in the target directory. The backup
file size depends on the number of computers that report to BigFix Inventory, and
the amount of historical data that is stored in the database. Therefore, you cannot
estimate the exact size of the backup file.
The backup file size can reach:
◦ 2GB or more in the environments that consist of less than 100 computers.
◦ 50GB for 30000 computers.
◦ 75GB for 100000 computers.
You can use compression to significantly reduce the backup size.

Related information
DB2 data recovery

Creating offline backups
You should back up the database on a regular basis to protect your data. Each backup is the
copy of the entire database that can be restored in the case of corruption or malfunction.
Choose offline backups if you can afford to deactivate the database during each backup.
During an offline backup, the entire database is copied to a file. Since the database must
be deactivated during each backup (no active transactions), the backup file contains all

transactions performed on the database so far. Therefore, the backup file is not dependent
on transaction logs, and the database can use the default circular logging, in which
transaction logs are overwritten with new transactions, which saves the disk space. To
restore the database, you only need the backup file.
1. Stop the BigFix Inventory server.
2. Terminate the connections and deactivate the database.
Note: TEMADB is the default database name. If you are unsure whether it
applies to your database, see: Checking the database name.

db2 terminate
db2 deactivate db TEMADB

DB20000I

The TERMINATE command completed successfully.

DB20000I

The DEACTIVATE DATABASE command completed successfully.

3. Make a full offline backup. The entire database is copied to a backup file in the
specified location.
db2 backup database TEMADB to <location>

Backup successful. The timestamp for this backup image is :
xxxxxxxxxxxx

4. Verify that the backup file was correctly created.
db2ckbkp <backup file>

Image Verification Complete - successful.

5. Activate the database and restart the BigFix Inventory server to restore its connection
to the database.
db2 activate db TEMADB
/etc/init.d/BFIserver restart

6. If DB2 is shared with the BigFix server, restart the BigFix server to restore its
connection to the database.
For more information, see: Starting and stopping the BigFix server.

Creating online backups
Choose online backups if you back up your database frequently and cannot afford to
deactivate it for each backup. Online backups allow you to maintain all connections to the
database, but they require more disk space to store the history of transaction logs.
During an online backup, the entire database is copied to a file, but it might not contain
transactions that were being performed on the database while the backup was being
created. Therefore, the backup file must always be complemented with transaction logs to
restore the database to the consistent state. Transaction logs are backed up automatically
after enabling archive logging, and must always be stored in a safe location together with
the backup file. After you restore the database from the backup file, you add the archive
logs, and the database is complete. Enabling the archive logging for the first time requires
that you deactivate the database.
1. Set up archive logging.
Note: TEMADB is the default database name. If you are unsure whether it
applies to your database, see: Checking the database name.
a. Check the status of archive logging in your database. If the first archive method
contains a value other than OFF, you can omit the following steps and make an
online backup.
db2 get db cfg for TEMADB | grep LOGARCHMETH

First log archive method

(LOGARCHMETH1) = OFF

Second log archive method

(LOGARCHMETH2) = OFF

b. Create a backup directory that will be used to store archive logs and online
backups, and give it proper permissions.

mkdir /var/online_backup
chown db2inst1:db2iadm1 /var/online_backup

c. Update the database configuration to enable archive logging and point to the
new directory.
db2 update database configuration for TEMADB using LOGARCHMETH1
'disk:/var/online_backup'

DB20000I

The UPDATE DATABASE CONFIGURATION command completed

successfully.

The status of archive logging settings also changed to a specific path:
First log archive method

(LOGARCHMETH1) =

DISK:/var/online_backup/

d. Terminate the connections and deactivate the database.
db2 force application all
db2 deactivate db TEMADB

e. Make a full offline backup.
db2 backup database TEMADB to <location>

Creating an offline backup is a requirement after enabling the archive logging.
Although you will not need to create offline backups later, it is a good practice
to create them before major changes to the database. The archive logs can be
applied in the same way both to offline and online backups to restore them to
the most recent state. You can store this offline backup in a safe location as an
extra precaution.
f. Activate the database and restart the BigFix Inventory server to restore its
connection to the database.

db2 activate db TEMADB
/etc/init.d/BFIserver restart

g. If DB2 is shared with the BigFix server, restart the BigFix server to restore its
connection to the database.
For more information, see: Starting and stopping the BigFix server.
2. Make an online backup.
db2 backup database TEMADB online to /var/online_backup/ compress
include logs

Backup successful. The timestamp for this backup image is :
xxxxxxxxxxxx

Whenever you create an online backup, all archive logs created up to this point
are no longer needed. To restore a complete database, you need a backup file and
subsequent archive logs.
3. Verify that the backup file was correctly created.
db2ckbkp <online backup file>

Image Verification Complete - successful.

Restoring the DB2® database
If your database has been corrupted or you want to revert some changes, you can restore it
to its previous state from one of the backup files. Depending on the backup procedure that
you chose, use either offline or online backup files. In the latter case, you must also restore
the archive logs to make the database consistent.

Restoring database from offline backup files
An offline backup file is the copy of the entire database and all transactions performed on
it at the time when the backup was created. To restore the database, you only need this
backup file.

1. Terminate the connections and deactivate the database.
Note: TEMADB is the default database name. If you are unsure whether it
applies to your database, see: Checking the database name.

db2 terminate
db2 deactivate db TEMADB

2. Restore the database from the offline backup file.
db2 restore db TEMADB from <location> taken at <timestamp> replace
existing

3. Upload the software catalog to avoid problems with the data import. At this point,
there might be some discrepancies between the server and the contents of the
database, which will be resolved after the upload.

Restoring database from online backup files
An online backup file is also the copy of the entire database, but it might not include
transactions that were being performed on the database while the backup was being
created. Therefore, the backup file must be complemented with archive logs that contain
the latest transactions. By choosing the right archive logs, you can either restore the
database to the most recent state, or to one of the previous states.

Restoring to the most recent state
To restore the database to the most recent state, use one of your online backup files
(preferably, the most recent one), and then apply to it all subsequent archive logs. If you
store all archive logs in one directory, the correct ones will be applied automatically.
1. Terminate the connections and deactivate the database.
Note: TEMADB is the default database name. If you are unsure whether it
applies to your database, see: Checking the database name.

db2 terminate
db2 deactivate db TEMADB

2. Restore the database from the online backup file.
db2 restore database TEMADB from <location> taken at <timestamp>
replace existing

3. Restore all archive logs that were saved after the backup file was created.
db2 rollforward db TEMADB to end of logs and stop log path
(/var/archive_logs)

4. Activate the database and restart the BigFix Inventory server to restore its connection
to the database.
db2 activate db TEMADB
/etc/init.d/BFIserver restart

5. Upload the software catalog to avoid problems with the data import. At this point,
there might be some discrepancies between the server and the contents of the
database, which will be resolved after the upload.

Restoring to one of the previous states
You can also restore the database to one of the previous states to avoid all subsequent
transactions that might have corrupted it. In such a case, you do not apply all archive logs
that you store, but only those that are bundled in the backup file. These bundled logs include
only transactions from the exact state when the backup was created. You can extract them
from the backup file.
1. Terminate the connections and deactivate the database.
Note: TEMADB is the default database name. If you are unsure whether it
applies to your database, see: Checking the database name.

db2 terminate
db2 deactivate db TEMADB

2. Extract the transaction logs from the online backup file. This step is required, because
you will not be able to activate the database unless some logs are applied to it.
db2 restore database TEMADB logs from <online backup file>
LOGTARGET /var/extracted_logs/

Note: Ensure that the location for the extracted log files is different from the
one in which you store all other archive logs.
3. Restore the database from the online backup file.
db2 restore database TEMADB from <location> taken at <timestamp>
replace existing

4. Apply the extracted archive logs.
db2 rollforward database TEMADB to end of logs overflow log path
(/var/extracted_logs/)

5. Activate the database and restart the BigFix Inventory server to restore its connection
to the database.
db2 activate db TEMADB
/etc/init.d/BFIserver restart

6. Upload the software catalog to avoid problems with the data import. At this point,
there might be some discrepancies between the server and the contents of the
database, which will be resolved after the upload.

Backing up the SQL Server database
You can make a copy of your database by saving it to a backup file. If you want, you can
then move the backup to another computer and restore it in a different BigFix Inventory
instance.

• You can back up and restore the database only within one version of BigFix Inventory.
• BigFix Inventory and Microsoft™ SQL Server Management Studio must be installed.
• Ensure that enough storage space is available in the target directory. The backup
file size depends on the number of computers that report to BigFix Inventory, and
the amount of historical data that is stored in the database. Therefore, you cannot
estimate the exact size of the backup file. In small environments the backup file
size starts at 1GB, and for 30000 computers the file reaches 40 GB. You can use
compression to significantly reduce the backup file size.
1. Log in to the computer that hosts the database that you want to back up.
2. Open Microsoft™ SQL Server Management Studio.
3. In the left navigation bar, expand Databases.
4. Right-click on the database that you want to back up and then click Tasks > Back Up.
Note: TEMADB is the default database name. If you are unsure whether it
applies to your database, see: Checking the database name.

5. Review the details of the backup and then click OK to create the backup.

6. Click OK.
If the database was backed up successfully, you can find the bak file in the location that you
specified in step 5.
If you want to move the database to a different BigFix Inventory instance, copy the backup
file to the target computer and then restore the database.

Restoring the SQL Server database
If you encounter any problems with your database or if you want to move it between
different instances of BigFix Inventory, you can use a backup file to restore the database.

• You can back up and restore the database only within one version of BigFix Inventory.
• Ensure that you are logged in to Microsoft™ SQL Server Management Studio as the
user who created the temadb database. If you log in as a different user, the restoring
will fail.
• BigFix Inventory and Microsoft™ SQL Server Management Studio must be installed.
• Stop the BFIserver service. Open the command prompt and run net stop
BFIserver.

1. Log in to the computer on which you want to restore the database.
2. Open Microsoft™ SQL Server Management Studio.
3. In the left navigation bar, right-click on Databases and then click Restore Database.

4. In the Source section, select Device and click the button with three dots.

5. In the pop up window that opens, click Add and browse for your backup file. Click OK.

6. In the left navigation menu, click Options.
7. In the pane on the right select Overwrite the existing database (WITH REPLACE) and
Close existing connections to destination database.

8. Click OK.
Upload the software catalog to avoid problems with the data import. At this point, there
might be some discrepancies between the server and the contents of the database, which
will be resolved after the upload.

Creating a new database
To create a new database without reinstalling BigFix Inventory, you must modify the
configuration file that stores information about the database. After you do so, you will be
able to complete the initial configuration again, and create a new database.
1. Stop the BigFix Inventory server.
2. Delete the current database.
Note: TEMADB is the default database name. If you are unsure whether it
applies to your database, see: Checking the database name.

DB2:
a. Log in as the DB2 instance owner, which by default is db2inst1.
b. Run the following command to check the details of the existing database.
db2 list db directory

c. Run the following commands to close the existing connections, deactivate the
database, and delete it.
db2 deactivate db TEMADB
db2 drop db TEMADB

SQL Server:
a. Log in to SQL Server Management Studio.
b. In the navigation tree, expand Databases.
c. Right-click on the TEMADB database, and then click Delete.
3. Go to installation_dir/wlp/usr/servers/server1/config/, and
rename the database.yml file to database.yml.bak. This step resets the initial
configuration and allows you to create a new database. You will also have to create a
new administrative user and specify connections to the BigFix platform.
4. Start the BigFix Inventory server.
5. Go to https://hostname:port/setup/database to perform the initial
configuration and create a new database. For more information, see: Performing initial
configuration on Windows or Performing initial configuration on Linux.
6. After the configuration is completed, upload the software catalog to avoid problems
with the data import. At this point, there might be some discrepancies between the
server and the contents of the database, which will be resolved after the upload.

Reinstalling BigFix Inventory with an existing database
You can reinstall BigFix Inventory and connect it to an existing database. This allows you to
preserve all the data collected so far and avoid changing configuration settings.

1. Back up the following files from the BigFix Inventory installation directory.
installation_dir/wlp/usr/servers/server1/logs/imports/
installation_dir/wlp/usr/servers/server1/data/sam/
installation_dir/wlp/usr/servers/server1/apps/tema.war/WEB-INF/
domains/sam/config/file_names*.txt
2. Uninstall the BigFix Inventory server. For more information, see: Uninstalling on
Windows or Uninstalling on Linux.
3. Install the BigFix Inventory server. For more information, see: Installing the server on
Windows or Installing the server on Linux.
4. Before you complete the initial configuration, copy the files that you backed up in step
1 into the new installation directory.
5. Perform the initial configuration and point to the existing database instance. It
is enough to specify the right host name and leave the same database name.
BigFix Inventory will connect to your existing database. For more information, see:
Performing initial configuration on Windows or Performing initial configuration on
Linux.
6. Upload the software catalog to avoid problems with the data import. At this point,
there might be some discrepancies between the server and the contents of the
database, which will be resolved after the upload.

Moving the BigFix Inventory database
To move the BigFix Inventory database to a different computer, back up the database,
move it to the target computer, and point to that computer in the server.xml and
database.yml files.
1. Stop the BigFix Inventory server.
2. Back up the BigFix Inventory database.
• Backing up the DB2 database.
• Backing up the SQL Server database.
3. Move the database to the target computer and make it operational.
4. Back up the following files from the installation directory of the BigFix Inventory
server.

• installation_directory/wlp/usr/servers/server1/server.xml
• installation_directory/wlp/usr/servers/server1/config/
database.yml
5. Update the database location in the server.xml file. Provide the IP address or
domain name of the computer on which the database is located.
• DB2 database

<properties.db2.jcc
password="{aes}xxxxXXXXxxxxXXXXxxxxXXXXxxxxXXXXxxxxXXXX"
user="db2inst1"
serverName="localhost"
databaseName="temadb"/>

• MSSQL database

<properties.microsoft.sqlserver
password="{aes}xxxxXXXXxxxxXXXXxxxxXXXXxxxxXXXXxxxxXXXX"
user="sa"
serverName="localhost"
databaseName="temadb"/>

6. Update the database location in the database.yml file. Provide the IP address or
domain name of the computer on which the database is located.
host: localhost
database: temadb
database_type: mssql
windows_authenticated: true

7. Start the BigFix Inventory server.

Updating the database password
You can update the database user password when needed, for example if the password is
changed and users cannot log in to BigFix Inventory.

Before you can run the security utility you must set the JAVA_HOME environment variable,
for example export JAVA_HOME=install_dir/jre/jre.
Important: Create a backup of server.xml and database.yml files before you make
any change.
For information about changing the DB2 database password, see: Maintaining passwords
on servers. For information about changing the SQL Server password, see the SQL Server
Login Password Expiration.
1. Log in to the computer where BigFix Inventory is installed.
2. Run the following command and enter the new password for the database user.
install_dir/wlp/bin/securityUtility encode

The password is returned as an encrypted string.
Note: If you use AES encryption, add the following parameter to the command
above: --encoding=aes.
3. Edit the following configuration files, and enter the new encrypted password.
• install_dir/wlp/usr/servers/server1/server.xml
Search the database entry "properties.db2.jcc" for DB2 and
"properties.microsoft.sqlserver" for SQL Server and then change the password
for the database entry.
Copy the new encrypted password to the password attribute, for example:
◦ In case of 'xor' encoding : password="{xor}fgspGzAWPTApFzk="
◦ In case of 'aes' encoding : password="{aes}fgspGzAWPTApFzk="
• install_dir/wlp/usr/servers/server1/config/database.yml
Copy the new encrypted password to the encrypted_password parameter.
4. If you use the same user for the BigFix database, you must also enter the new
password in the following locations.

• Update the database password in the BigFix server. For more information, see:
Changing the database password.
• In BigFix Inventory, go to Management > Data Sources. Enter the unencrypted
password for the database user and click Save.
5. Restart BigFix Inventory server.
a. Stop the BigFix Inventory server.
b. Start the BigFix Inventory server.

Related information
Starting the server

Removing inactive computers
When you decommission a computer in your infrastructure, it continues to report to BigFix
Inventory. The data is still collected from this computer, and displayed on the metric reports.
To ensure that all infrastructure changes are reflected in BigFix Inventory, you should
remove each decommissioned computer from BigFix. If you cannot remove this computer
from BigFix for a valid reason, you can use an alternative solution, and decommission the
computer in BigFix Inventory.

Removing inactive computers from BigFix
When you decommission a computer in your infrastructure, you need to remove this
computer from BigFix to reflect the change in the BigFix Inventory reports.
The computer that is decommissioned in your infrastructure continues to report to BigFix
Inventory. The software is listed in the metric reports, and included in license calculation. To
make sure that the components that are installed on this computer are not counted, remove
the computer from BigFix.

1. Remove the decommissioned computers from the database.
• Log in to BigFix console. To remove the computers manually, follow the
Removing Computers from the database instruction.
• To automatically detect, and remove the inactive computers from the database,
use the BigFix Administration Tool. For more information, see: Removing
computers with BES Computer Remover and BES Computer Remover utility.
2. Run a data import.
The computer that you removed from the database is no longer listed in the Computers
report. The metric reports that are generated for the period before the removal, still list
the software that was installed on the computer. The reports that collect the data for the
period after the computer was removed, do not include the software that was installed on
the computer.

Automatically decommissioning inactive computers
Available from 9.2.8. When infrastructure management policy does not allow
the deletion of decommissioned BigFix clients in BigFix, you can enable automatic
decommissioning of inactive computers directly in BigFix Inventory. By decommissioning
the inactive computers you ensure that they do not have negative impact on metric
calculation.
Important: To ensure consistency between the BigFix platform and the BigFix
applications, it is recommended to manage the entire infrastructure in BigFix.
Decommissioning computers in BigFix Inventory is an alternative solution allowed
only when decommissioning in BigFix is not possible.
If a computer stops reporting to BigFix, it is considered inactive. Configure BigFix Inventory
to automatically decommission computers that are inactive for a specified period.
Note: This solution is not supported on the computers with disconnected scanner.
For more information, see: Decommissioning computers with disconnected
scanners.

1. Log in to BigFix Inventory.
2. Go to Management > Advanced Server Settings.
3. To enable the feature, set the decommission_inactive_computers parameter to true,
and click Save.
4. To set the inactivity period after which the computers are
automatically decommissioned, configure the value of
max_data_visibility_for_inactive_computers parameter to the required number

of days, and click Save. By default, the inactivity period is set to 90 days.
The reports display only the data for the period before the date when the computer was
decommissioned.
Note: When a decommissioned computer reactivates and starts reporting back to
BigFix, the report data is updated.
To disable automatic decommissioning of inactive computers, go to Advanced Server
Settings, select the decommission_inactive_computers parameter, and set it to False.

Managing data sources
Computers in an organization can be divided into organizational units, and can be
monitored by multiple BigFix infrastructures. Each infrastructure is referred to as a data
source. Data from multiple data sources can be imported to one instance of BigFix
Inventory.
Definition of a data source
A data source can be viewed as a BigFix server and the clients that report
to that server. Thus, a data source is the infrastructure from which BigFix
Inventory imports the scan data. Organizations can define multiple data
sources that mirror various types of organizational units such as departments
or countries in which the organizations have their branches.
A disconnected data source is specific for environments that are monitored by
disconnected scanners. It can be defined as a directory on the BigFix Inventory

server that provides the scan data during the import. The disconnected data
source cannot be the only data source that is set up in BigFix Inventory.

Hardware requirements
Sum up the number of the BigFix clients that report to BigFix Inventory from all
data sources, and ensure that the computer where BigFix Inventory is installed
meets the hardware requirements specific to the environment size. You can
designate a physical server or virtual machine that is capable of handling large
data imports (ETL) and has the capability to process a large amount of data.
For more information, see:
• BigFix Inventory hardware requirements.
• Tuning performance
Import of data from multiple data sources
During the import of data to BigFix Inventory, connectivity to all data sources
is checked. If any of the data sources is not reachable, the entire import fails.
Ensure that all data sources are reachable during the import.

Adding a data source
To collect data from multiple BigFix infrastructures and report it to a single instance of
BigFix Inventory, add multiple data sources to BigFix Inventory.
1. In the top navigation bar, click Management > Data Sources, and then click New.
2. Provide a unique name for the data source.
3. To automatically enable scans that collect data from the computers in your
infrastructure, select Enable default scan schedule for this data source.
If you enable the default scan schedule, actions that are needed to collect data from
the computers in your infrastructure are automatically started on the BigFix server.
This option is advised for environments with up to a few thousand computers. For
larger environments, divide the computers into groups, and then manually set up scan
schedule for each group to avoid performance issues. For more information about
the default and manual scan schedule, see: Setting up scans to discover software and
hardware inventory.
4. Select the database type.
• If you choose DB2, specify the host, port, database name, and credentials of the
user that can access the BigFix server database. See Installation accounts.
• If you choose SQL Server, specify the host, database name, and credentials of
the user that can access the BigFix server database. See Installation accounts.
• If you choose Disconnected data source, see: Adding a disconnected data
source.
5. Provide credentials of the Console Operator that you created while installing BigFix
(by default, IEMAdmin).
6. Optional: If the BigFix and BigFix Inventory servers are in separated networks, the
automatic address lookup might return incorrect address. To disable the lookup,
select Disable automatic address lookup, and specify the address manually. Then,
configure additional environment variables on the BigFix Inventory server. For more
information, see Configuring servers in separate networks.
7. Optional: You can additionally configure connection between your BigFix Inventory
data source and the Web Reports database to allow the Web Reports users to
access BigFix Inventory. Specify the database type, host name, database name, and

credentials of the Web Reports database user. For more information, see: Integrating
users with Web Reports.
8. Click Create.

Editing a data source
If you move the BigFix database to a different computer, or change credentials of the
Console Operator that is used for connecting with BigFix, edit the parameters to maintain
data source connectivity.
1. In the top navigation bar, click Management > Data Sources.
2. Click the data source that you want to edit, and change connection parameters.
• To edit connection parameters to the BigFix database, edit fields in the first
column.
• To edit credentials of the Console Operator that is used for connecting with
BigFix, edit fields in the second column.
• To edit connection parameters to the Web Reports database, edit fields in the
last column.
3. During editing, passwords for the BigFix database, Console Operator, and the Web
Reports database are cleared. Re-enter the passwords, and click Save.

Deleting a data source
If you no longer want to import data from a particular BigFix infrastructure to BigFix
Inventory, remove this data source.
1. In the top navigation bar, click Management > Data Sources.
2. Click the data source that you want to delete, and click Delete.
3. Run the data import to refresh the reports.
Data for computers that reported to this data source is deleted from BigFix Inventory.
Note: It is mandatory to run the data import before you continue to use BigFix
Inventory.

Lowering user permissions for BigFix Platform database access
The permission of database users may be lowered to allow them to access the BigFix
Platform database. Users with lower permission than those with permission to configure
BigFix Inventory Data Source can perform data imports. It might be required due to security
policies for database accounts. See Installation accounts.

Importing software scan data
The inventory results are stored on your BigFix server. To import software scan data, the
software catalog and other settings that changed since the last update, you must extract
the data from BigFix server and load it into BigFix Inventory.
You must have the Manage Imports permission to perform this task.
The import of data is an Extract, Transform, Load (ETL) process.
• During the Extract stage, data is extracted from the BigFix server. It includes
information about the infrastructure, installed clients, and detected software. ETL also
checks whether a new software catalog is available, gathers information about the
software scan and files that are present on the computers. It also collects data from
VM managers.
• During the Transform stage, the extracted data is transformed to a single format that
can be loaded to the BigFix Inventory database. This stage also involves matching
scan data with the software catalog, calculating processor value units (PVUs),
processing the capacity scan, and converting information that is contained in the XML
files.
• During the Load stage, the data that was extracted and transformed is loaded into the
BigFix Inventory database and can be used by BigFix Inventory.
1. In the navigation bar, click Management > Data Imports.
2. To schedule regular imports, select Enabled, specify the number of daily imports and
their hours, and click Save.

Information about data imports and their status is displayed in the import history.

Note: An error may appear during data import. Wait for few seconds or refresh the
page to allow the application to get back to its previous state.
We're sorry, the application is not accessible. (503)
An import is finalizing. Refresh the page to see the new data.

If you want to quickly discover recent changes to software inventory without having to wait
for the complete data import, you can schedule imports of raw data. Such imports are much
quicker but the imported data is not visible in the user interface. It can be retrieved only by
using REST API. For more information, see: Importing raw scan data.
If the imports of data are failing, you can enable partial imports. For more
information, see: Enabling partial imports.

Importing raw scan data
Available from 9.2.2. You can schedule an import of raw scan data. Such an
import is much quicker, because it only imports raw scan results, and omits successive
steps, such as aggregation and license calculations. The imported raw data, however, is
not updated in the user interface, and can only be retrieved by using REST API. This type of
import is used to quickly discover recent changes to software inventory without having to
wait for the complete data import.
• The Raw Data Only import does not replace the complete data import, which must be
run regularly to process and aggregate the data.
• The Raw Data Only import can be run only as a scheduled import. When you click
Import Now, you always run a complete data import.
• To run the Raw Data Only import only once, use REST API. For more information, see:
Running data imports.
1. To enable this feature, go to https://hostname:port/management/feature,
and select Enable the Raw Data Only import mode.
2. In the navigation bar, click Management > Data Imports.
3. To schedule regular imports, select Enabled, and specify the number of daily imports
and their hours.

4. Select Raw Data Only next to each import that you want to use for importing raw scan
results.

5. Click Save.
Information about completed data imports is displayed in the import history. Each entry has
an icon that indicates the type of the import, either Complete or Raw Data Only.

When the Raw Data Only import finishes, retrieve the imported raw data by using REST API.
For more information, see REST API for retrieving raw scan results.

Software inventory and license utilization
You can classify the discovered software so that reports in BigFix Inventory reflect your
entitlements and properly show utilization of license metrics by particular products.
Software components that are installed in your infrastructure are discovered in two ways:
• By software scans that correlate data collected from the computers with the content
of the software catalog
• By dedicated fixlets that discover details about specific enterprise applications, and
need to be run separately
After the components are discovered, they are assigned to products based on a number of
bundling rules. If the initial assignment is not correct, you should adjust it by reassigning
components to correct products and metrics, or by excluding products from license
calculations. After you complete the classification, you obtain a report that shows what
products are installed in your infrastructure, and what is their license metric utilization.

View the licence utilization
To see the list of detected components in your infrastructure and usage information on
each computer, refer to Software Installation reports. Use view details about software usage
statistics and usage of specific software on the listed instances, use Software Summary
report. See also, Available Reports.
This section provides you information about the following:
Vendor-specific reports
Provides vendors of BigFix Inventory customers with a quick access to
important statistics across the infrastructure through predefined vendorspecific reports.
Reports
Provides detailed information about the computers in your infrastructure and
the software items that are installed on these computers.
Reported license metrics

Lists the supported license metric types and their covered software titles.
BigFix Inventory allows you to reuse the metric type for caculating licenses for
other software products.
Enterprise application inventory
Lists additional features to detect details of deployment for specific software.
It is an extension of standard detection methods to get information about a
specific software.
Software classification
Provides report for working with software inventory and its assignment to the
licenses (products).
License metrics
Provides report for license utilization.
Software catalogs
Describes the methods to extend provided software catalog with custom
entries.

Vendor-specific predefined reports
Vendor-specific predefined reports provide software discovery and licensing
information for specific software vendors of BigFix Inventory customers. These reports
help Software Asset Managers manage software for their vendors and prepare for contract
negotiations and license audits.
These reports available through BigFix Inventory dashboard shows reports for the below
vendors:
• Adobe
• HCL
• IBM
• Microsoft
• Oracle

• SAP
• VMware
Below mentioned are some of the dedicated reports for specific software:
• Adobe Cloud Software
• Microsoft Office 365
• Microsoft SQL Server
• Oracle Database
• Oracle Java
• Oracle Weblogic
• SAP ERP
Note: BigFix Inventory provides reports and data for other vendors as well. Such
information can be accessed under generic reports. See also, Reports.
For more information on predefined vendor-specific reports, refer to List of vendor-specific
predefined reports

List of vendor-specific predefined reports
Vendor-specific predefined reports are ready-to-use reports that show the inventory
and license utilization details of a selected vendor or product. The reports are shown within
widgets and each widget includes a summarized dataset for the vendors.

Prerequisites to access reports
Access to vendor-specific reports is based on the access rules. For more information on
access rules, see Roles and permissions.

List of available vendor-specific reports
• Adobe Reports
◦ Adobe Cloud Software Inventory
◦ Adobe Cloud Software Measured License
◦ Adobe Cloud Software Users
◦ Adobe Inventory Summary
◦ Adobe Measured License
These reports help you understand discovery and license utilization of Adobe
products, such as Adobe CC suite and Adobe DC, including Adobe CC suite userbased license utilization.

• HCL Reports
◦ HCL Inventory
◦ HCL Summary
These reports help you understand discovery and license utilization of HCL products.
• IBM Reports
◦ IBM PVU Sub-capacity
◦ IBM FlexPoints and Cloud Paks
◦ All IBM Metrices
◦ IBM Software Only
◦ First Detected Last Week - IBM Software
◦ IBM Software - Pending Classification
These reports help you understand discovery and license utilization of IBM products
and provide information about IBM approved audits. You can also use the IBM
PVU and RVU MAPC consumption under full and subcapacity licensing terms to
understand current liecnse consumption and predict the future license requirements.
• Microsoft Reports
◦ Microsoft Office Usage per Computer
◦ Microsoft Measured License
◦ Microsoft SQL Server Inventory
◦ Microsoft SQL Server Measured License
◦ Microsoft Office 365 Inventory
◦ Microsoft Office 365 Measured License
◦ Microsoft Office 365 Software Users
These reports help you understand discovery and license utilization of Microsoft
products, such as Microsoft SQL server processor core licensing and Microsoft Office
365 user-based licensing. The reports allow discovery of Microsoft products through
which you can manually gather CAL licensing information.
• Oracle Reports
◦ Oracle Measured License
◦ Oracle Database
◦ Oracle Database Measured License
◦ Oracle Java Measured Inventory

◦ Oracle Java Inventory
◦ Oracle Database Inventory
◦ Oracle WebLogic Inventory
These reports help you understand discovery and license utilization of Oracle
products, such as Oracle Processor licensing for Oracle Database, Oracle Java and
Oracle WebLogic products.
• SAP Reports
◦ SAP Inventory
◦ SAP Measured Licenses
◦ SAP Inventory Summary
These reports help you understand discovery and license utilization of SAP products,
such as SAP R/3 and SAP S4/HANA.
• VMware Reports
◦ VMware Inventory
◦ VMware Measured License
◦ VMware Inventory Summary
These reports help you understand discovery and license utilization of VMware
products, such as processor-based VMware licensing.

Report types
All vendor-specific predefined reports follow a naming convention according to their
features and purpose. You may follow the naming convention to create reports. The reports
are listed according to their naming convention.
• Reports name ending with Inventory provide details about the inventory of a
software with supporting discovery data to help Software Asset Management (SAM)
understand of title license utilization. For more information on inventory reports, refer
to Software Classification

• Reports name ending with Measured License provide information about license
measured by BigFix Inventory. For more information on measured license reports,
refer to All Metrics
• Reports name ending with Summary provide discovery summary for a specific
software vendor. For more information on software summary reports, refer to
Software Summary
For some software titles, BigFix Inventory provides additional reports specific to them:
• Oracle Java Usage per Computer to help SAMs to discover computers that have
installed Oracle Java instances that are never used. This data helps to optimize
license by uninstalling Java instances that have not been used.
• Microsoft Office 365 Software Users and Adobe Cloud Software Users provide
information about users who use this software.
• Oracle Databases provide additional discovery details about Oracle database product.

Note: IBM-specific reports follow the same naming convention as in IBM License
Metric Tool.
For more information about how to use the functions of predefined reports and for
the complete list of the reports, refer to Available reports. For more information
about different vendor reports, see also Reported license metrics

Reported license metrics
BigFix Inventory reports utilization for a number of license metrics for IBM and non-IBM
products. It also shows products that are assigned any BigFix metric even if calculating
utilization is not yet supported for this metric. It gives you an overview of all IBM metrics for
which you should have licenses.

Metrics for which utilization is calculated
License metric utilization is calculated for products that are assigned to one of the metrics
that are listed in the following table. Their utilization is shown on the All Metrics report. For
more information, see: License metric utilization.
For every of these metrics, BigFix Inventory calculates the so-called high-water mark. For
more information, see: High-water mark.
To learn about custom metric requirements of all the All Metrics panel, refer to the
conditions mentioned here.
Table 156. Metrics for which utilization is calculated
Vendor
IBM

Product

Metric

• IBM products that

Flex

Description
PVU and RVU software that

are sold as part of Point

is assigned to a FlexPoint

FlexPoint bundles

bundle, must be licensed
based on subcapacity rules.
For more information, see:
IBM FlexPoints.

• IBM products
that are licensed

Install A unit of measure that is
Instances

based on the number of in

based on the list

stalled instances regardless

ed metrics

of whether the instances
are installed on one or many
computers. For example,
when three instances of a
product are installed on one
computer, the metric quanti
ty is 3.
Processor Value For more information, see:
Unit (PVU)

IBM Processor value unit
(PVU).

Table 156. Metrics for which utilization is calculated (continued)
Vendor

Product

Metric

Description

Resource Val

For more information, see:

ue Unit (RVU

IBM Resource value unit

MAPC)

(RVU MAPC).
Virtual For more information, see:

Selected IBM Products

SAP

• SAP-ABAP based

Processor Core

IBM Virtual processor core

(VPC)

(VPC).

Other IBM met

For more information, see:

rics

Other IBM metrics.

Engines, Users

For more information, see:

products

Discovering and measuring
SAP and Raw utilization of li
cense metrics.
Note: Information
about SAP metrics
is shown only on the
Resource Utilization
report.

Oracle

• All discoverable

Oracle

versions of Oracle Processor Core
Database (Enter
prise Edition)

For more information, see:
Oracle Processor Core.

Oracle Concur

For more information, see:

rent Sessions,

Extended discovery of Ora

Oracle User Ses cle Database and Raw uti
sions

lization of license metrics.
Note: Information
about Oracle Data

Table 156. Metrics for which utilization is calculated (continued)
Vendor

Product

Metric

Description
base concurrent
user sessions met
rics is shown only
on the Resource Uti
lization report.

Install A unit of measure that is
• Programs discov

Seats

based on the number of

ered by BigFix In

computers on which the

ventory and based

software is installed. For ex

on the Instal Seats

ample, when three instances

metric

of a product are installed on
one computer, the metric
quantity is 1.

Microsoft

• Windows Server

Mi

For more information, see:

2008 R2 Datacen

crosoft Sin

Microsoft Single and Dual

ter

gle Physical

Physical Processor.

Processor
• Windows Server
2012 Datacenter
• Windows Server
2012 R2 Datacen
ter

Mi
crosoft Dual
Physical
Processor

Table 156. Metrics for which utilization is calculated (continued)
Vendor

Product

Metric

• Microsoft SQL
Server Standard
Edition
• Microsoft SQL
Server Enterprise

Description
For more information, see

Microsoft SQL
Server Physical

10.011 Managing Microsoft
Processor Core licenses.

Processor Core

Edition
• Microsoft SQL

Mi

For more information, see:

Server 2012, 2014, crosoft Physical Microsoft Physical Core with
and 2016 (Stan

Core with SA

SA.

dard and Enter
prise)
• Microsoft SQL

Mi

For more information, see:

Server 2012, 2014, crosoft Virtual

Microsoft Virtual Core with

and 2016 (Stan

SA.

Core with SA

dard and Enter
prise).
• Microsoft Office
365

Regis For more information, see:
tered User

• Programs discov
ered by BigFix In

Registered User.

Install A unit of measure that is
Seats

based on the number of

ventory and based

computers on which the

on the Instal Seats

software is installed. For ex

metric

ample, when three instances
of a product are installed on
one computer, the metric
quantity is 1.

Table 156. Metrics for which utilization is calculated (continued)
Vendor
VMware

Product

Metric

• vSphere
• vCenter

Description
For more information, see:

VMware sock

Measuring license metric

ets

utilization of VMware prod
ucts and Raw utilization of li
cense metrics.
Note: Information
about VMware met
rics is shown only
on the Resource Uti
lization report.

• Programs discov
ered by BigFix In

Install A unit of measure that is
Seats

based on the number of

ventory and based

computers on which the

on the Instal Seats

software is installed. For ex

metric

ample, when three instances
of a product are installed on
one computer, the metric
quantity is 1.

Adobe

• Adobe Illustrator
CC
• Adobe PhotoShop
CC
• Adobe InDesign
CC
• Adobe Premiere
Pro CC

Regis For more information, see:
tered User

Registered User.

Table 156. Metrics for which utilization is calculated (continued)
Vendor

Product

Metric

Description

• Adobe After Ef
fects CC
• Adobe
Dreamweaver CC
• Adobe Muse CC
• Programs discov
ered by BigFix In

Install A unit of measure that is
Seats

based on the number of

ventory and based

computers on which the

on the Instal Seats

software is installed. For ex

metric

ample, when three instances
of a product are installed on
one computer, the metric
quantity is 1.

Other

• Non-IBM products
that use this met
ric.
• Non-IBM products

Install A unit of measure that is
Seats

based on the number of
computers on which the
software is installed. For ex

that are discov

ample, when three instances

ered by SWID tags

of a product are installed on

and for which the

one computer, the metric

software catalog

quantity is 1.

does not define li
cense details.

IBM FlexPoints
Available from 9.2.13. IBM FlexPoint is a license metric unit that can be used
to determine the cost of IBM products that are purchased as part of FlexPoint bundles.
Each product from a bundle is licensed based on a different license metric but all metrics

are converted into FlexPoints. The conversion is based on the specific calculations. PVU
and RVU software that is assigned to a FlexPoint bundle, must be licensed based on
subcapacity rules. Products that are currently available as part of FlexPoint bundles are
products from the IBM Cloud and IBM Analytics brands.

Predicting the number of required IBM FlexPoints
To predict the number of FlexPoints that are required to license products in your
environment, you can use IBM FlexPoint Calculator. For each product that you are planning
to deploy as part of a FlexPoint bundle, specify the number of license metric units. The
numbers are then converted into FlexPoints and summed up.

Example
The following example describes how the number of FlexPoints that are used in your
environment is counted by BigFix Inventory. The calculations are based on sample values
and should be treated only as an example.
You purchased the IBM Cloud DevOps offering and you deployed three products from this
offering: UrbanCode Deploy Server Agent, Rational Test Workbench, and Rational Test
Virtualization Server. Each of the products is licensed based on a different license metric
as presented in Table 157: IBM FlexPoints needed to license products deployed as part of
the IBM Cloud DevOps offering. To calculate the number of IBM FlexPoints that are used
by these products, multiplies the number of license metric units that each product uses
by the number of IBM FlexPoints that are assigned per metric unit for that product. Results
for each product are then summed up to obtain the number of IBM FlexPoints used by the
entire IBM FlexPoint bundle.

Table 157. IBM FlexPoints needed to license products deployed as part of the IBM
Cloud DevOps offering
The table consists of four columns and five rows. In the fifth row, the first three
columns are joined.
Product
UrbanCode Deploy

Used li

IBM FlexPoints per

cense metrics

license metric unit

2 Virtual Servers

Calculations

129,800

Server Agent
Rational Test Work

259,600
50 Authorized Users

15,950

bench
Rational Test Virtu

2 x 129,800 =

50 x 15,950 =
797,500

210 PVUs

2,893

alization Server
Total FlexPoints Used

210 x 2,893 =
607,530
1,664,630

Reading metric utilization
Information about IBM FlexPoint bundles
You can view information about IBM FlexPoint bundles on the IBM FlexPoints and IBM
Cloud Paks report. The report lists the IBM FlexPoint bundles based on the decisions that
you make during software classification. The metric quantity represents the license metric
utilization for an entire bundle over the specified period of time expressed in IBM FlexPoints.

Information about the products that contribute to IBM FlexPoint bundles
To view the detailed report with license metric utilization for individual products that
are parts of a bundle, go to the IBM FlexPoints and IBM Cloud Paks report, and click the

FlexPoint bundle name in the Product Name column. The detailed information include
the peak date of the entire FlexPoint bundle and the number of FlexPoints used by each
individual product. Additionally, you can check the number of original metric units by which
the products are licensed that are used over the reporting period.
Note:

You can change the metric quantity for the products that contribute

to the bundle. Once you set the declared metric quantity for a product that is a
part of a FlexPoint bundle, the number of the FlexPoints for the entire bundle
is automatically adjusted. For more information, see: Setting and removing the
declared metric quantity.

Information about FlexPoints in audit snapshot
When you generate the audit snapshot, information about FlexPoint bundles and
the number of FlexPoints that they use is contained in the flexpoints.csv file. The file
additionally contains information about the software products within the bundle and the
number of FlexPoints used by them.

Table 158. A fragment of the flexpoints.csv file
Flex
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Related information
High-water mark

Microsoft Single and Dual Physical Processor
Available from 9.2.8. Microsoft Single Physical Processor and Dual Physical
Processor metrics are used to determine the licensing cost of Microsoft products. They are

based on the number of active physical processors that are deployed on the host where the
software is installed. When the software is installed on multiple hosts, all active processors
from all hosts contribute to metric utilization.
Microsoft Single Physical Processor metric covers one physical processor. Microsoft Dual
Physical Processor license covers up to two physical processors. BigFix Inventory reports
the number of processors, not licenses. Thus, the number of processors is rounded up to an
even number.
By default, calculation of both metrics takes into account data from the last 90
days because Microsoft licensing rules do not allow for license migration more
often than once per 90 days. To change the period for which data is calculated,
go to Management > Advanced Server Settings and change the value of the
historical_period_for_microsoft_metrics parameter according to your needs.

Supported software
• Reporting of the Microsoft Single Physical Processor metric is supported for Windows
Server 2008 R2 Datacenter.
• Reporting of the Microsoft Dual Physical Processor metric is supported for Windows
Server 2012 Datacenter or Windows Server 2012 R2 Datacenter.

Requirements
VM managers should be defined for all virtual machines in your environment. If a VM
manager is not defined for a particular host, the number of processors on the host is
counted as 0. As a result, license utilization might be underestimated. If a component of a
product with any of the two metrics is detected on a host for which a VM manager is not
defined, a warning sign (

) is displayed on the All Metrics report. It indicates calculation

inaccuracy.
Note: The warning is displayed only on the user interface. It is not displayed in the
CSV or PDF version of the All Metrics report.

Limitations
When a computer on which the software was discovered is deleted, report columns related
to server capacity show <no data> in the user interface. Information about computers that
contributed to the metric peak value is available in the audit snapshot regardless of whether
these computers were removed.

Examples
Example 1: Software is deployed on two physical computers
Microsoft Windows Server 2012 Datacenter is installed on 2 physical
computers, each with 4 processors. Metric utilization equals 8.
Example 2: Software is deployed on a virtual machine that was migrated between
hosts
Microsoft Windows Server 2012 Datacenter is installed on a virtual machine
that runs on a host with 2 processors. Within a period of 90 days from the
software discovery, the virtual machine is migrated to another host that also
has 2 processors. The number of processors from the two hosts is added.
Metric utilization equals 4.
Table 159. Utilization of the Dual Physical Processor metric for a virtual
machine that was migrated

Physical processors
Metric utilization

Related information
High-water mark

Host 1

Host 2

2

2
4

Microsoft Physical Core with SA
Available from 9.2.6. The Microsoft Physical Core with SA metric is used to
determine the licensing cost of Microsoft products. It is based on the number of physical
cores that are deployed on the host where the software is installed. When the software
is installed on multiple hosts, all cores from all hosts contribute to metric utilization.
Because this license type is based on physical cores, the same number of cores is assigned
regardless of whether the software is installed on a physical host or on a virtual machine.
Depending on the processor type, Microsoft requires that an appropriate core factor is
applied to calculate the number of required licenses. The number of cores that is reported
by BigFix Inventory represents the actual number of physical cores without any core factor
applied. The minimal number of licensable cores is four per physical processor. It means
that each processor on a host with one or two cores is assigned four cores.

Supported software
Reporting of the metric is supported for Microsoft SQL Server 2012, 2014, and 2016
(Standard and Enterprise).

Requirements
To report the number of physical cores for the discovered Microsoft software, the licensed
software must have Software Assurance.
Additionally, VM managers should be defined for all virtual machines in your environment.
If a VM manager is not defined for a particular host, the number of cores on the host is
counted as 0. As a result, license utilization might be underestimated. If a component of
a product with the Microsoft Physical Core with SA metric is detected on a host for which
a VM manager is not defined, a warning sign (

) is displayed on the All Metrics report. It

indicates calculation inaccuracy.
Note: The warning is displayed only on the user interface. It is not displayed in the
CSV or PDF version of the All Metrics report.

Limitations
When a computer on which the software was discovered is deleted, report columns related
to server capacity show <no data> in the user interface. Information about computers that
contributed to the metric peak value is available in the audit snapshot regardless of whether
these computers were removed.

Examples
The following examples describe how the number of required licenses is calculated. They
are based on sample data.
Example 1: Software is deployed on a physical server
Microsoft SQL Server 2014 Enterprise is installed on a physical computer
with four dual-core processors. According to the licensing terms, each dualcore processor is assigned four cores which gives 16 cores in total. Metric
utilization for Microsoft SQL Server is 16.
Table 160. Metric utilization for software in a physical environment
Host 1
Physical processors on the host

4

Physical cores on the host

8

Core licenses needed

16

Example 2: Software is deployed on two virtual machines
Microsoft SQL Server 2014 Enterprise is installed on two virtual machines
that run on a host with 10-core processor. The cores are shared by the virtual
machines. The number of virtual cores that are assigned to a virtual machine
is ignored and BigFix Inventory reports the total number of physical cores on
the host. Metric utilization for Microsoft SQL Server is 10.

Table 161. Metric utilization for software in a virtual environment
Virtual Machine 1

Virtual Machine 2

Virtual cores

8

16

Physical cores on the

10

10

host
Physical processors

1

on the host
Core licenses needed

10

Example 3: Software is deployed on two virtual machines that were migrated between
hosts
Microsoft SQL Server 2014 Enterprise is installed on two virtual machines that
run on a host with 10-core processor. Both virtual machines are migrated on
the same day to a host with a 12-core processor. Metric utilization is checked
once per day at midnight (GMT). Taking advantage of License Mobility, all
licenses from Host 1 are reassigned to Host 2. Metric utilization for Microsoft
SQL Server is 10 for the period before the migration, and 12 starting from the
day of the migration.
Example 4: Software instance uses a different license metric
Two instances of Microsoft SQL Server 2014 Enterprise are discovered. The
first instance uses the Microsoft Physical Core with SA metric. The second
instance uses a different metric, for example Microsoft Virtual Core with SA.
To ensure that only the first instance contributes to the calculation of the
Microsoft Physical Core with SA metric, reassign the second instance to the
proper metric. If the metric is not available in the software catalog, exclude
the instance from pricing calculations. For more information, see: Assigning
components to products, and Excluding and suppressing software instances.

Example 5: Two software instances use the same metric and are installed on the
same server
Microsoft SQL Server 2012 Enterprise and Microsoft SQL Server 2014
Enterprise are discovered on one server. Both instances use the Microsoft
Physical Core with SA metric. Metric utilization is counted once for this server
regardless of the number of installed instances.

Reading metric utilization
The first level of the All Metrics report shows a product and its metric quantity, which is
the highest number of metric units that the product used during the specified period. The
warning sign (

) indicates that the VM manager is not defined for at least one of the hosts

on which the product is installed.

When you click the product name, the second level of the report shows all instances of
product components that contributed to the metric quantity, including historical instances
that are no longer installed. The value in the Server Cores column shows the number of
physical cores on the host. For hosts without VM managers defined, the column shows the
number of virtual cores. Thus, it is skipped in the calculation of the overall metric quantity.

The fact that the value is skipped is reflected in the Core Metric column in the
microsoft_physical_core_with_sa.csv file which is a part of the audit snapshot.
Additionally, information about incomplete virtualization technology is provided in the
Comment column.

Table 162. A fragment of the microsoft_physical_core_with_sa.csv file
Publisher
Microsoft

Product

Metric

Server

Name

Quantity

Cores

Microsoft

Core Metric

44

12

12

44

32

32

44

0

0

Comment

SQL Server
Enterprise
Edition
Microsoft

Microsoft
SQL Server
Enterprise
Edition

Microsoft

Microsoft

Incomplete

SQL Server

virtualiza

Enterprise

tion hierar

Edition

chy

Related information
High-water mark

Microsoft Virtual Core with SA
Available from 9.2.7. The Microsoft Virtual Core with SA metric is used to
determine the licensing cost of Microsoft products that have Software Assurance. It is
based on the number of virtual cores that are available to the product. When the product is
installed on multiple virtual machines, virtual cores from all machines contribute to metric
utilization.
The number of virtual cores can be greater than the number of physical cores that are
available on the hosts. The minimal number of licensable cores is four. It means that when a

virtual machine is assigned one or two cores, four cores are reported. If the number of cores
is not a multiple of 2, it is rounded up.

Supported software
Reporting of the metric is supported for Microsoft SQL Server 2012, 2014, and 2016
(Standard and Enterprise).

Requirements
To report the number of virtual cores for the discovered Microsoft software, the licensed
software must have Software Assurance.

Limitations
Reporting of the metric has the following limitations:
• By default, the supported products are assigned to the Microsoft Physical Core
with SA metric. To calculate utilization of the virtual core based metric, reassign
the products to this metric. For more information, see: Assigning components to
products.
• BigFix Inventory does not recognize when a virtual machine is migrated to a server
farm located in a time zone that is more than four hours apart from the current time
zone. Instead of reporting two instances of a product that is installed on such a virtual
machine, BigFix Inventory reports one instance.
• When a computer on which the software was discovered is deleted, report columns
related to server capacity show <no data> in the user interface. Information about
computers that contributed to the metric peak value is available in the audit snapshot
regardless of whether these computers were removed.

Examples
The following examples describe how the number of required licenses is calculated. They
are based on sample data.
Example 1: Software is deployed on one virtual machine

Microsoft SQL Server 2014 Enterprise is installed on a virtual machine that
is assigned two virtual cores. According to the licensing terms, the minimal
number of licensable cores is four. Metric utilization for Microsoft SQL Server
is 4.
Table 163. Metric utilization for software on one virtual machine
Virtual machine 1
Virtual cores

2

Core licenses needed

4

Example 2: Software is deployed on two virtual machines
Microsoft SQL Server 2014 Enterprise is installed on two virtual machines
that run on the same physical host. The host has 10 cores. The first virtual
machine is assigned 8 cores. The second virtual machine is assigned 16
cores. Metric utilization is the sum of virtual cores that are available to
Microsoft SQL Server and equals 24.
Table 164. Metric utilization for software on two virtual machines
Summary for complex table

Virtual cores
Physical cores on the

Virtual Machine 1

Virtual Machine 2

8

16
10

host
Core licenses needed

24

Example 3: Software is deployed on a virtual machine that was assigned additional
cores

Microsoft SQL Server 2014 Enterprise is installed on a virtual machine that
is assigned 10 cores. The virtual machine is assigned two additional cores.
Metric utilization for Microsoft SQL Server is 10 until the day when additional
cores were added. Starting from the next day, metric utilization is 12.
Example 4: Software instance uses a different license metric
Two instances of Microsoft SQL Server 2014 Enterprise are discovered. The
first instance uses the Microsoft Virtual Core with SA metric. The second
instance uses the Microsoft Physical Core with SA metric. To ensure that
the first instance contributes to the calculation of the virtual core based
metric, reassign this instance to the proper metric. For more information, see:
Assigning components to products.
Example 5: Two software instances use the same metric and are installed on the
same virtual machine
Microsoft SQL Server 2012 Enterprise and Microsoft SQL Server 2014
Enterprise are discovered on one virtual machine. Both instances use the
Microsoft Virtual Core with SA metric. Metric utilization is counted once for
this virtual machine regardless of the number of installed instances.

Reading metric utilization
The first level of the All Metrics report shows a product and its metric quantity, which is the
highest number of metric units that the product used during the specified period.

When you click the product name, the second level of the report shows all instances of
product components that contributed to the metric quantity, including historical instances
that are no longer installed. The values in the Logical Processors column show the number
of virtual cores that are reported on the computers where the component is installed.
Because the minimal number of licensable cores is four, virtual machines with one and two

cores are counted as having four cores. This requirement is not reflected in the Logical
Processor column because the column shows the actual number of processor cores.

The requirement is reflected in the Core Metric column in the
microsoft_virtual_core_with_sa.csv file which is a part of the audit snapshot.
Table 165. A fragment of the microsoft_virtual_core_with_sa.csv file
Publisher
Microsoft

Product Name
Microsoft SQL

Logical

Metric Quantity

Core Metric

Processors

16

2

4

16

1

4

16

8

8

Server Enter
prise Edition
Microsoft

Microsoft SQL
Server Enter
prise Edition

Microsoft

Microsoft SQL
Server Enter
prise Edition

Related information
High-water mark

Oracle Processor Core
Available from 9.2.8. Oracle Processor Core metric is used to determine the
licensing cost of Oracle products. It is based on the number of physical cores that are

deployed on the host where the software is installed multiplied by an appropriate processor
core factor. When the software is installed on multiple hosts, all cores that require applying
the same core factor are added. Then, the factor is applied to calculate metric utilization.
By default, the 0.5 factor is applied to all servers. If the number of cores multiplied by the
core factor is not an integer, it is rounded up at the core factor level. If a processor requires
a different core factor, the value can be adjusted through the user interface or by using REST
API.

Supported software
Reporting of the metric is supported for all discoverable versions of Oracle Database
(Enterprise Edition).

Requirements
VM managers should be defined for all virtual machines in your environment. If a VM
manager is not defined for a particular host, the number of cores is counted at the level
of the virtual machine. As a result, license utilization might be incorrectly calculated. If a
component of a product with the Oracle Processor Core metric is detected on a host for
which a VM manager is not defined, a warning sign (

) is displayed on the All Metrics

report. It indicates calculation inaccuracy.
Note: The warning is displayed only on the user interface. It is not displayed in the
CSV or PDF version of the All Metrics report.
In case of VMware, if a virtual machine is a cluster, metric utilization is counted on the
basis of the number of cores in a cluster, not the physical server. To obtain correct count
of cluster cores, go to Management > Advanced Server Settings and set the value of the
storeHwDataForAllVMManagerNodes parameter to true. Otherwise, only hosts on which the
BigFix client is installed are included in the cluster core count.

Limitations
Only active sockets are taken into account during the calculations.

Examples
Example 1: Software is installed on multiple servers that require various core factors
Oracle Database Enterprise Edition is installed on the following six servers:
• One server with two cores that require applying the 0.75 core factor
• Four servers with one core each that requires applying the 0.75 core
factor
• One server with one core that requires applying the 0.5 factor
All cores that require the same core factor are added and the factor is applied.
Then, the values obtained at each core factor level are rounded up and added.
Metric utilization equals 6.
Table 166. Utilization of the Oracle Processor Core metric on multiple
servers that require various core factors
Summary for complex table
Cores that require

Cores that re

the 0.75 factor

quire the 0.5 factor

Actual number of

(1 × 2 cores + 4 × 1

cores

core) = 6

Number of cores after

(1 × 2 cores + 4 × 1

applying the core fac

core) × 0.75 = 4,5

1 × 1 core = 1

1 × 1 core x 0.5 = 0.5

tor
Number of cores after

5

1

rounding up
Total

6

Related information
High-water mark

Changing the Oracle core factor
By default, all servers are assigned the 0.5 factor. If the processor that is deployed on a
server requires applying a different core factor, you can change it through the user interface
or, to perform the operation on multiple servers, by using REST API.

Changing the Oracle core factor through the user interface
Available from 9.2.8. To change the Oracle core factor thorough the user interface,
open the Hardware Inventory report, and edit the value in the Oracle Core Factor column.
You must have the Manage Hardware Inventory permissions to perform this task.
1. Log in to BigFix Inventory, and go to Reports > Hardware Inventory.
2. To adjust the report view, hover over the Manage Report View icon

, and click

Configure View.
a. Optional: To narrow the report to a server for which you want to change the
core factor, specify appropriate filters.
For example: Computer Name, contains, and specify the name of the server.

b. To add a column in which you can edit the core factor, select Oracle Core
Factor. Then, click Submit.

3. To change the Oracle core factor, click the pencil icon (

) in the Oracle Core Factor

column, and click Change Oracle Core Factor.
4. Specify the new core factor, and click Change.

5. To update utilization of the Oracle Processor Core metric, go to Reports > All Metrics,
and click Recalculate.
The core factor value is updated for the selected server. Metric utilization is updated for
products that are installed on that server.

Changing the Oracle core factor through REST API
Available from 9.2.8. To change the Oracle core factor thorough REST API, retrieve
the list of servers that exist in your infrastructure. Then, choose IDs of the servers for which
you want to change the core factor and update the value.
You must have the Manage Hardware Inventory permissions to use this API.

1. Retrieve information about servers that exist in your infrastructure and the Oracle core
factor that is assigned to every server.
• If you retrieve the information through a web browser plug-in, use the following
request:
GET https://hostname:port/sam/processors.json?columns[]=server_id
&columns[]=server_name&columns[]=oracle_core_factor
&token=cb1e554922312e0e4aa44a1ef2b9a426117efe39
Accept: application/json
Accept-Language: en-US

• If you retrieve the information by using cURL, run the following command:
curl --insecure -H "Content-type: application/json;
charset=UTF-8"
-X GET
"https://hostname:port/sam/processors?columns%5B%5D=server_id
&columns%5B%5D=server_name&columns%5B%5D=oracle_core_factor
&token=cb1e554922312e0e4aa44a1ef2b9a426117efe39" -o out.json

The request returns the list of server IDs and names together with core factors that
are currently assigned to each server.
{
"total":3,
"rows":
[{
"server_id":1,
"server_name":"TLM_VM_42362841-6b4e-ea26-9755-07b28dc0fd41",
"oracle_core_factor":"0.5"
},
{
"server_id":2,
"server_name":"Oracle Corporation SPARC-Enterprise-T5220
2225894042",

"oracle_core_factor":"0.5"
},
{
"server_id":3,
"server_name":"Microsoft Azure VMware-42 3b f0 3c fb d5 4c 97-4f
bd ca 3f 83 3a 91 46",
"oracle_core_factor":"0.5"
}]}

2. Update the core factor that is assigned to a selected server.
• If you update the information through a web browser plug-in, use the following
request:
POST
api/v1/servers?token=cb1e554922312e0e4aa44a1ef2b9a426117efe39
{
"oracle_core_factors":
[
{
"server_id": 1,
"oracle_core_factor": 1.0
}
]}

• If you update the information by using cURL, run the following command:
curl --insecure -H "Content-type: application/json;
charset=UTF-8"
-X PUT
https://hostname:port/
api/v1/servers?token=cb1e554922312e0e4aa44a1ef2b9a426117efe39
-d '{"oracle_core_factors":[{"server_id": 1,"oracle_core_factor":
1.4}]}'

3. To update utilization of the Oracle Processor Core metric, log in to BigFix Inventory
and go to Reports > All Metrics. Then, click Recalculate.

IBM Processor value unit (PVU)
A Processor Value Unit (PVU) is a unit of measurement that is used to determine the
licensing cost of IBM middleware products. It is based on the type of processor that is
deployed on the server where the software is installed. For each product, you must acquire
the appropriate number of PVUs that is defined for the specific processor on which the
software is installed.
The number of required PVUs is based on the processor technology and the number of
processors that are available to the software product. For PVU-based licensing, IBM defines
a processor as a processor core on a chip. For example, a dual-core processor chip has two
processor cores. PVUs are assigned per core, not per processor. The number of PVUs that
are assigned to a processor core is defined in the PVU table format. For more information,
refer to Processor Value Unit [PVU] licensing for Distributed Software.

Processor value unit license types
PVU licensing can be full capacity or subcapacity. Full capacity licensing is based on the
overall number of processor cores on the physical server on which the product is installed.
Subcapacity licensing is available only in virtualized environments. It is counted as the
highest number of PVUs that are available for the VM on which the product is installed,
not the total PVU count on the physical server. You acquire licenses for the lower value:
subcapacity or full capacity.
Subcapacity licensing can significantly reduce the licensing cost, especially with a move to
a newer processor core technology. However, virtual machines or partitions that restrict the
available processor capacity must be created by using eligible virtualization technologies.
For more information about subcapacity licensing requirements, see: Passport Advantage®
Virtualization Capacity (Subcapacity) Licensing.
For information about rules of subcapacity counting on each virtualization type, see: IBM
Virtualization Capacity License Counting Rules.

Scenarios
The following scenarios describe how the cost of software license is calculated. The
calculations are based on sample values and should be treated as examples.

Scenario 1: Full capacity on a physical server
IBM MQ software is installed on a server that has two Intel Xeon 3400
processors, each processor with eight cores which gives 16 cores in total.

Because the environment is not virtualized, subcapacity license does not
apply. Full capacity license is counted as the highest number of PVUs on the
server where the software is installed. According to the PVU table, when the
server has two sockets, this processor model is assigned 70 PVUs per core.
The following table shows how the cost of full capacity license is calculated
for IBM MQ software that is installed on this server.
Table 167. Cos of full capacity license for IBM MQ software
The table consists of two columns and five rows.
Description

Full capacity

Cores to license

16

PVU per core

70

Software cost per PVU

$50

License cost

16 * 70 * $50 = $56,000

Scenario 2: Subcapacity on two virtual machines
Two virtual machines are deployed on a server that has two Intel Xeon 3400
processors, each processor with eight cores which gives 16 cores in total.
Each VM is assigned eight virtual cores. WebSphere software is installed only

on the first virtual machine and has access to eight cores. IBM MQ software is
installed on both virtual machines and thus has access to 16 cores.

According to the PVU table, when the server has two sockets, this processor
model is assigned 70 PVUs per core. The following table shows how the cost
of full capacity license and subcapacity license is calculated for IBM MQ
software and WebSphere software that is installed on this server.
Table 168. Cost of full capacity and sbcapacity lic"5"e for IBM MQ software
and WebSphere software
The table consists of two columns and five rows.
Description
Cores to li

IBM MQ software
Full capacity

Subcapacity

WebSphere software
Full capacity

Subcapacity

16

16

16

8

PVU per core 70

70

70

70

Software

$50

$50

$30

$30

16 * 70 * $50

16 * 70* $50

16 * 70 * $30

8 * 70 * $30 =

= $56,000

= $56,000

= $33,600

$16,800

cense

cost per PVU
License cost

Scenario 3: Capacity in a virtual environment where connection to the VM manager is
not configured
Important: In this scenario, default PVU counting is applied due to
the lack of connection to the VM manager. IBM accepts audit reports
that contain PVU values calculated based on the default PVU counting
instead of considering the client to be ineligible for subcapacity
or liable for full capacity. For more information, see: Default PVU
counting on x86 processors and Managing VM managers.
Two virtual machines are deployed on a server that has two Intel Xeon 3400
processors, each with eight cores which gives 16 cores in total. The first VM
is assigned 12 virtual cores. The second VM is assigned 10 virtual cores. IBM
MQ software is installed on both VMs.

If a virtual machine manager is not defined, BigFix Inventory does not have
access to information about the number of sockets and physical cores on
the server on which the VMs are deployed. It has access only to information
about the processor model and the number of virtual cores that each VM is
assigned. The sum of virtual cores to which IBM MQ software has access is
greater than the number of physical cores that are available on the server.

Tip: If the hypervisor data is missing from a virtual machine and
default PVU counting is applied, ID of the server on which the machine
runs begins with TLM_VM.
The number of PVUs per core that is assigned to a processor depends on
the number of sockets on the host. Because BigFix Inventory does not have
access to this information, it assigns the highest PVU per core value that is
defined for the particular processor in the PVU table. According to the PVU
table, when the server has two sockets, this processor model is assigned 70
PVUs per core. However, due to the lack of information about the number of
sockets, software is charged 120 PVUs per core. It is the highest number of
PVUs that is defined in the PVU table for this type of processor.
The following table shows the cost of license for the IBM MQ software
depending on whether the VM manager is defined.
Table 169. Cost of license for IBM MQ software depending on whether the
VM manager is defined
The table consists of two columns and five rows.

Description

Capacity for IBM MQ software

Capacity for IBM

when the VM manager is defined

MQ software
when VM manag

Full capacity

Subcapacity

er is not defined

Cores to license

16

22 capped to 16

22

PVU per core

70

70

120

$50

$50

16 * 70 * $50 =

16 * 70 * $50 =

22 * 120 * $50 =

$56,000

$56,000

$132,000

Software cost per $50
PVU
License cost

Related information
High-water mark

IBM Processor value unit table
A processor value unit table contains information about the conversion ratio that is used for
available processor types.
The processor value unit table supports processor-based pricing models in which charges
differ according to the type of processor on which the licensed product is installed and
running. In the table, a number of units is assigned to each processor type for which this
type of pricing model is available. It is necessary to ensure that the table is updated to
reflect the ratios for all processors in use.
If a processor cannot be properly identified by an agent, it is shown in the processor table as
OTHER. This case can occur because it is a new processor type and its discovery is not yet
supported. In this situation, upload the newest processor value unit table.
Related information
Uploading an IBM PVU table

Uploading an IBM PVU table
The PVU table supports processor-based pricing models in which charges differ according
to the type of processor on which the licensed product is installed and running. In the table,
a number of units are assigned to each processor type on which this type of pricing model
is available. BigFix continues to update the PVU table to include new processor types and
models. To ensure that the processors are properly detected and charged, upload a new
version of the PVU table whenever it is available.
You must have the Manage Uploads permission to perform this task.
A new PVU table is uploaded to BigFix Inventory during the upgrade. Use this
procedure when a new table is published between application updates.

The PVU table file is authenticated with SHA-256 to comply with the FIPS (Federal
Information Processing Standards) security standards. Previous versions of PVU tables that
are signed with SHA1 are not supported.
1. In the top navigation bar, click Management > Metric Table Upload.
2. To download PVU table, use Download PVU table fixlet.
Note: Download PVU table fixlet is available since 10.0.4.
3. To upload PVU table, click Choose File, select the file that you downloaded, and click
Upload.
A new entry is created in the Upload and Import History table. The status of the PVU
table is Pending.
4. Wait for the scheduled import or run it manually.
For BigFix Inventory to be compliant with Subcapacity, you must upgrade the server.

Related information
IBM Processor value unit table

Registered User
Available from 9.2.13. Registered User is a license metric unit that can be used to
determine the licensing cost of Microsoft Office 365 and a number of Adobe Creative Cloud
products.
A product can be licensed based on the number of registered users. Then, one product that
is installed on multiple computers or servers can be used by a number of registered users.
Only the number of registered users in taken into account when calculating license metric
utilization.
Note that the Registered User metric differs from the Authorized User metric. Authorized
User has a broader spectrum and relates to all users who are authorized to use a product.
Registered User is more accurate and pertains only to those users who registered.

Supported Software
Reporting of the Registered User metric is supported for the following software
that is installed on Windows computers:
• Microsoft Office 365
Adobe Creative Cloud (CC) applications on Windows computers.

•

◦ Adobe Illustrator CC
◦ Adobe Photoshop CC
◦ Adobe InDesign CC
◦ Adobe Premiere Pro CC
◦ Adobe After Effects CC
◦ Adobe Dreamweaver CC
◦ Adobe Muse CC

Limitations
• extracts users only of those Office 365 components in which the user logs in to
Microsoft. If an Office 365 component is deployed but the user does not log in to
Microsoft, the user is not reported. Due to this fact, users are reported only when they
are logged in to at least one of the following components: Access, Excel, PowerPoint,
Publisher, Word.
• Because extracts only users that log in to Microsoft, users are reported only for
components that provide the option to log in to Microsoft. For example, users of
Skype are reported only if they use another component of Office 365 and log in to
Microsoft.
• If the software scan runs during a time when the user of Office 365 is not logged in to
Windows, information about the user is not captured. If the user was reported in the
past and Office 365 is still deployed on the scanned computer, the user is counted. If
the user was reported in the past but Office 365 is no longer deployed nor activated,
the user is not counted.
• Utilization of the Registered User metric is calculated only for products that are
installed on Windows. Product instances that are installed on computers with other
operating systems, on mobile devices, or are available online are not taken into

account. Thus, the reported license metric utilization might differ from the number
provided by the software manufacturer.
• incorrectly reports users of Office 365 that is installed in the Shared Client Activation
(SCA) mode.
• To display the information about software users of Adobe CC applications on the
Software Users report, you must have Adobe Creative Cloud Desktop App installed
on all relevant computers. Otherwise, BigFix Inventory measures and reports only the
usage of these components that is based on the Windows processes.

Examples

Related information
High-water mark

Setting and removing the declared metric quantity
Available from 9.2.16. On the All Metrics report, you can manually declare the
metric quantity for selected license types for which does not calculate the utilization. You
can also use this option to customize the metric quantity if needed. The declared value
takes precedence over the value that is measured by the application.
You must have the Manage License and the Manage Software Classification permissions
to set the license metric quantity.
You can check which of your license metric quantities can be customized. Look at the
pencil icon

in the Metric Quantity column. If the icon is active, you can declare the

custom metric quantity for the product.

By default, you set the declared value from the reporting start date onwards. However when
you explicitly provide also the end date for the report, then the declared metric quantity is
set only until this date. Using this mechanism, you can declare metric quantities for any
period of time by defining the appropriate time range for the report.
1. In the top navigation bar, click Reports > All Metrics.
2. Optional: To change the period for which you want to set the declared metric quantity,
hover over Configure, click Configure View, and select the time range. If you specify a
period from a date to a date, the license metric quantity is set only for this particular
period of time.
3. To set the metric quantity, click the pencil icon

in the Metric Quantity column.

Note: In case of FlexPoint bundles, you can set the license metric quantities
for particular products that contribute to the bundle but not for the bundle
itself. Click on the name of the bundle to see the detailed report that lists the
products within bundle.
4. Specify the metric quantity and click Set. The value is set only for the computer group
to which you are assigned and is not inherited by its subgroups.

Note: If you want to set a metric quantity for a subgroup of your computer
group, go to Reports > Computer Groups and open the subgroup. In the upper
left corner, select All IBM Metrics and set the license metric quantity for a
particular product.
The metric quantity for the product is set.
The declared metric quantity is independent of your software inventory or bundling and
you should make sure that it is kept up-to-date. If you reassign software to another product
or FlexPoint bundle, the declared metric quantity remains unchanged. If, as a result of
reassignment, a product is left with no components, it is still visible on the All Metrics report
with the declared metric quantity.

Removing the declared metric quantity
You can remove the declared value to restore the value that is measured by the application.
1. Open the All Metrics report.
2. To remove the declared metric quantity, click the pencil icon (

) in the Metric

Quantity column.
3. Clear the text field to remove the declared metric quantity for the specified period of
time.
4. Click Set.

IBM Resource value unit (RVU MAPC)
IBM Resource value unit (RVU MAPC) is a license metric unit that is based on the number
of activated processor cores that are available to the product. An activated processor core
is a core that is managed or used by a product, regardless of whether the capacity of the
processor core can be limited through virtualization technologies.

Resource value unit license types
IBM RVU MAPC licensing can be full capacity or subcapacity. Full capacity licensing is
counted as the highest number of RVUs in the physical environment that are managed or
used by the product.
Subcapacity licensing is available only in virtualized environments. It is counted as the
highest number of RVUs that are available to the VM on which the product is installed, not
the total RVU count on the physical server.

Resource value unit tier table
The RVU tier table provides factors that are specific to the number of activated processor
cores. The greater the number of activated processors, the lower is the factor and thus the
fewer RVUs are required per processor core.
Table 170. The RVU tier table for activated processor cores
Tier

Activated processor cores

Factor

1

0 - 2,500

1.00

2

2,501 - 10,000

0.80

3

10,001 - 50,000

0.60

4

50,001 - 150,000

0.40

5

Above 150,001

0.20

Example
A product has access to 45.000 activated processor cores. The number is divided into tiers
based on the RVU tier table. The number of cores that fall into each tier is multiplied by the
factor that is applicable for that tier. The values are summed up to obtain the total number
of required RVUs. The following table shows how the number of required RVUs is obtained
for this product.

Table 171. Activated processor cores divided into quantity tiers
Number of man
Tier

aged cores in the tier

Calculations

1

2,500

2,500 x 1.00 = 2,500

2

7,500

7,500 x 0.80 = 6,000

3

35,000

35,000 x 0.60 = 21,000

Total

45,000

29,500

Related information
High-water mark

IBM Virtual processor core (VPC)
Available from 9.2.11. IBM virtual processor core (VPC) is a unit of measurement
that is used to determine the licensing cost of BigFix products. It is based on the number
of virtual cores (vCPUs) that are available to the product. A vCPU is a virtual core that is
assigned to a virtual machine or a physical processor core if the server is not partitioned for
virtual machines.

Scenarios
The following scenarios describe how the number of vCPUs is counted under different
circumstances. The calculations are based on sample values and should be treated as
examples.
Scenario 1: VPC on a physical server
IBM MQ software is installed on a server that has two processors. Each
processor has 8 physical cores which gives 16 cores in total. The number of
vCPUs to license is 16.

Scenario 2: VPC on two virtual machines
Two VMs are deployed on a server that has two processors. Each processor
has 8 physical cores which gives 16 cores in total. Each VM is assigned 10
vCPUs.
WebSphere software is installed only on the first VM and has access to 10
vCPUs. The number of vCPUs to license is 10. IBM MQ software is installed on
both VMs and thus has access to 20 vCPUs. Because the number of physical
cores is lower than the number of vCPUs that are assigned to the VMs, the
number of vCPUs to license is capped to 16.

Scenario 3: VPC in a virtual environment where the VM manager is not defined
Important: This scenario is not supported. It is provided to explain
the consequences of not defining the VM manager that controls
resources that are available to virtual machines. VM managers must
be defined to properly report VPC consumption.

Two VMs are deployed on a server that has two processors. Each processor
has 8 cores which gives 16 physical cores in total. The first VM is assigned 12
vCPUs. The second VM is assigned 10 vCPUs. It gives 22 vCPUs in total. IBM
MQ software is installed on both VMs.

If a connection to the VM manager is not defined, BigFix Inventory does
not have access to information about the number of sockets and physical
cores on the server on which the VMs are deployed. It has access only to
information about the number of vCPUs that each VM is assigned. The sum
of vCPUs to which IBM MQ software has access is greater than the number of
physical cores that are available on the server.
If a connection to the VM manager is not defined, the number of vCPUs to
license is 22. If the connection is defined, 22 vCPUs are capped to 16 physical
cores and thus the number of vCPUs to license is 16.

Related information
High-water mark

Fixed PVU and VPC values for instances running in the
warm standby mode
The licensing model of some IBM products, such as DB2, defines that product instances
that run in the warm standby mode consume a fixed number of PVUs or VPCs. To report
metric utilization by such product instances, assign them with the PVU Warm Standby or
VPC Warm Standby metric.

Fixed values
License Metric Tool reports the following fixed number of metric units per product instance:
• 100 PVUs if the product is assigned the PVU Warm Standby metric.
• 1 VPC if the product is assigned the VPC Warm Standby metric.
Note: The values are not configurable.

Calculating and reporting the utilization
Before you start, read the license agreement for your product. If the agreement states that
product instances that run in the warm standby mode consume 100 PVUs or 1 VPC per
instance, assign the instances with the PVU Warm Standby or VPC Warm Standby metric
on the Software Classification report. For more information, see: Assigning components to
products.
PVU subcapacity and VPC
Utilization of the PVU Warm Standby or VPC Warm Standby metric is reported
separately from the utilization of the PVU subcapacity or VPC metric for
the product. To obtain the final utilization of the license metric, add the two
values that are reported on the All Metrics report or in the audit snapshot. For
example, IBM DB2 Enterprise Server Edition Processor Value Unit consumes
the following number of PVUs.
• 1200 PVUs under the subcapacity license.
• 300 PVUs by instances that run in the warm standby mode.

The overall utilization of PVU by this product is 1500.

PVU full capacity
If you report PVU full capacity instead of the PVU subcapacity for a product,
assign all product instances, including the ones that run in the warm standby
mode, to the PVU license metric. Do not assign any product instances to the
PVU Warm Standby metric.
Flex Point offerings and Cloud Paks
If the product is further assigned to a Flex Point offering or a Cloud Pak,
manual calculation is not needed. The two values are automatically summed
up while License Metric Tool calculates the overall metric utilization for the
FlexPoint offering or a Cloud Pak. For example, IBM DB2 Enterprise Server
Edition Processor Value Unit consumes the following number of PVUs.
• 1200 PVUs under the subcapacity license.
• 300 PVUs by instances that run in the warm standby mode.
The product is assigned to IBM Db2 Advanced Edition Extension for IBM Cloud
Pak for Data. The Cloud Pak is licensed for the number of consumed VPCs.
License Metric Tool applies proper ratio to the PVU values that are reported
for IBM DB2 Enterprise Server Edition Processor Value Unit and calculates
utilization of VPC by the Cloud Pak.

Adding the PVU Warm Standby or VPC Warm Standby metric to a product
The software catalog contains a number of products for which the license agreement states
that product instances that run in the warm standby mode consume 100 PVUs or 1 VPC per
instance. If the license agreement for your product states the same, but the option to assign
the PVU Warm Standby or VPC Warm Standby metric is not available, add the metric on the

Products & Metrics report. For more information, see: Assigning an additional metric to a
product.

Other uses
If the license agreement for your product states that the product uses 100 PVUs or 1 VPC
per instance in a scenario other than the warm standby mode, for example the hot standby
mode, you can assign the product with the PVU Warm Standby or VPC Warm Standby
metric.

Software classification
After new components are discovered, they are assigned to products based on bundling
rules. If the initial assignment does not reflect your entitlements, work with the software
inventory until it matches the entitlements. To make metric calculation accurate, assign
each component to a product, exclude, or suppress the instances that should not be
included in the calculation, and confirm your actions. After you confirm the actions, the
classification is complete, and the metric calculation is accurate.
Click a selected step to view detailed instructions

Bundling Assistant
Bundling assistant assigns instances of discovered components to products based on five
bundling rules: bundling tags, part numbers, partition collocation, infrastructure collocation,
and stand-alone product discovery. Results of this assignment are shown on the Software
Classification panel.

Bundling assistance process
After a component is discovered, it undergoes the process of bundling assistance. During
the process, bundling rules are applied to discover possible component-product relations.
Each relation is evaluated and assigned an internal score. The component is assigned to the
product with the highest score.
If the discovered component belongs to the product and license metric assigned during
bundling assistance, you can confirm the assignment. Otherwise, assign the component
to a different product or license metric so that the relation reflects your entitlement, and
confirm it. If the assignment is not confirmed, it might be automatically changed. It might
happen when a new software catalog is uploaded or when a different product is suggested
as the best bundling option based on the new results of bundling assistance.
Important: Instances that are a part of an excluded product cannot be bundled
again automatically. Instances can be bundled with excluded products only if they
are associated with the excluded products based on the software catalog or the
stand-alone product discovery. Any new instance that is assigned to the excluded
product is also excluded.

Bundling rules
The following table lists rules that are used during the process of bundling assistance.
Table 172. Bundling rules
Rule
Custom bundling

Description
This rule assigns a component to the product and license
metric based on the custom bundling that was defined
manually.

Bundling tags

This rule assigns a component to the product and license
metric that are represented by the part number listed in the
bundling tag. The tag is placed on the computer where the
component is installed which allows for assigning the spe

Table 172. Bundling rules (continued)
Rule

Description
cific instance of the component to the right product and li
cense metric.

Part numbers/Setting en This rule uses part numbers that you upload to BigFix In
titlements

ventory to narrow down the list of products and license
metrics to which a component can be assigned to the
ones that you purchased. The rule instructs bundling al
gorithm to prefer products selected manually by end user
through Set Entitlement function or by Upload of Part num
bers that is uploaded when suggesting bundling option.

Partition collocation

This rule discovers components that are installed on the
same partition and are related to the same product in the
software catalog.

Infrastructure collocation This rule discovers components that are installed in the
same infrastructure and are related to the same product
in the software catalog. The search does not include the
computer on which the component is installed.
Stand-alone product dis

This rule identifies all products to which a component can

covery

be assigned and chooses the product for which the fewest
components are listed in the software catalog.

Related information
Main background application tasks

Bundling tags
Available from 9.2.5. Bundling tag is a type of the ISO/IEC 19770-2 supplemental
tag. It allows for unambiguously assigning a component to a product and license metric
based on the part number that is specified in the tag. When a bundling tag is available, it

takes precedence over other bundling rules. Thus, you can create bundling tags to facilitate
the process of software classification.

Example
A bundling tag was manually created for the database component. The tag contains a part
number that represents the product and license metric to which the component should be
assigned. The part number is correlated with the information from the software catalog. It is
established that the part number represents Product 2.
The database component can be assigned to two products. Based on the part number from
the bundling tag, the database component is assigned to Product 2. The assignment needs
to be manually confirmed.

Details
• Bundling tags can be created only for IBM products.
• Bundling tags can be created only for products that are discovered by SWID tags.
• The bundling tag must be placed in the same directory as the SWID tag.
• The bundling tag can contain only one part number.
• PersistentId in the bundling tag and SWID tag must be the same.

Supported schemas
BigFix Inventory supports bundling tags in the 19770-2:2014-CD1 and 19770-2:2015
schemas.

Example of a bundling tag in the 19770-2:2015 schema
<?xml version="1.0" encoding="UTF-8"?>
<SoftwareIdentity
name="IBM DB2 Enterprise Server Edition"
tagId="ibm.com-b3414ccd1e364aa6b82f4e1c3adecdf6-D0NU9LL"
version="10.5.0"
versionScheme="multipartnumeric"
supplemental="true"
xmlns="http://standards.iso.org/iso/19770/-2/2015/schema.xsd"
xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"
xsi:schemaLocation="http://standards.iso.org/iso/19770/-2/2015-current/sche
ma.xsd">
<Meta productId="PN:D0NU9LL" />
<Link rel="parent" href="swidpath://SoftwareIdentity
[Meta/@persistentId='b3414ccd1e364aa6b82f4e1c3adecdf6']" />
<Entity name="BigFix" regid="ibm.com" role="licensor publisher" />
<Entity name="customer" regid="customer.com" role="tagCreator"/>
</SoftwareIdentity>

Related information
Support for ISO/IEC 19770-2

Manually creating bundling tags
Available from 9.2.5. You can facilitate the process of software classification by
manually creating bundling tags. When a bundling tag is placed on the computer where
a component is installed, the component is automatically assigned to the product that is
specified in the bundling tag.
Creating bundling tags is most effective when your company uses a process of packaging
software installers. In this case, you can add a bundling tag to the packaged installer, and
automatically place it on the computers during the installation.

1. Find the SWID tag that is used to discover the component.
a. In the top navigation bar, go to Reports > Software Installations.
b. Find the component, and click the link in the Details column. Information about
the SWID tag and its location is displayed at the bottom of the page.
2. Go to the computer where the component in installed and open the SWID tag.
To create a bundling tag, you need the following information from the SWID tag.
• name
• version
• persistentId
BigFix Inventory supports SWID tags in the 19770-2:2014-CD1 and 19770-2:2015
schemas. The information necessary to create the bundling tag is available in SWID
tags in both schemas. The following example shows SWID tag in the 19770-2:2014CD1 schema.
<?xml version="1.0" encoding="UTF-8"?>
<SoftwareIdentity name="IBM Control Desk"
uniqueId="0ecd37302a7648a5aca7a26aec76731d-7.6.0"
version="7.6.0"
versionScheme="multipartnumeric"
xmlns="http://standards.iso.org/iso/19770/-2/2014-CD1/schema.xsd"
xmlns:ds="http://www.w3.org/2000/09/xmldsig#"
xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"

xsi:schemaLocation="http://standards.iso.org/iso/19770/-2/2014-CD1/sc
hema.xsd
swid.xsd">
<Meta persistentId="0ecd37302a7648a5aca7a26aec76731d"/>
<Meta taxonomyCode="SSWT9A"/>
<Meta taggingProcess="4-1-20150603"/>
<Entity name="IBM" regid="regid.1986-03.com.ibm" role="licensor
publisher tagCreator"/>
</SoftwareIdentity>

3. Open a text editor and create a bundling tag according to the following template.
<?xml version="1.0" encoding="UTF-8"?>
<SoftwareIdentity name="IBM Control Desk"
uniqueId="0ecd37302a7648a5aca7a26aec76731d-7.6.0"
version="7.6.0"
versionScheme="multipartnumeric"
xmlns="http://standards.iso.org/iso/19770/-2/2014-CD1/schema.xsd"
xmlns:ds="http://www.w3.org/2000/09/xmldsig#"
xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"

xsi:schemaLocation="http://standards.iso.org/iso/19770/-2/2014-CD1/sc
hema.xsd
swid.xsd">
<Meta persistentId="0ecd37302a7648a5aca7a26aec76731d"/>
<Meta taxonomyCode="SSWT9A"/>
<Meta taggingProcess="4-1-20150603"/>
<Entity name="IBM" regid="regid.1986-03.com.ibm" role="licensor
publisher tagCreator"/>
</SoftwareIdentity>

Where:
• COMPONENT_NAME is the name of the component as specified in the SWID tag
• PERSISTENT_ID is the persistent ID of the component as specified in the SWID
tag
• VERSION is the version of the component as specified in the SWID tag
• PART_NUMBER is the part number that represents the product to which the
component is to be assigned and its license metric
• CUSTOMER is the name of your organization
• CUSTOMER.COM is the registration identifier of your organization in the URI format.
For more information, see: Uniform Resource Identifier (URI): Generic Syntax.
A bundling tag that is created based on the SWID tag presented in step 2 looks as
follows.

<?xml version="1.0" encoding="UTF-8"?>
<SoftwareIdentity name="BigFix Control Desk"
tagId="ibm.com-0ecd37302a7648a5aca7a26aec76731d-D0LKPLL"
version="7.6.0"
versionScheme="multipartnumeric"
supplemental="true"
xmlns="http://standards.iso.org/iso/19770/-2/2015/schema.xsd"
xmlns:ds="http://www.w3.org/2000/09/xmldsig#"
xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"

xsi:schemaLocation="http://standards.iso.org/iso/19770/-2/2015-curren
t/schema.xsd
swid.xsd">
<Meta productId="PN:D0LKPLL" />
<Link rel="parent"
href="swidpath://SoftwareIdentity[Meta/@persistentId='0ecd37302a7648a
5aca7a26aec76731d']" />
<Entity name="IBM" regid="ibm.com" role="licensor
softwareCreator" />
<Entity name="MyCompany" regid="mycompany.com"
role="tagCreator"/>
</SoftwareIdentity>

4. Save the bundling tag. Name it according to the following template:
<Tag_Creator_Regid>-<Component_Name>-<Part_Number>.swidtag

For example, mycompany.com-IBM_Control_Desk-D0LKPLL.swidtag.
5. Place the bundling tag in the same location as the SWID tag.
Place the bundling tag on all computers on which the component is to be assigned to
the product specified in the bundling tag.
6. Wait for the next software scan and import of data.
7. Confirm the assignment of the components.

Note: You can easily assign all components that are bundled based on the
bundling tag when you use the Software Classification panel.
a. In the top navigation bar, go to Reports > Software Classification.
To filter out the report to components that were bundled by using bundling tags,
hover over Configure, and click Configure View. Then, specify the following
filter: Bundling Tag Used, equal to, Yes.
b. Press CTRL + A to select all components.
c. To confirm the assignment, hover over Confirm, and click Confirm.

Part numbers
Part numbers represent software products that you purchased and license metrics that
these products use. Part numbers are used to increase the accuracy of bundling assistant
by narrowing down the number of possible products to which a discovered component can
be assigned.

Example
Bundling assistant assigns a database component to one of the products that were
discovered in your infrastructure. However, the database component can also be potentially
assigned to another product.

Before you confirm the assignment of the database component or change it manually, you
can import the part numbers file to BigFix Inventory. Based on the file, and the componentproduct relations that are defined in the software catalog, the initial assignment of the
database component is more accurate.

Types of part numbers
There are three types of part numbers:
• Catalog part numbers are provided by BigFix together with the software catalog. Each
part number represents a product and a license metric that this product uses.
•

Custom part numbers are user-defined part numbers that are not included
in the software catalog by default. They might be assigned to products with custom
deals, or any additional software you wish to add to the software catalog.

• Uploaded part numbers are part numbers of products that you purchased. You can
download the uploaded part numbers list from the Passport Advantage website
or create it manually, and upload the file on the Part Numbers Upload panel. Part
numbers that represents products that you purchased and their license metrics are
matched against the part numbers that are provided with the software catalog to
improve the results of bundling assistance.
takes into consideration part numbers that start with the following letters:
• D - part numbers that represent License Entitlements
• E - part numbers that represent Support and Subscription

Limitations
The extent to which part numbers can improve bundling assistance is limited by the
following factors:
• Part numbers influence the assignment of only those components whose assignment
is not confirmed
• Part numbers that were purchased before 2010 are not contained in the software
catalog
• Part numbers that represent products that have limited availability are not contained
in the software catalog
• Part numbers that represent products that are available only outside of the United
States are not included in the catalog
Note:

You can add a custom part number to the software catalog

for any existing product-license metric pair. This solution allows you
to customize the software catalog, and ensure that products that were
purchased before 2010, or are specific to your business and geographical
location are additionally considered during bundling assistance. For more
information, see: Adding custom part numbers.

Adding custom part numbers
Available from 9.2.7. Add custom part numbers to the software catalog to
improve the results of bundling assistant of software components.
You must have the View Software Catalog and Signatures and Manage Licenses
permissions to perform this task.
You can add custom part numbers to any product-license metric pair existing in the
software catalog. After adding custom part numbers to the catalog, make sure to include
these custom part numbers in the part numbers file that is uploaded to BigFix Inventory.
After the next data import, the custom part numbers are matched against the uploaded
part numbers and used for bundling assistant. For more information, see: Uploading part
numbers.

1. Log in to BigFix Inventory, and go to Reports > Products & Metrics.
2. Select the product for which you want to add a custom part number.
3. Hover over the Edit, and click Edit Part Number.
4. Provide a custom part number, or part numbers in the Custom Part Number field.
Separate each number with a comma. The custom part number can contain letters,
numbers and an underscore (_). Other characters are not allowed. Each part number
needs to be unique. Thus, you cannot add a duplicate of an existing catalog part
number.
5. Click OK.
The specified custom part numbers are added to the software catalog, and displayed in the
Catalog Part Numbers column.
To remove custom part numbers, select the product, hover over the Edit, and click Edit Part
Number. Then, remove custom part numbers from the list, and click OK.

Preparing the part numbers file
The part numbers file can be used to increase the accuracy of bundling assistant by
narrowing the number of possible products to which a discovered component can be
assigned. You can download the file from Passport Advantage® or create it manually.
If you added custom part numbers to the software catalog, make sure that they are included
in the part numbers file. Otherwise, the custom part numbers are not matched against the
uploaded part numbers and are not used during bundling assistance.
Restriction: BigFix Inventory supports only CR LF and LF end of line characters.
While editing the part number file do not use CR end of line characters specific for
Mac systems.
Downloading the file with part numbers from Passport Advantage®

1. Download the part numbers file from Passport Advantage.
a. Log in to Passport Advantage®.
b. From the menu on the top, select Reporting > Order history.
c. If applicable, select the relevant site or sites.
d. In the Type of order section, select All.
e. Specify the Sales order date and Sort by. Then, click Submit detail report. Your
report is ready.
f. To save the file, click Download report and then select Comma delimited.
Ensure that the file is in the CSV or ZIP format.
Important: If you are not able to download part numbers, you might not
have the required permissions on Passport Advantage.
2. If you do not have custom part numbers, create a CSV file that contains a single
column without a header. This file can only contain Passport Advantage part numbers,
not your custom part numbers. List each part number in a new line. Do not use
quotation marks (" ") to define part numbers.
Example:
D07UMLL
D08UMLL
D09UMLL

3. If you have custom part numbers that are not available on Passport Advantage,
add them to the downloaded file. Ensure that the edited file meets the following
requirements:
a. The file contains two mandatory columns: Part number and Order type. Only
the rows that contain the Licenses element in the Order type column are
imported. The list of part numbers can include Passport Advantage® part
numbers, as well as your custom part numbers. You can add any other columns

to the file, however, these columns are ignored during upload. Use a comma as
a field separator and quotation marks (" ") as a text delimiter.
b. Part numbers that should be imported to BigFix Inventory must have the value
"Licenses" in the Order type column. Rows with other values are skipped.
Example
"Part number", "Order type"
"D07UMLL", "Licenses"
"D08UMLL", "Licenses"
"Custom part number", "Licenses"

After you prepare the file, upload the part numbers.

Uploading part numbers
Upload and import part numbers to increase the accuracy of bundling assistance of
software components.
You must have the Manage Entitlements and Part Numbers Uploads permission to
perform this task.
If you added custom part numbers to the software catalog, make sure that they are included
in the part number file. Otherwise, the custom part numbers will not be matched against the
uploaded part numbers and used during bundling assistance.
1. Prepare the part numbers file.
2. In the top navigation bar, click Management > Part Numbers Upload.
3.

Choose the computer group for which you want to upload the part numbers.
Note: The part numbers are taken into account only for the software that is
installed on the computers that belong to this group. They are also visible only
to the user who is assigned to this computer group. For example, if you upload
part numbers for a subgroup of the All Computers group, the part numbers are

visible only to the user who is assigned to the subgroup and are not visible to
the user who is assigned to the All Computers group.
4. Click Browse and choose the part numbers file to upload. You can upload a CSV or a
ZIP file.
5. Optional: If you want to overwrite the existing part numbers, select Overwrite existing
part numbers. Otherwise, the new part numbers are added to the existing ones.
The option is enabled only if you previously imported a part numbers file for the
computer group that you selected in step 3.
6. Click Upload.
When you upload the file, a new entry is created in the Upload History table. The
status is Pending until you run the import.
Important: If more than one entry has the Pending status, only the latest part
numbers file is imported.
7. Wait for the scheduled import or run it manually.
The part numbers were imported to BigFix Inventory.
If the part numbers are not matched with products after you upload the part number file and
run import, see: Catalog problems.
• Removing the imported part numbers from BigFix Inventory server
If you want to remove the part numbers from the server, go to Management > Part
Numbers Upload, click Remove All Part Numbers and then run the import. You can
remove the part numbers only if you previously imported the part numbers file to the
server.
• Checking what part numbers are currently imported to BigFix Inventory
You can check what part numbers are currently imported to BigFix Inventory. To do
it, go to Reports > Products & Metrics and configure the report view to display the
Imported Part Numbers column. You can also narrow down the report to only see the
products that are linked with the imported part numbers by setting the following filter:
Imported Part Numbers, is not empty.

Partition collocation
Partition collocation is a rule that discovers component instances that are on the same
partition and are related to a product in the software catalog. If any of the discovered
component instances has a confirmed, one-to-one, or auto-bundled relation to the product,
the other instances are automatically bundled with the same product.

Example
The assignment of the Server 2 component to Product 4 is simple, auto-bundled, or
manually confirmed. The database component is assigned to Product 1. Both components
are on the same partition.

Based on the software catalog data, the database component is automatically reassigned
to Product 4.

Components that are not evaluated
Some components are not evaluated as part of the partition collocation rule and do not
affect other components that are installed on the same partition. The components include:

• Tivoli Monitoring for Databases - <name> Agent
• Tivoli Monitoring - <name> Agent

Infrastructure collocation
Infrastructure collocation is a rule that discovers component instances that are installed in
the same infrastructure and that are related to a specific product in the software catalog.
The search does not include the agent on which the product is installed. If any of the
discovered component instances has a confirmed, one-to-one, or auto-bundled relationship
with the product, the other instances are automatically bundled with the same product.

Example
The assignment of the Server 2 component to Product 4 is simple, auto-bundled, or
manually confirmed. The database component is assigned to Product 1. Both components
are in the same infrastructure.

Based on the software catalog data, the database component is automatically reassigned
to Product 4.

Components that are not evaluated
Some components are not evaluated as part of the infrastructure collocation rule and do
not affect other components that are installed in the same infrastructure. The components
include:
• Tivoli Monitoring for Databases - <name> Agent
• Tivoli Monitoring - <name> Agent

Stand-alone product discovery
Stand-alone product discovery is a rule that identifies components that have more than
one default component to product relation. For each relation, it compares the name of
the component with the name of the product and calculates the Levenshtein distance.
During the calculation, production components are assigned to production products, and
non-production components such as trial, demonstration, limited, or express versions
are assigned to non-production products. The algorithm does not favor shorter names,
but names that have more letters in common. Based on the calculations, the productcomponent relation with the shortest distance (represented by the lowest score) is
selected. If a few relations have the same score, they are ordered alphabetically.

Example
The agent discovers the database component and the server checks which products
contain this component in the software catalog. The database component is assigned to
the product whose name produces a match with the lowest score, in this case, Product 1.

Software Classification panel
Available from 9.2.7. Software Classification panel provides an overview of your
software inventory and the relations between the discovered software components and
licensable products. It provides a flat structure with software installations broken into single
components, which makes it easier to view your software assets and manage relations
between them.
Note: The Software Classification panel replaced the IBM Software Classification
report and is the only integrated place to manage the discovered software
components and their relations with licensed products.

Permissions
You must have the Manage Software Classification permission to view the panel and
classify software. To view some additional columns related to computers on which the
components are installed, you also need the View Endpoints permission.

Panel overview
Before you start working with the discovered components, see the details of the Software
Classification panel to understand the available options and columns.

The Software Classification report is one of the most crucial reports in BigFix Inventory.
You can view your software assets and manage relations between them. The software
classification is reflect on the All IBM Metrics report and thus, ensures the currency and
accuracy of the audit snapshot.
Menu
The menu consists of a set of options that allow you to properly classify your software
inventory.
• Assigning components to products
• Assigning products to FlexPoint bundles
• Assigning products to Cloud Paks
• Excluding and suppressing software instances
• Confirming assignment of software components
• Adding and removing tags

Apart from the options that are available in the menu, you can also create custom rules to
automatize the software classification process. For more information, see: Creating and
managing custom rules
Report columns
The list of the default columns is limited. However, you can customize the report view and
add or remove the columns according to your needs by using the Configure View option,
under the Configure menu.
For more information about the columns, see: Report columns
Default columns
• Component Name shows components that were discovered on your computers.
• Component Detailed Version shows the version of the software component that is
installed on the computer. For more information, refer to Component Detailed Version.
• Version shows version of the component.
• Product Name shows products under which the components are licensed based on
the software catalog.
• Metric shows license metric that is assigned to the product.
• Computer Name shows the computer where a component was discovered.
• Installation Path shows details about an installationpath of IBM products.
• Details shows details, such as publisher, component, installation path, and signatures.
Starting from version 10.0.2, the details view shows only matched detection.
It does not show signatures that does not match. If a product has been installed in
different locations, the details view shows only the relevant path of the selected row. It
also includes a link with a complete list of signatures.
Additional columns not enabled by default
• Always Not Charged indicates whether a component is always not charged.
• Bundling Tag Used shows whether the product assignment is based on a bundling
tag.
• Charged indicates whether the component is charged, or not charged based on its
license.

• Comment shows a comment that was entered while excluding, or suppressing the
software instance from pricing calculations.
• Computer Deletion Date shows the date and time when the computer stopped being
discovered, for example because the computer was removed from the infrastructure,
the data source was removed, or the BigFix client was uninstalled.
• Confirmed indicates whether the software classification was manually confirmed.
• Discovery End indicates when the component instance was reported for the last time.
If the component is still detected, the column shows <n/a>.
• Discovery Start indicates when the component instance was reported for the first
time.
End of Support indicates the date when the software component reaches

•

EOS (End of Support). For information about how to change the date, see: Changing
end of support date.

The EOS date of Microsoft products, such as Microsoft

SQL Server, Microsoft Excel, Windows OS, and Visual Studio has been updated.
The EOS of non-IBM components has also been updated. The updated EOS of the
Microsoft products have been merged with the non-IBM components.
Vulnerability Risk (Preview) shows Common Vulnerabilities and Exposures

•

(CVEs) that were matched with the particular software component through its
detailed version. The column can contain multiple values that are displayed after
expanding. For more information about CVEs, see: Preview: Checking Common
Vulnerabilities and Exposures (CVEs).
• Excluded indicates whether the product on a particular computer is currently excluded
from pricing calculations.
FlexPoint Bundle shows the FlexPoint bundle to which the product is

•
assigned.

• IBM-provided Bundling Option indicates whether the product has the selected
component listed as a bundling option in the software catalog provided by IBM.
• Imported Part Numbers shows the part numbers that you imported to BigFix
Inventory.
• One to One indicates whether the product to which the component is currently
assigned is the only bundling option that is available in the software catalog.
• Present indicates whether the component instance is currently installed.

• Shared indicates whether a component instance is shared between multiple products.
• Suppressed indicates whether the component is currently suppressed from the
inventory. For more information on supression, see Excluding and suppressing
software instances.
Note:

With improvements for ISO SWID tags processing in

versions 10.0.2 and 10.0.4, BigFix Inventory is capable to read information
from most ISO SWID tags released by vendors. This includes the ability to
recover from issues within the tag itself.
Reporting of software through ISO SWID tags is not normalized and the
reports are shown as usual. Currently, the following ISO SWID tags were
indentified that results in duplicate discovery of existing software catalog
entries with below names:
◦ with the published defined as: Adobe Systems Incorporated
◦ with the published defined as: Microsoft Corporation
◦ with the component name of: Red Hat Enterprise Linux
Starting from version 10.0.4, predefined custom rules have been
created to suppress the duplicate discovery of software which have been
already discovered once.

With version 10.0.9, the issue of not marking

already discovered software have been addressed. In future releases, there
might be added capability to reject ISO SWID tags overlapping with catalog
content.
Product Publisher Name indicates the name of the publisher of a product that

•

a software instance is assigned to. The column is empty if no product assigned.

Customization
Sorting
You can adjust the view by sorting the displayed data by as many columns
as you need. To sort the data by multiple columns, hold SHIFT, and click the
columns. The column you choose first takes precedence in sorting. Other

columns are sorted in the order of the selection. In this way, if the data in
a single column is the same (for example, BigFix Platform Agent), you can
choose another column to further sort it by (for example, by version and
product name).

To clear a sorted column, hold CTRL or CMD on Mac, and click on this column.
To clear all, click any of the columns.
Multiselect
To simplify your actions, you can select multiple items at once. To select
multiple components:
• Hold CTRL, or CMD on Mac, to add another item to the current selection.
• Hold SHIFT and select two items to extend the selection to all items in
between (any previous selection is canceled).
• Select all instances by using CTRL + A, or CMD + A on Mac.
Restriction: You can select up to 250 000 components at once.

Limitations
Currently, the Software Classification panel has the following limitations:

• When you exclude, or suppress instances, the notification informs you whether the
action was successful or not. However, the notification does not provide the number
of instances affected, or any further details.
• When you exclude multiple products or products on multiple computers, the exclusion
window lists these items separately. The order does not reflect the relation between
the computer and the product. The lists are limited to display up to three items.
• When you reassign the component to the different release of the same product, and
this component is currently assigned to the excluded release of the product, the
exclusion flag is not cleared.
• If you created and saved a custom report filtered by Exclusion Status in the versions
before 9.2.6, the report is not replicated when you upgrade to the newest version of
BigFix Inventory.
• <Before

> Installation path is provided only for IBM products.

• When you reach the limit of unique custom rules, and create an additional rule without
applying a different filter, or refreshing the Software Classification panel view, the
additional rule is added.
• When you sort components by metric, components with the same metrics are
grouped together, but metrics are not sorted alphabetically.
• Going to the first and last row by using the HOME and END keys is not supported.

Benefits and limitations of the Software Classification panel
Available from 9.2.7. The Software Classification panel replaced the BigFix
Software Classification panel. It displays all your software installations and provides a
streamline software management, and classification.

Benefits
Main benefits of the Software Classification panel:
• Provides improved filtering capabilities, multiple filters can be applied to all available
columns.
• Allows for flexible ordering and sorting of data by any column.
• Allows for selecting multiple components and assigning them to a product in one go.

• Provides extended search capabilities when you assign components to products. The
list of target products can be searched by product name, version, metric, or by other
attributes.
• Shows components that are discovered with software ID tags.
• Shows components that were installed in the past but are no longer detected, for
example because they were uninstalled or the computer on which they were installed
was decommissioned.

Limitations
Currently, the Software Classification panel has the following limitations:
• When you exclude, or suppress instances, the notification informs you whether the
action was successful or not. However, the notification does not provide the number
of instances affected, or any further details.
• When you exclude multiple products or products on multiple computers, the exclusion
window lists these items separately. The order does not reflect the relation between
the computer and the product. The lists are limited to display up to three items.
• When you reassign the component to the different release of the same product, and
this component is currently assigned to the excluded release of the product, the
exclusion flag is not cleared.
• If you created and saved a custom report filtered by Exclusion Status in the versions
before 9.2.6, the report is not replicated when you upgrade to the newest version of
BigFix Inventory.
• <Before

> Installation path is provided only for IBM products.

• When you reach the limit of unique custom rules, and create an additional rule without
applying a different filter, or refreshing the Software Classification panel view, the
additional rule is added.
• When you sort components by metric, components with the same metrics are
grouped together, but metrics are not sorted alphabetically.
• Going to the first and last row by using the HOME and END keys is not supported.

Using BigFix Inventory to calculate license for BigFix products
BigFix Inventory can calculate licenses for products from BigFix portfolio, BigFix endpoints
are correctly classified to appropriate products and metrics. To automate that process, a
few fixlets are introduced into BES Support site. This document provides you information on
how to use these fixlets. The document also describes some additional steps to be followed
in BigFix Inventory. For more information, see also Activating the license counting process
(hcltechsw.com).
Prerequisite: Before performing any step, check the prerequisites at Prerequisites
(hcltechsw.com).
Most of the process is executed by generating components in BigFix Inventory.
Components are generated using tags that are put on the endpoints by using Generate
BigFix license tags fixlet. After the components are generated, a user must manually assign
a product with correct metric to it.
Tags are generated by Generate BigFix license tags fixlet according to the following table:
OS type

OS name example

Default metric

Supported UNIX

Solaris, HP-UP, AIX

RVU

Supported LINUX

SLES, RHEL, Debian, Ubun

RVU

tu, Centos
Supported Microsoft Win

Windows 2008, Windows

dows Server

2012

Supported Microsoft Win

Windows 7, Windows 8,

dows non-Server

Windows 10

RVU

ClientDevice

For example, on Windows 10 the default metric for all BigFix products is ClientDevice.
Based on the license agreement between the customer and HCL, the actual licensing may
differ from the default table. For example, a customer can use the ClientDevice licensing for
servers instead of the default RVU if they have such agreement.

In that situation, it is possible to override the default metrics by using the Categorize RVU/
MVS/ClientDevice clients fixlet.
The following topics explain the process of license counting. Step 1 is optional and it
explains how to override default metrics. Start from step 1, if you want to override default
metrics. Else, begin with step 2.

Running the "Categorize RVU/MVS/ClientDevice clients" fixlets
(Optional)
If you want to override default metric mapping to BigFix products, run the fixlet. For more
details, refer to Categorizing the clients (hcltechsw.com).
Note: This task is optional.

Using the fixlet
To use the fixlet, perform the below steps:
1. In the BigFix console, go to Sites > External Sites > BES Support > Fixlets and Tasks.

2. Search "Categorize" fixlet by using the keyword 'categorize'. A total of 3 fixlets
matching the keyword, appears.
3. Select the fixlet according to your BigFix license entitlements.

4. Select the products for which you want to override the default product. The default
metric for the endpoints and products that you select is overridden by ClientDevice.
The default metric for the ones you do not select remains same.
5. Click on Take Action and select the endpoints.

Example: Linux and one Windows machine

6. Click OK. The fixlet starts running.
Note: The Categorize fixlet only overrides the default metric used during Generate
BigFix license tags fixlet. The fixlet does not change anything else.

Running the "Distribute site mapping" file fixlet (Mandatory)
Distribute site mapping file fixlet is used to update the licensed products and their related
sites on the client. It is mandatory to run Distribute site mapping fixlet before using
Generate BigFix license tags fixlet. For more details, refer to Distributing the site mapping
file (hcltechsw.com).

Using the fixlet
To use the fixlet, perform the below steps:

1. Select the fixlet at Sites > External Sites > BES Support > Fixlets and Tasks.

2. Click on Distribute. Once the action is complete, a message INFO: file created and
uploaded appears.

Generate BigFix license tags (Mandatory)
After running the Distribute site mapping file fixlet you can run Generate BigFix license tags
to update the license tag of the product for each site to which the clients are subscribed.
The tags are put and stored on the chosen endpoints. For more information, refer to
Generating the license tags (hcltechsw.com).

Using the fixlet:
To use the fixlet, perform the below steps:
1. In BigFix Console, go to Sites > External Sites > BES Support > Support > Fixlets
and Tasks.

2. Click Take action and select the endpoints you want to run it on.

Result: The SWID tags are put on the endpoint in the BigFix folder.

Initiate software scan fixlet (Mandatory)
After running all the previous fixlets (Categorize fixlet is optional), wait until the next
software scan or use the Initiate Software Scan fixlet on the endpoints you have chosen
during previous steps.

After the scan finishes, import the scanner results to BigFix Inventory. To import the
results, wait until the next scheduled import finishes (depending on your import settings) or
manually import the results through the BigFix Inventory WebUI in the Management > Data
Import > Import Now.

Manual assignment in the BigFix Inventory WebUI (Mandatory for
products other than BigFix Inventory)
In the previous steps you have generated new tags on the endpoints. After the scan and
import new components were generated, you must manually assign correct products to
them.

Assigning the products
To assign products to components, perform the below steps:
1. Go to Reports > Software Classification.
Important: For license calculation to work correctly, select IBM products with
the latest version while assigning products.

New components are created on the selected endpoints and the existing component
(BigFix Platform Agent) got BigFix Inventory assigned to it with the default or
overridden metric.
For BigFix Inventory, no further step is required. For other BigFix products, you must
manually assign products.
2. To assign products to other BigFix products, go to Configure > Configure View and
use a right filter to select the product. For example, for Lifecycle, use component
name as 'BigFix Lifecycle ClientDevice'. ClientDevice is the metric name here. You can
use RVU or MVS accordingly.

3. After applying specific filters, choose all the rows by checking the checkbox at the top
left. All the rows get highlighted.

4. Select Assign > Choose from Catalog.

5. Deselect the “List products for which the component is listed as a bundling option”
and enter the product name.

6. From the list, select IBM BigFix Lifecycle with the latest version (9.5) and correct
metric. In this example, we use ClientDevice, so we assign the Client Device metric.
7. Select the Automatically confirm the affected component checkbox and click Assign.
On the next page, choose if the component is charged or not.
8. Click Assign.

All selected components should have a correct product assigned to it.

You have to repeat the manual assignment for every new unique component. If you
also have Compliance and Patch then you should also assign IBM BigFix Compliance
to BigFix Compliance and IBM BigFix Patch to BigFix Patch.
When you use the Generate BigFix license tags fixlet on other endpoints they will
be already assigned automatically. It is not required to do the manually assign them
again. It only works if you have previously assigned a product to a component with
the same name that you are generating, for example, if you have assigned IBM
BigFix Compliance to BigFix Compliance RVU then whenever you generate BigFix
Compliance RVU on other endpoints it will be automatically assigned but if you
generate BigFix Patch and there was no previous assignment of IBM BigFix Patch to
BigFix Patch then you must assign it manually.
Result: The licensing process has been done and now you can view the results in the
Reports > All IBM Metrics.

Setting entitlements
It is recommended to first import IBM owned part numbers to improve bundling
accuracy. Starting from BigFix Inventory 10.0.2, you can manually mark products as entitled
through Product & Metrics panel. You can also clear entitlements of previous entitled
products.
You must have following permissions to set and clear entitlements:
• View Software Catalog and Signatures
• Manage Entitlements and Part Numbers Uploads
1. If you have a list of part numbers that you own, prepare part number files and import
the part numbers. After you upload the file, products with part numbers are marked as
your software entitlements. For more information about the relation between changes
that you make to part numbers and software entitlements, see: Part numbers.
2. To manually declare a product entitlement, perform these steps:
a. In the top navigation bar, click Reports > Products & Metrics.
b. Select a product for which you purchased a license.
c. Hover over Entitle and click Set Entitlement.
Information about products for which you are entitled is visible on the Products
& Metrics report. When a component that is a part of a product for which you are
entitled is discovered, it is automatically assigned to this product.
Note: Software entitlements can be set for the primary computer group of the
user. Entitlements can not be set for child computer groups. For example, a
user with full permissions and access to “All Computers” group will be able to
set entitlement to the 'All Computers' computer group.
You can clear entitlements for a particular product.
To remove the entitlement, select a product, hover over Entitle, and click Clear Entitlement.
Then, click OK to confirm. The product is no longer marked as your software entitlement. If
you imported part numbers for this product, they are also removed to maintain consistency.

Note: Clearing entitlement also removes its imported Part Numbers.

Assigning components to products
Available from 9.2.7. After new components are discovered, they are associated
with products based on bundling rules. As a result, most components are automatically
assigned to products. Correct assignment of software components reduces the cost of
software ownership and ensures audit readiness. Compare the automatically created
bundles with information in your license agreement, confirm the accurate assignments, or
reassign the components to right products.
You must have the Manage Software Classification permission to view the Software
Classification panel and classify software. To view some additional columns related to
computers on which the components are installed, you also need the View Endpoints
permission.
Assign components to products based on the following scenarios:
• Assign a single component to a single product.
• Assign multiple components to a single product. To properly use this option, set filters
that limit the displayed components, select them, and assign to the product.
• Assign a single component more than once to share this component between multiple
products. Each assignment associates the component with one selected product. To
view all shared components, apply the following filter: Shared, equal to, Yes.

You can automate your software classification process by creating a set of custom rules
that will automatically classify your newly discovered software. For more information, see:
Creating and managing custom rules.
1. Log in to BigFix Inventory, and go to Reports > Software Classification.
2. Select a component or components that you want to assign.
3. Hover over the Assign icon

and click Choose from Catalog.

Tip: To narrow the list of displayed products, you can sort the data by
columns or use the search bar that is available at the top of each column.
After you type the search phrase, press Enter.
4. Select the product to which you want to assign the component and the license metric
that is suitable for your pricing calculations model.
• If you want to assign the component to a product according to a relation that is
defined in the software catalog, simply select the product from the list.
• If the product is not detected and the value of the Product Name column is <not
set>, see:Catalog Problems: The <not set> value appears under the Product

Name on Software Classification panel.
• If none of the products that is listed by default matches your license agreement,
create a custom relation known as custom bundling. You create a custom
bundling in the following situations.
◦ The component was obtained as part of a product that is not listed as an
existing relation.
◦

The type of the relation that is listed in your license agreement
is not available by default. For example, when the existing relation
between the component and the product is charged, but your license
agreement states that the component is not charged.

To create a custom bundling, perform the following steps.

a. Clear the List products for which the component is listed as a bundling
option check box to view all products that exist in the catalog, and select
the appropriate product.
b. Specify whether you want the relation between the component and
the product to be charged or not charged. If you specify the relation as
not charged, the component does not contribute to the license metric
utilization of the product to which it is assigned.
Creating a custom bundling impacts using bundling assistant. It increases
the chance for newly discovered components to get automatically bundled
according to custom bundling definition.
Note:

Starting from version 10.0.11, you can assign

components to products coming from template signatures, having
product version *.
5. Optional: To extend the current component assignment with the selected product
instead of reassigning the component, select Share component. The component
will be shared between the product to which it is currently assigned and the selected
product.
If you share the same component between multiple products, each assignment is
listed as a separate instance on the report.
Note: To stop sharing the component between multiple products, select all
instances of the component and assign them to a common product, but leave
the Share component check box cleared.
6. Optional: If you do not want the assignment to be automatically confirmed, clear the
Automatically confirm the affected components check box.
Note: To change the default setting of the check box, go to Management >
Advanced Server Settings, and change the value of the automaticConfirm
parameter according to your preferences.
7. To change the assignment, click Assign.

The component is reassigned to the specified product and metric. The change is reflected
on the report.
To ensure that metric utilization reflects the change of the component assignment, go to
Reports > All Metrics, and click Recalculate.

Excluding and suppressing software instances
Available from 9.2.7. If a software instance should not contribute to license metric
utilization, you can exclude it on the product level or suppress it on the component level.
Exclusion applies to all components that are assigned to a product and are installed on
the selected computer. Use it if license information specifies that the product should not
contribute to metric utilization under specific circumstances. Suppression applies to a
single component that is installed on the selected computer. Use it when a component is
improperly discovered.
You must have the Manage Software Classification permission to view the Software
Classification panel and classify software. To view some additional columns related to
computers on which the components are installed, you also need the View Endpoints
permission.
Exclusion
Exclude a product when it is installed on a non-production, test, or back up
computer and license information specifies that the product should not
contribute to license metric utilization under these circumstances. When you
exclude the product, all components that are assigned to this product and are
installed on the selected computer are excluded from metric utilization.
Excluded products and their components are still displayed on the Software
Classification report. They are also listed in the audit snapshot, together with
exclusion comments.
Suppression
Suppress a component when it is improperly discovered. For example, when
some files were not removed from the computer after the component was

uninstalled. Suppression applies only to the selected component on the
selected computer. A suppressed component is no longer assigned to any
product, and thus does not contribute to metric utilization.
By default, suppressed components are not displayed on the Software
Classification report. You can show them by removing one of the default
report filters. Suppressed components are not included in the audit snapshot
in order not to obscure the view. However, the components and suppression
comments are included in the Audit Trail.

1. In the top navigation bar, click Reports > Software Classification.
2. Optional: To filter down the report, hover over Configure, and click Configure View.
Then, specify appropriate filters.
3. Select one or more rows and hover over the Exclude

.

• To exclude the product on the selected computer, click Exclude Product from
Metric Calculation.
• To suppress the selected component on the selected computer, click Suppress
Component from Inventory.
4. Provide an obligatory comment.
If a comment was provided for any selected item before, it is overwritten. Exclusion
comment applies to all components that are assigned to the excluded product on the
selected computer. Suppression comment applies to the suppressed component on
the selected computer.
5. To automatically confirm the action, select Automatically confirm the affected
components.
Note: To change the default setting of the check box, go to Management >
Advanced Server Settings, and change the value of the automaticConfirm
parameter according to your preferences.

6. To complete the action, click Exclude > Suppress.
The action completes even if any of the selected items has already been excluded or
suppressed.
Excluded products and the suppressed components do not contribute to license metric
utilization. You can include them back to the calculations by using the Clear Exclusion,
or Clear Suppression option. The instances that you include back in the calculation are
marked as unconfirmed.
To review exclusion and suppression actions for IBM components and products, go to
Reports > Audit Trail.

Confirming assignment of software components
Available from 9.2.7. When the assignment of a component to the product is
correct, you can confirm it. The task is optional. However, components whose assignment is
not confirmed can be automatically reassigned to different products. It might happen when
a new software catalog is uploaded or when a different product is suggested as the best
bundling option based on the new results of bundling assistant. To avoid such a situation, it
is recommended to confirm the assignment of all components.
You must have the Manage Software Classification permission to view the Software
Classification panel and classify software. To view some additional columns related to
computers on which the components are installed, you also need the View Endpoints
permission.
1. In the top navigation bar, click Reports > Software Classification.
2. Confirm all components that are marked as One to One.
If a component relates to a single product in the software catalog, the relation is
marked as One to One. Previously, all IBM components that had a single bundling
option in the software catalog were automatically confirmed. Now, you can easily filter
the report to review these components, and confirm them. It ensures that you are fully
in charge of the software classification process.

a. Hover over Configure

and click Configure View. Then, add the following

filters to the filters that are already defined in this report, and click Submit.
• Publisher Name, equal to, IBM
• IBM-provided Bundling Option, equal to, Yes
• One to One, equal to, Yes
• Confirmed, equal to, No
b. Press CTRL + A, or CMD + A on Mac, to select all the filtered components.
c. Hover over Confirm, and click Confirm.
3. Confirm all assignments that are correct.
a. Select a component or components that you want to confirm.
b. Hover over Confirm, and click Confirm.

Creating and managing custom rules
Available from 9.2.7. You can create custom rules to automate the process of
software classification. The rules automatically perform the action that is defined by the
rule criteria. For example, when you create a custom rule while assigning a component to a
product, the rule is applied whenever the exact same component is discovered in the future.
You must have the Manage Imports and Manage Software Classification permissions to
perform this task.
Custom rules can be applied to:
• A single computer when they are created for this computer
• A computer group when they are created for this computer group
• Computer group to which the user is assigned. The user cannot choose a computer
group, and is limited to the group or groups to which the user belongs. The rule is

always applied to the current user group. When user's computer group changes, the
rule scope is revised.
Restriction: The number of unique custom rules you can create is currently
limited to 100.
Starting from application update 9.2.16, you can create a custom rule for
suppressing components.
1. Log in to BigFix Inventory, and go to Reports > Software Classification.
2. Filter the panel so that it shows only instances for which you want to create a custom
rule.
Tip: Specify the exact version of the component to avoid inconsistency.
3. A custom rule can be created only when you select all instances that are currently
displayed. To select all filtered instances, press Ctrl + A, or CMD + A on Mac.
4. Assign a component to a product, or exclude a product or suppress a component
from software calculations.
5. Before you confirm the assignment, exclusion, or suppression select the Create a
custom rule check box.
Restriction: You cannot create a custom rule and share the component at the
same time. Perform these actions separately.
6. Click Assign, Exclude, or Suppress.
The custom rule was created. To view your custom rules, navigate to Management >
Custom Rules. The rules are added to the panel in the order of creation, and are applied
from the top during import.

Deleting custom rules
All custom rules that you create are displayed, and can be deleted on the Custom Rules
panel. Any user who has the Manage Imports and Manage Software Classification
permissions can add, and delete any rules, including the rules created by other users. When
you delete a user, the rules created by that user are not automatically removed.
You must have the Manage Imports and Manage Software Classification permissions to
perform this task.
1. Go to Management > Custom Rules.
2. Select a custom rule that you want to delete, and click Delete.
The rule is deleted and no longer applied. The software classification based on the rule
remains unchanged.

Assigning products to Cloud Paks
Available from 10.0.1 When you purchase a product as part of a Cloud Pak,
assign instances of this product to the proper Cloud Pak to improve software tracking and
calculate utilization of license metrics by Cloud Pak bundles.
You must have the Manage Software Classification permission to view the Software
Classification panel and classify software. To view some additional columns related to
computers on which the components are installed, you also need the View Endpoints
permission.
Classification of non-containerized products to Cloud Paks is a two-step process. First,
you classify components that are discovered by License Metric Tool to products with
proper license metrics. Then, you assign products to Cloud Paks. The process needs to be
two-stage because a single component can belong to different product flavors that have
different conversion options. For example, the component WebSphere Application Server
can be a part of two products: WebSphere Application Server or WebSphere Application
Server Network Deployment.

When these products are a part of Cloud Pak for Applications, their conversion ratios differ
and are as follows.
• 4VPCs/ 1VPC for WebSphere Application Server
• 1VPC/ 1VPC for WebSphere Application Server Network Deployment
The following table shows how license metric quantity differs after applying the conversion
option depending on how the component WebSphere Application Server is classified.
Table 173. Difference in license metric quantity resulting from component
classification
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Discovered

which the

License

component

component

metric

is assigned
WebSphere

WebSphere

Application

Application

Server

Server

WebSphere

WebSphere

Application

Application

Server

Server Net

VPC

License
metric
quantity
100

License
Conver

metric quan

sion option

tity after
conversion

4VPCs/

25

1VPC

VPC

100

1VPC/ 1VPC 100

work Deploy
ment
Another reason for two-stage classification is that only some product instances might be
installed as part of a Cloud Pak. In the following example, the discovered components are
assigned to two instances of WebSphere Application Server Network Deployment. Only the
first instance was purchased as part of Cloud Pak for Applications. Thus, only this instance
is assigned to the Cloud Pak.

Table 174. Classification of components to products, and products to Cloud Paks
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which the
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component
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PVU

None

1. In the top navigation bar, click Reports > Software Classification.
2. Select the product instance that you want to assign to a Cloud Pak. Ensure that this
instance is assigned the license metric that is defined in the license agreement.
For example, to classify IBM WebSphere Application Server Network Deployment as
part of the IBM Cloud Pak for Applications, ensure that WebSphere Application Server
is assigned the Virtual Processor Core (VPC) license metric as stated in the License
Information document.
If the instance of the product that you want to assign to a Cloud Pak, reports a
different license metric than specified in the license agreement, perform the following
steps:
• For license metrics for which License Metric Tool calculates utilization
automatically, reassign the components to the product with the proper metric.
For more information, see: Assigning components to products.
• For license metrics for which License Metric Tool does not calculate utilization
automatically, declare the metric quantity. For more information, see: Setting
and removing the declared metric quantity.
3. Hover over Assign, and click FlexPoint or Cloud Pak Bundle.
4. Select the bundle to which you want to assign the product, and click Assign.
Information about the Cloud Pak to which the product is assigned is displayed in the
FlexPoint or Cloud Pak Bundle column.
To view utilization of license metrics by the Cloud Pak, go to Reports > FlexPoints and
Cloud Paks, and click Recalculate to refresh the data on the report. The report shows
information only about non-containerized products that are a part of the Cloud Pak. For
information about viewing the overall utilization of the license metric by the Cloud Pak, see:
Licensing of non-containerized Cloud Pak programs.

Assigning products to FlexPoint bundles
Available from 9.2.13. When you purchase a product as part of a FlexPoint bundle,
assign instances of this product to that bundle for improved tracking and to calculate
utilization of FlexPoints.

You must have the Manage Software Classification permission to view the

•

Software Classification panel and classify software. To view some additional columns
related to computers on which the components are installed, you also need the View
Endpoints permission.
• Ensure that components that were discovered in your environment are assigned to
software products in accordance with your license agreement. For more information,
see: Assigning components to products.
To properly classify the installed software, start by assigning the discovered components
to products in accordance with your license agreement. In this example, the discovered
components are assigned as follows.
• Component 1 and Component 2 installed on Computer 1 are assigned to Product 1.
• Component 3 installed on Computer 2 is assigned to the first instance of Product 2.
• Component 3 installed on Computer 3 is assigned to the second instance of Product
2.
Then, assign proper product instances to FlexPoint bundles. In this example, Product 1
and the first instance of Product 2 are a part of FlexPoint bundle 1. The second instance
of Product 2 is licensed under a different license metric and thus is not assigned to any
FlexPoint bundle.

If a component is assigned to a product that is a part of a FlexPoint bundle, and you
reassign such a component, the component instance is no longer assigned to any FlexPoint
bundle. In this example, Component 3 that is installed on Computer 2 is reassigned from
the first instance of Product 2 to Product 3. As a result, the reassigned component is no
longer a part of any FlexPoint bundle. The same applies to a situation in which you suppress
a component that is assigned to a product that is a part of a FlexPoint bundle.

1. In the top navigation bar, click Reports > Software Classification.
2. Select the product instance that you want to assign to a FlexPoint bundle. Ensure that
this instance is assigned the license metric that is defined in the license agreement.
3. Hover over Assign, and click FlexPoint or Cloud Pak Bundle.
4. Select the bundle to which you want to assign the product, and click Assign.
Only the product instance that is installed on the particular computer and its
components are assigned to the FlexPoint bundle.
Note: If you previously assigned a product to a FlexPoint bundle and later on
want to remove the product from that bundle, choose None.
Information about the FlexPoint bundle to which the product is assigned in displayed in the
FlexPoint or Cloud Pak Bundle column.

To view utilization of FlexPoints, go to Reports > IBM FlexPoints and IBM Cloud Paks, and
click Recalculate to refresh the data on the report.

Setting the number of metric units convertible to FlexPoints
Available from 9.2.13. When a software product is assigned to a FlexPoint bundle,
converts the number of metric units that the product used to FlexPoints. If the product uses
a license metric whose utilization is not calculated by , you can manually set the number of
metric units to be converted into FlexPoints.
You must have the View License Metrics permission to view the IBM FlexPoints report,
and Manage Software Classification permission to set the number of metric units to be
converted into FlexPoints.
You can manually set the number of metric units convertible to FlexPoints only for metrics
whose utilization is not calculated by . For the list of metrics whose utilization is calculated
in , see: Table 156: Metrics for which utilization is calculated.
1. Log in to , and go to Reports > IBM FlexPoints and IBM Cloud Paks.
2. To display the list of products that are assigned to a FlexPoint bundle, click the name
of that bundle.

3. Click on the product for which you want to specify the number of license metrics.
4. Click on the pencil icon
dialog box appears.

under the Metric Quantity column. A Set Metric Quantity

5. Enter the metric quantity value and and click Set.

To refresh the data that is displayed on the report, click Recalculate. Metric units that you
specified are converted into FlexPoints.

Viewing history of installed components
Available from 9.2.7. You can view information about components that were
installed in your infrastructure during a specific period and their assignment. You can
use this information to view details of components that contributed to the overall license
utilization for a specific period. You can also reassign and exclude uninstalled components
if their original assignment was incorrect and impacted the license metric utilization.
You must have the View Endpoints and Manage Software Classification permissions to
perform this task.
1. In the top navigation bar, click Reports > Software Classification.
2. To show components that were discovered during a particular period, hover over
Configure, and click Configure View. Then, perform the following steps.
a. Remove the current filter.
b. Specify discovery start on or before the last day of the period for which you
want to display the data, and discovery end on or after the first day of that
period.
For example, to display all components that were discovered between 1
September and 30 September, use the following filters:
• Discovery Start, on or before, and choose 30 September.
• Discovery End, on or after, and choose 1 September.
c. Click Submit.
The report shows components that were discovered during the specified period, including
uninstalled components, and components that were installed on computers that are no
longer discovered. Details of the computer on which the component was discovered,
computer health, scan results, and hardware inventory represent the current state of the
infrastructure, not historical data from the specified period. If a computer is no longer
discovered, the data is not available.

If a computer is no longer discovered, it has the

icon displayed next to its name. It

happens in the following situations:
• The computer was removed from the infrastructure. For more information, see
Removing inactive computers.
• The BigFix client was uninstalled from that computer
• The data source to which the computer belonged was removed
You can reassign components or exclude them from pricing calculations to obtain the
correct reports for the specified period.

Monitoring and reporting software usage
BigFix Inventory collects listing of running processes and associate this data with detected
software using usage signatures or by matching path.
BigFix Inventory collects information about the running processes with their statistics:
First Used, Last Used, Total Run Time, Total Runs, Average Runs per Day, and Average Run
Time. Based on that information, reports software usage for software instances that are
discovered and are having usage signatures or are Java based application (from

)

Starting with BigFix Inventory version 10.0.10, the amount of data transferred from
endpoint to server is reduced by limiting the data exchange to last 30 days. BigFix Inventory
combines incoming updates with existing data and because of server side optimization, the
already stored data is not processed again in the database. This process of handling data
collection leverages in reducing the load on the network and BigFix Platform.
Monitoring and reporting of software usage is enabled by default if during the initial
configuration you choose the default scan settings. For more information, see: Default scan
configuration.

Otherwise, follow the instruction at Manual scan configuration to enable the collecting of
software usage statistics by ensuring Application usage statistics checkbox is selected in
Additional Scan Capabilities section of Initiate Software Scan action.
How usage reporting works?
There are two method of linking Metering Data/process with the detected Software
Component release:
1. Using usage signature without splitting statistics per Component Instance
2.

Starting from application update 9.2.15, based on path for processes
named; java, java.exe, javaw.exe, jp2launcher.exe with splitting statistics
per Component Instance.

It is possible to distinguish between usage of BigFix and Oracle Java that is installed on a
single computer.
Starting from Software catalog 9.2.15 usage signatures for Java based application are not
longer included as path based matching is used and no signature is needed.
Checklist for Configuration BigFix Inventory for collecting usage data
1. Log in to the BigFix console.
2. Ensure that the Application Usage Statistics analysis from Sites > External Sites
> BigFix Inventory v10 is activated. To activate right-click the analysis, and click
Activate. For more information, see Activating the analyses.
3. Ensure that the Initiate Software Scan action have Application usage statistics
checkbox selected in Additional Scan Capabilities section. For more information, see:
Initiating software scans.
4. Review the properties: Status of Scan for Application Usage Statistics and Time of Last
Successful Scan for Application Usage Statistics in the Software Scan Status analysis
from Sites > External Sites > BigFix Inventory v10 is activated. To activate right-click
the analysis, and click Activate. For more information, see Activating the analyses.
Software usage report

The results of the analysis are reflected on the following reports:
• Metering Data shows the raw aggregated information about processes running on
given computer with statistical information like: First Used, Last Used, Total Run Time,
Total Runs, Average Runs per Day, Average Run Time.
• Software Classification / Software Installation panel lists the discovered software
components with the details about usage statistics.
Important: In case of signature based usage reporting statistics are not
Component Instance specific, but each record contains the same data.
• Usage per Computer panel provides an overview of the software usage statistics that
are aggregated for all instances on product level and presented in the report for each
computer.
Important: In case of signature based usage reporting statistics and multiple
Component Instance presented values are multiplied by number of instances.
For more information about the reports, see: Available reports.
Tip: To view information about usage on the reports, configure the report view to
display the columns that collect software usage statistics. To do that, hover over
the Manage Report View icon

, select Configure View and choose the applicable

columns.
If you are in the initial deployment phase, or if you do not need information about software
usage, you can disable the collection of this information to improve the BigFix Inventory
performance and shorten the import time. For more information, see: Disabling the
collection of software usage.

Software catalogs
To correctly identify components of software products in your infrastructure, ensure that
your software catalog is always up-to-date. Periodically import a new catalog that contains
the most recent software products. Also, manually add products that are installed in your
infrastructure but do not have corresponding entries in the catalog.
There are two types of the software catalog:
• Catalog provided by BigFix that contains signatures for BigFix products as well as
signatures for a range of products from vendors such as Microsoft or Oracle.
• Custom catalog that contains signatures created manually to discover products that
are not contained in the catalog provided by BigFix.
These two catalogs are fully independent. If you create a custom signature to discover a
product and then a signature for that product is delivered in the BigFix catalog, the two
signatures are not merged. If the same product is discovered by both signatures, the
number of discovered instances might be higher than the number of instances that are
installed. In such case, delete the custom signature. For more information, see: Catalog
problems.

Manually updating software catalog
The software catalog is automatically updated during every upgrade of BigFix
Inventory. However, as an exception, you can manually update the software catalog for
troubleshooting purposes.
Warning: Since catalog version 10.0.2, Software Catalog Update fixlet updates only
non-IBM part of the catalog. The same applies to the manual catalog upload. To get
the latest supported IBM catalog part you must upgrade BigFix Inventory. It is in line
with IBM ILMT 9.2.20, https://www.ibm.com/support/pages/node/6223460.
However, the definition of the software catalog does not change for other vendors,
and the manual updates continue to be supported.

•

Starting from application update 9.2.11, the Software Catalog Update task
automatically triggers the following actions:
◦ The catalog is downloaded to the following directory:
▪

/opt/BFI/wlp/usr/servers/server1/data/sam/
catalog/BFI

▪

C:\Program Files\BFI Enterprise\BFI\wlp\usr
\servers\server1\data\sam\catalog\BFI

◦ The catalog is automatically uploaded to the BigFix Inventory server during the
next import of data. No additional actions are required.
• For versions before 9.2.11, the software catalog is downloaded with the Software
Catalog Update task but it still needs to be manually uploaded to the BigFix Inventory
server according to this procedure.

You must have the Manage Uploads permission

to perform this task.
• If the computer where the BigFix server is installed does not have the Internet access,
ensure that the content of the BigFix Inventory site is up-to-date before you download
the catalog. For more information, see: Updating the fixlet site.
The software catalog is called BFI_Catalog_version-timestamp.zip and consists of
the following files:
• Software catalog in canonical 2.0 format:
IBMSoftwareCatalog_canonical_2.0_form_date.xml.
•

Software catalog in canonical 3.0 format:
IBMExtendedCatalog_canonical_3.0_form_date.xml. The file consists of
low priority applications; for example, open source software, freeware, and games.
The content of the file will be expanded to include high priority business applications
with time. The file is included in each software catalog, however, it is ignored by BigFix
Inventory versions lower than 9.2.5.

• Charge unit data file that contains information about charge unit
definitions, their relations with products, and some additional parameters:
charge_unit_parameters_dataversion_version.csv.
• Part numbers file that contains information about part numbers that are used for
software licensing purposes: part_numbers_dataversion_version.csv.

• Catalog metadata file that describes the software catalog:
catalog_package.properties.
•

FlexPoint bundles file that contains information about products
that can be assigned to each of the available FlexPoint Offerings:
flexpoint_bundles_dataversion_version.csv

•

For versions 9.2.11 and higher
1. Log in to the BigFix console.
2. In the navigation bar, click Sites > External Sites > BigFix Inventory v10 > Fixlets
and Tasks.
3. In the upper-right pane, select Software Catalog Update, and then click Take
Action. The action is applicable only on the computer on which the BigFix
Inventory server is installed. Select the computer, and click OK.
If the task is not applicable on that computer, see: Catalog problems.
4. Wait for the scheduled import of data or run it manually.

• For versions before 9.2.11
1. Download the software catalog
a. Log in to the BigFix console.
b. In the navigation bar, click Sites > External Sites > BigFix Inventory v10 >
Fixlets and Tasks.
c. In the upper-right pane, select Software Catalog Update, and choose the
option to download the software catalog for BigFix Inventory version
before 9.2.11.0.
d. Optional: Copy the file to the computer from which you access the BigFix
Inventory web user interface.
2. Upload the software catalog to BigFix Inventory.
a. Log in to BigFix Inventory.
b. In the navigation bar, click Management > Catalog Upload.
c. Click Browse and select the software catalog file.

d. To upload the file, click Upload. The software catalog file and the charge
unit data are listed in the Upload and Import History table. Their status is
Pending.
e. Wait for the scheduled import of data or run it manually.
During the import, scanner catalogs that are used for software discovery are created and
automatically distributed to the computers in your infrastructure.
If the automatic distribution of scanner catalogs fails, computers on which the catalog was
not updated have the Outdated Catalog status on the Software Scan Health widget. You
must manually update scanner catalogs on these computers. If you use the disconnected
scanner, distribute the downloaded software catalog to each computer.

Checking product components and their signatures in the
software catalog
You can browse the software catalog to check what components belong to a particular
product and what signatures cause that these components are detected.
1. In the navigation bar, click Reports > Products & Metrics.
2. Select a product. To narrow down the report, filter it by a product name or a part
number.
3. Drill down through the version name and release name to the component level.
Note: If the Component Version column contains an asterisk (*), the listed
software component is detected regardless of its version. The reported
version of each instance of the component is based on the generic signature
that pulls the component version from the file or package that caused
detection.
4. To check the signature that allows the discovery of a given component click
Signatures.

Expanding the custom software catalog
To ensure that all software items that are installed in your infrastructure are discovered,
create custom signatures. You can create them from scratch or directly from the Package
Data and Scanned File Data reports. You can also create extended signatures to discover
software that is not detected by using file or package signatures.
The custom catalog is fully independent from the catalog that is provided by IBM. If you
create a custom signature to discover a product and then a signature for that product is
delivered in the BigFix catalog, the two signatures are not merged. If the same product is
discovered by both signatures, the number of discovered instances might be higher than the
number of instances that are installed. In such case, delete the custom signature. For more
information, see: Catalog problems.
Before you create custom signatures, check the signature community. It is a place where
you can find custom signatures that are created by members of the community. You can
download such signatures and import them to BigFix Inventory. After you create your
custom signatures, consider contributing the community.

Catalog customization process
The process of adding custom signatures to the software catalog requires careful planning
and consideration. It starts with identifying products that you expect to discover but are
not reported or are missing from the software catalog. To correctly identify components of
software products in your infrastructure, ensure that your software catalog is always up-todate. Next, you should organize your work to ensure that the most important products are
given the highest priority. Then, you determine what files or packages can be used to detect
the software and report its usage. Finally, you can create the signatures.
Periodically import a new HCL catalog that contains the most recent signatures. Also,
manually add components that are installed in your infrastructure but do not have
corresponding entries in the catalog.
Note: BigFix Inventory is intended for software inventory and license management.
It is suggested that you extend the software catalog for those purposes only.

Process input
The input to the catalog customization process is a list of software products that you want
to be discovered. The list can be based on the general knowledge of your environment and
the procurement data. As the discovery, monitoring, and license management of every
software product require extra effort, target products on the basis of license expenses.
Focus on a few selected products and adopt an iterative approach instead of trying to work
on all products simultaneously.

Required skills
A set of skills that are helpful during the creation of the custom catalog content includes:
• General knowledge of the software products that are used in your company, their
architecture, and licensing models
• General knowledge of the operating systems on which the software is installed

There are two types of the software catalog
• Catalog provided by HCL that contains signatures for a range of software from
various vendors, such as Microsoft or Oracle. It also includes license information for
IBM products and template signatures.
• Custom catalog maintained by an end user that contains signatures created manually
to discover software for software items not contained in the catalog provided by HCL.
See also, Template signature support for catalog management

Step 1: Prioritize the work
Before you start adding custom signatures to the software catalog, prioritize your work.
Start with products that are critical from the business perspective. Then, iteratively continue
with the remaining products until all software that is used in your company is discovered.
To optimize your work on the custom catalog content, adopt an iterative approach. Start
by grouping all software products that are used in your company into software families
and focus on one software family per iteration. Analyze and create software signatures for
all products that belong to the family on which you are working. If a software family is too

extensive, split it into smaller groups, for example based on editions or distributions. The
iterative approach allows for continuously extending the catalog content and verifying its
correctness at the same time. Thus, you can gain more benefits in less time.

Step 2: Analyze your software
Extend the software catalog only with information that is related to products that are used
in your company but are not reported or do not exist in the catalog. Consult the product
administrators and available documentation to gather information that is related to the
product architecture and licensing model.
To gather basic information about a software product, work with the administrator who
is responsible for its installation and has the knowledge of its architecture and licensing
model. Try to establish a reference installation. Investigate the architecture of the product to
obtain the following details:
• Separately installable pieces (components) that constitute the product and are
important for discovery or licensing purposes
• Version number of each component
• Ways to check whether the component is installed
• Platforms on which the component can be installed
• Licensing model
If the product administrator is unable to provide the information necessary for creating the
licensing model, consult the available documentation. It can be found on the installation
media, in the product installation path, license agreements, installation instructions, or
online resources.

Step 3: Review information about files and packages
To identify candidates for software signatures, review information about files and packages
that exist on the computer where a particular software product is installed.

Candidates for file and package signatures
Most efficient signatures are file-based signatures with constant size that is different
for each release or signatures that are based on package data where a wildcard (*) can
be used. In both cases, the file and package data should be removed during the product
uninstallation or changed during the product upgrade or downgrade.
When you are looking for candidates for such signatures, always check:
• Whether any product documentation describes methods for determining the product
edition and release based on files or package data
• Whether the product name and version can be unambiguously determined, for
example, by the file name
• Whether there are any component-specific files:
◦ Executable files whose version, part of version, or size is specific to the
particular release
◦ Files whose name or its part is specific to the particular release
◦ Files whose content defines the product name and version
◦ Other files with constant size, for example, a graphic that contains the product
release number
◦ Libraries with version or constant size
• Whether there are application-specific packages
Do not create signatures that are based on:
• Shared or external libraries
• Files that can be used by another product
• File names that are commonly used, for example, readme.txt

Available reports
Use one of the following reports to identify candidates for signatures.
Package Data
The report provides information about the packages that are installed on
the computers in your infrastructure. To find a package that can be used

as a signature, filter the report to the data from the computer on which the
particular software product is installed.
Scanned File Data
The report provides information about files that were detected on the
computers in your infrastructure. The files with any file extensions can be used
to create software signatures.
Note: To find a file or a package that can be used as a signature, filter the report to
the data from the computer on which the particular software product is installed.
To further narrow down the results, specify the whole or part of the path to the
directory where the software is installed. Then, look at the following columns.
• Recognized - the column shows whether the package data and/or file was
recognized as part of an existing signature.
• Removed since

: Caused Detection - the column shows whether the

file contained enough information to cause detection of the related software.
The Caused Detection column is removed since BigFix Inventory version
10.0.4. You must re-create your saved reports in case you had used the
Caused Detection column.
If the value in both columns is No, the file is not used for software detection and you
can use it to create a new software signature.
Unrecognized Files
The report creates a ranking of files that are most commonly encountered in
your computer infrastructure but do not produce matches for any signature.
For more information, see: Available reports.

Step 4: Create component signatures
Use the following guidelines to avoid common mistakes and to create the most accurate
signatures that better recognize software.

To obtain the best results, try to create signatures that meet the following requirements:
• The signature is based on the main executable file of the software.
• The signature combines the main executable file of the software with package data if
it is available.
• The signature discovers only one release. If it discovers release 7.2, it cannot be valid
for releases 7.1 or 7.3.
• The signature is generic and discovers a particular release and all its mod-releases
and fix packs. To ensure that the signature is generic:
◦ Use a wildcard (*) in the package version, for example: 7.2.*
If you use a dot (.) in the package version, the dot is also matched with a
dash (-). For example, if you specify the package version as 4.9.3.1*, version
4.9.3-1.el1 is also matched.
If you specify a version without the wildcard, the signature also matches a
package that contains a comma in the version number. For example, if the
package version is 11.10.1,REV=2005.01.21.15.53, signatures that have the
following package version specified match it:
▪ 11.10.1
▪ 11.10.1,REV=2005.01.21.15.53
Signatures that have the following package version specified do not match it:
▪ 11.10
▪ 11.10.1,REV=2005.02.14.12.32
◦ Specify the version of the file limited to the release number. For example, 11.10.
Avoid using a complete file version such as 10.11.2 or file size. These values are
likely to change with every patch.
◦ If a signature combines a file and package data and neither of them has a
version, accept a file with any size.
Tip: If you are unable to cover all fix packs and mod-releases, combine
separate conditions for each of them.

Version of the software that is provided in the package and in the file might sometimes be
inaccurate and might not match the version that is displayed in BigFix Inventory. If such
a discrepancy occurs, ensure that the proper version is defined in the software catalog.
Consider creating more specific rules for handling issues that are related to software
versioning.

Template signature to support catalog management
Starting with version 10.0.9, BigFix Inventory provides two new signature types added in the
catalog customization panel.
The signature types are:
• Package Template signature – This signature includes one package with autodetectable version and optional files.
• File Template signature – This signature includes one file with auto-detectable
version and optional packages.
Auto-detectable version
In Package Template and File Template signatures, the component versions
are reported automatically. The feature is called auto-detectable, where the
version signifies that each time a signature is matched, a component with the
version contained in the package/file is detected in BigFix Inventory. A new
component is created if it does not exist. The related software product version
also includes this number.
Use case
These signatures are generic and, if correctly defined, works with current
and future versions of a given software. You don't need to create separate
signatures each time a new version of the software is released. The right
component version is detected and reported automatically.
Case-sensitivity of Template signatures and signature rules based on package
The below table lists the template signature package names and their case
sensitiveness in Windows and UNIX environments:

Case sensitive on

Case sensitive on

Windows

UNIX

Yes

Yes

Template file name

No

NA

Template vendor

No

No

Template version

NA

NA

Package signature

Yes

Yes

Yes

Yes

Package signature ver NA

NA

Signature packages
Template Package
Name

name
Package signature
vendor

sion
File signature name

Yes

NA

File signature vendor

No

NA

File signature version

NA

NA

CIT package name

Yes

Yes

CIT package vendor

Yes

Yes

CIT package version

NA

NA

CIT file name

Yes

Yes

CIT file vendor

NA

NA

CIT file version

NA

NA

Figure 6. Catalog Customizations panel

Creating signatures
You can use the built-in functionality to extend your custom catalog with the software
products that are installed in your infrastructure but are not present in the HCL® catalog.
You must have the Manage Catalogs permission to perform this task.
1. In the top navigation bar, click Management > Catalog Customization, and then click
New.
2. In the Create Catalog Entry window, enter the following details:
• For Package or File signature and Extended signature, provide publisher name,
product name, and release number.
• For Package Template signature and File Template signature, provide publisher
name and product name. You can not provide release number for template
signatures.
Figure 7. Create Catalog Entry

3. Decide whether the product should be detected with a package or File signature,
Package Template or File Template signature, or an Extended signature.
• For a Package or File signature, select a condition or conditions that must be
fulfilled for the software item to be discovered.
◦ To create an installation package signature, select the first condition, and
specify the name of the package, its version, and vendor.
◦ To create a file signature, select the second condition, and specify the
name of the file and its size or version. If neither the file size nor the
version is relevant, select Any size or version.
Tip: If you select one condition and specify multiple files or
installation packages, detection of any of them causes that the
software item is discovered. If you select both conditions, at least
one file and one installation package must be detected for the
software item to be discovered.

Important:
▪ If you add a rule with common executable files or other
popular file types, it is enough to run the data import once
and software inventory is available in the web user interface
after the import. The popular file extension list includes the
following file types:
*.exe, *.sys, *.com, *.ear, *.ocx, *.sh, *.bin, *.pl,
*.ear, *.SH, *.BIN, *.PL, and *.EAR.
▪ If you add a rule with non-standard file extensions, wait until
all the steps in the catalog data flow complete or perform
those steps yourself. For more information, see: Software
discovery process after customizing the catalog.
▪ File rules for both common executable files and nonstandard extensions are only supported on Windows™
endpoints if version is specified.

• Choose an extended signature to use various data elements such as file names,
registry keys, CPU architectures, or specified strings to discover software that
otherwise might not be discovered with file or package signatures.
a. Open an XML editor or text editor that has support for the XML language,
for example Notepad++, and create the extended signature in the XML
format. The signature length must not exceed 4000 characters.
Note: The supported version of the XML signature schema is 2.7.
b. In the XML editor, select and copy the elements of the extended XML
signature file.
c. In the Signature Content text area, paste the contents of the extended
signature that you created in step a.

Note: When you correct the rules, the existing detection method is
applicable for Extended Signature until scan is complete with new
Catalog pushed to the endpoint. To remove the detection, delete
signature and add a new signature.
•

Choose Package Template signature to select package with autodetectable version and optional files.

•

Choose File Template signature to select one file with auto-detectable
version and optional packages.
Additional information and restrictions related to Package Template signature
and File Template signature

◦ Package Template signature and File Template signature, when created,
are assigned to components with '*' release number, and the components
are assigned to software product releases with the same names and also
'*' number.
◦ Only one (template) signature is allowed for a given template component
(version '*'). However, it is possible to have non-template signatures for
the same component name, but they must use regular, non-'*' component
version.
◦ Files defined in a File Template signature must have .exe extension (in
BigFix Inventory, it is possible to collect version information only from
such files).
◦ Files defined in Package template signature may have any extension.
However, if the extension is not one of the "standard" extensions that are
collected by BigFix Inventory, this file will be matched only if it is listed on
Scanned File Data. This is different comparing to regular signatures which
create CIT rule in such case.
◦ Create and Delete actions on template components are listed on
Catalog Audit panel (signature modifications are displayed in details of
"Creation" for the related template components). Creation and deletion of
components derived from templates are not tracked on Catalog Audit.
◦ It is possible to use both a template and a derived product as regular
products, such as use both to bundle to them. Install Seats is the default
assigned metric and other metrics may be added as well.
◦ Contracts for the software products created from custom templates can
be created in advance before any version is discovered.
◦ You must use unique name for software release and component in
Catalog Customizations panel. You can not rename the template. If you
want to assign a different name, you must delete the existing template
and create a new template with the new name. Also, you can not assign a
product from one template to a different publisher.

◦ Deleting a template signature implies deleting the related template
component. While deleting these entries, all derived signatures,
components and discovery results are also deleted.
◦ It is possible to modify (change definitions of rules inside) a template
signature. In this case the related custom template component, the
custom template signature, and all derived signatures, components and
discovery results are deleted and recreated based on the new definition
during the next data import.
◦ You can view components, products, signatures derived from templates
but you can not manage them. You can delete them by deleting the related
template.
4. To save the catalog entry, click Submit.
You added a software signature to your custom catalog, and it can now be used to detect
software or its usage. Although you added a new signature, the custom content version
of the software catalog does not have to change. The version is updated only for nontemplate signatures that are based on non-standard file extensions. For more information,
see Software discovery process.
You can edit and delete a custom catalog entry on the Catalog Customization panel.
To edit a custom catalog entry, select it, edit a chosen element and confirm the change by
clicking Save. When you edit the name of a publisher, product, version or release you cannot
change it to a name that already exists in the custom catalog.
To delete a custom entry, select it and click Delete. You can delete an entire hierarchy, that
is a publisher, software product, version, release, component, and signature simultaneously.
However, you cannot delete multiple entries, for example multiple publishers, at the same
time.

Extended signature templates
Available from 9.2.2. Extended signatures are flexible signatures that are used for
software recognition. They consist of a number of exported variables and the declaration of
the operations that are required to assign a value to these variables. Update BigFix Server

and Software Catalog to allow the Extended Signature capability to report the detailed
versions of installed software.

Operands and operators
Every extended signature can be viewed as a set of processing instructions that are
used by software scans to detect if a software item is installed on the target computer
system. These processing expressions consist of two types of components: operands and
operators. Operands are the objects that are manipulated, and the operators as the symbols
that represent specific actions. Operands and operators can be either scalar (consisting of
only one value) or vector (consisting of multiple values).
The schema version that is supported by BigFix Inventory is 2.7.

Variables interpret by the BigFix Inventory
Following variables are interpret by BigFix Inventory:
• IS_INSTALLED - mandatory
When the software is detected, the condition should be set to true. When the software
is not detected, the condition should be set to false.
• INSTALL_PATH - optional
Value is listed in installation path.
•

DETAILED_VER
Use DETAILED_VER variable to search for the detailed version. The information
is reported in Component Detailed Version column. Value is listed in Component
Detailed Version column. The Component Release is referred from catalog entry.

Extended signature templates
The following section provides extended signature templates to help you create a new
extended signature and lists the necessary operators and operands that explain the values
that they have. The table lists the templates of extended signatures as they are created in
BigFix Inventory.

Note: To prevent the XML validation from failing, ensure that the following XML
element is present in the extended signature that you are creating. Otherwise, the
XML validation fails.
<Variable name="IS_INSTALLED">
...
</Variable>

Identification
or detection of

Sample template

Re The following template checks existence of 4.0 value registry key and reports the key as Detailed
porting De
tailed Version
using the value
fetched from
the registry

Version.
<Variable name="DETAILED_VER">
<RegKeyValue entry="Installed Version"
key="HKEY_LOCAL_MACHINE\Software\Microsoft\SMS\Client\Client
Components\Component Name\Installation Properties" section="64or32"/>
</Variable>
<Variable name="IS_INSTALLED">
<Compare relation="eq" type="string">
<StringSlice inputString="$(DETAILED_VER)" startIndex="0" endIndex="3"/>
<ValueOf value="4.0"/>
</Compare>
</Variable>

A file name

The following template checks the identification or detection of a file name.
<Variable name="IS_INSTALLED" export="true">
<Compare type="string" relation="ne">
<VectorToScalar>
<FindFilePathEx name="A_FILENAME.EXE"/>
</VectorToScalar>
<ValueOf value=""/>

Identification
or detection of

Sample template
</Compare>
</Variable>

The size of the file need not be provided.
Existence of

The following template checks the identification or detection of the existence of a number of

a number of

Windows™ registry keys.

Windows™ reg

The number of keys to be provided depends on the application.

istry keys
<Variable name="IS_INSTALLED">
<And>
<RegKeyValueEqual key="KEY NAME A" entry="ENTRY NAME" value="VALUE"
section="64or32"/>
<RegKeyValueEqual key="KEY NAME B" entry="ENTRY NAME" value="VALUE"
section="64or32"/>
<RegKeyValueEqual key="KEY NAME N" entry="ENTRY NAME" value="VALUE"
section="64or32"/>
</And>
</Variable>

Existence of

The following template checks the identification or detection of the existence of at least one of

at least one

the registry keys.

of the registry
<Variable name="IS_INSTALLED" export="true">

keys
<Or>
<RegKeyValueEqual key="KEY NAME A" entry="ENTRY NAME" value="VALUE"
section="64or32"/>
<RegKeyValueEqual key="KEY NAME B" entry="ENTRY NAME" value="VALUE"
section="64or32"/>
<RegKeyValueEqual key="KEY NAME N" entry="ENTRY NAME" value="VALUE"
section="64or32"/>

Identification
or detection of

Sample template
</Or>
</Variable>

File that is in

The following template checks the identification or detection of the file that is in a particular di

a particular di

rectory that is defined by a filter.

rectory that is
defined by a fil

Note: Use "?" as the single-character wildcard and "*" to denote multiple characters.

ter
Restriction: Replace the forward or backslashes in the file path with the "?" wildcard.

<Variable name="IS_INSTALLED" export="true">
<Compare type="string" relation="ne">
<VectorToScalar>
<Vector filter="?opt?symantec*">
<FindFilePathEx name="FILENAME"/>
</Vector>
</VectorToScalar>
<ValueOf value="" />
</Compare>
</Variable>

Key name, key

The following template checks the identification or detection of the key name, key entry, and its

entry, and its

value for a registry key.

value for a reg
<Variable name="IS_INSTALLED" export="true">

istry key
<RegKeyValueEqual key="KEY NAME" entry="ENTRY NAME" value="VALUE"
section="64or32"/>
</Variable>

CPU architec

The following template checks the identification or detection of CPU architecture.

ture
<Variable name="IS_INSTALLED" export="true">
<Compare relation="eq" type="string">

Identification
or detection of

Sample template
<ValueOf value="$(B_PROCESSOR_ARCH)"/>
<ValueOf value="ARCHITECTURE_CODE"/>
</Compare>
</Variable>

Where ARCHITECTURE_CODEs:
• AIX, IBM i, and Linux PPC: PPC
• Linux x86, Mac OS X, and Solaris x86: IX86
• Linux on System z: S390
• HP-UX Itanium: ITANIUM
• HP-UX PA-RISC: PA-RISC
• Solaris SPARC: SPARC
File contents

The following template checks the identification or detection of the file contents and matching

and match

specified strings.

ing specified
strings

Note: The scanner reads only text files. It cannot read binary files and archives, such as
.jar, .ear, and .zip.

<MultipleInstance>
<Iterator name="file_list" export="false">
<FindFilePathEx name="MYFILE.txt" />
</Iterator>
<Instance>
<Variable name="file_read" export="false">
<ReadFile path="$(file_list)MYFILE.txt" />
</Variable>
<Variable name="IS_INSTALLED">
<Compare type="string" relation="ne">
<VectorToScalar>
<Vector filter="*MYAPP_version=MYAPP-1.3*">

Identification
or detection of

Sample template
<ValueOf value="$(file_read)" />
</Vector>
</VectorToScalar>
<ValueOf value="" />
</Compare>
</Variable>
<Condition withVariable="IS_INSTALLED">
<Action onValue="false" do="SKIP" />
</Condition>
</Instance>
</MultipleInstance>

The name of the file to be detected is MYFILE.txt and the string value is MYAPP_version=MYAPP-1.3.

Existence

The following template checks the identification or detection of the existence of two files in a

of two files

particular directory where someprog.jar file has a particular size.

in a particu
<MultipleInstance>

lar directory
<Iterator name="INSTALL_PATH">

where some<Vector filter="*SOMEPROG.ear?SOMEPROG.war?">

prog.jar file
<FindFilePathEx name="essbase.jar"/>

has a particu
</Vector>

lar size
</Iterator>
<Instance>
<Variable name="IS_INSTALLED">
<FileInfoCompare absolutePath="$(INSTALL_PATH)someprog.jar"
field="size" value="649432" relation="eq" />
</Variable>
<Condition withVariable="IS_INSTALLED">
<Action onValue="false" do="SKIP"/>
</Condition>

Identification
or detection of

Sample template
</Instance>
</MultipleInstance>

Matching BFI

It is possible to match data listed on BFI Package Data report on endpoint side using Package-

Package Data

InforMatch operand.

report on end
point side

Below is an example for the same. The below example can be combined with other examples
mentioned on this page.
<Variable name="IS_INSTALLED" export="true">
<PackageInfoMatch vendor="RStudio*" name="rstudio-server"
version="1.1.*"/></Variable>

The existence

The following template checks the identification or detection of the existence of a particular file.

of a particular
<MultipleInstance>

file
<Iterator name="INSTALL_PATH">
<FindFilePathEx name="SWTAG_NAME.swtag"/>
</Iterator>
<Instance>
<Variable name="IS_INSTALLED">
<Compare type="string" relation="ne">
<ValueOf value="$(INSTALL_PATH)" />
<ValueOf value="" />
</Compare>
</Variable>
<Condition withVariable="IS_INSTALLED">
<Action onValue="false" do="SKIP"/>
</Condition>
</Instance>
</MultipleInstance>

Identification
or detection of

Sample template

File type with

The following template checks the identification or detection of the file type with only a part of

only a part of

the name given.

the name giv
<MultipleInstance>

en
<Iterator name="INSTALL_PATH">
<FindFilePathEx name="*.FILETYPE" appendFileName="true"/>
</Iterator>
<Instance>
<Variable name="IS_INSTALLED">
<Compare type="string" relation="ne">
<ValueOf value="$(INSTALL_PATH)" />
<ValueOf value="" />
</Compare>
</Variable>
<Condition withVariable="IS_INSTALLED">
<Action onValue="false" do="SKIP"/>
</Condition>
</Instance>
</MultipleInstance>

The existence

The following template checks the identification or detection of the existence of a specific file,

of a specific

another file does not exist.

file, another file
<MultipleInstance>

does not exist
<Iterator name="INSTALL_PATH">
<FindFilePathEx name="file1"/>
</Iterator>
<Instance>
<Variable name="IS_INSTALLED">
<And>
<FileExists absolutePath="$(INSTALL_PATH)file1"/>
<Not>

Identification
or detection of

Sample template
<Compare type="string" relation="ne">
<VectorToScalar>
<FindFilePathEx name="file2"/>
</VectorToScalar>
<ValueOf value=""/>
</Compare>
</Not>
</And>
</Variable>
<Condition withVariable="IS_INSTALLED">
<Action onValue="false" do="SKIP"/>
</Condition>
</Instance>
</MultipleInstance>

Software items The following template checks the identification or detection of the Software items when the
when the reg
istry key iden

registry key identifies the product, Windows™ systems.
Compares a part of the key string. To address this case, two signatures must be created, one for

tifies the prod 32 -bit and one for 64-bit architecture.
uct, Windows™
systems

<MultipleInstance>
<Iterator name="reg">
<Vector filter="*000000FF1CE}" ignoreCase="false">
<RegKeyList
root="HKEY_LOCAL_MACHINE\Software\Microsoft\Windows\CurrentVersion\Uninstal
l\*" section="32" subkeys="false"/>

</Vector>

</Iterator>
<Instance>
<Variable name="IS_INSTALLED">
<And>
<Compare relation="eq" type="string">

Identification
or detection of

Sample template
<Clip endIndex="76" inputString="$(reg)" startIndex="74"/>
<ValueOf value="140"/>
</Compare>
<Compare relation="eq" type="string">
<Clip endIndex="84" inputString="$(reg)" startIndex="81"/>
<ValueOf value="0018"/>
</Compare>
</And>
</Variable>
<Condition withVariable="IS_INSTALLED">
<Action do="SKIP" onValue="false"/>
</Condition>
</Instance>
</MultipleInstance>

<MultipleInstance>
<Iterator name="reg">
<Vector filter="*000000FF1CE}" ignoreCase="false">
<RegKeyList
root="HKEY_LOCAL_MACHINE\Software\Microsoft\Windows\CurrentVersion\Uninstal
l\*" section="64" subkeys="false"/>
</Vector>
</Iterator>
<Instance>
<Variable name="IS_INSTALLED">
<And>
<Compare relation="eq" type="string">
<Clip endIndex="76" inputString="$(reg)" startIndex="74"/>
<ValueOf value="140"/>
</Compare>

Identification
or detection of

Sample template
<Compare relation="eq" type="string">
<Clip endIndex="84" inputString="$(reg)" startIndex="81"/>
<ValueOf value="0018"/>
</Compare>
</And>
</Variable>
<Condition withVariable="IS_INSTALLED">
<Action do="SKIP" onValue="false"/>
</Condition>
</Instance>
</MultipleInstance>

Registry keys,

The following template checks the identification or detection of the registry keys, where edition

where edition

and version are stored.

and version

This signature matches a specific version range.

are stored
<Variable name="IS_INSTALLED">
<And>
<RegKeyValueContains entry="Edition"
key="HKEY_LOCAL_MACHINE\SOFTWARE\Vendor\SoftwareName\Data"
value="Enterprise" section="64or32"/>
<RegKeyVersionCompare
key="HKEY_LOCAL_MACHINE\SOFTWARE\Vendor\SoftwareName\CurrVer"
entry="Version" relation="ge" value="3.00.00.00" section="64or32"/>
<RegKeyVersionCompare
key="HKEY_LOCAL_MACHINE\SOFTWARE\Vendor\SoftwareName\CurrVer"
entry="Version" relation="le" value="3.9999.9999.9999" section="64or32"/>
</And>
</Variable>

Identification
or detection of

Sample template

Software in

The following template checks the identification or detection of the software instances by identi

stances by

fying their registry keys.

identifying
their registry
keys.

Instance name is reflected by the asterisk character in registry path: HKEY_LOCAL_MACHINE\SOFTWARE\ Microsoft\SoftwareName\*\Info\CurrVer
This signature matches a specific edition and version range. To address this case, two signa
tures must be created, one for 32-bit and one for 64-bit architecture.
<MultipleInstance>
<Iterator export="false" name="rg">
<Vector>
<RegKeyList
root="HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\SoftwareName\*" section="64"
subkeys="false"/>
</Vector>
</Iterator>
<Instance>
<Variable export="false" name="vr">
<RegKeyValue entry="Version" key="$(rg)\Info\CurrVer"
mustExists="true" section="64"/>
</Variable>
<Variable name="IS_INSTALLED">
<And>
<RegKeyValueContains entry="Edition" key="$(rg)\Data" section="64"
value="Enterprise"/>
<Contains inputString="$(vr)" position="start" searchedString="3."/>
</And>
</Variable>
<Condition withVariable="IS_INSTALLED">
<Action do="SKIP" onValue="false"/>
</Condition>

Identification
or detection of

Sample template
</Instance>
</MultipleInstance>

<MultipleInstance>
<Iterator export="false" name="rg">
<Vector>
<RegKeyList
root="HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\SoftwareName\*" section="32"
subkeys="false"/>
</Vector>
</Iterator>
<Instance>
<Variable export="false" name="vr">
<RegKeyValue entry="Version" key="$(rg)\Info\CurrVer"
mustExists="true" section="32"/>
</Variable>
<Variable name="IS_INSTALLED">
<And>
<RegKeyValueContains entry="Edition" key="$(rg)\Data" section="32"
value="Enterprise"/>
<Contains inputString="$(vr)" position="start" searchedString="3."/>
</And>
</Variable>
<Condition withVariable="IS_INSTALLED">
<Action do="SKIP" onValue="false"/>
</Condition>
</Instance>
</MultipleInstance>

Uninstall reg

The following template checks the identification or detection of the uninstall registry keys, Win

istry keys, Win dows™ systems.

Identification
or detection of

Sample template

dows™ sys

This signature iterates through all keys and tries to match specific patterns in DisplayName and

tems

DisplayVersion values. To address this case, two signatures must be created, one for the 32-bit
and one for the 64-bit architecture.
<MultipleInstance>
<Iterator name="reg" export="true">
<RegKeyList
root="HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Uninstal
l\*"

section="32" subkeys="false"/>

</Iterator>

<Instance>
<Variable name="valueName" export="true">
<RegKeyValue entry="DisplayName" key="$(reg)" section="32" />
</Variable>
<Variable name="valueVersion" export="true">
<RegKeyValue entry="DisplayVersion" key="$(reg)" section="32" />
</Variable>
<Variable name="IS_INSTALLED">
<And>
<Contains inputString="$(valueName)" searchedString="TestProduct"
position="start"/>
<Contains inputString="$(valueVersion)" searchedString="12.0"
position="start"/>
</And>
</Variable>
<Condition withVariable="IS_INSTALLED">
<Action onValue="false" do="SKIP"/>
</Condition>
</Instance>
</MultipleInstance>

Identification
or detection of

Sample template
<MultipleInstance>
<Iterator name="reg" export="true">
<RegKeyList
root="HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Uninstal
l\*"

section="64" subkeys="false"/>

</Iterator>
<Instance>
<Variable name="valueName" export="true">
<RegKeyValue entry="DisplayName" key="$(reg)" section="64" />
</Variable>
<Variable name="valueVersion" export="true">
<RegKeyValue entry="DisplayVersion" key="$(reg)" section="64" />
</Variable>
<Variable name="IS_INSTALLED">
<And>
<Contains inputString="$(valueName)" searchedString="TestProduct"
position="start"/>
<Contains inputString="$(valueVersion)" searchedString="12.0"
position="start"/>
</And>
</Variable>
<Condition withVariable="IS_INSTALLED">
<Action onValue="false" do="SKIP"/>
</Condition>
</Instance>
</MultipleInstance>

Extended signature operators
Available from 9.2.2. The scan operations during which extended XML signature
definitions are used are performed based on the processing instructions that are contained
in the signature catalog. In computer languages, expressions consist of two types of
components: operands and operators. Operands are the objects that are manipulated and
operators are the symbols that represent specific actions. Operands and operators can be
either scalar or vector.
The following definitions apply to operators and operands in the context of the signature
catalog:
scalar operand
Returns a value in string format. An operand cannot have children. For
example, the RegKeyValue scalar operand returns the value of the specified
registry key.
scalar operator
Performs an operation on other operators and operands and returns results in
string format. An operator can have children. For example, the AND operator,
returns true or false as a result.
vector operand
Returns results as a set of strings. An operand cannot have children. For
example, the FindFilePathEx operand, returns a set of file paths.
vector operator
Performs an operation on other operators and operands and returns results
as a set of strings. An operator can have children. For example, the Vector
operator, returns a set of strings that contain the results of all its children.
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The structure of the signature catalog
Table 175. The structure of the signature catalog
Operands and
operators
Action

Function and supported attributes
Specifies the action to be performed depending on the result of the Condition element.
Attributes:
onValue
The value that causes the action to be performed. This at
tribute is required.
do
Specifies the operation to be performed. This attribute is re
quired. The supported value is SKIP, which interrupts the sig
nature or the iterator instance evaluation and prevents it from
being returned in the output.

Condition

Verifies if the specified condition is met. It contains one or more Action elements, which
specify the action to be performed depending on the result of the Condition element.
Attributes:
withVariable
Specifies the name of the variable whose condition is to be
verified. This attribute is required.

MultipleInstance

Groups information to identify a software product that might be installed in several in
stances on the same workstation. It contains 1 Iterator and 1 Instance element.
Attributes:
None

Table 175. The structure of the signature catalog (continued)
Operands and
operators

Function and supported attributes
Multiple instance - iterator on INSTALL_PATH
<MultipleInstance>
<Iterator name="INSTALL_PATH">
<FindFilePathEx name=""/>
</Iterator>
<Instance>
<Variable name="IS_INSTALLED"><!-- RULE -->
</Variable>
<Condition withVariable="IS_INSTALLED">
<Action onValue="false" do="SKIP"/>
</Condition>
</Instance>
</MultipleInstance>

Multiple instance - iterator on a vector with calculation (options) of INSTALL PATH
later on
<MultipleInstance>
<Iterator name="ITER_VAR">
</Iterator>
<Instance>
<Variable name="IS_INSTALLED"><!-- RULE --> </Variable>
<Variable name="INSTALL_PATH"><!-- RULE --> </Variable>
<Condition withVariable="IS_INSTALLED">
<Action onValue="false" do="SKIP"/>
</Condition>
</Instance>
</MultipleInstance>

Table 175. The structure of the signature catalog (continued)
Operands and
operators
Variable

Function and supported attributes
Is a container for a single value that is expressed as a string whose return value is given
by the result of a set of operators and operands.
Attributes:
name
Specifies the name of the variable. It is unique in the contain
ing signature scope. This attribute is required.
export
Specifies if the output of the variable is to be exported. Sup
ported values are true and false. The default value is true. This
attribute is optional.

Core expressions
Operands and
operators
And

Function and supported attributes
Performs a logical AND operation between the results of all its children. If one of the op
erations returns false, the whole operation is set to false without performing further eval
uation on the remaining children. At least one child is required.
Properties:
• Result type: scalar [true | false]
• Expression type: operator
Example:

Operands and
operators

Function and supported attributes
<And>
....scalar operators and operands returning a Boolean
value
</And>

Clip

Returns a substring that is a range of consecutive characters from a string, starting with
the character whose index is specified as startIndex and ending with the character whose
index is specified as endIndex.
Properties:
• Result type: scalar
• Expression type: operand
Example:
For example: the substring 234 is returned when:
<Clip inputString="123456789" startIndex="1" endIndex="3"/>

Attributes:
inputString
Specifies the string to be cropped.
startIndex
Specifies the index of the character in the input string that the
substring should start with. An index of 0 refers to the first
character of the input string.
endIndex
Specifies the index of the character in the input string that
the substring should end with. An index of 0 refers to the last
character of the input string.

Operands and
operators

Function and supported attributes
Note: It is recommended to use the new operator StringSlice whose range is
wider than that of Clip because StringSlice supports negative indexes in Python
syntax.

Compare

Compares two expressions based on the value of the relation attribute. The result is true
if the expression is satisfied, false if the expression is not satisfied.
Properties:
• Result type: scalar
• Expression type: operator
Example:
<Compare relation="relation" type="type" >
<Expression 1/>
<Expression 2/>
</Compare>

Attributes:
relation
Specifies the relation to be evaluated. The supported values
are as follows:
• eq - equal to
• ne - not equal to
• gt - greater than
• ge - greater than or equal to
• lt - less than
• le - less than or equal to
type

Operands and
operators

Function and supported attributes
Specifies the format of the expressions to be compared. The
supported values are as follows:
• version - Compares two versions. The version is ex
pressed by no more than four numbers that are sepa
rated by periods or commas.
• integer - Compares two integers.
• string - Compares two strings.
• cistring - Compares two case-insensitive strings.
• boolean - The comparison is to be performed between
two Boolean values.
• hex - Compares two unsigned 4-byte hexadecimal inte
gers. The 0x prefix is optional.

Concat

Returns a concatenation of the expressions.
Properties:
• Result type: scalar
• Expression type: operator
Example:
<Concat [separator="separator"] [ifEmpty="{add|skip}"] >
<Expression 1/>
<Expression 2/>
...
</Concat>

Attributes:
separator
Specifies the separator to insert between two expressions.
This attribute is optional. The default value is an empty string.

Operands and
operators

Function and supported attributes
ifEmpty
Specifies if the separator must be added if the expression to
concatenate is empty. This attribute is optional. Supported
values are as follows:
skip
If the string is empty, the separator is not added.
This is the default value.
add
If the string is empty, the separator is added.

Contains

Checks if the string contains a string.
Properties:
• Result type: scalar [{true|false}]
• Expression type: operand
Example:
<Contains inputString="example_string" searchedString=
"example_string_to_search" position = ["start" | "end" |
"contains"]/>

Attributes:
inputString
Specifies string to search in.
searchedString
Specifies string to search.
position
Specifies where to search.
start

Operands and
operators

Function and supported attributes
Checks if the searched string is at the beginning.
end
Checks if searched string is at the end.
contains
Checks if searched string is somewhere in the
original string.

FileInfoCompare Returns the information that is specified in the field attribute.
Properties:
• Result type: scalar [{true|false}]
• Expression type: operand
Example:
<FileInfoCompare
absolutePath="absolute_path"
field="field"
value="value"
relation="relation"
[mustExist="{true|false}"]
/>

Attributes:
absolutePath
Specifies the absolute path to the file to evaluate.
field
Compares two files by one of the values that are supported,
which are as follows:

Operands and
operators

Function and supported attributes
• size
• inode (UNIX™ only)
• atime - the date the file was accessed in UNIX™ time
stamp format.
• ctime - the date the file was created in UNIX™ time
stamp format.
• mtime - the date the file was modified in UNIX™ time
stamp format.
relation
Specifies the relation to be evaluated.
value
Specifies the value to compare with.
mustExist
Indicates that the specified file must exist. This attribute is op
tional. The default value is false. If this attribute is set to true
and the specified file does not exist, the current signature is
not evaluated.

FileExists

Returns a Boolean value that indicates if the specified file exists.
Properties:
• Result type: scalar [true | false]
• Expression type: operand
Example:
<FileExists absolutePath="absolute_path" />

Attributes:
absolutePath

Operands and
operators

Function and supported attributes
Specifies the absolute path to the file to be searched.

Not

Performs a logical NOT operation on the result of its one child. Only one child is allowed.
Properties:
• Result type: scalar [true | false]
• Expression type: operator
Example:
<Not>
.... a single scalar operator or operand returning a
Boolean value
</Not>

PathExists

Returns a Boolean value that indicates if the specified path exists.
Properties:
• Result type: scalar
• Expression type: operand
Example:
<PathExists absolutePath="absolute_path" />

Attributes:
absolutePath
Specifies the absolute path to be searched.
Or

Performs a logical OR operation between the results of all its children. If one of the opera
tions returns "true", the whole operation is set to "true" without performing further evalua
tion on the remaining children. At least one child is required.

Substring

Searches through a string that contains multiple lines of text and returns the lines of a
string that contain the search text.

Operands and
operators

Function and supported attributes
Properties:
• Result type: vector
• Expression type: operand
Example:
<Substring inputString="input_string_to_search"
searchedString=
"string_to_search_for"/>

Attributes:
inputString
Input string that contains multiple lines.
searchedString
The string that is searched for.
Vector

Returns a vector that contains the union of all its children, duplicates are included. If you
specify a filter, the result contains only the strings that match the pattern.
• filter: Specifies the filter criteria to be applied to the search. The asterisk (*) and
question mark (?) wildcards are supported.

VectorAt

Returns the vector element for the specified position.
Properties:
• Result type: scalar
• Expression type: operator
Example:
<VectorAt index="index_number">
... any number of scalar/vector operator/operand
</VectorAt>

Operands and
operators

Function and supported attributes
Attributes:
index
Specifies the wanted vector position. The first vector element
has position "1".

VectorToScalar

Converts a vector to its scalar representation. You must convert a vector to scalar be
cause only scalars can be compared.

File system expressions
Operands and
operators
FindFilePathEx

Function and supported attributes
Searches for the specified file in the specified locations. The result is a vector of all the
paths where at least one entry that matches the specified file is found.
The operand searches either the cache or the file system depending on the settings that
are defined for the file system scanner. To have the operand search the file system, set
the maxDataAge attribute to zero in the configuration file. An extra filter can be set to re
fine the file search. Such a filter can contain a file system scanner query, which is applied
to the found file. If the filter returns a true condition, the directory for the file is returned,
otherwise it is not returned.
Properties:
• Result type: vector
• Expression type: operand
Example:
< FindFilePathEx name="file_name"[filter="query_filter"]
[recursive="{true|false}"]
[appendFileName="{true|false}"]/>

Attributes:

Operands and
operators

Function and supported attributes
name
Specifies the file mask to be searched. This attribute is re
quired.
appendFileName
Specifies if the results contain the file name. This attribute is
optional. The supported values are as follows:
• true
• false
filter
Specifies a file system query.

FileInfoMatch

Searches for a file with the specified name and attributes in the specified locations. The
result is true if at least one matching file is found.
Properties:
• Result type: scalar
• Expression type: operand
Example:
<FileInfoMatch
[rootPath="root_path"]
[recursive="{true|false}"]
name="file_name"
field="field"
values="values"
/>

Attributes:
rootPath

Operands and
operators

Function and supported attributes
Specifies the path where the search is to be performed. The
default value is /. Wildcards (*) (?) are supported. The path is
indicated according to the following syntax:
media_type::]drive:path

where
media_type
Specifies the media type and can assume the
following values:
$local
Includes local disks. This is the de
fault value.
$remote
Includes remote disks
$other
On Windows™ systems, includes
other disk types, such as CDROM,
DVD. On UNIX™ systems, this value
is not supported and is expressed
with the $local value.
$all
Includes all disks that are listed
above.
If the media_type variable is not specified, the
$local value is assumed, therefore, if you want

to scan disks other than local, specify a value
for the media_type variable.

Operands and
operators

Function and supported attributes
drive
Specifies the drives to be excluded. You can in
dicate one or more specific drives or you can
use the $local, $remote, $other, and $all val
ues. In this case, all drives in the specified cate
gory are excluded from the search. This variable
is optional on UNIX™ operating systems.
path
Specifies the path to be excluded. Wildcards (*)
and (?) are supported.
This attribute is optional.
recursive
Specifies if the search is to be performed in the specified path
and in all its subdirectories. Supported values are true and
false. The default value is true. This attribute is optional.
name
Specifies the file name to be searched. This attribute is re
quired. Wildcards (*) and (?) are supported.
field
Compares two files by one of the values that are supported,
which are as follows:
• size
• inode (UNIX™ only)
• atime - the date the file was accessed in UNIX™ time
stamp format.

Operands and
operators

Function and supported attributes
• ctime - the date the file was created in UNIX™ time
stamp format.
• mtime - the date the file was modified in UNIX™ time
stamp format.
values
Specifies one or more values for the attribute that is specified
in the field attribute. If more than one value is specified, the
items are concatenated by using the Unicode control charac
ter "Private Use 1" with ASCII code 0x0091.
date
Returns the creation, access, and modification dates of the
file.

ReadFile

Returns in string form the text from a file on the system.
Properties:
• Result type: scalar
• Expression type: operand
Example:
<ReadFile
path="path_to_file" [trim="{true|false}"][fileType="{nativ
e|utf8}"]/>

Attributes:
Path
Specifies the path to the file.
trim

Operands and
operators

Function and supported attributes
Indicates if new line special characters must be removed
from the content of the file. The default is false.
fileType
Indicates the type of file. The default is native.

Native registry expressions
Operands and
operators
AixProductInfo

Function and supported attributes
Returns any information about the supported AIX® operating systems.
Properties:
• Result type: scalar
• Expression type: operand
Example:
<AixProductInfo code="product_code"
field="{name|version|vendor|description|installDir}"
[mustExist="{true|false}"] />

Attributes:
code
Specifies the product code that uniquely identifies an AIX®
ODM package. The product code can be retrieved only by us
ing the AixProductList operand. For more information about
this operand, see AixProductList.
field
Specifies the information to be retrieved. Supported values
are as follows:

Operands and
operators

Function and supported attributes
• name
• version - The version is expressed by no more than
four numbers that are separated by periods or com
mas.
• vendor
• description
• installDir
mustExist
Specifies whether to stop the operand evaluation if the spec
ified file does not exist. Supported values are true and false.
The default value is false. This attribute is optional. If this at
tribute is set to true and the specified file does not exist, the
current signature is not evaluated. If the attribute is false and
the specified file does not exist, the return value is an empty
string.

AixProductList

Returns the set of AIX® ODM package codes. The codes that are returned can be used
with the AixProductExists and AixProductInfo operands.
Properties:
• Result type: vector
• Expression type: operand
Example:
<AixProductList [filter="filter_expression"]
[type="type"] />

Attributes:
type

Operands and
operators

Function and supported attributes
Applies a filter based on the product type. This attribute is op
tional. Supported values are as follows:
any
Returns both products and any subproducts.
This is the default value.
product
Returns only products.
filter
Specifies the filter criteria to be applied to the search. The as
terisk (*) and question mark (?) wildcards are supported. This
attribute is optional.

HpProductInfo

Returns the requested information, if available.
Properties:
• Result type: scalar
• Expression type: operand
Example:
<HpProductInfo code="product_code" field="{name|version|
vendor|installDir}"/>

Attributes:
code
Specifies the product and subproduct code that uniquely iden
tifies an HP-UX package. The product and subproduct code
can be retrieved only by using the HpProductList operand. For
more information about this operand, see HpProductList. This
attribute is optional.

Operands and
operators

Function and supported attributes
field
Specifies the information to be retrieved. Supported values
are as follows:
• name
• version - The version is expressed by no more than
four numbers that are separated by periods or com
mas.
• vendor
• installDir

HpProductList

Returns the set of HP-UX package codes. The codes that are returned can be used with
the HpProductExists and HpProductInfo operands.
Properties:
• Result type: vector
• Expression type: operand
Example:
<HpProductList [filter="filter_expression"]
[type="type"] />

Attributes:
type
Applies a filter based on the product type. This attribute is op
tional. Supported values are as follows:
any
Returns both products and any subproducts.
This is the default value.
product

Operands and
operators

Function and supported attributes
Returns only products.
subproduct
Returns only subproducts.
filter
Specifies the filter criteria to be applied to the search. The as
terisk (*) and question mark (?) wildcards are supported. This
attribute is optional.

RpmProductEx
ists

Indicates if the specified package is installed.
Properties:
• Result type: scalar [true | false]
• Expression type: operand
• Operating system: supported on Linux™ and AIX
Example:
<RpmProductExists code="product_code" />

Attributes:
code
Specifies the product code that uniquely identifies an RPM
package. The product code can be retrieved by using the
RPMProductList operand. For more information about this
operand, see RpmProductList.
The product code can also be listed with the rpm -qa com
mand. The command returns all available codes that identify
RPM packages. The codes can either define the package ar
chitecture or not; for example: kernel-2.6.32-358.el6.x86_64 or
kernel-2.6.32-358.el6.

Operands and
operators
RpmProductList

Function and supported attributes
Returns the set of RPM package codes. The codes that are returned can be used with the
RpmProductExists and RpmProductInfo operands.
Properties:
• Result type: vector
• Expression type: operand
• Operating system: supported on Linux™ and AIX
Example:
<RpmProductList [filter="filter_expression"]
[type="type"] />

Attributes:
filter
Specifies the filter criteria to be applied to the search. The as
terisk (*) and question mark (?) wildcards are supported. This
attribute is optional.
type
Applies a filter based on the product type. This attribute is op
tional. Supported values are as follows:
any
Returns both products and any subproducts.
This is the default value.
product
Returns only products.
SunProductInfo

Returns the requested information, if available.
Properties:

Operands and
operators

Function and supported attributes
• Result type: scalar
• Expression type: operand
• Operating system: supported Oracle Solaris operating environments
Example:
<SunProductInfo code="produt_code"
field="{name|version|displayVersion|vendor|installDir}"/>

Attributes:
code
Specifies the product code that uniquely identifies an Ora
cle Solaris package. The product code can be retrieved only
by using the SunProductList operand. For more information
about this operand, see SunProductList.
field
Specifies the information to be retrieved. Supported values
are as follows:
name
Returns the name of the product.
version
Returns the product version and revision num
ber, for example 3.7.2101.
displayVersion
Returns the product version and revision num
ber, for example 3.7.2101, REV=0.98.08.26.
vendor
Returns the name of the vendor.
installDir

Operands and
operators

Function and supported attributes
Returns the topmost installation directories.

SunProductList

Returns the set of Sun Solaris package codes. The codes that are returned can be used
with the SunProductExists and operands.
Properties:
• Result type: vector
• Expression type: operand
• Operating system: supported Sun Solaris operating environments
Example:
<SunProductList [filter="filter_expression"]
[type="type"] />

Attributes:
type
Applies a filter based on the product type. This attribute is op
tional. Supported values are as follows:
any
Returns both products and any subproducts.
This is the default value.
product
Returns only products.
filter
Specifies the filter criteria to be applied to the search. The as
terisk (*) and question mark (?) wildcards are supported. This
attribute is optional.
Win32Program
Info

Returns the requested information, if available.
Properties:

Operands and
operators

Function and supported attributes
• Result type: scalar
• Expression type: operand
• Operating systems: all supported Windows™ operating systems
Example:
<Win32ProgramInfo code="product_code"
field="{name|description|version|vendor|installDir|uninstD
ata}"/>

Attributes:
code
Specifies the product code that uniquely identifies a Win32
program. The program code can be retrieved only by using the
Win32ProgramList operand. For more information about this
operand, see Win32ProgramList.
field
Specifies the information to be retrieved. Supported values
are as follows:
name
Returns the patch name.
description
Returns the patch description.
version
Returns the product version. The version is ex
pressed by no more than four numbers that are
separated by periods or commas.
vendor
Returns the product vendor.

Operands and
operators

Function and supported attributes
installDir
Returns the product installation directory.
uninstData
Returns the product uninstallation command.

Win32Program

Returns the set of packages installed. The codes that are returned can be used with the

List

Win32ProgramExists and Win32ProgramInfo operands.
Properties:
• Result type: vector
• Expression type: operand
• Operating systems: all supported Windows™ operating systems
Example:
<Win32ProgramList [filter="filter_expression"]
[type="type"] />

Attributes:
type
Applies a filter based on the product type. This attribute is op
tional. Supported values are as follows:
any
Returns both products and any subproducts.
This is the default value.
product
Returns only products.
filter

Operands and
operators

Function and supported attributes
Specifies the filter criteria to be applied to the search. The as
terisk (*) and question mark (?) wildcards are supported. This
attribute is optional.

Registry operands
Operands and
operators

Function and supported attributes

PackageInfoE

Returns true if an item with the same name, version, and vendor exists in the specified

qual

registry.
Properties:
• Result type: scalar [true | false]
• Expression type: operand
Example:
<PackageInfoEqual
provider="{any | ismp | os}"
code="product_code"
value="name_version_vendor"
/>

Attributes:
provider
Specifies the installation database to be searched. Supported
values are as follows:
any
Specifies that the search is performed on the
operating system installation database and then
on the ISMP installation database.

Operands and
operators

Function and supported attributes
OS
Specifies that the search is performed on the
operating system installation database.
ismp
Specifies that the search is performed on the
ISMP installation database.
code
Specifies the product code that uniquely identifies the prod
uct.
value
Comprises the concatenation of the name, version, and ven
dor strings for the product. Separate each string with a blank
space; empty strings can be omitted.

PackageInfo
Match

Returns true if an item with the same name, version, and vendor exists in any registry.
Properties:
• Result type: scalar [true | false]
• Expression type: operand
• Operating systems: all supported operating systems
Example:
<PackageInfoMatch
vendor="product vendor"
name="product name"
version="product version"
/>

Attributes:
vendor

Operands and
operators

Function and supported attributes
Specifies the product vendor.
name
Specifies the name of the product.
version
Specifies the product version number.
The wildcard (*) is supported.

Windows™ registry expressions
Operands and
operators
RegKeyExists

Function and supported attributes
Indicates whether the specified key exists.
Properties:
• Result type: scalar [true | false]
• Expression type: operand
Example:
<RegKeyExists key="key" [section="{32|64|32or64|64or32}"]/>

Attributes:
key
Specifies the full registry key name in registry_key\registry_subkey format.
section
Specifies the attribute that indicates which section of the reg
istry the search is to be performed on. This is the parameter
introduced to make sure that the scanner functions correctly
on 64-bit systems. Its values are:

Operands and
operators

Function and supported attributes
32
The search is only performed on the 32-bit part
of the registry.
64
The search is only performed on the 64-bit part
of the registry.
32or64
The search is performed on the 32-bit part first,
then on the 64-bit part of the registry.
64or32
The search is performed on the 64-bit part first,
then on the 32-bit part of the registry.
Default value is 32.

RegKeyList

Searches the Windows™ registry under the key that is specified in the root attribute, and
returns a list of keys that are in the registry under the root key. If the subKeys attribute is
set to false, only the values in the root key are returned.
Properties:
• Result type: vector
• Expression type: operand
Example:
<RegKeyList
root="root_key"
[section="{32|64|32or64|64or32}"]
[subKeys="{true|false}"]/>

Attributes:

Operands and
operators

Function and supported attributes
root
Specifies the full registry key name in registry_key\registry_subkey format.
section
Specifies the attribute that indicates which section of the reg
istry the search is to be performed on. (This is the parameter
introduced to make sure that the scanner runs correctly under
64-bit systems. Its values are:
32
The search is only performed on the 32-bit part
of the registry.
64
The search is only performed on the 32-bit part
of the registry.
32or64
The search is performed on the 32-bit part first,
then on the 64-bit part of the registry.
64or32
The search is performed on the 64-bit part first,
then on the 32-bit part of the registry.
Default value is 32.
subKeys
Specifies if subkeys must be returned. The default value is
false.

RegKeyValue

Returns the current value for the specified registry key. When the registry key is a REG_DWORD entry, the key attribute returns a decimal value.

Operands and
operators

Function and supported attributes
Properties:
• Result type: scalar
• Expression type: operand
Example:
<RegKeyValue entry="entry" key="key"
[section="{32|64|32or64|64or32}"]
[mustExist="{true|false}"]/>

Attributes:
key
Specifies the full registry key name in registry_key\registry_subkey format.
entry
Specifies the name of the value that is contained in the key. To
retrieve the value of registry entries that are named "(Default)",
you must specify a null value for the entry attribute, for exam
ple entry="".
section
Specifies the attribute that indicates which section of the reg
istry the search is to be performed on. This is the parameter
introduced to make sure that the scanner runs correctly on 64bit systems. Its values are:
32
The search is only performed on the 32-bit part
of the registry.
64

Operands and
operators

Function and supported attributes
The search is only performed on the 32-bit part
of the registry.
32or64
The search is performed on the 32-bit part first,
then on the 64-bit part of the registry.
64or32
The search is performed on the 64-bit part first,
then on the 32-bit part of the registry.
Default value is 32.
mustExist
Specifies whether to stop the operand evaluation if the spec
ified key does not exist. Supported values are true and false.
The default value is false. This attribute is optional. If this at
tribute is set to true and the specified key does not exist, the
current signature is not evaluated. If this attribute is set to
false and the specified key does not exist, an empty string is
returned.

RegKeyValue
Contains

Specifies whether the specified registry key contains the specified value.
Properties:
• Result type: scalar [true | false]
• Expression type: operand
Example:
<RegKeyValueContains
entry="entry"
key="key"
value="value"

Operands and
operators

Function and supported attributes
[section="{32|64|32or64|64or32}"]
[mustExist="{true|false}"]/>

Attributes:
key
Specifies the full registry key name in registry_key\registry_subkey format.
entry
Specifies the name of the value that is contained in the key.
value
Specifies the value that must be contained in the entry.
section
Specifies the attribute indicating which section of the registry
the search should be performed on. This is the parameter in
troduced to make sure that the scanner runs correctly on 64bit systems. Its values are:
32
The search is only performed on the 32-bit part
of the registry.
64
The search is only performed on the 32-bit part
of the registry.
32or64
The search is performed on the 32-bit part first,
then on the 64-bit part of the registry.
64or32

Operands and
operators

Function and supported attributes
The search is performed on the 64-bit part first,
then on the 32-bit part of the registry.
Default value is 32.
mustExist
Specifies whether to stop the operand evaluation if the spec
ified key does not exist. Supported values are true and false.
The default value is false. This attribute is optional. If this at
tribute is set to true and the specified key does not exist, the
current signature is not evaluated. If this attribute is set to
false and the specified key does not exist, an empty string is
returned.

RegKeyValueE
qual

Indicates if the specified registry key value is equal to the specified key.
key
Specifies the full registry key name in registry_key/registry_subkey
format.
entry
Specifies the name of the value that is contained in the key.
value
Specifies the value to be compared. When the registry key that is specified
in the entry attribute is a REG_DWORD entry, enter a decimal value in the val
ue attribute.

RegKeyVersion

Compares the specified registry key value with the specified version based on the value

Compare

of the relation attribute.
Properties:
• Result type: scalar [true | false]
• Expression type: operand

Operands and
operators

Function and supported attributes
Example:
<RegKeyVersionCompare
key="key"
entry="entry"
relation="relation"
value="value"
[section="{32|64|32or64|64or32}"]
[mustExist="{true|false}"]/>

Attributes:
key
Specifies the full registry key name in registry_key\registry_
subkey format.
entry
Specifies the name of the value that is contained in the key.
relation
Specifies the relation to be evaluated. Supported values are as
follows:
• eq - equal to
• ne - not equal to
• gt - greater than
• ge - greater than or equal to
• lt - less than
• le - less than or equal to
value
Specifies the version to be compared.

Operands and
operators

Function and supported attributes
Note: When the registry key that is specified in the en
try attribute is a REG_DWORD entry, enter a decimal
value in the value attribute. The supported value is
version. The version is expressed by up to four num
bers that are separated by periods or commas.

Note: When the registry key that is specified in the en
try attribute is a REG_BINARY entry in the value field,
enter a string that looks exactly like the "data" field
when you are viewing the field in the registry editor.
This string must be of a series of two-digit numbers
that are separated by spaces, for example, "01 01" "10
11 10".

section
Specifies the attribute that indicates which section of the reg
istry the search is to be performed on. This is the parameter
introduced to make sure that the scanner runs correctly on 64bit systems. Its values are:
32
The search is only performed on the 32-bit part
of the registry.
64
The search is only performed on the 64-bit part
of the registry.
32or64
The search is performed on the 32-bit part first,
then on the 64-bit part of the registry.

Operands and
operators

Function and supported attributes
64or32
The search is performed on the 64-bit part first,
then on the 32-bit part of the registry.
The default value is 32.
mustExist
Specifies whether to stop the operand evaluation if the spec
ified key does not exist. Supported values are true and false.
The default value is false. This attribute is optional. If this at
tribute is set to true and the specified key does not exist, the
current signature is not evaluated.

Testing extended signatures
You can test signatures on endpoints and verify if they discover any software. There are two
methods to test signatures.
Using a fixlet in BigFix Console
Testing manually on the endpoint

Testing using BigFix Console
The 'Test CIT Signature fixlet' allows you test custom signatures on selected endpoints, to
discover if there is any match. For creating custom signatures refer to Extended signature
templates.
Prepare a valid CIT signature in the XML format, like the signatures shown in the templates.
Important: This task is relevant if both 'Initiate Software Scan' and the 'Upload the
Scan Results' fixlets complete at least once on selected endpoint. Software scan
cannot be running when you want to perform CIT signature test.

To run the fixlet, perform these steps:
1. Log in to the BigFix console.
2. Go to Sites > External Sites > BigFix Inventory v10 > Fixlets and Tasks.
3. Select Test CIT Signature.
4. In the 'Enter a single valid CIT signature' field, paste the signature. Enter only one
signature.
Fixlet validates if the XML structure is correct, but it does not check the validity of the
signature. If XML structure is incorrect, the fixlet will show an error with information
about the problem and the line where it is located. The signature should not include
<signature> and <xml> tags.
Only local drives are scanned on the selected computers. For information about
scanning shared disks, see: Discovering software on shared disks.
5. To enable scanning of shared disks in basic mode, select 'Scan remote shared disks'.
The basic mode is advised for environments where a single shared disk is mounted
on a single computer or a few computers.
This action uses the same CPU threshold, included and excluded directories as
'Initiate Software Scan' fixlet that is executed on this endpoint.
6. To start the scan, click Take Action.
7. Select the computers on which you want to initiate the scans and click OK to proceed.
Starting the action sends signature to the endpoint, where it creates custom catalog and
performs software scan. Fixlet runs until results are ready, unless the time of execution
exceeds 15 minutes. You can edit the timeout settings. See also, Timeout setting.
When fixlet completes, scan results are available on the endpoint at BESClint/LMT/
cit_signature_test folder and compressed archive is available on BES Server in
location: BES Server \UploadManagerData\BufferDir\sha1\<last 2 digits
of computer id>\<computer id>\signatureTest_<computer_id>.
Result files:

• Scan results are available in <computer_id>_cit.xml file, where a list of matches
is found. If there are no matches, there is no data between <MatchedSignatures></
MatchedSignatures> tags.

• <computer_id>_citlog.log contains logging information from the scan
• <computer_id>_citlog.xml contains signature warnings, if there is anything
wrong with the signature, a warning appears
• <computer_id>_catalog.xml contains tested signature
• catalog_scan_status.info contains information if scan was successful, 1 for
yes, 0 for no
• last_catalog_scan_success.info contains date of the last successful scan
• cit_test_sw_config.xml contains configuration for the scanner
• runcit_sw.bat / runcit_sw.sh
• set_shared_disk_scan.sh

Timeout setting
The timeout can be changed by setting the timeout property in computer settings in BigFix
Console.
Note: Timeout properties:
• For BigFix Inventory: BFI_Wait_Timeout_Override
• For CIT Signatures: CITTEST_Wait_Timeout_Override

To change the settings, perform these steps:
1. Log in to BigFix Console.
2. In Management > Computers, select a computer.
3. Right click on the computer and select Edit Computer Settings. Edit Settings for
Computer <computer_name> window appears.
4. Click Add. Add Custom Setting dialog box appears.
5. In the Setting Name field, enter the timeout property as setting name.

6. In the Setting Value field, enter the value of time in seconds.
7. Click OK. New setting appears on the Custom Settings list.
8. Click OK on the bottom of Computer Settings window to send modified properties to
the endpoint.
Result: After the action status changes to "Completed", the settings are saved on the
computer.

Adding property to multiple computers at once
You can also add property to multiple computers at once. To add properties, perform these
steps:
1. Log in to BigFix Console.
2. In Management > Computers, select multiple computers and right click on one of
them.
3. In the menu choose, Edit Computer Settings. A new window appears.
4. Select Custom Setting.
5. In the Name field, enter the timeout property as setting name.
6. In the Value field, enter the value of time in seconds.
7. Click OK on the bottom of Computer Settings window to send modified properties to
the endpoints
Result: After the action status changes to "Completed", the settings are saved on the
computers.
For more information about editing computer settings see, Edit Settings for Computer.

Testing manually
Available from 9.2.2. You can test the extended signatures that you create by
using a BigFix client that is installed on the platform for which a signature is defined.

1. Prepare a test catalog file that contains only the signature that you want to verify and
the name the file extended_signature_test.xml.
The following example shows a test catalog file. It consists of three main parts: the
header, the body and the footer. The body, which is in bold, is formatted basing on the
available signature templates. For the full list, see: Extended signature templates.
<?xml version="1.0" encoding="UTF-8"?>
<Signatures>
<Signature guid="EXTENDED SIGNATURE TEST" name="EXTENDED SIGNATURE
TEST" type="OtherSignature">
<!-- SIGANTURE BODY START -->
<Variable name="IS_INSTALLED" export="true">
<RegKeyExists key="HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\"
section="64or32"/>
</Variable>
<!-- SIGANTURE BODY END -->
</Signature>
</Signatures>

2. Add a scanner location to the environment variables by running the following
command:
•
LIBPATH="/opt/tivoli/cit/bin:$LIBPATH"
export LIBPATH

•
SHLIB_PATH="/opt/tivoli/cit/bin:$SHLIB_PATH"
export SHLIB_PATH

•
LD_LIBRARY_PATH="/opt/tivoli/cit/bin:$LD_LIBRARY_PATH"
export LD_LIBRARY_PATH

•
set Path=C:\Program Files\Tivoli\cit\bin;%Path%

3. Reset the file system scanner by running the following command:
•

/opt/tivoli/cit/bin/wscanfs -reset

•

"C:\Program Files\Tivoli\cit\bin\wscanfs.exe" -reset

4. Run a scan by using the test catalog file.
•

/opt/tivoli/cit/bin/wscansw -i extended_signature_test.xml
-o output.xml -e warning.xml

•

"C:\Program Files\Tivoli\cit\bin\wscansw.exe" -i
extended_signature_test.xml -o output.xml -e warning.xml

5. Review the output.xml and warning.xml files.
a. In output.xml, ensure that the MatchedSignature element is returned for
every matching instance. If no instance is found, there are no MatchedSignature
elements in the file.
<?xml version="1.0" encoding="UTF-8"?>
<MatchedSignatures>
<MatchedSignature guid="EXTENDED
SIGNATURE TEST" name="EXTENDED SIGNATURE TEST"
type="OtherSignature">
<Variable name="IS_INSTALLED"
value="true"/>
</MatchedSignature>
</MatchedSignatures>

b. Ensure that there are no error messages in the warning.xml file.

Creating signatures from package data
You can use package data to expand your custom catalog. You can add signatures for
software products that are installed in your infrastructure but are not present in the HCL®
catalog.

You must have the View Raw Data, View Endpoints and Manage Catalogs permissions to
perform this task.
•

For versions 9.2.11 and higher
1. Log in to BigFix Inventory, and go to Reports > Package Summary.
2. Set up the relevant filters, and identify the packages that you want to create
signatures for.
3. Check one or more packages. You can select up to twenty packages at a time.
4. Hover over the Signature icon

and click Add Signature.

Note: You cannot create a signature on a Package Data report, if
you already added either a file or an extended signature for the
component with the same details. If you create a package signature for
a component that is a part of a basic catalog, the component and the
detection will be duplicated.
• For versions before 9.2.11
1. Log in to BigFix Inventory, and go to Reports > Package Data.
2. To filter the report data, hover over the Manage Report View icon

, and click

Configure View. Then, specify the appropriate filtering options.
Note: To find a file or a package that can be used as a signature,
filter the report to the data from the computer on which the particular
software product is installed. To further narrow down the results,
specify the whole or part of the path to the directory where the software
is installed. Then, look at the following columns.

◦ Recognized - the column shows whether the package data and/or
file was recognized as part of an existing signature.
◦ Removed since

: Caused Detection - the column shows

whether the file contained enough information to cause detection
of the related software. The Caused Detection column is removed
since BigFix Inventory version 10.0.4. You must re-create your
saved reports in case you had used the Caused Detection column.
If the value in both columns is No, the file is not used for software
detection and you can use it to create a new software signature.
3. In the Name column, look for the location where the missing software title is
installed. Click the arrow on the right from the Name of the file that you want to
use as a signature, and click Create Signature.

4. In the Create Catalog Entry window, provide the publisher name, product name,
and release number.

To create a template signature with auto-detectable version of the
package, you may choose the Package Template signature type and copy data
from the Package or File Signatures tab to the template type. For more details,
see Creating signatures.
Tip: The most efficient signatures are file-based signatures with a
constant size that is different for each release, or signatures that are
based on registry entries where a wildcard (*) can be used. You can use
a wildcard in the Name and Version fields for a package. A wildcard
represents any string and can be combined with other characters. You
can use an asterisk '*' character not combined with other characters in
the Vendor field for a package (meaning any vendor). For example, you
can use IBM * SDK for Java™, 5.*, * for the name, version, and vendor
fields.
Note:

A detailed package version that is discovered

is shown in the 'Component Detailed Version' column in the
Software Classification report and 'component_detailed_version'
column in REST API.

5. To save the catalog entry, click Submit.
Important: If you create an entry that exists in the software catalog an
informational message is displayed, and both signatures are saved in
the catalog.
You added a software signature to your custom catalog, and it can now be used to detect
software. When you create signatures from package data, the custom content version of the
software catalog remains the same, because the signatures are matched on the server side,
and no new catalog needs to be created.

You can view the audit trail of the changes on the Catalog Audit report.
You can edit the details of the signature and delete a custom catalog entry on the Catalog
Customization panel.

Related information
Software discovery process after customizing the catalog

Creating signatures from scanned file data
You can use scanned file data to expand your custom catalog. You can add signatures
for software products that are installed in your infrastructure but are not present in the
HCL catalog. You identify the file name, or another item of information that can be used to
identify the software and add the signature.
You must have the View Endpoints and Manage Catalogs permissions to perform this
task.
1. Log in to BigFix Inventory.
2. In the top navigation bar, click Reports > Scanned File Data.
3. To filter the report data, hover over the Manage Report View icon

, and click

Configure View. Then, specify the appropriate filtering options.
a. Optional: Select the Recognized checkbox to add these two columns to the
view of scan data.
Note: To find a file or a package that can be used as a signature,
filter the report to the data from the computer on which the particular
software product is installed. To further narrow down the results,
specify the whole or part of the path to the directory where the software
is installed. Then, look at the following columns.

• Recognized - the column shows whether the package data and/or
file was recognized as part of an existing signature.
• Removed since

: Caused Detection - the column shows

whether the file contained enough information to cause detection
of the related software. The Caused Detection column is removed
since BigFix Inventory version 10.0.4. You must re-create your
saved reports in case you had used the Caused Detection column.
If the value in both columns is No, the file is not used for software
detection and you can use it to create a new software signature.
4. Optional: In the File Path column, look for the location where the missing software
title is installed.
5. Click the arrow on the right from the File Name that you want to use as a signature,
and click Create Signature.

6. In the Create Catalog Entry window, provide the publisher name, product name, and
release number. Further select the component that is found.
Starting from application update 9.2.11, the Scanned File Data report
provides full versions of discovered files. However, best practices of creating software
signatures recommend that file version that is specified in the signature is limited to
the release number, for example, 9.0. When you specify a more detailed version of
the file such as 9.0.7, the signature does not detect all patches or mod-releases of
the software component. When you create a signature from the scanned file data,
the pre-filled version of the file is limited to the release number according to the best
practices.
To create a template signature with auto-detectable version of the file, you
may choose the File Template Signature type and copy data from the Package or File
Signatures tab to the template type. For more information, see Creating signatures.

7. To save the catalog entry, click Submit.
Important: If you create an entry that exists in the software catalog, an
information message is displayed, and both signatures are saved in the
catalog.
8. To make the signatures available for software detection, click Reports > Import Now,
or wait for a scheduled import.
You added a software signature to your custom catalog, and it can now be used to detect
software or its usage. When you create signatures from scanned file data, the custom
content version of the software catalog remains the same, because the signatures are
matched on the server side, and no new catalog needs to be created.
You can view the audit trail of the changes on the Catalog Audit report.
You can edit the details of the signature and delete a custom catalog entry on the Catalog
Customization panel.

Related information
Software discovery process after customizing the catalog

Adding a new product to software catalog
The software catalog consists of a list of standard software products. Use the Add Product
feature to define a custom product with the accompanying information, such as a publisher
name, license metric and release.
You must have the View Software Catalog and Signatures and Manage Licenses
permissions to perform this task.
You can add a custom product to the software catalog to ensure it contains all your
business applications. You can later use the new product during software classification.
1. Log in to Products & Metrics, and go to Reports > Products & Metrics.
2. Hover over the Add icon

, and select Add Product.

3. Provide the publisher name. If the publisher already exists in the software catalog, you
can search for it, and select it from the drop-down list.
4. Provide the product name. The product name must be unique for the publisher that
you provided in step 3.
5. Select a metric from the list. To search for a metric, type the metric name in the
search bar.
6. Provide the release of the product. By default, this field is set to 1.0.
7. Click OK. You will be notified about product creation.
8. Wait for the scheduled import of data, or run it manually. You cannot add new
products during the import. Thus, if you plan to create more than one product, first
create all products and then run the import of data.
A new line is added on the Products & Metrics report. You can now use the newly created
product to classify your software. The newly created product is available on all reports after
the import of data is successfully completed.
To assign components to the new product, go to Reports > Software Classification, select
the components, and reassign them. For more information, see: Assigning components to
products.

To delete the catalog entry that you create for the product, see: Deleting custom catalog
entries.

Assigning an additional metric to a product
Available from 9.2.8. The pricing calculations are based on the relation between a
product and a metric. The software catalog consists of an inventory of standard relations.
To define a custom relation, assign one of available metrics to an existing product.
You must have the View Software Catalog and Signatures and Manage Licenses
permissions to perform this task.
You can assign one of available metrics to a product from the software catalog, and thus,
define a custom relation. You cannot duplicate an existing relation. You can only assign a
metric that is not yet assigned to a certain product. The custom relation can be used while
classifying your software inventory. It allows you to make your pricing calculations accurate
and tailor-made.
Note: If you use version 9.2.8 or higher, go to Software Catalog report to define
a custom relation. Starting from application update 9.2.14, the Software Catalog
report is renamed to Products & Metrics report.
1. In the top navigation bar, click Reports > Products & Metrics.
2. Select a product for which you want to assign a metric. You can select any product
from the software catalog.
3. Hover over the Add icon

, and select Assign Metric to Product.

4. Select a metric from the list. To search for a metric, type the metric name in the
search bar.

5. Click OK to confirm.
After you confirm the assignment of a new metric to a product, a new line is added on the
Products & Metrics report. You can now use the newly created custom relation to classify
your software.
To assign components to the product with the new metric, go to Reports > Software
Classification, select the components, and reassign them. For more information, see:
Assigning components to products.

Managing license metrics through the UI
BigFix Inventory allows you to add, modify, and delete metrics through the UI (user
interface). You can also perform the same using the REST API, api/sam/v2/metrics as
described under 10.0.4 REST API for managing license metrics.
Note:

You must have the Manage Contracts permission to perform this task.

Using the interface
With the new capabilities, you can perform the following tasks:
Add Metric

Click this option to create a new custom metric. Select the code name and the
display name and click OK. The metric is added.
Modify Metric
Click this option to modify a display name of a custom metric. Select the
code name: display name and the display name and click OK. The metric is
modified.
Note: You cannot modify a non-custom metric. Only custom metrics
are listed.
Delete Metric
Click this option to delete a custom metric. Select the code name: display
name and the display name and click OK. The metric is modified.
Note: You cannot delete a custom or non-custom metric that is
assigned to a contract. Metrics that are assigned to contracts are not
listed in the Delete Metric list.
Set default product metric
Click this option to set default product metric for bundling assistant. You can
set only one default product metric for a product. When the action is applied,
the newly discovered components are assigned the new default metric if there
is a default bundling assignment between the product and component. It
is also possible to set the new product metric assignment as default while
creating the new assignment.

Note: You can manage license metrics through the UI with a few restrictions, such
as follows:
• All three options are disabled while the data import is running to ensure data
consistency.
• Each code name and display name must be unique among all metrics. If an
incorrect value is specified, an error message is displayed.
• Each code name is uniquely identified and cannot be altered after you the
metric. Display names are presented as text on other UI panels to identify the
metric.
• After you modify metrics, reload the page to refresh metric the names list,
which is available in the filter criteria.
• After you delete a metric that is used in filters in a custom report, these
filtering criteria must be manually adjusted. After you modify a display name,
you do not have to adjust the associated report.

Changing end of support date
Available from 9.2.11. Set or change the end of support date for your software
components to have a comprehensive overview of your software inventory.
You must have the View Software Catalog and Signatures permission to perform this
task.

BigFix Inventory Server is provided with pre-populated end of supports dates for selected
vendors. For the available EOS dates, refer to the BigFix Inventory Release Notes.
It is possible to change the existing date or define the missing dates using this procedure.
Perform the below steps to change the end of support date:
1. In the top navigation bar, click Reports > Software Components.
2. Select one or more components for which you want to set the end of support date.
You can select up to a 100 rows at a time.
3. Hover over Edit, and click Change End of Support.
4. Choose the end of support date, and click Change.
5. Optional: To clear the end of support date, remove the date, and click Change.
You set the end of support date for the selected components.
Starting from application update 9.2.12, end of support date is also displayed on
the Software Classification report.
You can use end of support dates to filter and sort the report. You can also create a saved
report view that is filtered by the specified information, and enable notifications that are
triggered when specific criteria are met.

Software discovery process after customizing the catalog
Software matching your catalog customizations can be identified in one of the below ways
depending on the custom signature.
Case 1: Common executable files or other popular file types
If you create a custom template signature based on any file or package data,
or a custom signature of Package or File type, which is based on package
data or file data, such as common executable files, then you need to run a
data import to pull the latest scan data from the BigFix server. The new data
is compared with the latest catalog and the updated software inventory is
displayed in the web user interface.

The popular file extension list includes the following file types: *.exe, *.sys,
*.com, *.ear, *.ocx, *.sh, *.bin, *.pl, *.ear, *.SH, *.BIN, *.PL, and
*.EAR.
When you create signatures based on these file types, the custom content
version of the software catalog remains the same, because no new catalog
is created. The data is pulled from your endpoints and matched against the
signatures on the server side. The same happens with template signatures
including any file extension so such signature will work only if this file is listed
on Scanned File Data panel.
Case 2: Non-standard file types
If you added new software signatures to the software catalog and those
signatures are based on files other than common executable files, you must
either wait until all the following steps in the catalog data flow complete or
perform those steps yourself.

When you create signatures based on non-standard file types, the custom
content version of the software catalog changes, because the new catalog
is created and distributed to your endpoints. The catalog with the new
signatures is matched against the data on your endpoints.
Note: The above scenario does not apply to template signatures. For
more information, see Scanned File Data.

Exporting and importing custom signatures
You can export custom signatures to an XML file and import them to a different instance
of BigFix Inventory to augment you software catalog. It is useful if you maintain separate
instances of BigFix Inventory for test and production sites. In such case, you can reuse the
custom catalog content instead of creating the new one. You can also import signatures
that are published on the signature community or export your custom signatures and
contribute them to the community.

You must have the Manage Catalogs permission to perform this task.
The signature community is a place where you can find custom signatures that are created
by members of the community. You can download such signatures and import them to
BigFix Inventory. You can also export your custom signatures and contribute them to the
community for other members to download.
1. Export custom signatures to an XML format.
a. In the top navigation bar, click Management > Catalog Customizations.
b. Click Export Mode.
• To export only a selection of signatures, check the appropriate check boxes and
click Export Selected. You can select individual signatures, or all signatures for
a publisher. Each signature is exported to a separate XML file, and compressed.
When you select multiple signatures, all XML files are compressed into one ZIP
file.
• To export the entire custom catalog, click Export All. You export all signatures,
regardless of your selection, or filters, in a form of one ZIP file that contains
individual XML files.
2. Import custom signatures in an XML format to the other instance of BigFix Inventory.
a. In the top navigation bar, click Management > Catalog Customizations.
b. Click Import to open the Import Signatures window.
c. Browse to the location of the file that you want to import.
d. Select the file and click Import. You can either import a single XML file or a ZIP
package that contains one or more XML files.
e. Click Done.
The imported signatures are available on the Catalog Customizations panel. They are now
used by software scans to discover software in your environment.

Deprecated: Synchronizing software catalog content
You can export your custom catalog content from one instance of BigFix Inventory and
import it into another to merge the custom data. It is useful if you maintain separate

instances of BigFix Inventory for test and production sites. In such case, you can reuse the
custom catalog content instead of creating the new one.
Important:

Starting from application update 9.2.11.0, you can no longer

export the software catalog with your custom content from the Catalog Upload
panel. As an alternative, you can export your custom signatures and import them
onto the other instance of BigFix Inventory using the Catalog Customization panel.
For more information, see: Exporting and importing custom signatures.
You must have the Manage Catalogs permission to perform this task.
Restriction:
• The catalog is exported in to the native format. This format overwrites the
existing catalog, so it can be imported only into a fresh installation of BigFix
Inventory before the initial import.
• You can transfer custom catalog content only between two instances of
BigFix Inventory if they have the same version.

When you export the custom catalog content from BigFix Inventory, an XML file that
contains all catalog entries is saved to your computer. Then, you must log in to the instance
of BigFix Inventory to which you want to import the custom catalog content and upload the
XML file.
1. Log in to the instance of BigFix Inventory from which you want to export the custom
catalog content.
2. In the top navigation bar, click Management > Catalog Upload.
3. In the Catalog Export section, click Export. An XML file with your custom catalog
content is saved to your computer.
4. Log in to the instance of BigFix Inventory to which you want to import the custom
catalog content.

5. In the top navigation bar, click Management > Catalog Upload.
6. Click Browse, select the XML file with your custom catalog content, and click Upload.
The software catalog file is listed in the table. The status is Pending until you go to
Management > Imports, and click Import Now to process new changes.

Reports
Reports provide detailed information about the computers in your infrastructure and the
software items that are installed on these computers. By viewing the reports regularly, you
can check whether actual installations reflect the software inventory information and ensure
that the capacity values are assigned to products correctly. You can decide what type of
information you want to display by choosing the appropriate type of report. You can also
customize the type and amount of information that is displayed in a report and save the
report settings to reuse them.

Available reports
Reports are the primary source of information about computers in your infrastructure and
software that is installed on these computers.
The inventory data is collected from all computers in your infrastructure. When you
decommission a computer, it continues to report to BigFix Inventory. For report accuracy,
ensure that all infrastructure changes are reflected in BigFix Inventory. For more
information, see: Removing inactive computers.
Note: The data that is displayed on the reports is limited to the computer group to
which the user belongs.

General
Report

Description

Saved Re

This option allows you to save your preferred vendor-specific reports.

ports

The reports provide below information:

Report

Description
• The base report from which the saved report was created.
• The user who created it. The reports that are delivered with BigFix
Inventory are marked as SYSTEM. Other reports are created by in
dividual users.
• Whether the report is private or not.
• Whether the report is default or not.
• Whether the report is a global default report.
• Next export schedule which states the date and time when the
saved report will be sent to your specified recipients.
The reports help all BFI users to access BFI data related to a specific
vendor.
Following report options are available to be saved:
• Adobe reports
• HCL reports
• IBM reports
• Microsoft reports
• Oracle reports
• SAP reports
• VMware reports
For more information, see: Creating saved report views.

Software Inventory
Report
Soft
ware Sum
mary

Description
Required permission: View Endpoints
The report provides an overview of software inventory in your environ
ment. Each row in the report represents a set of software instances
that are grouped by the columns, such as component name, compo

Report

Description
nent version, product name, the count of usage by a particular vendor.
You can limit the instances in the groups by using the report filters. By
default, you can see only the instances that are currently installed and
not suppressed instances of the infrastructure.
To change the way how the data is displayed, select different report
columns. For example, you can filter the group by selecting a publish
er. In the column Count you get the number of software instances only
from the selected publisher.
Note: You cannot filter the report by selecting columns that ag
gregate the values, for example: Count, Used and Unused.
Drill down
You can drill down the Software Summary report to view the Software
Classification panel with the detailed information about all software in
stances from the related group, including component name, compo
nent version, and installation path.
Summary of the usage statistics
This report also provides software usage statistics that contain details
about the usage of specific software on the listed instances. You can
check how many instances of a product within the group were used
and how many were not. You can see an overview of software usage
statistics from the last month, the last quarter, and the last year. You
can track the number of software instances within the group where
software usage is monitored and where it is not.
Limitations

Report

Description
• You might experience performance issues on SQL Server, espe
cially when you select Product Name column or usage related
columns, for example Used, for grouping.

No

Important: Starting from application updated

tice:

port becomes deprecated. It is planned to be removed from
This

re

, this re

BigFix Inventory in the coming releases. Instead of this report,
use the Software Summary report.

port
has
been
re
moved.
Inventory
Exploration
(deprecated)

Required permission: View Endpoints
The report provides information about software items that are installed
in your infrastructure. The items are structured into hierarchies that
consist of the publisher, software titles, their versions, releases, and
components. You can drill down through the hierarchy to gather de
tailed information about software usage including its time and frequen
cy.
For each product, its version and release, you can also view information
about contracts to which this product is assigned. The report shows
the number of software instances that are covered by contracts and
the cost of acquisition and maintenance of the licenses for that prod
uct. You can use the report to efficiently manage your software invento
ry by monitoring the cost of software licenses and the use of the partic
ular software products.

Software In
stallations

Required permission: View Endpoints
The Software Installations report has been changed. The old
report is based on the old data model that does not take shared disks
and multiple component instances into account. Now, it is deprecated,
moved to the bottom of the Reports menu, and will be entirely removed
in the future. The old report is substituted with a new report view that
is based on the new data model and consistent with other reports.

Report

Description
Thanks to the new data model, the report criteria are extended to cover
additional component instances and the reported number of installed
software might be affected. The new report is based on the Software
Classification panel. For more information, see: Software Classifica
tion.
The report provides information about computers in your infrastructure
and software items that are installed on these computers. You can see
a detailed report for a single software item, when you click the link in
the Details column. The Details page shows information, such as pub
lisher, component, installation path, and signatures. It includes a link
with a complete list of signatures. The details view now shows only
matched detection. It does not show signatures that does not match.
The signatures are shown with below icons:
•

- The signature matched the software item, or the software ID
tag was discovered on the computer and caused software detec
tion.

•

- The signature did not match the software item.

If a product has been installed in different locations, the details view
shows only the relevant path of the selected row.
If the software was erroneously detected, you can use this information
to examine how the signature or the software ID tag was evaluated.
You can also view the installation path of software that was discovered
by a file-based signature. If software was discovered by a complex sig
nature, you can view the hierarchical structure of the signature.
In this view, you can also see information about software usage. When
a usage signature exists and matches a process listed on the Meter
ing Data report, statistics about usage time and frequency are shown.

Report

Description
If the information cannot be gathered for the particular software, one of
the following messages is displayed:
• Usage data is not supported - Usage data cannot be gathered
because the usage signature for this software item does not ex
ist.
• Usage data was not found - At least one usage signature ex
ists for the particular software, but the usage data was not gath
ered. Thus, report columns with statistics about usage time and
frequency show 0. Usage data might not be found because the
software was never used and thus has no usage information.
It might also happen because the option to run the Application
Usage Statistics scan was cleared in the Initiate Software Scan
fixlet.

Software
Classifica
tion

Required permission: View Endpoints or Manage Software Classifi
cation
The report types help software asset managers and inventory adminis
trators to export vendor-specific license metrics. The vendor-specific
report provides an overview of software inventory and the relations be
tween the discovered software components and licensable products. It
provides a flat structure with software installations broken into single
components, which makes it easier to view your software assets and
manage relations between them. The Software Classification panel al
lows streamline management of your software inventory. To make your
metric calculation accurate, assign each component to a product, ex
clude, or suppress the instances that should not be included in the cal
culation, and confirm your actions. After you classify all your compo
nents, and confirm all actions, software classification is complete.
The reports show only present instances in the infrastructure. It does
not show the supressed instances.

Report

Description
Starting from application update 9.2.15, BigFix Inventory col
lects detailed information about the usage of Java processes on each
instance separately. The usage statistics for each instance is available
on Software Classification report.
The report provides the following predefined views:
• IBM Software Only that shows only IBM software that is currently
installed.
• First Detected Last Week - IBM Software Only shows the IBM
software that was detected within the last week and is current
ly installed. It helps you to review the recently installed software
and make an appropriate action, such as changing the compo
nent assignment.
• Software Installations shows all components that are installed in
your environment.
• Current Installations shows software that is currently installed in
your environment and its classification.
•

Software: Out of support shows installations for which
support already ended. Starting from application 9.2.14, the re
port additionally shows the installations of old software compo
nents that do not have the end of support date set but were creat
ed more than 6 years ago.

•

Software: Approaching end of support shows software
installations for which support ends within the next three months.
Starting from application update 9.2.14, the report additionally
shows installations of the components that do not have the end
of support set but were created between 5 years 9 months and 6
years ago. These installations will be reported as out of support
within the next three months.

Report

Description
Software: Discovered in the last 2 weeks shows new

•

software installations that were discovered within the last two
weeks.
IBM Software - Pending Classification shows the IBM

•

software components that are not yet classified.
Security Data: Vulnerable software shows software in

•

stallations for which at least one CVE was matched.
Security Data: Vulnerable software discovered in the

•

last 2 weeks shows software installations that were discovered
within the last two weeks and for which at least one CVE was
matched.
•

Security Data: Blacklist software shows the discov
ered software components that are marked with a blacklist tag
that represents unwanted software. For more information, see:
Adding and removing tags.

Predefined view for the following reports is also included:
• Oracle Java Inventory
• Oracle Database Inventory
• Oracle WebLogic Inventory
• Microsoft SQL Server Inventory
• Microsoft Office 365 Inventory
• Adobe Cloud Software Inventory
• SAP Inventory
• VMware Inventory
• HCL Inventory
Required permission: View License Metrics
Usage per
Computer

The report provides information about the frequency and time of us
ing software products that are installed on the computers in your infra
structure. For every product, you can see what the frequency and the

Report

Description
total time of its use per computer was as well as when it was used for
the first and last time. You can also see what the average run time of
each product and the average number of its runs per day is.
By default, the report is calculated after every import. To change this
behavior so that the report is calculated on demand, go to Manage
ment > Advanced Server Settings, and change the value of the calcu
late_during_import/product_usage parameter.
After you change the parameter, the report must be refreshed on de
mand. To refresh the report, open it, and click Calculate. The data is
calculated immediately, unless the import is in progress. In this case,
the report is calculated after the import completes. If new data arrives,
information about the need of recalculating the data is displayed on the
report.
Starting from application update 9.2.15, BigFix Inventory col
lects detailed information about the usage of Java processes on each
instance separately. The aggregated usage for all instances of the
same product is available on Usage per Computer report.
The Oracle Java Usage per Computer report is available for Oracle Java
Runtime Environment, JDK and SDK software.
Required permission: View Raw Data

Package
Summary

The report lists and counts the packages that are installed on the com
puters in your infrastructure. The report is calculated on demand only.
You can find out what is the name of every package, its version, vendor,
description, and type. You can use this information to create custom
software signatures. For more information, see: Creating signatures
from package data.
To refresh the report, open it, and click Calculate. The data is calculat
ed immediately, unless the import is in progress. In this case, the report

Report

Description
is calculated after the import completes. If new data arrives, informa
tion that the report is not updated is displayed.
The report might not be up to date it in the following situations:
• The import of data was completed, and the new package data
might be available.
• A new package signature was created, and it might influence the
Package Data report.
• Package signatures were changed or deleted on the Catalog Cus
tomizations panel.
Click the link for 'Number of packages' to view and suppress
packages as required. Use 'Suppress packages from Inventory' option
to suppress selected packages.

Package Da
ta

Required permission: View Raw Data
The report provides information about packages that are installed on
each computer in your infrastructure. The information is retrieved from
the Windows registry and UNIX RPM database. You can find out what
is the name of every package, its version, vendor, description, and type.
You can use this information to create custom software signatures. For
more information, see: Creating signatures from package data.
Use 'Suppress packages from Inventory' option to suppress se
lected packages. The suppression is applied to all computers that uses
the same package which means they have the same properties, such
as vendor, name, version and type. Suppressing the packages creates
an automatic rule for newly discovered packages to be suppressed.
The maximum number of packages allowed for suppression at once is
20.

Scanned File
Data

Required permission: View Raw Data

Report

Description
The report provides information about files that were found on the
computers in your infrastructure. You can find out what is the location,
size, and version of each file. The files that are displayed on the report
are detected basing on the discovery of particular file extensions, or the
processes that run on the computers in your environment. You can use
this information to create custom software signatures. For more infor
mation, see: Creating signatures from scanned file data.
The report provides the following predefined views:
Malware Threats (Preview) lists files that are found in

•

the environment by BigFix Inventory and classified as malware
threats.
Malware Threats - Recent (Preview) lists files that are

•

found in the environment BigFix Inventory within the last two
weeks and classified as malware threats.
The tool and the fixlets related to getting file reputation are not avail
able anymore as this preview feature has been withdrawn. However,
the historical data is still displayed, and the predefined views are still
available.
No
tice:
re

Required permission: View Raw Data
The report provides a ranking of 1000 files that are most encountered
in your computer infrastructure but do not produce matches for any
This
signature. The ranking is separate for each computer group. It is based

port

on the number of computers on which the files were detected, the num

has

ber of copies of a file, and the alphabetical order. The files are listed by

been

name with no regard to their size or version. You can use this report to

re

investigate unrecognized files that can be used to create custom signa

moved. tures.

Report

Description

Unrecog

Because aggregation of unrecognized scan data slows down imports,

nized Files

particularly in large deployments, it is disabled by default. To enable it,
perform the following steps:
• For versions up to 9.2.8, go to Management > Scanned File Data,
and choose the frequency of the aggregation.
• Starting from version 9.2.9, go to Management > Advanced Serv
er Settings, and change the value of the recompute_unrecog
nized_scan_data parameter to specify frequency of the aggrega
tion.

Metering Da
ta

Required permission: View Raw Data
The report provides information about processes that run on the com
puters in your infrastructure. You can track when the process was used
for the first and the last time as well as what is the frequency and the
total time of its usage. You can also view the average run time of each
process and its average number runs per day. This report provides ag
gregated usage statistics from all instances that are discovered on
each endpoint based on given binary file. In this report you cannot track
individual installations on one endpoint.
Starting from application update 9.2.15, BigFix Inventory col
lects detailed information about the usage of Java processes and pro
vides the aggregated usage statistics on Metering Data report.

No

This report includes all installed softwares.

tice:
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Software In
stallation
(Deprecated)

Business Applications
Report

Description

Oracle Data
bases

Required permission: View Endpoints
The report provides information about the edition (Standard or Enter
prise), options, and Management Packs (including Oracle Real Applica
tion Cluster, RAC) of Oracle Databases that are deployed in your envi
ronment. When you combine this information with the collected hard
ware inventory data, you can use it to calculate the demand for Oracle
Database licenses.
A prerequisite to see data on this report is to use the feature of extend
ed Oracle discovery. For more information, see: Extended discovery of
Oracle Database.

License Metrics
Report
All Metrics

Description
Required permission: View License Metrics
The report provides information about the utilization of license metrics
for products that are installed on the computers in your infrastructure.
For every product, you can see the maximum metric utilization and its
history over the specified period. You can also specify a metric thresh
old to verify whether metric utilization is above or below your expecta

Report

Description
tions. You can create a snapshot of the report and store it for audit pur
poses. For more information, see: License metric utilization.
Important: If the report does not show products with a particu
lar license metric, calculation of this metric might be disabled
for the computer group to which you are assigned. For informa
tion about enabling the calculations, see: Setting up computer
groups.
Metric quantities for new metric such as, Microsoft SQL Serv
er Physical Cores are not shown on All Metrics panel. For such metrics,
the Metric Quantity column shows 'Calculated for Contract’. Use the Go
to All Contracts link on the menu bar of the panel to navigate to the All
Contracts panel and where you can create a contract and see the con
tract's metric quantity.
Starting from application update 9.2.16, the report provides
information about the top level of metric utilization, which means that
stand-alone products and flexpoint bundles are displayed. You can also
see products that contribute to a FlexPoint bundle by applying the ap
propriate report filter.
Starting from application update 10.0.1, the report provides al
so information about Cloud Paks. You can also see products that con
tribute to a Cloud Pak by applying the appropriate report filter.
The report provides the following predefined views:
• IBM PVU Subcapacity that shows only products that are licensed
for PVU subcapacity.
•

IBM Flex Points and IBM Cloud Paks that shows informa
tion about FlexPoint bundles and Cloud Paks.

• All IBM Metrics that shows only IBM products.

Report

Description
Install Seats Metric that shows only products that are li

•

censed based on the number of computers on which the product
is installed.
• Metric Thresholds that includes a column in which you can spec
ify a metric threshold. The threshold indicates the maximum
number of metric units that a product can use within a comput
er group. It is then used to calculate whether metric utilization is
above or below your expectations. For more information, see: Set
ting license metric threshold.
• Exceeded Thresholds that shows only products for which metric
utilization is above the specified threshold.
Microsoft Measured License (previously Microsoft Met

•

rics) that shows Microsoft products for which metrics are calcu
lated in BigFix Inventory.
Oracle Measured License (previously Oracle Metrics) that

•

shows Oracle products for which metrics are calculated in BigFix
Inventory.
• Oracle Java Measured License that shows Oracle Java Runtime
Environment, JDK and SDK products.
• Oracle Database Measured License that shows Oracle databas
es.
• Oracle WebLogic Measured License that shows Oracle WebLogic
software.
• Microsoft SQL Server Measured License that shows Microsoft
SQL server products for all editions.
• Microsoft Office 365 Measured License that shows Microsoft Of
fice 365 products.
• Adobe Measured License that shows all Adobe products,
• Adobe Cloud Software Measured License that shows products
fromAdobe Cloud Software family.

Report

Description
• SAP Measured License that shows all SAP products.
• VMware Measured License that shows all VMware products.

Audit Trail

Required permission: View Audit Trail
The report provides information about actions that have influence on
the information that is displayed on other reports. You can view details
of each action, its type, date, and the user who performed it.
Important: Audit trail shows actions that are performed only
within the computer group to which the user who views the re
port has access.
The actions that are shown on the report include:
• Modifications to the IBM software classification: confirming and
changing the default classification, sharing an instance between
products, including an instance in and excluding it from pricing
calculations
Note: Audit trail does not contain information about soft
ware classification when either component, product or
both are non-IBM.
• Uploads: successful or failed upload of the software catalog,
charge unit data, and PVU table
• Imports: successful or failed import of the software catalog,
charge unit data, and PVU table
• VM managers: adding, modifying, and deleting VM managers
• Updates to the scan configuration on the Scan Configurations
panel
• Changes of server parameters and advanced server settings
• Changes of the PVU per core value

Report

Description
• Creation and deletion of user (does not work if user is signed in
through LDAP/SSO)
• Modification in user role and user computer group (does not
work if user is signed in through LDAP/SSO)
Required permission: View License Metrics

Resource
Utilization

The report provides information about the utilization of license metrics
for products that deliver .slmtags. The report shows the maximum met
ric utilization and its trend value over the last 30 days. For every prod
uct, you can see the type and subtype of license metrics that a product
uses as well as the first and last time when each metric was reported.
You can also see the path to the .slmtag file from which the data was
retrieved.
The report shows only products that deliver resource utilization data. It
does not show products for which metric utilization is calculated and
shown on the All Metrics report. For more information, see: Raw utiliza
tion of license metrics.

Users
Report

Description
Required permission: View User Details

Software
Users

Scope of the report
•
•

Microsoft Office 365
The following Adobe Creative Cloud (CC) ap
plications that are installed on Windows computers.
◦ Adobe Illustrator CC
◦ Adobe Photoshop CC
◦ Adobe InDesign CC
◦ Adobe Premiere Pro CC

Report

Description
◦ Adobe After Effects CC
◦ Adobe Dreamweaver CC
◦ Adobe Muse CC
Overview
The report provides information about the current users of software
and their details. Users are matched with the instance of the product
to which they are registered with the given ID. By clicking the product
name, you are redirected to the Software Classification panel.
The report shows a list of users who use or registered Microsoft Of
fice 365 and a set of Adobe CC components on the computers in your
environment. They have a unique user ID, that might be an e-mail ad
dress, or an alternative user ID, which is an identifier that is specific to
the software.
User details
The user information that is collected might include the personal da
ta. By default, the user personal data, such as an e-mail address, is ob
fuscated with SHA-1 and is not shown on the report or stored in the
database. If you would like to collect and display it, select the Store and
show user names on reports when initiating software scans. For more
information, see: Initiating software scans.
If you no longer need to view information about software users on the
Software Users report, go to Management > Advanced Server Settings,
and change the value of the remove_user_information parameter to
True. After the next import of data, the user information is removed and
the report is emptied. To repopulate the report, run the Initiate Software
Scan fixlet. Removing user information also removes all historical data
related to the Registered User metric on the All Metrics report.

Report

Description
Important: BigFix Inventory is GDPR compliant. By default,
BigFix Inventory does not collect any personal data about the
users. Gathering personal data is optional and should be en
abled consciously. Personal data is stored and used by BigFix
Inventory only. It is not passed or used outside BigFix Invento
ry.
Following reports options are available:
• Adobe Users
• Microsoft Office Users
• Microsoft Office 365 Software Users
• Adobe Cloud Software Users

Infrastructure
Report
Computers

Description
Required permission: Manage Computer Groups
The report provides information about computer groups that are de
fined in your infrastructure. The information includes the ID of the com
puter group, its name, and description. You can find out how many
computers and subgroups are in the computer group, and what soft
ware items are installed in that group.
The report shows two types of computer groups: reporting and
software template. Both types are visible to all entitled users. However,
only an Administrator can create software template groups and modi
fy software templates of existing groups of this type. For more informa
tion, see: Setting up computer groups

Report

Description
• The time when the computer last connected to BigFix
• The version of the client that is installed on the computer
• The version of the catalog that is available on the computer
• The time when the last attempt to run the scan was done
• Whether each type of the software scan was successful
• Whether the computer misses scan results
• Whether it is running out of disk space
• Whether it misses some prerequisites
When you click a link in the Name column, detailed information about
a particular computer is displayed. You can now view reports narrowed
down to this computer. To do this, select the report from the upper left
corner.
You can decommission computers that are import
ed from the disconnected data source to remove them from the report.
For more information, see: Decommissioning computers with discon
nected scanners.
The report provides the following predefined views:
•

Outdated Agents shows computers on which the BigFix
client is not updated to the latest available version.
Important: For some operating systems, support is with
drawn with newer versions of the BigFix client and on
ly earlier versions are supported. Such a computer is re
ported as having an outdated version of the client even
though a newer version is not available.

•

Computers lists all computers in your infrastructure.

•

Computers: Discovered in the last 2 weeks shows the
computers that were added to within the last two weeks.

Report

Description
Computers without Scan (Preview) shows computers

•

that are visible in for more than a week, and on which the scan
was not initiated.
Computers: No Scan Attempt in the last 2 weeks

•

shows computers with scan that is older than two weeks.
Computer
Groups

Required permission: Manage Computer Groups
The report provides information about computer groups that are de
fined in your infrastructure. The information includes the ID of the com
puter group, its name, and description. You can find out how many
computers and subgroups are in the computer group, and what soft
ware items are installed in that group. The report also provides infor
mation about the contracts that are assigned to a computer group, with
the acquisition and maintenance cost for each contract.
When you click a link in the Name column, detailed information about
a particular computer group is displayed. You can now view the reports
narrowed down to the computers that belong to the group. To do this,
from the upper left corner, select the report that you want to view for
this computer group.
The report shows two types of computer groups: reporting and
software template. Both types are visible to all entitled users. However,
only an Administrator can create software template groups and modi
fy software templates of existing groups of this type. For more informa
tion, see: Setting up computer groups.
Notice:

These columns have been removed:

• Contracts (Deprecated)
• Total Acquisition Cost (Deprecated)
• Total Maintenance Cost (Deprecated)

Report

Description
Required permission: View Shared Disks

Shared Disks

The report provides information about shared disks that are used in
your infrastructure. For each shared disk, you can view information
about its type, the exported directory, and the number of computers
on which the disk is mounted. You can drill down the report to view
detailed information about the shared directory or the computers on
which the disk is mounted. If you use automatic scanning of shared
disks, the report also shows the status of the scan and the computer
that is designated to scan the shared disk.
To view information on the report, discover shared disks in your infra
structure. For more information, see: Discovering software on shared
disks.

Hardware In
ventory

Required permission: View Hardware Inventory
The report provides information about the state of BigFix clients in your
infrastructure. For every computer on which a client is installed, you
can view processor details, and the number of PVUs assigned to each
core.
If the PVU per core value that is assigned to a processor in your envi
ronment is incorrect, you can manually change it on the Hardware In
ventory report to ensure that subcapacity licenses are properly calculat
ed. For more information, see: Changing the PVU per core value.
Starting from application update 9.2.12, the report is depre

Current
State Values
(deprecated)

cated.
Required permission: Edit Server Configuration
The report provides information that is intended to help the HCL Sup
port team troubleshoot problems with BigFix Inventory. When you open
a support case, generate a CSV or PDF version of this report and pro
vide it to the HCL Support team.

Catalog
Report
Software

Description
This report shows the software components per publisher type. You

Components can view details, such as the version, component tags, vulnerabilities,
signatures, etc.
Signatures

Required permission: View Software Catalog and Signatures
The report provides information about signatures that are available in
the software catalog. You can find out what signature is used to detect
each software item that exists in the catalog.

Catalog Au
dit

Required permission: View Catalog Audit
The report provides information about modifications that were made
to the content of your custom software catalog. For each modification,
you can see detailed information about the current status of the soft
ware entity, as well as its status before and after modification.

Contracts
Report
Products &
Metrics

Description
Required permission to view data: View Software Catalog and Signa
tures
Required permission to manage data: Manage Software Catalog and
Signatures
The report provides information about the content of the software cata
log including software products and their publishers, part numbers that
represent the products, and license metrics that the product uses.
When you drill down to the component level, you can also
view the date when the software component reaches end of support.
Actions: You can perform the following actions:
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• Add products. See also, add product
• Edit part numbers. See also, edit part numbers
• Assign metric to a product. See also, manage products and met
rics
• Set default product metric. See also, manage products and met
rics
• Add, modify, and delete metrics. See also, manage products and
metrics
• Set and clear entitlement or do both. See also, manage entitle
ment

All
Contracts

Required permission: Manage Contracts
This report shows all contracts that are related to product and metrics.
The same can be viewed through the predefined dashboard. Contracts
can be defined for products and any metric in the All Contracts report.
By using this report, you can add, modify, and assign custom metrics
to products that are used in new contract definitions and software bun
dles. You can view information such as contract types, current mea
sured value, deltas, thresholds, next entitlement dates, and so on.
With BigFix Inventory version 10.0.11, All Contracts panel uses
a new data model that improves usability and performance.
Following are the changes in the All Contracts panel:
• All Contracts panel has a link to the product under the Products
column, which on clicking redirects to the new Product Metrics
per Contract panel. For more information, refer to 10.011 Using
the Product Metrics per Contract panel.
Note: The link is disabled when there is no metric or
product assigned to the contract.
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• All Contracts panel also has an option to recalculate metric val
ues if there is a change in the contract definition. For more infor
mation, refer to 10.011 Recalculating contracts.
• A new metric Microsoft SQL Server Physical Processor Cores is
added for the per core physical licensing model. The new metric
is calculated as per the given current day and follows the latest
Microsoft SQL Server product terms.
• The Current Measured Value column shows <n/a> if a metric
is not calculated by BigFix Inventory or if there are no products
added to the Contract. If other cases, the column shows the val
ue.
Actions: You can perform the following actions:
• Add, modify, and delete contracts - See also, Add, modify, and
delete contracts in the All Contracts report
• Add, modify, and delete metrics - See also, manage products and
metrics
Different report types available are:
• Contracts: All
• Contracts: License Utilization Exceeded
• Contracts: License Ended
• Contracts License Ends in 30 Days
• Contracts: License Ends in 90 Days
• Contracts: Threshold Exceeded
• Contracts: Support Ended
• Contracts: Support Ends in 30 Days
• Contracts: Support Ends in 90 Days

Report

Description
Note: The Current Contract Value, Current Measured Value and
Next Entitlement Value are calculated based on UTC time zone.
Required permission to view data on Product Metrics per Group pan

Product
Metrics per
Group

el: View Contracts or Manage Contracts
Required permission to update 'Current Measure Value': Manage Li
censes or Manage Software Classification
Product Metric per Group shows contract data and more reporting ca
pability. With the report, you can view metric calculations per product
among computer groups. You can modify the measured metric value
for specific products when automated metric calculation is not sup
ported or a data adjustment is required (data from other source or cus
tom calculation). By drilling down in the report, you can view a product
link to get metric calculation details as input for further analysis.
For optimal performance, this report is displayed for first 20 comput
er groups . Computer groups are selected in the order they were creat
ed (computer ID). It excludes the computer groups that have metrics
disabled. However, you can select the computer groups that use the
new_contracts_max_computer_groups and new_contracts_selected_
computer_groups hidden parameters from the Advanced Server set
tings.
A Go to All Contracts link have been added on the heading of
the panel to allow you to navigate to All Contracts report panel.
Actions: You can modify the measured metric value for specific prod
ucts when automated metric calculation is not supported or a data ad
justment is required (data from other source or custom calculation).
See also, Setting and removing metric quantity.

Report

Description
Required permission: View Contracts

No
tice:

The report provides information about contracts that you created for
the software items. You can see the relationship between the num
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ber of software products that you are entitled to use and the actual
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number of software instances that are used. You can use the report to

port

eliminate unused licenses and track computers that use unlicensed in
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stances of a software product.
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Note: This report is related to previous deprecated contracts
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functionality.

Contract Us
age Data
(deprecated)

Report columns
This glossary provides a brief description of every column that can be found in the reports
that are available in BigFix Inventory.
ABCDEFGHILMNOPRSTUVWY
Note: When the value of the column cannot be populated because there is no data,
one of the following values is displayed.
• <no data> when the data does not exist.
• <not set> when the value is not yet set. You can set it using the dedicated
option.
If the <not set> value appears under the Product Name column, see: The
<not set> value appears under the Product Name on Software Classification
panel.

• <n/a> when the data is not relevant for the particular report line.
• The cell is empty when the value does not exist and cannot be populated.

A
Action
Indicates whether the upload of the part numbers file overwrote the previously
uploaded part numbers or added part numbers to the existing ones.
Acquisition Cost
Overall cost of purchasing the license for the software product. It is the value
that you specify while creating the contract.
Agent Version
Version of the BigFix agent that is deployed on the computer.
Always Not Charged
Indicates whether a component is always not charged.
Alternative User ID
An identifier of a user who currently uses or registered a software program. It
is a number or a string specific to this software program.
Authentication Method
Method of authentication that is used to log in to BigFix Inventory.
Automatic Scan Status
Indicates whether the shared disk is scanned by using the automatic version
of the optimized scanning mode. For more information, see: Step 2a:
Optimized mode - Automatic scanning of remote shared disks. The column
can have one of the following values:

• Disabled
• OK
• Pending
When you hover over the Pending status, you can see more details why the
action is pending.
Average Runs per Day
Average number of times a process or software item is started per day. See
also Monitoring and reporting software usage
Average Run Time
Average amount of time during which a process or software was used. It
is calculated by dividing the total run time by the number of total runs. The
average run time is the same as the total run time when the total number of
runs equals one. See also Monitoring and reporting software usage

B
Brand
Brand of the processor that was matched in the PVU table. If the brand
is “Other”, the processor is not listed in the PVU table. For details of the
processor read from the computer operating system, see: Processor Brand
String.
Bundle Metric Contribution
Indicates the number of license metric units that the particular product
contributes to the overall metric quantity of the FlexPoint bundle or Cloud Pak
to which that product is assigned.
Bundling Tag Used
Indicates whether the product assignment is based on a bundling tag.

C
Catalog-based Scan
Indicates whether the catalog-based scan is a part of the scan schedule
configured directly from BigFix Inventory.
Catalog Format
Format of the software catalog.
Catalog Part Numbers
Part numbers that represent the product that are listed in the software
catalog.
Catalog-provided
• On the Products & Metrics report, it indicates whether the product and
metric relation is provided in the software catalog. If the column value is
No, the relation comes from the SWID tag, or is defined by a user.

• On the Package Data report, it indicates whether the component from
the particular vendor and in the specific version already exists in the
software catalog.
Catalog Provider
Name of the catalog content originator.
Catalog Scan Results Missing
Indicates whether the catalog scan results are missing. The scan might be
missing because the computer or a relay is offline, there is a network outage,
or the last scan attempt was more than 30 days ago.
Catalog Scan Successful
Indicates whether the catalog scan was successful. The scan might be
unsuccessful because the computer is out of space, it is misconfigured, or the
scan was stopped.
Catalog Version

Version of the software catalog that is available on the computer. If different
versions of the catalog are available on various computers, update the
catalog.
Caused Detection: Removed since
Indicates whether a file or a package contained enough information to cause
detection of the related software. This column is not available by default.
The data that is required to populate this column uses many resources, and
the time to load and filter the reports will be extended, especially for huge
environments.
To enable this column on the Scanned File Data and Package Data reports,
go to Management > Advanced Server Settings and change the value of
enable_caused_detection_data parameter to true. To display the column on
the Scanned File Data or Package Data reports hover over the Manage Report
View icon

, and click Configure View. Select the appropriate check box.

In versions earlier than 9.2.9, the Caused Detection column can be enabled
only on the Scanned File Data Report. To display it, enable the aggregation of
unrecognized scan data. Go to Management > Unrecognized Scan Data and
choose whether you want to aggregate the data after every import or after the
next import only. Next, configure the report view.
Note: The Caused Detection column and
enable_caused_detection_data parameter is removed since BigFix
Inventory version 10.0.4. You must re-create your saved reports in
case you had used the Caused Detection column.
Changed PVU per Core Value
Specifies whether the number of processor value units for a specific server
was manually changed.
Charged

Indicates whether the relation between the component and the product is
charged based on the license terms. If the relation is charged, the component
contributes to the license metric utilization of the product to which it is
assigned.
Children
Number of nested computer groups.
Cluster Cores
The total number of processor cores available within the cluster of host
computer systems.
Cluster Name
Name of the cluster to which a particular host computer system belongs.
Comment
Extra technical information. Possible values on the server level include:
Incomplete virtualization hierarchy and All instances are excluded. Possible
values on the software instance level include reasons for excluding the
instance from pricing calculations, and suppressing the product from the
inventory.
Comments
Additional information that was specified during the upload of the PVU table,
part numbers file, or the software catalog.
Component Creation
Date and time when the component was created.
Component Definition Source
Specifies the entity that provided the component definition. From application
update 9.2.9, this column replaced the Software Catalog column.
Component Detailed Version

Detailed version of the software component that is installed on the computer.
This information is provided for components that are discovered by the
following means:
• Software identification (SWID) tags. Supplemental SWID tags are not
supported. Thus, if the fix pack version is embedded in the supplemental
tag, it is not shown.
Windows files in which the file version attribute is set and

•

which is used as a software signature.
Extended Signature reporting detailed version.

•

A package in which the version attribute is set and which is used

•

as a software signature.
For components that are discovered with other detection methods the
values in Component Detailed Version and Component Version columns are
duplicated.
Starting from application update 9.2.11, the column presents the highest
reported version of the component. Versions are sorted in numerical order.
If the version consists of digits and letters, it is sorted in numerical order
and then the alphabetical order. Precision of sorting is up to four places per
position, and up to four positions. The type of the discovery mean takes
precedence over the sorting.
For versions below 10.0.4, the precedence of the version information
displayed is:
• SWID tags
• Windows file version
• Extended signature
For versions 10.0.4 and above, the precedence of the version information
displayed is:

• Extended Signature
• SWID tags
• The package with version attribute
• Windows file version
For 10.0.4 and above, the version information which contains patch level (with
two dots) takes precedence over the above order. For example, if both file and
package versions with patch level are available for a given software instance,
package version is shown. If package version contains only release level (for
example, "1.2"), but file version contains patch level ("e.g. 1.2.3"), file version is
shown.
Component Modification
Date and time when the component was modified.
Component Name
Product component that was discovered on the computer.
Component Tags
Tags defined on the Software Components panel. These tags are common for
all discovered instances of the same component.
Component Version
Version of the software component that is installed on the computer.
Computer Count
Number of computers on which the software is installed or the shared disk is
mounted.
Computer Deletion Date
The date and time when the computer stopped being discovered, for example
because it was removed from the infrastructure, the data source was removed,
or the BigFix client was uninstalled.
Computer First Seen

Date and time when the information about the computer was imported from
BigFix for the first time.
Computer Group
An organized list of computers through which users can get dedicated
reporting or perform common operations in bulk. This feature simplifies the
maintenance of customer environments, and it can be used to represent, for
instance, a department or region.
• Computer group to which the user has access.
• On the Part Numbers Panel, the column indicates the computer group
for which the part numbers were uploaded.
Computer Group Name
Computer Group for which the metric was calculated.
Computer ID of VM Manager Tool
Identifier of the computer on which the VM Manager Tool that collects data
from the particular VM manager is installed.
Computer Last Seen
Date and time when the agent connected to the BigFix server the last time.
Computer Name
Host name of the computer on which the data specific to the report was
discovered. For VMware products displayed on the Resource Utilization report,
the name of the computer where VM Manager Tool is installed.
Computer Type
Type of the computer: physical, virtual, or public cloud.
Computers
Number of computers.
Confidence

Reliability of the signature that is defined in the software catalog. The lowest
confidence equals 0, the highest confidence equals 3.
Confirmed
Indicates whether the software classification was manually confirmed.
Connection Test Status
Indicates whether connection to the VM manager was tested and what was
the result of the test.
Contact Information
The column is not used.
Content
Content of the software catalog. Possible values are: catalog XML file, or
charge unit data.
Contracts
The Contracts report type includes 'products and metrics', 'all contracts', and
'product metrics per group' reports. See also, contract management.
Copies
Number of copies of the unrecognized file that are discovered on the
computers in your infrastructure.
Cost Delta
Difference between the cost of purchasing the license for the particular
software product, and the cost of used or unused instances of that product.
If the cost delta is a positive number that is displayed in green, the number of
product instances that are used does not exceed the license entitlement. The
number indicates that you have some spare licenses that you can distribute
in your enterprise or that you can reduce the license-related cost by not
extending the excessive licenses. If the cost delta is a negative number
that is displayed in red, the number of software product instances that are

used exceeds the license entitlement. You must purchase licenses for more
instances of the software product.
Cost per Seat
Cost of the license for an instance of the software product.
Count
The number of software instances in the group that is filtered based on the
selected columns.
CPU Core Full Capacity
Total count of physical processor cores of the server on which the product is
installed.
CPU Core Subcapacity
Number of processor cores that are used by a software product.
CPU Core Subcapacity Limit
Total count of physical cores of the server on which the product is installed. It
is counted at the time when the subcapacity is maximum which means when
the number of cores that are used by the product is the highest.
Created By
Name of the user that created the custom rule.
Criteria
Definition of the custom rule.
Current Measured Value
The maximum value of the license metric over the default aggregation period
for given computer group. Period may vary for computer groups and the value
can be changed in Computer Group settings. The declared quantity takes
precedence over the measured quantity.
Current Status
Details of the signature after modification.

Current Value
Value that is currently set for the server parameter.

D
Database Host
Host of the computer on which the BigFix Inventory database exists.
Database Name
Name of the BigFix Inventory database.
Database Type
Type of the BigFix Inventory database. Possible values are: DB2, disconnected,
SQL Server.
Database User Name
Name of the user that is used to connect to the BigFix Inventory database.
Data Collection Time
Date and time when data was collected from the VM manager.
Data Import Time
Date and time when data from the VM manager was imported to BigFix
Inventory.
Data Source Computer ID
An identifier of a computer as defined in BigFix.
Data Source Name
Name of the BigFix server from which the data is uploaded to BigFix Inventory.
Date
Date and time when the software catalog was published.
Default Report

Indicates whether the saved report view is set as the default view for a
particular report.
Default PVU Value
Indicates whether a default number of processor value units is assigned to the
computer. The default number is assigned when the processor is not listed in
the PVU table. The default value is 100 PVUs per core.
Deployment Type
Type of the VM Manager Tool deployment, either central or distributed.
Designated Computer
Provides information about the computer that is designated to scan the
particular share disk.
Description
Additional description of an item.
Details
On the Audit Trail, it is information about the type and date of action that
influences data on other reports as well as the user who performed the action.
On other reports, it is a link to detailed information about the software product.
Discovery
Indicates whether the signature is used for software discovery.
Discovery End
Date and time when the component instance was reported for the last time. If
the component is still detected, the column shows <n/a>.
Discovery Start
Date and time when the component was first detected by BigFix Inventory. The
Discovery Start date might be later than the First Used date.
DNS Name
Name of the computer that is specified in the Domain Name System.

Download
Link to downloading the data import log.
Duration
Duration of the data import.

E
Edition
Edition of the Oracle Database.
Enabled
Indicates whether the scan that was configured directly from BigFix Inventory
is enabled.
End of Support
Date when the software component reaches end of support.
Endpoint Scanner Catalog Version
Version of the custom software catalog that is available on the computer.
Entitled Computers
Number of computers that are entitled to use the software.
Entitlement End
Date of the end of entitlement for the product that was provided during the
creation of the contract.
Entitlement Start
Date of the start of entitlement for the product that was provided during the
creation of the contract.
Excluded
Indicates whether the product on a computer is currently excluded from the
pricing calculations.

Exported Directory
Exported directory of the shared disk.

F
Feature
Feature of the Oracle Database.
File Name
Name of the file that is used by the signature to discover the software.
File Path
Directory in which the file is located.
File System Scan Results Missing
Indicates whether the file system scan results are missing. Scan results might
be missing because the computer or a relay is offline, there is a network
outage, or the last scan attempt was more than 30 days ago.
File System Scan Successful
Indicates whether the file system scan was successful. The scan might be
unsuccessful because the computer is out of space, it is misconfigured, or the
scan was stopped.
File Version
Version of the file.
Starting from application update 9.2.11, the column
returns the full version of the file, not only version limited to the release
number. If you upgrade from earlier versions of BigFix Inventory, reupload
results of the file system scan to show the full version. Otherwise, it is shown
only for newly discovered or updated files. To reupload the result, run the
Force Re-upload of Software Scan Results fixlet.
First Detected

Date and time when the software component was detected by the scanner for
the first time.
First Measured
Date and time when the license metric was first measured.
First Used
Date and time when the information about the process was first collected
by the BigFix client. The First Used date might be prior to the Discovery Start
date. See also: Monitoring and reporting software usage
FlexPoint Bundle
FlexPoint bundle to which the product and its components are assigned. For
more information, see: Assigning products to FlexPoint bundles.
FlexPoints
Total utilization of FlexPoints by the FlexPoint bundle.
FlexPoint or Cloud Pak Bundle
FlexPoint bundle or Cloud Pak to which the product and its components are
assigned. For more information, see:
• Assigning products to FlexPoint bundles
• Assigning products to Cloud Paks
FlexPoints per Metric Unit
The factor by which the number of metric units is multiplied to obtain the
number of FlexPoints that the products uses.
FlexPoint Quantity
Indicates the number of FlexPoints to which the product and related metric are
assigned as a part of a FlexPoint bundle.
From Software Template

Indicates whether the software was discovered on a particular computer or
was generated from a software template. In the latter case, the software is
installed on a shared disk that is mounted on the particular computer. For
more information, see: Discovering software on shared disks.
Frequency
Frequency of the scan that was configured directly form BigFix Inventory.
From Software Template
Indicates whether the software was discovered on a particular computer or
was generated from a software template. In the latter case, the software is
installed on a shared disk that is mounted on the particular computer. For
more information, see: Discovering software on shared disks.

G
Global Default Report
Indicates whether the saved report view is set as a default view of the
particular report for all users.

H
Has Low Disk Space
Indicates whether the computer has less than 100 MB of free disk space.
Has Missing Prerequisites
Indicates whether any scanner prerequisites are missing on the computer.
Has Outdated Version
Indicates whether the latest version of the BigFix agent is installed on the
computer. For some operating systems, no newer version of the agent is
available.
Has Usage
Indicates whether a usage signature exists for the particular software.

I
IBM-provided Bundling Option
Indicates whether the product has the selected component listed as a
bundling option in the software catalog provided by IBM.
ID
Identifier of a computer group.
Imported At
Date and time when the PVU table, part numbers file, or the software catalog
was imported to BigFix Inventory.
Imported Part Numbers
Part numbers that you imported to BigFix Inventory. They represent IBM
products that you purchased.
Install Path
Installation path of the Oracle Database.
Installed Software
Number of software items that are installed on the computer.
Instance
Identifier of the software instance. For VMware products displayed on the
Resource Utilization report, it specifies the license key, machine type and the
host name.
Instance Tags
Tags for individually discovered instances of a software. These tags are
independent from component tags in catalog. Discovery tags are set by using
the dedicated option.
Instances Covered by Contracts
Number of software items by a particular vendor for which contracts are
defined.

Internal Computer ID
Identifier of a computer as defined in BigFix Inventory.
Internal Version
• On the Catalog Upload panel, the column indicates the internal version
of the software catalog.
• On the Part Numbers Upload panel, the column indicates the internal
version of the PVU table.
IP Address
IP address of the computer.
Is Capped
Indicates whether the partition is capped, that is whether its access to
processor resources is limited. Available only for AIX. For other operating
systems, the column shows no data.
Is Out of Sync
Indicates whether the time that is set on the computer is at least an hour from
the time that is set on the BigFix Inventory server.

L
Last Login
Date and time when the user last logged in to .
Last Scan Attempt
Date and time when the last scan was initiated.
Last Used
Date and time when the software item was last used or a process was last
run. See also: Monitoring and reporting software usage
Last Software Change

Date and time when the software on a particular computer last changed and
the change triggered a software scan that was imported to .
Licensed Computers
Number of computers that are entitled to use the software and have this
software installed.
License Delta
Difference between the number of software product instances that you are
entitled to under a particular license and the actual number of software
instances that are used. If the license delta is a positive number that is
displayed in green, the number of product instances that are used does not
exceed the license entitlement. If the license delta is a negative number that
is displayed in red, the number of product instances that are used exceeds the
license entitlement.
Logical Processors
Number of processor cores that are assigned to the partition on which the
BigFix agent is installed. The number takes into account hyper-threading on
the x86 architecture.
LPAR Entitlement
Number of processor cores that are assigned to the logical partition. Available
only for AIX. For other operating systems, the column shows no data.

M
Maintenance End
Date of the end of maintenance of the software that was provided during the
creation of the contract.
Maintenance Start
Date of the start of maintenance of the software that was provided during the
creation of the contract.

Maximal Trend Value
Maximum value of the license metric utilization over the last 30 days.
Maximal Trend Value History
Graphic representation of the history of license metric utilization over the last
30 days.
Maximum Value
Maximum value that the parameter accepts.
MD5
MD5 checksum calculated for a file. Checksums work as fingerprints of files,
and can be compared to checksums of known virus signatures to recognize
whether files were altered or tampered with. They are used to ensure file
integrity and safety in advanced security scenarios.
Metric
Type of the metric used by the software item, for example installed seats,
PVU.
Metric Quantity
The highest number of metric units that the product used over the specified
period.
Metric Quantity History
Graphic representation of the history of metric consumption over the specified
time period. If you set the license threshold, the graph also includes a line that
represents the threshold. For more information, see: Setting license metric
threshold.
Metric Subtype
Subtype of the license metric. For VMware products displayed on the
Resource Utilization report, metric subtype indicates if the count refers to the
metric utilization or overall license capacity.
Metric Type

Type of the license metric.
Metric Units Convertible to FlexPoints
The number of metric units that are converted into FlexPoints. The number of
convertible metric units can be lower than the overall number of units that are
used by the product. It happens when some instance of the product are not a
part of the FlexPoint bundle.
Minimum Value
Minimum value that the parameter accepts.
Model
Model of the processor.
Modification Date
Date and time when the item was modified.
Modification Type
Type of the modification.
Modified By
User who modified the item.
Modified Software
Software item that was modified.
Mounted Shared Disks
List of directories of all shared disks that are mounted on the computer. To
see the data, run the Discover Remote Shared Disks task on the computer.

N
Name
Name of an item. It depends on the report on which the column is displayed.
Normalized Component Name

The component name that is suggested after the analysis of package details
and current content of software catalog.
Normalized Component Vendor
The vendor that is suggested after the analysis of package details and current
content of software catalog.
Normalized Component Version
The component version that is based on what is embedded in package details
and rounded up to two decimal places.
Number of Packages
Number of specific packages that are identified in your environment.

O
One to One
Indicates whether the product to which the component is currently assigned is
the only bundling option that is available in the software catalog.
Operating System
Operating system of the computer on which the BigFix agent is installed.
Operation Status
Status of the connection to the VM manager.

P
Package Data Scan
Indicates whether the package data scan is a part of the scan schedule
configured directly from BigFix Inventory.
Package Scan Successful

Indicates whether the latest package scan was successful. The scan might be
unsuccessful because the computer is out of space, it is misconfigured, or the
scan was stopped.
Parameter Name
Name of the server parameter.
Parent Hostname
Hostname of the parent computer, if available. The value is null if the parent
computer is not available.
Parent Name
Name of the server parameter.
Parent Organization
Organization that owns the content of the catalog.
Partition Cores
Specifies the number of processor cores that are assigned to the partition on
which the BigFix agent is installed.
On the All Metrics report, when you click a product that is licensed under the
PVU subcapacity or RVU MAPC subcapacity, and you drill down to information
about a single computer, the column shows the number of partition cores
measured when the peak of the metric value occurred. When you sum up
partition cores from VMs running on a single server, the value might not be
equal to the number of cores that contribute to metric utilization on the server
level. It is in line with subcapacity pricing rules. For more information, see:
Virtualization Capacity License Counting Rules.
Partition Virtual Processors
Number of virtual processors that are assigned to the partition on which
the BigFix agent is installed. The value is used in further calculations when
the endpoint works in the uncapped mode. Available only for AIX. For other
operating systems, the column shows no data.

Path
Installation path of the software that was discovered on the computer or
where the .slmtag file was discovered.
Permissions
Permissions that are assigned to the particular role. Permissions define which
reports and panels the user who is assigned a particular role can view or edit.
For more information, see: Roles.
Peak Date
Indicates the date of license metric peak value for the reporting period.
Physical Shared Pool Cores
Number of processors that work in the shared mode.
Platform Name
Name of the platform on which the software is discovered by means of the
particular signature.
Predefined End of Support
Indicates whether the end of support date was provided by IBM or was
specified manually by a user.
Present
Indicates whether the component instance is currently installed.
Private
Indicates whether the saved report view can be used only by its creator or by
other users as well.
Process Name
Name of the process on which the calculation of software usage is based. See
also: Monitoring and reporting software usage
Processor
Details of the processor.

Processor Brand String
Full specification of the processor including its brand, model and speed as
read from the computer operating system.
Product Definition Source
Specifies the entity that provided the product definition. From application
update 9.2.9, this column replaced the Software Catalog column.
Product Name
Name of the product with link to calculation details. See also, All Metrics
Product Publisher Name
Name of the publisher of a product that a software instance is assigned to.
The column is empty if no product assigned.
Product Version
Version of the software product.

In case it is template-derived

software, the product version is '*'.
Provider
Provider of the software catalog.
Publisher
Name of the company that published the software item.
Publisher Definition Source
Specifies the entity that provided the publisher definition. From application
update 9.2.9, this column replaced the Software Catalog column.
Publisher Name
Name of the company that published the software item.
Purchase order
A set of information about purchased software.
PVU per Core

Number of processor value units that are assigned to a processor core on a
computer system. By default, the value is taken from the PVU table. It can also
be manually set on the Hardware Inventory report. For more information, see:
Changing the PVU per core value. See also: Changed PVU per Core Value.
PVU Full Capacity
Number of processor value units that are used by a product that is installed on
the server.
PVU Subcapacity
Number of processor value units that are used by a product that is installed on
the server partition.
PVU Subcapacity Limit
Total count of processor value units for the server on which the product is
deployed, counted at the time when subcapacity is maximum. Maximum
subcapacity is when the number of cores that are used by the product is the
highest.

R
Rank
The position of a file in the ranking of 1000 files that are most commonly
encountered in your computer infrastructure but do not produce matches for
any signature.
Recognized
Indicates whether the package data or file was recognized as part of an
existing signature.

Recognized column is the primary option as Cause

Detection column has been removed since BigFix Inventory version 10.0.4.
Release
Release of the software product.
Release Definition Source

Specifies the entity that provided the release definition. From application
update 9.2.9, this column replaced the Software Catalog column.
Resource Utilization Scan
Indicates whether the resource utilization scan is a part of the scan schedule
configured directly from BigFix Inventory.
Reported Since
Date and time when the package or file was discovered for the first time.
Reputation
Indicates whether the file is a malware threat. Possible values:
• <n/a> is when SHA-256 checksum is not collected.
• <no data> is when the Tool for Reporting File Reputation is not installed.
• <No threat> is when the file is not classified as a security threat.
• <No reputation> is when the classification was done but the type of
reputation is unknown.
• <Threat> is when the file is classified as a security threat. This value is
a link which directs you to IBM X-Force Exchange website that contains
details about the hash reputation. To see the information you must log
in using your IBMid.
Reputation Details
Indicates the type of a threat. Possible values:
• Trojan
• Downloader
• Spyware
• Backdoor
• Rootkit
• Ransomware
• Bot
• Adware

• Worm
• Unwanted
• Virus
• Miner
Reputation Import
The date when the reputation was updated in BigFix Inventory.
Reputation Update
The date when the reputation was updated in the reputation data source.
Roles
Roles that the user is assigned.

S
Scanning Shared Disks
Indicates whether shared disks were scanned during the last software scan.
Server Active Sockets
Number of physical processor chips that are mounted on the server.
Server Cores
Number of processor cores that are used by the server.
Server ID
Identifier of the server. The format of the identifier is specified by the
managedServerTagTemplate parameter for hosts from which data
is collected by the VM Manager Tool or by the Run Capacity Scan on
Virtualization Hosts fixlet or by the standaloneServerTagTemplate parameter
for the remaining hosts. For more information about the parameters, see:
Advanced server settings.
Server Model
Model of the server.

Server Name
A unique system in the enterprise. For a physical machine, it is the hardware
manufacturer, type, and a machine serial number. For a virtual machine, it is
the manufacturer and host name. For a virtual machine with an incomplete
definition, it is a UUID that is prefixed with TLM_VM_.
A unique system in the enterprise.
• If the computer is a physical machine, the Server Name column shows
the hardware manufacturer, type, and a machine serial number.
• If the computer is a virtual machine, the Server Name column shows the
manufacturer and host name of the physical host.
• If the computer is a virtual machine for which a VM manager is not
configured, the Server Name column shows a UUID assigned by prefixed
with TLM_VM_.
The serial number of the physical host with zCX (System Z

•

Container Extensions) is followed by the for zCX suffix. For example,
for CEC with z/VM guest and zCX hypervisor, the serial numbers will be
123456 and 123456 for zCX respectively. The distinction is related to

the different pricing rules established for zCX. For more information, see
Virtualization Capacity License Counting Rules.
Server Serial Number
Serial number of the server.
Server Type
Type of the server.
Server User Name
Name of the user that is used to connect to the BigFix server.
Server Vendor
Vendor of the server.
SHA-256

SHA-256 checksum calculated for a file. Checksums work as fingerprints
of files, and can be compared to checksums of known virus signatures to
recognize whether files were altered or tampered with. They are used to
ensure file integrity and safety in advanced security scenarios.
Shared
Indicates whether a component instance is shared between multiple products.
Shared Disk Type
Type of the shared disk.
Shared Mode
Indicates whether the logical partition works in the shared mode. Available
only for AIX. For other operating systems, the column shows no data.
Shared Pool ID
Identifier of the shared processor pool.
SID
Unique name of the Oracle Database instance.
Signature Creation
Date and time when the signature was created.
Signature Definition Source
Specifies the entity that provided the signature. From application update 9.2.9,
this column replaced the Software Catalog column.
Signature ID
Identifier of the signature.
Signature Modification
Date and time when the signature was last modified.
Size
Size of the file in bytes.

Software Catalog
Software catalog that contains the signature for the software item. Starting
from application update 9.2.9, the Software Catalog column is substituted
with the following columns:
• Component Definition Source
• Product Definition Source
• Publisher Definition Source
• Release Definition Source
• Signature Definition Source
• Version Definition Source
Software Component
Name of the software component.
Software Contracts
A set of information about a software license for a product, the product type,
cost, amount of purchased license metrics, and the entitlement period. When
a contract is assigned to a computer group, it indicates which computers the
license is distributed to.
Software ID
Identifier of the software to which the modification applies.
Software Identification Tags Scan
Indicates whether the software identification tags scan is a part of the scan
schedule configured directly from BigFix Inventory.
Software Level
Specifies the version, release, and modification number of a software item.
Software License
A legal instrument governing the use or redistribution of software.
Software Name

Name of the software product.
Software Product
Name of the software product.
Software Release
Release of the software product.
Software Tags Scan Successful
Indicates whether the last software tags scan was successful.
Software Version
Version of the software product.
Start Date
Date and time when the scan that was configured directly from BigFix
Inventory was run for the first time.
Start Time
Date and time when the import of data started.
Status
• On the Data Imports panel, the column indicates whether the import
succeeded or failed. For more information, see: Import logs.
• On the Hardware Inventory report, the column indicates whether data
from a hypervisor is available.
• On the Metric Table Upload panel, the column indicates whether the
uploaded PVU table was already imported to BigFix Inventory or is still
pending.
• On the Part Numbers Upload panel, the column indicates whether the
uploaded part numbers file was already imported to BigFix Inventory or
is still pending.

• On the Scan Configurations panel, the column indicates the status of the
scan that was configured directly in BigFix Inventory .
• On the Software Catalog panel, the column indicates whether the
software catalog was already imported to BigFix Inventory or is still
pending.
System Model
Name of the hardware system or virtualization technology that is discovered
by the agent.
Suppressed
Indicates whether the component is currently suppressed from the inventory.

T
Threshold
The maximum number of metric units that a product is entitled to use within a
computer group. The value is set manually and is used to calculate the metric
threshold delta.
Threshold Delta
It is calculated by subtracting the metric quantity from the threshold. If license
utilization is lower than or equal to the threshold, the delta is displayed in
green. Otherwise, it is displayed in red.
Time Range From
Start time of calculation period for given computer group.
Time Range To
End time of calculation period for given computer group.
Top-level Directory
Indicates whether the shared disk is a top-level directory in the shared disk
structure.

Total Acquisition Cost
On the Computer Groups report, it is the total cost of purchasing licenses for
software items in the computer group. On the Inventory Exploration report, it is
the cost of purchasing licenses for software items by a particular vendor.
Total Components
Number of components of software products that are listed in the catalog.
Total Licenses
Number of licenses for the particular software product that are available. If the
product is licensed per computer, the number of computers that are entitled
to use the product is provided. If an unlimited number of products can be
deployed under the particular license, the column includes the abbreviation
ELA (Enterprise Licensing Agreement). Higher-level users can define a
contract that applies to a broad group. If lower-level users view a contract
usage report that is defined in such a way, they see the larger total number of
licenses for the product. However, when the lower-level users view the list of
instances, they see only those instances of the product for which they have
permissions.
For example, a global administrator defines a contract for 5000 instances of
Lotus Notes, out of which 3500 instances are used. A lower-level user has
an infrastructure that consists of 100 computers. The user is entitled to 100
instances of Lotus Notes, but only 70 instances of the product are used. If the
global administrator makes the contract viewable to the lower-level user, the
user sees that 3500 instances of Lotus Notes out of 5000 available instances
are used. However, when lower-level users view the list of instances that are
pertinent to their computer group, they see only the numbers that reflect the
use of licenses in their computer group. The report shows 70 used instances
of Lotus Notes out of 100 instances available under the particular license.
Total Maintenance Cost

On the Computer Groups report, it is the cost of maintaining all software items
in the computer group. On the Inventory Exploration report, it is the cost of
maintaining software items by a particular vendor.
Total Publishers
Number of software publishers that are listed in the catalog.
Total Releases
Number of releases of software products that are listed in the catalog.
Total Runs
Number of times a software item or process was started. See also: Monitoring
and reporting software usage
Total Run Time
Indicates how long the software item or process was running. See also:
Monitoring and reporting software usage
Total Signatures
Number of signatures that are listed in the catalog.
Total Software Products
Number of software products that are listed in the catalog.
Total Versions
Number of versions of software products that are listed in the catalog.
Type
• On the Computer Groups report, the column indicates whether the type
of the group is Reporting or Software Template. For more information,
see: Setting up computer groups.
• On the Metric Custom Fields panel, the column indicates the type of the
custom filed. For example, boolean or string.

• On the Inventory Exploration report, it indicates whether the displayed
item is a publisher, software product, version, release, or component.
• On the Package Data report, it is the type of the package management
system.
• On the VM Managers panel, the column indicates the type of the VM
manager.
• On other reports, it is the type of the processor according to number of
cores.

U
Unique User ID
An identifier of a user who currently uses or registered a software program. It
is a specific ID that is assigned to one user only, and can either be an e-mail,
first name, last name, initials or a random string.
Unknown Use
Number of software instances for which use is not monitored. These
instances are grouped based on the columns defined or selected by the user
in the report view.
Unused
Number of software instances that were not used and that are grouped based
on the columns defined or selected by the user in the report view.
Unused in the Last Month
Number of software instances that were not used within the last month and
that are grouped based on the columns defined or selected by the user in the
report view.
Unused in the Last Quarter
Number of software instances that were not used within the last three months
and that are grouped based on the columns defined or selected by the user in
the report view.

Unused in the Last Week
Number of software instances that were not used within the last seven days
and that are grouped based on the columns defined or selected by the user in
the report view.
Unused in the Last Year
Number of software instances that were not used within the last year and
that are grouped based on the columns defined or selected by the user in the
report view.
Uploaded At
Date and time when part numbers file, the PVU table, or the software catalog
was uploaded to BigFix Inventory.
Uploaded By
User who uploaded the part number file, PVU table, or the software catalog.
The value SYSTEM means that the PVU table, or the software catalog was
automatically provided with BigFix Inventory.
URL
URL to the VM manager.
Used
Number of software instances that were used and that are grouped based on
the columns defined or selected by the user in the report view.
Used in the Last Month
Number of software instances that were used within the last month and that
are grouped based on the columns defined or selected by the user in the
report view.
Used in the Last Quarter
Number of software instances that were used within the last three months and
that are grouped based on the columns defined or selected by the user in the
report view.

Used in the Last Week
Number of software instances that were used within the last seven days and
that are grouped based on the columns defined or selected by the user in the
report view.
Used in the Last Year
Number of software instances that were used within the last year and that are
grouped based on the columns defined or selected by the user in the report
view.
User Group Name
Specifies the source of the information related to software users.
User Name
• Name of the user who created the custom report view.
• On the Users panel, it is the name of the user.
• On the Data Imports panel, it is the name of the user who ran the import.

V
Value Type
Type of the parameter value. For example, boolean or string.
Vendor
Vendor of the processor or of the software that is installed on the computer.
Version
Version of an item. It depends on the report on which the column is displayed.
Version Definition Source
Specifies the entity that provided the version definition. From application
update 9.2.9, this column replaced the Software Catalog column.
Virtual Shared Pool Cores
Number of active processor cores in the virtual shared pool.

Vulnerability Risk (Preview)
Lists Common Vulnerabilities and Exposures matched with a given software
component. The column can contain multiple values that are displayed after
expanding.

W
Website
Website of the software publisher.

Y
Your Next Scheduled Export
Date and time when the saved report will be sent to the recipients that you
specified in the schedule. The column does not contain sending dates
scheduled by other users.

Adding and removing tags
Available from 9.2.14. BigFix Inventory allows you to tag certain elements on the
reports. You can tag software components, and whole report rows and thus mark them to
meet your individual business needs.
To perform this task on the Software Components report, you must have the View
Software Catalog and Signatures and Manage Catalogs permissions.
To perform this task on the Software Classification panel, you must have the View
Endpoints and Manage Software Classification permissions.
Tagging software components, and whole report rows might be used to differentiate the
specific kind of software components, or the discovered software. It can help you group
items according to their importance, specificity, type or use. You can tag the following report
elements:

• Software components on the Software Components report.
• Individually discovered instances of software on the Software Classification panel.
Adding tags
1. In the top navigation bar, click Reports and choose the relevant report.
2. Select one or more rows for which you want to add tags
Note: On the Software Components report, you can select up to a 100 rows at
a time.
3. Hover over Edit, and click Add Tags.
4. List tags that you want to add for the selected components. You can select an
existing tag or add a new one.
5. Click Add Tags.
The tags are visible on a relevant report.
To remove tags, hover over Edit, and click Remove Tags. Select the tags and confirm by
clicking Remove Tags.

Applying report filters
The type and amount of information that is displayed on the reports is set by default. You
can apply filters to narrow down the scope of the report to information that meets specific
criteria.
1. In the top navigation bar, click Reports and open the report that you want to view.
2. To view the filtering options, in the upper right corner, hover over the Configure icon
, and click Configure View.
3. Optional: If you want to add multiple filters, choose all or any to specify whether the
items must match all filtering criteria or any of them.
4. Select the column by which you want to filter the report and the filter operator. Then,
enter the value that you want to use as the filter.

Filter operators are available depending on the type of column by which you filter the
report. All filter operators are enabled by default. Deselect the operators as required.

Restriction: When you use the IP Address operator and choose the ends with
operator, no computers are displayed even if some computers match the
criteria. To work around this issue, you can choose other relations, such as
contains or begins with.
5. Optional: Below "Specify the report filter which matches all of the following
conditions:", click on

. Dropdown lists with the configurable parameters for

the primary column name of the report appears.

• In the dropdown list, select All of... to group the configuration that apply to all
selected parameters. Select further rows and dropdowns as required.
• In the dropdown list, select Any of... to group the configuration that apply to any
of the selected parameters. Select further rows and dropdowns as required.

6. Optional: To add another filter, click on the plus icon.
Tip: To delete a filter, click on the trash icon.
7. Click Submit.

Exporting reports to a file
If you need a hard copy of a report that is generated in BigFix Inventory you can export the
report to a CSV or PDF file. You can also use the CSV file to create charts and statistics that
are based on the information from the report.

1. In the top navigation bar, click Reports and select the report that you want to view.
2. Optional: You can customize the report before export. To specify the required filters
and columns, hover over Configure, and click Configure View. To display all columns
on the report, select the Select All check box in the Columns section.
3. To export the report to a file, hover over Export, and click PDF or CSV.
Note: If your reports are not displayed correctly, see:User interface problems.
Starting from application update 9.2.15, the file name consists of the predefined
or custom report name, the default report name, and the time stamp. For example:
My_Custom_Report-software-classification-20190215085933.csv.

Creating saved report views
Saved report views are derived from base reports and provide quick access to information
that you use frequently. Some saved report views are delivered with BigFix Inventory and are
available for you immediately. You can also specify filters and parameters of any report and
create your own saved report views.
Three types of saved reports are available.
The table consists of five columns and four rows.

Type

Prede

Can be sent

Can be set

Can be

to specified

as a de

mod

Description

recipients

fault view

ified

Reports that are delivered with

Yes

Yes

Yes

Yes

BigFix Inventory.

fined
My Re
ports

Reports that you created.

Yes

Type

Can be sent

Can be set

Can be

to specified

as a de

mod

recipients

fault view

ified

Description

Other Re Reports that were created by
ports

Yes

other users and marked as
public.

1. In the top navigation bar, click Reports and choose the report for which you want to
create a custom view.
2. To customize the report view, hover over the Configure and click Configure View. Add
or remove columns and apply filters, then click Submit. Resize and sort the report
columns by clicking and dragging.
3. To save the report, hover over Configure icon

, and click Save As. Specify the name

of the report. You can also choose one of the following options:
• If you do not want other users of BigFix Inventory to view your custom report,
select Private.
Note: The Administrator can view and delete reports that are marked as
private.
• If you want the custom report to be your default view for the particular report,
select Set as default.
Tip: If the Administrator set a customized view as global default for a
particular report, you can overwrite this setting by creating your default
view. Your settings take precedence over the global settings.
• If you want the custom view to be the default report view for all users of BigFix
Inventory, select Set as global default. You must be an Administrator to perform
this task.
All types of saved reports can be accessed from the Saved Reports panel or from a dropdown list on the base report from which the saved report was created.

Deleting saved report views
To delete a saved report view, select the report from the list of all saved reports, and click
Delete.
1. To open the list of all saved reports, click Reports > Saved Reports.
2. Select the report that you want to delete.
3. In the upper left corner, click Delete.

Changing the default report view
To change the default view that you set for a particular report, you must first clear the
settings and then set the new custom view.
1. To open the list of all saved reports, click Reports > Saved Reports.
2. Open the report for which you want to edit or change the default customized view.
3. Clear the Set as default or Set as global default check box, and click Save.
4. Open the report for which you want to change the default view and customize it
according to your needs.
5. Hover over the Configure View icon

, and click Save As. Specify the report name,

and select Set as default or Set as global default. Click Create.

Scheduling report notifications
You can configure report notifications to be sent to a list of recipients regularly or when a
specific number of items appears on a report. For example, when the number of computers
that have not reported to BigFix Inventory within the last seven days exceeds five. Thanks to
the automatic notifications, you are always up-to-date with changes in your environment.

Configuring the server to send mail notifications
To be able to schedule report notifications, you must first configure the BigFix Inventory
server to send mail notifications.
You must be an Administrator to perform this task.

1. Log in to BigFix Inventory.
2. In the top navigation bar, click Management > Mail Settings.
3. Specify the SMTP server to which you want to have the email notifications sent.
Important: The SMTP port must be open for communication with BigFix
Inventory.
4. Choose the port through which you want to have the email notifications sent.
5. Optional: To have the email encrypted, select Use STARTTLS.
6. Specify the domain through which you access the BigFix server.
7. Choose the authentication method.
8. In the From address field, specify the address that is displayed as the sender of the
email.
9. Optional: To check whether you correctly configured mail settings, click Send Test
Email.
10. To save the configuration, click Save.
You can now schedule report notifications to be sent automatically.

Scheduling report emails
You can schedule reports to be emailed to the specified recipients. This option is especially
useful if a person does not work with BigFix Inventory, or is not familiar with the application,
yet must have access to the reports.
Ensure that the BigFix Inventory server is configured to send mail notifications.
1. Open the report that you want to email, hover over Export, and click Schedule Export.
Important:
Reports that you want to email must be saved before they can be sent.
You can either save the report without changing its default view or create a
customized view. You can set only one schedule per a saved report. If you

try to set a next schedule, it replaces the previous one. For more information,
see:Creating saved report views.
2. Select the file format and adjust the page settings.
3. In the Email field, enter a comma-separated list of email addresses to which you want
to send the notifications.
4. Select the language of the report.
5. Select at least one option for emailing the report:
• Email on a regular basis
The report is emailed according to a daily, weekly, or monthly schedule.
Note: The start time for each report must differ by at least 5 minutes.
•

Email if the number of rows exceeds
The report is emailed only if a specific number of rows is exceeded. You can
customize a report to show only products for which PVU exceeds a particular
value. You will be notified whenever the specified number of items appears
on the report. This option is an additional notification and does not affect the
regular schedule.
Note: Reports based on conditions are emailed during data imports.

6. Click Save.
Starting from application update 9.2.15, report file names, including report files
that are scheduled to be emailed, follow a new naming convention. The file name consists
of the predefined or custom report name, the default report name, and the time stamp. For
example: My_Custom_Report-software-classification-20190215085933.csv.
Additionally, the email subject contains the name of the predefined or custom report. For
example: Scheduled Report 'My Custom Report' from BigFix Inventory.
To disable the export schedule, clear the Report Subscription check box and click Save.

Difference between Web Reports and BigFix Inventory software
discovery results
This topic explains the reason behind the difference between Web Reports and BigFix
Inventory software discovery results.
Web Reports (BES Inventory and License) and BigFix Inventory use different methods to
discover software. The time of capturing the details might be different too. This results in
the difference between doscovery results shared by Web Reports and BigFix Inventory.
The Web Reports (BES Inventory and License) runs number of analyses included in BES
Inventory and License site, which create a list of:
• Install / Uninstall programs
• Services
• Package registry
• Basic hardware information
BigFix Inventory performs a complete file system scan, complete registry scan, and
complete hardware scan, including virtualization capacity. BigFix Inventory uses BigFix
Inventory Software Catalog which contains thousands of software discovery signatures,
component definitions and their relations to software products, and a number of product
bundling information and licensing data.
BigFix Inventory is dedicated solution for Software Asset Management, whereas Web
Reports (BES Inventory and License) is a demonstration of BigFix Platform capabilities and
it includes set of analysis using BigFix inspectors to gather data from your environment.
BigFix Inventory discovers software based on defined signatures, even if the signatures
does not appear in the install registry (the reason the software only copied and not correctly
installed). BigFix Inventory supports industry standard ISO tags as well.
Below table shows the results for BES Inventory and License site analysis “Application
Information (Windows)” – property “Installed Applications – Windows” and BigFix Inventory

Parameter
Source of data

Installed Applications –

Mapping to BigFix Invento

Windows

ry

Several Keys of Windows

Majority of entries will

Registry including: HKEY_

overlap with Package Scan

USERS hive

available through Pack
age Data. Due to different
source there will be differ
ences.
HKEY_USERS are not in
cluded in Package Data
listing to work in-line with
BFI Scanner (CIT).

Optimized For

Actuals Only

Software Installation
Tracking

Execution Time

Daily

Weekly

Evaluated once a day and

Gather according to set up

reported to server

of Initiate Software Scan

Scan & Transfer:

action and then refreshed

2022-03-11 01:00 PM

daily. So, data might ap
pear next day in BigFix
Platform. After revealing in
BigFix Platform it is picked
up by BigFix Inventory Data
Import.
• Scan: 2022-03-11
01:00 PM
• Transfer: 2022-03-12
10:00 AM

Parameter

Installed Applications –

Mapping to BigFix Invento

Windows

ry
• Data Import:
2022-03-12 11:00 PM
• Available to user
in BFI: 2022-03-13
06:00 AM

Enterprise applications inventory
Software components are discovered during software scans. The scans correlate data
that is collected from the computers with the content of the software catalog, and thus
determine whether a component is installed. However, software scans do not discover
details of some enterprise applications, for example licensable options of Oracle Database
or editions of Microsoft Exchange. The details are discovered by dedicated fixlets. If you
are interested in discovering additional details of enterprise applications, run the dedicated
fixlets apart from scheduling software scans. Otherwise, running the fixlets is not required.
Software identification tag files for enterprise applications are stored in the following
directories:
• BESClient/LMT/ORACLE
• BESClient/LMT/SAP
• BESClient/LMT/MS/exchange
The software identification tag path that is provided in BigFix Inventory shows the product
installation path, and the tag name.
Starting from application update 9.2.9, the software identification tag path and
installation path are shown separately on condition that the paths are different and the
tag contains information about the installation path. Paths to software identification tags
discovered before version 9.2.9 might also be updated after the upgrade on condition that
sufficient data is available.

Discovering Microsoft SQL Server Edition
It is important to discover an edition of Microsoft SQL Server for measuring the license
utilization. When components of SQL Server are installed on Windows, the installer of SQL
Server does not put information about edition of this product in the Windows Uninstallation
Registry. Initiate Software Scan fixlet collects the edition information from Windows Server
configuration stored in Windows Registry. This edition information is added into Windows
Package information available in BigFix Inventory and used by signatures for Microsoft SQL
Server components.

Extended discovery of Oracle Database
You can retrieve granular information about the edition (Standard or Enterprise), options,
Management Packs (including Oracle Real Application Cluster, RAC), and user concurrent
sessions of Oracle Databases that are deployed in your environment. When you combine
this information with the collected hardware inventory data, you can use it to calculate the
demand for Oracle Database licenses. The functionality is supported for Oracle Database
versions 11.2, 12.1, 18.3, 19.0, and 21.0
Table 176. Discovered versions and editions of Oracle Database
Oracle Database ver
sion
21c
19c
18c
12c
11g

Supported operating
Edition

systems

Offering type

Oracle Database

Oracle Database is

On-premises

Standard Edition and discovered on the
Oracle Database En

following operating

terprise Edition

systems.
• AIX
• Linux
• Windows
• Solaris

Note: BigFix supports Oracle Database Standard Edition and Oracle Database
Enterprise Edition. Other editions for example, Oracle Database Cloud Service
Enterprise Edition - Extreme Performance, which should be executed in the cloud are
not supported.

Coverage of Oracle licensable options
Check which options can be discovered for a particular version of Oracle Database. The
options are discovered by the official Oracle SQL auditing script.
Table 177. Coverage of Oracle licensable options
Oracle
SQL
Licensable Options

script

for the Enterprise Edi
tion of Oracle Database

21c

19c

18c

Oracle Active Data Guard

Yes

Yes

Yes

Oracle Advanced Analytics

Yes

Yes

Yes

Oracle Advanced Compression

Yes

Yes

Oracle Advanced Security

Yes

Oracle Database In-Memory

12c

11g 11g cover

R1

R2

R1

age

Yes

Yes Yes Yes

Yes

Yes

Yes Yes Yes

Yes

Yes

Yes

Yes Yes Yes

Yes

Yes

Yes

Yes

Oracle Database Vault

Yes

Yes

Yes

Yes

Yes Yes Yes

Oracle Label Security

Yes

Yes

Yes

Yes

Yes Yes Yes

Oracle Multitenant

Yes

Yes

Yes

Oracle On-Line Analytical Pro

Yes

Yes

Yes

Yes

Yes Yes Yes

Yes

Yes

Yes

Yes

Yes Yes Yes

cessing (OLAP)
Oracle Partitioning

Table 177. Coverage of Oracle licensable options (continued)
Oracle
SQL
Licensable Options

script

for the Enterprise Edi
tion of Oracle Database
Oracle Real Application Clus

21c

19c

18c

12c

11g 11g cover

R1

R2

R1

age

Yes

Yes

Yes

Yes

Yes Yes Yes

Oracle Real Application Testing Yes

Yes

Yes

Yes

Yes Yes

Oracle Spatial and Graph

Yes

Yes

ters (Oracle RAC)
Oracle Real Application Clus
ters One Node

Yes

Management Packs
Total Recall

Yes

Data Mining

Yes Yes

Spatial

Yes

Warehouse Builder
Oracle Change Management

Yes Yes Yes

Pack
Oracle Configuration Manage

Yes Yes Yes

ment Pack
Oracle Diagnostic Pack

Yes

Yes

Yes

Yes

Yes Yes Yes

Tuning Pack

Yes

Yes

Yes

Yes

Yes Yes Yes

Oracle Provisioning and Patch
Automation Pack
Transparent Gateways

Yes Yes Yes

Table 177. Coverage of Oracle licensable options (continued)
Oracle
SQL
Licensable Options

script

for the Enterprise Edi
tion of Oracle Database

21c

19c

18c

12c

11g 11g cover

R1

R2

R1

age

Oracle Cloud Management
Pack for Oracle Database
Oracle Data Masking Pack for

Yes

Yes

Oracle Database Lifecycle Man Yes

Yes

Yes

Yes

Oracle and Non-Oracle Data
bases

agement Pack for Oracle Data
base
In-Memory Database Cache
Oracle TimesTen Applica

Yes

Yes

Yes

tion-Tier Database Cache

Discovering usage of Oracle Database features
To retrieve detailed information about Oracle Database editions, options and management
packs that are used in your infrastructure, distribute the Oracle reporting script on relevant
endpoints, and run the Get Oracle Features task. When the information is imported to BigFix
Inventory, it is displayed on the Oracle Databases report.
The task establishes Oracle database connection as a user that has rights to run the BigFix
Agent process. Ensure that this user has the Oracle SYSDBA privilege.
The discovery of Oracle Database editions, options and management packs is based on
the use of one of the Oracle scripts: options_packs_usage_statistics.sql or
ReviewLite.sql. The former should be used by default. Both scripts retrieve information
about usage of Oracle features.

Note: BigFix Inventory supports ReviewLite.sql 17.1 and higher. Certification
was performed on version 17.1 and 17.2.
The ReviewLite.sql script is used mostly in case of an audit, review, or contract renewal.
It additionally gathers data that might be required by the Oracle License Management
Services (LMS) and uploads it to the BigFix server. The ReviewLite.sql script produces
the options.csv file which might contain data that is not entirely accurate and require
confirmation from Oracle LMS. Based on the options.csv file, BigFix Inventory might
detect usage or potential usage of Oracle features.
The following examples show the potential usage of Oracle features :
• Potential use of Tuning Pack or Real Application Testing might be reported based on
the data from SQL Tuning Sets. If they are contained in the results, the Tuning Pack or
Real Application Testing license is required.
• Potential use of Diagnostic Pack might be reported based on
control_management_pack_access data if the value of
control_management_pack_access is DIAGNOSTIC or DIAGNOSTIC+TUNING.
1. Choose the type of the Oracle script that you want to use to discover features of the
used Oracle databases, and download it.
You can choose options_packs_usage_statistics.sql or ReviewLite.sql.
• If you choose options_packs_usage_statistics.sql, download the
script from the Oracle support website. If the script is not available under this
link, refer to Oracle documentation specific to your version of the database for
more information:
◦ Oracle Database 12c
◦ Oracle Database 11g

Important: To download the script, you must have a valid Oracle
account. For any concerns, contact Oracle support.
• If you choose ReviewLite.sql, you must have a valid Oracle account. It is
recommended that you contact Oracle License Management Services to ensure
good cooperation.
2. Propagate the downloaded script to all computers on which you want to discover
usage of Oracle features. You can propagate the script in one of the following ways.
• Use the method of propagating files that is typical in your enterprise. Place the
script in the following directory: <BES Client>\LMT.
• Add the script to the Master Action Site and send it to all computers in your
enterprise.
a. In the top navigation bar of the BigFix console, click Tools > Add Files to
Site.
b. From the drop-down list, choose Master Action Site.
c. Click Browse and go to the directory in which the script is located.
d. Select the script and click Open.
e. Select Send to clients and click Add files. The script is sent to all
computers that are subscribed to the Master Action site.
• Create a custom site to which you subscribe computers on which you want to
discover the used features. Then, add the script to this site and send it to the
subscribed computers.
a. In the top navigation bar of the BigFix console, click Tools > Create
Custom Site. Provide the name of the custom site that begins with
"Oracle", and click OK.
b. Open the Computer Subscriptions tab, and subscribe computers on which
you want to discover usage of Oracle features. For example, you can
choose Computers which match the condition below, select Relevance
Expression, is true, and provide the following relevance expression.
if (name of operating system as lowercase starts with
"win")

then (exists services whose (display name of it starts with
"Oracle" and not ("Client" is contained by display name of
it)))
else (exists process whose (name of it = "oracle"))

c. In the top navigation bar of the BigFix console, click Tools > Add Files to
Site.
d. From the dropdown list, choose the custom site that you created.
e. Click Browse and go to the directory in which the script is located.
f. Select the script and click Open.
g. Select Send to clients and click Add files. The script is sent to all
computers that are subscribed to the custom site.
3. To retrieve information about features of the used Oracle databases, log in to the
BigFix console, and go to Sites > External Sites > BigFix Inventory v10 > Fixlets and
Tasks. Then, click Get Oracle Features.
4. Choose the type of the Oracle script that you downloaded in step 1.
If you choose ReviewLite.sql, read and accept the license agreement related to
the Oracle script.
You can find the license terms in the script or you can print them to the console by
running the following script on the Oracle database.

sqlplus <user_name>/<password> @ReviewLite.sql

When you print the license terms, you are asked whether you accept them. You can
ignore this question as you confirm that you accept the terms by selecting Accept
License Agreement in the Get Oracle Features task. By selecting this option, you also
agree that BigFix will accept the script license on your behalf on all computers on
which you run the Get Oracle Features task.

5. Optional: To enable debug logging, select Debug mode.
The information is logged in the script_trace.txt file. By default, the file is in the
following location.
•

/var/opt/BESClient/LMT/ORACLE

•

C:\Program Files (x86)\BigFix Enterprise\BES Client
\LMT\ORACLE

6. Optional: On Unix endpoints, you can change the folder in which the temporary script
used by the fixlet is created. By default, it is Oracle instance owner's default folder. In
case there is a security policy in place which forbids keeping executable scripts in this
folder, you can select a subfolder of /tmp folder.
7. To run the task, click Take Action. On the Target tab, select computers from which you
want to retrieve the information, and click OK.
8. Ensure that software identification tags scan and upload of its results are scheduled.
For more information, see: Initiating software scans and Uploading software scan
results.
9. To make the data available in BigFix Inventory, wait for the scheduled import of data
or run it manually.

Information about the used features is available on the Oracle Databases report. It is also
included on the Software Installations report.
Additionally, raw output of the script is sent to the to BigFix
server. It can be found in the following directory: <BigFix
Enterprise>\BES Server\UploadManagerData\BufferDir

\sha1\<last_2digits_of_computer_ID>\<computer_ID>\oracleresults_0_<computer_ID>
Starting from version 10.0.11, pluggable databases (CDB/PDB) can be
distinguished. The below image shows the detected licensable options grouped by the
database, on which they were detected. The image also shows the theta database instance,
which has CDB root named CDB$ROOT and pluggable database THETAPDB. Databases without
multitenancy are not renamed, such as beta database. Databases prior to version 12 are
named after the name of the instance.

Metering the number of Oracle Database concurrent sessions
To retrieve detailed information about the number of Oracle Database concurrent user
sessions that run on the computers in your environment, use the Get Oracle Concurrent

Sessions Number fixlet. When the data is imported to BigFix Inventory, it is displayed in the
Resource Utilization report.
The task establishes Oracle database connection as the LocalSystem user on Windows,
or as the database instance owner on Linux, AIX or Solaris. Ensure that this user has the
Oracle SYSDBA privilege.
BigFix Inventory supports metering of Named User Plus license consumption. Run this task
to retrieve information about the current number of concurrent sessions, and the high water
mark value of concurrent sessions for Oracle Databases that are installed on the computers
in your infrastructure. These values are individually retrieved for each database instance
with the following SQL query.
SELECT sessions_highwater, sessions_current FROM v$license;

The database instance must be running when the task is executed. Otherwise, the values
of high water mark, and current number of sessions equal 0 in the report. After you run this
task, the data is collected on a daily basis by default, to preserve the high water mark value
that is reset after each database instance restart.
For more information about the Oracle licenses, see: Oracle Database Licensing.
1. Log in to the BigFix console.
2. In the navigation bar, click Sites > External Sites > BigFix Inventory v10 > Fixlets and
Tasks.
3. In the upper right pane, select Get Oracle Concurrent Sessions Number.
4. Optional: To enable debug logging, select the Debug mode check box.
The information is logged in the script_trace_sessions.txt file that is, by
default, in the following location.
/var/opt/BESClient/LMT/ORACLE
C:\Program Files (x86)\BigFix Enterprise\BES Client\LMT
\ORACLE
5. Optional: On Unix endpoints, you can change the folder in which the temporary script
used by the fixlet is created. By default, it is Oracle instance owner's default folder. In

case there is a security policy in place which forbids keeping executable scripts in this
folder, you can select a subfolder of /tmp folder.
6. To run the task, click Take Action. On the Target tab, select computers from which you
want to retrieve the information, and click OK.
7. Ensure that the software scans are enabled, and run automatically. If not, run the
software scan manually. Select the Resource Utilization Scan.
8. Ensure that the scan results are automatically uploaded. If not, upload the results to
the BigFix server manually.
9. To make the data available in BigFix Inventory, wait for the scheduled import of data,
or run it manually.
The retrieved data about the Oracle database concurrent sessions is listed in the Resource
Utilization report. To view the data, log in to BigFix Inventory, and go to Reports > Resource
Utilization.

Handling common situations with extended oracle discovery
BigFix Inventory version 10.0.11 offers improvements related to serviceability.
Fixlet execution ends up with an exit code in the 'Computers' tab for each endpoint on which
it was executed. Each exit code represents a common probable situation.
The topic provides information about how you can handle those common situation:
• check the exit code
• check analysis results
• check logs on a machine or get them from Computer Support Data
• contact support (HCL or Oracle as per the need)

Get Oracle Feature Fixlet results
When you activate the Get Oracle Feature fixlet, two types of results are received; Failed
or Completed. The below image shows both the scenarios where some of the scan is
complete and some have failed. The details, such as Exit code, computer name that were
scanned, the operating systesm, the CPU, last report time, etc, are also displayed.

Exit codes
The Extended Oracle Discovery feature in BigFix Inventory exit codes which provide
feedback about issues occurred when you run the scan for databases.
The below table lists the exit codes and their descriptions:
Exit code

Description

0 - Everything went fine

Configuration Management Pack

1 - Generic error

This is a generic error, which means there was some
issue/problem which caused the program to exit.

2 - Misuse of Shell Built-in

Could be caused by incompatibility with older sys

command

tems. Command options differ between operating sys
tems.
This error could be shown especially on older systems
attempting to use the command option, which simply
does not exist, but on a newer system.

10 - Database querying prob Oracle Database error codes start with ORA- prefix,
lem

this code shows what happened. Refer to the Oracle
website to view the list of error codes.

Exit code

Description
The error could be thrown when the syntax of SQL
queries changes, and the query could be incompatible
with a newer database engine.
Additionally, Oracle Database views change from re
lease to release.
Oracle databases could be in 4 states: started, mount
ed, open, and restricted.
Only in an open state, all database views are available
to query.
When the auditing script tries to read these views, but
the database is not open output files will have many
errors:
ORA-01219: database not open: queries allowed on
fixed tables/views only
Because of the inability to interpret data properly in
that situation, the fixlet will exit with an error.

11 - Cannot find output from

This could be shown on the windows operating sys

database listing query

tem due to file permissions, fixlet is not able to save
output files properly.

20 - sqlplus failed at connect There might be a problem with the authorization or a
ing to the database

direct problem with sqlplus command execution.
Handling on the usage of sqlplus in this situation fails
faster when a problem occurs.
Database admin, for example, can forbid access for
the service user which we are trying to use, this will ap
pear as an authorization problem.

Exit code

Description

30 - Cannot map a user to a

On UNIX operating systems during the database

system username

recognition step, fixlet tries to use the security privi
leges user which started the database. This user is the
service user used to access the Oracle database. For
example, when the database process is executed in a
container.
On Solaris with Zones probably scan is executed in
Global Zone, which will not be able to proceed when
Oracle Database will be executed in Local Zones.
BigFix Agent should be installed in the same Zone in
which the Oracle Database process is executed.

127 - A command couldn’t be On some command execution, the operating system
found

checks PATH to find the binary, but it fails.
For example, when a user has changed the PATH envi
ronment variable, there is nothing to point to.

Oracle Features Health Check fixlet results
To check whether the task completed successfully or to troubleshoot a problem, go to
Analyses, right-click Oracle Features Health Check, and then click Activate. The analysis
provides information about the type and version of Oracle script that was initiated though
the Get Oracle Features fixlet. It also provides information about the time of last execution
of the fixlet, and its status: Success, Failure or Partial Success. If the status is Partial
Success, the script was run successfully only on some Oracle instances on a given
computer.

Obtain Get Oracle Feature Fixlet logs
You can obtain the fixlet logs in the below location:
•

/var/opt/BESClient/LMT/ORACLE
The fixlets logs are available in the oracle.log file. When debug mode mode is
enabled more detailed information is saved in same file.

•

C:\Program Files (x86)\BigFix Enterprise\BES Client\LMT
\ORACLE
The fixlets logs are available in the oracle.log file. When debug mode is enabled,
the debug pieces of information are saved in script_trace.txt.

For more information on obtaining logs, refer to Collecting logs for troubleshooting
purposes.

Discovering Microsoft Exchange edition
Available from 9.2.6. To retrieve detailed information about Microsoft Exchange
servers that are installed in your infrastructure, run the Get Microsoft Exchange Edition
fixlet. The data is collected, imported to BigFix Inventory, and displayed in the Software
Installations report.

The discovery of Microsoft Exchange edition is only applicable to the computers with the
Microsoft Exchange server installed. The server does not need to be running during this
task.
The following Microsoft Exchange versions are supported: 2007 (only 64bit version),
2010, 2013, 2016. The Microsoft Exchange edition is obtained through the cmdlet GetExchangeServer from Exchange Management Shell. For more information, see: Exchange

Server Updates: build numbers and release dates.
1. Log in to the BigFix console.
2. In the navigation bar, click Sites > External Sites > BigFix Inventory v10 > Fixlets and
Tasks.
3. In the upper right pane, select Get Microsoft Exchange Edition.
4. To run the task, click Take Action. On the Target tab, select computers from which you
want to retrieve the information, and click OK.
5. Ensure that the software scans are enabled, and run automatically. If not, run the
software scan manually. Select the Software identification tags scan.
6. Ensure that the scan results are automatically uploaded. If not, upload the results to
the BigFix server manually.
7. To make the data available in BigFix Inventory, wait for the scheduled import of data,
or run it manually.
The discovered Microsoft Exchange editions are listed on the Software Installations report.
To view the data, log in to BigFix Inventory, and go to Reports > Software Installations.
Notice: After you activate the Get Microsoft Exchange Edition fixlet, the Microsoft
Exchange instances are duplicated on the Software Installations report. The reason
behind the duplication is the dual detection. The Microsoft Exchange is included
in the software catalog, and thus, detected as a standard installation. During the
edition discovery, a separate line is added to the report that provides information
about the Microsoft Exchange edition.
You can filter the report to remove the redundant lines.

Measuring license metric utilization of VMware products
Available from 9.2.7. BigFix Inventory allows you to retrieve granular information
about license metric utilization of VMware vCenter and vSphere in your infrastructure.
The resource utilization data is collected by the VM Manager Tool and displayed on the
Resource Utilization report.

Enabling metric calculation of VMware products (basic VM
management)
Available from 9.2.7. You can calculate license metric utilization of the VMware
products: vCenter and vSphere in standard environments where the VM managers are
centralized and configured through user interface. Use basic (central) VM management to
enable data retrieval.
To collect granular information about the license metric utilization of VMware vCenter and
vSphere
• Update the VM Manager tool to the newest version. Metric calculation of VMware
products is supported starting from version 1.5.0.0.
• Ensure you have BigFix Inventory version 9.2.1 or higher.
• Ensure that the user defined for the VMware connection has Global.Licenses
permission.
Note: The API for retrieving the license data is available starting from vSphere API
4.0. The resource utilization is collected only for the VMware installations that are
defined as VM managers for BigFix Inventory.
When you enable license metric calculation of VMware vCenter and vSphere, the .slmtag
files are created locally on the machine running VM Manager tool and collected by the
resource utilization scan.
1. Log in to BigFix Inventory.
2. Go to Management > Advanced Server Settings.

3. Set the vmman_slm_tags_enabled parameter to true, and click Save.
4. Optional: To specify the maximum size of each VMware .slmtag file, configure the
vmman_slm_tags_file_size_limit parameter value, and click Save.
5. Optional: To specify the maximum number of VMware .slmtag files that are
stored on the computer for each license key under VMware instance, configure the
vmman_slm_tags_files_per_software parameter value, and click Save.
6. The data will be available in BigFix Inventory after the next resource utilization scan
and data import.
To view license metric utilization, log in to BigFix Inventory and navigate to Reports >
Resource Utilization.
The following columns are specific to the VMware vCenter and vSpere license metric
utilization data:
• Computer Name always shows a name of the computer where the VM Manager tool
is installed.
• Software Name shows the name and the version of the software with additional
information about license.
• Metric Subtype indicates if the count refers to the license metric utilization or overall
license capacity. The column shows one of two values. USED refers to the license
metric utilization of the specified license on a particular machine. CAPACITY reflects
the limit agreed in this license. The number is specified in Maximal Trend Value
column.

Note: The maximal trend value for unlimited licenses is always set to 999,999.
• Instance shows the instance identifier that consists of:
◦ License key, for example: P142Q-08L40-H8041-013RP-CHPQ1
◦ Machine type: virtual center or ESX box.

Virtual center refers to the entire vSphere infrastructure for which VM manager
connection is defined. The number of used licenses for virtual center shows the
license metric utilization for all the boxes within this center. Virtual center can
consist of more than one ESX, or ESXi box. VM manager can connect directly to
the ESX, or ESXi box. Then, the displayed license metric utilization is calculated
for each individual box.
License utilization is reported for the VMware connection that is defined in
BigFix Inventory. Thus, if you define the virtual center connection, the .slmtag
files are generated for this center, not individual ESX, or ESXi boxes.
Note: One license key can be shared between different virtual centers.
Therefore, license metric utilization might not represent the entire
license consumption.
◦ Host name, for example: 198.51.100.0
To enable the Instance column, hover over the Settings icon

, and click Configure

View.
To disable the license metric calculation of the VMware products, change the
vmman_slm_tags_enabled parameter value to false. The collected data will no longer be
retrieved, however, the historical data will still be displayed on the Resource Utilization
report.

Enabling metric calculation of VMware products (advanced VM
management)
Available from 9.2.7. You can calculate license metric utilization of the VMware
products: vCenter and vSphere in complex environments where the VM managers are
distributed across separated networks. Use advanced (distributed) VM management to
enable data retrieval.
To collect granular information about the license metric utilization of VMware vCenter and
vSphere

• Update the VM Manager tool to the newest version. Metric calculation of VMware
products is supported starting from version 1.5.0.0.
• Ensure you have BigFix Inventory version 9.2.1 or higher.
• Ensure that the user defined for the VMware connection has Global.Licenses
permission.
Note: The API for retrieving the license data is available starting from vSphere API
4.0. The resource utilization is collected only for the VMware installations that are
defined as VM managers for BigFix Inventory.
When you enable the license metric calculation of VMware vCenter and vSphere, the .slmtag
files are created locally on the machine running VM Manager tool and collected by the
resource utilization scan.
1. On the computer where VM Manager tool is installed, go to the BES Client\LMT
\VMMAN\config directory.
2. Open and edit the vmmmainconf.properties file.
3. Set the vmm_slm_tags_enabled parameter to true.
vmm_slm_tags_enabled=true

If the parameter does not appear in the properties file yet, add the line above to this
file. For more information, see: VM Manager Tool settings.
4. Optional: To specify the maximum size of each VMware .slmtag file, configure the
vmm_slm_tags_file_size_limit parameter value.
5. Optional: To specify the maximum number of VMware .slmtag files that are
stored on the computer for each license key under VMware instance, configure the
vmm_slm_tags_files_per_software parameter value.
6. Save the file.
7. Go to BES Client\LMT\VMMAN.
8. Run the following command in the command-line interface.
•

./vmman.sh -reloadconfig

•

vmman.bat -reloadconfig

For more information, see: VM Manager tool command-line options.
9. The data will be available in BigFix Inventory after the next resource utilization scan
and data import.
To view license metric utilization, log in to BigFix Inventory and navigate to Reports >
Resource Utilization.
The following columns are specific to the VMware vCenter and vSpere license metric
utilization data:
• Computer Name always shows a name of the computer where the VM Manager tool
is installed.
• Software Name shows the name and the version of the software with additional
information about license.
• Metric Subtype indicates if the count refers to the license metric utilization or overall
license capacity. The column shows one of two values. USED refers to the license
metric utilization of the specified license on a particular machine. CAPACITY reflects
the limit agreed in this license. The number is specified in Maximal Trend Value
column.

Note: The maximal trend value for unlimited licenses is always set to 999,999.
• Instance shows the instance identifier that consists of:
◦ License key, for example: P142Q-08L40-H8041-013RP-CHPQ1
◦ Machine type: virtual center or ESX box.
Virtual center refers to the entire vSphere infrastructure for which VM manager
connection is defined. The number of used licenses for virtual center shows the
license metric utilization for all the boxes within this center. Virtual center can
consist of more than one ESX, or ESXi box. VM manager can connect directly to
the ESX, or ESXi box. Then, the displayed license metric utilization is calculated
for each individual box.

License utilization is reported for the VMware connection that is defined in
BigFix Inventory. Thus, if you define the virtual center connection, the .slmtag
files are generated for this center, not individual ESX, or ESXi boxes.
Note: One license key can be shared between different virtual centers.
Therefore, license metric utilization might not represent the entire
license consumption.
◦ Host name, for example: 198.51.100.0
To enable the Instance column, hover over the Settings icon

, and click Configure

View.
To disable the license metric calculation of the VMware products, change the
vmm_slm_tags_enabled parameter value to false. The collected data will no longer be
retrieved, however, the historical data will still be displayed on the Resource Utilization
report.

Discovering and measuring SAP
You can discover components of SAP Business Suite that are installed on Linux and AIX
computers in your infrastructure. You can also collect license metric utilization data from
SAP landscapes and integrate it with your other resources on the Resource Utilization
report. Discovery and measuring are two separate processes that do not impact each other.

Discovering
BigFix Inventory discovers components of SAP Business Suite that are installed on Linux
and AIX computers. These components are listed on the Software Classification report, and
can be assigned to appropriate products. It allows you to manage SAP products that are
installed in your environment.

Measuring
The dedicated SAP Metric Data Collector collects information about the license metric
utilization of SAP ABAP-based products. The data is available on the Resource Utilization

report. The report shows the maximum metric utilization and its trend value over the last 30
days.

Discovering SAP components
Available from 9.2.7. To discover SAP components on Linux and AIX computers
in your infrastructure, run the Get SAP Components fixlet. The data is collected, imported to
BigFix Inventory, and displayed on the Software Classification panel.
The discovery of SAP components is supported on Linux and AIX systems.
BigFix Inventory discovers SAP Business Suite components that are based on SAP
NetWeaver 7.x; for example, the application server, cross-application components and
applications. For more information about SAP component hierarchy, see: Software
Components in SAP ERP.
If multiple instances of SAP are installed on the same computer, all of these instances are
discovered. The task is relevant only to the computers where SAP is installed.
1. Log in to BigFix console.
2. In the navigation bar, click Sites > External Sites > BigFix Inventory > Fixlets and
Tasks.
3. In the upper right pane, select Get SAP Components.
4. Optional: Select the Retrieve information about SAP subcomponents check box to
additionally discover SAP sub-components.
5. To run the task, click Take Action. On the Target tab, select computers from which you
want to retrieve the information, and click OK.
6. Ensure that the software scans are enabled, and run automatically. If not, run the
software scan manually. Select the Software identification tags scan.
7. Ensure that the scan results are automatically uploaded. If not, upload the results to
the BigFix server manually.
8. To make the data available in BigFix Inventory, wait for the scheduled import of data,
or run it manually.

The discovered SAP components are listed on the Software Classification panel. To view
the data, log in to BigFix Inventory, and go to Reports > Software Classification. The
component name is extended with a short description. You can classify these components
by manually assigning them to appropriate products.

In case of any inconsistencies or issues, log in to BigFix console, select Actions, and choose
Get SAP Components from the list. Check the exit code:
• 0 - Completed. Action successful.
• 1 - Failed. Action failed.
• 2 - Completed. Action partially completed. Some SAP instances did not return any
data.
For more information, see the following log file that is located on the computer where SAP
is installed:
/var/opt/BESClient/LMT/SAP/discover_sap.log

Measuring and collecting the license metric utilization of SAP
Available from 9.2.9. BigFix Inventory allows you to retrieve granular information
about license metric utilization of SAP ABAP-based products. The utilization data is
collected by the SAP Metric Data Collector and displayed on the Resource Utilization
report. SAP Metric Data Collector retrieves the license utilization data available in License
Administration Workbench in SAP.

Collecting utilization of SAP license metrics
Available from 9.2.9. Thanks to SAP Metric Data Collector, you can view the
license metric utilization of SAP ABAP-based products in BigFix Inventory. In this scenario,
the utilization data is retrieved from the central SAP system, uploaded into BigFix Inventory,
and displayed on the Resource Utilization report.
• You can install SAP Metric Data Collector on any computer, not necessarily the
computer where the BigFix Inventory server or SAP is installed. However, the
computer must meet the following requirements:
◦ Runs on Windows x86 (64-bit) or Red Hat Linux x86 (64-bit). Linux version
requires the unzip executable.
◦ Has at least 250 MB of free disk space.
◦ Can connect through RFC to the central SAP system that consolidates
utilization data in SAP License Administration Workbench (LAW).
• Ensure that the SAP landscape meets the following criteria:
◦ The licensing data that is consolidated in the central SAP system is up-to-date.
◦ A user account with permissions to run end-to-end functions of LAW or LAW 2.0
exists on the central SAP system.
◦ License utilization data can be processed with either LAW or LAW 2.0.

The SAP ABAP-based products use the licensing model that consists of two types of
licenses: software packages and named users.
Each SAP system measures utilization of SAP license metrics. The measurements from all
SAP systems in the landscape are transferred to the central SAP and combined into one
LAW report. To collect the report, SAP Metric Data Collector establishes an RFC connection
with the SAP License Administration Workbench (LAW) that is located on the central SAP
system. Information about license metric utilization from the report is displayed in BigFix
Inventory on the Resource Utilization report.

Support for License Administration Workbench 2.0
LAW 2.0 allows you to manually declare engine usage information. SAP Metric Data
Collector retrieves these self-declared details as well.
LAW 2.0 allows the creation and storage of multiple consolidations. SAP Metric Data
Collector uses the current consolidation if it is in the Consolidated status. If no current
consolidation is applicable, the tool retrieves the completed consolidation that has been
modified last. The completed consolidation must be in Sent to SAP or Closed status.
SAP Metric Data Collector supports LAW and LAW 2.0. If both versions are installed on the
central SAP system, SAP Metric Data Collector determines which instance of LAW to use by
checking the target of RFC actions in LAW 2.0 settings.
1. Install SAP Metric Data Collector.
a. Log in to the BigFix console.
b. In the navigation bar, click Sites > External Sites > BigFix Inventory > Fixlets and
Tasks.
c. In the upper right pane, select Install SAP Metric Data Collector, and click Take
Action.
d. Select the computer on which you want to install SAP Metric Data Collector, and
click OK.

2. Download the 64-bit version of the SAP Java Connector from http://support.sap.com/
en/product/connectors.html. Unpack it to the following directory on the computer
where you installed SAP Metric Data Collector:
•

/var/opt/BESClient/LMT/SAPTOOL/lib/sapjco3

•

C:\Program Files (x86)\BigFix Enterprise\BES Client
\LMT\SAPTOOL\lib\sapjco3

The following files, which are included in the package, are required to collect SAP
utilization:
•

sapjco3.jar, libsapjco3.so

•

sapjco3.jar, sapjco3.dll

Make sure that these files are located directly in the sapjco3 directory.
Note: Log in to http://support.sap.com/en/product/connectors.html with your
SAP S User ID and password.
3. If you use LAW 2.0, install the ABAP plug-in that is delivered with SAP Metric Data
Collector on a central SAP system.
a. Copy the following file from the SAP Metric Data Collector installation directory:
•

/var/opt/BESClient/LMT/SAPTOOL/trans/cofiles/
K900041.BF1

•

C:\Program Files (x86)\BigFix Enterprise\BES
Client\LMT\SAPTOOL\trans\cofiles\K900041.BF1

b. Paste the file to the trans/cofiles directory in the directory where SAP is
installed on the central SAP system.
c. Copy the following file from the SAP Metric Data Collector installation directory:
•

/var/opt/BESClient/LMT/SAPTOOL/trans/data/
R900041.BF1

•

C:\Program Files (x86)\BigFix Enterprise\BES
Client\LMT\SAPTOOL\trans\data\R900041.BF1

d. Paste the file to the trans/data directory in the directory where SAP is
installed on the central SAP system.
e. Run the STMS SAP t-code on the central SAP system and import the incoming
transport request. Select the Ignore Invalid Component Version option if needed.
After the import, check the transport logs to ensure that it was successful.
4. Manually configure SAP Metric Data Collector. Use the template.sapsystem file to
create the <host_name>.sapsystem file that defines the central SAP system in the
landscape.
Important: You must not remove the template.sapsystem file from the
config directory.
a. Open the template.sapsystem file that is located in the following directory.
•

/var/opt/BESClient/LMT/SAPTOOL/config

•

C:\Program Files (x86)\BigFix Enterprise\BES
Client\LMT\SAPTOOL\config

b. Save the file as <host_name>.sapsystem in the config directory. Do not
overwrite the template.
c. Specify all parameters, and save the file. For more information, see: SAP Metric
Data Collector configuration parameters.
5. To complete the configuration of SAP Metric Data Collector, edit the
saptool_config.properties file that is located in the following directory:
•

/var/opt/BESClient/LMT/SAPTOOL/config

•

C:\Program Files (x86)\BigFix Enterprise\BES Client
\LMT\SAPTOOL\config

a. Specify the landscape_name parameter. The landscape name is displayed on
the Resource Utilization report in the Instance column.
b. To collect data without triggering measurements, set the value of the
skip_measurements parameter to true and save the file. If you want to automate

the measurements, see: Measuring and collecting utilization of SAP license
metrics.
For more information about configuration, see: SAP Metric Data Collector
configuration parameters.
6. Optional: To test the connection to SAP and the correctness of data provided in the
configuration file, run the following script with the -testconnection parameter.
•

/var/opt/BESClient/LMT/SAPTOOL/saptool.sh
-testconnection

•

C:\Program Files (x86)\BigFix Enterprise\BES Client
\LMT\SAPTOOL\saptool.bat -testconnection

Apart from testing the connection, the -testconnection parameter encrypts the
password of the SAP user account. If you do not run the connection test, the
password will be encrypted when you run SAP Metric Data Collector.
To verify whether the connection test was successful, check the return code in the
trace.log file that is located in the following directory:
•

/var/opt/BESClient/LMT/SAPTOOL/logs

•

C:\Program Files (x86)\BigFix Enterprise\BES Client
\LMT\SAPTOOL\logs

The return code that is provided in the log file can differ from the code in SAP Metric
Data Collector Information analysis. The analysis does not provide a return code for
the connection test. For more information and the meaning of the return codes, see:
Troubleshooting SAP Metric Data Collector.
7. Initiate the collection of SAP metric data.
a. Log in to the BigFix console.
b. In the navigation bar, click Sites > External Sites > BigFix Inventory > Fixlets and
Tasks.
c. In the upper right pane, select Initiate Collection of SAP Metric Data, and click
Take Action.
d. Select the computer on which SAP Metric Data Collector is installed, and click
OK.

Tip: By default, the Initiate Collection of SAP Metric Data fixlet is
scheduled to run every 30 days. The fixlet starts the collection of
the utilization data, which can still be in progress after the fixlet is
completed.
To schedule the fixlet to run periodically, select it, click Take Action and
go to the Execute tab. Select the Reapply this action check box, and
specify the frequency.
To check the status of SAP metric data collection at any point, activate
the SAP Metric Data Collector Information analysis.
8. Ensure that the software scans are enabled, and run automatically. If not, run the
software scan manually. Select the Resource utilization scan.
9. Ensure that the scan results are automatically uploaded. If not, upload the results to
the BigFix server manually.
10. To make the data available in BigFix Inventory, wait for the scheduled import of data,
or run it manually.
License metric utilization data is displayed on the Resource Utilization report. The report
shows the following metrics:
• Named users metric
• Other metrics that are related to the software packages license
On the SAP audit report, metrics are reported for a specified period, or not. BigFix Inventory
reports these metrics as follows.
• If a metric is reported by SAP for a specified period, BigFix Inventory reports this
metric for that period.
• If a metric is not reported by SAP for a specified period, BigFix Inventory reports this
metric for the period since the previous collection of SAP metric data.
• If a metric is not reported by SAP for a specified period and you collect the SAP metric
data for the first time, BigFix Inventory reports this metric for the last 30 days.

Related information
Changing the default secret key and password to the SAP Metric Data
Collector keystore

Measuring and collecting utilization of SAP license metrics
Available from 9.2.10. Thanks to SAP Metric Data Collector and the installation
of ABAP plug-in, you can automatically measure the license metric utilization of SAP
ABAP-based products, and then view the data on the Resource Utilization report in BigFix
Inventory. In this scenario, SAP Metric Data Collector connects to each SAP system in the
landscape and initiates measurements. Then, the tool manages the consolidation of data
and integrates the results with BigFix Inventory.
• You can install SAP Metric Data Collector on any computer, not necessarily the
computer where the BigFix Inventory server or SAP is installed. However, the
computer must meet the following requirements:
◦ Runs on Windows x86 (64-bit) or Red Hat Linux x86 (64-bit). Linux version
requires the unzip executable.
◦ Has at least 250 MB of free disk space.
◦ Can connect through RFC to all SAP systems to collect the data required for
calculating the license metric utilization.
• You should install the HCL-provided ABAP plug-in only on the central SAP system.
• Ensure that the SAP landscape meets the following criteria:

◦ Configuration of Clients, Price Lists and User Types in System Measurement
dialog, which can be accessed via USMM transaction code (t-code), is up-to-date
on all the SAP systems.
◦ A dedicated user account with permissions to run USMM transaction exists on
each SAP system.
◦ A user account with permissions to run USMM transaction and end-to-end
functions of License Administration Workbench (LAW) exists on the central SAP
system.
◦ License utilization data must be processed with LAW. If you use LAW 2.0, see:
Collecting utilization of SAP license metrics.
The SAP ABAP-based products use the licensing model that consists of two types
of licenses: software packages and named users. BigFix Inventory uses a native
SAP functionality for determining utilization of these license metrics called System
Measurement and License Administration Workbench.
SAP Metric Data Collector connects to all SAP systems in the landscape through RFC,
automatically initiates measurements, and retrieves the results. Next, SAP Metric Data
Collector uses the ABAP plug-in to upload the results onto the central SAP system, and
manage automatic user grouping and data consolidation in License Administration
Workbench to produce a LAW report. SAP Metric Data Collector gathers the report data, and
transfers it to BigFix Inventory. Information about license metric utilization from the report is
displayed in BigFix Inventoryon the Resource Utilization report .

1. Install SAP Metric Data Collector.
a. Log in to the BigFix console.
b. In the navigation bar, click Sites > External Sites > BigFix Inventory > Fixlets and
Tasks.
c. In the upper right pane, select Install SAP Metric Data Collector, and click Take
Action.
d. Select the computer on which you want to install SAP Metric Data Collector, and
click OK.
2. Download the 64-bit version of the SAP Java Connector from http://service.sap.com/
connectors. Unpack it to the following directory on the computer where you installed
SAP Metric Data Collector:
•

/var/opt/BESClient/LMT/SAPTOOL/lib/sapjco3

•

C:\Program Files (x86)\BigFix Enterprise\BES Client
\LMT\SAPTOOL\lib\sapjco3

The following files, which are included in the package, are required to collect the SAP
utilization data:
•

sapjco3.jar, libsapjco3.so

•

sapjco3.jar, sapjco3.dll

Make sure that these files are located directly in the sapjco3 directory.
Note: Log in to http://service.sap.com/connectors with your SAP S User
ID and password. You must comply with the license terms of the SAP
Connectors.
3. Install the ABAP plug-in that is delivered with SAP Metric Data Collector on a central
SAP system.
a. Copy the following file from the SAP Metric Data Collector installation directory:
•

/var/opt/BESClient/LMT/SAPTOOL/trans/cofiles/
K900041.BF1

•

C:\Program Files (x86)\BigFix Enterprise\BES
Client\LMT\SAPTOOL\trans\cofiles\K900041.BF1

b. Paste the file to the trans/cofiles directory in the directory where SAP is
installed on the central SAP system.
c. Copy the following file from the SAP Metric Data Collector installation directory:
•

/var/opt/BESClient/LMT/SAPTOOL/trans/data/
R900041.BF1

•

C:\Program Files (x86)\BigFix Enterprise\BES
Client\LMT\SAPTOOL\trans\data\R900041.BF1

d. Paste the file to the trans/data directory in the directory where SAP is
installed on the central SAP system.
e. Run the STMS SAP t-code on the central SAP system and import the incoming
transport request. Select the Ignore Invalid Component Version option if needed.
After the import, check the transport logs to ensure that it was successful.
4. Define the connection to each SAP system in the landscape by configuring
a set of parameters. Use the template.sapsystem file to create the
<host_name>.sapsystem file with all the required information for each SAP system
in the landscape.
Important: You must not remove the template.sapsystem file from the
config directory.
a. Open the template.sapsystem file that is located in the following directory:
•

/var/opt/BESClient/LMT/SAPTOOL/config

•

C:\Program Files (x86)\BigFix Enterprise\BES
Client\LMT\SAPTOOL\config

b. Save the file as <host_name>.sapsystem in the config directory. Do not
overwrite the template.

c. Specify all parameters, and save. For more information, see: SAP Metric Data
Collector configuration parameters.
d. Create a separate file for each SAP system in the landscape.
5. To complete the configuration of SAP Metric Data Collector, edit the
saptool_config.properties file that is located in the following directory:
•

/var/opt/BESClient/LMT/SAPTOOL/config

•

C:\Program Files (x86)\BigFix Enterprise\BES Client
\LMT\SAPTOOL\config

a. Specify the landscape_name parameter and save the file. The landscape name
is displayed on the Resource Utilization report in the Instance column.
b. Ensure that the value of the skip_measurements parameter is set to false.
6. Optional: To test the connection to SAP and the correctness of data provided in the
configuration file, run the following script with the -testconnection parameter.
•

/var/opt/BESClient/LMT/SAPTOOL/saptool.sh
-testconnection

•

C:\Program Files (x86)\BigFix Enterprise\BES Client
\LMT\SAPTOOL\saptool.bat -testconnection

Apart from testing the connection, the -testconnection parameter encrypts the
password of the SAP user account. If you do not run the connection test, the
password will be encrypted when you run SAP Metric Data Collector.
To verify whether the connection test was successful, check the return code in the
trace.log file that is located in the following directory:
•

/var/opt/BESClient/LMT/SAPTOOL/logs

•

C:\Program Files (x86)\BigFix Enterprise\BES Client
\LMT\SAPTOOL\logs

The return code that is provided in the log file can differ from the code in the SAP
Metric Data Collector Information analysis. The analysis does not provide a return
code for the connection test. For more information and the meaning of the return
codes, see: Troubleshooting SAP Metric Data Collector.
7. Initiate the measurement and collection of SAP metric data.

a. Log in to the BigFix console.
b. In the navigation bar, click Sites > External Sites > BigFix Inventory > Fixlets and
Tasks.
c. In the upper right pane, select Initiate Collection of SAP Metric Data, and click
Take Action.
d. Select the computer on which SAP Metric Data Collector is installed, and click
OK.
Tip: By default, the Initiate Collection of SAP Metric Data fixlet is
scheduled to run every 30 days. The fixlet starts the collection of
the utilization data, which can still be in progress after the fixlet is
completed.
To schedule the fixlet to run periodically, select it, click Take Action and
go to the Execute tab. Select the Reapply this action check box, and
specify the frequency.
To check the status of SAP metric data collection at any point, activate
the SAP Metric Data Collector Information analysis.
8. Ensure that the software scans are enabled, and run automatically. If not, run the
software scan manually. Select the Resource utilization scan.
9. Ensure that the scan results are automatically uploaded. If not, upload the results to
the BigFix server manually.
10. To make the data available in BigFix Inventory, wait for the scheduled import of data,
or run it manually.
License metric utilization data is displayed on the Resource Utilization report. The report
shows the following metrics:
• Named users metric
• Other metrics that are related to the software packages license

On the SAP audit report, metrics are reported for a specified period, or not. BigFix Inventory
reports these metrics as follows.
• If a metric is reported by SAP for a specified period, BigFix Inventory reports this
metric for that period.
• If a metric is not reported by SAP for a specified period, BigFix Inventory reports this
metric for the period since the previous collection of SAP metric data.
• If a metric is not reported by SAP for a specified period and you collect the SAP metric
data for the first time, BigFix Inventory reports this metric for the last 30 days.

Related information
Changing the default secret key and password to the SAP Metric Data
Collector keystore

SAP Metric Data Collector configuration parameters
The configuration files contain important information that SAP Metric Data Collector
requires to connect to the SAP systems from which the tool collects the license metric
utilization data.
The configuration files are located in the following directory:
•

/var/opt/BESClient/LMT/SAPTOOL/config

•

C:\Program Files (x86)\BigFix Enterprise\BES Client\LMT
\SAPTOOL\config

List of main configuration parameters that define SAP systems
The following parameters define the SAP systems in your environment. They are configured
based on the template.sapsystem file. Do not overwrite the template file. Save the
configuration in a new file named <host_name>.sapsystem.
Table 178. List of main configuration parameters
Parameter

Description

jco.client.ashost

Hostname or IP address of the SAP system.

jco.client.user

SAP user account name.

jco.client.passwd

SAP user account password.

jco.client.client

SAP client number.

jco.client.sysnr

SAP system number.

jco.client.lang

Connection language; for example: EN or DE.

is_law

Confirm whether this is the central SAP system with
consolidated LAW data. Only one system in the land
scape must have this parameter set to true.

Other parameters
Other parameters that are required to collect SAP utilization data should be configured in a
separate configuration file saptool_config.properties. After you set up the value of
these parameters, overwrite the file by saving.
Table 179. List of other parameters
Parameter
landscape_name

Description
A custom name of the SAP landscape that is used
to distinguish the SAP landscape in BigFix Invento
ry. The landscape name is displayed on the Resource
Utilization report in a Instance column.

Table 179. List of other parameters (continued)
Parameter
skip_measurements

Description
By default, this parameter is set to false. If you only
need to collect SAP utilization data, without trigger
ing measurements, set the value of the parameter to
true and save the file. If you use the automated pro
cedure, do not change the default setting of the para
meter.
Note: The skip_measurements parameter is
relevant only if you use LAW. In case of LAW
2.0 measurements and consolidation are al
ways skipped.

Troubleshooting SAP Metric Data Collector
Available from 9.2.9. If you encounter problems with measuring utilization of SAP
license metrics by using SAP Metric Data Collector, check the log and the return code to
determine the possible cause.

Log file
The trace.log file is located in the following directory.
•

/var/opt/BESClient/LMT/SAPTOOL/logs

•

C:\Program Files (x86)\BigFix Enterprise\BES Client\LMT
\SAPTOOL\logs

Return codes
If the Initiate SAP Metric Data Collector task fails, an error code that indicates why the scan
failed is returned. The return code is included in the log file.

You can also check the status and the return code in the BigFix console. Go to Sites >
External Sites > BigFix Inventory v10 > Analyses, and activate theSAP Metric Data Collector
Information analysis. The analysis does not provide a return code for the connection test.
Table 180. SAP Metric Data Collector return codes
Return code

Possible cause and solutions

0

No errors.

1

An unknown error occurred. Contact BigFix Support.

2

Writing in to the trace.log file could not be initiated. Ensure that
the file is not used by other processes and that it is not opened in
any program, for example a text editor.

3

Encryption module could not be initiated. Ensure that the keystore
and keystore password are correctly configured. For more informa
tion, see: Changing the default secret key and password to the SAP
Metric Data Collector keystore.

4

The specified command-line parameters are incorrect. Run the saptool.bat or saptool.sh script with the -h parameter to see the
list of supported command-line parameters.

5

Configuration settings are invalid or missing. Ensure that all required
parameters are specified and correct. For more information, see:
SAP Metric Data Collector configuration parameters.

6

Connection to SAP failed. Ensure that connection to SAP is possible
and that all required parameters are specified and correct. For more
information, see: SAP Metric Data Collector configuration parame
ters.

7

The SAP Metric Data Collector process was interrupted. Run SAP
Metric Data Collector again.

8

Generating .slmtag files failed. Ensure that files in the slmtags
subdirectory are not locked by other processes.

Table 180. SAP Metric Data Collector return codes (continued)
Return code

Possible cause and solutions

9

Measuring utilization data in SAP exceeded the time limit.

10

Grouping SAP users in License Administration Workbench (LAW)
failed because SAP user grouping mode is not set to automatic. Set
the mode to automatic, and run SAP Metric Data Collector again.

11

The data collected from SAP is incomplete. Ensure that the consoli
dated results are available in LAW or LAW 2.0, and then run the SAP
Metric Data Collector again. The measurement results can be re
trieved and consolidated automatically in LAW when the skip_mea
surements parameter is set to false. If the problem persists, contact
BigFix Support.

12

The status of the SAP Metric Data Collector completion could not be
stored on disk. Ensure that the saptool.status file is not used by
other processes and that it is not opened in any program, for exam
ple a text editor.

13

The configuration file could not be updated with the encrypted pass
word. Ensure that none of the configuration files in the config sub
directory is used by other processes and that it is not opened in any
program, for example a text editor.

14

The SAP Metric Data Collector configuration that you initiated is not
supported. Contact BigFix Support.

15

SAP Java Connector is corrupted or missing. Download the SAP Ja
va Connector again. For more information, see: Collecting utilization
of SAP license metrics.

16

Currently not used.

17

SAP Metric Data Collector was run with the -encode parameter by
using a method other than the command line. Run the tool through

Table 180. SAP Metric Data Collector return codes (continued)
Return code

Possible cause and solutions
the command line to encode keystore password. For more informa
tion see: Changing the default secret key and password to the SAP
Metric Data Collector keystore.

18

SAP Metric Data Collector tried to decrypt the stored password by
using a key other than the one that was used to encrypt it. The en
cryption key was changed. Re-enter the password in plain text. The
password will be encrypted the next time the tool is run. For more in
formation see: Changing the default secret key and password to the
SAP Metric Data Collector keystore and Collecting utilization of SAP
license metrics.

19

SAP Metric Data Collector tried to encrypt the stored password by
using a key other than AES or the key was stronger than the Java
JCE jurisdiction policy allows. The encryption key was changed.
Change the encryption key to AES with correct length. For more in
formation see: Changing the default secret key and password to the
SAP Metric Data Collector keystore.

20

A given SAP system could not find the requested function module.

21

A function module on a given SAP system failed.

22

An error occurred when cleaning the last measurement data from
the central SAP system.

23

The ABAP plug-in is not installed on the central SAP system in the
landscape. For information about the installation of the code, see:
Installing the ABAP plug-in on a central SAP system.

24

SAP Metric Data Collector could not find the consolidated SAP uti
lization data.

Assigning components to active BigFix products <deprecated>
Notice: Refer to Using BigFix Inventory to calculate license for BigFix products for a
complete step-by-step guidance on license counting process.

License metrics
BigFix Inventory provides two types of information about license metrics utilization:
aggregated utilization and raw utilization. The former shows utilization of the assigned
license metric by all instances of a particular product within the reporting period. However,
it is limited to a subset of license metrics. The latter shows data that is collected from
.slmtag files. It shows raw utilization of all license metrics that can be used by a particular
product. The data is not aggregated and requires further processing.

License metric utilization
The primary source of information about license metric utilization is the All Metrics report.
For every product, you can specify a metric threshold to verify whether metric utilization is
above or below your expectations. You can also create a snapshot of the report, and store it
for audit purposes.

Report overview

Predefined report views
Predefined report views give you quick access to filtered information. You can
schedule these reports to be sent and set them as default views. However, you
cannot modify them.
Thresholds and Custom Fields
Custom fields allow you to extend information that is related to software
products by adding details pertinent to your organization. You can then use
the information to filter and sort the reports as well as group products based
on flexible criteria. A value that is specified in a custom field applies to the
selected product with the particular license metric. It also applies only within
the computer group to which you are assigned. For more information, see:
Adding custom information to license metric reports.
The menu can also be used to set license metric thresholds in the same way
as in the Threshold column.
Product Name
Name of the licensed product. When you click the link for a product that uses
the PVU or RVU MAPC metric, the next level of the report shows servers on
which the product was installed when the metric quantity was the highest.
When you click the link for any other product, the next level shows all
instances of product components, including historical instances that are no
longer installed. To view the list of component instances that were installed
when the metric quantity was the highest, generate the audit snapshot.
Metric
License metric that is assigned to the product. The metrics fall into three
categories:
• Metrics for which utilization is calculated, including:
◦

Install Instances

◦ Processor Value Unit (PVU)

◦ Resource Value Unit (RVU MAPC)
Virtual Processor Core (VPC)

◦
•

Metrics for which calculating utilization is not yet supported.

•

Metric is unknown

For more information about the license metrics, see: Reported license metrics.
Tip: If you want to display only products for which metric utilization
is calculated, hover over the Manage Report View icon

, and click

Configure View. Then, set the following filter: Metric Quantity,
greater than or equal to, 0.

FlexPoint Bundle or Cloud Pak Bundle
FlexPoint bundle or a Cloud Pak to which the product and its components are
assigned. For more information, see:
• Assigning products to FlexPoint bundles
• Assigning products to Cloud Paks
Metric Quantity
The highest number of metric units that the product used during the specified
period. The value <n/a> indicates that the quantity is not calculated for this
metric.
The following icons indicate that further actions are required to ensure that
the metric quantity is up-to-date:
• Red square (

) indicates that the metric quantity for the product

needs to be updated because an action that influences the value was
performed. For example, a component was assigned to this product.
To update the metric quantity, click Recalculate. The progress of
recalculation is displayed below the top menu bar.

• Exclamation mark (

) indicates that metric quantity might not be

calculated correctly because inventory data from at least one VM
manager is not reported properly. To solve the problem, ensure that all
VM managers are configured. For more information, see: Adding VM
managers in central mode or Adding VM managers in distributed mode.
If you create a custom signature for IBM software, you must assign a correct
IBM license metric to this product on Products & Metrics panel and then
bundle the component instances to this product and IBM metric. Software
from custom catalog content is assigned to Install Seats metric by default.
IBM metrics is calculated automatically for IBM software and non-IBM metrics
is calculated for non-IBM software.
Threshold
The maximum number of metric units that the product can use within the
computer group. The value is set manually. For more information, see: Setting
license metric threshold.
Threshold Delta
The difference between the threshold and the metric quantity. It indicates
whether the metric utilization is above or below the manually set threshold.
The following values indicate that the delta cannot be calculated:
• The value <no data> indicates that the threshold is not set.
• The value <n/a> indicates that the threshold was set for a product for
which metric quantity is not calculated.
Imported Part Numbers
Part numbers that represents products that you purchased. For more
information, see: Part numbers.
Metric Quantity History

History of changes in the metric utilization over the specified period. The
history is not available for products for which metric quantity is not calculated.
Note: A product with a metric is displayed on All Metrics panel if all of the following
conditions are met:
• There are component instances bundled to the product and the metric,
discovered in the selected reporting period, and not suppressed.
• The relation between the component instances and the product and the
metric is charged.
• If the metric is one of IBM metrics, such as PVU, RVU, VPC, and Install
Instances, the product's vendor must be IBM. For example, metric calculation
for these metrics will be applicable only for IBM products.
• Recalculation is not pending, which means that the Recalculate button is
disabled.
• The given computer group has metric calculations enabled.
To bundle components to a product and metric, make sure that the relation between
the metric and the product exists (Products & Metrics panel). Information whether
the purposes relation between a component instance bundled to a product and a
metric is charged is available on "Software Classification" panel under the "Charged"
column. Metric quantity is not available if the metric is not automatically calculated
by BigFix Inventory, In such case, products with the metric may be listed on All
Metrics panel with quantity as "<n/a>" and this value can be updated manually.

Setting license metric threshold
Available from 9.2.4. You can set a threshold to indicate the maximum number of
metric units that a product can use within a computer group. The threshold is then used to
calculate whether metric utilization is above or below your expectations.
You must have the View License Metrics permission to view the threshold and the
Manage Contracts permission to change it.

1. In the top navigation bar, click Reports > All Metrics. From the list of predefined
reports, choose Metric Thresholds.
2. Optional: To filter down the report to the product for which you want to set the
threshold, hover over Configure, and click Configure View. Then, specify appropriate
filters.
For example, choose Product Name, contains and specify the name of the product.
Then, click Submit.
3. To set the threshold, click the pencil icon

in the Threshold column, and click Set

Threshold.

4. Specify the threshold and click Set. The value is set only for the computer group to
which you are assigned and is not inherited by its subgroups.

Tip: If you want to set a threshold for a subgroup of your computer group,
go to Reports > Computer Groups and open the subgroup. In the upper left
corner, select All Metrics. Then, from the list of predefined reports, choose
Metric Thresholds and set the threshold value for a particular product.
When you set the threshold, its delta is automatically calculated by subtracting the metric
quantity from the threshold. If the utilization is lower than or equal to the threshold, the delta
is displayed in green. Otherwise, it is displayed in red. Additionally, a line that represents the
threshold is displayed on the metric quantity history graph.

If you want to remove the threshold, click the pencil icon

and click Clear Threshold.

Then, click Clear.
From the list of predefined reports, you can choose the Exceeded Thresholds report and
schedule emails to be sent whenever a product appears on that report. It will ensure that
you are automatically notified when metric utilization for any product exceeds the threshold.
For more information, see: Scheduling report emails.

Setting and removing the declared metric quantity
Available from 9.2.16. On the All Metrics report, you can manually declare the
metric quantity for selected license types for which does not calculate the utilization. You
can also use this option to customize the metric quantity if needed. The declared value
takes precedence over the value that is measured by the application.

You must have the Manage License and the Manage Software Classification permissions
to set the license metric quantity.
You can check which of your license metric quantities can be customized. Look at the
pencil icon

in the Metric Quantity column. If the icon is active, you can declare the

custom metric quantity for the product.
By default, you set the declared value from the reporting start date onwards. However when
you explicitly provide also the end date for the report, then the declared metric quantity is
set only until this date. Using this mechanism, you can declare metric quantities for any
period of time by defining the appropriate time range for the report.
1. In the top navigation bar, click Reports > All Metrics.
2. Optional: To change the period for which you want to set the declared metric quantity,
hover over Configure, click Configure View, and select the time range. If you specify a
period from a date to a date, the license metric quantity is set only for this particular
period of time.
3. To set the metric quantity, click the pencil icon

in the Metric Quantity column.

Note: In case of FlexPoint bundles, you can set the license metric quantities
for particular products that contribute to the bundle but not for the bundle
itself. Click on the name of the bundle to see the detailed report that lists the
products within bundle.
4. Specify the metric quantity and click Set. The value is set only for the computer group
to which you are assigned and is not inherited by its subgroups.

Note: If you want to set a metric quantity for a subgroup of your computer
group, go to Reports > Computer Groups and open the subgroup. In the upper
left corner, select All IBM Metrics and set the license metric quantity for a
particular product.
The metric quantity for the product is set.
The declared metric quantity is independent of your software inventory or bundling and
you should make sure that it is kept up-to-date. If you reassign software to another product
or FlexPoint bundle, the declared metric quantity remains unchanged. If, as a result of
reassignment, a product is left with no components, it is still visible on the All Metrics report
with the declared metric quantity.

Removing the declared metric quantity
You can remove the declared value to restore the value that is measured by the application.
1. Open the All Metrics report.
2. To remove the declared metric quantity, click the pencil icon (
Quantity column.

) in the Metric

3. Clear the text field to remove the declared metric quantity for the specified period of
time.
4. Click Set.

Adding custom information to license metric reports
Available from 9.2.9. You can extend information that is related to software
products by adding custom fields on the All Metrics report and its derivatives. You can then
use the information to group products based on flexible criteria such as contract name,
placement, allocation, date, or other.
You must have the Manage Contracts permission to add and edit custom fields, and the
View License Metrics permission to view them.
1. To add a custom field that is displayed on the All Metrics report and its derivatives,
perform the following steps.
a. In the top navigation bar, click Management > Metric Custom Fields.
b. To add a custom field, click New.
c. Provide the name of the field.
For example, Needs Renewal.
d. Choose the type of data to be entered in the field.
For example, Boolean.

Note: After you create a custom field, you can edit only its name. You
cannot change the type of data that is required in that field.
e. Click Create.
2. To specify the value of a custom field, perform the following steps.
a. In the top navigation bar, click Reports > All Metrics.
b. Select the row for which you want to specify the value. The value applies only to
the selected product with the particular license metric. It is also set only for the
computer group to which you are assigned and is not inherited by its subgroups.
Tip: If you want to set the value for a subgroup of your computer group,
go to Reports > Computer Groups and open the subgroup. Then, set the
value for a particular product within the selected subgroup.
c. Hover over the Edit and click Set Value.
d. Specify the value, and click OK.

Tip:
• If the type of the custom field is Boolean, the check box that is
displayed on the reports has three possible values.
◦ Not set
◦ Yes
◦ No
3. To display the custom field on the All Metrics report, perform the following steps.
a. Hover over the Configure icon

, and click Configure View.

b. Select the custom field, and click Submit.
You created a custom field that can be used to provide specific information about a product
with a particular license metric.

If you want to remove a value in the custom field, select a specific row, and hover over Edit.
Then, click Clear Value. If you want to remove a custom field, go to Management > Metric
Custom Fields, select the field that you want to remove, and click Delete.
You can use values in the custom fields to filter and sort the reports. You can also create
saved report views that are filtered by the specified information, and enable notifications
that are triggered when specific criteria are met.
Note: New contracts are defined in All contracts and the above custom fields are
used for other purpose.

Creating snapshots of license metric utilization for auditing
purposes
Create the snapshot of the report, and store it as a record of license metric utilization in your
enterprise over a particular period. You can create the snapshot with any frequency that
is suitable for your purposes. However, it is a good practice to create the snapshot every
quarter. You can also regenerate the snapshot at any time as the historical data is always
editable.
You must have the following permissions to perform this task:
• View License Metric to open the report.
• View Audit Trail if you want the snapshot to contain the audit trail file.
To ensure completeness and accuracy of data that is contained in the audit snapshot,
ensure that:
• Software scan data is collected from the entire environment. To verify whether there
are any problems, check the Software Scan Health widget on the Overview panel.
• Capacity data is collected from the entire environment. To verify whether there are any
problems, check the Capacity Scan Health widget on the Overview panel.
• Imports of data are successful. To check the import history, go to Management > Data
Imports.
• Software is correctly classified. For more information, see: Software classification.
1. Log in to BigFix Inventory, and go to Reports > All Metrics.
2. Optional: To configure the period for which you want to create the snapshot, hover
over the Configure icon

, and click Configure View. Then, select the time range.

• If you specify a period from a particular date until the last successful import, the
reports contain entries from that date starting at 00:00:00.
• If you specify a period from a date to a date, the reports contain entries from the
first date starting at 00:00:00 to the second date ending at 23:59:59.
3. Optional: To limit the number of products that are included in the snapshot, specify
the name of the product in the Filters section.

4. To create the snapshot, in the top navigation bar, click Audit Snapshot.
5. Optional: Provide a comment in the comment text field.
6. Optional: To add an attachment, click Browse and select the file that you want to
attach to the snapshot.

7. Click Generate.
The audit_snapshot_date_time.zip file is downloaded to your computer. The date
that is provided as part of the file name is expressed in the GMT time zone. For information
about the content of the file, see: Content of the audit snapshot.

Content of the audit snapshot
Audit snapshot is a record of license metric utilization in your enterprise over a period
of time. It is generated on the All Metrics/All IBM Metrics report and its derivatives. It
is downloaded to your computer as the audit_snapshot_date_time.zip file that
contains a number of other files.
Important: If you use the audit snapshot for integration of BigFix Inventory with
external tools, base the integration on column names, not their order. The order of
columns might change if new columns are added.

Table 181. General files
File

Content

audit_at- Optional. A file that was attached during the creation of the snapshot. The
tachmen-

file is listed in the checksums.txt file.

t.extension
audit_-

Optional. Comments that were added during the creation of the snapshot.

commen-

The file is listed in the checksums.txt file.

t.txt
Summary of all software products that were installed in your environ
audit_s-

ment during the period for which the snapshot is generated and which are

napshot_- charged. The file contains information about:

Table 181. General files (continued)
File

Content

summa-

• License metric that is used by the product.

ry.csv

• The highest number of metric units that the product used during the
specified period.
• Part numbers that represents products that you purchased.
• The need to perform recalculation to update the metric quantity for the
product.

audit_-

Information about:

trails.csv

• Software classification actions
• Uploads and imports of the PVU table, software catalog, and charge
units
• Changes to the VM managers
The file is not generated if the user who generates the snapshot does not
have the permission to view audit trails. It is also not generated when the
snapshot contains only products that use license metrics other than PVU
and RVU MAPC. For example, when the snapshot contains only products
that use the Install Seats metric.

bundling_- Information about:
definitions.csv

• Software limited to the vendor that was specified on the user interface
•

License metric that each product uses

• Details of computers on which the software is installed
checksum- Checksums that are used to verify whether any files from the audit snapshot
s.txt

were tampered with.
To verify the report files on Linux, run the following command:
sha256sum -c pvu_sub_capacity.csv

To verify the report files on Windows, run the following command:

Table 181. General files (continued)
File

Content
CertUtil -hashfile pvu_sub_capacity.csv SHA256

data_-

Information about:

condition.txt

Version of BigFix Inventory in which the snapshot was gen

•
erated

• Author of the snapshot
• Date of the snapshot
• Period that is covered by the snapshot
• Version of the PVU table
• Version of the software catalog
• Status of aggregation and recalculation
• Filters that are used on the reports
• Attached file (optional)
Date when BigFix Inventory was installed

•

part_num- Part numbers that are listed in the software catalog for software products
bers.csv

included in any of the CSV report files.

pub_-

Public key file that can be used to verify the signature.rsa file against

key.pem

the checksums.txt file.

signa-

A digital signature that can be used to verify whether the checksums.txt

ture.rsa

file was tampered with. To verify the file, you can use OpenSSL.
To verify the checksums.txt file on Linux, run the following com
mand:
openssl dgst -sha256 -verify pub_key.pem
-signature signature.rsa checksums.txt

To verify the checksums.txt file on Windows, run the following
command:

Table 181. General files (continued)
File

Content
openssl -sha256 -verify pub_key.pem
-signature file signature.rsa checksums.txt

The following files are included in each audit snapshot unless you filter the report to show
only a specific metric type, for example PVU subcapacity. In this case, files with other
metrics are not included.
Table 182. Files with license metric utilization
File

Content
cloud_paks.csv

Information about:
• Cloud Paks
• Software products that are installed as part of
Cloud Paks

flexpoints.csv

Information about:
• Software licensed per number of FlexPoints
• Details of software products that are licensed un
der the Flex Point bundles

install_in-

Information about:

stances.csv
• Software licensed per number of installed in
stances
•

FlexPoint offerings to which products
and their components are bundled

• Details of computers on which the software was
installed when the metric quantity was the highest

Table 182. Files with license metric utilization (continued)
File

Content
install_seat-

Information about:

s.csv
• Software licensed per number of computers on
which it is installed
• Details of computers on which the software was
installed when the metric quantity was the highest
microsoft_dual_-

Information about:

physical_processor.csv
• Microsoft software that is licensed for the number
of active physical processors
• Utilization of the metric
• Details of computers on which the software was
installed when the metric quantity was the highest
microsoft_single_- Information about:
physical_processor.csv
• Microsoft software that is licensed for the number
of active physical processors
• Utilization of the metric
• Details of computers on which the software was
installed when the metric quantity was the highest
microsoft_physi- Information about:
cal_core_with_sa.csv
• Microsoft software that has Software Assurance
and is licensed for the number of physical cores
• Utilization of the metric
• Details of computers on which the software was
installed when the metric quantity was the highest
microsoft_virtu- Information about:
al_core_with_sa.csv

Table 182. Files with license metric utilization (continued)
File

Content
• Microsoft software that has Software Assurance
and is licensed for the number of virtual cores
• Utilization of the metric
• Details of computers on which the software was
installed when the metric quantity was the highest
oracle_processor_- Information about:

core.csv
• Oracle software that is licensed for the number of
physical cores
• Utilization of the metric
• Details of computers on which the software was
installed when the metric quantity was the highest
pvu_full_capacity.csv

Information about:
• PVU software and its PVU utilization under full ca
pacity license
•

FlexPoint offerings to which products
and their components are bundled

• Details of computers on which the software was
installed when the metric quantity was the highest
pvu_sub_capacity.csv

Information about:
• PVU software and its PVU utilization under subca
pacity license
•

FlexPoint offerings to which products
and their components are bundled

• Details of computers on which the software was
installed when the metric quantity was the highest

Table 182. Files with license metric utilization (continued)
File

Content
registered_-

Information about:

user.csv
• Software that is licensed for the number of regis
tered users
• Utilization of the metric
• Details of users who used or registered the soft
ware when the metric quantity was the highest
rvu_full_capacity.csv

Information about:
• RVU software and its RVU MAPC utilization under
full capacity license
•

FlexPoint offerings to which products
and their components are bundled

• Details of computers on which the software was
installed when the metric quantity was the highest
rvu_sub_capacity.csv

Information about:
• RVU software and its RVU MAPC utilization under
subcapacity license
•

FlexPoint offerings to which products
and their components are bundled

• Details of computers on which the software was
installed when the metric quantity was the highest
vpc_capacity.csv Information about:

Table 182. Files with license metric utilization (continued)
File

Content
• VPC software and its VPC utilization
FlexPoint offerings to which products

•

and their components are bundled
• Details of computers on which the software was
installed when the metric quantity was the highest

Files for integration with IBM Cloud Platform Common Services
Table 183.
File

Content
products_daily_<start_-

The file contains daily values of license

date><end_date><server_FQD-

metric utilization for products that were

N>.csv

visible on the All Metrics report when the
audit snapshot was generated. It pro

• start_date is the time range select
ed on the All Metrics reports .
• end_date time range selected on
the All Metrics report.
• server_FQDN is the fully qualified

vides a separate entry for every unique li
cense offering (product and license met
ric record from the All Metrics report)
for each day during the reporting peri
od. The purpose of this file is to allow for

domain name of the BigFix Inven

consolidating data from BigFix Invento

tory server on which the snapshot

ry about IBM software in IBM Cloud Plat

was generated.

form Common Services.

Snapshot columns
This glossary provides a brief description of every column that can be found in the audit
snapshot generated in BigFix Inventory.
B CD E F I L M O P R S U V

B
Bundle Metric Contribution (previously FlexPoint Quantity)
Indicates the number of license metric units that the particular product
contributes to the overall metric quantity of the FlexPoint bundle or Cloud Pak
to which that product is assigned.

C
Changed PVU per Core
Specifies whether the number of processor value units assigned to a single
core was manually changed for the server that is listed in the Server Name
column. If the value is Yes, you can check the comment that was provided as
the reason of the change. It is listed in the audit_trails.csv file, and has
the following format.
Modification Type: PVU per core value changed
Details: The PVU per core value was changed to 70 on server serv
er_name. The provided reason: reason.

Charged
Indicates whether the relation between the component and the product is
charged based on the license terms. If the relation is charged, the component
contributes to the license metric utilization of the product to which it is
assigned.
Cluster Cores
Total number of processor cores that were available within the cluster of
servers when the snapshot was generated. The information is available in the
oracle_processor_core.csv file.
Cluster Name

Name of the cluster to which the server listed in the Computer column
belonged when the snapshot was generated. The information is available in
the oracle_processor_core.csv file.
Comment
Extra technical information. Possible values include:
• Incomplete virtualization hierarchy
• All instances are excluded
Component
Software component that was discovered on the computer that is listed in the
Computer column.
Computer
Host name of the endpoint on which the BigFix client is installed.
Computer Deleted
Specifies whether the computer that is listed in the Computer column existed
in the environment when the snapshot was generated.
Computer First Seen
• BigFix Inventory Server: Date and time when information about the
computer was imported for the first time.
• Disconnected: Date and time of generating the disconnected scanner
package that was imported to the License Metric Tool server for the first
time.
Computer Last Seen
Date and time when the BigFix client connected to the BigFix server the last
time.
Computer Type
Type of the computer. Possible values include:

• Physical
• Virtual
• Public cloud
Current Server Name
Name of the server on which the computer that is listed in the Computer
column resided when the snapshot was generated. Capacity of that server
does not influence utilization of license metric. The server whose capacity
influences metric utilization is listed in the Server Name column.

D
Details
Information about the type and date of action that is listed in the
audit_trails.csv file as well as the user who performed the action.
Discovery End
Date and time when the component instance stopped being detected. If the
component is still detected, the column is empty.
Discovery Start
Date and time when the component was first detected by BigFix Inventory.

E
Exclusion Comment
Comment that was provided as the reason for excluding the product instance
from pricing calculations on the computer that is listed in the Computer
column.

F
FlexPoint Bundle
FlexPoint bundle to which the product and its components are assigned.

Flex Point or Cloud Pak Bundle (previously FlexPoint Bundle)
FlexPoint bundle or Cloud Pak to which the product and its components are
assigned.

I
Imported Part Numbers
Part number that was imported to BigFix Inventory. It represents the
product that is listed in the Product Name column and the license
metric that is assigned to the product. License metric is the same for all
products that are listed in a single csv file. For example, all products in the
pvu_sub_capacity.csv file are assigned the PVU subcapacity metric.
IP Address
IP address of the computer that is listed in the Computer column.
Is Imported
Specifies whether a part number that is listed in the Part Number column was
also imported to BigFix Inventory by a user.

L
Last Seen
Date and time when the BigFix client connected to the BigFix server the last
time.
Starting from application update 9.2.11, the name of the column is
changed to Computer Last Seen.
License Use For Cluster
Total number of licenses needed for a cluster, based on number of processor
cores, that were available within the cluster of servers when the snapshot was
generated and multiplied by Oracle Core Factor. The information is available in
the oracle_processor_core.csv file.

License Use For Endpoint
Number of unique users who used the software on a specified computer
within the period for which the snapshot was generated. License Use for
Endpoint is measured at the metric peak value time.
License Use For Server
Total number of licenses needed for a server, based on number of processor
cores, that were available on the server that is listed in the Server Name
column when the snapshot was generated and multiplied by Oracle Core
Factor. The information is available in the oracle_processor_core.csv
file.
Logical Processors
Number of processor cores that were assigned to the computer that is
listed in the Computer column when the peak of metric value occurred.
When hyper-threading is used on the x86 architecture, each core is
counted as two logical processors. The information is available in the
microsoft_virtual_core_with_sa.csv file.

M
Metric
Type of software license metric that is used by the product.
Metric Peak Value Time
Date and time when utilization of the license metric was the highest during the
period for which the snapshot was generated.
Metric Quantity
The highest number of metric units that the product used within the period for
which the snapshot was generated. Metric quantity is measured at the metric
peak value time. It represents metric utilization in the entire environment.
Modification Date

Date and time when the modification that is listed in the audit_trails.csv
file was performed.
Modification Type
Type of modification.
Modified By
User who modified the item.

O
Oracle Core Factor
Factor that is applied to the server on which Oracle products are installed.
OS
Operating system of the computer that is listed in the Computer column.

P
Part Number
Part number that represents the product and its license metric as listed in the
software catalog.
Partition Cores
Number of partition cores that were assigned to the computer that is listed in
the Computer column when the peak of metric value occurred.
Path
Installation path of the software that was discovered on the computer or the
path where the .swidtag file was discovered.
Peak Date
Date when the product used the highest number of metric units within the
period for which the snapshot was generated.
Physical Server CPU Core Full Capacity

Number of physical cores that were available on the server that is listed in the
Server Name column when peak of metric value occurred. The information is
available in the pvu_full_capacity.csv and rvu_full_capacity.csv
files.
Physical Server CPU Core Subcapacity
Number of physical cores that were available to the product that is listed in the
Product Name column when peak of metric value occurred. The information is
available in the pvu_sub_capacity.csv file.
Physical Server CPU Core Subcapacity Limit
Number of physical cores that were available on the server that is listed in the
Server Name column when peak of metric value occurred. The information is
available in the following files:
• pvu_sub_capacity.csv
• rvu_sub_capacity.csv
•

vpc_capacity.csv

Physical Server PVU Full Capacity
Number of cores (Physical Server CPU Core Full Capacity column)
multiplied by the number of PVUs assigned to the processor core (PVU
per Core column). It represents PVU full capacity for the server that is
listed in the Server Name column. The information is available in the
pvu_full_capacity.csv file.
Physical Server PVU Subcapacity
Number of cores (Physical Server CPU Core Subcapacity column)
multiplied by the number of PVUs assigned to the processor core (PVU
per Core column). It represents PVU subcapacity for the product that is
listed in the Product Name column. The information is available in the
pvu_sub_capacity.csv file.
Physical Server PVU Subcapacity Limit

Number of cores (Physical Server CPU Core Subcapacity Limit column)
multiplied by the number of PVUs assigned to the processor core (PVU
per Core column). It represents PVU full capacity for the server that is
listed in the Server Name column. The information is available in the
pvu_sub_capacity.csv file.
Processor
Name of the processor normalized to the name that is listed in the PVU table.
If the discovered processor was not matched with any processor from the
PVU table, the value is Unknown processor.
Processor Brand String
Full specification of the processor including its brand, model and speed as
read from the operating system of the computer that is listed in the Computer
column.
Processor Metric
Number of processors that contributed to calculating
license metric utilization. The information is available in the
microsoft_single_physical_processor.csv and
microsoft_dual_physical_processor.csv files.
Product Name
Name of the software product.
Product Release
Release of the software product.
Publisher
Name of the company that published the software product.
PVU per Core
Number of processor value units that are assigned to a processor core on a
server that is listed in the Server Name column. By default, the value is taken

from the PVU table but it can also be set manually. If it was set manually, the
value in the column Changed PVU per Core is Yes.

R
Recalculation Needed
Specifies whether recalculation was needed when the snapshot was
generated. If the value is Yes, metric quantity for the product might not be
correct. It happens because actions that influence metric quantity were
performed but the value was not recalculated. For example, a component was
reassigned to a different product. A correct snapshot contains only entries for
which the value in the Recalculation Needed column is No.

S
Server Active Sockets
Number of physical processor chips that are mounted on the server that is
listed in the Server Name column. The number also includes empty sockets
without processors.
Server Cores
Number of processor cores that were available on the server that is listed in
the Server Name column when peak of metric value occurred. The information
is available in the microsoft_physical_core_with_sa.csv and
oracle_processor_core.csv files.
Server Name
A unique system in the enterprise. The value depends on what type of
computer is listed in the Computer column.
• If the computer is a physical machine, the Server Name column shows
the hardware manufacturer, type, and a machine serial number.
• If the computer is a virtual machine, the Server Name column shows the
manufacturer and host name of the physical host.

• If the computer is a virtual machine for which a VM manager is not
configured, the Server Name column shows a UUID assigned by BigFix
Inventory prefixed with TLM_VM_. A correct snapshot should not contain
any entries with such a value unless you have the permission of the IBM
Compliance Team.
If multiple virtual machines are running on the same physical server, the same
server name is listed multiple times.

U
Unconfirmed Product Instance
Specifies whether the assignment of the component to the product was
confirmed. Confirming the assignment is optional and does not impact metric
utilization.

V
Virtualization Layer ID
Internal ID of the virtualization layer on which the software component is
installed. The information is used by the HCL Support for troubleshooting
purposes.

Understanding CSV files with metric utilization
Due to differences in the structure of the user interface reports and CSV reports,
information about metric utilization is presented differently in each type of report. Learn
more about these differences to better understand how to correlate the information
between user interface reports and CSV reports.

Multilevel versus flat report structure
The All Metrics and IBM PVU subcapacity reports consist of the following levels for PVU
and RVU MAPC products:

1. First level - a list of all products.

2. Second level - when you click a product name, you go to information about the
physical server on which the product is installed.

3. Third level - when you click the server name, you go to the list of virtual machines that
run on this server and have the product installed.

The audit snapshot is not multilevel. However, it must present the same information that
the report that is available in the user interface. Below is an excerpt from the audit snapshot
that corresponds to the report presented on the screen captures above. Some columns are
hidden in the snapshot to simplify it.
Table 184. Excerpt of the audit snapshot
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Table 184. Excerpt of the audit snapshot (continued)
D

IBM MQ

E

810

F

H

2016-06-01 X.XXX.XX.217
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When values in column O (Physical Server PVU Subcapacity Limit) are added, PVU
consumption equals 1680 PVUs, which is greater than the value that is presented on the
user interface. These values should not be added because they all refer to a single server
(X.XXX.XX.217) on which the three VMs run, not an individual VM that is listed in column S
(Computer). The value in column M is repeated due to the flat structure of the CSV report.
If you want to relate the values from the CSV report to the user interface report, the relation
is as follows:
• Column O in the CSV report relates to the PVU Subcapacity Limit column on the
second level of the report
• Column N in the CSV report relates to the CPU Core Subcapacity column on the
second level of the report

PVU and RVU MAPC subcapacity license terms specify license consumption only on the
physical server level. The values cannot be calculated and presented on the virtual machine
or LPAR level, and such data is not provided by BigFix Inventory. For more information, see:
Virtualization Capacity License Counting Rules.

CSV reports contain only software instances discovered during the license
peak value time
CSV reports list only software instances that were discovered during the license peak value
time. If an instance was installed in your environment during the reporting period but was
not discovered during the license peak value time, the instance is not listed in the CSV
reports.
For example, three instances of DB2 are installed. The reporting period is set to one month
and DB2 license utilization is as follows:
• Instance 1 uses the maximum of 100 PVUs
• Instance 2 uses the maximum of 300 PVUs
• Instance 3 uses the maximum of 500 PVUs

The license peak value occurs when the sum of PVU values for all instances is the highest
and equals 800 PVUs (300 PVUs for instance 2 + 500 PVUs for instance 3). The peak occurs

during the period that is marked with a red square. It is the license peak value time. The
peak usage for instance 1 is outside of the peak value time. It means that this instance
was installed in the environment during the current reporting period but was not discovered
during the license peak value time. This instance is not listed in the CSV report.

Raw utilization of license metrics
Available from 9.2.1. Raw data about utilization of license metrics is collected for products
that deliver .slmtag files and is shown on the Resource Utilization report. The data that
is shown on the report is not aggregated. It means that if a product can use five license
metrics, five rows are shown on the report for that product. What is more, all metrics that
are available for a product are displayed, not only metrics that are defined by your license
agreement.
To collect raw utilization data, run the resource utilization scan. The scan is scheduled
automatically if you enabled the default scan configuration. Otherwise, enable it manually.
For more information, see: Initiating software scans.
For the list of IBM products that deliver .slmtag files, see: Resource Utilization
Measurement Community.

Retention period setting

To reduce the amount of resource utilization data, set the retention period
after which the data is removed from the database. For more information, see:
Configuring data retention period for raw utilization data.
Export History
History provides initially processed data about the average and maximum
utilization of each license metric for each product for a specified period. It is
different from export to CSV or PDF that includes only data that is visible on
the user interface.
Metric Type and Metric Subtype
The type and subtype of license metrics that a product uses. The report does
not show products that use the PVU, RVU MAPC or Install Seats metric. To
view these products, open the All Metrics report.
First Measured and Last Measured
The first and last time when each metric was reported.
Maximal Trend Value
The maximum utilization of each license metric over the last 30 days. If a
particular product is unused, no resource utilization data is available, or the
data is older than 30 days, the value is 0.
Maximal Trend Value History
Trend value of the maximum utilization over the last 30 days. When the graph
shows 0 for a specific period, it means that there is no data, or there was no
license utilization during this period. To recognize which is the case, click
Export History to save the report to a file. Then, open the file, and check if the
entries that show 0 in the user interface also show 0 in the file. If they do, it
means that the license utilization during this period equals 0. If there are no
such entries, the data from this period was not reported.

Aggregating the data
If you want to aggregate the data according to your license agreement, export the history of
license metric utilization and aggregate it outside of BigFix Inventory. Apply all necessary
filters on the Resource Utilization report, and click Export History. The csvhistory.zip
file is downloaded to your computer. It contains the export_history.csv file that
provides initially processed data about the average and maximum utilization of each license
metric for each product.
Example
IBM Product is an application that is licensed based on the number of users who
simultaneously log in to that application per hour. Figure 8: License metric utilization data
retrieved from the .slmtag file for BigFix Product is a visualization of the license metric
utilization that is retrieved from the .slmtag file specific for BigFix Product.
Figure 8. License metric utilization data retrieved from the .slmtag file for BigFix
Product

The data undergoes initial processing during which the average daily utilization of the
license metric is calculated. Information about the maximum utilization, including its value

and time, is preserved. Figure 9: License metric utilization data for BigFix Product after
initial processing is a visualization of the license metric utilization data for BigFix Product
after initial processing. It shows that on average, four users were simultaneously logged in
to the application. The maximum utilization occurred between 2:00 PM and 3:00 PM when
10 users were simultaneously logged in to BigFix Product.
Figure 9. License metric utilization data for BigFix Product after initial
processing

The export_history.csv file contains license metric utilization data after initial
processing. It does not contain all data that was collected from the endpoints in your
infrastructure. Table 185: A fragment of the export_history.csv file shows a fragment of
the export_history.csv file that corresponds to the data that is presented in Figure
9: License metric utilization data for BigFix Product after initial processing. The first row
corresponds to the average license metric utilization before the peak. The second row
corresponds to the peak value. The third row corresponds to the average utilization after the
peak value.

Table 185. A fragment of the export_history.csv file
A simple table with 4 rows and 7 columns.
Comput

Software

er Name

Name

VMW00912 IBM Prod
uct
VMW00912 IBM Prod
uct
VMW00912 IBM Prod
uct

Metric Type

Metric

Start Time

End Time

Subtype

(UTC 0)

(UTC 0)

CONCURREN

2015-06-20 2015-06-20 4

T_USER

00:00:00.0 14:00:00.0

CONCURREN

2015-06-20 2015-06-20 10

T_USER

14:00:00.0 15:00:00.0

CONCURREN

2015-06-20 2015-06-21 4

T_USER

15:00:00.0 00:00:00.0

Value

Disabling collection of raw utilization data
Available from 9.2.1. Raw utilization data is collected by default. However, you can disable
the option if you are not interested in this data.
You must be an Administrator to perform this task.
1. Stop all actions that were created by the Initiate Software Scan task.
a. Log in to the BigFix console.
b. In the left navigation tree, click Actions.
c. Select all open actions that were created by the Initiate Software Scan task,
right-click them, and click Stop Action.
The status of the actions changes to Stopped.
2. Run the software scan. Clear the Resource utilization check box.
3. Log in to BigFix Inventory, go to https://hostname:port/management/
feature, and clear the Measure resource utilization check box. Then, click Save.

Raw utilization data is no longer collected from the computers in your infrastructure. The
Resource Utilization report is hidden from the BigFix Inventory menu.

Managing Microsoft Processor Core licenses
With version 10.0.11, BigFix Inventory supports a new metric "Microsoft SQL Server Physical
Processor Cores" for the per core physical licensing model. The metric is in line with the
latest Microsoft product license terms. For the list of license terms, refer to Microsoft SQL
Server Product Terms/.
The new metric is calculated as per the given current day and follows the latest Microsoft
SQL Server product terms. This new metric is calculated once the contract is defined to give
SAM full control for the specific contract and group it is needed. Enabling license usage
calculation on computer group definition to calculate this metric is no longer required. This
new metric is managed through contract definition and due to this reason, its value is not
presented in All metrics panel.

Supported metric
The below table shows the metric supported for Microsoft Processor Core licenses:
ID
-13314

Code Name

Description

SQL_SERVER_MICROSOFT_PHYSICAL_PRO

Microsoft SQL Serv

CESSOR_CORES

er Physical Processor
Cores

This metric is dedicated to "Microsoft SQL Server Standard Edition" and "Microsoft SQL
Server Enterprise Edition" products.

Metric calculation
The metric calculation is based on the below rules:
• Metric value is calculated only for products that are part of the contract.
• The calculated value is visible on "All Contracts" and "Product Metrics per Contract"
panels.

Method to calculate the metric value for a product:
Metric value for a product = sum of calculated values for each physical server
with product or with VM with a product.
Metric value for a server = number of server cores, minimum 4 cores per
physical processor.
Note: The metric is calculated only when there is a contract created
with it. Its value is no longer visible from the All Metrics panel.

Examples
SQL Server Microsoft Physical Processor Core
There are two hosts. Each of them has two processors (Server Active Sockets)
and there are 16 cores per processor (total 32 Server Cores).
Microsoft SQL Server has been detected on 3 virtual machines. Two of them
run on the first host, another one on the second.
According to the algorithm, both processors from the first host exceed the
minimum value of 4 cores per processor, so 2x16 cores will be counted as
a total number of cores for the metric. Also, the second has the 32 cores,
this time 4 processors 8 cores each, so another 32 cores will be added to the
calculation. Total number of cores is 64.

SQL Server Microsoft Physical Processor Core
In this example 'Server Cores' and 'Server Active Sockets' value is different
on the second host. There are 8 server cores, however minimum cores per

processor is 4 and we have 4 processors, so the cores value for this server will
be 16.
According to the algorithm, we have 32 cores for the first host and 16 cores
for second, so we have 48 cores as a result.

Additional SQL Server simplifications
You will have to manually manage a situation when there are VMs on a server with SQL
Server Standard and you will classify them to be calculated per Physical Processor Core.
This is required by Microsoft license terms for SQL Server Standard and BigFix Inventory
does not handle this situation automatically. Normally customer should reassign such
instances to Virtual Processor Core metric.

Contracts management
The contracts management group shows all contract-related reports in one place. This
allows you to easily manage all your contracts.

Advantages over old contracts
In previous BigFix Inventory versions, contracts supported only Seats and ELA metrics.
Views of contract data is available only for software instances and not for current products
and metrics. To improve product function, with contract management in BigFix Inventory
version 10.0.5, you can define contracts according to all metrics. This ability helps you track
contracts.
Note: IBM Flexpoint bundles are not available for contracts as license usage is
covered by IBM License Service Reporter. See also, Tracking license usage in
multicluster environment with License Service Reporter.
The purposes of improved contracts management are as follows:
• Managing contracts from one report
• Using contract metric calculation for products presented by computer groups

• Managing contracts that are not limited to predefined metrics
• Using the current measured metric value or software instances to drill down and view
contract details

Deprecation
Starting from version 10.0.9, the old contracts and other deprecated features
are removed, and migration is not possible. The customer must upgrade the deprecated
contracts before the upgrade. The custom saved reports that relate to the deprecated
report will not work as well. The customer must redefine them before the upgrade. See also,
Migrating contracts.

Actions
With the contracts management feature you can perform the following actions:
• Search for specific contract to complete outstanding actions
• Use predefined reports from dashboard to access saved reports.
• Define custom reports or email notification to access the contract status
The reports are categorized into the following types:
• Product and Metrics
• All Contracts
• Product Metrics per Group
Refer to the respective report type to know more about the actions you can perform on
individual report type.

Contract fields and values
The below table includes the fields and their values
Field name

Description

Importance

Name

Contract name. Two or more contracts can Mandatory
have the same name only if their types are
different.

Contract ID

Unique identifier of a contract.

Mandatory

Metric

Metric value of the contract.

Optional

Software Product

Any number of software products. If any

Optional

metric is selected, it must be assigned to
the selected software products.
Type

Type of the contract.

Mandatory

Computer Group

Computer group that the contract belongs

Mandatory

to.
Threshold

Threshold for the contract measured value. Optional

Purchase Orders

Any number of purchase orders assigned
to the contract. Each purchase order con
sists of the following values:
• Purchase Number - Identifier of the
purchase order. All purchase orders
in the contract must have different
purchase numbers. Mandatory.
• Document Link - Link to a document
related to the purchase order. Option
al.
• Vendor - Optional.
• Value - Value of the purchase order.
Can be set to non-negative number

Optional

Field name

Description

Importance

or ELA. To change the value type use
the “Convert to ELA” / “Convert to
number” button. Mandatory.
• Entitlement Start - Entitlement start
date of the purchase order. Mandato
ry.
• Entitlement End - Entitlement end
date of the purchase order. If not
specified, the purchase order is con
sidered to have no entitlement end
date. Optional.
Based on the provided purchase order val
ues, Current Contract Value, Next Entitle
ment Change Date, Next Entitlement Value
and Entitlement End Date values are calcu
lated. When a contract has no purchase or
ders, the values show ‘<no data>’.
Note: The Current Contract Value, Current Measured Value and Next Entitlement
Value are calculated based on UTC time zone.

Add, modify, and delete contracts in the All Contracts report
With All Contracts report, you can add, modify, and delete contracts.

Add contracts
1. Open the All Contracts reports.
2. Click Edit and select Add Contract. A New Contract window appears.
3. Enter the field values and click Save.
Result: A new contract is created.

Modify contracts
1. Open the All Contracts reports.
2. Select a contract, click Edit, and select Modify Contract. An Edit
Contract window appears.
3. Update the field values.

4. Click Save.
Result: The contract is updated.
Delete contracts
1. Go to All Contracts reports.
2. Select a contract, and click on Edit and select Delete Contract. A
confirmation dialog box appears.
3. Click Delete Contract.
Result: The report is updated.
Restriction: The add and edit contract window has the following constraints:
• The date format is always in MM/DD/YYYY format.
• The Select Year and Select Month labels in the date selector widget are not
translated. They are always in English.
• Software products with names containing non-ASCII characters cannot be
assigned to a contract (applicable to BigFix Inventory versions before 10.0.7).

Import contracts
Import contracts using the UI and the API. For more information, see also
Importing contracts.
From version 10.0.11, the All Contracts panel includes more options, such as
Recalculation of metrics and a link to access the Product Metrics per Contract report. For
more information, refer to 10.011 Using the Product Metrics per Contract panel and 10.011
Recalculating contracts.

Saved reports
The following contracts reports are included in the Saved reports list:

• Contracts: All
• Contracts: License Utilization Exceeded
• Contracts: License Ended
• Contracts License Ends in 30 Days
• Contracts: License Ends in 90 Days
• Contracts: Threshold Exceeded
• Contracts: Support Ended
• Contracts: Support Ends in 30 Days
• Contracts: Support Ends in 90 Days
You can access saved reports from the predefined reports dashboard. For more
information, see saved reports.

Creating contract custom fields
You can customize your contracts by creating custom fields that store your preferred
information about the software licenses in your environment. Select an appropriate name
for each custom field to reflect its purpose. After you create a custom field, it is available in
the Create Contract pane, among other fields that are required to create a contract.
You must have the Manage Contracts permission to perform this task.
1. In the top navigation bar, click Management > Contract Custom Fields.
2. To create a custom field for a contract, in the upper left corner of the Contract Custom
Fields window, click New.
3. In the Create Contract Custom Field pane, enter the name of the field, specify whether
the field is required for a contract, and choose the type of the requested input.

4. To save the custom field, click Create.
5. To make the custom field available for the reports, click Reports > Import Now.
You created a custom field for a contract. You can now create a contract or edit the existing
ones to add the values for the new fields.

Using the Product Metrics per Contract panel
Starting from version 10.0.11, the All Contracts panel provides an option to navigate to the
Product Metrics per Contract panel.
The Product Metrics per Contract panel includes the following features:
• The panel shows the current metric values for each product that is assigned to a
particular Contract.
• The panel is also enhanced by an additional column Recalculation Pending which
reflects the status of recalculation (applicable to all metrics), and Is Incomplete
column which indicates that the metric quantity might not be calculated correctly,
because hardware inventory data from at least one computer is not complete
(currently applicable only to Microsoft SQL Server Physical Processor Cores Metric).
• Depending on the type of a given metric, clicking on a selected product name redirects
you to the corresponding Software Classification, Software Users or All Metrics
reports. These reports lists all the software instances used for the calculation of
this metric. The link is disabled when calculation is disabled for the computer group
assigned to the contract, the calculation is not up-to-date, or the metric quantity
equals 0.
• The Product Metrics per Contract panel does not provide the option to set a metric
value for not calculated metrics. To set a metric value for not calculated metrics, go
to All Metrics reports and further set the value. See also, Setting and removing the
declared metric quantity.

Note: Product name link may not redirect to the target page if the local date
and time of your computer is different from the current date and time in UTC.
If the problem occurs, change the local date and time to UTC in your computer
to open the link.

Recalculating contracts
From version 10.0.11, you can recalculate contracts using the Recalculate option in the All
Contracts reports panel.
The recalculation can be done in the following scenarios:
• Contract has been changed
• Contract has been added or imported
• Product list or computer group have been modified in a Contract
Following are the different considerations under recalculation:
• The utilized metric values for contracts, shown under Current Measured Value column
are calculated during data import or on demand, for example, during recalculation.
• The metric values for contracts are stored in a separate database table (comparing
to reusing aggregation tables from All Metrics panel) which is synchronized with data
from All Metrics. So, the same rules apply (high watermark from the last x days for a
given computer group, 90 by default).
• After recalculation/reaggregation, the metric values are the same comparing to
the previous release, with one change: in case there are no discovered software
instances for a given contract's product, metric and computer group and the metric is
aggregable in BigFix Inventory, the value will be 0 instead of n/a.
• The limitation of the number of computer groups used in contracts is no longer
applicable.

Note:

• The All Contracts panel does not show the progress of recalculation. The
information on this panel is refreshed when the recalculation is complete. An
Recalculation Pending column is added to show that recalculation is needed.
• When a new computer group is added, BigFix Inventory requires you to run
another data import to correctly calculate the existing contracts.
• In case of any changes on Software Classification panel, like Exclusion
or Rebundling, data needs to be recalculated from All Metrics panel for
given computer croup, or by manual or scheduled data import. Otherwise
‘Recalculation Pending’ indicator appears on the All Contracts panel.

Migrating contracts
Attention:

Deprecated contracts have been removed. As a result, the

functionality to migrate contracts have also been removed. You must migrate
the deprecated contacts to the equivalent before upgrading the BigFix Inventory
server to 10.0.9. Once the server is upgraded, the deprecated features, such as
deprecated contracts and saved reports on deprecated panels, will be deleted and
will not be retrievable. The custom saved reports defined on removed panels must
be redefined. Before upgrading the server, make sure to back up your data.

Perform migration
To migrate deprecated contracts, perform these steps:
1. Go to Management > Contracts (Deprecated). Contracts (Deprecated) panel is
visible when deprecated_contracts_mgmt_enabled parameter is enabled. See also,
Parameter to enable deprecated contracts.
2. Select the contract and click Migrate.
3. In the Confirm Migration dialog box, click Migrate.
Result: Migration complete.

At the end of migration, a detailed report of the migration is displayed.

Migration features
• For each deprecated contract a new contract of license type is created.
• If Maintenance Start date is set in a deprecated contract, a new contract of support
type is created during migration.
• Contract ID is generated and suffixed with “_MIGRATED”
• New contract names include the names of software assigned to the deprecated
contract.
• Each new contract includes one purchase order with the same value as the
deprecated contract and the same start and end dates - entitlement dates for license
contract, maintenance dates for support contract. The purchase number is set to
“MIGRATED”
• Install Seats metric is assigned to the new contracts if all products assigned to the
contract are assigned to the Install Seats metric. Otherwise, metric is not set.

• If a software title version or release is assigned to a deprecated contract, a software
title product related to the version or release will be assigned to a new contract.
• Migrated report contains details, such as migrated contracts, not-migrated contracts,
custom fields which could not be migrated (but other elements of the contract were
migrated)
• Migration report is saved in logs.
• Migration does not modify deprecated contracts.

Prerequisites
• Migration can be run only by a user with an Administrator role.
• Software components cannot be migrated as they cannot be assigned to new
contracts (new contracts support Software products only).
• A deprecated contract cannot be migrated:
◦ if a new contract with the same name and type already exists
◦ if it is assigned to a deleted computer group
• A custom field value cannot be migrated if the value mismatches their type. Such a
situation can happen when a user changes type of already used custom field.
Since version 10.0.6, the ability to change custom field type is no longer available.
• Even if some contracts could not be migrated, other contracts are migrated

Importing contracts using CSV files
BigFix Inventory allows you to import contract data through API and Web UI.

Import contract features
BigFix Inventory import contracts have the following features:
• Allows you to create and modify contract details with data provided in a CSV file.
• Contracts are identified using the contract ID.
• Multiple software products can be added to a contract – one software product per
CSV row. You can not delete a software product.
• Software products, metrics and their relations specified in the CSV file must exist prior
to the import.

• Purchase orders are identified by Purchase Order Number.
• Multiple purchase orders can be added to a contract or modified – one purchase order
per CSV row. You can not delete a purchase order.
• Custom field columns are prefixed with CUSTOM_, for example, “CUSTOM_My custom
field”. The custom field column header is case sensitive.
• CSV separator can be modified in the Advanced Server Settings with the “CSV report
separator” (csvReportSeparator) property. Comma (‘,’) is default separator.
• In case an import fails, import report appears with errors details.
• CSV files must be encoded as UTF-8 (without BOM) format.
• Only ASCII characters in contracts data are fully supported in BigFix Inventory version
10.0.6. The issue is not applicable since version 10.0.7. From BigFix Inventory 10.0.7,
softwares which contains non-ASCII characters are accepted in contracts REST API,
as well as in the search field on UI, and contract fields like contract name in REST API
can contain non-ASCII characters.

Import through WebUI
To import using the WebUI, perform the following steps:
1. Click Reports > All Contracts. All Contracts page appears.
2. Click Edit and then select Import Contracts from the dropdown. Import contracts from
CSV file dialog box appears.
3. Select a CSV file and click Import.

Import through API
Example API request:

curl -H "Content-Type: multipart/form-data" \
-X POST \
-F upload[contracts]=@c:\contracts.csv \

https://localhost:9081/api/sam/v2/contracts/import?token=1234567890abcdef1
234567890abcdef123456

CSV file format
Contracts can be imported from a CSV file. The following tables lists the column names
available in the CSV file:
Column name
Contract ID

Description
Contract ID allows you to

Importance
Mandatory

identify a contract. The pur
pose of this field is to iden
tify main properties, such
as type and metric of a
contract. If a contract with
specified ID already exists
in BigFix Inventory, it is up
dated with the values from
CSV file. If it does not exist,
a new contract is created.
Name

Contract name

Mandatory

Metric ID

Metric ID

Optional

For metric ID names, see
also Metric IDs and code
names.
Metric Code Name

If Metric ID column is
present, the Metric Code
Name value is ignored. For

Optional

Column name

Description

Importance

metric ID names, see al
so Metric IDs and code
names.
Type ID

Number representing con

Required

tract type, such as 1 - Li
cense, 2 - Support, 3 - Ser
vice, 4 - Hardware, and 5 –
Other.
Computer Group ID

Identifier of the comput

Optional

er group. When provided,
Computer Group Name val
ue is ignored.
Computer Group Name

When both Computer

Optional

Group ID and Computer
Group Name are not pro
vided, then “All comput
ers” group will be assigned.
If no matching computer
group is found, the CSV
row is rejected. When there
is more than one computer
group with provided name,
the CSV row is rejected.
Note: Case sensi
tive
Threshold

Theshold value

Optional

Column name

Description

Importance

Note: Positive inte
ger
Publisher Name

Publisher name is required

Optional

only when Software Prod
uct Name is specified. The
publisher must exist in Big
Fix Inventory before import.
Product Name

Name of the product.

Optional

The product must exist in
BigFix Inventory before im
port.
Purchase Order Number

Purchase order number

Optional

Purchase Order Document

Document link of the pur

Optional

Link

chase order.
If specified, requires Pur
chase Order Number to be
present.

Purchase Order Vendor

Vendor of the purchase or

Optional

der.
If specified, requires Pur
chase Order Number to be
present.
Purchase Order Value

Purchase order value. Val

Optional. Required if Pur

ue is always a positive inte chase Order Number value
ger (including 0). ELA val
ue can be set by specify
ing ELA or -1. If specified,

is provided

Column name

Description

Importance

requires Purchase Order
Number to be present.
Purchase Order Entitle

Entitlement start date of

Optional. Required if Pur

ment Start

the purchase order. The

chase Order Number value

allowed format is "YYYY-

is provided.

MM-DD", for example
"2019-01-31". If specified,
requires Purchase Order
Number to be present
Purchase Order Entitle

Entitlement end date of

ment End

the purchase order. This
value is optional. Allowed
format is "YYYY-MM-DD",
for example, "9999-12-31"
or "Never". If specified,
requires Purchase Order
Number to be present.

Custom fields

Any number of option
al columns representing
contract custom fields.
The fields must be already
present in BigFix Invento
ry. When provided custom
field is not found (does not
exist), CSV import fails.
Column names for cus
tom fields are prefixed with
"CUSTOM_", such as "CUS
TOM_My Custom Field".
Provided value type must

Optional

Column name

Description

Importance

match the type of the cus
tom field. If the the custom
field is required, then the
value must be provided.

Assumptions, limitations and restrictions of the CSV imports:
• First row of the CSV file (header) contains field names.
• Unused, optional columns can be omitted.
• Import of the CSV adds new Software Products to a contract and does not remove
existing entries.
• Import of the CSV adds new or updates existing Purchase Order entries (matching on
Purchase Order Number value) and does not remove existing entries.
• In case multiple Software Products and/or Purchase Order need to be added, they
need to be specified in separate rows (repeating the contract specific fields, like.
name and computer group).
• Column names and values need to be separated by a character specified
in BigFix Inventory Advanced Server Settings with the “CSV report
separator” (csvReportSeparator) property. Comma (‘,’) is default separator.
• If column header or value contains a separator character, it needs to be enclosed in
quotes.
• CSV rows are processed in the order they are defined in the file. If one contract
is defined in multiple rows, all values except Publisher Name, Product Name and
Purchase Order fields should be repeated in every column. Otherwise, contract values
updated by one row may be later modified by further rows. Subsequent imports of the
same CSV file will produce the same outcome.
• Purchase Order Document Link, Purchase Order Vendor, Purchase Order Value,
Purchase Order Entitlement Start and Purchase Order Entitlement End columns can
be present in the CSV file only when Purchase Order Number column is present.
• A failure of importing a single contract row fails whole import. Already imported rows
are rolled back.

Known issues
• Custom fields for error messages are identified using the ID. The ID is retrieved using
contracts API. To view the list of all custom fields, view the Contracts API.

CSV Example with multiple contracts
Contract ID, Name, Type ID, Threshold, Metric Code Name, Computer Group ID,
Computer Group Name, Purchase Order Number, Purchase Order Value, Purchase
Order Entitlement Start, Purchase Order Entitlement End, Product Name,
Publisher Name, CUSTOM_contact person
CO1, Contract 1, 3, 100, INTERNAL_INSTALL, 0, All Computers, PO1, 5000,
2021-08-03, 2030-05-20, Software 1, Publisher 1, Name
CO2, Contract 2, 2, 350, CLIENT, 0, All Computers, PO2, 2, 2019-05-21,
2025-06-21, Software 2, Publisher 2, Tom

CSV Example with multiple Purchase Orders and software products assigned
to two contracts
Contract ID, Name, Metric Code Name, Type ID, Computer Group ID, Threshold,
Publisher Name, Product Name, Purchase Order Number, Purchase Order
Document Link, Purchase Order Vendor, Purchase Order Value, Purchase Order
Entitlement Start, Purchase Order Entitlement End
Contract 1, My contract 1, TICKETS,3,2,12, Publisher A, Sample Product A,
PU001, www.test.com, My Vendor A,125,2019-03-03,2044-07-11
Contract 1, My contract 1, TICKETS,3,2,12, Publisher A, Sample Product B,
PU002,www.test2.com, My Vendor B,ELA,2020-03-03,
Contract 1, My contract 1, TICKETS,3,2,12, Publisher B, Sample Product C
Contract 2, My contract 2, CLIENT,1,0,70, Publisher A, Sample Product B,
PU003,www.test3.com, My Vendor C,200,2018-01-01,2021-12-28
Contract 2, My contract 2, CLIENT,1,0,70,,, PU004, www.test4.com, My Vendor
D, 100,2020-01-01, 2021-03-28

Hands-on tutorial for contract management
This section details out the concept of contracts, the various tasks you can perform using
contracts and the prerequisites you need to perform those tasks.

Definitions used in contracts operation
This topic lists important definitions that are used in contract management.
Computer group
An organized list of computers through which users can get dedicated
reporting or perform common operations in bulk. This feature simplifies the
maintenance of customer environments, and it can be used to represent, for
instance, a department or region.
Software License
A legal instrument governing the use or redistribution of software.
Metric
A measurement unit that defines usage of software license, for example,
installed seats, and PVU.
Software Contract
A set of information about a software license for a product or products,
its type, cost, amount of purchased license metrics, and the entitlement
period. When a contract is assigned to a computer group, it indicates which
computers the license is distributed to.
Purchase order
A set of information about purchased software.

Contracts overview
BigFix Inventory Contract Management feature enables organizations to increase visibility
into their software license consumption and to keep licenses compliant. It helps to avoid
overusing licenses (a situation where the software license goes beyond the terms agreed

in the contract with the supplier). It also helps to optimize software cost by identifying
underused licenses.
The diagram below provides an overview of the entire contract management in BigFix
Inventory.

Note: In future release, features such as, All Metrics Threshold, Threshold
Delta, Metric Custom Fields (panel and added fields), and the related API will be
deprecated.

Prerequisites
To access contracts, you must have permission to manage contracts.
Required permission: Manage Contracts

Contract features
This topic describes the panels needed to manage contracts.
All Contracts

On ‘All Contracts’ panel you can add and modify contracts. You can also
view the comparison with the discovered software and calculated license
metrics. To allow BigFix Inventory provide data for the comparison, classify
the discovered components under appropriate license metrics.

Products and Metrics
On ‘Products and Metrics’ you can view the list of software products (licenses)
and associated license metrics that you can manage in contracts. You can
add new products and new metrics as well as assign existing metrics to
products in ‘Products and Metrics’ panel as required.

Software Classification
On ‘Software Classification’ panel you can classify discovered components to
applicable products and metrics. It allows BigFix Inventory to calculate license
metrics for products, compare Software Inventory and calculate license
metrics with your contracts.

This document focusses on key aspects of contract management in BigFix Inventory and
how to handle real-life scenarios.
For more information about contract reports, see All contracts.

Considerations before creating a contract
When using contracts in BigFix Inventory, you can set multiple attributes of the contract.
Following are the key attributes:
• Contract type
• Assign one or more software products (licenses) to a contract
• Add applicable Purchase Orders
• Assign the contract to applicable computers
Before creating a contract in BigFix Inventory you should know the answer to the following
questions about your license entitlement:

• Do you have separate agreements for support and license?
• What license metric does it cover? Do I need to add a new license metric to BigFix
Inventory?
• What product versions does it cover? Is it limited to given version or release? Or
maybe it covers any version of given software can be used with this license.
• What software products does it cover? Is it a special software bundle?
• How are these products represented in BigFix Inventory product definitions?
After having answers to these questions, you can create a contract.

Managing product and metric definitions in BigFix Inventory
In BigFix Inventory, a product definition and associated metrics represents what you can
purchase. You can assign one or more license metric to one product definition. Together,
the product definition and associated metric represent what you can purchase (license).
On ‘Products & Metrics’ panel you can browse available product definitions and associated
metrics, create new product definitions, create new metrics, and associate metrics to
product definitions.

1. Use filters to search through product definitions. On ‘Products & Metrics’ panel you
can browse available product definitions and associated metrics, create new product
definitions, create new metrics, and associate metrics to product definitions.

2. Add a new license metric.

3. Assign a metric to a product.

4. Add a new product definition.

Choosing contract type
You can manage contracts for a software product individually. This is useful if there are
different agreements and purchase order with a software vendor for software licenses as
well as support. If both software licenses and support have one agreement, and you do
not want to manage them individually, you can create one contract that represents both
software and support.
To choose contracts, follow the below path:
• Reports > All Contracts > Edit > Add new contract

There are four types of contracts:
• License - This is the default type of a contract. Select contract type as 'License' if
the time period mentioned in the license and support agreements is the same, select
contract type as 'License'.
• Support - Select contract type as 'Support' if the time period mentioned in the license
and support agreements is not the same. In such case, create separate contracts for
license and support.
• Service - Select contract type as 'Service' to manage contracts for purchased
professional services if they have different period or metric for license and support.
• Hardware - Select contract type as 'Hardware' to manage your contract for Hardware.

Assigning products to contracts
In BigFix Inventory, generally all versions of a software product are grouped into one product
definition, as in most cases licenses are not bound to a particular software product version.
However, for some products the most commonly sold licenses are for a particular software
version. In these cases, BigFix Inventory defines product definitions differently for applicable
software versions (for example, Microsoft Windows Server).
Follow the below scenarios while assigning products to a contract:
• Product definition follows your license agreement
• Product definition covers all versions, but license agreement covers a specific version
or subset of product versions
• License agreement covers multiple product definitions
The following subsections describe these scenarios in more details.

Product definition follows your license agreement
If you purchase a license for Total Commander and this license allows you to install any
version of Total Commander. In BigFix Inventory Software catalog there is one product
definition for Total Commander regardless of its version. In such situation during creation of
a contract you need to assign the existing product definition to the contract.

Product definition covers all versions, but license agreement
covers a specific version or subset of product versions
In case, you purchased a license for Microsoft SQL Server Enterprise Edition without
Software Assurance and this license allows you to install only Microsoft SQL Server 2019
Enterprise Edition. BigFix Inventory contains one product definition that groups all versions
of Microsoft SQL Server.
In such case you need to create a product definition in ‘Products & Metrics’ for Microsoft
SQL Server 2019 Enterprise Edition and assign to it an applicable license metric.

Once the product is created, you need to add this product to a contract.

Classify all discovered components of Microsoft SQL Server 2019 Enterprise Edition to the
newly created product and assigned metric (note that you can use Custom Rules for that job
to automate action) and add this product to your contract in BigFix Inventory.

License agreement covers multiple product definitions
In case, you purchase a license for Microsoft Windows Server Standard Edition with
Software Assurance that allows you to install any version of this product. In BigFix Inventory
each version of Microsoft Windows Server Enterprise Edition has a separate product
definition.
In such case you need to create a contract in BigFix Inventory and add to it all products
for different versions of Microsoft Windows Server Standard Edition. Note that when you
browse through product definitions in ‘Products & Metrics’ you can observe that Windows
Server Standard has the metric ‘Unknown’ assigned by default. You should assign to it an
appropriate license metric according to your license agreement.

After assigning an appropriate metric to a product you can add these products to a contract.
Classify the discovered component to appropriate products and license metric, if necessary.

Assigning a contract to applicable computers
If you purchase a license for an organization that is part of your company (for example,
HR), you can create a computer group that represents this organization and assign this
group to your contract. You can find more information about computer groups at Setting up
computer groups.
Note: In order to enable calculating license metrics for this group, this group must
have license calculation enabled.

Once the computer group is created, you can add it to a contract.

Note: By default, metrics are calculated for 90 days and on 'All Metrics' panel you
can see a maximum value of a metric in that period and this maximum value is used
to compare contract with the calculated metrics. If you like to use a shorter period,
you can create a Computer Group and configure it to lower number of aggregated
days to, for example, one day. The shorter period may be useful if you like to see
more current value of a license metric than the maximum value for last 90 days in
the contracts.

Managing contracts with metrics that are not calculated by BigFix
Inventory
BigFix Inventory does not calculate license for every type of license metric, including the
custom metrics. For a list of calculated license metrics, see Reported license metrics.
You can create contracts for these metrics and manage their values. For instance, you have
a license contract for Windows Server 2016 Standard and you want to create a contract

for Microsoft Windows Server 2016 Standard with Microsoft Client Access License (CAL)
metric.
You can create such contracts as described in this document. There are some additional
considerations for classifying the discovered components and you will find instructions
below.
1. Before you start, you need to create a new license metric.

2. Assign this metric to a product.

3. Add a contract with this product and metric.

4. After adding the contract, classify all instance components that are part of this
product to this metric. It is similar to what was described in the previous scenarios.
If you measure CAL license for this product you can enter its value in ‘Product Metrics
per Group’.
5. After that the value of metric is defined, delta and threshold is visible on ‘All contracts’
report.

Managing products that are licensed to more than one metric
Some software titles require entitlements for two or more license metrics. For example,
Microsoft Windows Server, which requires you to purchase CPU Cores license as well as
CAL license. In this case, you need to create two contracts for Microsoft Windows Server;

one for CPU Cores and one for CALs. In order to enable BigFix Inventory to compare these
contracts with license metrics, you need to classify the discovered components accordingly.
1. Classify component to the first metric.

2. Classify the same component to the second metric and choose ‘Share components’
option.
Result: On the ‘Software Classification’ panel, you can see two rows for every component
instance; one for ‘Microsoft Physical Processor Core with SA’ metric and another for ‘CAL’
metric.

Changing default license usage reporting period
By default, metrics are calculated for 90 days and on 'All Metrics' panel you can see a
maximum value of a metric in that period and this maximum value is used to compare
contracts with the calculated metrics. If you would like to use a shorter period, you can
change configuration of computer group in BigFix Inventory to lower number of aggregated
days to, for example, to one day. Note, that if you have IBM software and you would like
to get IBM Subcapacity reports in BigFix Inventory, it is not advisable to decrease the
reporting period below 90 days. In such cases you need to setup different reporting period
as described in document section ‘Achieving different reporting periods’

Using different license usage reporting periods
In some cases, you may want to have two different usage license reporting periods. For
example, you may have IBM software, which generally requires 90-day reporting period
and reports like ‘All metrics’ as well as ‘Contracts’ should follow that period. However,
for other publishers you may want to have a shorter reporting period to see more current

maximum value of license metrics. In such case you should have two computer groups, one
for reporting of IBM licenses, second for other reporting of other publishers.
To achieve that you need to keep the default licensing reporting in one computer group and
use it for IBM license reporting

Next you need to create a computer group with a different reporting period, for example 1
day and use it in your contracts as on a figure below.

Managing purchase orders
In your contracts you can manage purchase orders. To each contract, you can add one or
more applicable purchase orders, their license metric value as well as when entitlement
starts and optionally when it ends.

Managing multiple purchase orders in a contract
If you add multiple purchase orders to a contract, BigFix Inventory calculates the current
contract value taking into consideration purchase orders validity periods. It also provides
you with information about the next date when a contract value is going to be changed
together with contact value at this date.

Managing Enterprise License Agreement (ELA) purchase orders
If you sign an Enterprise License Agreement (ELA) contract that allows you to use a
particular product without usage limit, you can also manage it in BigFix Inventory.

1. Create a contract and add a Purchase Order to it.

2. Click ‘Covert to ELA’ to convert the Purchase Order as well as contract into ELA.

Note: For contracts with ELA, contract delta data is not available

Managing purchase orders that cover multiple metrics or products
One purchase order may cover entitlements for different license metrics for the same
product, multiple products or both license and support entitlements. In such case, add this
purchase order to multiple applicable contracts.
For example, you have a purchase order for Microsoft Windows Server 2016 Datacenter and
it covers 16 CPU Cores and 100 CALs. In that case, you need to assign this purchase order
to two contracts.
1. First, add this purchase order to Microsoft Core license contract.

2. Add this purchase order to Microsoft CAL license contract.

Result: After you complete the process, on the ‘All Contracts’ reports, you can see two
contracts with their values corresponding to their purchase orders.

Managing email notifications for contracts that passed through
the threshold value
You can specify the threshold metric value in a contract, that is a ‘warning’ point of license
usage when you may need to take an action like acquiring additional license entitlements to
keep license compliance.

You can set up an email notification when license consumption has passed the compliance.
To set up the notification, define a filter on ‘Contracts’ panel to show contacts whose
threshold delta is below zero.

Save the report with a custom name.

Select Export > Schedule reports to schedule the saved report to be sent by email.

Software discovery in containers
BigFix Inventory supports discovery of software in container images through standard
discovery methods that includes catalog signatures, template signatures, installation
registry and ISO SWID tags to cover traditional model of software deployment.
In addition, the application provides information about software running in containers, the
container instances with basic properties and their current status. This information allows
to determine the software deployment across container resources that are allocated.

A new plugin framework is available to communicate to the Kubernetes APIs of on-premise
and public cloud containers to determine software usage of container instances.
Collection of container details is with the use of two configurations:
• Kubernetes-based solutions that are compatible with standard Kubernetes API v1.18
or newer. For details, see notes.
• Generic Kubernetes API available in case own access method is preferred.
Note: Examples of compatible solutions verified in test lab environment are Vanilla
(unmodified) Kubernetes v1.18, v1.21, and v1.23, Google Cloud v1.20, and Red Hat
OpenShift Container Platform v4.9. For information on how to verify BigFix Inventory
Containers solution with your Kubernetes cluster, refer to the section “Kubernetes
Cluster Test Procedure” in the detailed containers document.
For managing IBM software in Containers, refer to the IBM strategy and solution FAQ.
BigFix Inventory is certified for IBM Virtualization Capacity License reporting on physical
machines, virtual machines on-premise and in the cloud. For IBM Certified Containers the
only approved licensing counting is through IBM License Service. For feedback or questions
regarding this capability, contact IBM.
Currently, BigFix Inventory Software Discovery in Containers is limited to software discovery
only without license management capability but provides visibility to a large set of vendor
software in Kubernetes compatible environments including Red Hat OpenShift.
As BigFix Inventory feature improves, support for a wide variety of license management
within containers will be added, beyond IBM/Red Hat container license management, such
as Microsoft, Adobe, SAP, HP, BMC, CA, Citrix, Corel Symantec, TIBCO, and VMware.
HCL looks forward to continue partnership with IBM/Red Hat to address their container
license management as a leading software vendor.
The detailed containers document is available as PDF accessible through link “Discovering
software inventory with BigFix Inventory Container Solution” on “Download the BigFix
Inventory Container Solution Packages (version)” fixlet.

Software data harvesting tool
BigFix Inventory provides a Software Data Harvesting Tool for BigFix Inventory which is
part of BigFix Inventory Catalog Enhancement Program. The purpose of this program is to
provide users with better discovery capabilities for the software installed on their Windows
endpoints.
Note: The detailed document is available as PDF accessible through "Run Software
Data Harvesting Tool" fixlet.

Managing security threats
Learn how to use to manage security threats in your environment. You can view whether
any of the installed components is prone to any Common Vulnerability and Exposure (CVE).

Collecting file checksums
Available from 9.2.3. Checksums are long strings that describe the content of files
and act as their fingerprints. You can enable the calculation of checksums for files on your
computers to check their integrity and to ensure that they were not altered or tampered with.
In general, checksums are used to ensure safe transmission of files between devices,
or across the Internet. In the latter case, after downloading a file, you can calculate its
checksum and then compare it to the original checksum that was published together with
the download. If both checksums match, you know that your download is exactly the same
as the published source file, and that it is secure. Otherwise, there was some data loss or
alteration, which means that the file was corrupted, either by accident or intentionally.
In BigFix Inventory, checksums are calculated during the file system scan and are created
for each file that is discovered by the scan. In other words, apart from collecting usual
information about files, such as their version or size, the scanner also collects information
about their checksums. The checksums can then be viewed in the user interface or
retrieved by using REST API, and compared to the checksums of known virus signatures
or malware to ensure that none of such files is present in your environment. If any of the
collected checksums finds a match in the database of corrupted checksums, there is a
high probability that the file associated with this checksum is not secure, and presents a
potential security breach.
Checksums in BigFix Inventory can be calculated by using two hash functions, MD5 and
SHA-256. The choice of either of these should depend on the database of corrupted
checksums that you own, and that you can compare with checksums collected by the scan.

Enabling the collection of checksums
Available from 9.2.3. You enable the collection of checksums by running a
fixlet that changes the configuration of the software scan for BigFix Inventory. When you

select checksums and run the fixlet against a chosen endpoint, this endpoint is given new
properties that represent either MD5, SHA-256, or both. Based on these properties, the
software scan can recognize which checksums must be collected from an endpoint. If you
choose just one type of checksum and want to add another one later, you need to run the
fixlet again.
• Upgrade the BigFix Inventory server to version 9.2.3, or higher.
• If you upgraded from previous versions, stop all Initiate Software Scan actions, and
rerun the software scan against your endpoints. The software scan was changed to
collect checksums, and must be started from the updated fixlet.
• Divide your environment into scan groups to distribute the load of the imported data:
◦ If the extended data import (three times longer) is acceptable, enable the
collection of file hashes for all scan groups, and collect the data according to
schedule.
◦ If the extended data import does not meet your expectations, rearrange your
scan groups into smaller ones with fewer endpoints to lower the amount of data
included in a single data import. After the first import is completed for all scan
groups, you can go back to the previous setup.
It is important that you enable checksums for a small group of endpoints. After data from
the first group is imported to BigFix Inventory, proceed to the next group. Because of the
checksums, each file is detected as changed. By default, BigFix Inventory imports the delta
file system scan, so only data that changed since the last scan. However, when it detects
too many changes, it always chooses the full file system scan over the delta file system
scan. Importing so many results might overload your data import. In such a case, you must
recover from accumulated scans. This applies not only to enabling the checksums for the
first time, but also to each change, such as adding a new type of checksum to be collected,
or removing it.
1. Log in to the BigFix console.
2. In the navigation bar, click Sites > External Sites > BigFix Inventory v10 > Fixlets and
Tasks.
3. In the upper right pane, select Configure File Checksums Collection (MD5/SHA-256).

4. Select the types of checksums that you want to collect, either MD5, SHA-256, or both.

Important: Always select all checksums that you want to collect, especially if
you are running the fixlet for the next time. New properties always overwrite
the previous ones.
5. Click Take Action.
6. Select the computers from which you want to collect checksums, and click OK.
7. Optional: In the navigation bar, go to Analyses, select File Checksums Collection
Settings (MD5/SHA-256), and click Activate. The analysis shows which checksums
are collected from your endpoints.

Checksums are displayed in BigFix Inventory after the next software scan finishes and its
results are imported from BigFix during the import of data.
In an environment with 60 000 endpoints divided into 6 scan groups (each with 10 000
endpoints), where each scan group is scanned on a different day, the file hashes will be

collected in 6 days. The initial import for each scan group after enabling the collection
might be three times longer. Next imports will take about 10% longer.
Impact of file hashes on the BigFix Inventory database size
For both DB2 and SQL Server databases, the collection of file hashes (MD5 and SHA-256) is
expected to result in a 20% growth of the disk space consumption.
Impact of file hashes on the BigFix client
File hashes are calculated during the software scan and the results are gathered on the
endpoint. The size of scan results will increase by about 5%. For an average endpoint with
30 matched and 800 unmatched raw data files, an additional 0.5 MB of disk space might be
consumed.
You can view the checksums in the user interface or retrieve them by using REST API.

Viewing checksums in the user interface
Available from 9.2.3. To view checksums in the user interface, you must enable
columns that show this data. It can be useful to verify checksums of single files. For bigger
amounts of files, use REST API that can retrieve all collected checksums at once.
1. Log in to BigFix Inventory.
2. Go to Reports > Scanned File Data.
3. Hover over the Manage Report View icon

, and click Configure View.

4. Select the MD5 or SHA-256 check box, and then click OK.
Checksums for each file are shown in the appropriate columns.

Retrieving checksums through REST API
Available from 9.2.3. To retrieve information about checksums, you can use REST
API that is generally used to retrieve raw scanned file data. This API retrieves information
about scanned files, such as name, size, version, path, and so on. It can also return the
values of the MD5 and SHA-256 columns, which show the checksums.

Before you begin
This topic is only an excerpt from the REST API call, intended to show specific examples
that can be used to retrieve the MD5 and SHA-256 checksums. For more information, see
REST API for retrieving raw scanned file data.

Sample columns
The following response body shows default columns that can be retrieved by using this
REST API. You can use the names of the shown columns while creating your REST API
requests. If you do not specify any columns in the request, all of them are returned.
{
"scan_file_id": 3,
"computer_id": 5,
"path": "C:\BES\BESAirgapTool",
"name": "BESAirgapTool.exe",
"full_path_sha1": "9eb46086883dcbb6d2aefa2d6fd40bf8e736621b",
"size": 92174,
"version": null,
"md5": "8cb2289800b34ef1a5f472f7177348e2",
"sha256":
"99e0c7c22c9ad735ec766914f0af17449a83681de22db7ce16672f16f37131bec0022371d
4ace5d1854301e0",
"valid_from": "2015-07-31T07:03:21Z"
"valid_to": "9999-12-31T23:59:59Z"
}

Examples
Example 1: Retrieving information only about name, computer name, path, MD5, and
SHA-256 columns.
Request:
https://hostname:port/api/sam/raw_file_facts?token=token
&columns[]=name&columns[]=computer.name&columns[]=path&columns[]
=md5&columns[]=sha256

Output:
{
"path": "C:\BES\BESAirgapTool",
"name": "BESAirgapTool.exe",
"md5": "8cb2289800b34ef1a5f472f7177348e2",
"sha256": "99e0c7c22c9ad735ec766914f0af17449a83681de22db7ce166
72f16f37131bec0022371d4ace5d1854301e0",
"computer":{
"name":"NC581058"}
}

Example 2: Retrieving information about files with a specific MD5 checksum.
This example can be used to quickly find a corrupted checksum.
Request:
https://hostname:port/api/sam/raw_file_facts?token=token
&criteria={"and":[["md5","=","8CB2289800B34EF1A5F472F7177348E2"]
]}

Output:
{
"scan_file_id": "6",

"computer_id": "3",
"path": "C:\Files",
"name": "arch.exe",
"full_path_sha1": "9eb46086883dcbb6d2aefa2d6fd40bf8e736621b",
"size": 2032,
"version": null,
"md5": "8cb2289800b34ef1a5f472f7177348e2",
"sha256": null,
"valid_from": "2015-12-10T11:37:14Z",
"valid_to": "9999-12-31T23:59:59Z"
}

Example 3: Retrieving information about name, computer name, path, and MD5
columns for all word.exe files that have a different MD5 checksum than the
specified one.
This example can be used if you know that a file should have a specific
checksum. You can therefore retrieve all files with other, corrupted
checksums.
Request:
https://hostname:port/api/sam/raw_file_facts?token=token
&columns[]=name&columns[]=computer.name&columns[]=path&columns[]
=md5
&criteria={"and":[["md5","!=","8CB2289800B34EF1A5F472F7177348E2"
],["name","=","word.exe"]]}

Output:
{
"path": "C:\Programs",
"name": "word.exe",
"md5": "6cb1465800b34ef1a5f376f717743t6",
"computer":{

"name":"NC581058"}
}

Preview: Checking Common Vulnerabilities and
Exposures (CVEs)
Available from 9.2.12. The software catalog contains information about Common
Vulnerabilities and Exposures (CVEs). Browse the software catalog to check for any
potential threats. Checking CVE in BigFix Inventory is a preview feature.
Common Vulnerabilities and Exposures (CVE) is a list of known security threats that are
assigned identification numbers. BigFix Inventory uses CVE that is provided by the National
Vulnerability Database at https://nvd.nist.gov/ to help you identify potential threats in your
environment.
Order of CVEs
Potential threats are displayed in the Vulnerability Risk (Preview) column. If matched, CVEs
are sorted in descending order by the base score, and then the CVE identifier. They are not
ordered by severity. The base score and severity are assigned according to the Common
Vulnerability Scoring System (CVSS). When CVSS v3.0 is available, it takes precedence over
CVSS v2.0.
CVE details
When you click the View Details icon

next to the CVE identification number, you are

presented with the details of the relevant CVEs such as their names, severity and CVSS.
If there are more CVEs matched with a particular component, you can view them on the
detailed list. You can export the report view to CSV or PDF for additional processing. The
exported report contains a full list of names of relevant CVEs.
Limitations
• CVE description might not always represent accurate information about the vulnerable
versions. As a result, despite upgrading the patch and referring to the BigFix Inventory
detailed component version, CVE might be listed. Refer to the latest CVE description
in National Vulnerability database.

Example: CVE-2015-1728, Windows Media Player and all 12.x versions are affected.
There is no fix available for 12.x versions. Hence, 12.x is listed under the CVE in BigFix
Inventory.
• For best results, update the NVD feed. To learn about updating the CVE, refer to
Updating information about Common Vulnerabilities and Exposures (CVE).
• BigFix Inventory provides Component Detailed Version (patch/fix pack level) reporting
for selected software components. In such case, the NVD feed provides correct
information about versions related to the issue, but CVE still lists the versions in
BigFix Inventory as generic discovery.
• CVEs that are listed in the National Vulnerability Database might impact software that
is installed only on a particular operating system. BigFix Inventory does not take this
fact into account while matching CVEs to components.
• If the name of a component or its publisher is different in BigFix Inventory and in the
National Vulnerability Database, CVEs might not be matched in BigFix Inventory.
• If the detailed version of the component is significantly different from its version,
CVEs might not be matched in BigFix Inventory.
•

The following aliases were added to improve the CPE generation and
vulnerability matching:
◦ RedHat alias for the Red Hat publisher.
◦ Apache alias for the Apache Software Foundation publisher.

Log in to BigFix Inventory and open one of the following reports.
•

Go to Reports > Software Classification. To display the Vulnerability Risk
(Preview) column, click the Manage Report View icon

, click Configure View, and

select the Vulnerability Risk (Preview) column to display it on the report.
CVEs on this report are matched with the particular software component through its
detailed version.

• Go to Reports > Software Components. Common Vulnerabilities and Exposures are
displayed in the Vulnerability Risk (Preview) column.
The report lists components in a particular version. However, CVEs that are matched
relate to versions and their patches.

Note:

You can filter and sort both reports by CVE names.

• To show components for which any vulnerability was matched, specify the
following filter: Vulnerability Risk (Preview), is not empty.
• To show components for which a specific vulnerability was matched, specify
the following filter: Vulnerability: CVE Name, contains, and provide the
name of the CVE.
For better performance, combine these two filters whenever you want to search for
components for which a specific vulnerability was matched.

Updating information about Common Vulnerabilities and
Exposures (CVE)
Available from 9.2.12. Common Vulnerabilities and Exposures (CVE) list is
integrated with the software catalog and updated with each upgrade of BigFix Inventory.
Use this procedure if you require more frequent updates.
• You must have access to the computer where the BigFix Inventory server is installed
with permissions to paste files into the installation directory of BigFix Inventory.
• To perform the described actions, you must have the following tools installed:
◦ GNU Wget
◦ unzip tool
◦ sha256sum
CVE contains a list of known security threats that are assigned identification numbers.
Thanks to the import of CVE to BigFix Inventory, you can browse your software inventory
and identify potential threats in your environment.
Information about CVE is automatically updated during every upgrade of BigFix Inventory.
Use this procedure if you require to update CVE between the subsequent releases of BigFix
Inventory.
Note: The procedure describes how to update CVE files with a semi-automated
method. Alternatively, you can perform each step manually.
1. To download the zip CVE files, including json files and the relevant meta files from
the National Vulnerability Database, run the following command.
wget --secure-protocol=auto -r -A
nvdcve-1.0-20*.meta,nvdcve-1.0-20*.json.zip
https://nvd.nist.gov/vuln/data-feeds

The files are downloaded to the following location: nvd.nist.gov/feeds/json/
cve/1.0.

Important: Do not change names of the downloaded files.
2. Optional: Ensure that you downloaded the appropriate files.
a. To unpack the packages that contain json files, run the following command.
unzip '*.zip'

b. To generate SHA-256 for each json file, run the following command.
sha256sum file_name.json

c. Compare SHA-256 from each json file with SHA-256 from the relevant meta
file.
Both values should be the same.
3. Copy all zip CVE files to the following directory on the computer where the BigFix
Inventory server is installed:
•

installation_directory/cve_data

•

installation_directory\cve_data

4. Wait for the scheduled import of data or run it manually.
The list of common vulnerabilities and exposures is populated to BigFix Inventory. To check
information about CVE, go to Reports > Software Components. The vulnerabilities are listed
in the Vulnerability Risk (Preview) column for each relevant component.

Tutorials
Tutorials help you understand how to use . They consist of modules that focus on broad
goals. Modules consist of tasks that show how to configure specific settings step-by-step.

Tutorial: Reporting subcapacity usage per computer
group
Available from 9.2.2. In this tutorial, you will learn how to create computer
groups that allow for managing software and generating audit snapshots for a subset
of computers. You can use such groups to report PVU consumption for BigFix software
installed in multiple BigFix subcapacity regions or to manage software per organizational
business unit.
Managing software per computer group can be used in the following scenarios:
• You have BigFix software that is installed in multiple BigFix subcapacity regions. For
more information, see: BigFix subcapacity regions.
• You want to separately manage software that is installed in each business unit in your
organization. For more information, see: Organizational business units.
Learning objectives
After you complete the lessons in this tutorial, you will know how to perform
the following tasks:
• Divide the computers in your infrastructure into BigFix computer groups.
• Define the scope of audit snapshots by creating computer groups in
BigFix Inventory.
• Import part numbers and manage software per computer group.
• Generate audit snapshots per computer group.
Time required
This module should take 45 minutes to complete. If you explore other
concepts related to this tutorial, it can take longer to complete.

Audience
• Customers who have BigFix software installed in multiple BigFix
subcapacity regions.
• Customers who want to manage software per organizational business
unit.
Prerequisites
• Install the scanner on all computers that you want to monitor. For more
information, see: Installing the scanner.
• Configure VM managers that control virtual machines in your
environment. For more information, see: Managing VM managers.
Conventions used in this tutorial
This tutorial is based on the example of creating computer groups that reflect
BigFix subcapacity regions.
Lessons in this tutorial
The tutorial contains the following lessons:
1. Lesson 1 (Optional): Creating computer groups in the BigFix console
2. Lesson 2: Creating computer groups that define the scope of reports
3. Lesson 3: Managing software and generating audit snapshots per
computer group

Lesson 1 (Optional): Creating computer groups in the BigFix
console
Available from 9.2.2. You can divide the computers in your infrastructure into
BigFix groups. They are used to manage the infrastructure, and run Fixlets against selected
computers. They are not automatically copied to BigFix Inventory. However, they can be
used as the basis for creating computer groups that define the scope of reports in BigFix
Inventory.

Important: This lesson is optional. If you do not want to create separate scan
schedules for each computer group, skip this lesson and proceed to the next one.
1. Log in to the BigFix console.
2. Create a computer group that contains all computers that are located in the first
BigFix subcapacity region: North and South America.
a. In the top navigation bar, click Tools > Create New Automatic Computer Group.
b. Provide the name of the computer group.
For example, Americas.
c. Select the site and domain in which you want to create the computer group.
d. Specify criteria that must be met by the computers that belong to this group.
For example, add all computers whose DNS name contains .us.

e. To save the group, click Create.
3. Create computer groups for the remaining BigFix subcapacity regions in which you
have computers.
4. For every computer group, schedule scans and uploads of scan results.
For more information, see: Initiating software scans and Uploading software scan
results.

You created computer groups in the BigFix console. To generate audit snapshots for a
subset of computers, create analogical computer groups in BigFix Inventory.

Lesson 2: Creating computer groups that define the scope of
reports
Available from 9.2.2. To manage software and generate audit snapshots for
subsets of computers, divide the computers in your infrastructure into groups in BigFix
Inventory.
If you created computer groups in the BigFix console, run an import to ensure that
information about these groups is available in BigFix Inventory.
1. Log in to BigFix Inventory.
2. Create a computer group that contains all computers that are in the first BigFix
subcapacity region: North and South America.
a. In the top navigation bar, click Management > Computer Groups.
b. To create a computer group, click New.
c. Provide the name of the computer group.
Americas.
d. Optional: Provide a description of the computer group.
e. Specify criteria that must be met by the computers that belong to this group.
To reuse the computer group that you created in the BigFix console, select Data
Source Groups, in set, and select the proper BigFix computer group. In this case,
select Americas.

f.

From the Type section, select Reporting.

g. Select Enable license usage calculations to calculate utilization in this
computer group.
h. Specify the number of days for which the data is to be calculated.This number
defines the default period for which the data that is show on the All Metrics
report is calculated and up-to-date.
This number defines the default period for which the data that is show on the All
Metrics report is calculated and up-to-date.

For example, when you set the value to 30 days, and then display a report for the
last 90 days, the report shows the following data:
• If you display the report for a newly created computer group, the report
shows values for the last 30 days and is empty for the rest of the period.
• If you display the report for an existing group, the values might be
outdated.
In both cases, recalculate the data.
i. To save the group, click Create.
3. Create computer groups for the remaining BigFix subcapacity regions in which you
have computers.
4. Optional: If you do not need a collective snapshot for all computers, but separate
audit snapshots for each computer group, open the All Computers group, and clear
PVU and RVU MAPC. Then, click Save.
Important: Perform this step if you are creating computer groups to report
PVU usage for BigFix software that is installed in multiple IBM subcapacity
regions. If you choose to calculate subcapacity data for the All Computers
group, see: BigFix subcapacity regions to understand what is the difference
between reports generated for each region separately and the report
generated for the All Computers group.
Do not perform this step if you are creating computer groups to manage
software that is installed in multiple business units. When you do not
calculate subcapacity data for the All Computers group, you will not be able to
generate audit snapshots for the entire environment.
5. To make the computer groups available in BigFix Inventory, wait for the scheduled
import or run it manually.
6. Optional: If software in each computer group is managed by a separate person, create
dedicated users, each with access to one computer group.

You created computer groups for which you can manage software and generate audit
snapshots and dedicated users who can access these groups.

Lesson 3: Managing software and generating audit snapshots per
computer group
Available from 9.2.2. After you create computer groups in BigFix Inventory, you
can manage software and generate audit snapshot separately for each computer group.
1. Log in to BigFix Inventory.
• If software in all computer groups is managed by one person, log in as the user
that has access to all computer groups, for example the Administrator.
• If software in each group is managed by a different person, log in as the
user with access only to the computer group that represents the first BigFix
subcapacity region.

2. If you have a file with part numbers related to the software that is installed in this
region, upload the file.
a. Click Management > Part Numbers Upload.
b. Select the computer group for which you want to upload the part numbers. In
this case, select Americas.
c. Browse for the file with part numbers and provide a comment to the uploaded
file. Then, click Upload.

d. To make the part numbers available in BigFix Inventory, wait for the scheduled
import or run it manually.
3. To bundle the software, click Reports > Software Classification. The panel contains
software from all computer groups to which the user that you used to log in has
access. Assign each component to a product, exclude, or suppress the instances that
should not be included in the metric calculation, and confirm your actions. For more
information, see: Software classification.
4. When you finish bundling the software, generate the audit snapshot for this region.
• If you logged in as a user with access to multiple computer groups, open the
Computer Groups report, and click the computer group that represents the first
BigFix subcapacity region. Then, in the upper left corner, select All IBM Metrics
or IBM PVU Subcapacity.

The report that opens contains information only about software that is installed
on the computers in North and South America. Click Audit Snapshot. Provide
a comment to the generated snapshot and upload any related files. Then, click
Generate.
• If you logged in as a user with access only to the computer group that
represents the first BigFix subcapacity region, open the All IBM Metrics or IBM
PVU Subcapacity report, and click Audit Snapshot. Provide a comment to the
generated snapshot and upload any related files. Then, click Generate
You generated the audit snapshot with information about PVU consumption in the first
BigFix subcapacity region: North and South America.
Bundle software and generate audit snapshots for the remaining regions in which you have
BigFix software installed. For every product, sum up the PVU values from all regions. The
value that you obtain is the overall PVU usage for the particular product. This value might be

different from the value that you obtain when you generate a single audit snapshot for the
All Computers group. For more information, see: BigFix subcapacity regions.

Tutorial: Managing software in the service provider
environment
Available from 9.2.2. In this tutorial, you will learn how to create computer
groups that allow a service provider to manage software and generate audit snapshots per
customer.
A service provider is a company that provides other organizations with access to software
installed on machines that are owned and maintained by the service provider. There are
three typical scenarios that are used in the service provider environment.
• Software that is installed on one virtual machine is used by one customer
• Some of the software that is installed on a virtual machine is used by the service
provider
• Software that is installed on one virtual machine is used by many customers
For more information about the first two scenarios, see: Service providers. The last scenario
is not supported by BigFix Inventory.
Learning objectives
After you complete the lessons in this tutorial, you will know how to perform
the following tasks:
• Ensure that each customer can run scans and perform other actions in
the BigFix console only on the computers on which the software that he
uses is installed.
• Define the scope of audit snapshots by creating computer groups in
BigFix Inventory.
• Import part numbers and manage software per computer group.
• Filter out software that is not used by the customer from reports.
• Generate audit snapshots per computer group.

Time required
This module should take 60 minutes to complete. If you explore other
concepts related to this tutorial, it can take longer to complete.
Audience
Service providers who need to manage software and provide separate
subcapacity reports for each customer.
Data visibility
Some of the items in BigFix Inventory are visible globally to all users. Other
items are visible only for the user who has access to a particular computer
group. If you grant your customers access to BigFix Inventory, review which
items are visible globally and which are visible per computer group. For more
information, see: Service providers.
Prerequisites
• Install the scanner on all computers that you want to monitor. For more
information, see: Installing the scanner.
• Configure VM managers that control virtual machines in your
environment. For more information, see: Managing VM managers.
Tip: If each customer should be allowed to view information
about all VM managers in the infrastructure, use basic VM
management (central). If each customer should be allowed
to only view information about VM managers that control the
virtual machines that he uses, use advanced VM management
(distributed).
Conventions used in this tutorial
The tutorial is based on the example of a service provider whose customers
are Bank ABC and IT Company.
Lessons in this tutorial

The tutorial contains the following lessons:
1. Lesson 1 (Optional): Creating a site, a computer group, and an operator
dedicated to each customer
2. Lesson 2: Creating computer groups to manage software per customer
3. Lesson 3: Managing software and generating audit snapshots per
customer

Lesson 1 (Optional): Creating a site, a computer group, and an
operator dedicated to each customer
Available from 9.2.2. If you grant your customers access to the BigFix console to
allow them to run scans and perform other actions on computers, create a site, a computer
group, and an operator that is dedicated to each customer. Then, provide the customer with
credentials for the dedicated operator. This way, you ensure that each customer has access
only to computers on which the software that he uses is installed.
Important: This lesson is optional. If you do not grant you customers access to the
BigFix console, you can skip this entire lesson and move to the next one. You can
also create only computer groups to facilitate infrastructure and scan management
as described in step 3. However, it is also optional.
1. Log in to the BigFix console.
2. Create a custom site that is dedicated to Bank ABC.
a. In the top navigation bar, click Tools > Create Custom Site.
b. Provide the name of the custom site. For example, Bank ABC. Then, click OK.
c. Optional: On the Details tab, provide the description of the site.
d. On the Computer Subscriptions tab, select Computers which match the
condition below. Specify the condition that must be met by the computers that
belong to this group.

For example, choose all computers whose subnet address contains a particular
string.

e. Click Save Changes.
3. Create a computer group that contains the same computers as the site that you
created in the previous step.
a. In the top navigation bar, click Tools > Create New Automatic Computer Group.
b. Provide the name of the computer group.
For example, Bank ABC.
c. From the Create in site drop-down list, select the site that you created in the
previous step. In this case, select Bank ABC.
d. Specify criteria that must be met by the computers that belong to this group.
Choose the same criteria that you specified when you were creating the custom
site.

e. Click Create.
4. Create a BigFix operator that is dedicated to Bank ABC. The operator has access only
to computers on which the software that is used by this customer is installed.
a. In the top navigation bar, click Tools > Create Operator.
b. Provide the user name.
For example, Bank ABC.
c. Provide a password and confirm it. Then, click OK.
d. On the Sites tab, click Assign Site, and choose the custom site that is dedicated
to this customer. In this case, choose Bank ABC. Then, click Add.

e. To make operator the owner of the site, select the site and click Owner.

f. Ensure that the customer does not have access to the sites dedicated to other
customers. To remove access to a site, select the site and click Remove Site.
Each customer should have access to his dedicated site, the BES Support site,
and the BigFix Inventory site.

Tip: If you cannot remove a site from the list of sites to which an
operator has access, the site might have the read permission granted
globally. To change the setting, open the site, go to the Operator
Permissions tab, and clear the Grant read permission globally check
box. Then, click Save Changes.
g. On the Computer Assignments tab, click Add. Expand the By Group section, and
select the computer group that is dedicated to Bank ABC. Then, click OK.

h. Click Save Changes.
You created a site, a computer group, and an operator dedicated to Bank ABC. You can now
provide the customer with operator credentials. The customer can perform actions only
against computers on which the software that he uses is installed.
Create sites, computer groups, and operators for the remaining customers.

Lesson 2: Creating computer groups to manage software per
customer
Available from 9.2.2. To manage software and generate audit snapshots for
each customer separately, create computer groups that represent the customers in BigFix
Inventory.
If you created computer groups in the BigFix console, run an import to ensure that
information about these groups is available in BigFix Inventory.

1. Log in to BigFix Inventory.
2. Create a computer group that contains all computers on which software that is used
by Bank ABC is installed.
a. In the top navigation bar, click Management > Computer Groups.
b. To create a computer group, click New.
c. Provide the name of the computer group.
For example, Bank ABC.
d. Optional: Provide a description of the computer group.
e. Specify criteria that must be met by the computers that belong to this group.
If you created computer groups in the BigFix console, select Data Source
Groups, in set, and select the proper BigFix computer group. In this case, select
Bank ABC.

Restriction: The size of data returned by the specified filter cannot
exceed 1 MB.
f.

From the Type section, select Reporting.

g. Select license metrics for which you want to calculate utilization in this
computer group.
h. Specify the number of days for which the data is to be calculated.
This number defines the default period for which the data that is show on the All
Metrics report is calculated and up-to-date.

For example, when you set the value to 30 days, and then display a report for the
last 90 days, the report shows the following data:
• If you display the report for a newly created computer group, the report
shows values for the last 30 days and is empty for the rest of the period.
• If you display the report for an existing group, the values might be
outdated.
In both cases, recalculate the data.
i. To save the group, click Create.
3. Create computer groups for the remaining customers.
4. Optional: If you do not need a collective snapshot for all computers, but separate
audit snapshots for each computer group, open the All Computers group, and clear
PVU and RVU MAPC. Then, click Save.
5. To make the computer groups available in BigFix Inventory, wait for the scheduled
import or run it manually.
6. Optional: If you give customers access to BigFix Inventory or when each customer
account is managed by a separate person, create dedicated BigFix Inventory users,
each with access to one computer group.
a. To create a user, go to Management > Users, and click New.
b. Select the role or roles that you want to assign to the user.
Restriction: To ensure that each user has access to information
only about computers that he uses, do not assign the user with the
Administrator role. By default, this role has access to the All Computers
group. Thus, a user who is assigned this role can view information about
all computers in the infrastructure.

c. Select the computer group to which you want the customer to have access.
d. Choose the authentication method. If you choose Password, provide the
password and confirm it.
e. Click Create.

You created computer groups, each dedicated to one customer, and users who can access
these groups. You can manage software and generate audit snapshots for each customer
separately. You can also provide your customers with credentials to their dedicated users
and allow them to manage software and generate snapshots on their own.

Lesson 3: Managing software and generating audit snapshots per
customer
Available from 9.2.2. After you create computer groups in BigFix Inventory, you
can manage software and generate audit snapshot separately for each customer.
Depending on your business model, you can perform these actions on your own or provide
each customer with credentials to their dedicated user. In the latter case, customers can
manage the software that they use and generate audit snapshots on their own.
1. Log in to BigFix Inventory.
• If you manage customer software, log in as any user that has access to the
computer group that represents Bank ABC, for example the Administrator.
• If you give customers access to BigFix Inventory or when each customer
account is managed by a separate person, log in as the user with access only to
the computer group that represents Bank ABC.

2. If you have a file with part numbers related to the software that is used by this
customer, upload the file.
a. Click Management > Part Numbers Upload.
b. Select the computer group for which you want to upload the part numbers. In
this case, select Bank ABC.
c. Browse for the file with part numbers and provide a comment to the uploaded
file. Then, click Upload.

d. To make the part numbers available in BigFix Inventory, wait for the scheduled
import or run it manually.
3. To bundle the software, click Reports > Software Classification. The panel contains
software from all computer groups to which the user that you used to log in has
access. Assign each component to a product, exclude, or suppress the instances that
should not be included in the metric calculation, and confirm your actions. For more
information, see: Software classification.
4. Optional: If some of the products are not used by the customer but by the service
provider, filter out these products from the report to avoid charging the customer for
products that he does not use.
Restriction: All instances of the product that you filter out must be used by the
service provider.
a. Open the All IBM Metrics or IBM PVU Subcapacity report.
b. To filter out the report, hover over the Manage Report View icon

, and click

Configure View. Then, add a filter to the filter that is already defined in this
report.
For example, choose Product, does not contain, and provide the name of the
product. Then, click Submit.

c. Optional: You can set the filtered report as the default report view for this
customer. To do this, hover over the Manage Report View icon

, and click

Save As. Then, provide the name of the report, and select Set as default. Then,
click Create.
5. Generate the audit snapshot for the customer.
• If you logged in as a user with access to multiple computer groups, open
the Computer Groups report, and click the computer group that represents
Bank ABC. Then, in the upper left corner, select All IBM Metrics or IBM PVU
Subcapacity.

The report that opens contains information only about software that is installed
on the computers that are used by Bank ABC. Click Audit Snapshot. Provide a

comment to the generated snapshot and upload any related files. Then, click
Generate.
• If you logged in as a user with access only to the computer group that
represents Bank ABC, open the All IBM Metrics or IBM PVU Subcapacity report,
and click Audit Snapshot. Provide a comment to the generated snapshot and
upload any related files. Then, click Generate.
You generated the audit snapshot with information about license consumption in Bank ABC.

Tutorial: Bulk software classification using external
tools
This tutorial teaches you how to rebundle products using the REST API and a cURL
command line tool.
Tutorial: Bulk software classification using external tools
Tutorial abstract: Bulk software classification using external tools
Learning objectives
In this tutorial you learn to do the following tasks:
• Reassign software instances.
• Exclude software instances.
Time required
120 minutes.
If you explore other concepts that are related to this tutorial, it might take
longer to complete.
The order of lessons:
This tutorial contains two lessons. Complete them in order.
1. Lesson 1: Reassigning large quantities of software instances.
2. Lesson 2: Excluding software instances from usage calculations.

Lesson 1: Reassigning large quantities of software instances
This lesson shows you how to reassign large quantities of software instances with the REST
API and a cURL command line tool. You can use the information in this lesson to implement
an automatic external tool for large scale rebundling.
You must have root operating system privileges.
After software scan data is imported from the BigFix server, software instances are
automatically associated with products based on automatic bundling rules. If some
instances are assigned to the wrong product, they must be reassigned correctly.
In this lesson, some instances of Tivoli® Storage FlashCopy® Manager are assigned to
the wrong product. The Tivoli® Storage FlashCopy® Manager product is only installed on
computers with a host name that begins with nc04, and only on Linux™ computers. You
reassign all other instances of Tivoli® Storage FlashCopy® Manager to a release of IBM
Tivoli® Storage Manager.
Important:
• Some of the commands in this lesson are long, and for the purposes of
presentation, some line breaks were introduced. Treat each line break as a
space.
• You must add token ID at the end of each cURL command. To obtain the
token,
1. In the BigFix Inventory user interface, click Management > Users.
2. Click the user name.
3. In the lower part of the page, click Show token.

1. Log on to your computer and start the command line interface.
2. Retrieve a list of all products that are discovered in your environment. Run the
following command:

curl -v -X GET
http://server_url:server_port/
api/sam/swinventory/products?token=token_ID

3. Review the list to obtain the product ID for IBM Tivoli® Storage FlashCopy® Manager.
{
"id": "16790",
"level": "product",
"isConfirmed": "false",
"productReleaseComponent": "IBM Tivoli Storage FlashCopy Manager",
"children": "true",
"nmbOfAllRows": "44",
"confidence": "11",
"type": "root"
}

4. Retrieve all releases for the product. Use the product ID you obtained in the previous
step. Run the following command:
curl -v -X GET
http://server_url:server_port/api/sam/swinventory/product/16790/
releases?token=token_ID

5. Review the list to obtain the release IDs for IBM Tivoli® Storage FlashCopy® Manager.
{
"label": "name",
"identifier": "id",
"numRows": "1",
"items": [{
"id": "985",
"level": "release",
"isConfirmed": "false",
"numberOfAllInstances": "5",

"productReleaseComponent": "IBM Tivoli Storage FlashCopy Manager
3.1",
"children": "true",
"nmbOfAllRows": "1",
"confidence": "11"
}

6. Retrieve a list of all instances for the releases. Use the release IDs you obtained in the
previous step. Run the following command:
curl -v -X GET
http://server_url:server_port/api/sam/swinventory/release/985/
instances?token=token_ID

7. Review the list to obtain the product inventory IDs for instances of IBM Tivoli®
Storage FlashCopy® Manager that meet your criteria.
Instances that are not installed on a computer with a host name that begins with
nc04, or that are not installed on a Linux™ computer.
Note: You might need to filter the list by using an external tool.

{
"isCharged": "true",
"operatingSystem": "AIX 6.1",
"isConfirmed": "false",
"currentServerId": "8233 06A851P",
"updateTime": "1381322771321",
"children": "false",
"hostname": "NC107073",
"confidence": "11",
"productInventoryId": "134",
"id": "134",
"level": "instance",

"bundleRules": "the relation in the software catalog, the
stand-alone pr
oduct discovery",
"isAgentDeleted": "false",
"processorType": "BigFix(R) POWER7 (750, 755, 775 servers)
Multi-core All E
xisting",
"productReleaseComponent": "BigFix Tivoli Storage Manager Client 6.3",
"pvuPerCore": "100",
"installationPaths": "/BigFix/TSM",
"nmbOfAllRows": "5",
"isSimple": "false"
},
{
"isCharged": "true",
"operatingSystem": "Win2008R2 6.1.7601",
"isConfirmed": "false",
"currentServerId": "TLM_VM_42362841-6b4e-ea26-9755-07b28dc0fd41",
"updateTime": "1381322771321",
"children": "false",
"hostname": "VMW009128109094",
"confidence": "11",
"productInventoryId": "137",
"id": "137",
"level": "instance",
"bundleRules": "the relation in the software catalog, the
stand-alone pr
oduct discovery",
"isAgentDeleted": "false",
"processorType": "Other Other One core All Existing",
"productReleaseComponent": "IBM Tivoli Storage Manager Client 6.3",
"pvuPerCore": "100",

"installationPaths": "C:\\BigFix Software\\TSM",
"nmbOfAllRows": "5",
"isSimple": "false"
}

8. Retrieve a list of the releases where instances can be reassigned to. Use an instance
ID you obtained in the previous step. Run the following command:
curl -v -X GET http://server_url:server_port/api/sam/swinventory/
targetBundlesOfInstances?productInventoryId=134&token=token_ID

9. Review the list to obtain the IBM Tivoli® Storage Manager release ID you want to
reassign the instances to.
{
"id": "33424",
"appliedRules":
"the infrastructure co-location, the relation in the software
catalog",
"releaseId": "33424",
"isSelected": "false",
"branchType": "0",
"confidenceLevel":3,
"isShared": "false",
"productName": "IBM Tivoli Storage Manager 6.3",
"productInventoryId": "134},
}

10. Reassign the releases by running the following command:
curl -v -X POST
http://server_url:server_port/api/sam/swinventory/reassign -d
"productInventoryId=inventory_IDs&productId=release_ID&updateTime=time
stamp"?token=token_ID

Where:

• inventory_IDs Are the instances to reassign
• release_ID Is the product release to reassign to
• timestamp Is the update time that is expressed in milliseconds. The timestamp
must be equal to or greater than the timestamps retrieved as a property of the
instances to reassign, in step.6
For example:
curl -v -X POST
http://server_url:server_port/api/sam/swinventory/reassign -d
"productInventoryId=134,137&productId=33424&updateTime=9949237658579"

An HTTP response 204 is received. The selected instances are reassigned to the new
release.

Lesson 2: Excluding software instances from usage calculations
This lesson shows you how to exclude products from license usage calculations with the
REST API and a cURL command line tool. You can use the information in this lesson to
implement an automatic external tool for large scale rebundling.
You must have root operating system privileges.
In this lesson, a customer uses resource value unit (RVU) subcapacity licensing for some
BigFix endpoints. All computers are subscribed to the BigFix Inventory v10 site in the BigFix
console, and software scans of the infrastructure are completed. The subscribed computers
are 80% desktop computers and 20% servers. Before an RVU report is generated, all desktop
computers must be excluded from license usage calculations.
Important: Some of the commands in this lesson are long, and for the purposes of
presentation, some line breaks were introduced. Treat each line break as a space.
1. Start the command line interface.
2. To retrieve a list of all products that are discovered in your environment, run the
following command:

curl -v -X GET
http://server_url:server_port/api/sam/swinventory/products

3. Review the list to obtain the product IDs for BigFix applications.
There might be many BigFix applications. Search for all products that begin with
"BigFix".
{
"id": "21555",
"level": "product",
"isConfirmed": "false",
"productReleaseComponent": "BigFix Lifecycle",
"children": "true",
"nmbOfAllRows": "45",
"confidence": "23",
"type": "root"}

4. Retrieve lists of all releases for each of the BigFix products, and retrieve lists of all
instances.
The following commands are used for retrieving lists of releases and lists of
instances.
curl -v -X GET
http://server_url:server_port/api/sam/swinventory/product/product_ID
/releases

curl -v -X GET
http://server_url:server_port/api/sam/swinventory/release/release_ID
/instances

5. Filter the lists of instances in an external tool, to obtain a list of all BigFix product
instances that are installed on desktop computers.
You can use an external tool such as a spreadsheet to filter the lists. You can filter on
a number of criteria. A desktop can be defined as a computer that does not contain

the word server in the operating system name. The license type is not Windows server,
and the computer model is not VMware.
6. Using the inventory IDs from your filtered list, exclude all instances of BigFix products
that are installed on desktop computers. To exclude instances, run the following
command:
curl -v -X POST
http://server_url:server_port/api/sam/swinventory/exclude -d
"productInventoryId=inventory_IDs&reason=no_licensing&updateTime=times
tamp"

Where:
• inventory_IDs are the instances to reassign
• timestamp is the update time that is expressed in milliseconds. The timestamp
must be equal to or greater than the timestamps retrieved as a property of the
instances to reassign, in step.4
All instances can be entered separated by commas, for example:
curl -v -X POST
http://server_url:server_port/api/sam/swinventory/exclude -d
"productInventoryId=134,137&reason=no_licensing&updateTime=99492376585
79"

An HTTP response 204 is received. The selected instances are excluded.
7. Open the All Metrics report, and click Recalculate, to update the RVU values for BigFix.

Tutorial: Migrating software assignments between
two BigFix servers
Available from 9.2.14This tutorial teaches you how to migrate the software
assignments for each computer that is moved to a new BigFix server using the REST API
requests.
Learning objectives
In this tutorial you learn how to perform the following tasks:

• Retrieving information about the software assignments for the computer
that is moved to the new BigFix server.
• Changing the Data Source Computer ID, performing test, and migrating
the software assignments of the computer which is connected to the
new BigFix server.
Time required
20 minutes. If you explore other concepts that are related to this
tutorial, it might take longer to complete.
The order of lessons
This tutorial contains two lessons. Complete them in order.
Lessons in this tutorial
1. Lesson 1: Retrieving information about software
assignments for a specified computer
2. Lesson 2: Performing tests and migrating the assignments

Lesson 1: Retrieving information about software assignments for
a specified computer
Available from 9.2.14 This lesson shows you how to use the REST API request to
retrieve software assignments of a computer that is moved to the new BigFix server.
You must have the View Endpoints and View Hardware Inventory permissions to perform
this task.
This tutorial is based on the old and new Data Source Computer ID of the computer that is
migrated to the new BigFix server. This information is crucial for the REST API requests. To
migrate software assignments for multiple computers, start with preparing a list of old and
new Data Source Computer IDs for all affected computers. Then, for best results, migrate
the software assignments for each computer in your environment separately. The number
of software instances per single API request should not exceed 150.

1. Move the computer to the new BigFix server.
2. Add a new data source to BigFix Inventory.
3. Upload software scan results from the computer that is connected to the new BigFix
server.
4. Collect a pair of old and new Data Source Computer IDs for the computer.
a. Log in to BigFix Inventory.
b. Go to Reports > Computers.
c. Hover over Configure, and click Configure View. Select Data Source Name and
Data Source Computer ID from the list of columns, and click Submit.
d. Sort the report by Computer Name by clicking on the column header. By looking
at the Computer Name and the Data Source Name prepare a pair of old and new
Data Source Computer IDs of the computer. The following example is used in
this tutorial.
• Data Source Computer ID that is assigned to the old data source on the
report: 9596634
• Data Source Computer ID that is assigned to the newly created data
source on the report: 778906
Tip: If you plan to migrate software assignments for multiple
computers, start with preparing a list of old and new Data Source
Computer IDs for all affected computers to save you time and effort.
5. To retrieve information about software assignments related to this computer, run the
following API query:
https://hostname:port/api/sam/v2/software_instances?limit=150&

columns[]=product_name&columns[]=component_name&columns[]=discovery_p
ath&columns[]=is_charged&

columns[]=is_confirmed&columns[]=computer_bigfix_id&columns[]=discove
rable_guid&columns[]=product_release_guid&

columns[]=metric_id&token=user_token&criteria={"and":[["is_present","
=","1"],
["computer_bigfix_id","=","9596634"]]}

The computer_bigfix_id is the same as the old Data Source Computer ID. In the
example, the old Data Source Computer ID is 9596634.
The following example shows the results of the query for this computer.
{
"total": 2,
"rows": [
{
"product_name": "BigFix Inventory",
"component_name": "BigFix Inventory Server",
"is_charged": 0,
"is_confirmed": 1,
"computer_bigfix_id": 9596634,
"discoverable_guid":
"cdf19da9-a9de-4ee9-ab41-ff09fa6eda92",
"product_release_guid":
"1ecbbb8d-1d1e-4beb-a40f-cb9b9b9462fb",
"metric_id": -13103
},
{
"product_name": "IBM DB2 Enterprise Server Edition
Unlicensed Product Base",
"component_name": "IBM DB2 Enterprise Server Edition
Unlicensed Product Base",
"is_charged": 1,
"is_confirmed": 0,
"computer_bigfix_id": 9596634,

"discoverable_guid":
"57628995-cf33-4335-984d-d2c8abde750e",
"product_release_guid":
"befa759d-0473-47bd-ae60-f1e16c13e8cc",
"metric_id": 1
}
]
}

6. Copy the results of the query to the Body of the request, and change the value of the
computer_bigfix_id to the new Data Source Computer ID.

The following example shows the modifications that are required to migrate software
assignments to the computer on the new server. The new Data Source Computer ID is
778906.
{
"total": 2,
"rows": [
{
"product_name": "BigFix Inventory",
"component_name": "BigFix Inventory Server",
"is_charged": 0,
"is_confirmed": 1,
"computer_bigfix_id": 778906,
"discoverable_guid":
"cdf19da9-a9de-4ee9-ab41-ff09fa6eda92",
"product_release_guid":
"1ecbbb8d-1d1e-4beb-a40f-cb9b9b9462fb",
"metric_id": -13103
},
{
"product_name": "IBM DB2 Enterprise Server Edition
Unlicensed Product Base",

"component_name": "IBM DB2 Enterprise Server Edition
Unlicensed Product Base",
"is_charged": 1,
"is_confirmed": 0,
"computer_bigfix_id": 778906,
"discoverable_guid":
"57628995-cf33-4335-984d-d2c8abde750e",
"product_release_guid":
"befa759d-0473-47bd-ae60-f1e16c13e8cc",
"metric_id": 1
}
]
}

Lesson 2: Performing tests and migrating the assignments
Available from 9.2.14 This lesson shows you how to run a test and complete the
migration of software assignments for a computer that is moved to the new BigFix server.
You must have the View Endpoints and View Hardware Inventory permissions to perform
this task.
The PUT request needs to be made using a dedicated API tool, such as Postman or cURL.
1. Use the Body of the request that you prepared in Step 6 at the end of Lesson 1. To run
a test and simulate the migration, use the following PUT request.
https://hostname:port/
api/sam/v2/software_instances?token=user_token&simulate=true&verbose=t
rue

2. Check the results of the test.
The following sample shows the example of test results.

{
"details": {
"valid_instances": {
"Bundled": {
"1": "instance_ids: 314"
}
},
"invalid_instances": {},
"unmodified_instances": {
"1": "Bundling 'BigFix DB2 Enterprise Server
Edition Unlicensed Product Base 10.5' to 'BigFix DB2 Enterprise
Server Edition Unlicensed Product Base 10.5' on '9589066'"
}
},
"summary": {
"valid_instances": {
"Bundled": 1
},
"invalid_instances": {},
"unmodified_instances": 1
}
}

3. If the test is successful, migrate the software assignments with the following PUT
request.
https://hostname:port/api/sam/v2/software_instances?token=user_token

The results of the API request should include a summary of changes that were made.
The following example shows the sample of the results:
{
"valid_instances": {

"Bundled": 1
},
"invalid_instances": {},
"unmodified_instances": 1
}

After migrating the software assignments with the API request, the data is updated in and
reflected on Software Classification panel. After the next import of data, the license metric
information is recalculated according to the changes.

Security
Configure different security features to adequately protect business assets and resources in
the data model when using BigFix Inventory.

Flow of data
There are several different interactions that occur between the components of the BigFix
Inventory infrastructure and between the user and tool.

BigFix Inventory domain
This table describes the flow of data for the BigFix Inventory domain. There are four
columns and two rows. Each row is divided in to two rows from column three.
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Web browser da Port

By default, the web browser connects to the BigFix In
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able the SSL/TLS connection tunneling.
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REST API data
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BigFix domain
This table describes the flow of data for the BigFix domain. There are four columns and two
rows. Each row is divided in to two rows from column three.
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• Configurable bandwidth throttling to BigFix relay
or clients
• Configurable gather interval. The default is 1 per
day per fixlet site.
• Configurable minimum time to wait between
posts. The default is 15 seconds.
• Configurable temporal distribution (spread out
downloads over time) per action
• The ability to set "policy" to prevent computers
from downloading files if they are not pointed at
the proper BigFix relay
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• Configurable limit of the number of UDP mes
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after sending UDP messages from a BigFix relay
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router. The BigFix client then sends an ICMP message
to both relays with TTL 2 and receives one “time ex
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client then chooses the relay that is one hop away.
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• Relay auto-selection can be disabled.
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• Configurable interval for when the BigFix clients
perform auto-selection
• Configurable limit on the maximum number of
ICMP packets to send out in a time interval
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The following database protocols are used:
• ODBC
• JDBC

Security configuration scenarios
Check what security options need to be enabled on the BigFix server and the BigFix
Inventory server to achieve each of the supported security scenarios.

TLS 1.2
To use TLS 1.2 protocol, perform the following configuration:
• Enable enhanced security on the BigFix server
• Enable HTTPS in BigFix Inventory

FIPS 140-2
To achieve compliance with the FIPS 140-2 standard, perform the following configuration:
• Enable enhanced security and SHA-256 downloads on the BigFix server
• Enable HTTPS in BigFix Inventory
• Enable FIPS 140-2 in BigFix Inventory
For more information about the standard, see: Federal Information Processing Standard
140-2.

SP800-131
To achieve compliance with SP800-131 standard, perform the following configuration:
• Enable HTTPS in BigFix Inventory
• Enable SP800-131 compliance in BigFix Inventory
For more information about the standard, see: SP800-131 compliance.

Configuring database connection encryption
You can encrypt the connection between BigFix Inventory server and the BigFix Inventory
database. Encryption is established between BigFix Inventory server and the database
engine using a JDBC driver. You can encrypt the connection while upgrading the server.
You must obtain a public certificate and then export it to use it.
This encryption is applied to encrypt the connection between BigFix Inventory and DB
server. To apply the encryption, you must select the Encrypt Database Connection checkbox
on the 'Create and Configure the application database' window.
To configure the encryption, you must perform the below tasks:
• enable encryption on the database
• export the public certificate
• add certificate to trustStore
• stop the service
• edit configuration and restart service
Refer to the below topics to learn about enabling the encryption:
• Enabling the database connection encryption for MS SQL
• Enabling the database connection encryption for DB2

Enabling the database connection encryption for MS SQL
Configure the MS SQL database to apply SSL based encryption.

MS SQL database must be configured to enable the connection encryption.
Export the public certificate in the .CER Base-64 encoded X.509 format using MMC
(Microsoft Management Console). Perform the below steps:
• Run the MMC on Windows system hosting MS SQL database.
• Right click on the certificate and go to All Tasks > Export.
• Click Next.
• Choose No, do not export the private key and click Next.
• Choose Base-64 encoded X.509 (.CER) format and click Next.
• Enter the file name.
• Review specified settings and click on Finish.
• Certificate is exported to the specified location.
Once you export the certificate, enable the connection encryption.
1. Upload the MS SQL server public certificate.
2. Open command line and use the command, cd <BFI_INSTALL_DIR>/wlp/usr/
servers/server1/resources/security.
3. Create a <keystore_extension> type TrustStore and import the public certificate
into it using the command, keytool -importcert -file <.cer file> -keystore
key_bfi_db.<keystore_extension> -alias "bfi_db_cert" -storetype <type>.

Provide the TrustStore password. Enter Yes to trust the certificate.
4. Stop BigFix Inventory service.
5. Update the existing attributes and add missing attributes in the server.xml file.
Important: For the database, use the same server name as provided in the
certificate. Update the value in the serverName attribute.

<dataSource id="DatabaseConnection"
jndiName="jdbc/ilmtDatabaseConnection"> <jdbcDriver
libraryRef="DatabaseLib"/>

<properties.microsoft.sqlserver databaseName="temadb" encrypt="true"
lockTimeout="180000"
password="<password encrypted in in ‘aes’ encoding>"
serverName="<host name - the same that certificate is issued to>"
trustServerCertificate="false"
trustStore="<BFI_INSTALL_DIR>/wlp/usr/servers/server1/resources/secur
ity/key_bfi_db.<keystore_extension>>”
trustStorePassword="<password encrypted in in ‘aes’ encoding>"
user="sa"/>
</dataSource>

Note: Encrypting the password in ‘aes’ encoding. Refer to Updating the
database password for more information. If you choose to encrypt the
database connection while upgrading the BigFix Inventory server, you must
define the password encryption attribute in the data source.
6. Update the existing attributes and add missing attributes in the database.yml file.
Important: For the database, use the same hostname as provided in the
certificate. Update the value in the host name attribute.

host: <host name - the same that certificate is issued to>
database: temadb
username: sa
database_type: mssql
windows_authenticated: false
encrypted_password: "<password encrypted in in ‘aes’ encoding>"
encrypt: true
trustServerCertificate: false

trustStore:
<<BFI_INSTALL_DIR>/wlp/usr/servers/server1/resources/security/key_bfi
_db.<keystore_extension>>
trustStorePassword: "<password encrypted in in ‘aes’ encoding>"

7. Start BigFix Inventory service.
8. Monitor tema.log to make sure that the connection is established.
If the application does not start, review the tema.log from the top. In case of
configuration issues, WebSphere creates a FFDC log.
[3/10/21 11:28:03:118 UTC] 00000026
com.ibm.ws.recoverylog.spi.RecoveryDirectorImpl I CWRLS0010I:
Performing recovery processing for local WebSphere server (server1).
[3/10/21 11:28:03:180 UTC] 00000026
com.ibm.ws.recoverylog.spi.RecoveryDirectorImpl I CWRLS0012I: All
persistent services have been directed to perform recovery processing
for this WebSphere server (server1).
[3/10/21 11:28:03:180 UTC] 00000041
com.ibm.tx.jta.impl.RecoveryManager I WTRN0135I: Transaction service
recovering no transactions.
[3/10/21 11:28:03:352 UTC] 00000026
com.ibm.ws.logging.internal.impl.IncidentImpl
I FFDC1015I: An FFDC Incident has been created:
"com.microsoft.sqlserver.jdbc.SQLServerException: The driver could
not establish a secure connection to SQL Server by using Secure
Sockets Layer (SSL) encryption. Error: "PKIX path validation failed:
java.security.cert.CertPathValidatorException: signature check
failed". ClientConnectionId:a89039f3-b6ce-4de6-8d10-8c205c44243e
com.ibm.ws.rsadapter.impl.MicrosoftSQLServerHelper 1298" at
ffdc_21.03.10_11.28.03.0.log
[3/10/21 11:28:03:477 UTC] 00000026
com.ibm.ws.logging.internal.impl.IncidentImpl
I FFDC1015I: An FFDC Incident has been created:
"com.ibm.ws.rsadapter.exceptions.DataStoreAdapterException:

DSRA8100E: Unable to get a PooledConnection from
the DataSource. with SQL State : 08S01 SQL Code : 0
com.ibm.ejs.j2c.poolmanager.FreePool.createManagedConnectionWithMCWra
pper 199" at ffdc_21.03.10_11.28.03.1.log
[3/10/21 11:28:03:524 UTC] 00000026
com.ibm.ws.logging.internal.impl.IncidentImpl
I FFDC1015I: An FFDC Incident has been created:
"javax.resource.spi.ResourceAllocationException: DSRA8100E: Unable
to get a PooledConnection from the DataSource. with SQL State : 08S01
SQL Code : 0 com.ibm.ws.rsadapter.jdbc.WSJdbcDataSource.getConnection
299" at ffdc_21.03.10_11.28.03.2.log
[3/10/21 11:28:03:524 UTC] 00000026 SystemOut O
[JAVA] [ERROR] [ILMTCore] (Default Executor-thread-3)
com.ibm.ilmt.common.dao.util.DBDefaultPoolerManager::init:Unable to
initialize datasource jdbc/ilmtDatabaseConnection

Note: The <type> and <keystore_extension> parameters that apply to the
above commands specifies the following:
<type>

Starting from version 10.0.8.0, the type of the certificate is
PKCS12. For earlier versions, it is JCEKS.
<keystore_extension>
Starting from version 10.0.8.0, the name of the keystore file is
.p12. For earlier versions, it is .jceks.

Enabling the database connection encryption for DB2
Configure the MS SQL database to apply SSL based encryption.

• DB2 database is configured to enable the connection encryption.
• The extracted public trust certificate should be available in 64-bit encoded .CER
format. It can be done by using the command, gsk8capicmd_64 -cert -extract
-db "<Server Keystore .kdb file>" -pw "<Server Keystore password>" -label
"<label name>" -target "<.cer file name>" -format ascii.

Once you export the certificate, enable the connection encryption:
1. Create<keystore_extension> type TrustStore and import the public certificate into it:
• Go to BigFix Inventory java directory, BFI_INSTALL_DIR>/jre/jre/bin
• Import the certificate into the TrustStore using the command, ./
keytool -importcert -file <.cer file location> -keystore
<BFI_INSTALL_DIR>/wlp/usr/servers/server1/resources/security/
key_bfi_db.<keystore_extension> -alias "bfi_db_cert"

• Provide the TrustStore password. Enter Yes to trust the certificate.
2. Stop BigFix Inventory service.
3. Update the existing attributes and add missing attributes in the server.xml file.
Important: For the database, use the same server name as provided in the
certificate. Update the value in the serverName attribute.

<dataSource id='DatabaseConnection'
jndiName='jdbc/ilmtDatabaseConnection'>
<jdbcDriver libraryRef='DatabaseLib'/>
<properties.db2.jcc databaseName='temadb' driverType='4'
enableExtendedIndicators='2' password="<password encrypted in in ‘aes’
encoding>"
portNumber='<TLS port number>' serverName=‘<host name - the same that
certificate is issued to>’
user='db2inst1' sslConnection="true"
sslTrustStoreLocation="<BFI_INSTALL_DIR>/wlp/usr/servers/server1/resou
rces/security/key_bfi_db.<keystore_extension>>”

sslTrustStorePassword="<password encrypted in in ‘aes’ encoding>"/>
</dataSource>

Note: Encrypting the password in ‘aes’ encoding. Refer to Updating the
database password for more information. If you choose to encrypt the
database connection while upgrading the BigFix Inventory server, you must
define the password encryption attribute in the data source.
4. Update the existing attributes and add missing attributes in the database.yml file.
Important: For the database, use the same hostname as provided in the
certificate. Update the value in the host name attribute.

host: <host name - the same that certificate is issued to>
database: temadb
username: db2inst1
database_type: db2
port: ‘<TLS port number>'
encrypted_password: "<password encrypted in in ‘aes’ encoding>"
sslConnection: true
sslTrustStoreLocation:
'<<BFI_INSTALL_DIR>/wlp/usr/servers/server1/resources/security/key_bf
i_db.<keystore_extension>>’
sslTrustStorePassword: "<password encrypted in in ‘aes’ encoding>"

5. Start BigFix Inventory service.
6. Monitor tema.log to make sure that the connection is established.
If the application does not start, review the tema.log from the top. In case of
configuration issues, the log shows error messages that helps in troubleshooting. For
example:
[3/11/21 14:43:42:658 UTC] 0000002a SystemOut

O 2021-03-11 14:43:42 ERROR: Cannot connect to the database:
Java::ComIbmDb2JccAm::DisconnectNonTransientConnectionException:
[jcc]
t4][2043][11550][4.28.11] Exception java.io.FileNotFoundException:
Error opening socket to server ***/*** on port 51,001 with message:
***<keystore_extension> (No such file or directory).
ERRORCODE=-4499, SQLSTATE=08001.
The next try for 60 seconds.

[3/11/21 17:02:45:608 UTC] 0000002b SystemOut

O 2021-03-11 17:02:45 ERROR: Cannot connect to the database:
Java::ComIbmDb2JccAm::DisconnectNonTransientConnectionException:
[jcc]
[t4][2043][11550][4.28.11] Exception java.io.IOException: Error
opening socket to server ***/*** on port 51,001 with message:
Keystore was tampered with, or password was incorrect.
ERRORCODE=-4499, SQLSTATE=08001.
The next try for 60 seconds.

Note: The <type> and <keystore_extension> parameters that apply to the
above commands specifies the following:
<type>

Starting from version 10.0.8.0, the type of the certificate is
PKCS12. For earlier versions, it is JCEKS.
<keystore_extension>
Starting from version 10.0.8.0, the name of the keystore file is
.p12. For earlier versions, it is .jceks.

Configuring secure communication
To ensure secure communication, BigFix Inventory uses public key cryptography, which is
based on algorithms that use two separate keys, a private key and a public key. This key pair
is used to encrypt and decrypt communication.
The private key encrypts communication. The public key, which is contained in a certificate,
decrypts communication. The use of encrypted communication requires that you create
both a private key and a certificate that is associated with it. You can share the public key
(certificate) with anyone because it is used only to read the communication. The safety of
your communication depends mainly on your private key that proves your identity, and must
therefore be securely stored. The keys are created in such a way that a message encrypted
with the private key can be decrypted only with the public key that is associated with it. If
someone receives your public key and can decrypt your communication with this key, they
know for certain that you are the originator of the message and that it was not tampered
with on the way. Otherwise, the public key would be unable to decrypt it.
BigFix Inventory provides self-signed certificates by default, but they are not intended for
production environments. To improve security, create your own private key and a certificate
signing request (CSR) that can be transformed into a certificate after it is signed by a
certificate authority (CA). By signing your request, a CA approves your public key and
certifies that it can be trusted. You can create your own private CA, use the CA of your
organization, or an internationally trusted CA, such as Entrust, VeriSign, or other.
The private key and the associated certificate are uploaded to BigFix Inventory. After
enabling the encrypted communication, anyone who connects to your server receives a
certificate that contains your public key. All successive communication that originates from
the server is encrypted with your private key. After a user receives the communication, it
is decrypted with the certificate that they obtained from the server. If the certificate can
decrypt the communication, it is known for certain that the server is the originator of the
message and that it is valid.
Key pair requirements
Your key pair must meet the following requirements to be accepted by BigFix Inventory.

• Type: RSA or DSA.
• Key strength: maximum 2048 bits. This limitation is caused by IBM Java policy.
You can use stronger keys if you substitute default policy files with the unlimited
jurisdiction ones. For more information, see: IBM SDK Policy files.
• Format: PEM-encoded. Such an encoding is ensured if you create the key pair by
using openSSL. You can also create your keys by using other methods, for example
Makecert on Windows. Such keys are DER-encoded and therefore not supported by
BigFix Inventory. However, you can convert other formats to PEM, for example by
using openSSL.
• Private key format: PKCS 8 (used by openSSL). The pvk format is not supported.
Limitations
Key pair that is generated for BigFix Inventory can be used for Web Reports only if the
private key is not password-protected.
Structure and format of the private key and certificate
• Private key format
◦ PEM-encoded without password protection. Ensure that the private key
(private.key) is enclosed between the following statements:
-----BEGIN PRIVATE KEY----<<base64 stringfrom private.key>>
-----END PRIVATE KEY-----

◦ PEM-encoded with password protection. Ensure that the private key
(private.key) is enclosed between the following statements:
-----BEGIN ENCRYPTED PRIVATE KEY----<<base64 stringfrom private.key>>
-----END ENCRYPTED PRIVATE KEY-----

• X509 certificate format
PEM-encoded. If you received the intermediate and root certificates as separate files,
combine them into a single file. For example, if you have the primary certificate file

(certificate.crt) and the intermediate certificate file (ca_intermediate.crt),
combine them in the following order.
BEGIN CERTIFICATE----<<primary certificate: base64 stringfrom certificate.crt>>
-----END CERTIFICATE---------BEGIN CERTIFICATE----<<intermediate certificate: base64 stringfrom ca_intermediate.crt>>
-----END CERTIFICATE-----

If you received the root certificate (ca_root.crt) in addition to the intermediate
certificate, combine them in the following order.
BEGIN CERTIFICATE----<<primary certificate: base64 stringfrom certificate.crt>>
-----END CERTIFICATE---------BEGIN CERTIFICATE----<<intermediate certificate: base64 stringfrom ca_intermediate.crt>>
-----END CERTIFICATE---------BEGIN CERTIFICATE----<<root certificate: base64 stringfrom ca_root.crt>>
-----END CERTIFICATE-----

• Single file (private key with certificates) format
PEM-encoded. This file can contain the private key and the primary certificate, or the
private key and the chain of certificates combined in the following order:
◦ Private key and primary certificate.
-----BEGIN CERTIFICATE----<<primary certificate: certificate.crt>>
-----END CERTIFICATE---------BEGIN PRIVATE KEY----<<private key: base64 stringfrom private.key>>
-----END PRIVATE KEY-----

◦ Private key, primary certificate, and intermediate certificate.

BEGIN CERTIFICATE----<<primary certificate: base64 stringfrom certificate.crt>>
-----END CERTIFICATE---------BEGIN CERTIFICATE----<<intermediate certificate: base64 stringfrom
ca_intermediate.crt>>
-----END CERTIFICATE---------BEGIN PRIVATE KEY----<<private key: base64 stringfrom private.key>>
-----END PRIVATE KEY-----

◦ Private key, primary certificate, intermediate certificate, and root certificate.
BEGIN CERTIFICATE----<<primary certificate: base64 stringfrom certificate.crt>>
-----END CERTIFICATE---------BEGIN CERTIFICATE----<<intermediate certificate: base64 stringfrom
ca_intermediate.crt>>
-----END CERTIFICATE---------BEGIN CERTIFICATE----<<root certificate: base64 stringfrom ca_root.crt>>
-----END CERTIFICATE---------BEGIN PRIVATE KEY----<<private key: base64 stringfrom private.key>>
-----END PRIVATE KEY-----

Procedure
Complete the following steps to create your key pair and to enable encrypted
communication. If you already have a key pair or want to use the self-signed certificates,
you can skip to enabling secure communication.

Step 1: Creating private keys and certificates
To improve security, create your own private key and a certificate instead of using the
self-signed ones that are available in BigFix Inventory by default. You can use openSSL to
create a private key and a certificate signing request (CSR) that can be transformed into a
certificate after it is signed by a certificate authority (CA).
Remember: Use the latest OpenSSL version to create private keys and certificates.
This procedure is valid for all operating systems that support openSSL.
If you are generating an encrypted private key in the pkcs8 format, add the following line to
the installation_dir/jre/lib/security/java.security file:
security.provider.10=org.bouncycastle.jce.provider.BouncyCastleProvider

Then, restart the BigFix Inventory server.
1. Open the command line.
2. Create a new private key.
openssl genrsa -des3 -out inventory.key -aes256 2048

For example, openssl genrsa -des3 -out inventory.key -aes256 2048
Where:
-des3
Enables password for the private key. This is an optional parameter.
You can also enable password for an existing private key by using the
following command:
openssl rsa -des3 -in path_to_private_key.key -out
key_name.key

key_name
File name for your new private key.

key_strength
Key strength, measured in bits. The maximum value that you can use for
BigFix Inventory is 2048 bits.
3. Create a certificate signing request (CSR). The request is associated with your private
key, and is later transformed into a certificate.
openssl req -new -key path_to_private_key.key -out csr_name.csr

For example, openssl req -new -key private_key.key -out CSR.csr
Where:
path_to_private_key
Path to your private key.
csr_name
File name for your certificate signing request (CSR).
After you run the command, you are asked to provide information that helps your
users to identify your certificate and ensure that it can be trusted. The following
excerpt from the command line is filled in with sample information:
Country Name (2 letter code) [XX]: US
State or Province Name (full name) []: New York
Locality Name (eg, city) [Default City]: New York
Organization Name (eg, company) [Default Company Ltd]: HCL (eg,
section) []: Software
Common Name (eg, your name or your server's hostname) []:
inventory.bigfix.com
Email Address []: inventory@bigfix.com

After completing these steps, two files are created, your private key (.key) and the
certificate signing request (.csr).
Sign the request to transform it into the certificate. For information about how to create a
private certificate authority (CA) to sign the request, see Signing certificates.

Step 2: Signing certificates
Your certificate signing request (CSR) must be signed by a certificate authority (CA) to be
transformed into a certificate that can be uploaded to BigFix Inventory. You can use the
openSSL cryptographic library to create a private CA and sign your request.
Using a private CA to sign your request is not the only way. You can also send the request
to internationally trusted CAs, such as Entrust, VeriSign, and so on, or use the CA of your
organization. The certificates of these CAs are often trusted by default and do not display
any warnings in the browser. Warnings might be displayed if you use a private CA.
1. Create a private certificate authority (CA) and a certificate for it.
a. Create a private CA. This step creates a private key (.key) and a request (.csr)
similar to those that you created in Creating private keys and certificates.
openssl req -new -newkey rsa:key_strength -nodes
-out CA_csr_name.csr -keyout CA_key_name.key -sha256

For example, openssl req -new -newkey rsa:2048 -nodes -out CA_CSR.csr
-keyout CA_private_key.key -sha256

Where:
key_strength
Key strength, measured in bits. The maximum value that you can
use for BigFix Inventory is 2048 bits.
CA_csr_name
File name for the certificate signing request (CSR). The certificate
authority (CA) requires a separate request.
CA_key_name
File name for the private key. The certificate authority (CA)
requires a separate private key.
b. Create a certificate for your private CA. This step creates a certificate (.arm)
that you can use to sign your CSR.

openssl x509 -signkey path_to_CA_key.key -days
number_of_days -req -in path_to_CA_csr.csr
-out CA_certificate_name.arm -sha256

For example, openssl x509 -signkey CA_private_key.key -days 90 -req
-in CA_CSR.csr -out CA_certificate.arm -sha256

Where:
key_strength
Key strength, measured in bits. The maximum value that you can
use for BigFix Inventory is 2048 bits.
path_to_CA_csr
File name for the certificate signing request (CSR) that you created
for the certificate authority (CA).
path_to_CA_key
File name for the private key that you created for the certificate
authority (CA).
number_of_days
Number of days for the new certificate to be valid.
CA_certificate_name
File name for the certificate of your CA. This certificate is used to
sign your CSR.
2. Use the CA certificate to sign the certificate signing request that you created in
Creating private keys and certificates.
openssl x509 -req -days number_of_days -in path_to_csr.csr
-CA path_to_CA_certificate.arm
-CAkey path_to_CA_key.key -out new_certificate.arm -set_serial 01
-sha256

For example, openssl x509 -req -days 90 -in CSR.csr -CA CA_certificate.arm
-CAkey CA_private_key.key -out certificate.arm -set_serial 01 -sha256

Where:
number_of_days
Number of days for the new certificate to be valid.
path_to_csr
Path to certificate signing request (CSR) that you want to sign.
path_to_CA_certificate
Path to certificate that you created for the certificate authority (CA).
path_to_CA_key
Path to the private key that you created for the certificate authority (CA).
new_certificate
File name for the new certificate that is created from your certificate
signing request (CSR). You upload this certificate together with your
private key to BigFix Inventory.
You signed your certificate signing request and obtained a new certificate.
Enable encrypted communication in BigFix Inventory and upload your private key and the
certificate. These files replace the self-signed certificate that is already available in BigFix
Inventory, and thus ensure secure communication. For more information, see: Step 3:
Enabling secure communication.

Step 3: Enabling secure communication
You can enable encrypted communication (HTTPS) to ensure secure communication
between your server and all users that access it. You can base your communication on selfsigned certificates that are provided by default in BigFix Inventory, but these certificates are
not intended for production environments. To improve security, create your own private key
and certificate, and upload them to BigFix Inventory.

Note:
• The use of HTTPS is enabled by default, but this configuration is based
on temporary self-signed certificates that are not intended for production
environments.
• Enabling or disabling the use of HTTPS changes the web address of your
BigFix Inventory server. Ensure that you run a data import afterward to update
the address in the Fixlets that use it to download files from the server.

Procedure
1. Log in to BigFix Inventory.
2. In the top navigation bar, click Management > Server Settings.
3. Select Use HTTPS. The Certificate subsection opens.
Important: Starting from application update

, the use of HTTPS is

enforced and the option to enable it is not available on the user interface.
4. Provide information about the certificate.
• If you have a private key and a certificate:
Note: The certificate and the key must be PEM-encoded or enfolded in
PKCS 12 KeyStore.
a. Select Import a PEM or PKCS#12 private key and certificate.
In application updates earlier than

, select Import a PEM encoded

private key and certificate.
b. Click Browse to locate the file in the PEM or PKCS 12 format.
c. If the private key and certificates are delivered in separated files, select
Private key is in a separate file and locate the private key file.

d. In the Private key password field, enter the password for the key. This field
is required only if you set a password for your private key.
e. Click Save.
Note: The certificate and the key must be PEM-encoded.
• If you want to generate a new self-signed certificate:
Restriction: A self-signed certificate contains a public key, information
about the owner of the certificate, and the owner's signature. Because
such a certificate is signed by its own private key, it does not provide
means to verify the origin of the certificate through a trusted certificate
authority.
a. Select Generate a self-signed certificate.
b. Specify the certificate subject common name. The common name must
correspond to the DNS name of the BigFix Inventory server.
c. In the Expiration Date field, enter the date when the certificate expires.
d. Click Save.
Note: Most browsers display a warning message when a self-signed
certificate is used.
5. Restart the server.
You enabled secure communication on your server. All outgoing communication is now
encrypted with the private key that you provided.

Related information
SP800-131 compliance
Enabling SP800-131 compliance

Configuring Cipher suites
This topic describes how to manually select Cipher Suites that should be accepted by BigFix
Inventory server.
The list of vulnerable Cipher Suites is updated regularly. Accepted cipher suites are updated
with new Java service packs so that vulnerable ciphers are not included. You can manually
select the ciphers that should be enabled to address security risks before it is addressed by
Java service pack or to comply with the security policy.
Below is the recommendation based on internal security scans.
To select the list of accepted cipher suites, modify the installation_directory/wlp/
usr/servers/server1/customization.xml file, to make the file contents look like
below:
<server>
<ssl id="defaultSSLConfig"
enabledCiphers="TLS_ECDHE_RSA_WITH_AES_128_CBC_SHA256
TLS_ECDHE_RSA_WITH_AES_128_GCM_SHA256
TLS_ECDHE_RSA_WITH_AES_256_CBC_SHA384 TLS_ECDHE_RSA_WITH_AES_256_GCM_SHA384
TLS_DHE_RSA_WITH_AES_128_CBC_SHA256
TLS_DHE_RSA_WITH_AES_256_CBC_SHA256 TLS_DHE_RSA_WITH_AES_128_GCM_SHA256
TLS_DHE_RSA_WITH_AES_256_GCM_SHA384"/>
</server>

Restart BigFix Inventory application after you make the changes.

Assuring compliance with federal encryption
standards
You can configure BigFix Inventory to be compliant with the Federal Information Processing
Standard requirements that are related to encryption.

Federal Information Processing Standard 140-2
Federal Information Processing Standards (FIPS) are standards and guidelines that are
issued by the National Institute of Standards and Technology (NIST) for federal government
computer systems.
Government agencies and financial institutions use Federal Information Processing
Standard (FIPS) to ensure that the products conform to specified security requirements. For
more information about these standards, see the NIST website.
FIPS 140-2 is the standard that defines the security requirements for cryptographic
modules that are used within a system that handles sensitive but unclassified information.
Compliance with the FIPS 140-2 standard has two aspects that affect BigFix Inventory:
the algorithms that are used to manage sensitive data must be FIPS-approved and a FIPSapproved implementation must be used when data is transmitted with the SSL/TLS.
BigFix Inventory uses the FIPS 140-2 approved cryptographic providers for cryptography:
• IBMJCEFIPS (certificate 376)
• IBMJSSEFIPS (certificate 409)
• IBM Crypto for C (ICC) (certificate 384)
The certificates are listed on the NIST web site.

Configuring the server to achieve FIPS compliance
You can assure compliance with the FIPS 140-2 standard by modifying the configuration
properties for the underlying application server.
Important: After upgrading BigFix Inventory server version 10.0.4 or higher with
FIPS function enabled, ensure that java.security files contains RSAPSS,
RSASSA-PSS listed in the jdk.tls.disabledAlgorithms.

1. Edit your java.security file that is in the following directory:
• <installation_dir>/wlp/usr/servers/server1/ (BigFix Inventory
version 10.0.8 or higher)
• <installation_dir>/jre/jre/lib/security/ (BigFix Inventory version
10.0.7 or lower)
a. Put the com.ibm.crypto.fips.provider.IBMJCEFIPS before the IBMJCE
in the provider list. Ensure that the list is correctly numbered.
b. Add the RSAPSS, RSASSA-PSS algorithm, to the
jdk.tls.disabled.Algorithms list (BigFix Inventory version 10.0.4 or
higher)
Example: jdk.tls.disabledAlgorithms=SSLv3, TLSv1, TLSv1.1, RC4, DES,
MD5withRSA, DH keySize < 1024, DESede, EC keySize < 224, 3DES_EDE_CBC,
anon, NULL, DES_CBC, RSAPSS, RSASSA-PSS
2. Add the -Dcom.ibm.jsse2.usefipsprovider=true property to the jvm.options file.
The property allows the Java™ Secure Socket Extension (JSSE2) provider to run in
FIPS 140-2 mode.
Note: Your certificates must have a key that is at least 1024 bits in length and
can be signed with a DSA or RSA signature algorithm. You can use the IBM
keytool utility to generate a compatible key pair.
3. To use the TLS protocol, configure secure communication.
A number of ciphers are supported by FIPS 140-2. The default HTTPS configuration
automatically enables the FIPS 140-2 compliant ciphers when JSSE is running in FIPS
mode. You can enable specific ciphers by listing them in the enabledCiphers attribute
of the SSL service configuration element in the server.xml file.

SP800-131 compliance
SP800-131 requires longer key lengths and stronger cryptography. The specification also
provides a transition configuration to enable users to move to a strict enforcement of
SP800-131.

The transition configuration also enables users to run with a mixture of settings from both
FIPS140-2 and SP800-131. SP800-131 can be run in two modes, transition and strict. The
transition mode is offered to give you a setting to move your environment to SP800-131
strict mode. In transition mode, it is optional to use the SP800-131 required certificates and
to set the protocol to SP800-131.
The following requirements must be fulfilled to allow for the strict enforcement of
SP800-131:
• The use of the TLS version 1.2 protocol for the Secure Sockets Layer (SSL) context.
• Certificates must have a minimum length of 2048 bytes. An Elliptic Curve (EC)
certificate requires a minimum size of 244-bit curves.
• Certificates must be signed with a signature algorithm of SHA256, SHA384, or
SHA512. Valid signature algorithms include:
◦ SHA256 with RSA
◦ SHA384 with RSA
◦ SHA512 with RSA
◦ SHA256 with ECDSA
◦ SHA384 with ECDSA
◦ SHA512 with ECDSA
• SP800-131 approved cipher suites.
For more information about the SP800-131 standard, see the web site run by National
Institute of Standards and Technology.
Related information
Step 3: Enabling secure communication
Enabling SP800-131 compliance

Enabling SP800-131 compliance
You can set up a BigFix Inventory profile to meet the SP800-131 requirement that is
originated by the National Institute of Standards and Technology (NIST).

You can configure BigFix Inventory to run in SP800-131 strict or transition mode.
• To configure the product to run in strict mode:
1. Ensure that your server certificates meet the criteria for SP800-131.
For more information about SP800-131, see the National Institute of Standards
and Technology Special Publication 800-131A.
2. Enable the Java Secure Socket Extension (JSSE) to run in SP800-131 strict
mode: set the system property com.ibm.jsse2.sp800-131 to strict. The property
must be set in the jvm.options file, which is in the installation_dir/
wlp/usr/servers/server1 directory.
Example:
-Dcom.ibm.jsse2.sp800-131=strict

Note: If your server certificates do not meet the criteria for SP800-131 or if
the TLS version 1.2 protocol is not used, then after you restart the server you
are not able to connect to BigFix Inventory. In this event, you can remove the
com.ibm.jsse2.sp800-131 property from the jvm.options file, or set the
property to transition.
• To configure the product to run in transition mode, enable JSSE to run in SP800-131
transition mode by setting the system property com.ibm.jsse2.sp800-131 to
transition. The property must be set in the jvm.options file, which is in the
installation_dir/wlp/usr/servers/server1 directory.
Example:
-Dcom.ibm.jsse2.sp800-131=transition

Related information
SP800-131 compliance
Step 3: Enabling secure communication

Authenticating users with LDAP
BigFix Inventory supports authentication through a Lightweight Directory Access Protocol
(LDAP) server. To use this feature, you must configure the BigFix Inventory server.

Configuring connection to a directory server
To use LDAP for authentication of BigFix Inventory users, you must first configure a
connection to your directory server.
•

You must have the Manage Directory Servers permission to perform this task.

1. In the top navigation bar, click Management > Directory Servers.
2. To create an LDAP connection, click New.
3. Enter a name for the new directory service.
4. In the LDAP server list, select the type of your LDAP server. If your LDAP server
values are different from the defaults, select Other and enter the values of filters and
attributes of your LDAP server. If you select Microsoft Active Directory Global Catalog,
the Search Base field is disabled.
Important: The default values might need to be modified in particular for
openLDAP servers due to various implementations of openLDAP.
5. Type the name of Search Base. This parameter defines the location in the directory
from which the LDAP search begins.
6. If your directory server uses Secure Socket Layer protocol, select the SSL check box.
7. If your server requires authentication, clear Anonymous bind and provide a name
and a password for the user whose credentials are to be used for connecting to the
directory server.
Tip: If you selected Microsoft Active Directory, provide the user name
as Active Directory logon name or User Principal Name, for example
username@domain.com. Do not specify the user name in the following way:
DOMAIN/username.

8. In the Host text field, provide the host name or IP address of your primary LDAP
server.
9. Accept the default port value or provide a new one.
10. Optional: To add a backup server:
a. Click add backup server.
b. Provide its host name or IP address and the port number.
11. To verify whether all of the provided entries are valid, click Test Connection.
A confirmation pop-up window opens.
12. Click Create. A confirmation message is displayed in the middle of the page.
You configured a connection to your LDAP server.

Related information
User provisioning

Editing a directory server configuration
1. On the Directory Servers page, click the name of the directory server whose
configuration you want to modify.
2. In the lower area of the window, enter the new parameters.
3. Click Save.

Deleting a directory server configuration
1. On the Directory Servers page, click the name of the directory server whose
configuration you want to delete.
2. In the upper left area of the window, click Delete.

Configuring a directory server with load balancer or multiple
domain controllers
If your LDAP server uses load balancer or multiple domain controllers that dynamically
change the list of hosts, and the connection between LDAP and the BigFix Inventory server

is secure, perform advanced configuration of the BigFix Inventory server. The LDAP server
can be already configured in BigFix Inventory.
The <install_dir> is the directory where the BigFix Inventory server is installed. By default, it
is the following path.
/opt/BFI
C:\Program Files\BigFix Enterprise\BFI
Substitute <install_dir> in the procedure with the directory where the BigFix Inventory server
is installed in your environment.
For application update 9.2.9 or higher, perform the following steps to

•

permanently configure the directory server.
1. Contact your LDAP server administrator to obtain a public certificate from the
certificate authority (CA) that issues server certificates for LDAP. The certificate
file should be in the PEM format, and should contain one or more certificates
(full chain of trust).
For example:
-----BEGIN CERTIFICATE----MIIHZjCCBk6gAwIBAgISKESJLWXAAAACTANBgkqhkiG9w0BAQUFADBNMRMwEQYK
CRWmyVBwPWQBBUNdilPKJRQwpeYKCZImiZPyLGQBGRYEQ354jTEgGG7GA1UEAiU5
.
.
.
MTAzMzQxWjBZMRMwEQYKCZImiZPJVGQBGRYDbmV0MRkwFwYKCZImiZPyLGQBGRYJ
bnNyb290ZGV2MScwJQYDVQQDEx5DaXRXAEludGVybmFsIERldmljZSBDQSAwMyBM
-----END CERTIFICATE-----

2. To create a custom truststore and import the public certificate for the LDAP
server to that truststore, run the following command.

<install_dir>/jre/jre/bin/keytool -import
-file <path_to_certificate> -alias ldapCA
-keystore <install_dir>/
wlp/usr/servers/server1/resources/security/ldap_truststore
-storepass <password>

Where:
-file
Is the path to the public certificate of the LDAP server.
-storepass
Is the password that you want to set for the truststore.
3. After you run the command, confirm it by typing yes in the following line.
Trust this certificate? [no]: yes

4. To encode the truststore password, perform the following steps.
a. Set the JAVA_HOME variable.
◦

export JAVA_HOME=<install_dir>/jre/jre

◦

set JAVA_HOME=<install_dir>/jre/jre

b. Run the following command.
<install_dir>/wlp/bin/securityUtility encode --encoding=aes

c. When prompted, enter and re-enter the password that you specified in
step 2.
d. Save the encoded password. You will need it to complete this procedure.
5. Back up the server.xml file before you make any changes. Then, provide
information about the location of the truststore and its password in the
server.xml file.
a. Open the server.xml file that is in the <install_dir>/wlp/usr/
servers/server1 directory.
b. Locate the keyStore entry that has the defaultKeyStore identifier.

<keyStore id='defaultKeyStore'>

c. Paste the following lines after that entry. In the password parameter,
provide the encoded password from step 3.
<keyStore id='ldapCustom'
location='<install_dir>/
wlp/usr/servers/server1/resources/security/ldap_truststore'
password='{aes}xxxxXXXXxxxxXXXXxxxxXXXXxxxx'/>

• For versions older than application update 9.2.9, perform the following steps to
configure the directory server. This solution must be applied after each application
upgrade, as the certificates that you add according to this procedure are not
preserved.
Note: Before you begin, contact the HCL Support for the password that is
required during configuration.
1. Contact your LDAP server administrator, and obtain the public certificate from
certificate authority (CA) that issues the server certificates for LDAP. The
certificate file should be in the PEM format, and should contain one or more
certificates.
For example:
-----BEGIN CERTIFICATE-----

MIIHZjCCBk6gAwIBAgISKESJLWXAAAACTANBgkqhkiG9w0BAQUFADBNMRMwEQYK

CRWmyVBwPWQBBUNdilPKJRQwpeYKCZImiZPyLGQBGRYEQ354jTEgGG7GA1UEAiU5
.
.
.

MTAzMzQxWjBZMRMwEQYKCZImiZPJVGQBGRYDbmV0MRkwFwYKCZImiZPyLGQBGRYJ

bnNyb290ZGV2MScwJQYDVQQDEx5DaXRXAEludGVybmFsIERldmljZSBDQSAwMyBM
-----END CERTIFICATE-----

2. Copy the certificate file to the following directory: <install_dir>/jre/jre/
lib/security/.
3. Run the following command:
<install_dir>/jre/jre/bin/keytool -import -trustcacerts -file
<certificate_file_name>
-alias certAliasName -keystore cacerts -storepass <password>

Where <password> is the password that was provided by the BigFix Support.

Linking users to directories
To complete an authentication process through LDAP, you must create a user that would
link to the created directory.
You must have the Manage Users permission to perform this task.
1. In the top navigation bar, click Management > Users.
2. To create a user, click New.
3. In the User Name field, type the name of an existing user of an LDAP server.
Tip: The login format depends on the configuration of your environment. It
can be, for example, an e-mail address, or a user ID, and it might need to be
followed by a domain name.
4. From the list, select a Computer Group to which the user would be assigned.
5. From the Authentication Method list, select the name of an LDAP directory.
6. Click Create.

7. To delete the created user, click its name. Then, in the upper left of the window click
Delete.
Note: The deleted user cannot be re-created.
To confirm authentication, log in to the BigFix Inventory server with the credentials of the
LDAP user that you created in BigFix Inventory.

User provisioning
After configuring a Directory Server, you can integrate its users with BigFix Inventory using
the LDAP protocol. With user provisioning, you can integrate whole groups of users instead
of linking each of them separately. The user provisioning works for users of specific LDAP
groups and not for the users of the nested groups and sub-groups.
Configure a Directory Server.
1. Log in to BigFix Inventory.
2. In the top navigation bar, click Management > User Provisioning.
3. Click New to create a new user provisioning rule.
4. In Group Names, start typing the name of a group of users from your Directory Server
and then choose one of the auto-filled results.
5. In Roles, select the roles that will be assigned to the new users.
6. In Computer Group, select the computer group to which the new users will be
assigned.
7. Click Create.
You integrated your Directory Server users with BigFix Inventory. Each user is created in
BigFix Inventory after you log in to the application with that user. The user is assigned a role
that is defined in user provisioning. However, the role can be changed later on.
Important: If you want to log in with Active Directory users, the user name must be
followed by a domain name, for example username@domain.com.

Related information
Configuring connection to a directory server

Integrating users with Web Reports
You can use the Web Reports component to allow your local Web Reports users to access
BigFix Inventory.
Install the Web Reports component. The component is typically installed together with your
BigFix server but you can also add it to your environment at any time. To do so, start the
installation of BigFix and choose to install only Web Reports.
You can use the same credentials for the user as specified in Web Reports. To achieve
this create an entry for user in BigFix Inventory using the username as in Web Reports and
choose Web Reports as authentication method. Whenever you change the credentials in
Web Reports, they will also be valid in BigFix Inventory with no additional configuration.
Role of the user is managed in BigFix Inventory.
Only local Web Reports users are supported.
1. Connect your BigFix Inventory server to the Web Reports database.
a. Log in to BigFix Inventory.
b. In the navigation bar, click Management > Data Sources.

c. Click on your data source and fill in the connection parameters for the Web
Reports database. The required information will differ depending on the type of
the database that you use. For more information, see the following examples.

2. Each of your Web Reports users must be manually added to BigFix Inventory. After
your complete this action, the users will be linked with their equivalents in Web
Reports:
a. In BigFix Inventory, click Management > Users.
b. Click New to create a new user.
c. Enter the user name that corresponds with a Web Reports user name.
d. Select the appropriate roles.
The roles are not integrated between the applications and must be selected
manually for each user.
e. In the Authentication Method, choose Web Reports.

f. Click Create.
g. Repeat this action for each of your Web Reports users.
The created user is linked with its equivalent in Web Reports. You can now use it to log in
to BigFix Inventory by using the same password that is specified in Web Reports. Whenever
you change this password in Web Reports, it will also be valid for logging in to BigFix
Inventory.

Troubleshooting LDAP connectivity issues
Troubleshoot the LDAP connectivity issues.

1. Log in to BigFix Inventory as a non-LDAP user.
2. Click Management > Directory Services, select the directory server and then click Test
Connection.
If a "connect error" message is displayed, or if an error message states that the
current certificate is not trusted but the displayed subject common name and
fingerprint fields are empty, complete these steps:
Figure 10. LDAP connectivity error

a. Go to <INSTALL_DIR>/wlp/usr/servers/server1/logs and review the
tema.log file for additional information.

b. Go to <INSTALL_DIR>/wlp/usr/servers/server1 and review the
jvm.options file. Ensure that the following line exists to the jvm.options file

and restart BigFix Inventory:
-Dcom.ibm.jsse2.overrideDefaultCSName=true

This line is added by default in BigFix Inventory version 10.0.5 or newer.
Note: Backup the files before you modify the files.
3. If the issue persists, add the following lines to the jvm.options file and restart BigFix
Inventory:
-Dcom.unboundid.util.SSLUtil.defaultSSLProtocol=TLSV1.2
-Dcom.unboundid.util.SSLUtil.enabledSSLProtocols=TLSV1.2

4. Accept the current certificate and save the certificate only if the displayed subject
common name and fingerprint fields are not empty and contain valid values.
The LDAP connectivity issue is resolved.

Configuring and enabling single sign-on (SSO)
Available from 9.2.1. You can now use the two-factor authentication and use SSO to log on
to BigFix Inventory and maintain login consistency with other applications in the enterprise.
You can configure BigFix Inventory to use two-factor authentication with single sign-on
based either on the exchange of Security Assertion Markup Language (SAML 2.0) token
and Microsoft™ Active Directory Federation Services as Identity Provider or you can use the
IBM Lightweight Third-Party Authentication (LTPA) technology and IBM Security Access
Manager for Web as the authentication service.
To enable debug logging for single sign-on in BigFix Inventory, edit the web.xml file and
change the value of config.sso.debug to true.

<context-param>
<param-name>config.sso.debug</param-name>
<param-value>true</param-value>
</context-param>

The solution described in this section is based on the assumption that the connection with
BigFix Inventory is established via the BigFix Inventory host name. For complex scenarios,
you need to manually configure SAML provider in the server.xml file and perform
additional configuration of the authentication service.

Session timeout configuration when logged in through SSO
You can set the session timeout for BigFix Inventory. Refer to the steps mentioned at
Session timeout.
Note: The time that you set must be greater than the current SSO time. If you set a
time lower than current SSO time, BigFix Inventory times out sooner and does not
redirect you to the SSO login page. It gives an error message.

Option 1: Configuring single sign-on based on Security Assertion
Markup Language token
You can configure single sign-on based on a Security Access Markup Language (SAML 2.0)
token and an external Identity Provider server.
The following entities participate in the exchange of authentication data:
Application User
A person who uses several applications in one domain and wants to single
sign-on to these applications.
Service Provider
The application that requests the authentication service. In this case, it is
BigFix Inventory.
Identity Provider

The service that authenticates the application users. BigFix Inventory supports
only Active Directory Federation Services.
A web user authenticates to a SAML Identity Provider, which produces a SAML assertion.
A SAML assertion is an XML-formatted token that is used to transfer user identity and
attribute information from the Identity Provider of a user to a trusted Service Provider as
part of a single sign-on request. The Service Provider consumes the SAML assertion to
establish a security context for the web user.
The following diagram shows steps that are performed during a typical single sign-on based
on the exchange of the SAML token.

Procedure
The following scenario presents a typical workflow of configuring BigFix Inventory to work
with Active Directory Federation Services. However, you might want to use other software
products for enabling single sign-on in your infrastructure.

Related information
SAML 2.0 Web Browser Single-Sign-On
Configuring SAML Web Browser SSO in the Liberty profile

Step 1: Configuring single sign-on settings in BigFix Inventory
As the first step, configure single sign-on settings in BigFix Inventory.
Gather necessary information
Before you start the configuration, gather the following information:
• URL to the login page of the Identity Provider. It is the URL to which an
unauthenticated request is redirected. After the request is authenticated
by the Identity Provider, the user is redirected to BigFix Inventory.
For example: https://ADFS_host_name/
adfs/ls/IdPInitiatedSignOn.aspx?
LoginToRP=https://BFI_host_name:9081/ibm/saml20/
defaultSP.
• URL of the Trusted Issuer. It is the URL to the certificate issuer of the
Identity Provider that is needed to establish a trust relationship.
For example, http://ADFS_host_name/adfs/services/trust.
• Public certificate of the Identity Provider in the key_name.cer format.
Enable SSL
Ensure that SSL is enabled in BigFix Inventory and in the Identity Provider.
Backup files

Before you start configuring single sign-on, back up the following files:
• server.xml
◦

bfi_install_dir/wlp/usr/servers/server1

◦

bfi_install_dir\wlp\usr\servers\server1

• web.xml
◦

bfi_install_dir/wlp/usr/servers/server1/
apps/tema.war/WEB-INF

◦

bfi_install_dir\wlp\usr\servers
\server1\apps\tema.war\WEB-INF

Note: If you set up the session timeout for Single Sign-On, remember
that it should be longer than the session timeout that is set up for
BigFix Inventory. Otherwise, change the settings in BigFix Inventory.
For more information, see: Setting session timeout.
Create users
Create BigFix Inventory users who will use the single sign-on. During the
creation of the users, select Single Sign-on as the authentication method.
Ensure that all user names are fully-qualified names that contain the full
domain name, for example: user@domain.example. Also, ensure that at least
one user is an Administrator.
If the BigFix Inventory server is installed on Linux, and users in
the Identity Provider use the camel-case naming convention, create users
following the same convention in BigFix Inventory. Otherwise, the users are
not be able to generate audit snapshots.
Note: User token is not available after a single sign-on user is created.
If you need the token, for example to run REST API calls, ask the BigFix
Inventory administrator to provide it for you.

1. Log in to BigFix Inventory, and click Management > Single Sign-On Settings.
2. Select SAML as the single sign-on method.
The Instance ID filed is automatically filled with the defaultSP value. It is the identifier
of the BigFix Inventory service. Together with the BigFix Inventory URL, it forms the
overall Service Provider ID: https://BFI_host_name:BFI_port/ibm/saml20/
defaultSP.
Based on this value, the SAML Assertion Consumer Service URL is built:
https://BFI_host_name:BFI_port/ibm/saml20/defaultSP/acs. The URL
should be used for the configuration of the Identity Provider.
3. Specify the URL to the login page of the Identity Provider that you will use to single
sign-on to BigFix Inventory.
For example:
https://ADFS_host_name/
adfs/ls/IdPInitiatedSignOn.aspx?LoginToRP=https://BFI_host_name:9081/i
bm/saml20/defaultSP

Important: Ensure that the URL that you specify is correct. The address is not
validated. If you make a typo in the URL, you might need to manually revert the
SSO configuration.
4. Provide the public certificate of the Identity Provider. Click Browse to locate the
key_name.cer certificate that you created.
5. Provide the URL of the certificate issuer of the Identity Provider. It is the issuer name
of the Identity Provider as it appears in the SAML assertion.
For example:
http://ADFS_host_name/adfs/services/trust

Important: Ensure that the URL that you specify is correct. The address is not
validated. If you make a typo in the URL, you might need to manually revert the
SSO configuration.

6. Click Save.
7. Optional: To use a custom certificate for the SSO setup, see: Using a CA-signed
(custom) certificate for SSO based on SAML. Otherwise, continue to the next step.
8. Click the Download Service Provider Metadata link, and save the spMetadata.xml
file.
Note: When the SAML single sign-on entry is created, only the Delete button,
and the Download SP Metadata link are enabled. If the download link is not
displayed, restart the BigFix Inventory server.
Based on the spMetadata.xml file, configure Identity Provider for single sign-on.

Using a CA-signed (custom) certificate for SSO based on SAML
By default, a self-signed certificate is used during the SSO configuration. However, you can
use a custom certificate generated for the BigFix Inventory server to increase security of the
configuration.
1. Log in to the computer where Active Directory Federation Services are installed.
2. Generate a certificate for the BigFix Inventory sever signed by a trusted CA.
Important: Ensure that you remember the certificate label that is used during
certificate generation as it is needed in further steps.
3. Export the certificate into a .pfx file. For example, custom_cert.pfx.
4. Copy the custom_cert.pfx file to the computer where the BigFix Inventory server
is installed and place it in the following location: install_dir\wlp\usr\servers
\server1\resources\security.
5. To delete the existing self-signed certificate and private key provided by HCL, run the
following commands.
install_dir\jre\jre\bin\ikeycmd -cert -delete -label cert_label -db
install_dir\wlp\usr\servers\server1\resources\security\<keystore_name>
-pw sso_password -type <type>

Where:
cert_label
Is the label of the custom certificate generated for the BigFix Inventory
server in step 2. If you do not know the certificate label, run the following
command:
install_dir\jre\jre\bin\ikeycmd -cert -list -db custom_cert
.pfx -pw custom_cert_password -type pkcs12

sso_password
Is the password to the SSO keystore. For the default keystore password
contact the HCL Support. Otherwise, provide the password that you
configured.
6. To import the custom certificate, run the following commands.
install_dir\jre\jre\bin\ikeycmd -cert -import -file custom_cert.pfx
-pw custom_cert_password -type pkcs12 -target
install_dir\wlp\usr\servers\server1\resources\security\<keystore_name>
-target_pw sso_password -target_type <type> -label cert_label
-new_label samlsp

Where:
custom_cert_password
Is the password to the custom certificate generated in step 2.
sso_password
Is the password to the SSO keystore.
cert_label
Is the label of the custom certificate generated in step 2.
7. In BigFix Inventory go to Management > Single Sign-On Settings. Click Download
Service Provider Metadata, and save the spMetadata.xml file.
Based on the spMetadata.xml file, configure Identity Provider for single sign-on.

Note: The <type> and <keystore_name> parameters that apply to the above
commands specifies the following:
<type>

Starting from version 10.0.8.0, the type of the certificate is PKCS12.
For earlier versions, it is JCEKS.
<keystore_name>
Starting from version 10.0.8.0, the name of the keystore file is
SPKeyStore.p12. For earlier versions, it is SPKeyStore.jceks.

Step 2: Configuring Identity Provider for single sign-on
As the second step, configure BigFix Inventory server as a relying party to consume claims
from the Identity Provider. Perform the configuration based on the spMetadata.xml file
that you downloaded from BigFix Inventory.
BigFix Inventory supports single sign-on (SSO) through Active Directory Federation Services
(AD FS). If you are using Azure, you must configure Azure to AD FS to authenticate through
the SSO and access the application. The following procedure is based on the example of AD
FS.
1. Log in to the computer where Active Directory Federation Services are installed.
2. Copy the spMetadata.xml file from your computer to a directory on the AD FS
server.
3. Click the Start rectangle in the lower-left area of the screen in Windows 2012 and then
click the AD FS Management tile.
4. In the left navigation tree of the AD FS application, expand AD FS > Trust
Relationships > Relying Party Trusts.
5. In the Relying Party Trusts pane on the right, click Add Relying Party Trust. A wizard
opens. Click Start.
6. Select Import data about the relying party from a file.
7. Click Browse, select the spMetadata.xml file and click Open. Click Next.

8. On the new pane, provide the Display name for your ADFS service. Click Next.
9. Leave the option Permit all users to access the relying party selected, and click Next.
10. On the Ready to Add Trust pane, click Next.
11. On the Finish pane, click Close. The Edit Claim rules window opens.
12. Click the Add Rule button in the lower left corner. The Add Transform Claim Rule
wizard opens. Click Next.
13. In the Claim Rule template, type Name ID rule.
14. From the Attribute store drop-down list, select Active Directory.
15. In the Mapping of LDAP Attributes to outgoing claim types section, click the first
drop-down list and select User Principal Name. From the second list, select Name ID.
16. Repeat the step to achieve the following configuration and click Finish.
Table 186. Mapping of LDAP Attributes to outgoing claim types
LDAP Attribute

Outgoing Claim Type

User-Principal-Name

Name ID

E-Mail-Addresses

E-Mail Address

Token-Groups - Qualified by Long Do

Group

main Name
SAM-Account-Name

Windows™ account name

17. In the Edit Claim rules window, click Apply and OK.
Enable single sign-on in BigFix Inventory.

Step 3: Enabling the SAML single sign-on
As the final step, enable single sign-on in the BigFix Inventory web user interface.
Important: Before enabling single sign-on, create a dedicated administrative user.
For more information, see: Creating single sign-on users.

1. Log in to BigFix Inventory, and click Management > Single Sign-on Settings. Then,
click Enable.
2. Stop the BigFix Inventory server.
3. Start the BigFix Inventory server. The BigFix Inventory web user interface opens and
you are redirected to the login page of the Identity Provider.
4. Provide the user name and password and click sign-in.
Note: All user names must be fully-qualified names that contain the full
domain name. For example: user@domain.example.

Reverting disabled SSO configuration for SAML
You can revert to the default SAML SSO configuration with single sign-on disabled if there
are problems with logging in to the application.
To revert to the disabled SAML SSO configuration, follow the automated procedure below.
1. Stop the BigFix Inventory server.
2. Restore the web.xml file from the web.xml.timestamp.backup file. The backup
file was created automatically in the following location:
•

bfi_install_dir/wlp/usr/servers/server1/apps/
tema.war/WEB-INF

•

bfi_install_dir\wlp\usr\servers\server1\apps
\tema.war\WEB-INF

3. Start the BigFix Inventory server.

Reverting disabled SSO configuration for SAML manually
It is recommended to use the automated solution to revert to the disabled SAML SSO
configuration. However, if the automated solution is not successful, follow the steps below
to revert the default SAML SSO configuration manually.
1. Stop the BigFix Inventory server.
2. Make changes in the server.xml file that is in the following directory.

•

bfi_install_dir/wlp/usr/servers/server1

•

bfi_install_dir\wlp\usr\servers\server1

a. Remove the <application-bnd> element that is inside of the <application>
element.
<application autoStart='true' location="tema.war"
context-root="/" name="tema" type="war">
<classloader commonLibraryRef='tema,DatabaseLib'
delegation='parentLast'/>
<application-bnd>
<security-role id="TemaSSOAuthenticated"
name="TemaSSOAuthenticated">
<special-subject type="ALL_AUTHENTICATED_USERS" />
</security-role>
</application-bnd>
</application>

b. Remove the <feature>samlWeb-2.0</feature> element that is inside the
<featureManager> element.

c. Remove the <samlWebSso20> element if it exists.
3. Make changes in the web.xml file that is in the following directory.
•

bfi_install_dir/wlp/usr/servers/server1/apps/
tema.war/WEB-INF

•

bfi_install_dir\wlp\usr\servers\server1\apps
\tema.war\WEB-INF

a. Set the value of the <config.sso.enabled> parameter to false.
<context-param>
<param-name>config.sso.enabled</param-name>
<param-value>false</param-value>
</context-param>

b. Remove the <security-constraint> element.
<security-constraint>
<display-name>TemaSSOAuthenticated</display-name>
<web-resource-collection>
<web-resource-name>index</web-resource-name>
<url-pattern>/</url-pattern>
<url-pattern>/session/*</url-pattern>
<url-pattern>/management/*</url-pattern>
<url-pattern>/scm/*</url-pattern>
<url-pattern>/sam/*</url-pattern>
<url-pattern>/setup/*</url-pattern>
<url-pattern>/internal/*</url-pattern>
<url-pattern>/wait_for_import</url-pattern>
<url-pattern>/import_finalizing</url-pattern>
<url-pattern>/import_status</url-pattern>
<url-pattern>/missing_computer_group</url-pattern>
<url-pattern>/account/*</url-pattern>
<url-pattern>/autocomplete/*</url-pattern>
<url-pattern>/pagestates/*</url-pattern>
<url-pattern>/reports/*</url-pattern>
<url-pattern>/test/*</url-pattern>
<url-pattern>/help/*</url-pattern>
</web-resource-collection>
<auth-constraint>
<role-name>TemaSSOAuthenticated</role-name>
</auth-constraint>
<user-data-constraint>
<transport-guarantee>CONFIDENTIAL</transport-guarantee>
</user-data-constraint>
</security-constraint>

4. Start the BigFix Inventory server.

Option 2: Configuring single sign-on based on IBM Lightweight
Third-Party Authentication
You can configure single sign-on based on IBM Lightweight Third-Party
Authentication(LTPA)with ® IBM Security Access Manager for Web.
Back up the following files before you start configuring single sign-on:
• server.xml
◦

installation_dir/wlp/usr/servers/server1

◦

installation_dir\wlp\usr\servers\server1

• web.xml
◦

installation_dir/wlp/usr/servers/server1/apps/
tema.war/WEB-INF

◦

installation_dir\wlp\usr\servers\server1\apps
\tema.war\WEB-INF

The following scenario presents a typical workflow for configuring BigFix Inventory to work
with BigFix® Security Access Manager. However, you might want to use other software
products for enabling single sign-on in your infrastructure.
1. Configure the connection to your directory server.
2. Create the users that will be authenticated with the single sign-on server. You must
create at least one user that has the Administrator role.
Important: Ensure that you select Single Sign-on from the Authenticated
method drop-down list.
3. Export the LDAP server SSL certificate embedded in BigFix® IBM Security Access
Manager for Web.
4. Configure LTPA single sign-on in BigFix Inventory web user interface.
5. Import the LTPA keys into BigFix® Security Access Manager for Web.
6. Import the BigFix Inventory server certificate into BigFix® Security Access Manager
for Web.
7. Configure a Virtual Junction in BigFix® IBM Security Access Manager for Web.

8. Enable single sign-on in BigFix Inventory.
9. Optional: Update the WebUI shortcut (Windows only)
10. Optional: Reverting SSO configuration for LTPA.
You can revert to the default LTPA SSO configuration with single sign-on disabled if
there are problems with logging in to the application.

Related information
Configuring LTPA on the Liberty profile
Customizing SSO configuration using LTPA cookies for the Liberty profile

Step 1: Exporting the LDAP server SSL certificate embedded in
BigFix Security Access Manager
You must export the certificate from the LDAP server embedded in IBM Security Access
Manager (ISAM) to be able to configure the single sign-on in the BigFix Inventory web user
interface.
1. Log on to the ISAM web user interface.
2. Manage System Settings > Secure Settings > SSL Certificates.
3. Select embedded_ldap_keys, click the Manage drop-down list and then click Edit SSL
Certificate Database.
4. Open the Personal Certificates tab. Select server, click the Manage drop-down list
and then click Export. A pop-up window opens with the server certificate details.
5. Click OK and save the file in a directory on your computer.
You exported the LDAP server SSL certificate. You can use it in the next step while
configuring LTPA single sign-on.

Step 2: Configuring LTPA single sign-on
You can use the Single Sign-On Settings pane to configure IBM Lightweight Third-Party
Authentication (LTPA) settings in BigFix Inventory.

Note: If you set up the session timeout for Single Sign-On, remember that it should
be longer than the session timeout that is set up for BigFix Inventory. Otherwise,
change the settings in BigFix Inventory. For more information, see: Setting session
timeout.
1. In the BigFix Inventory web UI, click Management > Single Sign-On Settings.
2. Select LTPA as the single sign-on method.
3. From the Directory Server drop-down list select the LDAP server that you want to be
used for authenticating users.
4. Click Browse and select your certificate file.

5. Click Save.
6. Stop the BigFix Inventory server.
7. Start the BigFix Inventory server.

Step 3: Importing LTPA keys into BigFix® Security Access Manager
You must import the LTPA keys into IBM® Security Access Manager to add BigFix Inventory
to the trusted list.
1. In the BigFix Inventory web user interface, click Management > Single Sign-On
Settings.
2. Click Download LTPA keys and save the files in a directory on your computer.
3. Log on to the Security Access Manager web user interface.
4. Click Secure Web Settings > Global Keys > LTPA Keys.

5. Click Manage > Import

6. Click Browse and select the file to be imported.
7. Click Import.

A message about one not deployed change is displayed. The LTPA keys are displayed
together with other keys.

8. Click the link Click here to review the changes or apply them to the system.
You just imported the LTPA keys into IBM® Security Access Manager for Web.
It is also advisable to rename the imported key file. To rename the file that you imported:
1. Click the Manage drop-down list and then click Rename.
2. In the pop-up window that opens, provide the new name for your LTPA keys file and
click Save.
3. On the LTPA Key Files pane, click the link Click here to review the changes or apply
them to the system.
4. In the Deploy Pending Changes pop-up window, click Deploy.

Step 4: Importing the BigFix Inventory server certificate into IBM®
Security Access Manager
Import the BigFix Inventory server certificate into BigFix® Security Access Manager for Web
to establish trusted server-to-server communication.
1. In the BigFix Inventory web UI, click Management > Server Settings.
2. Click Download Certificate and save the file in a directory on your computer.
3. Log on to the Security Access Manager web user interface.
4. Click Manage System Settings > Secure Settings > SSL Certificates.

5. Select pdsrv and then, from the Manage drop-down list, select Edit SSL Certificate
Database.

6. From the Manage drop-down list, select Import. A new window opens.

7. Click Browse to select the certificate file and provide the certificate label.

8. Click Import.
9. Click Close to close the Edit SSL certificate database - pdsrv pop-up window.
A message about an undeployed change is displayed.
10. Click the link Click here to review the changes or apply them to the system.
11. In the Deploy Pending Changes pop-up window, click Deploy.
A message about the successful deployment is displayed.
Restart the default instance of the proxy server for the changes to take effect.
1. Click Secure Web Settings and then Reverse Proxy.
2. In the navigation bar, click Restart.

Step 5: Configuring a virtual junction
A virtual host junction is a mount point for specific content that is located on the WebSEAL
server.
Ensure that the HTTPS port of the reverse proxy in BigFix Security Access Manager for web
is set to 9081, which is the port number used by BigFix Inventory server. If the port is not set
to this value, REST API might not work. To configure this port for the proxy server:

1. In the IBM Security Access Manager user interface, click Secure Web Settings and
then, under Manage click Reverse Proxy.
2. Select the default proxy and click Edit.
3. In the Reverse Proxy Basic Configuration - default window, on the Server tab, provide
9081 as the value of the HTTPS Port and click Save.

1. Log on to BigFix® Security Access Manager.
2. In the top navigation bar, click Secure Web Settings > Manage > Reverse Proxy.

3. Select the instance and then, from the drop-down list on the right of the Reverse Proxy
bar, select Manage > Junction Management. A new pane opens.

4. From the drop-down list in the upper-left corner of the pane, click New > Virtual
Junction.

5. On the new pane, specify the junction label, Virtual Host, Virtual Host Port, and SSL as
the Junction Type, and click Save.

6. Configure a backend server for this junction: Click the Servers tab and then click New.

7. Specify the IP address or host name of the BigFix Inventory server and click Save.

8. Click the Identity tab and select all the items under HTTP Header Identity
Information.

9. Click the SSO and LTPA tab and select the following entries.
• Enable LTPA cookie support
• Use Version 2 Cookies
From the LTPA Keyfile drop-down list, select the file that you into IBM Security Access
Manager and in the next field provide the LTPA keyfile password.

10. Click the General tab and leave all the default configuration unchanged.

11. Click Save to save the configuration and exit the wizard.
12. Click Cancel to exit the Junction Management - default pane.

Step 6: Enabling the LTPA single sign-on
As the final step, enable single sign-on in BigFix Inventory web user interface.
Important: Before enabling single sign-on, create a dedicated administrative user.
For more information, see: Creating single sign-on users.
1. Open the BigFix Inventory web user interface.
2. Go to Management > Single Sign-on Settings and click Enable.
3. Stop the BigFix Inventory server.
4. Start the BigFix Inventory server.

5. Access your BigFix Inventory server using the virtual host that you created in step
Step 5: Configuring a virtual junction. Example: https://virtual_host/sam.
Note: Once LTPA single sign-on is enabled, you will not be able
to access the BigFix Inventory web user interface using the URL
https://host_name:9081.
6. Log in with the directory user that you created in the step Setting up users.

Optional: Updating the WebUI shortcut
You might need to edit the WebUI shortcut if you installed or upgraded to BigFix Inventory
9.2.1 and you also enabled single sign-on using LTPA. This URL is defined in the WebUI file
that is in the following location: C:\Program Files\BFI Enterprise\BFI\admin
\resources\WebUI.
1. Open the WebUI file in a text editor, for example Notepad++, and change the URL from
https://localhost:port-number to https://virtual-junction-host-name:portnumber.

2. Clear the cache in your web browser.
3. End all your browser processes.
4. Restart the system on which your browser is installed.

Optional: Reverting disabled SSO configuration for LTPA
You can revert to the default LTPA SSO configuration with single sign-on disabled if there are
problems with logging in to the application.
1. Stop the BigFix Inventory server.
2. Restore the web.xml file from the web.xml.timestamp.backup file. The backup
file was created automatically in the following location:

•

bfi_installation_dir/wlp/usr/servers/server1/apps/
tema.war/WEB-INF

•

bfi_installation_dir\wlp\usr\servers\server1\apps
\tema.war\WEB-INF

3. Start the BigFix Inventory server.

Creating single sign-on users
To complete an authentication process through single sign-on, you must create users that
can later log in to BigFix Inventory.
You must have the Manage Users permission to perform this task.

1. In the top navigation bar, click Management > Users.
2. To create a user, click New.
3. In the User Name field, type the name of an existing single sign-on user.
Tip: The login format depends on the configuration of your environment. It
can be, for example, an e-mail address, or a user ID, and it might need to be
followed by a domain name.
4. From the list, select a Computer Group to which the user would be assigned.
5. From the Authentication Method list, select Single Sign-On.
6. Click Create.
7. To delete the created user, click its name. Then, in the upper left of the window click
Delete.
To confirm authentication, log in to the BigFix Inventory server with the credentials of the
single sign-on user that you created in BigFix Inventory.

Logging out of the BigFix Inventory server
To log out of the BigFix Inventory user interface, simply clear your browser history and
restart the browser.

1. Clear the browser history. The steps might vary depending on the web browser that
you are using.
2. Restart the web browser.

Disabling the single sign-on configuration
You can disable the SSO configuration on the Single Sign-on Settings pane.
1. Log on to the BigFix Inventory web user interface.
2. In the top navigation bar, click Management > Single Sign-On Settings.
3. Click Disable.
4. Restart the BigFix Inventory server.
a. Stop the server.
b. Start the server.
You can now log in to the BigFix Inventory web user interface with the credentials that you
used before you enabled single sign-on.

Deleting the single sign-on configuration
You can delete the SSO configuration on the Single Sign-on Settings pane.
Important: Do not delete the single sign-on configuration while it is enabled. You
must first disable the single sign-on configuration before you delete it.
1. Log on to the BigFix Inventory web user interface.
2. In the top navigation bar, click Management > Single Sign-On Settings.
3. Click Delete. A pop-up window appears.
4. Click Delete to confirm.
The server.xml file is backed up to server.xml.timestamp.backup in the
following location. You can restore this file to undo these changes.
•

bfi_installation_dir/wlp/usr/servers/server1

•

bfi_installation_dir\wlp\usr\servers\server1

Modifying port in BigFix Inventory that has single sign-on enabled
Modifying the port number on the Server Settings pane in BigFix Inventory while single signon is enabled invalidates the single sign-on configuration. To properly modify the port, you
must repeat the single sign-on configuration steps.
1. Disable the single sign-on configuration.
2. Provide the new port value on the Server Settings page:
a. In the BigFix Inventory web user interface, click Management > Server Settings.
b. Provide the new port value in the Port field, and click Save.
3. Re-create the single sign-on configuration with the new port value. For more
information, see either Configuring SSO based on SAML token or Configuring SSO
based on LTPA.

Configuring SSO keystore passwords and encryption
Configure unique passwords to the SSO keystores, and encrypt them with the AES
encryption algorithm.
Starting from application update 9.2.9, for all fresh configurations of single signon in BigFix Inventory, SSO keystore passwords use AES as a default encryption method.
The password encryption schema remains unchanged if the single sign-on was enabled
before an upgrade to version 9.2.9.
Both SAML and LTPA SSO types require two separate keystores: Service Provider and
Identity Provider. You can set up either identical or different passwords for these keystores.
To configure new passwords for your SSO keystores, or change encryption method from
XOR to AES, use the appropriate variables and complete the following procedure.
<SP_keystore_name>
Service Provider keystore name is either SPKeyStore for SAML SSO, or
LdapSSLTrustStore for LTPA SSO.
<IP_keystore_name>
Identity Provider keystore name is either SPKeyStore for SAML SSO, or
LdapSSLTrustStore for LTPA SSO.

<alias>
Is either samlsp for SAML SSO, or default for LTPA SSO.
1. Stop the BigFix Inventory server.
2. Optional: If you want to configure a custom SSO keystore password, follow the
instructions below. If you only want to change password encryption method from XOR
to AES, continue with step 3.
a. To change the key password for the Service Provider keystore, run the following
command.
<Installation_directory>/jre/bin/keytool -keypasswd
-keystore <Installation_directory>/wlp/usr/servers/server1/
resources/security/<SP_keystore_name>.<keystore_extension>
-storetype <type> -alias <alias>
<Installation_directory>\jre\bin\keytool -keypasswd
-keystore <Installation_directory>\wlp\usr\servers\server1\resources
\security\<SP_keystore_name>.<keystore_extension> -storetype <type>
-alias <alias>

When prompted, provide the SSO keystore password. For the default keystore
password contact the BigFix Support.

Enter keystore password:
Enter key password for <alias>:
New key password for <alias>:
Re-enter new key password for <alias>:
Password change successful for alias <alias>

b. To change the Service Provider keystore password, run the following command.
<Installation_directory>/jre/jre/bin/keytool -storepasswd
-keystore <Installation_directory>/wlp/usr/servers/server1/

resources/security/<SP_keystore_name>.<keystore_extension>
-storetype <type>
<Installation_directory>\jre\jre\bin\keytool.exe
-storepasswd -keystore <Installation_directory>\wlp\usr\servers
\server1\resources\security\<SP_keystore_name>.<keystore_extension>
-storetype <type>

Set up the new keystore password. The password must match the password
that you set up for the key (step a).

Enter keystore password:
New keystore password:
Re-enter new keystore password:

c. To change the Identity Provider keystore password, run the following command.
<Installation_directory>/jre/jre/bin/keytool -storepasswd
-keystore <Installation_directory>/wlp/usr/servers/server1/
resources/security/<IP_keystore_name>.<keystore_extension>
-storetype <type>
<Installation_directory>\jre\jre\bin\keytool.exe
-storepasswd -keystore <Installation_directory>\wlp\usr\servers
\server1\resources\security\<IP_keystore_name>.<keystore_extension>
-storetype <type>

Set up the new keystore password.

Enter keystore password:
New keystore password:
Re-enter new keystore password:

3. To encrypt your Service Provider keystore password with AES, run the following
command.

a. Set the JAVA_HOME variable
export JAVA_HOME=Installation_directory/jre/jre
set JAVA_HOME=Installation_directory\jre\jre
b. Run the following command.
<Installation_directory>/wlp/bin/securityUtility encode -encoding=aes
<Installation_directory>\wlp\bin\securityUtility.bat encode
--encoding=aes

Provide your current keystore password.

Enter text:
Re-enter text:
{aes}xxxxXXXXxxxxXXXXxxxxXXXXxxxxXXXXxxxxXXXX

4. Update the Service Provider keystore password in the server.xml file. Enter the
value generated in step 3 in the following code line:
<keyStore id='<SP_keystore_name>'
location='<SP_keystore_name>.<keystore_extension>'
password='{aes}xxxxXXXXxxxxXXXXxxxxXXXXxxxxXXXXxxxxXXXX'
type='<type>'/>

For SAML SSO, update the additional line in the server.xml file.
<samlWebSso20 enabled="true" id="defaultSP" keyAlias="samlsp"
keyPassword="{aes}xxxxXXXXxxxxXXXXxxxxXXXXxxxxXXXXxxxxXXXX"
keyStoreRef="SPKeyStore" loginPageURL="https://hostname:9081/"
nameIDFormat="customize">

The server.xml file is located in the following folder.

<Installation_directory>/wlp/usr/servers/server1/
server.xml
<Installation_directory>\wlp\usr\servers
\server1\server.xml
5. To encrypt your Identity Provider keystore password with AES, run the following
command.
<Installation_directory>/wlp/bin/securityUtility encode
--encoding=aes
<Installation_directory>\wlp\bin\securityUtility.bat
encode --encoding=aes
Provide your current keystore password.

Enter text:
Re-enter text:
{aes}xxxxXXXXxxxxXXXXxxxxXXXXxxxxXXXXxxxxXXXX

6. Update the Identity Provider keystore password in the server.xml file. Enter the
value generated in step 5 in the following code line.
<keyStore id='<IP_keystore_name>'
location='<IP_keystore_name>.<keystore_extension>'
password='{aes}xxxxXXXXxxxxXXXXxxxxXXXXxxxxXXXXxxxxXXXX'
type='<type>'/>

The server.xml file is located in the following folder.
•

<Installation_directory>/wlp/usr/servers/server1/
server.xml

•

<Installation_directory>\wlp\usr\servers
\server1\server.xml

7. Start the BigFix Inventory server.

Note: The <type> and <keystore_extension> parameters that apply to the
above commands specifies the following:
<type>

Starting from version 10.0.8.0, the type of the certificate is
PKCS12. For earlier versions, it is JCEKS.
<keystore_extension>
Starting from version 10.0.8.0, the name of the keystore file is
.p12. For earlier versions, it is .jceks.

Configuring passwords and encryption mechanisms
To improve the application security, define a security policy for user passwords. You
can also configure passwords and encryption mechanisms for the keystore in which the
passwords are stored, and the BigFix Inventory database.
BigFix Inventory stores the encrypted passwords in its database in a password-protected
keystore on the local storage (unless Windows Authentication is used for database access).
It is recommended to change the default keystore password, and configure encryption
mechanism for the keystore, and the BigFix Inventory database to ensure additional
protection.
For more information, see:
• The limits to protection through password encryption
• Keytool overview
• securityUtility command manual

Configuring security policy for user passwords
Available from 9.2.7. If your company has a security policy for user passwords, or
you want to improve the application security, you can configure BigFix Inventory to require
that user passwords fulfill the policy requirements.

Starting from application update 9.2.7, user passwords must fulfill the following default
requirements:
• Must be at least 8 characters long
• Must contain at least one lowercase character, one uppercase character, and one digit
If you upgraded from an earlier version and a user password does not fulfill these
requirements, it remains valid until the user changes it. The new password must fulfill the
default requirements. Similarly, if you introduce a password policy, existing passwords that
do not meet the requirements remain valid until the next time they are changed.
1. Go to Management > Advanced Server Settings.
2. Define requirements for user passwords.
• To specify the minimal length of the password, set the
user_password_min_length parameter. For example:
user_password_min_length = 8

• To specify the maximal length of the password, set the
user_password_max_length parameter. For example:
user_password_max_length = 16

• To set a limit on the number of the same characters that can be used in a row,
set the user_password_max_of_identical_characters_in_row parameter. For
example:
user_password_max_of_identical_characters_in_row = 3

• To specify that at least one special character must be used, provide the list of
acceptable characters in the user_password_special_characters parameter. For
example:
user_password_special_characters = ?!%&

• To specify other requirements such as the need to use at least one uppercase
character, create a regular expression that defines the requirement, and provide
it in the user_password_regular_expression parameter. For example:

user_password_regular_expression = ^(?=.*[A-Z]).+$

Tip: To learn more about each parameter, see: Advanced server settings.

Configuring cryptographic keystore password and encryption
Configure a unique password to the cryptographic keystore, and encrypt it with the AES
encryption algorithm.
Starting from application update 9.2.7, for all fresh installations of BigFix
Inventory, keystore and database passwords use AES as a default encryption method. The
password encryption schema remains unchanged for all the application instances upgraded
to version 9.2.7.
To configure SSO keystore passwords and encryption, see: Configuring SSO keystore
passwords and encryption.
1. Stop the BigFix Inventory server.
2. Optional: If you want to change the keystore password into a custom password,
follow the instructions below. If you only want to change password encryption method
from XOR to AES, continue with step 3.
a. To list the contents of the application keystore, run the following command.
Installation_directory/jre/jre/bin/keytool -list
-keystore <inst_dir>/wlp/usr/servers/server1/resources/security/
<keystore_name> -storetype <type>
Installation_directory\jre\jre\bin\keytool.exe -list
-keystore <inst_dir>\wlp\usr\servers\server1\resources\security
\<keystore_name> -storetype <type>

When prompted, provide the keystore password. For the default keystore
password contact the HCL Support.

Enter keystore password:

Keystore type: <type>
Keystore provider: IBMJCE

Your keystore contains 1 entry

default, Nov 15, 2013, keyEntry,
Certificate fingerprint (SHA1):
xx:xx:xx:xx:xx:xx:xx:xx:xx:xx:xx:xx:xx:xx:xx:xx:xx:xx:xx:xx

Note: The list can consist of more than one entry, if Single Sign On is
configured for the product. The underlined element is an alias for the
listed entry, and it is required to complete next steps.
b. Ensure that you change the password for all the listed entries. Run the following
command, and specify the alias at the end of the command line.
Installation_directory/jre/jre/bin/keytool -keypasswd
-keystore <inst_dir>/wlp/usr/servers/server1/resources/security/
<keystore_name> -storetype <type> -alias default
Installation_directory\jre\jre\bin\keytool.exe -keypasswd
-keystore <inst_dir>\wlp\usr\servers\server1\resources\security
\<keystore_name> -storetype <type> -alias default

Set up a single password for all the listed entries. For more than one entry,
ensure the passwords are identical.

Enter keystore password:
Enter key password for <default>:
New key password for <default>:

Re-enter new key password for <default>:
Password change successful for alias <default>

c. To change the keystore password, run the following command.
Installation_directory/jre/jre/bin/keytool -storepasswd
-keystore <inst_dir>/wlp/usr/servers/server1/resources/security/
<keystore_name> -storetype <type>
Installation_directory\jre\jre\bin\keytool.exe -storepasswd
-keystore <inst_dir>\wlp\usr\servers\server1\resources\security
\<keystore_name> -storetype <type>

Set up the new keystore password. The password must match the password
that you set up for the listed entries (step b).

Enter keystore password:
New keystore password:
Re-enter new keystore password:

3. To encrypt your keystore password with AES, run the following command.
a. Set the JAVA_HOME variable.
export JAVA_HOME=Installation_directory/jre/jre
set JAVA_HOME=Installation_directory\jre\jre
b. Run the following command
Installation_directory/wlp/bin/securityUtility encode -encoding=aes
Installation_directory\wlp\bin\securityUtility.bat encode
--encoding=aes

Provide your current keystore password.

Enter text:
Re-enter text:
{aes}xxxxXXXXxxxxXXXXxxxxXXXXxxxxXXXXxxxxXXXX

4. Update the keystore password in the server.xml file. Enter the value generated in
step 3 in the following code line:
<keyStore id='defaultKeyStore' location='<keystore_name>'
password='{aes}xxxxXXXXxxxxXXXXxxxxXXXXxxxxXXXXxxxxXXXX'
type='<type>'/>

The server.xml file is located in the following folder.
•

Installation_directory/wlp/usr/servers/server1/
server.xml

•

Installation_directory\wlp\usr\servers
\server1\server.xml

5. Start the BigFix Inventory server.
Note: The <type> and <keystore_name> parameters that apply to the above
commands specifies the following:
<type>

Starting from version 10.0.8.0, the type of the certificate is
PKCS12. For earlier versions, it is JCEKS.
<keystore_name>

Starting from version 10.0.8.0, the name of the keystore file is
key_server.p12. For earlier versions, it is key_server.jceks.

Configuring database password encryption
Change the configuration of your locally stored database password to improve application
security. Encrypt the password using AES encryption algorithm. This solution does not apply
if you use Windows Authentication for the database access.

1. Stop the BigFix Inventory server.
2. To encrypt your database password with AES, execute the following command.
a. Set the JAVA_HOME variable.
export JAVA_HOME=Installation_directory/jre/jre
set JAVA_HOME=Installation_directory\jre\jre
b. Run the following command.
Installation_directory/wlp/bin/securityUtility encode -encoding=aes
Installation_directory\wlp\bin\securityUtility.bat encode
--encoding=aes

Provide your current database password.

Enter text:
Re-enter text:
{aes}xxxxXXXXxxxxXXXXxxxxXXXXxxxxXXXXxxxxXXXX

3. Update the database password in the server.xml file. Enter the value generated in
the previous step in the following code line:
• DB2 database:
<properties.db2.jcc databaseName='temadb' driverType='4'
enableExtendedIndicators='2'
password='{aes}xxxxXXXXxxxxXXXXxxxxXXXXxxxxXXXXxxxxXXXX'
portNumber='50000' serverName='localhost' user='db2inst1'/>

• MSSQL database
<properties.microsoft.sqlserver databaseName='temadb'
password='{aes}xxxxXXXXxxxxXXXXxxxxXXXXxxxxXXXXxxxxXXXX''
serverName='localhost' user='sa'/>

The server.xml file is located in the following folder.

•

Installation_directory/wlp/usr/servers/server1

•

Installation_directory\wlp\usr\servers\server1

4. Update the database password in the database.yml file, located in the following
folder.
•

Installation_directory/wlp/usr/servers/server1/
config

•

Installation_directory\wlp\usr\servers
\server1\config

Enter the value generated in the step 2 in the following code line.
encrypted_password: "{aes}xxxxXXXXxxxxXXXXxxxxXXXXxxxxXXXXxxxxXXXX"

5. Start the BigFix Inventory server.

Improving security of storing VM manager passwords
Available from 9.2.9. To improve security of storing passwords to VM managers,
you can overwrite the default key that is used to encrypt the passwords or change the
default password to the VM Manager tool keystore. These two procedures are independent.
You can change the encryption key, the keystore password or both, depending on your
needs.
• To overwrite the default key that is used to encrypt passwords to VM managers,
perform the following steps.
1. Go to the VM Manager tool directory.
2. Stop VM Manager tool by using the following command.
◦

./vmman.sh -stop

◦

vmman.bat -stop

3. Back up the config and keydb directories.

◦

/var/opt/BESClient/LMT/VMMAN/config//var/opt/
BESClient/LMT/VMMAN/keydb/

◦

C:\Program Files (x86)\BigFix Enterprise\BES
Client\LMT\VMMAN\config\ C:\Program Files (x86)\BigFix
Enterprise\BES Client\LMT\VMMAN\keydb

If an error occurs during the regeneration of the key, restore these directories to
their current locations.
4. Run the following command.
◦

./vmman.sh -regenerateencryptionkey

◦

vmman.bat -regenerateencryptionkey

5. Start VM Manager tool by using the following command.
◦

./vmman.sh -run

◦

vmman.bat -run

• To change the default password to the VM Manager tool keystore, perform the
following steps.
1. Go to the VM Manager tool directory.
2. Stop VM Manager tool by using the following command.
◦

./vmman.sh -stop

◦

vmman.bat -stop

3. Back up the config and keydb directories.
◦

/var/opt/BESClient/LMT/VMMAN/config//var/opt/
BESClient/LMT/VMMAN/keydb/

◦

C:\Program Files (x86)\BigFix Enterprise\BES Client\LMT
\VMMAN\config\ C:\Program Files (x86)\BigFix Enterprise\BES
Client\LMT\VMMAN\keydb
C:\Program Files (x86)\BigFix Enterprise\BES Client\LMT\VMMAN
\keydb

If an error occurs during changing the keystore password, restore these
directories to their current locations.

4. Create a txt file, for example keystore_password.txt. Provide the new
keystore password in the customPassword parameter.
customPassword=<new_password>

5. To change the password, run the following command.
◦

./vmman.sh -changepassword -file /var/opt/BESClient/
LMT/VMMAN/config/keystore_password.txt

◦

vmman.bat -changepassword -file "C:\Program
Files (x86)\BigFix Enterprise\BES Client\LMT\VMMAN\config
\keystore_password.txt"

Where -file is the path to the txt file in which you specified the new keystore
password.
After you run the command, the password is encrypted
and saved in the vmmmainconf.properties under the
vmm_keystore_password_do_not_change_it parameter.
6. After the new password is set, remove the txt file in which you specified the
password.
7. Start VM Manager tool by using the following command.
◦

./vmman.sh -run

◦

vmman.bat -run

Changing the default secret key and password to the SAP Metric
Data Collector keystore
Available from 9.2.9. To improve security of encrypting the password to the SAP
Metric Data Collector, you can change the default secret key or the default password to
the SAP Metric Data Collector keystore. These two procedures are independent. You can
change the secret key, the keystore password or both depending on your needs.
Contact BigFix Support to obtain the current password to the SAP Metric Data Collector
keystore.

• To substitute the default secret key with a custom one, perform the following steps.
Important: To run each of the following commands, provide the current
password for the SAP Metric Data Collector keystore. You can obtain the
default password from BigFix Support. If you already changed it, use the
custom password that you set up.
1. To remove the default secret key, run the following command.
◦

"/var/opt/BESClient/LMT/SAPTOOL/java/jre/bin/
keytool" -delete -keystore "/var/opt/BESClient/LMT/
SAPTOOL/keydb/<keystore_name>" -storetype <type> -alias
bigfixsaptoolcustomkey

◦

"C:\Program Files (x86)\BigFix Enterprise\BES Client
\LMT\SAPTOOL\java\jre\bin\keytool.exe" -delete -keystore
"C:\Program Files (x86)\BigFix Enterprise\BES Client\LMT
\SAPTOOL\keydb\<keystore_name>" -storetype <type> -alias
bigfixsaptoolcustomkey

2. To create a custom secret key, run the following command.
Important: During the creation of the new secret key, you are asked
to provide its password. Specify the same password as the password
for the SAP Metric Data Collector keystore. If you did not change the
keystore password, provide the one that you obtained from BigFix
Support. Otherwise, provide your custom password for the SAP Metric
Data Collector keystore.
◦

"/var/opt/BESClient/LMT/SAPTOOL/java/jre/bin/
keytool" -genseckey -keystore "/var/opt/BESClient/
LMT/SAPTOOL/keydb/<keystore_name>" -storetype <type>
-keyalg AES -keysize 128 -alias bigfixsaptoolcustomkey

◦

"C:\Program Files (x86)\BigFix Enterprise
\BES Client\LMT\SAPTOOL\java\jre\bin\keytool.exe"

-genseckey -keystore "C:\Program Files (x86)\BigFix
Enterprise\BES Client\LMT\SAPTOOL\keydb
\<keystore_name>" -storetype <type> -keyalg AES
-keysize 128 -alias bigfixsaptoolcustomkey
where:
-keyalg
Is the algorithm used to encrypt the secret key. Only AES is
supported.
-keysize
Is the size of the secret key. The default size is 128 bits. To use a
longer key, set up Java JCE unlimited jurisdiction policy. For more
information, see: IBM SDK Policy files.
• To change the default password to the SAP Metric Data Collector keystore, perform
the following steps.
Important: To run each of the following commands, provide the current
password for the SAP Metric Data Collector keystore that you obtained from
HCL Support.
1. To change the password to the keystore, run the following command.
Password to each key in the keystore must be the same as the password to the
keystore. Thus, the -all parameter is used in the command.
◦

"/var/opt/BESClient/LMT/SAPTOOL/java/jre/
bin/keytool" -storepasswd -all -keystore "/var/
opt/BESClient/LMT/SAPTOOL/keydb/<keystore_name>"
-storetype <type>

◦

"C:\Program Files (x86)\BigFix Enterprise
\BES Client\LMT\SAPTOOL\java\jre\bin\keytool.exe"
-storepasswd -all -keystore "C:\Program Files
(x86)\BigFix Enterprise\BES Client\LMT\SAPTOOL\keydb
\<keystore_name>" -storetype <type>

2. When prompted, provide the new keystore password.
3. To encode the password, run the following command.
◦

"/var/opt/BESClient/LMT/SAPTOOL/saptool.sh"
-encode

◦

"C:\Program Files (x86)\BigFix Enterprise\BES
Client\LMT\SAPTOOL\saptool.bat" -encode

The password is encoded and displayed in the command line.
4. Copy the encoded password to a file, and save it in a text format.
For example:
◦

"/var/opt/BESClient/LMT/SAPTOOL/config/
custom_access_code.txt"

◦

"C:\Program Files (x86)\BigFix Enterprise\BES
Client\LMT\SAPTOOL\config\custom_access_code.txt"
Note: It is recommended to save the custom_access_code.txt in
the config directory. This directory remains unchanged after the SAP
Metric Data Collector update.

5. Open the saptool_config.properties file that is in the following location.
◦

"/var/opt/BESClient/LMT/SAPTOOL/config/"

◦

"C:\Program Files (x86)\BigFix Enterprise\BES
Client\LMT\SAPTOOL\config\"

Provide the path to the file with the encoded password in the
configuration_key_init_path parameter.
For example:
◦

configuration_key_init_path=/var/opt/BESClient/
LMT/SAPTOOL/config/custom_access_code.txt

◦

configuration_key_init_path=C:\\Program Files
(x86)\\BigFix Enterprise\\BES Client\\LMT\\SAPTOOL\
\config\\custom_access_code.txt

Tip: Provide the path in one line and without quotation marks. To use a
backslash, provide it twice (\\).

Note: The <type> and <keystore_name> parameters that apply to the
above commands specifies the following:
<type>
Starting from version 10.0.8.0, the type of the certificate is
PKCS12. For earlier versions, it is JCEKS.
<keystore_name>
Starting from version 10.0.8.0, the name of the keystore
file is keys.p12. For earlier versions, it is keys.jceks.

Related information
Collecting utilization of SAP license metrics
Measuring and collecting utilization of SAP license metrics

Configuring user account lockout
Available from 9.2.8. By default, user account is locked for 5 minutes after the user
attempts to log in to BigFix Inventory more than 10 times within 5 minutes. You can change
the default settings or disable the user account lockout.
The lockout mechanism is enabled by default. To disable it, set the value of the
user_lockout_enabled parameter to false.
1. Go to Management > Advanced Server Settings.
2. Specify conditions under which the user account is locked.

• To specify the maximal number of failed login attempts, set the value of the
user_max_login_retries parameter. For example:
user_max_login_retries = 5

• To specifies the period during which the user can try to log in to the application,
set the value of the user_retry_time_period. For example:
user_retry_time_period = 10

When the maximal number of failed login attempts is exceeded within this
period, the account is locked.
• To specify the period for which a user cannot log in to the application after the
account is locked, set the value of the user_lockout_length. For example:
user_lockout_length = 10

Tip: To learn more about each parameter, see: Advanced server settings.

Configuring VM Manager tool to accept trusted VM
manager certificates
By default, the VM Manager tool accepts all VM manager certificates regardless of whether
they are trusted or not. You can change the default behavior to ensure that only trusted
certificates are accepted by the VM Manager tool.
1. Extract the VM manager certificate to a file.
The following steps are provided as an example and show how to extract a VMware
certificate in Firefox. The steps that you need to perform might differ depending
on the virtualization type and the web browser that you are using. If you encounter
problems with extracting VM manager certificates, refer to the documentation of the
virtualization that you are using.
a. Type the VM manager address in the web browser.
b. Click the lock sign and click More Information.

c. Open the Security tab and click View Certificate.

d. Open the Details tab and click Export.
e. Save the file in the DER format.
2. Log in to the computer where the VM Manager tool is installed and copy the VM
manager certificate to that computer.
3. To define the certificate as trusted, open the command-line interface and run the
following command.

vmman.bat -addcertificate -alias unique_alias
-file vm_manager_certificate

Where:
-alias

Unique alias that will be associated with the VM manager certificate.
-file

Path to the VM manager certificate that you extracted.
Important: Both switches are required.
4. Change the VM Manager tool settings to accept only trusted certificates.
• If you are using basic VM management, log in to BigFix Inventory and go
to Management > Advanced Server Settings. Then, set the value of the
vmmman_trust_all_vm_managers_certificates parameter to false.
• If you are using advanced VM management, open the <BES Client>\LMT
\VMMAN\config\vmmmainconf.properties file on the computer
where the VM Manager tool is installed. Then, change the value of the
vmm_trust_all_vm_managers_certificates parameter to false.
The VM Manager tool accepts only trusted VM manager certificates. If a certificate of a
VM manager that is defined in BigFix Inventory is not trusted, the status of the VM manager
changes to Connection failed.

Relays
Relays lighten both upstream and downstream burdens on the server. Rather than
communicating directly with a server, clients can instead be instructed to communicate with
designated relays, considerably reducing both server load and client and server network
traffic.
Relays work by:

• Relieving downstream traffic.
• Reducing upstream traffic.
• Reducing congestion on low-bandwidth connections.
• Reducing the load on the server.
Relays are an absolute requirement for any network with slow links or more than a few
thousand clients. For more information about Relays, see BigFix documentation.

Troubleshooting and support
Learn about solutions to common problems that might arise when you use BigFix Inventory
and how to find logs and trace files that help you troubleshoot those problems.

Troubleshooting a problem
Troubleshooting is a systematic approach to solving a problem. The goal of troubleshooting
is to determine why something does not work as expected and explain how to resolve the
problem.
The first step in the troubleshooting process is to describe the problem completely. Problem
descriptions help you and the BigFix Support person know where to start to find the cause
of the problem. This step includes asking yourself basic questions:
• What are the symptoms of the problem?
• Where does the problem occur?
• When does the problem occur?
• Under which conditions does the problem occur?
• Can the problem be reproduced?
The answers to these questions typically lead to a good description of the problem, and that
is the best way to start down the path of problem resolution.

What are the symptoms of the problem?
When starting to describe a problem, the most obvious question is "What is the problem?"
This might seem like a straightforward question; however, you can break it down into several
more-focused questions that create a more descriptive picture of the problem. These
questions can include:
• Who, or what, is reporting the problem?
• What are the error codes and messages?

• How does the system fail? For example, is it a loop, hang, crash, performance
degradation, or incorrect result?
• What is the business impact of the problem?

Where does the problem occur?
Determining where the problem originates is not always easy, but it is one of the most
important steps in resolving a problem. Many layers of technology can exist between
the reporting and failing components. Networks, disks, and drivers are only a few of the
components to consider when you are investigating problems.
The following questions help you to focus on where the problem occurs to isolate the
problem layer:
• Is the problem specific to one platform or operating system, or is it common across
multiple platforms or operating systems?
• Is the current environment and configuration supported?
Remember that if one layer reports the problem, the problem does not necessarily
originate in that layer. Part of identifying where a problem originates is understanding
the environment in which it exists. Take some time to completely describe the problem
environment, including the operating system and version, all corresponding software and
versions, and hardware information. Confirm that you are running within an environment
that is a supported configuration; many problems can be traced back to incompatible levels
of software that are not intended to run together or have not been fully tested together.

When does the problem occur?
Develop a detailed timeline of events leading up to a failure, especially for those cases that
are one-time occurrences. You can most easily do this by working backward: Start at the
time an error was reported (as precisely as possible, even down to the millisecond), and
work backward through the available logs and information. Typically, you need to look only
as far as the first suspicious event that you find in a diagnostic log; however, this is not
always easy to do and takes practice. Knowing when to stop looking is especially difficult

when multiple layers of technology are involved, and when each has its own diagnostic
information.
To develop a detailed timeline of events, answer these questions:
• Does the problem happen only at a certain time of day or night?
• How often does the problem happen?
• What sequence of events leads up to the time that the problem is reported?
• Does the problem happen after an environment change, such as upgrading or
installing software or hardware?
Responding to questions like this helps to provide you with a frame of reference in which to
investigate the problem.

Under which conditions does the problem occur?
Knowing which systems and applications are running at the time that a problem occurs is
an important part of troubleshooting. These questions about your environment can help you
to identify the root cause of the problem:
• Does the problem always occur when the same task is being performed?
• Does a certain sequence of events need to occur for the problem to surface?
• Do any other applications fail at the same time?
Answering these types of questions can help you explain the environment in which the
problem occurs and correlate any dependencies. Remember that just because multiple
problems might have occurred around the same time, the problems are not necessarily
related.

Can the problem be reproduced?
From a troubleshooting standpoint, the ideal problem is one that can be reproduced.
Typically, problems that can be reproduced have a larger set of tools or procedures at
your disposal to help you investigate. Consequently, problems that you can reproduce are
often easier to debug and solve. However, problems that you can reproduce can have a
disadvantage: If the problem is of significant business impact, you do not want it to recur. If

possible, re-create the problem in a test or development environment, which typically offers
you more flexibility and control during your investigation.
• Can the problem be re-created on a test system?
• Are multiple users or applications encountering the same type of problem?
• Can the problem be re-created by running a single command, a set of commands, a
particular application, or a stand-alone application?

Duplicate UUIDs problem
BigFix Inventory requires unique virtual machine UUID (Universally Unique Identifier)
numbers to calculate the capacity for all virtual machines and to detect virtualization
hierarchy. If there are computers with duplicated UUIDs, a message is displayed in the To Do
list. The import log also shows a warning about duplicate UUIDs.

Possible root causes
1. The duplication occurs when incorrect or duplicate UUIDs are assigned to some
virtual machines. The problem occurs most frequently on VMWare and is usually
caused by one of the following reasons:
• Virtual machines are deployed from catalog templates in vCloud Director.
By default, such machines are assigned the same BIOS UUID. For more
information, see: BIOS UUIDs in vCloud Director are not unique when virtual
machines are deployed from catalog templates.
• Virtual machines were cloned without changing their UUIDs. For more
information, see: Changing or keeping a UUID for a moved virtual machine.
Duplicates might cause incorrect PVU, RVU, MPAC values because BigFix Inventory
cannot create a valid virtualization hierarchy. In duplication, the devices have mixed
information and it leads to an incorrect representation of cores and calculation of
metrics.
Action: See the documentation for your virtualization type to learn how to assign
unique UUIDs to each virtual machine. For information about VMware, see: Editing a
virtual machine with a duplicate UUID.bios.

After you fix the issue, wait for the next capacity and VM manager scans and BigFix
Inventory data import.
2. Duplicates come from machines where BigFix client is reinstalled or reset (Data
Source Computer ID is different but host names and IP addresses are the same)
but the old computers which are no longer valid have not been removed from BigFix
console. In such case, software discovery is reported for each of such computers.
Action: Remove the computers which are no longer valid from BigFix console. Wait for
the next data import in BigFix Inventory.
After the duplicates are corrected, the related notification is no longer included in the To Do
list.

Interrupting software scan
BigFix Inventory scans run in the background. Fixlets, such as Initiate Software Scan and
Initiate Software Scan on Shared Disks trigger the scan to run in the background.
With version 10.0.6, a fixlet '114 Interrupt BigFix Inventory Software Scans' is provided in the
troubleshooting category to kill the running processes:
• wscansw, wscanfs
• runcit_sw.bat/sh
• start_scan.sh (shared disk scan)
After executing the fixlet, Software Scan Status for Catalog, File, ISO tag and SLM Tag scan
is set to 2:Interrupted. Each execution is tracked in LMT/CIT/end_scanner.log.
Steps to interrupt the scan in progress
To stop all running scans, perform the below recommended steps:
1. Stop any instance of the Initiate Software Scan and Initiate Software Scan on Share
Disks.
2. Target the fixlet '114 Interrupt BigFix Inventory Software Scans' on the machines
which are in scope.

3. Set the desired time range of operation. Use the UTC time and ensure that the time is
in future.
a. The start of action BigFix Client depends on multiple factors, such as evaluation
cycle. So, do not end action too soon.
b. Action is relevant only when processes, wscansw/wscanfs/runcit_sw/
start_scan.sh are found.
4. It is possible to completely remove the relevance and let the action be executed.

Troubleshooting software discovery
Problems with software discovery usually fall into one of three categories. The most
common category is when the software is discovered but the components are assigned to
an incorrect product. In this case, it is enough to reassign the component. The remaining
categories include false-positive discovery, or no discovery due to the lack of the signature
on the computer.

Incorrect software is displayed on reports due to incorrect
bundling
Bundling assistant assigns discovered software components to products based on bundling
rules. The rules assess the probability with which a component is part of a particular
product. Because bundling assistance takes into account all products that are available
in the software catalog, not only products that you purchased, it might happen that the
component is assigned to a product that you do not have. As a result, the product that you
have is not displayed on the reports, and some other product is displayed instead. To solve
the problem, reassign the discovered component to the correct product.
1. Identify what components are used to discover the product that is not shown on the
reports.
For example, check unconfirmed components that are installed on the computer
where the product should be discovered. Such components are likely to be used to
discover the product.

a. Log in to BigFix Inventory, and go to Reports > Software Classification.
b. Hover over Configure, and click Configure View. Then, filter the report to narrow
down the list of instances to the unconfirmed components that are installed on
a particular computer. Set up the following filters.
• Confirm equal to No
• Computer Name contains Computer Name
2. If any of the components was assigned to an incorrect product, reassign it to the
correct one.
For example, if the component IBM WebSphere Application Server was assigned to
the product IBM Rational Software Architect, but the product that you have is IBM
WebSphere Application Server Network Deployment, reassign the component to IBM
WebSphere Application Server Network Deployment.
a. Hover over the Assign icon

, and click Choose from Catalog.

b. Select the product to which you want to reassign this component instance, and
click Assign. For more information, see: Assigning components to products.
After you reassign the component, the correct product is displayed on the reports.

Software that you do not have is discovered due to false-positive
discovery
It might happen that an older version of the software is discovered after the upgrade or
the software signature is not removed from the computer during the uninstallation. Falsepositive discovery can also be caused by backups of software directories or installation
media that are stored on the endpoints and are reported as separate software instances.
1. Update the software catalog to the latest version.
2. Check what signature caused software detection.

a. In the top navigation bar, go to Reports > Software Installations.
b. Find the software that was discovered, and click the link in the Details column.
Information about the signature or software ID tag that caused the detection
and its location is displayed at the bottom of the page.

Check whether the signature or software ID tag that caused the detection was discovered
in a backup directory or a directory that contains installation media. If yes, compress the
directory, delete it, or exclude from software scans.
Otherwise, open a PMR and file it against the product that was discovered and provide the
following information:
• Exact name of the product that was installed, including its release
• Signature or software ID tag that caused the discovery

Software that you have is not discovered
It might happen that software that is installed is not discovered because the signature or
the software ID tag does not exist on the computer where the software is installed.
1. Update the software catalog to the latest version.
2. Check what signature or software ID tag is used to discover the software.
a. On the Software Catalog widget, click Software Components.

b. To filter out the report, hover over Configure, and click Configure View. Then,
specify appropriate filters. For example, Name, contains, DB2

c. To view signatures that are used to discover this component, click the link in the
Name column.

3. Check whether any of the signatures or the software ID tag exists on the computer
where the software was not discovered.
• If the number of signatures is 0, the software is discovered by a software ID tag.
Check whether .swidtag file is in the installation directory of the software that
was not discovered.
• If the number of signatures is greater than 0, check whether any of discovery
signatures exists on the computer.

If none of the signatures nor the software ID tag exists on the computer, open a PMR and
file it against the product that was not discovered. If a signature or the software ID tag

exists on the computer but the software is not discovered, open a PMR and file it against
BigFix Inventory. In both cases provide the following information:
• Exact name of the product that was not discovered, including its release
• Part number of the product that was not discovered
• Platform on which the product was not discovered

Troubleshooting problems with computers
When you encounter problems with scan results not being uploaded from a particular
computer or you need to collect all logs from that computer, use the Computer Support
Data panel. The panel is available in BigFix Inventory and is used to perform some
troubleshooting actions without the need of using the BigFix console.

Checking whether the maximum archive size is exceeded
You can check whether the maximum archive size is exceeded through the Computer
Support Data panel.
You must be an Administrator or have the Manage Support Data and View Endpoints
permissions to perform this task.
1. Log in to BigFix Inventory, and go to Reports > Computers.
2. Select the name of the affected computer and then click Computer Support Data.

3. Check the information in the Computer refresh section to verify whether the
maximum archive size is exceeded.
If it is, follow the documentation to resolve the problem. For more information, see:
Configuring VM manager for subcapacity reporting.

Refreshing scan data on a computer
If software scan, capacity scan, or VM Manager tool scan finishes successfully on a
particular computer but its results are not uploaded to the BigFix server, force the upload
of the data. You can do it directly from BigFix Inventory without the need of accessing the
BigFix console and running a separate fixlet for each type of scan.
You must be an Administrator or have the Manage Support Data and View Endpoints
permissions to perform this task.
1. Log in to BigFix Inventory, and go to Reports > Computers
2. Select the name of the computer from which you want to force the upload of scan
results, and then click Computer Support Data.

3. Click Request Data Refresh.
Refresh of data forces upload of scan results from the BigFix client to the BigFix
server.

4. When the data is refreshed, run an import to make the data available in BigFix
Inventory.

Collecting logs for troubleshooting purposes
If you are asked by BigFix Support to provide data for troubleshooting problems with
computers in your infrastructure, go to the details of the computer. Open the Computer
Support Data panel, download the log package, and provide it to BigFix Support. The
package contains log files that are needed for troubleshooting purposes such as BigFix
client logs, scanner logs, scan configuration logs, VM manager configuration files, and files
generated during scans.
You must be an Administrator or have the Manage Support Data and View Endpoints
permissions to perform this task.
If you want to collect the logs, follow the steps that are described below. The steps might be
different for particular version. Choose the path suitable for your version.
•

For version 9.2.11 and higher, perform the following steps.
1. Log in to BigFix Inventory, and go to Reports > Computers.
2. Select the name of the computer from which you want to collect the logs, and
then click Computer Support Data.

3. Download the logs.
◦ If you are requested to provide only basic support data, click Download.
◦ If you are requested to provide basic and supplementary data, click
Refresh Supplementary Data. Then, refresh the page to see when the data
is collected. When the supplementary data is available, click Download.

4. Optional: By default, the size of downloaded packages is limited to 20 MB.
If you are not able to download the log package, change the value of the
_BESRelay_UploadManager_CompressedFileMaxSize parameter. It is a onetime setup. To change the value, perform the following steps.
a. Log in to the BigFix console.
b. In the left navigation tree, click Computers.
c. Right-click the following computer, and click Edit Computer Settings.
◦ BigFix relay with which the computer that cannot send the logs is
communicating.
◦ If there is no relay, computer on which the BigFix server is installed.
d. Set the value of the _BESRelay_UploadManager_CompressedFileMaxSize
parameter to 100000000 (100 MB). If the parameter is not listed, click Add
to add it.
_BESRelay_UploadManager_CompressedFileMaxSize=100000000

5. Provide the log package to BigFix Support.
•

For versions 9.2.8 to 9.2.10, perform the following steps.
1. Run a fixlet that creates a log package on the selected computer. The fixlet is
available starting from site version 99.
a. Log in to the BigFix console.
b. In the navigation tree, click Sites > External Sites > BigFix Inventory v10 >
Fixlets and Tasks.
c. Select Collect Logs from Endpoints, and click Take Action.
d. Choose the computer for which you need to provide the troubleshooting
data, and click OK.
2. Download the log package.
a. Log in to BigFix Inventory.
b. In the navigation bar, click Reports > Computers.
c. Click the name of the computer on which the fixlet was run.

d. When the detailed report for that computer opens, add /mustgather
to the report URL in the web browser to download the package to your
computer. For example:
https://<host>:<port>/sam/computers/1/mustgather

3. Provide the log package to BigFix Support.

Disaster recovery
To perform disaster recovery for your BigFix environment, you need to regularly back up the
BigFix Inventory database and the BigFix platform server.

Regular back up
Ensure you regularly back up:
• BigFix server.
• BigFix Inventory database.
Note: The BigFix Inventory data is stored in the database. Thus, you do not have to
additionally back up the BigFix Inventory server.

Disaster recovery
To perform the disaster recovery of your BigFix Inventory environment:
• Restore the BigFix server. For more information, see: Running server backup and
restore
• Restore your BigFix Inventory database. For more information, see: Backing up and
restoring the database

Common problems
Learn how to solve some common problems with the server installation, configuration and
administration.

The following list contains descriptions of common installation problems:

Agent problems
The Deployment Health widget provides the status of computers that do not meet one or
more of the deployment health conditions. To resolve deployment health issues, perform
the steps relevant for your particular problem. The BigFix console provides fixlets that can
be run to resolve some deployment health issues. Issues that cannot be resolved by using
fixlets must be resolved manually.
Disconnected: The computer has not connected to the server for the last 72 hours
These computers did not connect to the server for the last three days. You
must check whether each computer listed in the report is up and running or
why it is not connected to your network.
Important: When you decommission a computer in your environment,
the software installed on this computer is still listed on the metric
reports. Remove the computer from BigFix database, to reflect the
status change in the reports. For more information, see: Removing
inactive computers.
Low disk space: The drive on which the agent is installed has less than 100 MB of free
disk space
Computers with low disk space have less than 100 MB of free space available.
To identify the affected computers:
1. Log in to the BigFix console.
2. Click Sites > External sites > BES Support > Fixlets and Tasks.
3. In the upper right pane, click BES Client Computer is Low on Free Disk
Space. The list of computers is displayed.
4. Free up disk space on each affected computer.

Out of sync: The time that is set on the computer differs by at least an hour from the
time that is set on the server
Out of sync computers have incorrect system clock times. To update the
clocks on affected computers:
1. Log in to the BigFix console.
2. Click Sites > External sites > BES Support > Fixlets and Tasks.
3. In the upper right pane, select BES Clients Have Incorrect Clock Time
and click Take Action.
4. In the lower right pane of the window that opens, select the computers
whose clocks you want to synchronize and click OK.
Missing prerequisites: Scanner prerequisites are not installed on the computer
Linux™ computers with missing prerequisites do not have the correct C++
runtime library versions installed.
1. Log in to the BigFix console.
2. Click Sites > External sites > BigFix Inventory v10 > Analyses.
3. In the upper right pane, select the Scanner Information analysis and
then click Results to see which computers are missing the correct C++
runtime library.
4. Install the C++ runtime libraries manually on each computer that is
returned by this analysis. The required version of the /usr/lib/
libstdc++.* or /usr/lib64/libstdc++.* library is 6.
If the scanner is still experiencing problems, ensure the endpoints have the
correct version of the bzip2 archiver installed.
1. Log in to the BigFix console.
2. Click Sites > External sites > BigFix Inventory v10 > Analyses.
3. In the upper right pane, select the Software Scan Status analysis and
then click Results to see which computers return the Invalid archived
status.

4. Copy the correct version of the bzip2 archive manually to each computer
that is returned by this analysis, to the /LMT/CIT/custom folder. Name
the file:
•

bzip2

•

bzip2.exe

The correct version of the bzip2 archive for your operating system can
be obtained from your operating system vendor. It can also be compiled
on the endpoint with resources from bzip.

Catalog problems
Catalog problems are related to the inability to download a new catalog or upload it to
BigFix Inventory.
The software catalog cannot be downloaded because the Software Catalog Update
task is not applicable.
Note: The Software Catalog Update task is not relevant for BigFix
Inventory versions before 9.2.11.
When you install BigFix Inventory, the target computer sends information
about the new software to the BigFix server. Then, the BigFix server verifies
that the computer is linked to this server. If it is, the server marks it with the
custom setting SUA_Server_Path_[user_ID]. If the setting is set to the BigFix
Inventory installation path, the task is applicable.
If the setting is not specified for a particular computer, the Software Catalog
Update task might not be applicable. If you are sure that BigFix Inventory is
installed on this computer, specify the setting manually.
1. Log in to the BigFix console that is linked to your BigFix server.
2. In the navigation bar, click Computers.
3. In the right-upper pane, right-click the computer on which you installed
BigFix Inventory, and click Edit Computer Settings.

4. To add a setting, click Add.
5. In the Setting Name, type SUA_Server_Path_[user_ID].
Note: [user_ID] is the ID of a Linux™ user who installed BigFix
Inventory.
6. In the Setting Value, specify the BigFix Inventory installation path.
7. Click OK.
If the SUA_Server_Path_[user_ID] setting is set properly and the problem
persists, ensure that the following conditions are fulfilled:
• The BigFix Inventory server is installed on a computer with a single
static IP.
• The computer on which the BigFix Inventory server is installed can
decompress the downloaded catalog file.
• A manually downloaded catalog is not in the /opt/BFI/bfi_catalog
directory.
• The BigFix server can connect to the BigFix Inventory server by using
port 9081.
• The BigFix Inventory server can connect to the BigFix server by using
port 52311.
• The BigFix Inventory server has an entry for the BigFix server in the etc/
hosts file.
• The BigFix server has an entry for the BigFix Inventory server in the etc/
hosts file.
• The user that you provided when you configured the connection
to the BigFix server has the right permissions to run the fixlet. For
more information, see the topic Operators permissions in the BigFix
documentation.
The Catalog Download task fails because the BigFix server cannot connect to the
BigFix Inventory server.

The problem occurs when the BigFix and BigFix Inventory servers are installed
in separate networks and the automatic lookup of their IP addresses does
not work correctly. To ensure that IP addresses of the servers are correct and
the communication between them works, change the default settings, and
manually enter the IP addresses or domain names of the servers. For more
information, see: Configuring servers in separate networks.
When you upload a software catalog file, the following error is displayed: Upload
failed. The uploaded file does not appear to be a valid catalog. On

inspection, file appears truncated.
If there is a delay when initially downloading the catalog file from the server,
then the downloaded file might be truncated. For example, if more than 30
seconds is taken to rename and save the file. This problem depends on how
your browser handles the downloading of large files. To solve this problem,
accept and save the file within a short time period or use a different browser.
Backups of software directories are reported as separate products.
If you store backups of software directories on your endpoints, they might
be reported as separate software instances resulting in false discoveries
and incorrect license consumption. To avoid this problem, either exclude the
backups from scanning or compress them with a data compressor, such as
zip or rar.
A duplicated software component is created during a second import of catalog
customizations.
If you import a custom catalog definition that contains unique IDs to another
BigFix Inventory instance, then modify a publisher or vendor in the signature
xml file and import it again, the second import will create a new software
component in the hierarchy. The signature definition will be removed from the
original hierarchy.
This behavior is caused by using the same signature uniqueId. When the
custom catalog definition XML file reuses a signature uniqueId that exists in
the database, the signature is updated to reflect the new software component.

To correct the data in the catalog, delete the first catalog entry and ensure that
the new entry contains the needed data or reimport the new catalog with a
different unique signature ID.
The number of discovered software instances is higher than the number of instances
that are installed.
The problem might occur when the product is discovered both by a custom
signature and a signature from the catalog provided by BigFix. It happens
when you create a custom signature and later on a signature for the same
product is delivered with the software catalog provided by BigFix. Because the
catalogs are fully independent, the two signatures are not merged.
To verify whether it is the case, perform the following steps:
1. In the top navigation bar, click Reports > Software Installations.
2. Hover over the Manage Report View icon

, and click Manage Report

View. Then, select the Component Definition Source check box.
3. Filter the report to the product for which the number of discovered
instances was too high.
4. Check whether the catalog that is listed in the Component Definition
Source column is Custom for some instances and some other type
for other instances of a particular product. If yes, delete the custom
signature for this product.
The number of discovered instances should be normalized after the next
software scan and import of data.
Part numbers are not matched with products after you upload the part number file.
The problem might be related to the outdated application data.
• Ensure that import of data was completed after the upload of the part
number file. Log in to BigFix Inventory, and go to Reports > Part Number
Upload. Look at the Upload and Import History and check the status
of the latest action. After import completes, it should be marked as
successful.

• Check if you have the latest version of the software catalog. If not,
update the software catalog to the latest version.
• Make sure that the list of discovered software is up-to-date by checking
the date of the last scan in the Software Scan Status analysis in the
BigFix console. To update the inventory data, run the Initiate Software
Scan fixlet. Set up a single scan by clearing the Reapply this action
check box on Execution tab.
After applying any changes, upload the part number file again and run the
import of data.
The version of the software catalog is displayed in different formats in BigFix
Inventory and in the BigFix console.
The catalog upload process is automatized and the task that triggers the
catalog upload is changes. Because of these changes, the software catalog
can be displayed in a date format or as a fixpack version. To ensure the
version consistency, upgrade the BigFix Inventory server to the latest version.
The <not set> value appears under the Product Name on Software Classification
panel
The product name is not set if the component does not have any product
relation that is defined in the software catalog. The component is detected on
its own.
To resolve this issue, make sure that you have the latest version of BigFix
software catalog.
• To check your current version of software catalog, see: Verifying the
current version of and the software catalog.
• To update the software catalog, see: Manually updating software
catalog..
Note: If upgrading the software catalog does not help, contact the
relevant product team and ask them to register the product. You

can use custom bundling to create a new relation as a temporary
workaround. For more information, see: Assigning components to
products.

Missing content from the new IBM software catalog
Since catalog version 10.0.2, Software Catalog Update fixlet updates only non-IBM part of
the catalog. The same applies to the manual catalog upload. To get the latest supported
IBM catalog part you must upgrade BigFix Inventory. It is in line with IBM ILMT 9.2.20,
https://www.ibm.com/support/pages/node/6223460.
However, the definition of the software catalog does not change for other vendors, and the
manual updates continue to be supported.

Manually updating software catalog
The software catalog is automatically updated during every upgrade of BigFix
Inventory. However, as an exception, you can manually update the software catalog for
troubleshooting purposes.
Warning: Since catalog version 10.0.2, Software Catalog Update fixlet updates only
non-IBM part of the catalog. The same applies to the manual catalog upload. To get
the latest supported IBM catalog part you must upgrade BigFix Inventory. It is in line
with IBM ILMT 9.2.20, https://www.ibm.com/support/pages/node/6223460.
However, the definition of the software catalog does not change for other vendors,
and the manual updates continue to be supported.

•

Starting from application update 9.2.11, the Software Catalog Update task
automatically triggers the following actions:
◦ The catalog is downloaded to the following directory:
▪

/opt/BFI/wlp/usr/servers/server1/data/sam/
catalog/BFI

▪

C:\Program Files\BFI Enterprise\BFI\wlp\usr
\servers\server1\data\sam\catalog\BFI

◦ The catalog is automatically uploaded to the BigFix Inventory server during the
next import of data. No additional actions are required.
• For versions before 9.2.11, the software catalog is downloaded with the Software
Catalog Update task but it still needs to be manually uploaded to the BigFix Inventory
server according to this procedure.

You must have the Manage Uploads permission

to perform this task.
• If the computer where the BigFix server is installed does not have the Internet access,
ensure that the content of the BigFix Inventory site is up-to-date before you download
the catalog. For more information, see: Updating the fixlet site.
The software catalog is called BFI_Catalog_version-timestamp.zip and consists of
the following files:
• Software catalog in canonical 2.0 format:
IBMSoftwareCatalog_canonical_2.0_form_date.xml.
•

Software catalog in canonical 3.0 format:
IBMExtendedCatalog_canonical_3.0_form_date.xml. The file consists of
low priority applications; for example, open source software, freeware, and games.
The content of the file will be expanded to include high priority business applications
with time. The file is included in each software catalog, however, it is ignored by BigFix
Inventory versions lower than 9.2.5.

• Charge unit data file that contains information about charge unit
definitions, their relations with products, and some additional parameters:
charge_unit_parameters_dataversion_version.csv.
• Part numbers file that contains information about part numbers that are used for
software licensing purposes: part_numbers_dataversion_version.csv.

• Catalog metadata file that describes the software catalog:
catalog_package.properties.
•

FlexPoint bundles file that contains information about products
that can be assigned to each of the available FlexPoint Offerings:
flexpoint_bundles_dataversion_version.csv

•

For versions 9.2.11 and higher
1. Log in to the BigFix console.
2. In the navigation bar, click Sites > External Sites > BigFix Inventory v10 > Fixlets
and Tasks.
3. In the upper-right pane, select Software Catalog Update, and then click Take
Action. The action is applicable only on the computer on which the BigFix
Inventory server is installed. Select the computer, and click OK.
If the task is not applicable on that computer, see: Catalog problems.
4. Wait for the scheduled import of data or run it manually.

• For versions before 9.2.11
1. Download the software catalog
a. Log in to the BigFix console.
b. In the navigation bar, click Sites > External Sites > BigFix Inventory v10 >
Fixlets and Tasks.
c. In the upper-right pane, select Software Catalog Update, and choose the
option to download the software catalog for BigFix Inventory version
before 9.2.11.0.
d. Optional: Copy the file to the computer from which you access the BigFix
Inventory web user interface.
2. Upload the software catalog to BigFix Inventory.
a. Log in to BigFix Inventory.
b. In the navigation bar, click Management > Catalog Upload.
c. Click Browse and select the software catalog file.

d. To upload the file, click Upload. The software catalog file and the charge
unit data are listed in the Upload and Import History table. Their status is
Pending.
e. Wait for the scheduled import of data or run it manually.
During the import, scanner catalogs that are used for software discovery are created and
automatically distributed to the computers in your infrastructure.
If the automatic distribution of scanner catalogs fails, computers on which the catalog was
not updated have the Outdated Catalog status on the Software Scan Health widget. You
must manually update scanner catalogs on these computers. If you use the disconnected
scanner, distribute the downloaded software catalog to each computer.

Data import problems
Data import problems are related to situations in which the data import fails or the data that
is displayed in reports is inconsistent as a result of a failed import.

Data import errors
This topic lists the errors that might appear when you perform data imports. You can also
find solution to those error in this topic.

Error messages
During the initial import, the following error is written in the logs: Error was
getaddrinfo: name or service not known (SocketError).

During the initial import, the following error is written in the logs:
ERROR: Datasource file citsearch_0_4580013_cit.xml.bz2 raised an
exception
while reading from {:port=>"52311", :path=>"/UploadReplication",
:query=>{:BaseDirectory=>1,
:Name=>"\\13\\4580013\\citsearch_0_4580013_cit.xml.bz2",
:sha1=>"5B0FE15F7E097171566F0AC3B9BE93826FDC0D41", :offset=>0}}.
Error was getaddrinfo: name or service not known (SocketError)

The problem might be caused by incorrect DNS name settings. To solve the
problem, ensure that BigFix Inventory can ping the BigFix server by using the
DNS name that is specified in the fixlet site. To find the DNS name, on the
computer where the BigFix server is installed, go to the C:\Program Files
(x86)\BigFix Enterprise\BES Installers\Server, and find the
ActionSite.afxm file. If BigFix Inventory cannot ping the BigFix server
by using this DNS name, add the name to the etc\hosts file on the BigFix
Inventory server.
The import fails. After you rerun the import, the software inventory is empty.
One of the scenarios in which the problem occurs is when you run an import
and the BigFix server is not running. After you restart the server and rerun
the import, the software inventory is empty. To solve the problem, manually
initiate the scanner. Gather fresh scan data, and run the import.
As an alternative, you can run the Force Reupload of Software Scan Results
task and then run the import of data. This task forces reupload of inventory
data that was gathered by the software inventory and the file system scans to
the BigFix server. The data is then imported to BigFix Inventory.
The import fails because the transaction log is full.
After a failed import, the import log contains the following error:
Batch failure. The batch was submitted, but at least one excepti
on
occurred on an individual member of the batch. Use getNextExcept
ion()
to retrieve the exceptions for specific batched elements.
ERRORCODE=-4229,

Also, the following error can be found in the tema.log file:
Batch execution error: Error for batch element #903:
The transaction log for the database is full.

To solve the problem, complete the following steps:

1. Increase the size of the transaction log for the database.
2. Restart the DB2® and BigFix Inventory servers.
The import fails because the Java™ heap size is too low.
After a failed import, the import log contains the following error:
E SRVE0777E: Exception thrown by application class
'java.lang.StringBuilder.ensureCapacityImpl:342'
java.lang.OutOfMemoryError: Java heap space

To solve the problem, increase the Java heap size.
The import fails and the following message is written in the logs: Overflow occurred
during numeric data type conversion.

The problem occurs when you create a contract custom field that requires an
integer value, and then enter a value that is greater than 32767. To solve the
problem, enter a smaller value.
The import fails and the following message is written in the logs: The SQL
statement or command failed because of a database system error. (Reason
"optBitFilterSize less than min".). SQLCODE=-901, SQLSTATE=58004,
DRIVER=4.14.111.

To solve the problem, create a script that reorganizes internal database
tables and keeps statistics up-to-date, and run it against the BigFix Inventory
database.
1. Create the reorg.sh script.
$ cat reorg.sh
#!/bin/bash
db2 connect to TEMADB
db2 -x "select 'reorg
table',substr(rtrim(tabschema)||'.'||rtrim(tabname),1,50),
'allow no access;'from syscat.tables where type = 'T' and t
abschema not in

('NULLID','SYSCAT','SYSFUN','SYSIBM','SYSPROC','SYSSTAT') o
rder by tabschema,tabname
" > reorgs.sql
db2 -tvf reorgs.sql
db2 terminate

db2 connect to TEMADB
db2 -x "select 'runstats on table',substr(rtrim(tabschema)|
|'.'||rtrim(tabname),1,50),
' and indexes all;'from syscat.tables where type = 'T' and
tabschema not in
('NULLID','SYSCAT','SYSFUN','SYSIBM','SYSPROC','SYSSTAT') o
rder by tabschema,tabname
" > runstats.sql
db2 -tvf runstats.sql
db2 terminate

2. Log in as a database instance owner to the computer where the DB2® is
installed and run the script.
The import fails and the following message is written in the logs: INFO: ETL from
Data Source data_source_name - RawDatasourceFixletResult: Failed

The problem occurs because there is not enough disk space on the computer
where the BigFix Inventory database is installed. To solve the problem, free
some disk space.
The import fails and the following message is written in the logs: Snapshot
isolation transaction failed accessing database 'TEMADB' because snapshot
isolation is not allowed in this database. Use ALTER DATABASE to allow
snapshot isolation.

To solve the problem, enable snapshot isolation in the MS SQL Server. For
more information, see the Microsoft™ SQL Server documentation.

After adding a large data source, the import fails and the following message is written
in the logs: 500 Internal Server Error.
The problem might occur because there is not enough disk space on the
computer where the BigFix database is installed. To calculate the amount of
required disk space, perform the following steps:
1. Optimize the import of data from BigFix. Log in to BigFix Inventory and
go to Management > Advanced Server Settings. Then, change the value
of the schema_next parameter to true.
2. To calculate the required disk space, check how many objects exist in
all fixlet sites that you have enabled in the BigFix console. An object is
every computer group, analysis, fixlet, and task that exist in the console,
including the ones that are not relevant. Every 1000 of objects requires
1GB of free disk space. For example, if you have 500 fixlets and tasks,
300 analyses, and 20 computer groups, you have 820 objects in total.
The BigFix database requires 1 GB of disk space.
The import fails and the following message is written in the logs: INFO: ETL from
Datasource - RawDatasourceAnalysis (0x000000 - 0x00000035): Failed.

During the import, the following error is written in the logs:
INFO: ETL from Datasource - RawDatasourceAnalysis (0x000000 - 0x
00000035): Failed
ERROR: Sequel::SerializationFailure: Java::ComMicrosoftSqlserver
Jdbc::SQLServerException:
Transaction (Process ID 1111) was deadlocked on lock resources w
ith another process
and has been chosen as the deadlock victim. Rerun the transactio
n

To solve the problem, ensure that no actions such as a backup or recovery are
taking place on the BigFix database. Then, rerun the import.
The import fails after you change the host name of the BigFix Inventory server.

Changing the host name of the BigFix Inventory server is not supported. When
the application cannot recognize the original host name, the ETL step of a
data import is failing and you cannot gather and process data from your
endpoints. A new host name requires a new installation of BigFix Inventory.
The host name also cannot be changed for the BigFix server. In this case,
the host name of the server is recorded into your license certificate during
the installation. To change it, you must create a new license certificate that
requires a new installation.
The import hangs after the database connection is lost and recovered
During the import of data, database connection is lost and information about
connection problems is displayed on the user interface. After you restart the
database, the user interface is refreshed but the import hangs. Additionally,
the following or similar error is written in the logs.
ERROR: Sequel::DatabaseError: DBNAME: temadb25 - Java::ComIbmDb2
JccAm::SqlNonTransientConnectionException:
[jcc][t4][10335][10366][4.22.29] Invalid operation: Connection i
s closed. ERRORCODE=-4470, SQLSTATE=08003

To solve the problem, restart the BigFix Inventory server.
A successful software scan is run but there are no changes to the data after the data
import to the BigFix Inventory server.
Check the maximum archive file size to ensure that it is greater than the scan
file size.
1. Log on to the BigFix console.
2. In the left navigation, click Computers, right-click the name of the
appropriate computer, and then click Edit Computer Settings.
3. Check the _BESClient_ArchiveManager_MaxArchiveSize setting is
greater than the size of the largest scan file. If needed, edit the value to
increase the maximum archive size.

Verify that there are no software scan errors.
1. In the BigFix console navigation, click Sites > External Sites > BigFix
Inventory v10 > Analyses.
2. Select the Software Scan Status analysis.
3. In the lower pane, click the Results tab, and verify that the status of the
software scan is OK for the computers.
The import is delayed when there more than 20 computer groups and all computers
have metrics calculation enabled.
Some of the products are not discovered.
If you optimized the volume of scanned file data, either during the postupgrade configuration or manually, you must run an import for the changes
to take effect. After the import, some software items might not be visible on
the reports. It is an expected behavior. To ensure that the software inventory is
properly reported, perform the following steps.
1. Ensure that the catalog that is uploaded to BigFix Inventory is in the
canonical format. If the catalog is in the native format, upload a new
catalog. If the catalog is in canonical format but a new version is
available, upload the new catalog. To check the format of the uploaded
catalog, click Management > Catalog Upload and check the Catalog
Format column.
2. Stop the current scan.
a. Log in to the BigFix console and in the left navigation tree, click
Actions.
b. In the upper-right pane, click Initiate Software Scan and then click
Stop.
3. Initiate a new software scan. Wait for the scan to finish.
4. Wait for the scheduled import or run it manually.
Files with a particular extension are not reported on the Scanned File Data report.

The problem might occur if you optimized the volume of scanned file data
and removed the extension from the list of monitored extensions. To solve the
problem, contact HCL support in order to add the file extension that you want
to monitor.
After a failed import of scan data, the data that is displayed in reports is inconsistent
If there are inconsistencies in the data, and the last data import failed, the data
inconsistencies might be the result of the import failure. To solve the problem,
run the import again.
As an alternative, you can run the Force Reupload of Software Scan Results
task and then run the import of data. This task forces reupload of inventory
data that was gathered by the software inventory and the file system scans to
the BigFix server. The data is then imported to BigFix Inventory.
The data import log cannot be viewed in the user interface.
The problem might occur if you enabled debug logging for the import process.
Debug information significantly increases the size of the import log file and
it might happen that the log file cannot be displayed in the user interface. To
solve the problem, consider the following solutions:
• Instead of viewing the log file in the user interface, open it as a file. The
log file is in one of the following directories:
◦

installation_directory/wlp/usr/servers/
server1/logs/imports

◦

installation_directory\wlp\usr\servers
\server1\logs\imports

To avoid problems in the user interface, move the log file to a different
location so that BigFix Inventory does not load it into the user interface.
• Server log file to limit the amount of information saved in the log file.
Software is properly discovered by the scan but is not reported in BigFix Inventory
after the import.

The problem occurs on BigFix 9.0 installed on Linux™. If the value of the
sequence changed in the BigFix database and is higher than the sequence
that was imported, scan results are not imported during a particular import. To
solve the problem, wait for the next scheduled import or run it manually.
Data about a computer was not imported from the BigFix server.
Because BigFix Inventory imports live data that is constantly changing on the
BigFix server, it might happen that some data, for example about computers,
might not be imported. That happens because only the scope of data that is
calculated at the beginning of an import is processed during the import.
Example: If a computer is saved in the BigFix database during a data import
from BigFix to BigFix Inventory, it will not be imported.
Important: It might also happen that after the second data import,
the imported computers do not have important properties such
as Computer Name, IP Address, or Operating System. To fix this
problem:
1. In the navigation tree of the BigFix console, click Computers
and then in the list pane, select the computer for which the
properties are missing.
2. In the lower right pane, click Send refresh 3 times. All missing
computers properties will be imported during the next data
import.

BigFix Inventory takes longer to import data due to the File Facts ETL step involved
The default list of excluded Windows endpoints is extended to improve the
data import and overall file scan. For a newly installed scanner, the list of
exclusions has been extended with directories containing large files that are
not related to the software discovery. The list of excluded directories are

listed in the KB article. To add your preferred entry of exclusion for upgraded
scanners, follow the instruction provided in the KB article.

Data import warnings
This topic lists the warning messages that might appear when you perform data imports.
The warnings appear when running the file fact handler.

Warning messages
File Facts Result exceeding limit of files
Step: ETL SAM::FileFact
Versions: 10.0.4 or higher
Message in data import log:
Import: FileFactHandler:42780) FileFactHandler::endDocument::Fil
e
44575::0::AE5142947EA6176C027C33DCA8EEBF7A02F76E60::\20\10865511
20\
itsitsearch_0_1086551120.xml.bz2
on computer 44575 has 12224 lines which is above the limit of 10
000 lines.
All entries will be imported.

Meaning: Warning message that appears about exceeding 10000 entries for
File Scan result on a given computer. Review the Scanned File Data on the
computer using provided computer ID in the log. Consider excluding some
directories from scan.
File Facts Result exceed limit of size (Default: 4 MB)
Step: ETL SAM::FileFact
Versions: 10.0.4 or higher
Message in Data Import Log:

WARN:

(ImportFileFactAction) Skipping file itsitsearch_0_108102

6664.xml.bz2 on computer 22137 of size
6611177 B because it is over limit of 4194304 B. Nothing to impo
rt.

Meaning: Warning message about exceeding the limit of Scan Result
maximum size (scanFileSizeLimit Advanced Server Setting). Such scan result
is not processed and thus no changes are made to existing data. Get the File
Scan result file using Computer Support Data and review the File Scan result
at itsitsearch_0_<comptuer_id>.xml.bz2 against possible exclusions
from scan.
Issue with SLM Tag Scan Result
Step: SlmTagImport
Versions: 10.x
Message in Data Import Log:
WARN:(ImportSlmTags-Thread:2) SlmTagsScanFileHandler::handle::Wr
ong file for computer id = 33948 provided.

Meaning: Issue with SLM Tag Scan Result preventing processing
of the scan result. There might be a corrupt, empty or missing
list.txt file inside. Review SLM Tag Scan Result file
slmtagsearch_0_<comptuer_id>_*_slmtag.tar.gz/.zip.
Application usage data exceeds limit of size 1 MB
Step: SAM::RawAppUsagePropertyValue
Versions: 10.x
Message in Data Import Log:
WARN: Application Usage Data for remote computer with ID 5528399
86 trimmed to 1MB.
The data exceeds the allowed length.

Meaning: The result is larger than 1MB and only first 1MB will be stored.
This can happen on systems that have been existing since long and has
automation tools creating one time, unique process name. As a result, it is
ordered from most recent changes most used applications usage is also
updated in this case. Ensure that most recent Initiate Software Scan version is
used to prevent this message.
Issue with fetch file from BigFix Platform
Step: Various: CIT Facts, ISO Tag Facts...
Versions: 10.x
Message in Data Import Log:
WARN: Received only 46 of 3009 bytes of \35\550993735\citsearch_
0_550993735_cit.xml.bz2 / }
WARN: Registering failed read for file citsearch_0_550993735_cit
.xml.bz2 on computer 856590

Meaning: The most common issue is BigFix Platform overload or
change of the file after BigFix Inventory fetches the information about in
RawDataSourceFile step. As a result, the file is marked for re-read in the next
import.
Unable to get the path and name from string
Step: File Fact Import
Versions: 10.x
Message in Data Import Log:
WARN:(Import: FileFactHandler:57465)com.ibm.license.mgmt.etl.cor
e.actions.filefact.
FileFactRecordBuilder::build::Could not parse file for computer:
2071634,
unable to get path and name from string: "runcit_sw.sh", skippin
g invalid record.

Meaning: Malformed entry in file system scan. Provided entry is ignored.
Ensure that most recent Initate Software Scan is being used.
UUID not found - processing of duplicate guests from VM Manager is skipped
Step: VMManager Data Import
Versions: 10.x
Message in Data Import Log:
WARN:[ILMTCore] (ImportMergeTask-Thread:1) MergeGuestStrategy::p
rocess::
UUID:8429-4789-0735-0157 3771-6736-98 was found:
on host HOST1.HOSTNAME.ORG (PROCESSED)
on host HOST2.HOSTNAME.ORG (DUPLICATE)
skipping processing of duplicated guest from vm manager (https:/
/VMMAN.HOSTNAME.ORG:5986/wsman)

Meaning: In BigFix Inventory each device requires an assigned unique ID to be
able to correctly place the VMs in virtualization hierarchy. If there is a duplicate
ID, the entry is rejected and the VM is not placed in the virtualization hierarchy.
It is mandatory for the VM UUID to be unique. The affected VMs are listed.
No virtual machine detected
Step: VMManager Data Import
Versions: 10.x
Message in Data Import Log:
WARN:[ILMTCore] (ImportMergeTask-Thread:1) There is no virtual m
achines detected in the vm manager
scan result. Scan taken by vm manager tool on computer with id 8
28655 to vm manager
https://VMMAN.HOSTNAME.ORG/sdk/vimService.wsdl at Tue Apr 12 03:
48:55 UTC 2022.

Please verify whether defined user (BFI_USER@HOSTNAME.ORG) has r
ead rights to all required objects.

Meaning: BigFix Inventory can not show if the lack of machines in listing is
due to an issue with permissions or there are no VMs deployed. If the issue
persists, it is recommend to check permissions.
VM Manager has been marked as deleted
Step: VM Manager Data Import
Versions: 10.x
Message in Data Import Log:
2022-04-12 15:20:26 (+0:00:00.015) WARN: [ILMTCore] (ImportMerge
Task-Thread:1)
MergeDataTask::processTask::That vm manager has been marked as d
eleted, the data coming from this VM manager
will be discarded.

Meaning: Removal of the VM Manager configuration in VM Manager panel
results in ignoring any future result coming from such configuration. It
appears only in the next import as data from VM Manager might be already
collected and waiting for import.
Missing computer ID
Step: SAM::AppUsage SAM::DeepHw SAM::SharedDisk
Versions: 10.x
Message in Data Import Log:
WARN:

(ImportThread) Skipping import of computer data: Computer

ID missing for datasource 7.

Meaning: It is not possible to map Remote Computer ID to the computers
known to BigFix Inventory. This might be possible because of synchronization
issue. Contact support if the problem persist.

Exception while decrypting scan result
Step: SAM::CitFact SAM::IsotagFact
Versions: 10.x
Message in Data Import Log:
WARN: Exception while decrypting DatasourceFile citsearch_0_6076
322_cit.xml.bz2

Error was pad block corrupted in

org/jruby/ext/openssl/Cipher.java:1210:in `final'
D:/Program Files/ibm/BFI/wlp/usr/servers/server1/apps/tema.war/W
EB-INF/app/models/datasource_file.rb:155:in `get_data_from_bigfi
x_server'
D:/Program Files/ibm/BFI/wlp/usr/servers/server1/apps/tema.war/W
EB-INF/app/models/datasource_file.rb:109:in `read_data_into_mem'
D:/Program Files/ibm/BFI/wlp/usr/servers/server1/apps/tema.war/W
EB-INF/domains/sam/app/models/sam/scan_file.rb:62:in `get_file_i
nto_datasource_file'
D:/Program Files/ibm/BFI/wlp/usr/servers/server1/apps/tema.war/W
EB-INF/domains/sam/app/models/sam/cit_fact.rb:82:in `block in et
l_source'
D:/Program Files/ibm/BFI/wlp/usr/servers/server1/apps/tema.war/W
EB-INF/lib/threaded_mapper.rb:76:in `block in initialize'
WARN: Registering failed read for file citsearch_0_6076322_cit.x
ml.bz2 on computer 12565

Meaning: A mismatch between the file provided and nformation stored in the
database results is issue with decrypting scan result. Files on BigFix Platform
might be updated in between resulting in decrypting information which is no
longer valid. File will be processed again during next import.
Disconnected Scan: Importing older scan package from:
Step: SAM::DisconnectedScan
Versions: 10.x

Message in Data Import Log:
WARN: Importing older scan package from: 2022-01-10T14:59:00+00:
00 for computer: 218986. This computer already has data from: 20
22-01-10 14:59:00 UTC.

Meaning: When importing more then one package form single device older
results are ignored with above message.
Disconnected Scan: Skipping file
Step: SAM::DisconnectedScan
Versions: 10.x
Message in Data Import Log:
INFO: Skipping file: scanner_status.yml. Unsupported file in: 20
2201101459-7839250-28.zip.

Meaning: Disconnected Scanner package might include additional files that
are not recognized by scanner and ignored with above message.
Destination for disconnected scan package already exists
Step: SAM::DisconnectedScan
Versions: 10.x
Message in Data Import Log:
WARN: Exception while processing Disconnected Scan package 20220
1031457-7839250-28.zip. Only first 16
packages has been processed. Fix the problem by removing package
causing error.
The following error occurred: Destination 'D:\Program Files\ibm\
BFI\wlp\usr\servers\server1/tmp/datasources/
12/UploadManager/sha1/40/40/cit_capacity_1_40_tlm_hw.zip' alread
y exists

Meaning: There is an issue with extraction of Disconnected Scanner package
due to an issue with overwriting the file on the disk. File is located on host
of BigFix Inventory Server in provided location. Consider removing file and
running Data Import again.
Issues, such as missing physical processor group, missing lpar group, or
inconsistency in the HW scan file received
Step: ETL from ImportCapacity
Versions: 10.x
Message in Data Import Log:
INFO: ETL from ImportCapacity: Start
WARN: [ILMTCore] (ImportCapacity-Thread:0) The HW scan file rece
ived from agent does not contain a
physical processor group.
WARN: [ILMTCore] (ImportCapacity-Thread:0) The HW scan file rece
ived from agent is not consistent,
discarding the HW scan results...If no other detailed informatio
n is traced earlier, the problem may be
in missing 'Lpar' group in HW scan output or missing or empty Ph
ysicalProcessor group.
WARN: [ILMTCore] (ImportCapacity-Thread:0) CapacityScanFileHandl
er::processTask::Some error occurred
during importing the capacity scan from file : tlm_hw_2022011707
06_1642424799.xml for endpoint : 41303.

Meaning: Malformed Capacity scan result. Check Hardware Inventory: Status
for listed computer. Ensure that there are no known defects on the BigFix
Inventory Scanner / Run Capacity Scan and Upload Results fixlet for the given
OS. Consider upgrading to most recent version.
Inconsistent data detected when inventory builder is run
Step: ETL from InventoryBuilder

Versions: 10.x
Message in Data Import Log:
INFO:

(ImportThread) ProductInventoryBO: before dropAndCreateDi

scoveredSoftwareDetailsTable ->
ultimateUpdateDiscoveredSoftwareDetailsTable
WARN:

(ImportThread) Some data inconsistency detected during in

ventory builder - there was more then one current records with t
he same instance_hash present.Total number of problematic record
s is: 4.

Meaning: It is an unexpected condition when creating Software Classification
view leading to have more then one Component Instance (Software
Component with given Release in given path on given computer). BigFix
Inventory drops one of entries to avoid duplicates. Check if you are on most
recent version of BigFix Inventory Server. If the issue persists, contact support
to determine the scenario and adjust Inventory Builder logic.
Missing CVE file for the current year
Step: Calculating software components vulnerability risk based on NIST NVD
Versions: 10.x
Message in Data Import Log:
WARN:

(ImportAndProcessCVE) com.ibm.license.mgmt.bfi.bl.cve.CVE

Loader::loadNextFile::Missing file for
year 2022

Meaning: When the year changes and BigFix Inventory server is upgraded
after (or later) the first date of the year, the server does not include the new
files, the above warning appears. You must upgrade BigFix Inventory server
once again (subsequent upgrade) to allow the new files get included. The
warning disappears after the upgrade. Refer to this section to learn about
subsequent upgrade procedure.
Platform of the computer is not defined

Step: Calling Model.after_snapshot
Versions: 10.x
Message in Data Import Log:
WARN: There are multiple computers with not well determined Plat
form.
Software will not be properly discovered on them. Listing top 10
:

Example:
Datasource:
Platform:
Datasource:
Platform:

<DS> Computer:

(Id: <ID> RemoteId: <ID>) OS: ANY

IsUnix: 1
<DS> Computer:

(Id: <ID> RemoteId: <ID>) OS: ANY

IsUnix: 1

Meaning: To match with correct signatures, BigFix Inventory requires the
platform of the computer to be correctly defined so that the signatures can
have limited scope to particular platform only. Platform is assessed based on
OS property. This property might not be available or there can be some issue
with synchronization of this property between BigFix Inventory and BigFix
Platform. As a result, computer does not have defined platform. This warning
indicates if there are any such computers in the system. When all computers
have proper setting the message All computers got proper Platform set
appears. In case when computers are listed with such error it is needed to go
to Management > feature page and use the "Import all computer properties
and do matching of all facts once again (next import only)" option to resolve
the issue. If the problem occurs again, check procedures for rolling out BigFix
Agents. Ensure that they are properly initiated and have sufficient time to
report the basic data and this information reaches the BigFix Platform.

Database problems
Database problems are related to issues with connecting to DB2 and MSSQL Server as well
as retrieving information from these databases.

SQL Server
During the import, SQL Server uses 99% of the physical memory.
To solve the problem, set the maximum amount of memory that can be used
by SQL Server. For more information, see Server Memory Options and How to:
Set a Fixed Amount of Memory (SQL Server Management Studio) in the SQL
Server documentation.
The login process to SQL Server fails.
During a login process to SQL server, the following error is displayed:
Login failed for user 'username'. The user is not associated wit
h a trusted SQL Server connection.
(Microsoft SQL Server, Error: 18452).

The cause of this error is that SQL server is configured to use Windows
Authentication mode and does not allow the use of SQL accounts. To solve
this problem, enable the SQL Server Authentication in SQL Server. For more
information, see Enabling the SQL Server Authentication Mode.

DB2
BigFix Inventory cannot connect to its database and the following error is written in
the logs: Connection refused. ERRORCODE=-4499, SQLSTATE=08001.
The problem occurs because the DB2® database is not yet activated after a
restart and is thus not accessible to BigFix Inventory. To solve the problem,
run the following command after you restart the database:
db2 activate db database_name

Issues and resolution related to DB2 database fix pack installation

After you install DB2 fix pack and restart BigFix Inventory, the application does
not work and following message is displayed.
We're sorry, but something went wrong.

In tema.log the following error is found:
Java::ComIbmDb2JccAm::SqlSyntaxErrorException: The name of the o
bject to be created is identical to the existing name "DBO.SCHEM
A_MIGRATIONS" of type "TABLE"

Once you install a fix pack for DB2, perform the steps mentioned in DB2 for
Linux, UNIX, and Windows.
Note: Take a backup of the database before you activate or deactivate
your database. For more information, see Backing up the DB2
database. To learn about maintaining a database, see Maintaining the
DB2 database.
BigFix Inventory cannot connect to the database. The default port range is modified.
The default local port range for Linux™ is 32768-61000. If the default range is
modified, it is possible that the DB2® port number is allocated to another local
process. If the port number is pre-allocated, BigFix Inventory cannot connect
to DB2®. To troubleshoot this issue, complete the following steps:
• Ensure that IPv4 is being used.
• Use the netstat command to check whether DB2® is listening on the
expected port, and no other socket is pre-allocated the DB2® port.
• If DB2® is not listening on the expected port, restart DB2® and check
again.
Unable to establish a connection to a data source in the BigFix Inventory web user
interface with single sign-on enabled.

An error message is displayed after you saved the connection parameters on
the Data Sources pane:
Unexpected WebSEAL Response.
Code: 0x38cf04d3
Error: DPWWA1235E
Please contact your system administrator. This may indicate an i
nsufficient proxy HTTPS timeout.

To be able to save the connection parameters successfully, increase the httpstimeout parameter in the ISAM Reverse Proxy configuration. For example, to
set the timeout to 5 minutes:
1. Log on to IBM Security Access Manager.
2. In the top navigation bar, click Secure Web Settings > Manage > Reverse
Proxy.
3. Select the instance and then, from the drop-down list on the right of the
Reverse Proxy bar, select Manage > Configuration > Edit Configuration
File.
4. In the Advanced Configuration File Editor, locate the https-timeout
parameter and specify the value as 300.
Example:
https-timeout = 300

5. Click Save.

Both databases
After you restore the BigFix database, new data is not displayed in BigFix Inventory.
To ensure that only newly created data is imported to BigFix Inventory,
the data that is stored in the BigFix database is marked with the so-called
sequence number. The number is incremented with every change. Every
import contains data starting from the sequence number reported during the
last successful import to the current sequence number.

When the BigFix database is restored, the sequence number is restored to the
value from the time when the database backup was created. Thus, there is a
possibility that the sequence number after the restoration is lower than the
sequence number reported during the last successful import. In such case,
the first import after the database restoration does not include any data. After
that import, the sequence number is updated and the next import contains
new data.
However, data from the period between the database restoration and the first
successful import is not imported which creates a gap. To solve the problem,
go to Management > Advanced Server Settings, and change the value of the
resynchronize_datasources_once parameter to true. Then, run an import. This
initial import takes time depending on the amount of software scan data from
the restored BigFix database to cover the gap. The subsequent imports will
run in the normal operation mode.
Checking the database name.
The default database name is TEMADB (which was SUADB in the earlier
versions). You can check the name of your database in the database.yml
file in one of the following directories.
/opt/ibm/BFI/wlp/usr/servers/server1/config/
database.yml
C:\Program Files\BigFix Enterprise\BFI\wlp\usr
\servers\server1\config\database.yml
In earlier versions, the default installation path is C:\Program Files
\BigFix Enterprise\SUA or /opt/ibm/SUA.

Installation and upgrade problems
Solve common problems that are related to installation, configuration, and upgrade of BigFix
Inventory.
Installation of the server cannot continue and an error is displayed.

Installation of the BigFix Inventory server cannot continue and the following
message is displayed:

./tools/getArch: line 108: print: command not found
./tools/getArch: line 109: print: command not found
./tools/getArch: line 116: print: command not found
setup-server-9.0-linux-x86_64.sh: line 52: print: command not fo
und

The error might be caused by the fact the operating system is not fully
configured. You might also need to reboot the operating system.
Installation of the BigFix server with a remote SQL Server database fails.
The problem might occur while installing the BigFix server on the Windows
2008 Server operating system. When the installer attempts to connect to the
remote SQL Server database, the following message is displayed:
Computer Browser Error with Windows Authentication

To solve the problem, enable the file and printer sharing in Windows:
1. Go to Control Panel > Network and Sharing Center.
2. Click Advanced sharing settings.
3. Select the Turn on file and printer sharing check box.
4. Click Save changes.
Installation of the BigFix Inventory server does not start on Linux.
The problem occurs when the Symantec process rtvscand is running. To solve
the problem, you can stop the rtvscand process or exclude the /tmp folder
from Symantec scan. For more information about excluding the /tmp folder,
see: How to Configure Scan Exclusions in SEP for Linux.
Installation fails and a warning about the lack of free disk space in a given directory is
displayed. However, there is enough free space in that directory.

To solve the problem, perform the following steps.
1. Open the command line.
2. Run the following command to change the variable that is responsible
for checking disk space requirements.
•

export tlm_debug_disable_disk_space_check=true

•

set tlm_debug_disable_disk_space_check=true

3. Run the following command to start the installation.
•

./setup-server-linux-x86_64.sh

•

setup-server-windows-x86_64.bat

Installation cannot be started, because the /tmp directory has the NOEXEC flag.
In some environments, the /tmp directory might be mounted with the NOEXEC
flag, which blocks the installation. The problem can be recognized by the
following error in the ia.log file.
Launching installer...

./server/parts/CDROM_Installers/Disk1/InstData/Linux_64/VM/setup
Server.b
in: line 3318: /tmp/install.dir.20400/Linux/resource/jre/jre/bin
/java:
Permission denied

The /tmp directory is used to store temporary files during the installation.
Since the BigFix Inventory installer is based on InstallAnywhere, you can
change the IATEMPDIR environment variable that specifies the temporary
directory of InstallAnywhere, and set it to a custom directory.
1. Create a custom temporary directory, for example:
mkdir /root/Install_tmp

2. Set the IATEMPDIR variable to the new directory:

export IATEMPDIR=/root/Install_tmp

3. Restart the installation.
Installation of BigFix Inventory with All-in-one installer fails because the file system
where the DB2 instance directory resides is mounted as NOSUID or NOEXEC (or both).
Remount the file system where the DB2 instance directory resides, and make
sure is not mounted with the NOSUID or NOEXEC flag (or both).
During the configuration of the connection to a remote DB2 database, the following
error is displayed: The user specified for the communication with the database
could not be found in the system.

The problem occurs when the remote DB2 database is installed on an AIX
computer. It means that the user that you want to use for connecting to the
database does not exist on the LDAP server. To solve the problem, specify
a different user or create a user with the specified credentials on the LDAP
server.
During the installation of BigFix Inventory for non-English-language locales, some
Java exceptions are displayed in English.
Even for non-English-language locales, some Java exceptions that might
occur during the installation are displayed in English. However, the Details
view that contains the exceptions also includes more information that can
help you to understand and solve the issue. If you want to see the translated
description of a problem, you can switch to the Problems view where all the
available details are provided.
During the configuration of the connection to the BigFix server, the following message
is displayed: Could not determine character set of the BES database. Are you
sure the BES server is running an agent?.

The problem occurs when the BigFix client was removed from the computer
where the BigFix server is installed. To solve the problem, manually set

the _BESClient_DeploymentEncoding_IANAName property to that of your
deployment code page.
The list of non-English languages in the installation wizard is reduced.
To see your language as an option in the installation wizard, change your
system locale to a chosen language:
1. On Linux, open the Terminal and run the following command:
export LC_ALL=language_code.UTF8

For example, export LC_ALL=en_US.UTF8.
2. Run the locale command to verify changes.
3. Restart the installation and choose the language.
Despite upgrading to the latest version, the service name still shows the old version.
The display name of the service on Windows does not change after the
upgrade, which is a limitation. It does not, however, impact BigFix Inventory in
any way. To update the service name, restart your computer.
The server cannot be upgraded because the task Upgrade to the latest version of
BigFix Inventory is not relevant.
The problem occurs when the previous version of the server was installed
manually on a computer without the BigFix client. To make the upgrade task
relevant, perform the following steps:
1. Install the BigFix client on the computer with the BigFix Inventory server.
2. Set the value of the SUA_Server_Path_[user_ID] parameter to the
installation path of the BigFix Inventory.
a. Log in to the BigFix console that is linked to your BigFix server.
b. In the navigation bar, click Computers.
c. In the upper-right pane, right click the computer on which you
installed BigFix Inventory, and click Edit Computer Settings.
d. To add a setting, click Add.
e. In the Setting Name, type SUA_Server_Path_[user_ID].

Note: user_ID on Linux is the Linux user ID of the user
who installed BigFix Inventory, while on Windows it must
be set to 0.
f. In the Setting Value, specify the BigFix Inventory installation path.
g. Click OK.
Upgrade of the BigFix Inventory server with a fixlet is not possible on Linux because
the fixlet is not relevant due to problems with relevance 6 is not met.
When the Upgrade to the latest version of BigFix Inventory (version) fixlet
is not relevant, use the Analyze the Relevance of a Fixlet or Task fixlet to
check which part of the relevance expression is not matched. For detailed
instructions, see: Relevance.
If the problem is with relevance 6, it is most likely that the /etc/passwd file
cannot be accessed or read. To work around this problem, create a custom
copy of the Upgrade to the latest version of BigFix Inventory (version) fixlet
with relevance 6 removed.
1. Relevance 6 checks whether there is enough disk space to perform
the upgrade. Because you are going to remove these checks from the
fixlet, ensure that enough free disk space is available in the relevant
directories.After you run the Upgrade to the latest version of BigFix
Inventory (version) fixlet, the BigFix server downloads the new installer
to its file system (1 GB on the server). Then, it delivers the package
to the specified endpoint and extracts it (1 GB on the endpoint). The
upgrade also requires 0.5 GB in the system temporary directory and 1
GB on the disk where BigFix Inventory is installed plus the current size of
the following directories.
• install_dir\wlp\usr\servers\server1\data
• install_dir\wlp\usr\servers\server1\logs

Where install_dir is the BigFix Inventory installation directory. By
default, the BigFix Inventory server is installed in the following
directory.
◦

/opt/BFI

◦

C:\Program Files\BigFix Enterpise\BFI

2. Create a custom copy of the Upgrade to the latest version of BigFix
Inventory (version) fixlet.
• Log in to the BigFix console.
• In the navigation tree, go to Sites > External Sites > BigFix
Inventory v10 > Fixlets and Tasks.
• Right-click the fixlet Upgrade to the latest version of IBM BigFix
Inventory (version), and click Create Custom Copy.
• Change the name of the fixlet so that you can easily recognize it.
• Open the Relevance tab, remove relevance 6, and click OK.
3. To upgrade the BigFix Inventory server with a custom version of the
fixlet, click Take Action. Select the computer on which the BigFix
Inventory server is installed, and click OK.
If you want to upgrade the server later, the custom copy of the fixlet is
available in Sites > Master Action Site > Fixlets and Tasks.
4. After the BigFix Inventory server is upgraded, remove the custom version
of the fixlet.
• In the navigation tree, go to Sites > Master Action Site > Fixlets
and Tasks.
• Right-click the custom version of the fixlet, and click Remove.
Then, click OK to confirm.
Upgrade of the server with a fixlet fails on Linux.
The problem occurs when the server was installed by a non-root user. To solve
the problem, upgrade the server in interactive or silent mode.
After the upgrade, the Usage per Computer report is empty
To solve the problem, run the import of data.

Manually changing the port number of BigFix Inventory
If you cannot access the user interface (Management > Server Settings) to
change the port number, you can also do it in the server.xml file.
1. Go to install_dir/wlp/usr/servers/server1, and edit the
server.xml file.
2. In httpsPort, enter the new port number.
<httpEndpoint host="*" httpsPort="9081" id="tema">

The change takes effect immediately, the server does not need to be
restarted.
Uninstalling BigFix Inventory fails because the BigFix Inventory service is
unresponsive and cannot be stopped.
You can manually force an unresponsive service to stop.
1. Open the command line.
2. Run the following command:
•

service BFIserver status

•

sc queryex BFIServer

3. Identify the PID of the BigFix Inventory process.
4. In the same command line, run the following command:
•

kill -9 identified_PID

•

taskkill /pid identified_PID /f

Hardware inventory problems
Find the solution to the issues that you have encountered while working with virtual
machine managers and hardware inventory.
Update of the VM Manager tool fails

When you run the Update VM Manager Tool to version fixlet, the update fails.
When you view the details of the action on a particular computer, the script
can fail on various lines, for example:
waithidden cmd /c "rmdir "{parameter "homefolder"}" /s /q"
continue if {exit code of action = 0}

To solve the problem, perform the following steps:
1. Go to the computer on which the update of the VM Manager tool failed
and open the <BES_Client>/LMT folder.
2. If the folder does not contain the VMMAN_copy folder, create it.
3. Copy the config and keydb folders from the <BES_Client>/LMT/
VMMAN folder to the <BES_Client>/LMT/VMMAN_copy folder.
4. Remove the VMMAN folder.
5. Run one of the following fixlets to complete the update. It might take
some time before the fixlet becomes relevant.
• Run the Install VM Manager Tool version number fixlet, if the
update failed on the computer where the main instance of the VM
Manager tool is installed.
• Run the Install Additional VM Manager Tool (OPTIONAL) version
number fixlet if the update failed on the computer where an
additional instance of the VM Manager tool is installed.
Error message CODVM0005E is displayed when attempting to connect to the VM
manager over SSL.
When trying to connect to the VM manager over SSL, an error message is
displayed: CODVM0005E An error occurred when attempting to connect
to the VM manager at the following address: hostName. To solve the

problem, complete the following steps:

1. Go to https://www14.software.ibm.com/webapp/iwm/web/
preLogin.do?source=jcesdk.
2. Provide your BigFix ID and password and click Sign in. You might need
to register with BigFix to download the files.
3. Select Unrestricted SDK JCE Policy files for Java 5.0 SR16, Java 6
SR13, Java 7 SR4 and later versions and then click Continue.
4. View the license agreement, select I Agree, and then click I confirm.
5. Click Download Now.
6. Extract the files and copy them to the following directory:
<BES_Client>/LMT/VMMAN/java/jre/security

7. Restart the server.
Server is running, but an exception in traces appears. The exception is
related to the connection with the specified ESX with the following message:
javax.net.ssl.SSLException: Unrecognized SSL message, plaintext
connection?

1. Add the following lines to file /etc/vmware/hostd/config.xml:
..
<ssl>
<doVersionCheck> false </doVersionCheck>
<handshakeTimeoutMs>30000</handshakeTimeoutMs>
</ssl>
<http>
<readTimeoutMs>45000</readTimeoutMs>
<writeTimeoutMs>45000</writeTimeoutMs>
<blacklistPeriodMs>3000</blacklistPeriodMs>
</http>
<vmdb>
...

2. Restart the hostd service using service mgmt-vmware restart.
3. Verify that the exception does not occur.
Server is running, but an org.xml.sax.SAXParseException exception in traces
appears. The exception is related to the connection with the specified ESX.
Make sure that you have the latest patches to your problematic ESX server
installed.
Upgrade of vCenter server from v5.0 to v5.1 causing server connection failure.
The following message is displayed CODVM0003E The VM manager denied
access because of invalid credentials. To solve this issue, perform the

following steps:
1. In vCenter, stop all sessions under a user name that is defined as a user
credential in VM manager for specific vCenter.
2. Remove this user name.
3. From vCenter, add the user name back with read-only or propagation
authorities.
4. Redefine the VM manager entry for this specific vCenter using the same
user name credential.
Specification of the domain for the user name for VM Managers is inconsistent.
Different definitions of users are used for each type of VM manager:
• For Microsoft Hyper-V, you must use the Administrator account. The
user is defined as user_name\domain or user_name@domain. For
example: test\cluster.com or test@cluster.com.
• For VMware, the user is defined as domain\user_name, for example:
cluster.com\test.

• For RHV-M, the user is defined as user_name@domain, for example:
test@cluster.com.

•

For Citrix Hypervisor (formerly XenServer), the user is defined
as user_name, for example root.

For Oracle VM Server for x86, the user is defined as

•

user_name, for example: test.
For Nutanix, the user is defined as user_name, for example:

•
test.

Changes to the VM managers are not updated on the BigFix server.
Changes to the VM managers are not updated on the BigFix server and the
following error message is displayed in the VM Managers panel: The last
modification of VM managers was not processed correctly on the
BigFix server. The data is not synchronized with the VM Manager
Tool.

To solve the problem, make sure that the VM Manager tool is installed. You
can also check the history of the Configure VM Manager Tool action in the
BigFix console to investigate the failed step. Additional information can
also be found in the BigFix console log files that are in one of the following
directories:
•

/var/opt/BES Client/__BESData/__Global/Logs

•

C:\Program Files (x86)\BigFix Enterprise\BES
Client\__BESData\__Global\Logs

The connection test does not finish.
See the solution for: Data from VM managers is not updated on the BigFix
server.
Connection to Hyper-V fails with the following error: The RPC server is
unavailable.

Ensure that port 135 as well as all Windows dynamic ports are open for
communication.
Data from VM managers is not updated on the BigFix server.
If you run a connection test for a VM manager and it does not finish, it might
indicate a problem with the BigFix client that is installed on the BigFix server.

If the client is stopped, actions that you perform in BigFix Inventory are sent
to the BigFix server but the status is marked as Not reported. To determine
further actions, investigate the BigFix client that is installed on the BigFix
server.
For the same reason, data from VM managers might not be uploaded to the
BigFix server. Check the value in the Last Successful Operation column to
verify if the data was recently sent to the server.
Actions that are performed in the VM Managers panel, such as testing the connection
or adding a new VM manager, fail.
If actions that you perform in the VM Managers panel fail, you can log in to the
BigFix console that is linked to your primary data source and check the history
of recent actions, such as Configure VM Manager Tool or VM Manager Tool connection test. By doing so, you can investigate details of the failed step and
determine the solution. If you are not sure which data source to connect to, log
in to BigFix Inventory and click Management > Data Sources.
To check the history of recent actions, complete the following steps:
1. Log in to the BigFix console that is linked to your primary data source.
2. In the navigation tree, click Computers.
3. In the upper-right pane, select the computer that is defined as your
primary data source.
4. In the lower-right pane, click the Action History tab.
5. Double-click on one of the recent actions that failed:
• If the connection test was unsuccessful, check the VM Manager
Tool - connection test action.
• If modification of VM managers failed, check the Configure VM
Manager Tool action.
6. In the new window, click the Computers tab.
7. Double-click on the action.
8. Locate the failed step and check the details.

The VM Managers panel is blocked or contains error messages.
The VM Managers panel is either blocked completely, with no possibility of
performing any actions, or it contains one of the error messages that instruct
you to install the VM Manager tool or the BigFix services.
To solve the problem, complete the following steps:
• Ensure that the BigFix server and client are installed on the target
endpoint.
• Install and start Web Reports on the BigFix server. For more information,
see: Installing the Web Reports.
• Subscribe the BigFix server to the BigFix Inventory v10 site.
• Make sure that the content of the BigFix Inventory v10 site is up-to-date.
If your computer does not have access to the Internet, see: Downloading
files in an air-gapped environment.
• Subscribe the target endpoint to the BigFix Inventory v10 site.
• Make sure that the VM Manager tool is installed. For more information,
see: Installing the VM Manager tool.
CPU frequency that is displayed on the Hardware Inventory report equals zero
CPU frequency is an additional parameter. It is retrieved only from computers
that are not managed by VM managers or from virtual machines that are not
in the OK status. CPU frequency values do not influence PVU calculations.
Virtual machines that are managed by the VMware vCloud Director have duplicate
BIOS UUIDs.
The problem occurs when virtual machines are deployed from catalog
templates. To work around the problem, see: BIOS UUIDs in vCloud Director
are not unique when virtual machines are deployed from catalog templates
(2002506).
The Hardware Inventory report in BigFix Inventory displays No Scan Data after
capacity scans were run on VMware guest operating systems.

The import log contains multiple occurrences of the following errors.
Some error occurred during importing the capacity scan from file
:
capacity_scan_file_name.xml for endpoint :
endpoint_number.

getNodeInfo Error: VMWare VirtualMachine UUID (06XZXA0) do not m
atch with the UUID pattern!

In the scan files uploaded by the clients, the UUID tag contains the hosts serial
number instead of the virtual machine UUID. Example:
<VirtualMachineGuest version="1">
<UUID>06CZFCV</UUID>
<HypervisorType>VMware</HypervisorType>
</VirtualMachineGuest>

BigFix Inventory requires unique virtual machine UUID numbers to properly
calculate the capacity for all virtual machines. This error might be caused by
the host serial number appearing in the place where virtual machine UUID
is normally recorded. If you install an operating system with the so-called
Reseller Option Kit (ROK) media, some data might be obtained from the server
BIOS, instead of from the virtual machine.
To enable the correct retrieval of UUID data from operating systems
installed with the ROK media, edit the virtual machine's .vmx file and set the
reflectHost parameter to false. Example:
SMBIOS.reflectHost = "false"

If the problem persists, force the upload of capacity scan data. To do this,
perform the following steps.
1. Log in to the BigFix console.
2. In the navigation tree, go to Fixlets and Tasks and select the Run
Capacity Scan and Upload Results fixlet.

3. In the lower pane, click Take Action, and choose Click here to run a
single capacity scan and force upload of results.
4. Open the Target tab and select the computers that you want to scan.
Then, click OK.
5. Wait for the scheduled import, or run it manually.
Data on the Hardware Inventory report is outdated.
The problem might occur when the import of capacity scan data fails. To
solve the problem, perform the following steps:
1. Log in to the BigFix console.
2. In the navigation tree, go to Fixlets and Tasks and select the Run
Capacity Scan and Upload Results fixlet.
3. In the lower pane, click Take Action, and choose Click here to run a
single capacity scan and force upload of results.
4. Open the Target tab and select the computers that you want to scan.
Then, click OK.
5. Wait for the scheduled import, or run it manually.
When the scan finishes, its results are uploaded to the BigFix server. After the
data is imported to BigFix Inventory, the Hardware Inventory report should be
up-to-date.
The Hardware Inventory report displays no Processor Brand String data.
The problem might occur after the migration, or upgrade. To see the Processor
Brand String data on the report, force the upload of capacity data by
completing the following steps.
1. Log in to the BigFix console.
2. In the navigation tree, go to Fixlets and Tasks and select the Run
Capacity Scan and Upload Results fixlet.
3. In the lower pane, click Take Action, and choose Click here to run a
single capacity scan and force upload of results.

4. Open the Target tab and select the computers that you want to scan.
Then, click OK.
5. Wait for the scheduled import, or run it manually.
Computers have the No Scan Data status because results of the capacity scan were
removed from the BigFix Inventory server
Results of the capacity scan are stored in a folder on the computer where
the BigFix Inventory server is installed. If the folder is removed, the status
of computers on the BigFix Capacity Completeness widget changes to No
Scan Data. If the results of the next capacity scan differ from the results that
currently exist on the scanned computers, they are uploaded to the BigFix
Inventory server. Then, the status of computers changes from No Scan Data
to OK. However, if the results of the next capacity scan are the same as the
results that exist on the scanned computer, they are not uploaded and the
computers remain in the No Scan Data status. To solve the problem, perform
the following steps.
1. Log in to the BigFix console.
2. In the navigation tree, go to Fixlets and Tasks and select the Run
Capacity Scan and Upload Results fixlet.
3. In the lower pane, click Take Action, and choose Click here to run a
single capacity scan and force upload of results.
4. Open the Target tab and select the computers that you want to scan.
Then, click OK.
5. Wait for the scheduled import, or run it manually.

Scan problems
The most common problems with software scans are reported on the Software Scan Health
widget. Refer to this topic to learn how to solve problems that are reported on the widget as
well as for solutions to other scan-related problems.

Software Scan Health widget
The Software Scan Health widget shows the health of scans that are running in your
infrastructure. You can drill down to reports for specific computers with scan problems. By
sorting the columns of a report, you can quickly understand which computers are failing
which specific software scan types.
Failed Scan: At least one type of software scan (catalog-based, file system, package
data, or software tags) did not complete successfully.
This problem might occur because the computer is out of space, is
misconfigured, or the scan was stopped.
Missing Scan: The last attempt to initiate at least one type of software scan (catalogbased, file system, package data, or software tags) was more than 30 days ago.
This problem might occur because the computer is out of space, is
misconfigured, or the scan was stopped.
Outdated Catalog: The version of the catalog on the agent is older than the version
that is available on the server.
When you upload a software catalog to BigFix Inventory or edit your custom
catalog, the status of the catalog is pending until you run an import. During
the import, endpoint catalogs are created and the version of the catalog that
is displayed on the Software Catalog widget is updated. Endpoint catalogs are
then distributed to the computers in your infrastructure.
The time when the endpoint catalog reaches the computers depends, for
example, on the computer connection status. When the endpoint catalog is
updated on the computer, information about the new version of the catalog
is gathered by the Software Scan Status analysis. After the next import,
information about the version of the catalog that is available on the computer
is updated in BigFix Inventory.
Because this entire flow might take some time, it can happen that a computer
has the Outdated Catalog status even thought there are no problems. To verify
whether any action is needed, perform the following steps:

1. On the Software Catalog widget, check the date when the catalog was
last edited.
2. On the Software Scan Health widget, click Outdated Catalog to view
the list of affected computers and check the date in the Last Software
Change column.
• If the last scan import was before the date when the catalog was
last edited, wait for the next scan and the subsequent import.
As described above, distribution of the endpoint catalog to the
computers and reporting its version from the computers to BigFix
Inventory might take some time.
• If the last scan import was after the date when the catalog was
last edited, force the distribution of the software catalog to the
computers. For more information, see: Updating scanner catalogs.
Scan Not Uploaded: Results of the catalog-based scan or file system scan were not
uploaded to the BigFix server.
This problem might occur because the computer or a relay is offline, there is a
network outage, or the last scan attempt was more than 30 days ago. Check
whether each computer listed in the report is running and that the scan results
are uploaded to the server on a regular basis. You can check the time of last
scan attempt for all types of the software scan in the Software Scan Status
analysis.
If the problem persists, it might indicate that the initial download of the
catalog to the endpoints failed. To solve the problem, upload the latest catalog
to the agent. For more information, see: Updating scanner catalogs.
IBM i computer scans are excluded from the Scan Not Uploaded
check.
Unscanned Shared Disks: A remote shared disk is not scanned by the agent.
License usage for IBM software that is installed on an unscanned shared disk
might be under-reported. To solve the problem, enable scans of remote shared
disks.

The status is based on scanning shared disks by using the basic
mode. Starting from application update 9.2.12, you can discover software
that is installed on shared disks by using the optimized mode. This mode
allows for reducing the load that scans produce on shared disks. For more
information, see: Discovering software on shared disks.

Other scan problems
Long running scans caused by signatures using config.xml file to discover
the IBM Clarity Data Collection
The signatures which were using config.xml to discover the IBM Clarity
Data Collection 6.6 and 7.2, caused the scans to run longer. In BigFix Inventory
version 10.0.5, the signatures have been removed from the LMT catalog.
The software scans cannot be initiated because the Initiate Software Scans task is not
applicable
The software scans depend on the scanner catalogs that are used by the
scanner to discover software. The scanner catalogs are created when you
upload the software catalog to BigFix Inventory. If you cannot run the software
scans, it might mean that the catalogs were not created. Before you update
the scanner catalogs manually, complete the following steps to check the
cause of this problem:
1. On the computer on which the task is not applicable, go to the
<BES_Client>\LMT\CIT directory.
2. Check if the catalog.bz2 file exists. The file contains the scanner
catalogs.
3. Log in to the BigFix console.
4. In the navigation bar, click Actions.
5. In the upper-right pane, locate the Catalog Download (Version version)
action and select it.
6. Check the details of the action. You can check on which computer the
action failed and investigate the failed steps. Try to determine the cause
of the problem and fix it.

If you cannot determine the cause, update the catalogs manually. For more
information, see: Updating scanner catalogs.
In the Software Scan Status analysis, the status of a software scan is Failed and the
value in the Is archive file size exceeded column is True
The problem occurs when the scan file is larger than the maximum archive file
size that can be sent by the BigFix client. To solve the problem, perform the
following steps:
1. Check the BigFix client log for information about the size of the file that
exceeded the limit. By default, the log is in the following location.
/var/opt/BESClient/__BESData/__Global/Logs
C:\Program Files (x86)\BigFix Enterprise
\BESClient\__BESData\__Global \Logs
2. Log in to the BigFix console.
3. In the left navigation, click Computers, right-click the computer on which
the scan failed, and then click Edit Computer Settings.
4. Increase the value of the _BESClient_ArchiveManager_MaxArchiveSize
parameter.
The software scan cannot be run on an LPAR because the Initiate Software Scan is not
relevant on that computer
When a WPAR exists on an LPAR, all WPAR processes are visible on the level
of the LPAR. When the software scan is running on the WPAR, the process is
visible on the level of the LPAR and thus the Initiate Software Scan fixlet is not
relevant on the LPAR. To run the software scan on the LPAR, wait for the scan
to finish on the WPAR. Alternatively, perform the following steps:
1. Log in to the BigFix console.
2. Select the Initiate Software Scan fixlet and click Take Action.
3. On the Target tab, select Dynamically target by property.

4. Expand By Retrieved Properties and then expand By Computer Name.
5. Select the LPAR computer on which you want to run the software scan
and click OK.
Upgrade of the scanner fails on a WPAR
When a WPAR exists on an LPAR, you must first upgrade the scanner on the
LPAR, and then on the WPAR.
Software scans are failing. Computers where the scans are failing have the Low Disk
Space status on the Deployment Health widget.
The problem might be caused by insufficient disk space for the scanner
cache. To solve the problem, move the scanner cache folder to a different
location or optimize the cache. For more information, see: Optimizing scanner
cache configuration.
Software components that are installed in the /usr/lpp directory on AIX are not
discovered
The problem occurs because the /usr/lpp directory is by default excluded
from software scans. Starting from scanner version 2.8.0.5000, the
directory is included in software scans, and components installed in this
directory are discovered. Thus, to solve the problem, update the scanner to
version 2.8.0.5000 or later, and wait for the next scheduled software scan.
Alternatively, you can manually include the /usr/lpp directory in software
scans. For more information, see: Including the excluded directories back in
scans.
After the update of the scanner, the number of software components discovered on
AIX increased and some duplicates appeared
Previously, the /usr/lpp directory was excluded from software scans.
However, components whose signatures existed only in this directory were not
discovered. Thus, starting from scanner version 2.8.0.5000, the /usr/lpp
directory was included in software scans. It caused that more components
are discovered and displayed on the reports. However, components installed

in the /usr/lpp might also be discovered in other directories. In such case,
duplicate components appear on the reports. To solve the problem, suppress
the duplicates. For more information, see: Excluding and suppressing software
instances. You can also create a custom rule that suppresses components
that are discovered in /usr/lpp and other directories. For more information,
see: Creating and managing custom rules.
How to check the results of the Software Scan Status analysis
To check the status of the software scan, view the results of the Software
Scan Status analysis.
1. Log in to the BigFix console.
2. In the navigation tree, go to Sites > External Sites > BigFix Inventory v10
> Analyses.
3. Select the Software Scan Status analysis.
4. In the lower pane, open the Results tab.
Tip: Scroll right to view all the relevant data.

New software titles were added to the catalog, a data import was run but the software
is not visible in the BigFix Inventory web user interface

One of the reasons for the missing software titles in the BigFix Inventory UI is
that non-standard file types were used as software signatures. If you added a
rule with non-standard file extensions, you must either wait until all the steps
in the catalog data flow complete or perform those steps yourself. To have
accurate inventory data:
1. Run a data import to propagate the catalog to the endpoints.
2. Verify that the catalog was propagated successfully.
3. Upload the scan data to the BigFix Inventory server.
4. Run another data import.
The scanner cannot be updated on 32-bit Linux x86
The problem occurs on the 32-bit Linux x86 with the libstdc++.so.5 library
for which the last available version of the scanner is 2.8.0.3000. To solve the
problem, update the library to libstdc++.so.6 if available. Otherwise, the
scanner cannot be updated.
Software Scan Health limitations on IBM i
The result of the file system scan is positive by default in the IBM i
environment. The File System Scan Successful column is always set to yes.
After running a scan on a large system with high number of mount points or
share drives, the log file contains multiple return codes related to insufficient memory
During file scan or software scan that is performed on large servers with high
number of mount points or share drives, memory requirements for the scanner
increase. If there is not enough memory available for the scanner to work, the
log file might contain the following return codes:
• 125 which indicates memory allocation failure.
• 134 which translates into the operating system signal 6 - SIGABRT.
• 139 which translates into the operating system signal 11 - SIGSEGV.
For more information, see: Software scan return codes.

To check whether the issue is related to problems with memory, monitor
the memory usage of the scanner and determine if it reaches the limits set
on the system. Ensure that your limit allows scanner to work properly. For
example, for the scanner on a sever with 20 000 mount points or share drive
the required memory is about 500 MB of RAM. Thus, the ulimit for data seg
size, or ulimit -d must be set to at least 500000. For more information, see:

Ulimit command (on AIX).
When you scan large systems with high number of mount points or share
drives, consider the following aspects:
• The scan can be slow.
• The scanner logging must be set to minimum, as it has significant
impact on performance in such environments.
• Do not set a CPU threshold, or if required, ensure that the limit is not too
low.
Optimized scan of shared disks does not complete on Windows
When you enable optimized scan of shared disk, the scan does not complete.
In the BigFix console, when you go to Actions, the status of the Optimized
Shared Disks Scan Update Resources List action is Pending Downloads and
the following error is displayed in the Summary section.
HTTP Error 28: Timeout was reached: Connection timed out after 1
0000 milliseconds"

The problem occurs on Windows systems with multiple interfaces. To solve
the problem, see: Configuring servers in separate networks.

Security problems
Security problems in BigFix Inventory might include issues with logging in to the application
or those related to the security of your credentials and your environment. However, you can
easily recover from these problems.

Login credentials and the authenticity token are stored as plain text in the HTTP
packet.
After logging in, the login form that contains the credentials is sent as plain
text in the HTTP packet. You can solve this issue by configuring SSL.
When creating a new user, autocomplete is enabled for the password field.
When creating a new user, the password field might be filled by autocomplete
based on the password that is stored in the browser.
The server is not working properly after certificates are modified.
If the server is not working properly after certificates are modified and the
server is restarted, then delete the keystore file key_server.jceks and restart
the server. The keystore file is regenerated with a self-signed certificate. You
can investigate the problem in the tema.log file.
The keystore file name is different for different versions:
• Starting from 10.0.8.0
◦ key_server.p12
• For earlier versions
◦ key_server.jceks
Difficulty establishing a connection with HTTPS.
If you have difficulty when establishing a connection with HTTPS and you are
using SSL, check that your browser supports TLS 1.2 and that it is enabled.
The single sign-on configuration values are not updated automatically after you
modify the server port.
Modifying the port number on the Server Settings pane in BigFix Inventory
while single sign-on is enabled invalidates the single sign-on configuration.
For information how to properly modify the port, see Modifying port in BigFix
Inventory that has single sign-on enabled.
If you already modified the BigFix Inventory server port and are experiencing
issues signing onto BigFix Inventory, you need to:

1. Revert the disabled SSO configuration for SAML or Revert the disabled
SSO configuration for LTPA.
2. Provide the new port value on the Server Settings page. To access the
page, click Management > Server Settings.
3. Re-create the single sign-on configuration with the new port value. For
more information, see either Configuring SSO based on SAML token or
Configuring SSO based on LTPA.
After you log in to BigFix Inventory for the first time with single sign-on enabled, you
are redirected to an BigFix icon instead of the overview page.
To recover from this error, follow the instructions in Handling the favicon.ico
file with Mozilla Firefox.
When you are importing a certificate in the PEM format and an encrypted private key
in the pkcs8 format, an error about incorrect password for the private key is displayed.
When you are importing a certificate and a private key in the pkcs8 format, the
following error is displayed:
Error when validating private key password: problem parsing ENCR
YPTED
PRIVATE KEY: java.lang.SecurityException: JCE cannot authenticat
e the provider BC.

To solve the problem, add the following line to the installation_dir/
jre/lib/security/java.security file:
security.provider.10=org.bouncycastle.jce.provider.BouncyCastleP
rovider

Then, restart the BigFix Inventory server.
When you log in to BigFix Inventory using the LDAP authentication, the following
error message is displayed: Error contacting the Directory Server for
authentication.

The error might occur if the SSL LDAP certificate that is used to authenticate
users in BigFix Inventory was recently updated. To refresh the certificate in the
BigFix Inventory database, perform the following actions:
1. Log in to BigFix Inventory as a local administrator.
2. In the top navigation bar, click Management > Directory Servers.
3. Choose the LDAP server that is used to authenticate users.
4. Click Test Connection, and wait for connection test to finish.
5. Click Save.
Antivirus software detects the LMT/CIT directory as possible threat.
The LMT/CIT directory is one of the default scanner directories that is
required by BigFix Inventory. It is not infected with any malicious software and
does not pose any threat to your system. It is recommended to exclude this
directory from antivirus scans.
Secure connection is not initialized and the CWWKO0801E error can be found in the
tema.log file.
Secure connection is not initialized and the following error can be found in the
tema.log file.
000000b7 com.ibm.ws.channel.ssl.internal.SSLHandshakeErrorTracke
r
CWWKO0801E: Unable to initialize SSL connection. Unauthorized ac
cess was denied
or security settings have expired. Exception is javax.net.ssl.SS
LHandshakeException:
Client requested protocol TLSv1 not enabled or not supported.

Server operation problems
Server operation problems in BigFix Inventory might include general issues that you might
encounter when you use the application and its functions. However, you can easily recover
from these problems.

Scan configuration displays the status: Server unavailable
The scan schedule cannot be displayed and set because the BigFix server or
the Web Reports service is not responding. To fix the problem:
1. Go to Management > Data Sources.
2. Check the connection parameters for the BigFix server.
3. Go to a browser on computer and test the following URL:
https://bigfix-server-address:52311/api/query?relevance=id%
20of%20bes%20computers%20whose%20(root%20server%20flag%20o
f%20it=true)

4. When prompted, log in providing the connection parameters for the
BigFix server, that you verified in step 2.
The expected result is:
<BESAPI xsi:noNamespaceSchemaLocation="BESAPI.xsd">
<Query Resource="id of bes computers whose (root server fl
ag of it=true)">
<Result>
<Answer type="integer">number value</Answer>
</Result>
<Evaluation>
<Time>0.202ms</Time>
<Plurality>Singular</Plurality>
</Evaluation>
</Query>
</BESAPI>

The following message indicates that Web Reports service is started but the
required information is not collected yet. Wait a couple of minutes and retry
the query.

<BESAPI xsi:noNamespaceSchemaLocation="BESAPI.xsd">
<Query Resource="id of bes computers whose (root server fl
ag of it=true)">
<Result/>
<Error>Singular expression refers to nonexistent
object.</Error>
</Query>
</BESAPI>

You can receive one of the following error messages:
•

HTTP 401: Unauthorized

It indicates that you provided invalid credentials or the authorization
step was canceled.
•

Cannot perform relevance query evaluation at this time beca
use there is no reachable Web Reports instance collecting d
ata from this Server.

It indicates that Web Reports service is down or there is an issue with
network connection, for example: proxy or firewall blocks access to Web
Reports. Contact your network administrator for assistance to enable
the communication between the BigFix server and Web Reports.
The RPM scanner fixlet fails on AIX® 6.1
The scanner fails and the RPM installation package returns undefined during
the software scan. To remedy this problem, upgrade your BigFix server,
console, and clients to version 8.2.1175.
Version 8.0 and 8.1 BigFix® Enterprise Server Clients cannot subscribe to the BigFix
Inventory server.
The solution is to unsubscribe all computers from the current site or remove
the site, and then subscribe the clients back.

A report was created correctly but it could not be sent as a PDF attachment to an
email.
The PDF report could not be sent because the mail server in your company
does not accept large email attachments. To fix the problem:
1. Determine the size of large reports that are generated by BigFix
Inventory: generate a sample PDF by clicking the PDF icon in the BigFix
Inventory web user interface.
2. Contact your mail server administrator and request a higher size limit
for email attachments in both the outgoing and incoming mail server
configuration.
Data that is gathered by an analysis property is incorrect.
The same analysis property can exist in multiple external sites. In such a
situation, the data that is gathered by the analysis might come from any of the
sites, not necessarily the intended one. If some unexpected data is gathered
by an analysis property, ensure that the analysis that you defined comes from
the correct site. Go to the following URLs:
• https://<bfi_host>:<port>/management/sam/
unix_package_properties
• https://<bfi_host>:<port>/management/sam/
package_properties
• https://<bfi_host>:<port>/management/sam/
app_usage_properties
Click the name of the property, and in the Data Source Property list, check
whether the site is correct. The name of the site is displayed below the name
of the property. If the site is incorrect, change it.
BigFix Inventory does not start after rebooting the server.

The problem often occurs in environments where BigFix Inventory and DB2®
are installed on the same server. After rebooting the server, the DB2® instance
is not started which also blocks BigFix Inventory from starting.
To fix the problem, ensure that your DB2® instance is running and then start
BigFix Inventory:
1. Log in as the DB2® instance owner and start the instance:
su db2inst1
db2start

2. Start the BigFix Inventory server:
/etc/init.d/SUAserver start

'We're sorry, but something went wrong.'
For more information about the error, check the server log file tema.log in
the installation_directory/wlp/usr/servers/server1/logs/
directory.
Software that is deployed under a tmp directory is not discovered.
Temporary directories (tmp) contain large amounts of irrelevant data. Thus,
they are not scanned by default. However, some applications are installed
under tmp directories. As a result, they are not discovered by software
scans. To solve the problem, include all tmp directories except for the
main temporary directory of the operating system into software scans. It
ensures that applications that are installed under tmp directories are correctly
discovered but the main temporary directory of the operating system is not
unnecessarily scanned.
On the computer where the software is installed, go to the BESClient/LMT/
CIT/ directory and open the exclude_path.txt file. It lists all directories
that are excluded from software scans.

• For UNIX operating systems
1. Remove the */tmp/* directory from the list.
2. Add the following directories and save the file.
/tmp/*
/var/tmp/*
*/usr/tmp/*

• For Windows
1. Remove the */tmp/* directory from the list and save the file.
Return code 9 or 29 is displayed in the results of the Software Scan Status analysis.
The return code indicates that the scanner timed out. To solve the problem,
perform the following tasks:
• Increase the scan timeout in the Configure Scan Timeout task.
• Increase the amount of CPU that can be consumed by the scanner by
increasing CPU threshold in the Initiate Software Scan task.
• Exclude directories with backups from software scans.
• Decrease the scanner trace level in the Edit Scanner Trace Settings
task.
If all other options fail, reinstall the scanner.
An error occurs while importing contracts through REST API.
When using a curl command to import contracts through REST API, the
following error is displayed:
curl: (18) transfer closed with outstanding read data remaining

To solve the problem, upgrade curl to a later version:
Curl must use the NSS library 3.14, or later. Run curl --version. The
version of NSS is displayed in the output. Upgrade curl if the NSS version is
earlier than 3.14.

curl 7.19.7 (x86_64-redhat-linux-gnu) libcurl/7.19.7 NSS/3.14.0.
0
zlib/1.2.3 libidn/1.18 libssh2/1.4.2

Upgrade to curl 7.27.0, or later.
When you make an API call, the call fails and the following message is written in the
log: The connection is closed.
The problem occurs when you make an API during the import. To solve the
problem, wait until the import finishes and ensure that the BigFix Inventory
server is running. Then, repeat the API call.
The tema.log file contains the following error: E CWWKF0002E: A bundle could not
be found for com.ibm.ws.javaee.servlet.3.0/[1.0.0,1.0.100).

The error occurs after you enable single sign-on. There are no other problems
except for the errors in the log. To solve the problem, perform the following
steps:
1. Go to the BigFix Inventory installation directory and open the
wlpstart.bat file.
• Linux: /opt/ibm/BFI/wlp/bin/wlpstart.bat
• Windows: C:\Program Files\BigFix Enterprise
\BFI\wlp\bin\wlpstart.bat
2. Add the --clean parameter to the last line in the file.
call "%WLP_PATH%\bin\server.bat" start server1 --clean

3. Stop the server.
4. Start the server.
5. Verify that the errors no longer appear in the log and remove the -clean parameter from the wlpstart.bat file.

Emails with scheduled reports are not sent via email after the BigFix Inventory server
was upgraded.
To fix this problem, restart the BigFix Inventory server.

User interface problems
User interface problems in BigFix Inventory are mostly related to information that is
incorrectly displayed in the application or to errors that arise in the non-English-language
versions of the software. However, you can easily recover from these problems.
After restarting the computer, the BigFix Inventory user interface cannot be launched.
When you restart the computer on which you have BigFix Inventory installed,
you must start the DB2® database before starting the application. Otherwise,
you will not be able to log in to BigFix Inventory.
If you restart your computer, complete the following steps before starting the
application:
1. Switch to the DB2® instance owner:
su - db2inst1

2. Start the database:
db2start

3. Restart BigFix Inventory:
/etc/init.d/BFIserver restart

On a low-resolution monitor, the user interface is not displayed correctly.
The minimal supported screen resolution is 1360x768 pixels. Recommended
screen resolution is 1920x1080 pixels.
On Linux, text columns in reports are not alphabetically sorted.
Text columns in BigFix Inventory are sorted differently on Linux, and Windows.
If you click a column header, the values are sorted in a case-sensitive way
on Linux (all the names with capital letters are displayed first) and caseinsensitive on Windows (capitalized and non-capitalized words are mixed and
sorted in alphabetical order).

On the Catalog Audit report, the values are displayed in an incorrect time zone.
Values that are related to dates and time are based on the time zone that
is set in your operating system. However, the Daylight Saving Time is not
considered. Thus, values are set to an incorrect time zone.
When you leave a page while modifying data, there is no warning that the data will be
lost.
When you modify data, for example, in one of the panels from the Catalog
Customization menu, the data will be lost if you change the view or close the
page. No warning is displayed. Ensure that you save all data before navigating
to another view.
The Import is now running message is not refreshed even after the import is
complete.
The page with the Import is now running message is not refreshed and the
message is still displayed even when the import is complete. To solve this
issue, you can hover over the Reports menu and check the percentage status
of the import on the bottom of the drop-down list. You can also refresh the
page manually.
The PDF reports are missing a part of text or the font is incorrect.
To ensure that text in PDF is properly displayed, the following font families
or their substitutes must be installed in the operating system with BigFix
Inventory installation:
• Windows: Arial, Verdana
• Linux: Times, Lucida
Non-latin characters may require additional font familes, depending on
selected language:
• Windows: SimSun, Mongolian Baiti, Microsoft Yi Baiti, Microsoft
Himalaya, Batang, MS PMincho, Tahoma
• Linux: ZYSong, Baekmuk Batang, Kochi Mincho

Limitation: Style of latin and non-latin characters may be different.
The PDF reports open in the same browser tab as BigFix Inventory.
The generated PDF reports open in the same tab as BigFix Inventory. Because
of this issue, you might be forced to stop any activity in the application until
the PDF opens. To solve the issue, change the settings in your browser.
The PDF reports that are downloaded by using Firefox are corrupted.
Although the PDF reports are correctly displayed in the browser, the
downloaded file is corrupted. The problem occurs in Firefox. To solve the
issue, use a different browser.
Autocomplete suggests irrelevant results.
In some cases, autocomplete might suggest irrelevant results. For example,
when you type HCL® as a publisher and then start typing the software
product, autocomplete will list all possible software products instead of only
those that belong to HCL®.
When you open links to product details in new tabs, an error is displayed
When you open the All Metrics or the IBM PVU Subcapacity report and open
links to products that are displayed on these reports in new tabs, an error is
displayed. The problem occurs because information about the time range
for which the metric quantity should be displayed on the report is lost while
opening the links in new tabs. To solve the problem, refresh the page.
Paths for Korean and Japanese locales contain incorrect delimiter.
Paths for Korean and Japanese locales use a backslash (\) as a delimiter,
instead of won (₩) or yen.
There is a missing space before the colon (:) for French locale.
When a colon is used in text, there is a missing space before it although it is
required in French language.
The string on the Browse button on the Catalog Upload panel is not displayed in
languages other than English.

This error is caused by the web browser internal configuration and does not
depend on BigFix Inventory.
Some Chinese characters are not displayed correctly.
To solve the problem, install the Zhong Yi Song TrueType font for the GB18030
standard:
1. Obtain the fonts-chinese-zysong package.
2. Install the package by running the following command:
rpm -ivh fonts-chinese-zysong-0.1-5.el5.noarch.rpm --nodeps

The new font was installed in the /usr/share/fonts/zh_CN/TrueType
directory. The characters should now be displayed correctly.
Messages are displayed in multiple languages.
The language in which some of some messages are displayed depends on the
settings of the BigFix Inventory server. To change the language settings on the
server:
1. Open the jvm.options file that is in the
installation_directory/wlp/usr/servers/server1/
directory.
2. Add the following lines to the file and specify the language to be used.
-Duser.country=country
-Duser.language=language

For example:
-Duser.country=US
-Duser.language=en

3. Restart the server.
Names of roles and computer properties are not translated.

Starting from version 9.2.3, the language in which names of roles and
computer properties are displayed depends on the language that was chosen
during the installation of the BigFix Inventory server. For earlier versions, the
language depends on the language that was set in the web browser during the
creation of database connections after the installation.
If you need to change the language in which these items are displayed, you
must do it manually. To change the name of a role, go to Management > Roles,
select the role that is displayed in a wrong language, and change its name.
To change the name of a computer property, go to Management > Computer
Properties, select the property that is displayed in a wrong language, and
change its name. In both cases, wait for a scheduled import or run in manually
for the changes to take effect.
The changes that you make apply to all users regardless of their language
settings.
'We're sorry, but something went wrong.'
For more information about the error, check the server log file tema.log in
the installation_directory/wlp/usr/servers/server1/logs/
directory.
Migrated to SUA9 report column is blank.
When you migrate Software Use Analysis 2.2 endpoints to 9.2.16, the Migrated
to SUA9 column in your software inventory and computer reports is blank.
Check whether the SUA 2.2 Endpoint Migration analysis is activated.
1. In the BigFix console navigation tree, click Sites > External Sites > BigFix
Inventory v10 and click Analyses.
2. Select the SUA 2.2 Endpoint Migration analysis, right-click on it, and
then select Activate.
Unable to log in with users from Microsoft™ Active Directory
If you are having problems with your Active Directory users, append the user
name with a domain, for example username@domain.com. Adding a domain

is required starting from Software Use Analysis 9.2.0.2, but it also concerns
Active Directory servers that were configured in previous versions. See the
following cases for more information about how this change might impact
your existing users.
Active Directory with Global Catalog

• If you added users through User Provisioning in BigFix
Inventory, new users are created whenever you log in
with a user name and a domain. You can delete all Active
Directory users that have only the user name specified
because you will not be able to log in with those users.
• If you added users manually in BigFix Inventory, you must
create them again, this time also specifying the domain.
You can delete all Active Directory users that have only the
user name specified because you will not be able to log in
with those users.
Active Directory without Global Catalog

If you did not use the Global Catalog, you must have specified a
domain in the Search Base field. This domain is automatically
added to all users in BigFix Inventory and no action is required
from you.
URLs that point to the product web user interface do not work.

If you enabled single sign-on in BigFix Inventory, the link that
is available in the Start menu on Windows™ might not work
because an extra "https://" prefix is added to the url.
You can access this link on Windows™ 2008 by clicking Start
> All Programs > BigFix Inventory > Web Interface. This URL
is defined in the WebUI file that is in the following location: C:
\Program Files\ibm\BFI\admin\resources\WebUI.
To fix this issue:
1. Open the WebUI file in a text editor, for example Notepad+
+, and remove the extra "https://" from the beginning of
the URL.
Note: The default shortcut path is
https://localhost:9081. If LTPA SSO is enabled,

it needs to be updated to https://virtualjunction-host-name:9081.

2. Clear the cache in your web browser.
3. End all your browser processes.
4. Restart the system on which your browser is installed.
When opening an exported CSV report in Microsoft Excel, some data is corrupted.
Due to formatting issues in some versions of Microsoft Excel, the data might
be displayed in incorrect columns. This problem mostly concerns components
that have a comma in their name, which results in wrong formatting.
To fix this problem, complete the following steps.
1. Open Microsoft Excel.
2. In the navigation bar, click Open, and navigate to the folder that contains
your report.
3. Change the valid file extensions to All Files (*.*) to see the report.

4. Open the file.
5. In the Text Import Wizard, select Delimited, and then choose Comma as
a delimiter, and a quotation mark (") as a text qualifier.
After clicking Finish, the data will be divided among appropriate columns and
displayed correctly.
Loading any report takes substantial amount of time in case of huge deployments.
In case of huge deployments, it can take a lot of time to generate a full report.
Thus, if you do not need to view a full report as a default, you can use the work
around and filter the report to limit the list of items.
1. Open a report and wait until it loads.
2. Hover over the Manage Report View icon

, and click Configure View.

3. Set up adequate filters so that the report view is simple and limited to a
few entries and click Submit.
4. Hover over the Manage Report View icon

, and click Save As.

5. Name the report and save it as default.
This simple report that you created is now set as the default view. You no
longer need to wait for the full report to load. You can further filter the data to
view only the information that you require.
A new computer has an empty computer name and operating system in BigFix
Inventory
To solve the problem, go to BigFix console > Computers, right-click on the
computer and choose Send Refresh. Repeat the steps for 3 times. Then run
data import in BigFix Inventory.
Limitation in the Patronus input component on New/Edit Contract dialog box
There is a limitation on Patronus number input component. The limitation is that while
creating and editing contracts (New Contract/Edit Contract dialog box) in Firefox, you can
not type '-' (minus) character in the number input fields. You can type '-' (minus) character

in other browsers. This may lead to some inconsistencies in number input fields, such as
'Purchase Order Value' and numeric custom fields. In Firefox, you can use mouse wheel and
arrow keys to navigate through numbers in Number Input fields to enter negative numbers.

Logs and return codes
Find logs and interpret return codes to troubleshoot issues.

Database creation logs and return codes
The log file is automatically generated when you create a database during the initial
configuration of BigFix Inventory. The log file contains a return code that can help you check
why database creation or validation failed. The file is in the /tmp directory and has a time
stamp suffix, for example: /tmp/createdb_20131018-131841.
The log file is created only if you installed BigFix Inventory on Linux™ and use a
DB2® server.

Return codes
Check the return code to find the reasons for database creation problems.
Table 187. Return codes for the create database script
The table consists of two columns and 9 rows.
Return
code

Description and possible solutions

0

Database successfully created.

1

Help message is displayed, or incorrect syntax.

100

One or more errors occurred during the database creation. Database creation
error. Check the database creation log: creation log /tmp/createdb_latest_timestamp.

101

Database already created.

Table 187. Return codes for the create database script
The table consists of two columns and 9 rows.
(continued)
Return
code
102

Description and possible solutions
One or more errors occurred during the database validation. There is some
thing wrong with the DB2® commands run from the script. The script re
quires a correctly initialized DB2® environment.

103

The DB2® version could not be correctly read from the db2level command.
The db2level command returned the DB2® version string in an unexpected
format.

104

Unsupported database version. ®You can check the version by running the
db2level and db2licm -l commands as the SYSADM user.

105

An unsupported edition of the database was found in the system. You can
check the version by running the db2level and db2licm -l commands as the
SYSADM user.

127

Cannot run the db2 command. Incorrectly configured DB2® instance. The
user that runs the script must have SYSADM authority. Try to run the script as
the DB2® instance owner.

Server installation and upgrade logs
Installation and upgrade log files are in the same directories, because those processes
are completed by using the same installer. If you encounter any problems while installing
or upgrading the server, refer to those log files for more information about any occurring
errors.

Log files
There are several log files that are created either during the installation or upgrade, or only
when the process failed or completed successfully. Each path starts with a variable that is
specific to the operating system. Those variables are explained below the table.
Table 188. Installation and upgrade log files
Instal
lation
Status

Windows

Linux

In

%USERPROFILE%\BFI_9.2.16

$HOME/BFI_9.2.16

progress

%USERPROFILE%\ia.log

$HOME/ia.log

BESclient_installation_-

BESClient_installation_di-

directory\LMT\BFI_up-

rectory\LMT\BFI_upgrade.log

grade.log
Failed

%USERPROFILE%\BFI_9.2.16_- $HOME/BFI_9.2.16_timestamtimestamp_uniqueID_logs-

p_uniqueID_logs.tar.gz

.zip
Success

installation_directo-

ful

ry\BFI_9.2.16_timestamp_u- BFI_9.2.16_timestamp_uniqueID_logs.zip

installation_directory/

niqueID_logs.tar.gz

%USERPROFILE%
Home directory of the user who installed the server, for example C:\Users
\Administrator\.
Important: When you upgrade by using a Fixlet, the upgrade runs
under the NT AUTHORITY\SYSTEM user whose default home directory is
C:\Windows\System32\config\systemprofile\.

$HOME
Home directory of the user who installed the BigFix client, for example /
root/.

Log file contents
To understand the root cause of installation and upgrade problems, review logs for
messages with a severity level of WARN or ERROR. The following example shows a warning
message.
<Message Id="CODIN0215W" Severity="WARN">
<Time Millis="1381929782997"> 2013-10-16 15:23:02.997+02:00</Time>
<Server Format="IP">NC040226.kraklab.pl.ibm.com</Server>
<ProductI>dCOD</ProductI>d
<Component>Install</Component>
<ProductInstance></ProductInstance>
<LogText><![CDATA[CODIN0215W The following ports are in use: 9081, .
The installation process can be continued but the server will not be
started.
The server has to be started manually after resolving the ports
conflict.]]></LogText>
<Source
FileName="com.ibm.license.mgmt.install.ia.common.CommunicationCommon"
Method="okToContinue"/>
<TranslationInfo Type="JAVA" Catalog="userLocales.InstallMessageEWI"
MsgKey="checkPorts">
<Param><![CDATA[9081, ]]></Param></TranslationInfo>
<Principal></Principal>
</Message>

To learn more about errors and return codes that can appear in the logs, go to Server
installation and uninstallation return codes.

Server installation and uninstallation return codes
If the server installation or uninstallation fails, check the return code to learn about the
reason of the problem and possible solutions.
Table 189. Server installation and uninstallation return codes
Return
code

Possible cause and solutions

0

The server was installed successfully.

5

An unexpected error occurred.

6

An unexpected exception occurred.

7

An internal error occurred. The installer failed to save the file with information
that was collected or generated during the preinstallation stage.

8

The installation was canceled.

9

A post-installation step was terminated before it was finished. Problems with
resuming the installation might occur.

11

Validation of the communication ports failed. Either the same port is speci
fied for more than one parameter or the specified port is in use. If you want
to specify a port that is temporarily used but will be available later, set the
RSP_DISABLE_COMMUNICATION_WARNINGS parameter to true. For more
information, see: Server installation response file.

13

Validation of the license agreement, or the file path failed. Either the license
agreement was not accepted, the path to the installation response file is not
absolute, or the command is too long. To accept the license agreement, set
the RSP_LICENSE_ACCEPTED parameter to true.
If the problem persists, ensure that you provided an absolute path to the re
sponse file, or move the files to a different directory to shorten the command,
for example /root/BFI or C:\BFI.

Table 189. Server installation and uninstallation return codes (continued)
Return
code
14

Possible cause and solutions
There is not enough space for the installation. To check how much free disk
space is required to proceed with the installation, see the following installa
tion log: installation_dir/BFI_9.2_timestamp_logs.tar.gz.

18

Validation of the installation path failed. The specified path is incorrect or the
installation directory is read-only.

20

An unknown response file parameter was specified. Remove the parameter
from the installation response file.

21

The response file was not found. It is either empty or contains Windows™ line
endings instead of UNIX™ ones.

23

The command-line interface or another application from the BigFix Inventory
installation path is still running. End the process manually or set the RSP_AU
TO_CLOSE_PROCESSES parameter to true.

26

An internal error occurred. Creation of the log directory failed.

27

It was impossible to recognize the environment, for example, installed prod
ucts.

28

The upgrading scenario is not supported.

29

A part of BigFix Inventory that is already installed, is corrupted.

30

The uninstallation wizard could not find product information in registries. Big
Fix Inventory was already uninstalled.

31

The host name was not obtained. To verify the host name, in the com
mand-line interface, enter the following command:
nslookup host_name

32

An exception was detected while reading the setup.ini file.

Table 189. Server installation and uninstallation return codes (continued)
Return
code

Possible cause and solutions

33

An attempt of creating a log directory in the installation path failed because a
file called BFI9.2 already exists. To proceed with the installation, delete the
file.

34

The log directory is read-only.

35

The system TEMP environment variable does not point to a valid directory.

36

Installation in console mode is not supported. Use interactive or silent mode.

37

The required resources could not be extracted from the installation image.

38

The required resources could not be found inside the installation image.

41

The post-installation failed.

42

Another instance of the installer is already running.

46

The post-installation was interrupted.

50

Resuming a failed installation in silent mode is not supported.

55

All elements of the infrastructure are already installed.

59

An internal error occurred. Contact IBM® support.

74

The previous installation or upgrade has not been finished successfully.

208

The installation could not finish because of the NOEXEC on the tmp directo
ry. If all installation steps are completed, no further action is required. Other
wise, remove NOEXEC from the tmp directory or specify a new tmp directory in
the following environment variable: IATEMPDIR. For example, mkdir /root/
Install_tmp; export IATEMPDIR=/root/Install_tmp. Next, repeat the in

stallation.
214

The uninstallation process could not connect to the X server. Verify that the
DISPLAY variable is properly set and points to a working X server.

TASK
Uninstalling the server on Windows in interactive mode
Uninstalling the server on Windows in silent mode
TASK
Uninstalling the server on Linux in silent mode
Uninstalling the server on Linux in interactive mode

Software scan return codes
If the software scan fails, an error code that indicates why the scan failed is returned. Check
what is the possible cause of scan failure that is indicated by each code and how to solve
the problem.

Locating the return codes
The error codes for the software scan are returned in the results of the Software Scan
Status analysis.

The Software Scan Status describes values for:
• Status of Catalog-based Scan
• Status of File System Scan
• Status of Scan for Software Identification Tag Files
• Status of Scan for Package Data
• Status of Resource Utilization Scan
All above property reads the code from the file created during Software Scan. (Initiate
Software Scan and then background runcit_sw.sh/.bat). For example, for Catalog Scan –
file is named: catalog_scan_status.info

Possible Status Messages
Software Scan Status reads the codes
Displayed Sta

Code in file

Meaning

Not supported

N/A

Given endpoint is not supported

Running

0

Scan in progress or terminated without updat

tus

ing the status
OK

1

Failed (return

2:<RC>

Scan returned with error. Error as reported by

code: <RC>)

2:5

Scanner/CIT. See also, Software scan return

2:255

Expected file to execute has been not found.

Failed (return

codes.

code:5)
Failed (return
code: 255)
Failed: (return
code: 9009)

Issue with previous step.
2:9009

Expected file to copy / move has been not
found. Issue with previous step.

Displayed Sta
tus
Upload Failed

Code in file

Meaning

N/A

Check MaxArchiveSizeExceeded on the end
point

Invalid archiver

9

There is an issue with 7za.exe/pack.cmd on
Windows or bzip2 on other platforms

No information

N/A

missing .info file for scan

Inspector inter

N/A

BigFix interrupted evaluation of the relevance

rupted

due to timeout. If problem persist reach sup
port, relevance might need optimization. Big
Fix does not received the result of given prop
erty. Consider using "Force Refresh" on the
endpoint to get complete report.

Property not

N/A

found

BigFix does not received the result of given
property. Consider using "Force Refresh" on
the endpoint to get complete report.

4: <RC>

4: <RC>

Indicates issue with use of command move
on Windows boxes
• -1073740791 - STATUS_STACK_
BUFFER_OVERRUN
• -1073741571 – file system error
• -1073741819 – file system error

<error>

<error>

Issue with Relevance evalution

Software scan return codes
Re
turn
code
0

Possible cause and solutions
No errors.

1

Scan data was not gathered. To verify what is the cause of the prob
lem, go to the computer where the problem occurred, open the command
prompt and run the following command.
cscript

The command should return one of the following errors.
•

'cscript' is not recognized as an internal or external
command, operable program or batch file.

The message indicates that the Windows cscript is not recognized
as an internal or external command, operable program or batch file. To
solve the problem, perform the following steps. The exact steps might
differ depending on the version of Windows that you are using.
1. On the computer where the problem occurred, open the Control
Panel, and go to System and Security > System > Advanced sys
tem settings.
2. Click Environment Variables.
3. In the Path field variable, add ;C:\windows\system32.
4. Restart the BigFix client.
•

CScript Error: Can't find script engine "VBScript" for
script ...

The message indicates that the Windows VBScript.dll script is not
registered. To solve the problem, perform the following steps.

Re
turn
code

Possible cause and solutions
1. On the computer where the problem occurred, click the Start but
ton, and type cmd. In the search results, right-click the Command
Prompt, and click Run as administrator.
2. In the command prompt, type %windir%\system 32, and press En
ter.
3. Type regsvr32 vbscript.dll, and press Enter.
4. Type regsvr32 jscript.dll, and press Enter.
If the registration completed successfully, the following message is dis
played: DllRegisterServer in vbscript.dll succeeded.

2

The scanner configuration file is corrupted. Reinstall or upgrade the scanner.
• Installing the scanner (BigFix scenario)
• Updating the disconnected scanner (disconnected scenario)

3

A signature file could not be parsed. Update the scanner catalog on the end
points where the problem occurred.

4

Scan output file could not be saved to the output directory. Ensure that the
scan output directory is writable. By default, the directory is:
/var/opt/BESClient/LMT/CIT
C:\Program Files (x86)\BigFix Enterprise\BESClient\LMT\CIT

5
6

File system scan result is empty.
Scanner catalog does not exist on the endpoint. Update the scanner catalog
on the endpoints where the problem occurred.

8

Scanner internal error occurred. Gather scanner logs and contact BigFix Sup
port. By default, the log files are in the following directory:

Re
turn
code

Possible cause and solutions
/usr/ibm/tivoli/common/CIT/logs or /var/ibm/
tivoli/common/CIT/logs
/etc/cit/logs
C:\Program Files\ibm\tivoli\common\CIT\logs

9

The scanner timed out. Perform the following tasks:
• Increase the scan timeout in the Configure Scanner Query Timeout task.
• Increase the amount of CPU that can be consumed by the scanner by in
creasing CPU threshold in the Initiate Software Scan task.
• Exclude directories with backups from software scans. For more infor
mation, see: Excluding directories from being scanned.
• Decrease the scanner trace level in the Edit Scanner Trace Settings task.
If all other options fail, reinstall the scanner.

10

The scanner is being upgraded. Wait until the upgrade finishes.

11

Scan output file or directory is read only. Ensure that the scan output file or di
rectory is writable for the user that is running the BigFix client. By default, the
directory is:
/var/opt/BESClient/LMT/CIT
C:\Program Files (x86)\BigFix Enterprise\BESClient\LMT\CIT

12

The cit.ini file was not found. Install the scanner. By default, the cit.ini
file is located in the following directory:
/etc/cit
C:\Windows\cit

13

The scanner configuration file was not found. Reinstall or update the scanner.

Re
turn
code

Possible cause and solutions

14

The scanner trace file was not found. Reinstall or update the scanner.

15

Failure to read or write CIT configuration files (incorrect values being written,

16
17
18

corrupt files or incompatible with the scanner). Reinstall or upgrade the scan
ner.
One of the scanner files could not be open. Ensure that the administrator or
root of the computer on which the problem occurred has the read and write
permissions to the following files:
• Scanner configuration file CitHWConfig.xml, scanner properties file
Cit.properties, and scanner trace file CitTrace.properties,
which by default are in the following directory:

19

◦

/opt/tivoli/cit/config/

◦

C:\Program Files\tivoli\cit\config

One of the scanner files could not be renamed. Ensure that the administrator
or root of the computer on which the problem occurred has the read and write
permissions to the following files:
• Scanner configuration file CitHWConfig.xml, scanner properties file
Cit.properties, and scanner trace file CitTrace.properties,
which by default are in the following directory:

20

◦

/opt/tivoli/cit/config/

◦

C:\Program Files\tivoli\cit\config

One of the scanner files could not be deleted. Ensure that the administrator or
root of the computer on which the problem occurred has the read and write
permissions to the following files:

Re
turn
code

Possible cause and solutions
• Scanner configuration file CitHWConfig.xml, scanner properties file
Cit.properties, and scanner trace file CitTrace.properties,
which by default are in the following directory:
◦

/opt/tivoli/cit/config/

◦

C:\Program Files\tivoli\cit\config

21

The scanner configuration file is corrupted. Reinstall or upgrade the scanner.

22

The scanner trace file is corrupted. Reinstall or upgrade the scanner.

24

Invalid parameter value in SW or FS scanner configuration (SW scanner, FS

25

scanner). Reinstall or upgrade the scanner.

26
27
28

A required shared library file is not available. Reinstall or upgrade the scanner.

29

The scanner timed out. Perform the following tasks:
• Increase the scan timeout in the Configure Scanner Query Timeout task.
• Increase the amount of CPU that can be consumed by the scanner by in
creasing CPU threshold in the Initiate Software Scan task.
• Exclude directories with backups from software scans. For more infor
mation, see: Excluding directories from being scanned.
• Decrease the scanner trace level in the Edit Scanner Trace Settings task.
If all other options fail, reinstall the scanner.

30

The scanner query failed. Gather scanner logs and contact BigFix Support.

31

The scan process was interrupted. Stop the scan action that is running on the
endpoints where the problem occurred and start the scans again.

Re
turn
code

Possible cause and solutions

36

The scanner configuration file is corrupted. Reinstall or upgrade the scanner.

37

Scanner internal error occurred. Gather scanner logs and contact BigFix Sup
port.

40

An error occurred while creating the warning file during the software scan. En
sure that the administrator or root of the computer on which the problem oc
curred has the read and write permissions to the following directory:
/var/opt/BESClient/LMT/CIT
C:\Program Files (x86)\BigFix Enterprise\BESClient\LMT\CIT

41

Scanner process initialization failed. Gather scanner logs and contact BigFix
Support.

42

The signature catalog schema cannot be found. Reinstall or update the scan
ner. If it does not help, gather scanner logs and contact .

49

The user that runs the scan does not have the read permission to the scanner
properties file cit.properties. Ensure that the administrator or root of the
computer on which the problem occurred has the read permissions to this file.
By default, the file is in the following directory:
/opt/tivoli/cit/config/
C:\Program Files\tivoli\cit\config

51

The scanner configuration file was not found. Reinstall or upgrade the scan
ner.

52

Scanner internal error occurred. Gather scanner logs and contact BigFix Sup
port.

53

The scanner configuration file is invalid. Reinstall or upgrade the scanner.

Re
turn
code
54

Possible cause and solutions
The scan file cannot be compressed. Ensure that the administrator or root of
the computer on which the problem occurred has the read and write permis
sions to the following directory:
/var/opt/BESClient/LMT/CIT
C:\Program Files (x86)\BigFix Enterprise\BESClient\LMT\CIT

56

The scan output signature file cannot be created. Ensure that the administra
tor or root of the computer on which the problem occurred has the read and
write permissions to the following directory:
/var/opt/BESClient/LMT/CIT
C:\Program Files(x86)\BigFix Enterprise\BESClient\LMT\CIT

57

Failure to load a scanner plugin. Possibly corrupt installation. Reinstall or up
grade the scanner.

125

Scanner memory allocation issue. Check if Cache Optimization is enabled and
scanner is up-to-date.

Return codes greater than 128
Some return codes are triggered by the problems that are signaled by the
operating system. These are the return codes greater than 128. To check what is the system
signal, use the following calculation:
return code - 128 = operating system signal

To identify the issue, check the meaning of the signal in the operating system
documentation.

The following table presents the list of the most common return codes, their possible cause
and solution.
Table 190. Scanner return codes greater than 128
Return code
134

Possible cause

Signal
6 - SIGABRT

and solution
There might not be enough
memory available for the
process to work. Increase
the memory limit for this
process by changing ulimit
for data seg size: ulimit
-d. If the problem persists,

contact BigFix Support.
138

10 - SIGBUS

There is not enough disk
space on the computer.
Free some disk space. If
the problem persists, en
sure that you use the latest
version of the scanner.

139

11 - SIGSEGV

There might not be enough
memory available for the
process to work. Increase
the memory limit for this
process by changing ulimit
for data seg size: ulimit -d. If the problem per

sists, contact BigFix Sup
port.

Table 190. Scanner return codes greater than 128 (continued)
Return code

Possible cause

Signal

255

and solution
Expected file to execute
has been not found. Issue
with previous step.

Platform specific errors / windows
Below table explains the Windows error return codes:
Return code
1260

Possible cause and solution
Windows cannot open this program because it has been prevented by
a software restriction policy. It is recommended to update the system
with latest patches.

Capacity scan return codes
If the capacity scan fails, an error code that indicates why the scan failed is returned. Check
what is the possible cause of scan failure that is indicated by each code and how to solve
the problem.

Locating the return codes
If the capacity scan fails, first check whether the return code is related to the scanner, or
to running the checkCapacityScanOutput.vbs script. If the log refers to the script,
the return code is specific for the script. It indicates that the capacity scan results are
incomplete. The problem is usually solved after the next scan or after the upgrade of the
scanner to the latest version.
Check for the error codes:

• The scanner error codes for capacity scan are written in the BigFix client logs. The
logs are stored in the following locations:
◦

/var/opt/BESClient/__BESData/__Global/Logs

◦

C:\Program Files (x86)\BigFix Enterprise\BESClient
\__BESData\__Global\Logs

• To check the error codes that are related to running the
checkCapacityScanOutput.vbs script, check the Run Capacity Scan and Upload
Results action in the BigFix console. On the Computers tab, identify the computer on
which the action failed by checking its status. Double-click this computer. The error
code is written in execution details.

Capacity scan return codes
Table 191. Capacity scan return codes
Re
turn
code

Possible cause and solutions

0

No errors.

1

Wrong arguments were used during the capacity scan. Ensure that the capaci
ty scan is triggered with an official fixlet.

2

The scan configuration file is corrupted. Update the fixlet site.

5

The user that runs the scan does not have read permission to the scanner
configuration file. Ensure that the BigFix client is running as SYSTEM user on
Windows, or root for other operating systems.

8

Scanner internal error occurred. Gather scanner logs and contact HCL Sup
port. By default, the log files are in the following directory:
/usr/ibm/tivoli/common/CIT/logs
C:\Program Files\ibm\tivoli\common\CIT\logs

Table 191. Capacity scan return codes (continued)
Re
turn
code

Possible cause and solutions
If the logs are not in the default directory, check the value of the common_trace_path parameter in the following file for information about the loca
tion of the logs:
/opt/tivoli/cit/config/Cit.properties
C:\Program Files\tivoli\cit\config\Cit.properties

11

Scan output file or directory is read only. Ensure that the scan output file or di
rectory is writable for the user that is running the BigFix client. By default, the
directory is:
/var/opt/BESClient/LMT/CIT
C:\Program Files (x86)\BigFix Enterprise\BESClient\LMT\CIT

13

The scanner configuration file was not found. Reinstall or update the scanner.

18

One of the scanner files could not be open. Ensure that the administrator or
root of the computer on which the problem occurred has the read and write
permissions to the following files:
• Scanner configuration file CitHWConfig.xml, scanner properties file
Cit.properties, and scanner trace file CitTrace.properties,
which by default are in the following directory:
◦

/opt/tivoli/cit/config/

◦

C:\Program Files\tivoli\cit\config

21

The scanner configuration file is corrupted. Reinstall or upgrade the scanner.

49

The user that runs the scan does not have the read permission to the scanner
properties file Cit.properties. Ensure that the administrator or root of the

Table 191. Capacity scan return codes (continued)
Re
turn
code

Possible cause and solutions
computer on which the problem occurred has the read permissions to this file.
By default, the file is in the following directory:
/opt/tivoli/cit/config/
C:\Program Files\tivoli\cit\config

54

The scan file cannot be compressed. Ensure that the administrator or root of
the computer on which the problem occurred has the read and write permis
sions to the following directory:
/var/opt/BESClient/LMT/CIT
C:\Program Files (x86)\BigFix Enterprise\BESClient\LMT\CIT

Return codes greater than 128
Some return codes are triggered by the problems that are signaled by the
operating system. These are the return codes greater than 128. To check what is the system
signal , use the following calculation:
return code - 128 = operating system signal

To identify the issue, check the meaning of the signal in the operating system
documentation.
The following table presents the list of the most common return codes, their possible cause
and solution.

Table 192. Scanner return codes greater than 128
Return code
134

Signal
6 - SIGABRT

Possible cause
and solution
There might not be enough
memory available for the
process to work. Increase
the memory limit for this
process by changing ulimit
for data seg size: ulimit
-d. If the problem persists,

contact BigFix Support.
138

10 - SIGBUS

There is not enough disk
space on the computer.
Free some disk space. If
the problem persists, en
sure that you use the latest
version of the scanner.

139

11 - SIGSEGV

There might not be enough
memory available for the
process to work. Increase
the memory limit for this
process by changing ulimit
for data seg size: ulimit
-d. If the problem persists,

contact BigFix Support.

Return codes related to the checkCapacityScanOutput.vbs script
Table 193. Return codes linked to the checkCapacityScanOutput.vbs script
p
Re
turn

Possible cause
Windows systems

code
1

2

3

4

5

A general VBS script error. The

Systems other than Win
dows
n/a

dows Script

disabled.

Host.

ComponentID is missing the Se-

Capacity scan output file Update the

rialNumber attribute in capacity

is missing the Physical- scanner to the

scan output file.

Processor section.

SerialNumber attribute in the ca

Capacity scan output file

pacity scan output file does not

is missing the Operat-

contain any value.

ingSystem section.

Capacity scan output file is miss

Capacity scan output file

ing the PhysicalProcessor sec

is missing the Lpar sec

tion.

tion.

Capacity scan output file is miss

n/a

Capacity scan output file is miss

n/a

ing the Lpar section.
7

Enable Win

Windows Script Host could be

ing the OperatingSystem section.
6

Solution

Capacity scan output file is miss

Capacity scan output file

ing the ComponentID section.

is missing the ComponentID section.

latest version.
For more infor
mation, see:
Installing the
scanner

Return codes of capacity scans on virtualization hosts
If the capacity scan that is run by using the Run Capacity Scan on Virtualization Hosts task
fails, an error code that indicates why the scan failed is returned. The code is presented
in the results of the Status of Capacity Scan on Virtualization Hosts analysis. Check what
is the possible cause of scan failure that is indicated by each code and how to solve the
problem.
Table 194. Return codes of capacity scans on virtualization hosts
Return code

Possible cause and solution

0

No errors.

20

Unsupported virtualization type. To solve the problem, perform the follow
ing steps:
• Verify that the computer on which you ran the task is a virtualization
host. If it is not, you do not need to run the task on this computer.
• Verify that the computer runs on a supported virtualization. If the vir
tualization is a supported version of PowerKVM, KVM x86, Citrix Hy
pervisor (formerly XenServer), contact BigFix Support. If it is a dif
ferent type of a supported virtualization, configure VM managers to
collect capacity data from these hosts. For more information, see:
Adding VM managers in central mode.

30

KVM virtualization architecture could not be recognized. KVM virtualization
was detected, but testing the virsh command to determine whether the ar
chitecture is x86 or Power failed. Contact BigFix Support.

40

Determining the number of processor sockets or cores failed. The returned
result is not a number. Contact BigFix Support.

50

No valid host UUID could be retrieved by using the xe, dmidecode, and
xl command. Verify that the UUID of the computer is correctly returned
by SMBIOS. If it is not correctly returned, contact the hardware vendor to
solve the problem.

Table 194. Return codes of capacity scans on virtualization hosts (continued)
Return code
Other codes

Possible cause and solution
If other codes are returned, check the run_vtech_scan.log log file
to learn running which command returned the code. The log file is in
the installation directory of the BigFix client, by default: var/opt/BESClient/BFI/vtech/run_vtech_scan.log.

Related information
Collecting capacity data from virtualization hosts for Xen and KVM

Import logs
Import logs contain information about the import of data from the BigFix server to BigFix
Inventory. They list steps related to the import process and show their status. Each action in
the log file is reported according to the UTC time zone, but the file also shows information
about the local time zone of your server.

The import log also shows a warning about

duplicate UUIDs (universally unique identifier).
The logs are stored in one of the following directories:
•

installation_directory/wlp/usr/servers/server1/logs/
imports

•

installation_directory\wlp\usr\servers\server1\logs
\imports

The log from the latest import is also accessible from the BigFix Inventory user interface.
To view the log, click Management > Data Imports. The last megabyte of the log data is
displayed in the web user interface.
To download an earlier version of the import log from the user interface, identify the table
row with the import that you are interested in, and click Download. The log file is saved in
the download directory of your web browser.

Log level
By default, the data import logging level is set to INFO. You can change the setting to
collect debug information about broken relationships, for example deleted component
relationships. To enable debug logging, go to Management > Advanced Server Settings, and
change the value of the debug_logging_for_imports parameter to true.
Enabling the debug logging level increases the size of the data import log, which might
lead to errors while displaying the log in the user interface. For more information, see
Troubleshooting.

Import statuses
Successful
The import finished successfully.
Incomplete
The import could not finish. It might happen when the BigFix Inventory server
is stopped during the import. Ensure that the server is running, check the
import logs, and rerun the import.
Failed

The import failed. Ensure that the BigFix server is running, check the import
logs, and rerun the import.

Time zone
The time of all actions saved in the import log file is specified according to the UTC time
zone. You can compare these actions to the local time zone of your server to learn when
exactly a particular action occurred. Information about your server time zone is written in
the beginning of the log file and is repeated every 1000 entries. The following examples are
the excerpts from the log file:

[INFO]: Local Server Time Zone is +0200 Europe/Warsaw

[INFO]: Local Server Time Zone is CurrentTimeZone=-300 (UTC-06:00)
DaylightBias=-60

Reviewing the import log
Review the following INFO messages in the import log to check how much data was
transferred during the import.
Summary for complex table
Informa

Items specified

tion about

in the import log

Infrastructure Computer items

Description
The total number of computers in your environment. A computer
is a system with a BigFix client that provides data to BigFix Inven
tory.

Software and
hardware

SAM::ScanFile items

The number of files that have input data for the following items:

Informa

Items specified

tion about

in the import log

Description
• File system scan information (SAM::FileFact items)
• Catalog-based scan information (SAM::CitFact items)
• Software identification tag scan information (SAM::Isotag
Fact items)

SAM::FileFactDelta items

The total count of information pieces about files that changed be
tween the last two full file system scans.

SAM::FileFact items

The total count of information pieces about files from all comput
ers in your environment (contained in the processed scan files).

SAM::CitFact items

The total count of information pieces from catalog-based scans
(contained in the processed scan files).

SAM::IsotagFact items

The total count of information pieces from software identification
tag scans (contained in the processed scan files).

Installed

SAM::PackageFact items

packages

The total count of information pieces about Windows™ packages
that were gathered by the package data scan.

SAM::UnixPackageFact items The total count of information pieces about UNIX™ packages that
were gathered by the package data scan.
Software us

SAM::AppUsagePropertyVal The total number of processes that were captured during scans

age

ue items

on the systems in your infrastructure.

Example:
INFO: Computer items: 15000
INFO: SAM::AppUsagePropertyValue items: 4250
INFO: SAM::ScanFile items: 30000
INFO: Delta changes applied on model SAM::FileFact: 0 rows
INFO: Number of computers processing delta file scan data: 0
INFO: SAM::FileFactDelta items: 0
INFO: Number of computers processing full file scan data: 16
INFO: Inserting new 28423 rows into SAM::FileFact

INFO: SAM::FileFact items: 15735838
INFO: SAM::IsotagFact items: 0
INFO: SAM::CitFact items: 149496
INFO: SAM::PackageFact items: 406687
INFO: SAM::UnixPackageFact items: 1922564

Server log file
The server log file tema.log is in the installation_directory/wlp/usr/servers/
server1/logs/ directory. The log file saves all actions related to the server and is the
primary source of information for troubleshooting purposes. Each action in the log file is
reported according to the UTC time zone, but the file also shows information about the local
time zone of your server.
Production.log is no longer created. All information is stored in tema.log.

Settings that you can modify
Logging properties are set in the server.xml file that is in one of the following directories:
•

installation_directory/wlp/usr/servers/server1

•

installation_directory\wlp\usr\servers\server1

You can change the following settings:
messageFileName
The server log file name. The default name is tema.log.
logDirectory
The server log file location. The default location is:
•

installation_directory/wlp/usr/servers/server1

•

installation_directory\wlp\usr\servers\server1

maxFileSize

The maximum size (in MB) that a log file can reach before it is rolled over. To
disable this attribute, set the value to 0. The default value is 10.
maxFiles
If an enforced maximum file size exists, this setting is used to determine the
maximum number of iterations of the server log file. If the log file reaches the
maximum size that is defined in the maxFileSize parameter, the remaining
messages roll over to another iteration of the file.

Log level
There are three options to maximize the log level information:
1. Performance log for data
Performance logs are automatically enabled. You can disable the log
using the query, update adm.control set value = 'false' where name =
'PERFORMANCE_LOGS_ENABLED'. To enable the log again, use the query, update
adm.control set value = 'true' where name = 'PERFORMANCE_LOGS_ENABLED'.

2. Debug log for data imports in Advanced Server setting. Change
debug_logging_for_imports parameter before you import the data.

Note: Enable the setting only when needed by the support team.
3. BigFix Inventory application debug logs
Modify jvm.options in one of the following directories:
•

installation_directory/wlp/usr/servers/server1

•

installation_directory\wlp\usr\servers\server1

To modify the file, perform these steps:
a. Change #-DTEMA_LOG_DEBUG=true to -DTEMA_LOG_DEBUG=true.
Note: To change the log level from DEBUG to any other level, change
the value of the parameter. For example, If the -DTEMA_LOG_DEBUG

parameter is enabled, DEBUG level is used. If the #-DTEMA_LOG_DEBUG
parameter is disabled, INFO level is used.
b. Restart BigFix Inventory.
After restarting, tema.log includes logs at DEBUG level.
Starting from version 10.0.9, BigFix Inventory Server TEMA_LOG_DEBUG
jvm.options flag is limited only to the application log. This allows to safely enable the
option without impacting the data import log. Data import log is controlled by Advanced
Server settings.

Time zone
The time of all actions saved in the log file is according to the UTC time zone. You can
choose to view these actions in your preferred time zone to analyze the cause. The server
time zone is mentioned the beginning of the log file and is repeated every 1000 entries. The
following examples are the excerpts from the log file:

[INFO]: Local Server Time Zone is +0200 Europe/Warsaw

[INFO]: Local Server Time Zone is CurrentTimeZone=-300 (UTC-06:00)
DaylightBias=-60

Enabling the logging of memory consumption
You can log information about the memory that is used by BigFix Inventory.
1. On the computer where the server is installed, go to one of the following directories,
and create or modify the server.env file.
•

install_dir/wlp/usr/servers/server1

•

install_dir\wlp\usr\servers\server1

2. Add the following variable to the file.

LOG_MEMORY=true
3. Restart the BigFix Inventory server.
Each log returns memory consumption information.
INFO: Memory Used,458MB,Memory Diff,0kB,Memory Committed,743MB,
DEBUG: SF = # <SAM::ScanFile
@values={:scan_file_id=>1, :file_size=>18681, :computer_id=>4,
:file_name=>"itsitsearch_0_3205710.xml.bz2"}>
INFO: Memory Used,460MB,Memory Diff,1835kB,Memory Committed,743MB,
DEBUG: Checking cache for /itsitsearch_0_3205710.xml.bz2

VM Manager tool return codes
If you encounter any problems while configuring or managing the VM Manager tool, refer
to the log files for more information about any occurring errors. The log files for the VM
Manager tool are in the following directories:
• Trace log files: BES Client\LMT\VMMAN\logs
• Installation log files: BES Client\LMT\VMMAN\logs\install
For more information, see: Log files.
The log file contains a return code that can help you check why the issue occurs and solve
the problem.
Table 195. VM Manager tool return codes
The table consists of two columns and 17 rows.
Return code

Description and possible solutions

0

No errors.

1

It failed to initialize the logs and the log files are not created. En
sure that the log4j2.xml file is located in its default directory:

Table 195. VM Manager tool return codes
The table consists of two columns and 17 rows.
(continued)
Return code

Description and possible solutions
/var/opt/BESClient/LMT/VMMAN/config/

C:\Program Files (x86)\BigFix Enterprise\BES Client\LMT\VMMAN\config\

Note: For BigFix Inventory version below 10.0.3, the log
file log4j.properties is used.
2

The security module did not start successfully. Ensure that
keys.jackes keystore is located in its default directory:
/var/opt/BESClient/LMT/VMMAN/keydb/
C:\Program Files (x86)\BigFix Enterprise\BES Client\LMT\VMMAN\keydb\

3

It failed to lock the .lock file. When the file is locked, it means
that the application is working properly. Locking the file might
fail because the application is already running or because some
other process is blocking the file. To solve the issue, find the
process that is blocking the .lock file and stop it.

4

The used command is incorrect. Follow the displayed instruc
tions and type the correct command.

5

It is not possible to read the configuration files. Ensure that the
following folder contains all configuration files and that they are
correct:
/var/opt/BESClient/LMT/VMMAN/config/

Table 195. VM Manager tool return codes
The table consists of two columns and 17 rows.
(continued)
Return code

Description and possible solutions
C:\Program Files (x86)\BigFix Enterprise\BES Client\LMT\VMMAN\config\

6

The command did not complete successfully. For more informa
tion, check command output and the log file.

7

The application did not start in running mode because the ser
vice is not installed. Run the command -install and install the
service.

8

The service did not start in running mode. For more information,
check the log file.

10

It failed to connect to VM Manager using the command test
connection. For more information, check the command output.

12

It was not possible to add the VM Manager certificate to the key
store. The alias that was used to create the certificate already
exists. Use another alias.

13

Adding the certificate did not complete successfully. For more
information, see the log files.

14

It failed to change the password for keystore. For more informa
tion, check the command output and log files.

15

It is not possible to regenerate the encryption key for VM Man
ager. For more information, check the command output and log
files.

16

The command run once did not perform any action because
there are no VM Managers defined.

Changing and analyzing scanner trace settings
You can change the scanner trace settings to collect diagnostic data to help in investigating
problems.

Changing scanner trace settings
If requested by HCL® support or to limit the amount of traces generated by the scanner
tool, you can change the scanner trace settings.
1. Log on to the BigFix console.
2. In the navigation tree, click Sites > External Sites > BigFix Inventory v10 > Fixlets and
Tasks.
3. Select Edit Scanner Trace Settings, specify the following values:
• Trace level
• Number of trace files
• Trace file size
In the lower pane, click Take Action.
4. To select a subset of computers on which you want to create the capacity
configuration, open the Target tab, and then click the computers.
Table 196. Trace level values
Supported trace level
Value on Scanner
Level / Analysis
MIN

Value on “Edit
Scanner Trace

Description

Settings” fixlet
DEFAULT

Only errors are traced. This is the de
fault value.

MID

VERBOSE

Errors, entry and exit points are traced.

MAX

<Not available>

All traces are enabled.
This scanner value has a negative im
pact on stability and duration of the
scan. It is not recommended for use.

Value on Scanner
Level / Analysis

Value on “Edit
Scanner Trace

Description

Settings” fixlet
In BigFix Inventory version 10.0.5 and
higher, this option is removed from the
list of “Edit Scanner Trace Settings”
fixlet.

Note: The trace level values appear as Min and Mid in the log and properties
file where Min represents Default and Mid represents Verbose.
In disconnected scanner folder there is a script, setcfg.bat in windows and
setcfg.sh on unix systems. When you run this script, it shows help screen

with instruction and requests for new values to be set. You can set the new
value or enter '0' to reset the parameter to default. You can also press ENTER
to skip setting the value. After you finish this step, it shows the amount of
disk space required by all log files. Another way to run the script is to use
a parameter, such as ./setcfg.sh -r. This script resets all parameters to
default.

Analyzing scanner trace settings
You can check scanner trace settings for computers, and see the number of trace files and
trace file size.
1. Log on to the BigFix console.
2. In the navigation tree, click Sites > External Sites > BigFix Inventory v10 > Analyses.
3. In the upper-right pane, select an Scanner Trace Settings analysis, and in the lowerright pane, click the Result tab.
For each endpoint, you can view the following information:
• Computer host name
• Computer ID
• Trace level

• Number of trace files
• Trace file size

Checking why a fixlet or task is not relevant
Available from 9.2.1. When a fixlet or task is not relevant on a particular endpoint,
you can create an analysis that checks which part of the relevance expression is not
matched. This way, you can identify the exact reason why the fixlet or task cannot be run on
an endpoint and troubleshoot the problem.
1. In the navigation tree of BigFix, click Sites > External Sites > BigFix Inventory v10 >
Fixlets and Tasks.
2. In the upper right pane, select Analyze the Relevance of a Fixlet or Task.
3. Choose the fixlet or task that you want to analyze. Then, click Create Analysis.

4. Optional: In the window that opens, you can change the display name of the analysis
or decide whether the analysis is activated automatically.

5. To create the analysis, click OK.
By default, the analysis is created in the Master Action site and is activated globally.
6. Open the Master Action site and click Analyses.
7. In the upper right pane, select Relevance Check for the name Task/Fixlet from the
BigFix Inventory Site and open the Results tab. The part of the relevance expression
that causes that the fixlet or task is not relevant on a particular endpoint has the value
False.

In this example, the second and third part of the relevance is not matched and thus
causes that the entire task is not relevant.

8. When you know which part of the relevance expression is not matched, open the
Details tab to see the content of the relevance.

In this example, the task is not relevant for two reasons. First, the targeted endpoint
does not meet the operating system requirements (relevance 2). Second, the directory
SUA_Server_Path/properties/version or SUA_Server_Path/iso-swid
does not exist on the endpoint or the latest software catalog is already available on
that endpoint (relevance 3).

When you know the exact reason why a fixlet or task is not relevant on an endpoint, you can
troubleshoot the problem.
The analysis is created in the Master Action site and thus is activated on all endpoints that
report to BigFix, not only the endpoints that are subscribed to the BigFix Inventory site. To
avoid performance issues, deactivate the analysis when you identify and troubleshoot the
problem with the relevance of a fixlet or task. To deactivate an analysis, right-click it and
click Deactivate.

Removing the server manually
If you encounter any problems with uninstalling the BigFix Inventory server, you can remove
it manually.
1. Run the following command to verify that the process associated with the server is
running:
ps -ef | grep <installation dir>/cli | grep server1

Tip: The ID of the process is the number next to the user name.
2. End the process by running the following command:
kill -9 <process ID>

3. Remove the directory in which you installed BigFix Inventory:
rm -rf <installation dir>

For example:
rm -rf /opt/BFI

4. Edit the .com.zerog.registry.xml file that is in the /var directory. If you
installed the server as a non-root user, the registry file is in $HOME/.
5. In the registry file, locate the entries that are related to BigFix Inventory. Remove the
entries that represent the product and all the related components. You can recognize
them by the product name and a common file path. If the registry file contains entries
only for BigFix Inventory, you can delete the whole file.

TASK
Uninstalling the server on Windows in interactive mode
Uninstalling the server on Windows in silent mode

TASK
Uninstalling the server on Linux in silent mode
Uninstalling the server on Linux in interactive mode

Checking the client installation date
You can create a property on your BigFix server that enables the date when your endpoints
first connected to the server.
This procedure might be useful if you are using an automated tool to silently install many
BigFix clients. To verify that the clients were installed and check their installation dates, you
can add a column that shows the dates when your clients first connected to the server.
1. Create a property on your BigFix server that enables the new column:
a. Log in to the BigFix console.
b. Click Tools > Manage Properties, and then click Add New.
c. In the Name field, enter First Report Time.
d. In the Relevance field, enter the following relevance expression:
(month of it as two digits & "/" & day_of_month of it as two
digits & "/" & year of it as string)
of date (local time zone) of (minimum of subscribe times of
sites)

Note: The preceding expression changes the date format to DD/MM/
YYYY, which makes it suitable for sorting in a CSV format. If you want to

keep the default format (Mon, 1 Jan 2014), use the following relevance
expression: minimum of subscribe times of sites.
e. In the Evaluate field, choose 12 hours.

f. Click OK. The new column can be viewed in the Computers page.
2. Optional: Add the created column to Web Reports where your data can be viewed as
reports, or exported to a CSV or PDF format:
a. Log in to Web Reports.
Tip: You can access Web Reports under the following web address:
http://BigFix_server_hostname/webreports.
b. Click Explore Data.
c. In the Computer section, click Edit Columns, and then select the First Report
Time column.
d. Click Save Report.
e. Optional: To export your report, click Export to CSV or Export to PDF.

Changing the PVU per core value
Available from 9.2.3. The number of processor value units is assigned per
processor core based on the information that is provided in the PVU table. It might happen
that the value that is assigned to a processor in your environment is incorrect. In such case,
manually change the PVU per core value to ensure that subcapacity licenses are properly
calculated. When the problem that causes incorrect detection of the PVU value is solved,
reset the PVU per core to the value that is specified in the PVU table.
You must have the Manage Hardware Inventory permission to perform this task.
The Manually Adjust the PVU per Core Value fixlet that was used in earlier versions of BigFix
Inventory is deprecated. The PVU per core value can now be changed on the Hardware
Inventory panel. If you previously changed the PVU per core value on some computers by
using the fixlet, run the deprecated fixlet on these computers to remove the adjustment. Do
it to avoid a situation in which the PVU values changed by the fixlet overwrite the values that
you specify on the Hardware Inventory panel.

To properly calculate PVU values for Linux on IBM Power Systems, set the PVU per core
value to 70.
1. In the top navigation bar, click Reports > Hardware Inventory.
2. Click the pencil in the PVU per Core column, and click Change PVU per Core.
Note: The pencil is not available for computers with the No Scan Data status.
Capacity data is not available for such computers, and thus it is not possible
to determine whether the PVU per core value was properly assigned or
requires changing.

3. Provide the PVU value that you want to assign to the processor.
It will be changed for the server that is listed in the Server ID column and all virtual
machines that are hosted on that server.
Important: Ensure that you provide a correct PVU per core value as it affects
your PVU reports. In case of doubts, contact BigFix Support for guidance.
4. Provide a justification for changing the PVU value, for example a support case
number. The justification is listed on the Audit Trail report. Then, click Change.
The changed PVU per core value is displayed on the Hardware Inventory report. To reflect
the change on other reports, recalculate the data. Open the All Metrics report, and click
Recalculate.
When the problem that causes incorrect detection of the PVU value is solved, reset the
changed PVU per core value to the value that is provided in the PVU table. To do this, click
the pencil in the PVU per Core column, and click Reset PVU per Core. Then, click Reset. The

PVU per core value is reset on the server that is listed in the Server ID column and all virtual
machines that are hosted on that server.

Updating scanner catalogs
Scanner catalogs are used by the scanner to discover software on the endpoints. The
catalogs are automatically updated after each import of the BigFix software catalog. Use
this procedure only if the automatic update of the scanner catalogs fails.
Before you force the update of scanner catalogs, ensure that the following requirements are
met.
• The BigFix Inventory server is visible to the BigFix server.
• If Secure Socket Layer (SSL) is enabled in BigFix Inventory, the BigFix server
recognizes SSL certificates of BigFix Inventory as valid.
1. Check whether the action that automatically updates scanner catalogs was created.
a. Log in to the BigFix console.
b. In the navigation bar, click Actions.
c. In the upper-right pane, locate the Catalog Download (Version version) action.
The source of the action should be Master Operator Site.
2. If the action exists, check whether it failed due to prefetch problems. If it does not
exist, go to step 3.
a. Select the Catalog Download (Version version) action.
b. Open the Computers tab, and double-click a computer on which the status of
the action is Failed.

c. Check whether the reason of the failure is a problem with prefetching the
catalog.
Failed prefetch catalog.xml.bz2

If the status is Failed, communication between the BigFix server and the BigFix
Inventory server is blocked. Ensure that the servers can communicate. Then,
download the Catalog Download Fixlet to force the catalog update. If you cannot
change the configuration to allow communication between servers, edit the fixlet so
that the BigFix Inventory server can download catalogs from the BigFix server, and
then run the fixlet.
3. Download the fixlet for forcing the update of scanner catalogs.
a. Log in to BigFix Inventory.
b. In the top navigation bar, click Management > Catalog Upload.
c. Click the question mark sign

. Then, click Catalog Download Fixlet. Choose

the location where you want to save the catalog_download.bes file, and
click Save.
4. Optional: If the problem is caused by the lack of communication between servers,
edit the catalog_download.bes file and substitute the host_name and port of the
BigFix Inventory server with values that allow the server for downloading scanner
catalogs from the BigFix server.
prefetch catalog.xml.bz2
sha1:24dcb13c743f2f92b0c5e9887e9df1d4491c4a66
size:398083
http://host_name:port/sam/catalogs/CIT_catalog_WINDOWS.xml.bz2
sha256:1e81c865d7fc96468649dbd5c334a2d77b12c5dd252671e22a7e5df0bd7ccbb
e

Important: Change the host_name and port for all catalogs.
5. Upload the catalog_download.bes file to the BigFix console and run the Catalog
Download (Version: version) fixlet.

a. Copy the file to the computer where the BigFix console is installed.
b. Log in to the BigFix console.
c. To import the file to the console, click File > Import.
d. Open the directory where you store the catalog_download.bes file, select
the file, and click Open. The file is imported.
e. In the left pane, click Sites > Master Action Site > Fixlets and Tasks. The list of
available fixlets opens in the upper right pane.
f. Select Catalog Download (Version: version), and click Take Action.
g. Select computers on which you want to run the fixlet, and click OK.
6. Wait for the next scheduled software scan and import of data or run these actions
manually. For more information, see: Initiating software scans and Scheduling imports
of data.
7. Optional: If the problem is not solved, manually copy the catalog files from the BigFix
Inventory server to the BigFix server.
a. Log in to the computer where the BigFix Inventory server is installed and go to
the following directory.
•

/opt/BFI/wlp/usr/servers/server1/data/sam/
public/catalogs

•

C:\Program Files\IBM\BFI\wlp\usr\servers
\server1\data\sam\public\catalogs

b. Copy the following files to a temporary folder on the computer where the BigFix
server is installed.
• CIT_catalog_AIX.xml.bz2
• CIT_catalog_HPUX.xml.bz2
• CIT_catalog_I5OS.xml.bz2
• CIT_catalog_LINUX.xml.bz2
• CIT_catalog_SUN.xml.bz2
• CIT_catalog_WINDOWS.xml.bz2
c. Open the catalog_download.bes file that you downloaded in step 3 in a text
editor, and check the sha1 value for each catalog file.

For example, the sha1 value for the catalog on Windows is
24dcb13c743f2f92b0c5e9887e9df1d4491c4a66.
prefetch catalog.xml.bz2
sha1:24dcb13c743f2f92b0c5e9887e9df1d4491c4a66
size:398083
http://host_name:port/sam/catalogs/CIT_catalog_WINDOWS.xml.bz2
sha256:1e81c865d7fc96468649dbd5c334a2d77b12c5dd252671e22a7e5df0bd
7ccbbe

Change the names of all catalog files to their sha1 values.
d. Copy the renamed catalog files to the following directory.
•

/var/opt/BESServer/wwwrootbes/bfmirror/
downloads/sha1

•

C:\Program Files (x86)\BigFix Enterprise\BES
Server\wwwrootbes\bfmirror\downloads\sha1

e. Wait for the next scheduled software scan and import of data or run these
actions manually.
Scanner catalogs are imported to the computers in your infrastructure and are used to
discover the installed software.

Install or Upgrade Scanner in private mode on windows
If the catalog is not propagated to the scanner that is installed in the private mode, you have
to run the 'Update Catalog Download fixlet templates on BFI server' fixlet. The templates will
be regenerated after the next software catalog upload. The templates will be regenerated
after the next software catalog upload.
In case you have already the newest catalog uploaded the BFI server and then you
have installed agent in the private mode, the newest catalog may not be automatically
propagated to the agent. In such case follow the steps:

1. Download the fixlet for forcing the update of scanner catalogs.
a. Log in to BigFix Inventory.
b. In the top navigation bar, click Management > Catalog Upload.
c. Click the question mark sign Question mark sign. Then, click Catalog Download
Fixlet. Choose the location where you want to save the catalog_download.bes
file, and click Save.
2. Edit the catalog_download.bes file and substitute the relevances:
This:
<Relevance><![CDATA[if (name of operating system as lowercase starts
with "win")
then (exists (folder "cit" of folder (value of variable "windir" of
environment))
whose (exists file "cit.ini" of it) and (exists folder ((key
"CIT_HomeDirectory" of file "cit.ini" of folder "cit"
of folder (value of variable "windir" of environment)) & "\bin") whose
((exists file "wscansw.exe" of it)
and (exists file "wscanfs.exe" of it)))) else (exists (folder
"/etc/cit") whose (exists file "cit.ini" of it)
and (exists folder ((key "CIT_HomeDirectory" of file "cit.ini" of
folder "/etc/cit") & "/bin") whose
((exists file "wscansw" of it) and (exists file "wscanfs" of
it))))]]></Relevance>

with the following:
<Relevance><![CDATA[if (name of operating system as lowercase starts
with "win") then
((exists (folder "cit" of folder (value of variable "windir" of
environment)) whose (exists file "cit.ini" of it)
and (exists folder ((key "CIT_HomeDirectory" of file "cit.ini" of
folder "cit" of folder (value of variable "windir"
of environment)) & "\bin") whose ((exists file "wscansw.exe" of it)
and (exists file "wscanfs.exe" of it))))

OR (exists folder ((pathname of parent folder of data folder of
client) & "\LMT\CIT\scanner\bin") whose
((exists file "wscansw.exe" of it) and (exists file "wscanfs.exe" of
it)))) else (exists (folder "/etc/cit")
whose (exists file "cit.ini" of it) and (exists folder ((key
"CIT_HomeDirectory" of file "cit.ini" of folder
"/etc/cit") & "/bin") whose ((exists file "wscansw" of it) and (exists
file "wscanfs" of it))))]]></Relevance>

this:
<Relevance>if (name of operating system as lowercase starts with
"win") then ((exists (folder "cit" of folder
(value of variable "windir" of environment)) whose (exists file
"cit.ini" of it)) and ((key "CIT_Exploiters" of
file "cit.ini" of folder "cit" of folder (value of variable "windir"
of environment)) contains "SUA:")) else
((exists (folder "/etc/cit") whose (exists file "cit.ini" of it)) and
((key "CIT_Exploiters" of file "cit.ini"
of folder "/etc/cit") contains "SUA:"))</Relevance>

With the following:
<Relevance><![CDATA[if (name of operating system as lowercase starts
with "win") then (((exists (folder "cit" of
folder (value of variable "windir" of environment)) whose (exists file
"cit.ini" of it)) and ((key "CIT_Exploiters"
of file "cit.ini" of folder "cit" of folder (value of variable
"windir" of environment)) contains "SUA:")) OR
(exists folder ((pathname of parent folder of data folder of client) &
"\LMT\CIT\scanner\config") whose
(exists file "Cit.properties" of it))) else ((exists (folder
"/etc/cit") whose (exists file "cit.ini" of it))

and ((key "CIT_Exploiters" of file "cit.ini" of folder "/etc/cit")
contains "SUA:"))]]></Relevance>

3. Upload the catalog_download.bes file to the BigFix console and run the Catalog
Download (Version: version) fixlet.
a. Copy the file to the computer where the BigFix console is installed.
b. Log in to the BigFix console.
c. To import the file to the console, click File > Import.
d. Open the directory where you store the catalog_download.bes file, select the
file, and click Open. The file is imported.
e. In the left pane, click Sites > Master Action Site > Fixlets and Tasks. The list of
available fixlets opens in the upper right pane.
f. Select Catalog Download (Version: version), and click Take Action.
g. Select computers on which you want to run the fixlet, and click OK.

Preserving bundling when the BigFix client is reinstalled or reverted
from a snapshot
When the BigFix client is reinstalled or reverted from a snapshot, the next time it registers
at the BigFix server, it receives a new Data Source Computer ID. The BigFix client with
the old Data Source Computer ID becomes inactive because it does not report with the
same Computer ID. As a result, the BigFix console shows duplicated entries for the same
computer. Additionally, the affected computer loses bundling information for software that
was discovered on this computer. To avoid this situation, store some registry keys data
aside of the computer whose identity you want to preserve.
To preserve the identity of a computer on which the BigFix client is already installed, you
need to prepare a gold image of this computer and store some registry keys data aside. The
gold image is a simple VM template that can be deployed multiple times. This procedure is
applicable in the following cases:

• You revert the computer from a VM snapshot with registry keys data stored aside. In
this case, the computer keeps its previous Data Source Computer ID.
• You revert the computer from a VM snapshot without registry keys data stored aside.
In this case, the BigFix client needs to register on the BigFix server to receive its
unique Data Source Computer ID.
1. The BigFix server can match the data that is stored aside to the BigFix client that is
reinstalled or reverted from a snapshot when the ClientIdentityMatch parameter of
the BigFix server is set to 100. By default, the parameter is set to 0. To change the
value of the parameter, go to the computer on which the BigFix server is installed and
perform the following steps.
Go to Start > BigFix Administrative Tool > Advanced Options and set

•

the value of the ClientIdentityMatch parameter to 100.
Run the following command.

•

./BESAdmin.sh -setadvancedoptions
-sitePvkLocation=/root/backup/license.pvk
-sitePvkPassword=pippo000 -update clientIdentityMatch=100

Ensure that you complete this action before you install the BigFix client on the
computer whose identity you want to preserve. For more information about the
ClientIdentityMatch parameter, see: List of advanced options.
2. Install the BigFix client on the computer whose identity you want to preserve. For
available methods, see: Installing the BigFix clients.
After the installation of the BigFix client completes, the computer automatically
registers at the BigFix server and receives a unique Data Source Computer ID.
3. Include the BigFix client in a computer image that can be deployed multiple times.
a. Stop the BigFix client.
Open the Windows services dialog box and stop the BigFix client

•
service.
•

Run the following command.
BESClient stop

b. Go to the following location.
•

HKEY_LOCAL_MACHINE\SOFTWARE\BigFix
\EnterpriseClient\GlobalOptions
/var/opt/BESClient/besclient.config under the

•

section [Software\BigFix\EnterpriseClient\GlobalOptions].
Remove values for the following parameters.
• RegCount
• ComputerID
• ReportSequenceNumber
c. Delete __BESData and KeyStorage folders from the default installation
directory of the BigFix client.
•

C:\Program Files\BigFix Enterprise\BES Client

•

/var/opt/BESClient

Your computer is now ready to be imaged. It is important to save the gold image when
the BigFix client service is stopped. To prepare a VM template, follow documentation
for the virtualization technology that you use.
4. Reload the image without any computer identity that is stored aside and start the
BigFix client.
Open the Windows services dialog box and start the BigFix client

•
service.
•

Run the following command.
BESClient start

After you start the BigFix client service, the computer that is reloaded from this image
registers automatically at the BigFix server and receives a new Data Source Computer
ID.
5. To preserve the new identity of this computer, store some registry keys data aside
before you power off the computer.
a. Stop the BigFix client service.
b. Store the following data.

• The registry key value for ComputerID from the following location.
◦

HKEY_LOCAL_MACHINE\SOFTWARE\BigFix
\EnterpriseClient\GlobalOptions

◦

/var/opt/BESClient/besclient.config
under the section Software\BigFix\EnterpriseClient
\GlobalOptions.

• The BES Client\KeyStorage folder from the default installation
directory of the BigFix client.
6. Reload the computer from the gold image with the BigFix client service stopped.
7. Import the data that you stored in step 5.
8. Start the BigFix client.
The gold image of your computer is ready and you can reload it at any time. Thanks to the
registry keys data stored aside, the computer keeps its identity and bundling information of
software that was discovered on this computer.
You can write a script to automate some of the steps. For example, the script can:
• Start and stop the BigFix client service.
• Store and restore registry keys data that is needed to identify the computer.
If you want to deploy the image multiple times in your environment, it is beneficial to include
the scripts in the gold image to help you make the process more effective.

Setting the code page for double-byte languages
Double-byte character corruption can occur in some environments because BigFix
Inventory uses the code page to transcode data. For double-byte languages such as Korean,
Japanese, and Chinese, set the code page to avoid character corruption.
The _BESClient_DeploymentEncoding_IANAName setting of the BESClient running on the
BigFix server must use the correct character set for double-byte languages. For example, for
simplified Chinese the setting is CP936. One double-byte code page translation is allowed
per BigFix server that is configured as a data source for BigFix Inventory.

1. Log in to the BigFix console.
2. Go to your Subscribed Computers, and select the computer on which you have both
the BigFix server and the BESClient installed.
3. Go to Edit Settings, and change the _BESClient_DeploymentEncoding_IANAName
setting to the correct encoding.
4. Stop the BigFix Inventory server.
5. Log in to the database server as a user with DB2 authority, open a DB2 command line
and run the following commands:
db2 "connect to database database_name"
db2 "update dbo.datasource_sequences set
last_sequence=cast( x'0000000000000000' as char(8) for bit data)'"
db2 commit

6. Start the BigFix Inventory server and run a data import.

Contacting Support
HCL Support provides assistance with product defects.
Before contacting Support, your company must have an active software maintenance
contract, and you must be authorized to submit problems to HCL. For information about the
types of maintenance contracts available, see "Enhanced Technical Support" in the Software
Support Handbook at: https://support.hcltechsw.com/csm.
Complete the following steps to contact Support with a problem:
1. Define the problem, gather background information, and determine the severity of
the problem. For help, see “Contacting Software Support” in the Software Support
Handbook.
2. Gather diagnostic information.
3. Submit your problem to Support in one of the following ways:
• Online: Visit the Support site: https://support.hcltechsw.com/csm.
• By phone: For the phone number to call in your country, go to the “Contact
Information” section of the Software Support Handbook.

If the problem you submit is for a software defect or for missing or inaccurate
documentation, HCL Support creates an Authorized Program Analysis Report (APAR).
The APAR describes the problem in detail. Whenever possible, HCL Support provides a
workaround that you can implement until the APAR is resolved and a fix is delivered. HCL
publishes resolved APARs on the HCL Support website daily, so that other users who
experience the same problem can benefit from the same resolution.

Tuning performance
Learn how to plan the infrastructure of BigFix Inventory and to configure the application
server to achieve optimal performance. The following guidelines are applicable in big data
environments as well as in smaller environments that are running on low-performance
hardware.
Your deployment architecture depends on:
• the number of endpoints managed
• the number of facts captured, such as file facts, ISO tags, package facts, resource
utilization metrics tags, and other information
• dynamics of the changes in environment: on endpoints and software classification
operation influencing calculation of license metrics
• number of configured computer groups
• number of concurrent users using the application
• load from 3rd party system integrating through APIs
The BigFix Inventory server stores its data in a dedicated database, either DB2 or MS SQL
Server. When you plan and install the BigFix Inventory infrastructure, consider the hardware
requirements for all the components. For more information, see: Hardware requirements.
To benefit from all the good practices, use BigFix server version 9.5.5 and above.

Infrastructure
The main factor that affects the performance of the BigFix Inventory server is the
performance of the underlying infrastructure on which the application server and the DB2
database are running. You must ensure that the recommended requirements are met.
Important: The official hardware recommendations were prepared with assumption
that the BigFix Inventory server is running on a dedicated physical server or servers.
If virtual machines are used, the specified hardware (processor, RAM, or disk space)

must be exclusively dedicated to those virtual machines – not shared with any
others.
Even if you meet the recommended requirements, the application might work slowly
because of issues with the underlying hardware. The issues might be caused by, for
example, sharing resources with other machines within the virtual environment. You can run
some diagnostic methods to ensure that the underlying infrastructure is in good shape.
Make sure that you configured the VM Manager Tool efficiently. For more information, see:
Best practices for configuring VM managers.

Memory performance requirements
RAM performance metrics such as seek time or memory bandwidth, are strictly dependent
on the memory type, which is linked with the processor type.
Restriction: Do not run your server on a virtual machine for which memory
compression was enabled, for example in x86 virtualization that is provided by
VMware. It is especially important in case of the computer on which the DB2®
database is running.
Pay particular attention to the amount of memory that is available for BigFix Inventory and
the DB2® application. It is important to monitor the RAM usage on a daily basis because
memory usage differs greatly depending on how the application is being used. The main
factors besides the environment size include:
• The number of concurrent web UI users
• The frequency of data imports
Memory monitoring is especially important on the database computer as insufficient
amount of RAM can significantly slow down background tasks, such as PVU data
aggregation because of memory swapping. Swapping, also known as paging, is the use
of secondary disk storage to store and retrieve application data for use in RAM. It is
automatically performed by the operating system and typically occurs when the available

RAM is depleted. Swapping can have a significant impact on DB2® performance and should
be avoided. To avoid swapping, ensure that sufficient RAM is available on the computer so
processes do not consume all the available RAM. Use the following Linux™ tools to monitor
RAM usage and memory swapping:
• top
• free
• vmstat
• or sar
If you notice that there is almost no free memory available to BigFix Inventory and the DB2®
processes are being swapped to disk, the best solution is to increase the RAM memory size.

Storage performance requirements
To ensure good performance of BigFix Inventory, it is essential to have good storage
performance on the database server computer. The storage performance of the BigFix
Inventory server alone is not that important.
The recommended average disk speed for the database server computer is specified in the
following table.
Table 197. Recommended average disk speed
for the database server computer in specific
environments
Recommended average disk speed for
the database server computer in specific
environments
Deployment Size

Disk Speed

Small (up to 5000 endpoints)

100 MB/sec

Medium (5000 - 30000 endpoints)

250 MB/sec

Large (more than 30000 endpoints) 400 MB/sec

Running hard disk tests
Learn some diagnostic methods and use them to ensure that the hardware infrastructure
is in good shape. On Linux™, you can use the hdparm and dd commands or the Bonnie++
application to determine the hard disk write rate. You can also use the iostat command to
determine average disk usage.

Determining the write rate with the hdparm command
In the Linux operating system, there is a built-in hdparm command that can be used to
determine the hard disk write rate.
In the Linux console, enter hdparm -t path_to_the_test_file
hdparm -t /dev/sda1
Timing buffered disk reads: 200 MB in 1.19 seconds = 167.47 MB/sec

Running the disk test with the DD application
The DD test measures the most basic single-threaded disk access, which is a large
sequential write, followed by a large sequential read. It is relevant for the database
performance testing effort because it gives you the maximum speed for sequential scans of
large tables.
Note: Check the RAM size on the testing computer to correctly run a DD test and
avoid file system caching that can distort the test results.
1. Create a file that is twice the size of the RAM capacity on the test computer and copy
it to the target computer hard disk.
In your tests use a 4 KB block size because the default page size of the DB2® table
space that BigFix Inventory is using is 4 KB. For example, if you have 16 GB of RAM,
run the following command so that a 32 GB file named ddfile is created in the
current directory:
time sh -c "dd if=/dev/zero of=ddfile bs=4k count=8000000 && sync".

Note: Some implementations of DD report the write rate, but the time
command always returns the execution time that is larger than the DD
time. The time and rate reported by DD represent the rate without any lag or
synchronization time. Divide the data size by the time reported by the time
command to get the real synchronous file writing rate.
Example:
8000000+0 records in
8000000+0 records out
32768000000 bytes (32 GB) copied, 38.924 s, 842 MB/s
real 3m49.192s
user 0m0.450s
sys 0m38.282s

In this example, the rate for writes including caching is 842 MB/s, but including the
synchronization time it is much poorer – only about 136.46 MB/s (32 GB / 3 minutes
49 seconds).
2. To flush out the file system cache so that you read directly from the disk later, write to
the disk another large file: dd if=/dev/zero of=ddfile2 bs=4k count=4000000
3. Read the first large file. Since the file system cache is filled with the second file, this
test returns a valid read rate result:
time dd if=ddfile of=/dev/null bs=4k
8000000+0 records in
8000000+0 records out
32768000000 bytes (32 GB) copied, 186.456 seconds, 167.6 MB/s
real 3m6.496s
user 0m1.652s
sys 0m10.753s

4. Compare the results with those in the table Recommended average disk write and
read rates for the database server computer to determine whether your storage can
handle the DB2® database for your environment. The system should easily be able to
deal with a database of up to 10000 clients.

Determining disk usage
If response times are slow, check the average disk usage with the iostat command. Disk
usage times of greater than 80% can reduce I/O performance, it is desirable to have average
disk usage below 40%.
In the Linux console, enter iostat -x interval duration
Where:
• interval is the time interval in seconds. If no interval is specified, the output reflects
the values over the entire period since the system was rebooted
• duration is the number of times to run the command.
Example:
iostat -x 30 5

Using relays to increase the performance of BigFix
To take advantage of the speed and scalability that is offered by BigFix, it is often necessary
to tune the settings of the BigFix deployment.
A relay is a client that is enhanced with a relay service. It performs all client actions to
protect the host computer, and in addition, delivers content and software downloads to child
clients and relays. Instead of requiring every networked computer to directly access the
server, relays can be used to offload much of the burden. Hundreds of clients can point to
a relay for downloads, which in turn makes only a single request to the server. Relays can
connect to other relays as well, further increasing efficiency.

Reducing the BigFix server load
For all but the smallest BigFix deployments (< 500 BigFix clients), a primary BigFix relay
should be set for each BigFix client even if they are not in a remote location.
The reason for this is that the BigFix server performs many tasks including:
• Gathering new Fixlet content from the BigFix server
• Distributing new Fixlet content to the clients
• Accepting and processing reports from the BigFix clients
• Providing data for the BigFix consoles
• Sending downloaded files (which can be large) to the BigFix client, and much more.
By using BigFix relays, the burden of communicating directly with every client is effectively
moved to a different computer (the BigFix relay computer), which frees the BigFix server
to do other tasks. If the relays are not used, you might observe that performance degrades
significantly when an action with a download is sent to the BigFix server.
Setting up BigFix relays in appropriate places and correctly configuring clients to use them
is the most important change that has highest impact on performance. To configure a relay,
you can:
• Allow the clients to auto-select their closest BigFix relay.
• Manually configure the BigFix clients to use a specific relay.
For more information, see Managing relays.

Setting up scans and import
Learn how to improve the scanning and importing activities to optimize the performance in
your infrastructure.

Good practices for running scans and imports
Apply the good practices when running scans and imports to ensure that your infrastructure
works efficiently.

Initial configuration task
• Run the initial import
It is a good practice to run the initial import before you schedule scans and activate
analysis. This import uploads the software catalog from the installation directory
to BigFix Inventory and extracts basic data about endpoints from the BigFix server.
Make sure that the scan data from the first scan group is available in BigFix server
and then run the second import. When the scan results from the second scan group
are available in the BigFix server, you can run the next import of data.

Scanning related activities
• Plan scan frequency
After you find the optimal size of scan groups, set the frequency of software scans.
The most common frequency is weekly so that every endpoint is scanned once a
week. If your environment has more than 100 000 endpoints, consider performing
scans less frequently, for example monthly. If scans are running daily, take into
account system updates. When many files are modified, the next data import runs
longer.
• Avoid scanning when it is not needed
Scan frequency depends on how often software changes on the endpoints and on
your reporting needs. Group endpoints on which software changes dynamically
together and scan them more frequently, for example once a week. Group endpoints
with a more stable set of software together and scan them less frequently, for
example once a month.
• Limit the number of computer properties gathered during scans
By default, BigFix Inventory retrieves four computer properties from the BigFix server:
computer name, DNS name, IP address, and operating system. Imports can be much
longer if you extract more properties from BigFix during each import. It is a good
practice to limit the number of computer properties to 10 or fewer.
• Limit the number of BigFix Inventory computer groups

Create only as many computer groups as are needed. Import of data gets longer
with a growing number of computer groups. If the size of your environment requires
that you create many computer groups, consider skipping calculation of extended
software aggregates. By skipping these calculations, you can reduce the length of
data imports in very large environments. For more information, see: Disabling the
calculation of extended software aggregates.
• Enable the collection of checksums for a small group of endpoints
Each change to the configuration of the cryptographic hash collection (enabling,
disabling, adding new types) significantly lengthens the first data import that
follows the change. Because of multiple modifications on the file system, the new
configuration triggers a complete data import instead of the delta one, in which only
modifications are imported. This first data import might take up to three times longer,
and the subsequent ones about 10% longer than data imports without file hashes.
The impact of subsequent data imports is considered as moderate. Before you enable
the collection of file hashes, divide your environment into scan groups to distribute
the load of the imported data. For more information, see: Enabling the collection of
checksums.

Import related activities
• Maintain frequent imports
After the installation, imports are scheduled to run once a day. Do not change this
configuration. However, you might want to change the hour when the import starts. If
your import is longer than 24 hours, you can improve the scan groups configuration.
Alternatively, you can preserve the current configuration because BigFix Inventory
handles overlapping imports. If an import is running, no other import is started.
• Consider web user interface
Data import is a computation-intensive task so be prepared to experience slower user
interface response times while you are using BigFix Inventory. Thus, it is better to

schedule the imports to take place at other times when you are not likely to use the
application WebUI.
If, in case of huge deployments, loading any report takes substantial amount of time,
see: User interface problems.

Dividing the infrastructure into scan groups
To avoid running into performance issues, you should divide the computers in your
infrastructure into scan groups and properly set the scan schedule. You should start by
creating a benchmark scan group on which you can try different configurations to achieve
optimal import time. After the import time is satisfactory for the benchmark group, you can
divide the rest of your infrastructure into analogous scan groups.
1. Create a single scan group that will be your benchmark.
The size of the scan group might vary depending on the size of your infrastructure.
However, the recommendation is to avoid creating a group larger than 20 000
endpoints. For more information about creating computer groups, see: Lesson 1
(Optional): Creating computer groups in the BigFix console
2. Run Initiate Software Scan fixlet and scan the computers in this scan group. For more
information, see: Initiating software scans.
3. When the scan finishes, use Upload Software Scan Results fixlet to upload the results
of the scan to the BigFix server. For more information, see: Uploading software scan
results.
4. Run an import of data. For more information about running imports, see: Scheduling
imports of data. Check the import time and decide whether its duration is satisfactory.
5. If you are not satisfied with the import time, go to the following directory and check
the import log.
•

installation_directory/wlp/usr/servers/server1/logs/
imports

•

installation_directory\wlp\usr\servers\server1\logs
\imports

6. Undertake one of the following actions:
• If you see that the duration of the import of raw file system scan data or
package data takes longer than one third of the ETL time and the volume of the
data is large (a few millions of entries), create a smaller group.
• If you see that the duration of the import of raw file system scan data or
package data takes longer than one third of the ETL time but the volume of
the data is low, fine-tune hardware. For information about processor and RAM
requirements as well as network latency and storage throughput, see: Hardware
requirements.
7. If you see that processing of usage data takes an excessive amount of time and you
are not interested in collecting usage data, disable gathering of usage data. For more
information, see: Disabling the collection of software usage.
8. After you adjust the first scan group, run the software scan again, upload its results to
the BigFix server and run an import of data.
9. When you achieve an import time that is satisfactory, decide whether you want to
have a shorter scan cycle.
If you have an environment that consists of 42 000 endpoints and you created seven scan
groups of 6000 endpoints each, your scan cycle will last seven days. To shorten the scan
cycle, you can try increasing the number of computers in a scan group, for example, to
7000. It will allow you for shortening the scan cycle to six days.
Note: After you increase the scan group size, observe the import time to ensure that
its performance remains on an acceptable level.
When you are satisfied with the performance of the benchmark scan group, create the
remaining groups. Schedule scans so that they fit into your preferred scan cycle. Then,
schedule import of data from BigFix server. Observe the import time. If it is not satisfactory,
adjust the configuration as you did in the benchmark scan group. When you achieve suitable
performance, make room for end-of-scan-cycle activities and plan to have a data export to
other integrated solutions (i.e. SmartCloud Control Desk through BigFix Tivoli Integration
Composer) at the end of a 1- or 2-week cycle. For more information, see: Integrating with
IBM Control Desk.

Use the following diagram to get an overview of actions and decisions that you will have to
undertake to achieve optimal performance of BigFix Inventory.

Scan schedule
It is critical for BigFix Inventory performance that you accurately schedule scans in the scan
groups in your environment. If the configuration is not well-balanced, you might experience
long import times.
For environments larger than 35 000 endpoints, divide your endpoints into separate scan
groups. The system administrator can then set a different scanning schedule for every scan
group in your environment.
Example
If you have 60 000 endpoints, you can create six scan groups (every group containing 10
000 endpoints). The first scan group has the scanning schedule set to Monday, the second
to Tuesday, and so on. Using this configuration, every endpoint is scanned once a week.
At the same time, the BigFix server receives data only from 1/6 of your environment daily
and for every daily import the BigFix Inventory server needs to process data only from 10
000 endpoints (instead of 60 000 endpoints). This environment configuration shortens the
BigFix Inventory import time.
The image below presents a scan schedule for an infrastructure that is divided into six scan
groups. You might achieve such a schedule after you implement recommendations that are
contained in this guide. The assumption is that both software scans and imports of scan
data to BigFix Inventory are scheduled to take place at night, while uploads of scan data
from the endpoints to the BigFix server occur during the day.

If you have a powerful server computer and longer import time is acceptable, you can create
fewer scan groups with greater number of endpoints in the BigFix console. Remember to
monitor the import log to analyze the amount of data that is processed and the time it takes
to process it.
For information how to create scan groups, see the topic Computer groups that is available
in the BigFix documentation.

Recommendations for the service provider environments
The service provider functionality is used to create separate subcapacity reports for
different sets of computers. You can create such a report for each computer group. By
default, the calculation of PVU and RVU MAPC consumption is disabled for new computer
groups. After you enable it, a computer group becomes a subcapacity computer group, and
can have its own subcapacity report. This, however, impacts performance due to increased
number of subcapacity calculations.
If you decide to create more than 10 subcapacity computer groups, adjust the use
of CPU resources and tune the default configuration of BigFix Inventory. The most
important processes for subcapacity computer groups are aggregation and reaggregation.
Performance of these processes depends on the maximum number of threads that can be
run for the calculations, which by default is 2. You improve performance by increasing the
number of available threads.
To increase the number of available threads, specify the values of the
maxAggregationThreads and maxReaggregationThreads parameters. To specify
the values of these parameters, log in to BigFix Inventory and go to Management >
Advanced Server Settings. In general, you should provide two processor cores for each
thread on your database server. For example, if you can provide 12 processor cores
for the aggregation process itself, increase the number of threads to 6 by specifying
maxAggregationThreads=6. For more information, see: Advanced server settings.

Additional tasks for improving performance
Learn about additional tasks that you might want to perform to improve the performance in
your infrastructure.

The default list of excluded Windows endpoints is extended to improve the data import
and overall file scan. This helps is reducing the overall data import duration. For more
information, refer to the KB article.

Changing the mode of sorting bundling options on the Software
Classification panel
If the Software Classification panel runs slowly or the BigFix Inventory server is under a
heavy load, you might want to change the mode of sorting bundling options.
After you invoke the function Assign Components to Product on the Software Classification
panel, you might experience a performance issue while loading the data. By default, the
bundling options that are displayed when you reassign a software component are sorted by
confidence. To improve the performance, sort the displayed bundling options alphabetically.
You can use a REST add-on in your web browser or the curl tool to perform this task.
• You can use the REST add-on in your web browser to sort the displayed bundling
options alphabetically.
◦ Open the REST add-on in your web browser, for example Advanced REST client.
◦ To set the value of the blockUiBundlingComputations parameter to true, run the
following REST API query:
PUT http://bfi_server_host_name:port_number/rest/configs?
token=token&name=blockUiBundlingComputations&value=true

Example:
PUT
http://localhost:9981/api/sam/configs?token=7adc3efb175e2bc0f448
4bdd2efca54a8fa04623&name=blockUiBundlingComputations&value=true

• You can use the curl tool to sort the displayed bundling options alphabetically.
◦ Start the curl tool.
◦ Enter the following command.
curl -v PUT
http://bfi_server_host_name:port_number/

rest/configs?token=token&name=blockUiBundlingComputations&value=t
rue

Example:
curl -v PUT
http://localhost:9981/api/sam/configs?token=7adc3efb175e2bc0f448
4bdd2efca54a8fa04623&name=blockUiBundlingComputations&value=true

The bundling options are sorted alphabetically and are displayed more quickly because no
additional computation is added to the server workload.

Related reference
Advanced server settings

Disabling the calculation of extended software aggregates
You can noticeably reduce the length of data imports in very large environments if you
disable the calculation of extended software aggregates. Software aggregates are pieces
of data that are gathered during software scans on your endpoints and which are later
processed during successive data imports. They are displayed on the Inventory Exploration
report.
You can disable the gathering of the following software aggregates:
• Total Runs
• Total Run Time
• Average Runs per Day
• Average Run Time
• First Used

1. Enable the new feature that allows for skipping the processing of extended software
aggregates.
a. Open the following URL in your web browser: https://bfi_server_name:port/
management/feature.

b. Select Skip Extended Software Aggregates and click Save.
2. To disable the calculation of extended software aggregates for a specific computer
group:
a. In the BigFix Inventory web user interface, click Management > Computer
Groups.
b. Expand the All Computers computer group and click the group for which you
want to disable the calculation of software aggregates.
c. Select Skip Extended Software Aggregates and click Save.
After you run a data import, the individual entries for extended software aggregates are
displayed on the Inventory Exploration report as Not calculated.
Run a data import to recalculate the aggregates.

Recovering from accumulated scans
If scan results are not imported to BigFix Inventory for a longer period of time, they
accumulate on the BigFix server. They are all processed during the first import after the
break which might lead to long import times. To avoid the problem, skip importing the
results of the software scan during the first import after the break. Then, apply good
practices for distributing scans in your infrastructure, including dividing the computers into
scan groups, and planning the scan schedule. It will allow for importing scan results from
the consecutive scan groups without overloading the import.
Recovering from accumulated scans is necessary in the following situations:
Import of data to BigFix Inventory was failing for a longer period of time
If the import of data fails for a longer period of time, scan results accumulate
on the BigFix server. They are all processed during the first import after the
break which might lead to long import times.

BigFix Inventory was reinstalled and scans were run in the past
With each reinstallation of BigFix Inventory, a new instance of BigFix Inventory
database is created. A fresh installation triggers the import of all historically
collected scan files.
BigFix Inventory V9.x coexists with Software Use Analysis V1.3, V2.2, License Metric
Tool V7.x or Tivoli Asset Discovery for Distributed V7.x
Different versions of License Metric Tool 9.x and BigFix Inventory 9.x can
coexist with each other and the earlier versions as well as Tivoli Asset
Discovery for Distributed. For each additionally installed or reinstalled instance
of the License Metric Tool 9.x or BigFix Inventory 9.x server, a new database is
created. It triggers the import of all historically collected scan files.
1. Log in to BigFix Inventory and go to the following URL: https://host:port/
management/feature.
2. Check the Disable the import of accumulated software scan results (next import
only) check box.
3. Run the import of data (ETL).
If the accumulated scan results are successfully skipped, the following information is
written in the import log:
2015-08-10 22:11:35 (+0:00:00.003) INFO: Accumulated results of
software scans
are SKIPPED
2015-08-10 22:11:35 (+0:00:00.119) INFO: Accumulated results of
software scans
were successfully skipped during the import. The setting applied only
to this import.
The subsequent imports will contain the results of the software scan.

If the import is successful, the function will be disabled.
If the computers in your environment are divided into scan groups, run the scans according
to the specified schedule and wait for the scan results. Otherwise, divide the computers into

scan groups and distribute scans over the days of the week according to the good practices
for running scans. Then, schedule incremental imports of data to BigFix Inventory.

Shortening the retention period gradually to avoid problems with
growing database size
Since BigFix Inventory 9.2.1, retention period is set to 7 days in a fresh installation, so
this procedure does not apply in case of fresh 9.2.1 installations. If you did not configure
the retention period after installation in earlier versions of BigFix Inventory and the data
accumulation continued for several months, you must enable and repeatedly change the
data retention configuration to make the retention period as short as possible. With each
successive import, the historical data is deleted gradually and thus problems with growing
database size are avoided.
For information about how to configure the retention period in the product web user
interface, see Configuring data retention period for raw utilization data.
Note:
• After this configuration was applied, the transaction log is used heavily
because all the data is deleted in one transaction.
• The database size is not decreased automatically. If you want to reclaim
disk space that is occupied by database tables, run the command that is
appropriate for your database management system.
• If the data imports during which historical data was deleted failed, increase
the retention period and run the import again.

1. Determine the date of the first successful import.
2. Calculate the number of days since the first successful import. For example: If the
import occurred 6 months ago: 6 months * 30 days = 180 days.
3. Set the retention period to begin 30 days after the first successful data import.
Example: 5 months * 30 days = 150 days.
4. Run the data import.

5. Set the retention period to begin 60 days after the first successful data import, that is,
set the retention period to 120 days.
Example: 4 months * 30 days = 120 days.
6. Repeat the step as many times as necessary, each time decreasing the retention
period by 30 days.
7. When the retention period is short enough, enter the target configuration of 7 days.

Tuning performance in medium and large
environments
You can learn the possible causes of the most common performance issues in medium and
large environments. Follow the tips and the known solutions to these issues to keep the
system in good shape and avoid performance problems.
Scalability of multiple concurrent UI users
The number of users that are simultaneously logged in to BigFix Inventory and perform
actions on the user interface influences the application performance. When BigFix Inventory
is running on the hardware that meets the minimal hardware requirements, the optimal
number of concurrent users is five.

Tuning DB2 application database
To avoid performance issues in medium and large environments, configure the location
of the transaction log and adjust the log size. If you are using DB2 as database,
you might want also to change the swappiness parameter in Linux or configure the
DB2_COMPATIBILITY_VECTOR.
Make sure that the statement concentrator is set to OFF on the DB2 instance where the
is installed. For more information, see: stmt_conc - Statement concentrator configuration
parameter.

Maintaining the DB2 database
To ensure that the DB® database works properly, you need to regularly back up your data
and perform maintenance actions.

The configuration of DB2 has a significant impact on performance. You should perform
some standard actions to administer the database correctly. If you have DB2 administration
professionals, they can monitor the DB2 health and performance. In other cases, you should
follow the procedures that are described in this topic to keep your database healthy.
Perform regular backups
Perform regular backups of the data that is stored in the database.
It is advisable to back up the database before upgrading the server to facilitate recovery in
case of failure.
1. Perform regular backups of the data that is stored in the database. It is advisable to
back up the database before upgrading the server to facilitate recovery in case of
failure.
a. Stop the server.
b. In the DB2 command-line interface, run the following command: db2 backup
database TEMADB.

Note: TEMADB is the default database name. If you are unsure whether it
applies to your database, see: Checking the database name.
c. Start the server.
The backup is created in the current working directory, and the file name
contains the instance name and time stamp of the backup procedure (for
example: TLMA.0.db2inst1.NODE0000.CATN0000.20101105000715.001).
For more information about database backup strategies, see: Developing a
backup and recovery strategy.
DB2 Maintenance: Reorganize Table and Refresh Indexes statistics

2. Reorganize the table to match the index and to reclaim space:
a. Stop the BigFix Inventory server.
b. In the DB2® command-line interface, run the following commands:
• db2 connect to TEMADB
• db2 -x "select 'reorg table',substr(rtrim(tabschema)||'.'||
rtrim(tabname),1,50),' allow no access;'from syscat.tables
where type = 'T' and tabschema in ('ADM','SAM','DBO') order by
tabschema,tabname " > reorgs.sql

• db2 -tvf reorgs.sql
• db2 terminate
c. Start the BigFix Inventory server.
3. Keep the statistics up-to-date. By default, DB2® statistics are run automatically. If this
option is disabled, you must manually run the following commands:
a. Stop the BigFix Inventory server.
b. In the DB2® command-line interface, run the following commands:
• db2 connect to TEMADB
• db2 -x "select 'runstats on
table',substr(rtrim(tabschema)||'.'||rtrim(tabname),1,50),'
and indexes all;'from syscat.tables where type = 'T' and
tabschema in ('DBO','SAM','ADM') order by tabschema,tabname " >
runstats.sql

• db2 -tvf runstats.sql
• db2 terminate
c. Start the server.
Reclaim storage / reduce database size
To reduce tablespace size and avoid huge .LRG files please follow the below
instructions.

• How to identify used pages in a tablespace
◦ db2 inspect check tablespace name USERSPACE1 results keep
inspect.log

▪ This will generate a file inspect.log on the instance's diagnostic
directory (usually <instance directory>/sqllib/db2dump).
If multinode, it will generate a file for each node, adding the
node number at the end of the filename. ie: inspect.log.000,
inspect.log.001, etc. or it will generate separate folders for the
nodes ie: DIAG000, DIAG0001, etc.
• To format the output, you must navigate to where the output file is located and
run:
◦ db2inspf inspect.log inspect.out
▪ This will generate inspect.out in the current directory
Please note that you may have to wait a while for the below commands to execute so
please execute these commands a few minutes apart
• To recover the space, please run:
◦ db2 "ALTER TABLESPACE USERSPACE1 LOWER HIGH WATER MARK "
• To reduce the size of USERSPACE1 please run:
◦ db2 "ALTER TABLESPACE USERSPACE1 REDUCE MAX
• To check for any change in "High water mark (pages)"
• db2 "LIST TABLESPACES SHOW DETAIL"
Checking space occupied by individual tables
• To get the size of the tables in temadb please run:
◦

db2 “select
char(date(TAB.STATS_TIME))||'-'||char(time(TAB.STATS_TIME))
as STATSTIME, substr(TAB.TABSCHEMA,1,3)
as TABSCHEMA, substr(TAB.TABNAME,1,35)
as TABNAME, CARD as ROWS,
(COL_OBJECT_P_SIZE + DATA_OBJECT_P_SIZE +
INDEX_OBJECT_P_SIZE

+ LONG_OBJECT_P_SIZE + LOB_OBJECT_P_SIZE
+ XML_OBJECT_P_SIZE) as TAB_ALLOC_KB,
(COL_OBJECT_L_SIZE + DATA_OBJECT_L_SIZE
+ INDEX_OBJECT_L_SIZE + LONG_OBJECT_L_SIZE
+ LOB_OBJECT_L_SIZE + XML_OBJECT_L_SIZE)
as TAB_USED_KB, DICTIONARY_SIZE AS DICT_P_SIZE,
DATA_OBJECT_P_SIZE AS DATA_P_SIZE,
INDEX_OBJECT_P_SIZE AS INDEX_P_SIZE,
LOB_OBJECT_P_SIZE AS LOB_P_SIZE,
LONG_OBJECT_P_SIZE AS LONG_P_SIZE,
XML_OBJECT_P_SIZE AS XML_P_SIZE,
DATA_OBJECT_L_SIZE AS DATA_L_SIZE, INDEX_OBJECT_L_SIZE AS
INDEX_L_SIZE,
LOB_OBJECT_L_SIZE AS LOB_L_SIZE,
LONG_OBJECT_L_SIZE AS LONG_L_SIZE, XML_OBJECT_L_SIZE AS
XML_L_SIZE
from syscat.tables TAB join
sysibmadm.admintabinfo ADMTI on TAB.tabname=ADMTI.tabname
and
TAB.tabschema=ADMTI.tabschema where
TAB.TABSCHEMA IN ('DBO','SAM','ADM') order by TABSCHEMA,
TABNAME with ur"

For a more advanced investigation of queries that are used by the BigFix Inventory server,
you should use the DB2 design advisor command (db2advis). It helps in finding new
indexes that can improve the database performance. The Design Advisor uses the output
from the DB2 monitors to suggest the creation of new indexes. The suggestions are based
on the queries that are found in monitors. For more information about Design Advisor,
consult the DB2 documentation:
DB2 11.5

• db2advis - DB2 Design Advisor command
• DB2® topic: Design Advisor

Configuring the transaction logs size
If your environment consists of many endpoints, increase the transaction logs size to
improve performance.
The transaction logs size can be configured through the LOGFILSIZ DB2 parameter
that defines the size of a single log file. To calculate the value that can be used for this
parameter, you must first calculate the total disk space that is required for transaction logs
in your specific environment and then multiply it, thus obtaining the size of one transaction
log. The required amount of disk space depends on the number of endpoints in your
environment and the number of endpoints in the biggest scan group for which data is
processed during the import.
During the performance test execution, details such as, disc utilization, disk speed, memory
utilization is calculated. The details are shown in the form of chart.
Important: Use the provided formula to calculate the size of transaction logs
that are generated during the import of data. More space might be required for
transaction logs that are generated when you remove the data source.
1. Use the following formula to calculate the disk space that is needed for transaction
logs:
<The number of computers> × 0.0012 GB + <the number of computers in
the biggest scan group> × 0.0012 GB + 17 GB

2. To obtain the size of a single transaction log file that can be specified in the
LOGFILSIZ DB2 parameter, multiply the result by 1852.
Note: The number 1852 expresses the relation between the primary and
secondary log files and is necessary to calculate the size of a single

transaction log file (LOGFILSIZ). The factor was calculated assuming the
default number of log files (LOGPRIMARY = 25 and LOGSECOND = 110).
3. Run the following command to update the transaction log size in your database.
Substitute value with the size of a single transaction log.
Note: TEMADB is the default database name. If you are unsure whether it
applies to your database, see: Checking the database name.

db2 update database configuration for TEMADB using logfilsiz value

4. For the changes to take effect, restart the database. Run the following commands:
db2 deactivate db TEMADB
db2stop
db2start
db2 activate db TEMADB

5. Restart the BigFix Inventory server.
a. To stop the server, run the following command:
/etc/init.d/BFIserver stop

b. To start the server, run the following command:
/etc/init.d/BFIserver start

Calculating the single transaction log size for 100 000 endpoints and 15 000 scan results:
100 000 × 0.0012 GB + 15 000 × 0.0012 GB + 17 GB = 155 GB
155 × 1852 = 287060

287060 is the value to be specified in the LOGFILSIZ parameter.

Configuring the transaction log location for DB2
To increase database performance, move the DB2® transaction log to a file system that is
separate from the DB2® file system.
Medium environments:

Strongly ad
vised

Large environments:

Required

Very large environ

Required

ments
1. To move the DB2® transaction log to a file system that is separate from the DB2®
file system, update the DB2® NEWLOGPATH parameter for your BigFix Inventory
database:
UPDATE DATABASE CONFIGURATION FOR TEMADB USING NEWLOGPATH value

Where value is a directory on a separate disk (different from the disk where the DB2®
database is installed) where you want to keep the transaction logs. This configuration
is strongly advised.
2. For the changes to take effect, restart the database. Run the following commands:
DEACTIVATE DB TEMADB
DB2STOP
DB2START
ACTIVATE DB TEMADB

3. Restart the BigFix Inventory server.
a. To stop the server, run the following command:
/etc/init.d/BFIserver stop

b. To start the server, run the following command:
/etc/init.d/BFIserver start

Configuring swappiness in Linux hosting DB2 database server
Swappiness determines how quickly processes are moved from RAM to hard disk to free
memory. It can assume the value 0 - 100. A low value means that your Linux™ system
swaps out processes rarely while a high value means that processes are written to disk
immediately. Swapping out runtime processes should be avoided on the DB2® server on
Linux™, so it is advisable to set the swappiness kernel parameter to a low value or zero.
1. Log in to the Linux™ system as root.
2. Set the swappiness parameter to a low value or 0.
• Option A:
a. Open the file /etc/sysctl.conf in a text editor and enter the
vm.swappiness parameter of your choice.
Example:
vm.swappiness = 0

b. Restart the operating system to load the changes.
• Option B: To change the value without restarting the operating system, run the
following command: sysctl -w vm.swappiness=0.

Configuring the DB2_COMPATIBILITY_VECTOR variable for
improved UI performance
For environments with 5000 or more clients in your infrastructure, it is advisable to set the
value of the DB2_COMPATIBILITY_VECTOR variable to MYS. This change might result in a
UI response time that is significantly faster on some BigFix Inventory installations.
For information about how to modify this registry variable, see
DB2_COMPATIBILITY_VECTOR registry variable in HCL® Knowledge Center.

Configuring statement heap size
Statement heap size configuration parameter (stmtheap) refers to the limit of the statement
heap, which is used as a workspace for the SQL compiler during compilation of an SQL
statement. Statement heap size has an impact on the time taken to execute complex
queries, for example generating the audit snapshot.

Allocating small statement heap size for complex queries causes the query to be not fully
optimized and the execution lakes longer. It also consumes excessive amount of disk
space. This scenario occurs in databases that have large amount of data. On the other
hand, allocating large statement heap size may cause in longer execution time for complex
queries even if the database has small amount of data. It may be helpful to adjust the
statement heap size for large environments, if there are queries that run for a long time, or
use large amount of disk space.
Use the below command to define the statement heap size:
db2 update db config for TEMADB using stmtheap 81920 automatic

Note: Restart BigFix Inventory application and DB2 database after you change the
statement heap size.

Tuning MS SQL application database
To avoid performance issues in medium and large environments, configure the location
of the transaction log. If you are using MS SQL as database, you might want to shrink the
transaction log or update query optimization statistics.

Optimizing the tempdb database in Microsoft SQL Server
tempdb is a system database in SQL Server whose main functions are to store temporary
tables, cursors, stored procedures, and other internal objects that are created by the
database engine.
By default, the database size is set to 8 MB and it can grow by 10% automatically. In large
environments, its size can be as large as 15 GB. It is therefore important to optimize the
tempdb database because the location and size of this database can negatively affect the
performance of the BigFix Inventory server.
For information about how to set the database size and how to determine the optimal
number of files, see the TechNet article Optimizing tempdb Performance.

MS SQL Server transaction log related activities
Perform the following activities to improve the performance and the reliability of your
environment.
• Shrink the transaction log once a month. If the environment is large, it is advisable to
shrink the log after every data import.
For more information, see: How to: Shrink a File (SQL Server Management Studio).
• The transaction log in MS SQL Server records all transactions and the database
changes caused by each transaction.
For information how to configure the database transaction log, see: Move the
Database Transaction Log to Another Drive.

Database indexes rebuilding
Rebuilding database indexes and updating the statistics is mandatory for BigFix Inventory to
operate smoothly. If you experience a delay in UI response or importing data, make sure to
defragment your hard disk and that statistics are up to date.
From version 10.0.4, for new installations and upgrades, a job is included in MS SQL
database named “<InventoryDB> Full database Index Reorganization.” This job conducts
required index maintenance.
The job follows the below criteria:
• The script runs everyday at 4 AM local time.
• If a data import is running (scheduled import or manual import), the job waits for
the import to finish, and then attempts to rebuild the index. The job attempts to run
16 times after 30 minute intervals. The total time spent on waiting is 8 hours. If the
import does not complete in 8 hours, the job exits the queue with an error message in
the status log. In that case, the index is rebuilt the next day at the scheduled time.
• If an index rebuilding job already exists with the name, "<InventoryDB> Full database
Index Reorganization," then the scripts do not overwrite the data and the existing
configuration is retained.

• For the BigFix Inventory index rebuilding job to execute, the SQL Server Agent must be
configured and running. The agent is turned off in some cases. You need to manually
turn it on. To learn about how to configure and how to start SQL Server Agent, refer to
Configure SQL Server Agent and Start, Stop, or Pause the SQL Server Agent Service
respectively.
• It is recommended to configure SQL Server Agent to restart automatically in case of
failure. For more information, see Auto Restart SQL Server Agent.
For versions lower than 10.0.4, run the operation once a week to rebuild database.
The following example shows a simple approach to rebuild indexes and update statistics.
The job rebuilds all indexes independent of their fragmentation. The script uses the
standard database name as TEMADB.
USE TEMADB
GO
IF EXISTS (SELECT
*
FROM dbo.imports
WHERE success IS NULL)
BEGIN
PRINT N'CANNOT RUN index rebuild. BFI import is running!'
PRINT N'Wait until BFI import finishes'
END
ELSE
BEGIN
DECLARE table_cursor CURSOR FOR
SELECT
table_schema,
table_name
FROM INFORMATION_SCHEMA.TABLES
WHERE table_type = 'BASE TABLE'
OPEN table_cursor
DECLARE @tableName sysname

DECLARE @tableSchema sysname
FETCH NEXT FROM table_cursor INTO @tableSchema, @tableName
WHILE @@fetch_status != -1
BEGIN
PRINT N'START alter index all on ' + @tableSchema
+ N'.' + @tableName + N' rebuild';
EXECUTE (N'alter index all on ' + @tableSchema + N'.'
+ @tableName
+
N' rebuild')
PRINT N'END alter index all on ' + @tableSchema
+ N'.' + @tableName + N' rebuild';
FETCH NEXT FROM table_cursor INTO @tableSchema,
@tableName
END
CLOSE table_cursor
DEALLOCATE table_cursor
PRINT N'START sp_updatestats';
EXECUTE sp_updatestats
PRINT N'END sp_updatestats';
END
GO

SQL server parallelism optimization
BigFix Inventory follows the process mentioned in SQL Server parallelism optimization to
improve the database performance.

REST API considerations
You can use BigFix Inventory REST API to retrieve large amounts of data that is related
to computer systems, software instances, and license usage in your environment. Such
information can then be passed to other applications for further processing and analysis.

Although using single API requests to retrieve data only from a selected subset of
computers does not greatly impact the performance of BigFix Inventory, this is not true
when retrieving data in bulk for all your computer systems at the same time. Such an action
requires the processing of large amounts of data and it always influences the application
performance and when possible should not be executed during data import.
In general, the API requests should not be used together with other performance intensive
tasks, like software scans or data imports. Each user that is logged in to the application, as
well as the number of actions that are performed in the web user interface during the REST
API calls also decrease the performance.
Important: Each time you want to retrieve data through REST API, ensure that the
use of BigFix Inventory at a moderate level, so that the extra workload resulting from
REST API does not overload the application and create performance problems.
Special considerations
1. Up to version 10.0.2, the application that calls the APIs, must control the size of
individual response.

Starting from 10.0.2, BigFix Inventory uses HTTP

streaming in JSON responses. As a result, the response does not cause buffering on
the server side to calculate the response size.
2. Before 10.0.2, BigFix Inventory used to send a HTTP error code in case of any issue
during preparing whole response. Starting from 10.0.2, if an error occurs during
streaming and the streaming gets interrupted, you must interpret the problem as an
error.
3. Check only for changes in data and do not fetch all the data every time. Use
valid_from / valid_to or discovery_start / discovery_end fields to retrieve

changes.
4. When you complete your data import, BigFix Inventory does not call the APIs. In case,
you attempt to perform this process, the request may fail with a misleading error. It
is recommended to implement an option for the application to retry the request after
some time.

Optimizing response time
Starting from 10.0.2, BigFix Inventory uses HTTP streaming for JSON responses.
As a result, pagination can be omitted and the whole dataset can be fetched using a single
query. The pagination feature is still available and can be used. When using the pagination
feature, it is recommended to retrieve the total number of records only once and then iterate
over pages.

Avoiding calculation of the number of records returned
When executing an API call, use countSwitch=1 attribute to avoid calculating number of
reported rows. To return total number of the rows for an API query, use countSwitch=2 and
then retrieve pages of the records.
1. Retrieve total number of available records.
https://hostname:port/api/sam/raw_file_facts?token=token&countSwitch=2

2. Retrieve first 10000 records by using the limit parameter.
https://hostname:port/
api/sam/raw_file_facts?token=token&countSwitch=1&limit=10000&offset=0

3. Retrieve next 10000 records. You can ignore the already retrieved records by using the
offset parameter.
https://hostname:port/
api/sam/raw_file_facts?token=token&countSwitch=1&limit=10000&offset=10
000

Options to limit size of the individual response
Starting from 10.0.2, BigFix Inventory uses HTTP streaming in JSON responses.
In HTTP response method, the HTTP Header Transfer Encoding is set to chunked and the
response size is not determined. As a result, the data is available in stream as the database
provides records that matches the API. With this improvement, pagination in the API is
optional and all data can be fetched with a single query.

Using limit and offset
The limit and offset parameters works as same as their representation in SQL/RDBMS. This
allows to page over the result set. The first page, Tradeoff is available in the shortest time
and other subsequent pages load slowly. It needs more data to load the subsequent pages
and it cannot be optimized.
When you retrieve data in bulk, you can also make several API requests and use the limit
and offset parameters to paginate your results instead of retrieving all the data at the same
time:
• Use the limit parameter to specify the number of retrieved results:
https://hostname:port/URL?
token=token&countSwitch=1&limit=10000&offset=0

For example:
https://192.0.2.2:9081/api/sam/v2/computers?token=token&countSwitch=1&
limit=10000&offset=0

• If you limit the first request to 100000 results, append the next request with the
offset=100000 parameter to omit the records that you already retrieved:
https://hostname:port/URL?
token=token&countSwitch=1&limit=10000&offset=10000

For example:
https://192.0.2.2:9081/api/sam/v2/computers?token=token&countSwitch=1&
limit=10000&offset=10000

Note: The limit and offset parameters can be omitted if you are retrieving data for
50 endpoints. For environments with approximately 200000 endpoints, you are
advised to retrieve data in pages of 100000 rows for computer systems, 200000
rows for software instances, and 300000 rows for license usage.

Using criteria
The alternative method depends on the API instance and is based on using criteria. It allows
to optimize response time for subsequent pages as the application can extract information
directly about the page, without preparing the whole data.
Limit and offset parameters require to have the results ready according to some order and
then extract it partially. With this approach, the API, when requested, yields the entire result.
The pages are reported at different time. However, size of response varies due to the data
structure.

Software Instance Paging example using criteria
There instance_id field provides an unique value of the entry. It does not guarantee that
there will be no gaps in instance_id number. First instance_id is 1.
To get maximum value of instance_id, use the below example:
https://hostname:port/api/sam/v2/software_instances?
columns[]=instance_id&order[]=instance_id
%20desc&offset=0&limit=1&countSwitch=1
The return value is:
{"total":-1,"rows":[{"instance_id":162}]}

Specifying order (order[]=instance_id desc) assures that as first will be reported with
maximum value, so we can get just top row (limit=1). Returned value is maximum value of
instance_id.

You can page over the software_instances using instance_id and criteria.
Below is an example request:https://hostname:port/api/sam/v2/software_instances?

columns[]=computer_id&columns[]=instance_id&columns[]=component_name&offset=0&limit=10000&c
[["instance_id",">=","1"],["instance_id ","<","10000"]]}

Limit and offset values are additional parameters but it is recommended to use them.
Control over paging is moved to the criteria part then:
criteria={"and":[
["instance_id",">=","1"],

["instance_id ","<","10000"]
]}

Next page is returned by passing:
criteria={"and":[
["instance_id",">=","10000"],
["instance_id ","<","20000"]
]}

This method leverage data indexes to extract immediately desired subset of data and
should provide more stable response times over subsequent queries.

Synchronizing with Data Imports
The below available APIs provide status information of the data import:
1. https://hostname:port/api/import_status.json?token=token
2. https://help.hcltechsw.com/bigfix/9.5/inventory/Inventory/integration/
r_get_import_status_bfi.html
Consider synchronizing API bulk calls with data import by:
• checking if there is no import in progress (mode).
• checking if the time of last successful data import (last_success_time) is later than in
previous synchronization.

Understanding data changes
Raw Data API
By default, raw data remains in the database for 7 days. To change this period,
go to Management > Advanced Server Settings and change the value of the
raw_data_api_history_keep_days parameter.
This applies to:

• /api/sam/raw_package_facts.js
• /api/sam/raw_unix_package_facts.json
• /api/sam/raw_file_facts
The APIs enables the below fields to be displayed:
valid_-

The date when you imported information about the file

from

for the first time.

valid_to

The date when you attempted to import infor
mation about the file for the first time. The value

✓

String

✓

String

9999-12-31T23:59:59Z indicates that the file is still be
ing discovered.
See below an example for filtering criteria for a request:
{"or":[
{"and":[
["valid_from",">","${import_time_previous}"],
["valid_from","<=","${import_time_last}"]
]}
,
{"and":[
["valid_to",">","${import_time_previous}"],
["valid_to","<=","${import_time_last}"]
]}
]}

Where:
• import_time_previous – Previous successful data import time.
• import_time_last – Last successful data import time during initial load.

This API provides information about the hardware associated to the application.

Hardware API (v2/computers)
The hardware API provides information about the hardware associated to the application.
first_seen

Date and time when the computer were entered

String

in the application. The time is shown in GMT.
is_deleted

✓

Information whether the computer was re
moved.

deletion_date

Date and time when the computer was re

Boolean

String

moved. The time is shown in GMT.

detailed_hw_*association
This API provides detailed hardware information along with information when the
information was modified for the last time. The API is used to limit synchronization only to
new/updated records.
updated_at Date and time when the current information was imported to String
BigFix Inventory.

Software instances (v2/software_instances)
This API shows information related to software associated to the application. The following
information are applicable for the software.

is_present

Information whether the component is still in

Date and time when the component was re
discovery_start

ported for the first time. The time is shown in
GMT.
Date and time when the component was re

discovery_end

Boolean

stalled in the environment.

ported for the last time. The time is shown in
GMT.

✓

String

✓

String

Information whether the component is sup
is_suppressed

pressed on the computer on which it is in
stalled.

✓

Boolean

Integrating with REST API
External systems integration is one of the key features of BigFix Inventory. Business logic is
enabled for integration and interfaces are provided for common integration points.
Restriction: The database cannot be modified. The data can be retrieved only
through REST API, not directly from the database.

Considerations
• Although using single REST API requests to retrieve data only from a selected subset
of computers does not greatly impact the performance of BigFix Inventory, this is
not true when retrieving data in bulk for all your computer systems at the same time.
To improve the performance of a REST API, retrieve the data in chunks. For more
information, see: REST API considerations.
• Do not use REST API during the import as you might encounter a problem with the
database connection. If the problem occurs, wait until the import finishes and ensure
that the BigFix Inventory server is up and running. Then, repeat the API call.

Using the token
To use REST API when you are not logged in to BigFix Inventory, you must provide the token
parameter for each query. To check the token, log in to BigFix Inventory, hover over the User
icon

, and click Profile. Then, click Show token.

The token parameter is not required when you are logged in to BigFix Inventory.

REST API
Managing large amounts of information by using the application user interface can be timeconsuming. You can use the REST APIs as an alternative to the graphical user interface to
reduce the time that is needed to manage your software inventory and the content of your
software catalog.
REST API for retrieving authentication token

Important: If you want to use REST API when you are not logged in to BigFix
Inventory, you must provide the token parameter for each query. To check the token,
log in to BigFix Inventory, hover over the User icon

, and click Profile. Then, click

Show token.
The token parameter is not required when you are logged in to BigFix Inventory.

REST API for retrieving the BigFix Inventory version
Although using single API requests to retrieve data only from a selected subset of
computers does not greatly impact the performance of BigFix Inventory, this is not true
when retrieving data in bulk for all your computer systems at the same time. To improve the
performance of a REST API, retrieve the data in chunks. For more information, see: REST
API considerations.
Restriction: Do not use REST API during the import as you might encounter a
problem with the database connection. If the problem occurs, wait until the import
finishes and ensure that the BigFix Inventory server is up and running. Then, repeat
the API call.

API response language
The language of API response depends on the below criteria:
When the user is authenticated
• The user's profile language is set to default language:
◦ If the 'Accept-Language' header is defined in the request and
the language is supported in BigFix Inventory, the API response
appears in the defined language. If the language is not supported
in BigFix Inventory, the response appears in the fallback language.

◦ If the browser's language is supported in BigFix Inventory, the
response appears in the selected language. If the browser's
language is not supported in BigFix Inventory, the response
appears in English language.
• The user's profile language is not set to default:
◦ The API response appears in the selected user profile language.
When the user is not authenticated
• If the 'Accept-Language' header is defined in the request and the
language is supported in BigFix Inventory, the API response appears
in the defined language. If the language is not supported in BigFix
Inventory, the response appears in fallback language.
• If the 'Accept-Language' header is not defined in the request, the
response appears in English language.
Note: The fallback language setting depends on the language that you set in the
config file, such as pristine_installer_language property in the config/
lmt_settings.yml. It should be set as a supported language. When the language
is not supported, the default language becomes English.

Abbreviations
The following abbreviations are used in the documentation that is related to REST API:
HTTP
Hyper Text Transfer Protocol. HTTP version 1.1 is defined in RFC 2616. Unless
otherwise noted, the use of the term HTTP indicates both HTTP and HTTPS.
HTTPS
Hyper Text Transfer Protocol Secure, as defined in RFC 2818
JSON
JavaScript™ Object Notation, as defined in ECMA-262

REST
Representational State Transfer, as originally and informally described in
Architectural Styles and the Design of Network-based Software Architectures
URI
Uniform Resource Identifier, as defined in RFC 3986, Draft 5

Software Products and Software Components
BigFix Inventory detects software components which are bundled with the product.
The list shows the available software component. You can add a software
component to Inventory as required. Below given is an example to
BigFix Platform Agent which is installed at /opt/BESClient/bin/.

Use the Software Component listing to see the number of active and inactive components.
Each row shows details, such as usage, product and metric that it is added to, the
installation path about the selected component. You can select multiple components.

You can access information about computer properties through Computer Properties
(Management > Computers). You can access the computer properties through the user
interface or the API.
Note: The API shows the computer properties by its number and ID and not by its
name.

Table 198. API
computer_property_number

Custom computer property that was added on the
Computer Properties panel. To view the list of all cus
tom properties, view the computer_details schema.

Table 198. API (continued)
The name of the property as displayed on the user in
terface is shown in the title parameter.
You can use this feature to access user information, such as username from the system. It
provides the basic user information which is already available at the Platform level. The user
information may vary for each application.

REST API resources and HTTP methods
The operations of the BigFix Inventory REST API protocol are defined as HTTP methods on
certain REST resources.
Table 199. Overview of REST operations
HTTP
meth
Target REST operation URI
api/get_token

ods
POST

Purpose of the operation
Returns a unique token that is required
to authenticate REST API requests.
Returns the version of BigFix Invento

api/sam/about

ry.
api/import_status.json

GET

Returns the current status of the data
import.

Core API

Table 199. Overview of REST operations (continued)
HTTP
meth
Target REST operation URI

ods

api/sam/v2/license_us- GET

Purpose of the operation
Returns information about utilization
of license metrics by products that are

age

installed in your infrastructure.
PUT

Sets up license metric thresholds as
well as values of custom fields that
were added on the All Metrics report.

api/sam/v2/software_in-

GET

Returns information about software in
ventory in your infrastructure.

stances
api/sam/v2/computers

GET

Returns information about hardware
inventory in your infrastructure.

api/sam/v2/detailed_h- GET
w_ip_addresses

Retrieves information related to IP ad
dresses of computers in your infra
structure.

api/sam/v2/detailed_h- GET

Retrieves information related to
the logical partition and its CPU re

w_lpars

sources.
api/sam/v2/detailed_h- GET
w_memories

Retrieves information related to infor
mation related to the system memory
of the scanned system.

api/sam/v2/detailed_h- GET
w_network_adapters

Retrieves information related to in
formation related to the type, model
and MAC addresses of the network
adapters.

Table 199. Overview of REST operations (continued)
HTTP
meth
Target REST operation URI

ods

api/sam/v2/detailed_h- GET

Purpose of the operation
Retrieves information related to infor
mation related to the operating sys

w_operating_systems

tem on the scanned computer.
api/sam/v2/detailed_h- GET

Retrieves information related to infor
mation related to the file system that

w_partitions

is mounted on a scanned system: Unix
mount points and Windows logical dri
ves.
api/sam/v2/detailed_h- GET

Retrieves information related to infor
mation related to all active physical

w_physical_processors

processors.
api/sam/v2/detailed_h- GET

Retrieves information related to in
formation related to SMBIOS of the

w_smbios

scanned system.
api/sam/v2/detailed_h- GET

Retrieves information related to infor
mation related to storage devices on

w_storages

the scanned system.
GET

Retrieves raw metering data.

api/sam/raw_file_facts

GET

Retrieves raw scanned file data.

api/sam/raw_package_facts

GET

Retrieves raw package data.

api/sam/raw_unix_package_facts

GET

Retrieves raw UNIX package data.

api/sam/raw_app_usage_property_values

Table 199. Overview of REST operations (continued)
HTTP
meth
Target REST operation URI
/api/sam/unified/cur-

ods
GET

Purpose of the operation
Provides unified view of the currently
installed software instances and pack

rent/software

age data.
Configuration APIs
/api/sam/v2/contract-

GET

Retrieves contract nformation.

/api/sam/v2/contract-

PUT

Adds and updates contracts.

GET

Returns information about VM man

s.json

s.json
api/sam/vmmanagers

agers that are defined in your infra
structure.

api/v1/servers

PUT

Adds or updates VM managers.

PUT

Changes Oracle core factor that is as
signed to a server.

sam/component_lifecy-

POST

Sets the end of support date for soft
ware components.

cles
sam/software_compo-

DELETE

Removes the end of support date for a
software component.

nents/software_component_id/
component_lifecycles
sam/software_compo-

DELETE

Removes the end of support date for a
software component.

nents/software_component_id/
component_lifecycles
api/reports/report_ID

GET

Exports a saved report view.

Table 199. Overview of REST operations (continued)
HTTP
meth
Target REST operation URI

ods

Purpose of the operation

api/reports

POST

Imports a saved report view.

api/sam/configs

GET

Returns information about the current
settings of the administration server.

PUT

Changes the current settings of the
administration server.

api/sam/v2/metrics

POST

Creates and manages the products
and metrices.

GET

Returns the list of products and metri
ces.

PUT

Updates the metrics for products.

DELETE

Deletes metric for products.

GET

Returns information about clusters

Historical APIs
api/sam/clusters

that group your host computer sys
tems.
api/sam/computer_systems

GET

Returns a list of computer systems in
your infrastructure.

api/sam/license_usages

GET

Returns information about license us
age reported by your computer sys
tems.

api/sam/software_instances

GET

Returns a list of installed software in
stances.

Table 199. Overview of REST operations (continued)
HTTP
meth
Target REST operation URI

ods

Purpose of the operation
Note: This REST API is now
substituted with api/sam/v2/
software_instances REST

API.
api/sam/swinventory/confirm

POST

Confirms instances to bundle or as
sign.

api/sam/swinventory/confirmRe-

POST

for a release.

lease
api/sam/swinventory/exclude

Confirms the assignment of instances

POST

Excludes instances from pricing calcu
lations.

api/sam/swinventory/include

POST

Includes instances in pricing calcula
tions.

api/sam/swinventory/instance-

GET

can share a particular instance.

ToShare
api/sam/swinventory/prod-

Returns a list of software releases that

GET

Returns a list of releases of a particu
lar software product that is identified

uct/{product_id}/releases

by its identifier.
api/sam/swinventory/products

GET

Returns a list of software products.

api/sam/swinventory/reassign

POST

Reassigns instances to a product.

api/sam/swinventory/reassign-

POST

Reassigns instances to a product for a
list of releases.

Release
api/sam/swinventory/release/{release_id}/instances

GET

Returns a list of instances for the re
quested software product release.

Table 199. Overview of REST operations (continued)
HTTP
meth
Target REST operation URI
api/sam/swinventory/share

ods
POST

Purpose of the operation
Shares an instance with a list of soft
ware products.

api/sam/swinventory/target-

GET

Returns a list of possible releases
to which the requested software in

BundlesOfInstances

stance can be reassigned.
api/sam/swinventory/target-

GET

Returns a list of possible releases to
which the instances of the requested

BundlesOfReleases

software releases can be reassigned.
api/sam/swinventory/targetIn-

GET

Returns a list of target instances that
will be reassigned to a particular re

stances

lease.

Common REST API elements
You use connectors and operators to build query segments that filter on matching
conditions and values.

Connectors
Table 200. Connectors
Connector

Description

and

Add all clauses with an and concatenator

or

Add all clauses with an or concatenator

Parameters
Table 201. Parameters
Parameter
countSwitch

Description
Specifies whether the query returns the requested data, the number
of retrieved rows, or both. The operator can have the following val
ues:
• 1 - only requested data is returned
• 2 - only the number of rows is returned
• No value or any other value - both the requested data and the
number of rows are returned

Operators
Table 202. Operators
Operator

Description

Applicable to

=

Equal to.

!=

Not equal to.

<

Less than.

Numeric and date fields only.

<=

Less than or equal to.

Numeric and date fields only.

>

Greater than.

Numeric and date fields only.

>=

Greater than or equal to.

Numeric and date fields only.

last

Relative period of time in the past Date and time fields only.
(for example, last 7 days).

next

Relative period of time in the fu

Date and time fields only.

ture (for example, next 7 days).
starting

Relative period of time starting
in the past or in the future (for

Date and time fields only.

Table 202. Operators (continued)
Operator

Description

Applicable to

example, 7 days ago, or 7 days
ahead) and lasting until infinity.
For syntax, see Table 203: Rela
tive date and time operators.
Relative period of time ending

ending

Date and time fields only.

in the past or in the future (for
example, 7 days ago, or 7 days
ahead) and including all data un
til this point. For syntax, see Ta
ble 203: Relative date and time
operators.
begins_with

String begins with the specified

String fields only.

value.
not_begins_-

String does not begin with the

with

specified value.

contains

String contains the specified val

String fields only.

String fields only.

ue.
not_contains

String does not contain the speci String fields only.
fied value.

ends_with

String ends with the specified val String fields only.
ue.

not_ends_with

String does not end with the

String fields only.

specified value.
is_empty

Column does not contain any val Selected columns only.
ue.
Example:

Table 202. Operators (continued)
Operator

Description
•

Applicable to

https://hostname:port
/api/sam/v2/software_
instances?token=token
&criteria={"and":[["e
xclusion_or_suppress_
comment","is_empty"]]
}

is_not_empty

Column contains a value.

Selected columns only.

Example:
•

https://hostname:port
/api/sam/v2/software_
instances?token=token
&criteria={"and":[["e
xclusion_or_suppress_
comment","is_not_empt
y"]]}

Syntax of relative date and time operators
These operators can be used for all columns that use the date and time format.
Note: This contract API is applicable to old contracts (deprecated contracts). New
contracts do not use this API. For details about new contracts, refer to new contract
management.

Table 203. Relative date and time operators
Operator

Syntax

last

Px[D|W|M|Y]

next

where x is a number in the 1-999 range, and D, W, M, or Y is a desig
nator that represents days, weeks, months, or years respectively. For
example:
• Retrieve data from computers that reported within last 7 days:
https://hostname:port/api/sam/computer_systems?tok
en=token
&criteria={"and":[["last_seen","last","P7D"]]}

• Retrieve contracts whose entitlement ends within next 7 days:
https://hostname:port/api/sam/contracts?token=toke
n
&criteria={"and":[["entitlement_end","next","P7D"]
]}
starting

[-|+]Px[D|W|M|Y]

ending

where x is a number in the 1-999 range, -/+ stands for ago or ahead,
and D, W, M, or Y is a designator that represents days, weeks,
months, or years respectively. For example:
• Retrieve contracts whose maintenance starts in a period of
time starting 1 week ahead. This API retrieves only future con
tracts.
https://hostname:port/api/sam/contracts?token=toke
n
&criteria={"and":[["maintenance_start","starting",
"+P1W"]]}

Table 203. Relative date and time operators (continued)
Operator

Syntax
• Retrieve contracts whose entitlement ends in a period of time
ending 1 day ago. This API retrieves all possible contracts
from the past until a day ago:
https://hostname:port/api/sam/contracts?token=toke
n
&criteria={"and":[["entitlement_end","ending","-P1
D"]]}

Response elements for GET requests
Table 204. Response elements for GET requests
Element
total

Description
Number of all records that meet query parameter. The number of re
turned records might be smaller, for example if you use the limit para
meter.

rows

Records that are returned by the query.

Mapping REST API versions
Available from 9.2.8. For some REST APIs, version 2 is created to provide improved
functions or experience. In such cases, the original API becomes deprecated with time and
only version 2 is further developed. If you have custom tools or internal processes that are
based on such REST APIs, it is best to adjust the tools to use the new version of the APIs.

Mapping columns between software_instances and v2/
software_instances REST API
Available from 9.2.8. If you have custom tools or internal processes that use the
software_instances REST API, learn how columns in this API map to the columns in the v2/
software_instances API. It is best to adjust the tools to use REST API in version 2.

The amount of data returned by the v2/software_instances API might be greater than
the amount of data returned by the software_instances API. It happens because the v2/
software_instances API returns historical data about uninstalled software and removed
computers. It also returns multiple records if software is installed in multiple locations on
the same computer. The software_instances API does not return this data.
Note: If a column from the software_instances API that you use does not map to
any column in the v2/software_instances API or the mapping provides insufficient
granularity of information, submit an idea.

Table 205. Mapping software_instances to v2/software_instances REST API
software_instances API

v2/software_instances API

Comment

id
software_fact_id
computer_system_id

Computer systems are sub
stituted with computers.

computer_id

computer_id

discoverable_guid

discoverable_guid

default_product_guid

The default_product_guid
column provides infor
mation about the default
bundling.
REST API version 2, pro
vides information about the
product to which the com
ponent is in fact assigned.
The information is provided

Table 205. Mapping software_instances to v2/software_instances REST API
(continued)
software_instances API

v2/software_instances API

Comment
in the product_name col
umn.

first_used

usage_data.first_used

last_used

usage_data.last_used

valid_from

discovery_start

valid_to

discovery_end

The valid_to col
umn always shows
9999-12-31T23:59:59Z

because the software_in
stances REST API does not
provide historical data.
The discovery_end column
provides the actual date
when the component was
reported for the last time.
updated_at
signature_count
total_time

usage_data.total_time

total_runs

usage_data.total_runs

avg_run_time

usage_data.avg_run_time

avg_runs_per_day

usage_data.avg_runs_per_
day

process

usage_data.process

Table 205. Mapping software_instances to v2/software_instances REST API
(continued)
software_instances API
deleted

v2/software_instances API
is_present

Comment
The deleted column always
shows false.
The is_present column pro
vides the actual informa
tion.

catalog_dimension.soft

product_name

ware_title_name*
catalog_dimension.pub

log_dimension columns
product_publisher_name

lisher_name*
catalog_dimension.soft

sion*

provide information about
the default product. In
some cases, the columns

product_release_name

ware_title_release_name*
catalog_dimension.ver

In most cases, the cata

provide information about
the component.

product_release
Important: * If the
catalog_dimen
sion columns con
tain information
about a compo
nent, there is no
mapping between
REST API version
1 and version 2 be
cause REST API
version 2 always
provides informa
tion about the prod
uct to which the

Table 205. Mapping software_instances to v2/software_instances REST API
(continued)
software_instances API

v2/software_instances API

Comment
component is in
fact assigned.

catalog_dimension.soft
ware_title_version_name

Mapping columns between computer_systems and v2/computers
REST API
Available from 9.2.8. If you have custom tools or internal processes that use the
computer_systems REST API, learn how columns in this API map to the columns in the v2/
computers API. It is best to adjust the tools to use REST API in version 2.
Note: If a column from the computer_systems API that you use does not map to
any column in the v2/computers API or the mapping provides insufficient granularity
of information, submit an idea.

Table 206. Mapping computer_systems to v2/computers REST API
computer_systems API

computers API

id

Comments
Computer systems are sub
stituted with computers.

parent_id

Computer systems are sub
stituted with computers.
Additionally, REST API ver
sion 2 is not hierarchical.

computer_id

id

computer_remote_id

bigfix_id

Table 206. Mapping computer_systems to v2/computers REST API (continued)
computer_systems API
server_id

computers API

Comments

computer_hardware.serv
er_id

datasource_name
datasource_id
type

computer_hardware.com

REST API version 2 has

puter_type

three possible values: phys
ical, virtual, and computer
running on a public cloud.

os

os

host_name

name

dns_name

dns_name

ip_address

ip_address

last_seen

last_seen

hardware_manufacturer

The information is con
tained in the computer_
hardware.server_name col
umn.

hardware_model

The information is con
tained in the computer_
hardware.server_name col
umn.

hardware_serial_number

The information is con
tained in the computer_
hardware.server_name col
umn.

Table 206. Mapping computer_systems to v2/computers REST API (continued)
computer_systems API

computers API

hardware_type

Comments
The information is con
tained in the computer_
hardware.server_name col
umn.

hardware_name

computer_hardware.serv
er_name

processor_brand_string

computer_hard
ware.processor_brand_
string

processor_type

computer_hard
ware.processor_type

processor_brand

computer_hard
ware.processor_brand

processor_vendor

computer_hard
ware.processor_vendor

partition_cores

computer_hardware.parti
tion_cores

server_processors

computer_hardware.n
ode_total_processors

server_cores

computer_hardware.serv
er_cores

pvu_per_core

computer_hardware.pvu_
per_core

uuid

Table 206. Mapping computer_systems to v2/computers REST API (continued)
computer_systems API

computers API

cluster_id

Comments
Cluster ID is substituted
with cluster name that is
available in the comput
er_hardware.cluster_name
column.

Mapping functions of the software_instances REST API
Available from 9.2.14. If you have custom tools or internal processes that use
the software_instances REST API, learn how to achieve your goals by using the v2/
license_usage and v2/software_instances REST API. It is best to adjust the tools to use

REST API in version 2.

Mapping software_instances REST API functions
The software_instances REST API allows you to retrieve information about the software
instance that contributed to the peak in the utilization of a license metric by a product
during the reporting period. By default, the reporting period is set to 90 days.
The v2/software_instances REST API allows you to retrieve information about all software
instances in your environment. Additionally, you can retrieve data from any relevant period,
including the details of existing components as well as historical data about components
that were removed. By filtering the data you can narrow down the results to the instances
that contributed to the peak in the utilization of a license metric by a product. Combining the
capabilities of v2/license_usage and v2/software_instances APIs can not only substitute
all functions of the old version of software_instances API, but also guarantees flexibility
that allows you to alter the queries and retrieve the required data sample.

Examples
Scenario: Retrieving information about the software instances that contributed to the peak
in the utilization of a license metric by a product

• software_instances API allows you to only retrieve information about the software
instances that contributed to the peak of a license metric of a product over a reporting
period.
Figure 11. Software instances that can be retrieved with the
software_instances REST API

• v2/license_usage and v2/software_instances APIs allow you to retrieve the
following information:

◦ The list of all software instances that were used within a specified period
Figure 12. Software instances that can be retrieved with the v2/
software_instances REST API

◦ The time of the peak in the utilization of a license metric by a product with the
hwm_peak_time parameter value

◦ The list of software instances that contributed to the peak
◦ The overall utilization of a license metric of a product during the peak
To retrieve information about the software instances that contributed to the peak in
the utilization of a license metric by a product proceed with the following steps.
1. Run the v2/license_usage REST API for a product and the license metric that is
assigned to this product.
Example
GET
api/sam/v2/license_usage?columns[]=product_name&columns[]=metric
_code_name&columns[]=hwm_quantity&
columns[]=hwm_peak_time&criteria={"and":[["product_name","=","IBM
DB2 Advanced Enterprise Server Edition PVU Option"]]}
&token=7adc3efb175e2bc0f4484bdd2efca54a8fa04623
Host: localhost:9081

Accept: application/json
Accept-Language: en-US

2. See the value of the hwm_peak_time column for the product-license pair in the
response.
Example
[{
"product_name": "IBM DB2 Advanced Enterprise Server Edition PVU
Option",
"metric_code_name": "PVU_SUB_CAP",
"hwm_quantity": 960,
"hwm_peak_time": "2018-10-11T01:12:26Z"
}]

3. Run the v2/software_instances REST API with the filter on the following
columns: Discovery Start and Discovery End. Base the dates on the value of
hwm_peak_time.

Example
GET
api/sam/v2/software_instances?columns[]=discovery_start&columns[
]=discovery_end&columns[]=product_name&
columns[]=metric_id&columns[]=computer_name&criteria={"and":[["pr
oduct_name","=
","IBM DB2 Advanced Enterprise Server Edition PVU
Option"],["metric_id","=","5"],["discovery_start", "<=",
"2018-10-11T01:12:26Z"],
["discovery_end", ">",
"2018-10-11T01:12:26Z"]]}&token=7adc3efb175e2bc0f4484bdd2efca54a
8fa04623
Host: localhost:9081
Accept: application/json
Accept-Language: en-US

Note: The example uses the timestamp format used for PVU, RVP
MPAC and VPC metrics. For different metrics, see: Retrieval of software
inventory (v2).
4. See the results for a list of software instances that contributed to the peak.

REST API for retrieving authentication token
You use the POST operation on the api/get_token element to request your unique token that
is required to authenticate the REST API requests.
To request your unique token, use the following URL:
https://hostname:port/api/get_token

Important: This REST API call does not work when single sign-on authentication is
enabled. To view the token, log in to BigFix Inventory, hover over the User icon

,

and click Profile. Then, click Show token.

Table 207. Operation descriptions
Operation details

Description

Operation

POST /api/get_token

Purpose

Returns the authentication token

HTTP method

POST

Resource URI

https://server_host_name:port_number/api/
get_token

URL link relation

n/a

URI query parameters

n/a

Request headers

Header
Accept-Language (optional)

Table 207. Operation descriptions (continued)
Operation details

Description
Values
en-US (only English is supported)
Used to negotiate the language of the response. If this
header is not specified, the content is returned in the
server language.

Request payload

{
"user" : "username",
"password" : "password"
}

Request Content-Type
Response headers

application/json

Header
Content-Type

Values
application/json

Specifies the content type of the response.
Header
Content-Language

Values
en-US, …
Specifies the language of the response content. If this
header is not specified, the content is returned in the
server language.
Response payload
Response Content-Type

Token element
application/json

Table 207. Operation descriptions (continued)
Operation details

Description

Normal HTTP response

200 – OK

codes
Error HTTP response codes

401 – “Unauthorized”

There is no match for the provided user name and
password. If you are using Active Directory, ensure the
user name is followed by a domain name, for example
username@domain.com.

Example HTTP conversation
Request
POST api/get_token
Host: localhost:9081
Accept: application/json
Accept-Language: en-US

Request header
Content-Type: application/json

Request payload
{
"user" : "admin",
"password" : "password"
}

Response header

HTTP/1.1 200 OK
Content-Type: application/json
Content-Language: en-US

Response body (JSON)
{
"token":"44072fb20fbe38322b5e67a7e780978e20abbc80"
}

REST API for retrieving the BigFix Inventory version
You use the GET operation on the api/sam/about element to request information about the
version of BigFix Inventory.
To retrieve information about the current version of BigFix Inventory, use the following URL:
https://hostname:port/api/sam/about?token=token

Important:
• To use this API, you must be assigned to the All Computers group and have
the View Hardware Inventory permission.
• Each API request must be authenticated with the token parameter. You can
retrieve it by using REST API for retrieving authentication token. You can also
log in to BigFix Inventory, hover over the User icon

, and click Profile. Then,

click Show token.
• By default, the retrieved data is sorted by id.

Table 208. Operation descriptions
Operation details
Operation

Description
GET /api/sam/about

Table 208. Operation descriptions (continued)
Operation details

Description

Purpose

Returns the version of BigFix Inventory

HTTP method

GET

Resource URI

https://server_host_name:port_number/api/
sam/about

URL link relation

n/a

URI query parameters

n/a

Request headers

Header
Accept-Language (optional)

Values
en-US (only English is supported)
Used to negotiate the language of the response. If this
header is not specified, the content is returned in the
server language.
Request payload
Request Content-Type
Response headers

n/a
application/json

Header
Content-Type

Values
application/json

Specifies the content type of the response.
Header
Content-Language

Values

Table 208. Operation descriptions (continued)
Operation details

Description
en-US, …
Specifies the language of the response content. If this
header is not specified, the content is returned in the
server language.

Response payload

About element

Response Content-Type

application/json

Normal HTTP response

200 – OK

codes
Error HTTP response codes

500 – “Bad Request” if a query parameter con

tains errors or is missing
Message body includes an error message with details.

Example HTTP conversation
Request
GET api/sam/about
?token=7adc3efb175e2bc0f4484bdd2efca54a8fa04623
Host: localhost:9081
Accept: application/json
Accept-Language: en-US

Response header
HTTP/1.1 200 OK
Content-Type: application/json
Content-Language: en-US

Response body (JSON)

{
"product": "BigFix Inventory",
"version": "9.2.20140331-2015"
}

Core APIs
Core APIs include all primary set of APIs that are integrated with BigFix Inventory.

Below APIs are supported:
• REST API for hardware (v2)
• REST APIs for retrieving software inventory, metric utilization and classifying software
(v2)
• REST API associations
Use REST API for retrieving raw scan results for advanced integration and providing more
insight to the environment.

REST API for hardware (v2)
Available from 9.2.8. You can use REST API requests to quickly retrieve large
amounts of data related to hardware inventory, including historical data about removed
computers. You can then pass this data to other applications for further processing and
analysis.

Retrieval of hardware inventory (v2)
Available from 9.2.8. You use the GET operation on the api/sam/v2/computers
element to request information about computers in your infrastructure. The API returns
details of existing computers as well as historical data about computers that were removed.

Permissions
You must have the View Endpoints and View Hardware Inventory permission to use this
API.

Resource URL
https://hostname:port/api/sam/v2/computers?token=token

Resource information
Table 209. Resource information
Operation details
HTTP method
Request headers

Description
GET

Header
Accept-Language (optional)

Values
en-US (only English is supported)
Negotiates the language of the response. If the header
is not specified, the content is returned in the server lan
guage.
Request format
Response headers

application/json

Header
Content-Type

Values
application/json

Specifies the content type of the response.
Header
Content-Language

Values
en-US, …

Table 209. Resource information (continued)
Operation details

Description
Specifies the language of the response content. If the
header is not specified, the content is returned in the serv
er language.

Response payload

Computer Systems element

Response format

application/json

Response codes

200 – OK
500 – "Bad Request" if a query parameter contains er

rors or is missing

Schema description
To retrieve the list of all columns that are returned by this REST API together with their
descriptions, use the following request.
GET api/sam/v2/schemas/computer.json?token=token

Available columns
Table 210. Available columns
Dis
Column

Description

played
Type
by de
fault

id

Identifier of the computer as defined in BigFix Inven

Nu

tory.

mer
ic

bigfix_id

Identifier of the computer as defined in BigFix.

Nu
mer
ic

Table 210. Available columns (continued)
Dis
Column

Description

played
Type
by de
fault
✓

name

Name of the computer.

String

dns_name

DNS of the computer.

ip_address

IP address of the computer.

os

Operating system of the computer.

os_type

Type of the operating system of the computer.

String

first_seen

Date and time when the computer reported to Big

String

String
✓
✓

String
String

Fix for the first time. The time is specified in the GMT
time zone.
last_seen

Date and time when the computer reported to Big
Fix for the last time. The time is specified in the GMT

✓

String

✓

Boolean

time zone.
is_deleted

Information whether the computer was removed.

deletion_date

Date and time when the computer was removed. The

String

time is specified in the GMT time zone.
is_managed_by_vm_

Information whether the computer is managed by a

manager

VM manager.

Applicable associations
You can additionally retrieve data from the following associations:
•

computer_details

• computer_hardware
• computer_health

Boolean

•

mounted_shared_disks

•

detailed_hw_ip_addresses

•

detailed_hw_lpars

•

detailed_hw_memories

•

detailed_hw_network_adapters

•

detailed_hw_operating_systems

•

detailed_hw_partitions

•

detailed_hw_physical_processors

•

detailed_hw_smbios

•

detailed_hw_storages

Note: Retrieving data from multiple API associations in a single request might
increase the response time.
For more information about how to use API associations, see: REST API associations.
Important: All associations provide data about items that currently exist in the
infrastructure. For removed computers and uninstalled software, these associations
return null.

Query parameters
Table 211. Query parameters
Parameter
columns

Description
Specify which columns to retrieve. If you do not
specify this parameter, only default columns are
retrieved.
Example: Retrieve product name and release
URL?columns[]=first_seen

Required

Value
String

Table 211. Query parameters (continued)
Parameter
order

Description

Required

Specify how to sort the returned data. The de

Value
String

fault direction for sorting columns is ascending.
If you want to specify a descending sort, append
desc to the column name.

Example: Order by computer ID descending:
URL?order[]=id desc

limit

Specify the number of rows to retrieve. If you

Numeric

omit this parameter, all rows are retrieved.
Example: Retrieve 100 records
URL?limit=100

offset

Specify the number of rows to skip for retrieving

Numeric

results. You can use it together with the limit pa
rameter to paginate results.
Example: Retrieve 50 records starting after
record 150
URL?limit=50&offset=150

token

A unique user authentication identifier. You can
retrieve it by using REST API for retrieving au

✓

Alphanu
meric

thentication token. You can also log in to BigFix
Inventory, hover over the User icon

, and click

Profile. Then, click Show token.
criteria

Retrieve records which match specific condi
tions. The parameter should have the following
structure, written in one line:

String

Table 211. Query parameters (continued)
Parameter

Description
<criteria> ::= <left-brace>
<boolean-operator><colon>
<left-bracket>
<criterion> [{ <comma>
<criterion> }...] <right-bracket>
<right-brace>
<boolean-operator> ::= "and" | "or"
<criterion> ::= <criteria> |
<left-bracket> <column> <comma>
<operator> <comma> <value>
<right-bracket>
<column> ::= <json-string>
<operator> ::= <json-string>
<value> ::= <json-array> |
<json-string> | <json-numver> |
<json-null>

For more information about operators, see: Com
mon connectors and operators.
Example: retrieve computers that reported for
the first time within a specific date range:
URL?criteria={"and":[["first_seen",
">", "1970-01-01T00:00:00+00:00Z"],
["first_seen", "<",
"1970-01-02T00:00:00+00:00Z"]]}

For columns that use the date and time values,
you can retrieve data also for a period instead
of a specific date. To do so, use last or next as
<operator>, and then specify the time value

Required

Value

Table 211. Query parameters (continued)
Parameter

Description

Required

in the following convention: PxD/PxW/PxM/PxY,
where x is a number in the 1-999 range, and D,
W, M, or Y is a designator that represents days,
weeks, months, or years respectively.
Example: Retrieve computers that were first re
ported within the last 7 days
URL?
criteria={"and":[["first_seen","last","
P7D"]]}

Example conversation - default columns
Request
GET api/sam/v2/computers?token=7adc3efb175e2bc0f4484bdd2efca54a8
fa04623
Host: localhost:9081
Accept: application/json
Accept-Language: en-US

Response body
[{
"name":"NC9143126194",
"ip_address":["9.143.126.194"],
"os":"Win2012R2 6.3.9600",
"last_seen":"2016-09-22T10:32:12Z",
"is_deleted":1
}]

Value

Example conversation - all columns
Request
GET api/sam/v2/computers?columns[]=id&columns[]=bigfix_id
&columns[]=name&columns[]=dns_name
&columns[]=ip_address&columns[]=os&columns[]=os_type
&columns[]=first_seen&columns[]=last_seen&columns[]=is_deleted
&columns[]=deletion_date&columns[]=is_managed_by_vm_manager
&token=7adc3efb175e2bc0f4484bdd2efca54a8fa04623
Host: localhost:9081
Accept: application/json
Accept-Language: en-US

Response body
[{
"id":2,
"bigfix_id":11368943,
"name":"NC9143126194",
"dns_name":"NC9143126194",
"ip_address":["9.143.126.194"],
"os":"Win2012R2 6.3.9600",
"os_type":"Windows",
"first_seen":"2016-10-04T09:42:55Z",
"last_seen":"2016-09-22T10:32:12Z",
"is_deleted":1,
"deletion_date":"2016-12-19T09:40:14Z",
"is_managed_by_vm_manager":0
}]

Example conversation - additional column
Request

GET api/sam/v2/computers?columns[]=id
&columns[]=is_deleted&columns[]=deletion_date
&token=7adc3efb175e2bc0f4484bdd2efca54a8fa04623
Host: localhost:9081
Accept: application/json
Accept-Language: en-US

Response body
[{
"id":21,
"is_deleted":1,
"deletion_date":"2016-10-18T14:51:52Z"
}]

Example conversation - association
Request
GET api/sam/v2/computers?columns[]=id
&columns[]=computer_health.catalog_version
&token=7adc3efb175e2bc0f4484bdd2efca54a8fa04623
Host: localhost:9081
Accept: application/json
Accept-Language: en-US

Response body
[{
"id":1,
"catalog_version":1304630
}]

Related reference
Running data imports
Retrieving raw scanned file data
Retrieving raw package data
Retrieving raw UNIX package data
Retrieving raw metering data
Retrieval of shared disks (v2)
Related information
REST API for retrieving detailed hardware information (v2)

Retrieval of shared disks (v2)
Available from 9.2.12. You use the GET operation on the api/sam/v2/
shared_disks element to request information about shared disks that are used in your

infrastructure.

Prerequisites
Before you can retrieve information about shared disks by using the REST API, discover the
shared disks in your infrastructure. For more information, see: Step 1: Discovering remote
shared disks.

Permissions
You must have the View Shared Disks permissions to use this API.

Resource URL
https://hostname:port/api/sam/v2/shared_disks?token=token

Resource information
Table 212. Resource information
Operation details
HTTP method
Request headers

Description
GET

Header
Accept-Language (optional)

Values
en-US (only English is supported)
Negotiates the language of the response. If the header
is not specified, the content is returned in the server lan
guage.
Request format
Response headers

application/json

Header
Content-Type

Values
application/json

Specifies the content type of the response.
Header
Content-Language

Values
en-US, …
Specifies the language of the response content. If the
header is not specified, the content is returned in the serv
er language.
Response payload

Shared Disks element

Table 212. Resource information (continued)
Operation details

Description

Response format

application/json

Response codes

200 – OK
403 – “Forbidden” if the user is not authorized to per

form the action
500– “Bad Request” if a query parameter contains errors

or is missing

Schema description
To retrieve the list of all columns that are returned by this REST API together with their
descriptions, use the following request.
GET api/sam/v2/schemas/shared_disk.json?token=<token>

Available columns
Table 213. Available columns
Dis
Column

Description

played
Type
by de
fault

id

Identifier of the shared disk instance.

✓

In
te
ger

status

Indicates the status of the computer that is designat ✓

In

ed to scan the shared disk instance. Possible values

te

are:

ger
• 0 - Shared disk detected
• 1 - Child shared disk

Table 213. Available columns (continued)
Dis
Column

Description

played
Type
by de
fault

• 2 - Designating a computer
• 3 - Waiting for software scan
• 4 - OK
• 5 - Designating new top-level directory
• 6 - Designating a new computer
• 7 - Waiting for software scan on the newly des
ignated computer
parent_id

Identifier of the parent of the shared disk instance.

✓

In
te
ger

top_level

Indicates whether the shared disk is a top-level direc

Boolean

tory in the shared disk structure. Possible values are:
• 0 - The directory is not top-level
• 1 - The directory is top-level
exported_directory

Exported directory of the shared disk.

type

Type of the shared disk. Possible values are:

✓

String

✓

In
te

• 0 - Network File System

ger

• 1- Samba File System
computers_count

Number of computers on which the shared disk is
mounted.

✓

In
te
ger

Applicable associations
You can additionally retrieve data from the following associations:
• designated_computer
• shared_disk_members

Query parameters
Table 214. Query parameters
Parameter
columns[]

Description
Specify which columns to retrieve. If you do not

Required

Value
String

specify this parameter, only default columns are
retrieved.
Example: Retrieve product name and release
URL?
columns[]=product_name&columns[]=produc
t_release

order

Specify how to sort the returned data. The de

Alphanu

fault direction for sorting columns is ascending.

meric

If you want to specify a descending sort, append
desc to the column name.

Example: Order by computer ID descending
URL?order[]=computer_id desc

limit

Specify the number of rows to retrieve. If you
omit this parameter, all rows are retrieved.
Example: Retrieve 100 records
URL?limit=100

Numeric

Table 214. Query parameters (continued)
Parameter
offset

Description

Required

Specify the number of rows to skip for retrieving

Value
Numeric

results. You can use it together with the limit pa
rameter to paginate results.
Example: Retrieve 50 records starting after
record 150
URL?limit=50&offset=150

token

A unique user authentication identifier. You can
retrieve it by using REST API for retrieving au

✓

Alphanu
meric

thentication token. You can also log in to BigFix
Inventory, hover over the User icon

, and click

Profile. Then, click Show token.
criteria

Retrieve records which match specific condi
tions. The parameter should have the following
structure, written in one line:
<criteria> ::= <left-brace>
<boolean-operator> <colon>
<left-bracket>
<criterion> [{ <comma>
<criterion> }...] <right-bracket>
<right-brace>
<boolean-operator> ::= "and" | "or"
<criterion> ::= <criteria> |
<left-bracket> <column> <comma>
<operator> <comma> <value>
<right-bracket>
<column> ::= <json-string>
<operator> ::= <json-string>

String

Table 214. Query parameters (continued)
Parameter

Description
<value> ::= <json-array> |
<json-string> | <json-number> |
<json-null>

For more information about operators, see: Com
mon connectors and operators.
Example: Retrieve software instances whose
product name contains "BigFix" OR the discovery
start is within a specific date range
URL?criteria={ "or": [ ["product_name",
"contains", "BigFix"],
{ "and": [ ["discovery_start", ">",
"1970-01-01T00:00:00+00:00Z"],
["discovery_start", "<",
"1970-01-02T00:00:00+00:00Z"] ] } ] }

For columns that use the date and time values,
you can retrieve data also for a period instead
of a specific date. To do so, use last or next as
<operator>, and then specify the time value
in the following convention: PxD/PxW/PxM/PxY,
where x is a number in the 1-999 range, and D,
W, M, or Y is a designator that represents days,
weeks, months, or years respectively.
Example: Retrieve software instances that were
first reported within the last 7 days
URL?
criteria={"and":[["discovery_start","la
st","P7D"]]}

Required

Value

Example conversation - default columns
Request
GET api/sam/v2/shared_disks?token=7adc3efb175e2bc0f4484bdd2efca5
4a8fa04623
Host: localhost:9081
Accept: application/json
Accept-Language: en-US

Response body
[{
"id":"5",
"status":"0"'
"type":"0"
"designated_computer_id":"29"
"parent_id":"3"
"computers_count":"10"
"exported_directory":"192.0.2.24:/file_server/tlcm/ISO/RHEL"

Example conversation - all columns
Request
GET api/sam/v2/shared_disks?columns[]=id&columns[]=status
&columns[]=parent_id&columns[]=top_level&columns[]=exported_dire
ctory
&columns[]=type&columns[]=computers_count&columns[]=designated_c
opmuter_id
&token=7adc3efb175e2bc0f4484bdd2efca54a8fa04623

Response body
[{
"id":"1",
"status":"0",

"parent_id":"5",
"top_level":"0",
"exported_directory":"192.0.2.24:/file_server/tlcm/HOME"
"type":"0",
"computers_count":"10",
"designated_computer_id":"29"

Example conversation - association
Request
GET api/sam/v2/shared_disks?columns[]=exported_directory
&columns[]=computers_count&columns[]=shared_disk_members.compute
r_id
&columns[]=shared_disk_members.mount_point&token=7adc3efb175e2bc
0f4484bdd2efca54a8fa04623
Host: localhost:9081
Accept: application/json
Accept-Language: en-US

Response body
[{
"exported_directory":"192.0.2.24:/file_server/tlcm/HOME",
"computers_count":"1",
"members":
{
"computer_id":"5",
"mount_point":"/mnt/fs"
}
}]

Related reference
Running data imports
Retrieving raw scanned file data
Retrieving raw package data
Retrieving raw UNIX package data
Retrieving raw metering data
Retrieval of hardware inventory (v2)
Related information
REST API for retrieving detailed hardware information (v2)

REST API for retrieving detailed hardware information (v2)
You can use REST API requests to retrieve data related to detailed hardware information,
such as memory, operating systems, storage, processors, partitions, network adapters,
SMBIOS data, IP addresses and logical partition capacity data. You can then pass this data
to other applications for further processing and analysis.
Note: The APIs from this section can be used as associations to the api/sam/v2/
computers API.

Related reference
Running data imports
Retrieving raw scanned file data
Retrieving raw package data
Retrieving raw UNIX package data
Retrieving raw metering data

Retrieval of hardware inventory (v2)
Retrieval of shared disks (v2)

Retrieval of IP addresses (v2)
Available from 9.2.12. You use the GET operation on the api/sam/v2/
detailed_hw_ip_addresses element to request information related to IP addresses of

computers in your infrastructure.

Permissions
You must have the View Endpoints and View Hardware Inventory permission to use this
API.

Resource URL
https://hostname:port/api/sam/v2/detailed_hw_ip_addresses?token=token

Resource information
Table 215. Resource information
Operation details
HTTP method
Request headers

Description
GET

Header
Accept-Language (optional)

Values
en-US (only English is supported)
Negotiates the language of the response. If the header
is not specified, the content is returned in the server lan
guage.
Request format

application/json

Table 215. Resource information (continued)
Operation details
Response headers

Description
Header
Content-Type

Values
application/json

Specifies the content type of the response.
Header
Content-Language

Values
en-US, …
Specifies the language of the response content. If the
header is not specified, the content is returned in the serv
er language.
Response payload

IP Addresses element

Response format

application/json

Response codes

200 – OK
500 – "Bad Request" if a query parameter contains er

rors or is missing

Schema description
To retrieve the list of all columns that are returned by this REST API together with their
descriptions, use the following request.
GET api/sam/v2/schemas/detailed_hw_ip_address.json?token=token

Available columns
The list of attributes related to IP addresses on the scanned system. The retrieved
addresses are in the IPv4 format, except for the ipv6_address attribute.
The output might contain multiple instances of each attribute from this group.
Table 216. Columns with information related to IP addresses
Property
id

Description
Identifier of the record.

Type
In
te
ger

computer_id Identifier of the computer as specified in the BigFix Inventory data
base.

In
te
ger

updated_at

Date and time when the current information was imported to BigFix String
Inventory.

address

IP address of the computer.

String

hostname

Host name of the computer with the given IP.

String

primary_dns Primary domain name system (DNS).

String

permanen

Permanent media access control (MAC) address associated with

String

t_mac_ad

the given IP address.

dress
ipv6_ad

IP address in version 6.

dress

Related APIs
This API can be associated with the following API:
• Retrieval of hardware inventory (v2)

String

Query parameters
Table 217. Query parameters
Parameter
columns[]

Description
Specify which columns to retrieve. If you do not

Required

Value
String

specify this parameter, only default columns are
retrieved.
Example: Retrieve the computer ID:
URL?columns[]=computer_id

order

Specify how to sort the returned data. The de

String

fault direction for sorting columns is ascending.
If you want to specify a descending sort, append
desc to the column name.

Example: Order by computer ID descending:
URL?order[]=computer_id desc

limit

Specify the number of rows to retrieve. If you

Numeric

omit this parameter, all rows are retrieved.
Example: Retrieve 100 records
URL?limit=100

Note: By default the limit parameter for
this API is set to 100000.
offset

Specify the number of rows to skip for retrieving
results. You can use it together with the limit pa
rameter to paginate results.
Example: Retrieve 50 records starting after
record 150

Numeric

Table 217. Query parameters (continued)
Parameter

Description

Required

Value

URL?limit=50&offset=150

token

A unique user authentication identifier. You can
retrieve it by using REST API for retrieving au

✓

Alphanu
meric

thentication token. You can also log in to BigFix
Inventory, hover over the User icon

, and click

Profile. Then, click Show token.
criteria

Retrieve records which match specific condi
tions. The parameter should have the following
structure, written in one line:
<criteria> ::= <left-brace>
<boolean-operator><colon>
<left-bracket>
<criterion> [{ <comma>
<criterion> }...] <right-bracket>
<right-brace>
<boolean-operator> ::= "and" | "or"
<criterion> ::= <criteria> |
<left-bracket> <column> <comma>
<operator> <comma> <value>
<right-bracket>
<column> ::= <json-string>
<operator> ::= <json-string>
<value> ::= <json-array> |
<json-string> | <json-numver> |
<json-null>

For more information about operators, see: Com
mon connectors and operators.

String

Table 217. Query parameters (continued)
Parameter

Description

Required

Example: retrieve computers with computer ID
greater than 1000.
URL?criteria={"and":[["computer_id",
">", "1000"]]}

For columns that use the date and time values,
you can retrieve data also for a period instead
of a specific date. To do so, use last or next as
<operator>, and then specify the time value
in the following convention: PxD/PxW/PxM/PxY,
where x is a number in the 1-999 range, and D,
W, M, or Y is a designator that represents days,
weeks, months, or years respectively.

Example conversation - default columns
Request
GET /api/sam/v2/detailed_hw_ip_addresses?token=7adc3efb175e2bc0f
4484bdd2efca54a8fa04623
Host: localhost:9081
Accept: application/json
Accept-Language: en-US

Response body
[{
"id":1
"computer_id":1,
"updated_at":"2018-05-16T14:37:08Z",
"address":"9.174.39.183",
"hostname":"NC9174039183",

Value

"primary_dns":"9.20.136.11",
"permanent_mac_address":"00:50:56:94:7C:95",
"ipv6_address":"fe80:0000:0000:0000:44a3:f150:0968:869e%2"
}]

Example conversation - selected columns
Request
GET api/sam/v2/detailed_hw_ip_addresses?columns[]=computer_id
&columns[]=primary_dns
&token=7adc3efb175e2bc0f4484bdd2efca54a8fa04623
Host: localhost:9081
Accept: application/json
Accept-Language: en-US

Response body
[{
"computer_id":1,
"primary_dns":"9.20.136.11"}
}]

Retrieval of information related to logical partition capacity (v2)
Available from 9.2.12. You use the GET operation on the api/sam/v2/
detailed_hw_lpars element to request information related to the logical partition and its

CPU resources. The data retrieved by this API is not limited to LPARs on POWER. It includes
data related to every supported virtualization technology.

Permissions
You must have the View Endpoints and View Hardware Inventory permission to use this
API.

Resource URL
https://hostname:port/api/sam/v2/detailed_hw_lpars?token=token

Resource information
Table 218. Resource information
Operation details
HTTP method
Request headers

Description
GET

Header
Accept-Language (optional)

Values
en-US (only English is supported)
Negotiates the language of the response. If the header
is not specified, the content is returned in the server lan
guage.
Request format
Response headers

application/json

Header
Content-Type

Values
application/json

Specifies the content type of the response.
Header
Content-Language

Values
en-US, …

Table 218. Resource information (continued)
Operation details

Description
Specifies the language of the response content. If the
header is not specified, the content is returned in the serv
er language.

Response payload

LPARS element

Response format

application/json

Response codes

200 – OK
500 – "Bad Request" if a query parameter contains er

rors or is missing

Schema description
To retrieve the list of all columns that are returned by this REST API together with their
descriptions, use the following request.
GET api/sam/v2/schemas/detailed_hw_lpar.json?token=token

Available columns
The list of attributes related to the logical partition and its CPU resources.
The scan output contains a single instance of each attribute from this group.
Table 219. Columns with information about the logical partition and its CPU resources
Property
id

Description
Identifier of the record.

Type
In
te
ger

Table 219. Columns with information about the logical partition and its CPU resources
(continued)
Property
computer_id

Description

Type

Identifier of the computer as specified in the BigFix Inventory

In

database.

te
ger

updated_at

Date and time when the current information was imported to

String

BigFix Inventory.
lpar_capacity_

The number of processor cores assigned to the partition.

String

The number of active logical processors in the partition. Logi

String

in_cores
lpar_online_

processor_count cal processors are the smallest CPU entities visible in the op
erating system, which are dividable and schedulable. Depend
ing on the hardware platform, a logical processor might cor
respond to a chip, the core of a multi-core chip, or a hardware
CPU thread on a multithreaded chip or core (provided that the
feature is enabled).
lpar_online_

The number of active cores in a logical partition. The core is ac String

core_count

tive if any of the logical processors in the system is running on
this core.

lpar_online_

The number of active processor packages in the partition. The

package_count

processor package is active if any of the logical processors in
the system is running on this package.

Related APIs
This API can be associated with the following API:
• Retrieval of hardware inventory (v2)

String

Query parameters
Table 220. Query parameters
Parameter
columns[]

Description
Specify which columns to retrieve. If you do not

Required

Value
String

specify this parameter, only default columns are
retrieved.
Example: Retrieve the computer id:
URL?columns[]=computer_id

order

Specify how to sort the returned data. The de

String

fault direction for sorting columns is ascending.
If you want to specify a descending sort, append
desc to the column name.

Example: Order by computer ID descending:
URL?order[]=computer_id desc

limit

Specify the number of rows to retrieve. If you

Numeric

omit this parameter, all rows are retrieved.
Example: Retrieve 100 records
URL?limit=100

Note: By default the limit parameter for
this API is set to 100000.
offset

Specify the number of rows to skip for retrieving
results. You can use it together with the limit pa
rameter to paginate results.
Example: Retrieve 50 records starting after
record 150

Numeric

Table 220. Query parameters (continued)
Parameter

Description

Required

Value

URL?limit=50&offset=150

token

A unique user authentication identifier. You can
retrieve it by using REST API for retrieving au

✓

Alphanu
meric

thentication token. You can also log in to BigFix
Inventory, hover over the User icon

, and click

Profile. Then, click Show token.
criteria

Retrieve records which match specific condi
tions. The parameter should have the following
structure, written in one line:
<criteria> ::= <left-brace>
<boolean-operator><colon>
<left-bracket>
<criterion> [{ <comma>
<criterion> }...] <right-bracket>
<right-brace>
<boolean-operator> ::= "and" | "or"
<criterion> ::= <criteria> |
<left-bracket> <column> <comma>
<operator> <comma> <value>
<right-bracket>
<column> ::= <json-string>
<operator> ::= <json-string>
<value> ::= <json-array> |
<json-string> | <json-numver> |
<json-null>

For more information about operators, see: Com
mon connectors and operators.

String

Table 220. Query parameters (continued)
Parameter

Description

Required

Example: retrieve computers with computer ID
greater than 1000.
URL?criteria={"and":[["computer_id",
">", "1000"]]}

For columns that use the date and time values,
you can retrieve data also for a period instead
of a specific date. To do so, use last or next as
<operator>, and then specify the time value
in the following convention: PxD/PxW/PxM/PxY,
where x is a number in the 1-999 range, and D,
W, M, or Y is a designator that represents days,
weeks, months, or years respectively.

Example conversation - default columns
Request
GET api/sam/v2/detailed_hw_lpars?token=c77a88cfdde276de605c6fdee
689b7961ddb93ef
Host: localhost:9081
Accept: application/json
Accept-Language: en-US

Response body
[{
"id":1,
"computer_id":1,
"updated_at":"2018-05-28T01:22:16Z",
"lpar_capacity_in_cores":"-1.000000",
"lpar_online_processor_count":"2.000000",

Value

"lpar_online_core_count":"2.000000",
"lpar_online_package_count":"2.000000"
}]

Example conversation - selected columns
Request
GET api/sam/v2/detailed_hw_lpars?columns[]=id
&columns[]=lpar_capacity_in_cores
&token=c77a88cfdde276de605c6fdee689b7961ddb93ef
Host: localhost:9081
Accept: application/json
Accept-Language: en-US

Response body
[{
"id":1,
"lpar_capacity_in_cores":"-1.000000"
}]

Retrieval of information related to system memory (v2)
Available from 9.2.12. You use the GET operation on the api/sam/v2/
detailed_hw_memories element to request information related to the system memory of

the scanned system.

Permissions
You must have the View Endpoints and View Hardware Inventory permission to use this
API.

Resource URL
https://hostname:port/api/sam/v2/detailed_hw_memories?token=token

Resource information
Table 221. Resource information
Operation details
HTTP method
Request headers

Description
GET

Header
Accept-Language (optional)

Values
en-US (only English is supported)
Negotiates the language of the response. If the header
is not specified, the content is returned in the server lan
guage.
Request format
Response headers

application/json

Header
Content-Type

Values
application/json

Specifies the content type of the response.
Header
Content-Language

Values
en-US, …
Specifies the language of the response content. If the
header is not specified, the content is returned in the serv
er language.
Response payload

System Memory element

Table 221. Resource information (continued)
Operation details

Description

Response format

application/json

Response codes

200 – OK
500 – "Bad Request" if a query parameter contains er

rors or is missing

Schema description
To retrieve the list of all columns that are returned by this REST API together with their
descriptions, use the following request.
GET api/sam/v2/schemas/detailed_hw_memory.json?token=token

Available columns
The list of attributes related to the memory on a scanned system.
The scan output contains a single instance of each attribute from this group.
Table 222. Columns with information about the system memory
Property
id

Description
Identifier of the record.

Type
In
te
ger

computer_id

Identifier of the computer as specified in the BigFix Inventory

In

database.

te
ger

updated_at

Date and time when the current information was imported to Big

String

Fix Inventory.
total_physical

Total amount of installed memory in kilobytes (KB).

String

free_physical

Total amount of free memory on the system in kilobytes (KB).

String

Related APIs
This API can be associated with the following API:
• Retrieval of hardware inventory (v2)

Query parameters
Table 223. Query parameters
Parameter
columns[]

Description
Specify which columns to retrieve. If you do not

Required

Value
String

specify this parameter, only default columns are
retrieved.
Example: Retrieve the computer id:
URL?columns[]=computer_id

order

Specify how to sort the returned data. The de

String

fault direction for sorting columns is ascending.
If you want to specify a descending sort, append
desc to the column name.

Example: Order by computer ID descending:
URL?order[]=computer_id desc

limit

Specify the number of rows to retrieve. If you
omit this parameter, all rows are retrieved.
Example: Retrieve 100 records
URL?limit=100

Note: By default the limit parameter for
this API is set to 100000.

Numeric

Table 223. Query parameters (continued)
Parameter
offset

Description

Required

Specify the number of rows to skip for retrieving

Value
Numeric

results. You can use it together with the limit pa
rameter to paginate results.
Example: Retrieve 50 records starting after
record 150
URL?limit=50&offset=150

token

A unique user authentication identifier. You can
retrieve it by using REST API for retrieving au

✓

Alphanu
meric

thentication token. You can also log in to BigFix
Inventory, hover over the User icon

, and click

Profile. Then, click Show token.
criteria

Retrieve records which match specific condi
tions. The parameter should have the following
structure, written in one line:
<criteria> ::= <left-brace>
<boolean-operator><colon>
<left-bracket>
<criterion> [{ <comma>
<criterion> }...] <right-bracket>
<right-brace>
<boolean-operator> ::= "and" | "or"
<criterion> ::= <criteria> |
<left-bracket> <column> <comma>
<operator> <comma> <value>
<right-bracket>
<column> ::= <json-string>
<operator> ::= <json-string>

String

Table 223. Query parameters (continued)
Parameter

Description

Required

<value> ::= <json-array> |
<json-string> | <json-numver> |
<json-null>

For more information about operators, see: Com
mon connectors and operators.
Example: retrieve computers with computer ID
greater than 1000.
URL?criteria={"and":[["computer_id",
">", "1000"]]}

For columns that use the date and time values,
you can retrieve data also for a period instead
of a specific date. To do so, use last or next as
<operator>, and then specify the time value
in the following convention: PxD/PxW/PxM/PxY,
where x is a number in the 1-999 range, and D,
W, M, or Y is a designator that represents days,
weeks, months, or years respectively.

Example conversation - default columns
Request
GET api/sam/v2/detailed_hw_memories?token=7adc3efb175e2bc0f4484b
dd2efca54a8fa04623
Host: localhost:9081
Accept: application/json
Accept-Language: en-US

Response body

Value

[{
"id":1,
"computer_id":1,
"updated_at":"2018-05-28T01:22:16Z",
"total_physical":"8010840",
"free_physical":"221176"
}]

Example conversation - selected columns
Request
GET api/sam/v2/detailed_hw_memories?columns[]=id
&columns[]=total_physical
&token=7adc3efb175e2bc0f4484bdd2efca54a8fa04623
Host: localhost:9081
Accept: application/json
Accept-Language: en-US

Response body
[{
"id":1,
"total_physical":"8010840"
}]

Retrieval of information related to network adapters (v2)
Available from 9.2.12. You use the GET operation on the api/sam/v2/
detailed_hw_network_adapters element to request information related to the type, model

and MAC addresses of the network adapters.

Permissions
You must have the View Endpoints and View Hardware Inventory permission to use this
API.

Resource URL
https://hostname:port/api/sam/v2/detailed_hw_network_adapters?token=token

Resource information
Table 224. Resource information
Operation details
HTTP method
Request headers

Description
GET

Header
Accept-Language (optional)

Values
en-US (only English is supported)
Negotiates the language of the response. If the header
is not specified, the content is returned in the server lan
guage.
Request format
Response headers

application/json

Header
Content-Type

Values
application/json

Specifies the content type of the response.
Header
Content-Language

Values
en-US, …

Table 224. Resource information (continued)
Operation details

Description
Specifies the language of the response content. If the
header is not specified, the content is returned in the serv
er language.

Response payload

Network Adapter element

Response format

application/json

Response codes

200 – OK
500 – "Bad Request" if a query parameter contains er

rors or is missing

Schema description
To retrieve the list of all columns that are returned by this REST API together with their
descriptions, use the following request.
GET api/sam/v2/schemas/detailed_hw_network_adapter.json?token=token

Available columns
The list of attributes related to the network adapters.
The scan output might contain multiple instances of each attribute from this group.
Table 225. Columns with information about the network adapters
Property

Description

Type

id

Identifier of the record.

Integer

computer_id

Identifier of the computer

Integer

as specified in the BigFix
Inventory database.
updated_at

Date and time when the
current information was

String

Table 225. Columns with information about the network adapters (continued)
Property

Description

Type

imported to BigFix Invento
ry.
permanent_address

The permanent media ac

String

cess control (MAC) ad
dress associated with the
adapter.
current_address

The current network ad

String

dress of the adapter.
type

The type of network

String

adapter.
model

The model of the network

String

adapter.

Related APIs
This API can be associated with the following API:
• Retrieval of hardware inventory (v2)

Query parameters
Table 226. Query parameters
Parameter
columns[]

Description
Specify which columns to retrieve. If you do not
specify this parameter, only default columns are
retrieved.
Example: Retrieve the computer id:
URL?columns[]=computer_id

Required

Value
String

Table 226. Query parameters (continued)
Parameter
order

Description

Required

Specify how to sort the returned data. The de

Value
String

fault direction for sorting columns is ascending.
If you want to specify a descending sort, append
desc to the column name.

Example: Order by computer ID descending:
URL?order[]=computer_id desc

limit

Specify the number of rows to retrieve. If you

Numeric

omit this parameter, all rows are retrieved.
Example: Retrieve 100 records
URL?limit=100

Note: By default the limit parameter for
this API is set to 100000.
offset

Specify the number of rows to skip for retrieving

Numeric

results. You can use it together with the limit pa
rameter to paginate results.
Example: Retrieve 50 records starting after
record 150
URL?limit=50&offset=150

token

A unique user authentication identifier. You can
retrieve it by using REST API for retrieving au
thentication token. You can also log in to BigFix
Inventory, hover over the User icon
Profile. Then, click Show token.

, and click

✓

Alphanu
meric

Table 226. Query parameters (continued)
Parameter
criteria

Description
Retrieve records which match specific condi
tions. The parameter should have the following
structure, written in one line:
<criteria> ::= <left-brace>
<boolean-operator><colon>
<left-bracket>
<criterion> [{ <comma>
<criterion> }...] <right-bracket>
<right-brace>
<boolean-operator> ::= "and" | "or"
<criterion> ::= <criteria> |
<left-bracket> <column> <comma>
<operator> <comma> <value>
<right-bracket>
<column> ::= <json-string>
<operator> ::= <json-string>
<value> ::= <json-array> |
<json-string> | <json-numver> |
<json-null>

For more information about operators, see: Com
mon connectors and operators.
Example: retrieve computers with computer ID
greater than 1000.
URL?criteria={"and":[["computer_id",
">", "1000"]]}

For columns that use the date and time values,
you can retrieve data also for a period instead

Required

Value
String

Table 226. Query parameters (continued)
Parameter

Description

Required

of a specific date. To do so, use last or next as
<operator>, and then specify the time value
in the following convention: PxD/PxW/PxM/PxY,
where x is a number in the 1-999 range, and D,
W, M, or Y is a designator that represents days,
weeks, months, or years respectively.

Example conversation - default columns
Request
GET api/sam/v2/detailed_hw_network_adapters?token=7adc3efb175e2b
c0f4484bdd2efca54a8fa04623
Host: localhost:9081
Accept: application/json
Accept-Language: en-US

Response body
[{
"id":13,
"computer_id":4,
"updated_at":"2018-05-28T01:22:16Z",
"permanent_address":"00:50:56:94:A1:39",
"current_address":"00:50:56:94:A1:39",
"type":"Ethernet Adapter",
"model":"vmxnet3 Ethernet Adapter"
}]

Example conversation - selected columns
Request

Value

GET api/sam/v2/detailed_hw_network_adapters?columns[]=id
&columns[]=id&columns[]=type&columns[]=model
&token=7adc3efb175e2bc0f4484bdd2efca54a8fa04623
Host: localhost:9081
Accept: application/json
Accept-Language: en-US

Response body
[{
"id":13,
"type":"Ethernet Adapter",
"model":"vmxnet3 Ethernet Adapter"
}]

Retrieval of information related to the operating system (v2)
Available from 9.2.12. You use the GET operation on the api/sam/v2/
detailed_hw_operating_systems element to request information related to the operating

system on the scanned computer.

Permissions
You must have the View Endpoints and View Hardware Inventory permission to use this
API.

Resource URL
https://hostname:port/api/sam/v2/detailed_hw_operating_systems?token=token

Resource information
Table 227. Resource information
Operation details
HTTP method

Description
GET

Table 227. Resource information (continued)
Operation details
Request headers

Description
Header
Accept-Language (optional)

Values
en-US (only English is supported)
Negotiates the language of the response. If the header
is not specified, the content is returned in the server lan
guage.
Request format
Response headers

application/json

Header
Content-Type

Values
application/json

Specifies the content type of the response.
Header
Content-Language

Values
en-US, …
Specifies the language of the response content. If the
header is not specified, the content is returned in the serv
er language.
Response payload

Operating System element

Response format

application/json

Response codes

200 – OK

Table 227. Resource information (continued)
Operation details

Description
500 – "Bad Request" if a query parameter contains er

rors or is missing

Schema description
To retrieve the list of all columns that are returned by this REST API together with their
descriptions, use the following request.
GET api/sam/v2/schemas/detailed_hw_operating_system.json?token=token

Available columns
The list of attributes related to the operating system that is installed on the scanned
system.
The scan output contains a single instance of each attribute from this group.
Table 228. Columns with information about the operating system
Property
id

Description
Identifier of the record.

Type
In
te
ger

computer_id

Identifier of the computer as specified in the BigFix Inventory

In

database.

te
ger

updated_at

Date and time when the current information was imported to Big

String

Fix Inventory.
name

The name of an operating system; for example, Windows 10.

String

major_ver

The major version of an operating system.

String

sion

Table 228. Columns with information about the operating system (continued)
Property
minor_ver

Description

Type

The minor version of an operating system.

String

The date when the operating system was installed.

String

os_arch

The version of the operating system architecture.

String

os_kernel_

The kernel mode of the operating system (32-bit or 64-bit).

String

The description of the operating system.

String

sion
in
stall_date

mode
de
scription_
string

Related APIs
This API can be associated with the following API:
• Retrieval of hardware inventory (v2)

Query parameters
Table 229. Query parameters
Parameter
columns

Description
Specify which columns to retrieve. If you do not

Required

Value
String

specify this parameter, only default columns are
retrieved.
Example: Retrieve the computer id:
URL?columns[]=computer_id

order

Specify how to sort the returned data. The de
fault direction for sorting columns is ascending.

String

Table 229. Query parameters (continued)
Parameter

Description

Required

Value

If you want to specify a descending sort, append
desc to the column name.

Example: Order by computer ID descending:
URL?order[]=computer_id desc

limit

Specify the number of rows to retrieve. If you

Numeric

omit this parameter, all rows are retrieved.
Example: Retrieve 100 records
URL?limit=100

Note: By default the limit parameter for
this API is set to 100000.
offset

Specify the number of rows to skip for retrieving

Numeric

results. You can use it together with the limit pa
rameter to paginate results.
Example: Retrieve 50 records starting after
record 150
URL?limit=50&offset=150

token

A unique user authentication identifier. You can
retrieve it by using REST API for retrieving au

✓

Alphanu
meric

thentication token. You can also log in to BigFix
Inventory, hover over the User icon

, and click

Profile. Then, click Show token.
criteria

Retrieve records which match specific condi
tions. The parameter should have the following
structure, written in one line:

String

Table 229. Query parameters (continued)
Parameter

Description
<criteria> ::= <left-brace>
<boolean-operator><colon>
<left-bracket>
<criterion> [{ <comma>
<criterion> }...] <right-bracket>
<right-brace>
<boolean-operator> ::= "and" | "or"
<criterion> ::= <criteria> |
<left-bracket> <column> <comma>
<operator> <comma> <value>
<right-bracket>
<column> ::= <json-string>
<operator> ::= <json-string>
<value> ::= <json-array> |
<json-string> | <json-numver> |
<json-null>

For more information about operators, see: Com
mon connectors and operators.
Example: retrieve computers with computer ID
greater than 1000.
URL?criteria={"and":[["computer_id",
">", "1000"]]}

For columns that use the date and time values,
you can retrieve data also for a period instead
of a specific date. To do so, use last or next as
<operator>, and then specify the time value
in the following convention: PxD/PxW/PxM/PxY,
where x is a number in the 1-999 range, and D,

Required

Value

Table 229. Query parameters (continued)
Parameter

Description

Required

W, M, or Y is a designator that represents days,
weeks, months, or years respectively.

Example conversation - default columns
Request
GET api/sam/v2/detailed_hw_operating_systems?token=7adc3efb175e2
bc0f4484bdd2efca54a8fa04623
Host: localhost:9081
Accept: application/json
Accept-Language: en-US

Response body
[{
"id":13,
"computer_id":22,
"updated_at":"2018-05-28T01:22:16Z",
"name":"Red Hat Enterprise Linux Server release 6.8 (Santiago)",
"major_version":"2",
"minor_version":"6",
"install_date":"2017-10-31-08.37.06.000000",
"os_arch":"x86_64",
"os_kernel_mode":"64",
"description_string":"Red Hat Enterprise Linux Server release 6.
8 (Santiago)"
}]

Example conversation - selected columns
Request

Value

GET api/sam/v2/detailed_hw_operating_systems?columns[]=id
&columns[]=name&columns[]=major_version&columns[]=minor_version
&token=7adc3efb175e2bc0f4484bdd2efca54a8fa04623
Host: localhost:9081
Accept: application/json
Accept-Language: en-US

Response body
[{
"id":13,
"name":"Red Hat Enterprise Linux Server release 6.8 (Santiago)",
"major_version":"2",
"minor_version":"6"
}]

Retrieval of information related to partitions (v2)
Available from 9.2.12. You use the GET operation on the api/sam/v2/
detailed_hw_partitions element to request information related to the file system that is

mounted on a scanned system: Unix mount points and Windows logical drives.

Permissions
You must have the View Endpoints and View Hardware Inventory permission to use this
API.

Resource URL
https://hostname:port/api/sam/v2/detailed_hw_partitions?token=token

Resource information
Table 230. Resource information
Operation details
HTTP method
Request headers

Description
GET

Header
Accept-Language (optional)

Values
en-US (only English is supported)
Negotiates the language of the response. If the header
is not specified, the content is returned in the server lan
guage.
Request format
Response headers

application/json

Header
Content-Type

Values
application/json

Specifies the content type of the response.
Header
Content-Language

Values
en-US, …
Specifies the language of the response content. If the
header is not specified, the content is returned in the serv
er language.
Response payload

Partitions element

Table 230. Resource information (continued)
Operation details

Description

Response format

application/json

Response codes

200 – OK
500 – "Bad Request" if a query parameter contains er

rors or is missing

Schema description
To retrieve the list of all columns that are returned by this REST API together with their
descriptions, use the following request.
GET api/sam/v2/schemas/detailed_hw_partition.json?token=token

Available columns
The list of attributes related to the file system that is mounted on a scanned system: Unix
mount points and Windows logical drives.
The scan output might contain multiple instances of each attribute from this group.
Table 231. Columns with information about partitions
Property
id

Description
Identifier of the record.

Type
In
te
ger

computer_id

Identifier of the computer as specified in the BigFix Inventory data In
base.

te
ger

updated_at

Date and time when the current information was imported to Big
Fix Inventory.

String

Table 231. Columns with information about partitions (continued)
Property
type

Description

Type

The type of the partition; for example, Logical Drive or Remote Dri String
ve.

media_type

The media type that contains the partition; for example, Local Disc String
or CD-ROM.
Note: The media type is Unknown when the scanner can
not recognize it.

device_name

The name of the device or a label of a Windows drive; for example, String
/dev/dsk/c1t3d0s0 or Storage.

physical_size The size of a drive that contains the partition.

String

fs_total_size

Total size of the partition in kilobytes (KB).

String

fs_free_size

The amount of free space on the partition in kilobytes (KB).

String

Related APIs
This API can be associated with the following API:
• Retrieval of hardware inventory (v2)

Query parameters
Table 232. Query parameters
Parameter
columns[]

Description
Specify which columns to retrieve. If you do not
specify this parameter, only default columns are
retrieved.
Example: Retrieve the computer id:

Required

Value
String

Table 232. Query parameters (continued)
Parameter

Description

Required

Value

URL?columns[]=computer_id

order

Specify how to sort the returned data. The de

String

fault direction for sorting columns is ascending.
If you want to specify a descending sort, append
desc to the column name.

Example: Order by computer ID descending:
URL?order[]=computer_id desc

limit

Specify the number of rows to retrieve. If you

Numeric

omit this parameter, all rows are retrieved.
Example: Retrieve 100 records
URL?limit=100

Note: By default the limit parameter for
this API is set to 100000.
offset

Specify the number of rows to skip for retrieving

Numeric

results. You can use it together with the limit pa
rameter to paginate results.
Example: Retrieve 50 records starting after
record 150
URL?limit=50&offset=150

token

A unique user authentication identifier. You can
retrieve it by using REST API for retrieving au
thentication token. You can also log in to BigFix

✓

Alphanu
meric

Table 232. Query parameters (continued)
Parameter

Description
Inventory, hover over the User icon

Required

Value

, and click

Profile. Then, click Show token.
criteria

Retrieve records which match specific condi
tions. The parameter should have the following
structure, written in one line:
<criteria> ::= <left-brace>
<boolean-operator><colon>
<left-bracket>
<criterion> [{ <comma>
<criterion> }...] <right-bracket>
<right-brace>
<boolean-operator> ::= "and" | "or"
<criterion> ::= <criteria> |
<left-bracket> <column> <comma>
<operator> <comma> <value>
<right-bracket>
<column> ::= <json-string>
<operator> ::= <json-string>
<value> ::= <json-array> |
<json-string> | <json-numver> |
<json-null>

For more information about operators, see: Com
mon connectors and operators.
Example: retrieve computers with computer ID
greater than 1000.
URL?criteria={"and":[["computer_id",
">", "1000"]]}

String

Table 232. Query parameters (continued)
Parameter

Description

Required

For columns that use the date and time values,
you can retrieve data also for a period instead
of a specific date. To do so, use last or next as
<operator>, and then specify the time value
in the following convention: PxD/PxW/PxM/PxY,
where x is a number in the 1-999 range, and D,
W, M, or Y is a designator that represents days,
weeks, months, or years respectively.

Example conversation - default columns
Request
GET api/sam/v2/detailed_hw_partitions??token=7adc3efb175e2bc0f44
84bdd2efca54a8fa04623
Host: localhost:9081
Accept: application/json
Accept-Language: en-US

Response body
[{
"id":4,
"computer_id":1,
"updated_at":"2018-05-28T01:22:16Z",
"type":"Logical Drive",
"media_type":"Local Disk",
"device_name":"tmpfs",
"physical_size":"4005420",
"fs_total_size":"4005420",
"fs_free_size":"4005408"
}]

Value

Example conversation - selected columns
Request
GET api/sam/v2/detailed_hw_partitions?columns[]=id
&columns[]=media_type&columns[]=physical_size
&token=7adc3efb175e2bc0f4484bdd2efca54a8fa04623
Host: localhost:9081
Accept: application/json
Accept-Language: en-US

Response body
[{
"id":4,
"media_type":"Local Disk",
"physical_size":"4005420"
}]

Retrieval of information related to physical processors (v2)
Available from 9.2.12. You use the GET operation on the api/sam/v2/
detailed_hw_physical_processors element to request information related to all active

physical processors.

Permissions
You must have the View Endpoints and View Hardware Inventory permission to use this
API.

Resource URL
https://hostname:port/
api/sam/v2/detailed_hw_physical_processors?token=token

Resource information
Table 233. Resource information
Operation details
HTTP method
Request headers

Description
GET

Header
Accept-Language (optional)

Values
en-US (only English is supported)
Negotiates the language of the response. If the header
is not specified, the content is returned in the server lan
guage.
Request format
Response headers

application/json

Header
Content-Type

Values
application/json

Specifies the content type of the response.
Header
Content-Language

Values
en-US, …
Specifies the language of the response content. If the
header is not specified, the content is returned in the serv
er language.
Response payload

Physical Processors element

Table 233. Resource information (continued)
Operation details

Description

Response format

application/json

Response codes

200 – OK
500 – "Bad Request" if a query parameter contains er

rors or is missing

Schema description
To retrieve the list of all columns that are returned by this REST API together with their
descriptions, use the following request.
GET api/sam/v2/schemas/detailed_hw_physical_processor.json?token=token

Available columns
The list of attributes related to all active physical processors including single chips and
processor packages. You can retrieve values for each platform working as a host which
translates into one operating system per physical processor.
Note: To retrieve information about physical processors for guest operating
systems, such as VMware or BigFix LPAR, the complete information for the physical
machine must be available.
The scan output might contain multiple instances of each attribute from this group.
Table 234. Columns with information about physical processors
Property
id

Description
Identifier of the record.

Type
In
te
ger

Table 234. Columns with information about physical processors (continued)
Property
computer_id

Description

Type

Identifier of the computer as specified in the BigFix Inventory data In
base

te
ger

updated_at

Date and time when the current information was imported to Big

String

Fix Inventory.
core_per_

The number of cores on a physical processor; for example, 8 cores String

package_

for Intel Xeon E5-4620, and 12 for POWER9.

count
logical_

The number of logical processors assigned for each core; for ex

proc_per_

ample, 2 for Intel Xeon E5-4620, and 8 for POWER9.

String

core
manufactur

Processor manufacturer; for example Intel, AMD, or BigFix.

String

er
Note: You can only retrieve information about the manu
facturers that are supported by the scanner. Otherwise, the
displayed value is Unknown.
family

Processor family; for example, Xeon, or POWER9.

String

Note: You can only retrieve information about the proces
sor families that are supported by the scanner. Otherwise,
the displayed value is Unknown.
type

Processor type; for example, E5-4620 for Intel Xeon E5-4620.
Note: If the scanner does not support type identification of
the processor family the value is empty. If the scanner sup
ports type identification for the processor family, however,

String

Table 234. Columns with information about physical processors (continued)
Property

Description

Type

the given types is not recognize, the displayed value is Un
known.
cpu_freq

Processor frequency in megahertz (MHz). This information is op

String

tional, and vendor-specific. Depending on the processor family the
value might represent either nominal or current CPU frequency.
Note: CPU frequency might be interpreted differently
across processor architectures and families. If this infor
mation is not applicable the value is 0.
brandname

Processor name. This information is optional, and specific to plat

String

form and vendor. Thus, it can be retrieved from a different source
in case of each platform, or even processor family. If available, it is
a copy of a value reported by CPUID instruction, BIOS or OS.
active_

The number of active processors in the physical processor. A

processor_

processor is active if a logical processor is running on this physi

count

cal processor.

active_core_ The number of active cores in the physical processor. The core is
count

active if a logical processor is running on this core.

Related APIs
This API can be associated with the following API:
• Retrieval of hardware inventory (v2)

String

String

Query parameters
Table 235. Query parameters
Parameter
columns[]

Description
Specify which columns to retrieve. If you do not

Required

Value
String

specify this parameter, only default columns are
retrieved.
Example: Retrieve the computer id:
URL?columns[]=computer_id

order

Specify how to sort the returned data. The de

String

fault direction for sorting columns is ascending.
If you want to specify a descending sort, append
desc to the column name.

Example: Order by computer ID descending:
URL?order[]=computer_id desc

limit

Specify the number of rows to retrieve. If you

Numeric

omit this parameter, all rows are retrieved.
Example: Retrieve 100 records
URL?limit=100

Note: By default the limit parameter for
this API is set to 100000.
offset

Specify the number of rows to skip for retrieving
results. You can use it together with the limit pa
rameter to paginate results.
Example: Retrieve 50 records starting after
record 150

Numeric

Table 235. Query parameters (continued)
Parameter

Description

Required

Value

URL?limit=50&offset=150

token

A unique user authentication identifier. You can
retrieve it by using REST API for retrieving au

✓

Alphanu
meric

thentication token. You can also log in to BigFix
Inventory, hover over the User icon

, and click

Profile. Then, click Show token.
criteria

Retrieve records which match specific condi
tions. The parameter should have the following
structure, written in one line:
<criteria> ::= <left-brace>
<boolean-operator><colon>
<left-bracket>
<criterion> [{ <comma>
<criterion> }...] <right-bracket>
<right-brace>
<boolean-operator> ::= "and" | "or"
<criterion> ::= <criteria> |
<left-bracket> <column> <comma>
<operator> <comma> <value>
<right-bracket>
<column> ::= <json-string>
<operator> ::= <json-string>
<value> ::= <json-array> |
<json-string> | <json-numver> |
<json-null>

For more information about operators, see: Com
mon connectors and operators.

String

Table 235. Query parameters (continued)
Parameter

Description

Required

Example: retrieve computers with computer ID
greater than 1000.
URL?criteria={"and":[["computer_id",
">", "1000"]]}

For columns that use the date and time values,
you can retrieve data also for a period instead
of a specific date. To do so, use last or next as
<operator>, and then specify the time value
in the following convention: PxD/PxW/PxM/PxY,
where x is a number in the 1-999 range, and D,
W, M, or Y is a designator that represents days,
weeks, months, or years respectively.

Example conversation - default columns
Request
GET api/sam/v2/detailed_hw_physical_processors?token=7adc3efb175
e2bc0f4484bdd2efca54a8fa04623
Host: localhost:9081
Accept: application/json
Accept-Language: en-US

Response body
[{
"id":7,
"computer_id":4,
"updated_at":"2018-05-30T01:15:05Z",
"core_per_package_count":"1",
"logical_proc_per_core":"1",

Value

"manufacturer":"Intel",
"family":"Xeon",
"type":"E7-8880",
"cpu_freq":"2200",
"brandname":"Intel(R) Xeon(R) CPU E7-8880 v4 @ 2.20GHz","
active_processor_count":"1",
"active_core_count":"1"
}]

Example conversation - selected columns
Request
GET api/sam/v2/detailed_hw_physical_processors?columns[]=compute
r_id
&columns[]=manufacturer&columns[]=family&columns[]=type
&token=7adc3efb175e2bc0f4484bdd2efca54a8fa04623
Host: localhost:9081
Accept: application/json
Accept-Language: en-US

Response body
[{
"computer_id":4,
"manufacturer":"Intel",
"family":"Xeon",
"type":"E7-8880"
}]

Retrieval of information related to SMBIOS (v2)
Available from 9.2.12. You use the GET operation on the api/sam/v2/
detailed_hw_smbios element to request information related to SMBIOS of the scanned

system.

Permissions
You must have the View Endpoints and View Hardware Inventory permission to use this
API.

Resource URL
https://hostname:port/api/sam/v2/detailed_hw_smbios?token=token

Resource information
Table 236. Resource information
Operation details
HTTP method
Request headers

Description
GET

Header
Accept-Language (optional)

Values
en-US (only English is supported)
Negotiates the language of the response. If the header
is not specified, the content is returned in the server lan
guage.
Request format
Response headers

application/json

Header
Content-Type

Values
application/json

Specifies the content type of the response.
Header
Content-Language

Table 236. Resource information (continued)
Operation details

Description
Values
en-US, …
Specifies the language of the response content. If the
header is not specified, the content is returned in the serv
er language.

Response payload

SMBIOS element

Response format

application/json

Response codes

200 – OK
500 – "Bad Request" if a query parameter contains er

rors or is missing

Schema description
To retrieve the list of all columns that are returned by this REST API together with their
descriptions, use the following request.
GET api/sam/v2/schemas/detailed_hw_smbios.json?token=token

Available columns
The list of attributes related to SMBIOS of the scanned system.
The scan output contains a single instance of each attribute from this group.
Table 237. Columns with information about SMBIOS
Property
id

Description
Identifier of the record.

Type
In
te
ger

Table 237. Columns with information about SMBIOS (continued)
Property
computer_id

Description

Type

Identifier of the computer as specified in the BigFix Inventory

In

database

te
ger

updated_at

Date and time when the current information was imported to Big String
Fix Inventory.
The manufacturer of the BIOS system.

String

The version of the BIOS system.

String

The version of the system.

String

The serial number of the system.

String

bios_vendor

bios_version
sys
tem_version

sys
tem_serial_
number

Related APIs
This API can be associated with the following API:
• Retrieval of hardware inventory (v2)

Query parameters
Table 238. Query parameters
Parameter
columns[]

Description
Specify which columns to retrieve. If you do not

Required

Value
String

specify this parameter, only default columns are
retrieved.
Example: Retrieve the computer id:
URL?columns[]=computer_id

order

Specify how to sort the returned data. The de

String

fault direction for sorting columns is ascending.
If you want to specify a descending sort, append
desc to the column name.

Example: Order by computer ID descending:
URL?order[]=computer_id desc

limit

Specify the number of rows to retrieve. If you

Numeric

omit this parameter, all rows are retrieved.
Example: Retrieve 100 records
URL?limit=100

Note: By default the limit parameter for
this API is set to 100000.
offset

Specify the number of rows to skip for retrieving
results. You can use it together with the limit pa
rameter to paginate results.
Example: Retrieve 50 records starting after
record 150

Numeric

Table 238. Query parameters (continued)
Parameter

Description

Required

Value

URL?limit=50&offset=150

token

A unique user authentication identifier. You can
retrieve it by using REST API for retrieving au

✓

Alphanu
meric

thentication token. You can also log in to BigFix
Inventory, hover over the User icon

, and click

Profile. Then, click Show token.
criteria

Retrieve records which match specific condi
tions. The parameter should have the following
structure, written in one line:
<criteria> ::= <left-brace>
<boolean-operator><colon>
<left-bracket>
<criterion> [{ <comma>
<criterion> }...] <right-bracket>
<right-brace>
<boolean-operator> ::= "and" | "or"
<criterion> ::= <criteria> |
<left-bracket> <column> <comma>
<operator> <comma> <value>
<right-bracket>
<column> ::= <json-string>
<operator> ::= <json-string>
<value> ::= <json-array> |
<json-string> | <json-numver> |
<json-null>

For more information about operators, see: Com
mon connectors and operators.

String

Table 238. Query parameters (continued)
Parameter

Description

Required

Example: retrieve computers with computer ID
greater than 1000.
URL?criteria={"and":[["computer_id",
">", "1000"]]}

For columns that use the date and time values,
you can retrieve data also for a period instead
of a specific date. To do so, use last or next as
<operator>, and then specify the time value
in the following convention: PxD/PxW/PxM/PxY,
where x is a number in the 1-999 range, and D,
W, M, or Y is a designator that represents days,
weeks, months, or years respectively.

Example conversation - default columns
Request
GET api/sam/v2/detailed_hw_smbios?token=7adc3efb175e2bc0f4484bdd
2efca54a8fa04623
Host: localhost:9081
Accept: application/json
Accept-Language: en-US

Response body
[{
"id":12,
"computer_id":19,
"updated_at":"2018-05-28T01:22:16Z",
"bios_vendor":"Phoenix Technologies LTD",
"bios_version":"6.00",

Value

"system_version":"None",
"system_serial_number":"VMware-42 14 ea ea 03 c0 d5 03-fd f6 43
d6 44 a2 f8 52"
}]

Example conversation - selected columns
Request
GET api/sam/v2/detailed_hw_smbios?columns[]=computer_id
&columns[]=bios_vendor&columns[]=bios_version
&token=7adc3efb175e2bc0f4484bdd2efca54a8fa04623
Host: localhost:9081
Accept: application/json
Accept-Language: en-US

Response body
[{
"computer_id":19,
"bios_vendor":"Phoenix Technologies LTD",
"bios_version":"6.00"
}]

REST API for retrieving software inventory and metric utilization
and classifying software (v2)
Available from 9.2.8. You can use REST API requests to quickly retrieve large
amounts of data related to license metric utilization as well as your software inventory,
including historical data about uninstalled software. You can then pass this data to other
applications for further processing and analysis.

Retrieval of software inventory (v2)
Available from 9.2.8. You use the GET operation on the api/sam/v2/
software_instances element to request information about software installed in your

infrastructure. The API returns details of existing components as well as historical data
about components that were removed.

Permissions
You must have the View Endpoints and View Hardware Inventory permissions to use this
API.

Resource URL
https://hostname:port/api/sam/v2/software_instances?token=token

Resource information
Table 239. Resource information
Operation details
HTTP method
Request headers

Description
GET

Header
Accept-Language (optional)

Values
en-US (only English is supported)
Negotiates the language of the response. If the header
is not specified, the content is returned in the server lan
guage.
Request format
Response headers

application/json

Header
Content-Type

Values
application/json

Specifies the content type of the response.

Table 239. Resource information (continued)
Operation details

Description
Header
Content-Language

Values
en-US
Specifies the language of the response content. If the
header is not specified, the content is returned in the serv
er language.
Response payload

Software Instances element

Response format

application/json

Response codes

200 – OK
400 – "Bad Request" if a query parameter contains er

rors or is missing

Schema description
To retrieve the list of all columns that are returned by this REST API together with their
descriptions, use the following request.
GET api/sam/v2/schemas/software_instance.json?token=<token>

Available columns
Table 240. Available columns
Dis
Column

Description

played
Type
by de
fault

instance_id

Identifier of the component instance.

Nu
mer
ic

computer_id

Identifier of the computer as defined in BigFix Inven

Nu

tory.

mer
ic

computer_bigfix_id

Identifier of the computer as defined in BigFix.

Nu
mer
ic

computer_dns_name

DNS of the computer.

computer_name

Name of the computer.

computer_ip_address

IP address of the computer.

computer_os

Operating system of the computer.

String

computer_os_type

Type of the operating system of the computer.

String

component_name

Component name.

component_release

Component release number.

component_de Detailed version of a software component. The ver
tailed_version

sion is used as software signature. The software ver
sion is detected in several ways, such as in the pres
ence of specific packages, the highest version of
SWID tags, Windows file, and extended signature re

String
✓
✓

✓
✓

String
String

String
String
String

Table 240. Available columns (continued)
Dis
Column

Description

played
Type
by de
fault

porting. The package based discovery is available
since BigFix Inventory
discoverable_guid

.

Component GUID.

String

discoverable_family_guid Component family GUID. For example, if the compo

String

nent is IBM DB2 Enterprise Server Edition, compo
nent family is IBM DB2.
component_publisher_

Component publisher.

String

Information whether usage data is available for the

Boolean

name
component_has_usage

component.
is_present

Information whether the component is still installed

Boolean

in the environment.
discovery_start

Date and time when the component was reported for
the first time. The time is specified in the GMT time

✓

String

✓

String

✓

String

zone.
discovery_end

Date and time when the component was reported for
the last time. The time is specified in the GMT time
zone.

discovery_path

Path under which the component is installed. Before
BigFix Inventory version 10.0.2, it was available for
IBM products only. Starting from BigFix Inventory
10.0.2, it is available for all products.

Table 240. Available columns (continued)
Dis
Column

Description

played
Type
by de
fault

product_name

Name of the product to which the component is as
signed.

product_guid

✓

Product GUID. For example, if the product release is

String

String

IBM DB2 Enterprise Server Edition 10.5, product is
IBM DB2 Enterprise Server Edition.
product_family_guid

Product family GUID. For example, if the product is

String

IBM DB2 Enterprise Server Edition, product family is
IBM DB2.
product_publisher_name

Product publisher.

String

product_release_name

Name of the product release to which the compo

String

nent is assigned.
✓

product_release

Product release number.

String

product_release_guid

Product release GUID.

String

metric_id

Identifier of the license metric that is used by the

String

product. For information about the meaning of each
metric_id, see: Metric IDs and code names.

metric_code_name

Unique code name of the license metric that is used

String

by the product. For information about the meaning
of each metric_code_name, see: Metric IDs and code
names.
is_confirmed

Information whether the assignment of the compo
nent to the product is confirmed.

Boolean

Table 240. Available columns (continued)
Dis
Column

Description

played
Type
by de
fault

is_excluded

Information whether the product is excluded from

Boolean

pricing calculations.
is_suppressed

Information whether the component is suppressed
on the computer on which it is installed.

exclusion_or_suppress_

Comment that was provided during the exclusion or

comment

suppression.
bundle_id

Identifier of the FlexPoint offering or CloudPak to

✓

Boolean

String

String

which the software instance is bundled. Possible val
ues include:
• - 1 - The software instance cannot be assigned
to any FlexPoint offering nor Cloud Pak be
cause the component is not assigned to any
product
• 0 - The software instance is not bundled to any
FlexPoint offering nor Cloud Pak
• Other values - Identifier of the FlexPoint offer
ing or CloudPak to which the software instance
is assigned
bundle_name

Name of the FlexPoint offering or Cloud Pak to which
the software instance is assigned. Possible values
include:

String

Table 240. Available columns (continued)
Dis
Column

Description

played
Type
by de
fault

• Empty column - The software instance can
not be assigned to any FlexPoint offering nor
Cloud Pak because the component is not as
signed to any product
• None - The software instance is not bundled to
any FlexPoint offering nor Cloud Pak
• Other values - Name of the FlexPoint offering
or Cloud Pak to which the software instance is
assigned
bundle_type

Type of a bundle to which the software instance is

Nu

assigned. Possible values include:

mer
ic

• -1 - The software instance is not assigned to
any bundle or cannot be assigned because the
component is not assigned to any product
• 0 - FlexPoint bundle
• 1 - Cloud Pak bundle
bundle_guid

GUID of the FlexPoint offering or Cloud Pak to which
the software instance is assigned. Possible values
include:

String

Table 240. Available columns (continued)
Dis
Column

Description

played
Type
by de
fault

• Empty column - The software instance is not
bundled to any FlexPoint offering nor Cloud
Pak
• Other values - GUID of the FlexPoint offering
or Cloud Pak to which the software instance is
assigned
is_vulnerable

Information whether any Common Vulnerabilities

Boolean

and Exposures (CVE) are matched to the component.
Possible values include:
• 0 - No CVEs are matched
• 1 - At least one CVE is matched
is_charged

Information whether the component to product as

Boolean

signment is confirmed.
is_entitled

Information whether you declared the particular
product as your software entitlement.

Applicable associations
You can additionally retrieve data from the following associations:
•

component_cpe

•

component_tags

• computer_hardware
• computer_health
•

cve

•

discovery_details

Boolean

•

instance_tags

•

release_component_lifecycle

• usage_data
Important: All associations provide data about items that currently exist in the
infrastructure. For removed computers and uninstalled software, these associations
return null.

Query parameters
Table 241. Query parameters
Parameter
columns

Description
Specify which columns to retrieve. If you do not

Required

Value
String

specify this parameter, only default columns are
retrieved.
Example: Retrieve product name and release
URL?
columns[]=product_name&columns[]=produc
t_release

order

Specify how to sort the returned data. The de

Alphanu

fault direction for sorting columns is ascending.

meric

If you want to specify a descending sort, append
desc to the column name.

Example: Order by computer ID descending
URL?order[]=computer_id desc

limit

Specify the number of rows to retrieve. If you
omit this parameter, all rows are retrieved.
Example: Retrieve 100 records

Numeric

Table 241. Query parameters (continued)
Parameter

Description

Required

Value

URL?limit=100

offset

Specify the number of rows to skip for retrieving

Numeric

results. You can use it together with the limit pa
rameter to paginate results.
Example: Retrieve 50 records starting after
record 150
URL?limit=50&offset=150

token

A unique user authentication identifier. You can
retrieve it by using REST API for retrieving au

✓

Alphanu
meric

thentication token. You can also log in to BigFix
Inventory, hover over the User icon

, and click

Profile. Then, click Show token.
criteria

Retrieve records which match specific condi
tions. The parameter should have the following
structure, written in one line:
<criteria> ::= <left-brace>
<boolean-operator> <colon>
<left-bracket>
<criterion> [{ <comma>
<criterion> }...] <right-bracket>
<right-brace>
<boolean-operator> ::= "and" | "or"
<criterion> ::= <criteria> |
<left-bracket> <column> <comma>
<operator> <comma> <value>
<right-bracket>
<column> ::= <json-string>

String

Table 241. Query parameters (continued)
Parameter

Description
<operator> ::= <json-string>
<value> ::= <json-array> |
<json-string> | <json-number> |
<json-null>

For more information about operators, see: Com
mon connectors and operators.
Example: Retrieve software instances whose
product name contains "BigFix" OR the discovery
start is within a specific date range
URL?criteria={ "or": [ ["product_name",
"contains", "BigFix"],
{ "and": [ ["discovery_start", ">",
"2018-10-01T00:00:00+00:00Z"],
["discovery_start", "<",
"2018-10-02T00:00:00+00:00Z"] ] } ] }

For columns that use the date and time values,
you can retrieve data also for a period instead
of a specific date. To do so, use last or next as
<operator>, and then specify the time value
in the following convention: PxD/PxW/PxM/PxY,
where x is a number in the 1-999 range, and D,
W, M, or Y is a designator that represents days,
weeks, months, or years respectively.
Example: Retrieve software instances
which took part in the license utilization
peak. The date and time of the peak is:
2018-10-10T00:00:00+00:00Z. Query searches
for the instances that meet the following criteria:

Required

Value

Table 241. Query parameters (continued)
Parameter

Description
product name contains "DB2" AND use the given
metric AND discovery start withing the peak.
For PVU, RVU MAPC and VPC
URL?criteria={ "and":
[ ["discovery_start", "<=",
"2018-10-10T00:00:00+00:00Z"],
["discovery_end", ">",
"2018-10-10T00:00:00+00:00Z"],
["product_name", "contains", "DB2"],
["metric_id", "=", "5"] ] }

For other metrics
URL?criteria={ "and":
[ ["discovery_start", "<",
"2018-10-11T00:00:00+00:00Z"],
["discovery_end", ">=",
"2018-10-10T00:00:00+00:00Z"],
["product_name", "contains", "DB2"],
["metric_id", "=", "9"] ] }

Example: Retrieve software instances that were
first reported within the last 7 days
URL?
criteria={"and":[["discovery_start","la
st","P7D"]]}

Example conversation - default columns
Request

Required

Value

GET api/sam/v2/software_instances?token=7adc3efb175e2bc0f4484bdd
2efca54a8fa04623
Host: localhost:9081
Accept: application/json
Accept-Language: en-US

Response body
[{
"computer_name":"NC107069",
"computer_ip_address":["10.0.107.69"],
"component_name":"BigFix Platform Agent",
"component_release":"9.0",
"is_present":1,
"discovery_start":"2016-04-28T15:37:26Z",
"discovery_end":"2016-11-17T15:11:10Z",
"discovery_path":"/opt/BESClient/bin/properties/version",
"product_name":"BigFix for Power Management",
"product_release":"9.0"
}]

Example conversation - all columns
Request
GET api/sam/v2/software_instances?columns[]=discovery_path
&columns[]=instance_id&columns[]=computer_id&columns[]=computer_
bigfix_id
&columns[]=computer_dns_name&columns[]&columns[]=computer_name
&columns[]=computer_ip_address&columns[]=computer_os&columns[]=c
omputer_os_type
&columns[]=component_name&columns[]=component_release&columns[]=
discoverable_guid

&columns[]=component_publisher_name&columns[]=component_has_usag
e&columns[]=is_present
&columns[]=discovery_start&columns[]=discovery_end&columns[]=pro
duct_name
&columns[]=product_publisher_name&columns[]=product_release_name
&columns[]=product_release
&columns[]=metric_id&columns=metric_code_name&columns[]=is_confi
rmed
&columns[]=is_excluded&columns[]=is_suppressed&columns[]=exclusi
on_or_suppress_comment
&token=7adc3efb175e2bc0f4484bdd2efca54a8fa04623
Host: localhost:9081
Accept: application/json
Accept-Language: en-US

Response body
[{
"instance_id":1,
"computer_id":3,
"computer_bigfix_id":null,
"computer_dns_name":"NC107069",
"computer_name":"NC107069",
"computer_ip_address":"10.0.107.69",
"computer_os":"AIX 5.3",
"computer_os_type":"AIX",
"component_name":"BigFix Platform Agent",
"component_release":"9.0",
"discoverable_guid":"0768FB15-383C-4124-A7E2-0D76DDA06874",
"component publisher name":"IBM",

"component_has_usage":1,
"is_present":0,

"discovery_start":"2016-04-28T15:37:26Z",
"discovery_end":"2016-11-17T15:11:10Z",
"discovery_path":"/opt/BESClient/bin/properties/version",
"product_name":"BigFix for Power Management",
"product_publisher_name":"IBM",
"product_release_name":"BigFix for Power Management",
"product_release":"9.0",
"metric_id":"6",
"metric_code_name":"INTERNAL_RVU_MAPC",
"is_confirmed":0,
"is_excluded":0,
"is_suppressed":0,
"exclusion_or_suppress_comment":null
}]

Example conversation - additional column
Request
GET api/sam/v2/software_instances?columns[]=component_name
&columns[]=product_name&columns[]=is_confirmed
&token=7adc3efb175e2bc0f4484bdd2efca54a8fa04623
Host: localhost:9081
Accept: application/json
Accept-Language: en-US

Response body
[{
"component_name":"BigFix Platform Agent",
"product_name":"BigFix for Power Management",
"is_confirmed":0
}]

Example conversation - association
Request
GET api/sam/v2/software_instances?columns[]=computer_id
&columns[]=computer_health.catalog_version
&token=7adc3efb175e2bc0f4484bdd2efca54a8fa04623
Host: localhost:9081
Accept: application/json
Accept-Language: en-US

Response body
[{
"computer_id":1,
"catalog_version":1304630
}]

Classifying software (v2)
Available from 9.2.14. You can use the PUT operation on the api/sam/v2/
software_instances element to define, change, or migrate software classification.

The API supports the following actions
• Assigning component instance to a product using relation existing in a catalog
• Assigning component instance to a product using custom bundling. The bundling
needs to be created earlier in WebUI.
• Excluding products from metric calculation and clearing the exclusion
• Suppressing component from inventory and clearing the suppression
•

Assigning a product to a FlexPoint offering or a Cloud Pak

•

Assigning a component to a product and product to a Cloud Pak in one call

Permissions
You must have the View Endpoints and View Hardware Inventory permissions to use this
API.

Resource URL
https://hostname:port/api/sam/v2/software_instances?token=token

Important: You can use this API to update or migrate software bundlings. You can
only update the budlings that are defined in the software catalog or were earlier
created manually in WebUI.

Resource information
Table 242. Resource information
Operation details
HTTP method
Request headers

Description
PUT

Header
Accept-Language (optional)

Values
en-US (only English is supported)
Negotiates the language of the response. If the header
is not specified, the content is returned in the server lan
guage.
Request format
Response headers

application/json

Header
Content-Type

Values
application/json

Table 242. Resource information (continued)
Operation details

Description
Specifies the content type of the response.
Header
Content-Language

Values
en-US, …
Specifies the language of the response content. If the
header is not specified, the content is returned in the serv
er language.
Response payload

n/a element

Response format

application/json

Response codes

207 – OK
500 – "Bad Request" if a query parameter contains er

rors or is missing

Parameters
Important: The following parameters are required to assign a component instance
to a product requests:
• token
• is_charged
• metric_id
• product_release_guid
• instance_id, or, alternatively, a combination of parameters including:
a parameter that identifies a computer: computer_dns_name

or computer_bigfix_id and a parameter that identifies software:
discoverable_guid that can be followed by the discovery_path parameter for
precision.
Requests, such as suppression and exclusion require different set of parameters as
described in the table below.

Table 243. Parameters
Parameters that are listed below are optional. You can include them in your query according
to your needs. The out-of-range values for all the optional parameters are ignored.
Parameter
instance_id

Description

Type

Identifier of the component instance.

Nu
mer
ic

computer_bigfix_id

Identifier of the computer as defined in BigFix.

Nu
mer
ic

computer_dns_name

DNS of the computer.

String

discoverable_guid

Component GUID.

String

discovery_path

Path under which the component is installed. Available for

String

BigFix products only. For non-BigFix products, the returned
value is null.
product_release_guid

Product release GUID.

String

metric_id

Identifier of the license metric that is used by the product.

String

For information about the meaning of each metric_id, see:
Metric IDs and code names.
is_confirmed

Information whether the assignment of the component to
the product is confirmed.

Boolean

Table 243. Parameters
Parameters that are listed below are optional. You can include them in your query according
to your needs. The out-of-range values for all the optional parameters are ignored.
(continued)
Parameter
is_excluded

Description
Information whether the product is excluded from pricing

Type
Boolean

calculations.
is_suppressed

Information whether the component is suppressed on the

Boolean

computer on which it is installed.
exclusion_or_suppress_

Comment that was provided during the exclusion or sup

comment

pression.
is_charged

Information whether the component to product assign

String

Boolean

ment is charged.
token

A unique user authentication identifier. You can retrieve it

Al

by using REST API for retrieving authentication token. You

phanu

can also log in to BigFix Inventory, hover over the User icon mer
, and click Profile. Then, click Show token.
verbose

Descriptive information about the result of an API request.

ic
Boolean

By default, this parameter is set to false.
simulate

By adding this parameter to API request you can test the
call to view its results and status. By default, this parame
ter is set to false.

Note: You can change multiple values during a single request. For example, you can
use a single request to reassign the component, and change its status to confirmed.

Boolean

Example conversation
1. Assigning a component
Assign a component instance with ID 214 to a product release with GUID 7E9162CDB894-48B3-AFB7-1234567890AB using bundling with metric with ID 6 which has
charged type as '0'.
Request
PUT
https://example.com:9081/api/sam/v2/software_instances?tok
en=1234567890abcdef1234567890abcdef12345678
Content-Type: application/json
{
"rows": [
{
"instance_id": 214,
"product_release_guid": "7E9162CD-B894-48B3-AFB
7-1234567890AB",
"metric_id": 6,
"is_charged": 0
}
]
}

Response body
Response code: 207
Content-Type: application/json; charset=utf-8
{
"valid_instances": {
"Bundled": 1
},
"invalid_instances": {},

"unmodified_instances": 0
}

2. Suppress a component instance with ID 103 from BigFix Inventory.
Request
PUT
https://example.com:9081/api/sam/v2/software_instances?tok
en=1234567890abcdef1234567890abcdef12345678
Content-Type: application/json
{
"rows": [
{
"instance_id": 103,
"is_suppressed": 1
}
]
}

Response
Response code: 207
Content-Type: application/json; charset=utf-8
{
"valid_instances": {
"Suppressed": 1
},
"invalid_instances": {},
"unmodified_instances": 0
}

3. Clear suppression of a component instance with ID 73
Request

PUT
https://example.com:9081/api/sam/v2/software_instances?tok
en=1234567890abcdef1234567890abcdef12345678
Content-Type: application/json
{
"rows": [
{
"instance_id": 73,
"is_suppressed": 0
}
]
}

Response
Response code: 207
Content-Type: application/json; charset=utf-8
{
"valid_instances": {
"Unsuppressed": 1
},
"invalid_instances": {},
"unmodified_instances": 0
}

4. Exclude product assigned to component instance with ID 94 from metric calculation
Request
PUT
https://example.com:9081/api/sam/v2/software_instances?tok
en=1234567890abcdef1234567890abcdef12345678
Content-Type: application/json
{
"rows": [

{
"instance_id": 94,
"is_excluded": 1
}
]
}

Response
Response code: 207
Content-Type: application/json; charset=utf-8
{
"valid_instances": {
"Excluded": 1
},
"invalid_instances": {},
"unmodified_instances": 0
}

5. Clear exclusion of a product assigned to component instance with ID 58
Request
PUT
https://example.com:9081/api/sam/v2/software_instances?tok
en=1234567890abcdef1234567890abcdef12345678
Content-Type: application/json
{
"rows": [
{
"instance_id": 58,
"is_excluded": 0
}
]
}

Response
Response code: 207
Content-Type: application/json; charset=utf-8
{
"valid_instances": {
"Included": 1
},
"invalid_instances": {},
"unmodified_instances": 0
}

Assigning a product to a FlexPoint offering or a Cloud Pak
To assign a product to a FlexPoint offering or a Cloud Pak, the following fields are required:
• instance_id or a combination of fields that includes:
◦ A field that identifies a computer: computer_dns_name or computer_bigfix_id
◦ A field that identifies software: discoverable_guid that can be followed by the
discovery_path parameter for precision
• bundle_name or bundle_guid or both
Request
PUT api/sam/v2/software_instances?token=7adc3efb175e2bc0f4484bdd
2efca54a8fa04623
{
"rows": [
{
"instance_id":4,
"bundle_name":"Unified Governance \u0026 Integration"
}

]
}

Response header
207 - OK

Response body
{
"valid_instances":
{"Assigned to CloudPak":1},
"invalid_instances":{},
"unmodified_instances":0
}

Assigning a component to a product and product to a Cloud Pak in one
call
To assign a component to a product and then the product to a Cloud Pak in one REST API
call, the following fields are required:
• instance_id or a combination of fields that includes:
◦ A field that identifies a computer: computer_dns_name or computer_bigfix_id
◦ A field that identifies software: discoverable_guid that can be followed by the
discovery_path parameter for precision
• product_release_guid
• metric_id
• is_charged
• bundle_name or bundle_guid or both
Request
PUT api/sam/v2/software_instances?token=7adc3efb175e2bc0f4484bdd
2efca54a8fa04623

{
"rows": [
{
"instance_id":1423,
"product_release_guid":"1bde5fc0-0e29-496a-b581-bacdaa7
5810f",
"metric_id":5,
"is_charged":1,
"bundle_name":"IBM Db2 Standard Edition Extension for I
BM Cloud Pak for Data"
}
]
}

Response header
207 - OK

Response body
{
"valid_instances":
{
"Bundled":1,
"Assigned to CloudPak":1
},
"invalid_instances":{},
"unmodified_instances":0
}

Example conversation - migrating software assignments between BigFix
servers
For more information, see: Tutorial: Migrating software assignments between two BigFix
servers.

Retrieval of software components (v2)
Available from 9.2.14. You use the GET operation on the api/sam/v2/
software_components element to request information about software components in your

catalog. The API returns details of existing components as well as historical data about
components that were removed.

Permissions
You must have the View Software Catalog and Signatures permission to perform this
task.

Resource URL
https://hostname:port/api/sam/v2/software_components?token=token

Resource information
Table 244. Resource information
Operation details
HTTP method
Request headers

Description
GET

Header
Accept-Language (optional)

Values
en-US (only English is supported)
Negotiates the language of the response. If the header
is not specified, the content is returned in the server lan
guage.
Request format
Response headers

application/json

Header
Content-Type

Values

Table 244. Resource information (continued)
Operation details

Description
application/json

Specifies the content type of the response.
Header
Content-Language

Values
en-US, …
Specifies the language of the response content. If the
header is not specified, the content is returned in the serv
er language.
Response payload

Software Components element

Response format

application/json

Response codes

200 – OK
500 – "Bad Request" if a query parameter contains er

rors or is missing

Schema description
To retrieve the list of all columns that are returned by this REST API together with their
descriptions, use the following request.
GET api/sam/v2/schemas/software_component.json?token=<token>

Available columns
Table 245. Available columns
Dis
Column

played
Type
by de

Description

fault
id

✓

Identifier of the component instance.

Nu
mer
ic

✓

name

Name of the component.

release

Release of the component.

guid

Component GUID.

is_ibm

Information whether the component is an IBM soft

✓
✓

ware component.

✓

Applicable associations
You can additionally retrieve data from the following associations:
• tags

Query parameters
Table 246. Query parameters
Parameter
columns[]

Description
Specify which columns to retrieve. If you do not
specify this parameter, only default columns are
retrieved.
Example: Retrieve component name and id
URL?columns[]=name&columns[]=id

Required

Value
String

String
String
String
Boolean

Table 246. Query parameters (continued)
Parameter
order

Description

Required

Value

Specify how to sort the returned data. The de

Alphanu

fault direction for sorting columns is ascending.

meric

If you want to specify a descending sort, append
desc to the column name.

Example: Order by component ID descending
URL?order[]=id desc

limit

Specify the number of rows to retrieve. If you

Numeric

omit this parameter, all rows are retrieved.
Example: Retrieve 100 records
URL?limit=100

offset

Specify the number of rows to skip for retrieving

Numeric

results. You can use it together with the limit pa
rameter to paginate results.
Example: Retrieve 50 records starting after
record 150
URL?limit=50&offset=150

token

A unique user authentication identifier. You can
retrieve it by using REST API for retrieving au

✓

Alphanu
meric

thentication token. You can also log in to BigFix
Inventory, hover over the User icon

, and click

Profile. Then, click Show token.
criteria

Retrieve records which match specific condi
tions. The parameter should have the following
structure, written in one line:

String

Table 246. Query parameters (continued)
Parameter

Description

Required

<criteria> ::= <left-brace>
<boolean-operator> <colon>
<left-bracket>
<criterion> [{ <comma>
<criterion> }...] <right-bracket>
<right-brace>
<boolean-operator> ::= "and" | "or"
<criterion> ::= <criteria> |
<left-bracket> <column> <comma>
<operator> <comma> <value>
<right-bracket>
<column> ::= <json-string>
<operator> ::= <json-string>
<value> ::= <json-array> |
<json-string> | <json-number> |
<json-null>

For more information about operators, see: Com
mon connectors and operators.

Example conversation - default columns
Request
GET api/sam/v2/software_components?token=7adc3efb175e2bc0f4484bd
d2efca54a8fa04623
Host: localhost:9081
Accept: application/json
Accept-Language: en-US

Response body

Value

[{
"id":1,
"name":"DB2 8.1",
"release":8,
"guid":"XYZ",
"is_ibm":1,
}]

Example conversation - association
Request
GET api/sam/v2/software_components?columns[]=id&columns[]=name
&columns[]=tags.name
&token=7adc3efb175e2bc0f4484bdd2efca54a8fa04623
Host: localhost:9081
Accept: application/json
Accept-Language: en-US

Response body
[{
"id":1,
"name":"DB2 8.1",
"tags":
[{"name":"ibm"}]
}]

Retrieval of license metric utilization (v2)
Available from 9.2.10. Use the GET operation on the api/sam/v2/license_usage
element to request information about utilization of license metrics by products that are
installed in your infrastructure. By default, the results are returned for the computer group
of the user whose token is used for authentication and cover the period for which data is

aggregated in this group. They also include custom fields that were added to the All Metrics
report.

Permissions
You must have the View License Metrics permission to use this API.

Resource URL
https://hostname:port/api/sam/v2/license_usage?token=token

Resource information
Table 247. Resource information
Operation details
HTTP method
Request headers

Description
GET

Header
Accept-Language (optional)

Values
en-US (only English is supported)
Negotiates the language of the response. If the header
is not specified, the content is returned in the server lan
guage.
Request format
Response headers

application/json

Header
Content-Type

Values
application/json

Specifies the content type of the response.
Header

Table 247. Resource information (continued)
Operation details

Description
Content-Language

Values
en-US, …
Specifies the language of the response content. If the
header is not specified, the content is returned in the serv
er language.
Header
startdate

Values
YYYY-MM-DD

Specifies the date starting from which the data is re
trieved.
Header
enddate

Values
YYYY-MM-DD

Specifies the date until which the data is retrieved.
Header
computerGroupId

Values
Integer
Specifies ID of the computer group for which data is re
trieved.
Response payload

License Usage element

Table 247. Resource information (continued)
Operation details

Description

Response format

application/json

Response codes

200 – OK
400 – "Bad Request" if a query parameter contains er

rors or is missing

Schema description
To retrieve the list of all columns that are returned by this REST API together with their
descriptions, use the following request.
GET api/sam/v2/schemas/license_usage.json?token=token

Available columns
Table 248. Available columns
Column
product_publisher_

Description
Name of the product publisher.

name

Displayed by
default
✓

Type
String

product_id

Identifier of the software product.

Integer

product_name

Name of the software product.

product_family_guid

GUID of the software product.

String

metric_id

Identifier of the license metric. For ex

String

✓

String

planation of the returned values, see:
Metric IDs and code names.
metric_name

Name of the license metric. The value
that is returned by the metric_name pa
rameter is provided as reference and

String

Table 248. Available columns (continued)
Column

Description

Displayed by
default

Type

can slightly differ from the value that is
provided as a metric description in Table
252: Metric ID, code name, and descrip
tion. It is best to retrieve metrics by us
ing metric_id or metric_code_name pa
rameters and then check the exact met
ric description by referring to Table 252:
Metric ID, code name, and description.
metric_code_name

Code name of the license metric. For
explanation of the returned values, see:

✓

String

✓

Integer

Metric IDs and code names.
hwm_quantity

The highest number of metric units that
the product used within the period for
which the data is retrieved. When metric
quantity is not measured for a particular
license metric, the value returned by the
hwm_quantity parameter is -1. The val
ue -1 cannot be used for sorting nor fil
tering.

threshold

The maximum number of metric units

Integer

that the product is entitled to use within
a computer group. The value is set man
ually and is used to calculate the metric
threshold delta.
threshold_delta

It is calculated by subtracting metric
quantity from the threshold. When you
specify a threshold for a license met

Integer

Table 248. Available columns (continued)
Column

Description

Displayed by
default

Type

ric that is not calculated, the value re
turned by the threshold_delta parameter
is 2147483647. The value 2147483647
cannot be used for sorting nor filtering.
imported_part_num

Part number that was imported to Big

bers

Fix Inventory. It represents the product

String

that is listed in the product_name col
umn and its license metric.
is_reaggregation_

Specifies whether recalculation is need

needed

ed for the product. The parameter can

Boolean

not be used to filter or sort the results.
custom_field_number

Custom field that was added to the All

Various

Metrics report. To view the list of all
custom fields, view the license_usage.json schema.
hwm_peak_ The date and time when the highest
time

number of metric units was used by a
product in the selected period of time. If
the value of hwm_quantity parameter is
-1, the value of hwm_peak_time is mean
ingless.
Note: Retrieving hwm_peak_
time might noticeably increase
the time of retrieving the data.

String

Table 248. Available columns (continued)
Column
bundle_id

Description
ID of the FlexPoint bundle or the Cloud

Displayed by
default

Type
Integer

Pak to which the product is assigned.
bundle_name

Name of the FlexPoint bundle or Cloud

String

Pak to which the product is assigned.
bundle_type

Type of the bundle. Possible values:

Set of
integers

• -1 - Not a bundle
• 0 - FlexPoint bundle
• 1 - Cloud Pak
bundle_guid

GUID of the FlexPoint bundle or Cloud

String

Pak to which the product is assigned.
bundle_met
ric_contribution

When the product is a part of a Flex
Point bundle or a Cloud Pak, the col
umn shows the number of license met
ric units that the particular product con
tributes to the overall metric quantity
of the FlexPoint bundle or Cloud Pak to
which that product is assigned.
It is the value from the hwm_quantity
column multiplied by the conversion op
tion that is specified for the particular
product.
When the product is not a part of the
FlexPoint bundle or a Cloud Pak, the col
umn is empty.

Integer

Table 248. Available columns (continued)
Column
product_bun
dle_ratio_divider

Description
When the product is a part of a Flex

Displayed by
default

Type
Integer

Point bundle or a Cloud Pak, the col
umn shows the divider of the ratio that is
used to convert product license metrics
to license metrics of the bundle.
For example, when IBM Security QRadar
SOAR Users is installed as part of IBM
Cloud Pak for Security, the conversion
ratio is 5:1. The value of the product_
bundle_ratio_divider column in this case
would be 5.

product_bun
dle_ratio_factor

When the product is a part of a Flex
Point bundle or a Cloud Pak, the column
shows the factor of the ratio that is used
to convert product license metrics to li
cense metrics of the bundle.
For example, when IBM Security QRadar
SOAR Users is installed as part of IBM
Cloud Pak for Security, the conversion
ratio is 5:1. The value of the product_
bundle_ratio_factor column in this case
would be 1.

Integer

Query parameters
Table 249. Query parameters
Parameter
columns

Description

Required

Specify which columns to retrieve. If you do not

Value
String

specify this parameter, only default columns are
retrieved.
Example: Retrieve product name and threshold
delta
URL?
columns[]=product_name&columns[]=thresh
old_delta

computer

Specify ID of the computer group for which you

GroupId

want to retrieve the data. If you do not specify

Integer

this parameter, the data is retrieved for the com
puter group of the user whose token is used for
authentication. If you specify the parameter, you
can retrieve the data for a subgroup of this com
puter group.
To view IDs of computer groups, log in to BigFix
Inventory and go to Reports > Computer Groups.
Then, hover of the Manage Report View icon

,

click Configure View, and select the ID column to
display it on the report.
Example: Retrieve data for computer group 5
URL?computerGroupId=5

order

Specify how to sort the retrieved data. The de

Alphanu

fault direction for sorting columns is ascending.

meric

Table 249. Query parameters (continued)
Parameter

Description

Required

Value

If you want to specify a descending sort, append
desc to the column name.

Example: Order by threshold delta
URL?order[]=threshold_delta desc

limit

Specify the number of rows to retrieve. If you

Numeric

omit this parameter, all rows are retrieved.
Example: Retrieve 100 records
URL?limit=100

offset

Specify the number of rows to skip for retrieving

Numeric

results. You can use it together with the limit pa
rameter to paginate results.
Example: Retrieve 50 records starting after
record 150
URL?limit=50&offset=150

startdate

Specify the date starting from which you want
to retrieve the data. Specify it in the YYYY-MM-DD
format. If you do not specify the filter, its default
value is the date of the last successful import
of data to BigFix Inventory minus the number of
days for which data is calculated in the computer
group (90 days by default).
Example: Retrieve data starting from 14th July
2017
URL?startdate=2017-07-14

Date

Table 249. Query parameters (continued)
Parameter
enddate

Description

Required

Specify the date until which you want to retrieve

Value
Date

the data. Specify it in the YYYY-MM-DD format. If
you do not specify the filter, its default value is
the date of the last successful import of data to
BigFix Inventory.
Example: Retrieve data from 1st October 2017 to
31st October 2017
URL?
startdate=2017-10-01&enddate=2017-10-31

token

A unique user authentication identifier. You can
retrieve it by using REST API for retrieving au

✓

Alphanu
meric

thentication token. You can also log in to BigFix
Inventory, hover over the User icon

, and click

Profile. Then, click Show token.
criteria

Retrieve records which match specific condi
tions. The parameter should have the following
structure, written in one line:
<criteria> ::= <left-brace>
<boolean-operator> <colon>
<left-bracket>
<criterion> [{ <comma>
<criterion> }...] <right-bracket>
<right-brace>
<boolean-operator> ::= "and" | "or"
<criterion> ::= <criteria> |
<left-bracket> <column> <comma>

String

Table 249. Query parameters (continued)
Parameter

Description
<operator> <comma> <value>
<right-bracket>
<column> ::= <json-string>
<operator> ::= <json-string>
<value> ::= <json-array> |
<json-string> | <json-number> |
<json-null>

Note: The license_usage REST API does
not support nested filtering criteria.
Example 1: Retrieve software instances whose
product name contains "BigFix" AND the thresh
old delta is below 0
URL?criteria={"and":[["product_name","c
ontains","BigFix"],
["threshold_delta","<","0"] ] }

In case of the threshold, and custom_field_number fields, you can retrieve all entries for

which the value is specified or for which it is not
specified.
Example 2: Retrieve software products for which
the threshold is specified
URL?criteria={"and":[["threshold","!=",
]]}

Example 3: Retrieve software products for which
the threshold is not specified

Required

Value

Table 249. Query parameters (continued)
Parameter

Description

Required

URL?criteria={"and":[["threshold","=",]
]}

If you created custom fields that use the date
values, you can retrieve data also for a period
instead of a specific date. To do so, use last or
next as <operator>, and then specify the time
value in the following convention: PxD/PxW/
PxM/PxY, where x is a number in the 1-999 range,
and D, W, M, or Y is a designator that represents
days, weeks, months, or years respectively.
Example 4: Retrieve software products for which
entitlement ends within next month
URL?criteria={"and":[["custom_field_1",
"next","P1M"]]}

For more information about operators, see: Com
mon connectors and operators.

Example conversation - default columns
Request
GET api/sam/v2/license_usage?token=7adc3efb175e2bc0f4484bdd2efca
54a8fa04623
Host: localhost:9081
Accept: application/json
Accept-Language: en-US

Response header

Value

Status Code: 200 OK
Content-Type: application/json
computerGroupId: 0
enddate: 2017-10-31
startdate: 2017-10-01

Response body
[{

"product_publisher_name": "IBM",
"product_name": "WebSphere Service Registry and Repository",
"metric_code_name": "PVU_FULL_CAP",
"hwm_quantity": 480
}]

Example conversation - all columns
Request
GET api/sam/v2/license_usage?columns[]=product_id
&columns[]=product_name&columns[]=product_family_guid&columns[]=
metric_id
&columns[]=metric_name&columns[]=metric_code_name&columns[]=hwm_
quantity
&columns[]=threshold&columns[]=threshold_delta&columns[]=importe
d_part_numbers
&columns[]=is_reaggregation_needed&token=7adc3efb175e2bc0f4484bd
d2efca54a8fa04623
Host: localhost:9081
Accept: application/json
Accept-Language: en-US

Response body

[{

"product_publisher_name": "IBM",
"product_id": 29258,
"product_name": "WebSphere Service Registry and Repository",
"product_family_guid": "3b31a72e-468d-47bb-825a-ea26c8e85199",
"metric_id": 3,
"metric_code_name": "PVU_FULL_CAP",
"metric_name": "PVU Full Capacity",
"hwm_quantity": 480,
"threshold": null,
"threshold_delta": null,
"imported_part_numbers": null,
"is_reaggregation_needed": 0
"bundle_name": null,
"bundle_type": -1,
"bundle_guid": null,
"bundle_metric_contribution": null
}]

Example conversation - additional column
Request
GET api/sam/v2/license_usages?columns[]=product_name
&columns[]=metric_name&columns[]=threshold_delta
&token=7adc3efb175e2bc0f4484bdd2efca54a8fa04623
Host: localhost:9081
Accept: application/json
Accept-Language: en-US

Response body

[{
"product_name": "WebSphere Service Registry and Repository",
"metric_name": "PVU Full Capacity",
"threshold_delta": 100
}]

Example conversation - custom field
To retrieve data from custom fields that were added to the All Metrics report, start by
viewing the license_usage.json schema. The schema lists all columns, including
custom fields. Identify the custom field from which you want to retrieve the data.
Request - check list of created custom fields
GET api/sam/v2/schemas/license_usage.json?token=7adc3efb175e2bc0
f4484bdd2efca54a8fa04623

Response - list of all columns, including custom fields
[{
"product_name":
{
"type": "string",
"description": "Name of the software product."
},
...

"custom_field_1":
{
"type": "date",
"title": "Entitlement End"
}
}]

After you identify the name of the custom field, you can use it in the REST API request.

Request
GET api/sam/v2/license_usages?columns[]=product_name
&columns[]=custom_field_1&token=7adc3efb175e2bc0f4484bdd2efca54a
8fa04623
Host: localhost:9081
Accept: application/json
Accept-Language: en-US

Response body
[{
"product_name": "WebSphere Service Registry and Repository",
"custom_field_1": "2017-10-01"
}]

Example conversation - retrieving information about FlexPoint bundles and
Cloud Paks
Request
GET api/sam/v2/license_usages?columns[]=product_name
&columns[]=bundle_name&columns[]=bundle_type&columns[]=bundle_me
tric_contribution
&token=7adc3efb175e2bc0f4484bdd2efca54a8fa04623&criteria={"and"
:[["bundle_type","in","[0,1]"]]}
Host: localhost:9081
Accept: application/json
Accept-Language: en-US

Response body
[{
"product_name": "IBM WebSphere Application Server Network Deploy
ment",
"bundle_name": "IBM Cloud Pak for Applications"

"bundle_type": "1"
"bundle_metric_contribution": "100"
}]

Setting license metric thresholds and custom field values (v2)
Available from 9.2.10. You use the PUT operation on the api/sam/v2/
license_usage element to set up license metric thresholds as well as values of custom

fields that were added on the All Metrics report.

Permissions
You must have the Manage Contracts permission to use this API.

Resource URL
https://hostname:port/api/sam/v2/license_usage?token=token

Resource information
Table 250. Resource information
Operation details
HTTP method
Request headers

Description
PUT

Header
Accept-Language (optional)

Values
en-US (only English is supported)
Negotiates the language of the response. If the header
is not specified, the content is returned in the server lan
guage.
Request format
Response headers

application/json

Header

Table 250. Resource information (continued)
Operation details

Description
Content-Type

Values
application/json

Specifies the content type of the response.
Header
Content-Language

Values
en-US, …
Specifies the language of the response content. If the
header is not specified, the content is returned in the serv
er language.
Header
computerGroupId

Values
Integer
Specifies ID of the computer group for which values are
changed.
Response payload

n/a

Response format

application/json

Response codes

200 – OK
400 – "Bad Request" if a parameter contains errors
401 – "Unauthorized user" if the user whose token is

used for authentication is not authorized to access the da
ta

Table 250. Resource information (continued)
Operation details

Description
404 – "Not Found" if a parameter does not exist
406 – "Not Acceptable" if the import is in progress and

the values cannot be updated. For information about
checking the status of the import, see: Running data im
ports.

Schema description
To retrieve the list of all columns that are used by this REST API together with their
descriptions, use the following request.
GET api/sam/v2/schemas/license_usage.json?token=token

Query parameters
Table 251. Query parameters
Column
computerGroupId

Re

Description

quired

Identifier of the computer group for which you want
to update the values. If you do not specify this pa
rameter, the values are updated for the computer
group of the user whose token is used for authenti
cation.
To view IDs of computer groups, log in to BigFix In
ventory and go to Reports > Computer Groups. Then,
hover of the Manage Report View icon

, click

Configure View, and select the ID column to display
it on the report.

Type

Table 251. Query parameters (continued)
Column
bundle_id

Description
ID of the FlexPoint bundle or the Cloud Pak to which
the product is assigned.

Re
quired
✓

Type
In
te
ger

product_id

Identifier of the software product.

✓

In
te
ger

metric_id

Identifier of the license metric. For the list of metric
identifiers, see: Metric IDs and code names.

threshold

The maximum number of metric units that the prod
uct is entitled to use within a computer group.

✓

String

✓

In
te
ger

custom_field_number

Custom field that was added to the All Metrics re

Var

port. To view the list of all custom fields, view the

i

license_usage.json schema.

ous

Note: You can change multiple values during a single request. For example, you can
use a single request to set the metric threshold, set a value of one custom field, and
clear the value of another custom field.

Example conversation - setting a license metric threshold
1. To retrieve information about the identifier of the product for which you want to set
the license metric threshold, use the following GET request. The request returns
product ID and name as well as metric ID and code name.
Request

GET api/sam/v2/license_usage?columns[]=product_id&columns[]
=product_name
&columns[]=metric_id&columns[]=metric_code_name&token=7adc3
efb175e2bc0f4484bdd2efca54a8fa04623

Response
[{
"product_id": 29258,
"product_name": "WebSphere Service Registry and Repository"
,
"metric_id": 3,
"metric_code_name": "PVU_FULL_CAP"
}]

2. To change the value of the license metric threshold, use the following PUT request.
A relation between the product specified by the product_id parameter and the license
metric specified by the metric_id parameter must exist in the software catalog.
Otherwise, the request returns an error. If the relation does not exist in the software
catalog, you can create it on the Products & Metrics panel. For more information, see:
Assigning an additional metric to a product.
Request
PUT api/sam/v2/license_usage?product_id=29258&metric_id=3
&threshold=300&token=7adc3efb175e2bc0f4484bdd2efca54a8fa046
23

Response
200 - OK

Tip: To automate the process, you can write a script that parses the results returned
by the GET request, iterates through these results, and updates them one by one by
using the PUT request.

Example conversation - setting the value of a custom field
1. To check the list of custom fields that were created on the All Metrics report, view the
license_usage.json schema. The schema lists all columns, including custom fields.

Identify the custom field for which you want to set the value.
Request - check the list of existing custom fields
GET api/sam/v2/schemas/license_usage.json?token=7adc3efb175
e2bc0f4484bdd2efca54a8fa04623

Response - list of all columns, including custom fields
[{
"product_name":
{
"type": "string",
"description": "Name of the software product."
},
...
"custom_field_1":
{
"type": "boolean",
"title": "Requires Extension"
}
}]

2. After you identify the name of the custom field, use the following PUT request.
Request

PUT api/sam/v2/license_usage?product_id=29258&metric_id=3&b
undle_id=3496
&custom_field_1=1&token=7adc3efb175e2bc0f4484bdd2efca54a8fa
04623

Response
200 - OK

Example conversation - clearing a license metric threshold
1. To retrieve information about the identifier of the product for which you want to clear
the license metric threshold, use the following GET request. The request returns
product ID and name, metric ID and name, and the threshold value.
Request
GET api/sam/v2/license_usage?columns[]=product_id&columns[]
=product_name
&columns[]=metric_id&columns[]=metric_name&columns[]=thresh
old
&token=7adc3efb175e2bc0f4484bdd2efca54a8fa04623

Response
[{
"product_id": 29258,
"product_name": "WebSphere Service Registry and Repository"
,
"metric_id": 3,
"metric_name": "PVU Full Capacity"
"threshold": 300
}]

2. To clear the license metric threshold, specify an empty value in the threshold
parameter. The same method is used for clearing values of custom fields.

Request
PUT api/sam/v2/license_usage?product_id=29258&metric_id=3
&threshold=&token=7adc3efb175e2bc0f4484bdd2efca54a8fa04623

Response
200 - OK

Metric IDs and code names
Available from 9.2.8. The api/sam/v2/software_instances and api/sam/v2/
license_usage REST APIs return information about metric that is used by a product in the

form of a unique metric ID or metric code name. Learn what is the relation between the
metric ID and code name as well as what is the description of every metric.
Table 252. Metric ID, code name, and description
Metric ID

Metric code name

Metric description

-8413

FREE

Free

5347

MONTHLY_API_CALL

Monthly API call

19462

NAMED_USER

Named User

10808

CLIENT_ACCESS_LICENSE

Client Access License
(CAL)

-29884

MANAGEMENT_LICENSE

Management License
(ML)

-32264

MILLION_EVENT

Million Event

-31967

PROCESS

Process

-24028

TIERED_DECIMAL_TERABYTES

Tiered Decimal Ter
abyte Small

Table 252. Metric ID, code name, and description (continued)
Metric ID

Metric code name

Metric description

-19454

EMPLOYEE_USER

Employee User

-16552

CONCURRENT_CONNECTION

Concurrent Connec
tion

-4347

EXTERNAL_USER

External User

10251

RESOURCE_UNIT

Resource Unit

22960

GIGABITS_PER_SECOND

Gigabits per second

31139

INFREQUENT_USER

Infrequent User

ACTIVE_CONTAINER

Active Container

-32603

CONCURRENT_USER

Concurrent User

-32470

VU_VALUE_UNIT

VU Value Unit

-32337

APPSERVER_CONNECTED

AppServer Connected

-30184

LIMITED_USE_VIRTUAL_SERVER

Limited Use Virtual

17346

Server
-29478

POPULATED_SOCKET

Populated Socket

-27870

MANAGED_SWITCH

Managed Switch

-27189

BED

Bed

-26157

SWITCH

Switch

-25214

TOKEN

Token

-24771

AUTHORIZED_USER_SINGLE_INSTALL

Authorized User Sin
gle Install

-24466

5000_FLOATING_USERS

5000 Floating Users

Table 252. Metric ID, code name, and description (continued)
Metric ID

Metric code name

Metric description

-24282

PRINTER

Printer

-23594

ESTABLISHMENT

Establishment

-21525

CURRENCY_VALUE_UNIT

Currency Value Unit

-21171

MILLION_SPEND_CONVERSION_UNITS

Million Spend Conver
sion Units

-18783

AUTHORIZED_USER

Authorized User

-18750

PROCESSOR

Processor

-18667

FEED

Feed

-18577

STORAGE_CAPACITY_UNIT_(101-250)

Storage Capacity Unit
(101-250)

-17749

STORAGE_CAPACITY_UNIT_(751-1250)

Storage Capacity Unit
(751-1250)

-16893

TEN_MONTHLY_JOBS

10 Monthly Jobs

-16798

TERABYTE

Terabyte

-16762

INSTALL_WITH_PAGES

Install with up to
<number> Pages

-15896

RESOURCE_VALUE_UNIT

Resource Value Unit

-15529

INSTANCE

Instance

-15520

CLIENT_USER

Client User

-13938

STORE

Stores

-13494

AUTHORIZED_USER_SINGLE_SESSION

Authorized User Sin
gle Session

-13103

CLIENT_DEVICE

Client Device

Table 252. Metric ID, code name, and description (continued)
Metric ID

Metric code name

Metric description

-12983

TRANSACTION

Transaction

-11982

SIMULTANEOUS_SESSION

Simultaneous Ses
sion

-11743

FILE

File

-10658

TERMINAL

Terminal

-10377

HOST_SERVER

Host Server

-10210

PAGE

Page

-9208

APPLIANCE_INSTALL

Appliance Install

-8670

RACK

Rack

-8617

MILLION_OF_SERVICE_UNIT_PER_HOURS

Millions of Service
Units per Hour

-8333

STORAGE_CAPACITY_UNIT_(251-500)

Storage Capacity Unit
(251-500)

-8152

STORAGE_DEVICE

Storage Device

-7054

VIRTUAL_CORE_BASED

Microsoft Virtual Core
with SA

-6957

TIERED_TERABYTES

Tiered Terabytes

-6399

PROCESSOR_DAY

Processor Day

-5373

TIVOLI_MANAGEMENT_POINT

Tivoli Management
Point

-5368

STORAGE_CAPACITY_UNIT_(1-100)

Storage Capacity Unit
(1-100)

Table 252. Metric ID, code name, and description (continued)
Metric ID

Metric code name

Metric description

-5256

STORAGE_CAPACITY_UNIT_(501-750)

Storage Capacity Unit
(501-750)

-5048

ONE_M_ORDER_LINES

1 Million Order Lines

- 4563

ORACLE_PROCESSORS

Oracle Processor
Core

-4608

MANAGED_DEVICE

Managed Device Ora
cle Core Based

-4050
-2984

ADDRESSABLE_DEVICE

Addressable Device

LIMITED_USE_AUTHORIZED_USER

Limited Use Autho
rized User

-2809

STORAGE_CAPACITY_UNIT_(2001+)

Storage Capacity Unit
(2001+)

-2758

FLOATING_USER_SINGLE_SESSION_SIN-

Floating User Single

GLE_INSTALL

Session Single Install

-2583

SERVER_DEVICE

Server

-2368

CLIENT

Client

-1827

LIMITED_USE_MANAGED_SERVER

Limited Managed
Server Unit

1

INTERNAL_OTHER

Unknown

3

PVU_FULL_CAP

PVU Full Capacity

Use this metric ID or code name to re
trieve or set up thresholds of license met
ric utilization by using the api/sam/v2/
license_usage REST API.

Table 252. Metric ID, code name, and description (continued)
Metric ID

Metric code name

Metric description

4

PVU_SUB_CAP

PVU Subcapacity

Use this metric ID or code name to re
trieve or set up thresholds of license met
ric utilization by using the api/sam/v2/
license_usage REST API.

5

INTERNAL_PVU

PVU

Use this metric ID or code name to re
trieve information about the license met
ric that is assigned to a product by us
ing the api/sam/v2/software_instances
REST API.
6

INTERNAL_RVU_MAPC

RVU MAPC

Use this metric ID or code name to re
trieve information about the license met
ric that is assigned to a product by us
ing the api/sam/v2/software_instances
REST API.
7

RVU_FULL_CAP

Use this metric ID or code name to re

RVU MAPC Full Ca
pacity

trieve or set up thresholds of license met
ric utilization by using the api/sam/v2/
license_usage REST API.

8

RVU_SUB_CAP

Use this metric ID or code name to re
trieve or set up thresholds of license met

RVU MAPC Subca
pacity

Table 252. Metric ID, code name, and description (continued)
Metric ID

Metric code name

Metric description

ric utilization by using the api/sam/v2/
license_usage REST API.

9

INTERNAL_INSTALL

Install Seats

10

FLEXPOINT

Flexpoint

488

TEN_AUTHORIZED_USER

10 Authorized User

526

MAILBOX

Mailbox

865

VIRTUAL_SERVER

Virtual Server

500_FLOATING_USERS

500 Floating Users

CONNECTOR_FOR_DEMAND_SIDE

Connector for De

2110
2692

mand-side
3058

CONNECTION

Connection

3729

FLOATING_USER_SINGLE_INSTALL

Floating User Single
Install

3774

USER_VALUE_UNIT

User Value Unit

MANAGED_CONTAINER

Managed Container

5264

REGISTERED_USER

Registered User

5844

VIRTUAL_PROCESSOR_CORE

Virtual Processor

3827

Core
5856

ELIGIBLE_PARTICIPANT

Eligible Participant

6083

10_MANAGED_VIRTUAL_SERVERS

10 Managed Virtual
Servers

6089

PER_TOKEN

Per Token

Table 252. Metric ID, code name, and description (continued)
Metric ID

Metric code name

Metric description

6420

MANAGED_VIRTUAL_NETWORK_DEVICE

Managed Virtual Net
work Device

6554

10000_FLOATING_USERS

10000 Floating Users

6967

APPLICATION

Application

7057

MONTHLY_MILLION_RULES_DECISIONS

Monthly Million Rules
Decisions

7884

MILLION_SQUARE_FEET

Million Square Feet

8321

LIMITED_USE_SOCKET

Limited Use Socket

8604

INSTALL_WITH_3_AUTHORIZED_USERS

Install with 3 Autho
rized Users

8843

CONCURRENT_SESSION

Concurrent Session

9033

THOUSAND_ADDRESSABLE_DEVICES

Thousand Address
able Devices

10157

CONNECTOR

Connector

10310

PORT

Port

10989

APPLICATION_INSTANCE

Application Instance

11165

LINEAR_ASSET

Linear Asset

11328

USER

Users

12599

HUNDRED_THOUSAND_SQUARE_METERS

Hundred Thousand
Square Meters

13557

FLOATING_USER

Floating User

Table 252. Metric ID, code name, and description (continued)
Metric ID

Metric code name

Metric description

14325

MONTHLY_THOUSAND_MANAGED_DECISION_-

Monthly Thousand

ARTIFACTS

Managed Decision Ar
tifacts

14692

SINGLE_PHYSICAL_PROCESSOR_BASED

Microsoft Single
Processor

15006

FLOATING_USER_SINGLE_SESSION

Floating User Single
Session

15282

DECIMAL_TERABYTE

Decimal Terabyte

16958

BASE_PROCESSOR

Base Processors

17437

SERVER_LESS_THAN_1000

Server Less Than
1000 Nodes

17502

MANAGED_CHASSIS

Managed Chassis

19131

MONTHLY_JOBS

Monthly Order Re
quest

20170

SOCKET

Socket

20249

TICKETS

Tickets

21058

SERVER_GREATER_OR_EQUAL_TO_1000

Server Greater Or
Equal to 1000 Nodes

21426
21610
21704

NETWORK_NODE

Network Node

1000_FLOATING_USERS

1000 Floating Users

CONNECTOR_FOR_SUPPLY_SIDE

Connector for Sup
ply-side

21936

MANAGED_TERABYTE

Managed Terabyte

Table 252. Metric ID, code name, and description (continued)
Metric ID

Metric code name

Metric description

22225

STORAGE_CAPACITY_UNIT_(1251-2000)

Storage Capacity Unit
(1251-2000)

22989

IDLE_STANDBY_SERVER

Idle Standby Server

23720

PHYSICAL_CORE_BASED

Microsoft Physical
Core with SA

24179

MANAGED_CLIENT_DEVICES

Managed Client De
vices

26571

MONTHLY_HOUR

Monthly Hour

27777

ASSET

Asset

28226

GENERAL_PURPOSE_GRAPHICS_PRO-

General Purpose

CESSING_UNIT

Graphics Proc Unit

MANAGED_VIRTUAL_SERVER

Managed Virtual Serv

28591

er
28953

INSTALL

Install Instances

28967

MANAGED_SERVER

Managed Server

29313

ADDRESSABLE_DEVICES

Addressable Devices

31619

STG_TIER

STG Tier

31705

SERVER_WITH_ONE_PROCESSOR

Server with One
Processor

31997

ADDITIONAL_PROCESSOR

Additional Processor

32455

DUAL_PHYSICAL_PROCESSOR_BASED

Microsoft Dual
Processor

REST API associations
Available from 9.2.8. For REST APIs in version 2, you can use associations to
retrieve additional data as part of API requests. For example, you can retrieve detailed
information about computer hardware as part of the software_instances API request.

Syntax
To retrieve the additional data, use the following syntax of the query:
<URL>?columns[]=<association>.<column>&token=<token>

Where:
• <URL> is the REST API request
• <association> is the name of the association from which you want to retrieve the
column
• <column> is the name of the column that you want to retrieve
• <token> is the unique user authentication identifier
For example:
GET api/sam/v2/software_instances?columns[]=computer_health.catalog_version
&token=7adc3efb175e2bc0f4484bdd2efca54a8fa04623

Note: Use API associations to retrieve information that cannot be obtained directly
through an existing API.

component_cpe association
Available from 9.2.12. Use the component_cpe association to retrieve information
about the discovered component as specified in the Common Platform Enumeration (CPE)
dictionary as part of other REST API requests.

Association
component_cpe

Applicable REST APIs
You can use the component_cpe association with the following REST APIs:
• /api/sam/v2/software_instances

Syntax
<URL>?columns[]=component_cpe.<column>&token=<token>

Schema description
To retrieve the list of all columns that are returned by this association together with their
descriptions, use the following request.
GET api/sam/schemas/associations/component_cpe.json?token=<token>

Available columns
Table 253. Columns with information about components as specified in the CPE
standard
Property
cpe22

Description
Information about the dis

Type
String

covered component in the
CPE v2.2 format.
cpe23

Information about the dis
covered component in the
CPE v2.3 format.

String

Limitations
• BigFix Inventory does not support the following fields that are specified in the CPE
standard: update, edition, lang.
• Marking of software as o (operating system) is automatic and might not always be
accurate.
• Dots (.) and dashes (-) are not escaped as defined in the CPE standard. Otherwise,
CPE information that is provided by BigFix Inventory could not be matched with the
CVE data.

computer association
Available from 9.2.10. Use the computer association to retrieve information about
details of the computer and custom computer properties as part of REST API requests.

Association
computer

Applicable REST APIs
You can use the computer association with the following REST APIs:
• /api/sam/raw_file_facts
• /api/sam/unified/current/

Syntax
<URL>?columns[]=computer.<column>&token=<token>

For example:
GET api/sam/raw_file_facts?columns[]=computer.ip_address
&token=7adc3efb175e2bc0f4484bdd2efca54a8fa04623

Schema description
To retrieve the list of all columns that are returned by this association together with their
descriptions, use the following request. The list contains custom computer properties that
were added on the Computer Properties panel.
GET api/sam/schemas/associations/computer.json?token=<token>

Available columns
Table 254. Columns with information about computer details
Column
id

Description

Type

Identifier of the computer as Integer
specified in the BigFix Inven
tory database.

remote_id

Identifier of the computer as Integer
specified in the BigFix data
base.

last_seen

Date and time when the Big

String

Fix client connected to the
BigFix server the last time.
datasource_id

Identifier of the BigFix serv

Integer

er to which the computer re
ports.
datasource_name

Name of the BigFix server to

String

which the computer reports.
created_at

Date and time when the in
formation about the comput
er was imported from BigFix
for the first time.

String

Table 254. Columns with information about computer details (continued)
Column
valid_to

Description
The date and time when the

Type
String

computer stopped being dis
covered, for example be
cause it was removed from
the infrastructure, the data
source was removed, or the
BigFix client was uninstalled.
os

Operating system of the

String

computer.
dns_name

Name of the computer that

String

is specified in the Domain
Name System.
name

Host name of the computer.

String

ip_address

IP address of the computer.

String

computer_property_number

Custom computer property

String

that was added on the Com
puter Properties panel. To
view the list of all custom
properties, view the computer schema. The name of the

property as displayed on the
user interface is shown in
the title parameter.

computer_details association
Available from 9.2.10. Use the computer_details association to retrieve
information about details of the computer and custom computer properties as part of REST
API requests.

Association
computer_details

Applicable REST APIs
You can use the computer_details association with the following REST APIs:
• api/sam/v2/computers

Syntax
<URL>?columns[]=computer_details.<column>&token=<token>

For example:
GET api/sam/v2/software_instances?columns[]=computer_details.ip_address
&token=7adc3efb175e2bc0f4484bdd2efca54a8fa04623

Schema description
To retrieve the list of all columns that are returned by this association together with their
descriptions, use the following request. The list contains custom computer properties that
were added on the Computer Properties panel.
GET api/sam/schemas/associations/computer_details.json?token=<token>

Available columns
Table 255. Columns with information about computer details
Column
id

Description

Type

Identifier of the computer as Integer
specified in the BigFix Inven
tory database.

remote_id

Identifier of the computer as Integer
specified in the BigFix data
base.

last_seen

Date and time when the Big

String

Fix client connected to the
BigFix server the last time.
datasource_id

Identifier of the BigFix serv

Integer

er to which the computer re
ports.
datasource_name

Name of the BigFix server to

String

which the computer reports.
created_at

Date and time when the in

String

formation about the comput
er was imported from BigFix
for the first time.
valid_to

The date and time when the
computer stopped being dis
covered, for example be
cause it was removed from
the infrastructure, the data
source was removed, or the
BigFix client was uninstalled.

String

Table 255. Columns with information about computer details (continued)
Column
os

Description
Operating system of the

Type
String

computer.
dns_name

Name of the computer that

String

is specified in the Domain
Name System.
name

Host name of the computer.

String

ip_address

IP address of the computer.

String

computer_property_number

Custom computer property

String

that was added on the Com
puter Properties panel. To
view the list of all custom
properties, view the computer_details schema. The

name of the property as dis
played on the user interface
is shown in the title para
meter.

computer_health association
Available from 9.2.8. Use the computer_health association to retrieve information
about health of the computer, such as the status of software scans, or version of the
installed BigFix client, as part of REST API requests.

Association
computer_health

Applicable REST APIs
You can use the computer_health association with the following REST APIs:
• api/sam/v2/computers
• api/sam/v2/software_instances

Syntax
<URL>?columns[]=computer_health.<column>&token=<token>

For example:
GET api/sam/v2/software_instances?columns[]=computer_health.catalog_version
&token=7adc3efb175e2bc0f4484bdd2efca54a8fa04623

Schema description
To retrieve the list of all columns that are returned by this association together with their
descriptions, use the following request.
GET api/sam/schemas/associations/computer_health.json?token=<token>

Available columns
Table 256. Columns with information about computer health
Column
agent_version

Description
Version of the BigFix client

Type
Numeric

that is deployed on the com
puter.
catalog_version

Version of the BigFix-provid
ed software catalog that is
available on the computer.

Numeric

Table 256. Columns with information about computer health (continued)
Column

Description

catalog_custom_content_

Version of the custom soft

version

ware catalog that is available

Type
Numeric

on the computer.
is_catalog_scan_successful

Indicates whether the cata

Boolean

log scan was successful.
is_filesys_scan_successful

Indicates whether the file

Boolean

system scan was success
ful.
is_idtag_scan_successful

Indicates whether the last

Boolean

software tags scan was suc
cessful.
is_low_on_disk_space

Indicates whether the com

Boolean

puter has less than 100 MB
of free disk space.
is_missing_prereqs

Indicates whether any scan

Boolean

ner prerequisites are missing
on the computer.
is_out_of_date

Indicates whether the latest

Boolean

version of the BigFix client
is installed on the comput
er. For some operating sys
tems, no newer version of
the client is available.
is_out_of_sync

Indicates whether the time
that is set on the computer
is at least an hour from the

Boolean

Table 256. Columns with information about computer health (continued)
Column

Description

Type

time that is set on the BigFix
Inventory server.
is_package_scan_successful Indicates whether the latest

Boolean

package scan was success
ful.
last_scan_attempt

Date and time when the last

String

scan was initiated.

computer_hardware association
Available from 9.2.8. Use the computer_hardware association to retrieve detailed
hardware information as part of other REST API requests.

Association
computer_hardware

Applicable REST APIs
You can use the computer_hardware association with the following REST APIs:
• api/sam/v2/computers
• api/sam/v2/software_instances

Syntax
<URL>?columns[]=computer_hardware.<column>&token=<token>

For example:
GET api/sam/v2/software_instances?columns[]=computer_hardware.computer_type
&token=7adc3efb175e2bc0f4484bdd2efca54a8fa04623

Schema description
To retrieve the list of all columns that are returned by this association together with their
descriptions, use the following request.
GET api/sam/schemas/associations/computer_hardware.json?token=<token>

Available columns
Table 257. Columns with information about computer hardware
Name on the Hard

Description

ware Inventory report
computer_type

Computer Type. Possible

Type
Numeric

values are:
• 0 - physical
• 1- virtual
• 2- computer running
on a public cloud
shared_pool_id

Identifier of IBM POWER

String

shared processor pool.
system_model

Name of the hardware sys String
tem or virtualization tech
nology that is discovered
by the BigFix client.

cluster_name

Name of the cluster to

String

which the computer be
longs.
cluster_cores_count

Number of processor cores Numeric
available within the cluster
to which the computer be
longs.

Table 257. Columns with information about computer hardware (continued)
Name on the Hard

Description

ware Inventory report
partition_cores

Number of processor

Type
Numeric

cores on the partition on
which the BigFix client is in
stalled. The number does
not take into account hy
per-threading on the x86 ar
chitecture.
status

Status of the computer.

String

Possible values are:
• 1 - OK
• 2 - No Scan Data
• 3 - No Host Scan Da
ta
• 4 - No VM Manager
Data
5 - Outdat

•

ed VM Manager Data
server_id

Internal identifier of the
physical server that hosts a
computer. In case of a vir
tual machine that is not ful
ly defined, the ID is a place
holder for a physical serv
er and it changes when you
complete defining the virtu
al machine.

Numeric

Table 257. Columns with information about computer hardware (continued)
Name on the Hard

Description

ware Inventory report
server_name

A unique system in the in

Type
String

frastructure. For a physi
cal machine, it is the hard
ware manufacturer, type,
and a machine serial num
ber. For a virtual machine,
it is the manufacturer and
host name. For a virtual
machine with an incom
plete definition, it is a UUID
that is prefixed with TLM_VM_.

You can specify the da
ta that is returned by this
property by configuring the
following advanced server
settings: managedServer
TagTemplate and stand
aloneServerTagTemplate.
For more information, see:
Configuring advanced serv
er settings.
server_serial_
number

A serial number of a phys
ical server. In case of a vir
tual machine that is not ful
ly defined, the Server Seri
al Number is a UUID that is
prefixed with TLM_VM_.

Numeric

Table 257. Columns with information about computer hardware (continued)
Name on the Hard
ware Inventory report

Description

Type

server_type

A type of a physical server.

String

server_vendor

A type of a physical server.

String

server_model

A type of a physical server.

String

Number of active sockets

Numeric

node_total_processors

on the physical server for
placing CPU units.
server_cores

Number of active physi

Numeric

cal processor cores on the
physical server.
server_id

Identifier of the server.

pvu_per_core

Number of PVUs that are

Numeric

assigned to a processor
core on the computer. By
default, the value is taken
from the PVU table.
default_pvu_value

Indicates whether a default Boolean
number of processor val
ue units is assigned to the
computer.

parent_hostname Hostname of the parent

String

computer, if available. The
value is null if the parent
computer is not available.
platform

Hardware architecture.
Possible values are:

String

Table 257. Columns with information about computer hardware (continued)
Name on the Hard
ware Inventory report

Description
• x86 platforms that
are available on Win
dows, Linux, and
SUN:
◦ IA32ONWIN64
◦ AMD64
◦ amd64
◦ x86
◦ i386
◦ i586
◦ i686
◦ x86_64
• Power platforms that
are available on AIX,
IBM i, and Linux:
◦ ppc
◦ ppc64
◦ ppc64le
◦ PowerPC
◦ PowerPC64
• PA-RISC platform
that is available on
HP-UX:
◦ PA-RISC
• IA-64 platform that is
available on HP-UX:
◦ ia64
• IBM Z platforms that
are available on Linux

Type

Table 257. Columns with information about computer hardware (continued)
Name on the Hard

Description

ware Inventory report

Type

◦ s390
◦ s390x
• SPARC platform that
is available on So
laris:
◦ sparcv9
The list might change with
time because the REST API
stores the same value that
is returned by the operating
system.
The following properties identify the Current Physical Server Processor. In case of a virtual
machine that is not fully defined, the information is gathered on VM level.
Table 258. Columns with properties that identify the Current Physical Server
Processor
Name on the
Property

Hardware In

Description

Type

ventory report
processor_brand_

Processor Brand

Full specification

string

String

of the processor in
cluding its brand,
model and speed as
read from the com
puter operating sys
tem.

String

Table 258. Columns with properties that identify the Current Physical Server
Processor (continued)
Name on the
Property

Hardware In

Description

Type

ventory report
processor_brand

Brand

Brand of the proces String
sor that was
matched in the PVU
table. If the brand is
"Other", the proces
sor is not listed in
the PVU table.

processor_model

Model

Model of the

String

processor.
processor_type

Type

Type of the proces

String

sor according to the
number of cores.
processor_vendor

Vendor

Vendor of the

String

processor.

cve association
Available from 9.2.13. Use the cve association to retrieve information about
Common Vulnerabilities and Exposures (CVEs) that were matched with a particular
component through its detailed version as part of other REST API requests.

Association
cve

Applicable REST APIs
You can use the cve association with the following REST API:

• /api/sam/v2/software_instances

Syntax
<URL>?columns[]=cve.<column>&token=<token>

Schema description
To retrieve the list of all columns that are returned by this association together with their
descriptions, use the following request.
GET api/sam/schemas/associations/cve.json?token=<token>

Available columns
Table 259. Columns with information about CVEs
Property
name

Description
A unique identifier of the

Type
String

vulnerability as assigned in
the National Vulnerability
Database.
base_severity

Severity of the CVE. Possi

Integer

ble values:
• 0 - None
• 1 - Low
• 2 - Medium
• 3 - High
• 4 - Critical
base_score

Base score of the CVE that
represents innate charac
teristics of the vulnerability.
It maps to the severity of
the CVE. For example, base

Float

Table 259. Columns with information about CVEs (continued)
Property

Description

Type

score in range between 0.1
and 3.9 is an equivalent of
low severity in CVSS v3.0.
For more information, see:
Vulnerability Metrics.
vector_string

Vector string of the CVE

String

in the CVSS system. It is a
textual representation of
metric values that are used
to score the vulnerability.
exploitability_score

Exploitability sub-score of

Float

the CVE that represent the
ease and technical means
by which the vulnerability
can be exploited.
impact_score

Impact sub-score of the

Float

CVE that indicates how im
portant will be the conse
quences if the vulnerability
is exploited.
source_version

Version of CVSS that is
used as the source of in
formation about the sever
ity and metrics of the CVE.
Possible values:
• 2 - CVSS v2.0
• 3 - CVSS v3.0

Integer

Table 259. Columns with information about CVEs (continued)
Property
publish_date

Description
The date and time when

Type
String

the CVE was published in
the National Vulnerability
Database.
modified_date

The date and time when

String

the CVE was last modified
in the National Vulnerability
Database.
description

Description of the CVE de

String

tails.

Sorting and filtering
Note: It is not recommended to filter information by more than two CVE properties
at a time because of the high consumption of database resources.
• When you filter REST API responses by any CVE property, the filter shows all
components that meet the specified criteria by searching through the full list of CVEs
of each reported component.
• CVEs that are returned for a single component are sorted by the base_score value.
• REST API responses cannot be sorted by columns from the cve association because
the association returns multiple CVEs for each component.

discovery_details association
Available from 9.2.11. Use the discovery_details association to retrieve details
of a file that caused component discovery as part of a REST API request. The details include
the name and size of the file as well as the path under which it was found.

Association
discovery_details

Applicable REST APIs
You can use the discovery_details association with the api/sam/v2/
software_instances REST API.

Syntax
<URL>?columns[]=discovery_details.<column>&token=<token>

For example:
GET
api/sam/v2/software_instances?columns[]=discovery_details.discovery_path&t
oken=7adc3efb175e2bc0f4484bdd2efca54a8fa04623

Available columns
Table 260. Columns with information about file that caused component discovery
Property
discovery_path

Description
Path to the file that caused

Type
String

component discovery.
file_name

Name of the file that

String

caused component discov
ery.
file_size

Size of the file that caused
component discovery.

String

designated_computer association
Available from 9.2.12. Use the designated_computer association to retrieve
information about computers that were designated to scan shared disks as part of other
REST API requests.

Association
designated_computer

Applicable REST APIs
You can use the designated_computer association with the following REST APIs:
• api/sam/v2/shared_disks

Syntax
<URL>?columns[]=designated_computer.<column>&token=<token>

For example:
GET api/sam/v2/shared_disks?columns[]=designated_computer.ip_address
&token=7adc3efb175e2bc0f4484bdd2efca54a8fa04623

Schema description
To retrieve the list of all columns that are returned by this association together with their
descriptions, use the following request.
GET api/sam/schemas/associations/designated_computer.json?token=<token>

Available columns
Table 261. Columns with information about computer hardware
Property
id

Description
Identifier of the computer
that was designated by Big

Type
Integer

Table 261. Columns with information about computer hardware (continued)
Property

Description

Type

Fix Inventory to scan the
shared disk as specified in
the BigFix Inventory data
base.
remote_id

Identifier of the computer

Integer

that was designated by Big
Fix Inventory to scan the
shared disk as specified in
the BigFix database.
last_seen

Date and time when the

String

computer reported to Big
Fix for the last time. The
time is specified in the
GMT time zone.
datasource_id

Identifier of the BigFix serv Integer
er to which the computer
reports.

datasource_name

Name of the BigFix server

String

to which the computer re
ports.
created_at

Date and time when the in

String

formation about the com
puter was imported from
BigFix for the first time.
valid_to

The date and time when
the computer stopped be
ing discovered, for example

String

Table 261. Columns with information about computer hardware (continued)
Property

Description

Type

because it was removed
from the infrastructure, the
data source was removed,
or the BigFix client was
uninstalled.
os

Operating system of the

String

computer.
dns_name

Name of the computer that String
is specified in the Domain
Name System.

name

Host name of the comput

String

er.
ip_address

IP address of the comput

String

er.

mounted_shared_disks association
Available from 9.2.12. Use the mounted_shared_disks association to retrieve
information about shared disks that are mounted on each computer as part of other REST
API requests.

Association
mounted_shared_disks

Applicable REST APIs
You can use the mounted_shared_disks association with the following REST APIs:
• api/sam/v2/computers

Syntax
<URL>?columns[]=mounted_shared_disks.<column>&token=<token>

For example:
GET api/sam/v2/computers?columns[]=mounted_shared_disks.mount_point
&token=7adc3efb175e2bc0f4484bdd2efca54a8fa04623

Schema description
To retrieve the list of all columns that are returned by this association together with their
descriptions, use the following request.
GET api/sam/schemas/associations/mounted_shared_disks.json?token=<token>

Available columns
Table 262. Columns with information about computer hardware
Property
shared_disk_id

Description
Identifier of the shared

Type
Integer

disk that is mounted on the
computer.
mount_point

Directory in which the

String

shared disk is mounted.
exported_directory

Exported directory of the

String

shared disk.

release_component_lifecycle association
Available from 9.2.13. Use the release_component_lifecycle association to
retrieve information about when a component reaches its end of support as part of other
REST API requests.

Association
release_component_lifecycle

Applicable REST APIs
You can use the release_component_lifecycle association with the following REST API:
• /api/sam/v2/software_instances

Syntax
<URL>?columns[]=release_component_lifecycle.<column>&token=<token>

Schema description
To retrieve the list of all columns that are returned by this association together with their
descriptions, use the following request.
GET
api/sam/schemas/associations/release_component_lifecycle.json?token=<token
>

Available columns
Table 263. Columns with information about when a component reaches its end of
support
Property
source_type

Description
Indicates whether the end
of support date is prede
fined or was set by a user.
Possible values:
• 0 - Set by a user
• 1 - Predefined

Type
Integer

Table 263. Columns with information about when a component reaches its end of
support (continued)
Property
eos_date

Description
Date when the component

Type
String

reaches its end of support.
updated_at

Date and time when the

String

end of support date was
last modified.

shared_disk_members association
Available from 9.2.12. Use the shared_disk_members association to retrieve
information about computers on which shared disks are mounted as part of other REST API
requests.

Association
shared_disk_members

Applicable REST APIs
You can use the shared_disk_members association with the following REST APIs:
• api/sam/v2/shared_disks

Syntax
<URL>?columns[]=shared_disk_members.<column>&token=<token>

For example:
GET api/sam/v2/shared_disks?columns[]=shared_disk_members.mount_point
&token=7adc3efb175e2bc0f4484bdd2efca54a8fa04623

Schema description
To retrieve the list of all columns that are returned by this association together with their
descriptions, use the following request.
GET api/sam/schemas/associations/shared_disk_members.json?token=<token>

Available columns
Table 264. Columns with information about computer hardware
Property
computer_id

Description
Identifier of the computer

Type
Integer

on which the shared disk is
mounted.
mount_point

Directory in which the

String

shared disk is mounted.

tags association
Available from 9.2.14. Use the tags association to retrieve information about tags
as part of other REST API requests.

Association
tags

Applicable REST APIs
You can use the tags association with the following REST APIs:
• /api/sam/v2/software_instances
Syntax:
<URL>?columns[]=component_tags.<column>&token=<token>

<URL>?columns[]=instance_tags.<column>&token=<token>

• /api/sam/v2/software_components
Syntax:
<URL>?columns[]=tags.<column>&token=<token>

Schema description
To retrieve the list of all columns that are returned by this association together with their
descriptions, use the following request.
GET api/sam/schemas/associations/tag.json?token=<token>

Available columns
Table 265. Columns with information about components as specified in the CPE
standard
Property
ID

Description
Information about the

Type
Integer

unique identifier of a tag.
name

Name of a tag.

String

usage_data association
Available from 9.2.8. Use the usage_data association to retrieve information about
application usage as part of other REST API requests.

Association
usage_data

Applicable REST APIs
You can use the usage_data association with the api/sam/v2/software_instances REST
API.

Syntax
<URL>?columns[]=usage_data.<column>&token=<token>

For example:
GET api/sam/v2/software_instances?columns[]=usage_data.has_usage
&token=7adc3efb175e2bc0f4484bdd2efca54a8fa04623

Schema description
To retrieve the list of all columns that are returned by this association together with their
descriptions, use the following request.
GET api/sam/schemas/associations/usage_data.json?token=<token>

Available columns
Table 266. Columns with information about usage
Column
avg_run_time

Description

Type

Average amount of time dur String
ing which a process or soft
ware was used. It is calculat
ed by dividing the total run
time by the number of total
runs.

avg_runs_per_day

Average number of times a

Numeric

process or software item is
started per day.
first_used

Date and time when the in
formation about the process
was first collected by the
BigFix client.

String

Table 266. Columns with information about usage (continued)
Column
has_usage

Description
Indicates whether a usage

Type
Boolean

signature exists for the par
ticular software.
last_used

Date and time when the soft String
ware item was last used or a
process was last run.

process

Name of the process on

String

which the calculation of soft
ware usage is based.
total_runs

Number of times a software

Numeric

item or process was started.
total_time

Indicates how long the soft

String

ware item or process was
running.

Computer group association
Use the Computer group association to retrieve information about computer group
associated to the contracts.

Syntax
<URL>?columns[]=computer_group.<column>&token=<token>

Available columns
Column name
ID

Identifier of the
computer group.

name

Displayed

Description

Name of the com
puter group.

Type

by default
✓

Integer

✓

String

Metric association
Use the metric association to retrieve information about metric associated to the
contracts.

Syntax
<URL>?columns[]=metric.<column>&token=<token>

Available columns
Column name

Displayed

Description
Identifier of the met ✓

ID

Type

by default
String

ric.
code_name

Code name of the
metric.

display_name

Display name of the

✓

Integer

String

metric

Purchase orders association
Use the purchase_orders association to retrieve information about purchase orders
associated to the contracts.

Syntax
<URL>?columns[]=purchase_orders.<column>&token=<token>

Available columns
Column name
purchase_number

Displayed

Description
Identifier of a pur
chase order. Pur
chase numbers
must be unique for
a given contract.
For the existing con
tracts, uniqueness
of this value is en
forced when editing
a contract.
Allowed format
is "YYYY-MMDD", for example
"2019-01-31". Val
ue "9999-12-31"
in REST API repre
sents "Never".
A special value ELA
(Enterprise License
Agreement) for pur
chase order value is
added. It means un
limited number of li

Type

by default
✓

String

Column name

Displayed

Description

Type

by default

censes for a given
entitlement period.
document_link

Document link of

String

the purchase order.
This value is option
al.
vendor

Vendor of the pur

String

chase order. This
value is optional.
quantity

Value of the pur
chase order. -1

✓

Integer

✓

String

means ELA and
positive integer
means a quantity of
the purchase order.
entitlement_start

Entitlement start
date of the pur
chase order.
Note: The
allowed
format is
"YYYY-MMDD", for
example
"2019-01-31".
Value
"9999-12-31"

Column name

Displayed

Description

Type

by default

in REST API
represents
"Never" on
UI.
entitlement_end

Entitlement end
date of the pur

✓

String

chase order. This
value is optional.
Note: Al
lowed for
mat is
"YYYY-MMDD", for
example,
"2019-03-31".
Value
"9999-12-31"
in REST API
represents
"Never" on
UI.

Software products association
Use the software_products association to retrieve information about software
products associated to the contracts.

Syntax
<URL>?columns[]=software_products.<column>&token=<token>

Available columns
Column name
name

Name of the soft
ware products.

publisher_name

Displayed

Description

Name of the pub
lisher of the soft

Type

by default
✓

String

✓

String

ware products.

REST API for retrieving raw scan results
Available from 9.2.2. Retrieving raw scan results through REST API is intended to
improve the monitoring of your environment by allowing you to quickly discover software
that was installed or modified recently. By using shortened data imports, data about your
software reaches the server much quicker, and at the same time allows you to increase the
number of imports that you can run each day.
A data import consists of several steps, out of which the most important ones are the
retrieval of raw scan results, aggregation of this data, and finally calculation of your license
consumption. In big environments, a complete data import can take up to several hours,
which increases the time that is required for BigFix Inventory to show information about
recent changes.
When using REST API to retrieve raw scan results, you can run a Raw Data Only type of
data import that retrieves raw scan results, but omits later steps, such as aggregation
and license calculations. This data import is much shorter, but the imported raw data can
only be retrieved through REST API. Since the data is not aggregated, it is not displayed
in the BigFix Inventory UI. The UI still shows the state of your environment from the last
successful complete data import.

Running data imports
Available from 9.2.2. You can use this REST API to check the status of a
data import, or to run a Raw Data Only, or a Complete data import. All these actions are
completed through a common API request. You distinguish between them by appending the
request with specific parameters. To work with this API, you use the GET operation on the
api/import_status.json element, or its alias api/management/imports.json.

Before you begin
You must have the Manage Imports permission to perform this task.

Checking the import status
Before you start running data imports, retrieve the status of a data import to ensure that
no imports are currently in progress. The statuses that can be retrieved are explained in
Example HTTP conversation. To check the import status, use the following request:
https://hostname:port/api/import_status.json?token=token

Running a Raw Data Only import
Running a Raw Data Only import is much quicker, because it only retrieves raw scan results.
This type of data import is used for retrieving raw scan results through REST API. A Raw
Data Only data import includes the following steps of the import process:
• Initialization of models:
Calling Model.before_snapshot

• Initialization of each data source:
Initialize datasource #{datasource.name}

• Computer data:
RawComputerId
Computer
ComputerPropertyValue
ComputerDimension

• Computer-related files:
RawDatasourceFile
DatasourceFile
SAM::ScanFile

• Scanned file, package, UNIX package, and application usage data:
SAM::FileFactDelta
SAM::FileFact
SAM::RawPackageFact
SAM::PackageFact
SAM::RawUnixPackageFact
SAM::UnixPackageFact
SAM::RawAppUsagePropertyValue
SAM::AppUsagePropertyValue

To start importing your raw data, append the API request with the run parameter, and
specify the value as raw_only:
https://hostname:port/api/import_status.json?token=token&run=raw_only

Note: After running a Raw Data Only data import, the raw data can be retrieved
through REST API, but is not visible in the UI. The UI still shows the state of your
environment from the last successful data import. The only exception is the
Metering Data report that shows the most recent data even after a raw only data
import. For more details, see Importing raw scan data

Running a complete data import
Running a Complete import through REST API has the same effect as running the data
import from the UI. To start importing your data, append the API request with the run
parameter, and specify the value as Complete:
https://hostname:port/api/import_status.json?token=token&run=complete

Operation descriptions
Note: Each API request must be authenticated with the token parameter. You can
retrieve it by using REST API for retrieving authentication token. You can also log in
to BigFix Inventory, hover over the User icon

, and click Profile. Then, click Show

token.

Table 267. Operation descriptions
Operation details
Operation

Description
GET /api/import_status.json, or GET /api/management/imports.json

Purpose

Returns the status of the data import

HTTP method

GET

Resource URI

https://server_host_name:port_number/
api/import_status.json, or https://server_host_name:port_number/api/management/imports.json

URL link relation

n/a

URI query parameters

n/a

Request headers

Header
Accept-Language (optional)

Values
en-US (only English is supported)
Used to negotiate the language of the response. If this
header is not specified, the content is returned in the
server language.
Request payload

n/a

Table 267. Operation descriptions (continued)
Operation details
Request Content-Type
Response headers

Description
application/json

Header
Content-Type

Values
application/json

Specifies the content type of the response.
Header
Content-Language

Values
en-US, …;
Specifies the language of the response content. If this
header is not specified, the content is returned in the
server language.
Response payload

Import status element

Response Content-Type

application/json

Normal HTTP response

200 – OK

codes
Error HTTP response codes

500 – “Bad Request” if a query parameter con

tains errors or is missing
Message body includes an error message with details.

Query parameters
You can use query parameters to narrow down the results of your search or perform extra
actions. The following table presents query parameters that you can use for the api/
import_status.json and api/management/imports.json elements.
Table 268. Query parameters for running a data import and retrieving its status
The table consists of four columns and nine rows.
Parameter
format

Description
Specifies the format of the retrieved

Required

Value

No

String

Yes

Alphanumeric

No

String

information. The possible values are
json or xml.

Retrieve information in the json for
mat:
URL?format=json

token

A unique user authentication identifi
er. You can view your token in the Pro
file preferences of BigFix Inventory.

run

Specifies the type of a data import to
run. The possible values are:
• complete - runs a Complete data
import
• raw_only - runs a Raw Data On
ly import that retrieves raw scan
results. The data is not aggre
gated and therefore not shown
in the UI. You can only retrieve it
through REST API.

Example HTTP conversation
Request
GET api/import_status.json
?token=7adc3efb175e2bc0f4484bdd2efca54a8fa04623
Host: localhost:9081
Accept: application/json
Accept-Language: en-US

Response header
HTTP/1.1 200 OK
Content-Type: application/json
Content-Language: en-US

Response body (JSON)
If a data import has never been initiated:
{
"mode": "none",
"can_run_imports": true,
"import_status_url": "/import_status",
"import_create_url": "/management/imports",
}

If a data import is in progress:
{
"mode": "running",
"can_run_imports": true,
"import_status_url": "/import_status",
"import_create_url": "/management/imports",
"progress": 59
}

If a data import is not running:
{
"mode": "idle"/"pending",
"can_run_imports": true,
"import_status_url": "/import_status",
"import_create_url": "/management/imports",
"last_status": successful,
"last_success_time": "2015-06-18T04:00:29Z"
"last_import_time": "2015-06-18T04:00:29Z",
"last_import_type": "raw_only"
"next_import_time": "2015-06-20T06:00:00Z",
"next_import_time_in": 75057,
"next_import_type": "complete"
}

Where:
• mode - status of the data import, it can assume the following values:
◦ none - a data import has never been initiated
◦ idle - no data imports are currently running
◦ running - a data import is in progress
◦ pending - an action performed in the user interface requires a data
import to be started for the change to take effect
• can_run_imports - specifies whether the user retrieving this API can run
imports,
• import_status_url - web address of this API,
• import_create_url - web address of the data imports panel in BigFix
Inventory,
• progress - percentage status of the running import,
• last_status - status of the last import,
• last_success_time - time of the last successful import,
• last_import_time - time of the last import,

• last_import_type - type of the last import,
• next_import_time - time of the next scheduled data import,
• next_import_time_in - remaining time (in seconds) to the next
scheduled data import,
• next_import_type - type of the next scheduled data import.

Related reference
Retrieving raw scanned file data
Retrieving raw package data
Retrieving raw UNIX package data
Retrieving raw metering data
Retrieval of hardware inventory (v2)
Retrieval of shared disks (v2)
Related information
REST API for retrieving detailed hardware information (v2)

Retrieving raw scanned file data
Available from 9.2.2. You use the GET operation on the /api/sam/raw_file_facts
element to retrieve information about all files discovered on the computers in your
infrastructure. The API returns details of existing files as well as historical data about
files that were removed. By default, raw data is preserved for 7 days. To change this
period, go to Management > Advanced Server Settings and change the value of the
raw_data_api_history_keep_days parameter.

Note
To obtain information about detected software use api/sam/v2/software_instances
API.

Before you begin
Use limit parameter when previewing API output
When you use /api/sam/raw_file_facts API for test purpose, append the limit parameter
to achieve faster response time. First 100 records should be sufficient to have a view on the
data available.
https://hostname:port/api/sam/raw_file_facts?token=token&limit=100

Permissions
You must have the View Raw Data permission to perform this task.

Resource URL
https://hostname:port/api/sam/raw_file_facts?token=token

Resource information
Table 269. Resource information
The table consists of two columns and 6 rows.
Operation details

Description

HTTP method

GET

Request headers

Header
Accept-Language (optional)

Values
en-US (only English is supported)
Negotiates the language of the response. If the header
is not specified, the content is returned in the server lan
guage.
Request format

application/json

Table 269. Resource information
The table consists of two columns and 6 rows.
(continued)
Operation details

Description

Response headers

Header
Content-Type

Values
application/json

Specifies the content type of the response.
Header
Content-Language

Values
en-US, …
Specifies the language of the response content. If this
header is not specified, the content is returned in the serv
er language.
Response payload

File Fact element

Response format

application/json

Response codes

200 – OK
500 – “Bad Request” if a query parameter contains

errors or is missing

Schema description
To retrieve the list of all columns that are returned by this REST API together with their
descriptions, use the following request.
GET api/sam/schemas/raw_file_fact.json?token=token

Available columns
Table 270. Columns with information about scanned files
Dis
Column

Description

played
by de

Type

fault
computer_id

Identifier of the computer on which the file was dis
covered.

path

Path where the file was discovered.

name

Name of the discovered file.

size

Size of the discovered file.

version

Version of the discovered file if available.

md5

MD5 checksum of the file.

sha256

SHA256 checksum of the file.

valid_from

Date of the first import that contained information
about the file.

valid_to

Date of the first import that did not include informa
tion about the file. The value 9999-12-31T23:59:59Z

✓

String

✓

String

✓
✓
✓
✓
✓

String
Integer
String
String
String

✓

String

✓

String

indicates that the file is still being discovered.
win_

Name of the product with which the file is distributed.

String

Copyright notices that apply to the file.

String

hdr_product_
name
win_h
dr_copyright

Table 270. Columns with information about scanned files (continued)
Dis
Column

Description

played
by de

Type

fault
win_h
dr_product_ver

Version of the product with which the file is distrib

String

uted.

sion
win_h

Description of the file.

String

Company that produced the file.

String

Trademarks and registered trademarks that apply to

String

dr_description
win_h
dr_company
win_h
dr_trademarks

the file.

Columns starting with 'win_hdr_' require enablement. For details, refer to Enabling the
collection of additional properties of Windows executables.

Applicable associations
You can additionally retrieve data from the following associations:
• computer

Query parameters
Table 271. Query parameters
The table consists of four columns and nine rows.
Re
Parameter
columns[]

Description
Specify which columns to retrieve. If you do not spec

quired

Value
String

ify this parameter, only default columns are retrieved.
Example: Retrieve the name and size of a file:
URL?columns[]=name&columns[]=size

order

Specify how to sort the returned data. The default di

String

rection for sorting columns is ascending. If you want
to specify a descending sort, append desc to the col
umn name.
Example: Order by name
URL?order[]=name desc

limit

Specify the number of rows to retrieve. If you omit

Numer

this parameter, all rows are retrieved. For BigFix In

ic

ventory versions up to 10.0.1, if you omit the 'limit'
parameter, 100 000 rows are retrieved. The number
is defined at raw_data_api_default_limit on the Ad
vanced Server Settings panel.
Example: Retrieve 100 records
URL?limit=100

Table 271. Query parameters
The table consists of four columns and nine rows.
(continued)
Re
Parameter

Description

quired

Value

Note: Parameter raw_data_api_default_limit
has been removed since BigFix Inventory ver
sion 10.0.2.
offset

Specify the number of rows to skip for retrieving re

Numer

sults. You can use it together with the limit parameter

ic

to paginate results.
Example: Retrieve 50 records starting after record
150:
URL?limit=50&offset=150

token

A unique user authentication identifier. You can re
trieve it by using REST API for retrieving authentica
tion token. You can also log in to BigFix Inventory,
hover over the User icon

, and click Profile. Then,

click Show token.
criteria

Retrieve records which match specific conditions.
The parameter should have the following structure,
written in one line:
<criteria> ::= <left-brace>
<boolean-operator><colon> <left-bracket>
<criterion> [{ <comma> <criterion> }...]
<right-bracket> <right-brace>

✓

Al
phanu
meric

Table 271. Query parameters
The table consists of four columns and nine rows.
(continued)
Re
Parameter

Description
<boolean-operator> ::= "and" | "or"
<criterion> ::= <criteria> | <left-bracket>
<column> <comma> <operator> <comma>
<value> <right-bracket>
<column> ::= <json-string>
<operator> ::= <json-string>
<value> ::= <json-array> | <json-string> |
<json-numver> | <json-null>

For more information about operators, see Common
connectors and operators.
Example: Retrieve scanned file data from computer
systems with ID greater than 10:
URL?criteria={ "and": [ ["computer_id",
">", "10"]]}

For columns that use the date and time values, such
as Last Seen, you can retrieve data also for a period
instead of a specific date. To do so, use last or next
as <operator>, and then specify the time value in
the following convention: PxD/PxW/PxM/PxY, where
x is a number in the 1-999 range, and D, W, M, or Y is
a designator that represents days, weeks, months, or
years respectively.

quired

Value

Table 271. Query parameters
The table consists of four columns and nine rows.
(continued)
Re
Parameter

Description
Example: Retrieve information from computers that
were first reported in BigFix Inventory within last 7
days
URL?
criteria={"and":[["valid_from","last","P7D"
]]}

Example conversation - default columns
Request
GET api/sam/raw_file_facts
?token=7adc3efb175e2bc0f4484bdd2efca54a8fa04623
Host: localhost:9081
Accept: application/json
Accept-Language: en-US

Response body
{
"computer_id": 5,
"path": "C:\BES\BESAirgapTool",
"name": "BESAirgapTool.exe",
"size": 92174,
"version": null,
"valid_from": "2015-07-31T07:03:21Z"
"valid_to": "9999-12-31T23:59:59Z"
}

quired

Value

{
"computer_id": 5,
"path": "C:/Program Files/ibm/SQLLIB/BIN",
"name":"db2set.exe",
"size": 81768,
"version": "10.1",
"valid_from": "2015-07-31T07:03:21Z",
"valid_to": "9999-12-31T23:59:59Z"
}

Example conversation - additional Windows parameters
Request
GET api/sam/raw_file_facts
?columns[]=win_hdr_product_name
&columns[]=win_hdr_copyright
&columns[]=win_hdr_product_version
&columns[]=win_hdr_description
&columns[]=win_hdr_company
&columns[]=win_hdr_trademarks
&criteria=
{"and":[["win_hdr_copyright","!=",""]]}
&token=7adc3efb175e2bc0f4484bdd2efca54a8fa04623
Host: localhost:9081
Accept: application/json
Accept-Language: en-US

Response
{
"win_hdr_product_name":"Microsoft (R) Visual Studio (R) 2010",
"win_hdr_copyright":"Ac Microsoft Corporation. All rights reserv
ed.",
"win_hdr_product_version":"10.0.40219.1",

"win_hdr_description":"WebDev.WebServer40.exe",
"win_hdr_company":"Microsoft Corporation",
"win_hdr_trademarks":""
}

Related reference
Running data imports
Retrieving raw package data
Retrieving raw UNIX package data
Retrieving raw metering data
Retrieval of hardware inventory (v2)
Retrieval of shared disks (v2)
Related information
REST API for retrieving detailed hardware information (v2)

Enabling collection of additional properties of Windows
executables
Available from BigFix Inventory 10.0.1. You can enable the collection of additional
properties of Windows executables by running a fixlet. The fixlet changes the configuration
of the software scan for BigFix Inventory. When you choose to collect these properties and
run the fixlet against a chosen endpoint, the software scan can recognize that additional
data must be collected from an endpoint. If you choose to revert this setting, you need to
run the fixlet again with collection checkbox disabled.
• Upgrade BigFix Inventory server to version 10.0.1 or higher.
• Upgrade the scanner to HCL Scanner using "Install or Upgrade Scanner" fixlet.
Upgrade to this scanner is available only if BigFix Inventory is the only exploiter of

the scanner. Alternatively, you can use "Install or Upgrade Scanner in private mode on
Windows" fixlet.
• If you upgrade BigFix Inventory from previous version, stop all Initiate Software
Scan actions, and re-run the software scan for your endpoints. Post upgrade, BigFix
Inventory collects additional information and hence the scan must be restarted.
Important: This setting must not be enabled for more than 50 000 endpoints.
Perform a test activation on a small group of computers (up to 1000 endpoints) and check
its impact on the BigFix Inventory data import. Once you import data for first group, move
to the next group. A single group should not have more than 10000 endpoints. If you import
data for more or all endpoints at once, the overload may impact the performance. In case,
the data import scan gets accumulated, you need to recover it to proceed further. This
activation process is applicable for enabling the collection for the first time as well as all
subsequent changes. It is also applicable for disabling the collection.
Impact of enabling data collection
The time taken for initial data import for each 10 000 endpoints after enabling the
collection, might be three times longer than usual. For DB2 database, the transaction log
usage during data import may increase by 80GB. The time taken for subsequent imports in
an environment with 50 000 endpoints will be 25% longer than usual.
If you enable data collection import for DB2 and SQL Server databases, the disc
consumption in BigFix Inventory may increase by 25%.
Additional properties are gathered during the software scan and the results are stored on
the endpoint. For an average endpoint with 3000 discovered files, an additional 0.5 MB
of disk space might be consumed. The additional data is compressed and transferred
to BigFix server. So, the disc utilization increases by 1GB for an environment of 50 000
endpoints.
1. Log in to the BigFix console.
2. In the navigation bar, click Sites > External Sites > BigFix Inventory v10 > Fixlets and
Tasks.

3. In the upper right pane, select Configure Collection of Additional Properties of
Windows Executables.

4. Enable Collect additional properties of Windows executables checkbox.
5. Click Take Actions.

6. Select the computers from which you want to collect checksums, and click OK.

7. Optional: In the navigation bar, go to Analyses, select Additional Properties of
Windows Executables Collection Settings, and click Activate. The analysis shows the
current status of additional data collection on your endpoints.

Now wait for a new Initiate Software Scan and Upload Software Scan results. Run Data
Import in BigFix Inventory. Then you can retrieve additional properties of Windows
executables through REST API for raw scanned file data. For more information, refer to
Retrieving raw scanned file data.

Retrieving raw package data
Available from 9.2.2. This API retrieves raw package data, which contains
information about all packages discovered on your computers. This information is retrieved
from the Windows registry. Unlike in the UI, through this API you can retrieve all historical
data that is stored in the database.
To obtain information about detected software use api/sam/v2/software_instances API.
Before you begin
Use limit parameter when previewing API output
When you use api/sam/raw_package_facts API for test purpose, append the limit
parameter to achieve faster response time. First 100 records should be sufficient to have a
view on the data available.
https://hostname:port/api/sam/raw_package_facts?token=token&limit=100

Note: Each API request must be authenticated with the token parameter. You can
retrieve it by using REST API for retrieving authentication token. You can also log in

to BigFix Inventory, hover over the User icon

, and click Profile. Then, click Show

token.

Table 272. Operation descriptions
The table consists of two columns and 15 rows. For the eleventh row there are two
levels.
Operation details

Description

Operation

GET /api/sam/raw_package_facts

Purpose

Returns raw package data.

HTTP method

GET

Resource URI

https://server_host_name:port_number/api/
sam/raw_package_facts

URL link relation

n/a

URI query parameters

n/a

Request headers

Header
Accept-Language (optional)

Values
en-US (only English is supported)
Used to negotiate the language of the response. If this
header is not specified, the content is returned in the
server language.
Request payload
Request Content-Type
Response headers

n/a
application/json

Header
Content-Type

Table 272. Operation descriptions
The table consists of two columns and 15 rows. For the eleventh row there are two
levels.
(continued)
Operation details

Description
Values
application/json

Specifies the content type of the response.
Header
Content-Language

Values
en-US, …
Specifies the language of the response content. If this
header is not specified, the content is returned in the
server language.
Response payload

Package Fact element

Response Content-Type

application/json

Normal HTTP response

200 – OK

codes
Error HTTP response codes

400 – “Bad Request” if a query parameter con

tains errors or is missing
Message body includes an error message with details.

Available columns
Table 273. Available columns
Dis
Column

Description

played
Type
by de
fault

is_suppressed

Indicates that package is suppressed. When the

Boolean

package is suppressed the column value is 1. When
the package is not suppressed, the value is 0.
comment
package_property_id

Comment about the suppression.
Identifier of the unix package property.

String
✓

Nu
mer
ic

index_sha1
computer_id

Package sha1 checksum
Identifier of the computer as defined in BigFix Inven
tory.

✓
✓

String
Nu
mer
ic

description

Description of the package.

name

Name of the package.

version

Version of the package.

vendor

Vendor of the package.

valid_from

Date and time when the package was reported for
the first time. The time is specified in the GMT time

✓
✓
✓
✓

String
String
String
String

✓

String

✓

String

zone.
valid_to

Date and time when the package was reported for
the last time. The time is specified in the GMT time
zone.

Query parameters
You can use query parameters to narrow down the results of your search.
Table 274. Query parameters
The table consists of four columns and nine rows.
Parameter
columns

Description
Specify which columns to retrieve. If

Required

Value

No

String

No

String

No

Numeric

you do not specify this parameter, a
set of default columns is retrieved. Ex
ample:
Retrieve the name and computer_id
columns:
URL?
columns[]=name&columns[]=compu
ter_id

order

Specify how to sort the returned da
ta. The default direction for sorting
columns is ascending. If you want to
specify a descending sort, append desc to the column name. Example:

Order by name descending:
URL?order[]=name desc

limit

Specify the number of rows to re
trieve. If you omit this parameter, all
rows are retrieved. For BigFix Inven
tory versions up to 10.0.1, if you omit
the 'limit' parameter, 100 000 rows are
retrieved. The number is defined at

Table 274. Query parameters
The table consists of four columns and nine rows.
(continued)
Parameter

Description

Required

Value

raw_data_api_default_limit on the Ad
vanced Server Settings panel.
Note: Parameter raw_data_
api_default_limit has been re
moved since BigFix Inventory
version 10.0.2.
offset

Specify the number of rows to skip for No

Numeric

retrieving results. You can use it to
gether with the limit parameter to pag
inate results. Example:
Retrieve 50 records starting after
record 150:
URL?limit=50&offset=150

token

A unique user authentication identifi

Yes

Alphanumeric

er. You can view your token in the Pro
file preferences of BigFix Inventory.
criteria

Retrieve records which match specific conditions. The parameter
should have the following structure, written on one line:
<criteria> ::= <left-brace> <boolean-operator><colon>
<left-bracket>
<criterion> [{ <comma> <criterion> }...] <right-bracket>
<right-brace>

Table 274. Query parameters
The table consists of four columns and nine rows.
(continued)
Parameter

Description

Required

Value

<boolean-operator> ::= "and" | "or"
<criterion> ::= <criteria> | <left-bracket> <column>
<comma> <operator> <comma> <value> <right-bracket>
<column> ::= <json-string>
<operator> ::= <json-string>
<value>

::= <json-array> | <json-string> |

<json-numver> | <json-null>

For more information about operators, see Common connectors and
operators.
Example: Retrieve package data from computer systems with ID
greater than 10:
URL?criteria={ "and": [ ["computer_id", ">", "10"]]}

For columns that use the date and time values, such as Last Seen,
you can retrieve data also for a instead of a specific date. To do so,
use last or next as <operator>, and then specify the time value in
the following convention: PxD/PxW/PxM/PxY, where x is a number
in the 1-999 range, and D, W, M, or Y is a designator that represents
days, weeks, months, or years respectively. For example, to retrieve
computer systems that reported within last 7 days, use the following
API request:
URL?criteria={"and":[["last_seen","last","P7D"]]}

Example HTTP conversation
Request

GET api/sam/raw_package_facts
?token=7adc3efb175e2bc0f4484bdd2efca54a8fa04623
Host: localhost:9081
Accept: application/json
Accept-Language: en-US

Response header
HTTP/1.1 200 OK
Content-Type: application/json
Content-Language: en-US

Response body (JSON)
{
"package_property_id": 1,
"computer_id": 3,
"description": "{FA7394B8-CE65-4F9E-AC99-F372AD365424}",
"name": "SQL Server 2008 R2 Database Engine Services",
"version": "10.50.1600.1",
"vendor": "Microsoft Corporation",
"valid_from": "2015-08-05T14:41:19Z",
"valid_to": "9999-12-31T23:59:59Z"
}
{
"package_property_id": 1,
"computer_id": 3,
"description": "{0AECF03B-E9FC-4A17-999D-6641A2851B26}",
"name": "BigFix Client",
"version": "9.2.3.68",
"vendor": "IBM Corp.",
"valid_from": "2015-08-05T14:41:19Z",
"valid_to": "9999-12-31T23:59:59Z"
}

Related reference
Running data imports
Retrieving raw scanned file data
Retrieving raw UNIX package data
Retrieving raw metering data
Retrieval of hardware inventory (v2)
Retrieval of shared disks (v2)
Related information
REST API for retrieving detailed hardware information (v2)

Retrieving raw UNIX package data
Available from 9.2.2. This API retrieves raw UNIX package data, which contains
information about all packages discovered on the UNIX operating systems. Unlike in the UI,
through this API you can retrieve all historical data that is stored in the database.
To obtain information about detected software use api/sam/v2/software_instances API.
Before you begin
Use limit parameter when previewing API output
When you use api/sam/raw_unix_package_facts API for test purpose, append the limit
parameter to achieve faster response time. First 100 records should be sufficient to have a
view on the data available.
https://hostname:port/api/sam/raw_unix_package_facts?token=token&limit=100

Important: Each API requests must be authenticated with the token parameter. You
can retrieve it by using REST API for retrieving authentication token. You can also

log in to BigFix Inventory, hover over the User icon

, and click Profile. Then, click

Show token.

Table 275. Operation descriptions
The table consists of two columns and 15 rows. For the eleventh row there are two
levels.
Operation details

Description

Operation

GET /api/sam/raw_unix_package_facts

Purpose

Returns raw scanned file data.

HTTP method

GET

Resource URI

https://server_host_name:port_number/api/
sam/raw_unix_package_facts

URL link relation

n/a

URI query parameters

n/a

Request headers

Header
Accept-Language (optional)

Values
en-US (only English is supported)
Used to negotiate the language of the response. If this
header is not specified, the content is returned in the
server language.
Request payload
Request Content-Type
Response headers

n/a
application/json

Header
Content-Type

Table 275. Operation descriptions
The table consists of two columns and 15 rows. For the eleventh row there are two
levels.
(continued)
Operation details

Description
Values
application/json

Specifies the content type of the response.
Header
Content-Language

Values
en-US, …
Specifies the language of the response content. If this
header is not specified, the content is returned in the
server language.
Response payload

Unix Package Fact element

Response Content-Type

application/json

Normal HTTP response

200 – OK

codes
Error HTTP response codes

400 – “Bad Request” if a query parameter con

tains errors or is missing
Message body includes an error message with details.

Available columns
Table 276. Available columns
Dis
Column

Description

played
Type
by de
fault

is_suppressed

Indicates that package is suppressed. When the

Boolean

package is suppressed the column value is 1. When
the package is not suppressed, the value is 0.
comment

Comment about the suppression.

unix_package_property_ Identifier of the unix package property.
id

String
✓

Nu
mer
ic

version_id

Internal version identifier of the package.

Nu
mer
ic

type

Type of the package data.
index_sha1

computer_id

Package sha1 checksum
Identifier of the computer as defined in BigFix Inven
tory.

✓
✓
✓

String
String
Nu
mer
ic

description

Description of the package.

name

Name of the package.

version

Version of the package.

vendor

Vendor of the package.

✓
✓
✓
✓

String
String
String
String

Table 276. Available columns (continued)
Dis
Column

played
Type
by de

Description

fault
valid_from

Date and time when the package was reported for
the first time. The time is specified in the GMT time

✓

String

✓

String

zone.
valid_to

Date and time when the package was reported for
the last time. The time is specified in the GMT time
zone.

Query parameters
You can use query parameters to narrow down the results of your search.
Table 277. Query parameters
The table consists of four columns and nine rows.
Parameter
columns

Description
Specify which columns to retrieve. If

Required

Value

No

String

No

String

you do not specify this parameter, a
set of default columns is retrieved. Ex
ample:
Retrieve the name and computer_id
columns:
URL?
columns[]=name&columns[]=compu
ter_id

order

Specify how to sort the returned da
ta. The default direction for sorting

Table 277. Query parameters
The table consists of four columns and nine rows.
(continued)
Parameter

Description

Required

Value

columns is ascending. If you want to
specify a descending sort, append desc to the column name. Example:

Order by name descending:
URL?order[]=name desc

limit

Specify the number of rows to re

No

Numeric

Specify the number of rows to skip for No

Numeric

trieve. If you omit this parameter, all
rows are retrieved. For BigFix Inven
tory versions up to 10.0.1, if you omit
the 'limit' parameter, 100 000 rows are
retrieved. The number is defined at
raw_data_api_default_limit on the Ad
vanced Server Settings panel.
Note: Parameter raw_data_
api_default_limit has been re
moved since BigFix Inventory
version 10.0.2.
offset

retrieving results. You can use it to
gether with the limit parameter to pag
inate results. Example:
Retrieve 50 records starting after
record 150:
URL?limit=50&offset=150

Table 277. Query parameters
The table consists of four columns and nine rows.
(continued)
Parameter
token

Description
A unique user authentication identifi

Required
Yes

Value
Alphanumeric

er. You can view your token in the Pro
file preferences of BigFix Inventory.
criteria

Retrieve records which match specific conditions. The parameter
should have the following structure, written on one line:
<criteria> ::= <left-brace> <boolean-operator><colon>
<left-bracket>
<criterion> [{ <comma> <criterion> }...] <right-bracket>
<right-brace>

<boolean-operator> ::= "and" | "or"
<criterion> ::= <criteria> | <left-bracket> <column>
<comma> <operator> <comma> <value> <right-bracket>
<column> ::= <json-string>
<operator> ::= <json-string>
<value>

::= <json-array> | <json-string> |

<json-numver> | <json-null>

For more information about operators, see Common connectors and
operators.
Example: Retrieve UNIX package data from computer systems with
ID greater than 10:
URL?criteria={ "and": [ ["computer_id", ">", "10"]]}

For columns that use the date and time values, such as Last Seen,
you can retrieve data also for a period instead of a specific date. To
do so, use last or next as <operator>, and then specify the time val

Table 277. Query parameters
The table consists of four columns and nine rows.
(continued)
Parameter

Description

Required

Value

ue in the following convention: PxD/PxW/PxM/PxY, where x is a num
ber in the 1-999 range, and D, W, M, or Y is a designator that repre
sents days, weeks, months, or years respectively. For example, to re
trieve computer systems that reported within last 7 days, use the fol
lowing API request:
URL?criteria={"and":[["last_seen","last","P7D"]]}

Example HTTP conversation
Request
GET api/sam/raw_unix_package_facts
?token=7adc3efb175e2bc0f4484bdd2efca54a8fa04623
Host: localhost:9081
Accept: application/json
Accept-Language: en-US

Response header
HTTP/1.1 200 OK
Content-Type: application/json
Content-Language: en-US

Response body (JSON)
{
"unix_package_property_id": -1,
"computer_id": 14,
"name": "lohit-oriya-fonts",

"version": "2.4.3-6.el6",
"vendor": "Red Hat, Inc.",
"description": null,
"type": "Rpm",
"index_sha1": "176d82d8994b5c7b27f5ba8446cb40a802b2e8f5",
"valid_from": "2016-02-29T15:33:10Z",
"valid_to": "9999-12-31T23:59:59Z"
}
{
"unix_package_property_id": -1,
"computer_id": 14,
"name": "libcollection",
"version": "0.6.0-9.el6",
"vendor": "Red Hat, Inc.",
"description": null,
"type": "Rpm",
"index_sha1": "69ac3e6fc5674c4feb1c90aae88975d9d0ebe615",
"valid_from": "2016-02-29T15:33:10Z",
"valid_to": "9999-12-31T23:59:59Z"
}

Related reference
Running data imports
Retrieving raw scanned file data
Retrieving raw package data
Retrieving raw metering data
Retrieval of hardware inventory (v2)
Retrieval of shared disks (v2)

Related information
REST API for retrieving detailed hardware information (v2)

Retrieving raw metering data
Available from 9.2.2. This API retrieves raw metering data, which contains
information about the use of software items that are installed on your computers. Unlike in
the UI, through this API you can retrieve all historical data that is stored in the database.
To obtain information about detected software use api/sam/v2/software_instances API.
Before you begin
Use limit parameter when previewing API output
When you use the api/sam/raw_app_usage_property_values API for test purpose, append
the limit parameter to achieve faster response time. First 100 records should be sufficient to
have a view on the data available.
https://hostname:port/api/sam/raw_app_usage_property_values?token=token&lim
it=100

Note: Each API request must be authenticated with the token parameter. You can
retrieve it by using REST API for retrieving authentication token. You can also log in
to BigFix Inventory, hover over the User icon

, and click Profile. Then, click Show

token.

Table 278. Operation descriptions
The table consists of two columns and 15 rows. For the eleventh row there are two
levels.
Operation details
Operation

Description
GET /api/sam/raw_app_usage_property_values

Table 278. Operation descriptions
The table consists of two columns and 15 rows. For the eleventh row there are two
levels.
(continued)
Operation details

Description

Purpose

Returns raw package data.

HTTP method

GET

Resource URI

https://server_host_name:port_number/api/
sam/raw_app_usage_property_values

URL link relation

n/a

URI query parameters

n/a

Request headers

Header
Accept-Language (optional)

Values
en-US (only English is supported)
Used to negotiate the language of the response. If this
header is not specified, the content is returned in the
server language.
Request payload
Request Content-Type
Response headers

n/a
application/json

Header
Content-Type

Values
application/json

Specifies the content type of the response.
Header

Table 278. Operation descriptions
The table consists of two columns and 15 rows. For the eleventh row there are two
levels.
(continued)
Operation details

Description
Content-Language

Values
en-US, …
Specifies the language of the response content. If this
header is not specified, the content is returned in the
server language.
Response payload

App Usage Property Value element

Response Content-Type

application/json

Normal HTTP response

200 – OK

codes
Error HTTP response codes

500 – “Bad Request” if a query parameter con

tains errors or is missing
Message body includes an error message with details.

Query parameters
You can use query parameters to narrow down the results of your search.
Table 279. Query parameters
The table consists of four columns and nine rows.
Parameter
columns[]

Description
Specify which columns to retrieve. If
you do not specify this parameter, a

Required
No

Value
String

Table 279. Query parameters
The table consists of four columns and nine rows.
(continued)
Parameter

Description

Required

Value

set of default columns is retrieved. Ex
ample:
Retrieve the name and computer_id
columns:
URL?
columns[]=name&columns[]=compu
ter_id

order

Specify how to sort the returned da

No

String

No

Numeric

ta. The default direction for sorting
columns is ascending. If you want to
specify a descending sort, append desc to the column name. Example:

Order by name descending:
URL?order[]=name desc

limit

Specify the number of rows to re
trieve. If you omit this parameter, all
rows are retrieved. For BigFix Inven
tory versions up to 10.0.1, if you omit
the 'limit' parameter, 100 000 rows are
retrieved. The number is defined at
raw_data_api_default_limit on the Ad
vanced Server Settings panel.
Note: Parameter raw_data_
api_default_limit has been re

Table 279. Query parameters
The table consists of four columns and nine rows.
(continued)
Parameter

Description

Required

Value

moved since BigFix Inventory
version 10.0.2.
offset

Specify the number of rows to skip for No

Numeric

retrieving results. You can use it to
gether with the limit parameter to pag
inate results. Example:
Retrieve 50 records starting after
record 150:
URL?limit=50&offset=150

token

A unique user authentication identifi

Yes

Alphanumeric

er. You can view your token in the Pro
file preferences of BigFix Inventory.
criteria

Retrieve records which match specific conditions. The parameter
should have the following structure, written on one line:
<criteria> ::= <left-brace> <boolean-operator><colon>
<left-bracket>
<criterion> [{ <comma> <criterion> }...] <right-bracket>
<right-brace>

<boolean-operator> ::= "and" | "or"
<criterion> ::= <criteria> | <left-bracket> <column>
<comma> <operator> <comma> <value> <right-bracket>
<column> ::= <json-string>
<operator> ::= <json-string>

Table 279. Query parameters
The table consists of four columns and nine rows.
(continued)
Parameter

Description
<value>

Required

Value

::= <json-array> | <json-string> |

<json-numver> | <json-null>

For more information about operators, see Common connectors and
operators.
Example: Retrieve metering data from computer systems with ID
greater than 10:
URL?criteria={ "and": [ ["computer_id", ">", "10"]]}

For columns that use the date and time values, such as Last Seen,
you can retrieve data also for a period instead of a specific date. To
do so, use last or next as <operator>, and then specify the time val
ue in the following convention: PxD/PxW/PxM/PxY, where x is a num
ber in the 1-999 range, and D, W, M, or Y is a designator that repre
sents days, weeks, months, or years respectively. For example, to re
trieve computer systems that reported within last 7 days, use the fol
lowing API request:
URL?criteria={"and":[["last_seen","last","P7D"]]}

Example HTTP conversation
Request
GET api/sam/raw_app_usage_property_values
?token=7adc3efb175e2bc0f4484bdd2efca54a8fa04623
Host: localhost:9081
Accept: application/json
Accept-Language: en-US

Response header
HTTP/1.1 200 OK
Content-Type: application/json
Content-Language: en-US

Response body (JSON)
{
"app_usage_property_id": -1,
"computer_id": 2,
"process": "BESClient.exe",
"first_used": "2015-03-27T16:28:47Z",
"last_used": "2015-08-03T11:46:16Z",
"total_runs": 5,
"total_time": 10888494,
"avg_runs_per_day": 0.03943099252280677,
"avg_run_time": 2177698.8,
"valid_from": "2015-08-05T14:41:19Z",
"valid_to": "9999-12-31T23:59:59Z"
}
{
"app_usage_property_id": -1,
"computer_id": 2,
"process": "BESConsole.exe",
"first_used": "2015-07-09T11:27:50Z",
"last_used": "2015-07-13T13:33:42Z",
"total_runs": 2,
"total_time": 16767,
"avg_runs_per_day": 0.4893077201884741,
"avg_run_time": 8383.5,
"valid_from": "2015-08-05T14:41:19Z",

"valid_to": "9999-12-31T23:59:59Z"
}

Related reference
Running data imports
Retrieving raw scanned file data
Retrieving raw package data
Retrieving raw UNIX package data
Retrieval of hardware inventory (v2)
Retrieval of shared disks (v2)
Related information
REST API for retrieving detailed hardware information (v2)

Retrieval of hardware inventory (v2)
Available from 9.2.8. You use the GET operation on the api/sam/v2/computers
element to request information about computers in your infrastructure. The API returns
details of existing computers as well as historical data about computers that were removed.

Permissions
You must have the View Endpoints and View Hardware Inventory permission to use this
API.

Resource URL
https://hostname:port/api/sam/v2/computers?token=token

Resource information
Table 280. Resource information
Operation details
HTTP method
Request headers

Description
GET

Header
Accept-Language (optional)

Values
en-US (only English is supported)
Negotiates the language of the response. If the header
is not specified, the content is returned in the server lan
guage.
Request format
Response headers

application/json

Header
Content-Type

Values
application/json

Specifies the content type of the response.
Header
Content-Language

Values
en-US, …
Specifies the language of the response content. If the
header is not specified, the content is returned in the serv
er language.
Response payload

Computer Systems element

Table 280. Resource information (continued)
Operation details

Description

Response format

application/json

Response codes

200 – OK
500 – "Bad Request" if a query parameter contains er

rors or is missing

Schema description
To retrieve the list of all columns that are returned by this REST API together with their
descriptions, use the following request.
GET api/sam/v2/schemas/computer.json?token=token

Available columns
Table 281. Available columns
Dis
Column

Description

played
Type
by de
fault

id

Identifier of the computer as defined in BigFix Inven

Nu

tory.

mer
ic

bigfix_id

Identifier of the computer as defined in BigFix.

Nu
mer
ic

name

Name of the computer.

dns_name

DNS of the computer.

ip_address

IP address of the computer.

✓

String
String

✓

String

Table 281. Available columns (continued)
Dis
Column

Description

played
Type
by de
fault
✓

os

Operating system of the computer.

String

os_type

Type of the operating system of the computer.

String

first_seen

Date and time when the computer reported to Big

String

Fix for the first time. The time is specified in the GMT
time zone.
last_seen

Date and time when the computer reported to Big
Fix for the last time. The time is specified in the GMT

✓

String

✓

Boolean

time zone.
is_deleted

Information whether the computer was removed.

deletion_date

Date and time when the computer was removed. The

String

time is specified in the GMT time zone.
is_managed_by_vm_

Information whether the computer is managed by a

manager

VM manager.

Applicable associations
You can additionally retrieve data from the following associations:
•

computer_details

• computer_hardware
• computer_health
•

mounted_shared_disks

•

detailed_hw_ip_addresses

•

detailed_hw_lpars

•

detailed_hw_memories

•

detailed_hw_network_adapters

Boolean

•

detailed_hw_operating_systems

•

detailed_hw_partitions

•

detailed_hw_physical_processors

•

detailed_hw_smbios

•

detailed_hw_storages

Note: Retrieving data from multiple API associations in a single request might
increase the response time.
For more information about how to use API associations, see: REST API associations.
Important: All associations provide data about items that currently exist in the
infrastructure. For removed computers and uninstalled software, these associations
return null.

Query parameters
Table 282. Query parameters
Parameter
columns

Description
Specify which columns to retrieve. If you do not

Required

Value
String

specify this parameter, only default columns are
retrieved.
Example: Retrieve product name and release
URL?columns[]=first_seen

order

Specify how to sort the returned data. The de
fault direction for sorting columns is ascending.
If you want to specify a descending sort, append
desc to the column name.

Example: Order by computer ID descending:

String

Table 282. Query parameters (continued)
Parameter

Description

Required

Value

URL?order[]=id desc

limit

Specify the number of rows to retrieve. If you

Numeric

omit this parameter, all rows are retrieved.
Example: Retrieve 100 records
URL?limit=100

offset

Specify the number of rows to skip for retrieving

Numeric

results. You can use it together with the limit pa
rameter to paginate results.
Example: Retrieve 50 records starting after
record 150
URL?limit=50&offset=150

token

A unique user authentication identifier. You can
retrieve it by using REST API for retrieving au

✓

Alphanu
meric

thentication token. You can also log in to BigFix
Inventory, hover over the User icon

, and click

Profile. Then, click Show token.
criteria

Retrieve records which match specific condi
tions. The parameter should have the following
structure, written in one line:
<criteria> ::= <left-brace>
<boolean-operator><colon>
<left-bracket>
<criterion> [{ <comma>
<criterion> }...] <right-bracket>
<right-brace>

String

Table 282. Query parameters (continued)
Parameter

Description
<boolean-operator> ::= "and" | "or"
<criterion> ::= <criteria> |
<left-bracket> <column> <comma>
<operator> <comma> <value>
<right-bracket>
<column> ::= <json-string>
<operator> ::= <json-string>
<value> ::= <json-array> |
<json-string> | <json-numver> |
<json-null>

For more information about operators, see: Com
mon connectors and operators.
Example: retrieve computers that reported for
the first time within a specific date range:
URL?criteria={"and":[["first_seen",
">", "1970-01-01T00:00:00+00:00Z"],
["first_seen", "<",
"1970-01-02T00:00:00+00:00Z"]]}

For columns that use the date and time values,
you can retrieve data also for a period instead
of a specific date. To do so, use last or next as
<operator>, and then specify the time value
in the following convention: PxD/PxW/PxM/PxY,
where x is a number in the 1-999 range, and D,
W, M, or Y is a designator that represents days,
weeks, months, or years respectively.
Example: Retrieve computers that were first re
ported within the last 7 days

Required

Value

Table 282. Query parameters (continued)
Parameter

Description

Required

URL?
criteria={"and":[["first_seen","last","
P7D"]]}

Example conversation - default columns
Request
GET api/sam/v2/computers?token=7adc3efb175e2bc0f4484bdd2efca54a8
fa04623
Host: localhost:9081
Accept: application/json
Accept-Language: en-US

Response body
[{
"name":"NC9143126194",
"ip_address":["9.143.126.194"],
"os":"Win2012R2 6.3.9600",
"last_seen":"2016-09-22T10:32:12Z",
"is_deleted":1
}]

Example conversation - all columns
Request
GET api/sam/v2/computers?columns[]=id&columns[]=bigfix_id
&columns[]=name&columns[]=dns_name
&columns[]=ip_address&columns[]=os&columns[]=os_type
&columns[]=first_seen&columns[]=last_seen&columns[]=is_deleted
&columns[]=deletion_date&columns[]=is_managed_by_vm_manager

Value

&token=7adc3efb175e2bc0f4484bdd2efca54a8fa04623
Host: localhost:9081
Accept: application/json
Accept-Language: en-US

Response body
[{
"id":2,
"bigfix_id":11368943,
"name":"NC9143126194",
"dns_name":"NC9143126194",
"ip_address":["9.143.126.194"],
"os":"Win2012R2 6.3.9600",
"os_type":"Windows",
"first_seen":"2016-10-04T09:42:55Z",
"last_seen":"2016-09-22T10:32:12Z",
"is_deleted":1,
"deletion_date":"2016-12-19T09:40:14Z",
"is_managed_by_vm_manager":0
}]

Example conversation - additional column
Request
GET api/sam/v2/computers?columns[]=id
&columns[]=is_deleted&columns[]=deletion_date
&token=7adc3efb175e2bc0f4484bdd2efca54a8fa04623
Host: localhost:9081
Accept: application/json
Accept-Language: en-US

Response body

[{
"id":21,
"is_deleted":1,
"deletion_date":"2016-10-18T14:51:52Z"
}]

Example conversation - association
Request
GET api/sam/v2/computers?columns[]=id
&columns[]=computer_health.catalog_version
&token=7adc3efb175e2bc0f4484bdd2efca54a8fa04623
Host: localhost:9081
Accept: application/json
Accept-Language: en-US

Response body
[{
"id":1,
"catalog_version":1304630
}]

Related reference
Running data imports
Retrieving raw scanned file data
Retrieving raw package data
Retrieving raw UNIX package data
Retrieving raw metering data
Retrieval of shared disks (v2)

Related information
REST API for retrieving detailed hardware information (v2)

Retrieval of shared disks (v2)
Available from 9.2.12. You use the GET operation on the api/sam/v2/
shared_disks element to request information about shared disks that are used in your

infrastructure.

Prerequisites
Before you can retrieve information about shared disks by using the REST API, discover the
shared disks in your infrastructure. For more information, see: Step 1: Discovering remote
shared disks.

Permissions
You must have the View Shared Disks permissions to use this API.

Resource URL
https://hostname:port/api/sam/v2/shared_disks?token=token

Resource information
Table 283. Resource information
Operation details
HTTP method
Request headers

Description
GET

Header
Accept-Language (optional)

Values
en-US (only English is supported)

Table 283. Resource information (continued)
Operation details

Description
Negotiates the language of the response. If the header
is not specified, the content is returned in the server lan
guage.

Request format
Response headers

application/json

Header
Content-Type

Values
application/json

Specifies the content type of the response.
Header
Content-Language

Values
en-US, …
Specifies the language of the response content. If the
header is not specified, the content is returned in the serv
er language.
Response payload

Shared Disks element

Response format

application/json

Response codes

200 – OK
403 – “Forbidden” if the user is not authorized to per

form the action
500– “Bad Request” if a query parameter contains errors

or is missing

Schema description
To retrieve the list of all columns that are returned by this REST API together with their
descriptions, use the following request.
GET api/sam/v2/schemas/shared_disk.json?token=<token>

Available columns
Table 284. Available columns
Dis
Column

Description

played
Type
by de
fault

id

Identifier of the shared disk instance.

✓

In
te
ger

status

Indicates the status of the computer that is designat ✓

In

ed to scan the shared disk instance. Possible values

te

are:

ger
• 0 - Shared disk detected
• 1 - Child shared disk
• 2 - Designating a computer
• 3 - Waiting for software scan
• 4 - OK
• 5 - Designating new top-level directory
• 6 - Designating a new computer
• 7 - Waiting for software scan on the newly des
ignated computer

parent_id

Identifier of the parent of the shared disk instance.

✓

In
te
ger

Table 284. Available columns (continued)
Dis
Column

Description

played
Type
by de
fault

top_level

Indicates whether the shared disk is a top-level direc

Boolean

tory in the shared disk structure. Possible values are:
• 0 - The directory is not top-level
• 1 - The directory is top-level
exported_directory

Exported directory of the shared disk.

type

Type of the shared disk. Possible values are:

✓

String

✓

In
te

• 0 - Network File System

ger

• 1- Samba File System
computers_count

Number of computers on which the shared disk is
mounted.

✓

In
te
ger

Applicable associations
You can additionally retrieve data from the following associations:
• designated_computer
• shared_disk_members

Query parameters
Table 285. Query parameters
Parameter
columns[]

Description
Specify which columns to retrieve. If you do not

Required

Value
String

specify this parameter, only default columns are
retrieved.
Example: Retrieve product name and release
URL?
columns[]=product_name&columns[]=produc
t_release

order

Specify how to sort the returned data. The de

Alphanu

fault direction for sorting columns is ascending.

meric

If you want to specify a descending sort, append
desc to the column name.

Example: Order by computer ID descending
URL?order[]=computer_id desc

limit

Specify the number of rows to retrieve. If you

Numeric

omit this parameter, all rows are retrieved.
Example: Retrieve 100 records
URL?limit=100

offset

Specify the number of rows to skip for retrieving
results. You can use it together with the limit pa
rameter to paginate results.
Example: Retrieve 50 records starting after
record 150
URL?limit=50&offset=150

Numeric

Table 285. Query parameters (continued)
Parameter
token

Description

Required

A unique user authentication identifier. You can
retrieve it by using REST API for retrieving au

✓

Value
Alphanu
meric

thentication token. You can also log in to BigFix
Inventory, hover over the User icon

, and click

Profile. Then, click Show token.
criteria

Retrieve records which match specific condi
tions. The parameter should have the following
structure, written in one line:
<criteria> ::= <left-brace>
<boolean-operator> <colon>
<left-bracket>
<criterion> [{ <comma>
<criterion> }...] <right-bracket>
<right-brace>
<boolean-operator> ::= "and" | "or"
<criterion> ::= <criteria> |
<left-bracket> <column> <comma>
<operator> <comma> <value>
<right-bracket>
<column> ::= <json-string>
<operator> ::= <json-string>
<value> ::= <json-array> |
<json-string> | <json-number> |
<json-null>

For more information about operators, see: Com
mon connectors and operators.

String

Table 285. Query parameters (continued)
Parameter

Description

Required

Example: Retrieve software instances whose
product name contains "BigFix" OR the discovery
start is within a specific date range
URL?criteria={ "or": [ ["product_name",
"contains", "BigFix"],
{ "and": [ ["discovery_start", ">",
"1970-01-01T00:00:00+00:00Z"],
["discovery_start", "<",
"1970-01-02T00:00:00+00:00Z"] ] } ] }

For columns that use the date and time values,
you can retrieve data also for a period instead
of a specific date. To do so, use last or next as
<operator>, and then specify the time value
in the following convention: PxD/PxW/PxM/PxY,
where x is a number in the 1-999 range, and D,
W, M, or Y is a designator that represents days,
weeks, months, or years respectively.
Example: Retrieve software instances that were
first reported within the last 7 days
URL?
criteria={"and":[["discovery_start","la
st","P7D"]]}

Example conversation - default columns
Request
GET api/sam/v2/shared_disks?token=7adc3efb175e2bc0f4484bdd2efca5
4a8fa04623

Value

Host: localhost:9081
Accept: application/json
Accept-Language: en-US

Response body
[{
"id":"5",
"status":"0"'
"type":"0"
"designated_computer_id":"29"
"parent_id":"3"
"computers_count":"10"
"exported_directory":"192.0.2.24:/file_server/tlcm/ISO/RHEL"

Example conversation - all columns
Request
GET api/sam/v2/shared_disks?columns[]=id&columns[]=status
&columns[]=parent_id&columns[]=top_level&columns[]=exported_dire
ctory
&columns[]=type&columns[]=computers_count&columns[]=designated_c
opmuter_id
&token=7adc3efb175e2bc0f4484bdd2efca54a8fa04623

Response body
[{
"id":"1",
"status":"0",
"parent_id":"5",
"top_level":"0",
"exported_directory":"192.0.2.24:/file_server/tlcm/HOME"
"type":"0",

"computers_count":"10",
"designated_computer_id":"29"

Example conversation - association
Request
GET api/sam/v2/shared_disks?columns[]=exported_directory
&columns[]=computers_count&columns[]=shared_disk_members.compute
r_id
&columns[]=shared_disk_members.mount_point&token=7adc3efb175e2bc
0f4484bdd2efca54a8fa04623
Host: localhost:9081
Accept: application/json
Accept-Language: en-US

Response body
[{
"exported_directory":"192.0.2.24:/file_server/tlcm/HOME",
"computers_count":"1",
"members":
{
"computer_id":"5",
"mount_point":"/mnt/fs"
}
}]

Related reference
Running data imports
Retrieving raw scanned file data
Retrieving raw package data

Retrieving raw UNIX package data
Retrieving raw metering data
Retrieval of hardware inventory (v2)
Related information
REST API for retrieving detailed hardware information (v2)

REST API for retrieving detailed hardware information (v2)
You can use REST API requests to retrieve data related to detailed hardware information,
such as memory, operating systems, storage, processors, partitions, network adapters,
SMBIOS data, IP addresses and logical partition capacity data. You can then pass this data
to other applications for further processing and analysis.
Note: The APIs from this section can be used as associations to the api/sam/v2/
computers API.

Related reference
Running data imports
Retrieving raw scanned file data
Retrieving raw package data
Retrieving raw UNIX package data
Retrieving raw metering data
Retrieval of hardware inventory (v2)
Retrieval of shared disks (v2)

Retrieval of IP addresses (v2)
Available from 9.2.12. You use the GET operation on the api/sam/v2/
detailed_hw_ip_addresses element to request information related to IP addresses of

computers in your infrastructure.

Permissions
You must have the View Endpoints and View Hardware Inventory permission to use this
API.

Resource URL
https://hostname:port/api/sam/v2/detailed_hw_ip_addresses?token=token

Resource information
Table 286. Resource information
Operation details
HTTP method
Request headers

Description
GET

Header
Accept-Language (optional)

Values
en-US (only English is supported)
Negotiates the language of the response. If the header
is not specified, the content is returned in the server lan
guage.
Request format
Response headers

application/json

Header
Content-Type

Values

Table 286. Resource information (continued)
Operation details

Description
application/json

Specifies the content type of the response.
Header
Content-Language

Values
en-US, …
Specifies the language of the response content. If the
header is not specified, the content is returned in the serv
er language.
Response payload

IP Addresses element

Response format

application/json

Response codes

200 – OK
500 – "Bad Request" if a query parameter contains er

rors or is missing

Schema description
To retrieve the list of all columns that are returned by this REST API together with their
descriptions, use the following request.
GET api/sam/v2/schemas/detailed_hw_ip_address.json?token=token

Available columns
The list of attributes related to IP addresses on the scanned system. The retrieved
addresses are in the IPv4 format, except for the ipv6_address attribute.
The output might contain multiple instances of each attribute from this group.

Table 287. Columns with information related to IP addresses
Property
id

Description
Identifier of the record.

Type
In
te
ger

computer_id Identifier of the computer as specified in the BigFix Inventory data
base.

In
te
ger

updated_at

Date and time when the current information was imported to BigFix String
Inventory.

address

IP address of the computer.

String

hostname

Host name of the computer with the given IP.

String

primary_dns Primary domain name system (DNS).

String

permanen

Permanent media access control (MAC) address associated with

String

t_mac_ad

the given IP address.

dress
ipv6_ad

IP address in version 6.

dress

Related APIs
This API can be associated with the following API:
• Retrieval of hardware inventory (v2)

String

Query parameters
Table 288. Query parameters
Parameter
columns[]

Description
Specify which columns to retrieve. If you do not

Required

Value
String

specify this parameter, only default columns are
retrieved.
Example: Retrieve the computer ID:
URL?columns[]=computer_id

order

Specify how to sort the returned data. The de

String

fault direction for sorting columns is ascending.
If you want to specify a descending sort, append
desc to the column name.

Example: Order by computer ID descending:
URL?order[]=computer_id desc

limit

Specify the number of rows to retrieve. If you

Numeric

omit this parameter, all rows are retrieved.
Example: Retrieve 100 records
URL?limit=100

Note: By default the limit parameter for
this API is set to 100000.
offset

Specify the number of rows to skip for retrieving
results. You can use it together with the limit pa
rameter to paginate results.
Example: Retrieve 50 records starting after
record 150

Numeric

Table 288. Query parameters (continued)
Parameter

Description

Required

Value

URL?limit=50&offset=150

token

A unique user authentication identifier. You can
retrieve it by using REST API for retrieving au

✓

Alphanu
meric

thentication token. You can also log in to BigFix
Inventory, hover over the User icon

, and click

Profile. Then, click Show token.
criteria

Retrieve records which match specific condi
tions. The parameter should have the following
structure, written in one line:
<criteria> ::= <left-brace>
<boolean-operator><colon>
<left-bracket>
<criterion> [{ <comma>
<criterion> }...] <right-bracket>
<right-brace>
<boolean-operator> ::= "and" | "or"
<criterion> ::= <criteria> |
<left-bracket> <column> <comma>
<operator> <comma> <value>
<right-bracket>
<column> ::= <json-string>
<operator> ::= <json-string>
<value> ::= <json-array> |
<json-string> | <json-numver> |
<json-null>

For more information about operators, see: Com
mon connectors and operators.

String

Table 288. Query parameters (continued)
Parameter

Description

Required

Example: retrieve computers with computer ID
greater than 1000.
URL?criteria={"and":[["computer_id",
">", "1000"]]}

For columns that use the date and time values,
you can retrieve data also for a period instead
of a specific date. To do so, use last or next as
<operator>, and then specify the time value
in the following convention: PxD/PxW/PxM/PxY,
where x is a number in the 1-999 range, and D,
W, M, or Y is a designator that represents days,
weeks, months, or years respectively.

Example conversation - default columns
Request
GET /api/sam/v2/detailed_hw_ip_addresses?token=7adc3efb175e2bc0f
4484bdd2efca54a8fa04623
Host: localhost:9081
Accept: application/json
Accept-Language: en-US

Response body
[{
"id":1
"computer_id":1,
"updated_at":"2018-05-16T14:37:08Z",
"address":"9.174.39.183",
"hostname":"NC9174039183",

Value

"primary_dns":"9.20.136.11",
"permanent_mac_address":"00:50:56:94:7C:95",
"ipv6_address":"fe80:0000:0000:0000:44a3:f150:0968:869e%2"
}]

Example conversation - selected columns
Request
GET api/sam/v2/detailed_hw_ip_addresses?columns[]=computer_id
&columns[]=primary_dns
&token=7adc3efb175e2bc0f4484bdd2efca54a8fa04623
Host: localhost:9081
Accept: application/json
Accept-Language: en-US

Response body
[{
"computer_id":1,
"primary_dns":"9.20.136.11"}
}]

Retrieval of information related to logical partition capacity (v2)
Available from 9.2.12. You use the GET operation on the api/sam/v2/
detailed_hw_lpars element to request information related to the logical partition and its

CPU resources. The data retrieved by this API is not limited to LPARs on POWER. It includes
data related to every supported virtualization technology.

Permissions
You must have the View Endpoints and View Hardware Inventory permission to use this
API.

Resource URL
https://hostname:port/api/sam/v2/detailed_hw_lpars?token=token

Resource information
Table 289. Resource information
Operation details
HTTP method
Request headers

Description
GET

Header
Accept-Language (optional)

Values
en-US (only English is supported)
Negotiates the language of the response. If the header
is not specified, the content is returned in the server lan
guage.
Request format
Response headers

application/json

Header
Content-Type

Values
application/json

Specifies the content type of the response.
Header
Content-Language

Values
en-US, …

Table 289. Resource information (continued)
Operation details

Description
Specifies the language of the response content. If the
header is not specified, the content is returned in the serv
er language.

Response payload

LPARS element

Response format

application/json

Response codes

200 – OK
500 – "Bad Request" if a query parameter contains er

rors or is missing

Schema description
To retrieve the list of all columns that are returned by this REST API together with their
descriptions, use the following request.
GET api/sam/v2/schemas/detailed_hw_lpar.json?token=token

Available columns
The list of attributes related to the logical partition and its CPU resources.
The scan output contains a single instance of each attribute from this group.
Table 290. Columns with information about the logical partition and its CPU resources
Property
id

Description
Identifier of the record.

Type
In
te
ger

Table 290. Columns with information about the logical partition and its CPU resources
(continued)
Property
computer_id

Description

Type

Identifier of the computer as specified in the BigFix Inventory

In

database.

te
ger

updated_at

Date and time when the current information was imported to

String

BigFix Inventory.
lpar_capacity_

The number of processor cores assigned to the partition.

String

The number of active logical processors in the partition. Logi

String

in_cores
lpar_online_

processor_count cal processors are the smallest CPU entities visible in the op
erating system, which are dividable and schedulable. Depend
ing on the hardware platform, a logical processor might cor
respond to a chip, the core of a multi-core chip, or a hardware
CPU thread on a multithreaded chip or core (provided that the
feature is enabled).
lpar_online_

The number of active cores in a logical partition. The core is ac String

core_count

tive if any of the logical processors in the system is running on
this core.

lpar_online_

The number of active processor packages in the partition. The

package_count

processor package is active if any of the logical processors in
the system is running on this package.

Related APIs
This API can be associated with the following API:
• Retrieval of hardware inventory (v2)

String

Query parameters
Table 291. Query parameters
Parameter
columns[]

Description
Specify which columns to retrieve. If you do not

Required

Value
String

specify this parameter, only default columns are
retrieved.
Example: Retrieve the computer id:
URL?columns[]=computer_id

order

Specify how to sort the returned data. The de

String

fault direction for sorting columns is ascending.
If you want to specify a descending sort, append
desc to the column name.

Example: Order by computer ID descending:
URL?order[]=computer_id desc

limit

Specify the number of rows to retrieve. If you

Numeric

omit this parameter, all rows are retrieved.
Example: Retrieve 100 records
URL?limit=100

Note: By default the limit parameter for
this API is set to 100000.
offset

Specify the number of rows to skip for retrieving
results. You can use it together with the limit pa
rameter to paginate results.
Example: Retrieve 50 records starting after
record 150

Numeric

Table 291. Query parameters (continued)
Parameter

Description

Required

Value

URL?limit=50&offset=150

token

A unique user authentication identifier. You can
retrieve it by using REST API for retrieving au

✓

Alphanu
meric

thentication token. You can also log in to BigFix
Inventory, hover over the User icon

, and click

Profile. Then, click Show token.
criteria

Retrieve records which match specific condi
tions. The parameter should have the following
structure, written in one line:
<criteria> ::= <left-brace>
<boolean-operator><colon>
<left-bracket>
<criterion> [{ <comma>
<criterion> }...] <right-bracket>
<right-brace>
<boolean-operator> ::= "and" | "or"
<criterion> ::= <criteria> |
<left-bracket> <column> <comma>
<operator> <comma> <value>
<right-bracket>
<column> ::= <json-string>
<operator> ::= <json-string>
<value> ::= <json-array> |
<json-string> | <json-numver> |
<json-null>

For more information about operators, see: Com
mon connectors and operators.

String

Table 291. Query parameters (continued)
Parameter

Description

Required

Example: retrieve computers with computer ID
greater than 1000.
URL?criteria={"and":[["computer_id",
">", "1000"]]}

For columns that use the date and time values,
you can retrieve data also for a period instead
of a specific date. To do so, use last or next as
<operator>, and then specify the time value
in the following convention: PxD/PxW/PxM/PxY,
where x is a number in the 1-999 range, and D,
W, M, or Y is a designator that represents days,
weeks, months, or years respectively.

Example conversation - default columns
Request
GET api/sam/v2/detailed_hw_lpars?token=c77a88cfdde276de605c6fdee
689b7961ddb93ef
Host: localhost:9081
Accept: application/json
Accept-Language: en-US

Response body
[{
"id":1,
"computer_id":1,
"updated_at":"2018-05-28T01:22:16Z",
"lpar_capacity_in_cores":"-1.000000",
"lpar_online_processor_count":"2.000000",

Value

"lpar_online_core_count":"2.000000",
"lpar_online_package_count":"2.000000"
}]

Example conversation - selected columns
Request
GET api/sam/v2/detailed_hw_lpars?columns[]=id
&columns[]=lpar_capacity_in_cores
&token=c77a88cfdde276de605c6fdee689b7961ddb93ef
Host: localhost:9081
Accept: application/json
Accept-Language: en-US

Response body
[{
"id":1,
"lpar_capacity_in_cores":"-1.000000"
}]

Retrieval of information related to system memory (v2)
Available from 9.2.12. You use the GET operation on the api/sam/v2/
detailed_hw_memories element to request information related to the system memory of

the scanned system.

Permissions
You must have the View Endpoints and View Hardware Inventory permission to use this
API.

Resource URL
https://hostname:port/api/sam/v2/detailed_hw_memories?token=token

Resource information
Table 292. Resource information
Operation details
HTTP method
Request headers

Description
GET

Header
Accept-Language (optional)

Values
en-US (only English is supported)
Negotiates the language of the response. If the header
is not specified, the content is returned in the server lan
guage.
Request format
Response headers

application/json

Header
Content-Type

Values
application/json

Specifies the content type of the response.
Header
Content-Language

Values
en-US, …
Specifies the language of the response content. If the
header is not specified, the content is returned in the serv
er language.
Response payload

System Memory element

Table 292. Resource information (continued)
Operation details

Description

Response format

application/json

Response codes

200 – OK
500 – "Bad Request" if a query parameter contains er

rors or is missing

Schema description
To retrieve the list of all columns that are returned by this REST API together with their
descriptions, use the following request.
GET api/sam/v2/schemas/detailed_hw_memory.json?token=token

Available columns
The list of attributes related to the memory on a scanned system.
The scan output contains a single instance of each attribute from this group.
Table 293. Columns with information about the system memory
Property
id

Description
Identifier of the record.

Type
In
te
ger

computer_id

Identifier of the computer as specified in the BigFix Inventory

In

database.

te
ger

updated_at

Date and time when the current information was imported to Big

String

Fix Inventory.
total_physical

Total amount of installed memory in kilobytes (KB).

String

free_physical

Total amount of free memory on the system in kilobytes (KB).

String

Related APIs
This API can be associated with the following API:
• Retrieval of hardware inventory (v2)

Query parameters
Table 294. Query parameters
Parameter
columns[]

Description
Specify which columns to retrieve. If you do not

Required

Value
String

specify this parameter, only default columns are
retrieved.
Example: Retrieve the computer id:
URL?columns[]=computer_id

order

Specify how to sort the returned data. The de

String

fault direction for sorting columns is ascending.
If you want to specify a descending sort, append
desc to the column name.

Example: Order by computer ID descending:
URL?order[]=computer_id desc

limit

Specify the number of rows to retrieve. If you
omit this parameter, all rows are retrieved.
Example: Retrieve 100 records
URL?limit=100

Note: By default the limit parameter for
this API is set to 100000.

Numeric

Table 294. Query parameters (continued)
Parameter
offset

Description

Required

Specify the number of rows to skip for retrieving

Value
Numeric

results. You can use it together with the limit pa
rameter to paginate results.
Example: Retrieve 50 records starting after
record 150
URL?limit=50&offset=150

token

A unique user authentication identifier. You can
retrieve it by using REST API for retrieving au

✓

Alphanu
meric

thentication token. You can also log in to BigFix
Inventory, hover over the User icon

, and click

Profile. Then, click Show token.
criteria

Retrieve records which match specific condi
tions. The parameter should have the following
structure, written in one line:
<criteria> ::= <left-brace>
<boolean-operator><colon>
<left-bracket>
<criterion> [{ <comma>
<criterion> }...] <right-bracket>
<right-brace>
<boolean-operator> ::= "and" | "or"
<criterion> ::= <criteria> |
<left-bracket> <column> <comma>
<operator> <comma> <value>
<right-bracket>
<column> ::= <json-string>
<operator> ::= <json-string>

String

Table 294. Query parameters (continued)
Parameter

Description

Required

<value> ::= <json-array> |
<json-string> | <json-numver> |
<json-null>

For more information about operators, see: Com
mon connectors and operators.
Example: retrieve computers with computer ID
greater than 1000.
URL?criteria={"and":[["computer_id",
">", "1000"]]}

For columns that use the date and time values,
you can retrieve data also for a period instead
of a specific date. To do so, use last or next as
<operator>, and then specify the time value
in the following convention: PxD/PxW/PxM/PxY,
where x is a number in the 1-999 range, and D,
W, M, or Y is a designator that represents days,
weeks, months, or years respectively.

Example conversation - default columns
Request
GET api/sam/v2/detailed_hw_memories?token=7adc3efb175e2bc0f4484b
dd2efca54a8fa04623
Host: localhost:9081
Accept: application/json
Accept-Language: en-US

Response body

Value

[{
"id":1,
"computer_id":1,
"updated_at":"2018-05-28T01:22:16Z",
"total_physical":"8010840",
"free_physical":"221176"
}]

Example conversation - selected columns
Request
GET api/sam/v2/detailed_hw_memories?columns[]=id
&columns[]=total_physical
&token=7adc3efb175e2bc0f4484bdd2efca54a8fa04623
Host: localhost:9081
Accept: application/json
Accept-Language: en-US

Response body
[{
"id":1,
"total_physical":"8010840"
}]

Retrieval of information related to network adapters (v2)
Available from 9.2.12. You use the GET operation on the api/sam/v2/
detailed_hw_network_adapters element to request information related to the type, model

and MAC addresses of the network adapters.

Permissions
You must have the View Endpoints and View Hardware Inventory permission to use this
API.

Resource URL
https://hostname:port/api/sam/v2/detailed_hw_network_adapters?token=token

Resource information
Table 295. Resource information
Operation details
HTTP method
Request headers

Description
GET

Header
Accept-Language (optional)

Values
en-US (only English is supported)
Negotiates the language of the response. If the header
is not specified, the content is returned in the server lan
guage.
Request format
Response headers

application/json

Header
Content-Type

Values
application/json

Specifies the content type of the response.
Header
Content-Language

Values
en-US, …

Table 295. Resource information (continued)
Operation details

Description
Specifies the language of the response content. If the
header is not specified, the content is returned in the serv
er language.

Response payload

Network Adapter element

Response format

application/json

Response codes

200 – OK
500 – "Bad Request" if a query parameter contains er

rors or is missing

Schema description
To retrieve the list of all columns that are returned by this REST API together with their
descriptions, use the following request.
GET api/sam/v2/schemas/detailed_hw_network_adapter.json?token=token

Available columns
The list of attributes related to the network adapters.
The scan output might contain multiple instances of each attribute from this group.
Table 296. Columns with information about the network adapters
Property

Description

Type

id

Identifier of the record.

Integer

computer_id

Identifier of the computer

Integer

as specified in the BigFix
Inventory database.
updated_at

Date and time when the
current information was

String

Table 296. Columns with information about the network adapters (continued)
Property

Description

Type

imported to BigFix Invento
ry.
permanent_address

The permanent media ac

String

cess control (MAC) ad
dress associated with the
adapter.
current_address

The current network ad

String

dress of the adapter.
type

The type of network

String

adapter.
model

The model of the network

String

adapter.

Related APIs
This API can be associated with the following API:
• Retrieval of hardware inventory (v2)

Query parameters
Table 297. Query parameters
Parameter
columns[]

Description
Specify which columns to retrieve. If you do not
specify this parameter, only default columns are
retrieved.
Example: Retrieve the computer id:
URL?columns[]=computer_id

Required

Value
String

Table 297. Query parameters (continued)
Parameter
order

Description

Required

Specify how to sort the returned data. The de

Value
String

fault direction for sorting columns is ascending.
If you want to specify a descending sort, append
desc to the column name.

Example: Order by computer ID descending:
URL?order[]=computer_id desc

limit

Specify the number of rows to retrieve. If you

Numeric

omit this parameter, all rows are retrieved.
Example: Retrieve 100 records
URL?limit=100

Note: By default the limit parameter for
this API is set to 100000.
offset

Specify the number of rows to skip for retrieving

Numeric

results. You can use it together with the limit pa
rameter to paginate results.
Example: Retrieve 50 records starting after
record 150
URL?limit=50&offset=150

token

A unique user authentication identifier. You can
retrieve it by using REST API for retrieving au
thentication token. You can also log in to BigFix
Inventory, hover over the User icon
Profile. Then, click Show token.

, and click

✓

Alphanu
meric

Table 297. Query parameters (continued)
Parameter
criteria

Description
Retrieve records which match specific condi
tions. The parameter should have the following
structure, written in one line:
<criteria> ::= <left-brace>
<boolean-operator><colon>
<left-bracket>
<criterion> [{ <comma>
<criterion> }...] <right-bracket>
<right-brace>
<boolean-operator> ::= "and" | "or"
<criterion> ::= <criteria> |
<left-bracket> <column> <comma>
<operator> <comma> <value>
<right-bracket>
<column> ::= <json-string>
<operator> ::= <json-string>
<value> ::= <json-array> |
<json-string> | <json-numver> |
<json-null>

For more information about operators, see: Com
mon connectors and operators.
Example: retrieve computers with computer ID
greater than 1000.
URL?criteria={"and":[["computer_id",
">", "1000"]]}

For columns that use the date and time values,
you can retrieve data also for a period instead

Required

Value
String

Table 297. Query parameters (continued)
Parameter

Description

Required

of a specific date. To do so, use last or next as
<operator>, and then specify the time value
in the following convention: PxD/PxW/PxM/PxY,
where x is a number in the 1-999 range, and D,
W, M, or Y is a designator that represents days,
weeks, months, or years respectively.

Example conversation - default columns
Request
GET api/sam/v2/detailed_hw_network_adapters?token=7adc3efb175e2b
c0f4484bdd2efca54a8fa04623
Host: localhost:9081
Accept: application/json
Accept-Language: en-US

Response body
[{
"id":13,
"computer_id":4,
"updated_at":"2018-05-28T01:22:16Z",
"permanent_address":"00:50:56:94:A1:39",
"current_address":"00:50:56:94:A1:39",
"type":"Ethernet Adapter",
"model":"vmxnet3 Ethernet Adapter"
}]

Example conversation - selected columns
Request

Value

GET api/sam/v2/detailed_hw_network_adapters?columns[]=id
&columns[]=id&columns[]=type&columns[]=model
&token=7adc3efb175e2bc0f4484bdd2efca54a8fa04623
Host: localhost:9081
Accept: application/json
Accept-Language: en-US

Response body
[{
"id":13,
"type":"Ethernet Adapter",
"model":"vmxnet3 Ethernet Adapter"
}]

Retrieval of information related to the operating system (v2)
Available from 9.2.12. You use the GET operation on the api/sam/v2/
detailed_hw_operating_systems element to request information related to the operating

system on the scanned computer.

Permissions
You must have the View Endpoints and View Hardware Inventory permission to use this
API.

Resource URL
https://hostname:port/api/sam/v2/detailed_hw_operating_systems?token=token

Resource information
Table 298. Resource information
Operation details
HTTP method

Description
GET

Table 298. Resource information (continued)
Operation details
Request headers

Description
Header
Accept-Language (optional)

Values
en-US (only English is supported)
Negotiates the language of the response. If the header
is not specified, the content is returned in the server lan
guage.
Request format
Response headers

application/json

Header
Content-Type

Values
application/json

Specifies the content type of the response.
Header
Content-Language

Values
en-US, …
Specifies the language of the response content. If the
header is not specified, the content is returned in the serv
er language.
Response payload

Operating System element

Response format

application/json

Response codes

200 – OK

Table 298. Resource information (continued)
Operation details

Description
500 – "Bad Request" if a query parameter contains er

rors or is missing

Schema description
To retrieve the list of all columns that are returned by this REST API together with their
descriptions, use the following request.
GET api/sam/v2/schemas/detailed_hw_operating_system.json?token=token

Available columns
The list of attributes related to the operating system that is installed on the scanned
system.
The scan output contains a single instance of each attribute from this group.
Table 299. Columns with information about the operating system
Property
id

Description
Identifier of the record.

Type
In
te
ger

computer_id

Identifier of the computer as specified in the BigFix Inventory

In

database.

te
ger

updated_at

Date and time when the current information was imported to Big

String

Fix Inventory.
name

The name of an operating system; for example, Windows 10.

String

major_ver

The major version of an operating system.

String

sion

Table 299. Columns with information about the operating system (continued)
Property
minor_ver

Description

Type

The minor version of an operating system.

String

The date when the operating system was installed.

String

os_arch

The version of the operating system architecture.

String

os_kernel_

The kernel mode of the operating system (32-bit or 64-bit).

String

The description of the operating system.

String

sion
in
stall_date

mode
de
scription_
string

Related APIs
This API can be associated with the following API:
• Retrieval of hardware inventory (v2)

Query parameters
Table 300. Query parameters
Parameter
columns

Description
Specify which columns to retrieve. If you do not

Required

Value
String

specify this parameter, only default columns are
retrieved.
Example: Retrieve the computer id:
URL?columns[]=computer_id

order

Specify how to sort the returned data. The de
fault direction for sorting columns is ascending.

String

Table 300. Query parameters (continued)
Parameter

Description

Required

Value

If you want to specify a descending sort, append
desc to the column name.

Example: Order by computer ID descending:
URL?order[]=computer_id desc

limit

Specify the number of rows to retrieve. If you

Numeric

omit this parameter, all rows are retrieved.
Example: Retrieve 100 records
URL?limit=100

Note: By default the limit parameter for
this API is set to 100000.
offset

Specify the number of rows to skip for retrieving

Numeric

results. You can use it together with the limit pa
rameter to paginate results.
Example: Retrieve 50 records starting after
record 150
URL?limit=50&offset=150

token

A unique user authentication identifier. You can
retrieve it by using REST API for retrieving au

✓

Alphanu
meric

thentication token. You can also log in to BigFix
Inventory, hover over the User icon

, and click

Profile. Then, click Show token.
criteria

Retrieve records which match specific condi
tions. The parameter should have the following
structure, written in one line:

String

Table 300. Query parameters (continued)
Parameter

Description
<criteria> ::= <left-brace>
<boolean-operator><colon>
<left-bracket>
<criterion> [{ <comma>
<criterion> }...] <right-bracket>
<right-brace>
<boolean-operator> ::= "and" | "or"
<criterion> ::= <criteria> |
<left-bracket> <column> <comma>
<operator> <comma> <value>
<right-bracket>
<column> ::= <json-string>
<operator> ::= <json-string>
<value> ::= <json-array> |
<json-string> | <json-numver> |
<json-null>

For more information about operators, see: Com
mon connectors and operators.
Example: retrieve computers with computer ID
greater than 1000.
URL?criteria={"and":[["computer_id",
">", "1000"]]}

For columns that use the date and time values,
you can retrieve data also for a period instead
of a specific date. To do so, use last or next as
<operator>, and then specify the time value
in the following convention: PxD/PxW/PxM/PxY,
where x is a number in the 1-999 range, and D,

Required

Value

Table 300. Query parameters (continued)
Parameter

Description

Required

W, M, or Y is a designator that represents days,
weeks, months, or years respectively.

Example conversation - default columns
Request
GET api/sam/v2/detailed_hw_operating_systems?token=7adc3efb175e2
bc0f4484bdd2efca54a8fa04623
Host: localhost:9081
Accept: application/json
Accept-Language: en-US

Response body
[{
"id":13,
"computer_id":22,
"updated_at":"2018-05-28T01:22:16Z",
"name":"Red Hat Enterprise Linux Server release 6.8 (Santiago)",
"major_version":"2",
"minor_version":"6",
"install_date":"2017-10-31-08.37.06.000000",
"os_arch":"x86_64",
"os_kernel_mode":"64",
"description_string":"Red Hat Enterprise Linux Server release 6.
8 (Santiago)"
}]

Example conversation - selected columns
Request

Value

GET api/sam/v2/detailed_hw_operating_systems?columns[]=id
&columns[]=name&columns[]=major_version&columns[]=minor_version
&token=7adc3efb175e2bc0f4484bdd2efca54a8fa04623
Host: localhost:9081
Accept: application/json
Accept-Language: en-US

Response body
[{
"id":13,
"name":"Red Hat Enterprise Linux Server release 6.8 (Santiago)",
"major_version":"2",
"minor_version":"6"
}]

Retrieval of information related to partitions (v2)
Available from 9.2.12. You use the GET operation on the api/sam/v2/
detailed_hw_partitions element to request information related to the file system that is

mounted on a scanned system: Unix mount points and Windows logical drives.

Permissions
You must have the View Endpoints and View Hardware Inventory permission to use this
API.

Resource URL
https://hostname:port/api/sam/v2/detailed_hw_partitions?token=token

Resource information
Table 301. Resource information
Operation details
HTTP method
Request headers

Description
GET

Header
Accept-Language (optional)

Values
en-US (only English is supported)
Negotiates the language of the response. If the header
is not specified, the content is returned in the server lan
guage.
Request format
Response headers

application/json

Header
Content-Type

Values
application/json

Specifies the content type of the response.
Header
Content-Language

Values
en-US, …
Specifies the language of the response content. If the
header is not specified, the content is returned in the serv
er language.
Response payload

Partitions element

Table 301. Resource information (continued)
Operation details

Description

Response format

application/json

Response codes

200 – OK
500 – "Bad Request" if a query parameter contains er

rors or is missing

Schema description
To retrieve the list of all columns that are returned by this REST API together with their
descriptions, use the following request.
GET api/sam/v2/schemas/detailed_hw_partition.json?token=token

Available columns
The list of attributes related to the file system that is mounted on a scanned system: Unix
mount points and Windows logical drives.
The scan output might contain multiple instances of each attribute from this group.
Table 302. Columns with information about partitions
Property
id

Description
Identifier of the record.

Type
In
te
ger

computer_id

Identifier of the computer as specified in the BigFix Inventory data In
base.

te
ger

updated_at

Date and time when the current information was imported to Big
Fix Inventory.

String

Table 302. Columns with information about partitions (continued)
Property
type

Description

Type

The type of the partition; for example, Logical Drive or Remote Dri String
ve.

media_type

The media type that contains the partition; for example, Local Disc String
or CD-ROM.
Note: The media type is Unknown when the scanner can
not recognize it.

device_name

The name of the device or a label of a Windows drive; for example, String
/dev/dsk/c1t3d0s0 or Storage.

physical_size The size of a drive that contains the partition.

String

fs_total_size

Total size of the partition in kilobytes (KB).

String

fs_free_size

The amount of free space on the partition in kilobytes (KB).

String

Related APIs
This API can be associated with the following API:
• Retrieval of hardware inventory (v2)

Query parameters
Table 303. Query parameters
Parameter
columns[]

Description
Specify which columns to retrieve. If you do not
specify this parameter, only default columns are
retrieved.
Example: Retrieve the computer id:

Required

Value
String

Table 303. Query parameters (continued)
Parameter

Description

Required

Value

URL?columns[]=computer_id

order

Specify how to sort the returned data. The de

String

fault direction for sorting columns is ascending.
If you want to specify a descending sort, append
desc to the column name.

Example: Order by computer ID descending:
URL?order[]=computer_id desc

limit

Specify the number of rows to retrieve. If you

Numeric

omit this parameter, all rows are retrieved.
Example: Retrieve 100 records
URL?limit=100

Note: By default the limit parameter for
this API is set to 100000.
offset

Specify the number of rows to skip for retrieving

Numeric

results. You can use it together with the limit pa
rameter to paginate results.
Example: Retrieve 50 records starting after
record 150
URL?limit=50&offset=150

token

A unique user authentication identifier. You can
retrieve it by using REST API for retrieving au
thentication token. You can also log in to BigFix

✓

Alphanu
meric

Table 303. Query parameters (continued)
Parameter

Description
Inventory, hover over the User icon

Required

Value

, and click

Profile. Then, click Show token.
criteria

Retrieve records which match specific condi
tions. The parameter should have the following
structure, written in one line:
<criteria> ::= <left-brace>
<boolean-operator><colon>
<left-bracket>
<criterion> [{ <comma>
<criterion> }...] <right-bracket>
<right-brace>
<boolean-operator> ::= "and" | "or"
<criterion> ::= <criteria> |
<left-bracket> <column> <comma>
<operator> <comma> <value>
<right-bracket>
<column> ::= <json-string>
<operator> ::= <json-string>
<value> ::= <json-array> |
<json-string> | <json-numver> |
<json-null>

For more information about operators, see: Com
mon connectors and operators.
Example: retrieve computers with computer ID
greater than 1000.
URL?criteria={"and":[["computer_id",
">", "1000"]]}

String

Table 303. Query parameters (continued)
Parameter

Description

Required

For columns that use the date and time values,
you can retrieve data also for a period instead
of a specific date. To do so, use last or next as
<operator>, and then specify the time value
in the following convention: PxD/PxW/PxM/PxY,
where x is a number in the 1-999 range, and D,
W, M, or Y is a designator that represents days,
weeks, months, or years respectively.

Example conversation - default columns
Request
GET api/sam/v2/detailed_hw_partitions??token=7adc3efb175e2bc0f44
84bdd2efca54a8fa04623
Host: localhost:9081
Accept: application/json
Accept-Language: en-US

Response body
[{
"id":4,
"computer_id":1,
"updated_at":"2018-05-28T01:22:16Z",
"type":"Logical Drive",
"media_type":"Local Disk",
"device_name":"tmpfs",
"physical_size":"4005420",
"fs_total_size":"4005420",
"fs_free_size":"4005408"
}]

Value

Example conversation - selected columns
Request
GET api/sam/v2/detailed_hw_partitions?columns[]=id
&columns[]=media_type&columns[]=physical_size
&token=7adc3efb175e2bc0f4484bdd2efca54a8fa04623
Host: localhost:9081
Accept: application/json
Accept-Language: en-US

Response body
[{
"id":4,
"media_type":"Local Disk",
"physical_size":"4005420"
}]

Retrieval of information related to physical processors (v2)
Available from 9.2.12. You use the GET operation on the api/sam/v2/
detailed_hw_physical_processors element to request information related to all active

physical processors.

Permissions
You must have the View Endpoints and View Hardware Inventory permission to use this
API.

Resource URL
https://hostname:port/
api/sam/v2/detailed_hw_physical_processors?token=token

Resource information
Table 304. Resource information
Operation details
HTTP method
Request headers

Description
GET

Header
Accept-Language (optional)

Values
en-US (only English is supported)
Negotiates the language of the response. If the header
is not specified, the content is returned in the server lan
guage.
Request format
Response headers

application/json

Header
Content-Type

Values
application/json

Specifies the content type of the response.
Header
Content-Language

Values
en-US, …
Specifies the language of the response content. If the
header is not specified, the content is returned in the serv
er language.
Response payload

Physical Processors element

Table 304. Resource information (continued)
Operation details

Description

Response format

application/json

Response codes

200 – OK
500 – "Bad Request" if a query parameter contains er

rors or is missing

Schema description
To retrieve the list of all columns that are returned by this REST API together with their
descriptions, use the following request.
GET api/sam/v2/schemas/detailed_hw_physical_processor.json?token=token

Available columns
The list of attributes related to all active physical processors including single chips and
processor packages. You can retrieve values for each platform working as a host which
translates into one operating system per physical processor.
Note: To retrieve information about physical processors for guest operating
systems, such as VMware or BigFix LPAR, the complete information for the physical
machine must be available.
The scan output might contain multiple instances of each attribute from this group.
Table 305. Columns with information about physical processors
Property
id

Description
Identifier of the record.

Type
In
te
ger

Table 305. Columns with information about physical processors (continued)
Property
computer_id

Description

Type

Identifier of the computer as specified in the BigFix Inventory data In
base

te
ger

updated_at

Date and time when the current information was imported to Big

String

Fix Inventory.
core_per_

The number of cores on a physical processor; for example, 8 cores String

package_

for Intel Xeon E5-4620, and 12 for POWER9.

count
logical_

The number of logical processors assigned for each core; for ex

proc_per_

ample, 2 for Intel Xeon E5-4620, and 8 for POWER9.

String

core
manufactur

Processor manufacturer; for example Intel, AMD, or BigFix.

String

er
Note: You can only retrieve information about the manu
facturers that are supported by the scanner. Otherwise, the
displayed value is Unknown.
family

Processor family; for example, Xeon, or POWER9.

String

Note: You can only retrieve information about the proces
sor families that are supported by the scanner. Otherwise,
the displayed value is Unknown.
type

Processor type; for example, E5-4620 for Intel Xeon E5-4620.
Note: If the scanner does not support type identification of
the processor family the value is empty. If the scanner sup
ports type identification for the processor family, however,

String

Table 305. Columns with information about physical processors (continued)
Property

Description

Type

the given types is not recognize, the displayed value is Un
known.
cpu_freq

Processor frequency in megahertz (MHz). This information is op

String

tional, and vendor-specific. Depending on the processor family the
value might represent either nominal or current CPU frequency.
Note: CPU frequency might be interpreted differently
across processor architectures and families. If this infor
mation is not applicable the value is 0.
brandname

Processor name. This information is optional, and specific to plat

String

form and vendor. Thus, it can be retrieved from a different source
in case of each platform, or even processor family. If available, it is
a copy of a value reported by CPUID instruction, BIOS or OS.
active_

The number of active processors in the physical processor. A

processor_

processor is active if a logical processor is running on this physi

count

cal processor.

active_core_ The number of active cores in the physical processor. The core is
count

active if a logical processor is running on this core.

Related APIs
This API can be associated with the following API:
• Retrieval of hardware inventory (v2)

String

String

Query parameters
Table 306. Query parameters
Parameter
columns[]

Description
Specify which columns to retrieve. If you do not

Required

Value
String

specify this parameter, only default columns are
retrieved.
Example: Retrieve the computer id:
URL?columns[]=computer_id

order

Specify how to sort the returned data. The de

String

fault direction for sorting columns is ascending.
If you want to specify a descending sort, append
desc to the column name.

Example: Order by computer ID descending:
URL?order[]=computer_id desc

limit

Specify the number of rows to retrieve. If you

Numeric

omit this parameter, all rows are retrieved.
Example: Retrieve 100 records
URL?limit=100

Note: By default the limit parameter for
this API is set to 100000.
offset

Specify the number of rows to skip for retrieving
results. You can use it together with the limit pa
rameter to paginate results.
Example: Retrieve 50 records starting after
record 150

Numeric

Table 306. Query parameters (continued)
Parameter

Description

Required

Value

URL?limit=50&offset=150

token

A unique user authentication identifier. You can
retrieve it by using REST API for retrieving au

✓

Alphanu
meric

thentication token. You can also log in to BigFix
Inventory, hover over the User icon

, and click

Profile. Then, click Show token.
criteria

Retrieve records which match specific condi
tions. The parameter should have the following
structure, written in one line:
<criteria> ::= <left-brace>
<boolean-operator><colon>
<left-bracket>
<criterion> [{ <comma>
<criterion> }...] <right-bracket>
<right-brace>
<boolean-operator> ::= "and" | "or"
<criterion> ::= <criteria> |
<left-bracket> <column> <comma>
<operator> <comma> <value>
<right-bracket>
<column> ::= <json-string>
<operator> ::= <json-string>
<value> ::= <json-array> |
<json-string> | <json-numver> |
<json-null>

For more information about operators, see: Com
mon connectors and operators.

String

Table 306. Query parameters (continued)
Parameter

Description

Required

Example: retrieve computers with computer ID
greater than 1000.
URL?criteria={"and":[["computer_id",
">", "1000"]]}

For columns that use the date and time values,
you can retrieve data also for a period instead
of a specific date. To do so, use last or next as
<operator>, and then specify the time value
in the following convention: PxD/PxW/PxM/PxY,
where x is a number in the 1-999 range, and D,
W, M, or Y is a designator that represents days,
weeks, months, or years respectively.

Example conversation - default columns
Request
GET api/sam/v2/detailed_hw_physical_processors?token=7adc3efb175
e2bc0f4484bdd2efca54a8fa04623
Host: localhost:9081
Accept: application/json
Accept-Language: en-US

Response body
[{
"id":7,
"computer_id":4,
"updated_at":"2018-05-30T01:15:05Z",
"core_per_package_count":"1",
"logical_proc_per_core":"1",

Value

"manufacturer":"Intel",
"family":"Xeon",
"type":"E7-8880",
"cpu_freq":"2200",
"brandname":"Intel(R) Xeon(R) CPU E7-8880 v4 @ 2.20GHz","
active_processor_count":"1",
"active_core_count":"1"
}]

Example conversation - selected columns
Request
GET api/sam/v2/detailed_hw_physical_processors?columns[]=compute
r_id
&columns[]=manufacturer&columns[]=family&columns[]=type
&token=7adc3efb175e2bc0f4484bdd2efca54a8fa04623
Host: localhost:9081
Accept: application/json
Accept-Language: en-US

Response body
[{
"computer_id":4,
"manufacturer":"Intel",
"family":"Xeon",
"type":"E7-8880"
}]

Retrieval of information related to SMBIOS (v2)
Available from 9.2.12. You use the GET operation on the api/sam/v2/
detailed_hw_smbios element to request information related to SMBIOS of the scanned

system.

Permissions
You must have the View Endpoints and View Hardware Inventory permission to use this
API.

Resource URL
https://hostname:port/api/sam/v2/detailed_hw_smbios?token=token

Resource information
Table 307. Resource information
Operation details
HTTP method
Request headers

Description
GET

Header
Accept-Language (optional)

Values
en-US (only English is supported)
Negotiates the language of the response. If the header
is not specified, the content is returned in the server lan
guage.
Request format
Response headers

application/json

Header
Content-Type

Values
application/json

Specifies the content type of the response.
Header
Content-Language

Table 307. Resource information (continued)
Operation details

Description
Values
en-US, …
Specifies the language of the response content. If the
header is not specified, the content is returned in the serv
er language.

Response payload

SMBIOS element

Response format

application/json

Response codes

200 – OK
500 – "Bad Request" if a query parameter contains er

rors or is missing

Schema description
To retrieve the list of all columns that are returned by this REST API together with their
descriptions, use the following request.
GET api/sam/v2/schemas/detailed_hw_smbios.json?token=token

Available columns
The list of attributes related to SMBIOS of the scanned system.
The scan output contains a single instance of each attribute from this group.
Table 308. Columns with information about SMBIOS
Property
id

Description
Identifier of the record.

Type
In
te
ger

Table 308. Columns with information about SMBIOS (continued)
Property
computer_id

Description

Type

Identifier of the computer as specified in the BigFix Inventory

In

database

te
ger

updated_at

Date and time when the current information was imported to Big String
Fix Inventory.
The manufacturer of the BIOS system.

String

The version of the BIOS system.

String

The version of the system.

String

The serial number of the system.

String

bios_vendor

bios_version
sys
tem_version

sys
tem_serial_
number

Related APIs
This API can be associated with the following API:
• Retrieval of hardware inventory (v2)

Query parameters
Table 309. Query parameters
Parameter
columns[]

Description
Specify which columns to retrieve. If you do not

Required

Value
String

specify this parameter, only default columns are
retrieved.
Example: Retrieve the computer id:
URL?columns[]=computer_id

order

Specify how to sort the returned data. The de

String

fault direction for sorting columns is ascending.
If you want to specify a descending sort, append
desc to the column name.

Example: Order by computer ID descending:
URL?order[]=computer_id desc

limit

Specify the number of rows to retrieve. If you

Numeric

omit this parameter, all rows are retrieved.
Example: Retrieve 100 records
URL?limit=100

Note: By default the limit parameter for
this API is set to 100000.
offset

Specify the number of rows to skip for retrieving
results. You can use it together with the limit pa
rameter to paginate results.
Example: Retrieve 50 records starting after
record 150

Numeric

Table 309. Query parameters (continued)
Parameter

Description

Required

Value

URL?limit=50&offset=150

token

A unique user authentication identifier. You can
retrieve it by using REST API for retrieving au

✓

Alphanu
meric

thentication token. You can also log in to BigFix
Inventory, hover over the User icon

, and click

Profile. Then, click Show token.
criteria

Retrieve records which match specific condi
tions. The parameter should have the following
structure, written in one line:
<criteria> ::= <left-brace>
<boolean-operator><colon>
<left-bracket>
<criterion> [{ <comma>
<criterion> }...] <right-bracket>
<right-brace>
<boolean-operator> ::= "and" | "or"
<criterion> ::= <criteria> |
<left-bracket> <column> <comma>
<operator> <comma> <value>
<right-bracket>
<column> ::= <json-string>
<operator> ::= <json-string>
<value> ::= <json-array> |
<json-string> | <json-numver> |
<json-null>

For more information about operators, see: Com
mon connectors and operators.

String

Table 309. Query parameters (continued)
Parameter

Description

Required

Example: retrieve computers with computer ID
greater than 1000.
URL?criteria={"and":[["computer_id",
">", "1000"]]}

For columns that use the date and time values,
you can retrieve data also for a period instead
of a specific date. To do so, use last or next as
<operator>, and then specify the time value
in the following convention: PxD/PxW/PxM/PxY,
where x is a number in the 1-999 range, and D,
W, M, or Y is a designator that represents days,
weeks, months, or years respectively.

Example conversation - default columns
Request
GET api/sam/v2/detailed_hw_smbios?token=7adc3efb175e2bc0f4484bdd
2efca54a8fa04623
Host: localhost:9081
Accept: application/json
Accept-Language: en-US

Response body
[{
"id":12,
"computer_id":19,
"updated_at":"2018-05-28T01:22:16Z",
"bios_vendor":"Phoenix Technologies LTD",
"bios_version":"6.00",

Value

"system_version":"None",
"system_serial_number":"VMware-42 14 ea ea 03 c0 d5 03-fd f6 43
d6 44 a2 f8 52"
}]

Example conversation - selected columns
Request
GET api/sam/v2/detailed_hw_smbios?columns[]=computer_id
&columns[]=bios_vendor&columns[]=bios_version
&token=7adc3efb175e2bc0f4484bdd2efca54a8fa04623
Host: localhost:9081
Accept: application/json
Accept-Language: en-US

Response body
[{
"computer_id":19,
"bios_vendor":"Phoenix Technologies LTD",
"bios_version":"6.00"
}]

Retrieving unified view
Unified view APIs provides you a unified view of the instances.

Supported APIs
Unified Software API to combine package data and software instance data

Unified Software API to combine package data and software
instance data
With the /api/sam/unified/current/software API, you can view the currently
installed software instances and package data together.

Simplified integrations with one API that covers discovered software
The API shows the following information:
• Currently installed software instances and package data
• Software instances and package data that are not suppressed
• Package data that is not recognized
• The computer data that can be accessed through computer association, such as
computer association

Permissions
You must have the View Endpoints and View Raw Data permissions to use this API.

Resource URL
https://hostname:port/api/sam/unified/current/software?token=<token>

Syntax
GET /api/sam/unified/current/software?token=<token>

Resource information
Table 310. Resource information
Operation details
HTTP method
Request headers

Description
GET

Header
Accept-Language (optional)

Values
en-US (only English is supported)
Negotiates the language of the response. If the header
is not specified, the content is returned in the server lan
guage.

Table 310. Resource information (continued)
Operation details
Request format
Response headers

Description
application/json

Header
Content-Type

Values
application/json

Specifies the content type of the response.
Header
Content-Language

Values
en-US
Specifies the language of the response content. If the
header is not specified, the content is returned in the serv
er language.
Response payload

Unified Software element

Response format

application/json

Response codes

200 – OK
400 – "Bad Request" if a query parameter contains er

rors or is missing

Schema description
To retrieve the list of all columns that are returned by this association together with their
descriptions, use the following request:
GET /api/sam/unified/current/schemas/software.json?token=<token>

Available columns
Table 311. Columns with information about computer details
Column

Displayed

Description

Type

by default
✓

Numeric

✓

String

✓

String

✓

String

discoverable_guid Globally unique identifier (GUID) ✓

String

id

Identifier of the component in
stance or package.

name

Name of the component or
package.

release

Release of the component or
package version.

detailed_version

Detailed version of the compo
nent or package version.

of the component or sha1 of the
package.

discoverable_fam Family GUID of the component.
ily_guid

For packages, the returned val

✓

String

✓

String

✓

String

✓

String

ue is null.
publisher_name

Component publisher or pack
age vendor.

discovery_start

Date and time when the com
ponent or package was report
ed for the first time. The time is
specified in the GMT time zone.

discovery_path

Path to the folder where the
component is installed. For
packages, the returned value is
null.

Table 311. Columns with information about computer details (continued)
Column

Displayed

Description

source

Type

by default

Type of the software:

Numeric

• 0: component instance
• 1: Windows package
• 2: Unix package
computer.id

ID of the computer where the
software is discovered.

computer.name

Name of the computer where
the software is discovered.

✓

Numeric

✓

String

Applicable association
You can additionally retrieve data from the computer association.

Query parameters
Table 312. Query parameters
Parameter

Description

columns

Specify which columns to retrieve. If you

Required

Value
String

do not specify this parameter, only default
columns are retrieved.
Example: Retrieve release
URL?columns[]=name&columns[]=release

order

Specify how to sort the returned data. The de

Alphanu

fault direction for sorting columns is ascend

meric

ing. If you want to specify a descending sort,
append desc to the column name.

Table 312. Query parameters (continued)
Parameter

Description

Required

Value

Example: Order by ID descending
URL?order[]=id desc

limit

Specify the number of rows to retrieve. If you

Numeric

omit this parameter, all rows are retrieved.
Example: Retrieve 100 records
URL?limit=100

offset

Specify the number of rows to skip for retriev

Numeric

ing results. You can use it together with the
limit parameter to paginate results.
Example: Retrieve 50 records starting after
record 150
URL?limit=50&offset=150

token

A unique user authentication identifier. You
can retrieve it by using REST API for retrieving

✓

Alphanu
meric

authentication token. You can also log in to
BigFix Inventory, hover over the User icon

,

and click Profile. Then, click Show token.
criteria

Retrieve records that match specific condi
tions. The parameter should have the follow
ing structure, written in one line:
<criteria> ::= <left-brace>
<boolean-operator> <colon>
<left-bracket>

String

Table 312. Query parameters (continued)
Parameter

Description
<criterion> [{ <comma>
<criterion> }...] <right-bracket>
<right-brace>
<boolean-operator> ::= "and" | "or"
<criterion> ::= <criteria> |
<left-bracket> <column> <comma>
<operator> <comma> <value>
<right-bracket>
<column> ::= <json-string>
<operator> ::= <json-string>
<value> ::= <json-array> |
<json-string> | <json-number> |
<json-null>

For more information about operators, see:
Common connectors and operators.
Example: Retrieve a software instance whose
name contains "BigFix" or the discovery start
is within a specific date range
URL?criteria={ "or": [ ["name",
"contains", "BigFix"],
{ "and": [ ["discovery_start", ">",
"2018-10-01T00:00:00+00:00Z"],
["discovery_start", "<",
"2018-10-02T00:00:00+00:00Z"] ] } ]
}

For columns that use the date and time val
ues, you can retrieve data also for a period in
stead of a specific date. To do so, use last or

Required

Value

Table 312. Query parameters (continued)
Parameter

Description

Required

Value

next as <operator>, and then specify the
time value in the following convention: PxD/
PxW/PxM/PxY, where x is a number in the
1-999 range, and D, W, M, or Y is a designator
that represents days, weeks, months, or years.
Example: Retrieve software instances that
were first reported within the last 7 days
URL?
criteria={"and":[["discovery_start",
"last","P7D"]]}

Example conversations
To review the suppressed windows packages, use the following API:
GET api/sam/raw_package_facts?columns[]=name&columns[]=
is_supressed&columns[]=.comment&criteria=
{"and":[["is_suppressed","=",1]]}
&token=7adc3efb175e2bc0f4484bdd2efca54a8fa04623

To review the suppressed UNIX packages, use the following API:
GET api/sam/raw_unix_package_facts?columns[]=name&columns[]=
is_suppressed&columns[]=comment&criteria=
{"and":[["is_suppressed","=",1]]}
&token=7adc3efb175e2bc0f4484bdd2efca54a8fa04623

To review the suppressed software instances, use the following API:
GET /api/sam/v2/software_instances?columns[]=component_name&colu
mns[]

=component_release&columns[]=is_suppressed&columns[]=exclusion_o
r_suppress_comment&criteria=
{"and":[["is_suppressed","=",1]]}
&token=7adc3efb175e2bc0f4484bdd2efca54a8fa04623

To view associated computer data, use the following API:
GET /api/sam/unified/current/software?columns[]=name&columns[]=r
elease&columns[]
=computer.name&columns[]=computer.ip_address
&token=7adc3efb175e2bc0f4484bdd2efca54a8fa04623

Configuration APIs
Configuration APIs include all APIs that you need to configure the application.

Below APIs are supported:
• REST API for managing VM managers
• REST API for changing advanced server settings
• REST API for setting and deleting the end of support date
• REST API for adding and removing tags
• REST API for export and import of saved report views
• REST API for updating the Oracle core fact
•

REST API for managing license metrics

REST API for managing VM managers
You can use REST API requests to add and change VM managers in your infrastructure.

Retrieval of VM managers
You use the GET operation on the api/sam/vmmanagers element to request information
about VM managers that are defined in your infrastructure. The REST API returns more
information than is visible on the user interface. It returns information about VM managers
that are managed both in central and distributed mode, VM managers that were inactive

for more than 90 days as well as those that were removed. It also returns information from
virtualization technologies that do not require defining connection to the VM manager
such as Xen or KVM without RHV-M. The scope of VM managers from which data is
collected depends on which VM Manager Tools are installed on computers that belong to
the computer group to which you are assigned.
To retrieve information about VM managers, you must have the Manage VM Managers and
Servers permission.
Table 313. Operation descriptions
Operation details

Description

Operation

GET /api/sam/vmmanagers

Purpose

Returns a list of VM managers.

HTTP method

GET

Resource URI

https://server_host_name:port_number/
api/sam/vmmanagers?token=token

Request Content-Type

application/json

Response Content-Type

application/json

Normal HTTP response

200 – OK

codes
Error HTTP response codes

400 – "Bad Request" if a query parameter con

tains errors or is missing
401 – "Unauthorized" if the user does not have

the Manage VM Managers and Servers permis
sion
403 – "Forbidden" if the computer where the

central VM Manager tool is installed does not be

Table 313. Operation descriptions (continued)
Operation details

Description
long to the computer group that the user is as
signed
500 – "Internal Server Error" if no VM Man

ager tool is defined in the BigFix Inventory data
base.
Message body includes an error message with details.

Response attributes
Table 314. Response attributes and their possible values
Attribute
deleted

Possible values
Indicates whether the VM manager was removed from
BigFix Inventory.

lastmodified

The date and time when the VM manager was last
modified.

login

User name that is used to access the VM manager.

protocol

Communication protocol used by the VM manager. The
attribute is applicable only for Hyper-V.
• 0 - WinRM
• 1 - PowerShell
• null - the VM manager is not Hyper-V

sharedcredentials

Indicates whether the VM manager shares credentials
with other hosts in the same cluster. The attribute is
applicable only for Hyper-V.

status

Status of the VM manager.

Table 314. Response attributes and their possible values (continued)
Attribute

Possible values
• -1 - Invalid credentials - suspended
• 0 - Pending
• 1 - OK
• 2 - Connection failed
• 3 - Invalid credentials - attempting
• 6 - Duplicated address
• 7 - Hard timeout - suspended
• 8 - OK - duplicated UUIDs discarded
• 9 - No VM Manager Data
• 98 - Inactive
• 99 - Unknown problem
For more information about each status, see: VM man
ager statuses.

type

Type of the VM manager.
• 1 - Hyper-V
• 2 - VMware vSphere or VMware ESX
• 3 - RHV-M
4 - Citrix Hypervisor (formerly XenServ

•
er)

• 99 - Other. The value is used for VM managers
for which data is collected by using the Run Ca
pacity Scan on Virtualization Hosts task, for ex
ample Xen and KVM without RHV-M.
url

Web address of the VM manager.

vmmanagerid

ID of the VM manager.

Table 314. Response attributes and their possible values (continued)
Attribute
vmmanagertoolid

Possible values
ID of the VM Manager tool that collects information
from the particular VM manager.

Example HTTP conversation
Request
GET http://localhost:9081/api/sam/vmmanagers
?token=7adc3efb175e2bc0f4484bdd2efca54a8fa04623

Response body (JSON)

[{
"vmmanagerid":1,
"protocol":null,
"deleted":false,
"vmmanagertoolid":1,
"sharecredentials":false,
"lastmodified":"2016-06-12 09:06:51.723",
"login":"admin@internal",
"type":3,
"url":"https:\/\/9.156.44.146:8443\/api",
"status":98
}]

Adding and updating VM managers
You use the PUT operation on the api/sam/vmmanagers element to add or update VM
managers. You can perform these actions only for VM managers that are managed in
central mode.
To add or update VM managers, the following requirements must be met:

• You must have the Manage VM Managers and Servers permission
• The computer group to which you are assigned must contain the computer on which
the central VM Manager tool is installed
Table 315. Operation descriptions
Operation details

Description

Operation

PUT api/sam/vmmanagers

Purpose

Adds a new VM manager or changes an existing one.

HTTP method

PUT

Resource URI

https://server_host_name:port_number/
api/sam/vmmanagers?token=token

Request Content-Type

application/json

Response Content-Type

application/json

Normal HTTP response

200 - OK

codes
Error HTTP response codes

400 – "Bad Request" if a query parameter con

tains errors or is missing
401 – "Unauthorized" if the user does not have

the Manage VM Managers and Servers permis
sion
403 – "Forbidden" if the computer where the

central VM Manager tool is installed does not be
long to the computer group that the user is as
signed
500 – "Internal Server Error" if no VM Man

ager tool is defined in the BigFix Inventory data
base. The code might also indicate an unknown
problem that requires contacting BigFix support.

Note: The backslash character is a reserved character and can not be used in JSON.
It must be properly escaped to be used in strings. Replace Backslash with \\. It
applies to all fields in the API.

Request attributes
Table 316. Request attributes
Attribute

Description

login

User name that is used to access the VM manager.

password

Password that is used to access the VM manager. The
password is encrypted after it is sent.

protocol

Communication protocol used by the VM manager. The
attribute is applicable only for Hyper-V.
• 0 - WinRM
• 1 - PowerShell

sharecredentials

Indicates whether the VM manager shares credentials
with other hosts in the same cluster. The attribute is
applicable only for Hyper-V.
• true - the VM manager shares the credentials
and it is not necessary to specify them
• false - the VM manager does not share the cre
dentials

type

Type of the VM manager.
• 1 - Hyper-V
• 2 - vCenter

Table 316. Request attributes (continued)
Attribute

Description
• 3 - RHV-M
4 - Citrix Hypervisor (formerly XenServ

•
er)
url

Web address of the VM manager. You can specify a full
URL, a host name, or an IP address. The default URL
differs depending on the virtualization type.
• vCenter
◦ https://<vCenter_IP_address>/sdk/
vimService.wsdl

• RHV-M
◦ https://<RHV-M_IP_address>/ovirt-engine/api

• Hyper-V
◦ https://<Hyper-V_IP_address>/wsman
vmmanagerid

ID of the VM manager that you want to change. To ob
tain the ID, use REST API for the retrieval of VM man
agers.

vmmanagertoolid

ID of the VM Manager tool that collects data from the
VM manager that you want to change. To obtain the ID,
use REST API for the retrieval of VM managers.

Example HTTP conversation - adding a VM manager
To add a new VM manager, provide the following attributes:
• login
• password
• url
• type

Request
PUT http://localhost:9081/api/sam/vmmanagers
?token=7adc3efb175e2bc0f4484bdd2efca54a8fa04623
[
{
"login":"user1",
"password":"vZaW1Ve6",
"url":"192.0.2.24",
"type":2
}
]

Response
200 OK

Example HTTP conversation - changing a VM manager
To change an existing VM manager, provide the following attributes:
• login
• password
• url
• type
• vmmanagerid
• vmmanagertoolid
Important: All attributes must be provided in the request regardless of how many of
the attributes you want to change.
Request
PUT http://localhost:9081/api/sam/vmmanagers
?token=7adc3efb175e2bc0f4484bdd2efca54a8fa04623

[
{
"vmmanagerid":1,
"vmmanagertoolid":1,
"login":"user1",
"password":"vZaW1Ve6",
"url":"192.0.2.24",
"type":3
}
]

Response
200 OK

REST API for changing advanced server settings
Available from 9.2.3. You can change the parameters of the BigFix Inventory
server by using REST API.

Retrieval of the current values of advanced server settings
Available from 9.2.3. You use the GET operation on the api/sam/configs element
to request information about the current values of the BigFix Inventory server settings. The
output is returned in the JSON format.
Table 317. Operation descriptions
Operation details

Description

Operation

GET /api/sam/configs

Purpose

Returns information about the current values of the BigFix
Inventory server settings.

HTTP method

GET

Table 317. Operation descriptions (continued)
Operation details
Resource URI

Description
https://server_host_name:port_number/api/
sam/configs

URL link relation

n/a

URL query parameters

For a list of query parameters, see: Query parameters.

Request headers

Header
Accept-Language (optional)

Values
en-US (only English is supported)
Used to negotiate the language of the response. If this
header is not specified, the content is returned in the serv
er language.
Request payload
Request Content-Type
Response headers

n/a
Application/json

Header
Content-Type

Values
Application/json
Specifies the content type of the response.
Header
Content-Language

Values
en-US, …

Table 317. Operation descriptions (continued)
Operation details

Description
Specifies the language of the response content. If this
header is not specified, the content is returned in the serv
er language.

Response payload

configs element

Response Content-Type

Application/json

Normal HTTP response codes n/a
Error HTTP response codes

n/a

Query parameters
The following table presents query parameters that you can use for the configs element.
Table 318. Query parameters for retrieving current values of server settings
The table consists of four columns and two rows.
Parameter
name

Description

Required

Value

Returns the configuration of a single pa No

Name of the para

rameter. For a complete list of possible

meter

values and their explanation, see: Ad
vanced server settings.
token

A unique user authentication identifier.

Yes

Example HTTP conversation
Checking the current value of all parameters.
Request
GET https://localhost:9081/api/sam/configs?token=
7adc3efb175e2bc0f4484bdd2efca54a8fa04623

Alphanumeric

Excerpt for the response body (JSON)
[
{"valueMax":10080,
"valueMin":0,
"valueType":"minutes",
"name":"vmman_transfer_period","value":"720"},

{"valueType":"boolean",
"name":"vmman_check_uniqueness_enabled",
"value":"true"},

{"valueType":"boolean",
"name":"blockUiBundlingComputations",
"value":"false"},

{"valueMax":10080,
"valueMin":0,
"valueType":"minutes",
"name":"catalog_download_task_stagger_interval",
"value":"0"},

{"valueType":"boolean",
"name":"storeHwDataForAllVMManagerNodes",
"value":"false"},
]

Checking the current value of a single parameter.
Request
GET https://localhost:9081/api/sam/configs?token=
7adc3efb175e2bc0f4484bdd2efca54a8fa04623&name=maxVMManagerInacti
vity

Response body (JSON)
[
{"valueMax":90,
"valueMin":1,
"valueType":"days",
"name":"maxVMManagerInactivity",
"value":"3"}
]

Configuration of advanced server settings
Available from 9.2.3. You use the PUT operation on the api/sam/configs element
to change the values of the BigFix Inventory server settings.
You must be an Administrator to perform this task.
Table 319. Operation descriptions
Operation details

Description

Operation

PUT /api/sam/configs

Purpose

Changes the current value of a server setting.

HTTP method

PUT

Resource URI

https://server_host_name:port_number/api/
sam/configs

URL link relation

n/a

URL query parameters

For a list of query parameters, see: Query parameters.

Request headers

Header
Accept-Language (optional)

Values
en-US (only English is supported)

Table 319. Operation descriptions (continued)
Operation details

Description
Used to negotiate the language of the response. If this
header is not specified, the content is returned in the
server language.

Request payload

n/a

Request Content-Type
Response headers

application/x-www-form-urlencoded

Header
Content-Language

Values
en-US, …
Specifies the language of the response content. If this
header is not specified, the content is returned in the
server language.
Response payload

n/a

Response Content-Type

n/a

Normal HTTP response

204

codes
Error HTTP response codes

400 - "Bad Request" if the provided value is

invalid. For example, it is out of range or has a
wrong type.
404 - "Not Found"

Query parameters
The following table presents query parameters that you can use for the configs element.

Table 320. Query parameters for changing current values of server settings
Parameter
name

Description
Specifies the parameter whose value

Required
Yes

is to be changed. For a complete list of

Value
Name of the para
meter

possible values and their explanation,
see: Advanced server settings.
token

A unique user authentication identifier.

Yes

Alphanumeric

value

Specifies the new value of the parame

Yes

Value that is within

ter.

the range specific
for the parameter.

Example HTTP conversation
Request
PUT http://localhost:9981/api/sam/configs
?token=7adc3efb175e2bc0f4484bdd2efca54a8fa04623&name=
maxVMManagerInactivity&value=30

REST API for setting and deleting the end of support date
Available from 9.2.11. You can set and delete the end of support date for any
software component by using REST API.

Setting the end of support date for software components
Available from 9.2.11. You use the POST operation on the sam/
component_lifecycles element to set the end of support date for software components.

The end of support date is added on the Products &Metrics report. If you want to change
the end of support date, you must first delete the current date and then set a new one by
using this API.

Permissions
You must have the Manage Catalogs permission to use this API.

Resource URL
https://hostname:port/sam/component_lifecycles?token=token

Note: The URL is going to change in the future. If you are going to use it for
integration, check for updates in future releases.

Resource information
Table 321. Resource information
Operation details
HTTP method
Request headers

Description
POST

Header
Accept-Language (optional)

Values
en-US (only English is supported)
Negotiates the language of the response. If the header
is not specified, the content is returned in the server lan
guage.
Header
Content-Type

Values
application/json

Specifies the content type of the request.
Request format

application/json

Table 321. Resource information (continued)
Operation details
Request payload

Description
{ "component_lifecycle": { "eos_date": "YYYY-MMDD", "software_component_id": "software_component_id"} }

Response headers

Header
Content-Type

Values
application/json

Specifies the content type of the response.
Header
Content-Language

Values
en-US, …
Specifies the language of the response content. If the
header is not specified, the content is returned in the serv
er language.
Response format

application/json

Response codes

200 – OK
422 – "Unprocessable entity" if a parameter contains

errors or is missing

Example conversation - setting end of support date for a software
component
1. To retrieve information about the software component ID for which you want to set
the end of support date, perform the following steps:
a. Log in to BigFix Inventory.
b. Go to Reports > Software Components.
c. Hover over the component name and check the URL address at the bottom of
the page. The software component ID is a number at the end of the URL. For
example: sam/catalog/software_components/10379
2. To set the end of support date, use the following POST request.
Request header
POST sam/component_lifecycles?token=7adc3efb175e2bc0f4484bd
d2efca54a8fa04623
Host: localhost:9081
Accept: application/json
Accept-Language: en-US

Request Body
{ "component_lifecycle":
{
"eos_date": "2020-12-22",
"software_component_id": "10379"}
}

Response Header
200 - OK

Response Body
{
"created_at": "2018-01-26T10:30:06Z",

"detailed_version": null,
"eos_date": "2020-12-23",
"id": 2,
"is_release": true,
"software_component_id": 10379,
"source_id": 1,
"source_type": 0,
"updated_at": "2018-01-26T10:30:06Z"
}

Deleting the end of support date for software components
Available from 9.2.11. You use the DELETE operation on the sam/
software_components/software_component_id/component_lifecycles/ element to

remove the end of support date for a software component.

Permissions
You must have the Manage Catalogs permission to use this API.

Resource URL
https://hostname:port/sam/software_components/software_component_id/
component_lifecycles?token=token

Resource information
Table 322. Resource information
Operation details
HTTP method
Request headers

Description
DELETE

Header
Accept-Language (optional)

Values

Table 322. Resource information (continued)
Operation details

Description
en-US (only English is supported)
Negotiates the language of the response. If the header
is not specified, the content is returned in the server lan
guage.

Request format
Response headers

application/json

Header
Content-Type

Values
application/json

Specifies the content type of the response.
Header
Content-Language

Values
en-US, …
Specifies the language of the response content. If the
header is not specified, the content is returned in the serv
er language.
Response format

application/json

Response codes

200 – OK

Example conversation - clearing the end of support date for a software
component
1. To retrieve information about the software component ID for which you want to clear
the end of support date, perform the following steps:
a. Log in to BigFix Inventory.
b. Go to Reports > Software Components.
c. Hover over the component name and check the URL address at the bottom of
the page. The software component ID is a number at the end of the URL. For
example: sam/catalog/software_components/10379
2. To remove the end of support date, use the following DELETE request.
Request header
DELETE sam/software_components/10379/component_lifecycles?t
oken=7adc3efb175e2bc0f4484bdd2efca54a8fa04623
Host: localhost:9081
Accept: application/json
Accept-Language: en-US

Response
200 - OK

REST API for adding and removing tags
Available from 9.2.14. You can add and remove tags for any software component
by using REST API.

Adding tags for software components
Available from 9.2.14. You use the POST operation on the api/sam/v2/tags/
software_components element to add tags for software components.

Permissions
You must have the Manage Catalogs permission to use this API.

Resource URL
https://hostname:port/api/sam/v2/tags/software_components?token=token

Resource information
Table 323. Resource information
Operation details
HTTP method
Request headers

Description
POST

Header
Accept-Language (optional)

Values
en-US (only English is supported)
Negotiates the language of the response. If the header
is not specified, the content is returned in the server lan
guage.
Request format

application/x-www-form-urlencoded

Request payload

ids=id_1, id_2, id_3&tags=tag_1, tag_2, tag_3

Response headers

Header
Content-Type

Values
application/json

Specifies the content type of the response.
Header
Content-Language

Values
en-US, …

Table 323. Resource information (continued)
Operation details

Description
Specifies the language of the response content. If the
header is not specified, the content is returned in the serv
er language.

Response format

application/json

Response codes

200 – OK
400 – Bad request

Example conversation - adding tags for the selected software components
Note: The length of a single tag is limited to 254 characters.
Request
POST api/sam/v2/tags/software_components?token=7adc3efb175e2bc0f
4484bdd2efca54a8fa04623&ids=1,2,3&tags=tag1,tag2
Host: localhost:9081
Accept: application/json
Accept-Language: en-US

Response
{
"updated_components": 3
}

Removing tags for software components
Available from 9.2.14. You use the DELETE operation on the api/sam/v2/tags/
software_components element to remove the previously added tags.

Permissions
You must have the Manage Catalogs permission to use this API.

Resource URL
https://hostname:port/api/sam/v2/tags/software_components?token=token

Resource information
Table 324. Resource information
Operation details
HTTP method
Request headers

Description
DELETE

Header
Accept-Language (optional)

Values
en-US (only English is supported)
Negotiates the language of the response. If the header
is not specified, the content is returned in the server lan
guage.
Request format

application/x-www-form-urlencoded

Request payload

ids=id_1, id_2, id_3&tags=tag_1, tag_2, tag_3

Response headers

Header
Content-Type

Values
application/json

Specifies the content type of the response.
Header
Content-Language

Table 324. Resource information (continued)
Operation details

Description
Values
en-US, …
Specifies the language of the response content. If the
header is not specified, the content is returned in the serv
er language.

Response format

application/json

Response codes

200 – OK
400 – "Bad request"

Example conversation - removing tags for the selected software components
Note: The length of a single tag is limited to 254 characters.
Request
DELETE api/sam/v2/tags/software_components?token=7adc3efb175e2bc
0f4484bdd2efca54a8fa04623&ids=1,2,3&tags=tag1,tag2
Host: localhost:9081
Accept: application/json
Accept-Language: en-US

Response
{
"updated_components": 3
}

REST API for export and import of saved report views
You can use REST API requests to export a saved report view from one instance of BigFix
Inventory and import it to another instance of the application.

Exporting and importing a saved report view
To export a saved report view to another instance of BigFix Inventory, check the ID of the
report view in the source instance of BigFix Inventory. Then, use the GET operation to
retrieve the definition of the saved report view. Next, use the POST operation to import it to
another instance of BigFix Inventory.
The following procedure uses cURL command-line tool for negotiating API requests.
1. Check the identifier of the saved report view.
a. Log in to the instance of BigFix Inventory from which you want to export the
saved report view.
b. In the top navigation bar, click Reports > Saved Reports. Open the saved report
view and check the last number in the report URL.
In the following example, the report ID is 2.
http://server_host_name:port_number/
sam/pvuonlysubcapreports#32fe0f54dc719893faacc1d0f38a0c9045863729
/2

2. Obtain API tokens from both instances of BigFix Inventory.
a. Hover over the User icon

, and click Profile.

b. In the API Token line, click Show token.
3. Open the command line interface and change to the location where cURL is installed.
4. To export the report view, use the following GET request:
curl -o C:\saved_reports\report_definitions\pvu_subcapacity.txt
-X GET server_host_name:port_number/api/reports/report_ID?
token=5edd5aey7cd91467h08450bc258c31f0ce706543

Where:
-o
Specifies the path to the file where the definition of the saved report
view is to be saved.
-X
Specifies the type of HTTP request.
report_ID
Specifies the identifier of the saved report view that is to be exported.
If the request is successful, the following message is displayed:
HTTP/1.1 200 OK

5. To import the saved report view to another instance of BigFix Inventory, use the
following POST request:
curl -H "Content-Type: application/json"
-X POST -d "@C:\saved_reports\report_definitions\pvu_subcapacity.txt"
server_host_name:port_number/api/reports?
token=5cd3gh78499496e89a3246ab343474e85d8bc8fc

Where:
-H
Specifies the header of the request.
-X
Specifies the type of HTTP request.
-d
Specifies the path to the file where the definition of the saved report
view was saved.
The saved report view was imported to the target instance of BigFix Inventory.

Export of saved report views
You use the GET operation on the api/reports/report_ID element to export a saved report
view which can be then imported to another instance of BigFix Inventory.
Table 325. Operation descriptions
Operation details

Description

Operation

GET /api/reports/report_ID

Purpose

Returns the saved report view with the specified ID.

HTTP method

GET

Resource URI

https://server_host_name:port_number/api/
reports/report_ID

URL link relation

n/a

URI query parameters

For a list of applicable query parameters, see: Query para
meters.

Request headers

Header
Accept-Language (optional)

Values
en-US (only English is supported)
Used to negotiate the language of the response. If this
header is not specified, the content is returned in the serv
er language.
Request payload
Request Content-Type
Response headers

n/a
Application/json

Header
Content-Type

Values

Table 325. Operation descriptions (continued)
Operation details

Description
Application/json

Specifies the content type of the response.
Header
Content-Language

Values
en-US, …
Specifies the language of the response content. If this
header is not specified, the content is returned in the serv
er language.
Response payload

Saved reports element

Response Content-Type

Application/json

Normal HTTP response codes

200 – OK

Error HTTP response codes

401- There is no match for the provided user
name and password
401 - You are not assigned a Computer Group.
You will not be able to access the system until you are assigned a valid Computer
Group. Contact your administrator for assistance
404 - Sequel::RecordNotFound

For more details about each error code, check the
tema.log log file in the install_dir/wlp/usr/
servers/server1/logs/ directory.

Query parameters
You can use query parameters to narrow down the results of your search. The following
table presents query parameters that you can use for the api/reports element.
Table 326. Query parameters for retrieving saved report views
Re
Parameter

Description

quired

Value

token

A unique user authentication identifier.

Yes

Alphanumeric

id

An identifier of the saved report. To find

No

Numeric

the report identifier, open the saved re
port and check the last number in the re
port URL. In the following example, the re
port ID is 3.
server_host_name:port/
sam/app_usage_property_values#ca
fcac39cd0b242b82729377b0b2b872d3
af8d8a/3

Example HTTP conversation
Request
GET/api/reports/1
&token=a070afeca411d2fs25f5s4c962de2d002b14352f

Response header
HTTP/1.1 200 OK
Content-Type: Application/json
Content-Language: en-US

Response body (JSON)

{
"id":1,
"user_id":1,
"pagestate_id":"eb5743b7cd23316f0bc8a4dd3f63b90d73549042",
"name":"pvu_test",
"path":"/sam/pvuonlysubcapreports",
"private":true,
"state":{
"columns":["product","quantity","hwm_history"],
"criteria":{"and":[["quantity",">","200"]]},
"grid_options":["autosize_columns"],
"order":{"asc":true,"col":null},
"time_range":{
"max":"2014-07-21T10:18:04Z",
"min":"2014-04-21T22:00:00Z",
"type":"absolute_to_now",
"units":"days",
"value":"90"
},
"column_order":{
"hwm_history":1,
"product":0,
"quantity":2
},
"column_widths":{
"hwm_history":180,
"product":524,
"quantity":719
}}}

Import of saved report views
You use the POST operation on the api/reports element to import a saved report view from
another instance of BigFix Inventory.
Table 327. Operation descriptions
Operation details

Description

Operation

POST /api/reports

Purpose

Imports a saved report view from another instance of Big
Fix Inventory.

HTTP method

POST

Resource URI

https://server_host_name:port_number/api/
reports

URL link relation

n/a

URI query parameters

For a list of applicable query parameters, see: Query para
meters.

Request headers

Header
Accept-Language (optional)

Values
en-US (only English is supported)
Used to negotiate the language of the response. If this
header is not specified, the content is returned in the serv
er language.
Request payload
Request Content-Type
Response headers

Saved reports element
Application/json

Header
Content-Type

Values

Table 327. Operation descriptions (continued)
Operation details

Description
Application/json

Specifies the content type of the response.
Header
Content-Language

Values
en-US, …
Specifies the language of the response content. If this
header is not specified, the content is returned in the serv
er language.
Response payload

n/a

Response Content-Type

Application/json

Normal HTTP response codes

200 – OK

Error HTTP response codes

401- There is no match for the provided user
name and password
401 - You are not assigned a Computer Group.
You will not be able to access the system until you are assigned a valid Computer
Group. Contact your administrator for assistance.
404 - Not Found
404 - Sequel::RecordNotFound
500 - Name is already taken
500 - There was a problem with your request
500 - We're sorry, but something went wrong.
Please contact your BigFix Analytics administrator if the problem persists

Table 327. Operation descriptions (continued)
Operation details

Description
500 if the JSON format is invalid, a detailed mes

sage with the problem explanation is also returned.
For example, if a name field is missing, the follow
ing message is displayed: The property '#/' did
not contain a required property of 'name' in
schema 69e40f9b-9a3e-53d1-a7d8-61d63eb191e8#

For more details about each error code, check the
tema.log log file in the install_dir/wlp/usr/
servers/server1/logs/ directory.

Query parameters
You can use query parameters to narrow down the results of your search. The following
table presents query parameters that you can use for the api/reports element.
Table 328. Query parameters for retrieving saved report views
Re
Parameter
token

Description
A unique user authentication identifier.

quired
Yes

Value
Alphanumeric

Example HTTP conversation
Request header
Content-Type: application/json
Content-Language: en-US

Request
POST /api/reports?token=465c33848de3db7ch5699023ea22deb5b1a476d1
{
"id":4,

"user_id":2,
"pagestate_id":"7ebb0b0a018ab55fab8e6e40d5eb62529ea38fad",
"name":"pvu_report",
"path":"/sam/pvuonlysubcapreports",
"private":true,
"state":{
"columns":["product","quantity","hwm_history"],
"criteria":{"and":[["quantity",">","200"]]},
"grid_options":["autosize_columns"],
"order":{
"asc":true,
"col":"quantity"
},
"time_range":{
"max":"2014-07-21T10:18:04Z",
"min":"2014-04-21T22:00:00Z",
"type":"absolute_to_now",
"units":"days",
"value":"90"
},
"column_order":{
"hwm_history":1,
"product":0,
"quantity":2
},
"column_widths":{
"hwm_history":180,
"product":524,
"quantity":719
}}}

Response

HTTP/1.1 200 OK

REST API for updating the Oracle core factor
Available from 9.2.8. You use the PUT operation on the api/v1/servers element to
change the processor core factor that is applied to a group of servers for the purpose of
calculating utilization of the Oracle Processor Core metric.

Permissions
You must have the Manage Hardware Inventory permissions to use this API.

Resource URL
https://hostname:port/api/v1/servers?token=token

For more information about using the REST API, see: Changing the Oracle core factor
through REST API.

Resource information
Table 329. Resource information
Operation details
HTTP method
Request headers

Description
PUT

Header
Accept-Language (optional)

Values
en-US (only English is supported)
Negotiates the language of the response. If the header
is not specified, the content is returned in the server lan
guage.
Request format

application/json

Table 329. Resource information (continued)
Operation details
Request payload
Response headers

Description
Oracle Core Factors element

Header
Content-Type

Values
application/json

Specifies the content type of the response.
Header
Content-Language

Values
en-US, …
Specifies the language of the response content. If the
header is not specified, the content is returned in the serv
er language.
Response format

application/json

Response codes

200 – OK
400 – "Bad Request" if a query parameter contains er

rors or is missing
401 – "Unauthorized" if the user is not authorized to per

form the operation
422 – "Unprocessable Entity" if the request is well-

formed but cannot be processed due to semantic errors

Available columns
Table 330. Available columns
Column
server_id

Description
ID of the server for which you want to change the
core factor.

Re
quired
✓

Type
Nu
mer
ic

oracle_core_factor

Oracle core factor that you want to assign to server.

Example conversation
Request header
Content-Type: application/json
Content-Language: en-US

Response body
POST api/v1/servers?token=465c33848de3db7ch5699023ea22deb5b1a476
d1
{
"oracle_core_factors":
[
{
"server_id": 1,
"oracle_core_factor": 1.0
},
{
"server_id": 2,
"oracle_core_factor": 1.5
}
]}

✓

Float

REST API for managing license metrics
Use REST API requests to retrieve, create, change, and delete license metrics. From version
10.0.5, you can also manage metrics through the UI. See also, managing license metrics
through UI.

Retrieval of license metrics
Use GET operation on api/sam/v2/metrics element to request information about license
metrics defined or present in BigFix Inventory.
You must have the View Contracts and Manage Contracts permissions to use the api/
sam/v2/metrics API.

Table 331. Operation descriptions
Operation details

Descriptions

Operation

GET api/sam/v2/metrics

Purpose

Returns list of license metrics and their details

HTTP method

GET

Resource URI

https://server_host_name:port_number/api/sam/
v2/metrics?token=token

Request content-type

application/json

Response content-type

application/json

Normal HTTP response codes

200-ok

Response attributes
Table 332. Response attributes and their possible values
Attribute
id

Possible values
Identifier of the license metric. For explanation
of the returned values, see: Metric IDs and code
names.

Table 332. Response attributes and their possible values (continued)
Attribute
code_name

Possible values
Code name of the license metric. For explanation
of the returned values, see: Metric IDs and code
names.

display_name

Name of the license metric.

source_type

Source type of license metric. Value 2 means a
custom metric and Values 0 and 1 mean a prede
fined metric.

source_id

Source id of license metric

Example HTTP conversion
Request
https://localhost:9081/api/sam/v2/metrics?token=6b884e39d8d34e05
192c5d72dd6739607293b828

Response
{
"total": 3,
"rows": [
{
"id": -32603,
"code_name": "CONCURRENT_USER",
"display_name": "Concurrent User",
"source_type": 1,
"source_id": 27
},
{
"id": -32470,
"code_name": "VU_VALUE_UNIT",

"display_name": "VU Value Unit",
"source_type": 1,
"source_id": 32
},
{
"id": -32337,
"code_name": "APPSERVER_CONNECTED",
"display_name": "AppServer Connected",
"source_type": 1,
"source_id": 108
}
]
}

Adding and updating license metrics
Adding license metrics
Use POST operation on api/sam/v2/metrics element to create new license metric.
Table 333. Operation descriptions for creating metric using POST operation
Operation details

Description

Operation

POST api/sam/v2/metrics

Purpose

Creates new license metric

HTTP method

POST

Resource URI

https://hostname:port/api/sam/v2/metrics?
code_name=code_name&display_name=display_
name&token=token

Request content-type

application/json

Response content-type

application/json

Table 333. Operation descriptions for creating metric using POST operation
(continued)
Operation details

Description

Normal HTTP response codes

200-ok

Error HTTP response codes

400 – "Bad Request" if a query parameter contains
errors or if the metric with same metric code name
or display name already present

Response attributes
Table 334. Response attributes and their possible values
Attribute

Possible values

code_name

Code name of the metric, which is created

display_name

Name of the metric created.

source_type

Source type of license metric created.

source_id

Source id of license metric created.

error

Reason for creation of metric failure.

Example HTTP conversation
Note:
• Maximum length allowed for code_name and display_name attributes is 254.
• Attribute code_name should not have any spaces in between the words and
can use "_" as word separator. All letters should be in upper case.

1. Create metric using POST operation
Request

POST https://localhost:9081/api/sam/v2/metrics?code_name=ME
TRIC_POST&display_name=DISPLAY&token=6b884e39d8d34e05192c5d
72dd6739607293b828

Response

200 ok
Response body (JSON)
{
"id": 32468,
"code_name": "METRIC_POST",
"display_name": "DISPLAY",
"source_type": 2,
"source_id": 32468
}

2. Creation of metric failed. Metric already exist.
Request
POST
https://localhost:9081/api/sam/v2/metrics?code_name=METRIC_
POST&display_name=DISPLAY&token=6b884e39d8d34e05192c5d72dd6
739607293b828

Response
400 Bad Request
Response body (JSON)
{
"error":

"Metric already present"

}

3. Creation of metric failed. Incorrect code name or display name.
Request

POST
https://localhost:9081/api/sam/v2/metrics?code_name=metric_
post&display_name=DISPLAY&token=6b884e39d8d34e05192c5d72dd6
739607293b828

Response
400 Bad Request
Response body (JSON)
{
"error": "Metric code name or display name not proper"
}

Updating license metrics
Use PUT operation on api/sam/v2/metrics element to update display name of already
existing metric.
Table 335. Operation descriptions for updating metric display name using PUT
operation
Operation details

Description

Operation

PUT api/sam/v2/metrics

Purpose

Updates metric display name for existing metric

HTTP method

PUT

Resource URI

https://hostname:port/api/sam/v2/metrics?
code_name=code_name&display_name=display_
name&token=token

Request content-type

application/json

Response content-type

application/json

Normal HTTP response codes

200-ok

Table 335. Operation descriptions for updating metric display name using PUT
operation (continued)
Operation details
Error HTTP response codes

Description
400 – "Bad Request" metric does not exist or display
name length given to for update is greater than 254
403 – “Forbidden”, trying to update non custom met
ric, which has source_type other than 2

Response attribute
Table 336. Response attributes and their possible values
Attribute

Possible values

code_name

Code name of the metric, for which update sent.

display_name

Updated name of the metric.

source_type

Source type of license metric updated.

source_id

Source id of license metric updated.

error

Reason for display name update fail.

Example HTTP conversion
1. Update metric using PUT operation
Request
PUT
https://localhost:9081/api/sam/v2/metrics?code_name=CONCURR
ENT_USER&display_name=Updatedvalue&token=6b884e39d8d34e0519
2c5d72dd6739607293b828

Response

200 ok
Response body (JSON)
{
"id": 27,
"code_name": "CONCURRENT_USER",
"display_name": "Updated value",
"source_type": 1,
"source_id": 27
}

2. Metric update failed. Metric does not exist.
Request
PUT
https://localhost:9081/api/sam/v2/metrics?code_name=NOT_PRE
SENT&display_name=DISPLAY&token=6b884e39d8d34e05192c5d72dd6
739607293b828

Response
400 Bad Request
Response body (JSON)
{
"error": "Metric does not exist"
}

3. Metric update failed. Display name length is more than 254.
Request
PUT
https://localhost:9081/api/sam/v2/metrics?code_name=CONCURR
ENT_USER&display_name=AAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAA
AAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAA
AAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAA
AAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAA

AAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAA 2&token=6b884e39
d8d34e05192c5d72dd6739607293b828

Response
400 Bad Request
Response body (JSON)
{
"error": "Display name length is too long"
}

4. Metric update failed. Attempt to update non-custom metric.
Request
https://localhost:9081/api/sam/v2/metrics?code_name= VU_VAL
UE_UNIT &display_name=Updatedvalue&token=6b884e39d8d34e0519
2c5d72dd6739607293b828

Response
403 Forbidden
Response body (JSON)
{
"error": "VU_VALUE_UNIT metric update not allowed"
}

Deleting license metric
Use DELETE operation on api/sam/v2/metrics element to delete license metric.
Table 337. Operation descriptions for creating metric using DELETE operation
Operation details

Description

Operation

DELETE api/sam/v2/metrics

Purpose

Deletes new license metric

Table 337. Operation descriptions for creating metric using DELETE operation
(continued)
Operation details

Description

HTTP method

DELETE

Resource URI

https://hostname:port/api/sam/v2/metrics?
code_name=code_name&token=token

Request content-type

application/json

Response content-type

application/json

Normal HTTP response codes

200-ok

Error HTTP response codes

400 – "Bad Request" if the metric not present
403- “Forbidden” if the metric is non custom metric,
having source_type value other than 2

Response attributes
Table 338. Response attributes and their possible values
Attribute

Possible values

error

Reason for metric deletion failure

Example HTTP conversation
1. Metric deleted successfully
Request
DELETE
https://localhost:9081/api/sam/v2/metrics?code_name=TEST&to
ken=6b884e39d8d34e05192c5d72dd6739607293b828

Response

200 ok
Response body (JSON)
{
}

2. Delete metric failed
Request
DELETE
https://localhost:9081/api/sam/v2/metrics?code_name=TEST&to
ken=6b884e39d8d34e05192c5d72dd6739607293b828

Response
400 Bad Request
Response body (JSON)
{
"error": "Metric does not exist"
}

3. Delete non-custom metric failed
Request
DELETE
https://localhost:9081/api/sam/v2/metrics?code_name= VU_VAL
UE_UNIT&token=6b884e39d8d34e05192c5d72dd6739607293b828

Response
Response
403 Forbidden
Response body (JSON)
{
"error": "VU_VALUE_UNIT metric delete not allowed"
}

REST API for managing contracts
With the /api/sam/v2/contracts.json API, you can import and export contract data with
purchase information. This operation is used to automate integration with external purchase
systems. You can also manage contracts using: contracts CSV import, user interface - All
Contracts panel and deprecated contracts migration.
Check the limitations of Adding and updating contracts before using the API.

Permissions
You must have Manage Contracts permission along with access to the computer group
of the contract.

Resource URL
https://hostname:port/api/sam/v2/contracts?token=<token>

Syntax
GET /api/sam/v2/contracts.json

Schema description
/api/sam/v2/schemas/contract.json

Association
• computer_group
• metric
• purchase_order
• software_product

Available columns
Column name
contract_id

Description
Identifier of contract.

Importance
Required

Column name

Description

Importance

• A contract is updated
only when a contract
ID is available.
• Contract ID must be
unique among all
contracts.
• On UI, it is generated
automatically.
Type: String
name

Name of the contract.

Optional

Type: String
type

Type of the contract: 1 - Li

Optional

cense, 2 - Support, 3 - Ser
vice, 4 - Hardware, 5 - Oth
er.
Type: Integer
threshold

Threshold for the contract

Optional

measured value. It is op
tional.
Type: Integer
computer_group

Contract's computer group

Optional

object. To check the list of
computer group columns,
see, computer_group.
metric

Contract's metric group ob Optional
ject. To check the list of

Column name

Description

Importance

metric columns, see, met
ric.
purchase_order

Array of purchase orders

Optional

assigned to the contract.
To check the list of pur
chase order columns, see,
purchase_orders.
software_products

Array of software products

Optional

assigned to the contract.
To check the list of soft
ware product columns, see,
software_product.
Note: All associations, computer_group, metric, purchase_order, and
software_product are optional. If computer_group association is not provided and
contract is being created, All Computers group is used.

Available metrics
For a list of available metric, refer to Metric IDs and code names and 10.0.4 REST API
for managing license metrics. Metrics not applicable to contracts are: INTERNAL_PVU,
INTERNAL_RVU_MAPC.
• If a column is not provided in the request for a contract, related contract's data is not
changed.
• To clear a field, use null value, such as "contract_custom_field_1": null, "threshold" null.
• If a request is invalid or an error occurs in processing, no contracts or related data
is updated, and in the response, detailed explanation is provided for each invalid
contract under "rowErrors". The entries numbering starts from 1.

{
"incorrectRows":7,
"allRows":7,
"message":{"code":"CODUI4099E","text":"Contract processing failed. The
contracts have not been imported."},
"rowErrors":{"1":["|CODUI4047E|Required field contract_id is empty",
"|CODUI4057E|Custom field with ID 2 is required"],"2":
[
"|CODUI4057E|Custom field with ID 2 is required"],
"3":
[
"|CODUI4042E|A contract with the specified contract ID already
exists",
"|CODUI4057E|Custom field with ID 2 is
required"],"4":["|CODUI4057E|Custom field with ID 2 is required"],
"5":["|CODUI4057E|Custom field with ID 2 is
required"],"6":["|CODUI4057E|Custom field with ID 2 is required"],
"7":["|CODUI4040E|A contract with the specified name and type already
exists"
]
}
}

Adding and updating contracts
Use /api/sam/v2/contracts.json API to add and update contracts.

PUT operation features
• The request does not delete contracts and it does not remove contract's purchase
orders or assignments to software. It merges data with the database content.
• The operation matches metric by ID, or by code name if metric ID not provided. It
creates a new metric if metric ID is not provided and metric code name is not found.
The new metric has the same display name as code name from the request.
• The operation does not create new software or publisher, unless createSoftware
parameter is set to true (createSoftware=true).
• The operation adds product-metric relation if needed.
• The operation matches computer group by ID, or by name if ID is not provided. In case
of no ID and no name, "All computers" group is used. Only computer groups of type
"Reporting" can be used in contracts.

Example HTTP conversations
PUT /api/sam/v2/contracts.json
Adds or updates contracts provided in request body in JSON format (the
format the same as the array under "rows" from GET request)
[
{
"contract_id":"CO1","name":"Contract1","type":2,"threshold":1
00,"metric":{"id":9,"code_name":"INTERNAL_INSTALL"},"computer_gr
oup":{"id":0,"name":"All Computers"}
"purchase_orders":[{"purchase_number":"PO1","quantity":5000,"e
ntitlement_start":"2021-08-03","entitlement_end":"2030-05-21"}
{
"purchase_number":"PO2","quantity":2,"entitlement_start":"203
0-05-21"
"entitlement_end":"2030-06-21"}],"software_products":
[
{"name":"Notepad++","publisher_name":"don.h@free.fr"}
]

}
]

Limitations
Note: The limitations are applicable in BigFix Inventory version 10.0.6.
• Error messages are displayed by default in language which is provided under "AcceptLanguage" header. The language selected in the user profile is not taken into account.
• Custom field values must be provided in text format, such as "123" for integer type.
This is not applicable to other fields.
• PUT operation does not support national characters, such as Latin alphabets. To
update or add contract data containing such characters, use CSV import or import
using the UI. See also, Importing contracts.
• Only ASCII characters in contracts data are fully supported in BigFix Inventory version
10.0.6. The issue is not applicable since version 10.0.7. From BigFix Inventory 10.0.7,
software which contains non-ASCII characters are accepted in contracts REST API,
as well as in the search field on UI, and contract fields like contract name in REST API
can contain non-ASCII characters.

Error codes
CODUI4040E=A contract with the specified name and type already exists
CODUI4041E=Some of the selected products are not assigned to the selected
metric
CODUI4042E=A contract with the specified contract ID already exists
CODUI4043E=Purchase order numbers are not unique in this contract
CODUI4044E=Element {0} is missing in this contract
CODUI4045E=Incorrect JSON format. An array is expected.
CODUI4046E=Incorrect JSON format. The element at row {0} is not an object.
CODUI4047E=Required field {0} is empty
CODUI4048E=Required field {0} at row {1} is empty
CODUI4049E=Contract custom field with ID {0} does not exist

CODUI4050E=Product and publisher pair at row {0} is not found. Creating
software option is not enabled.
CODUI4051E=Metric ID is not found
CODUI4052E=Specified metric code name is invalid. The field must contain up
to 254 characters and can contain only uppercase letters, numbers, and the
following characters: "-_".
CODUI4053E=Computer group with ID {0} is not accessible to the user or
target contract computer group does not exist
CODUI4054E=Ambiguous computer group name. More than one matching group is
found.
CODUI4055E=Field {0} at row {1} is too long. The maximal length is {2}.
CODUI4056E=Format of custom field with ID {0} is incorrect. Expected type:
{1}
CODUI4057E=Custom field with ID {0} is required
CODUI4058E=Invalid contract type. Correct values are: 1,2,3,4,5.
CODUI4059E=Invalid contract threshold. The value must be a positive
integer.
CODUI4060E=Field {0} is too long. The maximum length should be {1}.
CODUI4061E=Specified purchase order quantity at row {0} is invalid. The
value must be a positive integer or -1 for ELA.
CODUI4062E=Specified purchase order entitlement dates at row {0} are
invalid. End date cannot be before start date.
CODUI4063E=Format of field {0} at row {1} is incorrect. Expected type: {2}.
CODUI4064E=Software name at row {0} is already used by IBM bundle.
CODUI4065E=Software name at row {0} is already used by a software version
or release of the same publisher.
CODUI4066E=Software at row {0} cannot be assigned to both Unknown metric
and another metric.
CODUI4067E=Specified metric code name is not allowed.
CODUI4068E=Specified computer group name is not accessible to the user or
target contract computer group does not exist.

CODUI4098E=Data conversion error occurred at row {0}. Ensure all fields
have expected data types.
CODUI4099E=Contract processing failed. The contracts have not been
imported.

# For Contracts import from CSV
CODUI5040E=Incorrect number of columns at row {0}.
CODUI5041E=Invalid header: {0}.
CODUI5042E=Invalid number: {0} at row {1} in column {2}.
CODUI5043E=Missing required column: {0}.
CODUI5044E=All or none of the columns need to be provided: {0}.
CODUI5045E=The {0} column requires {1} column to be present.
CODUI5046E=Missing value at row {0} in column {1}.
CODUI5047E=Values need to be provided for all or none of {1} columns at row
{0}.

Retrieving contracts
Use /api/sam/v2/contracts.json API to retrieve contracts.

Example HTTP conversation
GET /api/sam/v2/contracts.json
{
"total":1,"rows":
[
{
"contract_id":"CO1","name":"Contract
1","type":2,"threshold":100,"metric":{"id":9,"code_name":"INTERN
AL_INSTALL"},
"computer_group":{"id":0,"name":"All
Computers"},"purchase_orders":[{"purchase_number":"PO1","quanti
ty":5000,"entitlement_start":

"2021-08-03","entitlement_end":"2030
-06-21"},{"purchase_number":"PO2","quantity":2,"entitlement_star
t":"2030-05-21","entitlement_end":"2030-06-21"}]
"software_products":[{"name":"Notepa
d++","publisher_name":"don.h@free.fr"}]}
]
}

GET /api/sam/v2/contracts.json?
columns[]=name&columns[]=contract_custom_field_1
{
"total":1,"rows":
[
{
"name":"Contract1","contract_custom_field_1":"Value of t
he custom field"
}
]
}

Note: Not all columns are displayed by default. To see the lists of available columns,
check the below topics:
• REST API for managing contracts
• Purchase orders association
• Software products association

Historical APIs
For some REST APIs, version 2 is created to provide improved functions or experience. In
such cases, the original API is deprecated and version 2 is supported. You must adjust your
custom tools or internal processes to the new version of these APIs.

Historical APIs include all APIs that you need to retrieve historical
information.
• REST API for retrieving computer systems, clusters, software instances, and license
usage
• REST API for software inventory management
• REST API for software classification
Note: The above APIs are not yet supported.

REST API for retrieving computer systems, clusters, software
instances, and license usage
You can use this REST API to quickly retrieve large amounts of data related to your
computer systems, clusters, software instances, and license usage. Once the data is
retrieved, it can be passed to other applications for further processing and analysis.
The following image represents the relations between all resources included in this REST
API:

Scenarios
Choose one of the scenarios to learn how to determine the license usage for all of your
computer systems or only for the selected ones. The first approach is recommended if you
want to retrieve your data in bulk and calculate the license usage for the whole environment.

The second one, however, allows you to quickly target specific information by retrieving data
for a chosen subset of computer systems.

Determining license usage for all computer systems
You can extract your data in bulk to determine total license usage for software on all your
computer systems. Instead of using reports in the application user interface, you can make
API requests to quickly retrieve large amounts of data.
• Each API request must be authenticated with the token parameter. You can retrieve
it by using REST API for retrieving authentication token. You can also log in to BigFix
Inventory, hover over the User icon

, and click Profile. Then, click Show token.

• To obtain the list of query parameters to narrow down your results and the list of
available columns, see the information related to a particular API type.
Performance considerations
• Retrieving large amounts of data might impact the performance of your environment,
therefore API should not be used together with other performance intensive tasks, like
data imports. For more information, see REST API considerations.
• Retrieve your data in pages rather then query for each computer ID separately. You
can make several API requests and use the limit and offset parameters to paginate
your results.
Note:
◦ For environments with approximately 200 000 endpoints, it is
recommended to retrieve your data in pages of 100 000 rows for
computer systems, 200 000 rows for software instances, and 300 000
rows for license usage. If you limit the first request to 100 000 results,
append the next request with the offset=100000 parameter to omit the

already retrieved records. Adjust the values according to the size of your
deployment.
◦ If you have a small number of endpoints, you can omit the limit and
offset parameters, and retrieve your data by using only one API request.
1. Retrieve the list of your computer systems:
https://hostname:port/api/sam/computer_systems?
token=token&limit=100000&offset=100000

Result: Each computer system has a different id. You can later use this id to create a
match between your software instances and computer systems.
{
"id": 182,
"parent_id": 175,
"type": "virtual",
"os": "Win2008R2 6.1.7601",
"host_name": "NC9128109187",
"dns_name": "NC9128109187",
"ip_address": [
"9.128.109.187"],
"last_seen": "2014-06-06T03:56:39Z",
"hardware_manufacturer": "-",
"hardware_model": "-",
"hardware_serial_number": "TLM_VM_4236ac43",
"processor_type": "Multi-core",
"processor_brand": "Xeon(R), 3 or 4 Socket",
"processor_vendor": "Intel(R)",
"processor_model": "E3-12xx, E7-28xx, E7-48xx",
"partition_cores": "1.0",
"server_processors": 1,
"server_cores": 1

}

2. Retrieve the list of your software instances. The software_title_name column that
allows you to recognize the name of your software is hidden by default, which means
that you have to append the URL with the columns[] parameter followed by the name
of a hidden column.
The following example retrieves the computer_system_id and software_title_name
columns so that you can recognize which software is installed on which computer
system. If you want to retrieve complete information, append the URL with the names
of all columns. You can find the column names in response body:
https://hostname:port/api/sam/software_instances?
token=token&limit=100000&offset=100000&
columns[]=computer_system_id&columns[]=catalog_dimension.software_titl
e_name

Result: Each software instance contains a computer_system_id column that
represents an ID of a computer that a particular instance is installed on. Use this
column to match your software instances with computer systems. For example, if
rows 152-155 contain a computer_system_id=182 column, it means that all those
software instances are installed on a computer system with ID 182.
{
"computer_system_id": 182,
"catalog_dimension": {
"software_title_name": "BigFix Inventory"
}

3. Retrieve the license usage information. Append the URL with the
software_title_dimension.name column to be able to recognize the name of the

software that the license usage is presented for.
The following example retrieves the computer_system_id, metric_name, peak_value,
and software_title_dimension.name columns. If you want to retrieve complete

information, append the URL with the names of all columns. You can find the column
names in response body:
https://hostname:port/api/sam/license_usages?
token=token&limit=100000&offset=100000&
columns[]=computer_system_id&columns[]=metric_name&columns[]=peak_valu
e&
columns[]=software_title_dimension.name

Result: Each record contains a computer_system_id column that represents an ID
of a computer for which the license usage is calculated. Use this column to match
the license usage with computer systems. For example, if rows 152-155 contain a
computer_system_id=182 column, it means that all those license usage records are

presented for a computer system with ID 182. The peak_value column represents
the peak license usage (over last 90 days) for a particular software title (which is
described by software_title_dimension.name). The metric_name column allows you
to recognize whether the license type is PVU or RVU, full or subcapacity.
{
"computer_system_id": 182,
"metric_name": "RVU_FULL_CAP",
"peak_value": 2,
"software_title_dimension": {
"name": "BigFix Inventory"
}},

{
"computer_system_id": 182,
"metric_name": "RVU_SUB_CAP",
"peak_value": 2,
"software_title_dimension": {
"name": "BigFix Inventory"
}}

4. Determine the total license usage for a software title by summing up the values
of all peak_value columns retrieved for this software title from all your computer
systems. For example, sum up all peak_values for BigFix Inventory on all computer
systems that contain entries for this particular software. Do not combine the metric
types, but calculate the PVU_FULL_CAP, RVU_FULL_CAP, PVU_SUB_CAP, and RVU_SUB_CAP
separately.

Determining license usage for selected computer systems
You can narrow down the results of your API requests to retrieve data only from selected
computer systems. This approach is recommended if you want to quickly target specific
information.
• Each API request must be authenticated with the token parameter. You can retrieve
it by using REST API for retrieving authentication token. You can also log in to BigFix
Inventory, hover over the User icon

, and click Profile. Then, click Show token.

• To obtain the list of query parameters to narrow down your results and the list of
available columns, see the information related to a particular API type.
1. Retrieve selected computer systems by querying for their ID:
https://hostname:port/api/sam/computer_systems?
token=token&criteria={"or":[["id","=","1"],["id","=","2"]]}

Result: Each computer system has a different id. You can later use this id to create
a match between your software instances and computer systems. In API for software
instances and license usage, this id is represented by the computer_system_id
column.
{
"id": 2,
"parent_id": 175,
"type": "virtual",
"os": "Win2008R2 6.1.7601",
"host_name": "NC9128109187",

"dns_name": "NC9128109187",
"ip_address": [
"9.128.109.187"],
"last_seen": "2014-06-06T03:56:39Z",
"hardware_manufacturer": "-",
"hardware_model": "-",
"hardware_serial_number": "TLM_VM_4236ac43",
"processor_type": "Multi-core",
"processor_brand": "Xeon(R), 3 or 4 Socket",
"processor_vendor": "Intel(R)",
"processor_model": "E3-12xx, E7-28xx, E7-48xx",
"partition_cores": "1.0",
"server_processors": 1,
"server_cores": 1
}

2. Retrieve software instances for selected computer systems by querying for their ID:
The following example retrieves the computer_system_id and software_title_name
columns so that you can recognize which software is installed on which computer
system. If you want to retrieve complete information, append the URL with the names
of all columns. You can find the column names in response body:
https://hostname:port/api/sam/software_instances?
token=token&
criteria={"or":[["computer_system_id","=","1"],["computer_system_id","
=","2"]]}
&columns[]=computer_system_id&columns[]=catalog_dimension.software_tit
le_name

Result: Each software instance contains a computer_system_id column that
represents an ID of a computer that a particular instance is installed on. Use this
column to match your software instances with computer systems. For example,
if rows 152-155 contain a computer_system_id=2 column, it means that all those
software instances are installed on a computer system with ID 2.

{
"computer_system_id": 2,
"catalog_dimension": {
"software_title_name": "BigFix Inventory"
}

3. Retrieve the license usage for selected computer systems by querying for their ID.
Append the URL with the software_title_dimension.name column to be able to
recognize the name of the software that the license usage is presented for.
The following example retrieves the computer_system_id, metric_name, peak_value,
and software_title_dimension.name columns. If you want to retrieve complete
information, append the URL with the names of all columns. You can find the column
names in response body:
https://hostname:port/api/sam/license_usages?
token=token&
criteria={"or":[["computer_system_id","=","1"],["computer_system_id","
=","2"]]}
&columns[]=computer_system_id&columns[]=metric_name&columns[]=peak_val
ue&
columns[]=software_title_dimension.name

Result: Each record contains a computer_system_id column that represents an ID
of a computer for which the license usage is calculated. Use this column to match
the license usage with computer systems. For example, if rows 152-155 contain a
computer_system_id=2 column, it means that all those license usage records are

presented for a computer system with ID 2. The peak_value column represents
the peak license usage (over last 90 days) for a particular software title (which is
described by software_title_dimension.name). The metric_name column allows you
to recognize whether the license type is PVU or RVU, full or subcapacity.
{
"computer_system_id": 2,
"metric_name": "RVU_SUB_CAP",

"peak_value": 2,
"software_title_dimension": {
"name": "BigFix Inventory"
}}

You retrieved the list of software instances that are installed on a particular computer
system, as well as the license usage that they generate. This information is only a part
of the total license usage generated on all your computer systems. To determine the
total license usage for your environment, see Determining license usage for all computer
systems.

Retrieval of computer systems
You use the GET operation on the api/sam/computer_systems element to request
information about computer systems in your infrastructure.
Important: This REST API is planned to be entirely substituted with api/sam/
v2/computers REST API. If you have custom tools or internal processes that are

based on api/sam/computer_systems REST API, it is best to adjust the tools to
use the new version of the API. For information, see: Mapping columns between
computer_systems and v2/computers REST API.
This API retrieves information about physical and virtual computer systems. Apart from
computers that have an BigFix client installed, it also includes host systems on which the
client is not deployed because some virtualization types do not allow for software to be
installed on the host level (VMware ESXi, IBM PowerVM, and so on). Data related to such
host computer systems must however be retrieved to build a proper hierarchy between the
server and its virtual machines and to correctly report the PVU and RVU utilization.
The type property determines whether a computer system is a host computer or a virtual
one. A host can be, for example, a virtualization server, ESX hypervisor, or a laptop with
agent installed. A virtual machine refers only to virtual machines that can be deployed on
a host. Because of this, you should not compare the outcome of the REST API with single
reports, especially with the Computers, and Hardware Inventory reports.

To retrieve information about your computer systems, use the following URL:
https://hostname:port/api/sam/computer_systems?token=token

Important:
• To use this API, you must be assigned to the All Computers group and have
the View Hardware Inventory permission.
• Each API request must be authenticated with the token parameter. You can
retrieve it by using REST API for retrieving authentication token. You can also
log in to BigFix Inventory, hover over the User icon

, and click Profile. Then,

click Show token.
• By default, the retrieved data is sorted by id.

Table 339. Operation descriptions
Operation details

Description

Operation

GET /api/sam/computer_systems

Purpose

Returns a list of computer systems.

HTTP method

GET

Resource URI

https://server_host_name:port_number/api/
sam/computer_systems

URL link relation

n/a

URI query parameters

For a list of applicable query parameters, see: Query pa
rameters.

Request headers

Header
Accept-Language (optional)

Values
en-US (only English is supported)

Table 339. Operation descriptions (continued)
Operation details

Description
Used to negotiate the language of the response. If this
header is not specified, the content is returned in the
server language.

Request payload
Request Content-Type
Response headers

n/a
application/json

Header
Content-Type

Values
application/json

Specifies the content type of the response.
Header
Content-Language

Values
en-US, …
Specifies the language of the response content. If this
header is not specified, the content is returned in the
server language.
Header
Import-Mode

Values
none, idle, running, pending

Specifies the data import status.
Header

Table 339. Operation descriptions (continued)
Operation details

Description
Import-Progress

Values
A percentage value, for example 59.
Specifies the percentage progress of a data import.
Header
Import-Last-Status

Values
successful, failed

Specifies the status of the last data import.
Header
Import-Last-Success-Time

Values
Date, for example
2014-06-18T04:00:29Z.

Specifies the time of the last successful data import.
Response payload

Computer Systems element

Response Content-Type

application/json

Normal HTTP response

200 - OK

codes
Error HTTP response codes

500 – "Bad Request" if a query parameter con

tains errors or is missing
Message body includes an error message with details.

Query parameters
You can use query parameters to narrow down the results of your search. The following
table presents query parameters that you can use for the api/sam/computer_systems
element.
Table 340. Query parameters for retrieving software products
Parameter
columns[]

Description
Specify which columns to retrieve. If

Required

Value

No

String

No

String

No

Numeric

Specify the number of rows to skip for No

Numeric

you do not specify this parameter, a
set of default columns is retrieved.
For available columns, see Response
body. Example:
Retrieve the name and version
columns:
URL?
columns[]=name&columns[]=versi
on

order

Specify how to sort the returned da
ta. The default direction for sorting
columns is ascending. If you want to
specify a descending sort, append desc to the column name. Example:

Order by type descending:
URL?order[]=type desc

limit

Specify the number of rows to re
trieve. If you omit this parameter, all
rows are retrieved.

offset

retrieving results. You can use it to

Table 340. Query parameters for retrieving software products (continued)
Parameter

Description

Required

Value

gether with the limit parameter to pag
inate results. Example:
Retrieve 50 records starting after
record 150:
URL?limit=50&offset=150

token

A unique user authentication identifi

Yes

Alphanumeric

er. You can view your token in the Pro
file preferences of BigFix Inventory.
criteria

Retrieve records which match specific conditions. The parameter
should have the following structure, written on one line:
<criteria> ::= <left-brace> <boolean-operator><colon>
<left-bracket>
<criterion> [{ <comma> <criterion> }...] <right-bracket>
<right-brace>

<boolean-operator> ::= "and" | "or"
<criterion> ::= <criteria> | <left-bracket> <column>
<comma> <operator> <comma> <value> <right-bracket>
<column> ::= <json-string>
<operator> ::= <json-string>
<value> ::= <json-array> | <json-string> | <json-numver>
| <json-null>

For more information about operators, see Common connectors and
operators.
Example: Retrieve computer systems whose operating system con
tains "AIX" OR the last seen date within a specific date range:

Table 340. Query parameters for retrieving software products (continued)
Parameter

Description

Required

Value

URL?criteria={ "or": [ ["os", "contains", "aix"],
{ "and": [ ["last_seen", ">",
"1970-01-01T00:00:00+00:00Z"],
["last_seen", "<", "1970-01-02T00:00:00+00:00Z"] ] } ] }

For columns that use the date and time values, such as Last Seen,
you can retrieve data also for a period instead of a specific date. To
do so, use last or next as <operator>, and then specify the time val
ue in the following convention: PxD/PxW/PxM/PxY, where x is a num
ber in the 1-999 range, and D, W, M, or Y is a designator that repre
sents days, weeks, months, or years respectively. For example, to re
trieve computer systems that reported within last 7 days, use the fol
lowing API request:
URL?criteria={"and":[["last_seen","last","P7D"]]}

Example HTTP conversation
Request
GET api/sam/computer_systems
?token=7adc3efb175e2bc0f4484bdd2efca54a8fa04623
Host: localhost:9081
Accept: application/json
Accept-Language: en-US

Response header
HTTP/1.1 200 OK
Content-Type: application/json
Content-Language: en-US

The above response header may be followed by different entries, depending
on the current status of the data import which is represented by Import-Mode.
To understand the returned values, see the following definitions:
• none - a data import has never been initiated
• idle - no data imports are currently running
• running - a data import is in progress
• pending - an action performed in the user interface requires a data
import to be started for the change to take effect
If a data import has never been initiated:
Import-Mode: none

If a data import is in progress:
Import-Mode: running
Import-Progress: 41

If a data import is not running:
Import-Mode: idle/pending
Import-Last-Status: successful
Import-Last-Success-Time: Mon, 23 Jun 2014 12:18:29 GMT

Response body (JSON)
If a particular entry is hidden by default, it is not retrieved by using the general
URL. To retrieve such data, you must use query parameters to specify the
name of the hidden column. For example, you can retrieve the server_id and
datasource_id columns by using the columns[] parameter:
URL?columns[]=server_id&columns[]=datasource_id

{
"id": 25,

"parent_id"=9,

//ID of a host for a VM

"computer_id": 2,

//hidden by default

"computer_remote_id": 123,

//hidden by default

"server_id": 24,

//hidden by default

"datasource_name"="Data source",

//hidden by default

"datasource_id"=1,

//hidden by default

"type"="virtual",

//type: virtual or host

"os": "Linux Red Hat Enterprise Server 6.2)",
"host_name": "NC040221",
"dns_name": "NC040221.kraklab.pl.ibm.com",
"ip_address": [
"9.167.40.221",
"192.168.122.1" ],
"last_seen": "2014-04-08T14:33:41Z",
"hardware_manufacturer": "IBM",
"hardware_model": "System x3550 M2 -[794662G]-",
"hardware_serial_number": "99B7166",
"hardware_type": "7946",

//hidden by default

"hardware_name": "IBM Corp. 7946",

//hidden by default

"processor_brand_string": "Intel(R) Xeon(R) CPU E7-3400 @ 2.40G
Hz",
"processor_type": "Multi-core",
"processor_brand": "Xeon(R)",
"processor_vendor": "Intel(R)",
"processor_model": "3400-3699 or 5500-5699",
"partition_cores" : 1,

//null for host serves

"server_processors": 1,
"server_cores": 8,
"pvu_per_core": 70,

//hidden by default

"uuid":"50305bd3-1f09-7294-7033-b903767d4605" //hidden by defau
lt
"cluster_id":"1"

// hidden by default

}

//ID of the cluster to which the computer system
belongs. Available only for type: host.

Retrieval of clusters
You use the GET operation on the api/sam/clusters element to request information about
clusters that group your host computer systems. This information represents the current
state of your environment and does not include any historical data.
After you retrieve the IDs of your clusters, compare them with the cluster_id column
retrieved by API for computer systems to recognize which of these systems belong to which
clusters. This information can also be viewed on the Hardware Inventory report in the user
interface.
To retrieve information about clusters, use the following URL:
https://hostname:port/api/sam/clusters?token=token

Important:
• To use this API, you must be assigned to the All Computers group and have
the View Hardware Inventory permission.
• Each API request must be authenticated with the token parameter. You can
retrieve it by using REST API for retrieving authentication token. You can also
log in to BigFix Inventory, hover over the User icon

, and click Profile. Then,

click Show token.
• By default, the retrieved data is sorted by id.

Table 341. Operation descriptions
Operation details

Description

Operation

GET /api/sam/clusters

Purpose

Returns a list of clusters.

Table 341. Operation descriptions (continued)
Operation details

Description

HTTP method

GET

Resource URI

https://server_host_name:port_number/api/
sam/clusters

URL link relation

n/a

URI query parameters

For a list of applicable query parameters, see: Query pa
rameters.

Request headers

Header
Accept-Language (optional)

Values
en-US (only English is supported)
Used to negotiate the language of the response. If this
header is not specified, the content is returned in the
server language.
Request payload
Request Content-Type
Response headers

n/a
application/json

Header
Content-Type

Values
application/json

Specifies the content type of the response.
Header
Content-Language

Values

Table 341. Operation descriptions (continued)
Operation details

Description
en-US, …
Specifies the language of the response content. If this
header is not specified, the content is returned in the
server language.
Header
Import-Mode

Values
none, idle, running, pending

Specifies the data import status.
Header
Import-Progress

Values
A percentage value, for example 59.
Specifies the percentage progress of a data import.
Header
Import-Last-Status

Values
successful, failed

Specifies the status of the last data import.
Header
Import-Last-Success-Time

Values

Table 341. Operation descriptions (continued)
Operation details

Description
Date, for example
2014-06-18T04:00:29Z.

Specifies the time of the last successful data import.
Response payload

Clusters element

Response Content-Type

application/json

Normal HTTP response

200 – OK

codes
Error HTTP response codes

500 – "Bad Request" if a query parameter con

tains errors or is missing
Message body includes an error message with details.

Query parameters
You can use query parameters to narrow down the results of your search. The following
table presents query parameters that you can use for the api/sam/clusters element.
Table 342. Query parameters for retrieving clusters
Parameter
columns

Description
Specify which columns to retrieve. If
you do not specify this parameter, a
set of default columns is retrieved.
For available columns, see Response
body. Example:
Retrieve the name and id columns:
URL?
columns[]=name&columns[]=id

Required
No

Value
String

Table 342. Query parameters for retrieving clusters (continued)
Parameter
order

Description
Specify how to sort the returned da

Required

Value

No

String

No

Numeric

Specify the number of rows to skip for No

Numeric

ta. The default direction for sorting
columns is ascending. If you want to
specify a descending sort, append desc to the column name. Example:

Order by type descending:
URL?order[]=type desc

limit

Specify the number of rows to re
trieve. If you omit this parameter, all
rows are retrieved.

offset

retrieving results. You can use it to
gether with the limit parameter to pag
inate results. Example:
Retrieve 50 records starting after
record 150:
URL?limit=50&offset=150

token

A unique user authentication identifi

Yes

er. You can view your token in the Pro
file preferences of BigFix Inventory.

Example HTTP conversation
Request
GET api/sam/clusters
?token=7adc3efb175e2bc0f4484bdd2efca54a8fa04623
Host: localhost:9081

Alphanumeric

Accept: application/json
Accept-Language: en-US

Response header
HTTP/1.1 200 OK
Content-Type: application/json
Content-Language: en-US

The above response header may be followed by different entries, depending
on the current status of the data import which is represented by Import-Mode.
To understand the returned values, see the following definitions:
• none - a data import has never been initiated
• idle - no data imports are currently running
• running - a data import is in progress
• pending - an action performed in the user interface requires a data
import to be started for the change to take effect
If a data import has never been initiated:
Import-Mode: none

If a data import is in progress:
Import-Mode: running
Import-Progress: 41

If a data import is not running:
Import-Mode: idle/pending
Import-Last-Status: successful
Import-Last-Success-Time: Mon, 23 Jun 2014 12:18:29 GMT

Response body (JSON)

{
"id": 1,
"name": "Production Cluster 1",
"cores_count": 24,
"vm_manager_url": "https://198.51.100/sdk",
}

Example about adding a vm_manager_status column to the result
API: /api/sam/clusters?

columns[]=name&columns[]=cores_count&columns[]=vm_manager_url&columns[]=vm_manager_st

Response:
{
{
{
"id": 1,
"name":
"Production Cluster 1",
"cores_count": 24,
"vm_manager_url":
"https://198.51.100/sdk",
"vm_manager_status": "98"
}
}
}

Example about filtering out data from inactive VM Managers
API: api/sam/clusters?criteria=\
{
"and":
[
[

"vm_manager_status","!=","98"
]
]
}

For description of other VM Managers statuses, see Retrieval of VM managers.

Retrieval of software instances
You use the GET operation on the api/sam/software_instances element to request
information about software installed in your infrastructure.
Important:

This REST API is now substituted with api/sam/v2/

software_instances REST API. If you have custom tools or internal processes that

are based on api/sam/software_instances REST API, it is best to adjust the tools
to use the new version of the API. For information, see: Mapping columns between
software_instances and v2/software_instances REST API.
To retrieve information about software instances installed on your computer systems, use
the following URL:
https://hostname:port/api/sam/software_instances?token=token

Note:
• To use this API, you must be assigned to the All Computers group and have
the View Endpoints permission.
• Each API request must be authenticated with the token parameter. You can
retrieve it by using REST API for retrieving authentication token. You can also
log in to BigFix Inventory, hover over the User icon
click Show token.
• By default, the retrieved data is sorted by id.

, and click Profile. Then,

Table 343. Operation descriptions
Operation details

Description

Operation

GET /api/sam/software_instances

Purpose

Returns a list of software.

HTTP method

GET

Resource URI

https://server_host_name:port_number/api/
sam/software_instances

URL link relation

n/a

URI query parameters

For a list of applicable query parameters, see: Query pa
rameters.

Request headers

Header
Accept-Language (optional)

Values
en-US (only English is supported)
Used to negotiate the language of the response. If this
header is not specified, the content is returned in the
server language.
Request payload
Request Content-Type
Response headers

n/a
application/json

Header
Content-Type

Values
application/json

Specifies the content type of the response.
Header

Table 343. Operation descriptions (continued)
Operation details

Description
Content-Language

Values
en-US, …
Specifies the language of the response content. If this
header is not specified, the content is returned in the
server language.
Header
Import-Mode

Values
none, idle, running, pending

Specifies the data import status.
Header
Import-Progress

Values
A percentage value, for example 59.
Specifies the percentage progress of a data import.
Header
Import-Last-Status

Values
successful, failed

Specifies the status of the last data import.
Header

Table 343. Operation descriptions (continued)
Operation details

Description
Import-Last-Success-Time

Values
Date, for example
2014-06-18T04:00:29Z.

Specifies the time of the last successful data import.
Response payload

Software Instances element

Response Content-Type

application/json

Normal HTTP response

200 – OK

codes
Error HTTP response codes

500 – "Bad Request" if a query parameter con

tains errors or is missing
Message body includes an error message with details.

Query parameters
You can use query parameters to narrow down the results of your search. The
following table presents query parameters that you can use for the api/sam/
software_instances element.
Table 344. Query parameters for retrieving software products
Parameter
columns[]

Description
Specify which columns to retrieve. If
you do not specify this parameter, a
set of default columns is retrieved. Ex
ample:
Retrieve the name and version
columns:

Required
No

Value
String

Table 344. Query parameters for retrieving software products (continued)
Parameter

Description

Required

Value

URL?
columns[]=name&columns[]=versi
on

order

Specify how to sort the returned da

No

String

No

Numeric

Specify the number of rows to skip for No

Numeric

ta. The default direction for sorting
columns is ascending. If you want to
specify a descending sort, append desc to the column name. Example:

Order by computer system ID de
scending:
URL?order[]=computer_system_id
desc

limit

Specify the number of rows to re
trieve. If you omit this parameter, all
rows are retrieved.

offset

retrieving results. You can use it to
gether with the limit parameter to pag
inate results. Example:
Retrieve 50 records starting after
record 150:
URL?limit=50&offset=150

token

A unique user authentication identifi
er. You can view your token in the Pro
file preferences of BigFix Inventory.

Yes

Alphanumeric

Table 344. Query parameters for retrieving software products (continued)
Parameter
criteria

Description

Required

Value

Retrieve records which match specific conditions. The parameter
should have the following structure, written on one line:
<criteria> ::= <left-brace> <boolean-operator><colon>
<left-bracket>
<criterion> [{ <comma> <criterion> }...] <right-bracket>
<right-brace>

<boolean-operator> ::= "and" | "or"
<criterion> ::= <criteria> | <left-bracket> <column>
<comma> <operator> <comma> <value> <right-bracket>
<column> ::= <json-string>
<operator> ::= <json-string>
<value>

::= <json-array> | <json-string> |

<json-numver> | <json-null>

For more information about operators, see Common connectors and
operators.
Example: Retrieve software instances whose publisher name con
tains "IBM" OR the last seen date within a specific date range:
URL?criteria={ "or": [ ["publisher_name", "contains",
"IBM"],
{ "and": [ ["last_seen", ">",
"1970-01-01T00:00:00+00:00Z"],
["last_seen", "<", "1970-01-02T00:00:00+00:00Z"] ] } ] }

For columns that use the date and time values, such as Last Seen,
you can retrieve data also for a period instead of a specific date. To
do so, use last or next as <operator>, and then specify the time val
ue in the following convention: PxD/PxW/PxM/PxY, where x is a num

Table 344. Query parameters for retrieving software products (continued)
Parameter

Description

Required

Value

ber in the 1-999 range, and D, W, M, or Y is a designator that repre
sents days, weeks, months, or years respectively. For example, to re
trieve software instances that reported within last 7 days, use the fol
lowing API request:
URL?criteria={"and":[["last_seen","last","P7D"]]}

Example HTTP conversation
Request
GET api/sam/software_instances
?token=7adc3efb175e2bc0f4484bdd2efca54a8fa04623
Host: localhost:9081
Accept: application/json
Accept-Language: en-US

Response header
HTTP/1.1 200 OK
Content-Type: application/json
Content-Language: en-US

The above response header may be followed by different entries, depending
on the current status of the data import which is represented by Import-Mode.
To understand the returned values, see the following definitions:
• none - a data import has never been initiated
• idle - no data imports are currently running
• running - a data import is in progress
• pending - an action performed in the user interface requires a data
import to be started for the change to take effect

If a data import has never been initiated:
Import-Mode: none

If a data import is in progress:
Import-Mode: running
Import-Progress: 41

If a data import is not running:
Import-Mode: idle/pending
Import-Last-Status: successful
Import-Last-Success-Time: Mon, 23 Jun 2014 12:18:29 GMT

Response body (JSON)
If a particular entry is hidden by default, it is not retrieved by using the general
URL. To retrieve such data, you must use query parameters to specify the
name of the hidden column. For example, you can retrieve the computer_id
and software_title_name columns by using the columns[] parameter:
URL?columns[]=computer_id&columns[]=catalog_dimension.software_t
itle_name

{
"id": 123,
"software_fact_id": 123, //hidden by default
"computer_system_id": 3,
"computer_id": 3,

//hidden by default

"discoverable_guid": "0768fb15-383c-4124-a7e2-0d76dda06874",
"default_product_guid": "78d380e0-9fb9-11e3-a151-005056872dc7",/
/hidden by default
"first_used": null,
"last_used": null,
"valid_from": "2014-04-02T14:24:04Z",

"valid_to": "9999-12-31T23:59:59Z",
"updated_at": "2014-04-02T14:24:04Z",
"signature_count": 1,
"total_time": 0,
"total_runs": 0,
"avg_run_time": null,
"avg_runs_per_day": null,
"process": null,
"deleted": false,

//hidden by default

"catalog_dimension":

//hidden by default

{
"software_title_name": "BigFix Platform Agent",
"publisher_name": "IBM",
"software_title_version_name": "BigFix Platform Agent",
"software_title_release_name": "BigFix Platform Agent",
"version": "9.0"
}
}

Retrieval of license usage
You use the GET operation on the api/sam/license_usages element to request information
about license usage reported by your computer systems.
This API retrieves peak license usage over the last 90 days. PVU and RVU full capacity and
subcapacity license usage is retrieved only on the host computer system level. To retrieve
information about license usage reported by your computer systems, use the following URL:
https://hostname:port/api/sam/license_usages?token=token

Important:

• To use this API, you must be assigned to the All Computers group and have
the View License Metrics permission.
• Each API request must be authenticated with the token parameter. You can
retrieve it by using REST API for retrieving authentication token. You can also
log in to BigFix Inventory, hover over the User icon

, and click Profile. Then,

click Show token.
• This API retrieves data for the last 90 days, until the last successful import.
• By default, the data retrieves is sorted by computer_system_id,
software_title_id, and metric_name columns.

Table 345. Operation descriptions
Operation details

Description

Operation

GET /api/sam/license_usages

Purpose

Returns information about license usage

HTTP method

GET

Resource URI

https://server_host_name:port_number/api/
sam/license_usages

URL link relation

n/a

URI query parameters

For a list of applicable query parameters, see: Query pa
rameters.

Request headers

Header
Accept-Language (optional)

Values
en-US (only English is supported)
Used to negotiate the language of the response. If this
header is not specified, the content is returned in the
server language.

Table 345. Operation descriptions (continued)
Operation details
Request payload
Request Content-Type
Response headers

Description
n/a
application/json

Header
Content-Type

Values
application/json

Specifies the content type of the response.
Header
Content-Language

Values
en-US, …
Specifies the language of the response content. If this
header is not specified, the content is returned in the
server language.
Header
Import-Mode

Values
none, idle, running, pending

Specifies the import status.
Header
Import-Progress

Values

Table 345. Operation descriptions (continued)
Operation details

Description
A percentage value, for example 59.
Specifies the percentage progress of an import.
Header
Import-Last-Status

Values
successful, failed

Specifies the status of the last import.
Header
Import-Last-Success-Time

Values
Date, for example
2014-06-18T04:00:29Z.

Specifies the time of the last successful import.
Response payload

License Usages element

Response Content-Type

application/json

Normal HTTP response

200 – OK

codes
Error HTTP response codes

500 – "Bad Request" if a query parameter con

tains errors or is missing
Message body includes an error message with details.

Query parameters
You can use query parameters to narrow down the results of your search. The following
table presents query parameters that you can use for the api/sam/license_usages
element.
Table 346. Query parameters for retrieving license usage
Parameter
columns[]

Description
Specify which columns to retrieve. If

Required

Value

No

String

No

String

No

Numeric

Specify the number of rows to skip for No

Numeric

you do not specify this parameter, a
set of default columns is retrieved. Ex
ample:
Retrieve the name and version
columns:
URL?
columns[]=name&columns[]=versi
on

order

Specify how to sort the returned da
ta. The default direction for sorting
columns is ascending. If you want to
specify a descending sort, append desc to the column name. Example:

Order by peak license usage descend
ing:
URL?order[]=peak_value desc

limit

Specify the number of rows to re
trieve. If you omit this parameter, all
rows are retrieved.

offset

retrieving results. You can use it to

Table 346. Query parameters for retrieving license usage (continued)
Parameter

Description

Required

Value

gether with the limit parameter to pag
inate results. Example:
Retrieve 50 records starting after
record 150:
URL?limit=50&offset=150

token

A unique user authentication identifi

Yes

Alphanumeric

er. You can view your token in the Pro
file preferences of BigFix Inventory.
criteria

Retrieve records which match specific conditions. The parameter
should have the following structure, written on one line:
<criteria> ::= <left-brace> <boolean-operator><colon>
<left-bracket>
<criterion> [{ <comma> <criterion> }...] <right-bracket>
<right-brace>

<boolean-operator> ::= "and" | "or"
<criterion> ::= <criteria> | <left-bracket> <column>
<comma> <operator> <comma> <value> <right-bracket>
<column> ::= <json-string>
<operator> ::= <json-string>
<value>

::= <json-array> | <json-string> |

<json-numver> | <json-null>

For more information about operators, see Common connectors and
operators.
Example: Retrieve license usage for software whose publisher name
contains "BigFix":

Table 346. Query parameters for retrieving license usage (continued)
Parameter

Description

Required

Value

URL?criteria={ "and": [ ["publisher_name", "contains",
"BigFix"]]}

Example HTTP conversation
Request
GET api/sam/license_usages
?token=7adc3efb175e2bc0f4484bdd2efca54a8fa04623
Host: localhost:9081
Accept: application/json
Accept-Language: en-US

Response header
HTTP/1.1 200 OK
Content-Type: application/json
Content-Language: en-US

The above response header may be followed by different entries, depending
on the current status of the data import which is represented by Import-Mode.
To understand the returned values, see the following definitions:
• none - a data import has never been initiated
• idle - no data imports are currently running
• running - a data import is in progress
• pending - an action performed in the user interface requires a data
import to be started for the change to take effect
If a data import has never been initiated:
Import-Mode: none

If a data import is in progress:
Import-Mode: running
Import-Progress: 41

If a data import is not running:
Import-Mode: idle/pending
Import-Last-Status: successful
Import-Last-Success-Time: Mon, 23 Jun 2014 12:18:29 GMT

Response body (JSON)
If a particular entry is hidden by default, it is not retrieved by using the
general URL. To retrieve such data, you must use query parameters to
specify the name of the hidden column. For example, you can retrieve the
software_title_dimension.name column by using the columns[] parameter:
URL?columns[]=software_title_dimension.name

{
"software_title_id": 36181,
"metric_name": "RVU_FULL_CAP",
"computer_system_id": 4,
"peak_value": 1,
"peak_date": "2014-04-14",
"peak_time": "2014-04-14T13:05:10Z",
"reporting_period_start_date": "2014-04-01",
"reporting_period_end_date": "2014-04-30",
"software_title_dimension":

//hidden by default

{
"name": "BigFix Protection",
"guid": "d78048cf-842b-44e8-8036-e7e2bf8afb31",
"publisher_name": "BigFix",
"publisher_guid": "8a759f0c-b91a-4d7d-8c4a-a9d85e06c13d"

}
}

REST API for software inventory management
You can reduce the time needed to manage your software inventory in a large environment
by using REST API instead of the application user interface. You can use REST API to get a
list of software products, releases, and release instances. You can also find out how your
software can be bundled.
Note: REST API for software inventory management work only for IBM products.
The REST APIs return only instances that are assigned to default license metrics.

Retrieval of software products
You use the GET operation on the api/sam/swinventory/products element to request
information about the software products that are installed in your infrastructure.
You must have the Manage Software Classification permission to perform this task.
Important: Use this REST API only for IBM products. This REST API returns only
instances that are assigned to default license metrics.

Table 347. Operation descriptions
The table consists of two columns and 15 rows. For the eleventh row there are two
levels.
Operation details

Description

Operation

GET /api/sam/swinventory/products

Purpose

Returns a list of software products.

HTTP method

GET

Table 347. Operation descriptions
The table consists of two columns and 15 rows. For the eleventh row there are two
levels.
(continued)
Operation details
Resource URI

Description
https://server_host_name:port_number/api/
sam/swinventory/products

URL link relation

n/a

URI query parameters

For a list of applicable query parameters, see: Query pa
rameters.

Request headers

Header
Accept-Language (optional)

Values
en-US (only English is supported)
Used to negotiate the language of the response. If this
header is not specified, the content is returned in the
server language.
Request payload
Request Content-Type
Response headers

n/a
Application/json

Header
Content-Type

Values
Application/json

Specifies the content type of the response.
Header
Content-Language

Table 347. Operation descriptions
The table consists of two columns and 15 rows. For the eleventh row there are two
levels.
(continued)
Operation details

Description
Values
en-US
Specifies the language of the response content. If this
header is not specified, the content is returned in the
server language.

Response payload

Products element

Response Content-Type

Application/json

Normal HTTP response

200 – OK

codes
Error HTTP response codes

400 – “Bad Request” if a query parameter con

tains errors or is missing
401 – "Unauthorized" if the user is not autho

rized to perform the operation
416 – “Requested Range Not Satisfiable” if

the user provided a start or count range that can
not be satisfied
Message body includes an error message with details.

Available columns
Table 348. Available columns
The table consists of four columns and 9 rows.
Dis
Column

Description

played
Type
by de
fault

nmbOfAllRows

Number of products that are returned by the REST
API request.

✓

In
te
ger

licenseType

Indicates the type of the license that is assigned to
the product. Possible values are:

✓

In
te
ger

• 1 - Other
• 5 - PVU
• 6 - RVU MAPC
Tip: To retrieve more detailed information
about the type of the license, use the api/
sam/v2/software_instances REST API.
level

Indicates whether the discovered software is a com
ponent or a product. In this REST API, the returned

✓

String

✓

Boolean

value is always product.
children

Indicates whether any instances of this product re
lease are discovered.

Table 348. Available columns
The table consists of four columns and 9 rows.
(continued)
Dis
Column

Description

played
Type
by de
fault

confidence

Confidence of the default assignment of a software
component to the software product that is expressed

✓

in per cents.
productReleaseCompo

te
ger

Name of the software product.

✓

String

Indicates whether the software classification was

✓

In

nent
isConfirmed

In

manually confirmed. Possible values are:

te
ger

• 0 - Not confirmed
• 1 - Confirmed
id

Identifier of the software product.

✓

In
te
ger

type

For internal use only. In this REST API, the returned
value is always root.

Query parameters
You can use query parameters to narrow down the results of your search. The following
table presents query parameters that you can use for the swinventory/products
element.

✓

String

Table 349. Query parameters for retrieving software products
The table consists of four columns and nine rows.
Parameter

Description

confirmed_fil

The state of bundling confirmation. If

ter

the parameter is not specified, both

Required

Value

No

truefalse

No

Numeric Default:

confirmed and unconfirmed software
instances are displayed.
count

The number of rows to be returned.

80
endDate

Discovery end date. If the parameter

No

is not specified, the current date is

Date in the YYYYMM-DD format

used.
part_number_ The part number to which the soft

No

String

product_re

The name of the software product, re No

String

lease_compo

lease, or component.

filter

ware item was assigned according to
the imported part number list.

nent_filter
start

The number of the first row of data to

No

be returned.
startDate

Discovery start date. If the parameter

Numeric Default:
0

No

is not specified, the start date is set

Date in the YYYYMM-DD format

either to 90 days back, or to the server
installation date, depending on which
one of these dates is closer to the cur
rent date.
token

A unique user authentication identifi
er.

Yes

Alphanumeric

Table 349. Query parameters for retrieving software products
The table consists of four columns and nine rows.
(continued)
Parameter

Description

Required

Value

Note: The token includes in
formation about the comput
er group to which the user
has access. Data that is re
trieved is limited to data from
computers that belong to this
group.

Example HTTP conversation
Request
GET /api/sam/swinventory/products
?token=7adc3efb175e2bc0f4484bdd2efca54a8fa04623&startDate=2012-1
0-19
&endDate=2012-10-19 HTTP/1.1
Host: localhost:9080
Accept: application/json
Accept-Language: en-US

Response header
HTTP/1.1 200 OK
Content-Type: application/json
Content-Language: en-US

Response body (JSON)
[{
"nmbOfAllRows" : "1967",

"licenseType" : "1",
"level" : "product",
"children" : "true",
"confidence" : "99",
"productReleaseComponent" : "AIX 5.2 Workload Partitions for AIX
7",
"isConfirmed" : "false",
"id" : "30369",
"type" : "root"

Retrieval of releases of a product
You use the GET operation on the api/sam/swinventory/product/{product_id}/releases
element to request information about the releases of a particular software product that is
installed in your infrastructure.
You must have the Manage Software Classification permission to perform this task.
Important: Use this REST API only for IBM products. This REST API returns only
instances that are assigned to default license metrics.

Table 350. Operation descriptions
Operation details
Operation

Description
GET /api/sam/swinventory/product/{product_id}/
releases

Purpose

Returns a list of releases of a particular software prod
uct that is identified by its identifier.

HTTP method

GET

Resource URI

https://server_host_name:port_number/api/
sam/swinventory/product/{product_id}/releases

Table 350. Operation descriptions (continued)
Operation details

Description

URL link relation

n/a

URI query parameters

For a list of applicable query parameters, see: Query pa
rameters.

Request headers

Header
Accept-Language (optional)

Values
en-US (only English is supported)
Used to negotiate the language of the response. If this
header is not specified, the content is returned in the
server language.
Request payload
Request Content-Type
Response headers

n/a
Application/json

Header
Content-Type

Values
Application/json

Specifies the content type of the response.
Header
Content-Language

Values
en-US, …
Specifies the language of the response content. If this
header is not specified, the content is returned in the
server language.

Table 350. Operation descriptions (continued)
Operation details
Response payload

Description
Releases element

Response Content-Type

Application/json

Normal HTTP response

200 – OK

codes
Error HTTP response codes

400 – “Bad Request” if a query parameter con

tains errors or is missing
401 – “Unauthorized” if the user is not autho

rized to perform the operation
404 – “Not Found” if a release or instance of the

product or version that is requested does not ex
ist
416 – “Requested Range Not Satisfiable” if

the user provided a start or count range that can
not be satisfied
Message body includes an error message with details.

Query parameters
You can use query parameters to narrow down the results of your search. The
following table presents query parameters that you can use for the swinventory/
product/{product_id}/releases element.

Table 351. Query parameters for retrieving releases of a software product
Parameter

Description

confirmed_fil

The state of bundling confirmation. If

ter

the parameter is not specified, both
confirmed and unconfirmed software
instances are displayed.

Required
No

Value
truefalse

Table 351. Query parameters for retrieving releases of a software product (continued)
Parameter
count

Description
The number of rows to be returned.

Required
No

Value
Numeric Default:
80

endDate

Discovery end date. If the parameter

No

is not specified, the current date is

Date in the YYYYMM-DD format

used.
part_number_ The part number to which the soft

No

String

product_re

The name of the software product, re No

String

lease_compo

lease, or component.

filter

ware item was assigned according to
the imported part number list.

nent_filter
start

The number of the first row of data to

No

be returned.
startDate

Discovery start date. If the parameter

Numeric Default:
0

No

is not specified, the start date is set

Date in the YYYYMM-DD format

either to 90 days back, or to the server
installation date, depending on which
one of these dates is closer to the cur
rent date.
token

A unique user authentication identifi
er.
Note: The token includes in
formation about the comput
er group to which the user
has access. Data that is re
trieved is limited to data from

Yes

Alphanumeric

Table 351. Query parameters for retrieving releases of a software product (continued)
Parameter

Description

Required

Value

computers that belong to this
group.

Example HTTP conversation
Request
GET /api/sam/swinventory/product/38818/releases
?token=7adc3efb175e2bc0f4484bdd2efca54a8fa04623&startDate=2012-1
0-19
&endDate=2012-10-19 HTTP/1.1
Host: localhost:9080
Accept: application/json Accept-Language: en-US

Response header
HTTP/1.1 200 OK
Content-Type: application/json
Content-Language: en-US

Response body (JSON)
[{
"nmbOfAllRows": "1",
"level": "release",
"productReleaseComponent": "DB2 UDB Query Patroller 6.1",
"id": "61922",
"numberOfAllInstances": "1",
"children": "true"
}]

Retrieval of release instances
You use the GET operation on the api/samswinventory/release/{release_id}/instances
element to request information about the instances of a software product release for a
particular release that is installed in your infrastructure.
You must have the Manage Software Classification permission to perform this task.
Important: Use this REST API only for IBM products. This REST API returns only
instances that are assigned to default license metrics.

Table 352. Operation descriptions
Operation details
Operation

Description
GET /api/sam/swinventory/release/{release_id}/
instances

Purpose

Returns a list of instances for the requested software
product release.

HTTP method

GET

Resource URI

https://server_host_name:port_number/api/
sam/swinventory/release/{release_id}/instances

URL link relation

n/a

URI query parameters

For a list of applicable query parameters, see: Query pa
rameters.

Request headers

Header
Accept-Language (optional)

Values
en-US (only English is supported)

Table 352. Operation descriptions (continued)
Operation details

Description
Used to negotiate the language of the response. If this
header is not specified, the content is returned in the
server language.

Request payload
Request Content-Type
Response headers

n/a
Application/json

Header
Content-Type

Values
Application/json

Specifies the content type of the response.
Header
Content-Language

Values
en-US, …
Specifies the language of the response content. If this
header is not specified, the content is returned in the
server language.
Response payload

Instances element. Each instance is a single compo

nent on a single agent.
Response Content-Type

Application/json

Normal HTTP response

200 – OK

codes

Table 352. Operation descriptions (continued)
Operation details
Error HTTP response codes

Description
400 – “Bad Request” if a query parameter con

tains errors or is missing
401 – “Unauthorized” if the user is not autho

rized to perform the operation
404 – “Not Found” if a release or instance of the

product or version that is requested does not ex
ist
416 – “Requested Range Not Satisfiable” if

the user provided a start or count range that can
not be satisfied
Message body includes an error message with details.

Query parameters
You can use query parameters to narrow down the results of your search. The
following table presents query parameters that you can use for the swinventory/
release/{release_id}/instances element.

Table 353. Query parameters for retrieving release instances
Parameter

Description

Required

confirmed_fil

The state of bundling confirmation. If No

ter

the parameter is not specified, both

Value
truefalse

confirmed and unconfirmed software
instances are displayed.
count

The number of rows to be returned.

No

Numeric Default:
80

endDate

Discovery end date. If the parameter
is not specified, the current date is
used.

No

Date in the YYYYMM-DD format

Table 353. Query parameters for retrieving release instances (continued)
Parameter

Description

name_host_fil The name of the computer on which

Required

Value

No

String

No

String

operating_sys Operating system of the computer on No

String

ter

the software item is installed.

name_server_ The name of the server on which the
filter

software item is installed.

tem_filter

which the software item is installed.

part_number_

The part number to which the soft

filter

ware item was assigned according to

No

String

product_re

The name of the software product, re No

String

lease_compo

lease, or component.

the imported part number list.

nent_filter
start

The number of the first row of data to No

Numeric Default: 0

be returned.
startDate

Discovery start date. If the parame

No

ter is not specified, the start date is

Date in the YYYYMM-DD format

set either to 90 days back, or to the
server installation date, depending on
which one of these dates is closer to
the current date.
token

A unique user authentication identifi
er.
Note: The token includes in
formation about the comput
er group to which the user
has access. Data that is re

Yes

Alphanumeric

Table 353. Query parameters for retrieving release instances (continued)
Parameter

Description

Required

Value

trieved is limited to data from
computers that belong to this
group.

Example HTTP conversation
Request
GET /api/sam/swinventory/release/61922/instances
?token=7adc3efb175e2bc0f4484bdd2efca54a8fa04623&startDate=2012-1
0-19
&endDate=2012-10-19 HTTP/1.1
Host: localhost:9080
Accept: application/json
Accept-Language: en-US

Response header
HTTP/1.1 200 OK
Content-Type: application/json
Content-Language: en-US

Response body (JSON)
[{
"isCharged": "true",
"operatingSystem": "Linux Red Hat Enterprise Server 5.4 (2.6.18
-164.el5)",
"isConfirmed": "false",
"currentServerId": "TLM_VM_VMware-42 3b 3b 73 2a 12 4a c5-e0 56
d1 30 74 6b 53 2a",
"updateTime": "1374082814268",

"children": "false",
"hostname": "NC042189",
"productInventoryId": "347",
"id": "347",
"level": "instance",
"bundleRules": "the relation in the software catalog, the stand
-alone product discovery",
"processorType": "Intel(R) Xeon(R) Multi-core 3400-3699 or 5500
-5699",
"isAgentDeleted": "false",
"productReleaseComponent": "IBM CICS Transaction Gateway 6.0",
"pvuPerCore": "70",
"installationPaths": "/nfs/bak/SLES10.2/usr/catalog_test/linux0
1/1",
"nmbOfAllRows": "4",
"isSimple": "false"
}]

Retrieval of releases to which a software instance can be
reassigned
You use the GET operation on the api/sam/swinventory/targetBundlesOfInstances
element to request information about the possible releases to which the requested software
instance can be reassigned.
You must have the Manage Software Classification permission to perform this task.
Important: Use this REST API only for IBM products. This REST API returns only
instances that are assigned to default license metrics.

Table 354. Operation descriptions
Operation details
Operation

Description
GET /api/sam/swinventory/targetBundlesOfInstances

Purpose

Returns a list of possible releases to which the request
ed software instance can be reassigned.

HTTP method

GET

Resource URI

https://server_host_name:port_number/api/
sam/swinventory/targetBundlesOfInstances

URL link relation

n/a

URI query parameters

For a list of applicable query parameters, see: Query pa
rameters.

Request headers

Header
Accept-Language (optional)

Values
en-US (only English is supported)
Used to negotiate the language of the response. If this
header is not specified, the content is returned in the
server language.
Request payload
Request Content-Type
Response headers

n/a
Application/json

Header
Content-Type

Values
Application/json
Specifies the content type of the response.

Table 354. Operation descriptions (continued)
Operation details

Description
Header
Content-Language

Values
en-US, …
Specifies the language of the response content. If this
header is not specified, the content is returned in the
server language.
Response payload

targetReleases element

Response Content-Type

Application/json

Normal HTTP response

200 – OK

codes
Error HTTP response codes

400 – “Bad Request” if a query parameter con

tains errors or is missing
401 – “Unauthorized” if the user is not autho

rized to perform the operation
404 – “Not Found” if a release or instance of the

product or version that is requested does not ex
ist
Message body includes an error message with details.

Query parameters
You can use query parameters to narrow down the results of your search. The
following table presents query parameters that you can use for the swinventory/
targetBundlesOfInstances element.

Table 355. Query parameters for retrieving releases to which a software instance can
be reassigned
Re
Parameter

Description

quired

productInven

A list of unique product identifiers Yes

toryId

separated with a comma.

token

A unique user authentication iden Yes

Value
Numeric

Alphanumeric

tifier.
Note: The token includes
information about the
computer group to which
the user has access. Data
that is retrieved is limited
to data from computers
that belong to this group.

Example HTTP conversation
Request
GET /api/sam/swinventory/targetBundlesOfInstances
?token=7adc3efb175e2bc0f4484bdd2efca54a8fa04623&productInventory
Id=200032 HTTP/1.1
Host: localhost:9080
Accept: application/json
Accept-Language: en-US

Response header
HTTP/1.1 200 OK
Content-Type: application/json
Content-Language: en-US

Response body (JSON)
[{
"productId": "69558",
"isSelected": "false",
"productInventoryId": "200032",
"appliedRules": "the relation in the software catalog,
the stand-alone product discovery",
"productName": "BigFix Smart Analytics System 2050 Departmental
Base Remote Standby Server 1.0",
"id": "69558",
"branchType": "0",
"isShared": "false"
}]

Retrieval of releases to which a release instance can be reassigned
You use the GET operation on the api/sam/swinventory/targetBundlesOfReleases
element to request information about the possible releases to which the instances of the
requested software releases can be reassigned.
You must have the Manage Software Classification permission to perform this task.
Important: Use this REST API only for IBM products. This REST API returns only
instances that are assigned to default license metrics.

Table 356. Operation descriptions
Operation details
Operation

Description
GET /api/sam/swinventory/targetBundlesOfReleases

Table 356. Operation descriptions (continued)
Operation details
Purpose

Description
Returns a list of possible releases to which the in
stances of the requested software releases can be re
assigned.

HTTP method

GET

Resource URI

https://server_host_name:port_number/api/
sam/swinventory/targetBundlesOfReleases

URL link relation

n/a

URI query parameters

For a list of applicable query parameters, see: Query pa
rameters.

Request headers

Header
Accept-Language (optional)

Values
en-US (only English is supported)
Used to negotiate the language of the response. If this
header is not specified, the content is returned in the
server language.
Request payload
Request Content-Type
Response headers

n/a
Application/json

Header
Content-Type

Values
Application/json
Specifies the content type of the response.
Header

Table 356. Operation descriptions (continued)
Operation details

Description
Content-Language

Values
en-US, …
Specifies the language of the response content. If this
header is not specified, the content is returned in the
server language.
Response payload

targetReleases element

Response Content-Type

Application/json

Normal HTTP response

200 – OK

codes
Error HTTP response codes

400 – “Bad Request” if a query parameter con

tains errors or is missing
401 – “Unauthorized” if the user is not autho

rized to perform the operation
404 – “Not Found” if a release or instance of the

product or version that is requested does not ex
ist
Message body includes an error message with details.

Query parameters
You can use query parameters to narrow down the results of your search. The
following table presents query parameters that you can use for the swinventory/
targetBundlesOfReleases element.

Table 357. Query parameters for retrieving releases to which a release instance can
be reassigned
Parameter

Description

confirmed_fil

The state of bundling confirmation. If

ter

the parameter is not specified, both

Required

Value

No

truefalse

No

Date in the YYYY-

confirmed and unconfirmed software
instances are displayed.
endDate

Discovery end date. If the parameter
is not specified, the current date is

MM-DD format

used.
name_host_fil The name of the computer on which

No

String

No

String

No

String

No

String

product_re

The name of the software product, re No

String

lease_compo

lease, or component.

ter

the software item is installed.

name_server_ The name of the server on which the
filter

software item is installed.

operating_sys Operating system of the computer on
tem_filter

which the software item is installed.

part_number_ The part number to which the soft
filter

ware item was assigned according to
the imported part number list.

nent_filter
releases

A list of unique release identifiers sep Yes

Numeric

arated with a comma.
startDate

Discovery start date. If the parameter
is not specified, the start date is set
either to 90 days back, or to the server
installation date, depending on which

No

Date in the YYYYMM-DD format

Table 357. Query parameters for retrieving releases to which a release instance can
be reassigned (continued)
Parameter

Description

Required

Value

one of these dates is closer to the cur
rent date.
token

A unique user authentication identifi

Yes

Alphanumeric

er.
Note: The token includes in
formation about the comput
er group to which the user
has access. Data that is re
trieved is limited to data from
computers that belong to this
group.

Example HTTP conversation
Request
GET /api/sam/swinventory/targetBundlesOfReleases
?token=7adc3efb175e2bc0f4484bdd2efca54a8fa04623
&releases=64050&startDate=2012-09-29&endDate=2012-10-02 HTTP/1.1
Host: localhost:9080
Accept: application/json
Accept-Language: en-US

Response header
HTTP/1.1 200 OK
Content-Type: application/json
Content-Language: en-US

Response body (JSON)

[{
"productId": "72563",
"isSelected": "false",
"productInventoryId": "200223",
"appliedRules": "the relation in the software catalog",
"productName": "BigFix",
"id": "72563",
"branchType": "0",
"isShared": "false"
}]

Retrieval of instances to reassign to a release
You use the GET operation on the api/sam/swinventory/targetInstances element to
request information about the target instances that can be reassigned to a particular
release.
You must have the Manage Software Classification permission to perform this task.
Important: Use this REST API only for IBM products. This REST API returns only
instances that are assigned to default license metrics.

Table 358. Operation descriptions
Operation details

Description

Operation

GET /api/sam/swinventory/targetInstances

Purpose

Returns a list of target instances that can be reas
signed to a particular release.

HTTP method

GET

Resource URI

https://server_host_name:port_number/api/
sam/swinventory/targetInstances

URL link relation

n/a

Table 358. Operation descriptions (continued)
Operation details
URI query parameters

Description
For a list of applicable query parameters, see: Query pa
rameters.

Request headers

Header
Accept-Language (optional)

Values
en-US (only English is supported)
Used to negotiate the language of the response. If this
header is not specified, the content is returned in the
server language.
Request payload
Request Content-Type
Response headers

n/a
Application/json

Header
Content-Type

Values
Application/json

Specifies the content type of the response.
Header
Content-Language

Values
en-US, …
Specifies the language of the response content. If this
header is not specified, the content is returned in the
server language.
Response payload

targetInstances element

Table 358. Operation descriptions (continued)
Operation details

Description

Response Content-Type

Application/json

Normal HTTP response

200 – OK

codes
Error HTTP response codes

400 – “Bad Request” if a query parameter con

tains errors or is missing
401 – “Unauthorized” if a user is not authorized

to perform the operation
404 – “Not Found” if a release or instance of the

product or version that you requested for does
not exist
Message body includes an error message with details.

Query parameters
You can use query parameters to narrow down the results of your search. The
following table presents query parameters that you can use for the GET/swinventory/
targetInstances element.

Table 359. Query parameters for retrieving instances to reassign to a release
Parameter

Description

Required

Value

releaseId

A unique identifier of a release.

Yes

Numeric

token

A unique user authentication identifi

Yes

Alphanumeric

er.
Note: The token includes in
formation about the comput
er group to which the user

Table 359. Query parameters for retrieving instances to reassign to a release
(continued)
Parameter

Description

Required

Value

has access. Data that is re
trieved is limited to data from
computers that belong to this
group.

Example HTTP conversation
Request
GET /api/sam/swinventory/targetInstances
?token=7adc3efb175e2bc0f4484bdd2efca54a8fa04623&releaseId=72717
HTTP/1.1
Host: localhost:9080
Accept: application/json
Accept-Language: en-US

Response header
HTTP/1.1 200 OK
Content-Type: application/json
Content-Language: en-US

Response body (JSON)
[{
"componentNameVersion": "BigFix Tivoli Directory Server (SP) 6.
0",
"hostname": "Agent20",
"path": "C:\Documents and Settings\Administrator\Signatures",
"updateTime": "1349270690593",
"productInventoryId": "200027",

"appliedRules": "the relation in the software catalog, the infr
astructure co-location",
"productId": "72717",
"id": "200027",
"productNameVersion": "IBM WebSphere Process Server Hypervisor
Edition for Novell SLES for x86 6.2",
"isShared": "false"
}]

Retrieval of instances shared by releases
You use the GET operation on the api/sam/swinventory/instanceToShare element to
request information about the releases that can share a particular instance.
You must have the Manage Software Classification permission to perform this task.
Important: Use this REST API only for IBM products. This REST API returns only
instances that are assigned to default license metrics.

Table 360. Operation descriptions
Operation details

Description

Operation

GET /api/sam/swinventory/instanceToShare

Purpose

Returns a list of software releases that can share a par
ticular instance.

HTTP method

GET

Resource URI

https://server_host_name:port_number/api/
sam/swinventory/instanceToShare

URL link relation

n/a

URI query parameters

For a list of applicable query parameters, see: Query pa
rameters.

Table 360. Operation descriptions (continued)
Operation details
Request headers

Description
Header
Accept-Language (optional)

Values
en-US (only English is supported)
Used to negotiate the language of the response. If this
header is not specified, the content is returned in the
server language.
Request payload
Request Content-Type
Response headers

n/a
Application/json

Header
Content-Type

Values
Application/json
Specifies the content type of the response.
Header
Content-Language

Values
en-US, …
Specifies the language of the response content. If this
header is not specified, the content is returned in the
server language.
Response payload
Response Content-Type

targetReleases element
Application/json

Table 360. Operation descriptions (continued)
Operation details

Description

Normal HTTP response

200 – OK

codes
Error HTTP response codes

400 – “Bad Request” if a parameter contains er

rors or is missing
401 – “Unauthorized” if you are not authorized

for the operation
404 – “Not Found” if a release or instance of the

product or version that is requested does not ex
ist
Message body includes an error message with details.

Query parameters
You can use query parameters to narrow down the results of your search. The following
table presents query parameters that you can use for the swinventory/instanceToShare
element.
Table 361. Query parameters for retrieving an instance shared by releases
Parameter
productInven

Description

Required

Value

A unique identifier of a product.

Yes

Numeric

A unique user authentication identifi

Yes

Alphanumeric

toryId
token

er.
Note: The token includes in
formation about the comput
er group to which the user
has access. Data that is re
trieved is limited to data from

Table 361. Query parameters for retrieving an instance shared by releases (continued)
Parameter

Description

Required

Value

computers that belong to this
group.

Example HTTP conversation
Request
GET /api/sam/swinventory/instanceToShare
?token=7adc3efb175e2bc0f4484bdd2efca54a8fa04623&productInventory
Id=200032 HTTP/1.1
Host: localhost:9080
Accept: application/json
Accept-Language: en-US

Response header
HTTP/1.1 200 OK
Content-Type: application/json
Content-Language: en-US

Response body (JSON)
[{
"productId": "64050",
"isSelected": "true",
"productInventoryId": "200032",
"appliedRules": "the relation in the software catalog, the stan
d-alone product discovery",
"productName": "IBM Alphablox for Linux, UNIX and Windows 9.5",
"id": "64050",
"branchType": "0",
"isShared": "false"

}
]

REST API for software classification
You can reduce the time that is needed to manage your software instances in a large
environment by using REST API instead of the application user interface. You can use REST
API to share instances, include or exclude instances from a pricing calculation, confirm and
assign instances, and reassign instances.
Important: REST APIs for software classification work only for BigFix products and
return only instances that are assigned to default license metrics.

Share an instance with more than one product
You use the POST operation on the api/sam/swinventory/share element to share an
instance of a component with more than one product.
You must have the Manage Software Classification permission to perform this task.
Important: Use this REST API only for BigFix products. The REST API returns only
instances that are assigned to default license metrics.

Table 362. Operation descriptions
Operation details

Description

Operation

/api/sam/swinventory/share

Purpose

Shares an instance with a list of software products.

HTTP method

POST

Resource URI

https://server_host_name:port_number/api/
sam/swinventory/share

URL link relation

n/a

Table 362. Operation descriptions (continued)
Operation details
URI query parameters

Description
For a list of applicable query parameters, see: Query pa
rameters.

Request headers

Header
Accept-Language (optional)

Values
en-US (only English is supported)
Used to negotiate the language of the response. If this
header is not specified, the content is returned in the
server language.
Request payload

n/a

Request Content-Type

n/a

Response headers

Header
Content-Language

Values
en-US, …
Specifies the language of the response content. If this
header is not specified, the content is returned in the
server language.
Response payload

n/a

Response Content-Type

n/a

Normal HTTP response
codes

204 – No content

Table 362. Operation descriptions (continued)
Operation details
Error HTTP response codes

Description
400 – “Bad Request” if a query parameter con

tains errors or is missing
401 – “Unauthorized” if the user is not autho

rized to perform the operation
404 – “Not Found” if a release or instance of the

product or version that the user requested does
not exist
422 – “Unprocessable Entity” if the request

was well-formed but was unable to be followed
due to semantic errors
Message body includes an error message with details.

Query parameters
You can use query parameters to narrow down the results of your search. The following
table presents query parameters that you use for the POST/swinventory/share element.
Table 363. Query parameters for sharing an instance with more than one product
The table consists of four columns and four rows.
Parameter
productIds

Description
A list of unique product identifiers
separated with a comma. At least one
identifier must be specified.
Use the GET operation on the swinventory/instanceToShare element to

get product identifiers.

Required
Yes

Value
Numeric

Table 363. Query parameters for sharing an instance with more than one product
The table consists of four columns and four rows.
(continued)
Parameter

Description

productInven

A unique identifier of an instance that

toryId

is shared by products.

token

A unique user authentication identifi

Required

Value

Yes

Numeric

Yes

Alphanumeric

Yes

Numeric

er.
updateTime

Timestamp of the last modification
time of the instance expressed in mil
liseconds. This parameter is used to
handle concurrent actions.
Use the GET operation on the swinventory/release/{release_id}/instances element to get the update

time.

Example HTTP conversation
Request
POST /api/sam/swinventory/share?token=7adc3efb175e2bc0f4484bdd2e
fca54a8fa04623
&productInventoryId=200032&updateTime=1349237658578&productIds=7
0665,70656 HTTP/1.1
Host: localhost:9080
Accept-Language: en-US

Response header

HTTP/1.1 204 OK
Content-Type: application/json
Content-Language: en-US

Related reference
Retrieval of release instances
Retrieval of instances shared by releases

Inclusion of instances in a pricing calculation
You use the POST operation on the api/sam/swinventory/include element to include
instances in the pricing calculation.
You must have the Manage Software Classification permission to perform this task.
Important: Use this REST API only for BigFix products. The REST API returns only
instances that are assigned to default license metrics.

Table 364. Operation descriptions
Operation details

Description

Operation

/api/sam/swinventory/include

Purpose

Includes instances in a pricing calculation.

HTTP method

POST

Resource URI

https://server_host_name:port_number/api/
sam/swinventory/include

URL link relation

n/a

URI query parameters

For a list of applicable query parameters, see: Query pa
rameters.

Table 364. Operation descriptions (continued)
Operation details
Request headers

Description
Header
Accept-Language (optional)

Values
en-US (only English is supported)
Used to negotiate the language of the response. If this
header is not specified, the content is returned in the
server language.
Request payload

n/a

Request Content-Type

n/a

Response headers

Header
Content-Language

Values
en-US, …
Specifies the language of the response content. If this
header is not specified, the content is returned in the
server language.
Response payload

n/a

Response Content-Type

n/a

Normal HTTP response

204 – No content

codes
Error HTTP response codes

400 – “Bad Request” if a query parameter con

tains errors or is missing
401 – “Unauthorized” if the user is not autho

rized to perform the operation

Table 364. Operation descriptions (continued)
Operation details

Description
404 – “Not Found” if a release or instance of the

product or version that the user requested does
not exist
422 – “Unprocessable Entity” if the request

was well-formed but was unable to be followed
due to semantic errors
Message body includes an error message with details.

Query parameters
You can use query parameters to narrow down the results of your search. The following
table presents query parameters that you can use for the POST/swinventory/include
element.
Table 365. Query parameters for including instances in pricing calculations
The table consists of four columns and three rows.
Parameter

Description

productInven

A list of unique identifiers of in

toryId

stances that are to be included in the

Required

Value

Yes

Numeric

Yes

Alphanumeric

Yes

Numeric

calculation separated with a comma.
At least one identifier must be speci
fied.
token

A unique user authentication identifi
er.

updateTime

A list of timestamps of the last modi
fication time of instances expressed
in milliseconds. The timestamps are
separated with a comma. The first

Table 365. Query parameters for including instances in pricing calculations
The table consists of four columns and three rows.
(continued)
Parameter

Description

Required

Value

timestamp in the list corresponds to
the first instance, and so on. This pa
rameter is used to handle concurrent
actions.
Use the GET operation on the swinventory/release/{release_id}/instances element to get the update

times.

Example HTTP conversation
Request
POST /api/sam/swinventory/include?token=7adc3efb175e2bc0f4484bdd
2efca54a8fa04623
&productInventoryId=198,300201&updateTime=1349237658578,13492376
58588 HTTP/1.1
Host: localhost:9080
Accept-Language: en-US

Response header
HTTP/1.1 204 OK
Content-Type: application/json
Content-Language: en-US

Related reference
Retrieval of release instances

Exclusion of instances from pricing calculations
You use the POST operation on the api/sam/swinventory/exclude element to exclude
instances from pricing calculations.
You must have the Manage Software Classification permission to perform this task.
Important: Use this REST API only for BigFix products. The REST API returns only
instances that are assigned to default license metrics.

Table 366. Operation descriptions
Operation details

Description

Operation

/api/sam/swinventory/exclude

Purpose

Excludes instances from a pricing calculation.

HTTP method

POST

Resource URI

https://server_host_name:port_number/api/
sam/swinventory/exclude

URL link relation

n/a

URI query parameters

For a list of applicable query parameters, see: Query pa
rameters.

Request headers

Header
Accept-Language (optional)

Values
en-US (only English is supported)
Used to negotiate the language of the response. If this
header is not specified, the content is returned in the
server language.
Request payload

n/a

Table 366. Operation descriptions (continued)
Operation details
Request Content-Type
Response headers

Description
n/a
Header
Content-Language

Values
en-US, …
Specifies the language of the response content. If this
header is not specified, the content is returned in the
server language.
Response payload

n/a

Response Content-Type

n/a

Normal HTTP response

204 – No content

codes
Error HTTP response codes

400 – “Bad Request” if a query parameter con

tains errors or is missing
401 – “Unauthorized” if the user is not autho

rized to perform the operation
404 – “Not Found” if a release or instance of the

product or version that the user requested does
not exist
422 – “Unprocessable Entity” if the request

was well-formed but was unable to be followed
due to semantic errors
Message body excludes an error message with details.

Query parameters
You can use query parameters to narrow down the results of your search. The following
table presents query parameters that you can use for the POST/swinventory/exclude
element.
Table 367. Query parameters for excluding instances from pricing calculations
Re
Parameter

Description

productInven

A list of unique identifiers of in

toryId

stances to be excluded from the

quired

Value

Yes

Numeric

Yes

backupbetacomponen-

calculation separated with a com
ma. At least one identifier must be
specified.
reason

The reason for excluding an in
stance from the pricing calcula

tevaluationno_li-

tions.

censingnot_compatibleother

comment

Additional comments for the rea

Only

son of exclusion.

when

String

reason
is other
token

A unique user authentication iden Yes

Alphanumeric

tifier.
updateTime

A list of timestamps of the last
modification time of the instances
expressed in milliseconds. Each
timestamp is separated with a
comma. The first timestamp in
the list corresponds to the first in
stance, and so on. This parameter

Yes

Numeric

Table 367. Query parameters for excluding instances from pricing calculations
(continued)
Re
Parameter

Description

quired

Value

is used to handle concurrent ac
tions.
Use the GET operation on the
swinventory/release/{release_id}/instances element to

get the update times.

Example HTTP conversation
Request
POST /api/sam/swinventory/exclude
?token=7adc3efb175e2bc0f4484bdd2efca54a8fa04623
&productInventoryId=300001,500001&updateTime=1349237658578,13492
37658588
&reason=no_licensing HTTP/1.1
Host: localhost:9080
Accept-Language: en-US

Response header
HTTP/1.1 204 OK
Content-Type: application/json
Content-Language: en-US

Related reference
Retrieval of release instances

Reassignment of instances to a product
You use the POST operation on the api/sam/swinventory/reassign element to reassign
instances to a different product.
You must have the Manage Software Classification permission to perform this task.
Important: Use this REST API only for BigFix products. The REST API returns only
instances that are assigned to default license metrics.

Table 368. Operation descriptions
Operation details

Description

Operation

/api/sam/swinventory/reassign

Purpose

Reassigns instances to a different product.

HTTP method

POST

Resource URI

https://server_host_name:port_number/api/
sam/swinventory/reassign

URL link relation

n/a

URI query parameters

For a list of applicable query parameters, see: Query pa
rameters.

Request headers

Header
Accept-Language (optional)

Values
en-US (only English is supported)
Used to negotiate the language of the response. If this
header is not specified, the content is returned in the
server language.
Request payload

n/a

Table 368. Operation descriptions (continued)
Operation details
Request Content-Type
Response headers

Description
n/a
Header
Content-Language

Values
en-US, …
Specifies the language of the response content. If this
header is not specified, the content is returned in the
server language.
Response payload

n/a

Response Content-Type

n/a

Normal HTTP response

204 – No content

codes
Error HTTP response codes

400 – “Bad Request” if a query parameter con

tains errors or is missing
401 – “Unauthorized” if the user is not autho

rized to perform the operation
404 – “Not Found” if a release or instance of the

product or version that the user requested does
not exist
422 – “Unprocessable Entity” if the request

was well-formed but was unable to be followed
due to semantic errors
Message body excludes an error message with details.

Query parameters
You can use query parameters to narrow down the results of your search. The following
table presents query parameters that you can use for the POST/swinventory/reassign
element.
Table 369. Query parameters for reassigning instances to a different product
The table consists of four columns and four rows.
Parameter
productId

Description
A unique identifier of a product to

Required

Value

Yes

Numeric

Yes

Numeric

Yes

Numeric

which the instance is to be reas
signed.
Use the GET operation on the swinventory/targetBundlesOfInstances

element to get product identifiers.
productInven

A list of unique identifiers of in

toryId

stances to be reassigned to a product
separated with a comma. At least one
identifier must be specified.

updateTime

A list of timestamps of the last mod
ification time of the instances ex
pressed in milliseconds. The time
stamps are separated with a comma.
The first timestamp in the list corre
sponds to the first instance, and so
on. This parameter is used to handle
concurrent actions.
Use the GET operation on the swinventory/release/{release_id}/in-

Table 369. Query parameters for reassigning instances to a different product
The table consists of four columns and four rows.
(continued)
Parameter

Description

Required

Value

stances element to get the update

times.
token

A unique user authentication identifi

Yes

Alphanumeric

er.

Example HTTP conversation
Request
POST /api/sam/swinventory/reassign?token=7adc3efb175e2bc0f4484bd
d2efca54a8fa04623
&productInventoryId=200027,300001&productId=72786&updateTime=
1349237658578,1349237658588 HTTP/1.1
Host: localhost:9080
Accept-Language: en-US

Response header
HTTP/1.1 204 OK
Content-Type: application/json
Content-Language: en-US

Related reference
Retrieval of release instances
Retrieval of releases to which a software instance can be reassigned

Reassignment of instances to a product for a list of releases
You use the POST operation on the api/sam/swinventory/reassignRelease element to
reassign instances for a list of releases to a product.
You must have the Manage Software Classification permission to perform this task.
Important: Use this REST API only for BigFix products. The REST API returns only
instances that are assigned to default license metrics.

Table 370. Operation descriptions
Operation details

Description

Operation

/api/sam/swinventory/reassignRelease

Purpose

Reassigns instances to a product for a list of releases.

HTTP method

POST

Resource URI

https://server_host_name:port_number/api/
sam/swinventory/reassignRelease

URL link relation

n/a

URI query parameters

For a list of applicable query parameters, see: Query pa
rameters.

Request headers

Header
Accept-Language (optional)

Values
en-US (only English is supported)
Used to negotiate the language of the response. If this
header is not specified, the content is returned in the
server language.
Request payload

n/a

Table 370. Operation descriptions (continued)
Operation details
Request Content-Type
Response headers

Description
n/a
Header
Content-Language

Values
en-US, …
Specifies the language of the response content. If this
header is not specified, the content is returned in the
server language.
Response payload

n/a

Response Content-Type

n/a

Normal HTTP response

204 – No content

codes
Error HTTP response codes

400 – “Bad Request” if a query parameter con

tains errors or is missing
401 – “Unauthorized” if the user is not autho

rized to perform the operation
404 – “Not Found” if a release or instance of the

product or version that the user requested does
not exist
422 – “Unprocessable Entity” if the request

was well-formed but was unable to be followed
due to semantic errors
Message body excludes an error message with details.

Query parameters
You can use query parameters to narrow down the results of your search. The
following table presents query parameters that you can use for the POST/swinventory/
reassignRelease element.

Table 371. Query parameters for retrieving instances to reassign to a release
The table consists of four columns and ten rows.
Parameter
endDate

Description
Discovery end date. If the parameter

Required
No

is not specified, the current date is

Value
Date in the YYYYMM-DD format

used.
name_host_fil The name of the computer on which

No

String

No

String

No

String

No

String

product_re

The name of the software product, re No

String

lease_compo

lease, or component.

ter

the software item is installed.

name_server_ The name of the server on which the
filter

software item is installed.

operating_sys Operating system of the computer on
tem_filter

which the software item is installed.

part_number_ The part number to which the soft
filter

ware item was assigned according to
the imported part number list.

nent_filter
productId

A unique identifier of a product to
which the instance is to be assigned.
Use the GET operation on the swinventory/targetBundlesOfReleases

element to get product identifiers.

Yes

Numeric

Table 371. Query parameters for retrieving instances to reassign to a release
The table consists of four columns and ten rows.
(continued)
Parameter
releases

Description

Required

A list of unique release identifiers sep Yes

Value
Numeric

arated with a comma. At least one
identifier must be specified.
startDate

Discovery start date. If the parameter

No

is not specified, the first date that is

Date in the YYYYMM-DD format

not covered by a signed audit report
is used. If there are no signed reports,
the server installation date is used.
token

A unique user authentication identifi

Yes

Alphanumeric

er.

Example HTTP conversation
Request
POST /api/sam/swinventory/reassignRelease
?token=7adc3efb175e2bc0f4484bdd2efca54a8fa04623
&releases=67757,95947&productId=67756&startDate=2012-09-29&endDa
te=2012-10-02
Host: localhost:9080
Accept-Language: en-US

Response header
HTTP/1.1 204 OK
Content-Type: application/json
Content-Language: en-US

Related reference
Retrieval of releases to which a release instance can be reassigned

Confirmation of instances to bundle or assign
You use the POST operation on the api/sam/swinventory/confirm element to confirm the
bundling or assignment of instances.
You must have the Manage Software Classification permission to perform this task.
Important: Use this REST API only for BigFix products. The REST API returns only
instances that are assigned to default license metrics.

Table 372. Operation descriptions
Operation details

Description

Operation

/api/sam/swinventory/confirm

Purpose

Confirms the bundling or assignment of instances.

HTTP method

POST

Resource URI

https://server_host_name:port_number/api/
sam/swinventory/confirm

URL link relation

n/a

URI query parameters

For a list of applicable query parameters, see: Query pa
rameters.

Request headers

Header
Accept-Language (optional)

Values
en-US (only English is supported)

Table 372. Operation descriptions (continued)
Operation details

Description
Used to negotiate the language of the response. If this
header is not specified, the content is returned in the
server language.

Request payload

n/a

Request Content-Type

n/a

Response headers

Header
Content-Language

Values
en-US, …
Specifies the language of the response content. If this
header is not specified, the content is returned in the
server language.
Response payload

n/a

Response Content-Type

n/a

Normal HTTP response

204 – No content

codes
Error HTTP response codes

400 – “Bad Request” if a query parameter con

tains errors or is missing
401 – “Unauthorized” if the user is not autho

rized to perform the operation
404 – “Not Found” if a release or instance of the

product or version that the user requested does
not exist
422 – “Unprocessable Entity” if the request

was well-formed but was unable to be followed
due to semantic errors

Table 372. Operation descriptions (continued)
Operation details

Description
Message body excludes an error message with details.

Query parameters
You can use query parameters to narrow down the results of your search. The following
table presents query parameters that you can use for the POST/swinventory/confirm
element.
Table 373. Query parameters for confirming instances
Parameter

Description

productInven

A list of unique identifiers of in

toryId

stances to be confirmed separated

Required

Value

Yes

Numeric

Yes

Numeric

Yes

Alphanumeric

with a comma. At least one identifier
must be specified.
updateTime

A list of timestamps of the last modi
fication time of instances expressed
in milliseconds. The timestamps are
separated with a comma. The first
timestamp in the list corresponds to
the first instance, and so on. This pa
rameter is used to handle concurrent
actions.
Use the GET operation on the swinventory/release/{release_id}/instances element to get the update

times.
token

A unique user authentication identifi
er.

Example HTTP conversation
Request
POST /api/sam/swinventory/confirm?token=7adc3efb175e2bc0f4484bdd
2efca54a8fa04623
&productInventoryId=200027,300001&updateTime=1349237658578,13492
37658588 HTTP/1.1
Host: localhost:9080
Accept-Language: en-US

Response header
HTTP/1.1 204 OK
Content-Type: application/json
Content-Language: en-US

Related reference
Retrieval of release instances

Confirmation of the assignment of instances for a release
You use the POST operation on the api/sam/swinventory/confirmRelease element to
confirm the assignment of instances for a release.
You must have the Manage Software Classification permission to perform this task.
Important: Use this REST API only for BigFix products. The REST API returns only
instances that are assigned to default license metrics.
Operation details

Description

Operation

api/sam/swinventory/confirmRelease

Purpose

Confirms assignment of instances for a release.

Operation details

Description

HTTP method

POST

Resource URI

https://server_host_name:port_number/api/
sam/swinventory/confirmRelease

URL link relation

n/a

URI query parameters

No

Request headers

Header
Accept-Language (optional)

Values
en-US (English language only supported)
Used to negotiate the language of the response. If this
header is not specified, the content is returned in the
server language.
Request payload

n/a

Request Content-Type

n/a

Response headers

Header
Content-Language

Values
en-US, …
Specifies the language of the response content. If this
header is not specified, the content is returned in the
server language.
Response payload

n/a

Response Content-Type

n/a

Normal HTTP response
codes

204 – No content

Operation details
Error HTTP response codes

Description
400 – “Bad Request” if a query parameter con

tains errors or is missing
401 – “Unauthorized” if the user is not autho

rized to perform the operation
404 – “Not Found” if a release or instance of the

product or version that the user requested does
not exist
422 – “Unprocessable Entity” if the request

was well-formed but was unable to be followed
due to semantic errors
Message body excludes an error message with details.

Query parameters
The following table presents query parameters that you can use for the POST/swinventory/
confirmRelease element.

Re
Parameter
endDate

Description
Discovery end date. If the parameter

quired
No

is not specified, the current date is

Value
Date in the YYYYMM-DD format

used.
name_host_

The name of the computer on which

No

String

filter

the software item is installed

name_serv

The name of the server on which the

No

String

er_filter

software item is installed

operating_

Operating system of the computer on No

String

system_filter

which the software item is installed

Re
Parameter

Description

part_num

The part number to which the soft

ber_filter

ware item was assigned according to

quired

Value

No

String

The name of a software product, soft No

String

the imported part number list.
product_re

lease_compo ware release, or a component
nent_filter
releases

A list of unique release identifiers.

Yes

Numeric

No

Date in the YYYY-

Each identifier is separated by a com
ma. At least one ID must be entered
startDate

Discovery start date. If the parameter
is not specified, the first date that is

MM-DD format

not covered by a signed audit report
is used. If there are no signed reports,
the server installation date is used.
token

A unique user authentication identifi

Yes

Alphanumeric

er.

Example HTTP conversation
Request
POST /api/sam/swinventory/confirmRelease
?token=7adc3efb175e2bc0f4484bdd2efca54a8fa04623&releases=95185
&startDate=2012-10-18&endDate=2013-01-26 HTTP/1.1
Host: localhost:9080
Accept-Language: en-US

Response header

HTTP/1.1 204 OK
Content-Type: application/json
Content-Language: en-US

Glossary
This glossary provides terms and definitions for the BigFix Inventory software and products.
The following cross-references are used in this glossary:
• See refers you from a nonpreferred term to the preferred term or from an abbreviation
to the spelled-out form.
• See also refers you to a related or contrasting term.
ABCDEFHIKLMOPRSTV

A
activated processor core
A processor core that is managed or used by a product, regardless of whether
the capacity of the processor core can be limited through virtualization
technologies.
administration server
The database and web interface that software asset managers use for
maintaining information about license entitlements and instances of installed
products.
agent
A process that performs an action on behalf of a user or other program
without user intervention or on a regular schedule, and reports the results
back to the user or program.
API
See application programming interface.
application programming interface (API)

An interface that allows an application program that is written in a high-level
language to use specific data or functions of the operating system or another
program.
audit
In ITIL, the act of confirming compliance with a standard or set of guidelines,
or comparing actual measurements to targets, or verifying the accuracy of
recorded information.
authentication
In computer security, a process that ensures that the identities of both the
sender and the receiver of a network transaction are true.

B
bundle
To package a collection of individually orderable components or products into
a single offering, often for promotional purposes. Software manufacturers
typically offer a single license to cover all components of a bundled offering.
bundling
A process during which the user assigns a component to a product.

C
CA
See certificate authority.
certificate
In computer security, a digital document that binds a public key to the
identity of the certificate owner, thereby enabling the certificate owner to be
authenticated. A certificate is issued by a certificate authority and is digitally
signed by that authority. See also certificate authority, certificate signing
request.

certificate authority (CA)
A trusted third-party organization or company that issues the digital
certificates. The certificate authority typically verifies the identity of the
individuals who are granted the unique certificate. See also certificate.
certificate signing request (CSR)
An electronic message that an organization sends to a certificate authority
(CA) to obtain a certificate. The request includes a public key and is signed
with a private key; the CA returns the certificate after signing with its own
private key. See also certificate, keystore.
client
A software program or computer that requests services from a server. See
also host.
cluster
A set of independent systems or logical partitions (called nodes) that
are organized into a network for the purpose of sharing resources and
communicating with each other.
compliance
A state of being in accordance with established software and security
specifications on target computers, or the process of becoming so.
component
A software item that is part of a software product, and might be separately
identified, but is not individually licensed.
Computer group
An organized list of computers through which users can get dedicated
reporting or perform common operations in bulk. This feature simplifies the
maintenance of customer environments, and it can be used to represent, for
instance, a department or region.
confirmed instance

An instance of an installed software product that has been explicitly assigned
to one or more bundles.
constant special item ID list (CSIDL)
In Windows environments, a list that identifies frequently used special folders
whose location might vary on different systems.
contract
A set of information about a software license for a product or products, its
cost and entitlement period. When a contract is assigned to a computer group,
it indicates which computers are entitled to the licenses described by that
contract.
core
A single chip that houses a central processing unit (CPU) and is a component
in the larger circuit design of a computer. A single chip can only contain one
CPU, but a processor can contain multiple cores. See also dual-core, multicore, processor value unit.
CSIDL
See constant special item ID list.
CSR
See certificate signing request.
cURL
A command line tool for retrieving and posting files using URL syntax.

D
data source
The source of data itself, such as a database or XML file, and the connection
information necessary for accessing the data.
discover

To identify resources within a network environment.
DNS
See domain name server.
domain name server (DNS)
A server program that supplies name-to-address conversion by mapping
domain names to IP addresses.
dual-core
Referring to a system that integrates two processors into one virtual
processor. See also core, multi-core.

E
endpoint
A server, computer, machine or device that is monitored.
entitlement
In software licensing, the maximum allowed allocation of capacity as
determined by a license agreement.

F
fixlet
A message that provides instructions to an agent to perform a management
or reporting action.
full-capacity
Pertains to a software licensing scheme that bases charges on the capacity
of the entire machine or cluster of machines that is available to the licensed
program, rather than on just one or more partitions. See also processor value
unit, subcapacity.

H
host
A computer that is connected to a network and that provides an access point
to that network. The host can be a client, a server, or both a client and server
simultaneously. See also client.
host name
In Internet communication, the name given to a computer. The
host name might be a fully qualified domain name such as
mycomputer.city.company.com, or it might be a specific subname such as
mycomputer.
HTTP
See Hypertext Transfer Protocol.
Hypertext Transfer Protocol (HTTP)
An Internet protocol that is used to transfer and display hypertext and XML
documents on the web.
hypervisor
Software or a physical device that enables multiple instances of operating
systems to run simultaneously on the same hardware.

I
instance
A software product or component that is installed on a server or logical
partition (LPAR).
IT infrastructure
All of the hardware, software, networks, and other facilities (but not people
or processes) required to develop, test, deliver, monitor, control, or support IT
services.

K
keystore
In security, a file or a hardware cryptographic card where identities and private
keys are stored, for authentication and encryption purposes. Some keystores
also contain trusted or public keys. See also certificate signing request.
knowledge base
See software knowledge base.

L
LDAP
See Lightweight Directory Access Protocol.
license
A legal agreement that authorizes the use of proprietary information including,
but not limited to, copyrighted or patented information.
Lightweight Directory Access Protocol (LDAP)
An open protocol that uses TCP/IP to provide access to directories that
support an X.500 model and that does not incur the resource requirements of
the more complex X.500 Directory Access Protocol (DAP). For example, LDAP
can be used to locate people, organizations, and other resources in an Internet
or intranet directory.
locale
A setting that identifies language or geography and determines formatting
conventions such as collation, case conversion, character classification,
the language of messages, date and time representation, and numeric
representation.
logical partition (LP, LPAR)
One or more virtualized images of a hardware computing system that can
include shared and dedicated resources assigned from the pool of resources

available on a physical server. Each image appears to the operating system
running within it to be a unique instance of a physical server. See also
virtualization.
LP
See logical partition.
LPAR
See logical partition.

M
multi-core
Referring to a system that integrates multiple processors into one virtual
processor. See also core, dual-core.
Metric
A measurement unit that defines usage of software license, for example,
installed seats, PVU

O
offering
The element or integrated set of elements (hardware, software, services)
designed to satisfy the wants and needs of current and/or prospective
customers. A solution is the application of the offering in a specific customer
environment.

P
partition
A logical division of storage on a fixed disk. See also subcapacity,
virtualization.
PID

See product identifier.
pricing metric
A measurement that defines how capacity is counted and applied against the
customer's entitlement. See also entitlement.
processor value unit (PVU)
A unit of measure that is assigned to each processor core for software
licensing purposes. PVUs vary according to chip architecture. See also core,
full-capacity, subcapacity.
product ID
See product identifier.
product identifier (PID, product ID)
A unique value that identifies an BigFix software product. Every mainframe
and distributed BigFix software product has a PID.
Purchase order
A set of information about purchased software
PVU
See processor value unit.

R
raw data
Unprocessed data that contains information about software items and
manufacturers, obtained through software scans.
Representational State Transfer (REST)
A software architectural style for distributed hypermedia systems like the
World Wide Web. The term is also often used to describe any simple interface
that uses XML (or YAML, JSON, plain text) over HTTP without an additional
messaging layer such as SOAP.

resource value unit (RVU)
A unit of measure by which a program can be licensed that is based on the
number of units of a specific resource used or managed by the program.
response file
A file that can be customized with the setup and configuration data that
automates an installation. During an interactive installation, the setup and
configuration data must be entered, but with a response file, the installation
can proceed without any intervention.
REST
See Representational State Transfer.
RVU
See resource value unit.

S
scan
To systematically search a computer or a network for information about
hardware, software, or configuration. See also software scan.
signature
The set of unique information that identifies a software application, such as
the name, version, and file size of an application.
silent mode
A method for installing or uninstalling a product component from the
command line with no GUI display. When using silent mode, you specify the
data required by the installation or uninstallation program directly on the
command line or in a file (called an option file or response file).
site
A subdivision of an organization that can track inventory and other data
separately from other sites.

software catalog
A portable representation of the contents of the software knowledge base
that serves IT management applications including asset management, license
management, and software provisioning. Catalog format and content might
vary, depending on the target application. See also software knowledge base.
Software contract
A set of information about a software license for a product or products,
its type, cost, amount of purchased license metrics, and the entitlement
period. When a contract is assigned to a computer group, it indicates which
computers the license is distributed to
software hierarchy
The combination of software product, version, release, and variation that
represents a software item in the software knowledge base. The product is the
root of the hierarchy. See also software knowledge base.
software knowledge base
A collection of information about distributed software products and
components, dependencies between them, the means to discover them, and
their basic licensing properties. The knowledge base is used to generate
software catalogs that asset management tools can use for software
inventory identification, license compliance, and software provisioning. See
also software catalog, software hierarchy.
Software license
A legal instrument governing the use or redistribution of software
software product
A software item that is licensed independently of other software items. For
licensing purposes, software products are sometimes bundled into a single
sales offering.
software scan

An automated process that discovers instances of software installed on the
computers in a network. The software scan results include details about
discovered software, such as version numbers. See also scan.
subcapacity
Pertains to a software licensing scheme that bases charges on the capacity
of the partition where the licensed program is used, rather than on the total
capacity in the server. See also full-capacity, partition, processor value unit,
virtualization, virtualization.

T
TLS
See Transport Layer Security.
Transport Layer Security (TLS)
A set of encryption rules that uses verified certificates and encryption keys
to secure communications over the Internet. TLS is an update to the SSL
protocol.

V
virtualization
The creation of a virtual computing resource such as an operating system,
server, storage device, or network resources in a one-to-many or many-toone association. For example, a single operating system might be divided
into multiple partitions that operate as independent systems, or multiple
disk devices might appear as a single logical drive. See also logical partition,
partition, subcapacity.
virtual machine (VM)
An instance of a data-processing system that appears to be at the exclusive
disposal of a single user, but whose functions are accomplished by sharing
the resources of a physical data-processing system.

VM
See virtual machine.
Computer Group – an organized list of computers through which users can get dedicated
reporting or perform common operations in bulk. This feature simplifies the maintenance
of customer environments, and it can be used to represent, for instance, a department or
region.
Software License – a legal instrument governing the use or redistribution of software.
Metric – a measurement unit that defines usage of software license e.g. installed seats,
PVU
Software Contract - A set of information about a software license for a product or products,
its type, cost, amount of purchased license metrics, and the entitlement period. When
a contract is assigned to a computer group, it indicates which computers the license is
distributed to.
Purchase order – a set of information about purchased software.
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